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Getting Started with Ektron

Ektron manages the life cycle of content, from creation to approval and publication. It helps
your organization set up a process for overseeing changes to a website, indicate the status of
content within that life cycle, and inform the next approver that it is their turn to review the
content.
Business users, such as marketing or public relations professionals, can author, manage and
publish Web content, build and deploy Web forms, and collect and leverage visitor
information. The editor supports the industry’s best in-context editing environment, ensuring
user adoption and project success.
People interact with your Ektron website in different ways. Some people operate in different
roles, and sometimes different roles overlap in activity. For example, a developer uses
PageBuilder to create page structures and content authors use PageBuilder to build a page in
those structures. Similarly, some administrators and developers may perform installation
and set up actions.
The major roles for people interacting with your website are as follows:
l

l

6

Content Author—creates content for your website and may edit the content in context
on the Web page, or modify content in the Workarea. Content authors can have
specialized roles and permissions, such as a discussion board administrator.
o Editing in Ektron on page 207
o

Creating New PageBuilder Pages on page 661

o

Editing Content on a PageBuilder Page on page 665

o

Displaying Content on Your Website on page 348

o

Managing Content on page 273

o

Working with Ektron Content on page 287

o

Working with Assets in the Document Management System on page 310

o

Storing Files in the Library on page 333

o

Working with Collections on page 355

o

Optimizing Page Layout with Multivariate Testing on page 695

o

Assigning and Managing Tasks on page 1027

o

Managing User Communities on page 1159

o

Working with Discussion Boards on page 536

o

Working with Forums on page 547

o

Working with Blogs on page 491

o

Working with Calendars on page 514

o

Assigning and Managing Tasks on page 1027

Administrator—manages the website including access to all content, taxonomies,
users, rules, and settings.
o Setting Up Your CMS Folder Structure on page 241
o

Managing Content on page 273

o

Working with Ektron Content on page 287

o

Using Widgets on page 711

o

Using Menus on page 753

o

Using Taxonomies on page 777

o

Using Breadcrumbs on page 819
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l

o

Personalizing a Web Page on page 825

o

Creating User-Friendly URLs with Aliasing on page 835

o

Analyzing Content on page 601

o

Working with Smart Forms on page 423

o

Using Taxonomies on page 777

o

Creating User-Friendly URLs with Aliasing on page 835

o

Creating Business Rules for Your Website on page 1049

o

Defining Roles on page 1120

o

Accessing the Permissions Table on page 257

o

Managing Users and User Groups on page 1099

o

Synchronizing Servers Using eSync on page 1473

o

Sending Notifications to a Community on page 1194

o

Administering Web Alerts on page 1567

Developer—writes API code, modifies ASPX pages, creates wireframe templates with
PageBuilder, and create widgets to customize your website.
o Installing Ektron on page 9
o

Upgrading to Version 8.7 on page 35

o

Securing Ektron on page 51

o

Setting Up Ektron on page 61

o

Developing Wireframe Templates on page 676

o

Using Ektron in the Cloud on page 153

o

Ektron's Mobile-Driven Web Experience on page 133

o

Setting Up Search for Your Website on page 861

o

Setting Up the Digital Experience Hub on page 991

o

Applying Adaptive Image Resizing on page 145

o

Using Responsive Frameworks with PageBuilder on page 670

o

Conducting eCommerce on page 1279

o

Distributing Resources with 3-Tier Architecture on page 1591

o

Using Widgets on page 711

o

Using LDAP with Ektron on page 1151

o

Working with Multi-Language Content on page 1057

o

Sending Notifications to a Community on page 1194

o

Using Ektron Building Block Server Controls on page 1601

o

Customizing Behavior with Extensions on page 1867

o

Ektron Windows Service on page 1877

o

Diagnostics Utility on page 1883

o

Targeting Content with GeoIP Information on page 1899

o

Controlling Output with Ektron Markup Language on page 1905

For information about developing a Web strategy, see Ektron's Mobile-Driven Web Experience
on page 133.
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Installing Ektron

For information about the system requirements for the current release, see the System
Requirements. If your system does not conform to these requirements, you should upgrade
before installing or upgrading Ektron.
IMPORTANT: Each deployment has unique requirements. Ektron recommends that you engage with a
Certified Ektron Partner when making decisions about the needs of your specific production environment.
This section also contains the following topics.
License Keys
Installing Ektron
Installing Ektron on Several Servers
Uninstalling Ektron
Installing Help Files on a Local Server

10
12
29
29
32

License Keys
IMPORTANT: Read the Ektron Perpetual License Agreement before installing Ektron Software.
Ektron controls the usage through a license key, a unique code assigned to your domain. Your
license key is included in the email that is sent when you request or purchase Ektron.
When you login to a website that contains Ektron, it checks the license key(s) against the
domain.
If the URL of a valid license key matches the URL of the site being accessed, the Workarea
appears.
If no valid license key is found for the URL of the site being accessed, Ektron is disabled and
you must log in the with Builtin account to change the License Key.
If you have a broken license key or a license key with an incorrect base URL, an error
message appears in the Ektron Login window. The message states, “Error: A license violation
has occurred and the application is presently locked. Please see your administrator.”
If this message appears, you can login with the Builtin account and reenter your license key.
If the message continues to appear and you are sure you have a valid key, contact Ektron
Support.
This section also contains the following topics.
Domains in which You Can Use a License Key
Using Ektron without a License Key
Inserting the License Key
Upgrading a License Key
License Key Format

10
11
11
11
11

Domains in which You Can Use a License Key
The license key is assigned to your base URL, which is typically your domain name. For
example, if your domain name is www.mycompany.com, the license key follows this pattern:
www.mycompany.com(expdate)(Modifiers)?1234567890.
Each domain name requires its own license key. For example, to support the domain names,
www.mycompany.com, sales.mycompany.com and support.mycompany.com, you need 3
license keys.
10
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Using Ektron without a License Key

When you purchase a license key, be sure to register a domain name, not an IP address. For
example, register www.mycompany.com, not 192.168.0.1.
Although Ektron supports IP addresses, the domain that you license becomes the required
URL in the browser address. For example, if you register 192.168.0.1, you would need to
access the site as http://192.168.0.1/somedirectory/myloginpage.aspx.
Because users would typically not identify a Web page by its IP address, you should register
the domain name instead.

Using Ektron without a License Key
For evaluation purposes, when you install Ektron, you do not need a license key. During the
installation process, leave the License Key field blank and click Next on the License screen.
This lets you use Ektron as localhost.

Inserting the License Key
If you download the executable (.exe) file, you are prompted to enter a license key during
installation. Otherwise, you can enter it by choosing Workarea > Settings > Setup and
clicking Edit and then add the license key to the License Key(s) field.

Upgrading a License Key
If you upgrade Ektron and want to replace the old license key with a new one, choose
Workarea > Settings > Setup and click Edit. Next, add the license key to the License
Key(s) field. On the other hand, if you want to add new keys in addition to old keys, create a
comma-delimited list of keys in the License Key(s) field.
When cutting and pasting license keys, keep the full license key intact without adding or
deleting characters. License keys that are changed in any way render Ektron inoperable.

License Key Format
A license key typically begins with a base URL (domain name, computer network name, or IP
address) followed by descriptor tags, a question mark, a series of numbers, a hyphen and
one or 2 digits signifying release number. For example:
dev.mysite.com(exp-2010-10-25)(modifiers)(users10)?51510837796786063064924334416-XX
License keys cannot contain spaces or line breaks. The following tables shows license key
modifiers.
Version Modifier
l
l

ST (Standard key)—All Ektron features other than the following features in this list.
PR (Professional key)—In addition to standard features:
o Personalization
o

XLIFF Support

o

Document Management

o

Social Networking

o

Analytics

Ektron 8.7
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l

EN (Enterprise key)—In addition to standard features:
o eSync
o

Multi-site

Option Modifiers
l

l

l

l

Mn (Multi-site)—n indicates number of sites; can be optionally purchased with Standard
or Professional key or part of an Enterprise version.
S (eSync)—can be optionally purchased with Professional key or part of an Enterprise
version
E (eCommerce)—can be optionally purchased with Standard, Professional or Enterprise
version
XML (eWebEditPro)—Support for eWebEditPro + XML; standard part of every license

Installing Ektron
By default, the installation places files in 2 server locations:
l

l

C:\Program Files\Ektron\CMS400vXX: sample and minimal databases,
documentation, utilities, setup files for creating additional sites
C:\Inetpub\wwwroot\site root: bin folder, Web Services, scripts, supporting files,
uploaded files and images, graphics used in Ektron, CustomAPI, and so on.
NOTE: The bin folder stores Ektron’s binary executable files. .NET automatically searches this
folder for .dll files.

During installation, the ASPNET or IIS_WPG and IUSR users are given permission to create
folders in these directories:
l

C:\Inetpub\wwwroot\[Your Site]\uploadedfiles

l

C:\Inetpub\wwwroot\[Your Site]\uploadedimages

This section also contains the following topics.
Before You Install
Installing the CMS Base
Installing a Site
Setting up a Database
Troubleshooting Installation Issues

12
13
17
23
28

Before You Install
1. Create a folder for the site. Make sure the drive and folder to which you install your
Ektron website have sufficient space. Anticipate future needs, since the site is likely to
grow over time.
2. Make sure that Internet Information Server (IIS) is installed on your server. See
Creating Multiple Websites on a Single Server on page 86.
3. Install and configure your Web Application Server. For more information, see Microsoft
ASP.net.
4. If you are setting up one website that uses multiple Ektron servers and points to a single
database server, make sure both servers connect to the same database. This
configuration ensures that membership user registrations, forum/blog posts, statistics,

12
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Installing the CMS Base

and so on, are the same on both servers. For more information, see Installing Ektron on
page 9.
5. Decide which search provider you will use. See Also: Setting Up Search for Your Website
on page 861
If you will use any Microsoft search provider, install it. See Also: Setting Up a Microsoft
FAST Search on page 899; Setting Up Microsoft Search Server 2010 on page 871
IMPORTANT: If your server uses Windows 7, the only supported Search provider is Search Server
Express. In this case, first install Ektron then install the version of Search Server Express available
from C:\Program Files\Ektron\CMS400vxx\Utilities\SearchServer\
SearchServerExpressInstall.exe. See Also: Setting Up Microsoft Search Server 2010
Express on page 864
6. Enable IIS 6 metabase compatibility and ASP.NET. To do that:
a. From the Windows Control Panel, choose Programs and Features.
b. From the left panel, choose Turn Windows Features On or Off.

c. Click to open Internet Information Services > Web Management Tools >
IIS 6 Management Compatibility.
d. Check IIS Metabase and IIS 6 configuration compatibility.
e. Click to open Internet Information Services > World Wide Web Services >
Application Development Features.
f. Check ASP.NET.
g. Click OK.
7. Obtain a license key from Ektron. Send email to license@ektron.com.

Installing the CMS Base
1. Contact your Ektron account manager to obtain a link to download Ektron 8.7. See Also:
Contact Ektron.
2. Double click the downloaded CMS400Basevreleasenumber.exe file.
3. Ektron verifies that your server has all required components. You must install any
missing ones before you can continue.

Ektron 8.7
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4. A screen displays Ektron’s License Agreement. Please read it and click I Accept. If you
do not accept, the setup ends.

5. Select Complete to install all components. Or, select Custom to choose which
components to install. You can also choose where to install them.

14
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6. When you click Next, the install checks for SQL or SQL Express on the server. If SQL is
not installed, a dialog prompts you to install SQL Express.
7. If you will use a remote SQL server, click Continue. If you plan to use SQL Server on
this computer, click the link on the message to install SQL Server Express 2008 R2 RTM.
If you do, the Ektron installation terminates. After installing SQL Server Express, restart
the Ektron installation.

8. The Ready to Install the Program screen appears. Click Install. The installation
program copies files to the C:\Program Files folder.

Ektron 8.7
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IMPORTANT: After completing the installation, you should further configure your permissions
based on your network security model before using Ektron.
9. Click Yes to check for updates. This verifies that you have the latest version of Ektron.

10. You might be prompted to restart your server. If so, you should restart now.
IMPORTANT: If this dialog appears, do not run the site setup until the system reboots.

16
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Installing a Site

After you install Ektron, the web.config file is updated as follows.
l

ek_sitePath—webroot/siteroot

l

ek_buildNumber—current build number of Ektron

l

ek_cmsversion—current version of Ektron

l

Connection String—information about the database's connection to Ektron.

See Also: Managing the web.config File on page 67

Installing a Site
NOTE: Continue with these steps after completing Installing the CMS Base on page 13.
The installation copies the following folders from C:\Program Files\Ektron\CMS400vxx to
the Web root folder you specify:
l

BIN

l

workarea

l

documentation

l

uploaded files and uploaded images

l

a login page

l

the Visual Studio solution file

1. You can create a new site manually by clicking the cms400sitesetup.exe file located in
C:\Program Files\Ektron\CMS400vxx\Utilities\SiteSetup or by choosing Start >
Programs > Ektron > CMS400vXX Utilities > CMS400 Site Setup. The Setup
Type screen appears.

Ektron 8.7
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2. Choose an option and click Next.
l
CMS400 Full Installation—For setting up a new site installation.
l
l

CMS400 Upgrade—For upgrading existing site's database and site files.
CMS400 Database Setup—For setting up a new site database. Site files, such as
.aspx pages, are not included in this setup.

3. In the License Key field, enter your primary license key for Ektron. License keys are
typically emailed to your organization when you request a copy of the application. When
cutting and pasting a license key, keep the full license key intact without adding or
deleting characters. If you do not have license keys now, you can insert them later.

4. You can select a site to install. This screen does not appear the first time you run the site
setup for a starter site. If you run it again and have multiple sites, this dialog box
appears.

18
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Installing a Site

5. If your server operating system accommodates multiple websites (for example,
Windows Server 2008), select the site to which you want to install Ektron from the dropdown list. Otherwise, accept the default.

Ektron 8.7
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6. Enter the destination folder for the site. If your website resides in a folder other than the
default, click Browse and navigate to that folder. The default reflects your selection in
the previous dialog.
WARNING! Do not install under another application’s folder within the Web root.
IMPORTANT: Ektron does not support the installation of nested sites, each having its own
web.config file. Nested sites can disrupt Ektron features, such as Aliasing, Menus, and eSync.

7. Enter the path of the Secure Asset Location. The Site Options screen appears.
IMPORTANT: If you plan to load balance several servers, make sure this path is the same for all
servers in the cluster. See Also: Balancing the Load on Your Servers on page 89
NOTE: Be sure the drive to which you install the asset library has sufficient storage space plus
room for growth.
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Installing a Site

8. On the Search Provider screen, determine which search provider you will use with
Ektron.

See Also: Setting Up a Microsoft FAST Search on page 899; Setting Up Microsoft Search
Server 2010 on page 871

Ektron 8.7
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IMPORTANT: If your server uses Windows 7, the only supported Search provider is Search Server
Express. In this case, first install Ektron then install the version of Search Server Express available
from C:\Program Files\Ektron\CMS400vxx\Utilities\SearchServer\
SearchServerExpressInstall.exe. See Also: Setting Up Microsoft Search Server 2010
Express on page 864
9. On the Site Options screen, check each option you want to install. Boxes are grayed out
if an option is not available.
See Also:
l
l

l

Diagnostics Utility on page 1883
an eSync security certificate. See Also: Managing eSync Security Certificates on
page 1521
Using Ektron’s Developer SDK on page 1633

NOTE: eSync is only available if the eSync modifier is in your license key. SDK is only available if
Visual Studio 2010 is installed on your server.
10. After choosing, click Install. The Moving Files dialog appears, and the following things
happen.
l
files are copied to the site
l
l

22

permissions are set for the site’s directories
ASPNET, IIS_WPG, or Network Service user and IUSR are given permissions to the
directories

l

the site is set up to use .NET 4.0

l

web.config settings are configured

l

IIS is configured

Ektron Reference
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Setting up a Database
NOTE: Continue with these steps after completing Installing a Site on page 17.
Your database contains information such as users and content blocks. The database setup
program:
l

l
l

checks for SQL or SQL Express server. If either is installed on your server, an
appropriate database is set up.
loads database tables
updates the web.config file with information about your database connection, based on
your responses

1. You are asked if you want to set up a database. Click Yes.

If you are using a separate database server, you need the following information:
l
l

l

l

database server host name or IP address
if the database server is on the same domain as the application server, it must
support NT or SQL authentication
if the database server is on a separate domain from the application server, it must
support SQL authentication
you must have database administrator or database creator privileges

Ektron 8.7
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2. Enter the name of the database you are creating.

3. Enter the builtin user’s password. For information about the builtin user, see Getting
Started with Ektron on page 5.

24
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Setting up a Database

4. Click Next. The SQL Server DB Setup screen appears and prompts for database
connection information.

l

Server—List the database server on this system. To setup the database on this
server, accept the default. Otherwise, enter a SQL or SQL Express server that
already exists. For SQL, this would typically be (local) if it’s installed on the local
server. Otherwise, enter the Server’s name. For SQL Express enter
(local)\SQLEXPRESS.

l

Username—Enter the username you will use to access the database.

l

Password—Enter the password you will use to access the database.
NOTE: If you want to use NT authentication, leave the username and password blank. This
will set up a trusted connection.

After you complete the screen, the setup verifies the database connection information. If
the database name already exists, you are asked to assign a different name. When a
connection is made and the name is available, the installation program creates a
database using the provided information.

Ektron 8.7

25

Installing Ektron

5. Click Install to begin the installation. The Setup Status screen appears.

6. When the SDK install is finished, the following screen appears. Click Finish. The site and
database setup portion of the install is complete.

7. If you selected a search provider in Setting Up Search for Your Website on page 861, the
following screen appears.

26
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l

l

l

If you set up a search provider and installed Ektron search components, click Yes. (This
would typically be the case when an Ektron site on the server is already using search).
If you have not set up a search provider, click No. After completing the Ektron
installation, install the search provider. Then, go to C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SearchServer\
Ektron.Cms.Search.Configuration.exe to configure Ektron to work with the search
provider. See Also:
o Setting Up Microsoft Search Server 2010 Express on page 864
o

Setting Up Microsoft Search Server 2010 on page 871

o

Setting Up a Microsoft FAST Search on page 899

If you set up a search provider but have not yet installed Ektron search components,
click No. Complete the Ektron installation then go to C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SearchServer\
Ektron.Cms.Search.Configuration.exe to configure Ektron with a search provider.
See Also: Managing a Microsoft Search Server on page 925.
IMPORTANT: If your server uses Windows 7, the only supported Search provider is Search Server
Express. In this case, first install Ektron then install the version of Search Server Express available
from C:\Program Files\Ektron\CMS400vxx\Utilities\SearchServer\
SearchServerExpressInstall.exe. See Also: Setting Up Microsoft Search Server 2010
Express on page 864

8. If your Assets folder will have more than 50 PDF files, you should Install Foxit PDF Filter
on page 937 to speed up the indexing of PDF files.

Ektron 8.7
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9. If you checked the eSync box in Step 9 of Installing a Site on page 17, the following
dialog appears.

To learn about eSync security certificates, see Part 2: Generate and Copy Security
Certificates on page 1484.

Troubleshooting Installation Issues
Error: Failed to Create Directory

The possible cause and solutions are as follows:
l

User does not have permission to create objects—Grant user permission to create
objects. For information on how to, read IIS Security help topic “Setting NTFS
Permissions for a Directory or File.”
http://localhost/iishelp/iis/htm/core/iidfpsc.htm

l

IIS is not installed—Make sure IIS is installed on the server.

l

Host is not localhost—Install Ektron on localhost machine only.

Error: Configuration Error

28
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Installing Ektron on Several Servers

If Ektron requires .NET 4.0, but you server has a previous version of the Microsoft .NET
framework, Install the .NET 4.0 framework.

Installing Ektron on Several Servers
Perform these steps on the development server.
1. Download and run the Ektron installation file, CMS400Basevversionnumber.exe.
2. In Windows Explorer, create a folder to be used for development (for example,
c:/cmsdev).
a. At the Setup Type page, select CMS 400 (Complete).
b. On the Site Setup screen, at the Select Site drop-down, select the site you created
in Step 3, dev.example.com. At Select Host, select the host you entered for
dev.example.com.
c. On the Site Path Directory screen, browse to the C:\cmsdev folder.
d. On the Host screen, enter http://dev.example.com or an IP address. A window
prompts you to define the Asset Storage Location. Enter C:\assetlibrary\cmsdev
and C:\assetcatalog\cmsdev. The Database Setup utility begins. (See Setting up
a Database on page 23.)
3. Run the Site Setup utility by choosing Start > Programs > Ektron > Utilities >
CMS400 Site Setup. This installs the site on the development server. (See Installing a
Site on page 17.)
a. Enter your database name, cmsdev to continue the example. (Do not leave it as
localhost.)
b. Enter your database server information, then the host, user and password. The
database is created. The site is ready for use.
c. Open Internet Explorer and go to http://dev.example.com/login.aspx to test
the site.
d. Log in to make sure the database is working.
Using the steps, install sites to your staging and production servers.

Uninstalling Ektron
Uninstalling removes all Ektron files from your server. You might want to do this if you
installed Ektron, experimented with it, and now want to remove that version and install a

Ektron 8.7
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clean, new version.
IMPORTANT: Do not use the Windows Add/Remove programs utility to uninstall Ektron. Use the
uninstall utility instead.
To uninstall Ektron:
1. Close all programs that are using your Ektron website. Close all Ektron files.
2. Go to C:\Program Files (x86)\Ektron\CMS400vxx\Utilities.
3. Copy the CMS uninstaller folder to your desktop.
4. From that folder, run CMSUninstaller.exe. You can uninstall specific websites, the Ektron
application directory, or all Ektron files.

Effect of Removing a Website
When you uninstall a website, the following happens.
1. The IIS and Indexing Service stops.
2. The website's database is deleted.
3. The website folder's files are deleted.
4. The IIS and Indexing Service starts.

Effect of Removing a Website's Database
If you check the Remove Websites Database box, the site database is removed.

Effect of Removing the Ektron Application Directory
If you check the Remove Ektron Application directory box, the following items are
removed.

30
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Removing Search Server Files and Services

l
l

l
l

l

All Ektron services
These Program Files (x86)\Ektron directories (if they exist)
o CMS400vx5
o

CMS400vx0

o

CMS400v76

o

CMS400v75

o

CMS400v70

o

Dms400

o

EktronWindowsService40

o

EktronWindowsService30

o

EktronWindowsService20

o

EktronWindowsService

o

EktronCmsFileHelperService

o

EktronNotificationServices

o

Plugins

o

CMS400SDK

Various system directory files
These registry entries
o Everything under Software\Ektron
o

All StarterSite keys

o

SDK install key

The base installer key

Removing Search Server Files and Services
If you check the Remove Ektron Search Server Files and Services box, the services
and files that Ektron uses for Microsoft Search Server are removed. (This action does not
remove Microsoft Search Server 2010).

Removing All Sites and Application Directory
If you check the Remove All Sites and Application Directory box, all Ektron files are
removed.
NOTE: After you complete the uninstall, you may need to manually remove the AssetLibrary,
EktronSearchData directories.

Removing Third-Party Programs
To remove all third-party applications required to run Ektron, go to Windows Control Panel
> Uninstall a Program and remove these programs.
l

Your search provider (for example, Microsoft Search Server 2010)

l

SQL 2008 R2 Reporting Services Sharepoint 2010 Addin

l

Microsoft Sync Framework 2.1 SDK

l

Microsoft Visual C++ 2010 x64 Redistributable
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l

Microsoft Filter Pack 2.0

l

Microsoft Visual C++ 2008 Redistributable

l

MSXML 4.0 SP2 Parser and SDK

l

Microsoft Visual C++ 2005 Redistributable (x64)

l

Microsoft Server Speech Recognition Language = Tele (enUS)

l

Adobe PDF iFilter for 64bit platforms

l

Microsoft Chart Controls for Microsoft .NET Framework 3.5

l

Microsoft Server Speech Platform Runtime (x64)

l

Microsoft ASP.NET 2.0 AJAX Extensions 1.0

l

Microsoft .NET Framework 4 Extended

l

Microsoft .NET Framework 4 Client Profile

l

Microsoft Sync Services for ADO.NET v2.0 (x64)

l

Microsoft Report Viewer Redistributable 2008 SP1

l

Microsoft Office 2003 Web Components

NOTE: Some applications may have been installed before you installed Ektron.

Installing Help Files on a Local Server
Beginning with Ektron Version 8.5, Ektron online help files reside in an Ektron-hosted Web
server instead of a folder on your Web server. If you block your users' workstation access to
the Internet, help files are not available, and users see an error when they click the help
button. To remedy this issue, either change the firewall to allow access to the internet, or
install help files locally.

Step 1: Download and Install the Help Folder on your
Web Server
1. Copy the following path into a browser:
http://downloads.ektron.com/software/released/CMS400/v87/Help/v870_
help.exe.
2. Download the file to your Ektron server, typically to the download folder.
3. In the download folder, click v870_help.exe. A wizard appears.
4. Choose the website for which you will install help.
5. On the Help File Directory screen, choose a folder to which you want to install help,
typically inetpub/wwwroot/yourwebsite/Workarea. You can install help to any website
folder.

Step 2: Change Your Website's web.config File
1. Edit your website's siteroot/web.config file.
2. Find ek_helpDomainPrefix.
3. If you installed the help folder to this website's Workarea folder, remove the path value.
For example
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Step 2: Change Your Website's web.config File

<add key="ek_helpDomainPrefix" value=""/>

If you installed help to any other folder, replace the default value with the complete URL
to that folder.
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The upgrade procedure copies Ektron’s latest features to your Web server. Ektron is installed
to its own folder, C:\Program Files (x86)\Ektron\CMS400v87. This means it can coexist
with previous versions on the same machine—the template directories are independent.
If you are upgrading from version 8.0 or higher, follow the instructions in this section. If you
are upgrading from an earlier version and need assistance, please contact Ektron technical
support.
For information about the system requirements for the current release, see the Ektron
System Requirements. If your system does not conform to these requirements, you should
upgrade your system before installing or upgrading Ektron.
Consider the following information before upgrading:
l

l

l

l

Warning! During the upgrade procedure, your website’s Bin, Workarea and
Documentation folders are removed. Any customized files in these folders will be lost.
Only store custom files in these folders when absolutely necessary. Even then, keep a
backup file in another folder.
Warning! If you are in an eSync environment, you must perform a full synchronization
before and after upgrading. See Running eSync on page 1532 in Synchronizing Servers
Using eSync on page 1473.
Important! You cannot upgrade Ektron sample or starter sites because they are
designed to demonstrate the product's latest features, so each version is uniquely
created to support a release.
Important! Each deployment has unique requirements. Ektron recommends that you
engage with a Certified Ektron Partnerwhen making decisions about the needs of your
specific production environment.

This section also contains the following topics.
Upgrade Overview
Performing the Upgrade
Backing Up Databases
Troubleshooting Upgrade Problems
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The Site Setup utility uses files in the CMS400vxx base folder to create and upgrade Ektron
sites. The base folder contains these subfolders.
l

AssetManagement—Folders and files for the Document Management Functionality

l

Bin—Required .NET assemblies

l

CMSServiceUpdate—Files to update your services

l

l

l
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CommonFiles—Application Global Resources, Web References and Starter Application
files
Documentation—Documentation. The site setup procedure copies this directory to the
workarea directory when setting up a site.
EktronAsyncProcessor_Service—Files needed to add Asynchronous Processor for Web
Alerts

l

StarterSites—Files for starter sites that have been added

l

StudioHelp—Files for adding API help to Visual Studio

l

SyncUpdate—Files to update eSync
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Upgrade Overview

l

l

Utilities—Utilities for
o database upgrade
o

database application strings update

o

email encrypt password tool

o

a setup SharePoint Portal

o

Document Management Registration tool

o

Load Balancing service files

Workarea—Scripts used for the Workarea
NOTE: The contents of this folder are later copied to a website folder, typically in the Web server’s
Web root. The sample provides a good way to learn how to work with an Ektron site.

Upgrade Overview
The upgrade procedure performs these tasks.
1. Installs new files to new directories. See Also: Installing the CMS Base on page 13
2. Removes the following folders (and their subfolders) from and copies new folders to
your site directory.
l
bin
l

workarea

l

Documentation

WARNING! Any customized files in these folders will be lost. So, only store custom files in these
folders when absolutely necessary. Even then, keep a backup of customized files in another folder.
3. Updates the web.config file.
4. Updates your databases using the upgrade and language update utilities.
NOTE: The upgrade automatically starts the IIS and Search services.

Performing the Upgrade
1. If you have not done so already, install a Search provider. You must use an external
search provider if you want to use search with Ektron. See Also: Setting Up Search for
Your Website on page 861
IMPORTANT: If your server uses Windows 7,the only supported Search provider is Search Server
Express. In this case, first install Ektron then install the version of Search Server Express available
from C:\Program Files\Ektron\CMS400vxx\Utilities\SearchServer\
SearchServerExpressInstall.exe. See Also: Setting Up Microsoft Search Server 2010
Express on page 864
2. Copy the Assets folder.
NOTE: This step is only relevant if you are using Microsoft Search Server 2010 on a server that is
different from your Ektron server.
BEST PRACTICE
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In general, do not install Microsoft Search Server 2010 on a server that also
hosts Ektron. Only install both programs on the same server in a development
environment.
For Microsoft Search Server 2010 to index your Ektron assets, they must be copied from
the Web server to the Search Server. This process is handled in the background once
your site is up and running. However, if your site has a large number of assets, the initial
copy may get clogged. To avoid this problem, inspect the size of your Ektron site's
Assets folder. If it exceeds 1 gigabyte, follow these steps. Failure to do so may result in
errors.
a. Create a folder on your search server to hold the assets. The folder's path must
match the path to your Ektron site's Assets folder and include EktronSearchData
between C:\ and the beginning of the path.
For example, if your site's Assets folder is
C:\inetpub\wwwroot\OnTrek85\Assets, create a folder on your Search Server
named C:\EktronSearchData\inetpub\wwwroot\OnTrek85\Assets.
b. Copy the Assets folder from your Ektron site folder to the Search Server folder you
created in Step a.
3. Follow the steps of the installation procedure, Installing the CMS Base on page 13, which
instruct you to install Ektron and restart your server. Continue to the step below when
the Site Setup Selection appears.
4. The Setup wizard appears. (If this screen does not appear, launch it by following this
path from the Windows Start menu: Start > Programs > Ektron > CMS400vxx >
Utilities > Site Setup
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5. The Setup Type screen appears. Choose CMS400 Upgrade and click Next.

6. Choose an application directory. If you are not sure, use the default (C:\Program
Files\Ektron\CMS400vxx). This directory stores Ektron components and utilities.
NOTE: This dialog only appears if the Setup cannot detect the location of the site’s application
directory.
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7. If your server operating system accommodates multiple websites, select the site to
which you want to upgrade Ektron from the drop-down list. Otherwise, accept the
default.
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8. Select the path of the website you are upgrading. Note that the upgrade only updates the
web.config file, Ektron assembly files, and Web Service/Workarea components. It does
not update your templates nor other files not mentioned above.

9. The message below appears. Click Yes to back up your site.
WARNING! Ektron strongly recommends backing up your site before continuing the upgrade. If you
choose No and the upgrade fails, you cannot revert the files to their original state.
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10. If you choose to back up your site, a dialog asks where to store the backup.

11. On the Search Provider screen, determine which search provider you will use with
Ektron.
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See Also: Setting Up a Microsoft FAST Search on page 899; Setting Up Microsoft Search
Server 2010 Express on page 864
IMPORTANT: If your server uses Windows 7, the only supported Search provider is Search Server
Express. In this case, first install Ektron then install the version of Search Server Express available
from C:\Program Files\Ektron\CMS400vxx\Utilities\SearchServer\
SearchServerExpressInstall.exe.
12. The Site Options screen appears. Check the box next to each option you want to install.
Boxes are grayed out if an option is not available for your site. See Also:
l
Diagnostics Utility on page 1883
l

l

an eSync security certificate. See Also: Managing eSync Security Certificates on
page 1521.
Using Ektron’s Developer SDK on page 1633

13. After choosing, click Install.
NOTE: eSync is only available if you have the eSync modifier in your license key.SDK is only
available if Visual Studio 2010 is installed on your server.

14. You are asked if you want to update your siteroot/widgets directory. Click Yes to
install the latest widgets. Be sure to rename any customized widgets in that folder. If
you do not rename them, they will be overwritten.
15. You are notified that files are moving to the starter site directory. The Choose
Destination Location screen appears.
16. Enter the path to your AssetManagement Directory.
NOTE: This dialog appears only when the setup cannot find the AssetManagement directory.
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17. If you chose to do so, your site is now being backed up. Next, the bin, Workarea and
other files are updated. Any missing permissions or Index catalogs are added.
WARNING! The previous version’s bin and Workarea folders are removed from your website. Any
customized files within these folders are lost. Do not store custom files in them unless absolutely
necessary. Even then, always keep a backup file in another folder.
18. Your web.config file is updated with information needed to run Ektron. If other
applications use the web.config file, the upgrade does not affect their sections.
19. A dialog asks if you want to upgrade the database. Select Yes to upgrade. If you select
No, the site will not work properly until the database upgrade has been run. To upgrade
the database at a later time, run the Site Setup and select Database Upgrade. The site
setup is located in Start > Programs > Ektron > CMS400vxX > Utilities >
CMS400 Site Setup.
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20. If you selected yes, the Database Upgrade Wizard appears. Click Install.

21. Enter the builtin user’s name and password. For information about the builtin user, see
Getting Started with Ektron on page 5.
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22. This screen prompts for database connection information.

Server—List the database server on this system. To set up the database on this server,
accept the default. Otherwise, enter a SQL or SQL Express server that already exists. For
SQL, this would typically be (local) if it’s installed on the local server. Otherwise, enter
the Server’s name. For SQL Express, enter (local)\SQLEXPRESS.
NOTE: This dialog appears if you are using SQL Authentication. If you are using Windows
Authentication, skip to the next step.
23. A dialog appears asking you to back up your database. See Also: Backing Up Databases
on page 48

24. If you clicked Yes, select the location of your database backup. If this path does not
exist on your database machine, the backup will fail. Otherwise, skip to the next step.
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IMPORTANT: If the backup fails, the following message appears: Warning! The install could not
backup your database. Please manually back it up now before continuing. In this case, you should
manually back up your database before clicking OK. See Also:
25. If your license key was not generated for the 8.x Release, you are prompted to enter an
8.x license key. If you do not have an 8.x license key:
l
Complete the upgrade.
l

Obtain an 8.x license key from Ektron (send email to license@ektron.com).

l

Log in as builtin user. See Also: Getting Started with Ektron on page 5

l

Insert the key into the Settings > Configuration > Setup screen's > General
tab >License Key(s) field.

26. If you selected a search provider in On the Search Provider screen, determine which
search provider you will use with Ektron.See Also: Setting Up a Microsoft FAST Search
on page 899; Setting Up Microsoft Search Server 2010 Express on page 864If your
server uses Windows 7, the only supported Search provider is Search Server Express. In
this case, first install Ektron then install the version of Search Server Express available
from C:\Program
Files\Ektron\CMS400vxx\Utilities\SearchServer\SearchServerExpressInstall.exe. on
page 42, the following screen appears.
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l

l

l

If you set up a search provider and installed Ektron search components, click Yes.
(This would typically be the case when an Ektron site on the server is already using
search).
If you have not set up a search provider, click No. After completing the Ektron
installation, install the search provider. Then, go to C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SearchServer\
Ektron.Cms.Search.Configuration.exe to configure Ektron to work with the
search provider. See Also:
o Setting Up Microsoft Search Server 2010 Express on page 864
o

Setting Up Microsoft Search Server 2010 on page 871

o

Setting Up a Microsoft FAST Search on page 899

If you set up a search provider but have not yet installed Ektron search
components, click No. Complete the Ektron installation then go to C:\Program
Files(x86)\Ektron\CMS400vxx\ Utilities\SearchServer
\Ektron.Cms.Search.Configuration.exe to configure Ektron with a search
provider.

See Also: Managing a Microsoft Search Server on page 925.
IMPORTANT: If your server uses Windows 7, the only supported Search provider is Search Server
Express. In this case, first install Ektron then install the version of Search Server Express available
from C:\Program Files (x86)\Ektron\CMS400vxx\Utilities\SearchServer\
SearchServerExpressInstall.exe.
27. If your Assets folder will have more than 50 PDF files, you should Install Foxit PDF Filter
on page 937 to speed up the indexing of PDF files.
After upgrading your site and rebuilding the solution, you are ready to use Ektron.
If you did not run the database upgrade or language update during the installation, you need
to do it manually. The next sections explain how to do that.

Backing Up Databases
To protect the information in your database, you should back it up before upgrading. During
the upgrade, Ektron attempts to create a backup of your database. If that fails, use the
following MSDN link for instructions on backing up and restoring your database via SQL
Server.
l
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NOTE: Links to options for restoring the backed-up database are provided at the bottom of the MSDN
resources.
Before restoring an SQL database, either stop the Ektron Windows service or force all
connections closed. You need to do this because the Ektron Windows Service accesses the
database. To view and update the status of the service, go to Computer Management >
Services and Applications > Services. For more information, see Ektron Windows
Service on page 1877.

Troubleshooting Upgrade Problems
Problem 1: After upgrade, Ektron does not load properly. Also, an error icon appears next to
your templates when you open the project in Visual Studio.NET, as illustrated below. The
problem is that your .NET references need to be updated.

Solution 1: To verify the problem, open the Ektron solution file in Visual Studio.NET
(webroot\siteroot\cms400sitename.sln; for example, cms400Intranet.sln) and look at
the template files. If your references are broken (as shown in the sample screen on the left),
delete all Ektron references. Then, add new references with the same name from the
webroot\siteroot\bin folder.
Problem 2: When viewing a page containing Ektron server controls or API calls, the page
returns a fatal error Compiler failed with Error Code 2000. Detailed compiler output
may say Fatal error BC2000: compiler initialization failed unexpectedly: The
filename, directory name, or volume label syntax is incorrect. This error message
might appear after an upgrade.
Solution 2: To remove the error message, open up your site's .sln file in Visual Studio. Then,
rebuild the solution using the Build > Rebuild solution menu option.
In this case, the error can be resolved by correcting the database settings in web.config.
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NOTE: To use SQL Authentication with Microsoft SQL server (as opposed to Windows Authentication),
you must have the database 'Security' properties set to allow "Windows and SQL Authentication." After
changing this setting, you must restart SQL Server for it to take effect.
Problem 3: After upgrading from Ektron version 4.8 or earlier, Metadata is no longer applied
or required when adding or editing content.
Solution 3: In Ektron version 4.8 or earlier, Metadata is applied globally. In later versions,
metadata is applied to each folder individually. Child folders can inherit the metadata from a
parent folder or they can have their own metadata settings. To set the metadata settings back
to global:
1. In the Workarea, click the site root folder.
2. Next, choose View > Folder Properties.
3. Click Edit Properties.
4. Click the Metadata tab.
5. Check the all of the appropriate check boxes for Assigned and Required Metadata.
6. Click Save.
If you have not broken inheritance on any of the folders, your metadata settings are applied
globally.
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WARNING! Securing your Ektron site is critical to you and to anyone using your site. Failure to
implement security measures can make your site vulnerable to cyber-attacks and other security threats.
You should complete the actions in this section to make Ektron as secure as possible.
Security updates are available for Ektron versions 8.02, 8.5, 8.6, 8.6.1, 8.7, and 9.10, including all service
packs from 8.02 to 9.10 SP1. For information, see Security Update 3.
Complete the actions in this section to secure Ektron.
l

Change the passwords for the Admin and Builtin users.

l

Update browsers to take advantage of advances in technology (including security).

l

Apply available service packs and updates for CMS, .NET, and Windows.

See Also: Additional Security Measures on page 59.
This section also contains the following topics.
Changing the Admin Password
Changing the Builtin Password
Changing the Everyone Group Permissions
Removing Sample Users and Sample Membership Users
Removing Ektron Users
Removing Membership Users
Disallowing Group User Accounts
Securing WebServices
Securing ServerControlWS.asmx
Securing Assets and User Folders
Defining the Default File Types for Assets
Enabling Firewall Use
Setting Up SSL
Additional Security Measures
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Changing the Admin Password
IMPORTANT: You should create your own Administrator user and delete the Admin user. Also, delete
unnecessary users from Ektron.
1. In the Workarea, choose Settings > Users.
2. Click the Admin user.
3. Click Edit Users.
4. Enter the new password in the Password and Confirm Password fields.
5. Click Save.

Changing the Builtin Password
NOTE: If you changed the builtin user password during the site setup, you do not need to change it again.
See Getting Started with Ektron on page 5 for additional information. Also, the “builtin” user does not
appear in the Users list. This user appears on the application setup screen.
1. In the Workarea, choose Settings > Configurations > Setup.
2. Click Edit.
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3. Find the Built In User field.
4. Enter the new password in the Password and Confirm Password fields.
5. Click Update.
NOTE: If you cannot sign in to Ektron because the builtin user password was changed and you do
not know the new password, use the BuiltinAccountReset.exe utility. This resets your
Ektron user / password to Builtin / Builtin. This utility is located in C:\Program
Files\Ektron\CMS400versionnumber\Utilities.

Changing the Everyone Group Permissions
By default, the root folder in Workarea provides the Everyone Group with all permissions
except Overwrite Library. You should review the permission needs of the Everyone Group
when you add a folder. See Also: Managing Folder Permissions on page 257
1. Go to Workarea > Folders > Folders. The View Contents for Folder "Root" appears.
2. Choose View > Properties.
3. Choose View Permissions (

). The View Permissions for Folder "Root" appears.

4. Click on the Everyone group. The Edit Permissions for Folder "Root" appears.

5. Check the permissions that you want and click Update.

Removing Sample Users and Sample
Membership Users
Ektron includes some sample users and sample membership users for evaluation and
demonstration purposes. Remove these users when they are no longer needed.
l

CMS users have access to the Workarea and can be content authors, administrators or
developers. These people count towards the number of users in your license.
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l

Membership users are typically people who only interact with your website but have
limited privileges to Ektron. They cannot use the Workarea and do not count towards the
number of users in your license.

NOTE: Some users in the following lists might not appear in your User list. Also, you might have sample
users that appear in your users lists. This depends on the version of the software you have installed.
Ektron Users—See Also: Managing Users and User Groups on page 1099
o

jedit

o

tbrown

o

jsmith

o

vs

Membership Users—See Also: Membership Users and Groups on page 1161
o

jmember

o

member@example.com

o

north

o

supermember

o

west

Removing Ektron Users
1. In the Workarea, choose Settings > Users.
2. Check the box next to each user that you want to remove.
3. Click Delete ( ).
4. Click OK.

Removing Membership Users
1. In the Workarea, choose Settings > Community Management > Memberships >
Users.
2. Check the box next to each user that you want to remove.
3. Click Delete ( ).
4. Click OK.

Disallowing Group User Accounts
A group account is an account that more than one person uses to log in to Ektron using the
same username and password. This is a serious security issue because it prevents you from
tracking user activities in your Workarea. Group accounts violate Ektron's license agreement.

Securing WebServices
You need to restrict Web services to specific IP addresses in IIS 7.
1. Run INETMGR (Start > Run then type INETMGR); IIS Manager appears.
2. Go to Your Website > Workarea > webservices.
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3. Double click on IP Address and Domain Restrictions.

4. In the Action pane, click Add Allow Entry. The Add Allow Restriction Rule dialog box
appears.
5. Select Specific IP Address and enter the IP address of the Web server and then click
OK.

6. In action pane, click Edit Feature Settings. The Edit IP and Domain Restrictions
Settings dialog box appears.
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7. Choose Deny from the drop-down and click OK.

Securing ServerControlWS.asmx
1. Run INETMGR (Start > Run then type INETMGR); IIS Manager appears.
2. Go to Your Website > Workarea.
3. Click Content View at the bottom of the window.
4. Right click ServerControlWS.asmx and choose Switch to Features View.
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5. Double click on IP Address and Domain Restrictions.

6. In the Action pane, click Add Allow Entry. The Add Allow Restriction Rule dialog box
appears.
7. Select Specific IP Address.
8. Enter the IP address of the Web server and then click OK.

9. In action pane, click Edit Feature Settings. The Edit IP and Domain Restrictions
Settings dialog box appears.
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10. Choose Deny from the drop-down and click OK.

Securing Assets and User Folders
As of version 8.50, user data is no longer indexed directly under the Assets folder. The
/users/ folder may expose user data, such as your users email addresses, when browsing to
this folder. Prevention was made within the Ektron handlers to address this issue in version
8.00, but you should review and remove the following folder [site root]\Assets\users if
you have version 8.50 or later. If the users folder exits, you should delete it.

Defining the Default File Types for Assets
Enable only the types of files that your website needs to support.
1. Go to Workarea > Settings > Configuration > Asset Server Setup.
2. Click on Edit File Types (

).

3. Add or remove the file types that your website needs, and click Save (

).

Enabling Firewall Use
l
l

l

Only open port 80 for standard websites. If you enable SSL, open port 443 also.
If you need FTP, open port 21, but restrict access to IP addresses that need to FTP
access to your server. The same applies for SFTP, FTPES, SSH for their respective ports.
Do not open remote desktop ports, SQL ports, SMTP ports, or any other port unless
absolutely necessary. Instead, use a VPN tunnel through the firewall for access to these
services. Even FTP can be made accessible through a VPN tunnel.

Setting Up SSL
Ektron strongly recommends configuring a secure socket layer (SSL), especially if you are
using Active Directory integration. SSL encrypts user names and passwords during
transmissions to the server that are otherwise sent as clear text to the Ektron server.
If your Web server does not have an SSL certificate installed, you need to install one. When
you set up an SSL certificate and configure Ektron to use it, the login page is launched in a
Secure Socket Layer. This section explains how to set up SSL for Ektron.
l
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To enable SSL, open your site's web.config file and set <add key="ek_UseSSL"
value="false" /> to true.
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l

To set up SSL in IIS, see How to Set Up SSL on a Server.

Additional Security Measures
The following best practices are also recommended.
l

Knowledge Base Article: Best Practices for Securing Ektron CMS400.Net

l

Encrypt cookies in web.config.
<add key="ek_EnableCookieEncryption" value="true" />

l

Enable Captcha for new user signup and other membership features. Captcha prevents
automated tools from creating unwanted data and traffic on your site. Set the
Membership server control's EnableCaptcha property to true. See Membership
Properties on page 1777.

l

Do not use IIS on a domain controller.

l

Install needed services only (for example, FTP, www, SMTP, NNTP).

l

Never use virtual directories across servers.

l

Never install websites on the system drive.

l

l

l

l

On all FTP sites, and WWW sites as needed, enable IP filtering. Use Ipsec filters to
accomplish this. See How to configure TCP/IP filtering in Windows 2000.
Remove NTFS write permissions wherever possible. See How IT Works: NTFS
Permissions.
Configure a default website with extremely secure settings (for example, Require SSL,
Integrated Windows authentication only, accessible from only one IP, NTFS permissions
to none on an empty home directory, and so on), then stop the site. This results in a
broken default website that 80% of hackers will blindly attack instead of your real
website.
Configure websites so that the host header matches the site's DNS name. Do this for
both HTTP and HTTPS. Do not configure the default website with host header. This should
prevent 90% of automated hacking tools from working by sending them to your crippled
default website. To do this:
1. Open IIS Manager.
2. Right-click your website icon.
3. On the Web Site tab, click Advanced.
4. Click the IP Address then Edit.
5. Enter the host header in the Host Header field.
6. Click OK to save.

l
l

Enable IIS auditing.
Enable W3 extended logging. Verify that the logged information is appropriate. Consider
enabling the following items:
o Date and time
o

IP address of client

o

IP address of server

o

Server port

o

Username

o

HTTP method used to access your site
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o

URI Stern

o

URI Query

o

Status of request

See Extended Log File Format and W3C Extended Log File Format (IIS 6.0)
l
l

Set permission for IIS logs to system and local administrators only
Remove write permissions to hklm\software for non-admin accounts.
o Administrators & System: Full
o

l

Everyone: Read/Execute

Restrict NTFS permissions to all executables on system.
o Administrators & System: Full
o

Users: Read/Execute

o

IUSR account: execute permissions sparingly

See How IT works: NTFS Permissions
l

l

60

Restrict NTFS permissions to any script interpreters, such as Perl.
o Administrators & System: Full
o

Everyone: Read/Execute

o

IUSR account: execute permissions sparingly

Ensure Everyone has read-only permissions for these directories
o Web root
o

%systemroot%

o

%systemroot%\system32

o

%systemroot%\system32\inetsrv

o

%systemroot%\system32\inetsrv\asp

o

%systemroot%\program files\common files\
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This section also contains the following topics.
Setting Up Development and Staging Environments
Copying the Site and Database to Other Servers
Setting Up the Certificate for IIS 7
Updating web.config to Use SSL
Managing the web.config File
Setting Up an Additional Site
Supporting Multi-Site Configurations
Creating Multiple Websites on a Single Server
Balancing the Load on Your Servers
Setting Up a User for the Ektron Database
Setting up the SMTP Server
Managing Logins and Passwords
Modifying Setup Information
Creating File System Folders with Ektron
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66
67
67
67
74
76
86
89
93
93
100
115
119

Setting Up Development and Staging
Environments
You can set up your Ektron website in the following ways. You decide which configuration is
the best fit for your particular situation.
This section also contains the following topics.
Virtual Staging
Same Server, Same Database
Same Server, Different Databases
Separate Servers, Same Database
Separate Servers, Separate Databases
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63
64
65
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Virtual Staging
Use Ektron’s approval process and scheduled publishing of content to manage when content
goes live.
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Same Server, Same Database

l

Best choice when changes to templates and library files are infrequent

l

No special implementation guidelines; just an installation on one server

l

When upgrading this type of site, make a temporary copy of the site (both display layer
and database) on a separate server to test the upgrade

Same Server, Same Database
l

l

Production and development/staging sites use separate copies of Ektron but reside on
same server and point to same database
Ektron’s settings, managed content, and library files are identical between sites

To set up this configuration:
l

To maintain file paths between sites:
o Create separate websites in IIS.
o

l

l

l

l

Assign different ports to the production and development/staging sites. For
example, the production site is http://www.example.com, and the
development/staging site is http://www.example.com:8080.

Both sites must use the same pathing relative to the Web root. For example,
www.example.com\Workarea\applicationAPI.asp and
dev.example.com\Workarea\applicationAPI.asp.
Because both sites use the same database, editing and publishing content on one site
affects the other site. As a result, the development/staging server always has the
freshest content.
Make the Ektronuploadedimages/ and uploadedfiles/ folders IIS virtual directories
that point to the same physical directory.
Template changes must be copied between sites. The best way to copy site templates
and other assets is eSync. This is described in Synchronizing Servers Using eSync on
page 1473.
o If eSync was not implemented and changes to these items are infrequent, you can
manually copy them.

To test and QA an upgrade, make a temporary copy of the site’s display layer on a separate
server connected to the development/staging database.
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If the development/staging database is the master, back it up before upgrading.

Same Server, Different Databases
l

l

Production and development/staging sites use separate copies of Ektron’s display layer,
reside on same server, but point to different databases
Changes to content, configuration, or library files made in one site must be copied to
other site

To set up this configuration:
l

To maintain file paths between sites:
l
Create separate websites in IIS.
l

l

l

l

l

l

64

Assign different ports to the production and development/staging sites. For
example, the production site is http://www.example.com, and the
development/staging site is http://www.example.com:8080.

l

Separate the databases for isolation.

l

One database is the master, and the other is a copy

l

Only edit content in the site connected to the master database

l

Remove the Ektron login page from the site connected to the copy database

To copy the Ektron database, your best choice is Ektron’s eSync feature. This is
described in Synchronizing Servers Using eSync on page 1473.
If you have not implemented eSync, copy site content using a replication tool for the
database.
l
SQL Server 2008 SDK Replication: See SQL Server Replication
Library files—Make sure the Ektron uploadedimages/ and uploadedfiles/ folders IIS
virtual directories point to the same physical directory.
Templates and other file system assets—The best way to move these is eSync. If that
was not implemented and changes to these items are infrequent, you can manually copy
them. For automated replication, use a product such as Microsoft Application Center.
Upgrading Ektron—To test an upgrade, make a temporary copy of the site’s display layer
on a separate server connected to the development/staging database. If the
development/staging database is the master, back it up before upgrading.
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Separate Servers, Same Database
l

Production and development/staging sites reside on separate servers, which point to the
same database.

l

Ektron settings, content, and library files are identical between sites.

l

Changes to templates must be copied between servers.

To set up this configuration:
l

l

l

Configure Ektron’s Load Balancing feature to copy uploaded images and files between
the servers.
The best way to move site templates and other assets is eSync. This is described in
Synchronizing Servers Using eSync on page 1473.
l
If that was not implemented and changes to these items are infrequent, you can
manually copy them. For automated replication, use a product like Microsoft
Application Center.
When upgrading Ektron:
1. Back up the file system of the development/staging server.
2. Make a temporary copy of the production server database.
3. Switch the development/staging site to use the copy.
4. Test and QA the upgrade on the development/staging server.

Separate Servers, Separate Databases
l

l

Production and development/staging sites are installed to separate servers and point to
different databases
Changes to content, configuration, or files must be copied between sites.
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To set up this configuration:
l

l

l

l

l

l

Both sites must have the same pathing relative to the Web root, for example,
www.example.com\Workarea\applicationAPI.asp and
dev.example.com\Workarea\applicationAPI.asp.
Separate the databases for isolation.
l
One database is the master, and the other is a copy
l

Only edit content in the site connected to the master database

l

Remove the Ektron login page from the site connected to the copied database

The best way to copy site templates and library files is eSync. This is described in
Synchronizing Servers Using eSync on page 1473.
l
If that was not implemented and changes to these items are infrequent, you can
manually copy them. For automated replication, use a product like Microsoft
Application Center.
To copy the Ektron database (containing HTML and XML content), your best choice is
Ektron’s eSync feature.
l
If you have not implemented eSync, copy site content using a replication tool for
the database, such as SQL Server 2008 SDK Replication. See SQL Server
Replication
Make sure the Ektronuploadedimages/ and uploadedfiles/ folders IIS virtual
directories point to the same physical directory.
When upgrading Ektron:
1. Back up the file system of the development/staging server
2. Make a temporary copy of the production server database
3. Switch the development/staging site to use the copy
4. Test and QA the upgrade on the development/staging server

Copying the Site and Database to Other Servers
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When your project is ready to be tested in house, move the site to a staging server. When the
project is ready to go live, move the site to a production (live) server. You can use the same
database for all environments. Back up that database often to keep it safe. Alternatively,
create a separate database for each server.
To create new environments:
1. On the same server or a separate server, create new folders for Ektron: C:/cmsstage
and/or C:/cmsproduct.
2. In IIS, create a new domain for each server. http://stage.example.com points to
c:/cmsstage and http://www.example.com points to c:/cmsproduct.
3. If all environments are on the same server, you do not need to copy other folders. But, if
you are using a separate server for each environment, copy the c:/assetcatalog and
c:/assetlibrary folders to the other servers.
4. For the database, access the SQL manager and make a backup of the development
database. Then, create new databases for staging and production. Finally, restore the
backup of the development database to the staging and production databases.
5. In the staging and production environments, open web.config. Then, update the
database connection information so that it points to the new databases.
6. Test the staging and production environments.

Setting Up the Certificate for IIS 7
See Configuring Internet Server Certificates (IIS 7).

Updating web.config to Use SSL
1. Open the siteroot/web.config file.
2. Find these settings.
<add key="ek_UseSSL" value="false" />
<add key="ek_SSL_Port" value="443" />

3. Set ek_UseSSL to true.
WARNING! If ek_UseSSL is true, but you did not install the certificate to the Web Server, you
cannot log into Ektron.
4. Set the ek_SSL_Port to 443 (unless you specified another SSL port).
5. Find the following line: <add key="WSPath" value="http://server name/site
name/Workarea/ServerControlWS.asmx" />
6. Change http to https.
7. Save and close the file.

Managing the web.config File
Ektron’s web.config file lets you control many key functions of your content management
system. When you install Ektron, web.config is placed into webroot/siteroot.
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If your server is currently running another .NET application, you must merge that web.config
file with this one. To distinguish Ektron’s tags, they begin with ek_ and reside within the
<appSettings> tags of the web.config file.
The following sections show the settings in the web.config file.
Analytics
l

See Google Web Analytics on page 626 and Templates on page 606.

Connection Strings
For SQL Server—Use this connection string to define an SQL server.
l

name—ektron.DbConnection

l

providerName—System.Data.SqlClient

l

connectionString—this part of the connection string contains the following element.

l

server—the name of the database server to which Ektron is installed. If installed
locally, the value is localhost. This value is set during installation, at the Host screen.

l

database—use the name of the database.

l

Integrated Security—use True or False. True—use integrated security.

l

user—If required, specify the username used to connect to the DSN. This user account
must have at least read and write permissions to the database.
NOTE: This value can be blank if you are using Windows authentication.

l

pwd—If required, specify the password for the username given. It should match your
database name.
NOTE: This value can be blank if you are using Windows authentication.
IMPORTANT: After changing any database settings, you must stop and restart the Ektron
Windows Service. See Also: Ektron Windows Service on page 1877

appSettings
l

l

l

l

l
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ek_appName—The name of the application, CMS400. You typically would not change
this value.
ek_appPath—This element is prefixed by the ek_sitePath value and describes the
location of the workarea folder. This file stores external applications (such as eWebDiff),
templates, and the images folder.
ek_appImagePath—The folder that stores the images within Ektron, such as toolbar
icons. Only change this value if you need to move the images folder to another location.
This value is prefixed by the value set in the ek_appPath variable. By default, ek_
appPath is set to webroot/cms400Min/workarea/. So, by default, this folder is set to
webroot/cms400Min/workarea/images/application/.
ek_appXSLTPath—The folder that stores XSLTs. Only change this value if you need to
move the XSLT folder to another location. This value is prefixed by the value set in the
ek_appPath variable. By default, ek_appPath is set to webroot/cms400Min/workarea/.
So, by default, this folder is set to webroot/cms400Min/workarea/Xslt.
ek_buildNumber—This value is set by the installation program. You typically would not
change it.
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l

l

l

ek_cmsversion—This value is set by the installation program. You typically would not
change it.
ek_LDAPMembershipUser—Integrate membership users with LDAP or Active
Directory. Set the value to True for Membership Users to be authenticated using
LDAP/AD.
ek_RedirectFromLoginKeyName—Provides a mechanism to return from the login
page to the previous page, specify the query string key-name. By default the value is
RedirectUrl. Currently, the redirect works in 2 instances.
1. When a user tries to use a forum but is not logged in, it sends them to a login page
and returns them. The value in this key used in conjunction with the ek_
RedirectToLoginURL key sends the user from a forum page to a login page and
back to the previous page.
For example, a user tries to reply to a forum post, but the user is not logged in. The
user is sent to the login page and then returned to the original page.
2. When a user sends a private message to another user or group administrator from
the SocialBar server control, the user is returned to the page where the user clicked
private message once the message is sent.
For example, you visit a community group’s page and click Private Message
Admin. You are directed to the private message screen. When you click post, you
are returned to the community group’s page. For additional information, see Server
Control Reference on page 1636.

l

ek_RedirectorInstalled—Turns the redirector on or off. Turning the redirector on
enables the option of aliasing the URL of your website. The default is False.
o True—Aliasing turned on
o

False—Aliasing turned off

See Also: Creating User-Friendly URLs with Aliasing on page 835
l

ek_RedirectorManualExt—Set a comma-delimited list of Web page extensions for
which you will create aliased pages. For example, .aspx,.htm,.html. By default, the
list contains.aspx. See Also: Creating User-Friendly URLs with Aliasing on page 835
NOTE: You can enter one or more extensions. Each extension must begin with a period, and the
last extension must be followed by a comma (,).

l

l

l

ek_RedirectToLoginURL—The URL of the login page to automatically redirect to when
a site visitor is not logged in as a user or membership user.
ek_sitePath—The location of Ektron relative to the Web root. This value is set during
installation at the Site Path Directory screen. If you move Ektron to another folder, you
must update this value.
ek_TreeModel—Choose whether or not to use Ajax for the folder tree in the Workarea.
o 0—use the legacy folder tree in the Workarea.
o

1—use Ajax for the folder tree in the Workarea.
NOTE: This key has been removed from the web.config file. However, you can still use
this key by adding it between the <appSettings> tags. For example, <add key=”ek_
TreeModel” value=”0”> changes the folder tree in the Workarea back to legacy.

l

ek_workareaDateFormat—Choose how you want to display dates in some areas of
the Workarea.
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l

l

l

o

long—for example, Tuesday May 21, 2013

o

short—for example, 5/21/2013

ek_xmlPath—The location of the xmlfiles directory. The ek_sitePath path is prefixed
to this location. You would only change this value if you want to move the location of the
xml files relative to the Web root.
GoogleMap—Enter connection information for using Google Maps with the Mapping
feature in Ektron. See Also: Server Control Reference on page 1636
VirtualEarthMap—Enter connection information for using Bing Maps for Enterprise with
the Mapping feature in Ektron. See Also: Server Control Reference on page 1636

Images
These images appear before the user signs in, so cannot be stored in the database. Update as
needed. Their location is set in the ek_appImagePath variable. See Also: ek_appImagePath.
l

ek_Image_1—close button

l

ek_Image_2—small login button

l

ek_Image_3—big login button

SMTP server configuration
See Installing Ektron on page 9
l

ek_SMTPPass—The password set up to send and receive email

l

ek_SMTPPort—The port your system uses to retrieve email

l

ek_SMTPServer—The server that processes email

l

ek_SMTPUser—The username set up to send and receive email

Mail Format
l

ek_MailFormat—The format of the email created in Ektron.HTML generates email in
HTML format, while Text generates plain text email.

SSL Support
See Setting Up Ektron on page 61
l

ek_SSL_Port—SSL port used by Web server.

l

ek_UseSSL—Determines if server will use SSL for security

Active Directory Server Configuration
See Using Active Directory with Ektron on page 1127
l

ek_ADAdvancedConfig—Enable Active Directory advanced configuration.

l

ek_ADEnabled—Whether Ektron uses Active Directory support.

l

ek_ADPassword—Password for the Active Directory server.

l

ek_ADUsername—User name for the Active Directory server.

l

ek_AUTH_Protocol—The directory access protocol used with the Active Directory
feature. The default value is LDAP. Other protocols are GC (global catalog) and WINNT.

Menu Settings
l

70

ek_MenuDisplayType—Determines the appearance of the content menu that appears
within every content block after the user signs in.
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NOTE: This setting only works if ek_UserMenuType is set to zero (0).

l

l

0—Horizontal—menu icons are arranged horizontally

l

1—Vertical—menu icons are arranged vertically and include the tooltip text

ek_UserMenuType—Determines the appearance of the content menu that appears
within every content block after the user signs in.
o 0—New dynamic menu—only appears when user moves cursor over content block
o

1—Old classic menu—always appears

o

2—Menu without borders—a silver pin head appears above content that has a menu
available. Hovering over this pin produces a menu.

See Also: Working with Ektron Content on page 287
Multilingual Settings
l

l

ek_DefaultContentLanguage—Sets the 4 digit, decimal representation of the default
content language. For example, American English is 1033. See Also: Setting the Default
Language on page 1061
ek_EnableMultilingual—Enable or disable multilingual content support.
o 1—enable
o

0—disable

See Also: Enabling/Disabling Support for Multiple Language Content on page 1059
l

ek_ServerURL—Mainly used in Web services to determine a remote server location.
For example, in a Web farm environment, the content server can reside in a remote
location. In this case, the developer’s content is replaced with this value, so all <img
src=””…/> and <href…. references point to server named here instead of the local one.

Machine Translation
Lets you enter the path to the Google Translation Service API key. See Also: Enabling Machine
Translation on page 1072
Miscellaneous Settings
l

l

ek_assetPath—The folder that stores assets. Only change this value if you need to
move the Assets folder to another location. Note that this value is prefixed by the ek_
appPath value. By default, ek_appPath is set to webroot/CMS400Min. So, by default,
this folder is set to webroot/CMS400Min/assets.
ek_BatchSize—The number of files that can be uploaded at one time. The default is 4,
but it can be any non-negative number.
NOTE: Users can upload any amount of files. The system handles them 4 at a time.

l

ek_CacheControls—Enable or disable caching for Ektronserver controls. See Also:
Caching with Server Controls on page 1629
o 0—Disable
o

l
l

1—Enable

ek_EditControlMac—Defines the editor used by a Macintosh operating system user.
ek_EditControlWin—Defines the editor used by a Microsoft Windows operating system
user. Choice are:
o ContentDesigner—Use the eWebEdit400 editor. This editor does not require an
ActiveX installation on the user’s computer.
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l

l

o

eWebEditPro—Use the eWebEditPro editor. This editor requires an ActiveX install
on the user’s computer.

o

Aloha (default)—This editor is installed by default. See Also: Editing in Ektron on
page 207

ek_EnableMessageBoardEmail—Set to True to enable e-mail notification when a
user posts a message to a user or community group’s message board. If true and a user
posts to another user’s message board, the board's owner is notified. If true and a user
posts a message to a community group’s message board, all group members are
notified. This setting does not affect content messages. See Also: Sending Notifications
to a Community on page 1194
ek_helpDomainPrefix—The path to the help files. By default, help files are located on
an external server and the path is
http://documentation.ektron.com/cms400/v[ek_cmsversion]/webhelp
Change this path if you install help files on local servers. See Also: Installing Help Files
on a Local Server on page 32.

l

l

l
l

l

l

ek_InvitationFromEmail—The “From” email address used when a user sends an
Invitation. Invitations are emails that are sent to non-system users asking them to join
your site. See Also: Invite on page 1751 server control.
ek_LinkManagement—This setting determines if Ektron uses linkit.aspx when
inserting a quicklink. By default, it is set to false. If set to true, when a user inserts a
quicklink, Ektron inserts a special link instead of a quicklink. A special link determines
the correct quicklink to use when a site visitor clicks it. For example, a user adds a
content block to folder A. A quicklink to that content is a.aspx?id=10. Later, if an
administrator changes the folder’s template but doesn’t update the quicklink within the
content block, the quicklink is broken. To avoid this problem, enable link management.
ek_LogFileName—Path to the log file name for the message queue
ek_loginAttempts—Ektron has a login security feature that, by default, locks out a
user after 5 unsuccessful attempts to log in. See Also: Getting Started with Ektron on
page 5
ek_LoginScreenWidth—The width of the login screen in pixels. You may need to widen
the screen if you are using Active Directory and database names are long.
ek_PageSize—This setting determines the maximum number of items that can appear
on a page before it “breaks.” When a page breaks, additional entries appear on another
screen, and the following appears near the bottom of the list:
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

NOTE: The above text changes depending on the page you are viewing.
l
l

ek_QueueName—Path to the message queue.
ek_ShowWorkareaRetErrorReferrer—Choose whether to enable referrer debug
information on the RetError.aspx page.
o True—enable
o

l
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False—disable

ek_ToolBarFormatTag— This setting only applies after a user signs in to your site.
Change this setting if the colored border that surrounds content looks wrong. (The border
color indicates the content’s status.) By default, <table> tags create the border. If the
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border looks wrong or inappropriate, change setting to div. If you do, <div> tags are
used to draw the border instead of <table> tags. This change typically solves the
problem.
l

l

l

ek_WorkareaLibSearchResultMode—Sets the Workarea Library search-results
mode.
o text—returns a text only version of the library search results.
o

mixed—returns text and images associated with library search results.

o

graphical—returns a images associated with library search results.

ek_XliffVersion—Define the XLIFF version to use when exporting files. See Also:
Exporting Content to XLIFF on page 1072
WSPath—Determines the location of the Web services page used by the server controls
at design time.

system.diagnostics
l

LogLevel—Enter a numeric value that determines the level of message logging. By
default, diagnostic messages are logged in the Event Log. Choices are:
1—Error: log errors.
2—Warning: log errors and warnings.
3—Information: log errors, warnings and informationals.
4—Verbose: Everything is logged.

ektronCommerce
See Conducting eCommerce on page 1279
l

l

ek_ecom_ComplianceMode—When set to true, your site is Security Compliant. This
means the Workarea is encrypted in an SSL session and Logging is started.
ek_ecom_DefaultCurrencyId—Select the default currency and enter its Numeric ISO
code. This should be done before creating your product catalog.
WARNING! Do not change the default currency or measurement system after your eCommerce
site is live.
See Also: The Default Currency on page 1308

l

l

ek_ecom_TestMode—When set to true, payments are sent to a test gateway instead
of the actual one.
ek_MeasurementSystem—Select whether to use English or Metric measurements for
your packages. See Also: Configuring Packages on page 1330

mediaSettings
See Also: Managing Multimedia Assets on page 318
l

l

l

application/x-shockwave-flash—Define the relationship between the Shockwave
Flash mime type and the Flash player.
audio/mpeg—Define the relationship between the MPEG audio mime type and the
Windows Media Player.
audio/x-ms-wma—Define the relationship between the MS-WMA mime type and the
Windows Media Player.
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l

l

l

audio/x-realaudio—Define the relationship between the realaudio mime type and the
Real player.
audio/x-wav—Define the relationship between the WAV mime type and the Windows
Media, Quicktime and Real players.
audio/x-wav-default—Define the relationship between the WAV default mime type
and the Windows Media Player.

l

Flash-CLSID—The class ID for the Flash player.

l

Flash-Codebase—Location of the code base plug-in for Flash player.

l

Quicktime-CLSID—The class ID for the Quicktime player.

l

Quicktime-Codebase—Location of the code base plug-in for Quicktime player.

l

Realplayer-CLSID—The class ID for the Real player.

l

Realplayer-Codebase—Location of the code base plug-in for Real player.

l

l

l

l

l

l

l

l

l

l

video/mpeg—Define the relationship between the MPEG video mime type and the
Windows Media Player.
video/quicktime—Define the relationship between the Quicktime mime type and the
Quicktime player.
video/x-avi—Define the relationship between the AVI mime type and the Windows
Media, Quicktime and Real players.
video/x-avi-default—Define the relationship between the AVI default mime type and
the Quicktime player.
video/x-msvideo—Define the relationship between the msvideo mime type and the
Windows Media, Quicktime players.
video/x-msvideo-default—Define the relationship between the msvideo default mime
type and the Windows Media Player.
video/x-ms-wmv—Define the relationship between the MS-WMV mime type and the
Windows Media Player.
video/x-realvideo—Define the relationship between the realvideo mime type and the
Real player.
WindowsMedia-Codebase—Location of the code base plug-in for Windows Media
Player.
WindowsMedia-CLSID—The class ID for the Windows Media Player.

Miscellaneous
l

l

l

HttpHandlers—This section sets how the URL Aliasing feature handles URLs with certain
extensions. If you have any extension you do not want aliased, add it below the following
line using the same syntax.
add verb="*" path="*.png" type="URLRewrite.StaticFileHandler,
Ektron.Cms.URLRewriter" />
maxRequestLength—This setting determines the maximum size of files that can be
uploaded to your server. The default setting is 204,800 kilobytes, or 200 MB. Enter the
desired value in kilobytes. To convert megabytes to kilobytes, go to
OnlineConversion.com.
session state—mode—determines the storage option for session data. Ektron supports
all session-state modes listed in this article: Session-State Modes.

Setting Up an Additional Site
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After installing Ektron, it is easy to create another site. While creating the new site, you can
create a sample or minimal site and database. To create a site for your content, you typically
install a minimal site and database, then create your Web page templates. Later, add users
and content.
1. Set up New Site.
a. Create a new folder in the Web root folder to contain the site files.
b. Choose Start > Programs > Ektron > CMS400 > Utilities > SiteSetup from
the Windows Start menu.
c. Follow the steps for creating a new site, as described in Setting Up Ektron on
page 61. When prompted to select a folder to which you want to install the files,
choose the folder you created in Step 1.
2. Set up New Database. After installing an Ektron site, it is easy to create a new database.
You can create either a sample or minimal database. When creating a database for your
content, you typically install a minimal database.
a. Choose Start > Programs > Ektron > CMS400 > Utilities > SiteSetup from
the Windows Start menu.
b. On the Setup Type screen, choose CMS400 Database Setup.

c. Follow the steps for creating a new database, as described in Setting Up Ektron on
page 61.
3. Create Project in Visual Studio.NET. To work with the new site in Visual Studio.NET, you
must create a new project for it. To do that:
a. Navigate to the folder that contains the new site.
b. Double click Ektron’s solution file. If you are using the minimal database, the file is
CMS400Min.sln.
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At this point, you can build the project and log in. If you cannot log in because you
have not set up the license key, use the builtin account: by default, the username is
builtin and password is builtin.
IMPORTANT: You should only use the builtin account temporarily. As soon as possible, you
should insert the license key and log in under a user name assigned in Ektron.
To learn about creating templates and using server controls, see Working with
Ektron Server Controls on page 1605.

Supporting Multi-Site Configurations
Ektron’s multi-site support feature lets you set up and manage several websites under one
CMS. (The multi-site support feature does not support multiple databases.) You can manage
content in the additional site the same way you work with content in the root site. You log into
a root site then begin editing content in the additional site. Regardless of which site you are
using, you can use the common library to insert hyperlinks, images, files, and quicklinks.
IMPORTANT: Place any file (such as an XSLT file) that needs to be shared among sites in a multi-site
environment in a virtual folder. Also, you cannot create a hyperlink within content, a collection, menu, and
so on to a form that resides in another site.
PREREQUISITES
l
l

All sites reside on the same server
Each site requires a multi-site license key. To purchase additional licenses,
contact Ektron sales.

Advantages of multi-site configurations:
l

l

The URL can indicate the nature of the site to visitors
o www.example.com
o

support.example.com

o

forums.example.com

All sites can share a single database
o common content, but appear within their own site and templates
o

the library of images and files. These files can be stored once; authors can insert
them into content from any site.

In the Workarea, sites appear in Ektron’s folder structure, and their icon is a globe. A folder
to which a production domain is assigned is a domain folder. Links to content in a domain
folder are activated via linkit.aspx, which redirects to the appropriate domain name and
uses the appropriate template for the folder or content.

There are 2 ways to install multi-site support. (The automatic setup is easy to use and
minimizes issues.)
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l

Automatic Multi-Site Setup below

l

Manual Multi-Site Setup on page 79

Automatic Multi-Site Setup
IMPORTANT: Before creating a multi-site configuration, you must have installed an Ektron website. All
installed folders must remain in that site. The original site cannot have virtual folders.
1. Create each new site in IIS. Convert each site folder to an application. See
http://www.iis.net/learn/manage/creating-websites.
2. Run the Multi-Site Setup Wizard.
a. Double click C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\MultiSiteInstall\Multisite.exe.
b. Use the pulldown to select the site you created in Step 1.
c. Select your host.
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d. Enter a path to the new site.

e. Identify your main website; that is, the site to which this multi-site is being added.

f. When prompted to add a multi-site key, click Yes.
g. Enter a license key for the new site. This step copies the new site's license keys to
the database.
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h. Enter information about the new site's database.
i. Follow the remaining screens in the wizard.
3. Assign multi-site capabilities in Ektron.
a. Log in the Workarea.
b. Click Content.
c. Click the site root folder.
NOTE: Site folders must reside within the site root folder.
d. On the View Contents of Folder screen, create a new top-level site folder for each
site by choosing New > Site.
e. Assign site folder properties as you did for the root folder. The Multi-site
Configuration fields appear on the lower section of the screen.

f. In the Staging Domain field, insert your staging domain.
IMPORTANT: Production and staging URLs must be unique across multi-sites. In other
words, in a multi-site configuration, one site's production or staging URL cannot be the same
as another site‘s production or staging URL.
g. In the Production Domain field, insert your production domain.
h. Click Add Folder. Within Ektron, new sites are indicated by a globe icon.

Manual Multi-Site Setup

Ektron 8.7

79

Setting Up Ektron

Ektron provides a utility (Multisite.exe) that automatically completes Steps 1 and 2 for
you. If you run this utility, you only need to complete Step 3. The utility is located
C:\Program Files\Ektron\CMS400vxx\Utilities\MultiSiteInstall.
1. Create New Folders in the File System.
IMPORTANT: Before creating a multi-site configuration, you must have installed an Ektron
website. All installed folders must remain in that site. The original site cannot have virtual folders.
a. Using Windows Explorer, navigate to the C:\Inetpub\wwwroot folder.
b. Create a new folder for each site.

c. Copy the following Ektron files and folders from the original site to the new, multisite folder.
l
all individual files (not subdirectories)
l
l

all .config files in all directories under the site root
these subdirectories:
l
bin
l

WorkArea

l

widgets

l

App_Code

l

AssetManagement

l

App_GlobalResources

d. Within each new site folder, open the web.config file and update the ek_sitePath
and WSPath elements with your Ektron site path.
For example, if your Ektron site is in the website root, enter slash (/). If it is in a
subdirectory of the website, enter the subdirectory name. For example, if the
website root is C:\inetpub\wwwroot and you have a subdirectory called
CMS400Min, enter CMS400Min as the site path.
2. Create new sites in IIS. Convert each site folder to an application. See
http://www.iis.net/learn/manage/creating-websites.
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3. Create Virtual Folders in IIS.
In IIS, for each new website, create one new virtual folder for the following shared
folders:
l

assets

l

privateassets

l

uploadedfiles

l

uploadedimages

These folders are created when you install Ektron. If you did a normal installation, they
reside under the site directory. For example,
C:\Inetpub\wwwroot\siteroot\uploadedimages.
To create virtual versions of these folders, see the following section.

Creating Virtual Folders in IIS 7
a. In IIS, select the new site folder you created.
b. Right click the mouse and choose Add Virtual Directory.
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c. Identify the corresponding subfolder in the root folder.

d. Follow this procedure for all folders: assets, privateassets, uploadedfiles,
uploadedimages.
4. Set file system permissions on new folders.
a. Using Windows Explorer, navigate to the new folder(s) you created in Setting Up
Development and Staging Environments on page 62.
b. Right click the folder and click Properties.
c. Click the Security tab.
d. Click Advanced.
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e. Check Include Inheritable Permissions from this object's parent.

5. Install the aspnet_isapi.dll file.

Installing the aspnet_isapi.dll File in IIS 7
a. In the Connections window, select your application.

b. Make sure that the Features view is selected.
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c. Double-click Handler Mappings.

d. Click Add Wildcard Script Map.
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e. The Add Wildcard Script Map dialog appears.

f. In the Executable field, browse to
C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll.
g. Enter a name.
h. Click OK.
6. Assign multi-site capabilities in Ektron.
a. In the Workarea, click Content.
b. Click the site root folder.
NOTE: Site folders must reside within the site root folder.
c. Create a new top-level site folder for each site by choosing New > Site.
d. Assign site folder properties as you did for the root folder. The Multi-site
Configuration fields appear on the lower section of the screen.
e. In the Staging Domain field, insert your staging domain.
IMPORTANT: Production and staging URLs must be unique across multi-sites. In other
words, in a multi-site configuration, one site's production or staging URL cannot be the same
as another site‘s production or staging URL.
f. In the Production Domain field, insert your production domain.
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g. Save the screen. In Ektron, new domains are indicated by a globe icon.

Creating Multiple Websites on a Single Server
NOTE: This text is adapted from Microsoft’s IIS help.
IIS lets you create multiple websites on a single server.
This section also contains the following topics.
Before Adding a Website
Adding a Website
Using Website Creation Wizard with IIS 7
Adding a Website with a Command Line Script in IIS 7

86
87
87
89

Before Adding a Website
Adding a website to a server requires careful preparation before running the Website Creation
Wizard. Consider these recommendations.
l

l

l

l

l

Review the methods of hosting multiple websites, and determine which one is
appropriate for your environment.
Multiple websites can use the same IP address. But if you decide to use a unique IP
address for the new website, obtain a static IP address from your organization or ISP.
Then, configure the server’s TCP/IP settings.
If you use a host header name to identify the new website, select a unique name. On a
private network, the host header can be an intranet site name. But on the Internet, the
host header must be a publicly available Domain Name System (DNS) name, such as
support.microsoft.com. Register a public DNS name with an authorized Internet name
authority.
Update your name resolution system (typically DNS) with a new record that contains the
new IP address and site name. For more information, see Domain Name Resolution in
IIS help.
Standard Internet services use TCP port 80 by default. It is not recommended to use any
other port for HTTP services.
If you use a non-standard TCP port number to identify a new website for special
situations (such as a private website for development/testing), select a TCP port number
above 1023. In this way, the number does not conflict with well-known port numbers
assigned by the Internet Assigned Numbers Authority. (For more information about IANA
and port assignments, see List of TCP and UDP port numbers.)

l

86

Use Windows Explorer to create a home directory for the content. Create subdirectories
to store HTML pages, image files, and other content as needed.
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To organize home directories for multiple websites on one server, create a top-level
directory for all home directories, then subdirectories for each site.
You can create a home directory
l

on the local server

l

as a uniform naming convention (UNC) path on a network share

l

as a URL that redirects clients to a different Web server

You can also create virtual directories that map to physical directories. For more
information, see “Setting Home Directories” and “Using Virtual Directories” in IIS help.
l

l

Determine whether to generate the website’s identification number incrementally or
from the website name.
Create a home page that clearly identifies the new site.

Adding a Website
IIS provides 2 methods for adding a new website.
l

The Website Creation Wizard

l

The iisweb.vbs command-line script

IMPORTANT: You must be a member of the Administrators group on the local computer to perform the
following procedure (or procedures), or you must have been delegated the appropriate authority. As a
security best practice, log on to your computer using an account that is not in the Administrators group,
and then use the Run as command to run IIS Manager as an administrator. From the command prompt,
type runas /user:administrative_accountname "mmc %systemroot%\system32\inetsrv\iis.msc".

Using Website Creation Wizard with IIS 7
1. In IIS Manager, expand the local computer, right-click the Sites directory, and click
Add Web Site.
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2. Click Next. The following dialog appears.

l
l

l

l
l

l

88

Site Name—Enter the website name.
Application Pool—Click Select if you want to select a different application pool
than the one listed in the Application Pool box. If you do, the Select Application
Pool dialog box appears. Select an application pool from the list and then click OK.
Physical path—Enter the physical path to the website's folder. Or, click the
browse button (...) to navigate the file system and find the folder.If the physical
path that you enter is to a remote share, click Connect as... to specify credentials
that have permission to access the path. If you do not use specific credentials,
select the Application user (pass-thru authentication) option in the Connect As
dialog.
Type—Select the protocol for the website from the Type list.
IP Address—The default value in the IP address box is All Unassigned. If you
must specify a static IP address for the website, type the IP address in the IP
address box. All Unassigned refers to IP addresses assigned to a computer but
not a specific site. The default website uses all IP addresses not assigned to other
sites. Only one site can be set to use unassigned IP addresses for a given port
number. For more information on how sites are identified, see Creating Multiple FTP
Sites in IIS help.
Port—Enter a port number. The TCP port is assigned to port 80 by default. To use a
nonstandard port number to create a unique identity for a private website, enter a
new port number above 1023.
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l

l

Host name—Optionally, enter a host header name for the website.If you are
adding additional sites to a single IP address by using host headers, you must
assign a host header name containing the full name of the site, for example,
www.ektron.com.
Start website immediately—Check this box if you do not have to make any
changes to the site and want it to be immediately available.

Adding a Website with a Command Line Script in IIS 7
To add a site, use the following syntax:
appcmd add site /name: string /id: uint /physicalPath:
string /bindings: string

The variable namestring is the name, and the variable iduint is the unsigned integer that you
want to assign to the site. The variables namestring and iduint are the only variables that are
required when you add a site in Appcmd.exe.
NOTE: If you add a site without specifying values for the bindings and physicalPath attributes, the site
will not be able to start.
The variable physicalPathstring is the path of the site content in the file system.
The variable bindingsstring contains information that is used to access the site, and it should
be in the form of protocol/IP_address:port:host_header. For example, a website binding
is the combination of protocol, IP address, port, and host header. A binding of http/*:85:
enables a website to listen for HTTP requests on port 85 for all IP addresses and domain
names (also known as host headers or host names). On the other hand, a binding of
http/*:85:marketing.contoso.com enables a website to listen for HTTP requests on port 85
for all IP addresses and the domain name marketing.contoso.com.
To add a website named contoso with an ID of 2 that has content in c:\contoso, and that
listens for HTTP requests on port 85 for all IP addresses and a domain name of
marketing.contoso.com, type the following at the command prompt, and then press Enter.
appcmd add site /name: contoso /id:2 /physicalPath: c:\contoso
/bindings:http/*:85: marketing.contoso.com
See Also: Appcmd.exe (IIS 7).

Balancing the Load on Your Servers
Load Balancing has 2 purposes:
l

l

Provides redundancy for your website—if one server fails, a second can still handle
requests
Balances requests—distributes requests across multiple servers

To enable load balancing, set up several servers that include the same files.
IMPORTANT: The physical path to the Ektron website must be the same on all servers being load
balanced. Also, sticky sessions must be enabled.
Then, purchase load balancing equipment to evenly distribute content requests among the
servers. Whenever an image or file gets uploaded to your website, regardless of the Web
server the user is working on, the asset is replicated on both servers.
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The client browser is unaware that more than one server is involved. All URLs point to a single
website. The load balance software resolves them.
Ektron provides different strategies for load balancing library images and files and DMS
assets.
See Also: eSync in a Load Balanced Environment on page 1556
This section also contains the following topics.
Load Balancing Library Images and Files
Load Balancing Assets
Refreshing Load Balanced Files
Load Balancing Status
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Load Balancing Library Images and Files
Library load balancing is important when your configuration consists of 2 or more websites
that share one database. Library files are not saved in the database but in the site root folders
uploadedfiles and uploadedimages.
To support load balancing, library files on all servers must be identical. To maintain this state,
whenever a user uploads an item to the library, it is replicated on all other servers. After
following the setup instructions, whenever an image or file is added to the library of one
server, it is copied to the corresponding folder on other servers in the configuration.
1. Open the file C:\Program
Files\Ektron\EktronWindowsService40\Ektron.ASM.EktronServices40.exe.confi
g using a word processor such as Notepad.
2. Set the value of the LibraryLoadBalanced property to 1.
3. Set the value of the LoadBalServerCount property to the number of servers in your load
balance cluster.
4. Save the config file.
5. Restart the Ektron Windows Service.
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See Also: Ektron Windows Service on page 1877

Load Balancing Assets
Asset load balancing is important when your configuration consists of 2 or more websites that
share one database. Ektron balances requests to work with assets from multiple servers by
ensuring that each server has a copy of every asset.
After setting up asset load balancing, any asset added to one server is copied to the
corresponding folder on other servers in the configuration. There is no limit to the number of
servers that can be load balanced.
The following list shows the load balance settings summary on all servers.
<webroot>\AssetManagement.config
l

LoadBalanced=1

l
(0 to disable)
c:\Program
Files\Ektron\Ektron.ASM.EktronServices40\
Ektron.ASM.EktronServices40.exe.config

l

LibraryLoadBalanced=1

l

LoadBalServerCount=x

Where x is the number of servers in load balanced configuration
To set up load balancing for assets, follow these steps on all servers that are load balanced
together.
1. Within the site root folder, open the AssetManagement.config file using a word
processor such as Notepad.
2. Change the value of the LoadBalanced element to 1.
3. Save the config file.
4. Open the following file using a word processor such as Notepad:
C:\Program Files\Ektron\EktronWindowsservice40\
Ektron.ASM.EktronServices40.exe.config
5. Set the value of the LibraryLoadBalanced property to 1.
6. Set the value of the LoadBalServerCount property to the number of servers in your load
balance cluster.
7. Save the config file.
8. Update these files for each server in the load balance cluster.
9. Sign on to Ektron. This action sets up the load balance software in the database.

Refreshing Load Balanced Files
PREREQUISITE
You must be an Administrators group member.
Asset and Library files may become out-of-date or lost due to equipment failures, power
outages, or other events. In addition to your Load Balance system, Ektron provides a way to
refresh the files contained in the DMS Assets folders and Library Files and Images folders.
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NOTE: Open Port 8732 on load balanced servers for load balancing refresh to work properly.
IMPORTANT: Previously, Ektron used Port 6079 for communication between load balancing servers.
Starting with version 8.01, this port is no longer used and can be closed in your firewall.
To refresh the load balanced files:
1. In the Workarea, go to Settings > Configuration > Load Balancing. The page looks
like this.

2. Click Start. A status screen appears.

3. Verify that the status screen shows servers you expect to be refreshed. Server name
WS10155 is circled in the example.
IMPORTANT: If you click Start and the screen quickly returns and files do not refresh, or if a server
is missing from the status list, check your Load Balancing settings in
Ektron.ASM.EKtronServices40.exe.config.
4. Click Close when finished viewing the status.

Load Balancing Status
To check the Load Balancing Status, click the Scroll button.
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The Status screen shows the Load Balancing screen showing either the previous refresh or the
current refresh in progress.

Setting Up a User for the Ektron Database
The installation automatically sets up user permissions based on data collected during setup.
However, if there is a problem with user permissions, this section describes how to install
manually.
NOTE: If you are using SQL Authentication, you only need to set up the SQL user. If you are using
Windows Authentication, you need to set up IUSR and an IIS_WPG or Network Service user.
1. In the SQL Server Management Studio, select Security > Logins.
2. Right click and select New Login.
3. On the Login dialog, click Search to the right of the Login name field.Network Service
4. Select your server.
5. Enter ASPNET, IIS_WPG, or Network Service user (depending on your Windows
version).
6. Click Add then OK.
7. Select your Ektron database. Then, assign permission to read and write to that database.
8. Run the grant permission script.
NOTE: Before doing this, review your users and their permissions. Adjust as necessary for your
configuration. Also, if you use Windows Authentication and all users are domain users (and the
database administrator wants it this way), you may not have to perform this step.
a. Open SQL Server Profiler.
b. Choose File > Open.
c. Open C:\Program
Files\Ektron\CMS400vnn\Utilities\SiteSetup\Database\cms400_
permissions.sql. (nn represents the release number)
d. Within that file, replace [MACHINENAME or DOMAINNAME\USERNAME] with your
domain name, backslash (\), and ASPNET (the ASP.NET machine account). For
example, [ws10080\ASPNET].
NOTE: If you are using Microsoft Windows 2003 Server or Microsoft Widows Vista, the user
is IIS_WPG. For example, [ws10080\IIS_WPG]. If you are using Microsoft Windows 2008
Server or Windows 7, the user is Network Service.
e. Click Execute Query ( ).
f. Replace the text between square brackets with your domain name, backslash (\),
and the IIS Internet Guest Account. For example, [ws10080\IUSR_ws10080]. Click
Execute Query ( ).
g. If using SQL server authentication, replace the text between square brackets with
the SQL server authentication name only. Do not include the domain name. Click
Execute Query ( ).

Setting up the SMTP Server
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Microsoft’s SMTP service sends an email to notify a user when a task (such as approving a
content block or submitting a form) was performed or needs to be performed. This section
explains how to enable email notification in Ektron.
This section also contains the following topics.
SMTP Error Messages
Automatic email Notification
Customizing Ektron email with Variables
Ektron email Variables
email Notification Variables
Default Ektron email Messages
Sending Instant email
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NOTE: To learn about email notification for Web Alerts, see Administering Web Alerts on page 1567.
To process email, Ektron uses CDOSYS. Using Simple Mail Transport Protocol (SMTP) and the
Network News Transfer Protocol (NNTP) standards, CDOSYS enables Windows applications to
route e-mail and USENET-style news posts across multiple platforms. CDOSYS lets authors
create and view sophisticated emails using HTML and data sources.
NOTE: If the SMTP server that processes email does not find CDOSYS installed, it tries to use CDONTS
as a mail server protocol.
For CDOSYS to work, set up the SMTP server on your Ektron server or a remote system that
sends and receives email. Generally, it is good practice to run SMTP on a server separate
from your Web server. However, your Web server must relay the email messages to your
SMTP server.
NOTE: To access an SMTP server on a local or remote system, consult your organization's email
administrator.
l

Local—Before setting up an SMTP server locally, install IIS. SMTP server settings on a
local system are something like this:
“ek_SMTPServer" value=“localhost”
“ek_SMTPServer" value=“127.0.0.1”
“ek_SMTPServer" value=“myname”

l

Remote—Set up an SMTP server on a remote system. SMTP server settings on a remote
system are something like this:
“ek_SMTPServer" value=“smtp.example.com”
“ek_SMTPServer" value=“example.com”

Use this article to configure SMTP in IIS7: Configuring SMTP E-mail in IIS 7
Next, configure Ektron to use SMTP.
1. Open the siteroot/web.config file.
2. Move to the section of the file that has these settings. (See Managing the web.config File
on page 67.)
<!-<add
<add
<add
<add

SMTP Server configuration -->
key="ek_SMTPServer" value="localhost" />
key="ek_SMTPPort" value="25" />
key="ek_SMTPUser" value="" />
key="ek_SMTPPass" value="" />

3. Set the ek_SMTPServer value.
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4. Set ek_SMTPPort to the port your system will access to retrieve email. In most cases,
the port is set to 25. If that is not the case, see your System Administrator.
5. Set ek_SMTPUser to the username that is set up for the SMTP Server to send and receive
email. Typically, the username takes the form of an email address, such as
"ek_SMTPUser" value="yourname@example.com".
6. This retrieval of email is based on how basic authentication is set up for you. You do not
need a username when using a local SMTP server. Check with your System
Administrator for details.
7. If you are using a remote system for accessing email, you must provide an
authenticated username before you can send or receive email.
8. Set the "ek_SMTPPass" value to the password that is set up for the SMTP server to send
and receive email. This password is based on the basic authentication. By default, Ektron
only accepts encrypted passwords.
9. To encrypt the password, Ektron provides a password encrypting tool.
a. Open C:\Program Files (x86)\Ektron\CMS400vxx\Utilities
b. Run EncryptEmailPassword.exe. The Encrypt Utility dialog appears.

c. Enter your SMTP password in the Text field.
d. Click Encrypt. The screen displays an encrypted password in the Encrypted field.
e. Copy the encrypted password and paste it into the web.config file's "ek_
SMTPPass" value.

SMTP Error Messages
When submitting a form or a content block in an approval process, if you get an error
message listed below, it is generated by the SMTP server on which you set up the mail
system, not by Ektron.
l
l

The Transport failed to connect to the server. [CBR SendMail R1] [CBR R65] [DIO R 36]
The server rejected one or more recipient addresses. The server response was: 550
5.7.1 Unable to replay for yourname@example.com [CBR SendMail R1] [CBR R1] [DIO
R36]
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Automatic email Notification
Ektron's automated system sends email to proper users when an action has been, or needs to
be, performed. See Also: Customizing Ektron email with Variables below.
Email is generated when any of the following actions takes place.
l

Submitted to be published—email sent to next approver

l

Submitted to be deleted—email sent to next approver

l

Published to website—email sent to author

l

Declined to be published or deleted—email sent to author

To be notified of these actions, the following criteria must be met:
l

Valid system email address

l

Enabled email notification

l

User email address

l

User email notification enabled

These values are set in the Edit User screen. See Also: Managing Users and User Groups on
page 1099
The Tasks feature also has automatic email notification. See Setting Up Task Types and
Categories on page 1031.

Customizing Ektron email with Variables
Ektron can send email notification to users, informing them that actions have taken place or
are requested of them. For example, a content contributor receives an email that the
contributor's content was published. These emails are stored in resource files, where each
email consists of one string for the subject and one for the body. Each message is called in
the presentation layer by its message title. Ektron does not support HTML email, however the
message text is fully customizable.
The body of an email can include variables, located between @ symbols. Ektron replaces
them with the information for that instance of the email. For example, @appContentTitle@
in the following sentence is replaced with the email’s title.
l

Before: The content “@appContentTitle@” has been deleted.

l

After: The content “Home Page Content” has been deleted.

You can customize the emails, move the variables, add text, rewrite and reorganize.
l

Before: “@appContentTitle@” has been deleted from the XYZ website.

l

After: “About Us” has been deleted from the XYZ website.

Carriage Return/Line Feeds are represented by @appCRLF@. These cause the email to move
down one line. For example:
l

Before: The content was approved.@appCRLF@Thank you!

l

After: The content was approved.
Thank you!

Ektron email Variables
Ektron email variables are specialized for the type of email message you need to send.
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l

Notify CMS users
o @appApprovalList@—The current approval list that the content block must pass
through.
o

@appChangeDateTime@—The date and time changes will be updated on the
website.

o

@appComment@—Displays the comments for the content block.

o

@appContentLink@—The link to the content block on the website.
NOTE: You must be logged in to see the changes.

l

o

@appContentTitle@—The title of the content block.

o

@appCRLF@—A carriage return.

o

@appDeclinerFirstName@—The first name of the user who declined the content
block.

o

@appDeclinerLastName@—The last name of the user who declined the content
block.

o

@appDeletionDateTime@—The date and time the content will be deleted from
the website.

o

@appEmailFrom@—The address of the email sender.

o

@appEmailTo@—The address of the email recipient.

o

@appFolderPath@—The location of the content block in the Ektron folder tree.

o

@appPassword@—Displays the account password for ResetPassword and
RequestResetPassword message types.

o

@appSubmitterDateTime@—The date and time the content block was submitted.

o

@appSubmitterFirstName@—The first name of the user who submitted the
content block.

o

@appSubmitterLastName@—The last name of the user who submitted the
content block.

Notify discussion board users—Discussion board email
o @appForumUrl@—The forum’s URL.
o

@appHostUrl@—The host site’s URL.

o

@appPosterDisplayName@—The display name of the person who posted.

o

@appPosterId@—The integer ID of the person who posted.

o

@appPosterProfileUrl@—The profile URL for the person who posted.

o

@appPostMessage@—The text of the message posted to the discussion board.

o

@appPostUrl@—The URL of the post on the website.

o

@appRecipientDisplayName@—The display name of the email recipient.

o

@appRecipientEmail@—The email address of the email recipient.

o

@appRecipientFirstName@—The first name of the email recipient.

o

@appRecipientId@—The email recipient’s integer ID.

o

@appRecipientLastName@—The last name of the email recipient.

o

@appTopicId@—The integer ID of the topic.

o

@appTopicTitle@—The title of the topic.
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l

Invite users to participate in a community group—Community group email
l
@appFriendDisplayName@—The recipient's name.
l
l

l

@appFromUserDeleted@—Token message is from a user that was deleted.
@appFromUserDisplayName@—The name of the user from whom the private
message was sent.
@appFromUserID@—The ID of the user from whom the private message was
sent.

l

@appGroupName@—The group a person is being invited to join.

l

@appInvitedEmail@—The recipient's email address.

l

@appInviteId@—Appends the invite ID to the registration URL. For example:
Click <a href=http://www.example.com/register.aspx&fInvId=
@appInviteId@>here</a> to accept.

l
l

l

@appMessage@—The Message field of the private message (message body text).
@appOptionalText@—Text a user types into the Optional Message box on the
Invite server control.

l

@appPrivateMessageID@—The CMS ID for the particular private message.

l

@appSenderName@—The sender of the invitation.

l

@appSubject@—The Subject field of the private message.

l

@appToUserDisplayName@—The name of the user receiving the message.

l

@appToUserID@—User ID of the user receiving the message.

l

@appToUserMessageID@—The CMS ID of the recipient's message object.

Notify a subscription list of users through a Web Alert—Web alert email
o @appComment@—The comments for the content block.
o

@appContentLink@—The link to the content block on the website.
NOTE: You must be logged in to see the changes.

o

@appContentTitle@—The title of the content block.

o

@appContentURL@—The URL of the content, from the quicklink and domain.

o

@appCRLF@—A carriage return. Moves text down one line.

o

@appSubmitterFirstName@—The first name of the user who submitted the
content block.

o

@appSubmitterLastName@—The last name of the user who submitted the
content block.

o

@appSubscriptionNames@—Comma separated list of subscriptions that a user
selected.
You can insert these membership variables into the confirmation message.
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n

@appActivateId@—Account ID

n

@appAvatar@—Avatar

n

@appDisplayName@—Display name

n

@appEmail@—email address

n

@appFirstName@—First name

n

@appLastName@—Last name
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n

@appSignature@—Signature

n

@appUserName@—UserName

email Notification Variables
The list shows variables you can use to customize email messages. When the email is sent,
the corresponding description replaces the variable.
l

@appApprovalList@—The current approval list that the content block must pass
through.

l

@appChangeDateTime@—The date and time changes will be updated on the website.

l

@appComment@—Displays the comments for the content block.

l

@appContentLink@—The link to the content block on the website.
NOTE: You must be logged in to see the changes.

l

@appContentTitle@—The title of the content block.

l

@appCRLF@—A carriage return.

l

l
l

@appDeclinerFirstName@—The first name of the user who declined the content
block.
@appDeclinerLastName@—The last name of the user who declined the content block.
@appDeletionDateTime@—The date and time the content will be deleted from the
website.

l

@appEmailFrom@—The address of the email sender.

l

@appEmailTo@—The address of the email recipient.

l

@appFolderPath@—The location of the content block in theEktron folder tree.

l

l
l

l

@appPassword@—Displays the account password for ResetPassword and
RequestResetPassword message types.
@appSubmitterDateTime@—The date and time the content block was submitted.
@appSubmitterFirstName@—The first name of the user who submitted the content
block.
@appSubmitterLastName@—The last name of the user who submitted the content
block.

Default Ektron email Messages
l

Approved Content Awaiting Go Live Date
Message Title: email subject: content changes approved.
Message Text: Content changes have been approved.

l

Approved Content Published Immediately
Message Title: email subject: content has been changed.
Message Text: Content changes have been made.

l

Decline Approval Request
Message Title: email subject: approval request declined.
Message Text: Content approval request declined.
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l

Deletion of Content Approved
Message Title: email subject: content deletion approved.
Message Text: Deletion of content has been approved.

l

Immediate Deletion of Content
Message Title: email subject: content has been deleted.
Message Text: Content has been deleted.

l

Send Approval Message
Message Title: email subject: request for approval.
Message Text: Request for content approval.

Sending Instant email
In addition to automatic email, Ektron lets you email a user or user group from many
screens. An email icon ( ) next to a user or group name or on the toolbar indicates your
ability to do this. Screens in the following Ektron features support instant email.
l

Tasks

l

Approvals

l

Reports

When you click one or more user/group names then the toolbar's email icon, the email screen
appears.
NOTE: The email software must be configured for your server. See Setting up the SMTP Server on
page 93.
When the email screen appears, the following information is copied from Ektron into the
email.
l

l
l

l

To—User you selected to receive email. If the user does not have a valid email address,
an error message appears. If you then insert a valid address, the email is sent. If you
specify a group to receive the message, as long as one group member has a valid email
address, all group members with valid addresses receive the email. You can edit and add
recipients.
From—User signed on to Ektron. You cannot edit this field.
Subject—If the email message is linked to content, its title appears. You can edit this
field.
Body of message—If the email message is linked to content, a content link appears.
You can edit this field.

Managing Logins and Passwords
This section describes how to log in and out, restrict login attempts, and manage passwords.
You must acquire the following before you can log into Ektron and manage website content.
l

URL (Web address) of your website

l

Username and password

This section also contains the following topics.
Logging into an Ektron Website
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Logging Out
Restricting Login Attempts
Changing the Number of Unsuccessful Login Attempts
Disabling the Login Attempts Feature
Unlocking a Locked Account
Manually Locking a User from Signing On
Preventing Ektron Users from Signing On
Preventing All Users from Signing On
Changing Images Used for Logging In and Out
Resolving a Problem with the Login Screen
Managing Passwords
Editing the Builtin Username and Password
Enforcing a Password Change Every 90 Days
Enforcing Login After Time of Inactivity
Enforcing a Minimum Password
Enforcing a No-match Password
Creating a Custom Password Strategy
Logging in through Facebook
Setting Up Facebook Login
Using Facebook Connect Extension with the Targeted Content Widget
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Logging into an Ektron Website
To sign on to an Ektron site:
1. In your Web browser, navigate to the URL of your Ektron website. Your system
administrator provides this.
2. Click the Login button. The Login dialog box appears.

3. Enter your username and password.
If you are using one of Ektron’s sample sites, you can use any of 3 standard users that
demonstrate Ektron’s flexible user-permissions model.
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l
l

l

Administrator—Username: admin; Password: admin; Permissions: All
Standard user—Username: jedit; Password: jedit; Permissions: Basic (for
example, add/edit content, manage library files, and so on)
Membership user —Username: jmember; Password: jmember; Permissions:
Read-only permission to private content

4. Click the Login button. The Web page appears. When you are logged in, the content is
either surrounded by a border or has an access point ( ) in the top left corner of the
content.

Logging Out
1. Click Logout from the content menu, or
confirmation box appears.

on the Web page. The Logout

2. Click Logout. You return to the Web page from which you logged out. However, it is in
standard view, not Ektron view.

Restricting Login Attempts
Ektron has a login security feature that locks out a user after 5 unsuccessful attempts to log in
on one computer. You control login security by changing the ek_loginAttempts element in
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Changing the Number of Unsuccessful Login

the web.config file.
l

any number between 1 and 254—The number of unsuccessful login attempts after which
the user is locked out

l

0—Lock out all users

l

-1—Disable feature; unlock all locked users

l

-2—Lock out Ektron users only; membership users can log in

Changing the Number of Unsuccessful Login Attempts
If a user unsuccessfully tries to log in 5 times, this error appears: The account is locked.
Please contact your administrator. Afterwards, even if the user enters the correct
password, the user is locked out.
NOTE: You can change the error message text in the resource file. See Also: Translating the Workarea
on page 1086.
To change the number of login attempts prior to lockout, edit the ek_loginAttempts element
in the siteroot/web.config file. For example, to allow 3 unsuccessful logins before lockout,
change the value to 3. You can enter a value of up to 254.

Disabling the Login Attempts Feature
To disable the Login Attempts feature, set the value of the ek_loginAttempts element in the
web.config file to -1. If you do, any user can try to log in as many times as the user wants.
The error message never appears, and the user is not prevented from entering a password.
NOTE: Setting the ek_loginAttempts element in the web.config file to -1 unlocks all locked
accounts.

Unlocking a Locked Account
When an account is locked out, the Account Locked field is checked on the Edit User screen.

To unlock the account, an administrator user (or a user assigned to the user-admin role)
accesses the Edit User screen and unchecks the box. At this point, the user can sign in again.
NOTE: To unlock all users, set the ek_login Attempts element in the siteroot/web.config file to 1. See Also: Disabling the Login Attempts Feature above.

Manually Locking a User from Signing On
You can use the Account Locked field to manually lock a user out of Ektron.
1. Go to the Edit User screen.
2. Identify the user.
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3. Check the Account Locked field.
That user cannot sign in until either you uncheck the box or change the value of the ek_
loginAttempts element in the web.config file to -1.

Preventing Ektron Users from Signing On
To lock out all Ektron users, set the ek_loginAttempts element in the web.config file to -2.
If you do, only membership users can sign in.
NOTE: The builtin user cannot sign in if ek_loginAttempts is set to -2.

Preventing All Users from Signing On
To lock out all users (including membership users), set the ek_loginAttempts element in the
web.config file to 0. If you do, no one can sign in to Ektron until you change the value.
NOTE: The builtin user cannot sign in if ek_loginAttempts is set to 0.

Changing Images Used for Logging In and Out
You can change the images used for the login and logout buttons. To do so:
1. Move the new images to the following folder: siteroot\Workarea\images\application.
2. Open the web.config file in your website’s root directory.
3. Change the images in this section of the file:
<add key="ek_Image_1" value="btn_close.png" />
<add key="ek_Image_2" value="btn_login.png" />
<add key="ek_Image_3" value="btn_login_big.png" />

NOTE: You must update the images and web.config whenever you upgrade Ektron.

Resolving a Problem with the Login Screen
You may find that in certain browsers, the login screen occupies the entire browser window
instead of just a small box. Browsers such as Internet Explorer 8 and Firefox have a feature
called tabs. When the login window pops up, it may appear as a new tab. You can change this
behavior by turning off tabs within the browser.

Managing Passwords
This section's topics relate to managing passwords.

Editing the Builtin Username and Password
The builtin user is an emergency user to use if you cannot log into Ektron as an administrator.
The builtin username and password are defined in Ektron's setup screen.
1. From the Workarea, choose Settings > Configuration > Setup. The Application Setup
screen appears with the General tab showing.
2. Click Edit to modify the settings.
3. Locate the Built In User fields.
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4. Change the username or password or both.
5. Click Update.
The builtin user can log in to Ektron whether or not Active Directory or LDAP is enabled. The
builtin user's default username/password combination is builtin/builtin. For security
reasons, change them during installation.
If you log into the Workarea as the builtin user, you can access only the following screens on
the Settings tab.
l

Active Directory

l

Asset Server Setup

l

Setup

l

User

l

User Group

WARNING! Use the builtin user only to correct a bad or expired license key. It is not designed for regular
Ektron operations. If you try to edit content while signed in as a builtin user, you will generate errors.
If the builtin user password was changed and you don’t know it, you cannot sign in. In this
case, use the BuiltinAccountReset.exe utility, which resets the username/password to
builtin/builtin. This utility is located in C:\Program
Files\Ektron\CMS400versionnumber\Utilities.

Enforcing a Password Change Every 90 Days
Ektron has a password security feature that forces an administrator or user with the
Commerce Admin role to change the password at least every 90 days. This feature is only
enabled if the ek_ecom_ComplianceMode key in the site’s web.config file is set to true.
When you go 85 days without changing your password, a dialog box appears upon the next
log-in, asking you to change the password. If you do not want to do so at that time, click
Skip. You can this for the next 5 days. After 90 days have passed, you must change your
password before you can log into Ektron.

Enforcing Login After Time of Inactivity
Ektron has a password security feature that automatically logs out an administrator or user
with the Commerce Admin role after 15 minutes of inactivity. Activity is based on requests
made to the server.
This feature is enabled when the site’s web.config file‘s ek_ecom_ComplianceMode key is set
to true. In addition, if you are using IIS7, the line in red below needs to appear between the
<modules> tags in the web.config file. This line is a part of the default install. You should
make sure it has not been removed.
<modules>
<add name="MyDigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,
Ektron.ASM.EkHttpDavHandler" />
<add name="ScriptModule"
type="System.Web.Handlers.ScriptModule, System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral,
PublicKeyToken=31bf3856ad364e35" preCondition="integratedMode" />
<add name="EkUrlAliasModule" type="UrlAliasingModule"
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preCondition="integratedMode" />
</modules>

Enforcing a Minimum Password
Ektron has a password security feature that forces an administrator or user with the
Commerce Admin role to use at least 7 characters in a password. Further, the password must
contain at least one alphabetic and one numeric character.
This feature is enabled only when the ek_ecom_ComplianceMode key in the site’s web.config
file is set to true.

Enforcing a No-match Password
Ektron has a password security feature that forces an administrator or user with the
Commerce Admin role to create a password that does not match the person's previous 4
passwords. This feature is enabled only when site’s web.config file has the ek_ecom_
ComplianceMode key is set to true and the ek_ecom_PasswordHistory key is set to at least
4.
You can set ek_ecom_PasswordHistory to a number higher than 4 if you want a higher level
of security. If you set this key to less than 4 and the ek_ecom_ComplianceMode key is set to
true, Ektron enforces at least 4.

Creating a Custom Password Strategy
The Ektron password validation provider lets developers create custom password validation
strategies for Ektron. These providers can enforce custom password rules inside the system,
beyond the out-of-box capabilities.
This section explains how to create a custom password validation provider for Ektron.
1. Create a class library project in Visual Studio.
2. Import the namespaces you need. Add references to:
l
Ektron.Cms.Commerce
l

Ektron.Cms.Common

l

Ektron.Cms.ObjectFactory

l

Microsoft.Practices.EnterpriseLibrary.Validation.dll

l

System.Configuration

l

Ektron.CMS.User

l

Ektron.CMS.DataRW

3. Add the following using statements.
using
using
using
using
using
using
using
using
using
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System;
System.Collections;
System.Configuration.Provider;
Microsoft.Practices.EnterpriseLibrary.Validation;
Ektron.Cms;
Ektron.Cms.Common;
Ektron.Cms.Commerce;
Ektron.Cms.Commerce.PasswordValidation.Provider;
System.Collections.Generic;
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using System.Text;
using System.Text.RegularExpressions;

4. Change the namespace to Ektron.Cms.Extensibility.Commerce.Samples, rename
your class to CustomPasswordProvider, and inherit from the
Ektron.Cms.Commerce.PasswordValidation.Provider.PasswordValidationProvide
r class and the Ektron.Cms.Commerce.IPasswordValidation interface.
namespace Ektron.Cms.Extensibility.Commerce.Samples
{ public class CustomPasswordProvider :
Ektron.Cms.Commerce.PasswordValidation.Provider.PasswordValidationProvider,
Ektron.Cms.Commerce.IPasswordValidation

5. Add the following constructor.
#region constructor, member variables
public CustomPasswordProvider() { }
#endregion

6. Add GetRegexFor methods required by the PasswordValidationProvider base class.
These methods return the RegExs that will validate passwords in Ektron for specific user
types.
l
GetRegexForMember—Returns one or more regular expressions used for client
side validation of membership users, along with corresponding error messages to
be used when client-side validation fails.
l

l

l

GetRegexForAuthor—Returns one or more regular expressions used for client
side validation of Ektron authors, along with corresponding error messages to be
used when client-side validation fails.
GetRegexForCommerceAdmin—Returns one or more regular expressions used
for client-side validation of eCommerce administrators, along with corresponding
error messages to be used when client side validation fails.
GetRegexForAdmin—Returns one or more regular expressions used for clientside validation of Ektron administrators, along with corresponding error messages
to be used when client side validation fails.

NOTE: This example enforces a minimal requirement for authors/members, and adds a length and
diversity requirement for administrators.
#region public methods
public override string GetRegexForAdmin()
{ return "[/.{7}/, Password must contain at least seven characters]
" + ",[/[0-9]+/,
Password must contain at least one number]
" + ",[/[a-zA-Z]+/,
Password must contain at least one alphabetical character]
" + ",[/^[^ \t'\"%#]+$/,
Password cannot contain spaces, tabs, single-quotes,
double-quotes, percent-signs, or pound-signs]";
}
public override string GetRegexForAuthor()
{ return "[/.{1}/, Password too short]" + ",[/^[^ \t'\"%#]+$/,
Password cannot contain spaces, tabs, single-quotes,
double-quotes, percent-signs, or pound-signs]";
}
public override string GetRegexForCommerceAdmin()
{ return "[/.{1}/, Password too short]" + ",[/^[^ \t'\"%#]+$/,
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Password cannot contain spaces, tabs, single-quotes,
double-quotes, percent-signs, or pound-signs]";
}
public override string GetRegexForMember()
{ return "[/.{1}/, Password too short]" + ",[/^[^ \t'\"%#]+$/,
Password cannot contain spaces, tabs, single-quotes,
double-quotes, percent-signs, or pound-signs]";
}
#endregion

7. Implement the ValidateFor methods, which use the regexs to validate passwords. We
use the generic function Validate to which we pass parameters.
public override ValidationResults
ValidateForAdmin(string password)
{ return Validate(password, GetRegexForAdmin());
}
public override ValidationResults
ValidateForAuthor(string password)
{ return Validate(password, GetRegexForAuthor());
}
public override ValidationResults
ValidateForCommerceAdmin(string password)
{ return Validate(password, GetRegexForCommerceAdmin());
}
public override ValidationResults
ValidateForMember(string password)
{ return Validate(password, GetRegexForMember());
}
protected ValidationResults
Validate(string password, string regexErrorMessage)
{ ValidationResults results = new ValidationResults();
string regex, errorMessage;
string[] parts;
string[] raw = regexErrorMessage.TrimStart('[').TrimEnd(']')
.Split(new string[] { "],[" }, StringSplitOptions.None);
foreach (string combined in raw)
{ parts = combined.Split(new string[] { "/," },
StringSplitOptions.None);
regex = parts[0].Trim('/');
errorMessage = parts[1].Trim().TrimStart('"').TrimEnd('"');
if (!Regex.IsMatch(password, regex))
{ results.AddResult(new ValidationResult(errorMessage,
this, "", "", null));
}
}
return results;
}

8. Tell the system whether to enforce password expiration on users. There are 2
requirements.
l
PasswordExpirationEnabled—Enabled password expiration globally, which
allows the RequiresPasswordExpiration to be called.
l
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RequiresPasswordExpiration—Returns whether password expiration is enforced
for a user.
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NOTE: The system handles password expiration dates. Setting PasswordExpirationEnabled and
RequiresPasswordExpiration tells Ektron to check and enforce those values.
NOTE: When compliance mode is on, password validation cannot be disabled.
public override bool PasswordExpirationEnabled()
{ return RequestInformation.CommerceSettings.ComplianceMode;
}
public override bool RequiresPasswordExpiration(long userId)
{ return (userId == 1);
}

9. Build the project, and copy the assembly to the Ektron site's bin directory.
10. Register the provider, and direct Ektron to use it. The siteroot/web.config file lets
you manage password providers within Ektron.
l
Locate the passwordValidationProvider section in the web.config file.
l

Add a reference to the class created earlier in the <providers> key.

l

Change the defaultProvider attribute, as shown below.

<passwordValidationProvider
defaultProvider="CustomPasswordProvider">
<providers>
<add name="CustomPasswordProvider"
type="Ektron.Cms.Extensibility.Commerce.Samples
.CustomPasswordProvider, CustomPasswordProvider" />
</providers>
</shipmentProvider>

Logging in through Facebook
Facebook Login, an alternative to Ektron's standard login, lets users log in using their
Facebook username and password instead of creating an Ektron username and password.
Here is an example of Facebook Login control.

This control lets Membership and Ektron users log into an Ektron website. If users have an
Ektron user profile, they can be prompted to link the Facebook username and password with
that profile.
Facebook Login allows log in only—it provides no other Facebook features, such as viewing
profiles or sending messages.
NOTE: The Facebook Login feature does not support Active Directory.
The OnTrek starter site includes a samples of a Facebook Login.
NOTE: The user experience is enabled only after a developer sets up the feature. See Also: Setting Up
Facebook Login on page 111
If a user clicks a Facebook Login button but is not logged into Facebook, the following screen
appears.
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When you complete this screen or if you are already logged into Facebook, you are forwarded
to a page that prompts you to register with or log into Ektron.

This screen asks if you have a membership account. If so, do you want to connect this
Facebook username and password with the Ektron account? If you agree, you will access your
membership account via the Facebook Login with Facebook credentials from now on. If you
do not have a membership account, complete the lower half of the screen. This is the same
screen that new members use to create Ektron accounts. From then on, you can click the
Facebook Login button to log into Ektron using a Facebook username and password.
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When you log out of Ektron, that action does not log you out of Facebook. Conversely, if a
user logs out of Facebook, you are not logged out of Ektron.
NOTE: Facebook often caches information in your browser. If you see JavaScript errors or other odd
behavior, clear the browser cache, close all browser windows, and try again.

Setting Up Facebook Login
To set up the Facebook Login feature:

Step 1: Connect Facebook to Your Ektron Website
Follow these steps to obtain Facebook keys, paste them into the web.config file, and identify
your site to Facebook.
1. In you do not have one, create a Facebook account. Go to www.facebook.com and follow
the sign up instructions.
2. Sign in to the Facebook Developer site.
3. Click +Create New App.
4. Enter an App Name and APP Namespace for your application. The name cannot
include facebook or any variations, such as FB. Click Continue. A new screen appears,
showing your App ID and AppSecret.

5. Open your website's root folder/web.config file.
6. Copy the Facebook keys into these web.config elements.
l
APP ID—ek_FacebookApiKey
l

App Secret—ek_FacebookSecret

NOTE: Keys shipped in Ektron sample sites are for localhost. Also, make sure the Facebook keys
were generated for the host header/URL to which you're applying them. And, if you are testing
secure site setup, verify that the web.config element ek_useSSL is true.
7. Save and close web.config.
NOTE: After you update web.config with Facebook keys, wait a few minutes before logging into
the Ektron site via the Facebook Login server control.
8. Return to the Facebook Basic screen.
9. Under Select how your app integrates with Facebook, click Website.
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10. In the Site URL field, enter your website's URL.
l
for a public site, enter its URL. For example, http://www.example.com.
l

l

for a shared server or if you are accessing the site from a remote machine, use the
IP address. As examples, http://192.168.14.10, http://192.168.14.10/QA
for a local server, use localhost. As examples, http://localhost,
http://localhost/EktronTech

11. Save and close the Facebook screen.
12. After setting up your application, you can return to this screen at any time to view the
keys, edit the Site URL, etc.

Step 2: Create or Modify a Facebook Login/Signup Page
A Facebook form appears if a user clicks a Facebook Login button and is not currently logged
into Facebook.

The form is created by Facebook, not Ektron. You can customize parts of it, such as the title
and site image, using Facebook's Application settings.
When the user completes the form, the user is forwarded to an Ektron form that prompts the
person to register or log in to Ektron.
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Alternative to Redirecting to the Signup Form

You specify which form appears via the Facebook Login server control's SignupTemplate
property.
The logic to connect a Facebook user with an Ektron account (circled) is not part of the
Facebook Login server control. However, sample code for that functionality is included in the
Ektron Tech sample site's register.aspx page.

Alternative to Redirecting to the Signup Form
If you do not want to redirect the user to a signup form after Facebook login, you can hook
the Ektron_FacebookNewMemberLoggedIn JavaScript event and do whatever you want with
it. For example, you could raise a modal dialog with a short signup form. .
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Step 3: Place the Facebook Login Server Control on a Page
1. In Visual Studio, open the template onto which you want to place a Facebook Login
server control. See Also: Working with Ektron Server Controls on page 1605
2. Drag and drop the control.
3. Use the following information to complete its properties.
The following are Ektron-specific server control properties. You can find information
about native .NET properties such as font, height, width and border style in Visual
Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to
content, collections, and so on. See Also: Browsing Your Ektron Site Using CMS
Explorer on page 1610.

l

FacebookButtonText (String)
Enter the Facebook Login button text. The default is Connect with Facebook.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

InstructionDetail (String)
Enter additional text that appears above the Facebook Login button. The default is
Sign in using your Facebook account.

l

InstructionHeader (String)
Enter text that appears above the Facebook Login button. The default is Sign in
using your Facebook account.

l

Language
Set a language for viewing content; shows results in design-time (in Visual Studio)
and at run-time (in a browser).

l

SignupTemplate (String)
Enter the path to the template that appears after a user completes the Connect with
Facebook screen.

You can customize the markup for the form using the LoginTemplate and LogoutTemplate
server controls.

Using Facebook Connect Extension with the Targeted
Content Widget
Facebook Login lets you retrieve the following Facebook profile information, using Facebook
Connect Extension.
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l

Age

l

Gender

l

Marital Status
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l

Likes

l

Employment

See Also: Using Widgets on page 711

Modifying Setup Information
NOTE: Only Administrator Group members can view and edit the Application Setup screen.
You must complete this before any user can access your Ektron website.
In Workarea > Settings > Configuration > Setup, you can enter or edit information for
the Ektron website including:
l

License keys

l

Default language

l

Summary sizes

l

email notification

l

Physical library folders on file server

l

Builtin user information

l

Editor options

l

Work page size settings

The Application Setup screen appears. Click Edit to modify the settings.
This section also contains the following topics.
General Tab
Editor Tab
Workarea Tab
System Tab
Impact on Ektron
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General Tab
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l

l
l

l

Version—This number shows the Ektron version and build numbers. This number is
important to know if you place a call to Ektron Support.
License Key(s)—Enter the license key sent to you from Ektron.
Module Licenses—Enter the license key for WebImageFX that was sent to you via
email.
Default Application Language—Select a default language for Ektron. This user’s
language determines the screens and messages that appear in Ektron. In the user
profile, you can set any user’s language to system default. Each user set to system
default uses the language assigned here.
NOTE: Do not confuse the default application language with the ek_ DefaultContentLanguage
variable in web.config. For more information on that, see Setting the Default Language on
page 1061.

l

l

System E-mail Address—Enter a valid email address. This address will appear in the
From field in the notification emails. See Also: Installing Ektron on page 9
Server Type: Staging Server—Check this box if you want your library links to refer to
the staging server domain, as opposed to the production server domain. This would help
you verify that the linked items exist on the staging server. See Also: Automatic MultiSite Setup on page 77
NOTE: Checking this box disables the Web Alerts feature on your server.
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l

l

l

l

Asynchronous Processor Location—If your site uses the Web Alerts feature, enter or
update the location of the asynchronous processor Web Services file. The default
location is “[none specified].” See Also: Setting Up Message Queuing and the
Asynchronous Processor on page 1572
Enable Office documents to be published in other format—Check the box to allow
Ektron to render Office documents in PDF format. When a checked, PDF generation is
available for individual folders.See Also: Working with Assets in the Document
Management System on page 310
Enable CMS to create file system folders for library assets—Check the box if
you want to create physical folders on your file system server that match the Ektron
library folder tree. See Also: Creating File System Folders with Ektron on page 119
Builtin User—Edit the username and/or password for the built in user. By default, the
username and password combination is builtin/builtin.
WARNING! Ektron strongly urges you to change the default password assigned to the builtin user.
Opportunities to do this are presented during installation and in the above field.

Editor Tab
IMPORTANT: Editor tab settings apply only to the eWebEdit400 editor.

l

Preserve MS-Word Styles—When Microsoft Word content is pasted into the editor, it
removes some Word styles by default. Check this box if you want to prevent the editor
from removing them.
NOTE: Ektron does not recommend enabling this feature.

l

Preserve MS-Word Classes—Similar to styles, when Microsoft Word content is pasted
into the editor, it removes some Word classes by default. Check this box if you want to
prevent the editor from removing them.
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l

l

Enable Font Buttons—Checking this option displays the following font-related buttons
on the editor toolbar:
o Font Face
o

Font Size

o

Font Color

o

Font Background Color

Accessibility/Section 508 Evaluation—If your editor is eWebEdit400:

Workarea Tab

The following fields change the default Web page after sign-in and the default Workarea page.
The default values are automatically applied to all new users, and to all existing users when
you upgrade. Normally, you can modify these values for any user via the Edit User screen.
But, you can force these values on all users, removing the ability to personalize them.
l

Landing Page After Login—If you want one page in your website to appear after users
sign in, enter the URL to that page. You can click Select Page to browse to the landing
page. The last published version of the page appears. If the page has never been
published, nothing appears. By default, the page from which the user logged in
reappears.
IMPORTANT: If you are logging in from the OnTrek sample site, this field is ignored. OnTrek has its
own landing page after login, regardless of this setting.

l

l

l

118

Set Smart Desktop as Start Location in the Workarea—If you want the Smart
Desktop to appear as soon as a user enters the Workarea, click this box. By default, the
user sees the Smart Desktop after sign in. If you leave this box blank, when a user
enters the Workarea, the folder of the content specified in the user profile at the
Landing Page after login field is displayed.
Force Preferences to all users—To force these settings on all Ektron users, check
this box. If you do, users can see the values in the user profile screen but not change
them. If you leave this box blank, users can personalize these values in their User
Profile.
Enable Verify Email—Check this box if users should be notified whenever they
subscribe to an email notification list. See Also: What Happens if Verification email is
Used on page 1587
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System Tab

IMPORTANT: When using the Checkout Server Control on an eCommerce site, the Enable setting
must be unchecked. Otherwise, new users will receive an error message when they sign-up using
this control. See Also: Checkout on page 1673
l

Enable PreApproval Group—Use this field to enable Automatic Task Creation. See
Also: Setting Up an Automatic Task for Pre-approving Content on page 1043

System Tab

Use this button to clear Ektron's cache, which recycles the application pool. For example, you
updated the web.config file but cannot yet see the changes.
Under certain circumstances, Ektron's support group may instruct you to click this button.
Administrators would use this button if they cannot access the hosting servers yet need to
reset their website. The button is an alternative to submitting a request to their IT
department or hosting company.

Impact on Ektron
After you click Restart, the first request takes longer than usual since the application needs
to recompile. Subsequent requests should be processed normally.
To minimize the impact on site visitors, visit your home page immediately after the restart,
so that your request is the first "hit."
See Also: Managing Application Pools in IIS 7

Creating File System Folders with Ektron
If this option is enabled, each time you create a new content or library folder in Ektron, a
corresponding physical folder is created on the file system to organize library files on your
file server. The following image shows a library folder tree and its corresponding system
folder structure.
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NOTE: If you are upgrading, the installation does not create sample website folders on the file server. You
must add these folders manually. However, all folders that you create are also created on the file server
when enabled.
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Migrating Your Site to Ektron

This chapter explains how to migrate your website to Ektron, as follows.
l

What to copy to your website

l

Setting up and deploying templates

Before You Migrate
l

l

Ektron requires a physical installation of the product. If you do not have physical access
to the machine, someone with access to the machine must run the install. For more
information, see Installing Ektron on page 12.
After you install Ektron, verify that it is properly installed by using the starter site. By
default, the sample website is located at the following address on the machine to which
Ektron is installed.
http://localhost/siteroot/default.aspx

If you can browse the starter site and it works properly, Ektron is properly installed.
BEST PRACTICE
You should keep a working version of the starter site to help you debug
problems. For example, if you encounter errors on your site, you can refer to the
starter site to see if the same errors occur. If they do, that may indicate a
problem with the installation. If they do not, the installation is probably OK and
an external factor is causing the problem.

Setting up Your New Site
NOTE: You can use the Site Setup utility to perform these tasks by choosing Start > Programs >
Ektron > CMS400 > Utilities > Site Setup. See Installing a Site on page 17.
1. Copy Application Core Files—Copy the application core files from the
siteroot/workarea folder into your site’s folder. These files operate the workarea,
library, and content functions.
2. Set up the Database—Because the content is stored in a database, you need to create
one. To learn how to set up a database, see Setting up a Database on page 23.
3. Modify Application Parameters—After you install and create the Ektron database, modify
the web.config file that installed to the directory to which you installed Ektron. Edit that
file and update the information between the <ConnectionString> tags to point to your:
server, database, user, and pwd.
NOTE: If you are using SSL, the settings you need to modify are explained in Installing Ektron on
page 9.
4. Create a Login Page—You can either copy the one from the starter site or create your
own. See Also: Login on page 1763 server control
5. Log In
a. Browse to the login page you created and click Login. A login dialog box opens
asking for a username and password.
b. Enter the default username (admin) and password (admin) and click Login. You
are logged into Ektron.
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6. Modify Configuration Settings—After you log in, click Workarea. From there, you can
modify the configuration settings.
l
Setting Up Active Directory—If plan to use Active Directory, configure this now. The
settings for Active Directory can be found in the Settings > Configuration folder.
Refer to Using Active Directory with Ektron on page 1127.
l

l

l

Modifying the Setup Screen—The Ektron setup section is located under the Settings
> Configuration folder. The setup section lets you configure items such as your
license key, style sheet support, max summary size, and default language. See
Getting Started with Ektron on page 5.
Setting up Metadata—Ektron includes extensive metadata support. Settings for
metadata definitions can be found under the Settings > Configuration folder in
the Workarea. You can have as many metadata definitions as needed. See Working
with Metadata on page 369 for more information.
Setting up Smart Forms—You can also set up your Smart Forms. You create XML
files externally or via the Data Designer. Next, a Smart Form is assigned to content
blocks and folders. See Working with Smart Forms on page 423 for additional
information.

7. Create Ektron Users—If you are not using Active Directory support, add your users
manually. The maximum number of users is determined by your license key. For
instance, if you purchase a 10-user license, you can enter 10 users. If you exceed the
licensed number of users, you may get locked out of Ektron. Every user must belong to a
group. When you first add a user, the user is automatically added to the Everyone group.
You can create more user groups and add users to them as desired. For more
information, see Managing Users and User Groups on page 1099.
8. Configuring Content and Forms Folders—Next, create folders to organize content blocks
and forms. Create as many folders as you want. Each folder level can go as deep as you
want.
Keep your folder structure simple so it’s easy for your users to navigate. Organize folders in a way
that makes sense to the users who will navigate through them. So, you may have 6 or so top level
folders, and each folder may go 4 or so deep.
This folder structure is replicated under the Library folder.
As you create folders, you can assign a default template and style sheet. The default
template is used when a new content block is created and Ektron creates a Quicklink that
points to the new content block. If you do not provide a default template, it is inherited
from the parent folder.
After creating the folders, assign permissions and approvals to them. Permissions can
be assigned to a user or a user group. The same is true for the approval process.
BEST PRACTICE
Limit permissions for the “Everyone” group, as this gives every user permissions
to that content. Similarly, you should limit the “Everyone” group’s inclusion in the
approval chain if you want to restrict which users can publish content.
9. Create your Templates—Now you can create your templates. Templates contain the look
and feel of the site. Masthead, navigation, and footer graphics are all part of the
template. Use server controls to insert Ektron content into a template. For a list of
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server controls, see Working with Ektron Server Controls on page 1605.
BEST PRACTICE
Because dynamic templates include URL parameters, make each main landing
page and other important pages static tags. This makes it easier for you to
remember if you need to provide that link to someone.
For instance, each main landing page from your home page could use the static
tag. Then, as you go deeper into that section, subsequent pages use a dynamic
tag.
10. Migrate or Create Content—You can create or migrate your content. If you are migrating
content from an existing site, add a new content block, and cut and paste the content into
the Ektron editor.
NOTE: All images and files must be uploaded and inserted into the content separately.
11. Deploy the content—Deployment from development to production is as simple as moving
the files over. To properly deploy your new Ektron website:
a. Copy all assets (templates, images, files, and so on) from your development box to
your production machine.
b. Move the database. You have 2 choices
l
point your data source on the production machine to the database you were
using.
l

copy the database, move it to your production box, and point a data source to
that.

12. Optionally, For email notification to work in Ektron, make sure the SMTP service is setup
and running in IIS, and that it points to a valid mail server. See Installing Ektron on
page 9 for additional information.
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Ektron's Marketing Optimization Suite

Marketing departments are constantly challenged to deliver greater business results on the
Web—leads, sales, downloads, donations, awareness and more. Yet marketers still deliver
"one size fits all" Web experiences to customers and potential customers.
Site visitors have little patience for generic Web experiences that ignore the context of their
visit. The opportunity for marketers is to connect content with context, to deliver personal
Web experiences that deliver business results.
The Ektron Marketing Optimization Suite (EMOS) empowers marketers to create relevant,
personalized Web experiences that deliver better business results. Engage customers with
targeted marketing to drive them to take action. Maximize conversion rates through
sophisticated multivariate testing. Analyze site performance by connecting your Web
analytics data to your marketing teams in real time. Create business agility by empowering
marketing with both data and tools with the Ektron Marketing Optimization Suite.
To learn more about the Ektron Marketing Optimization Suite, see Rapidly Test and Target to
Optimize Results.

Components of Ektron Marketing Optimization Suite
Ektron's Marketing Optimization Suite consists of the following components of Ektron.
l

Analyzing Content on page 601
The Business Analytics feature lets you track statistics about visits to your website. You
can use it to determine the following kinds of information:
l

how often your content was viewed

l

how many site visitors viewed for first time, and how many returned

l

l

the most popular referral pages (that is, the Web page from which visitors clicked
to arrive on your site)

Setting Up Site Overlay on page 655
Site Overlay provides an easy-to-use visual map of popular links on a Web page, based
on the frequency of clicks. When Site Overlay is enabled, each link on a page is
represented by a horizontal bar graph. When you hover over the graph, you see its
statistics. The following image shows menu links and the overlay bar graphs.

l

Using Widgets on page 711
The Targeted Content widget lets you personalize a site visitor's experience by providing
content that matches their interests, thereby placing your site information in the context
of your users. For example, the search keywords used to find your site might determine
the best offer to show a prospect. Or, site members might explicitly state their interests
by adding to their user profile or filling out a survey.

l

Optimizing Page Layout with Multivariate Testing on page 695
Multivariate testing lets you offer several variations of the same page, then measure site
visitors' reactions to each variation. The one that generates the most conversions is
automatically promoted to the design for that page, thereby maximizing your website's
ROI.

l

Personalizing a Web Page on page 825
Personalization is fast becoming an integral part of websites like iGoogle and Facebook,
and organizations see personalization as a way to make their sites "stickier" and more
engaging. Ektron provides tools to let membership users personalize their experience on
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your site, bringing relevant information to their fingertips. By letting users add widgets,
applications, and feeds to a website, Ektron provides a framework on which to easily
build true, personalized portals.
l

Working with Ektron Server Controls on page 1605
The SEO server control analyzes your website for W3C compliance, what information
Google has about the page, Alexa rankings, image alt text, keyword density and
metadata. SEO lets you know how (and if) you have set these values.
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Ektron's Social Business Software

Social Business changes everything.
l
l

l

how employees collaborate, enabling better communication, innovation, and productivity
customer support, allowing customers to support each other in vibrant online
communities.
commerce, providing authentic customer-driven ratings and reviews that build trust.

Is your company ready for the social revolution?
With Ektron Social Business Software, create vibrant social communities for employees and
customers. Socialize key business processes including Sales, Support, Marketing, and
Innovation. Ektron Social Software powers many well-known customer communities,
delivering enhanced customer satisfaction and loyalty. Social is not a feature, it is a business
strategy. Implement your social strategy with Ektron Social Business Software.
To learn more about Social Business Software, see Drive Customer Engagement and increase
Brand Loyalty and Awareness.

Components of Ektron Social Business Software
Ektron's Social Business Software consists of the following components.
l

Working with Discussion Boards on page 536 (includes Forums and Message Boards)
The discussion board feature provides topic discussions on your website. A site or
membership user with Add Topic permission creates a topic and posts a starter question.
Site visitors can then reply. Ektron supports an unlimited number of discussion boards. A
discussion board consists of a hierarchy. The following example shows the hierarchy
with sample data, to explain how each element is used.

l

User Profiles
A membership user can access his or her profile page only from the website. An Ektron
user can access his or her profile from the Workarea or the website.

l

Activity Streams on page 1231
An activity stream is a series of chronologically-arranged notification messages
describing activities within Ektron's Community Feature.

l

Working with Blogs on page 491
A blog is a form of online information sharing. You create a main blog post, and others
can comment on it. Or, you can use a blog to create an online diary of everyday life.
Your most recent blog post appears at the top with associated blogs following. Some
blogs display a calendar on which days when blogs were created are highlighted.

l
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User-Ranking of Content on page 587
o place a star-based scale on any page of your website
o

let users apply full or half-star rating increments and a comment

o

add reviews, depending on how the feature is used

o

moderate the review comments

o

display reviews and comments next to content for others to see

o

run reports to find the highest-rated content; tweak poorly-rated or reviewed
content to achieve optimal ratings

o

control which reviews get posted through a moderation feature
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l

Managing Community Groups on page 1181
Community groups are another aspect of a community sites. Group members can easily
meet people with similar interests, such as car racing for example. Groups have similar
features and functions to user features. For example, a community group can have a
Message Board, Discussion Board, maintain a membership list, and keep a group
journal. You can manage community groups from the website or the Workarea.

l

Sending Notifications to a Community on page 1194
Ektron's notification system creates and transmits a notification message to recipients
through various agents, based on Ektron activities. The activities may be performed by a
community group, membership user, or an Ektron user. For example, a membership
user wants to notify colleagues whenever a documented is uploaded to the profile page.
When this occurs, an Ektron event is triggered, which causes a notification agent to send
an email to the person's colleagues.

l

Logging in through Facebook on page 109
Facebook Login, an alternative to Ektron's standard login, lets users log in using their
Facebook username and password instead of creating an Ektron username and
password.

l

Targeting Content with GeoIP Information on page 1899
GeoIP support lets you target your messaging to specific audiences based on current
geographical location. Ektron uses a site visitor’s IP address to detect the location. For
example, your eCommerce website is having a special on snow blowers. That
information is relevant to people in colder climates but of no interest to those living in
the tropics. As another example, a site visitor uses a cell phone to find the nearest store
location. In this case, Ektron Map server control displays a map of nearby stores based
on the user's current latitude and longitude.

l

Creating Surveys and Polls on page 407
Surveys and polls can show ongoing results to site visitors after they submit their
answers.
Surveys and polls are a type of form. All of the same functionality is available and
applies.

l

o

A survey is usually multiple questions and appears on your site for a longer time
than a poll.

o

A poll is generally one question and appears on a site for a very short time: an hour
or a day.

Micro-messaging on page 1801 server control
The Micro-messaging server control lets users post brief messages. It resembles microblogging services like Twitter.

l

SocialBar on page 1845 server control
The SocialBar server control lets users of a community website bookmark colleagues,
community groups, and content. It provides access to Twitter, Facebook, YouTube, and
so on.

l

TagCloud on page 1848 server control
The TagCloud server control shows a weighted list of tags assigned to users, community
groups, content, or library items. Tag sizes are proportional to the number of times they
are assigned. For example, there are 2 tags, Software and Programming. If the

Ektron 8.7

131

Ektron's Social Business Software

Software tag is used 5 times and the Programming tag is used 2 times, the Software tag
is approximately twice as large.
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Ektron's Mobile-Driven Web Experience

Web traffic from mobile devices is accelerating. Making your website available to mobile
users is not enough. Your website must deliver the same, consistent level of experience to
your mobile visitors as you do for those who visit your website on their desktop to ensure that
your consumers are accessing information, products, and services from your website.
Mobile applications require different, more compact navigational aids, and content must fit
into a smaller footprint. Mobile websites need "tap to call" options to take advantage of
cellular technology, a robust search, flexible menus, and quick access to content. Tables and
figures may need to be adjusted or reconfigured to avoid unnecessary "pinching" and
scrolling.
This section also contains the following topics.
Developing a Multi-Channel Website Design
Using Mobile Templates
Grouping Mobile Devices
Editing a Device Configuration
Deleting a Device Configuration
Reordering a Device Configuration
Applying Adaptive Image Resizing
Resizing an Image with Direct Access Mode
Using Geographic Data from a Mobile Device
Updating the Wireless Universal Resource File
Additional Mobile Information
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Developing a Multi-Channel Website Design
When you design and develop your website, you want to reach as many people as possible.
People are using a wide variety of devices to access the Web.

When you evaluate your website, or where you want it to be, consider the following website
strategies:
l

l
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Foundational—Educate your users about your purpose and products with little
interactivity. Enable business users to publish content using content editing and
management, approval chains, and publishing. Reduce site maintenance for IT and
increase the number of visits to your website.
Tactical—Facilitate content reuse, user-generated content, categorization, and page
assembly. Create Smart Forms, taxonomies, online communities. Synchronize multiple
sites. Develop pages, templates, surveys and polls, blogs, search, commenting and
threaded discussions.
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l

l

Strategic—Embrace multi-channel delivery and support a richer customer experience
with eCommerce, multi-channel, multi-site, multi-language, and video.
Engagement—Continually analyze and customize the customer experience with
personas, create touch-centric interaction for mobile devices, integrate with marketing
automation, use multivariate testing, geolocation, device orientation, and activity
streams to target content for what is relevant and meaningful to your site visitor.
Customer Relationship Management systems can personalize the Web experience to
drive revenue, deliver better business results, increase your brand awareness, and
create customer loyalty.

Consider the following approaches to design.
l

Separate Mobile Site Design

l

Separate Mobile Template Design

l

Responsive Web Design

l

Responsive Web Design and Server Side Components (RESS)

Separate Mobile Site Design
If you have an existing website that you do not want to redesign, you can separate the
content into 2 site architectures: 1 for desktop computers and 1 for mobile devices. You can
target your content specifically for mobile devices, avoiding the complexity of developing
device-conditional style sheets and manipulating existing content.
However, you will have to maintain 2 sites and ensure that they are synchronized (where
applicable). You have to set up device recognition so that mobile device requests for your
website are routed to your mobile (m-dot) site instead.
Also, having 2 sites can impact your SEO ranking negatively if content is found on both sites.

Separate Mobile Template Design
Separate templates, optimized for mobile, get rendered whenever somebody visits your site
from a mobile device. This approach lets you define a unique mobile experience, without
affecting the desktop experience, and create a mobile experience without having to undergo a
complete website redesign. Loading of pages is more streamlined when you use separate
templates instead of the responsive design approach because only the mobile content gets
retrieved from the server; responsive sites often have extra content that is then hidden by
CSS rules based upon the current device.
However, you must maintain more than 1 set of templates (for mobile and desktop
experiences). Also, the server must detect whether a visitor is using a mobile device before
rendering a mobile template, so a list of devices must be kept up-to-date. Fortunately, Ektron
is able to keep the device list up to date for you. See Updating the Wireless Universal
Resource File on page 150.

Responsive Web Design
You should consider a Responsive Web Design (RWD) when you have a high degree of overlap
between the site visitor experience and content on many devices.
Responsive design provides an optimal viewing experience for devices of any size by
adapting the layout of your pages with CSS3 media queries. The elements on your pages
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(including any images) must use relative units (percentages or ems) for sizing instead of
fixed dimensions (pixels). This enables your site to expand and contract to the viewing size of
any device.
Responsive design has a single code base, where other approaches require the use of
separate mobile-specific templates to display your pages to mobile devices. While you may
identify which of your content is "canonical" in a Separate Mobile Site Design on the previous
page, the singular architecture and repository of a responsive design means that you have
one authoritative source for SEO leading to higher rankings by search engines. (Multiple
websites can dilute your ranking.) It also lets your site visitors use a consistent set of URLs
without the issue of directing to the WWW or m(dot) site.
Many traditional websites require a complete redesign and implementation to change to a
responsive site. Additionally, a complete redesign may require added time and effort to
ensure that the user experience is mobile-friendly. You must weigh the costs of a redesign to
gain the benefits of a single code base (long-term maintenance savings, SEO improvements,
and so on).
Another issue to consider before creating a responsive website is that entire pages are
loaded. If you have a lot of content on a page, it can impact the user experience. By contrast,
if your site uses separate mobile templates, you can decide if some of that content should be
loaded on certain types of devices.
Using Responsive Frameworks with PageBuilder on page 670 shows how to work responsive
Web design into your PageBuilder pages.

Responsive Web Design and Server Side
Components
Responsive Web Design + Server Side Components (RESS) has the flexibility of responsive
design while providing the granularity of device detection to deliver device-specific
components.
Ektron supports the use of RESS by providing tools to display content and assets based on
groups of devices, which can be added to your responsive pages. Of course, this responsive
aspect means that your site needs to be redesigned, but once redesigned, these tools can
provide the best of both approaches.
Using Responsive Frameworks with PageBuilder on page 670 shows how to work responsive
Web design into your PageBuilder pages.

Using Mobile Templates
A template is a customized Web page format comprised of objects such as content blocks, list
controls, menus, rotating banners, a search object, and videos. How you assemble the
objects affects the user experience. Because of the smaller display size, templates for mobile
devices may have a single column to eliminate horizontal scrolling, pinching, and zooming.
You decide what is practical for each device by creating different templates instead of
creating different content. Objects may have to be omitted or replaced with mobile-friendly
objects. The following image shows PageBuilder templates for desktop and mobile devices.
Note that the mobile template does not include content object 3. See Developing Wireframe
Templates on page 676 for information about creating PageBuilder wireframe templates.
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You should use the same dropzone IDs for both the mobile and desktop templates. Content
does not display if a mobile template contains a dropzone ID that the corresponding desktop
template does not have.
Ektron can detect specific characteristics of a mobile device, such as the differences between
the Android Droid X and Droid 2. These characteristics help you determine how to render the
user experience. For example, one device may support Flash technology and another may
not.
In any case, you want to ensure that your content on a mobile device is elastic, meaning that
it can scale to the various sizes of displays. Use percentages instead of hard-coded pixel sizes
for the mobile template. If you set PageBuilder dropzone width to 100%, the normal flow of
the objects in the mobile browser cause them to stack from the top to the bottom.

Setting Up a Mobile Template
1. In the site root/web.config file, set ek_EnableDeviceDetection to True.
<add key="ek_EnableDeviceDetection" value="true">

2. Identify a template for which you want to create a mobile version, using the Workarea
> Settings > Configuration > Template Configuration screen. Click any template
to see its folder location relative to your site root.

3. Open Windows Explorer and locate that template in the site root folder.
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4. Copy and save a mobile version of the template under a suitable name, for example,
account.pb.smartphone.aspx.
5. Adapt the template for mobile use by changing column styles, removing unwanted
navigation, images, headers, footers, adding components that help mobile users, and so
on.
6. Create device configurations. Assign to each one any mobile devices that use the
template you created. See Also: Grouping Mobile Devices on page 140.
7. Return to the Template Configuration screen and click the template you identified in Step
2.
8. Check every mobile Device Configuration for which you created a mobile template
version. Then, for every checked configuration, click the ellipsis button (
navigate to and select the mobile template you created in Step 6.

) to its right,

Now, if a mobile device user accesses a page which uses that template, the mobileenhanced template displays the content.
l

l

l

l

To test mobile templates, preview your content within them. See Previewing
Content in a Mobile Template below.
Ektron uses the Wireless Universal Resource File (WURFL) file to obtain wireless
device information. To learn how to view, update, and customize this file, see
Ektron's Mobile-Driven Web Experience on page 133.
To conditionalize Smart Form content based on user device, see Ektron's MobileDriven Web Experience on page 133.
To use a mobile site visitor's geographic location to deliver relevant content, see
Using Geographic Data from a Mobile Device on page 149.

Previewing Content in a Mobile Template
You can preview content in mobile template to ensure the content fits within the screen
resolution.

Previewing Mobile Content from a PageBuilder Page
1. Log into your Ektron website.
2. Navigate to PageBuilder page that you want to view as a mobile device user would.
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Previewing Mobile Content within the Editor

3. From the PageBuilder menu, click View > iPhone, iPad or Droid.

4. The page redisplays, simulating the selected device.

Previewing Mobile Content within the Editor
1. Edit content in the editor.
2. Click Preview (

).

3. Select a model from the Device Configuration drop-down and click Preview. The
content displays in the selected template.

Specifying Device-Specific Content with Smart Forms
You can set up Smart Form configurations to recognize a user's device and, based on that
information, display appropriate content. For example, if a user is not using a Smart Phone,
show a complex display with rich graphics. If a user is using a Smart Phone, create a simpler
presentation of the same fields without graphics. To learn about this capability, see Inserting
a Conditional Section on page 434.
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You can also designate some or all of an HTML form's postback message to be conditional
upon a user's device. So, for example, the postback message for Smart Phone users can be
much shorter than the message for users who are not using a mobile device. To learn more
about this, see Specifying Conditional Text in the Postback Message on page 414.

Grouping Mobile Devices
You can accommodate a variety of mobile devices by grouping characteristics, such as
display size. You can group devices for standard presentation and add refinements for specific
devices. For example, a device configuration may consist of a Smart Phones group (Apple
iPhone®, Samsung Galaxy Note™ II, Motorola® Droid RAZR MAXX HD, and so on) and a
Tablets group (Apple iPad®, Google Nexus™ 10, Microsoft® Surface™, and so on).
With Ektron, you can group devices by model or operating system.
Grouping by model gives you more control over specifications, but it is quicker to group by
operating system. You may want to first group by operating system, then only define models
that do not work properly under an operating system configuration.
IMPORTANT: Because a device may be covered by several configurations, use the Reorder button to
determine the order in which devices are checked. See Also: Reordering a Device Configuration on
page 144
To determine which mobile devices to add to your device configurations, review your
Analytics reporting to see which mobile devices are browsing your site. To see the Browser
and OS report:
1. In the Workarea, select Reports > Traffic Analytics > Visitors > Browser
Capabilities > Browsers and OS.
2. Modify the time period and rank if needed. For more information, see Viewing Analytics
Data on page 622.
The following example shows that Android and iPhone mobile devices have browsed pages.
You can create templates and device configurations to improve the experience of these
visitors.

Adding a Device Configuration by Selecting Operating
System
Each mobile device's definition includes an operating system. To reduce effort, you can create
configurations by choosing one or more operating systems. When you do, each device using
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Adding a Device Configuration by Selecting Models

that OS is automatically included in the list. For example, you create a device configuration
for all Android phones.
While defining a mobile device, you decide if the configuration applies to handheld devices,
tablets, or both device types. You also specify a resolution (width and height). So, if two
devices share an operating system but have different resolutions, create a separate
configuration for each one.
PREREQUISITES
l
l

You are a member of the Administrators group
Device detection is enabled See Also: Ektron's Mobile-Driven Web Experience on
page 133

To add a device configuration by selecting an operating system:
1. Workarea > Settings > Configuration > Device Configurations.
2. Click Add Device Configuration (by OS).
3. In the Device Configuration field, enter a name for the configuration.
4. Click Add OS.
5. Select one or more operating systems for this configuration.
6. At the Device Type field, choose whether the configuration applies to handheld devices,
tablets, or both device types.
7. Set the Width and Height of the device display in pixels.

8. Click Save Device Configuration.

Adding a Device Configuration by Selecting Models
When adding individual devices to a configuration, group devices that share characteristics,
such as Flash support and screen resolution. Since you will assign the configuration to a
mobile template, make sure that all devices support the template's functionality.
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1. Workarea >Settings > Configuration > Device Configurations.
2. Click Add Device Configuration.
3. In the Device Configuration field, enter a name for this configuration.
4. Click Add Model. The Selecting an existing model screen appears.

a. Type a model in the field and click Search.
b. Click on the model you want to add. Repeat this step for as many models that you
want to add.
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Editing a Device Configuration

5. Set the Width and Height of the device display in pixels.

6. Click Save Device Configuration.

Editing a Device Configuration
1. Workarea >Settings > Configuration > Device Configurations.
2. Click the configuration that you want to edit.
NOTE: You cannot edit the Generic and Generic Mobile configurations.
3. Note that the second line of the display indicates if the configuration was determined by
operating system or model. You can only add or remove models or operating systems,
depending on that setting.
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4. Click Edit Device Configuration. The Update Device Configuration screen appears.

5. To remove any model or operating system from this configuration, click X to the left of
its name.
6. Update the other fields on the screen as needed. For information on the fields, see
Ektron's Mobile-Driven Web Experience on page 133.
7. Click Save Device Configuration.

Deleting a Device Configuration
NOTE: You cannot delete the Generic and Generic Mobile configurations.
1. Workarea >Settings > Configuration > Device Configurations.
2. Click Delete ( ).
3. Check the box next to configurations you want to delete.
4. Click Delete ( ).

Reordering a Device Configuration
You can determine the first acceptable configuration that a device will use. To accomplish
this, change the order of the device configurations.
For example, you configured an iPad in the AppleDevices and the Tablet Devices
configurations. However, because AppleDevices is set for a small resolution, you want an
iPad to use the Tablet Devices configuration (which has a larger screen). Reorder the devices
so that Tablet Devices appears above AppleDevices.
1. Workarea >Settings > Configuration > Device Configurations.
2. Click Reorder Device Configurations ( ).
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Applying Adaptive Image Resizing

3. Click a configuration you want to move.

4. Click Up/Down ( ) to arrange the list to the desired order.
5. Click Update Device Order.

Applying Adaptive Image Resizing
Adaptive Image Resizing resizes images and helps you implement a caching strategy to
enhance a user's mobile experience on your site. It includes the following features:
l
l

l

Criteria to determine which images get resized
A user-defined set of resolutions—Ektron renders the image in a device-appropriate
resolution
A direct access mode that lets a developer set an image to a predefined resolution

PREREQUISITE
To enable Adaptive Image Resizing settings, set ek_EnableDeviceDetection to
True in siteroot/web.config.
<add key="ek_EnableDeviceDetection" value="true" />

Determining Which Images Get Resized
Two criteria determine which images get resized. Images must meet both criteria to be
eligible for resizing.
l

Minimum File Size—You can specify a minimum file size in KB. The default minimum
is 80 KB—smaller files are not resized. To modify it, open the siteroot/web.config file
and update the ImageSizeThresholdKB value.
<AdaptiveImageProcessorConfig ImageSizeThresholdKB="80"
Level1CacheSize="5000" Level2CacheSize="500"
Level2CacheItemThresholdKB="256" EnableL2Caching="true"
DirectAccessQueryString="targetTypeID">

l

Folders—Only images in specified folders and their subfolders can be resized. To do so,
open the siteroot/web.config file and find the following section. The tilde character
(~) represents your site root folder: ~/.
<IncludePathList>
<!--Files in the specified path WILL be processed by resizer.
The Include Path includes ALL sub-directories of the specified path--> |
<IncludePath Path="~/uploadedimages" />
<IncludePath Path="~/assets" />
</IncludePathList>

Ektron 8.7

145

Ektron's Mobile-Driven Web Experience

To include a folder, enter an IncludePath tag. For its Path property, enter the folder
path within your site root folder (as shown in the examples). You only need to specify
parent folders to include child folders.

Setting Image Resolutions
By default, web.config contains the following adaptive image resolutions:
<ImageResConfigs>
<ImageResConfig TypeID="LowRes" MaxWidth="320" MaxHeight="480" />
<ImageResConfig TypeID="MedRes" MaxWidth="1024" MaxHeight="768" />
</ImageResConfigs>

Ektron uses these settings to reduce images that exceed a device's resolution (as defined in
the Device Configurations screen). See Also: Ektron's Mobile-Driven Web Experience on
page 133. The image gets resized to the resolution of the user's device if the resolution is
listed within the <ImageResConfigs> tags. If the device's resolution is not listed, the image
gets resized to the next larger one.
For example, if a site visitor uses an iPhone (pixel resolution 320 x 480) and encounters an
706 x 534 image, Ektron resizes it to 320 x 242. If another visitor uses a Samsung Galaxy S
(pixel resolution 480 x 800), the visitor sees the full image because the image (706 x 534) is
smaller than the next larger breakpoint (1024 x 768); no resizing occurs.
In this example, you may need to identify a new breakpoint (say, between 320 and 1024) to
accommodate other devices.
IMPORTANT: Review your site analytics to gain an understanding of the devices that are being used to
view your site. To create a third ImageResConfig element to support Samsung Galaxy S. Modify the
<ImageResConfigs> tags as shown in the following example.
<ImageResConfigs>
<ImageResConfig TypeID="LowRes" MaxWidth="320" MaxHeight="480" />
<ImageResConfig TypeID="SGalaxySRes" MaxWidth="480" MaxHeight="800" />
<ImageResConfig TypeID="MedRes" MaxWidth="1024" MaxHeight="768" />
</ImageResConfigs>

After you make this change, on a Samsung Galaxy S, the 706 x 534 image is rendered as 480
x 363. You can insert as many ImageResConfig elements as you want to accommodate
mobile devices.

Creating Image Copies in the Specified Resolution
After you enable device detection in web.config, as new images are added to specified
Ektron folders, Ektron automatically creates versions of the image in specified sizes
(described in Setting Image Resolutions above).
<add key="ek_EnableDeviceDetection" value="true" />

A new image filename consists of ImageResConfig TypeID_original file
name.extension. For example, if the original image filename is mytest.png, and it is resized
to specifications set in the LowRes ImageResConfig element, the new filename is LowRes_
mytest.png.
If a mobile visitor views an image that was in Ektron before device detection was turned on,
the image may be resized at that time. Ektron creates resized image versions in the same
folder as the original image.
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Adaptive Image Caching

If you later view the image on any device with the same resolution range, the saved version
is displayed. This practice enhances the performance of your mobile website. However,
creating additional image versions also increases the number of files and storage space
needed.
BEST PRACTICE
When planning an implementation of Adaptive Image Resizing, consider your future
space requirements.

Adaptive Image Caching
Use caching to avoid expensive query storage.
PREREQUISITES
l

You can edit siteroot/web.config on your Ektron server.

l

In siteroot/web.config, set ek_EnableDeviceDetection to true.

To minimize the demand on your Ektron server, the Adaptive Image Resizing feature uses 2
caching strategies.
l

Level 1 caching stores only a filename, file size, and resolution. You determine the
number of items that may be stored in Level 1 cache in the following web.config
setting.
<AdaptiveImageProcessorConfig
ImageSizeThresholdKB="80"
Level1CacheSize="5000".....

BEST PRACTICE
The Level1CacheSize should approximate the number of image files in the
included folders.
l

Level 2 caching stores the file's content as a byte array. A resized file is only saved to
Level 2 cache if the resized file size is less than the value of
Level2CacheItemThresholdKB.
o To determine the number of items that you can store in Level 2 cache, set
Level2CacheSize.
o

To enable or disable Level 2 caching, set EnableL2Caching.

<AdaptiveImageProcessorConfig
ImageSizeThresholdKB="80"
Level1CacheSize="5000"
Level2CacheSize="500"
Level2CacheItemThresholdKB="256"
EnableL2Caching="true"

Adaptive Image Resizing caching works as follows:
1. A user on a mobile device accesses an Ektron Web page that uses Adaptive Image
Resizing.
2. For every image file request, Ektron looks for it in Level 1 cache to determine if the
image size exceeds the threshold.
l
If the cached item is found, the cached file information is used.
l

If the cached item is not found, Ektron queries the storage device for the file
information and caches it.
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3. For every qualified image request, if level 2 caching is enabled, Ektron searched Level 2
cache for the target file. If the file is found, the cached byte array is sent to the user's
device. If the file is not found, Ektron sends the image from storage and caches the byte
array (if the size does not exceed the defined limits).
BEST PRACTICE
Use the following formula to calculate memory usage for level 2 caching:
total memory used = Level2CacheItemThresholdKB * Level2CacheSize

For example: 256KB*500=128000KB=128MB of maximum memory used by Level 2
caching.

Clearing Cache
To clear both Level 1 and Level 2 cache, use the Clear Cache button in the Workarea >
Settings > Configuration > Device Configurations screen.

Resizing an Image with Direct Access Mode
PREREQUISITE
You must have 1 or more <ImageResConfig> tags within the <ImageResConfigs> tag
in web.config.
Direct access mode lets you resize an image to any resolution set in the <ImageResConfigs>
tags in web.config. See Also: Setting Image Resolutions on page 146. Unlike other Adaptive
Image features, direct access mode does not consider the user's device, and ignores the
value set by the ek_EnableDeviceDetection setting in web.config.
To apply direct access mode to an image (for example, so that the image displays in a
maximum resolution of 320 x 480), use the following syntax:
<img src="uploadedimages/testfile.jpg?targetTypeID=LowRes"/>

The targetTypeID refers to an <ImageResConfig> tag with TypeID=LowRes.
<ImageResConfigs>
<ImageResConfig TypeID="LowRes" MaxWidth="320" MaxHeight="480" />
<ImageResConfig TypeID="MedRes" MaxWidth="1024" MaxHeight="768" />
</ImageResConfigs>

Changing the Query String Parameter Name
You can change the targetTypeID name. For example, to change the direct access mode
query string parameter from targetTypeID to DirectAccessTarget, modify the
AdaptiveImageProcessorConfig tag in web.config as follows.
<AdaptiveImageProcessorConfig
ImageSizeThresholdKB="80"
Level1CacheSize="5000"
Level2CacheSize="500"
Level2CacheItemThresholdKB="256"
EnableL2Caching="true"
DirectAccessQueryString="DirectAccessTarget">

After you change the parameter, your syntax is as follows:
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<img src="uploadedimages/testfile.jpg?DirectAccessTarget=LowRes"/>

Using Geographic Data from a Mobile Device
If your site visitor is on a mobile device, the geographic location of your site visitor becomes
very important information. For example, if a mobile visitor is accessing your site, you can
display nearby stores and special promotions. To create a geographically aware Web
experience with Ektron, follow these steps.
1. Create content with MapLatitude and MapLongitude geo-location metadata. This
metadata is automatically added when you publish content with a street and city address
in the MapAddress field.

2. Place the Map on page 1765 server control in a mobile device template.
3. Because of the size of a mobile device, you may want to rearrange the content list, map
image, and search components provided by the Map server control. To do this, change
the standard map EkML file. See Controlling Output with Ektron Markup Language on
page 1905 and the sample file [siteroot]/workarea/template/map/map.ekml.
To learn more about using geolocation, see the Map on page 1765 server control and Using
the Map Server Control on page 590.
After finishing the previous steps, use your mobile device (if it has GPS capability) to browse
to the template that contains the map; it shows your location at the center of the map. For
other mobile devices, the center of the map is the Latitude and Longitude coordinates set by
the Map server control. Content locations appear as map pins, and the content list is sorted by
distance from the current location (with GPS) or map center.
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Updating the Wireless Universal Resource File
NOTE: The commercial license between Ektron Inc. and ScientiaMobile, Inc., the owner of WURFL,
expired on April 3rd, 2016. You have the following options:
l
Disable the WURFL data repository in your deployment so that you are not using WURFL in an
unlicensed manner.
l

l

Contact Scientiamobile, Inc. to obtain a license directly. ScientiaMobile, Inc. has provided a guide to
transitioning.
Replace the WURFL data repository with the 51 Degrees(TM) Lite library by 51Degrees.mobi,
which is licensed under an Mozilla Public License open-source license agreement.

When a device requests information from a Web server, HTTP headers are passed to the
server along with the image URL. The HTTP headers contain information that identifies the
type of device that is doing the request. Because new mobile devices are being created every
day, it is important for your website to detect these devices when they are available and
present the appropriate experience to visitors who use these devices when they visit your
site.
Each time a user clicks on the View All Device Groups folder, Ektron determines whether
more recent device information is available.
1. Go to Workarea > Settings > Configuration > Mobile Settings > View All
Device Groups. If your WURFL file is not up-to-date, you are given the opportunity to
update it.
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Additional Mobile Information

2. Click Update.

Additional Mobile Information
l

Should You Consider an M(dot) Site Strategy for Mobile?

l

Mobile-friendly: The mobile web optimization guide

l

Mobile HTML5

l

The Mobile Revolution: Move Beyond Mobile Friendly and Engage Mobile Visitors

l

Mobile First, Last, and Always: 5 Responsive Design Sites on Ektron

l

Why Adaptive Imaging is a Big Deal

l

Adaptive Images: How They Impact Social Media and SEO

l

Breakpoints: Planning for Different Device Sizes

l

Why Responsive Design Changes the Game for Website Templates

l

The Value of a Responsive Design: Who Really Benefits?

l

Which Responsive Framework is Right for You?

l

Responsive Web Design: Now for Marketers, Not Just Developers and Designers

l

Responsive Web Design or Native Apps? What's the Real Future of Mobile Advertising?

l

Building Blocks and Tools for Responsive Web Design: Part 1 - For Developers

l

Building Blocks and Tools for Responsive Web Design: Part 2 - For Marketers

l

The Broken Mobile Paradox Part 1: The Different Ways to Create a Mobile Strategy

l

The Broken Mobile Paradox Part 2: Server-Side Device Detection

l

The Broken Mobile Paradox Part 3: Responsive Web Design

l

The Broken Mobile Paradox Part 4: RESS

l

What the Mobile Web Means for Marketers Part 1: RWD

l

What the Mobile Web Means for Marketers Part 2: Adaptive Images
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Ektron's Cloud Manager simplifies the process of creating, deploying and managing websites
and assets to the cloud. The cloud lets you deal with different traffic patterns on an as-needed
or on-demand basis because space and computing power are virtual and expandable. Because
the cloud pools its resources to be used by many customers, and provide pay-as-you-go
pricing, the cloud provides significant cost benefits to on-premises resource planning and use.
Most services do not require long-term commitments or up-front expenses.
The following images show website usage patterns of rapid growth, bursts in traffic, and
active or dormant periods. These patterns can be costly to manage on your own but the costs
are mitigated when you use the cloud to distribute your site load.

This section also contains the following topics.
CDN Benefits in the Cloud
Before You Install to the Cloud
Using Ektron in the Amazon EC2 Cloud
Using Ektron in the Windows Azure Cloud
Troubleshooting Ektron Cloud Deployment
Additional Cloud Information
Consider the following cloud service models:
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CDN Benefits in the Cloud

l

l

l

Infrastructure as a Service (IaaS) is a set of infrastructure capabilities, (such as an
operating system, network connectivity, content delivery network (CDN) and so on),
that are delivered as pay-for-use services that you can use to host applications. You are
responsible for monitoring, backups, and upgrades of your applications.
o You can run Ektron CMS on any virtualized Windows environment, which includes
Hyper V from Microsoft, Amazon, RackSpace and Vmware virtualization platforms.
Ektron Cloud Manager supports the provisioning of site assets on Amazon S3 and
Microsoft Azure Blob.
o

You can deploy assets into cloud-based storage, which includes Internet-level
scaling and the flexibility to access software from anywhere.

o

You can leverage a CDN service without making a major investment, including
restructuring the sites to work with a CDN, (which is a must for every website
because CDNs are an easy way to increase a website performance and enhance the
user experience of the site). Major cloud vendors provide CDN services at
competitive prices.

Platform as a Service (PaaS) provides a higher-level set of functionality that are
delivered as consumable services for developers who are building applications. PaaS
abstracts developers from the underlying infrastructure, enabling applications to be
composed rapidly. Cloud vendors are responsible for services except for data and
applications.
Software as a Service (SaaS) are applications that are delivered for an organization
to use, paying for the use of applications without concerns about the operating system,
upgrades, or availability of the applications. A cloud vendor maintains the applications
running in the SaaS. Some examples of SaaS-based applications include Office 365,
Salesforce, and HubSpot.

CDN Benefits in the Cloud
You can achieve major performance enhancements by using a Content Delivery Network
(CDN) in the cloud to serve static files, assets, large files, and stream data. Selecting a CDN
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vendor is similar to selecting any other product or service, so be certain that the CDN you
choose meets your site requirements. Cloud vendors have simplified the management
interfaces and APIs to load and manage cloud storage, but you will need to synchronize your
assets. The following are key benefits of operating in the cloud CDN.
l

l

l

Performance—Loads website assets faster globally and also decreases the load on the
production environments. User experiences improve yielding increased conversion
rates, sales, and profits.
Improved SEO—Improves the SEO ranking because search engines give preference to
faster sites.
Operational—Reduces operational costs by offloading your Web server and making
your infrastructure more reliable and scalable because there is no single point of failure.

A CDN is “a large distributed system of servers deployed in multiple data centers on the
Internet” that cooperate to deliver content. The following figure shows how a CDN in the cloud
gives you optimal site performance. Typically, when a person visits your site, an Origin
server services the visit. If site visitors from all over the world are making requests from the
Origin server, the high traffic and distance slows the server response, and inhibits the user
experience. A CDN in the cloud gives you a large, distributed system of servers, called Edge
servers, that cache content, images, style sheets, JavaScript, and more. Site assets are
downloaded from the closest accessible CDN server, improving availability and response
time.

The following events occur on a cloud-enabled website as shown in the following image:
1. Development is on-premises at the Origin server ( ), and Staging and Production are in
the cloud. Content passes among the Development, Staging, and Production servers.
2. Assets are distributed to Edge servers ( ) through cloud storage. (blue arrows)
3. An end user ( ) accesses your site through a Web server. (red arrows) Dynamic content
is retrieved from the SQL database, which can be stored in the cloud, or on-premises.
4. Static content is retrieved from the nearest Edge server ( ) and passed to the Web page.
(black arrow)
Assets are distributed through the provisioning process.
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With Ektron’s Cloud Manager, storing assets in the cloud is completely transparent to the CMS
users. Assets are synchronized among the Edge servers in and out of cloud storage without
the need for customizations or specialized CDN knowledge. By enabling cloud-based storage
with a CDN, assets are cached globally through CDN servers. This produces high-performance
sites and does not bog down the site’s Origin server. You only need to configure the Cloud
Manager to point to your Amazon S3 or Microsoft Azure Blob storage services.
Cloud Manager has the following benefits:
l

l

Wizard-based cloud provisioning
o Easily create and deploy ASP.NET websites to the cloud with just a few clicks
o

Eliminate total dependence on IT

o

Leverage other cloud services like CDN, load balancing and caching

Flexible deployment
o Reduces time-to-scale
o

Deploy entire sites or specific assets to leverage cloud CDNs
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l

l

o

Manages content changes easily through a true hybrid cloud deployment

o

Easily keep content in sync across all deployments

o

Mix and match cloud instances with traditional on-premises Ektron instances or
deploy entire site environments in the cloud

Optimal performance
o Deliver sites at unlimited scale through the scalability and elasticity of the cloud
o

Centralized management of key cloud capabilities

o

Schedule instance usage to easily handle predicted site traffic

Significant cost reductions; a savings of up to 80% over on-premises options in most
cases.

l

Unlimited scalability

l

Connects your on-premises infrastructure with the cloud

Before You Install to the Cloud
This topic contains step-by-step instructions to set up and run Ektron applications in the
Amazon Cloud or the Windows Azure Cloud. You must be a member of the Administrator
group to perform these tasks.
Before you install or use the Ektron cloud manager, Ektron administrators and developers
should first build the system for On Premises use and then follow the instructions in this
documentation to get it running in cloud. You also should understand the following:
Amazon Cloud
l

158

You should have a valid subscription from the Amazon portal.
1. Log into the Amazon Web Services (AWS) console with your account information.
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Choose Account > Security Credentials. The page displays your access credentials.

l

l

l

After deployment, and before running eSync from your local machine, you need to apply
the certificates located at C:\Program Files
(x86)\Ektron\EktronCloud\bin\worker\certificate to your local machine.
Use the Amazon deployment wizard for proper configurations. See Deploying a Site
Package to Amazon on page 162.
The following are not supported as of this printing:
o Active directory
o

multi-site

Windows Azure Cloud
l

l
l

l

You must have Windows Azure SDK 1.7 (June 2012) on a development machine or onpremises server.
You should have a valid subscription from the Windows Azure portal.
The following are not supported as of this printing:
o Active directory
o

multi-site

o

eCommerce

o

Web Alerts

o

Notification Services

o

Diagnostic Services

Use the Azure deployment wizard for proper configurations. See Deploying a Site
Package to the Azure Cloud on page 183.

Other Considerations
l

Run the security configurator and generate certificates before you deploy the Ektron
cloud manager.

l

You must start instances before running database or template synchronizations.

l

Ektron eSync deploys the data to SQL databases and file resources to Blob storage.

l

Connecting an SQL database through enterprise manager requires SQL Server 2008R2
for SQL Management studio (or greater).

l

You can use both website and Application model as of this printing.

l

SQL database licensing limits the maximum database size.
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Using Ektron in the Amazon EC2 Cloud
The following sections show you how to use Ektron in the Amazon Elastic Compute Cloud
(EC2).
The following image shows an overview of Ektron in the Amazon EC2 cloud.

l

Amazon S3 Storage—a cloud storage for Ektron site-specific assets, including
templates.

l

Amazon RDS—a cloud database for all Ektron site-specific content.

l

Amazon EC2 Search and DxH—Ektron-specific site service instances.

The following image shows an overview of provisioning Ektron in the Amazon EC2 cloud.
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Setting Up the Amazon EC2 Security Groups and
Amazon RDS DB Security Groups
You need to set up your security certificate before deploying a site package to your Amazon
cloud site.
1. Log into the Amazon Web Services (AWS) console with your account information.
2. From the AWS console, choose Services > RDS.

3. In the left Navigation panel, choose Databases > DB Security Groups. The Amazon
RDS: My DB Security Groups screen appears.
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4. Select the Security group.
5. In the Description tab, select CIDR/IP in the drop-down menu.
6. Specify the IP address from which the administrator can access the database and click
Add. The specified IP address appears in the list.

Deploying a Site Package to Amazon
Download and Install EktronCloudSetup.exe
Install EktronCloudSetup.exe.
After you download and install EktronCloudSetup.exe, the Cloud Manager is added to the
Workarea Settings.

Create the Initial Deployment on Amazon
To create the initial deployment on the amazon cloud:
162
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IMPORTANT: You must first install EktronCloudSetup.exe. See Download and Install
EktronCloudSetup.exe on the previous page.
1. In the Workarea, choose Settings > Configuration > Cloud Manager.
2. Choose Create Hosted Service and select Amazon Web Services.

3. Click Next. A wizard appears (Step 1 of 5: Amazon Hosted Service). Fields with a red
asterisk (*) are required.

a. Cloud Site Name *—Specify a name for the site to deploy to the Cloud. (The
name also is used to pre-fill Bucket Name and Database Name fields on other
screens.)
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b. AWS Access Key *—Specify your Amazon Web Services (AWS) Access Key, which
identifies you as the responsible party for service requests.
c. AWS Secret Key *—Specify your Amazon Web Services (AWS) key.
d. Hosted Service Location—Select the location that is nearest to your hosted
service.
e. Web Instances—Choose the number of servers on which the load will be
balanced.
l
1—no load balancing.
l

more than 1—load balance equally among the number of servers you choose.

f. Web Instances Type—Choose 1 of the following types for your Web virtual
machine. This is your website and you can have as many instances as you want.
Each option is described at Amazon EC2 Instance Types.
l
c1.medium (default)—High-CPU instances—5 ECUs—2 Cores—613 MB
l

c1.xlarge—High-CPU instances—20 ECUs—8 Cores—7 GB

l

m1.small—Standard instances—1 ECU—1 Core—1.7 GB

l

m1.medium—Standard instances—2 ECUs—1 Core—3.7 GB

l

m1.large—Standard instances—4 ECUs—2 Cores—7.5 GB

l

m1.xlarge—Standard instances—8 ECUs—4 Cores—15 GB

l

m2.xlarge—High-Memory instances—6.5 ECUs—2 Cores—17.1 GB

l

m2.2xlarge—High-Memory instances—13 ECUs—4 Cores—34.2 GB

l

m2.4xlarge—High-Memory instances —26 ECUs—8 Cores—68.4 GB

g. Support OS Instance—Windows 2008 R2 is the only option at this time.
4. Click Next. Step 2 of 5: the Hosted Service Storage and Security dialog box appears.
Fields with a red asterisk (*) are required.

IMPORTANT: Make sure that you first import the certificate (.cer) into the Management
Certificate and then add the .pfx file to the cloud service.
a. Bucket Name *—This field is already filled with the Cloud Site Name you specified
but you can change it. It must be a unique name. The bucket is a container for your
files.
b. Ektron License Key—This field is already filled with your Ektron license. You can
specify a different valid license key for the cloud site.
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c. Key Pair *—Choose from a list of existing key pairs, or specify a new one.
IMPORTANT: For Amazon deployments only: To be able to connect to the EC2 cloud
(VM) instance, you need a private key file (.pem) for the key pair that is used during the cloud
deployment. If you create a new key pair when you run the deployment wizard, the
CloudPemFile folder is created in the Ektron on-premises Windows Service install directory
(C:\Program Files (x86)\Ektron\EktronWindowsService40) and the .pem file is
located there. If you enter an existing key pair, you must have an existing .pem file or you
cannot connect to the EC2 VM; you cannot update the key pair on EC2 instance later.
d. Security Group Settings *—Choose from a list of existing security group names,
or specify a new one.
1. In the AWS console, choose Services > EC2.

2. On the left Navigation panel, choose Network and Security > Security
Groups.

3. Select the name of the security group you want to see. The Inbound tab
displays information about the selected security group.
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5. Click Next. Step 3 of 5: Amazon Database Connection dialog box appears. Fields with a
red asterisk (*) are required.
IMPORTANT: You should have completed the steps in Setting Up the Amazon EC2 Security
Groups and Amazon RDS DB Security Groups on page 161 to complete this wizard step.
l

If you choose an existing database, fill in the following fields and click Next.

a. Database Name *—This field is already filled with the Cloud Site Name you
specified but you can change it.
b. Database Server *—Choose from a list of existing database servers, or
specify a new one.
c. SQL Server Username *—Specify up to 128 alpha-numeric characters (no
spaces) for the database administrator account name. The first character must
be a letter, and you cannot use reserved words.
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d. SQL Server Password *—Specify at least 8 and up to 128 alpha-numeric
characters (no spaces) for the password for the account.
l

If you choose to create a new database, the screen expands for additional data.

a. Database Name *—This field is already filled with the Cloud Site Name you
specified but you can change it.
b. Database Server *—Choose from a list of existing database servers, or
specify a new one.
c. Database Instance Type *—Choose Web Edition, Express Edition, or
Standard Edition. For information about instance types classes, see
SQL Server Editions and DB Instance Classes at Amazon Web Services.
NOTE: The Standard edition supports notification service capabilities; Web and
Express editions do not support notifications service capabilities.
d. SQL Server Username *—Specify up to 128 alpha-numeric characters (no
spaces) for the database administrator account name. The first character must
be a letter, and you cannot use reserved words.
e. SQL Server Password *—Appears if you create a new database: Specify at
least 8 and up to 128 alpha-numeric characters (no spaces) for the password
for the account.
f. Re-enter SQL Server Password *—Type the password for the account
again.
g. Database Instance Class *—This value is automatically filled in based on
the instance type you chose, but you can specify another value. Options are:
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o

Small

o

Large

o

Extra Large

o

2Xtra Large

o

4Xtra Large.

h. Server Name Prefix *—Specify up to 63 alpha-numeric characters (no
spaces; up to 15 for an SQL server) for the prefix that will help you uniquely
identify your server. The prefix name must begin with a letter and cannot have
consecutive dashes or end in a dash .
i. Storage Size *—The range you can specify (in gigabytes) is determined by
the instance type you chose.
o Web Edition—30 to 1024
o

Express Edition—30 to 1024

o

Standard Edition—200 to 1024

6. Click Next. Step 4 of 5: Deploy Site to Amazon Hosted Service appears.
7. Click Save. A profile is created on the View All Hosted Services screen where you can
deploy the site at a later time.

8. Then, Step 5 of 5: Deploy Site to Amazon Hosted Service appears. Click Deploy Site.

Ektron creates or uploads a new min database, provisions a storage container, creates
the deployment package, and deploys them into a hosted cloud service. A confirmation
message appears.
If you choose to deploy the site at another time, click Close; the View All Hosted
Services screen appears with the new profile. To deploy the site, click the Deploy Site
icon ( ).
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To view or edit the profile, click on the Template & Database - Upload link. The View
Profile "Template & Database - Upload" screen appears. For more information, see in
the next section.

Synchronize the Database and Templates
In this step, you use eSync to copy a site from a local server to the cloud. For more
information on this screen, see Setting up eSync Profiles on page 1512.
To synchronize the database and templates:
1. Choose Workarea > Settings > Configuration > Cloud Manager. The view panel
displays the instances of databases.
2. Run the default profile that was created by the deployment.
IMPORTANT: Without running this profile your data and resource is not transferred to cloud. You
can create additional profiles to perform a similar operation.
3. Click Add Profile ( ) to create a profile for the template. The Add Azure
Synchronization Profile screen appears. You can create additional profiles for the
database.
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l

l

Local Site Name—Specify the site that you want to synchronize.

l

Cloud Database Name—Specify the database that you want to synchronize.

l

l
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Profile Name—Give a unique name to this synchronization profile. You can have
several profiles to synchronize different elements at different times and
frequencies.

Items to Synchronize—You can synchronize everything, or select the portions
you want to synchronize on schedule, managing the synchronization activity.
Include/Exclude Files—Not supported.
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l

Synchronization Direction—Choose which way you want to synchronize the
sites.
NOTE: Templates can only be uploaded.

l

l

Conflict Resolution Policy—When there is a conflict between the local and cloud
sites, choose which site resolves the conflict.
Schedule—Choose the frequency of the automatic synchronization.

4. Specify a name, uncheck Database/Resources and CMS Core, and check the items
you want to synchronize.
5. Click Save Synchronization Profile. The profile is saved and the View Azure Hosted
Services screen appears.
6. In the Action section of the profile you just saved, click Sync (
database and templates.

) to synchronize the

Manage the Cloud Instances
In the View Azure Hosted Services screen (Workarea > Settings > Configuration >
Cloud Manager), you can modify cloud instances in the following ways:
l
l

l

Start the instance—If the icon is green, the instance is stopped; click to start it.
Stop the instance—If the icon is red, the instance is running; click to stop it.
Configure Load Balancing—Modify the number of instances. One (1) instance
means no load balancing; more than 1 instance balances the load equally among
instances.
NOTE: The DNS mapping needs to be changed when moving from 1-to-many or many-to-1. There
also will be disruption to a live site when making changes.

l

Schedule Cloud Event—Display or set cloud event schedules.

l

Get Status (Hosted Service)—Display the status of all profiles.

l

Delete Hosted Service—Removes the instance from the list.

l

Add Profile—Add a new profile.

l

Sync—Synchronize the database and templates.

l

Get Status (Profile)—Display the status of the selected profile.

l

Delete Profile—Removes a selected profile.

Schedule Cloud Events
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1. Go to Settings > Cloud Manager. The Cloud Manager screen appears.

2. Click Schedule Cloud Events (

). The View Schedule Cloud Events screen appears.

3. Click Schedule Cloud Event. The Schedule Cloud Event screen appears for you to fill in
the fields.

l
l

l
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Description—Describe what the event does.
Event Type—
o Edit Instances—Change the number of instances.
o

Deploy Site—Deploy the site.

o

Delete Deployment—Opens a selector to choose sites that you want to
delete.

Number of Web Instances—The number that you specify will overwrite the
number of instances that were set up with the initial deployment.
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l
l

Scheduled Date and Time—Specify when the event will occur.
Email Notifications—Send an email to the address list. Use commas to separate
the addresses.

4. Click Save. The event appears on the View Scheduled Cloud Events screen.

Creating a New Amazon Virtual Machine
1. Log into the Amazon Web Services (AWS) console with your account information.
2. Choose Services > EC2.

3. Click Launch Instance. The Create a New instance Wizard appears.
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4. Select Classic Wizard and click Continue.

5. Complete the wizard.

Setting Up eSync to a Cloud Instance
Ektron’s sync technology, built on the Microsoft Sync Framework, synchronizes information
between the Amazon cloud and on-premises data repositories. eSync makes it easy to
manage content changes through a true hybrid cloud deployment.
When you run eSync, SQL data and file system resources (such as ~/assets,
~/privateassets, ~/uploadedfiles, ~/uploadedimages, assetlibrary) are synched to
SQL Database Cloud Blob Storage.

IMPORTANT: After deployment on an Amazon AWS account, and before running eSync from your local
machine, you must apply the certificates located at C:\Program Files
(x86)\Ektron\EktronCloud\bin\worker\certificate to your local machine.

Setting Up Search Server and Ektron Search
Configuration Using Amazon EC2
This section explains how to connect Ektron in an Amazon environment to a search server
running on Amazon EC2. As a result of this connection, search querying and crawling occur in
the cloud.
If you are using Ektron in the cloud, there are many advantages to running search in the cloud
also, such as performance, scalability, etc.
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PREREQUISITES
You completed all tasks in these sections and deployed Ektron in an Amazon
environment:
l

l

Setting Up the Amazon EC2 Security Groups and Amazon RDS DB Security Groups on
page 161
Setting Up eSync to a Cloud Instance on the previous page

1. Deploy site to Amazon cloud. See Deploying a Site Package to Amazon on page 162.
2. Create security group to include TCP ports 8732 and 7500.

3. Create an EC2 instance in Amazon using any Windows 2008 server image and use the
security group that you created. This instance will be used as the search server.
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4. Make sure IIS is installed on the EC2 instance.
5. Add inbound rules to allow TCP communication for ports 8732 and your Ektron search
site (7500 is the default). To do that:
a. Go to Control Panel > Check Firewall Status > Advanced Settings.
b. Select Inbound Rules, then right click and select New Rule.
c. Select Port radio button and click Next.
d. Click the TCP radio button.
e. Click Specific Local Ports, then add port 7500 (7500 is the default) and click
Next.
f. Select Allow the connection and click Next. "When does this rule apply?"
appears. Accept all defaults and click Next.
g. Assign a name to the inbound rule and click Finish.
h. Repeat these steps for port 8732.
6. Copy Microsoft Search Server 2010 Express (SearchServerExpressInstall.exe from
C:\Program Files (x86)\Ektron\CMS400vxx\Utilities\SearchServer\ to the
search server.
7. Run SearchServerExpressInstall.exe and choose the Standalone option. See Setting
Up Microsoft Search Server 2010 Express on page 864.
8. Copy EktronSearchConfiguration.exe from C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SearchServer\ to the search server.
9. Run EktronSearchConfiguration.exe on the search server. See Setting Up Microsoft
Search Server 2010 on page 871.
10. Check if EktronSearchServerService and EktronPHFileHelperService are installed
and running.
11. Add Search Server Administrator to the EktronSearchServerService service.
12. Add the SharePoint Central Administration Site Port (46476 for example) to the Security
group that was created in step 2.
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13. Add a host entry on cloud EC2 so it can communicate with the search server. For
example, add 54.235.156.122 amazona-j0j933l to the host file on the EC2 cloud
(where 54.235.156.122 is an elastic IP and amazona-j0j933l is a machine name).
NOTE: In the load-balanced environment, each EC2 instance must have a host entry for search to
work.
14. On the EC2 cloud, open C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SearchServer and run
Ektron.cms.search.config.UI. Use a SharePoint Administration URL, for example:
http://amazona-j0j933l:46476See Also: Logging into Ektron's Search Server
Configuration Screen on page 926

Setting Up DxH on Amazon EC2
PREREQUISITE
You completed setting up and deploying Ektron to the Amazon cloud.
l

l

Setting Up the Amazon EC2 Security Groups and Amazon RDS DB Security Groups on
page 161
Setting Up eSync to a Cloud Instance on page 174

1. Deploy a site to Amazon cloud. See Deploying a Site Package to Amazon on page 162.
2. Create a security group to include TCP port 808.
3. Create an EC2 instance in Amazon using Windows 2008 server with SQL Server image
and use the security group that you created. This instance is used as the DxH server.
4. Make sure IIS is installed on the EC2 instance.
5. Add inbound and outbound rules to allow TCP communication for port 808. To do that:
a. Go to Control Panel > Check Firewall Status > Advanced Settings.
b. Select Inbound Rules, then right click and select New Rule.
c. Select Port radio button and click Next.
d. Click the TCP radio button.
e. Click Specific Local Ports, then add port 808 and click Next.
f. Select Allow the connection and click Next. "When does this rule apply?"
appears. Accept all defaults and click Next.
g. Assign a name to the inbound rule and click Finish.
h. Select Outbound Rules, then right click and select New Rule.
i. Select Port radio button and click Next.
j. Click the TCP radio button.
k. Click Specific Local Ports, then add port 808 and click Next.
l. Select Allow the connection and click Next. "When does this rule apply?"
appears. Accept all defaults and click Next.
m. Assign a name to the outbound rule and click Finish.
6. Install and configure DxH in the VM. See Installing and Configuring DxH on page 996.

Using Amazon S3 as a Storage System
Ektron 8.7
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You can connect multiple storage systems and provision Amazon S3 Storage to store static
files such as assets, privateassets, uploadedimages, uploadedfiles.
1. Sign in into http://aws.amazon.com.
2. Create the storage account. (You need to know how to get your accountId and
accountKey.)
3. Create the sync relationship.
4. Open the database and update the external_args as follows.
declare @scheduleid bigint
set @scheduleid=0
update scheduler set server_type=1, external_args=N' <CloudServiceRequest
xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<SubscriptionID>
[Place your Subscription Id here if you are connecting from the Azure cloud
service.
If you are connecting from another datacenter, leave this empty.]
</SubscriptionID>
<StorageAccountID>[Amazon Storage AccountId]</StorageAccountID>
<StorageAccountKey>[Amazon Storage Account Key]</StorageAccountKey>
<CDNEndpoint />
<ContainerConfigName>amazon</ContainerConfigName>
<WebSites>
<SiteInfo>
<ContainerAddress>[Your Bucket Name]</ContainerAddress >
<LocalSitePath>[Your local website path ex., c:\inetpub\site1]
</LocalSitePath>
</SiteInfo>
</WebSites>
</CloudServiceRequest>'
where scheduleid=@scheduleid

5. Run the synchronization it will now synchronize all the resource (assets,
privateassets, uploadfiles and uploadedimages) into S3.
6. Open web.config and make the following changes to read/write files directly onto S3
a. Replace the <unity.storage> as follows:
<unity.storage>
<assembly name="Ektron.Storage" />
<assembly name="Ektron.Cloud" />
<namespace name="Ektron.Cloud.Amazon.Storage" />
<namespace name="Ektron.Storage" />
<container name="storageContainer">
<register type="IFileService" mapTo="ES3FileService" />
<register type="IDirectoryService" mapTo="ES3DirectoryService" />
</container>
</unity.storage>

b. Add the following key in the appsettings section:
<add
<add
<add
<add
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key="AWSAccessKey" value="[Your Access Key]" />
key="AWSSecretKey" value="[Your Secret Key]" />
key="BlobStorageName" value="[Your Bucket Name]"/>
key="BlobOrCdnUrl" value="[Your S3 or CloudFront URL]" />
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c. Configure the following handler into the Module section:
<add name="EkBlobModule" type="BlobRedirectModule"
preCondition="integratedMode" />

Using Ektron in the Windows Azure Cloud
Setting Up the Azure Cloud Portal
IMPORTANT: Azure has 2 portal endpoints: http://windows.azure.com (old portal) and
https://manage.windowsazure.com (new preview portal). You need to use the new portal for all the new
features such as VM, and use the old portal for all other functionality. When following instructions in this
document, if you are redirected to new portal, you can click on your profile icon to redirect back to the old
portal.
The following sections describe the steps you take to set up your portal.
1. Sign Up below
2. Install a Cloud Server Certificate below
3. Create a Hosting Service on the next page
4. Create a Storage Account on page 181
5. Create a CDN Endpoint on page 182
6. Create an SQL Premium Server Virtual Machine from the Azure Portal on page 183

Sign Up
Windows Azure hosting requires Windows Live-ID sign on using your email address and
subscription, which can be purchased from Microsoft at https://www.windowsazure.com.
When you have the subscription, go to https://windows.azure.com or
https://www.windowsazure.com and log in using your Live-ID and password.

Install a Cloud Server Certificate
To install a cloud server certificate:
1. From the home page of https://manage.windowsazure.com, click Settings in the left
menu. The Settings screen appears.
2. Click the Management Certificates at the top of the Settings screen.
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3. Click Upload at the bottom of the Setting screen. The Upload screen appears.

4. Choose a subscription from the drop-down list.
5. Click Browse Your Computer and choose EktronCloud.cer from the following path:
l
64-bit system:
~\Program Files (x86)\Ektron\EktronCloud\mgtcert
l

32-bit system:
~\Program Files\Ektron\EktronCloud\mgtcert

6. Click OK (check mark).

Create a Hosting Service
NOTE: This is an optional step. If you do not create the hosted service, Ektron creates it for you.
To create a hosting service:
1. From the home page of https://manage.windowsazure.com, click New Hosted
Service. The Create a New Hosted Service dialog box appears.
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2. Enter the name of your service.
3. Enter the URL prefix for your service. If your host name is mydomain then your URL will
be mydomain.cloudapp.net, which is used to set up the CNAME rec and location.
4. Choose a region.
5. Click Do not deploy.
6. Click OK.

Create a Storage Account
You need a storage account to store site resources in the cloud storage service, and to store
and synchronize assets, private assets, uploaded files, uploaded images and asset library. To
create a storage account:
1. From the home page of https://manage.windowsazure.com, click New Storage
Account. The Create a New Storage Account dialog box appears.
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2. Enter your URL.
3. Choose a region.
4. Click OK.

Create a CDN Endpoint
Content Delivery Network (CDN) serves files faster from distributed servers. For better
performance, Ektron recommends that you define the endpoint for your storage accounts. To
create a CDN endpoint:
1. From the home page of https://manage.windowsazure.com, click Hosted Services,
Storage Accounts & CDN.
2. Click on CDN in the left navigation panel.
3. Click New Endpoint. The Create a New CDN Endpoint dialog appears.

4. Choose the hosted service from the drop-down menu.
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5. Optionally check Enable CDN, HTTPS, and Query String.
6. Click OK.

Create an SQL Premium Server Virtual Machine from the
Azure Portal
Make sure your endpoint is configured for incoming traffic in both Azure portal and the virtual
machine by setting the default port to 1433 (or any custom port number).

Deploying a Site Package to the Azure Cloud
After you set up the portal, following these steps to get your code running in the Azure cloud.
1. Download and Install EktronCloudSetup.exe below
2. Create the Initial Deployment on Windows Azure below
3. Synchronize the Database and Templates on page 169
4. Manage the Cloud Instances on page 191
5. Schedule Cloud Events on page 191
6. Set up Ektron Storage on page 193
7. Set Up Ektron Caching on page 193
8. Set the SQL Premium Database Connection String on page 194
9. Set the Blob Redirect Handler on page 194
10. Create a Cloud Package on page 194

Download and Install EktronCloudSetup.exe
Install EktronCloudSetup.exe.
After you download and install EktronCloudSetup.exe, the Cloud Manager is added to the
Workarea Settings.

Create the Initial Deployment on Windows Azure
To create the initial deployment:
IMPORTANT: You must first install EktronCloudSetup.exe. See Download and Install
EktronCloudSetup.exe above. You must also upload the certificate to the portal and configure it to the
cloud service before following this procedure.
1. In the Workarea, choose Settings > Configuration > Cloud Manager.
2. Choose Create Hosted Service. A wizard appears (Step 1 of 4: Hosted Service and
Storage). Fields with a red asterisk (*) are required.
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a. Subscription ID—You can get this from https://manage.windowsazure.com.
1. Click on Hosted Services, Storage Accounts & CDN.
2. Click the Storage Account folder.
3. Copy and paste the Subscription ID from the Properties panel.
b. Hosted Service Name—Specify the name of the server.
c. Hosted Service Location—Select the location that is nearest to your hosted
service.
d. Deployment Environment—Choose either Production (Friendly URL) or
Staging (GUID-based URL).
e. Web Virtual Machine Size—Choose Small, Medium (default), Large, or Extra
Large for your Web virtual machine. This is your website, and you can have as
many instances as you want. Each option is described at Amazon EC2 Instance
Types.
f. Web Instances—Choose the number of servers on which the load will be
balanced.
l
1—no load balancing.
l
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more than 1—load balance equally among the number of servers you choose.
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g. Worker Virtual Machine Size—Choose Small (default), Medium, Large, or
Extra Large for your windows service virtual machine. You can have only 1
instance of this virtual machine.
3. Click Next. Step 2 of 4: the Hosted Service Storage and Security dialog box appears.
Fields with a red asterisk (*) are required.

IMPORTANT: Make sure that you first install the certificate (.cer) into the Management
Certificate and then add the .pfx file to the cloud service. See Also: Install a Cloud Server
Certificate on page 179.
a. Storage Account—Specify the name of the storage account that you created in
Create a Storage Account on page 181.
b. CDN—Specify the URL with the Content Delivery Network (CDN). You can get this
from https://manage.windowsazure.com.
1. Click Hosted Services, Storage Accounts and CDN.
2. Click the CDN folder.
3. Click the server name with a CDN endpoint type.
4. Copy and paste the Default HTTP Endpoint from the Properties panel. Be
sure to start the URL with http:// and place a trailing slash (/) on the end.
c. License Key—Optionally, specify the license key.
d. Security Protocol Setting—Choose HTTP or HTTPS.
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e. Security Certificate Thumbprint—If you select HTTPS, you must also specify
the hexadecimal string that contains the SHA-1 hash of the certificate.
f. Caching—By default, Ektron uses the inmemory caching. However, Ektron uses the
AppFabric provider to set up the session state to use inproc.
1. Go to the portal.
2. Click Service Bus, Access Control & Caching.
3. Go to Services > Caching.
4. Click an active namespace.
5. Click View Client Configuration.
6. Copy the XML and paste it in the Caching box.

4. Click Next. Step 3 of 4: Azure SQL Database Connection dialog box appears. Fields with
a red asterisk (*) are required.
WARNING! As of August 2014, the Azure SQL database is no longer supported. Choose Do not
create SQL Database in the Database Option drop-down field.
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l

l
l

Database Option—Create SQL [Premium] Database is the default database
option. If your database is already set up, choose Do not create SQL Database.
Database Size—Select the size of your database.
SQL Database Server—You can get the premium server name from the
https://manage.windowsazure.com portal: click Database and look under the
Subscriptions folder for the server name.

l

Database Name—Specify the name of the database.

l

Administrator Login Name—Create the database administrator account name.

l

Password—Specify the password for the account.

5. Choose to create a new package or upload an existing package to deploy to the cloud.
The newly created deployment package is stored at:
~\sync\azuredeploy\{subscription-id}\{servicename}\package\
{servicename}.cspkg
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l

If you choose to create a new package, you get the following dialog box..

l

If you choose to upload your files, click the Browse buttons to select the files.

An advanced user can copy the Web.Cloud.config file from Ektron Windows service
(~\Program Files (x86)\Ektron\CMS400vxx\AzureConfig).
6. Click Save. A profile is created on the View All Hosted Services screen.
7. The Create Azure Hosted Service screen appears. Click Deploy Site. Ektron creates or
uploads a new min database, provisions a storage container, creates the deployment
package, and deploys them to a hosted cloud service. A confirmation message appears.
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Synchronize the Database and Templates
In this step, you use eSync to copy a site from a local server to the cloud. For more
information on this screen, see Setting up eSync Profiles on page 1512.
To synchronize the database and templates:
1. Choose Workarea > Settings > Configuration > Cloud Manager. The view panel
displays the instances of databases.
2. Run the default profile that was created by the deployment.
IMPORTANT: Without running this profile your data and resource is not transferred to cloud. You
can create additional profiles to perform a similar operation.
3. Click Add Profile ( ) to create a profile for the template. The Add Azure
Synchronization Profile screen appears. You can create additional profiles for the
database.
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l

l

Local Site Name—Specify the site that you want to synchronize.

l

Cloud Database Name—Specify the database that you want to synchronize.

l

l
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Profile Name—Give a unique name to this synchronization profile. You can have
several profiles to synchronize different elements at different times and
frequencies.

Items to Synchronize—You can synchronize everything, or select the portions
you want to synchronize on schedule, managing the synchronization activity.
Include/Exclude Files—Not supported.
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l

Synchronization Direction—Choose which way you want to synchronize the
sites.
NOTE: Templates can only be uploaded.

l

l

Conflict Resolution Policy—When there is a conflict between the local and cloud
sites, choose which site resolves the conflict.
Schedule—Choose the frequency of the automatic synchronization.

4. Specify a name, uncheck Database/Resources and CMS Core, and the items you
want to synchronize.
5. Click Save Synchronization Profile. The profile is saved and the View Azure Hosted
Services screen appears.
6. In the Action section of the profile you just saved, click Sync (
database and templates.

) to synchronize the

Manage the Cloud Instances
In the View Azure Hosted Services screen (Workarea > Settings > Configuration >
Cloud Manager), you can modify cloud instances in the following ways:
l
l

l

l

Start the instance—If the icon is green, the instance is stopped; click to start it.
Stop the instance—If the icon is red, the instance is running; click to stop it.
Configure Load Balancing—Modify the number of instances. One (1) instance
means no load balancing; more than 1 instance balances the load equally among
instances.
Swap Instance—If you have a production and staging server, click to swap the
instance (to staging and production).

l

Schedule Cloud Event—Display cloud event schedules.

l

Get Status (Hosted Service)—Display the status of all profiles.

l

Delete Hosted Service—Removes the instance from the list.

l

Add Profile—Add a new profile.

l

Sync—Synchronize the database and templates.

l

Get Status (Profile)—Display the status of the selected profile.

l

Delete Profile—Removes a selected profile.

Schedule Cloud Events
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1. Go to Settings > Cloud Manager. The Cloud Manager screen appears.

2. Click Schedule Cloud Events (

). The View Schedule Cloud Events screen appears.

3. Click Schedule Cloud Event. The Schedule Cloud Event screen appears for you to fill in
the fields.
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l
l

l

l
l

Description—Describe what the event does.
Event Type—
o Edit Instances—Change the number of instances.
o

Deploy Site—Deploy the site.

o

Delete Deployment—Opens a selector to choose sites that you want to
delete.

Number of Web Instances—The number that you specify will overwrite the
number of instances that were set up with the initial deployment.
Scheduled Date and Time—Specify when the event will occur.
Email Notifications—Send an email to the address list. Use commas to separate
the addresses.

4. Click Save.

Set up Ektron Storage
Ektron uses the unity section of your cloud web.config file to set up a storage destination.
1. Add the following to the configSections section:
<section name="unity.storage"
type="Ektron.Unity.Configuration.UnityConfigurationSection,
Ektron.Unity.Configuration, Version=2.0.414.0, Culture=neutral,
PublicKeyToken=1e97f90fc2b998db"/>

2. Define unity.storage as follows:
<unity.storage>
<assembly name="Ektron.Storage"/>
<assembly name="Ektron.Cloud"/>
<namespace name="Ektron.Cloud.Azure.Storage"/>
<namespace name="Ektron.Storage"/>
<container name="storageContainer">
<register type="IFileService" mapTo="CloudFileService"/>
<register type="IDirectoryService" mapTo="CloudDirectoryService"/>
</container>
</unity.storage>

Set Up Ektron Caching
NOTE: Caching configuration is required only if you run more than 1 instance (load balancing). You can
get the section values from the portal.
In your cloud web.config file (add location), do the following:
1. Add the following to the configSections section:
<section name="dataCacheClients"
type="Microsoft.ApplicationServer.Caching.DataCacheClientsSection,
Microsoft.ApplicationServer.Caching.Core" allowLocation="true"
allowDefinition="Everywhere"/>

2. Define dataCacheClients as follows:
<dataCacheClients>
<dataCacheClient name="default">
<host>
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<host name="[yournamespace].cache.windows.net" cacheport="22233" />
</hosts>
<securityProperties mode="Message">
<messageSecurity authorizationInfo="[yoursecretkeyinfo]"/>
</securityProperties>
</dataCacheClient>
<dataCacheClient name="SslEndpoint">
<host>
<host name="ektron.cache.windows.net" cacheport="22243"/>
</hosts>
<securityProperties mode="Message" sslEnbaled="true">
<messageSecurity authorizationInfo="[yoursecretkeyinfo]"/>
</securityProperties>
</dataCacheClient>
</dataCacheClients>

3. Set up the sessions to use Appfabric server:
<sessionState mode="Custom"
customProvider="AppFabricCacheSessionStoreProvider">
<providers>
<add name="AppFabricCacheSessionStoreProvider"
type="Microsoft.Web.DistributedCache
.DistributedCacheSessionStateStoreProvider,
Microsoft.Web.DistributedCache"
cacheName="default"
useBlobMode="true"
dataCacheClientName="default" />
</providers>
</sessionState>

Set the SQL Premium Database Connection String
In your cloud web.config file, modify the Ektron.DbConnection section to have an SQL
premium database connection string. You can get this value from the portal.

Set the Blob Redirect Handler
In your cloud web.config file, insert the Blob redirect handler into the module section:
<add name="EkBlobModule"
type="[assemblyname].BlobRedirect.Module,[assemblyname]"
precondition="integratorMode"/>

Create a Cloud Package
1. Open the cloud solution from Ektron Developer's SDK.
2. Set up the storage account details in the service configuration file. Use Visual Studio
2010 (or edit the XML-based configuration file) to have the following details:
Name: BlobOrCdnUrl
Type: String
Value: http://abcdefgh.vo.msecnd.net/
Name: DataConnectionString
Type: Connection String
Value:

194

Ektron Reference

Creating a New Azure Virtual Machine

DefaultEndPointProtocol=https;
AccountName=mysite;AccountKey=+Uv/eXOUoYkT1...

3. Compile the project with Visual Studio 2010, or use the msbuild command as follows:
msbuild yourcloudproject.ccproj /p:Configuration=Release /t:Build;Publish
4. Log into the portal and upload yourprojectname.cspkg and
ServiceConfiguration.Cloud.cscfg into your newly created hosted service.
NOTE: After you create the deployment, the set up on the cloud takes some time before the files are
ready to be accessed.

Creating a New Azure Virtual Machine
1. Login to https://windows.azure.com
2. Click New > Virtual Machine.
3. Click Quick Create.
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4. In the right panel, enter a DNS Name.

5. Under IMAGE, select Windows Server 2008 R2.
6. Enter a password and confirm it.
7. For Size, select Large.
8. Select your geographic location.
9. Click Create Virtual Machine.
10. Wait until provisioning is complete.
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11. Click Connect.

Setting Up eSync to a Cloud Instance
Ektron’s sync technology, built on the Microsoft Sync Framework, synchronizes information
between the Azure cloud and on-premises data repositories. eSync makes it easy to manage
content changes through a true hybrid cloud deployment.
When you run eSync, SQL data and file system resources (such as ~/assets,
~/privateassets, ~/uploadedfiles, ~/uploadedimages, assetlibrary) are synched to
SQL Database Cloud Blob Storage.

Setting Up Search Server and Ektron Search
Configuration Using an Azure Persistent VM
This section explains how to connect Ektron in an Azure environment to a search server
running on an Azure Virtual Machine. As a result of this connection, all search querying and
crawling are done in the cloud.
If you are using Ektron in the cloud, there are many advantages to running search in the cloud
also, such as performance, scalability, etc.
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PREREQUISITES
You completed all tasks in these sections and deployed Ektron in an Azure
environment:
l

Setting Up the Azure Cloud Portal on page 179

l

Deploying a Site Package to the Azure Cloud on page 183

l

Creating a New Azure Virtual Machine on page 195

l

Setting Up eSync to a Cloud Instance on the previous page

1. Within https://windows.azure.com, click your email/account name in upper right corner.
Then click previous portal.
2. Click Hosted Services, Storage Accounts & CDN.
3. Find your storage account primary key by navigating to Storage Accounts > click your
storage account > click the Primary access key view button. Copy the Primary access
key—you will paste it in Step 5.

4. On the on-premises server, open
C:\sync\azuredeploy\GUID\HostedServiceName\’HostedServiceName’_
web\web.config.
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5. Within the <appsettings> section, add these keys.
<add
<add
<add
<add

key="ek_CloudStorageType" value="AZURE"/>
key="ek_CloudAccountId" value="BlobID"/> //storage account name
key="ek_CloudAccountKey" value="BlobKey"/> //storage account primary key
key="ek_CloudContainer" value=""/>

o

You obtained the storage account ID (ek_CloudAccountId) in Create a Storage
Account on page 181.

o

You obtained the ek_CloudAccountKey value in Step 3.

o

You may leave the ek_CloudContainer value blank.

6. On the on-premises server, click C:\Program Files
(x86)\Ektron\EktronCloud\bin\ms\1.7.0.0\EktronConfigUploader.exe.
7. Enter your storage account name and primary key.
8. Click the Browse button and navigate to the web.config you just updated
(C:\sync\azuredeploy\GUID\HostedServiceName\’HostedServiceName’_
web\web.config).
9. Click Upload to push the web.config changes to your Azure website.
10. On the on-premises server, open C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SearchServer.
11. Copy SearchServerExpressInstall.exe and EktronSearchConfiguration.exe.
12. Log into the virtual machine. Paste those two files.
13. Run SearchServerExpressInstall.exe (or run the search server install executable file).
14. You may be prompted to install .Net 3.5. If so, install it from Server Manager >
Features > Add Features > .Net 3.5.
15. Run SearchServerExpressInstall again.
16. You may be prompted to install .Net 4.0. Continue with the installation.
17. Click to run the search server prerequisites.
18. Finish the search server installation.
19. Run EktronSearchConfiguration.exe. Follow the instructions beginning on Step 28 of
Setting Up Microsoft Search Server 2010 Express on page 864.
o Choose the Standalone option, rather than Server Farm.
20. Return to the Windows Azure portal and click your virtual machine.
21. Create an endpoint for the Search Query Web Service port for Ektron search site.
7500 is the default. (To check the port number on the VM, open IIS, click the
EktronSearchSite, click Edit Bindings, and view the port.)
To do this, click Endpoints then Add Endpoint.
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22. Click the Next arrow.

23. Enter a Name, select protocol TCP, and enter a public and private port. Both ports
should be the same value.

24. Click the checkmark to save.
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25. Follow the above 4 steps to create another endpoint for Ektron Search Server Service
port 8732.
26. Add inbound rules to allow TCP communication for ports 8732 and your Ektron search
site (7500 is the default). To do that:
a. Go to Control Panel > click Check Firewall Status > Advanced Settings.
b. Select Inbound Rules, then right click and select New Rule.
c. Select Port radio button and click Next.
d. Click the TCP radio button.
e. Click Specific Local Ports, then add port 7500 (7500 is the default) and click
Next.
f. Select Allow the connection and click Next.
g. When does this rule apply? appears. Accept all defaults and click Next.
h. Assign a name to the inbound rule and click Finish.
i. Repeat steps for port 8732.
NOTE: Make these ports also accessible through any firewall running on the VM.
27. Update the service endpoints in the Ektron Search Server Service configuration file:
C:\Program Files
(x86)\Ektron\EktronSearchServerService\EktronSearchServerHelperService.ex
e.config. To do that:
a. For query service URLs, change host name to the publicly accessible host name.

b. Override the administrative service endpoint with a publicly-accessible URL.

c. Restart the Ektron Search Server Service.
28. Open the Search Configuration utility configuration file: C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SearchServer\Ektron.Cms.Search.Config.UI
.exe.config
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29. Increase timeouts for requests to the Site Communication Service (highlighted below) to
00:05:00.

30. Reboot the Worker Hosted service. This action restarts the Ektron Windows service. To
do that:
a. In the Azure Web page, click Hosted Services.
b. Expand your hosted service until you see hosted service name_worker_IN_0.
c. Click the reboot button.
31. After the Worker Hosted Service restarts, go to the Azure virtual machine, open
C:\Program Files (x86)\Ektron\CMS400vxx\Utilities\SearchServer and run
Ektron.cms.search.config.UI. See Also: Logging into Ektron's Search Server
Configuration Screen on page 926

Setting Up DxH Using an Azure Persistent VM
You can securely deploy DxH in Azure (IaaS) while your CMS site is hosted in a Cloud service
using the Azure PaaS environment.
IMPORTANT: If you are using Ektron 8.60 with SQL premium database, (also known as SQL Azure), you
must manually navigate to install the directory database folder, then open Schema.sql and replace
newsequentialid() with newid(). You need to re-run all 3 scripts manually pointing to SQL
credentials.
The following diagram shows DxH and CMS Cloud Service with SQL Premium Database.
l

DxH is hosted in Azure Persisted VM (Azure IaaS).

l

CMS is hosted as an Azure Cloud service (Azure PaaS).

l

You can use your own SQL Server.

Setting up the Cloud Service and DxH
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1. Create an affinity group using any Azure data center location.
2. Create a Virtual network and a subnet of A, B, or C class IPs.
3. Create a virtual machine (VM) using the gallery option while creating the VM. See
Creating a New Azure Virtual Machine on page 195.
4. If you have not already done so, you need to install .NET 4.0 and Port sharing service
before you install DxH. Note this step can be performed independently later in the
process.
5. Install DxH in the VM.
6. You also need to open the firewall rule and add DxH port (default port is 808) to allow an
incoming connection.
7. Create the Cloud service using the affinity group as the location.
8. Create a storage account using the affinity group as the location.
9. Create a package manually, or use the deployment wizard to build and deploy the Cloud
Service Package.
If you had completed the DxH installation, you should be able to communicate between your
DxH and CMS. You may need to open additional ports (for example, 808 for DxH) using the
VM endpoints through the portal. If you do not want to open public end points, use the
following procedure.

Securing DxH Communication
To communicate to the DxH VM through the Pass Service only, perform the following
redeployment steps after deleting the current deployment.
1. Delete your current deployment from the cloud service so that you can make the change
to the serviceconfiguration.cscfg file.
2. From your On-Premise system go to:
~/Sync/azure/{guid}/{your service name}/package/
serviceconfiguration.cloud.cscfg

3. Add the following element before the </serviceconfiguration> tag. Make sure to replace
all the values to match your cloud service, virtual network and subnet.
<NetworkConfiguration>
<VirtualNetworkSitename="YourVirtualNetworkName" />
<AddressAssignments>
<InstanceAddressroleName="YourWebRoleName">
<Subnets>
<Subnetname="YourVirtualNetworkSubnetName" />
</Subnets>
</InstanceAddress>
<InstanceAddressroleName="YourWorkerRoleName">
<Subnets>
<Subnetname="YourVirtualNetworkSubnetName" />
</Subnets>
</InstanceAddress>
</AddressAssignments>
</NetworkConfiguration>

4. Create a production deployment using the new updated
ServiceConfiguration.cloud.cscfg for configuration. Use from Storage option for
Package. After you click on the storage option, go to your storage account and then the
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ektrondeployment container then select the package (.pkg) file.

Your CMS cloud service can now communicate to DxH service securely.

Customizing Roles
You can customize roles for actions on start events or diagnostics information.
A typical Ektron Azure PaaS environment consists of SQL, Azure Blob, a Web role, and a
Worker role. The site content is stored in SQL, and site-specific assets are stored in Azure
Blob.
The Web role and Worker role are specialized VMs designed for a specific purpose.
l

l

The Web role provides a dedicated IIS Web server used for hosting front-end
applications; the site runs on the Web role instance.
The Worker role handles asynchronous, long-running or perpetual tasks independent of
user interaction or input.
Ektron uses the Worker role to synchronize content between production and other Ektron
site environments. If you make any changes to a page in the production environment,
Ektron eSync service (running in the Worker role) ensures that changes are
synchronized with the staging environment and vice versa.

The template project is available as part of the cloud installation at C:\Program Files
(x86)\Ektron\EktronCloud\sdk and choose SDK > RoleEntry.
1. To customize the Web and Worker roles, open C:\Program Files
(x86)\Ektron\EktronCloud\sdk\RoleEntry\Web\Ektron.Azure.Web.Sln, (or
C:\Program Files
(x86)\Ektron\EktronCloud\sdk\RoleEntry\Worker\Ektron.Azure.Worker.Sln),
make changes, and copy the file to your template location.
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2. Create a custom package with Visual Studio® 2010 or using the command line.
3. Create a Web-role-only package by choosing SDK > Template > WebRoleOnly, then
copy and modify the following files: create.cmd, servicedefinition.csdef,
package/serviceconfiguration.cloud.cscfg.
a. Copy your website files into yourservicename_web directory.
b. Modify web.config.
c. Run create.cmd to create the package.
d. Upload the package to the cloud service.
NOTE: eSync will not work in this mode, so you must manually move the database to the
cloud using the data deployment package or any other ETL (extract, transform, load) tool.

Troubleshooting Ektron Cloud Deployment
l

Make sure EktronCloud.cer is uploaded into cloud Management Certificate portal.

l

Make sure to add firewall rules in your SQL Database Instance.

l

l

If you have database connection issue, try connecting through SQLServer R2 or from the
cloud Web portal.
If your full site is not deployed as part of initial deployment, make sure you create an
additional profile and run the database/resource/template sync.

l

Any configuration file can be uploaded thru EktronConfigUploader.exe.

l

Any template sync may take up to 5 minutes to reflect in the site template.

l

The on-premises site must be installed into the siteroot and not a subdirectory.

l

l

l

If you get an end point not found error, try again after a few minutes because the
service may still be configuring.
The caching configuration-per-deployment cannot be shared with other deployment
configurations.
If you host an https-based site, make sure that you first import the certificate (.cer)
into the Management Certificate and then add the .pfx file to the cloud service.

Additional Cloud Information
l

The Pros and Cons of Cloud Storage

l

Which Cloud? Comparing Microsoft Azure and Amazon Web Services

l

CMS in the Cloud Part 1: What is Cloud Computing?

l

CMS in the Cloud Part 2: The Benefits of the Cloud

l

CMS in the Cloud Part 3: Reducing Costs and Scaling with Ektron Cloud Manager

l

Deploying High-Performance Sites Using Low-Cost Cloud-CDNs

l

Ektron Managed Cloud: Focus on Strategy Not Infrastructure
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Editing Content
You can only edit content for which you have permission and in one of the following statuses:
l

published

l

checked in

l

checked out by you

l

submitted for your approval

After you sign in, you can access content by a silver access point ( ) on the Web page, or
through the Workarea. You can edit content in the following ways:
l

Edit in context on the Web page

l

Edit in the Workarea

NOTE: For more information about additional editing actions on content, see Working with Ektron Content
on page 287.

Editing Content in Context on a Web Page
When you log in, you can edit content on any Web page that has the access point ( ) displayed
on the page.
The top of the page displays a PageBuilder menu for performing actions on the page, such as
checking in, viewing properties, and placing widgets on the page.
NOTE: For information about how to create a widget, see Creating the “Hello World” Widget on page 716.

To keep the PageBuilder menu open, click the pin icon (

).

When you choose File > Edit from the PageBuilder menu, you see the widget components on
your page. In addition to modifying content, you can add or modify the widget placement. You
can edit the content using the access point ( ), and modify the widget properties by clicking
Edit ( ). Menu options vary depending on the content’s status, your permissions, and so on.
For information about editing the PageBuilder page, see Creating Web Pages with PageBuilder
on page 659. To learn about editor details, see Using the Editor on page 212.

208

Ektron Reference

Editing Content in Context on a Web Page

You can modify the access point menu's appearance by editing the ek_UserMenuType element
of the siteroot/web.config file. By default, ek_UserMenuType is set to 2.
l

l

2—drop-down Interface—No borders; drop-down menu appears when user clicks the
access point.

1—Classic Interface—Colored borders and menus always appear; menu options
appear as icons in the top row.
NOTE: If you use this interface, the page layout is not depicted accurately because of the fixed
toolbars.
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System administrators can modify toolbar buttons by editing the C:\Program
Files\Ektron\CMS400vxx\workarea\ContentDesigner\configurations
\InterfaceEditInContext.aspx file. Also, the content block server control’s
Suppresswrappertags property must be set to false.
l

l

l

l

Add HTML Content—Create new HTML content in the folder to which the
control is assigned. Creating New Content on page 287
Add Smart Form Content—Create new Smart Form content in the folder to
which the control is assigned. Working with Smart Forms on page 423
Approve—Approve or decline a request to publish or delete content.
Approving or Declining Content on page 267

l

Add Task—Add a task to a user. Assigning and Managing Tasks on page 1027

l

Delete—Open View Content page. From it, you can delete the content.

l

l

l

l

l

l

210

Add—Appears if you selected a language and the content is not available in that
language. Use this button to copy existing content into new content and translate it
to the new language. Creating Multi-language Content on page 1062

Edit—Check out content for editing; open in separate window. Editing Content
on page 208
Edit in Context—Check out content for editing; content remains within Web
page. Editing in Ektron on page 207
Logout—Log out of website. Getting Started with Ektron on page 5
New Poll—Create new poll or survey. Creating Surveys and Polls on page 407
Preview—Preview content before it is published. Previewing Content in a Mobile
Template on page 138
Properties—Open content’s View Content page.
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l

l

l

l

l

l

Site Overlay—View a visual map of popular links on a Web page, based on the
frequency of clicks. Setting Up Site Overlay on page 655
View Content Difference—Contrast previous and current versions of content.
Editing in Ektron on page 207
View History—Open View History screen, where you can view previous
versions of content. Editing in Ektron on page 207
View Page Activity—View the current page's SEO information. Working with
Ektron Server Controls on page 1605
Workarea—Open Workarea. From here, you can perform all Ektron tasks.
Managing Content on page 273

0—Hover Interface—Colored border appears when user hovers mouse over area;
menu appears when user right clicks mouse inside border. This interface has 2 display
options: vertical (shown) and horizontal.
To change:
1. Open the siteroot/web.config file.
2. Find ek_MenuDisplayType.
3. Change its value:
l
0 (zero) = horizontal
l

1 = vertical

Editing Content in the Workarea
In the Workarea, you can edit content, add information about content (summary, metadata,
and so on), edit HTML content, HTML forms, XML Smart Forms, and check in, submit, and
publish content.
1. From the Workarea, click Content and navigate to the folder that contains content you
want to edit.
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NOTE: If you don't know the folder location, you can find content using Action > Search from the
root folder.
2. Click the content you want to edit. The View Content screen appears.
3. Click Edit. The editor appears. To learn about editor details, see Using the Editor below.

You also can edit via the context menu on the View Contents of Folder screen. Click the
triangle ( ) next to the content item, and choose Edit from the menu. The editor
appears.

Using the Editor
When your hover the cursor over editable content, a yellow border appears. When you click
the content, the border turns blue, and a floating editor toolbar appears.
NOTE: You can place the editor toolbar anywhere on the screen and make it stay by clicking on the pin
icon ( ). When pinned, the icon changes ( ).
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The editor toolbar consists of tabs with buttons. A system administrator can customize the
toolbar options depending on the context. For example, he may want the Inspector available
when editing content in the Workarea but not while editing "in context". For information about
customizations, see Customizing the Editor on page 231 and Modifying Editor Plug-ins on
page 232.
l

l

Cut, copy, and paste may be accessible through your browser. Right-click to choose
them or use keyboard shortcuts.
The editor may modify pasted content, depending on tags that an administrator sets in
StyleConfig.js. For example, headings, bullets, and bolded fonts may be maintained
during a paste operation but the actual font may not.
IMPORTANT: When you paste content from another application into the editor, it formats that
content into valid, minimal HTML and retains as much formatting and styling as possible. However,
each browser affects this operation differently, so results browser dependent.

l

l

Paste HTML content into the Source Viewer. See Also: Viewing and Editing HTML Source
Content on page 227
Your browser handles spell checking. If your browser does not support it, you can find
and load a plug-in to do it.

NOTE: If you apply the Span style, you can select it in the Inspector to enter style modifications.
This section also contains the following topics.
Applying Styles
Applying Styling to Text
Working with Links
Viewing a Link
Inserting a Link
Removing a Link
Adding a Bookmark
Working with Tables
Inserting a Table
Using the Inspector with a Table
Adding a Table Caption
Modifying Rows and Columns
Modifying a Table Style
Moving a Table
Deleting a Table
Working with Images
Inserting an Image
Editing Images
Adding Video to Content
Displaying Bubble Text on Content
Viewing and Editing HTML Source Content
Finding and Replacing Text in the Source Viewer
Validating Content
Using a Template to Structure Content
Creating a Template
Inserting a Template
Translating Content
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Applying Styles
The Editor comes with inline styles that you can apply to content.
NOTE: A developer or administrator can add classes and IDs that also can be applied. An inline style will
display the style in content immediately, but the effects of classes are displayed only if the CSS and files
loaded on the page contain those classes.
In addition to the styling buttons on the editing bar, the Inspector lets you view and modify
style information about your content by clicking the Open Viewer ( ) tab. For example,
when you click on "37 percent gain" in the editor, the element shows that the content is in a
<b> tag and that you can select a red font Alert style (among others) for this element.
Each element may have difference styles that you can apply. To see the styles you can apply
to an element, open the Inspector and place your cursor in an element (such as a <p> or <b>
element).
See Also: Editing in Ektron on page 207

Applying Styling to Text
You may want to style a few words within your content. See 37 percent gain in the following
example.
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Working with Links

To apply styling to one or a few words:
1. Select the text.
2. On the toolbar's Format tab, click the Span button.

3. Click the Inspector.
4. Verify that the SPAN appears in the top right corner of the dialog.

5. Use the dialog to style the selected text.

Working with Links
This section shows you how to view, insert, or delete a link in content.

Viewing a Link
Click the cursor on linked text or image. The Link tab appears in the editor toolbar showing
you the URL or item to which the text is linked. You can Ctrl+click on a link to open a link in
the specified target.
Use the Inspector dialog to modify existing and set additional properties.
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Inserting a Link
Linking to Text
1. Highlight text that you want to become a hyperlink
2. Click Link ( ) on the Format tab. (If you click Link on an empty space, a link appears in
the content as New Link. Be sure to change New Link to something meaningful.)

A link tab appears.

3. Specify the URL you want, and press Enter. The selected text becomes a hyperlink.

Linking to an Image
To learn about inserting an image, see Inserting an Image on page 223.
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Removing a Link

1. Click an image that you want to become a hyperlink.
NOTE: You will know that you selected an image if you see an <IMG> tag in the Inspector.

2. Open the Inspector.
3. Click Add hyperlink to Image.
4. Click the <A> tag.

5. Enter hyperlink information. See Also: Inserting a Link on the previous page

Removing a Link
1. Click the cursor on the linked item. The link destination appears in the editor toolbar.
2. Click Break Link (

). The link is removed.

Adding a Bookmark
Use a bookmark to let a site visitor “jump” from any word or phrase to another place in the
same content block. On your Web page, text appears in a different color to indicate the
bookmark.
Bookmarks are particularly helpful if on a long page. For example, your Web page contains
minutes from several meetings, and the top of the page lists the meeting dates. You could
assign a hyperlink to each date, and a bookmark to each set of minutes. A site visitor can
click any date to “jump” (using the bookmark) to those minutes.
To use a bookmark, you create 2 things:
l

a source—text a user clicks to jump to the bookmark

l

a destination—the location to which the cursor jumps when the source is clicksed
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For example, place the text [ Top ] [ Bottom ] at the top and bottom of a content block. The
following procedure shows how to create bookmarks so that clicking on [ Top ] at the bottom
of the page jumps to the top of the page, and clicking on [ Bottom ] at the top of the page
jumps to the bottom of the page.
1. Create the bookmark's (destination).
a. At the bottom of the page, insert then highlight the destination text, in this case [
Top ].
b. On the editor toolbar, choose Insert > Bookmark ( ). A bookmark icon displays
next to the source text but does not show up on the Web page.
c. Double click the bookmark icon then the Inspector. A dialog displays the bookmark
options.
d. Give the new bookmark a unique id, title, and name.
e. Repeat steps a through d for [ Bottom ] at the bottom of the content, and give it
the Title and ID of PageBottom.
2. Create links to the bookmarks.
a. Highlight the source text. In this example, [ Top ] at the bottom of the content.
b. Choose Format > Insert Link (

). The text is selected.

c. Double click the selected text.
d. Open the Inspector.
e. Choose Existing Bookmark. A drop-down list appears from which you can select a
bookmark.
f. Click back in the editor window. The text is underlined and in a different color.
The following image shows text links that let the user click to the top and bottom of the page
by creating correlating bookmark sources and destinations.

Preview:
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Working with Tables
This section describes how to insert and edit tables.

Inserting a Table
1. Click Table (

). A table dialog box appears.

2. Drag the cursor over rows and columns to indicate the table size. The following example
shows 5 columns and 5 rows.

3. Click the mouse. The table is inserted.
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NOTE: You can use <Tab> to move from one cell to the next. If you are on the last cell, <Tab> creates a
new row.

Using the Inspector with a Table
Use the Inspector to apply properties to a table, a table row (TR), or a single cell (TD).

l

table properties—http://www.w3schools.com/tags/tag_table.asp

l

tbody properties—http://www.w3schools.com/tags/tag_tbody.asp

l

table row (TR) properties—http://www.w3schools.com/tags/tag_tr.asp

l

table cell (TD) properties—http://www.w3schools.com/tags/tag_td.asp

Adding a Table Caption
1. Hover the cursor over the top left corner and click the table handle.
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Modifying Rows and Columns

2. In the toolbar, the Table tab is selected.
3. Enter the caption in the text box and click the Table caption button (

).

Alternatively, you can enter a table caption in the Inspector.

Modifying Rows and Columns
Click the gray area beside a table row or above a table column. Your selection is highlighted.

You can use the following table functions on selected rows/columns:
l

—Add column to the left

l

—Add column to the right

l

—Add row below

l

—Add row above

l

—Delete column

l

—Delete row

l

—Format column as header (create a 508-compliant table without modifying the
source)

l

—Format row as header (create a 508-compliant table without modifying the source)

l

—Merge cells

l

—Split cells

l

l

—Table caption; when you click on this, Table caption appears above the table.
Modify text as desired.
Text Box—Add a summary that visually impaired users can access with a screen reader.
The summary does not appear in the editor or on a Web page.

IMPORTANT: When you save and publish your content, your site styling is applied. Therefore, a table in
the Workarea may appear differently from a table you edit in context.
Table with merged cells:
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NOTE: To split a merged cell, select the column or row of the merged cell before clicking Split.

Modifying a Table Style
When you click on an outer border to select a row, or click twice in a cell, the Inspector
displays the built-in table styles that you can select. The following image shows 2 tables in the
editor: 1 with a 50% width style selected, and the other with 25% applied.

Moving a Table
When you make a table the content focus (a colored bar appears around the table), a tab
appears above the table's left top corner. Use the tab to drag the table to another place in
your content.
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Deleting a Table

NOTE: You can also move a table in Source Viewer.

Deleting a Table
1. Add a blank paragraph tag above and below the table.
2. Select the paragraph tags before and after the table, and the table.
3. Press Delete.
NOTE: You can also delete a table from Source View, and easily collapse the entire table to delete it in
one line of HTML.

Working with Images
Before you can insert an image into content, the image must be uploaded to the Library or
imported as an asset. You can upload an image to the library while editing content using the
Add Library button.
l

Storing Files in the Library on page 333 explains how to upload an image to the Library.

l

Methods for Importing Assets on page 315 explains how to import an asset.

This section also contains the following topics.
Inserting an Image
Editing Images
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Inserting an Image
Inserting an Image via the Library
1. Place the cursor where you want the image to appear.
2. Click Library ( ). The CMS400 Library screen appears.
3. From the left panel, navigate to the folder containing the image you want to insert. If
you do not know its folder, use Search ( ) to find an image by title, description, or
internal file name.
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NOTE: If the file is not in the library, you can insert it by clicking the Add Library button, clicking
Browse and navigating to the image file. Then, enter a title and optionally a description and
metadata information. The file is inserted into the content and added to the library.

4. Select Images from the content type drop-down.

5. Select an image and click Insert (
also double-click the image.)

). The image is inserted into the content. (You can

Alternatively, you can insert a miniature version of the image, called a thumbnail, by
clicking the thumbnail button (
). When the thumbnail appears on a Web page, a site
visitor clicks it to view a full-sized image.

Editing Images
After inserting an image, you can adjust its properties by opening the Inspector.
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Editing Images

NOTE: You will know that you selected an image if you see an <IMG> tag in the Inspector.

l

—Opens an Image Editing window.

(The previous image shows an active Resize Image.)
You can perform the following image editing functions:
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l

—Save the changes to the image.
NOTE: Each time you save changes to an image, a new image is created in the library.

l

l

l

—Cancel editing; do not save changes.

l

—Crop the image.

l

—Resize the image.

l

—Rotate the image.

l

—Adjust the brightness of the image.

src—Displays the system location of the image file.
—Opens the CMS400 Library for you to select an image to replace the current image.
You can also click Add Library to upload a new image to the Library which you can use
to replace the image.

l

alt—Specify the alternate text to be rendered if the image cannot be rendered.

l

title—Specify additional information about the image.

l

class—Specify a class from your stylesheet.

l

Style Selector—Choose 1 of the style selectors (if available in your stylesheet). In this
example, choosing Text Right wraps the content to the right of the image.

Adding Video to Content
1. On the editor toolbar, click the Insert tab then Insert Embedded Media (
Insert Embedded Media screen appears.

2. Add your embedded HTML code. For example:
<object width="425" height="350">
<param name="movie"
value="http://www.youtube.com/v/8K_NQe57C-k"></param>
<param name="wmode"
value="transparent"></param>
<embed src="http://www.youtube.com/v/8K_NQe57C-k"
type="application/x-shockwave-flash"
wmode="transparent" width="425" height="350"></embed>
</object>
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). The

Displaying Bubble Text on Content

3. Click Embed. The video is embedded in the content.

Displaying Bubble Text on Content
1. Highlight text for which you want to display bubble text.
2. On the Format tab, click Abbreviation ( ) . The Abbreviation tab appears.

3. Enter the bubble text in the field and press Enter. When a site visitor hovers over
highlighted text, the bubble text appears.

Viewing and Editing HTML Source Content
To view and edit the HTML source, click View Source ( ) on the toolbar's Review tab. The
Source Viewer appears. As you edit the HTML, the content window dynamically updates with
your changes.
When you finish editing in the Source Viewer, click the X in the top right corner.
The Source Viewer supports tag completion. For example, if you type <p>, the Source Viewer
automatically adds a closing </p> tag.
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The Source Viewer supports collapsing and expanding tags. For example, if a table is in the
content, a small arrow appears next to the line numbers. Click the arrow to expand or
collapse the nested tags.

Finding and Replacing Text in the Source Viewer
NOTE: Replacing text is supported only in the Source Viewer. Search is supported in the editor by
pressing Ctrl/f.
Consider replacing OnTrek with Ektron in the following content.
<p>OnTrek announced a 37 percent gain in revenue for the first half of 2010
over the first half of 2009. Q3 2010 sales increased 45 percent compared to
a record sales month in July 2009. “Demand for OnTrek’s latest solutions,
from new and existing customers, combined with our ability to deliver upon
mission-critical business initiatives continues to drive a healthy gross margin,”
said James Bradford, founder and CEO of OnTrek. “With competitive technical
analysis and boardroom influence favoring OnTrek in customers’ due diligence,
our momentum and accelerated growth is expected to continue.”
<br/></p>

1. On the Review tab, click the View Source button (

). Source Viewer appears.

2. Press Ctrl/f to open the find and replace boxes.
3. Type the search string in the first box and the replace string in the second box.
4. Click Replace to find and replace occurrences one at a time. Click All to replace all
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occurrences.

Validating Content
You can validate content against Accessibility (Section 508 Guideline), WCAG, HTML5, or
XHTML guidelines by clicking Validate ( ) on the Review tab. The Content Validator screen
appears. Choose which guideline you want to use from the drop-down menu, then click
Validate. Options include:
l

Accessibility (Section 508 Guideline)

l

WCAG 2.0 Level A

l

WCAG 2.0 Level AA

l

WCAG 2.0 Level AAA

l

HTML5

l

XHTML

NOTE: Each standard may have conflicts with the other standards; valid HTML5 code may not be valid
XHTML code. Choose the standard guideline that you need.

Using a Template to Structure Content
An editor template is section of HTML-formatted content that users can copy into their content
for any number of reasons. For example, a template can help maintain a structure, such as
image captions. If you want the caption on the left with content flowing around it, create
mark-up to do this and put it in a template.

Creating a Template
To prepare for templates, create an Ektron parent folder to contain them. Then, specify the
parent folder at the templatePlugin element in the AlohaEktron.aspx on page 237 file.
templatePlugin: {FolderID: 45}
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IMPORTANT: You cannot use 0, the root folder, as the parent folder for templates.
NOTE: You can set permissions on this folder like any other. Users must have read-only or greater
permission for the folder in order to insert its templates into content.
After you create the folder, open it (or any child folders) and create and publish HTML content
to be used as a template. Content authors may only select published content from this folder
tree when inserting a template.

Inserting a Template
To insert a template, place the cursor where you want it, and click Template (
Insert tab. Navigate to the HTML content, select it, and click Insert.

) on the

The template is copied to your content, and then decoupled from the template source file. So,
you can modify the template text as you like; modifications do not affect the template. Also,
if you later change the template, that action does not affect previously-inserted copies.

Translating Content
This section describes machine translation, which converts content to another language.
Machine translation operates on an entire piece of content, not selected portions of content.
IMPORTANT: Before you can use machine translation, a system administrator must enable it. See
Enabling Machine Translation on page 1072.
1. While editing a piece of content, click Translate (
appears in a new window.
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) on the Review tab. The content

Customizing the Editor

2. Choose the Source and Target Languages and click Translate. The machine translation
appears.

3. If the translation is acceptable, click Paste Content to replace the original with the
translated text.
4. Edit the translation as needed then save.

Customizing the Editor
An administrator can customize the editor.
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Changing the Default Editor
The editor is automatically set by the ek_EditControlWin (Windows) or ek_EditControlMac
(MacIntosh) tags in web.config. However, you can change them to use another editor.
<!-- EditControlWin may be either "Aloha" or "ContentDesigner" or "eWebEditPro" or
"UserPreferred" -->
<add key="ek_EditControlWin" value="Aloha" />
l

Aloha designates the default editor.

l

ContentDesigner designates the eWebEdit400 editor.

l

UserPreferred lets users choose an editor on their profile page.

Modifying Editor Plug-ins
Plug-ins are open-source, customizable pieces of JavaScript code that provide editor
functionality.
Editor plug-ins are stored at
\Workarea\FrameworkUI\js\Ektron\Controls\EktronUI\Editor\Aloha\plugins\ektro
n\[plug-in_name]. Each [plug-in_name] folder has supporting CSS and lib folders
containing these files:
l

Plug-in_Name.css—Cascading style sheet for the plug-in.

l

Plug-in_Name-plugin.js—JavaScript file for the plug-in.

Plug-in code has the following basic outline:
l
l

Define/inclusion calls are at the top (powered by RequireJS for easy-to-use paths)
Main function (returns created plugin)
o Default variables or strings to be used
o

Init function that executes upon loading (usually to create the button)

o

createButtons function that adds a button to floating menu

o

Function that can be called whatever you like, and should be executed upon button
click

Editor Plug-ins
NOTE: For more information about customizing the editor and creating plug-ins, see the webinar:
Customize the Behavior of the Editor for Your Projects.
Ektron provides several useful plug-ins that lets you customize the editor. Specify editor plugins in the C:\inetpub\wwwroot\siteroot\ektron.cms.framework.ui.config file. Many
plug-ins are buttons on the editor toolbar. See Also: Customizing the Editor's Toolbar Buttons
on page 234
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Each editor plug-in has one of these prefixes:
l

common/—native to the editor

l

ektron/—supplied by Ektron

l

extra/—supplied by others. You can create your own plug-ins. (This document does not
describe how.)

The following are standard editor plug-ins.
l
l

l
l

common/ui, common/block—required internal plugins; do not remove
common/abbr ( )—specify an abbreviation for content, which shows up as bubble text
See Also: Displaying Bubble Text on Content on page 227
common/characterpicker ( )—insert special characters (such as ® and ±)
common/contenthandler—controls sanitization of content and supports cleaning of
Microsoft Word documents being pasted to the editor to preserve as much formatting as
possible.
Content handler is independent of paste. It cleans content when certain actions are
performed, such as paste, getContents (getting the content to save it to the database),
and initEditable (opening content).
NOTE: If content contains improper tagging, it is removed when pasted. Also, images embedded
within documents do not paste into Ektron content; you must insert them separately.

l

l

l

l

l

l

l

dom-to-xhtml/dom-to-xhtml—ensures XHTML compliance. This plug-in enables Ektron
controls.
common/highlighteditables—not a toolbar button; if enabled, you can click a content
item to highlight it for easy identification of content elements
common/horizontalruler (
common/list (
<ol>) list

and

)—insert horizontal line

)—create an unordered (bulleted <ul>) or ordered (numbered

common/paste—not a toolbar button; uses the browser’s capabilities to paste content
from the clipboard
common/table (

)—insert a table See Also: Inserting a Table on page 219

common/undo—not a toolbar button; enables the browser’s capabilities to undo the last
action
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l

l

l

l

l

l
l

ektron/bookmark ( )—set a bookmark within content. See Also: Removing a Link on
page 217
ektron/draganddrop—not a toolbar button; enables drag and drop of images into
content; supported browsers are Webkit-based (such as Safari and Chrome)
ektron/editInContextCallback—raise callback events (that depend on your
permissions and workflow) when you “edit in context.”
ektron/embed (

)— embed a video into your content.

ektron/format—contains bold ( ), italic ( ), subscript ( ), superscript ( ), and the
formatting palette (Paragraph, Span, Heading1-Heading6, Pre).

ektron/hyperlink (

)—insert a hyperlink in the content.

ektron/library ( )—insert a library item (file, form, hyperlink, image, and quicklink)
into the content

l

l

ektron/sourceview ( )—opens a view of HTML coding of the content. Whether you
edit in the source viewer or the HTML editor, both views are kept concurrent.
ektron/template(

)—insert predefined content into the editor at the cursor location;

for example, a caption below an image. See Also: Using a Template to Structure Content
on page 229
l

l

ektron/translate ( )—machine translate text to another Ektron-supported language.
See Also: Translating Content on page 230
ektron/validator ( )—verify content against HTML5, XHTML, WC3, and WCAG
compliance. See Also: Validating Content on page 229

Customizing the Editor's Toolbar Buttons
The editor toolbar appears in several Ektron Workarea locations, and on your site when
logged-in users edit "in context." A different toolbar appears when content authors create
HTML content, enter a calendar event, reply to a discussion forum post, and so on.
Within the C:\inetpub\wwwroot\siteroot\ektron.cms.framework.ui.config file, the
<add name="EditInContext"> element lists all editor locations. Following each location is a
list of the toolbar buttons on that editor. To customize a toolbar, edit the list.

Editor Locations
Editor locations are:
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l
l

l
l

l

Minimal—sample minimal toolbar that you can copy to other locations; not used
Content—toolbar appears when editing HTML content, and its summary; Smart Form rich
area text field; blog posts
Assets—toolbar appears when editing an asset's summary
DiscussionTopic—toolbar appears when working with a discussion topic and its forum
posts
Mediamedia—used in
o Workarea > Library > Add or edit Library item
o

l

l

l

library popup within editor, when adding new library item

CalendarEntryCMSUser—toolbar appears when an Ektron user is working with a calendar
event
CalendarEntryMembershipUser—toolbar appears when a membership user is working
with a calendar event
EditInContext—toolbar appears when using the Edit in Context option; See Also:
Editing Content in Context on a Web Page on page 208

For example, to remove the validator button (
Form rich area text field:

) from the editor that is used to edit a Smart

1. Using the Editor Locations on the previous page list, determine that you need to find the
Content element within the ektron.cms.framework.ui.config file.
2. Using the Editor Plug-ins on page 232 list, determine that you need to find
ektron/validator plug-in within the Content element.
3. Remove the ektron/validator element (see example below).
<add name="Content" path="dom-to-xhtml/dom-to-xhtml,common/ui,ektron/format,
common/contenthandler,common/table,common/list,ektron/hyperlink,
common/highlighteditables,common/undo,common/paste,common/horizontalruler,
ektron/translate,ektron/validator,ektron/template,ektron/embed,ektron/inspector,
ektron/sourceview,ektron/advancedinspector,ektron/draganddrop,common/block"
default="false" />

The following example shows how to modify the "Hello World" plug-in snippet within a <span>
tag.
// define the HelloWorld module using RequireJS
define([
'aloha',
'aloha/plugin',
'aloha/floatingmenu',
'aloha/jquery',
'i18n!aloha/nls/i18n',
'css!helloworld/css/helloworld.css'],
// callback executed once dependencies are loaded by RequireJS
function (Aloha, Plugin, FloatingMenu, jQuery, i18nCore) {
// create and register the Plugin
return Plugin.create("helloworld", {
defaults: {
text: "Hello World!",
wrapper: '<span class="helloworld"></span>'
},
init: function () {
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// executed on plugin initialization
window.console.info("HelloWorld: Begin initialization");
this.createButtons();
window.console.info("HelloWorld: End initialization");
},
createButtons: function () {
// provide locally scoped version of this for use
// in callbacks,e tc.
var that = this,
tabInsert = i18nCore.t('floatingmenu.tab.insert');
// create hellowworld button
this.helloWorldButton = new Aloha.ui.Button({
'name': 'helloWorld',
'iconClass': 'ektron-aloha-button ektron-aloha-helloWorld',
'size': 'small',
'onclick': function () {
that.insertHello();
},
'tooltip': "Click to insert Hello World!",
'toggle': false
});
// add it to the floating menu
FloatingMenu.addButton(
'Aloha.continuoustext',
this.helloWorldButton,
tabInsert,
1
);
},
insertHello: function () {
window.console.info("HelloWorld: Hello World Button clicked");
var html = jQuery(this.settings.wrapper).text(this.settings.text);
// get the current selection range
var range = Aloha.Selection.getRangeObject();
if (range.isCollapsed()) {
GENTICS.Utils.Dom.insertIntoDOM(html, range,
jQuery(Aloha.activeEditable.obj));
}
else {
// remove the contents of the current selection
range.deleteContents();
// insert our Hello World elements
GENTICS.Utils.Dom.insertIntoDOM(html, range,
jQuery(Aloha.activeEditable.obj));
// deselect the current range object
Aloha.getSelection().removeAllRanges();
}
return false;
}
});
}
);
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To learn about creating plug-ins, see http://aloha-editor.org/guides/writing_plugins.html.

Creating Styles and Classes
StyleConfig.js
You set up styles and classes that users can use with the Inspector in the StyleConfig.js
file. It is located at:
[siteroot]\Workarea\FrameworkUI\js\Ektron\Controls\EktronUI\Editor\
Aloha\plugins\ektron\inspector\lib\StyleConfigjs

In the following example, the Alert style is applied to the STRONG tag and is defined as
follows.
"STRONG": {
"styles": {
"Alert": {
"type": "style",
"value": "color:red;",
"workareaBox": "color:red;"
}
}
}
l

STRONG is the tag to which the Alert style is being applied.

l

Alert is the name of the new style that displays in the Inspector's Style Selector

l

The type is defined as style for an in-line style, or class to be applied to an element

l

The value for this Alert style is red text that gets applied to the style or class element

l

The workareaBox defines how the preview appears within the Inspector when a user
chooses this style

Customizing Tags and Attributes
AlohaEktron.aspx
To customize the tags and attributes that users can choose when editing, modify the
AlohaEktron.aspx configuration file, which is located at:
[siteroot]/Workarea/FrameworkUI/js/Ektron/Controls/EktronUI/Editor/Aloha/

Edit the contentHandler section to specify the elements, element attributes, and protocols
that you can apply to content and for content clean up (such as saving or copying and pasting
from an external editor source).
contentHandler: {
insertHtml: [ 'word', 'generic', 'oembed', 'sanitize' ],
initEditable: [ 'sanitize' ],
sanitize: 'relaxed',
allows: {
elements: [
'a', 'abbr', 'b', 'blockquote', 'br', 'caption', 'cite', 'code', 'col',
'colgroup', 'dd', 'dl', 'dt', 'em', 'h1', 'h2', 'h3', 'h4', 'h5', 'h6',
'i', 'img', 'li', 'ol', 'p', 'pre', 'q', 'small', 'strike', 'strong',
'sub', 'sup', 'table', 'tbody', 'td', 'tfoot', 'th', 'thead', 'tr', 'u',
'ul', 'span', 'hr', 'object', 'div', 'script', 'figure', 'noscript',
'figcaption'
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],
attributes: {
'a': ['href', 'name', 'title', 'id', 'rel', 'rev',
'data-gentics-aloha-repository', 'data-gentics-aloha-object-id',
'data-ektron-url', 'style', 'class', 'onclick', 'onkeypress'],
'p': ['class', 'style'],
'span': ['class', 'style'],
'div': [ 'id', 'class'],
'abbr': ['title'],
'blockquote': ['cite'],
'br': ['class'],
'col': ['span', 'width'],
'colgroup': ['span', 'width'],
'img': ['align', 'alt', 'height', 'src', 'title', 'width',
'data-ektron-url', 'class', 'style'],
'ol': ['start', 'type'],
'q': ['cite'],
'script': ['type', 'language'],
'table': ['summary', 'width'],
'td': ['abbr', 'axis', 'colspan', 'rowspan', 'width'],
'th': ['abbr', 'axis', 'colspan', 'rowspan', 'scope', 'width'],
'ul': ['type'],
'li': ['class', 'style'],
'figure': ['data-media','data-media400', 'data-media600', 'title']
},
protocols: {
'a': {'href': ['ftp', 'http', 'https', 'mailto', '__relative__']},
'blockquote': {'cite': ['http', 'https', '__relative__']},
'img': {'src' : ['http', 'https', '__relative__']},
'q': {'cite': ['http', 'https', '__relative__']}
}
}
},
templatePlugin: {FolderID: 0}

Integrating the Editor into an ASPX Page
ektronUI:Editor Control
The ektronUI:Editor control is an ASP.NET server component that you can integrate into an
ASPX page. The following example shows the control on an ASPX page.
The EditInContext value to the ToolbarConfig attribute specifies the group of plug-ins—
from the ektron.cms.framework.ui.config file—to be loaded with the editor. See Also:
Modifying Editor Plug-ins on page 232
<!DOCTYPE html PUBLIC "~//WJC//DTD XHTML 1.0 Strict//EN"
"http:..www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.org/1999/xhtml">
<head runat="server">
<title>Editor control integration</title>
</head>
<body>
<div id="content">
<ektronUI:Editor ID="Editor1" runat="server" ToolbarConfig="EditInContext" />
</div>
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</body>
</html>
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Folders are containers for . Ektron provides the following types of folders:
l

Standard—See this chapter.

l

Root—Acts a container for all folder types.

l

Site—See Supporting Multi-Site Configurations on page 76

l

Community—See Community Folders on page 1171

l

Blog—See Working with Blogs on page 491

l

Discussion Board—See Working with Discussion Boards on page 536

l

eCommerce catalog—See Creating a Catalog Folder on page 1354

l

Web Calendar—See Working with Calendars on page 514

Planning your folder structure helps you manage content effectively. The following
considerations can help you plan.
l

Folder structures should reflect an overall information architecture.
NOTE: Your information architecture also involves metadata, collections, and taxonomy.

l
l

l

l

Organize content by type (especially Smart Forms).
Organize content by user or user group permissions. This can make managing content
easier because permissions can be inherited for the folder.
Organize content by approval process so that there is a single approval chain associated
with the folder.
Keep PageBuilder folders separate; this can help manage permissions and also avoid
title conflicts.

This section also contains the following topics.
Using Folder Menus
Setting Folder Properties
Managing Folder Permissions
Setting Approval Chains
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Using Folder Menus
The following menus and button appear across the top of the View Contents of Folder screen.
Depending on your permissions, you may not see all menu options.

For information on the Add Asset button (
Management System on page 310.

), see Working with Assets in the Document

New Menu
Lets you create and upload new items into the folder.
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l

Folder—Add folder. See Also: Setting Up Your CMS Folder Structure on page 241

l

Blog—Add blog. See Also: Working with Blogs on page 491

l

l

Discussion Board—Add discussion board. See Also: Working with Discussion Boards on
page 536
Community Folder—Add folder whose content can be updated by membership as well
as regular users. See Also: Community Folders on page 1171

l

Calendar—Add Web calendar. See Also: Working with Calendars on page 514

l

Catalog—Add eCommerce catalog. See Also: Creating a Catalog Folder on page 1354

l

l
l

l

l

l

l

l

Site—Add website. (This option is only available in the context of the root folder.) See
Also: Supporting Multi-Site Configurations on page 76
HTML Content—Add HTML content. See Also: Creating New Content on page 287
HTML Form/Survey—Add HTML form, poll, or survey. See Also: Creating Surveys and
Polls on page 407
Page Layout—Add page layout. (This option is only available in the context of the
PageBuilder folder.) See Also: Developing Wireframe Templates on page 676
Master Layout—Add master layout. (This option is only available in the context of the
PageBuilder folder.) See Also: Creating a PageBuilder Master Layout on page 680
Smart Form—Add Smart Form. (This option is only available if one or more Smart
Forms are assigned to the folder.) See Also: Working with Smart Forms on page 423
DMS Document—Add Office document, managed file, or multimedia file, any supported
type. See Also: Managing Microsoft Office Assets on page 322, Managing Assets on
page 315
Multiple DMS Documents—Add several Office documents, managed files, multimedia
files, any supported type. See Also: Adding Multiple DMS Documents on page 317

l

Collection—Add collection. See Also: Working with Collections on page 355

l

Menu—Add menu. See Also: Using Menus on page 753

l

Add Calendar Event—Add calendar event. (This option is only available in the context
of the WebCalendar folder.) See Also: Adding System Calendar Events on page 517

View Menu
Lets you display information about existing content in the folder.
l
l

All types—Displays all content types of selected language.
HTML content, HTML Form/Survey, Office Documents, Managed Files,
Multimedia, or Image Assets—Limits folder display to selected content type. For
example, choose View > Managed Files and see only managed files in the folder;
other content types are suppressed. This is especially helpful if the folder has a lot of
items, and you are looking for only one type of content. If a PageBuilder folder is
selected, you can limit the display to Page Layouts or Master Layouts. For more
information on specific types of content:
l
Creating New Content on page 287
l

Working with HTML Forms on page 386

l

Managing Microsoft Office Assets on page 322

l

Managing Assets on page 315

l

Managing Multimedia Assets on page 318
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l

l

l

l

l

Language—Limits display of content within folder to one language, or lets you display
all languages. If set to one language, this also determines the language of new items you
create or upload into the folder.
Menu—Work with menus assigned to this folder. See Also: Adding a Menu Item via
Content Folder on page 759
Collection—Work with collections assigned to this folder. See Also: Working with
Collections on page 355
Archived Content—View and work with content that passed its scheduled End Date and
whose archive option is either Archive and remove from site or Archive and
remain on Site. When a Web Calendar folder is selected, this menu item appears as
Archived Events.
Properties—Only members of the administrators group and those assigned to the
Folder-Admin role see this option. It lets you assign folder properties, such as which
users can edit a folder’s content. See Also: Defining Roles on page 1120, Setting Folder
Properties on page 253

Delete Menu
Lets you delete folders or content within a folder.
l

l

This folder—Delete current folder and all of its content. If a Web Calendar is selected,
the menu option appears as "This calendar." You cannot delete the Root folder. See Also:
Deleting a Folder on page 251
Content—Delete one or more content items in folder. See Also: Deleting Content on
page 291

Action Menu
Lets you perform actions on the folder or content within the folder.
l

l

l

l

Export For Translation—Prepare content for translation by a translation agency. See
Also: Exporting Content to XLIFF on page 1072
Cut/Copy—Move or copy content to another folder. See Also: Moving or Copying
Content on page 290.
Search—Search content in the Workarea. See Also: Searching the Workarea on
page 966.
Synchronize Folder—Sync this folder on the current server with the same folder on
another server. This option is only displayed if eSync has been set up, you have the
required privileges, and content has changed. See Also: Synchronizing Content and
Folders on page 1537

Workarea Content Menu
The View Contents of Folder screen features a context-sensitive, drop-down menu of options
you can perform for a content item.
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The options displayed depend on several factors, such as
l

your folder permissions

l

your position in the approval chain (if any)

l

the content’s status

l

whether the item is a Microsoft Office document

To see the menu options for any content item:
1. After signing in, navigate to the folder that contains the content.

2. Click on the triangle. A menu of options for that content item appears. For example, if
you have permission to edit, Edit appears on the drop-down menu. The following items
are available on the Workarea context menu:
l
Approve—Approve content that has been submitted for publishing. See Also:
Approving or Declining Content on page 267
l

l

l

Check-In—Change status of selected content to checked in. Might use if you
checked out and saved a document then it became lost or corrupted. This option
changes original document’s status to checked in. However, it does not replace the
version of the file inEktron. To replace content that was checked out and edited,
drag and drop it into Ektron. See Also: Updating an Office Document on page 323
Check out and Save As—Change a content item’s status to checked out and save
it to your local computer. When you finish editing the item, drag and drop it into
Ektron. See Also: Updating an Office Document on page 323
Decline—Decline an approval request submitted to you. This option rejects the
changes and keeps the current version live on website. You are prompted to enter a
reason for the decline. After you decline, the author who made the change is
notified by email and the content is removed from the approval chain. If the author
updated content then submitted it for approval, the updated content remains in the
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file. If you do not want it to remain, choose the Edit option. You may be asked to
decline both a content change and a request to delete content. See Also: Approving
or Declining Content on page 267
l
l

Delete—Submit content for deletion.
Edit—For HTML, HTML form, or XML Smart Form content, edit content within the
editor. For assets, use Check out and Save As or Save As to save asset to your
computer and edit it. Then, use Edit to replace version in Ektron. See Also:
l
Working with Ektron Content on page 287
l

l

l

l

l
l

l

l

l

l

l

l

Working with Smart Forms on page 423

Edit in Microsoft Office—Edit Office document within Ektron. See Also: Editing an
Office Document on page 323
Edit Properties—Edit item’s Ektron information, such as Summary, Metadata,
Schedule, and taxonomy. After you complete the edit screen, you proceed to the
View Content screen. From here, you can perform additional content activities, such
as move/copy, delete, and view history.See Also:
l

Writing a Summary for Content on page 292

l

Working with Metadata on page 369

l

Scheduling Content on page 296

l

Using Taxonomies on page 777

Force Check In—Only appears if user is a member of the Administrator group or
assigned the folder admin role and content is checked out. This option lets an
administrator check in content even though the administrator did not check it out.
Publish—Accept changes to content and publish it to the site.
Request Check In—Allows either admin user or non-admin user with edit
permission for the content’s folder to email the user who checked out content. The
email asks the check-out user to check it in.
Save As—Save Office document or asset to your computer. See Also: Saving an
Office Document on page 324
Submit—Submit current version of content for publishing. When you do this, the
next person in the approval chain is notified that your content is ready for review.
Synchronize—Synchronize content or folders between 2 servers. See Also:
Synchronizing Servers Using eSync on page 1473
View—View item’s Ektron information, such as Summary, Metadata, Schedule, and
taxonomy. After viewing, you can also edit that information if you have permission
View in Microsoft Office—View Office document within Office application.
Cannot change.
View Properties—View Office document’s Ektron information, such as Summary,
Metadata, Schedule, and Taxonomy. After viewing, you can edit the information if
you have permission.

Viewing a Folder
Each folder lists the following information about its content.
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l
l

l

l

Title—The name of the content.
Content Type—HTML content, HTML form, XML Smart Form, managed asset, image,
and so on.
Language—The language of the content. See Also: Working with Multi-Language
Content on page 1057
ID—The number assigned to the content by Ektron. It is used to retrieve the content
from a database.

l

Status—The status of the content. See Also: Content Statuses on page 307

l

Date Modified—The most recent date the content was added, edited, or published.

l

Last Editor—The last user who accessed the content.

To view a folder, follow these steps.
NOTE: You can only view folders for which your system administrator has granted permission. See Also:
Managing Folder Permissions on page 257
1. Access the Workarea and click the Content tab.

2. All content in the root folder and the selected language appear in the right frame.
Subfolders appear in the left frame.
NOTE: The View menu option lets you filter content by type. For example, you can set it to view
only HTML content. Therefore, you may only see content of a selected type in the folder.
3. To work with any folder or its content, click the folder. When you do, its content appears
in the right frame.
4. If your system supports more than one language, you can view content for a particular
language or all languages using the View > Language menu option.

Adding a Folder
To further organize content on your website, create folders to store related content.

Ektron 8.7

247

Setting Up Your CMS Folder Structure

1. Navigate to and click the folder within which you want to create the new folder (that is,
the parent folder).
2. Each folder has a default language. By default, it is inherited from the parent folder. To
change a folder’s default language, use the parent folder’s View > Language selection
(shown below).

3. Choose New > Folder. Alternatively, you can hover the cursor over the folder, right
click the mouse, and choose Add Folder. The Add a folder screen appears.

4. Complete the fields. See Setting Folder Properties on page 253.
5. Click Add Folder.
You can modify the folder’s properties, permissions, approval chain, and so on.
l

If this is a Community Folder, see Community Folders on page 1171.

l

If this is a Site Folder, see Supporting Multi-Site Configurations on page 76.

l

If this is a Catalog Folder, see Creating a Catalog Folder on page 1354.

Copying and Moving a Folder
You can copy a folder and paste it into another folder. Or you can cut and paste one folder into
another. Cut and paste is synonymous with move.
1. In the left panel of the Workarea, hover the cursor over the folder you want to
copy/move.
2. Right click the mouse.
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3. Click Copy or Cut folder name.

4. Hover the cursor over the folder to which you want to paste the copied/cut folder.
5. Right click the mouse and select Paste Folder.
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6. A warning message appears. Click OK.

Who Can Copy and Move Folders
These users can copy or move folders.
l

users who have Add, Edit and Delete permissions for the folder being moved/copied and
the destination folder See Also: Managing Folder Permissions on page 257

l

members of the Administrators user group

l

users assigned in the Roles > Folder Specific > Folder User Admins screen

l

users assigned in the Roles > Folder Specific > Move or Copy screen

See Also: Defining Roles on page 1120

Rules for Copying and Moving Folders
l
l

l

All properties assigned to a folder (permissions, metadata, templates, and so on) remain
assigned after the copy or move. You can edit the folder in its new location and adjust
properties as needed.
Inherit checkboxes (see example below) that were checked are now unchecked. After
the copy/move, you can check them again as needed.

l

You cannot copy or move the root folder

l

You cannot copy or move a folder into its own subfolder

l

You cannot move a folder to same level in the folder structure

l

l
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When you copy or move a folder, you also copy/move all of its subfolders.

You can copy a folder to same level in the folder structure. If you do, a number is
appended to the folder's name, such as calendar(1).
If you move a folder, its content retains its status. That is, if content's status was
checked out (O) before the move, it is checked out after the move.
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l

l

If you copy a folder, only Approved content is copied. Content in any other status is not
copied.
All folder content that follows the above rules is moved/copied. This includes all
language versions of those items.

Which Folder Types Can be Moved and Copied
The following table describes which folder types can be copied/moved into other folder types.
Destination Folder
Source
Folder

Content

Blog

Forum

Community

Web
Calendar

Catalog

Site

Root

*

*

Content

Blog
Discussion
Board
Forum
Community
Web
Calendar
Catalog

*

*

Site
* Although you can copy or move a catalog folder to a non-catalog folder, its content is not
copied/moved; only the folder.

Deleting a Folder
You can delete obsolete folders from the Ektron website.
NOTE: The top-level folder, Root, cannot be deleted nor renamed.
WARNING! Deleting a folder permanently deletes the content and Quicklinks that belong to the folder
and all of its subfolders. You cannot retrieve deleted content.
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1. In the Workarea, navigate to the content folder you want to delete.
2. From the options across the top of the screen, choose Delete > This Folder.

3. Alternatively, you can hover the cursor over the folder in the folder display panel , right
click the mouse, and choose Delete folder name. A confirmation message appears.

4. Click OK.

Purging History
WARNING! Purging historical versions of content in a folder permanently deletes the specified content.
You cannot retrieve purged content.
The Purge History option lets you delete historical versions of content in a folder. For more
information on content versioning, see Managing Versions of Content on page 299.
Purging is generally performed due to storage space concerns or to clear away obsolete
versions before going live or migrating a site. Before purging, make sure you are aware of
any organizational or legal data retention policies.
When purging, you can:
l

specify a date to limit which historical versions are purged. Only historical versions with
an edit/publish date before this are purged.

l

indicate whether a folder’s subfolders are purged

l

purge published as well as checked-in versions of content

PREREQUISITE
252

Ektron Reference

Setting Folder Properties

Only administrators and users identified on the Manage Members for Role: Folder
User Admin screen can purge history.
To purge the history for a content folder:
1. Access the View Folder Properties screen for the content folder for which you want to
purge the history.
2. Click Purge History (

). The Purge History screen appears.

3. Use the following list to customize the Purge History options.
l
Only purge historical versions before (required)—Specify a date to limit the
number of historical versions to purge. When specified, only historical versions with
a date before this date are purged.
l

l

Recursive Purge (optional)—Purges historical content versions in this folder’s
subfolders.
Purge versions marked as Published (optional)—Purges published versions of
content as well as checked-in versions.

4. Click Purge History. A confirmation message appears.
5. Click OK to execute the purge and display a confirmation when complete.

Setting Folder Properties
The folder properties screen lets you set permissions and approvals for a folder. You can also
assign or modify the folder’s metadata, Web Alerts, and Smart Forms.
PREREQUISITE
Only members of the Administrator Group and those defined in the Manage Members
for Role: Folder User Admin screen can view, add, or edit folder properties. (See
Also: Defining Roles on page 1120) In addition, if a user is not a member of the
Administrators group, the user must be given permission for individual folders on the
View Permissions for Folder screen. (See Also: Managing Folder Permissions on
page 257)
NOTE: If you are using an eCommerce catalog, see Creating Product Types and Catalogs on
page 1343for a description of the Product Types screen. If you are using a Web Calendar folder, see
Viewing System Calendar Properties on page 521.
1. Select the folder.
2. From the View Contents of Folder screen, choose View > Properties. Alternatively,
from the left panel, right click the mouse and choose View Properties.
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The Folder Properties screen contains these toolbar buttons.
l
l

Edit Properties—Access the Edit Folder Properties screen.
Permissions—Access the folder’s Permissions Table; see Managing Folder
Permissions on page 257.

l

Modify Preapproval Group—Set or update preapproval group assigned to
folder; see Setting Up an Automatic Task for Pre-approving Content on page 1043

l

Approvals—Access the folder’s approvals table; see Setting Approval Chains on
page 262

l

Purge History—Access the folder’s purge history table; see Purging History
on page 252

l

Restore Web Alert Inheritance—Assigns the folder’s Web Alert properties to
all content in folder; see Restoring Folder-level Web Alert Information to Content
on page 1586

l

Back—Go to previous screen

3. To change properties, click Edit Properties to open the edit screen.
The Properties screen lets you set the following folder properties, arranged by tab:
Properties tab
l
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Name—Edit the name of the content folder. You cannot change the root folder
name.
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l
l

Description—Edit the description of the content folder.
Style Sheet—Specify a style sheet filename that defines styles that may be
applied to content in this folder. The style sheet populates the style drop-down list
within the editor. Leave this field blank to inherit the parent folder’s style sheet.
This style sheet affects content being edited. It does not necessarily affect the
content’s appearance on your website. To set or edit the style sheet that
determines your Web pages’ appearance, open the page’s Web form and place a
<link rel=”stylesheet”...tag within its <HEAD>tags. If desired, you can
identify the same style sheet in both locations. To include user-selectable styles,
they must be generic classes.
The Ektron editor ignores the CSS custom properties caption and visible. To
address this problem for Internet Explorer, replace them with the custom CSS
properties localeRef, caption and visible. For other browsers, use the custom
CSS selectors localeRef and unselectable (same as visible: false). To
achieve cross-browser compatibility, use both approaches. Non-IE browsers have
no equivalent forcaption.

l

l

l

l

l

Multi-site Domain Configuration—The Site Name, Staging Domain, and
Production Domain fields only appear for Site folders. These fields are used to
set up and manage several websites under one CMS.See Also: Supporting Multi-Site
Configurations on page 76.
Office Documents—This field only appears if the Enable Office documents to
be published in other format property is checked in the Settings >
Configuration > Setup screen. See Also: Getting Started with Ektron on page 5.
Enable the Publish Office documents as PDF check box if Office documents in
this folder are published as PDF files. See Also: Working with Assets in the
Document Management System on page 310. This property is not inherited from a
parent folder, nor is it inherited by any subfolders below this folder.
Content Searchable—Check the Inherit Parent Configuration box if you want
this folder to inherit the Content Searchable value from its parent folder. Uncheck
this box to break inheritance and apply a unique Content Searchable setting to this
folder.
Check this box to set the default value of the Content Searchable property for new
content added to this folder. It does not affect existing content in the folder, or
content copied or moved to this folder. Regardless of the default value, an
authorized user can change the Content Searchable value while adding content to
the folder or at any other time. See Also: Ensuring Your Content is Searchable on
page 942.
Display Settings—Enable the Inherit Parent Configuration check box if you
want this folder to inherit the Display Settings value from its parent folder setting.
Disable this check box if you want to break inheritance and apply a unique Display
Settings setting to this folder.
Display All Tabs—Check this box to display all tabs on the Create or Edit Content
screen. Or, check any tab-specific check boxes to display the selected tabs on the
Create or Edit Content screen. If you enable the Display All Tabs check box and
other tab-specific selections, only the individually checked tabs remain when you
click Update. Also, if a tab has a "required" property on it, the tab displays even if
you uncheck its box.

Taxonomy tab—See Assigning a Folder to a Taxonomy or Categories on page 791
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l

Taxonomy—Enable the Inherit Parent Configuration check box if you want this
folder to inherit taxonomy configurations from the parent folder. If you disable
Inherit Parent Configuration, you can then select taxonomies that can be
applied to content in this folder. Check the At least one category is required
check box if you want all content in this folder to be assigned at least one taxonomy
category. See Also: Using Taxonomies on page 777,Inheriting Taxonomies from a
Parent Folder on page 791

Templates tab—See Working with Templates on page 382
l

Page Templates—Lets you specify one or more templates for content in this
folder. This folder’s content uses the specified template when appearing on your
website. Enable the Inherit parent configuration check box to inherit the
template from the parent content folder. Or, do not check this box and specify one
or more templates.

Flagging tab—See Assigning a Flagging Definition to a Folder on page 1241
l

Flagging—Enable the Inherit Parent Configuration check box if content in this
folder inherits a flagging definition from its parent folder. If you do not check the
box, use the drop-down list to apply a flagging definition to content in this folder.
See Also: Defining Flags for Content on page 1239,Assigning a Flagging Definition to
a Folder on page 1241

Metadata tab—See Working with Metadata on page 369
l

Metadata—Enable the Inherit Parent Configuration check box if you want this
folder to inherit the metadata values from its parent folder setting. Uncheck this
box if you want to break inheritance and apply unique metadata settings to this
folder. If inheritance is disabled, check the applicable boxes to determine which
metadata definitions can be used.Only metadata definitions whose Assigned box is
checked can be completed by users working with content in the folder.

Web Alerts tab—See Assigning Web Alert Information to Folders and Content on
page 1581
l

Web Alerts—Lets you specify custom Web alert settings for this folder or inherit
settings from the parent folder. For a description of the Web alert settings, see
Assigning Web Alert Information to Folders and Content on page 1581.

Smart Forms tab—SeeWorking with Smart Forms on page 423
l

Smart Forms—Lets you specify custom Smart Form settings for this folder or
inherit settings from the parent folder. For a description of the Smart Form
settings, see Assigning a Smart Form Configuration to a Folder on page 437.

Product Types tab—SeeCreating Product Types on page 1343
l

Default product type—Enable the Inherit Parent Configuration check box if
you want this folder to inherit the metadata values from its parent folder setting.
Uncheck this box if you want to break inheritance and apply unique metadata
settings to this folder. If inheritance is broken, use the radio buttons to enable a
default product type.

Breadcrumb tab—See Creating Sitemap Breadcrumbs on page 820
l

Breadcrumbs—Lets you specify custom breadcrumb settings for this folder or
inherit settings from the parent folder.

Site Alias tab—SeeCreating a URL Alias for a Site on page 856
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l

Name—A URL to be used as an alias for the site. This tab and field combination
only appears for Site folders.

Aliasing tab—See Creating User-Friendly URLs with Aliasing on page 835
l

Aliasing—Only appears if some form of aliasing is enabled. Enable the Manual
Alias Required check box to force the user creating or updating content in the
folder to add a manual alias (if none exists). Enable the Inherit parent
configuration check box (disabled by default) if you want the folder to inherit the
Manual Alias Required value from the parent folder.

Managing Folder Permissions
Permissions determine which actions Ektron users and user group members can perform on
content, library items, and content folders. For example, you let your Webmaster perform
advanced actions, such as adding folders, editing folder properties, and deleting folders. At
the same time, you let content contributors only view, edit, and add content.
You can set permissions for a folder or content item. Content item permissions override the
associated content folder permissions. When you assign permissions to a folder, they affect
all of its subfolders and content unless you break inheritance for a subfolder or content item.
Only Ektron administrators and users identified on the Manage Members for Role: Folder User
Admin screen can set permissions. See Also: Using the Roles Screens on page 1121
NOTE: You can view and update membership users by selecting Membership users from the User Type
drop-down menu; see Assigning Membership Permissions on page 1166
This section also contains the following topics.
Accessing the Permissions Table
Inheriting Permissions
Breaking Inheritance
Restoring Inheritance
Adding a User or User Group to the Permissions Table
Deleting a User or User Group from the Permissions Table
Editing User or User Group Permissions
Setting Permissions for Content
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Accessing the Permissions Table
IMPORTANT: All members of the Administrators group have all permissions for all Ektron folders.
Although these users do not appear when you view a folder’s permission settings, they have full
permissions.
You manage the following permissions through the Permission Table.
NOTE: Use the Roles screens to assign permissions not defined in the Permissions Table, such as the
ability to create tasks. See Also: Defining Roles on page 1120
l
l

Content management: view, add, edit, delete, restore
Library File Management: view, add images, add other types of files, add hyperlinks,
overwrite files

l

Folder management: add, edit, delete, traverse

l

Work with collections and Menus
Ektron 8.7
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To accessing the permissions table:
1. From the left frame of the Workarea, select a content folder.
2. Choose View > Language.
3. Select the language whose folder properties you want to update. Some folder properties
(such as metadata and taxonomy) are language-specific.

4. Choose View > Properties. The Folder Properties screen appears.
5. Click Permissions (
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). The Permissions Table appears.

Inheriting Permissions

The Permissions Table displays each user or group’s abilities to perform actions on content in
the selected folder. Because all permissions cannot fit on one screen, click the Advanced tab
to see additional actions.
NOTE: To let users copy or move content, assign the Move or Copy role. See Also: Defining Roles on
page 1120
Standard permissions
l

Read Only—View content

l

Edit—Edit content

l

Add—Add content

l

Delete—Delete content

l

Restore—Restore old versions of content

l

Library Read Only—View items in the corresponding library folder See Also: Storing
Files in the Library on page 333

l

Add Images—Upload images to the corresponding library folder

l

Add Files—Upload files to the corresponding library folder

l

Add Hyperlinks—Add hyperlinks to the corresponding library folder

l

Overwrite Library—Overwrite images and files to the corresponding library folder

Advanced permissions
l

Collections—Manage collections See Also: Working with Collections on page 355
IMPORTANT: If a user is assigned any of the following roles, the user can create,edit, and delete
collections regardless of the user's Collections folder permission: Collection and Menu Admin,
Collection Admin, Collection Approver.

l

Add Folders—Add sub folders See Also: Adding a Folder on page 247

l

Edit Folders—Edit folder properties See Also: Setting Folder Properties on page 253

l

l

l

Delete Folders—Delete the current folder or its subfolders See Also: Deleting a Folder
on page 251
Traverse Folders—Access folders under the root folder. By default, the Everyone
user group has permission to view all subfolders. If you disable or modify the Everyone
user group, and you want to grant users/groups permission to a folder other than the
root folder, you must also assign Traverse permission. If you do not, the user cannot
access the folder. In that case, the user cannot perform any other granted permissions.
Modify Preapproval—Set or update a folder’s preapproval group. This permission is
only displayed if preapproval groups are enabled. See Also: Setting Up an Automatic
Task for Pre-approving Content on page 1043

Inheriting Permissions
An approval chain’s inheritance is determined by the corresponding permission table. If a
folder’s permission table inherits settings from its parent folder, that folder’s approval chain
also inherits.
The Approval Chain screen only displays its inheritance status; it does not let you set it.
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By default, all content folders and items inherit permissions from their parent folder. You
have 2 options for modifying permissions.
l

Modify the permissions of the parent folder

l

Break inheritance and add permissions to a folder

Breaking Inheritance
1. Access the Permissions Table for a content folder or content.
2. Disable the Allow this object to inherit permissions check box. A confirmation
message appears.
3. Click OK.

Restoring Inheritance
1. Access the Permissions Table.
2. Check the box that says Allow this object to inherit permissions. A confirmation
message appears.
3. Click OK.

Adding a User or User Group to the Permissions
Table
NOTE: Before adding users or groups, you must break inheritance. See Breaking Inheritance above. If a
user and a user group to which that user belongs are both given permission to a folder, the user has all
permissions to which he/she is assigned as well as permissions assigned to the group. You can only
assign Read Only permission to a Membership user or group. See Also: Membership Users and Groups
on page 1161.
1. Access the Permissions Table for the content folder or content.
2. Select CMS users or Membership users from the User Type drop-down menu. Users
and user groups of the selected type appear.
3. Click AddPermissions. The Add Permissions screen appears. Only users and groups not
assigned to the Permissions Table appear.
4. Select users and groups to add to the Permissions Table.
5. Click Save. The Add Permissions screen appears.
6. Check the standard and advanced permissions for the user or group.
NOTE: Check Enable All to assign all standard permissions. If you do, you still must assign
advanced permissions by hand.
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Deleting a User or User Group from the Permissions

7. Click Save.

Deleting a User or User Group from the Permissions
Table
1. Access the Permissions Table for the content folder or content.
2. Select CMS users or Membership users from the User Type drop-down menu. Users
and user groups of the selected type appear.
3. Click Delete ( ). The Remove Permissions screen appears.
4. Select the user or group to remove from the Permissions Table.
5. Click Remove Permissions for folder. A confirmation message appears.
6. Click OK.
NOTE: When you delete the permissions of a user or user group, that change is propagated to all
subfolders and content. Also, if the user or group was part of an approval chain, they are removed
from it.

Editing User or User Group Permissions
1. Access the Permissions Table for the content folder or content.
2. Select CMS users or Membership users from the User Type drop-down menu. Users
and user groups of the selected type appear.
3. Click the user or group for which you want to edit permissions. The Edit Permissions
screen appears.
4. To assign any permission, check the box. To remove any permission, uncheck the box.
NOTE: Remember to toggle between standard and advanced permissions.
5. Click Update.

Setting Permissions for Content
Users can only add, edit, or delete content in folders if they have traverse permission for its
parent folders all the way up to root. If the folder to which you assign permissions is not the
root folder, you must grant the user the Traverse Folder permission to all folders above that
folder. Otherwise, the user cannot navigate to the folder. For example, consider the following
folder structure.
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To let a user edit the Book Store folder only and no other folders, assign to the person
Traverse Folder permission for the 2 folders above Book Store: CMS400Demo and Folders
(root folder).
PREREQUISITES
l

Traverse permission to the folder containing the content, and all folders above it

l

Edit permission for the content

1. Access the content by navigating to its folder, selecting a language, and clicking on it.
2. Click View Permissions (

).

3. Uncheck the box next to Allow this object to inherit permissions. A confirmation
message appears.
NOTE: If Allow this object to inherit permissions is already checked, you cannot uncheck this
box. The content in this folder is private and can only be viewed by authorized users and members;
see Making Content Private on page 294. In that case, this folder is inheriting this setting from its
parent folder.
4. Click OK.
5. You can perform any action on the content that you can perform on a folder. These
options are described in Managing Folder Permissions on page 257.

Setting Approval Chains
An approval chain is a series of users or user groups who must approve content before it can
be published to your website.
An approval chain lets you control how and when your website is updated. For example, if
your Web master needs to approve every new content item or update of an existing item, the
Web master would be last member of every approval chain and exert total control over the
site.
Alternatively, you could set up a less centralized organization, where each department head
controls a section. To accommodate this, set up an approval chain for each department, and
assign the department head as the last member of the chain. When the last person in the
chain approves content, it goes live. Also, if a user deletes content, before it is removed from
Ektron, it must pass through the approval chain.
On the opposite extreme, you can delete the approval chain for a content item or folder. In
this case, every item in that folder is published as soon as a user submits it for publication.
You can approve, edit, or decline content submitted to you or your user group. The following
chart illustrates the approval process.
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Setting Approval Chains

NOTE: An approver can edit the content and publish it, unless Force All Approvers is set, in which case
an edit by any approver would cause the approval chain to start over.
You can create approval chains for a folder and content within a folder. If a content approval
chain exists, it overrides the folder approval chain. You can also set up an approval chain for
a language.
An approval chain can include any number of users or user groups.
NOTE: Only members of the Administrators group and users assigned to the Folder User Admin Role
screen can modify the approval chain. See Also: Defining Roles on page 1120
l

l

l

l

Only users or user groups with read-only or higher permission to the folder or content
can be added to the approval chain. See Also: Managing Folder Permissions on page 257
If you assign a user group to an approval chain, only 1 member of the group needs to
approve the content, not all members.
If a user appears in an approval chain twice (both as a user and part of a user group),
the approval chain skips the second approval because the user has already approved the
content.
An approval chain’s inheritance is determined by the corresponding permission table.
So, if a folder’s permission table inherits settings from its parent folder, that folder’s
approval chain also inherits. The Approval Chain screen only displays its inheritance
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status; you cannot set it.

Ektron can automatically send email notification, informing users that content work flow
events have either taken place or are requested of them. For example:
l

l

When 1 member of the approval chain approves content, the next user or group is
notified that the content is ready for approval.
A content contributor receives an email that the contributor's content was published.

The list of automatic emails and directions for customizing their content are described in
Customizing Ektron email with Variables on page 96.
Finally, the Approval Method determines if content must be approved by all users in the chain,
or only users higher up the chain than the one making the edits. See Setting the Approval
Method on page 271.
This section also contains the following topics.
Creating an Approval Chain for a Content Folder
Viewing a Folder’s Approval Chain
Adding Approvers
Editing the Approval Order
Deleting Approvers
Creating an Approval Chain For Content
Approving or Declining Content
Example Approval Chain
First Approver
Second Approver
Setting the Approval Method

Creating an Approval Chain for a Content Folder
PREREQUISITE
Only Administrators group members and users assigned to the Folder User Admin
Role screen can modify the approval chain See Also: Defining Roles on page 1120
Before you can create or edit an approval chain, you must access the View screen.

Viewing a Folder’s Approval Chain
1. Click the Content tab.
2. From the left frame of the Workarea, select a folder.
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Adding Approvers

3. Choose View > Language and select the language of the approval chain you want to
view.
4. Choose View > Properties.
5. Click Approvals (

).

The screen shows the following information about the approval chain.
l

its language

l

every user and user group in the chain

l

the approval order

l

the approval method See Also: Setting the Approval Method on page 271

l

buttons for modifying the approval chain and method

Adding Approvers
BEST PRACTICE
Assign user groups (and not individual users) to an approval chain. In this way, if
someone is out of the office, any group member can approve the content.
1. Access the approval table, as described in Viewing a Folder’s Approval Chain on the
previous page.
2. Select the language of the approval chain. The chain only applies to content in this
language.
3. Click Add. The Add Approvals screen appears.
NOTE: Only users and user groups with permissions to the folder appear. See Adding a User or
User Group to the Permissions Table on page 260 for more information.
4. Click the user or user group to add to the approval chain. A confirmation message
appears.
5. Click OK.

Editing the Approval Order
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After you assign approvers to a folder, you may want to adjust the approval order. Place the
user or group with final approval authority at the end of the approval chain (that is, the
highest number). For example, if you have a content contributor whose edits must be
approved by a department head, and the Webmaster has final review of all content, the
approval order would look like this:
l

Content contributor—1

l

Department Head—2

l

Webmaster—3

To edit the approval order:
1. Access the approval table as described in Viewing a Folder’s Approval Chain on
page 264.
2. Select the language.
3. Click Reorder Items (

). The Edit Approval Order screen appears.

4. Click the user or group whose approval order you want to change.

5. Click Up (

) or Down (

) to move the user or group to the desired order.

6. Click Update.

Deleting Approvers
WARNING! If a user is deleted from a folder's permissions table, the user is automatically deleted from
the folder's approval chain.
1. Access the approval table as described in Viewing a Folder’s Approval Chain on
page 264.
2. Select the language.
3. Click Delete ( ). The Remove Approval screen appears.
4. Click the user or group that you want to remove from the approval chain. A confirmation
message appears.
5. Click OK.

Creating an Approval Chain For Content
You can change the approval chain for a specific content item. Use the View Content screen's
Approvals button to do this.
Prerequisites
PREREQUISITES
l

266

You must disable the inheritance of permissions for the content whose approval chain
you want to edit. See Setting Permissions for Content on page 261.
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Approving or Declining Content

l

You must assign users or groups to the approval chain. Only users and user groups with
permissions to the content may be assigned. See Managing Folder Permissions on
page 257.

1. Go to the folder that contains the content.
2. Right click the content and choose View Properties.
3. Click View Approvals (

). The content’s approval chain appears.

4. If the approval chain is inherited, you must break inheritance.
5. From this screen, you can perform these actions:
l
Add—Add approvers
l
l

l

l

—Remove approvers
—Change the order of users in the approval chain
—Change the approval method
Content language—Change the language of the approval chain

Approving or Declining Content
1. Workarea > Reports > Contents > Approvals. All content submitted to you
appears. You can click the content to view it, the summary, metadata, and so on.
NOTE: An approver can edit the content and publish it, unless Force All Approvers is set, in
which case an edit by any approver would cause the approval chain to start over.
2. Check all content you want to approve or decline. To select all displayed content, check
the box in the title row.
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3. Click Approve All or click Decline All (

). The applicable message appears.

4. To continue, click OK. The approved content is either submitted to the next publisher,
published immediately to the website, or not published, depending on the approval chain
set for the content.

Example Approval Chain
The following example follows a typical content block from creation to publication. Three
users make up this approval chain.
l

Sports Writer—creates sports content

l

Sports Editor—edits and publishes all sports articles

l

Editor In Chief—edits and publishes all articles

Each user has different permissions that correspond to their roles.
The approval chain begins when a content contributor submits a new or edited content. If
email is enabled, an email is sent to the next approver in the approval chain.

First Approver
After the Sports Writer submits the content, the first user in the approval chain, Sports Editor,
receives an email stating content needs approval. Sports Writer can change and approve the
content or decline it.
Sports Editor logs into Ektron, navigates to the desktop, and sees the Content Awaiting
Approval panel.

Sports Editor clicks the View All link and sees all content awaiting approval. The approvals
folder window displays information such as title, who submitted it, go live date, and so on.
Sports Editor clicks the submitted content.
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Second Approver

The View Content Awaiting Approvals window appears listing all information necessary to
decide whether to approve or decline the content. At the approval window, the Sports Editor
has these options.
l

Approve—Send content to next approver in approval chain.

l

Decline (

l

)—

o

Send email to creator, notifying him/her that content was declined.

o

Remove content from approval chain.

Edit (

)—Invokes the editor. From here, the approver can change the content.

NOTE: An approver can edit the content and publish it, unless Force All Approvers is set, in
which case an edit by any approver would cause the approval chain to start over.
For this example, choose Publish.

Second Approver
After the content is approved, the next approver in the approval chain receives an email
saying that the content is ready for approval.
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EditorInChief logs in to Ektron and accesses the Workarea. The Workarea has an Approval
folder with the content awaiting approval. EditorInChief navigates through the Approval folder
to the content Red Sox win World Series.
From this window, EditorInChief can view information about the content, including title, go
live date, user who created it, and so on. EditorinChief then clicks the content to be approved.
This window is similar to the previous approver’s but includes a Publish button at the top of
the screen. The EditorInChief has a Publish button (instead of a Submit button) because this
user is the last approver in the approval chain. When the EditorInChief approves the content,
it is published to the website.
Like the Sports Editor, the EditorInChief has the following options:
l

Publish—Publish the content.
Decline

l

l

o

Sends an email to the creator, notifying him/her that content was declined.

o

Removes content from the approval chain.
Edit —Invokes the editor. The approver changes the content.

NOTE: An approver can edit the content and publish it, unless Force All Approvers is set, in which
case an edit by any approver would cause the approval chain to start over.
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Setting the Approval Method

After reviewing the content, the EditorInChief decides it is great and publishes it. At this
point, the content becomes live on the website, and the approval chain is complete. The user
who created the content receives an email notification that it was published.

Setting the Approval Method
The Approval Method determines if content must be approved by all users in the chain, or
only users higher up in the chain than the user creating the content or making edits. The
approval method affects the approval process only if the person submitting content for
publishing is a member of the approval chain.
Two approval methods are available.
l

l

Force All Approvers—All users in approval chain must approve the content, beginning
with the first.
Do Not Force All Approvers—Approvers after the user submitting content in the
approval chain must approve the content.

For example, assume the approval chain order is set as follows:
1. Content contributor
2. Department Head
3. Web Master
If the Approval Method is Force All Approvers, and the Department Head submits content,
the content must be approved by the content contributor, then the department head, and the
Webmaster before it is published.
If the Approval Method is Do Not Force All Approvers, and the Department Head submits
content, the content must only be approved the Webmaster before it is published.
PREREQUISITE
If the approval chain is inherited, you must break inheritance.
By default, the approval method is set to Do Not Force All Approvers. To change the
approval method for a content folder or item:
1. Click the Content tab.
2. From the left frame of the Workarea, select a folder.
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3. Choose View > Language and select the language of the approval chain you want to
view.
4. Choose View > Properties.
5. Click Approvals (
6. Click Edit (

).

). The Edit Approval Method screen appears.

7. Select an approval method by clicking the applicable radio button.
8. Click Update.
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Most of your time in Ektron is spent creating, editing, and performing other activities with
content. Content encompasses all of the articles, news, forms, blogs, discussion forums and
even calendars that appear on your website. Authors can conveniently update content directly
from the website (after logging in). To access the full functionality, however, users complete
tasks within the Workarea.
You can manage Ektron content using 1 or more tools.
l

l

l

Web Page Editing—You can interact directly on the Web page anywhere you see a
silver access point ( ), which lets you edit the content on the page. For information
about editing on the Web page, see Editing Content in Context on a Web Page on
page 208.
Workarea—depending on permissions, lets you access all content, assets, reports, and
settings.
Smart Desktop—Lets you organize information that is relevant to you in the Workarea.

Using the Workarea
The Workarea is a central location where you can perform most tasks for managing your
website. The Workarea is similar to Microsoft Outlook in its ability to manage email,
calendars, tasks, and so on.
NOTE: To access the Workarea, you must be logged in to your Ektron website.

Workarea Quick Reference
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l

l

l

l

1—Workarea Tabs
o Desktop—Smart personalization desktop.
o

Content—Folders, contents, DMS, taxonomies, collections and menus.

o

Library—Content folder structure which organizes the storage images, files ,
hyperlinks and quicklinks.

o

Settings—Manage CMS Settings based upon permissions.

o

Reports—Content reports and Site analytics.

o

Help—In Workarea and in context help section.

Content Tab Types
o 2—Folder Tab—Select to view folder architect structure of CMS.
o

3—Taxonomy Tab—Select to view Taxonomy Structure and options.

o

4—Collections Tab—Select to view Collections and options.

o

5—Menu Tab—Select to view Menus and options.

Folder Types
o 6—Content Folder—Regular folder for contents, select to view contents in that
folder.
o

7—Blog Folder—Select to view the posts and comments on this blog.

o

8—Forum Folder—Select to view the discussion forums, categories, topics, and
replies.

o

9—eCommerce Folder—Select to view the eCommerce items.

o

10—Calendar Folder—Select to view and plan events on the calendar.

o

11—Community Folder—Folders for membership uses to edit content, select to
view contents.

Dropdown Menus
o 12—New menu—Create new content, forms documents, Folders menus and
collections.
o

13—View menu—View Language, Properties and archived content and more.

o

14—Delete menu—Used to delete multiple items. Administrators can delete folders.

o

15—Action menu—Export for translation, search, move/copy content, eSync.
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l

o

16—DMS/ Add asset—Pop up the window for drag and drop documents from local
machine.

o

17—In Context Help—Click to get in context help anywhere in the Workarea.

o

18—Content Organization Bar—Ability to sort content by the title.

Content Types
o 19—Content Items—HTML Content, Forms, DMS, or Multimedia Content.
o

20—Quick Edit Menu—For content editing, properties and content eSync.

o

21—Language Flag—Indicate the content language version.

o

22—Content ID—Automatically generated by system.

o

23—Content Status—Shows the current status of a piece of content.
n (A) Approved Published and on the website.
n

(O) Checked Out Only available for editing by the content editor who checked it
out.

n

(I) Checked In Available for editing.

n

(S) Submitted Currently in the approval chain. Waiting for acceptance.

n

(M) Deletion Marked for deletion.

n

(T) Awaiting Tasks Currently awaiting completion of tasks.

n

(P) Pending Awaiting scheduled start date.

n

(D) Pending Deletion Pending deletion but created with a future start date.

o

24—Date Modified—Last modified date of the content.

o

25—Last Editor—Editor who made the last modification.

Workarea Tabs
The Workarea has 6 tabs in the upper left corner. Use them to access all other pages.

The following list shows the Workarea's main pages.
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l

Desktop—Personalizing the Smart Desktop on page 278

l

Content—Managing Content on page 273

l

Library—Storing Files in the Library on page 333

l

Settings—contains these folders.
l

Commerce—Conducting eCommerce on page 1279

l

Community Management—Managing User Communities on page 1159

l

Configuration—See feature-specific topics

l

Digital Experience hub—Setting Up the Digital Experience Hub on page 991

l

Localization—Importing Translation Files on page 1076

l

Roles—Defining Roles on page 1120

l

Business Rules—Creating Business Rules for Your Website on page 1049

l

User Groups—Managing User Groups on page 1106

l

Users—Managing Users on page 1100
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l

l

Reports—contains these folders:
l

Commerce—Generating eCommerce Reports, Widgets, and Logs on page 1397

l

Contents—Working with Content Reports on page 577

l

Traffic Analytics—Web Traffic Analytics on page 620

l

Business Analytics—Templates on page 606

l

Tasks—Assigning and Managing Tasks on page 1027

Help

Workarea Style Sheets
The Workarea uses 2 primary style sheets:
l

l

Ektron.workarea.css—the primary CSS file for the workarea. It replaces the previous
Ektron version’s global.css file.
Ektron.workarea.ie.css—is used for Internet Explorer browsers, and generally
targeted at IE7 or less. It includes overrides for some CSS rules in Ektron.workarea.css
that get around IE CSS bugs or deficiencies.

Using widely accepted style sheet classes and class attributes, you can modify the Workarea,
including colors, spacing, fonts, and so on. Also, if you later upgrade or re-install Ektron, you
can reuse this file and retain your changes.
NOTE: Several language specific Images are used at the top of the Workarea. They reside in the
language folders and always start with the word “Workarea” and end with “_top.” These images are 467
pixels wide by 77 pixels high. Their width can change but the height cannot. There are approximately six
images in each language folder. an Adobe Photoshop file, Workarea_top.psd, can be found under
\Workarea\images\English folder. You can modify these images as needed.

Accessing the Workarea
To access the Workarea, log into your website and click Workarea. The Smart Desktop is the
default tab.
NOTE: The Application Setup screen lets you determine the initial screen that appears when you access
the Workarea. See Also: Modifying Setup Information on page 115
The Smart Desktop contains useful information that pertains to you. You may personalize this
page by adding, moving or deleting Workarea widgets. See Also: Personalizing the Smart
Desktop on the next page

Closing the Workarea
There are 2 ways to close the workarea.
l

l

Log out of the Website from a Logout link on the Web page or the Logout button (
).
Using the Windows Close button (

) in the upper right corner of the browser. If you do

this, you remain logged in to the website.
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Using the Smart Desktop
Personalizing the Smart Desktop
To personalize your Smart Desktop, you choose and arrange widgets that pertain to your
work. To access the Smart Desktop, click the Desktop tab in the Workarea.

The default Smart Desktop displays several widgets with information about your website. You
can create new tabs on a Smart Desktop to add, move, delete, and organize widgets by
subject. Each tab consists of 1 or more columns, which you can create to further arrange
widgets on a tab. The following screen has 2 columns.
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Enabling Smart Desktop Widgets

Smart Desktop widgets are stored in a widget tray. Drag and drop widgets from the tray to
any tab and column on the Smart Desktop.

Enabling Smart Desktop Widgets
PREREQUISITE
You are a member of the Administrators group.
You must complete this procedure before administrators can create a default Smart Desktop.
1. Workarea > Settings > Configuration > Personalizations > Widget Space.
2. Click Edit (

) next to UserSmartDesktop.

3. Select widgets that users can place on their Smart Desktop.
4. Click Click here to save widget space.

Setting the Default Smart Desktop
The following procedure shows how an administrator creates a default Smart Desktop
consisting of a unique arrangement of widgets, tabs, and columns. The default desktop
becomes every user's Smart Desktop until modified by the user. A user can reset the Smart
Desktop to the default setting by running the Reset Widgets command (see Restoring Tabs
and Widgets on page 283).
NOTE: If you change the default Smart Desktop, that action does not affect existing users' desktops.
Those desktops are set to default settings only if the user runs the Reset Widgets command.
1. Go to Workarea > Desktop.
2. Choose Options ( ) > Edit Default Widgets on the right side of the Smart Desktop. A
confirmation dialog box appears.

3. Click OK.
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4. Arrange the Smart Desktop with widgets, tabs, and columns that you want to be the
default. See Also: Adding a Widget to the Smart Desktop on the facing page, Adding a
Tab to the Smart Desktop on the facing page, Adding a Column on page 282
5. Choose Options ( ) > Done.

Adding Smart Desktop Widgets
Smart Desktop widgets are located in the Web server's workarea\widgets folder. You can
also make Personalization and PageBuilder widgets available to the Smart Desktop.
IMPORTANT: Some Personalization and PageBuilder widgets may not work properly on the Smart
Desktop. Test them before notifying users.
PREREQUISITE
You have access to the Ektron Web server's file system.
1. On the Web server, copy desired widget files from the siteroot\widgets folder to the
siteroot\Workarea\Widgets folder. Be sure to copy all widget-related files and
folders. The following image shows all Calendar widget folders (with their files inside).

2. Click Workarea > Settings> Configuration > Personalizations > Widgets.
3. Click Synchronize Widgets....

4. At the prompt, click OK.
5. Go to Workarea > Settings > Personalizations > Widget Space.
6. Click Edit (

) next to UserSmartDesktop.

7. Select the new widget (you may have to scroll down to see it).
8. Click Click here to save widget space.
9. Users many now add the widget to the Smart Desktop. See Adding a Widget to the Smart
Desktop on the facing page.

Customizing the Smart Desktop
An end user can do the following when customizing a Smart Desktop:
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l

drag and drop widgets—See Adding a Widget to the Smart Desktop below

l

add tabs—See Adding a Tab to the Smart Desktop below

l

l

add or remove columns within a tab—See Adding a Column on the next page, Deleting a
Column on the next page
restore Smart Desktop to default settings—See Restoring Tabs and Widgets on page 283

Adding a Widget to the Smart Desktop
PREREQUISITE
Smart Desktop widgets have been enabled. See Also: Enabling Smart Desktop
Widgets on page 279
1. Go to the Workarea > Desktop.
2. Click the Toggle widget tray arrow, located in the upper right corner of the Smart
Desktop (circled).

3. The widget tray appears, containing widgets you can drag and drop to your Smart
Desktop. Use the left arrow ( ) or right arrow ( ) buttons to see more widgets.
4. To choose a widget, drag it from the tray and drop it into the Smart Desktop panel.

After placing a widget on the Smart Desktop, you may drag it to any desktop location.

Adding a Tab to the Smart Desktop
Tabs help you organize your Smart Desktop. You may add or remove tabs. For example, you
create an eCommerce tab on which to drop orders widgets. To add a tab:

Ektron 8.7

281

Managing Content

1. Choose Options ( ) > Add Tab. The Add Tab dialog window appears.

2. Enter a Tab Label. For example, eCommerce.
3. Click OK. The new tab appears at the top of the Smart Desktop.

Adding a Column
You can divide a Smart Desktop tab into columns This capability helps you arrange widgets on
the tab.
NOTE: Two columns are created for each new tab by default.
To add a column to a Smart Desktop tab, choose Options ( ) > Add Column.

Deleting a Column
1. Click the toggle widget tray button (circled) to show the widget tray and columns.
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2. Click Remove Column (

) (circled) inside the column you wish to delete.

Restoring Tabs and Widgets
A user can restore the Smart Desktop to the default widget and tab set.
WARNING! This action removes all tabs and widgets you have modified on your Smart Desktop. After
you restore, the default tabs and widgets appear.
1. Click the Options button on the right side of the Smart Desktop.
2. Click Reset Widgets.

3. A dialog appears. Click OK.

Standard Desktop Widgets
The following list describes the standard Smart Desktop widgets. See Also: Adding Smart
Desktop Widgets on page 280
l

l

l

l

l

l

Content Awaiting Approval—Content awaiting your approval; Approvals on
page 577
Content Checked Out—Content in checked-out status; Checked Out Content
Report on page 578
Content Edited—Content edited within the last week; Working with Ektron Content
on page 287
Content Flags—The 10 most recently-added content flags; Defining Flags for
Content on page 1239
Content In Workflow—Content that has been part of an approval chain within the
last week;Setting Approval Chains on page 262
Content Reviews—Content reviews awaiting moderation; Moderating Reviews on
page 588
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l

l

l

l

l

l

l

l

l

l

Content to Expire—Content that will expire between today and a number of days
you specify; Content to Expire on page 580
Forum Topics and Posts—Forum posts that require approval; Approving a Post on
page 562
Order on Hold—eCommerce orders on hold; Managing Customer Orders on
page 1381
Recent Orders—Recent eCommerce orders; Managing Customer Orders on
page 1381
Customer List—The top 5 eCommerce customers ranked according to account
date, sales, and orders;Customer Report on page 1397
Key Performance Indicators—Compares eCommerce sales and orders for 2 time
periods; Key Performance Indicators Report on page 1399
Reconciliation report—Lists payments for a specific time period; Reconciliation
Reports on page 1399
Sales Trend—The number of eCommerce orders for the past 8 periods; Sales
Trends Report on page 1400
Top Products—The most popular products on your eCommerce site; Top Products
Report on page 1401
Analytics Report—The Direct Traffic report for the past 7 days; Viewing Analytics
Data on page 622

Controlling Available Fonts
As an administrator, you can add, edit, and delete fonts to and from the Ektron application. By
adding fonts, you are allowing the content contributors to use them when creating content.
Administrators can also edit the name of a font, and delete a font from the system.
Minimizing the number of available fonts makes the website look more uniform. The following
figure shows the Font Manager screen.
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NOTE: Only members of the Administrator User Group can view, add, or edit fonts.

Adding Fonts
1. From the Workarea, choose Settings > Configuration > Fonts.
2. Click Add Font. The Add Font screen appears.

3. Enter the font name or family into the text field; (Kristen ITC in this example).
4. Click Save.
The new font is available to use when adding or editing content if the Application Setup
screen’s Enable Font Buttons field is checked. See Also: Getting Started with Ektron
on page 5

Viewing Fonts
When viewing fonts, you can also edit or delete them.
1. From the Workarea, choose Settings > Configuration > Fonts.
2. Click the font you want to view.The view font screen appears.

Editing Fonts
When you edit a font, the font or family name is changed. Editing does not change any fonts in
existing content.
1. From the Workarea, choose Settings > Configuration > Fonts.
2. Click the font you want to edit.The view font screen appears.
3. Click Edit. The Edit Font screen appears.
4. Edit the font name or family in the text field specified.
5. When finished, click Update.

Deleting Fonts
Ektron 8.7
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By deleting a font from the system, you are taking away the content contributors’ use of that
font in their content.
1. From the Workarea, choose Settings > Configuration > Fonts.
2. Click the font you want to delete.The view font screen appears.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The screen is refreshed, and the updated fonts table appears.
NOTE: When you delete a font from Ektron, you do not delete it from your computer.
Additional Topics About Managing Content
The following topics explain about managing content in Ektron.
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l

Working with Ektron Content on the facing page

l

Working with Assets in the Document Management System on page 310

l

Storing Files in the Library on page 333

l

Displaying Content on Your Website on page 348

l

Working with Collections on page 355

l

Working with Metadata on page 369

l

Working with Templates on page 382

l

Working with HTML Forms on page 386

l

Working with Smart Forms on page 423

l

Working with Blogs on page 491

l

Working with Calendars on page 514

l

Working with Discussion Boards on page 536

l

Working with Content Reports on page 577

l

User-Ranking of Content on page 587

l

Using the Map Server Control on page 590
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Working with Ektron Content
To work with content on your website or in the CMS Workarea, you must log in as a CMS user.
Ektron lets you access content on a Web page in the following ways:
l

l

Web page with PageBuilder menu—Hover over the access point ( ) to see options for
content on the page.
Workarea—You can specify additional information for content such as metadata, a
content summary, aliases, comments, scheduling, and so on.
o Navigate the Workarea folder tree. See Also: Managing Content on page 273
o

Use the Action > Search option, which appears in the View screen of every folder.
See Also: Searching the Workarea on page 966

Ektron has many types of content that you can use on your website. See Understanding
Ektron Content on page 305 for information about the types of content.
This section also contains the following topics.
Creating New Content
Moving or Copying Content
Deleting Content
Writing a Summary for Content
Making Content Private
Translating Content into Another Language
Scheduling Content
Managing Versions of Content
Understanding Ektron Content
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Creating New Content
NOTE: For information about editing content, see Editing in Ektron on page 207.
1. In the Workarea, go to the folder in which you want to create a new content item.
2. Choose a type of content from the New menu. (For example, choose New
> HTML Content. The Edit Content screen appears.
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Non-HTML content types:
l

HTML Form/Survey—Creating a Form on page 386

l

XML Smart Form—Working with Smart Forms on page 423

l

Assets (including multimedia)—Managing Assets on page 315

l

Microsoft Office document—Working with Assets in the Document Management
System on page 310

l

PageBuilder page—Creating Web Pages with PageBuilder on page 659

l

Web Calendar event—Adding System Calendar Events on page 517

l

Blog post—Working with Blog Posts on page 504

l

Discussion forum posts—Working with Posts on page 560

3. Specify a title and begin creating your new content item.
l
l

Title—Enter a title for the content. It cannot include these characters: \ / * > < |
Content Searchable—(Available to Administrators) Check this box if this content
should be found when someone searches your website. However, even if content is
not searchable:
o the Workarea Advanced search still finds it. See Also: Advanced Search on
page 941
o

l

288

it can appear among Suggested Results. See Also: Providing Suggested Results
on page 952

Publish or Submit—Publish the content to the website. This action updates the
content in the database and exits the editor. See Also: Approving or Declining
Content on page 267
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NOTE: Only the last approver in the approval chain sees the Publish button. Other users see
Submit. If no approval chain is assigned to the content’s folder, every authorized user sees
Publish.
l

l

l

l

l
l
l

l

—Check In—Save and check-in the content. This action updates the content in
the database and exits the editor. It does not submit the content into the approval
chain. Rather, it allows you and other users to continue changing it.
—Undo Checkout—Close editor without saving changes. Return content to its
state prior to checkout.
—Save—Save content without leaving the editor. It is a good idea to save your
work frequently. But, if you later click Cancel and exit the editor, you lose changes
saved by clicking this button.
—Cancel—Close editor without saving changes. Leave content in checked out
state.
—Preview—Preview current content within its template in a new browser.
Content—Enter content.
Summary—Enter or edit the content summary. See Also: Writing a Summary for
Content on page 292
Metadata—Enter or edit the content metadata. Working with Metadata on page 369
All required metadata must be added before content can be checked in or submitted
into the approval chain.

l

Alias—Enter or edit the content's manual alias, and view its automatic alias. See
Also: Creating User-Friendly URLs with Aliasing on page 835
A folder's Aliasing tab has a Manual Alias Required check box. If checked, the
user creating or updating content must enter a manual alias before the user can
save or submit the content.

l

l

l
l

l

Comment—Briefly describe the content, or comment on changes made when
editing content. The history comment appears on the View Content and Content
History screens. On the Using Advanced Search in the Workarea on page 966, you
can search for content by comments.
Schedule—Use this tab to set a future publication date/time. To be published, this
content must be approved and reach its publication date/time. See Also: Scheduling
Content on page 296 If appropriate, enter a date when the content will no longer be
viewable on the website. See Also: Setting an End Date on page 298
Web Alerts—See Administering Web Alerts on page 1567
Templates—This content’s folder must have a default template. It can also have
additional templates assigned. When content is created, the default template is
assigned to it. If you want to change the template assigned to this content, click this
tab and choose a template from the drop-down list. See Also: Working with
Templates on page 382
Category—Assign taxonomy categories to this content. See Also: Using
Taxonomies on page 777

After you create content, you or your system administrator typically make it available on the
site. For example, you can add a hyperlink to it from another page, or place it in a collection
or menu. Your administrator can add it to a list summary or content list.
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You can set up an approval process by which content is available to your website after it is
reviewed by people with approval responsibility. See Also: Accessing the Permissions Table
on page 257. When a content creator submits content for publishing approval, an email is sent
to the list of approvers. When the last approver signs off, the new content becomes available
on the website. The following graphic illustrates the content approval cycle.

To help track content’s position in this workflow, Ektron assigns a status to each content item.
The status determines what you can do with it, and indicates what must occur for it to get
published to the website. See Also: Content Statuses on page 307.

Moving or Copying Content
You can move content from a folder to another folder. Or, you can copy content between
folders. Moved content retains the original ID number, while copied content gets the next
available ID number.
Your can only move or copy content that has an Approved status. If a destination folder has
an approval chain, the content status changes to Submitted (or Approved if you are the last
person in the approval chain).
NOTE: The folder's Approval Method can affect the status of the moved/coped content. See Also: Setting
the Approval Method on page 271
You should move or copy content only between regular folders or eCommerce catalog folders.
Do not move or copy from or to other folder types. If you copy an eCommerce catalog entry
whose product type is not assigned to the destination catalog folder, the new product type
gets assigned to the folder. See Also: Defining Roles on page 1120; Managing Folder
Permissions on page 257
To move or copy content between folders:
1. Select content items in a folder and choose Action > Cut or Copy (or right click and
choose Cut or Copy).
2. In the left panel of the Workarea, navigate to the folder to which you want to paste the
selected content, right click and choose Paste Content.
NOTE: If you are copying content, and the content exists in more than one language, you are informed
that some content exist in several languages and asked if you want to paste them in all languages or only
selected languages. If you are moving content, all language versions are moved.

Permissions for Moving/Copying Content
Permissions for moving or copying content are defined as follows:
290

Ektron Reference

Effects of Moving/Copying Content

l

members of the Administrators user group

l

a user with Add, Edit, and Delete permissions for the source and destination folders

l

a user is a member of a group with those permissions

l

a user assigned in the Roles > Folder Specific > Folder User Admins screen

l

a user assigned in the Roles > Folder Specific > Move or Copy screen

Effects of Moving/Copying Content
When content is moved or copied, the following changes are made.
l

l

The content inherits permissions, the approval chain, and the default template from the
new folder.
The content’s Quicklink is moved or copied in the library to the destination folder.
However, the Quicklink remains the same (that is, the default template doesn’t change).
You can update this by editing the Quicklink.
NOTE: If the Link Management setting in the web.config file is set to true, you do not need to
update the quicklink. Link Management automatically finds the correct template based on the
current folder.

l

l
l

l

If the new folder already contains content with the same title, Ektron appends a number
to the title to make it unique. For example: ASP.NET Unleashed(2).
Library image paths inside the content remain the same.
If a destination folder has required metadata that the pasted content lacks, the paste
action is not affected. But, the next time a user edits that content, the user must
complete the required metadata before the user can save the edits.
If the content’s template is a Smart Form, it remains assigned even if the Smart Form is
not assigned to the new folder.

Deleting Content
The Delete command lets you permanently delete content from your website. You cannot
delete checked-out content.
NOTE: If you do not see a Delete button on the View Contents of Folder screen, you do not have
permission to do so.
Like publishing, deleted content must proceed through the approval chain before it is
removed. If you are the last approver in the approval chain, the content is deleted
immediately. See Also: Approving or Declining Content on page 267
This section also contains the following topics.
Link Checking Before Deleting
Deleting a Content Item from a Web Page
Deleting a Content Item from the Workarea
Deleting Several Content Items in a Folder
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Link Checking Before Deleting
NOTE: It is good practice to check for broken quicklinks before deleting content.
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Use the link checker button to locate all content with a link to the current content. The
identified content that will include a “dead” link after you delete the current content. So,
remove or change the obsolete links before deleting.
1. Navigate to the folder that contains the content.
2. Click the content and choose View Properties. The View Content screen appears.
3. Click Link Search (
content.

). A screen displays each content item with a link to the current

4. Click the linked content to access the View Content screen for the selected content.
5. Remove or change the Quicklink.

Deleting a Content Item from a Web Page
1. Sign in and browse to the content you want to delete.
2. From the access point ( ), choose Delete. The View Content screen appears.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.

Deleting a Content Item from the Workarea
1. Access the View Contents of Folder screen for the content you want to delete.
2. Hover the cursor over the triangle ( ) and choose Delete. A confirmation message
appears.
3. Click OK.

Deleting Several Content Items in a Folder
On the View Contents of Folder screen, you can delete several content items at once.
NOTE: If you are working with an eCommerce catalog entry, you can only delete it if it is not on an order
nor checked out.
1. Navigate to the folder that contains the Approved content you want to delete.
2. Choose Delete > Content. The Delete Contents screen appears.
3. Check the boxes of the content items you want to delete.
4. Click Delete Content. A confirmation message appears.
5. Click OK.

Writing a Summary for Content
A content summary is a short description that supplements the title when several content
items appear on a Web page, such as Web page of top news stories. Content authors compose
a summary when creating or editing content. Web developers can create pages that display
the content title and summary to attract readers to the full story. Summaries can include
images and various font styles and sizes.
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TOP STORIES
Ektron Named a Rising Star (08-15-2010)
August 15, 2013, Nashua, New Hampshire, USA — Ektron, Inc., an innovator in Web
content management and authoring, has been named a Rising Star as part of
the prestigious New England Technology Fast 50 Program.
Ektron Launches International Distribution Program(08-08-2009)
August 8, 2009, Nashua, New Hampshire, USA — Ektron, Inc., an innovator in
dynamic Web content authoring and management with over 350,000 users, today
announced the launch of its international distribution program.

Creating or Editing a Summary
1. Navigate to the folder in which you want to create or edit the content.
2. In the View Content screen, choose New > {type of content} or open the View menu
next to existing content and choose Edit. The Edit content screen appears.
3. Insert a Title and content, if needed.
4. Click the Summary tab.
5. Enter a summary for the content. The summary can include images, files, and
hyperlinks.
6. When done, click the appropriate button.
You can only edit the summary of content that is published, checked in, or checked out by
you. When you enter or edit existing content’s summary, its status changes to checked out.
After you create or edit the summary, click Check-In to check the content in. From that
point, you need to submit or publish it.

Automatically Creating a Summary
Ektron automatically generates a summary for new content if none exists when it is first
published. If the summary is blank, Ektron copies the first 40 words of content to the
summary. After the content is published, you can update or delete the summary. If you
delete a summary, it remains blank and is not automatically generated again.

Disabling the Automatic Summary Generation
By default, content summaries are automatic generated. To disable that:
l

l

For HTML content—open siteroot/web.config > change value of ek_
enableContentAutoSummary to false
For DMS assets—open C:\Program Files
(x86)\Ektron\EktronWindowsService40\Ektron.ASM.EktronServices40.exe.config >
change value of GenerateAutoSummary to zero (0)

How Membership Users Autogenerate a Summary
If a membership user edits content and wants to update the summary, the user checks the
Auto Generate New Summary field on the membership editing screen, and the first 40
words of the content are automatically copied into the summary.
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There is no limit on the number of times a membership user can automatically generate a
new summary.

Making Content Private
Private content is available to Ektron administrators and users or membership users with at
least Read-Only permissions for its folder. Those users must log in to work with private
content. Unauthorized site visitors cannot see it. When you make a folder private, the content
and any subfolders are also private (if they inherit permissions). You also can designate
specific content items as private.
IMPORTANT: Private content is hidden from search results if your search provider is Microsoft Search
Server 2010. It is not hidden if you are using another search provider.
To demonstrate private content, the following shows how a user’s permissions affect the
display of content in 3 scenarios.
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l

Site visitor

l

Logged in user with read-only permission
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Making a Folder Private

l

Logged-in user with edit permissions

NOTE: You can determine the appearance of the menu shown above. See Working with Ektron Content
on page 287.

Making a Folder Private
NOTE: You can only set content to private when inheritance is broken. See Also: Inheriting Permissions
on page 259
1. In the Workarea, navigate to the folder that you want to make private.
2. Choose View > Properties.
3. Click View Permissions (

).

4. If necessary, uncheck the box that says Allow this object to inherit permissions.
(You must disable inheritance before you can make the content private.)
5. Check the box that says The content in this folder is private and can only be
viewed by authorized users and members. A confirmation message appears.
6. Click OK. All content in the folder is now private. As new content is added, it is
automatically set to private.

Making Content Private
1. In the Workarea, navigate to the folder that contains the content you want to make
private.
2. Click the content item you want to make private.
3. Click View Permissions (

).

4. If necessary, uncheck the box that says Allow this object to inherit permissions.
(Inheritance must be disabled before you can make the content private.)
5. Check the box that says This content is private and is NOT viewable on the
public website. A confirmation message appears.
6. Click OK. The content is now private.

Making Assets Private
If assets are set to private, they are handled like other private content with one important
exception: unless you follow the procedure described below, anyone can access an asset by
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typing the URL of the asset into the browser’s address field.
If a user attempts to access the asset in any other way (such as, linking to it from a Web
page), the regular methods of making content private work. See Making a Folder Private on
the previous page and Making Content Private on the previous page.
To make assets private even if someone types their URL into the browser’s address field:
NOTE: If site users receive a 404 Page Not Found error when trying to view private assets, make sure
you have completed all steps below.
1. Open your website’s web.config file, located in the site root folder.
2. Make sure the following line is uncommented.
<remove verb="GET,HEAD,POST" path="*"/>

3. Comment out the 8 lines indicated below.
<httpHandlers>
<remove verb="GET,HEAD,POST" path="*"/>
<add verb="HEAD,OPTIONS,PROPFIND,PUT,LOCK,UNLOCK,MOVE,COPY,GETLIB,
PROPPATCH,MKCOL,DELETE,(GETSOURCE),(HEADSOURCE),(POSTSOURCE)"
path="*" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<!-<add verb="GET,POST" path="*.doc"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.docx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.xls"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.xlsx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.ppt"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.pptx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.vsd"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.vsdx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
-->

Eight add verb statements in the middle are commented out.
4. Make sure the following line is uncommented.
<add verb="GET,HEAD,POST" path="*"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

5. Save web.config.

Translating Content into Another Language
See Translating Content on page 1069

Scheduling Content

296

Ektron Reference

Setting a Start Date

Scheduling lets you control when a version of content becomes visible on the website or when
it expires (and is removed).
When you create or modify content, you can select a “go-live” date and time. If you do, after
the content passes through the approval chain, Ektron publishes the content to the live site at
the scheduled time. For example, your company is having a sale of the century in a month,
and everything is ready except the announcement. With this feature, you create the Web
content now and set it to go live a week before the sale.
The Ektron Windows Service manages these changes to your site. See Also: Ektron Windows
Service on page 1877
This section also contains the following topics.
Setting a Start Date
Setting an End Date
Setting Archive Options
Restoring Content from Archived to Active State
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Setting a Start Date
1. Edit a content item and click the Schedule tab.
2. Click Add (

) next to the Start Date field.

3. A calendar pops up. Select the date and time when this version of the content will
become visible on the website.
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4. Click Done. The date and time appear in the Start Date field.
NOTE: When you select a time for content to go live, that time depends on the server’s system
clock. If the clock is incorrect, the content will not go live at the intended time.
After you save the content, it appears on the Content Pending Start Date report, which
tracks content with a future start date. See Also: Content Pending Start Date Report on
page 579
After you set a go-live date and the content completes the approval chain, the following
scenarios may occur:
l

Setting the Go-Live Date on New Content
When you set a go-live date on new content, it becomes viewable on the specified
date and time as long as it completes the approval chain. If a site visitor accesses
the page that contains the content before then, only the template appears.
If a logged-in Ektron user browses your website, the user sees a gray border
around the content until the date specified. If the user clicks within the gray border,
the user can use the Preview option to see the new content.

l

Setting the Go-live Date on Existing Content
When you set a go-live date for changes to existing content, and it completes the
approval chain, a logged-in Ektron user sees a gray border around the content until
the date specified.
When you view content on the website, you see the previously published version.
When the go-live date occurs, the new content replaces the previous version, and
its status changes to Active.

Setting an End Date
1. Edit a content item and click the Schedule tab.
2. Click Add (

) next to the End Date field.

3. A calendar pops up. Select the date and time when this version of the content will
become visible on the website.
4. Click Done. The date and time appear in the End Date field.
When content reaches its end date, it appears on the Expired Content report. See Also:
Content to Expire on page 580
If your choice means the content will not appear on the website, you should have another
content item ready to replace it. If not, the template appears without the content.

Setting Archive Options
Use content’s archive options to determine what happens upon reaching its end date/time. To
be eligible for any option, the content must reach its end date/time, progress through its
approval chain, and be published. Until those events occur, the content remains visible within
its Workarea content folder and on the site.
Archive and remove from site (expire)
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Restoring Content from Archived to Active State

l
l

Site visitors cannot view content upon expiration.
You can view and edit content within its folder by choosing the View > Archive
Content option. Also, you can find the content through a basic search and advanced
search (if the Archived check box is checked).

Archive and remain on site
l

l

Content appears in a List Summary if the ListSummary control’s contentype property is
set to Archive_Content.
If content is an HTML form, the response page option appears. For example, if the form
displays a message after the user completes it, that message appears.

l

Content found by the search

l

Content visible within its taxonomy display

l

l

Content visible if site visitor enters exact path, such as
http://localhost/CMS400Developer
/dynamic.aspx?id=1014&__taxonomyid=14
Within Workarea, you can view and edit content within its folder by choosing the View >
Archive Content option. Also, you can find the content through a basic search and
advanced search (if the Archived check box is checked).

Add to CMS Refresh Report
l
l

Site visitors can view content upon expiration
You can view content in the active area of its folder and on the Refresh Report. See Also:
Refresh Reminder on page 579

Restoring Content from Archived to Active State
1. Navigate to its folder.
2. Choose View > Archived Content.
3. Hover the cursor over the content, click the triangle ( ), then Edit from the drop-down
menu. The Edit Content in Folder screen appears.
4. Click the Schedule tab.
5. Remove the End Date or change it to a future date.
6. Submit the content for publishing. When the content is published, it will no longer be
archived.

Managing Versions of Content
You can view and restore past versions of published content. After viewing previous versions
of content, authorized users can replace the current version with any previous one. See Also:
Managing Folder Permissions on page 257
Ektron assigns a unique number to each content version. The number is increased by one
tenth if the content is checked in but not published. If the content is published, the next whole
number is assigned. For example, if the current version is 1.0 and you check in that content,
that version is 1.1. If the next editor publishes it, that version is 2.0. Published version are
indicated by an arrow.
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If content versions are purged, the numbering scheme restarts with the remaining content.
NOTE: The Purge History feature deletes historical versions of content according to user-defined criteria.
Therefore, some previous versions may be unavailable. See Also: Purging History on page 252
This section also contains the following topics.
Viewing Content History
Comparing Versions of Content
Comparing Content (32-Bit Server/32-Bit Client)
Comparing Content (64-Bit Server/32-Bit Client)
Restoring a Previous Version
Removing Applied XSLT

300
301
301
302
303
304

Viewing Content History
l

l
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To access content history from the Workarea, click on a piece on content. The View
Content Screen appears. Then click View History ( ).
To access content history from a Web page, click the access point ( ) and choose View
History.
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Comparing Versions of Content

The window displays the following information for each version.
l

l
l

a Compare column lets you compare Web traffic analytics data between any 2
published versions.
Ektron assigns a unique number to each saved version of a content block.
an arrow indicates a published version. Versions without an arrow indicate content
that was checked-in.

l

date and time version was checked in or published

l

content title

l

last user who edited content

l

comments entered by user to describe the changes

To view any version, click its title to display the Content History window for that content.
There are 3 view modes.
l

Diff—Compares published version of content to staged version

l

Published—Displays currently published version

l

Staged—Displays the staged version of content.

Comparing Versions of Content
If content can be compared with another version, the View Difference button (
the content history area or the Web page view.

) appears in

NOTE: The first time you use the View Content Difference screen on a client machine, you are prompted
to install the differences tool. When the installation program completes, close and reopen the View
Content Difference feature.
There are varying versions of this procedure. Consult your system administrator to determine
the correct procedure for you.

Comparing Content (32-Bit Server/32-Bit Client)
Ektron 8.7
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1. Click View Properties on content that you want to compare.
2. Click History (

). The View Content History screen appears.

3. Click a version that you want to compare with the most recently published version.
4. Click Compare Analytics. The View Content Difference screen highlights changes to
selected content as shown in the following example.

l

l
l

Difference—Both versions:
o content that only appears in the version on the This Content tab is highlighted
in yellow
o

content that only appears in the currently published version is red

o

unchanged content is black

Last Published —Currently-published.
This Content—The version you are comparing the currently-published content
against.

Comparing Content (64-Bit Server/32-Bit Client)
1. Click View Properties on content that you want to compare.
2. Click History (

). The View Content History screen appears.

3. Click a version that you want to compare with the most recently published version.
4. Click Compare Analytics. The CMS Compare screen highlights changes to selected
content as shown in the following example.

302

Ektron Reference

Restoring a Previous Version

l

l

l

Print—Sends content to local or network printer. This option prints the currently
displayed content, whether it is the compared, published, or staged content.
Save—Saves the version of the content (in HTML) to your local machine or
network. When saved as a physical file, you can edit the HTML. However, the
changes are not saved to the Web Server.
Setup—Opens setup dialog box to configure the settings. Typically, only an
administrator would use this.
l
Compare visual aspect—Compares content as it would appear on a Web page
l

Compare source code—Displays compared content as source HTML

l

Ignore All—Blank (whitespace) characters are ignored

l

l
l

l

l

l

Smart Detect—One or more consecutive whitespace characters are treated as
a single separation sequence. That is, multiple whitespace characters are
ignored.
Detect All—Blank (whitespace) characters are treated as any other character.
Ignore case—Determines whether comparison is case sensitive. For example,
if you check this box, the strings “Bob” and “BOB” are not highlighted because
their only difference is the case of the characters.
Ignore format attributes—Determines whether comparison ignores changes in
text-formatting attributes (HTML Visual Analysis only).

Help—Displays additional information about the compare feature.
Exit—Closes the window.

Restoring a Previous Version
NOTE: The ability to restore content is a permission granted by the system administrator. If you do not
see Restore on the View Content History screen, you do not have permission to do so.
1. Open the folder that contains the content.
2. Click the content item.
3. Click History (

).
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4. Select an historical version that you want to restore.
IMPORTANT: Ektron recommends restoring a Checked In version of content, because this
restores all content attributes. If you restore a published version, metadata is not restored.
To learn how to recognize checked-in content on the View Content History screen, see Managing
Versions of Content on page 299.
5. Click Restore. The content history window closes, and you return to the View Content
page or the Web page, with the content in a checked in status.
If desired, check out the content to make additional changes. Select the workflow to
perform on the content. When the historical version is approved, it is published to the
website.

Removing Applied XSLT
You can only remove an applied XSLT when viewing historical versions of XML content. If you
remove the applied XSLT, you can view the content without the irrelevant XML tags.

IMPORTANT:
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Understanding Ektron Content
A website consists of pages that are made up of one or more blocks of content as shown in
the following example from the home page of one of Ektron’s sample sites.

The following sections provide information about Ektron content.
l

Content Types

l

Content Properties

l

Content Statuses

l

Other Content Information

Content Types
Every piece of content in Ektron is one of the following types.
l

l

l

l

HTML content—Content designed to be published on the World Wide Web. See Editing
in Ektron on page 207.
XML Smart Forms—Online forms, polls, or surveys designed to collect information
from site visitors and save it in an XML format. See Working with Smart Forms on
page 423
HTML form/survey—Online forms, polls, or surveys designed to collect information
from site visitors and save it in an HTML format. See Working with HTML Forms on
page 386
DMS Documents—consists of Office documents, managed files, and multimedia files.
See Working with Assets in the Document Management System on page 310.
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l

l

l

l

l

l

l

Office documents—Files normally created and edited using Microsoft Office. See
Working with Assets in the Document Management System on page 310
Managed files—Files created outside of Ektron, such as PDFs and .jpeg files. You
cannot create or edit these files within Ektron—you can only store them. See Managing
Assets on page 315
Multimedia—Files that run in a media player, such as sound and movie files. See
Managing Multimedia Assets on page 318
Blogs—A blog is a form of online information sharing and is often set up so a group of
people can share their thoughts on a subject. See Working with Blogs on page 491
Web Calendars—Web Calendars keep visitors informed about upcoming events. They
can be displayed to all visitors to your website, and any authorized user can add events
to a calendar. See Working with Calendars on page 514
Discussion Boards—The Discussion Board feature provides an opportunity for topic
discussions on your website. A site or membership user with Add Topic permission
creates a topic and posts a starter question. Site visitors can then reply. See Working
with Discussion Boards on page 536
Content Imported from SharePoint®—After an Ektron administrator sets up DxH to
map SharePoint to Ektron, an end user only needs to place content in a SharePoint folder
to update their Ektron-powered website; the content is automatically transferred to the
EktronWorkarea. You also can manually import SharePoint content from the Ektron
Workarea. See Setting Up the Import of SharePoint Files to Ektron on page 1009.

Content Properties
l
l

Content ID—The ID number assigned to the content. The ID number is used to retrieve
content from a database.

l

Content Language—The content’s language

l

Status—The current status of the content. See Also: Content Statuses on the facing page

l

Last User to Edit—The last user to edit this content

l

Last Edit Date—When the content was last edited

l

Start Date—When the content will go live on the website

l

End Date—When the content will be removed from the website

l

l
l

l

l

l

l
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Content Title—The title assigned to the content

Action on End Date—What happens to the content when its end date and time are
reached. See Also: Scheduling Content on page 296
Date Created—When the content was created
Approval Method—Whether all approvers must sign off on content before it is
published. See Also: Setting the Approval Method on page 271
Approvals—Users in the approval chain for this content. See Also: Approving or
Declining Content on page 267
Smart Form Configuration—The Smart Form applied to the content. This is typically
managed by your system administrator. See Also: Working with Smart Forms on
page 423
Template—The template currently assigned to the content. This is typically managed by
your system administrator. See Also: Working with Templates on page 382
Path—The folder path to the content’s folder. A slash (\) represents the Content folder.
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Content Statuses

l

l

Ranking—Ektron's Content Ranking feature lets site visitors rate content on a scale of 1
to 10. If this feature is enabled for the content, the average numerical rating appears.
See Also: User-Ranking of Content on page 587
Content Searchable—True appears if the content can be found when someone
searches your website. See Also: Ensuring Your Content is Searchable on page 942.
However, even if content is not searchable, the Workarea Advanced search still finds it.
See Also: Using Advanced Search in the Workarea on page 966

Content Statuses
l

l

A (Approved)—Through the approval chain and published on the website. You can:
o Check content out and save it on your computer
o

Save a copy to your computer

o

Check out the content and edit it

o

Edit the content summary, metadata, schedule, comment, and so on

o

View the content information

o

Delete or submit a request to delete the content.

O (Checked Out)—Currently being edited. Has not been checked in. You can:
o If you checked out the content
n Check it in

o

n

Save a copy to your computer

n

Edit it

n

Edit the summary, metadata, schedule, comment, and so on

If you are an administrator
n Force a check in
n

o
l

l

l

Request a check in from the person who checked it out

Anyone can view the content information

I (Checked In)—Checked in for other users to edit. You can:
o Check content out and save it on your computer
o

Save a copy to your computer

o

Check out the content and edit it

o

Edit the content summary, metadata, schedule, comment, and so on.

o

View the content information

o

Delete or submit a request to delete the content.

o

Publish content or submit it to the approval chain.

S (Submitted for Approval)—Saved and submitted into the approval chain. You can:
o Approve and publish content to the website
o

Decline to publish the submitted content

o

Check out the content and edit it

o

View the content information

M (Marked for Deletion)—Requested for deletion. You can:
o Approve the deletion request
o

Refuse the deletion request
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l

o

Save a copy to your computer

o

View the content information

P (Pending Go Live Date)—Approved but the Go Live date hasn’t occurred yet. You can:
o Check out and edit the content
o

l

l

View the content information

T (Awaiting Completion of Associated Tasks)—Task(s) assigned to content are not
complete
D (Pending Deletion)—Content was created with a future start date then checked in and
deleted. This status only remains until the start date is reached. At that point, the
content is deleted.

Other Content Information
l

Properties tab—View the content’s properties

l

Content tab—Display and edit content.

l

Summary tab—Edit content’s summary; Writing a Summary for Content on page 292

l

Metadata tab—Edit content’s metadata; Working with Metadata on page 369

l

l

l

l

l

l

l
l

l

l

l

l

l

l

l
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Alias tab—View and edit the content item’s primary alias, or View all secondary aliases;
Creating a Manual URL Alias on page 845
Comment tab—View comments on changes made when editing content. This comment
also appears on the View Content and Content History screens. Use it to help distinguish
one version from another.
Tasks tab—Add or edit tasks for this content; Assigning and Managing Tasks on
page 1027
Web Alerts tab—Add or edit Web Alerts for this content; Administering Web Alerts on
page 1567
Templates tab—The template currently assigned to the content; Working with
Templates on page 382
Category tab—Any taxonomy categories currently assigned to the content. Only
appears if at least one Taxonomy is applied to the folder in which the content resides;
Using Taxonomies on page 777; Numbers on the View Categories Screen on page 787
Edit—Open content for editing; Working with Ektron Content on page 287
—View older versions of content; restore older version; Managing Versions of Content
on page 299
—Toggle display between published and staged versions
—Compare current and earlier versions of content; Managing Versions of Content on
page 299
—Delete content; Deleting Content on page 291
—View and edit permissions for content; Setting Permissions for Content on page 261
—View and possibly edit the content's approval chain; Creating an Approval Chain For
Content on page 266
—Find all content with Quicklinks to this content; Link Checking Before Deleting on
page 291
—Attach a task to content; Assigning and Managing Tasks on page 1027
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Other Content Information

l

l

l

l

l

l

l

l

—View Analytics for this content; Viewing Page-Level Analytics from the Workarea on
page 624
—Displays the content item's rating and reviews, messages, and flags; MessageBoard
on page 1786server control; Defining Flags for Content on page 1239
—View and edit content's Content Searchable check box and flagging definitions;
Ensuring Your Content is Searchable on page 942; Defining Flags for Content on
page 1239
—Go back to previous menu
—Determines if content will be included when an .xlf file is created; Marking
Translation Statuses on page 1078
—Copy content to XLIFF files that can be submitted to a translation agency; Working
with Multi-Language Content on page 1057
View (language)—If you can view content in more than one language, select a language
from the drop-down list.
Add-select language-—Lets you copy current content into a new item and translate it to
selected language; Translating Content into Another Language on page 296
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Working with Assets in the
Document Management System
The Document Management System (DMS) lets you import Microsoft Office files and other
types of files into Ektron. Collectively, these files are called assets. When you import and
save an asset to Ektron, a copy of it is saved to the Document Management server. Then,
whenever you edit and save the asset, a new copy is stored, letting you review and, if
needed, restore a prior version.
You can edit Microsoft Office files from within Ektron; for other file types, you must check out
a file and edit it outside Ektron, and then use Add Assets again to bring the asset back into
Ektron.
Assets have the following qualities:
l

can be stored in folders with other content, or in separate folders that you create just for
them

l

are assigned content IDs

l

can have summary, metadata, comment, task, schedule, and taxonomy information

l

inherit permissions and approvals from their folder properties

l

progress through the approval process (check out, check in, publish)

l

retain a history so you can restore earlier versions

l

can be searched

l

support foreign language editions

l

can have a task assigned to them

l

appear on content reports

l

update the Smart Desktop listing of files awaiting approval, checked out, to expire, and
so on

After you save an asset, you can update and track it like other content. Assets are treated like
other content for security purposes. A system administrator applies security to each folder,
determining which user groups can perform which tasks on its content. For more information,
see Managing Folder Permissions on page 257 and Checking Document Management
Permissions on page 326.
The AssetControl on page 1644 and ImageControl on page 1750 server controls are
associated with DMS content.
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Storing External Files as Library Items vs. Assets

This section also contains the following topics.
Storing External Files as Library Items vs. Assets
Supported Types of Assets
Configuring Document Management
Managing Assets
Managing Microsoft Office Assets
Checking Document Management Permissions
Removing Front Page Server Extensions
Troubleshooting Assets

311
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312
315
322
326
328
329

Storing External Files as Library Items vs. Assets
You may save an external file in Ektron as a library item or an asset. The following table
compares each option.
Asset

Library

First class content items

Simple resources

All content management features, such as history, permissions and
approvals, scheduled go-live date, applying a template, and so on.

No content management features

Used primarily for content-centric documents, like Office documents
and PDFs

Used primarily for simple
resources such as a company
logo
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Asset

Library

Can import and store images, if history and approvals are needed

Works well when displaying a resource within a content block

Works well when providing a link
to download an item

Supported Types of Assets
By default, Ektron lets you store these file types as assets. An administrator can add or delete
file types on the Settings > Configuration > Asset Server Setup screen.
NOTE: Ektron does not support double extensions, such as filename.aspx.vb.
l

Microsoft Office 2000 or later documents—Word, Excel, Powerpoint, Project, Publisher,
Visio, and so on.

l

Managed files—*.zip files, PDFs, *.txt files, graphic files such as *.gif and *.jpeg

l

Multimedia files—*.swf, *.mp3, *.wav. *.avi

If you try to upload an unsupported file type, an error message appears.

Browser Notes
l

l

You can edit Microsoft Office documents in Ektron using Internet Explorer or Mozilla
FireFox. See Managing Microsoft Office Assets on page 322.
You can load multiple DMS documents with Internet Explorer, but not other browsers.
See Adding Multiple DMS Documents on page 317.
If your computer has Windows Vista, you must turn off its User Account Control first. For
details, see Inside Windows Vista User Account Control

Configuring Document Management
This section explains configuring the Document Management feature. By changing these
settings, you can:
l

update Document Management server settings

l

change which file types are allowed on the Document Management server

l

set the View Type

There are 2 ways you can configure a Document Management server:
l

Asset Server Setup screen

l

AssetManagement.config file

In either case, you are editing the AssetManagement.config file. While the Workarea screen
provides a quick way to update this information without accessing the Ektron server, some
tags can only be updated in the AssetManagement.config file.

Updating Asset Configuration Settings
312
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Updating Asset Configuration Settings

You can update some AssetManagement.Config tags from the Workarea.
NOTE: Only Administrator Group members can view, add, or edit the Asset Server Setup screen.
1. In the Workarea, go to Settings > Configuration > Asset Server Setup. The Asset
Management Configuration screen appears.

2. Click the FieldTypes Edit button (

).

3. Change the supported file types.
4. Click Save.
The following list describes the AssetManagement.Config file’s tags that you can edit from
this screen in the Workarea.
l

l

DomainName—Can be Domain Name, IP Address or Machine Name. An example is:
localhost. This is the address a Web client system uses to open managed documents
through HTTP.
FileTypes—Files types that users are allowed to upload to Document Management. The
default file types are:
.doc, .xls, .ppt, .pdf, .gif, .jpg, .jpeg, .log, .vsd, .dot, .zip, .swf,
.wma, .wav, .avi, .mp3, .mp4, .rm, .wmv, .ra, .mov, .odb, .odt, .odf,
.odp, .odg, .ods, .png, .docx, .xlsx, .pptx, .vsdx, .wmf, .xml, .htm,
.html, .flv
IMPORTANT: You can only add file extensions that are listed in the siteroot/web.config file
property ek_DMSFileTypeWhiteList.
See Also: Using the File Type Whitelist on the next page
Administrators control which file types are allowed by editing the
AssetManagement.config file. Reasons for limiting file types include:
l

l

Security—For example, you do not want users to load .exe files to your Ektron
server
Ease of management—For example, you want your Ektron server to store .doc files
only

The <FileTypes> tag in the AssetManagement.config file contains the file types users
can upload.
To add or remove a file type from the list:
1. Edit the Workarea > Settings > Configuration > Asset Server Setup >
Asset Management Configuration screen.
or
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Open the siteroot/AssetManagement.config file.
2. Edit the FileTypes=”” element. All file types must appear between the quotes. For
example, FileTypes=”*.doc,*.xls”.
NOTE: Use a comma to separate file types. Also, format file types as wildcard.extension. For
example, adding an .mp3 file type after *.zip looks like this: *.zip,*.mp3
3. Add or remove any file type.
4. Save and close the screen or AssetManagement.config file.
l

l
l

l

LoadBalanced—Enables Load Balancing for assets. Set to 1 to enable. See Also: Load
Balancing Assets on page 91
ServerName—The name of the server that hosts Ektron.
StorageLocation—The folder location where published assets are stored. For example:
C:\assetslibrary
WebShareDir—The folder that stores temporary data files waiting to be checked in,
saved, or published. For example: dmdata

Allowing File Types
IMPORTANT: You can only add file extensions that are listed in the siteroot/web.config file property ek_
DMSFileTypeWhiteList. See Also: Using the File Type Whitelist below
Administrators control which file types are allowed by editing the AssetManagement.config
file. Reasons for limiting file types include:
l

Security—For example, you do not want users to load .exe files to your Ektron server

l

Ease of management—For example, you want your Ektron server to store .doc files only

The <FileTypes> tag in the AssetManagement.config file contains the file types users can
upload.
To add or remove a file type from the list:
1. Edit the Workarea > Settings > Configuration > Asset Server Setup > Asset
Management Configuration screen.
or
Open the siteroot/AssetManagement.config file.
2. Edit the FileTypes=”” element. All file types must appear between the quotes. For
example, FileTypes=”*.doc,*.xls”.
NOTE: Use a comma to separate file types. Also, format file types as wildcard.extension. For
example, adding an .mp3 file type after *.zip looks like this: *.zip,*.mp3
3. Add or remove any file type.
4. Save and close the screen or AssetManagement.config file.

Using the File Type Whitelist
The siteroot/web.config file property ek_DMSFileTypeWhiteList contains the same default
file types as those on the Asset Management Configuration screen and
AssetManagement.config file.
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<add key="ek_DMSFileTypeWhiteList" value="*.odb,*.ods,*.odg,*.odp,*.odf,*.odt,*.doc,
*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.log,*.vsd,*.dot,*.zip,*.swf,*.wma,*.wav,*.avi,
*.mp3,*.mp4,*.rm,*.wmv,*.ra,*.mov,*.png,*.docx,*.xlsx,*.pptx,*.vsdx,*.wmf,*.xml,*.htm,
*.html,*.flv" />

A server administrator can use this property to restrict which file types may be uploaded to
Ektron. For example, if an Ektron administrator wants to add a new file type, someone who
can edit files on the Ektron server must first add it to the web.config ek_
DMSFileTypeWhiteList property. This provides additional security over which file types can
be uploaded to Ektron.
Conversely, if an server administrator wants to remove an allowed file type from the Asset
Management Configuration screen/AssetManagement.config file, the server administrator
must first remove it from the ek_DMSFileTypeWhiteList property.

Managing Assets
DMS can store and help you manage assets.
When you use the New > DMS Document file import option, you enter an Ektron title for
the file. When you import a file using any other method, its title is the file name without the
extension. So for example, mypicture.jpg becomes mypicture in Ektron. While it may
appear that the file extension was removed, it is retained and reappears for assets when you
use the Edit option, on the View Contents of Folder screen. The original file extension also
appears when you check out.
You cannot import a file whose name and extension match a file already in the folder. If you
import a file of the same name but a different extension into the folder, a number is
appended to the file name. For example, mypicture(2).
You cannot import files whose name includes a percentage sign (%) or ampersand (&).
This section also contains the following topics.
Methods for Importing Assets
Restrictions and Warnings about Importing Assets
Adding an Asset
Adding Multiple DMS Documents
Managing Multimedia Assets
Adding Assets to a Mapped Network Folder
Status of Asset Saved to Mapped Network Folder
Removing Mapped Network Drives
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Methods for Importing Assets
Ektron provides several ways to import assets. The sections below explain how to use each
option.
l

l

New > DMS Document (All browsers) from View Contents of Folders screen
o an enter Summary, Metadata, and so on for each asset
o

Can create unique title for each asset

o

Can check in or submit for approval

o

Uploads one asset at a time

New > Multiple DMS Documents (Internet Explorer with MS Office) from View
Contents of Folders screen
Ektron 8.7
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l

o

Uploads several files at once

o

Can apply same summary, metadata, and so on to all files

o

Can check in or submit for approval

o

Asset title taken from Windows file name

Add Asset button on the View Contents of Folder screen (
o File Upload tab (all browsers)
o

l

)

Multiple DMS Documents tab (Internet Explorer with MS Office)
n Same as Adding Multiple DMS Documents on the facing page except there is no
check-in option
n

Can upload several files at once

n

Asset title taken from Windows file name

Drag and drop to mapped network folder; Adding Assets to a Mapped Network
Folder on page 320
o User doesn’t need to install or learn Ektron software
o

Can drag/drop folder structure; Ektron recreates it in Workarea

o

Title taken from Windows file name

o

Content status is checked in; submitting for publishing is separate step

o

Cannot assign language to content

o

Cannot work with content in language other than default

Restrictions and Warnings about Importing Assets
l

l

l

l

l
l

You can only import assets using a method listed in the previous section. You cannot
simply drop files in the siteroot/assets or siteroot/PrivateAssets folder then
manage them using Ektron.
Only users with Add folder permission can import files to it. See Also: Managing Folder
Permissions on page 257.
You cannot import to a folder for which XML Smart Forms are required. See Also:
Assigning a Smart Form Configuration to a Folder on page 437.
If you are using the Firefox browser, you may not be able to upload a large file. To
resolve this, go to Firefox >Tools > Options > Advanced > Network and increase
the Offline Store to a size larger than the file being uploaded.
With MS Office 2010, you cannot upload more than 100 files at a time.
With MS Office 2010, files greater than 100 megabytes may fail if your computer's
memory is insufficient. In general, do not upload larges file via the Multiple DMS
Documents option.

Adding an Asset
To add an asset via the New > DMS Document menu option:
1. Workarea > Content.
2. Select the folder in which you want to place the document.
3. The default language icon appears next to the screen title. To create a document for a
different language, click View > Language and select the language.

316

Ektron Reference

Adding Multiple DMS Documents

4. Click New > DMS Document. The following screen appears.

Or, from the View Contents of Folder screen toolbar, click Add Assets(
appears.

). This screen

5. Click Browse and navigate to the file you want to import.
6. Enter a Title. It cannot include these characters: \ / *> <|
NOTE: If you want to retain the original document name, insert the full filename into the Title field.
For example, you could enter mydocument.doc.
7. Use the Content Searchable checkbox to determine if the content should be
searchable.See Also: Ensuring Your Content is Searchable on page 942
8. If desired, add a summary, metadata, a schedule, and comments. See Also:
l
Writing a Summary for Content on page 292
l

Working with Metadata on page 369

l

Scheduling Content on page 296

9. Check in or submit the content for publishing as you would HTML content.

Adding Multiple DMS Documents
This option requires Internet Explorer and Office 2003 or higher on your computer. Also, you
must enable ActiveX controls in your browser settings. To do this, open Internet Explorer and
go to Tools > Internet Options > Security Tab > Custom Level button. Within that
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screen, under ActiveX controls and plugins, find Script ActiveX controls marked safe
for scripting* and click Enable.
IMPORTANT: If you will apply the same information (Summary, Metadata, Categories, and so on) to
several files, place them in the same Windows folder before starting this procedure.
See Also: Managing Microsoft Office Assets on page 322.
To add assets toEktron via the New > Multiple DMS Documents menu option:
1. From the Workarea, select the Content tab.
2. Select the folder in which you want to place the documents.
3. Click New > Multiple DMS Documents.
4. Select your version of MS Office and click OK. If Office 2003 or 2007 is installed as well
as Office 2010, choose Office 2010. The Multiple Document Upload option uses MS
Office to perform the upload. The upload screen appears.
NOTE: If you later change your computer's Office version, update this setting from the Add Assets
button > Multiple DMS Document option > Switch Office version option.
5. Open Windows Explorer in a separate window, then drag and drop files onto the screen.
Or, you can Browse for files instead. You can only import files from one folder at a
time.
6. If Ektron requires you to apply metadata or a taxonomy category to the content,
complete all required information.
7. To check in the files, click Check In. To submit the files into the approval chain, click
Submit or Publish.
NOTE: If your website uses an https secure site setting, you may see errors after uploading assets. If this
occurs, open your site’s web.config file and change the value of the add key="ek_UseSSL" setting
to true.

Managing Multimedia Assets
Multimedia files contain audio, video, or both. File types include .wav, .mpeg., .swf, .avi, and
.wma.
Ektron supports multimedia files that run on one of these players.
l

WindowsMedia®

l

Quicktime®

l

Realplayer®

l

Flash®

If you import a multimedia file that does not play on a supported player, it is treated like any
other asset but cannot be played within Ektron. If you try to play a file in the Workarea, or a
site visitor tries to play a file but no supporting media player exists on the user’s computer,
you are prompted to download and install the player.
Every multimedia file type has a corresponding MIME type. For example, an mp3 file's MIME
type is audio/mpeg. Supported MIME types are defined within the mediasettings element of
the web.config file as follows:
<add key="application/x-shockwave-flash" value="Flash" />
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<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add

key="audio/x-wav" value="WindowsMedia, Quicktime, Realplayer" />
key="audio/x-wav-default" value="WindowsMedia" />
key="audio/x-pn-realaudio" value="WindowsMedia, Quicktime, Realplayer" />
key="video/x-avi" value="WindowsMedia, Quicktime, Realplayer" />
key="video/x-avi-default" value="Quicktime" />
key="video/x-msvideo" value="WindowsMedia, Quicktime"/>
key="video/x-msvideo-default" value="WindowsMedia"/>
key="audio/x-ms-wma" value="WindowsMedia"/>
key="audio/mpeg" value="WindowsMedia,Quicktime"/>
key="video/x-realvideo" value="Realplayer"/>
key="video/x-ms-wmv" value="WindowsMedia"/>
key="audio/x-realaudio" value="Realplayer"/>
key="video/quicktime" value="Quicktime"/>

To determine if a multimedia file type is supported, go to HTML Multimedia, then go to the
web.config file section to see if the MIME type exists and insert the player name within the
value element. For example:
<add key="audio/mpeg" value="WindowsMedia"/>

In this example, WindowsMedia is the only supported player for mp3 files. If you know that
other players can run mp3 files, insert additional players after WindowsMedia. To get the
exact name of the player, review the value elements in web.config file section.
If you want Ektron to support additional MIME types, add them within the <mediaSettings>
element using the following syntax:
<add key="MIME type/subtype" value="supported media player(s)"/>

For example:
<add key="video/x-ms-asf" value="WindowsMedia"/>

To identify a player as the default for a MIME type, use the following syntax within
web.config.
<add key="MIME Type/subtype" value="default player"/>

For example:
<add key="video/x-msvideo-default" value="WindowsMedia"/>

You must also add new file types to the supported file list in the assetmanagement.config
file. See Also: Allowing File Types on page 314.
After a multimedia file is imported into Ektron, you can view supported media players’
properties on the Edit Content screen's Content tab. Players defined for the file’s MIME type
are checked. You may uncheck any media players that you do not want to operate a particular
file.
l

l

If a default media player is defined for a MIME type in web.config, you cannot uncheck
its checkbox.
If the file is supported by several players, first check the player whose properties you
want to modify, then edit its properties.

The Width and Height fields determine the size (in pixels) of the media player when it
appears in the Workarea and on your website. The remaining properties are determined by
the media player (QuickTime in the example above).
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When you visit a page that hosts a multimedia file, Ektron tries to match media players on the
user’s computer with those defined in the web.config file for the file’s MIME type. Ektron
then displays a list of choices for every supported media player for the file.
You can change the multimedia player’s style properties by modifying the EKTTabs.css style
sheet. This file is installed to sitefolder/Workarea/csslib.
For example, you can change the color of the text that selects a player to red by changing the
property highlighted below.
.EktTabActive
{
padding: 2px 2px 2px 2px;
top:10px;
text-decoration:none;
position: relative;
background-color:white;
border: solid thin navy;
color:Red;
font-weight:bolder;
}

Here is the result.

Adding Assets to a Mapped Network Folder
You can set up a mapped network folder then drag and drop folders or assets into it. You can
also delete and move assets using the mapped network folder. The advantage of this method
is that you can upload documents without installing or learning how to use Ektron.
When using drag and drop, you can choose individual assets or a folder. Only supported file
types may be uploaded. If you choose a folder, Ektron recreates that folder structure, even if
it is several levels deep.
NOTE: You cannot choose a language for assets in a mapped network folder-- they are automatically
assigned the Ektron default language (set in the siteroot/web.config file at the ek_DefaultContent
Language element). Also, you can only work with assets in the default language.
PREREQUISITES
l

the path to your Ektron website

l

an Ektron user name and password

l

verify that WebDav is installed on your client system, and enabled on the Ektron
server that hosts your site. See http://www.iis.net/learn/publish/usingwebdav/using-the-webdav-redirector.

1. Log onto the server that hosts Ektron, or a client that can access Ektron.
2. Open Windows Explorer.
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3. For Windows 7, click Tools > Map Network Drive. For Windows 2008 server, click
Start > Computer > Map Network Drive. The Map Network Drive screen appears.
4. Click Connect to a website that you can use to store documents and pictures.
A wizard screen appears.
5. Click Next. Another wizard screen appears.
6. Click Choose a custom network location and click Next. A third wizard screen
appears.
7. Enter the path to your Ektron site, followed by the ekdavroot folder. For example,
http://CMSMIN870037/ekdavroot and click Next. An Ektron login screen appears.
8. Enter your username and password and click OK. Another wizard screen appears.
9. Name the network drive and click Next. You use this name to identify the folder when
dropping assets into it. The Finish screen appears.
10. In Windows Explorer, open the new network folder (it appears under Computer >
Local Disk (C:)). Notice that its structure mirrors your Workarea folders.
11. Navigate to the folder to which you want to drop files, and drag and drop them.
NOTE: Your access to folders and ability to drop files into them are determined by your Ektron folder
permissions (collected in Step 7). See Also: Managing Folder Permissions on page 257
12. If an asset is not supported, an error message appears: An error occurred copying
some or all of the selected files. However, all supported assets are uploaded.

Status of Asset Saved to Mapped Network Folder
The status of an asset dropped in a mapped network folder depends on the approval chain and
the user who signed in to the folder.
l
l

If you are the last approver, or if there is no approval chain, its status is Approved.
If there is an approval chain and you are not the last approver, its status is Checked In
(I).

Also, if the content’s folder requires metadata or a taxonomy category which has not been
entered, its status is Checked In (I).

Removing Mapped Network Drives
Ektron’s DMS feature creates a mapped, ekdavroot network drive for many functions. For
example, if you sign on to Ektron and create a new folder, a new mapped, ekdavroot
network drive is created.
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If you find that ekdavroot folders clutter up your My Network Places folder, you can delete
them. Deleting ekdavroot folders has no impact on your ability to use Ektron.

Managing Microsoft Office Assets
To learn about importing Microsoft Office assets, see
l

Methods for Importing Assets on page 315

l

Restrictions and Warnings about Importing Assets on page 316

l

Adding an Asset on page 316

This section shows you how to do the following:
l

Editing an Office Document on the facing page

l

Deleting an Office Document on page 324

l

Updating an Office Document on the facing page

l

Saving an Office Document on page 324

l

Saving an Office Document in HTML Format on page 325

PREREQUISITES
Before you begin working with Microsoft Office documents:
l

Your computer should have MS Office 2003 or higher (but see note below).

l

Internet Explorer or Firefox to work with Office documents within Ektron.
NOTE: The ability to use Firefox to edit Office documents within Ektron is only available in
Ektron version 8.5 SP2 and higher. Also, Office 2010 is required with the SharePoint
Foundation option.

l

Problems can arise if you try to open a document created with Office 2007 or
2010, and your computer has an earlier version of Office. The best solution is to
upgrade to Office 2007/2010.
If you cannot, install the Microsoft Windows Compatibility Pack. See Microsoft
Office Compatibility Pack for Word, Excel, and PowerPoint File Formats.
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When installed, you can work with Office 2007/2010 documents using an earlier
version of Office.
l

If you import an Excel spreadsheet then click it from its Ektron folder, you see
Download this file name. Click the download link to view the file.

Editing an Office Document
You can edit a Microsoft Office document in the following ways. When you begin to edit the
document, its status changes to Checked Out (0).
l

l

Select a document in an Ektron folder and choose Edit in Microsoft Office from the
drop-down menu.
Open a file in the mapped network drive location, using Microsoft Office. (You also can
delete and move documents using the mapped network folder.)

If you want to edit the document’s Summary, Metadata, Schedule, Comment, Task, or
taxonomy category information, click the asset from the Ektron folder, then select Edit
Properties from the drop-down menu.
A history of every saved version is retained so you can restore previous ones if necessary.
You cannot enter or change Ektron document information (Summary, Metadata, and so on) in
the mapped network folder; you must use Ektron to do that.

Updating an Office Document
If you check out and save an Office document to your computer, you would typically edit it
using Office. While an Office document is checked out, only you or a system administrator
can check it back in. Other users cannot edit it. You may use this feature to work on the
document on your computer, copy it to another computer, or even email it to someone who
does not have access to Ektron.
You can also use the Check Out and Save As option to edit an Office document if you use
the Firefox browser. Firefox does not let you edit Office documents within Ektron, as you can
with Internet Explorer. To work around this limitation, check out the Office document, save it
to your computer, and edit it.
When all edits have been entered, drag and drop the document back to Ektron.
Follow these steps to copy an Office document to your computer, edit it, then replace the
version in Ektron.
IMPORTANT: There are several ways to import a document into Ektron. Some methods retain the
original file name while others let you assign a name. When you check out and save a document to your
computer, it is saved under the original file name, which may be different from its Ektron name. The
original file name is on the screen that appears after you select Check out and Save as. Make note of the
original file name, because you use it to identify the file after it is saved to your computer.
1. In Ektron, open the folder that contains the Office document.
2. Click the triangle ( ) next to the document.
3. Select Check out and Save As.
4. Click Save and Open. The document’s status changes to checked out (O).
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5. Edit the document in Office.
NOTE: If you change your mind and do not change the document, but simply close Office, the
document remains Checked Out (O). Use the Check In menu option to check it in.
6. Within Office, click File > Save As and select a folder to which to save the document.
Do not change the file name.
7. Within the Ektron folder, open the document's folder and select the document.
8. From the context menu, click Check In.
9. From the context menu, click Edit Properties.
10. Click the Browse button and navigate to the folder selected in Step 6.
11. Select the edited document.
12. From the toolbar, click Check in or Publish.
13. You are asked to confirm the file replace. Click Yes. The revised document is saved in
Ektron.

Deleting an Office Document
NOTE: You must have delete permissions for the folder that contains the document. See Also: Managing
Folder Permissions on page 257. Also , it is good practice to check for broken quicklinks before deleting
documents. See Link Checking Before Deleting on page 291.
To delete an Office document:
1. In the Workarea, open the folder that contains the document.
2. Hover the cursor over the triangle ( ) next to the document and click. A drop-down
menu appears.
3. Click Delete and confirm the deletion with OK.
Like publishing, deleted content must be approved before it is removed. If you are the last
approver in the approval chain, the content is deleted immediately. See Also: Approving or
Declining Content on page 267

Saving an Office Document
You would typically save an Office document to your computer to distribute it to others, or if
you want a personal copy. You should not save a document to your computer if you plan to
edit it then replace the version in Ektron—doing this may overwrite edits made by other
users.
If you want to edit a document, use the Edit in MS Office or Check out and Save As
menu option. The Both options set the content to checked out status, which prevents nonadministrator users from editing it until you check it back in.
To save an Office document:
1. In Ektron, open the folder that contains the Office document.
2. Hover the cursor over the triangle ( ) on the right end of the document and click Save
As.
3. You are asked if you want to open or save the document. Choose Save.
4. Select a folder to which you want to save the document.
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Saving an Office Document in HTML Format
This feature converts Office documents to HTML format, which means they are formatted to
display within a browser. As a result, anyone visiting your site can view the document,
whether or not Microsoft Office is installed on their computer.
NOTE: You can publish only Microsoft Word and Excel documents as HTML. Ektron does not support
saving Powerpoint or Visio documents as HTML.
There are 2 ways to save an Office document in HTML format.
l

l

Drag and drop an Office document into Ektron and use the Edit in MS Office option to
save it in HTML format. You don’t need to know the path to your website’s root folder.
Open an Office document on your computer and save it in HTML format to the ekdavroot
folder in your Web root. You don’t need to drag and drop document to Ektron.

Regardless of how you save Office documents as HTML, be careful to set up procedures that
prevent HTML content from being overwritten. For example:
1. You save a Word document as .html.
2. Someone edits the HTML version.
3. You save the original Office Document as .html again.
In this scenario, the edits made in step 2 are overwritten by step 3. You should establish
procedures that avoid such problems.

Saving an Office Document as a Web Page
When saving a Word document, after you choose Save as from Word’s File menu, there are
2 choices for saving as HTML.
NOTE: When saving an Excel document, Save as Web Page (*.htm, *.html) is the only option.
l

save as Web Page

l

save as Web Page Filtered

NOTE: For a description of the differences between these options, see About using filtered HTML.
You should save as Web Page, Filtered because the resulting HTML is almost identical to the
original document. The save as Web Page is not a good option because its HTML content
does not match the original document and may cause problems when being edited.

Handling Images Embedded within a Word Document
If you save an Office document that includes images, they appear when anyone is editing the
document as well as when it appears on your website. In addition, the images are saved to
the corresponding Ektron Library folder. In this way, other Ektron users can apply the images
to HTML content as needed.
See Also: Storing Files in the Library on page 333

Saving an Office Document as .html from Ektron
This procedure assumes the Office document has been saved to Ektron. Procedures for doing
this are explained in Managing Microsoft Office Assets on page 322.
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1. Within the Workarea, open the Content area.
2. Open the folder that contains the Office document you want to save as .html.
3. Hover the cursor over the triangle ( ) on the right end of the document you want to save
4. Click Edit in Microsoft Office. The document opens within Office.
5. From Office’s File menu, select Save as Web Page.
6. In the Save as Type field, select Web page, Filtered (*,htm, *.html). See Also:
Saving an Office Document as a Web Page on the previous page
7. Click Save.
8. You may be warned about formatting features not supported in HTML. Click Continue.
9. A dialog prompts you to enter your Ektron user name and password.
10. Ektron’s folders appear in a Save as window. The folder that contains the Word
document is the default folder. Select that or any other Ektron folder and click Save.
11. The Office document is saved as an HTML file into Ektron.
12. Close the document and exit from Office.

Saving an Office Document as .html from Your Computer
1. Open the Office Document.
2. Click File > Save as (*,htm, *.html).
3. Click My Network Places and navigate to ekdavroot folder on the server that hosts
Ektron.
4. Ektron’s folders appear. The folder that contains the Word document is the default
folder. Select that or any other Ektron folder.
5. In the Save as Type field, select Web page (*.htm, *.html) or Web Page, filtered
(*.htm, *.html). See Also: Saving an Office Document as a Web Page on the previous
page.
6. Click Save.
7. You may be warned about formatting features not supported in HTML. Press Continue.
8. A dialog prompts you to enter your Ektron user name and password.
9. The Office document is saved as an HTML file into Ektron.
10. Close the document and exit from Office.
The status of the document depends on the approval chain and the user who signed in when
the mapped network folder was created.
l
l

If you are the last approver, or if there is no approval chain, its status is Approved.
If there is an approval chain and you are not the last approver, its status is Checked In
(I).

Checking Document Management Permissions
If you are having any problems with permissions, use this section to verify that your user and
folder settings are assigned properly. You can view current user permission settings for
affected folders in Diagnostics Utility on page 1883.
When the Document Management functionality is installed, permissions are granted to
several users for the following folders.
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l

l

l

root/assetLibrary—Set by the user during installation, you can view and change the path
to this folder in the Workarea Settings > Configuration > Asset Server Setup >
Storage Location.
siteroot\AssetManagement\dmdata—Set by Ektron during installation, dmdata has
settings for both the file system and IIS.
siteroot/assets—Set by Ektron during installation, the Asset Library folder contains file
assets uploaded to and managed by DMS. You can view and change the path to this
folder in the Workarea Settings > Configuration > Asset Server Setup > Storage
Location.

The assigned permissions vary depending on your server’s operating system.
The following table shows which users and permissions should be enabled for the folders
listed above. Use this information to troubleshoot permission problems. See Also: Setting Up
Your CMS Folder Structure on page 241
User

Windows 2000 Pro
or XP Pro

Windows 2003
Server

Windows 2003
Enterprise Edition

IIS_WPG User
IUSR_
The IUSR_ account is
required only if
Impersonate is set to
True in web.config, and
its username and password
attributes are not specified.
If impersonate is set to
false (default setting), the
IUSR_ account may be
harmlessly removed from
the folders listed.
IUSR_Group

ASP.NET User
User Defined (The User
Defined user account is
required only if
Impersonate is set to
True in web.config, and
its username and password
attributes are specified.)
The following list shows extended permissions for use with the Document Management
functionality.
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l

Traverse Folder / Execute File

l

List Folder / Read Data

l

Read Attributes

l

Read Extended Attributes

l

Create Files / Write Data

l

Create Folders / Append Data

l

Write Attributes

l

Write Extended Attributes

l

Delete Subfolder and Files

l

Read Permissions

Removing Front Page Server Extensions
When you remove FrontPage Server Extensions from the Web root, the extensions also are
removed from folders below that.
1. Click the Windows Start button.
2. Click Control Panel > Administrative Tools > Computer Management.
3. Open Services and Applications > Internet Information Services > Web Sites
> Default Web Site.
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4. Right click the mouse and select All Tasks > Remove Server Extensions.

Troubleshooting Assets
This section explains how to fix problems that may occur with Ektron assets.

Cannot drag and drop assets into Ektron
Symptom: You cannot drag and drop assets into Ektron.
Resolution: See Removing Front Page Server Extensions on the previous page.

Target Directory Already Exists
Symptom: While trying to drag and drop an asset, an error message appears: The target
directory already exists.
Resolution: Check the impersonate element of the web.config file. If it is set to true,
make sure the anonymous access account has at least write access to the dmdata and assets
directories.

Cannot Update Published DMS Documents
Symptom: When you try to publish DMS documents, Ektron sometimes does not allow them
to update.
Resolution: Make sure your production server is not running Windows XP. You cannot use XP
as a production server for DMS.

Removing aspnet_isapi.dll from the List of Wildcard
Application Maps
Symptom: When you try to upload an asset, you get the error message “Failed to upload
documents.”
Cause: Remove the aspnet_isapi.dll from the list of Wildcard Application Maps.
Resolution:
1. Open IIS.
2. Go to your Ektron website.
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3. Underneath the website, click Asset Management > dmdata.

4. Right click dmdata and choose Properties.
5. Click the Virtual Directory tab.
6. Click Configuration.
7. Look in the Wildcard Application Maps area. If aspnet_isapi.dll appears, remove
it.

330

Ektron Reference

ERRMSG: AssetManagement error: Failed to save

8. Click OK.

ERRMSG: AssetManagement error: Failed to save
asset
Symptom: After recently moving the ASM database to a new SQL server that has never
hosted an ASM database, the following error appears while adding a DMS asset.
AssetManagement error: Failed to save asset.
Internal Message: RAISERROR could not locate entry for error 2000000002 in sysmessages.
at
Ektron.ASM.Documents.Asset.Create(enAssetStatus state) at
Ektron.ASM.Documents.AbstractAssetManagement.Create(AssetMetaData
assetMetaData, enAssetStatus state) at
Ektron.ASM.PluginManager.PluginHandler.Create(AssetMetaData
assetMetaData, enAssetStatus state) at
AssetManagement.AssetManagementService.Create(AssetMetaData
assetMetaData, enAssetStatus state) at
Mojave.AssetManagementProxy.Create(AssetMetaData assetMetaData,
enAssetStatus state) at
Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at
Ektron.Cms.EkException.ThrowException(Exception ex) at
Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at
Ektron.Cms.Content.EkContent.AddNewContentv2_0(Collection ContObj)

Cause: During the creation of the ASM database, a total of 7 messages are written to the
sysmessages table in SQL Server’s master database. Each installation of SQL Server has its
own master database and, in a typical move from one location to another, changes to the
master database are not brought over.
If the ASM database was moved, and these messages are not in the sysmessages table in the
new location's master table, the above error appears instead of a standard error message.
Resolution: Run this set of SQL scripts against your database. They add appropriate
messages to the sysmessages table in the master database.
/********************************************************************************/
sp_addmessage 2000000001, 10, N'Error in %s: Error %d inserting into %s. %s',
US_ENGLISH, FALSE, REPLACE
go
/********************************************************************************/
sp_addmessage 2000000002, 10, N'Error in %s: Insert into %s returned %d rows. %s',
US_ENGLISH, FALSE, REPLACE
go
/********************************************************************************/
sp_addmessage 2000000003, 10, N'Error in %s: Failed creating record because
primary key already exists. %s', US_ENGLISH, FALSE, REPLACE
go
/********************************************************************************/
sp_addmessage 2000000004, 10, N'Error in %s: Error %d updating into %s. %s',
US_ENGLISH, FALSE, REPLACE
go
/********************************************************************************/
sp_addmessage 2000000005, 10, N'Error in %s: Update into %s returned %d rows. %s',
US_ENGLISH, FALSE, REPLACE
go
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/********************************************************************************/
sp_addmessage 2000000007, 10, N'Error in %s: Error %d deleting into %s. %s',
US_ENGLISH, FALSE, REPLACE
go
/********************************************************************************/
sp_addmessage 2000000008, 10, N'Error in %s: Delete into %s returned %d rows. %s',
US_ENGLISH, FALSE, REPLACE
go

This snippet utilizes the sp_addmessage stored procedure from the master database, which
adds the appropriate messages to the correct table.
NOTE: Although it is possible to recode these as an INSERT statement that can run directly against the
sysmessages table, that procedure is not recommended.
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Storing Files in the Library
The library folder stores images, files, quicklinks, and hyperlinks that can be inserted into
editor content. Before you can insert them into content, you must copy them from your
computer to a larger, file server computer that everyone editing your site can access.
See Also: Storing External Files as Library Items vs. Assets on page 311
l

l

l

l

l

An image is any graphic file, which can include illustrations and photos. Common image
file extensions are .gif., .jpg, .tiff, and so on.
A file is type of computer file that can be launched from a browser, such as Internet
Explorer. Examples include a Microsoft Word document and a .PDF file.
A hyperlink is a commonly used or hard to remember Web address (also known as a
URL). After you add hyperlinks to the library, users can easily apply them to editor
content. For example, if the editor content is “Contact Ektron,” the user can select the
text, click the library button, select hyperlinks to find the Ektron hyperlink, and apply
that hyperlink to the text. When the page is published, a person reading it can click the
text to “jump” to the Web address www.ektron.com.
A quicklink is a special kind of hyperlink that jumps to another content item on your
website. (A regular hyperlink jumps to a Web page on the internet.)
A form is a quicklink to HTML form content. Whenever content is created, a form link is
automatically created for it.

This section also contains the following topics.
Working with the Library
Working with Files
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Working with the Library
This section describe actions you may perform with library files.

Performing Actions on Library Items
The library is made up of images, files, form Quicklinks, hyperlinks, and regular Quicklinks
that were added by Ektron users. The following table displays the actions that can be
performed for each library item type.
Action

Files

Images

Hyperlinks

Quicklinks

Form Quicklinks

Add

Edit
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Action

Files

Images

Hyperlinks

Quicklinks

Form Quicklinks

View

Overwrite

Delete

Remove from server

Check links

Update URL

Most actions can be performed by a user who is granted permission to do so.
Whenever a new content folder is created and permissions given to it, a corresponding library
folder is created. The new library folder inherits permissions from the content folder.
Items added to library folders are only accessible by users with permission to the
corresponding content folder. If items are added to a library folders directly under the main
library folder, all users with at least library Read-Only permissions can use those library
items in their content.
Conversely, if a library item is uploaded to a folder to which only one person has permissions,
that is the only user who can use that library item.
To add, edit, overwrite, or delete a library item a user must either be a member of the
administrators group or have the following combination of folder permissions.

Add

Edit file name, summary,
metadata

Overwrite
file

Delete

Library
images

Add
Images

Add Images

Overwrite
library

Delete and Add
Images

Library files

Add Files

Add Files

Overwrite
library

Delete and Add
Files

Library
hyperlinks

Add Hyperlinks

Add Hyperlinks

Overwrite
library

Delete and Add
Hyperlinks

Accessing the Library
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1. Click Workarea > Library. The Library folder appears.

2. The sub-folders appear in the left frame. Files in the root folder (library) appear in the
right frame.

You can use the drop-down list (circled above) to change the type of library files that
appear.
To work with any library file, click it. When you do, the View Library screen appears,
providing additional information about the item. From here, you can
l

edit its title, file name, or description

l

overwrite it

l

find content linked to it

l

delete it

The following table explains toolbar buttons on the library screen.
NOTE: Your system administrator determines which library folders you can access, and which functions
you can perform on library items within the folders.
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Button

Description
Search library; Searching the Library on the facing page
View the library’s properties screen; Accessing Library Folder Properties below
Add an image, file, quicklink, or hyperlink to the library; Adding a File to the Library on
page 340

Select a type of Library file to work with

Accessing Library Folder Properties
The library folder properties screen lets you view and update image and file types may be
uploaded.
Administrators have permission to change library properties.
IMPORTANT: You can only add file extensions that are listed in the siteroot/web.config file property ek_
LibFileTypeWhiteList.
To view the properties of the library folder:
1. Click Workarea > Library. The Library folder appears.
2. Click Properties ( ). The Library Management window appears, displaying the
following settings.
l
Image Extensions—The types of image files that a content contributor can upload
to the library. You can add as many image file extensions as you want, or have
none. If no extensions appear, no one can upload image files to the specified folder.
IMPORTANT: You can only add file extensions that are listed in the siteroot/web.config file
property ek_LibFileTypeWhiteList. See Also: Using the File Type Whitelist on the
facing page
l

Image Upload Directory—Specifies where the uploaded images are saved on the
Web server. By default, the image upload directory is Web root/ek_
sitepath/uploadedimages. Theek_sitepathvalue is set in the web.config file.
See Also: Managing the web.config File on page 67

l

l
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Make Directory Relative to this website—If you want to specify the image
upload directory’s location as relative to your website root, check this box. (Your
website root’s location appears to the right of Make Directory Relative to this
website.)
File Extensions—Specify the types of non-image files that a content contributor
can upload to the library. You can add as many non-image file extensions as you
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want, or have none. If no extensions appear, no one can upload non-image files to
the specified folder.
IMPORTANT: You can only add file extensions that are listed in the siteroot/web.config file
property ek_LibFileTypeWhiteList. See Also: Using the File Type Whitelist below
l

File Upload Directory—Specifies where the uploaded files are saved on the Web
server. By default, the file upload directory is Web root/ek_
sitepath/uploadedfiles. Theek_sitepathvalue is set in theweb.config file.
NOTE: You must create the directory in your Web root manually, before adding it in Ektron.
See Also: Managing the web.config File on page 67

l

Make Directory Relative to this website—If you want to specify the file upload
directory’s location as relative to your website root, check this box. (Your website
root’s location appears to the right of Make Directory Relative to this
website.)

Using the File Type Whitelist
The siteroot/web.config file property ek_LibFileTypeWhiteList contains the same
default file types as those on the Library Managementscreen's Image Extensions and
File Extensions fields.
A server administrator can use this property to restrict which file types may be uploaded
to the library. For example, if an Ektron administrator wants to add a new file type,
someone who can edit files on the Ektron server must first add it to the web.configek_
LibFileTypeWhiteList property. This provides additional security over which file types
can be uploaded to the library.
Conversely, if an server administrator wants to remove an allowed file type from the
Library Management screen, he must first remove it from the ek_
LibFileTypeWhiteList property.

Searching the Library
NOTE: New and updated library items are available only after the next crawl completes. See Also:
Managing the Search Crawl on page 931
You can search the library to find items if you know only some information about them. For
example, you know that an image’s name includes Ektron but don’t know its filename or
folder.
To search the library, first select the folder in which you want to begin the search. The search
only considers files in that folder and its child folders. To search the entire library, select the
Library (root) folder.
Next, click Search ( ) from the library toolbar. When you do, a search screen appears
(shown below).
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The left tab, Search Published, finds both library items and content that satisfies the search
criteria.
l

Matches selected language

l

Search text is contained in title, summary, filename, or path.

l

If the search text is more than one term, all terms must be found. So, multiple terms
have an AND relationship.

To force an OR relationship, enter OR between search terms.
The right tab, Advanced Search, lets you narrow your search.

338

Ektron Reference

Working with Files

l

Enter Keyword(s)—Specify one or more keywords that the search will use. The search
looks for keywords in the file’s title. (The title is assigned by the user when the file is
added to the library.) If a file’s title matches the keywords, the file appears on the
search results screen.
The search also uses keywords to search through the file’s
l

l

internal name (for example, airplane.gif) if the Filename Search checkbox is
checked
description if the Description search checkbox is checked

A keyword can be a complete or partial word. But, you can only enter a partial term for
one word. For example, you can enter Adv and have the search return the content titled
“Adverse Drug Reactions.” But if you enter Adv Drug, the search returns nothing.
You can enter several complete search terms but they must be in the correct sequence.
For example, to find the topic titled “Adverse Drug Reactions,” you can enter Adverse
Reactions but cannot enter Reactions Adverse.
To find all files in a selected library folder, enter nothing in this field. Or, to find all files
in a selected library folder of a type (for example, images), select the type and enter
nothing in this field.
l

All Types—The search considers all library file types.

l

Images only—The search only considers images.

l

Quicklinks Only—The search only considers quicklinks.

l

Forms Only—The search only considers forms.

l

Files Only—The search only considers files.

l

Hyperlinks Only—The search only considers hyperlinks.

l

l

l

l

Description Search—If you check this box, the search considers the library item’s
description when returning search results. Otherwise, the search ignores the description.
For example, if you enter Ektron into the keyword field, the search returns all library
files that include that string.
Filename Search—If you check this box, the search considers the file name when
returning search results. Otherwise, the file name is not considered by the search. For
example, if you enter ppt into the keyword field, the search returns all files that include
that string (such as all Powerpoint presentations).
Only search items last edited by myself—The search only considers library files
that were last modified by you.
One or more search criteria set by your system administrator in the Metadata Definitions
screen.

NOTE: Some search field check boxes are circles while others are squares. If the box is a circle, you can
only choose one option. If it is a square, you can choose several.
The search displays library items that meet the search criteria. You can click any item to view
its properties (such as Library ID number, Last Edit Date and Description).

Working with Files
This section explains how to work with library files (which includes files, forms, hyperlinks,
images, and Quicklinks).

Ektron 8.7

339

Managing Content

This section also contains the following topics.
Adding a File to the Library
Viewing a File
Editing a File
Searching Library Links
Adding a Library File to Content
Adding a File to the Library and Inserting it into Content
Overwriting a File
Deleting a Library Item
Adding a Quicklink or Form to Content
Viewing Quicklinks or Forms
Updating the Default Template for Multiple Quicklinks
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Adding a File to the Library
After a file is copied to the library, users can add it to content. They can also add an item into
the library while inserting it to content.
PREREQUISITE
l

For the file being added, its type is defined in the Library Properties screen's Image
Extensions or File Extensions field. See Also: Accessing Library Folder Properties on
page 336

To add a file to the library:
IMPORTANT: You should use the Document Management system to add files. Unlike library files, DMS
files can be part of an approval chain, maintain a history, are searchable, and can have a summary,
schedule, metadata, taxonomy categories, and so on.
NOTE: Microsoft lets users upload files of any name. However, IIS security blocks files with names that
contain an ampersand (&), colon (:), or percentage sign (%). Source: FIX: "HTTP 400 - Bad request" error
message in the .NET Framework 1.1
To allow these characters, add the following registry key to your Web server then reset IIS.
Reg Key: DWORD HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ASP.NET
VerificationCompatibility = 1.
1. In the Workarea, browse the library folder and select a folder to which you want to copy
a file.
2. When you copy a file to a folder, only users with permissions to that folder can insert the
file into content. A list of files in that folder appears.
3. Click Add. The Add Library Item to Folder screen appears.

4. Enter the necessary information according to the following list.
l
Title—Enter a title for the file to be copied.
l
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Filename—Enter the path to the file to be copied. You can use the Browse button
to find it.
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IMPORTANT: You can only add file extensions that are listed in the siteroot/web.config file
property ek_LibFileTypeWhiteList. See Also: Using the File Type Whitelist on
page 337
l

Description—Enter a full text description to help other users identify this file. The
Description appears on the View File and Search Results screens.

5. Click Save to copy the file. Users with permissions to the selected folder can insert the
file into their content.
NOTE: When an image is uploaded to the Media tab for a product in the eCommerce feature, the original
image and any thumbnails associated with it are added to the Library. For example, if you add an image
named “TestImage” (actual file name: “case.jpg”) with a 150px and 50px thumbnails, you will see the
following entries in your library (File Name - Path):
TestImage - /~siteroot~/uploadedImages/case.jpg
case[filename]150 - /~siteroot~/uploadedImages/case[filename]150.jpg
case[filename]50 - /~siteroot~/uploadedImages/case[filename]50.jpg

Viewing a File
When a file is copied to the library, you may preview it. To preview a copied file:
1. Navigate to the library folder to which the file was copied.
2. Click the file you want to preview. The View File screen appears.

l

Title—Title assigned by user who copied or edited it.

l

Filename—Filename and location on the server.

l

Library ID—ID number assigned by Ektron when file was originally copied.
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l

Parent Folder—File’s parent folder. Users need permissions to this folder to insert the
file into content.

l

Last User to Edit—Last user who changed file.

l

Last Edit Date—When file was last edited.

l

Date Created—When file was originally copied to library.

l

Description—Optional, full-text description of file.

If the file can be displayed in your browser, a preview of it appears at the bottom of the
screen. If it cannot display in the browser, a link to preview it in its host application appears
instead.
NOTE: You may need to download some files before you can be view them (for example, .mdb, .mp3,
.zip, and so on).

Editing a File
To edit the title, filename and description of any library file:
1. Access the View File screen and click Edit. The Edit File screen appears.

2. Change the title, file name, and/or description of the file.
3. Click Update.

Searching Library Links
Link searching indicates all content that includes a library link. It is useful when you want to
delete a library item. With the click of a button, you see all content that you need to update to
reflect the change you are making.
To perform a library item link search:
1. Access the View Library Item for any type of library item and click Link Search (
2. A list of all content that references the library item appears.
You should edit that content before deleting the item.

Adding a Library File to Content
342
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After a file is copied to the library, users can add it to content. You can also insert an item into
the library while adding it to content.
If you insert an image file, it appears within the content. If you add any other type of file, the
file name appears as a hyperlink within the content. When a site visitor viewing that page
clicks the hyperlink, the inserted file is launched.
NOTE: The following procedure applies to files, forms, hyperlinks, images and quicklinks.
1. Invoke the editor by adding or editing content in Ektron.
2. Place the cursor within the content where you want the library file to appear.
3. Click Library ( ). The Library screen appears.
4. Navigate to the folder that contains the file you want to insert.

5. From the file types drop-down list, select the kind of file (file, form, hyperlink, image, or
quicklink) you want to insert. All library files of that type in the selected folder appear on
the screen.
6. Click the file you want to insert.
7. Click Insert ( ) to insert the file. The content appears in your editor. In this example,
inserting the file creates a link in your content. If you select an image, the image
appears.

If you select Files from the file types list, and Aliasing is enabled for your website, the
following screen appears.
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Adding a File to the Library and Inserting it into Content
Use this procedure to insert an image into content that has not yet been copied to the library.
This procedure inserts the item into the library then into the content.
1. Invoke the editor by adding or editing content in Ektron.
2. Place the cursor where you want the library item to appear.
3. Click Library ( ). The library opens.
4. Navigate to the folder that will contain the file after you insert it.
5. Select the type of file (file, form, hyperlink, image, or quicklink) you want to insert from
the File types drop-down.
6. Click Add Library. A new screen appears.
7. Browse to the file you want to insert, or you can click Search ( ) to search for a file to
insert.
IMPORTANT: You can only add file extensions that are listed in the siteroot/web.config file property
ek_LibFileTypeWhiteList. See Also: Using the File Type Whitelist on page 337
8. Enter a Title for the file.
9. If metadata is required for the library item, you must complete it. Metadata fields may
appear in the lower section of the screen.
10. Click Add Library. The file is inserted into the selected library folder and the content.

Overwriting a File
If a library file or image becomes out-of-date or the wrong version was copied, you can
replace it with a new version. Overwriting files lets you minimize disk space and the number
of library files.
NOTE: The ability to overwrite a library file is a privilege granted by the system administrator. If you do not
see an Overwrite button on the View Library Item in Folder screen, you do not have permission to
overwrite. You can only overwrite images and files. The new image or file must have the same file
extension as the file being replaced.
When overwriting an image, the new image uses the same size dimensions and file extension
as the older image. Be sure that the 2 images have the same file extension and size or make
the adjustments at each occurrence of the image.
Remember, all links that point to the overwritten file now point to the new file.
To overwrite a library file:
1. Navigate to the View File screen for the file you want to overwrite and click Overwrite (
). The Overwrite File screen appears.
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2. Click Browse. A window lets you navigate to the new file.
IMPORTANT: You can only add file extensions that are listed in the siteroot/web.config file
property ek_LibFileTypeWhiteList. See Also: Using the File Type Whitelist on page 337
3. Select a file, then click Open. You return to the Overwrite File screen with the path to
the new file in the Filename field.

4. Optionally, enter a description for the new file.
5. Click Update to overwrite the current version of the file with this version. A message
appears before you can continue.
6. Click OK to overwrite the file.

Deleting a Library Item
You can delete obsolete items from the library. By deleting an item, you prevent users from
adding it to their content. A deleted hyperlink, quicklink or form quicklink remains on your
Web server, so any existing links to them are not broken.
On the other hand, if an item is a file or image, the delete window displays an additional
prompt, Remove from the server, that lets you remove the item from the server. This
feature is available to help reduce disk space taken up by these files. Before removing an
image or file from your server, you should review all content with links to it and remove or
update the link.
To delete an item from the library:
1. Access the View Library Item for any type of library item and click Delete ( ). The
Delete Library Item screen appears.
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2. If appropriate, check the box next to Remove from the server.
3. Click Delete ( ).

Adding a Quicklink or Form to Content
Users can insert a quicklink to it within any content. To do so, follow the procedure described
in Adding a Library File to Content on page 342. The only difference is that you add a quicklink
or form instead of a file.
You can apply a quicklink to text or an image within the content. If you do, and a site visitor
moves the cursor over the text or image, the cursor indicates that a hyperlink is available. If
the link is clicked, the source content or image appears.
If you do not select text or an image before inserting a quicklink, place the cursor where you
want it to appear. The title of the “jumped to” content appears in the content.
To test a quicklink or form, select hyperlinked text or image and double click it.
When the page is published, a reader can click the link to jump to the quicklink or form page.

Viewing Quicklinks or Forms
To view a quicklink or form, follow the procedure described in Viewing a File on page 341. The
only difference is that you view a quicklink or form instead of a file.
The following list describes each field on the quicklinks display.
l

Title—Title given to the hyperlink or form by the user who added it, or last edited it.

l

URL Link—URL link for the quicklink or form.

l

l

Library ID—ID number assigned automatically by Ektron when the quicklink or form
was originally added.
Parent Folder—Parent folder that the quicklink or form belongs to. Users need
permissions to this folder to be able to access the quicklink or form.

l

Last User to Edit—Last user that made changes to the quicklink or form.

l

Last Edit Date—The date the quicklink or form was last edited.

l

Date Created—The date and time the quicklink or form was originally added to the
Ektron library.

To preview a quicklink or form, click the link at the bottom of the page.

Updating the Default Template for Multiple Quicklinks
IMPORTANT: This procedure is only necessary if Link Management is set to false in your
web.config file. If if Link Management is set to true, Ektron automatically updates the template within
the quicklink when content is moved. See your system administrator for help with the web.config file.
When content is moved in Ektron, its quicklink does not get changed. After it is moved, you
need to update the default template called in the content’s quicklink.
NOTE: This action can only be performed on quicklinks.
To update the default template for one or more quicklinks:
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1. In the library, access the quicklinks folder containing quicklinks you want to update.
2. Click Update Quicklink (

). The Update URL Link Template Quicklinks screen appears.

3. Check the quicklinks you want to update.
NOTE: Check the box in the table header to select or deselect all.
4. In the To: text field, enter the name of the template you want to apply to the selected
quicklinks.
5. Click Update Quicklink (

) to update the changes. A confirmation message appears.

6. Click OK to continue. The selected quicklinks are updated to use the specified template.
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Displaying Content on Your
Website
The following Ektron server controls display HTML content on your website.
l

ContentList—A comma-delimited list of content blocks. See ContentList on page 1708.

l

ContentBlock—One content block. See ContentBlock on page 1701.
IMPORTANT: Starting from release 8.6, these Content server controls were replaced by the
FrameworkUI: <ektron:ContentView> templated server control. If you are already using these
Content server controls, you can continue to do so, but Ektron recommends using current versions
of functionality.

NOTE: On a PageBuilder page, you can insert a content block using the Content Block widget. Also, you
can insert list of content blocks via the Content List widget. See Also: Widget Reference on page 714
The following sections describe displaying content with the ContentList server control. See
ContentList on page 1708 for information about its properties.
This section also contains the following topics.
Using Metadata to Display an Associated Content List
Using the ContentID Property to Display a Content List
Retrieving the XML Structure of a ContentList
Displaying Content Reviews on the Site
Displaying a User Review on the Site
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Using Metadata to Display an Associated
Content List
IMPORTANT: Starting from release 8.6, this functionality was replaced by the
FrameworkUI: <ektron:ContentView> templated server control. If you are already using this functionality,
you can continue to do so, but Ektron recommends using current versions of functionality.
You can use the ContentList server control to display a list of content associated with a given
content item. First, you define a content list in the metadata of a content block. Then, assign
the ID of the content block to the ContentID property and specify a Metadata definition in the
MetaTag property. The ContentList server control pulls information defined in the metadata of
the content to display the list of content.
The following steps show how to use the DefaultContentID and MetaTag properties to create
a content list.
1. In the Workarea, choose Settings > Configuration > Metadata Definition.
2. Click Add Metadata Definition.
3. Enter a title for the data in the Name field. This name is used in the MetaTag property
for the server control.
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4. Fill in all standard fields. The Type must be Content Selector.

5. Click Save.
6. Add the definition to all appropriate folders.
a. Right click a folder and choose View Properties.
b. Click Edit Properties.
c. Click the Metadata tab and check the boxes next to the metadata definition. (You
may have to break inheritance.)
d. Click Update.
7. For each content item to which you want to associate related content, access its
Metadata tab and identify the related item(s). For example, a list of content blocks
associated with motorcycle helmets. You want this list to appear whenever a helmet is
being viewed. To set this up, you would
a. Edit the content block.
b. Click its Metadata tab.
c. Find the metadata definition for the Content List.
d. Click Edit.
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e. Select content for the list and click Insert to display them below.

8. Optionally reorder the list, then click Save.
9. On a Web form in Visual Studio, add the ContentList server control.
10. Set the DefaultContentID property to the content block’s ID.
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11. Add the name of the Metadata field in the Workarea to the MetaTag property.

12. Set other properties using ContentList on page 1708.
13. When the Web form is saved, navigate to the page. The content list appears.

Using the ContentID Property to Display a
Content List
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1. On a Web form in Visual Studio, insert the ContentList server control.
2. Add a comma-delimited list of content IDs to the ContentIds property.

3. Set the other properties as you require.
4. Save the Web form, and navigate to the page. The content list appears.

Retrieving the XML Structure of a ContentList
Retrieving the XML structure of content allows for greater control over developing XSLs. The
following example shows how to retrieve the XML structure.
1. Open a new Web form.
2. Drag and drop a ContentList server control onto it.
3. Add at least one content ID to the ContentID property.
4. Drag and drop a textbox on the Web form.
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5. Set the TextMode property to MultiLine.
NOTE: Set the text box width to at least 400 px.
6. On the code-behind page, add the following line.
Textbox1.Text = ContentList1.XmlDoc.InnerXml

7. Build the project.
8. View the Web form in a browser. The XML structure of the ContentList appears in the
textbox.

Displaying Content Reviews on the Site
1. Drag and drop a ContentReview server control on a Web form.
2. Set the DefaultContentID property to the ID of the content whose reviews will be
displayed. To make the reviews for the content item dynamic, leave DefaultContentID
blank and set DynamicParameter to ID.
3. Set the DisplayXSLT property to Review List. If you want to change the look and feel of
the review list, modify an existing XSL file or create your own. If you modify an existing
XSL, save the modified file with a different name. Then, enter the file path in the
DisplayXSLT property.
4. Set the GetReviews property to Content.
5. Save the form.

Displaying a User Review on the Site
1. Drag and drop a ContentReview server control on a Web form.
2. Set the DisplayXSLT property to Review List. If you want to change the look and feel
of the review list, modify an existing XSL file or create your own. If you modify an
existing XSL, save the modified file with a different name. Then, enter the path to the
file in the DisplayXSLT property.
3. Set the GetReviews property to User.
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4. Set the UserID property to the ID of the user for whom reviews will be displayed. To
make the list of reviews for a user dynamic, leave the UserID blank and set the
DynamicParameter to ID.
5. Save the form.
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Working with Collections
A collection is a list of content links offered to readers of a Web page. The following
illustration shows a collection on a Web page.

You can use a collection to display any listing, such as job postings, press releases, and
knowledge base articles. The following is a collection within Ektron’s Knowledge Base.

This section explains how to find, create, and manage collections. Your system administrator
then creates or updates a Web page to display the collections using the Collection server
control or Collection widget.

Comparing Menu, Collection, List Summary, and
Taxonomy Features
Menu, collection, list summary, and taxonomy features are similar because they let you add a
list of links to a Web page. The following table compares the features to help you understand
which one is best suited to your needs.
NOTE: To implement these features, the assistance of a developer is required.
IMPORTANT: Starting from release 8.6, the ListSummary server control was replaced by the
FrameworkUI: <ektron:ContentView> templated server control. If you are already using the ListSummary
server control, you can continue to do so, but Ektron recommends using current versions of functionality.
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Menu

Display all content in a folder.
As folder’s content changes,
display changes.

Collection

List
Summary

(folder
items
appear on a
menu)

Can display all content in a
folder’s subfolders
Display selected content

Display external hyperlinks

Display library files
Display content summary
(optional)
Display additional content
information:
l

comment

l

last modified date

l

start date

l

end date

l

user who last edited it

l

ID number

l

path relative to your
site’s root

Can be multi-leveled

Main purpose is navigation

Main purpose is classification
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(recursive
folders)

Taxonomy

Finding Collections

Finding Collections
Every collection is assigned to a folder. You can find collections in the following ways.

Finding Collections by their Folder
To find collections in a folder:
1. Click the content folder that contains the collection.
2. If you are using Ektron’s multi-language support features, select the language by
choosing View > Language. See Also: Working with Multi-Language Content on
page 1057
3. Choose View > Collection. The View Collections screen appears.

Finding All Collections
The Content tab has a Collections panel that displays all collections, regardless of folder.
To view all collections in all content folders:
1. From the Workarea, click the Content tab.
2. In the lower left, choose Collections > Collections. The View Collections screen
appears.
3. Select a collection.

If you have a large number of collections, use the screen's Search box to find one.

Creating a Collection
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This section explains how to create a collection in a site that does not support multiple
languages. To create collections in several languages, see Working with a Collection in a
Multi-Language System on page 365.
PREREQUISITES
To create, edit, remove, delete, or reorder a collection, you must have one of these
criteria.
l
l

l

Administrators group member
assigned one of these roles See Also: Defining Roles on page 1120
l
Collection and Menu Admin
l

Collection Admin

l

Folder User Admin

l

Collection Approver

granted Collections permission for the collection’s folder. Permission is granted
on the folder Permission screen > Advanced tab. See Also: Managing Folder
Permissions on page 257

NOTE: Only users assigned to the Administrators group, Collection and Menu Admin role,
Collection Approver, or Collection Admin role can work with Collections via the Collections tab.
Users who do not belong to one of these groups can work with collections (if they have
Collections permission for the collection’s folder) by selecting a folder then New > Collection or
View > Collection.

To create a new collection, use one of these methods. The Add Collection screen appears.
l

l
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To create a collection in a specified folder, navigate to it, and choose New >
Collection.
To create the collection in the root folder, choose Content > Collections >
Collections then click Add.
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l

Hover the cursor over Collections (see red rectangle above), right click the mouse, and
click Add Collection.
Complete the screen using the following information.
o

Title—Assign a unique title to the collection.

o

Template—Enter the default template for the collection. This template displays the
content of the links generated if no template is assigned in the custom function. If
left blank, the links use their respective Quicklinks. See Also: Creating a Collection
on page 357

o

Description—Add a more detailed description for the collection.

o

Include Subfolders—Check if you want to be able to add to the collection content
in subfolders of the collection's content folder.

o

Approval is Required—See Setting Up Collection Approval on page 366

Click Save when finished.
A collection’s folder appears on the Content > Collections > View All Collections
screen, in the Path column. No value (\ ) indicates root folder.

After creating the collection, you typically add content to it. See Creating New Content for a
Collection on the next page and Assigning Content to the Collection on page 361.

Deleting a Collection
1. From the Workarea, go to Content > Collections.
2. Click the collection you want to delete.
3. Click Delete ( ). A confirmation message appears.
Alternatively, hover the cursor over the Collection, right click the mouse, and click
Delete collection name.
If this collection requires approval, and the user who is deleting cannot approve
changes, the following occurs. See Also: Setting Up Collection Approval on page 366
l

The collection’s status changes to Marked for Deletion (M), and an email notification
is sent to all approval users for the collection. One of the approval users must open
the Edit Collection screen and click the Delete or Decline button.
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l

l

If an approval user clicks Delete ( ), the collection is removed from your website.
If an approval user clicks Decline ( ), the user who submitted the deletion is
notified by email but no website changes are made.

NOTE: Any user with permission to edit a collection can perform the undo function until the content
is approved
4. Click OK to proceed.

Creating New Content for a Collection
To create new content while adding content links to a collection:
1. Navigate to the content folder containing the collection.
2. Choose View > Collection. The View Collections screen appears.
Alternatively, choose Content > Collections > Collections.
3. Choose a collection.
4. Accept or change the language.

5. Click Add Items. The Add Items to Collection screen appears, displaying all subfolders
within the selected folder and content in the folder that is not part of the collection.
(Subfolders are available if the Include subfolders checkbox was checked for the
collection.)
Alternatively, hover the cursor over the collection in the left panel, right click the mouse,
and click Add Items.
NOTE: If your collection includes subfolders and you want to add the content to one of them,
navigate to that subfolder. Otherwise, proceed to the next step.
6. Click Add Content (

). The Add Content screen appears.

NOTE: If you are using Ektron’s multi-language support, the content’s language appears next to the
title. The language is derived from the collection’s language and cannot be changed.**
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7. Create the content.
8. Click a workflow option in the Add Content screen, such as Publish. The Add Content
screen closes, and the new content link appears.
9. Check the content you created and other content.

10. Click Add.

Assigning Content to the Collection
After creating a collection, you assign content to it as described in the following steps.
NOTE: When viewing a Collection on the website, a site visitor sees last published version of content. If
it was never published, nothing appears.
1. Navigate to the content folder containing the collection to which you want to add content.
2. Choose View > Collection. The View Collections screen appears.
Alternatively, choose Content > Collections > Collections.
3. Choose a collection.
4. Accept or change the language.

5. Click Add Items. The Add Items to Collection screen appears, displaying all subfolders
within the selected folder and content in the folder that is not part of the collection.
(Subfolders are available if the Include subfolders checkbox was checked for the
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collection.)
Alternatively, hover the cursor over the collection in the left panel, right click the mouse,
and click Add Items.
As another alternative, navigate to a content folder, click items to be assigned, right
click the mouse and select Copy. Then, locate the collection, right click the mouse, and
select Paste Items to Collection.

NOTE: The file types pulldown remembers your most recent choice and can filter which files
appear. You can change the selection if desired.
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6. Check content to add to the collection. You can only add content from the selected folder
or its subfolders. (Subfolders are available if the Include subfolders checkbox is
checked for the collection.)
l
Click a subfolder to view its content.

l

l

To return to the parent folder, click the folder with the up arrow (

l

Navigating between subfolders deselects content.

).

Click Add to add selected content to the collection.

Editing Content in a Collection
1. Navigate to the content folder that contains the collection that you want to edit.
2. Choose View > Collection. The View Collections screen appears.
Or from the Content tab, click Collections.
3. Click the collection whose information you want to change.
4. Select a language.
5. Click Properties (

).

6. Click Edit.
7. Change any field values.
o Title—Assign a unique title to the collection.
o

Template—Enter the default template for the collection. This template displays the
content of the links generated if no template is assigned in the custom function. If
left blank, the links use their respective Quicklinks. See Also: Creating a Collection
on page 357

o

Description—Add a more detailed description for the collection.

o

Include Subfolders—Check if you want to be able to add to the collection content
in subfolders of the collection's content folder.

o

Approval is Required—See Setting Up Collection Approval on page 366

Removing Content from a Collection
1. Navigate to the content folder that contains the collection and click View > Collection.
Or from the Content tab, click Collections.
2. Click a collection.
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3. Click Remove Items (

). The Remove Items from Collection screen appears.

Alternatively, hover the cursor over the Collection, right click the mouse, and click
Remove Items.
4. Check boxes next to content you want to delete.

5. Click Delete.

Reordering a Collections List
After a collection is created, and more than one content item is assigned to it, you can reorder
a collection list as described in the following steps.
1. From the Workarea, go to Content > Collections.
2. Click the collection you want to reorder.
3. Click the Reorder button ( ). The Reorder Collection screen appears.
Alternatively, hover the cursor over the Collection, right click the mouse, and click
Reorder Item.
4. Click the content whose order you want to change.
5. Click the up or down arrow to move the content.
6. When you have the desired order, click Update.

Using a Default Template vs. Quicklinks for a
Collection
You can specify a template that determines the screen display for a collection when it is
published on a Web page. You also can disable the template and, instead, use quicklinks to
determine the page template. (See Also: Viewing Quicklinks or Forms on page 346)
l

If you use quicklinks, every page in the collection uses its original template. As a result,
the surrounding information may change for every content item in the collection.
The following example shows links using Quicklinks. Notice that content uses several
templates. As a result, when a user clicks content in the collection, the screen
information around the content is determined by its template.

364

Ektron Reference

Working with a Collection in a Multi-Language

l

If you use a template, all content in the collection uses the template other than the
specific content. For example, the page header, footer and information in the right
frame of the screen are all the same.
The following example show links when you use a template named index.asp.

NOTE: If a collection item is a form, ekfrm is used instead of id to denote form block.
To toggle between a default template and Quicklinks:
1. Access the Edit Collection screen for the collection you want to edit.
2. Modify the Template field.
3. Click Update.

Working with a Collection in a Multi-Language
System
In a multi-language Ektron system, you can create a language-specific edition of each
collection. When a site visitor selects a language, then navigates to a page with a collection,
Ektron displays the collection in the selected language if available. If not, Ektron displays
nothing.
NOTE: Notice the contrast between the collections and content: if a collection is not available in a
selected language, nothing appears. However, if content is not available in the selected language, content
in the other languages may appear.
IMPORTANT: You can only add content in the language of a collection. So, create content first, then
create a collection that links to it.
When you create a collection for a foreign language, decide from the following:
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l

Create a foreign edition of an existing collection to provide several versions of a single
page that change depending on the language selected by the user.
1. Form the Workarea, go to Content > Collection.
2. Click the Collection that you want to create in another language.
3. From the View drop-down list, select the language of the new collection.
4. Using AddItems, select content to add to the collection. Navigate through the
folders to the content you want to add. You can only add content in the selected
language.

l

Create a new collection in a foreign language to appear only on a foreign language page,
and no other edition of the collection appears on your site.
1. Navigate to the folder in which you will create the collection.
2. Click View > Language and select the language of the collection.
3. Click New > Collection. The Add Collections screen appears.
4. Click Add and enter basic information about the collection.
5. Using AddItems, select the content to add to the collection. Navigate through the
folders to the content you want to add. You can only add content in the selected
language.

Setting Up Collection Approval
If you require a collection to be approved, only the following users have permission to create
or edit a collection and can approve a change to a collection.
l
l

l

a member of the Administrators group
users to whom the Collection Approver role has been assigned and who have permission
to work with the collection
users to whom the Folder User Admin role has been assigned and who have permission
to work with the collection

You can set up an approval system for any collection. As with a content approval chain, you
specify users to approve changes to a collection before it can be published.
l

l

l

While content can have a chain of approvers, a collection has a list of approvers. Any
collection approver can publish or decline changes for a collection.
While content approval is folder-specific, collection approval is not. When set up,
collection approval affects the collection to which it was assigned, regardless of its
folder.
If a user who is not an approver tries to delete a collection, that action also requires
approval.

Only administrators or users to whom the folder-admin role has been assigned see the
Approval is Required checkbox on the Add and Edit Collection screens.
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What Happens when Someone Submits Changes to a
Collection
Whenever anyone changes a collection that requires approval (by adding or removing content
items), the toolbar on the View Collection Screen changes, as shown below.

By default, you only see approved collection items. To see unapproved items, click View
Stage.
After changing a collection's contents, if a user has permission to edit collections but not
approve changes, he sees the following toolbar.
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That user should click Submit ( ). This action triggers an email notification to all approval
users for the collection. It also changes the collection’s status to checked out. No other users
can edit it in this status.
A user with permission to approve changes sees the toolbar below after clicking View Stage.

If the user clicks Publish (

), the new version of the collection is published to your website.

Any user with permission to edit a collection can go to the screen and click Undo Checkout (
) any time before the approval. In this case, the submitted changes are deleted, and the
collection reverts to its original state.
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Working with Metadata
Metadata is information about a content item, such as its title and language. Ektron provides
extensive and flexible support for metadata, which is used in both standard and innovative
ways.
You define metadata in the Workarea at Settings > Configuration > Metadata
Definitions, but you assign metadata in the Content area.
PREREQUISITE
Only Administrator group members and those defined in the Manage Members for
Role: Metadata-Admin screen can view, add, or edit metadata definitions. See Also:
Using the Roles Screens on page 1121
This section also contains the following topics.
Metadata Types
Adding a Metadata Definition
Impact of Changing a Metadata Type
Creating and Deploying a Meta Tag Definition
Creating and Deploying a Title Tag Definition
Creating and Deploying a Search Tag Definition
Creating and Deploying a Related Content Definition
Changing the Style of a Metadata Definition
Assigning Metadata to a Folder
Requiring Users to Enter Metadata
Inheriting Metadata by Folder
Adding Metadata to Content
Applying Content Tags
Assigning an Image to Metadata
Applying Simple Dublin Core Metadata
Working with Templates
Using Templates
Declaring a Template
Adding a Template
Deleting a Template
Updating a Template
Assigning a Template to a Folder
Adding a Template to a Folder
Removing a Template from a Folder
Assigning a Template to Content
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You can add the following kinds of metadata content.

Metadata Types
l

l

Searchable—Metadata that can be found by Ektron’s search and the Workarea Search
screen. Creating and Deploying a Search Tag Definition on page 374
Meta tag—Resides in a content’s source code, helping search engines find it. Creating
and Deploying a Meta Tag Definition on page 372
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HTML tag—Information about content used by a Web browser. For example, <title>
identifies the content in the screen title, favorites list, and browser history. Creating and
Deploying a Title Tag Definition on page 373

l

Related content—A related content item, collection, List Summary, or library item that
accompanies a content item on a Web page. Creating and Deploying a Related Content
Definition on page 375

l

Content tags—Keywords that can be assigned to content and library items. Content
tags allow for tag-based searching. Applying Content Tags on page 380

l

Image—Not part of a metadata definition; automatically appears for every content item
and lets you assign an image to that content. Assigning an Image to Metadata on
page 380

l

Simple Dublin Core—Fifteen standard fields that cover the most useful information
about content. Applying Simple Dublin Core Metadata on page 380

l

BEST PRACTICES
l

l

When anyone creates a new Metadata definition, it is assigned the next available
ID number. The ID numbers determine the order in which metadata definitions
are arranged on the Folder properties screen’s Metadata tab. By planning
ahead, you can enter metadata definitions in logical groupings, which make it
more intuitive for the person assigning the metadata to pick the correct ones.
You can use metadata as a search criterion for your website content, but the
metadata definition name cannot include a space. Eliminate spaces from
metadata definition names.

Adding a Metadata Definition
Use the Add Metadata Definition screen to define metadata (such as keywords and title). You
can define as many instances of metadata as you wish. If your site supports multiple
languages, you create metadata definitions for each supported language.
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IMPORTANT: After creating a definition, you assign it to folders, whose content uses it. See Also:
Assigning Metadata to a Folder on page 377
To add a metadata definition:
1. Settings > Configuration > Metadata Definition. The View Metadata Definitions
screen appears.
2. From the language drop-down, select the primary language of the metadata definition.
You may apply other languages to the definition on the Add Metadata Definition screen.

3. Click Add Metadata Definition. The Add Metadata Definition screen appears.
l
Name—Enter a name to identify this metadata. Do not include spaces. Ektron
reserves a list of names that you cannot use. If you enter one, a message appears.
l

l

Type—Select a metadata type from the drop-down list. The type determines which
fields appear on the lower part of the screen. See Also: Metadata Types on
page 369
Editable—Check this box to allow users to edit metadata when applying it to
content. Do not check this box if you want uniform metadata text for each content
item that uses this metadata.
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l

For documentation of the next screen section, see the selected Type.
o Creating and Deploying a Meta Tag Definition below
o

Creating and Deploying a Title Tag Definition on the facing page

o

Creating and Deploying a Search Tag Definition on page 374

o

Creating and Deploying a Related Content Definition on page 375

4. To let users apply this metadata definition to content in languages other than the primary
one (which you selected in Step 2), check each allowed language.
IMPORTANT: You can apply additional languages only when creating a metadata definition. You
cannot apply them when editing.
5. Complete the fields and click Update.

Impact of Changing a Metadata Type
If you create a metadata definition, assign it to a folder, then users apply metadata
information to content, the information takes on the characteristics of the metadata
definition. For example, if the metadata is title and its type is HTML tag, this is how it
appears in the Web page’s source code.
<title>CMS Developer</title>

If you later change its type to Meta, the following occur:
l

l

metadata to which the definition is already assigned maintains the previous style
definition. For example, <title>CMS Developer</title>.
new content that uses the metadata definition is assigned the new style. For example,
<meta name="title" content="CMS developer">.

NOTE: For background information about metadata, see The Meta Element.
See Also: Changing the Style of a Metadata Definition on page 376

Creating and Deploying a Meta Tag Definition
Copied from www.w3.org/MarkUp/html-spec/html-spec_5.html:
The META element is an extensible container for use in identifying specialized document
meta-information. Meta-information has 2 main functions:
l

l

372

to provide a means to discover that a data set exists and how it might be obtained or
accessed
to document the content, quality, and features of a data set, indicating its fitness for use
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1. Complete the steps in Adding a Metadata Definition on page 370.
2. Complete the Meta Tag description fields.
l
Style—Select from the drop-down list to indicate whether you want the style to be
name or http-equiv. For more information, see The Meta Element
l

l

l

l

l

l

l

Remove Duplicates—Check this box to remove duplicate words or phrases from
the metadata.
Case Sensitive—Check this box to remove duplicates only if the letters and case
of each letter match.
Separator—Enter a character to separate the metadata values. The default is a
semicolon (;).
Selectable Metadata—Check this box to force users to select from the options
specified in the Allow Selectable Text and Default Text fields. If you do not
check this box, users can create their own metadata.
Allow Multiple Selections—Check this box to let users select multiple metadata
values instead of one. If multiple values are allowed, use the separator character to
delimit them. If this box is not checked, all values appears in a drop-down list, and
the user selects the correct one. This field is only active if the Selectable
Metadata box is checked.
Allowed Selectable Text—Enter standard metadata that can be selected by
users. Separate each option by the separator specified for the metadata definition.
This field is only active if the Selectable Metadata box is checked.
Default Text—Enter default content for the metadata tag.

3. Click Save.
4. Add the definition to all applicable folders by editing the properties of the folder and
checking the metadata boxes on the Metadata tab and clicking Update.
5. Edit the metadata on content items in the folder and click Save or Publish.
6. Add a metadata server control to every Web form (.aspx page) on which the content will
appear. See Metadata on page 1793 server control.

Creating and Deploying a Title Tag Definition
Copied from www.w3.org/MarkUp/html-spec/html-spec_5.html.
The title should identify the contents of the document in a global context. A browser may
display the title of a document in a history list or as a label for the window displaying the
document.

1. Complete the steps in Adding a Metadata Definition on page 370.
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2. Enter default content for the HTML tag. For example:
content="document management web content management content management
cms"
3. Click Save.
4. Add the definition to all applicable folders by editing the properties of the folder and
checking the metadata boxes on the Metadata tab and clicking Update.
5. Edit the metadata on content items in the folder and click Save or Publish.
6. Add a metadata server control to every Web form (.aspx page) on which the content will
appear. See Metadata on page 1793 server control.

Creating and Deploying a Search Tag Definition
Searchable metadata allows content to be found by a search phrase that you add to the
content’s metadata. The content is typically found by either a website search or a Workarea
search. For example, each document stored in the Document Management functionality has a
unique part number.
1. Complete the steps in Adding a Metadata Definition on page 370.
2. Complete the Searchable Property description fields.
l
Publicly Viewable—If you check the box, site visitors can find the metadata value
when searching your website. Otherwise, site visitors cannot find the metadata
value.
NOTE: Regardless of whether this is checked, this metadata value can be found using the
Workarea’s Search Content Folder screen. Only logged-in users can access the Workarea.
l
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Style—Select the style of the response field from these choices (available in a
drop-down list). You are specifying the kind of information that a user adding
searchable properties to content will enter to describe the data. Later, anyone using
the search can search on that information.
o Text—The user enters free text to describe the content.
o

Number—The user enters a number to describe the content.

o

Byte—1 byte. 0 through 255 (unsigned)

o

Double—8 bytes. -1.79769313486231570E+308 through 4.94065645841246544E-324 † for negative values; 4.94065645841246544E324 through 1.79769313486231570E+308 † for positive values

o

Float—(single-precision floating-point) 4 bytes. -3.4028235E+38 through 1.401298E-45 † for negative values; 1.401298E-45 through 3.4028235E+38 †
for positive values

o

Integer—4 bytes. -2,147,483,648 through 2,147,483,647 (signed)

o

Long—8 bytes. -9,223,372,036,854,775,808 through
9,223,372,036,854,775,807 (9.2...E+18 †) (signed)

o

Short—2 bytes. -32,768 through 32,767 (signed)

o

Date—The user enters a date to describe the content.

o

Yes or No—The user answers yes or no to describe the content. For example,
if the content describes automobile parts, the user could answer Yes to include
new and used parts or No to search for new parts only.
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l

o

Select from a list—The user picks a from a list to describe the content.

o

Multiple selections—The user selects an item from a drop-down list.

Default—If desired, enter the most common response to this definition. The
default value is automatically applied to all existing content within folders to which
this definition is assigned. While editing content that uses this definition, a user can
accept the default value or change it.

3. Click Save.
4. Add the definition to all applicable folders by editing the properties of the folder and
checking the metadata boxes on the Metadata tab and clicking Update.
5. Edit the metadata on content items in the folder and click Save or Publish. The next
time you visit the Workarea search screen, you will see the new field.
6. If you want site visitors to use this field when searching your website, ask your
developer to set the ShowExtendedSearch property of the Search Server Control to
true. This value enables the website search to find searchable metadata.

Creating and Deploying a Related Content
Definition
You can set up a Web page so that whenever a source content item appears, related
information appears next to it by associating the following types of content with a content
item.
l

another content item

l

a collection

l

a list summary

l

a menu

l

a user

l

image, hyperlink, or file library item

For example, your website sells motorcycle helmets. On a page that shows a particular
helmet, the left column lists a collection of motorcycle drivers who wear that helmet. Another
example might show the profile of a user when a certain content item appears.
Related content lets you connect a content item with several types of related content (see list
above), and is associated with a content item, not a Web form. For example, you can display
a library image of the company logo on a page whenever content in a certain folder appears.
For content in a different folder, a different logo could appear.
NOTE: This capability is similar to the MetadataList Server control except that MetadataList shows a link
to every content item with a selected term in the keywords or title. Also, a MetadataList is associated with
a Web form (.aspx page), not a content item.
To create and deploy a related content definition:
1. Complete the steps in Adding a Metadata Definition on page 370. Choose a type that ends
in Selector.
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2. Add the definition to all applicable folders by editing folder properties, checking
metadata boxes on the Metadata tab, and clicking Update.
3. Edit the metadata of content in the folder (associating related content) and click Save or
Publish. The next time you visit the Workarea search screen, you will see the new field.
4. Have your Web developer add code to each page on which the related item appears.
IMPORTANT: If you are using Collection Selector type, only users with permission to work with
collections can select a collection. Also, if you are using Image, Hyperlink or File Selector type, only
users with permission at least read-only Library permissions can select a library item. See Also: Managing
Folder Permissions on page 257.

Changing the Style of a Metadata Definition
You can change the style of a searchable property type of metadata. For example, you create
a definition to collect Part Number. Originally, the style is text, but you later decide its style
should be number.
When you change the style of searchable property type metadata, Ektron attempts to
maintain data stored in content that uses the definition. For example, if data style was
number but you change it to text, the number stored in that metadata definition is converted
to text and maintained in the content that uses it.
However, sometimes Ektron cannot maintain the data when you change the style. For
example, if you change a metadata definition style from number to date, Ektron cannot
convert those styles, in which case any data stored in metadata definitions is lost. The
following table shows how Ektron handles each conversion scenario.
l

OK—Data is maintained

l

NO—Data is lost during conversion
Text

Number

Date

Boolean

Single Select

Multiple Select

-

OK

OK

NO

NO

NO

OK

-

NO

NO

NO

NO

Text
Number
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Text

Number

Date

Boolean

Single Select

Multiple Select

Date

OK

NO

-

NO

NO

NO

Boolean

OK

NO

NO

-

NO

NO

Single Select

OK

NO

NO

NO

-

OK

Multiple Select

OK

NO

NO

NO

NO

-

When you change metadata definition's style, the screen lets you use existing data (if
possible) or the default value. Following these choices is a field that lets you define a default
value. If you want to replace existing data, select Use default value and enter the new
value in the Default field. If the data is convertible and you want to maintain existing data if
possible, select Use existing data if possible, else default. Then, enter a default value
below.

Assigning Metadata to a Folder
After you create a metadata definition, assign it to folders whose content will use it. To do
that, use the folder’s properties screen's Metadata tab > Assigned boxes to determine
which metadata definitions can be completed by users working with content in the folder.
NOTE: Only metadata definitions created for the language in which you are viewing the folder are
available. Use the language drop-down to choose a language.
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Requiring Users to Enter Metadata
You can require a metadata value to be inserted before content can be saved (see the
Required checkboxes in the illustration above). If applied, the requirement is enforced when
new content is added and existing content is edited. If you set a metadata field to be required,
when an author views on the Edit Content screen's Metadata tab, the metadata's label is red
and includes an asterisk (*).

NOTE: If a default value is supplied for a required metadata field, the default value is used when the user
saves the content. So, the user is not prompted to enter a value.

Inheriting Metadata by Folder
Each folder can inherit metadata fields from its parent folder or have a unique set of them.
The information includes the kinds of metadata that are assigned, and which are required. For
example, you could assign the top folder (Content) all metadata definitions, while you assign
the Contacts folder (directly below it) none. On every folder property’s Metadata tab, use
the Inherit Parent Configuration check box to determine if metadata definitions are the
same as the parent folder or unique. By default, Inherit Parent Configuration is checked,
meaning that the folders inherit their metadata definition from the parent folder. If you
uncheck Inherit Parent Configuration, you can change the settings as desired. All
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inherited values appear by default (that is, Assigned and Required boxes are either
checked or unchecked).

Adding Metadata to Content
When a user creates or updates content, he can define its metadata within the assignments
specified for its folder. Default metadata values are applied without user intervention. To
enter or edit content’s metadata:
NOTE: You may only edit metadata of content that is published, checked in, or checked out by you.
1. Access the Edit Content screen for the content whose metadata you want to enter or edit.
2. Click the Metadata tab. The Edit Metadata screen opens with the current metadata
displayed. To add metadata to content, an administrator must have created definitions
for it in the content's language.
3. Edit the metadata.
l
Required field labels are red and marked with an asterisk (*). You must place at
least one response before you can save.
l

l

l

l

Your system administrator may prevent you from editing a field. In this case, the
field has a gray background, and you cannot place the cursor there.
Fields may appear in 2 columns. In this case, the system administrator provides a
list of terms that you can apply to the content. You can select terms from the list or
enter free text. One column is labeled Not Included and the other Included. Move
terms between lists by clicking Add and Remove.
You may see a list of terms in one box, and a field labeled Text above it. You can:
o add a new term by typing it into the Text field and clicking Add.
o

remove any term by selecting it and clicking Remove.

o

modify any term by selecting it. It appears within the Text field, where you
can change it. Then, click the Edit button.

o

restore the terms to their default settings by pressing the Default button.

o

change the sequence of terms by selecting one then pressing the up and down
arrows.

If related content metadata is available for the content, its name appears followed
by None Selected (ID) ChangeClear. Click Change to display a window of
choices. For example, if the related content type is a collection, all collections
appear in the popup. Select the appropriate data for this content. Selected items
appear in the bottom of the screen. You can reorder them by selecting an item then
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clicking the up and down arrows. To remove items from the bottom of the screen,
select them and click Delete ( ). If the related content type is content item or
library image, hyperlink, or file, a window appears when you click Change where
you can select related content.
1. Select a folder from the left frame.
2. Double click the related-content item from the top right frame. The item
appears in the lower right frame
3. When all items are in the lower right frame, click Save.
l

If default metadata is defined for a specific data type, you can click Default at the
bottom of each field to restore it.

4. Click Save. The View Content screen reappears. The content is now in a checked out
state to you. For the changes to take effect on the website, check in the content and
submit it to the approval chain. See Also: Setting Approval Chains on page 262

Applying Content Tags
Use content tags to apply terms by which you want users to find content when the terms are
not in the content. The search can find content using the tags.
Default content tags appear on the Metadata tab of every content item. Check any tag that
you want to apply to a content item. You can also create a new tag and apply it to a content
item. You cannot reapply that tag to other content. The following example shows Farm, Silo,
and Combine added to the content tags.

Assigning an Image to Metadata
You can assign an image to any content item’s metadata from a standard field that is
available to every content item; it is not a definition in the Metadata fields. Use the Image
field to identify an image that can be retrieved by Ektron Markup Language’s (EkML)
[$Image] and [$ImageThumbnail] variables. See Also: Controlling Output with Ektron
Markup Language on page 1905.
For an example of using Image data, assume that your site promotes a soccer team. A list
summary shows every player on the team. An image appears next to each player’s name.

Applying Simple Dublin Core Metadata
Simple Dublin Core is a set of fifteen standard names for metadata fields designed to cover
the most useful items of information on a document. From the Dublin Core site FAQ: “Dublin
Core metadata provides card catalog-like definitions for defining the properties of objects for
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Web-based resource discovery systems.” For more information, refer to the Usage Guide:
Using Dublin Core.
To generate Dublin Core metadata, set the GenerateDublinCore property to True. This
creates 7 of the fifteen Dublin Core metadata fields. These fields are automatically filled with
the information from the equivalent Ektron property. The following list shows the 7 fields and
their Ektron equivalent. For more information on the Metadata Server Control, see Metadata
on page 1793 server control.
l

DC.title—Content block title

l

DC.description—Plain text version of a content summary

l

DC.contributor—Content block last editor name

l

DC.date—Content block last edit date

l

DC.format—"text/html"

l

DC.identifier—URL of current page (from ASP.NET Server.Request object)

l

DC.language—CMS language cookie / current site language, expressed as a .NET
System.Globalization Culture Name

To fully comply with the Simple Dublin Core metadata element set, the administrator must
create the remaining 8 Dublin Core fields as standard Ektron Metadata definitions and apply
them to all Ektron folders. Next, Ektron users complete the appropriate values for each
content block.
IMPORTANT: When creating the Dublin Core metadata fields in the Metadata section of the Workarea,
you do not need to create the first 7 fields in the table above. In addition, the names of the fields you create
must match the names in the following list. For example, in the name field, enter “DC.subject”. The DC
identifies the metadata as Dublin Core metadata.
These descriptions are from the Dublin Core Metadata Initiative site.
l

l

l

l
l

DC.subject—The topic of the content of the resource. Typically, a Subject is expressed
as keywords, key phrases, or classification codes that describe the topic of the resource.
DC.type—The nature or genre of the content of the resource. Type includes terms
describing general categories, functions, genres, or aggregation levels for content.
DC.source—A reference to a resource from which the present resource is derived. For
example, DC.source=”Image from page 54 of the 1922 edition of Romeo and Juliet”
DC.relation—A reference to a related resource.
DC.coverage—The extent or scope of the content of the resource. Coverage typically
includes spatial location (a place name or geographic co-ordinates), temporal period (a
period label, date, or date range) or jurisdiction (such as a named administrative
entity). Examples: DC.coverage=”1995-1996”, DC.coverage=”Boston, MA”,
DC.coverage=”17th century” or DC.coverage=”Upstate New York”.

l

DC.creator—An entity primarily responsible for making the content of the resource.

l

DC.publisher—The entity responsible for making the resource available.

l

DC.rights—Information about rights held in and over the resource. Typically, a Rights
element contains a rights management statement for the resource, or reference a
service providing such information.
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Working with Templates
As you set up your Ektron website, you create templates for your Web pages. A template
typically includes page headers, footers, and placeholders for content, forms, summaries,
and other page elements. The following image shows a template where the top of the screen
contains headers that appear on several pages. Other areas contain links to Ektron objects,
such as menus and text. A developer can modify content within these areas.

NOTE: To learn more about creating templates, see Creating a New Template in Visual Studio on
page 1609.
This section also contains the following topics.
Using Templates
Declaring a Template
Adding a Template
Deleting a Template
Updating a Template
Assigning a Template to a Folder
Adding a Template to a Folder
Removing a Template from a Folder
Assigning a Template to Content
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Using Templates
Except for your website’s home page, people access your site through hyperlinks. Hyperlinks
can appear within content. They also link content items from list summaries, menus,
collections, and so on. A template defines the place to display the content of a hyperlink. The
following example shows that when a user selects Email, content item (ID 87) displays within
the contactinformation.aspx template.
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Declaring a Template
PREREQUISITE
You must be a member of the Administrators group or in the Manage Members for
Role: Template Configuration screen. See Also: Defining Roles on page 1120.
After creating templates, declare them within Ektron. To do this, go to the Active System
Templates screen, available from Settings > Configuration > Template Configuration.

From this screen, you can add new templates, or delete or update existing ones.

Adding a Template
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1. Within the Workarea, navigate to Settings > Configuration > Template
Configuration.
2. Click Add New Template to System. The Add a New Template screen appears.

3. Enter the path to and name of the new template or click the ellipsis button (
navigate to it.

) and

4. Enter a name and description for the template.
5. Click Add New Template to System.

Deleting a Template
To delete a template, click Delete in the template row.
You can only delete a template if it is not assigned as any folder’s default template. If you
choose a template that is assigned as a default, a screen tells you why you cannot delete it
and lists the folders for which it is the default.

Updating a Template
The update procedures lets you change all references from an old to a new template. For
example, your old template is named MyTemplate.aspx. You can want to replace all
references to it to Updatetemplate.aspx.
1. Within the Workarea, navigate to Settings > Configuration > Template
Configuration.
2. Click the template that you want to update. A new screen appears.
3. Choose the new template file. You may also update the name or description.
4. Click Update Template.
NOTE: This screen has additional fields when mobile device detection is on and mobile configurations
exist. For more information, see Using Mobile Templates on page 136

Assigning a Template to a Folder
Each folder must have at least one template and one template must be chosen as the default.
By default, folders below the root folder inherit a template from their parent. However, you
can assign a unique set of templates to any folder by overriding the default inheritance. To do
this, go to the Edit Folder Properties screen and uncheck the box next to Inherit Parent
Template Configuration.
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When a folder’s default template is changed, existing template assignments remain, but new
content added or moved into the folder assumes the new default template.
If you break template inheritance, inherited templates are initially assigned to the folder. You
can then remove unwanted templates or add new ones. Available templates appear in the
template drop-down list. Select any that you want to be available from the folder and click
Add. (The list of available templates is managed through the Active System Templates
screen.)

Adding a Template to a Folder
1. In the Workarea, navigate to the folder to which you want to apply the template.
2. Choose View > Properties.
3. Click Edit Properties.
4. Click the Templates tab.
5. Uncheck Inherit Parent Configuration.
6. Click the arrow next to Select Template and choose the template you want to apply to
this folder.
7. Click Update.

Removing a Template from a Folder
l

l

If you try to delete a template that is the default for a folder, you are notified that you
must assign a new default to that folder before you can delete it.
If you try to delete a template that is assigned to a content block, you are notified via
the following message If you wish to continue and delete this template, the above
content will be set to their parent folder's default template. Do you wish to continue?

Assigning a Template to Content
A folder’s default template is automatically applied to all content in the folder. However, you
can change a content item’s template to any of those assigned to the folder.
1. In the Workarea, navigate to a content item to which you want to apply the template.
2. From the View menu of the content item, Choose View Properties. The view content
screen appears.
3. Click Edit.
4. Click the Templates tab.
5. Click the arrow next to Template: and choose the template you want to apply to this
content item.
6. Click Publish. The template assigned to the content will be used whenever a hyperlink is
created to it.
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Working with HTML Forms
Ektron provides powerful online form capabilities, letting you create an online dialog with
visitors. Anyone can create and deploy Web forms. A form has the following components.
l

l
l

Form (title, ID number, whether the form data is sent as email, and/or saved to a
database, and so on.)
Content information (title, start and/or end date, status, postback message, and so on.)
Form fields (text field, password field, text area, hidden text, choices, checkbox, select
list, calendar, submit button, and so on.)

By default, form permissions are inherited from a form’s folder. To customize permissions for
any folder that contains forms, access the corresponding folder under Content and assign
permission as described in Managing Folder Permissions on page 257.
Similar to content, users in the administrator user group have full control over form features.
You must be a member of the administrator group to add, edit, or delete a form, or assign
content to a form. You may also perform all actions on a form’s content. Users who are not
members of the administrator user group can add, edit, delete, and restore form content if
granted these permissions for the content folder or item.
This section also contains the following topics.
Creating a Form
Creating Surveys and Polls
Managing Form Responses

386
407
412

Creating a Form
Ektron provides sample forms to start with and then customize. Forms are saved to a
database by default, but not emailed. To change either setting, use the Edit Properties screen.
You should only create HTML forms in a folder whose template uses a FormBlock or Poll
server control. For example, in the OnTrek sample site, the Company folder uses the
company.pb.aspx. template.
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You can modify this template as needed or create a form template and assign it to any folder
through its Folder Properties screen. Because folders inherit properties from their parent
folder by default, new folders created under a parent folder use the correct template. Of
course, you can break inheritance and assign a custom template for any folder. Consult with
your Ektron administrator about the folders in which you should create forms.
To create a new form:
NOTE: You can also create a new edition of a form in another language by copying an existing form and
translating it. For more information, see Translating Content into Another Language on page 296.
1. From the Workarea, navigate to the folder in which you will create the form.
2. From the View menu, click Language, and select the language in which to create the
form.
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3. Click New > HTML Form/Survey. The New Form screen appears.

4. Choose the form that you want to begin with. You can click preview ( ) next to any
sample form to see it before choosing it. Select a sample that most closely matches the
form you want to create. After creating the form, you can add/remove fields, modify
possible responses, and so on.
5. Click Next.
6. Enter or edit the form’s Title and Description.
l
Title—used to reference the form within the Workarea (required)
l
l

Description—an extended description of the form
DxH Mapping—(Appears if DxH is installed and enabled.) Check this box if you
want to map this form to DxH. See Creating a Mapped Form on page 1018.

7. The next screen lets you assign a task to a user or user group. If you do, a task will be
created every time a site visitor submits this form. See Also:
8. A new screen lets you determine what happens after a site visitor completes the form.
The choices are:
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l

Display a message—See
IMPORTANT: If your form/survey/poll uses either Redirect option, your Web developer must
use a FormBlock server control to display this form on a Web page. The Web developer
cannot use a Poll server control when redirecting to an action page.

l

Redirect to form data to an action page—See

l

Report on the form—See

l

Redirect to a file or page—Identify a file or a page on your website that is
launched when the visitor completes the form.
o sample file—a white paper (PDF format)
o

sample page—prompts visitor to download your product

9. After completing the form information, you enter its content.

Creating a Form’s Content
Here is an example of form content that you can create.

Note that some fields are required, and some provide a drop-down list of choices. You can
learn how to create such a form by following the directions below.
The final screen lets you arrange the form fields. Then, add a button that lets the user submit
the data.
NOTE: The form can also contain explanatory text, lines, images, and so on. To lay out fields in columns,
insert a table and place the fields within table cells.
The following list explains each field type you can enter.

Ektron 8.7

389

Managing Content

l

l

l

l

l

l

l

Checkbox—User’s response is either checked or unchecked; see Inserting a
Checkbox Field below.
Text—Free text field; user cannot format text; see Inserting a Text Field on
page 395.
Choices—Several choices appear on screen. User checks any number of
appropriate responses. See Inserting a Choices Field on the facing page.
Calendar—Lets user insert a date by clicking a calendar; see Inserting a Calendar
Field on page 393.
Insert Button—Button with no text. You can easily add text to it. When a site visitor
completing the form presses this button, the data on the screen is submitted to your Web
server. See Inserting Buttons on page 402.
Insert Reset—Button with Reset as its text. When a site visitor completing the form
presses this button, the form’s field values are set to their state when the form first
loaded. See Inserting Buttons on page 402.
Insert Submit—Button with Submit as its text.When a site visitor completing the
form presses this button, the data on this screen is submitted to your Web server. See
Inserting Buttons on page 402.

Next, click Save and Submit or Publish ( ). After you complete and save the form, it may
need to go through the approval process. When that is complete, add it to the site by
assigning it to a page template.

Inserting a Checkbox Field
A Checkbox field is one character wide and is checked or unchecked. For example

To insert a checkbox field:
1. Place the cursor where you want the check box field to appear.
2. Click the Checkbox field button ( ). A dialog box appears.
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l
l

Descriptive Name—Enter a descriptive name for this checkbox.
Field Name—Enter a name for this checkbox. This text identifies the field in the
database and in email (if the form is mailed).
NOTE: You cannot enter spaces nor most special characters (!@#$%^&*()+=<>,.:;’"{}
[]|‘~) into this field. If you do, they are replaced by underscores.

l

l

l

Tool Tip Text—Enter text that appears when a site visitor hovers the cursor over
this field (circled in red below).

Default value—If you want this field to be checked when the screen first appears,
click True. Otherwise, click False. A site visitor can change the default value while
completing the screen.
Caption—Enter text to guide the user’s response to this field. The caption appears
on the screen to the right of the checkbox. To continue the above example, the
caption would be Check if you are over 65.

Inserting a Choices Field
Use a Choices field when you want a site visitor to select from a predetermined list. You can
let a site visitor select only one or more than one choice. You can also determine the list’s
items and appearance.
To insert a choices field:
1. Enter a field label. For example, Country.
2. Click Choices (

l

). The following dialog appears.

Descriptive Name—Enter a description of the field. This text describes the field
on form reports.
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l

Field Name—Enter a name for this field. This text identifies the field in the
database and in email if the form is mailed.
NOTE: You cannot enter spaces nor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~)
into this field. If you do, they are replaced by underscores.

l

Tool Tip Text—Enter text that appears when a site visitor hovers the cursor over
this field (circled in red below).

l
l

l

l

List—One of the following:
o Custom—You create your own set of choices. Use the Item List area to do
this.
o

Languages—A standard list of languages

o

Countries—A standard list of countries

o

U.S States and Territories—A standard list of United States of America
states and territories

o

Canadian Provinces—A standard list of Canadian provinces

o

Age Ranges—A standard list of age ranges

o

Numeric Ranges—A standard list of numeric ranges

o

Years—A standard list of years

o

Gender—Male or female

o

Marital Status—A standard list marital statuses

Allow Selection—Click More than one to let a site visitor select more than one
item for this field. Otherwise, click Only one to limit the user to one choice.
A selection is required—Check this box if the user must select at least one item.
First item is not a valid selection—You can use the first list item to prompt the
user to make a selection instead of being a valid response. For example, the first
item may say Select from the list. To do so, check this box. If you do, the site
visitor must choose any selection except the first item. If the site visitor tries to file
the screen without choosing a different item, this error message appears:First
item is not a valid selection.
This option is only available if Appearance is set to Drop List.

l

Appearance—One of the following:
o Vertical List—arranges choices vertically

o
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Horizontal List—arranges the choices horizontally
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l

o

List Box—displays all choices in a box. If more than 4 choices are available,
the user scrolls to see additional options.

o

Drop List—displays all choices in a drop-down list. When the user clicks the
down arrow, all entries appear.

Item List—This section of the screen displays the list items. It is only editable if the
list type is Custom.
o The Context-Sensitive Menu—Buttons to the left of each item (circled
below) display a menu. The menu lets you remove items, rearrange them, and
insert additional items anywhere on the list.

o

The Selected Box—Place a check in the box of any item to be checked by
default on the data entry screen. If you do, the user can accept the default or
uncheck the item by clicking in the checkbox. Note that if Only One is
selected under Allow selection (above), only one item can be selected. If the
Appearance is set to Drop-Down list, this value is ignored.

o

Display Text—Enter text to describe this item on the data entry screen.

o

Value—Enter the value that is collected when the site visitor selects this item.
For example, if Interests appears in the Name field, and you want music to
be collected when the data entry user selects this item and saves the page,
enter music here.

o

The Disabled Checkbox—Check the box next to any selection that you want
to disable. If you do, the option appears on the form but the user cannot select
it.

o

Option—Click this button to add a row to the bottom of the list.

Inserting a Calendar Field
To insert a field that lets a site visitor select a date, use a Calendar Field. To do that:
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1. Enter a field label. For example, Expiration Date.
2. Click Calendar field (

l

l

). The following dialog appears.

Descriptive Name—Enter a description of the field. This text describes the field on
form reports.
Field Name—Enter a name for this field. This text identifies the field in the database
and in email if the form is mailed.
NOTE: You cannot enter spaces nor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this
field. If you do, they are replaced by underscores.

l

l

l

l

Tool Tip Text—Enter text that appears when a site visitor hovers the cursor over this
field (circled in red below).

Default value—If you want to set a default date, enter it here. The site visitor can
change the default value while completing the screen.
Validation—Select the kind of validation to apply to this field. The choices are:
o No validation—response is not checked
o

Cannot be blank—Response is required. The format of the response is not
checked. If you assign Cannot be blank, the field is surrounded by red dashes
when it appears on your website.

o

Custom—See Custom Validation on page 399

Error Message—Enter text that appears if a site visitor‘s response does not satisfy the
validation criterion. For example, if the validation criterion is Cannot be blank, the
error message could be Please enter a response. By default, the error message is the
same as the validation criterion. Use this field to customize its text.
NOTE: You can only enter double-byte characters if your Windows settings include that language. If
you enter characters that are not in a language defined in your Windows settings, question marks (?)
appear instead of the characters.

l
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l

l

Validation—Select the kind of validation to apply to this field. The choices are:
o No validation—response is not checked
o

Cannot be blank—Response is required. The format of the response is not
checked. If you assign Cannot be blank, the field is surrounded by red dashes
when it appears on your website.

o

Custom—See Custom Validation on page 399

Message—Enter text that appears on the screen if the site visitor‘s response does not
satisfy the validation criterion. For example, if the validation criterion is Cannot be
blank, the error message could be Please enter a response. By default, the error
message is the same as the validation criterion. Use this field to customize it.

NOTE: You can only enter double-byte characters if your Windows settings include that language. If you
enter characters that are not in a language defined in your Windows settings, question marks (?) appear
instead of the characters.
These are the same as Creating a Form on page 386

Inserting a Text Field
Use a text field when you want the user to enter a free text response, or to display text on the
screen. There are many variations you can apply to such a field, such as
l

a default value

l

text can be read-only or hidden

l

the field can expand to accommodate user input

l

validation, requiring user input to meet criteria such as a non-negative whole number or
a zip code

To insert a text field:
1. Enter a field label. For example, Name.
2. Place the cursor where you want the text field to appear.
3. Click Text field (

). The following dialog appears.
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NOTE: If you are using FireFox, you cannot enter text into a text field while creating or editing the form. If
you need to prefill a text field with text, use the field’s Default Value property.
l

l

Descriptive Name—Enter a description of the field. This text describes the field on
form reports.
Field Name—Enter a name for this field. This text identifies the field in the database
and in email if the form is mailed.
NOTE: You cannot enter spaces nor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this
field. If you do, they are replaced by underscores.

l

l

l

Tool Tip Text—Enter text that appears if a site visitor hovers the cursor over this field
(circled in red below).

Default value—If you want to set a default value for this field, enter it here. For
example, if this field collects a city, and most users enter New York, enter New York as
the value. A site visitor can change the default value while completing the screen.
Allow multiple lines—Check this box if you want this field to scroll vertically to allow
the person completing the form to enter as much text as needed.
NOTE: This setting cannot be applied if this is a Password field.

l

l

l
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Cannot be changed—Check this box to prevent the person completing this field from
changing its content. For example, you want to display a license agreement. Below this
field, you might place a check box prompting the site visitor to check it to indicate the
agreement was read. As another example, you could provide instructions for completing
the screen.
Invisible—Check to make this field hidden. This option lets you store unseen
information in each document. An example might be putting a version number on the
form. f you apply this property to a form, the Allow multiple lines and Cannot be
changed fields are automatically checked and cannot be unchecked. Also, the
Validation tab is disabled.
Password field—Use a password field when you want the user to enter a password. A
password is like a text field but the user’s entry is disguised. This prevents an onlooker
from seeing the password. Passwords cannot exceed 18 characters.
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l

l

Validation—Select the kind of validation to apply to this field. See Validation Options
below. Your system administrator determines whether a user can save an invalid
document.
Message—Enter text that appears on the screen if a site visitor‘s response violates the
validation criterion. For example, if the validation criterion is telephone number, the
error message could be Please enter 7 or 10 digits. It would appear if the user
entered, for example, S061882. By default, the error message matches the selected
validation criterion. Use this field to customize the text.
NOTE: You can only enter double-byte characters if your Windows settings include that language. If
you enter characters that are not in a language defined in your Windows settings, question marks (?)
appear instead of the characters.

l

Custom Validation—See Custom Validation on page 399.

Validation Options
NOTE: Your Web developer can customize validation options. For details, see . However, the file that
maintains custom validation is different for HTML forms: it is
siteroot/workarea/ContentDesigner/ValidateSpace.xml.
All of the following options are used with the text field. Only No validation and Cannot be
blank are also used with the calendar field.
l

No validation—Response is not checked.

l

Cannot be blank—Response is required. The format of the response is not checked.

l

l

Allow Maximum of 1000 characters—Response cannot exceed 1000 characters.
(Only available if text field is set to Allow Multiple lines.)
Minimum of 8 characters with at least one digit—Site visitor’s entry must be at
least 8 characters and include one digit. (Only available if text field is set to Password
field.)

l

Non-negative whole number or blank—A positive whole number or no response.

l

Non-negative whole number (required)—A positive whole number.
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l

Decimal number or blank—A decimal number (for example, 12.345 or 12) or blank. A
leading minus sign “-” is allowed. The decimal point must be a period (.), even in locales
that normally use a comma (,).
NOTE: Decimal numbers include whole numbers because the decimal point is implied. That is, 12 is
12.0000.

l

Decimal number required—A decimal number (it cannot be blank) of 0, 1, or 2
decimal places. A leading minus sign “-” is allowed. The decimal point must be period
(.), even in locales that normally use a comma (,).
NOTE: Decimal numbers include whole numbers because the decimal point is implied. That is, 12 is
12.0000.

l

Percent: (0-100) required —A whole number from 0 to 100. A response is required.

l

email address—a@a, where a is one or more characters.

l

l

l

l
l

l
l

l
l

l
l

l

l

l
l

l
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email address required—a@a, where a is one or more characters. A response is
required.
email address list—Several email addresses. Each address’s format is a@a, where a
is one or more characters. The user must separate each address with a semicolon (;).
email address list required—Several email addresses. Each address’s format is a@a,
where a is one or more characters. The user must separate each address with a
semicolon (;). A response is required.
Zip code (US)—5 (nnnnn) or 9 digits. If 9, a dash appears after the fifth (nnnnn-nnnn).
Zip code (US) required—5 (nnnnn) or 9 digits. If 9, a dash appears after the fifth
(nnnnn-nnnn). A response is required.
Social Security (US)—Nine digits in this pattern: nnn-nn-nnnn.
Social Security (US) required—Nine digits in this pattern: nnn-nn-nnnn. A response
is required.
Postal Code (Canada)—ana nan, where a is an alphabetic character and n is numeric.
Postal Code (Canada) - (required)—ana nan, where a is an alphabetic character and
n is numeric. A response is required.
Social Insurance Number (Canada)—A 9-digit number in the format: nnnnnnnnn.
Social Insurance Number (Canada) Required—A 9-digit number in the
format:nnnnnnnnn. A response is required.
Telephone number (US and Canada)—A 7 or 10 digit number in the formatnnnnnnn
or nnnnnnnnnn. The site visitor can insert separator characters, such as dashes (-),
between numbers.
Telephone number (US and Canada) (required)—A 7 or 10 digit number in the
formatnnnnnnn or nnnnnnnnnn. The site visitor can insert separator characters, such as
dashes (-), between numbers. A response is required.
URL—A website address.
ISBN—ISBNis a 10 or 13-digit number that uniquely identifies books and book-like
products published internationally. When printed, the ISBN number is preceded by the
letters ISBN. (Copied from www.isbn.org.)
ISSN—The ISSNis an 8-digit number which identifies periodical publications as such,
including electronic serials. The ISSN takes the form of the acronym ISSN followed by 2
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groups of 4 digits, separated by a hyphen. The eighth character is a control digit
calculated according to a modulo 11 algorithm on the basis of the 7 preceding digits; this
eighth control character may be an “X” if the result of the computing is equal to “10”, in
order to avoid ambiguity. (Copied from www.issn.org.)

Custom Validation
The Text and Calendar field dialog’s Validation tab features a validation area.

The validation feature can ensure the following aspects user input.
l

The data type—the default types are
l
text
l

URL

l

whole number

l

decimal number

l

l
l

floating point number (Floating point includes scientific notation, so is appropriate
for scientific numbers. Decimals usually suffice for business numbers.)
date (calendars only)

The field value has one of the following relationships with another field, a number, or an
expression. The default expressions are
l
between 2 values (either another field or a number that you specify)
l

less than

l

equal to

l

not equal to

l

maximum length (usually for text responses)

NOTE: Your Web developer can customize validation options. For details, see . However, the file that
maintains custom validation is different for HTML forms: it is
siteroot/workarea/ContentDesigner/ValidateSpace.xml.
Your system administrator determines if a user can save the invalid data.
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When the Custom Validation option is selected from the Validation field, the Custom
Validation screen area becomes active.

l

The Data Type field is the value’s basic type, for example, text, number, or URL.

l

The Condition field displays the validation logic.

l

The Examples drop-down list shows validation expressions that you can apply to the
field.

Example of Creating Custom Validation
As an example of custom validation, assume that a field collects telephone numbers, and you
want to make sure the user enters 10 digits. To accomplish this:
1. Insert a Text Field.
2. Complete the Text Field dialog’s General tab.
3. Click the Validation tab.
4. In the Validationdrop-down list, select(Custom).

5. In the Data Type field, select Whole Number from the drop-down list. This ensures
that the user can only enter digits.
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6. Click the down arrow to the right of the Examples field to see sample logic.

7. Click Maximum text length.... This option lets you specify the length of the user’s
response.
8. string-length(.) <= {X} appears in the Condition field.
9. Because you want the user’s input to equal 10, remove the less than sign (<) from the
calculation. Now it looks like this:string-length(.) = {X}.
10. Replace the {X} with 10. Now, it looks like this: string-length(.) = 10.
11. Move the cursor up to the Message field and compose a relevant error message. For
example: must be 10 digits.
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12. Click OK.
Click the Data Style tab to apply formatting to a field that accepts user input.
When you do, the following tab appears.

Use the tab to assign the following formatting attributes to a response field.
l

Font style and size

l

Bold and italic

l

Text alignment (especially helpful for formatting dollar amounts in a plain text field)

l

Underline or strikethrough

l

Font color and/or background color

Inserting Buttons
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A form typically includes one or more buttons, which let a site visitor submit a completed
form.

You can place 3 buttons on a form (circled below).

l

Insert—Submits form information to your Web server. By default, it has no text. To
learn how to add button text, see Editing a Button’s Properties below.

l

Reset—Changes a form’s field values back to their state when the form first loaded.

l

Submit—Submits form information to your Web server. Its default text is Submit.

Editing a Button’s Properties
After you insert a button, you may want to enter or change its properties, such as its text,
height, and width. To edit a button’s properties:
1. Click the button so that it is selected. A selected button is surrounded by small squares,
as shown below. Below the editor screen, several fields appear.

2. Update the button fields as needed.
l
Name—Give the button a unique name.
l

Id—If needed, give the button a unique ID.
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l

Width—Enter or change the button’s width in pixels.

l

Height—Enter or change the button’s height in pixels.

l

Value—Enter or change the button text.

l

l

Tooltip—Enter or change the button’s tooltip (that is, text that appears in a small
window when someone hovers the mouse over the button).
Classname—Enter or change the style sheet class assigned to the button.

Entering Additional Form Information
Link other Ektron content, you use tabs on the Edit Content screen to enter the following
information about the form:
l

Metadata—Working with Metadata on page 369

l

Aliases—Creating User-Friendly URLs with Aliasing on page 835

l

Schedule—Scheduling Content on page 296

l

Comment

l

l

Templates—Be sure to apply a template that uses a FormBlock or Poll server control. For
example, in the OnTrek sample site, the Company folder uses the company.pb.aspx.
template. See Also: Working with Templates on page 382
Map to DxH—Configuring DxH for Mapping Form Data on page 1018

Viewing Form Properties
After a form is created, you can view its information in the Forms folder. To view a form:
1. Access the folder that contains the form you want to view.
2. Click the form you want to view. The View Form screen displays.
3. Click the Form Properties tab.
l
Form Title—Title used to reference the form.
l

FormID—ID number automatically assigned to form.

l

Status—The form’s current status.

l

Description—Extended description for the form.

l

Form Data—The type of form data: Mail or Database.

l

l

Form Submissions—The maximum number of times a user can submit the form.
This is typically used with polls and surveys to limit one user’s influence over the
results.
Assign Task to—Users and groups to whom a task will be automatically assigned
whenever a site visitor completes the form.

l

Content Properties—Displays the properties of the form’s content.

l

Content Title—Title of content associated with form.
NOTE: The content name is the same as the Form name.
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l

Content ID—Content ID number assigned to content.

l

Status—The status of the content.

l

Last Editor—Last user to edit the content.
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l

l

Start Date—Date and time when content will go live on website (if set for future
date).
End Date—Date and time when content will be removed from website (if set for
future date).

l

Action on End Date—What happens to a form when its end date is reached.

l

Date Created—Date and time when content was created.

Editing a Form’s Properties
To update additional form information that does not appear on the View Form screen,
navigate to the form’s View Form screen and click Form Properties (
Properties screen displays a subset of form information.
l
l

l

l

l

l
l

). The Form

Title and Description
Database or Mail—if form data is emailed whenever a site visitor submits it, enter mail
property information.
Autofill form values—checked by default, this allows the form’s fields to fill
automatically when a logged-in site visitor has previously completed the form.
Limit Submission—when checked, you can enter the number of times a user can submit
a form in the Number of Submissions text field.
Assign task to users and groups to whom a task will be automatically assigned whenever
a site visitor completes the form.
Form block’s ID number
Mail properties
l
To—Email address to which the form is sent when submitted.
l

From—Text that appears in the email’s From field.

l

CC—Text that appears in the email’s CC field.

l

Subject—Text that appears in the email’s subject field.

l

Preamble—Beginning text of the email.

l

Send data in XML Format—A green check means email data will be in a
structured XML packet. A red X means the email data will be in a standard mailto
format. For more information, see .

Retrieving an email Address from a Submitted Form
In the Mail Properties section of the Edit Form screen, you can select email addresses
submitted on the form to be inserted into the To, From, and CC Mail Property fields. Instead
of entering a static email address, it can be dynamically retrieved from the user’s form
submission. For example, you want to retrieve the “from” field of an email from the
information a user enters when completing the form. To do this, use the OR to addresses in
field drop-down lists shown below. These lists contain fields that dynamically retrieve data
from the submitted form.
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Note that the To and CC fields can accept fields whose validation type is email address or
email address list. On the other hand, the From field can only accept fields whose
validation type is email address (that is, a single email address).
To set up email address retrieval:
1. Add a form field whose Validation type is Email address or Email address list. The
field prompts the user completing the form to enter an email address. Label the field
something like Enter your email address. If the field allows more than one address,
add on-screen instructions to separate each address with a semicolon (;).

2. Go to the Edit Form screen > Mail Properties section.
3. Move to the field labeled From:.
4. At the drop-down list following OR to addresses in field, select the field you created
in Step 1.
When a user completes the form, the value entered in the field created in Step 1 is used for
the email’s From address.

Retrieving Form Data Into the Subject and Preamble Fields
You can retrieve data from a submitted form directly to the form’s Subject and Preamble
fields. (The subject is a standard mail field, and the preamble is text that appears at the
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beginning of the email.)
For example, the form may provide a list of your products. While the user is completing the
form, the user selects a product that the user is interested in. The product then becomes the
subject line of the email.
NOTE: Because a Textarea field can span multiple lines, it can only be used with the preamble. However,
a plain text field can be used with both the subject and preamble.
To retrieve data dynamically from a form field into the email’s subject line or preamble:
1. Add a form field that collects the information you want to insert into the email’s subject
line or preamble.
2. Go to the Edit Form screen > Mail Properties section.
3. Move to the field labeled Subject or Preamble.
4. At the drop-down list following OR use text in field, select the field you created in
Step 1.

Creating Surveys and Polls
Surveys and polls are a type of form. All of the same functionality is available and applies.
l

l

A survey is usually multiple questions and appears on your site for a longer time than a
poll.
A poll is generally one question and appears on a site for a very short time: an hour or a
day.

Surveys and polls can show ongoing results to site visitors after they submit their answers.
For information about how to display a poll or survey on a website, see Poll on page 1811
server control.
This section also contains the following topics.
Creating a Survey
Creating a Poll
Editing a Poll from a Website
Replacing a Poll from a Website
Editing the Poll Results Bar Chart

407
409
410
411
411

Creating a Survey
NOTE: You can also create a new edition of a survey in another language by copying an existing form and
translating it. For more information, see Translating Content into Another Language on page 296
To create a new survey:
1. From the View menu, click Language, and select the language in which to create the
form.
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2. Click New > HTML Form/Survey. The New Form screen appears.

NOTE: When you choose Standard Poll or Blank Survey, the number of steps in the Forms Wizard
changes from 5 steps to 4 steps. This happens because the Assign Tasks step is removed.
3. Choose Blank Survey. You can click preview (
it before choosing it.

) next to any sample form to preview

4. Click Next.
5. Enter or edit the form’s Title and Description.
l
Title—used to reference the survey within the Workarea (required)
l

Description—an extended description of the survey.

6. Click Next. This screen lets you determine what happens after the site visitor completes
the survey. The choices are:
l
Display a message—See Creating a Postback Message on page 412
l

408

Redirect to a file or page—Identify a file or a page on your website that is
launched when the visitor completes the form. An example of a file is a white paper
(a common file format is .PDF) that the visitor requested. An example of a page is
one that lets the visitor download your product.
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l

l

Redirect to an action page and forward form data—See Redirecting
Form Data to an Action Page on page 414
Report on the form—See Letting Site Users See the Form Results on
page 416

7. Click Next. A screen indicates that you have entered basic information about the survey
and should click Done to enter the survey’s content. This procedure is described in
Managing Form Responses on page 412.

Creating a Poll
The following example shows a poll. Note that when a site visitor hovers over the poll, the
question also appears as Tooltip text.

To create a new poll:
NOTE: You can also create a new edition of a poll in another language by copying an existing poll and
translating it. For more information, see Translating Content into Another Language on page 296.
1. From the View menu, click Language, and select the language in which to create the
poll.
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2. Click New > HTML Form/Survey. The New Form screen appears.

3. Choose Standard Poll. You can click preview (
it before choosing it.

) next to any sample form to preview

4. Click Next.
5. Enter or edit the form’s Title and Description.
l
Title—used to reference the poll within the Workarea (required)
l

Description—an extended description of the poll

6. Click Next. You can add a poll question and up to 8 replies. If you have more than 8
replies, you can add them in the forms editor after clicking Done.
7. Click Next. This screen indicates that you have entered the basic poll information and
should click Done to further edit and view the form’s fields. After clicking Done, the
form editor launches so you can edit existing fields and properties. In addition, you can
set post back and schedule information, add metadata and comments, change the title,
and submit the poll for publication. From this screen, you can add more replies to your
poll by right clicking on the choices field and clicking properties.

Editing a Poll from a Website
410
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WARNING! If you are logged into the site and create a new poll by right clicking on a poll selecting New,
the existing poll is replaced by the new one.
To edit an poll on a website:
1. Click the access point ( ) on the poll you want to change and choose Edit.
2. Make changes to the poll using the Forms editor.
3. Submit the poll to the Approval Process.

Replacing a Poll from a Website
When logged into Ektron, you can right click on a poll and choose New Poll to replace the
current one. The title of the poll, its ID, and properties stay the same. Only the questions and
answers change.
To replace a poll:
1. At the location of the poll, click the access point ( ) and choose New Poll. The
Workarea opens, indicating you are at step 3 of the Poll Wizard.

2. Add a new question to the Question text box.
3. Add possible responses to the Choices text boxes.
4. Click Next.
5. Click Done. The form editor launches, allowing you to edit the fields and properties. In
addition, you can set post back and schedule information, add metadata and comments,
change the title and submit the poll for publication. When published, the updated poll
appears on the site.

Editing the Poll Results Bar Chart
To edit the style and appearance of the bar chart, modify the following files:
l

siteroot/workarea/csslib/reportchart.css

l

siteroot/workarea/controls/forms/HistogramReportPoll.xslt

Those files include extensive comments that explain how to customize the bar chart's
appearance.
NOTE: You cannot edit pie charts.
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Managing Form Responses
This section also contains the following topics.
Applying Validation Rules to a Form
Creating a Postback Message
Specifying Conditional Text in the Postback Message
Redirecting Form Data to an Action Page
Letting Site Users See the Form Results
Chart Types
Viewing Form Reports
Choosing a Format to Display Form Data
Exporting a Form’s Raw Data
Assigning a Task to a Form
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414
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418
421
421

Applying Validation Rules to a Form
You can apply validation rules to text or calendar field types. Validation rules ensure that the
information entered by site visitors meets your criteria. For example, a validation rule
specifies that a response to the Telephone field is 10 digits. If the response does not
conform, an error message indicates the problem. The input must conform before the form
can be submitted.
Validation rules are applied when a site visitor submits an entire form, not when the input is
entered. If an invalid response is found, the error message that you define appears.
The site visitor must change the response to conform to the validation rule; then, the next
field is checked and, if that is invalid, its error message appears, and so on.
NOTE: If you apply validation rules to more than one field, include the field name in the error message. For
example, enter The name field only allows text. This is good practice because error messages only
appear after a form is submitted. If the message does not identify the field, the user may not know which
field needs correction.

Creating a Postback Message
The postback message is HTML content, so can contain text or graphics. Typically, the
message acknowledges a site visitor’s completion of the form. For most sample forms
provided, sample text appears in the editor. Modify it as you wish, using Ektron’s editor to
change the style sheet class, insert library items, and so on. You can also insert fields into the
Postback Message that retrieve form information. For example, your postback message may
be:
Thank you «Full Name» for completing the «[Form Title]».

When the message appears, it looks like this.
Thank you Jay Kohler for completing the breakroom survey.

When you click the Post back message tab and select Display a message, the Merge
Field button ( ) appears on the toolbar.
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When you click that button, a dialog like the one below appears.

The list includes all fields on the form plus the following fields.
l

Form title

l

Form description

l

Date submitted

Click any field to insert it into the form. The postback message retrieves the field's value and
displays it within the message.
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Specifying Conditional Text in the Postback Message
You can apply conditions to any portion (or all) of a postback message. For example, you can
display one paragraph if the user browsing your Web page is using a smart phone, and
different text if the user is not on a smart phone. As another example, you could display a
postback message only if the user is not logged into the website as an Ektron author.
The image below shows the message content after a condition is applied.

To designate a condition within a postback message, select it then click Conditional Section
(

).

Redirecting Form Data to an Action Page
PREREQUISITE
Obtain the folder and hyperlink name from your administrator who set up an action
page.
To redirect submitted form data to an action page:
1. Go to the page on which you determine the form’s response.
2. To modify an existing form, select the form’s folder, then the form. Next, select Edit and
click the Post back message tab.
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3. Select Redirect form data to an action page.

4. Click the icon next to File or page. The Link Manager screen appears.
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5. Fill in the fields and click OK. The hyperlink is inserted.

Letting Site Users See the Form Results
When you create polls and surveys, you can choose to display the results after a site visitors
completes the form. The results can display in the same window or a new window. In
addition, you can choose how to chart the data. See Chart Types below.
To show site visitors poll/survey results:
1. Go to the page on which you determine the form’s response. If this is a new form, it is
page 4 of the Forms Wizard. To modify an existing form, select the form’s folder, then
the form. Next, select Edit and click the Post Back Message tab.
2. Select Report on the form.
3. Choose whether you want the results to appear in the Same Window or a New
Window.
4. Choose the style of the report. (Bar Chart, for example.)

Chart Types
l

l

416

Data Table—Poll/survey answers, with the percentage of users who responded to each
item.

Bar Chart—Poll/survey answers as a bar graph. Provides a quick, visual representation
of responses.
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l

l

Pie Chart—Standard pie chart. Poll/survey answers are color coded, and percentage of
people who chose each answer is shown.

Combined—Combines Data Table and Bar Chart.

NOTE: Data entered into a text box cannot be charted. For example, if one choice in a poll is Other,
and the survey has a text box for site users to enter additional information, the text in the box is not
charted. However, the fact that a user chose Other is charted.

Viewing Form Reports
If a form is set to store data in the database, you can run a report that displays the submitted
data.
To view a form report:
1. Navigate to the folder for which you want to view the report. The View Contents of
Folder screen appears.
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2. Click the form you want to view. (If you do not see your form in the folder, make sure
the Content Type drop-down box is set to All Types or Forms.)
3. Click View Reports (
l

l

l

l

). The View Forms Report screen appears.

Start Date—If desired, specify a start date. The report displays only forms that
were submitted on or after the start date.
End Date—If desired, specify an end date. The report displays only forms that
were submitted on or before the end date.
Report Display—Specify the format to display the report. See Also: Choosing a
Format to Display Form Data below
Select Legacy Report—Specify the version of the form or poll for which to get a
report. Using this option lets you see the results from previous polls and forms.

4. Click Get Result to display the report.

Choosing a Format to Display Form Data
The submitted form data can be viewed in any of these formats.

Table with Totals
The table of values shows the following information for each completed form.
l

a checkbox that lets you delete the response

l

an internal identification number of the response

l

l
l

l

the name of the user who submitted the form, if the user signed in to Ektron beforehand.
If the user did not sign in, anonymous appears.
date response was submitted
The name of each field on the survey
l
under each field name is the submitted response for the each user
the bottom line sums the numerical and percentage totals for each response

The siteroot\Workarea\controls\forms\FormReportTotals.xslt file has a
largeListSize property that affects this report's display. By default, this property's value is
5, but you can change it as desired.
If the number of form responses is less than the largeListSize value, the report lists all
responses. In the sample report above, the question Age range has 3 possible responses:
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l

22-25

l

26-30
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l

31-40

On the other hand, if the number of form responses exceeds the largeListSize value, the
report only displays responses that have data. A response accumulates data when a site
visitor selects it.

Summary of Selected Choices
This format totals, for choice and select type fields, the number of times each choice was
selected. Only choices that were selected at least once appear.

Table of Values
The table of values shows the following information for each completed form.
l

a checkbox that lets you delete the response

l

an internal identification number of the response
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l

l
l

the name of the user who submitted the form, if the user signed in to Ektron beforehand.
If the user did not sign in, anonymous appears.
date response was submitted
descriptive name of each form field appears in the column header; the value entered for
each field appears below the header.

List of Submitted Values
The List of Submitted Values format provides the same information as the Table of Values,
but is formatted vertically rather than horizontally.

Submitted Data as XML
Displays the results of the form in an XML format. The following information is included:
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l

<Title>—title of the form block
NOTE: You can create a new poll question to replace an existing poll question. By default, the poll
still has the same Title, ID, and other properties. You can change the title of a new poll question
when you are editing the poll.

l

<Description>—description of the form

l

<SubmittedData>—information that was submitted

Exporting a Form’s Raw Data
After you run a report, you can export its data to a Microsoft Excel spreadsheet file (.xls) for
further analysis. If a form uses an XML structure, each XML tag becomes a column header in
the spreadsheet.
1. Access the View Form Reports screen for the report you want to export.
2. Click Export Report. A File Download dialog box appears. Choose the option that best
suits your needs.
3. After the data is exported, you can analyze and modify the .xls file.

Assigning a Task to a Form
While tasks typically help Ektron users track content activities, you can also assign a task to
users or user groups whenever a form is submitted.
For example, your website offers a free product demonstration to anyone who completes a
form. Whenever a site visitor submits the form, a task is assigned to your sales department’s
administrative assistant who uses the form information to schedule a demonstration. The
sales manager can review the task history to audit sales leads and ensure demonstration
requests are being handled in a timely manner.
To set up a task that it is assigned to users or groups whenever a site visitor completes the
form:
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NOTE: You should be familiar with tasks before beginning this procedure. See Also: Assigning and
Managing Tasks on page 1027
1. If you are creating a new form, assign the task using the Forms Wizard.
l
If you are editing a form, assign the task on the form’s Edit Properties screen.
l

In either case, you identify only users and groups to whom the task will be assigned
whenever a site visitor completes the form. Ektron assigns the remaining task
information.

2. Complete the form and make it available on your website.
When a site visitor completes and submits the form, Ektron creates a task and assigns it
to users and groups you identified in Step 1. The task created upon form submission has
the following information.
l

Title—Form title, as entered by the author

l

Assigned to—As set up by the user who created or edited the form

l

Assigned by—User who created or last edited form

l

Priority—Normal

l

Task Category—Form Submission Task Category

l

Task type—Form Submission Task

l

Created by—User who created or last edited form

l

State—Not specified

l

Due date—Not started

l

Start date—Not specified

l

Description—Data from form “form name” was received on date time.

l

form description—Name of every field on the form: value submitted by user into
that field

An email is automatically sent to every specified user who has a valid email address in the
User Information Screen. The email’s subject line is the form name. The body of the email
contains a name and a value submitted by the user for each field on the form.
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Working with Smart Forms
Use Smart Form configurations to display, save, and validate the content properly. Smart
Form configurations use XML tags (that are hidden from users) and serve content to various
presentation devices (PDAs, mobile phones, and so on), which saves users from creating
duplicate content. An XML schema validation ensures the accuracy and format of your Web
content, which reduces review and revision time.
PREREQUISITE
Smart Form configurations can be created only by members of the Administrators
group or those defined in Manage Members for Role: Smart Forms Admin screen
Ektron Smart Forms provide the following benefits:
l

Strictly enforce content and page layout with Ektron's editor, XSLT, and WYSIWYG
templates for content contributors

l

Deliver content to multiple devices (for example, PDAs, mobile phones, and so on)

l

Easily share content across B2B transactions

l

Advanced XML authoring: Ektron's highly-acclaimed XML editor lets developers hide XML
tags from content contributors and provides an easy-to-use WYSIWYG editing interface

The following are examples of industries that can benefit from XML Indexing.
l

Health Care—A cardiologist whose practice is located in your city

l

Human Resources—Sick time policy

l

Real Estate—A house with a zip code of 03031 priced under $200,000

l

Hospitality—A hotel in the city

l

Online Retail—Fleece gloves for men

l

Educational—A course in .NET programming

You should use XML content whenever possible because of the following advantages.
l

Standardized format for capturing content
o You can create an XML Smart Form then require anyone creating content in a folder
to use the form. The result is more uniform and consistent information.
o

l

Within an XML Smart Form, you can require authors to complete fields in a
specified format. So, for example, if you want the author to enter a date, XML can
ensure that it’s captured in a standard format. Several standard formats are
provided (email address, zip code), and you can create your own.

Superior control over content display
o Authors contribute XML content but have virtually no control over its format. The
Web administrator determines the format through an XSLT file. By customizing the
XSLT, you can exert maximum control over your website’s appearance.
o

Because one file controls several (even hundreds of) pages, you can update just
that file to efficiently change the look of all pages whose content is based on the
Smart Form.
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l

Improved search capabilities
o Because XML data is captured in individual fields, you can focus a search on
relevant fields. For example, if your XML content captures data about books, you
can place an author search on your website. Because that search only looks through
content in the Author field, it is much faster and returns more reliable results than a
search of HTML content.

This section also contains the following topics.
Accessing Smart Form Configurations
Copying a Smart Form Configuration
Creating a Smart Form Configuration
Editing a Smart Form Configuration’s XSLT
Assigning a Smart Form Configuration to a Folder
Deleting a Smart Form
Deleting a Smart Form Configuration
Searching XML Information
Using Data Field Types
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Accessing Smart Form Configurations
To access the Smart Form section of the Workarea, go to Settings > Configuration >
Smart Form Configuration. The View Smart Form Configurations screen appears.

When you click a Smart Form configuration to view its information, you can do the following:
l

Edit—Edit a Smart Form configuration

l

Data Design—Open Data Designer

l

l

424

Add Smart Form—Create a new Smart Form configuration from scratch or based on an
existing one
View XSLT—Display a Smart Form configuration’s XSLT
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l
l

l

DeleteAssociated Content—Delete content assigned to Smart Form configuration
Delete—Delete Smart Form configuration (only available if no content is assigned to
configuration) See Also: Deleting a Smart Form Configuration on page 438
Back—Return to previous screen

Properties Tab
l

Title—Name given to Smart Form configuration.

l

ID—ID number assigned by Ektron upon creation of the configuration.

l

Description—Detailed description of configuration given by creator or last editor.

If the Smart Form configuration was created using external XML files (instead of the Data
Designer), the following information also appears:
l

Edit XSLT—XSLT applied to the content when being edited.
NOTE: If no edit XSLT is specified, the Edit Data Design option is enabled in the toolbar.

l

l

l

l

Save XSLT—XSLT used to transform the XML created in the editor when the Smart Form
is saved to the database.
Advanced Configuration—XML file that contains display information, schema
validation, and other advanced XML data.
XML Schema—Specify the .xsd file used to validate the XML content that the Smart
Form will be assigned to.
Target Namespace—Specify the default namespace used for outgoing XML.
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Display Information Tab
The display information tab lists the XSLTs that are used when displaying XML in the
respective environment.
l

XSLT1—Display XSLT 1

l

XSLT2—Display XSLT 2

l

XSLT3—Display XSLT 3

l

XSLT (Packaged)—Display XSLT Package (created using the Data Designer)

l

XPaths—Location of the XSLT

NOTE: When a Smart Form configuration is created using the Data Designer, a default display XSLT is
also created which looks similar to the edit XSLT created in the editor. This default XSLT can be applied to
the XML content.
An asterisk (*) denotes a Smart Form's default XSLT.
Preview Tab
The Preview tab displays the XSLT applied to the editor when XML content is created. This is
the XSLT that was created for the Smart Form configuration.

426

Ektron Reference

Copying a Smart Form Configuration

Copying a Smart Form Configuration
If you need to make major changes to a Smart Form configuration, copy it and modify the
copy so that you do not affect the content controlled by the original configuration. To copy a
Smart Form:
1. Choose Workarea > Settings > Configuration > Smart Form Configurations.
2. Click a Smart Form configuration.
3. Click Add Smart Form. The Add Smart Form Configuration screen appears.
4. Specify a Title for the copy of the Smart form and click Add Smart Form. The new title
appears in the Smart Forms list and its description shows that it was derived from an
existing Smart form.
5. Click Update.
6. Design your Smart Form configuration in the Data Designer. See Creating a Smart Form
Configuration on page 430 for information about creating XSLTs using the Data Designer.
7. You are ready to assign the Smart Form configuration to a folder or content item. See
Assigning a Smart Form Configuration to a Folder on page 437 for more information.
A verification button ( ) appears to the right of some fields on the Add Smart Form screen.
After you identify an XSLT or schema, you can click this button to verify that the file exists in
the location specified and contains well-formed XML.
NOTE: The XML Verification feature does not validate the contents of the XML file.
Possible results when clicking the verification button:
l

Verified—File passes all verification parameters.

l

Not Verified—The file either does not exist in the specified location, or does not
contain well-formed XML. Review current settings. Ensure the file is in the proper
location, and that it contains well-formed XML

Adding a Smart Form Configuration Using the Data
Designer
1. Choose Workarea > Settings > Configuration > Smart Form Configurations.
2. Click Add Smart Form. The Add Smart Form configuration screen appears.
3. Enter a Title for the Smart Form configuration and click Save. The Smart Form Data
Designer screen appears.
Ektron 8.7
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4. Design your Smart Form configuration in the Data Designer. See Creating a Smart Form
Configuration on page 430 for information about creating XSLTs using the Data Designer.
5. Click Update.
You are ready to assign the Smart Form configuration to a folder or content item. See
Assigning a Smart Form Configuration to a Folder on page 437 for more information.

Adding a Smart Form Configuration Using External
XML Files
NOTE: If you want users to insert Smart Form information using eWebEdit400, you cannot create or edit
Smart Forms using external files. However, you can access eWebEdit400's source view, paste the
external file's XML, then return to design view.
To add a Smart Form configuration using external XML files:
1. Choose Workarea > Settings > Configuration > Smart Form Configurations.
2. Click Add Smart Form. The Add Smart Form configuration screen appears.
3. Enter a Title for the Smart Form configuration.
4. Click Save. The Smart Form Data Designer screen appears.
5. Click Backarrow ( ) to exit. The View Smart Form screen for the new Smart Form
configuration appears.
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Adding a Smart Form Configuration Using External

6. Click Edit (

). The Edit Smart Form screen appears.

7. Enter the following information.
General Information
l

Title—Name given to Smart Form configuration.

l

ID— (display only)ID number assigned when configuration is created.

l

Description—Detailed description given to configuration by its creator or last
editor.

Editor Information
l

Edit XSLT—XSLT applied to content while being edited.

l

Save XSLT—XSLT used to transform the XML when saved to the database.
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l

Advanced Configuration—XML file that contains display information, schema
validation, and other advanced XML data.

Validation Information
l

XML Schema—The .xsd file used to validate the XML content.

l

Target Namespace—The default namespace used for outgoing XML.

Display Information
l

XSLT1—XSLT 1 applied to XML data when viewed on a device.

l

XSLT2—XSLT 2 applied to XML data when viewed on a device.

l

XSLT3—XSLT 3 applied to XML data when viewed on a device.

l

XSLT (Packaged)—XSLT package applied to XML data when viewed on a device.

NOTE: When a Smart Form configuration is created using the Data Designer, a default XSLT is
created based on the configuration. To learn about modifying the packaged XSLT, see Editing a
Smart Form Configuration’s XSLT on page 436.
8. Specify the default display XSLT for the configuration by clicking the corresponding radio
button.
9. Click Update.

Creating a Smart Form Configuration
For each field on the screen:
1. Insert a field label.
2. Place the cursor at the desired location.
3. Click the button corresponding to the desired field type.
Ektron provides several options that let you insert or edit fields in the editor. Each field type is
described below.
l

Data Field Types (

)

NOTE: For information about these data field types, see Using Data Field Types on page 442.
l

Calculated—Performs calculations using other fields on the screen. See
Calculated on page 443.

l

l

l

Calendar—Lets user insert a date by clicking a calendar. See Calendar on
page 451.
Checkbox—User’s response is either checked or unchecked. See Checkbox on
page 455.
Choices—Several choices appear on screen. User checks appropriate boxes. All
user choices are inserted as values within single XML tag. See Choices on
page 456.

l

l
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Group Box—Groups related fields, which can be surrounded by a box and have
a caption. See Group Box on page 460.
Image Only—Lets user insert an image. See Image Only on page 471.
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l

l

Link Field—Lets user insert a link to a file, such as a PDF document. See Link
on page 473.
Resource Selector—Lets user place content or folders on a Smart Form. See
Resource Selector on page 476.
IMPORTANT: You can place content from folders of the following types on a Smart Form:
standard, root, site, blog, and eCommerce catalog. You CANNOT place content from
Community, Discussion Board, or WebCalendar folders on a Smart Form.

l

l

Tabular—Same as group box, but fields can be presented in a table format. See
Tabular Data on page 481.
Text—Lets user insert and format free text using editor See Text on page 485.

l

Check Compatibility—Checks the design against existing data.

l

Field Properties—Lets you change a field's properties. Select field then click this
button. This option is also available on the right click menu.
View Data as...

l
l

The XML data document
- <root>
- <Information>
<LastName />
<FirstName />
<MiddleName />
<Gender>male</Gender>
<Address />
<city />
<state>MA</state>
<Zip />
<SSN />
<BDate />
<HomeTel />
<WorkTel />
<x-ray />
- <Dental_Insurance>
<Field1 />
<OtherInsurance>N/A</OtherInsurance>
<Account_Number>N/A</Account_Number>
</Dental_Insurance>
<medication />
<lastAppointment />
<clincal />
</Information>
</root>

l

The structure, content, and semantics of an XML document
<xs:schema elementFormDefault="qualified"
attributeFormDefault="unqualified"
xmlns:xs="http://www.w3.org/2001/XMLSchema">
<xs:element name="root">
<xs:complexType>
<xs:sequence>
<xs:element name="Information">
<xs:complexType>
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<xs:sequence>
<xs:element name="LastName">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:minLength xmlns:xs="http://www.w3.org/2001/XMLSchema" value="1" />
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="FirstName">
<xs:simpleType>
<xs:restriction base="xs:string">. .. ..
l

A list of all fields and information about them (as XML)
<fieldlist>
<field name="LastName" datatype="string" basetype="text"
xpath="/root/Information/LastName" title="Last Name">Last Name</field>
<field name="FirstName" datatype="string" basetype="text"
xpath="/root/Information/FirstName" title="First Name">First Name</field>
<field name="MiddleName" datatype="string" basetype="text"
xpath="/root/Information/MiddleName" title="Middle Name">Middle Name</field>
<field name="Gender" datatype="choice" basetype="text"
xpath="/root/Information/Gender" datalist="IDAPK3KC">Gender</field>
. .. .. ..

l

xpath information for any indexed field on the screen
<indexable>
<xpath type="string">/root/Information/SSN</xpath>
<xpath type="string">/root/Information/HomeTel</xpath>
<xpath>/root/Information/WorkTel</xpath>
</indexable>

l

The Data Design document’s presentation XSLT
<xsl:stylesheet version="1.0"
xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:output method="xml" version="1.0"
omit-xml-declaration="yes" indent="yes" encoding="utf-8" />
<xsl:strip-space elements="*" />
<xsl:variable name="ektdesignns_fieldlist"
select="/*/ektdesignpackage_list/fieldlist" />
- <xsl:template match="/" xml:space="preserve"> <p> </p>
- <fieldset id="Information" title="Demographic Information">
<legend>Patient Information</legend>
- <div>
- <p> <strong>Last Name</strong> <xsl:text> </xsl:text>
<xsl:value-of select="/root/Information/LastName" />
<strong>First Name</strong>
<xsl:text> </xsl:text>
<xsl:value-of select="/root/Information/FirstName" />
.. .. ... ..

l

Validate—Validates data when previewing data entry. This button is available in data
entry and data design modes.

Buttons at the bottom of the Data Designer screen let you edit the content several ways.
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l
l

l

Data Design mode —lets you insert and remove fields from the screen.
XML mode—lets you edit the XML source code. If the edited source XML is not wellformed, you are notified and must remain in source view until you fix it.
Data Entry mode— simulates the screen’s appearance during data entry.

To edit any field's properties, select it, right click the mouse, and select Field Properties.
You also can use Ektron’s rich formatting capabilities to design the screen. For example, you
can format text, and use tables, images and hyperlinks to guide the user through the data
entry process. The following sample screen was created with the Data Designer.

Creating a Simple Data Entry Screen
The following example shows how to create a simple data entry screen that has a group box
with 2 text fields and a choices field.

PREREQUISITE
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You must be a member of the Administrators group or a Smart Form administrator.
See Also: Defining Roles on page 1120
1. Workarea >Settings > Configuration > Smart Form Configurations.
2. Click Add Smart Form.
3. Assign the form a title and click Save. For example, Sample Smart Form. The screen
refreshes and the editor appears.
4. Click Group Box (

).

5. Type Address in the Descriptive Name, Field Name, and Caption fields and click
OK. The Address group box appears on the form.
6. Click in the Address box and type the label "Street: " then click Text Field (

).

7. Type Street in the Descriptive Name, Field Name, and Tool Tip fields and click OK.
The text field box appears on the form inside the Address group box.
8. Under the Street label, type the label "City: " then click Text Field (

).

9. Type City in the Descriptive Name, Field Name, and Tool Tip fields and click OK.
The text field box appears on the form inside the Address group box.
10. Under the City label, type the label "State:" then click Choices Field (

).

11. Type State in the Descriptive Name, Field Name, and Tool Tip fields.
12. Choose U.S. States & Territories from the List menu.
13. Click OK. The field box appears on the form inside the Address group box.

Inserting a Conditional Section
You can specify a field or group of fields to appear on a Smart Form configuration only under
certain conditions. For example, a Winter outdoor image does not appear until November,
and drops off on April 1. As another example, one group of fields appears if the user is using a
mobile device (such as a smart phone), and a different set of fields appears if the user is not
on a mobile device.
1. After you insert the fields on a Smart Form configuration, click Conditional Section (
). The Conditional Section dialog appears.
2. Specify the condition. The Examples pull-down has sample conditions that you can
insert then modify.
—Examples—
l

l

l

l

The user is viewing the Web page on a Smart Phone
$deviceConfiguration = 'Smart Phones'
The user is viewing the Web page on a device that is not a smart phone
not($deviceConfiguration = 'Smart Phones')
The user is viewing the Web page on January 1, 2011 or later
$currentDate >= '2011-01-01'
The person viewing the Web page is a logged-in Ektron user
$userId != '0'

Use xpath to build the expression. For example, $deviceConfiguration = 'Smart
Phones'. You can click View Data as Index ( ) to see the configuration's xpath
structure.
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NOTE: Developers can modify the examples by editing
workarea/ContentDesigner/ConditionalExamples.xml.
3. Select a variable to replace. For example, select X.

4. Select a field from the lower section of the dialog. For example, select Smart Phones.
5. Click Replace field in Condition.

The expression looks like this: $deviceConfiguration = 'Smart Phones'
l
l

You cannot apply a conditional section to a rich area field.
You can only apply a conditional section to a Smart Form configuration. You cannot apply
a conditional section to Smart Form content created from a configuration. But, authors
working that content see conditions
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Editing a Smart Form Configuration’s XSLT
Every Smart Form configuration has a packaged XSLT, which is a default XSLT created from
the configuration’s display information. To modify the Smart Form’s appearance:
1. Go to Settings > Configuration > Smart Form Configurations.
2. Click the Smart Form configuration whose XSLT you want to customize.
3. Click View XSLT (

).

4. Select and copy the XSLT and paste it into an XSLT editor.
5. Customize the file.
6. Save it with an .xslt extension to your site root/xmlfiles folder.
7. Return to the Smart Form configuration you selected in Step 2 and click Edit.
8. In the XSLT1 field, enter the Xslt you saved in Step 6.
9. Click the radio button next to XSLT1.
10. Click Update.
You can edit the custom XSLT at any time. The changes immediately affect the appearance of
the Smart Form on your website. So, the XSLT is quite different from other aspects of the
Smart Form configuration, which generally cannot be edited for existing content.
To view a Smart Form's XSLT, click ( ). The View XSLT screen appears. You can use this
information to create your display XSLT.
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Assigning a Smart Form Configuration to a
Folder
If you break inheritance on the Smart Forms tab of a folder properties screen, you can select
the Smart Form configurations to be assigned to content in the folder.

l

To preview a Smart Form, click Preview (

l

To add any Smart Form, select it from the drop-down list and click Add (

l

To remove a Smart Form, click Remove.

l

).
).

You can require a Smart Form to be the only type of content that can be added within a
folder by checking the box next to Require Smart Forms. If you do, the user can only
choose enabled Smart Forms when viewing that folder’s New menu—all other content
types are suppressed.

Deleting a Smart Form
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You may delete a Smart Form in the same way that you delete other content. See Deleting
Content on page 291.

Deleting a Smart Form Configuration
You can delete a Smart Form Configuration only if no content is assigned to it. If no content is
assigned, click Delete ( ) to delete a configuration.
If content is assigned, you must first delete all assigned content.

Deleting Assigned Content
PREREQUISITE
You have permission to delete the assigned content. See Also: Managing Folder
Permissions on page 257
1. From the Smart Form Configuration screen, click Associated Content (
the Delete Contents of Smart Form screen.

) to access

2. Delete content assigned to the Smart Form.
3. The Smart Form Configuration screen appears. Click Delete ( ) to delete the
configuration.

Searching XML Information
XML indexing lets site visitors search XML information collected from Smart Forms and view
the results. The results appear as a list of topic titles, optionally followed by the content
summary. The Ektron Windows Service manages the background processing that creates XML
indexes. See Also: Ektron Windows Service on page 1877.
There are 2 ways that XML indexing can make XML content available to your site visitors.
l

l

Present a screen of search criteria. A site visitor uses the screen to select the desired
kind of information. For example, your site sells outdoor clothing, and a user searches
for wool hats under $20.00.
Determine the search and display criteria programmatically using a custom function.
Your Web developer inserts a control that specifies search and display criteria. For
example, your site sells books. A site visitor sees a navigation link Find books under
$5.00. When the link is clicked, the control searches your XML content and returns all
books whose price is less than $5.00.

You can choose the XML fields to index with the Data Designer. You can also validate those
fields to be numbers, dates, Boolean, or string values. After you identify fields to be indexed,
a search dialog is created. Where appropriate, the dialog automatically populates drop-down
lists from the indexed data.

Important Notes:
l
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XML indexing is only available for information collected on XML Smart Forms. It cannot
find information in other types of content.
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l

l

l

Ektron content has a Content Searchable check box, which you must check if you want
the Index Search to find Smart Form content. See Also: Ensuring Your Content is
Searchable on page 942
Do not insert a calendar field into a Smart Form that allows multiple entries (using the
Allow more than One option on the dialog). If you do, you cannot search the Smart
Form using that field.
For Smart Form fields to searchable, they must be stored as elements not attributes.If
you are upgrading to version 7.5 or higher, inspect your Smart Forms and change field
properties as needed so they are stored as elements not attributes.

This section also contains the following topics.

Setting up a Search
To create a search:
1. Select a Smart Form.
2. Assign indexing to each field to be searched. You can index the following types of fields:
Checkbox, Plain Text, Choices, List, Calculated, Image Only, Link, Calendar.
a. Choose Workarea > Settings > Configuration > Smart Form
Configuration.
b. Select a Smart Form configuration that you want to index and open its Data Design.
c. Move the cursor to the first field you want to index, right click the field, and choose
Field Properties. A dialog box appears.
d. Check Indexed.
e. Repeat these steps for every field by which you want site visitors to search the
Smart Form.
IMPORTANT: If a Smart Form configuration field's xpath exceeds 64 characters, Microsoft
Search Server 2010 cannot search it. So, if you need to index such a field, reduce the length of
its xpath to less than 64 characters.
To see a configuration's XPaths, click the Display Information tab.
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3. Set up the search screen.
l
Xpath—The xpath to each indexed field.
l
l

Label—The index field’s field name, as defined on its dialog.
Multiple—Check this box if you want to allow the user performing the search to
select more than one value. This checkbox only appears with List and Choice fields.

4. When you save a Data Design form, a dialog appears that lets you view all and modify
indexed fields.

l

Xpath—The xpath to each indexed field.

l

Label—The index field’s field name, as defined on its dialog.

l

Multiple—Check this box if you want to allow the user performing the search to
select more than one value. This checkbox only appears with List and Choice fields.

NOTE: To select more than one value on the search screen, the user holds down the Ctrl key while
selecting additional options.
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If you choose NoSelection in a search field, the search disregards that field when compiling
results. However, you must select a value (or range of values) in at least one field to get
results.
NOTE: The IndexSearch server control has been deprecated. Use the XML Search server controls to
display a Smart Form’s search screen on a Web form. If you are already using the IndexSearch server
control, you can continue to do so, but Ektron recommends using current versions of functionality.

Validation
Validation ensures that the user completing an XML form enters the right type of data. You
can decide if the user’s input should be a number, boolean, date, string, zip code, and so on.
If you do not specify type attributes using validation data, the field is a string.
Validation is especially important when users search XML data, because it helps the search
find the correct information. For example, if a field collects a zip code but you set its type to
plain text, a user completing the form can insert anything into the field. If the user inserts the
letter “o” instead of the number zero (0), the field accepts that input but the search will not
find that record. On the other hand, if you set validation to zip code, the user can only insert 5
or 9 digits—any other entry is rejected.

User- versus Developer-Selected Search Criteria
There are 2 ways that XML Indexing can make XML content available to your site visitors.
l

l

Present a screen of search criteria. A site visitor uses the screen to select the desired
kind of information. For example, your site sells outdoor clothing, and a user searches
for wool hats under $20.00.
Determine the search and display criteria programmatically using a custom function.
Your Web developer inserts a control that specifies search and display criteria. For
example, your site sells books. A site visitor sees a navigation link Find books under
$5.00. When the link is clicked, the control searches your XML content and returns all
books whose price is less than $5.00.

NOTE: The Ektron Windows Service manages the background processing that creates XML indexes.
See Also: Ektron Windows Service on page 1877.
Ektron content has a Content Searchable check box, which must be checked if you want the Index
Search to find Smart Form content. See Also: Ensuring Your Content is Searchable on page 942

Types of SearchCriteria
XML Indexing allows multi-dimensional searches on all types of XML data.
l
l

l

Plain text—Use an exact phrase, or any word or letter in a phrase
Numerical and date information—Use expressions such as greater than, less than,
or between 2 values
List and choice fields—Display the field values and let the user select relevant ones.
NOTE: Choices field values can consist of single letter.

l

Image Only—Use the alt or src attribute value

l

Link—Use the text or href attribute value
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For every search field, NoSelection is a value. If this is chosen, the search disregards that
field when compiling results. However, the user must select a value (or range of values) in at
least one field to get results.
IMPORTANT: Do not insert a calendar field into a Smart Form that allows multiple entries (using the
Allow more than One option on the dialog). If you do, you cannot search the Smart Form using that field.
For Smart Form fields to searchable, they must be stored as elements not attributes. If you are upgrading
to version 7.5 or higher, inspect your Smart Forms and change field properties as needed so they are
stored as elements not attributes.

Specifying Which XML Elements are Indexed
XML indexing allows multi-dimensional searches on all types of XML data.
l
l

l

Plain text—Use an exact phrase, or any word or letter in a phrase
Numerical and date information—Use expressions such as greater than, less than, or
between 2 values
List and choice fields—Display the field values and let the user select relevant ones.
Choices field values can consist of single letter.

l

Image Only—Use the alt or src attribute value

l

Link—Use the text or href attribute value

If a Smart Form configuration field's xpath exceeds 64 characters, Microsoft Search Server
2010 cannot search it. So, if you need to index such a field, reduce the length of its xpath to
less than 64 characters. To see a configuration's XPaths, click the Display Information tab.

Using Data Field Types
You can insert the following data field types into a data entry screen.
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IMPORTANT: For Smart Form fields to searchable, they must be stored as elements or attributes not
content.If you are upgrading to version 8.5 or higher, inspect your Smart Forms and change field
properties as needed so they are not stored as content.
This section also contains the following topics.
Calculated
Using the Formula Field
Formula Example Descriptions
Calendar
Creating a Custom Validation
Checkbox
Choices
Creating a Custom Choice List
Creating a Custom List in Configuration File
Creating a Dynamically Populated Choice List
Group Box
Group Box General Tab
Group Box Advanced Tab
Group Box Relevance Tab
Image Only
Link
Resource Selector
Tabular Data
Text
Adding Standard Validation Options
Creating Custom Validation Criteria
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461
463
465
471
473
476
481
485
488
488

Calculated
Use a calculated field to perform a calculation based on values in other fields. For example, if
your screen collects mortgage information, you could create one field to collect the mortgage
and interest payment and another to collect taxes and insurance. The calculated field could
sum those 2 numbers and display the monthly payment.
You can validate a calculated field. For example, you can require a positive number between
100 and 1,000.
Calculated fields are display only.
IMPORTANT: If a field is referenced in a calculation, use validation to require a value. This forces the
user to enter a number used in the calculation.
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l
l

l
l

l

l
l

l

Descriptive Name—Enter the name of the field.
Indexed—Check if you want to index this field. For more information, see Searching
XML Information on page 438. The Indexed field may or may not appear, depending on
how your administrator has set up your system.
Field Name—Enter the field’s element name. This defines the field in the XML.
Tool Tip Text—Enter the text that appears when a user hovers the cursor over this
field.
Formula—Enter the calculation that this field will perform. See Also: Using the Formula
Field on the facing page
Select Field—Click this button to select a field to reference in the calculation.
Examples—Click the down arrow next to this field to see sample calculations. If you
select an example, it is copied into the Formula field. See Also: Formula Example
Descriptions on page 447
Validation—Select the kind of validation to apply to this field. Your choices are:
l
No validation—the user’s response is not checked
l

444

Non-negative number (required)—the result of the calculation must be a
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positive number
l

Custom Validation—See Creating Custom Validation Criteria on page 488

If you assign any value other than No validation, the field is surrounded by red dashes
in Data Entry mode. If the user’s response does not meet the validation criteria, the field
remains surrounded by red dashes. Your system administrator determines if a user can
save a screen with invalid data.
l

l

Error message—If you select Non-negative number, insert text that appears on the
screen if the user’s response does not meet this criterion.
Data Style tab—You can specify the following data styles:
l
Font style and size
l
l

Bold and italic
Text alignment (especially helpful for formatting dollar amounts in a plain text
field)

l

Underline or strikethrough

l

Font color and background color
NOTE: The configuration data controls a command's appearance on the toolbar and on the
Data Style dialog. For example, if <button command="cmdfontname" /> is removed
from configdatadesign.xml, it disappears from the toolbar and the Data Style dialog.

l

Advanced tab—This is the same as the Group Box Advanced Tab on page 463.

Using the Formula Field
1. Copy a sample calculation into the Formula field by clicking the Examples field.
2. Select an operation from the drop-down list. For example, if you click Examples Add 2
numbers {X}+{Y}, {X}+{Y} appears in this field.

3. Replace the variables with fields on the screen. Be sure to select the curly brackets ({})
with the letter between them. Then, when the user enters data into those fields, the
calculation is performed using the current field values.
4. Select the first variable to replace. To continue the example, select {X}.
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5. Select a field to replace that variable in the calculation.

6. Click Replace X in Formula.
7. Replace all variables in the formula.

Important information about calculated variables
l
l

l

l
l

If the user does not replace all variables, validation will fail.
If a variable appears more than once in a formula (for example, {X} * number({X}<=
{Y}) + {Y} * number({X}>{Y}), you only need to replace the first occurrence—the
editor replaces subsequent occurrences for you.
If a calculated field tries to perform a numerical calculation with a value that is blank or
contains letters, NaN appears in the field. (NaN stands for “not a number.”)
If a calculated field tries to divide by zero, Infinity appears.
If an XML document contains several occurrences of a field that is referenced in a
formula, the value is derived as follows:
l
When using the XPath functions sum() and count(), all values with the field name
are considered. For example, a document includes 3 books whose prices are $10,
$20 and $30. In this case, sum’s value is $60.
l

l

l

l

l

You can replace a variable with a number instead of a field. For example, replace
{X} * {Y} with ../price * 1.15.
The expression can be complex, such as
(round(Field1 * 0.80) + (1 div Field2)) - 2.
You can use a string expression that creates a text message. For example, to calculate a
full name from its parts: concat( title, ' ', givenname, ' ', familyname), which
could produce “Dr. Jonathan Smythe”.
A calculated field can only reference other calculated fields that appear before it in a
document. For example, a document collects a series of numbers.
l
One calculated field counts the number of numbers.
l
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When using all other functions, the first value is used. For example, a document
includes 3 books whose prices are $10, $20 and $30. If a calculation formula refers
to <price>, its value is $10.

Another totals their values.
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l

A third computes the average by dividing the total by the count.

In this example, you must place the third field below or to the right of the first 2 fields.
Calculated fields that are defined later in a document do not appear in the Select Field or
Group dialog.

Formula Example Descriptions
These formulae appear in the Examples drop-down list of the Calculated Field dialog. Your
system administrator can customize the list.
Example Field
Text

Example Field Formula

Description

Add 2 numbers

{X} + {Y}

Add the value in the first field (X) to the value
in the second field (Y).

Subtract 2 numbers

{X} - {Y}

Subtract the value in the second field (Y) from
the value in the first field (X).

Multiply 2 numbers

{X} * {Y}

Multiply the value in the first field (X) by the
value in the second field (Y).

Divide 2 numbers

format-number({X} div
{Y},'0.###')

Divide the value in the first field (X) by the
value in the second field (Y).
Determine what percentage one number (X)
is of another (Y).

Format as a
percentage

format-number({X} div
{Y},'#0%')

Absolute value of a
number

{X} * (number({X} > 0)*2-1)

The number regardless of the sign (negative
or positive).

Minimum of 2
numbers

{X} * number({X} <=
{Y}) + {Y} * number({X} > {Y})

The smaller of 2 field values.

Maximum of 2
numbers

{X} * number({X} >=
{Y}) + {Y} * number({X} < {Y})

The larger of 2 field values.

Zero if subtraction is
negative

({X} - {Y}) * number(({X} - {Y}) >;
0)

Subtract one number (Y) from another (X). If
the difference is less than zero, insert zero.

For example, if {X}=10 and {Y}=100, the
result of the calculation is 10%.
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Example Field
Text

Example Field Formula

Description

X is a numeric field.
Y is another numeric field to multiply by X if a
checkbox is checked.
Multiply by another
number if checkbox
is checked

{X} * ( {Y} * number
( {Z} ='true') +
number( {Z}
!='true'))

Z is the checkbox.
For example, {X}=2 and {Y}=3
l

l

Round a decimal
number

Round up a decimal
number

round({X})

ceiling({X})

if the checkbox is checked, the result is
2 * 3, which is 6
If the checkbox is not checked, the
result is 2

Rounds the number to the nearest integer.
For example, round(3.14). The result is
3.
Returns the smallest integer that is greater
than the number. For example, ceiling
(3.14). The result is 4.
For negative numbers:
ceiling(-3.14) = -3

Round down a
decimal number

floor({X})

Returns the largest integer that is not greater
than the number argument. For example,
floor(3.14). The result is 3.
For negative numbers:
floor(-3.14) = -4
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Format decimal
number 0.00

format-number({X},'0.00')

Total numeric
values from multiple
fields

sum({X}[text()] |
{Y}[text()] | {Z}[text()]))
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Rounds a value either up or down to the
hundredth place. As examples, 100 becomes
100.00, and 3.14159265 becomes 3.14.
Add the values in all referenced fields.
Only elements that contain a value are
summed. Empty elements are excluded.

Formula Example Descriptions

Example Field
Text

Example Field Formula

Description

Total all values in a single repeating field.
Here’s an example.
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole number
XML Data
Total a list of
numeric values

<root>
sum({X}[text()])
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>
sum(Miles) equals 89+12+23+19=143
Only elements that contain a value are
summed. Empty elements are excluded.
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Example Field
Text

Example Field Formula

Description

Calculate the average of all values in a single
repeating field.
To continue the example from the Total a list
of numeric values field:
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole number
XML Data
Average a list of
numeric values

format-number(sum({X}[text()])
div count({X}),'0.###')

<root>
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>
Average=89+12+23+19=143
divided by the number of values (4)= 35.75
Only elements that contain a value are
summed. Empty elements are excluded.
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Example Field
Text

Example Field Formula

Description

Calculate the number of values in a single
repeating field.
To continue the example from the Total a list
of numeric values field:
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole number
Count the number of
values in a list

count({X})

XML Data
<root>
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>
Count = 4

Lowercase text

translate
({X},'ABCDEFGHIJKLMN
OPQRSTUVWXYZ',
'abcdefghijklmnopqrstuvwxyz')

Replace all uppercase characters with the
lowercase version of that character

Uppercase text

translate({X},'abcdefghijklmn
opqrstuvwxyz',
'ABCDEFGHIJKLMN
OPQRSTUVWXYZ')

Replace all lowercase characters with the
uppercase version of that character

Remove extra
spaces

normalize-space({X})

Remove extra space characters from
content\

Concatenate text

concat({X}, ', ', {Y})

Link text strings together into a single string.
For example, concat('The','
','XML') yields The XML.

Size of a text string

string-length({X})

Count the number of characters in a selected
field’s value. For example, if the referenced
field’s value is Hello, string-length = 5.

Calendar
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Insert a calendar field when you want a Smart Form to include a date field. You may use the
current date or click one from a calendar. Because users cannot enter digits, a standard date
format is ensured. The date is stored as a standard XML date (in the format yyyy-mm-dd),
and localized to the computer of the user viewing it.

l
l

l
l

l

Descriptive Name—Enter the name of the field.
Indexed—Check if you want to index this field. For more information, see Searching
XML Information on page 438. The Indexed field may or may not appear, depending on
how your administrator has set up your system.
Field Name—Enter the field’s element name. This defines the field in the XML.
Tool Tip Text—Enter the text that appears when a user hovers the cursor over this
field.
Default value—If you want this screen to have a default date when the user first sees
it, click the calendar icon to the right and select a date. The user can change the date in
Data Entry mode. Check Default to Current date if you want to use the date on which
the content is created or edited.
NOTE: If you enter a default date, you cannot later remove it. You can change it. If necessary, you
can delete the field and enter a new one.

l

Use—Click May not be removed if this field must be included on the screen.
Otherwise, click May be removed.
If you check May be removed, when this field appears on a data entry screen, an icon
( ) appears to the left of the field. If the user clicks the icon, a drop-down menu
provides an option to remove the field.
If the user removes the field, field name replaces the field on the data entry screen to
indicate that the field was removed and can be re-added if necessary. For example, if
the field’s display name is street address, and the user removes the field,
appears in place of the field.
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NOTE: The menu icon ( ) can also indicate that the user can add instances of a field (see the
Allow field). So, if a field is required, the icon could appear but omit a Remove option.
l

Allow—Check more than one if you want to let the user entering data add instances of
this field. Otherwise, check only one. For example, if a screen is collecting names and
addresses and you want to let the user enter several of them, check more than one. If
you check More than one here, you are allowing the user to insert an entirely new
table, not an additional table row.
IMPORTANT: Do not insert a calendar field into a Smart Form that allows multiple entries (using
the Allow more than One option on the dialog). If you do, you cannot search the Smart Form using
that field.
If the user entering data clicks , a menu appears, which lets the user click Duplicate
to add instances of the field to the screen.
NOTE: The menu icon ( ) can also indicate that the user can remove a field (see the Use field).
So, even if a field allows only one instance, the icon could appear but the menu would only display
Remove.

l

l

l

Validation—If you want to require the user using the calendar to enter a response, click
the down arrow to the right of this response field and select Cannot be blank. You can
also choose a date in the past/future option or Custom.
Error Message—If you select Cannot be blank, insert text that appears on the screen
if the user’s response does not meet this criterion.
Custom Validation—You can ensure the user’s input is greater or less than the date
you are inserting on the Data Design screen.
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l

Message—displays in Data Entry mode when the user inserts an invalid value. Your
system administrator determines if a user can save the invalid data.

l

Data Type—shows Date.

l

Condition—displays the validation logic.

l

l

l

Examples—drop-down list shows validation expressions that you can apply to the
field.
Select a Field to Insert area—displays fields that can be inserted into the
Condition field. You must choose a calendar type field (note the calendar icon to
the left of these fields).
Data Style tab—You can specify the following data styles:
l
Font style and size
l
l

Bold and italic
Text alignment (especially helpful for formatting dollar amounts in a plain text
field)

l

Underline or strikethrough

l

Font color and background color
NOTE: The configuration data controls a command's appearance on the toolbar and on
the Data Style dialog. For example, if <button command="cmdfontname" /> is
removed from configdatadesign.xml, it disappears from the toolbar and the Data Style
dialog.

l

Advanced tab—This is the same as the Group Box Advanced Tab on page 463.

Creating a Custom Validation
As an example of custom validation, assume a field collects the date when a patient’s health
insurance policy expires. You want to make sure the date is later than today. To accomplish
this:
1. Create a calendar field that prompts for today’s date.
2. Create another calendar field that prompts for a patient’s health insurance policy
expiration date.
3. While creating the second field, in the Validation section, click Custom Validation.
The Custom validation screen appears.
4. Click the down arrow to the right of the Examples field to see sample logic.

5. Click Date After (not(. >={X}). This option lets you specify that the user’s response
must be later than a specified date.
6. In the Condition field, select {X} and click the Select Field button. The Select Field or
Group screen appears.
7. Select the field that prompts for today’s date, which you created in Step 1. That field
replaces {X} in the Condition field.
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8. Move the cursor to the Error Message field and compose an error message. For
example: Must be after today. Your screen should look like this.

9. Click OK.
10. Click OK to save that dialog and test the validation on the date field. To do this, switch to
Data Entry mode and enter a date earlier than today to verify that validation works as
expected.

Checkbox
A Checkbox field is only one character wide and accepts one of 2 possible values: checked or
unchecked. For example:
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l

Descriptive Name—Enter text to guide the user’s response to this field. To continue
the example, the caption would be Check if you are over 65. After you insert this field
onto the screen, the Descriptive Name appears to the right of the checkbox. You can use
the editor's formatting capabilities to modify its size, font, color, and other attributes.
NOTE: The Descriptive Name field only appears on this dialog when you create the Check Box
field. If you later try to edit the field, it is not on the dialog. However, you can edit the Descriptive
Name text within the editor.

l

Indexed—Check if you want to index this field. See Also: Searching XML Information on
page 438. The Indexed field may not appear, depending on how your administrator set
up your system.

l

Field Name—Enter the field’s element name. This will define the field in the XML.

l

Tool Tip Text—Enter text that appears when a user hovers the cursor over this field.

l

l

l

Default value—If you want this field to be checked when the screen first appears, click
True. Otherwise, click False.
Validation tab—You can use this screen to specify if the checkbox must be checked or
unchecked.
Advanced tab—This is the same as the Group Box Advanced Tab on page 463.

Choices
Use a Choices field to give a data entry user several options. For example, you create a
Choices field named Interests that lists these options. The data entry user could check the
first 2 and leave the third blank.
l

music

l

art

l

sports

You can do the following with a Choices field.
l

Limit a user’s response to one item, or allow more than one.

l

Require a response.

l

Determine the list’s appearance.

l
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Choose from a standard list of choices (such as Languages, Countries, and so on) or
create your own list.
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l
l

l
l

l
l

Descriptive Name—Enter the name of the field.
Indexed—Check if you want to index this field. For more information, see Searching
XML Information on page 438. The Indexed field may or may not appear, depending on
how your administrator set up your system.
Field Name—Enter the field’s element name. This defines the field in the XML.
Tool Tip Text—Enter the text that appears when a user hovers the cursor over this
choice list.
List—Select from a standard list or choose Custom to create your own.
Allow selection—Click More than one to let the data entry user select more than one
item on the data entry screen. Otherwise, click Only one. For example, if you click
More than one, and the choices are: music, art, sports, the user could select all 3
choices.
l
A selection is required—Check this box if the user must select at least one list
item.
l

First item is not a valid selection—Check here if the first list item is text that
prompts the user to respond to the field. An example of such text for a list of states
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is Select a state. If you check this box and the user selects the first value on the
list (most likely by default), an error appears when he tries to save the screen.
l

Appearance—Determine the style of list.
List type

l
l

l

Example

Description

vertical

All choices appear, arranged vertically.

horizontal

All choices appear, arranged horizontally.

list box

All items appear. The default one is selected when the screen first
appears, but can be changed.

drop list

Only the top item appears. To its right, a down arrow appears
(circled). The user clicks the arrow to display all items and select
one.

Item List—See Creating a Custom Choice List below.
Value—Enter the value collected when a data entry user selects this item. For example,
if Interests appears in the Name field, and you want music to be collected when the
data entry user selects this item and saves the page, enter music here.
Data Style tab—You can specify the following data styles:
l
Font style and size
l
l

Bold and italic
Text alignment (especially helpful for formatting dollar amounts in a plain text
field)

l

Underline or strikethrough

l

Font color and background color
NOTE: The configuration data controls a command's appearance on the toolbar and on the
Data Style dialog. For example, if <button command="cmdfontname" /> is removed
from configdatadesign.xml, it disappears from the toolbar and the Data Style dialog.

l

Advanced tab—This is the same as the Group Box Advanced Tab on page 463.

Creating a Custom Choice List
To create your own set of list options, accept the List field’s default value, Custom. Then,
enter the list values using the Item List section of the screen.
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To indicate an option is the default choice, check the Selected checkbox.
l

l

In the Display Text field, enter text to describe this item on the data entry screen.
After you insert this field onto the screen, you can format it. For example, you can apply
bold, assign a style, and so on.
In the Value field, enter the value that is collected when the data entry user selects this
item.
For example, if Interests appears in the Name field, and you want music to be collected
when the data entry user selects this item and saves the page, enter music here.

To add a new choice, delete an existing choice, or move a choice up or down within the list,
click the menu icon ( ) next to that choice. Then select a menu option.

Creating a Custom List in Configuration File
Although you can create a custom list of choices using the Item List area of the Choices Field
dialog, that list is only available in that field of that screen. If you want to insert the same list
in another section of the screen or a different screen, you must re-enter all options. However,
if you create a list according to the following steps, your custom list is stored in the
configuration file (along with the standard choice lists, such as Countries). As a result, any
user connected to your server can insert the list into any Choices Field on any screen.
To insert a custom list of choices:
1. Open the Ektron configuration file,
siteroot/workarea/contentdesigner/DataListSpec.xml.
2. Insert the new list following the pattern of the other lists in the file, like the following
list.
<datalist name="MyNewList">
<schema datatype="string" />
<item default="true" value="Green" />
<item value="Red" />
<item value="Blue" />
</datalist>

NOTE: You can specify a data type of value: string, nonNegativeInteger, date, decimal. You also
can specify a default value (as shown in the third line).

Creating a Dynamically Populated Choice List
You specify the elements of the custom options list described in the configuration data. You
can also create a dynamically-populated list from any XML source. The source can be on your
server or on a remote website. Follow these steps to add a dynamic data list to the Choices
field.
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1. Open the Ektron configuration file,
siteroot/workarea/contentdesigner/DataListSpec.xml.
2. Insert the new list following the pattern of the other lists in the file, like the following
list.
<datalist name="MyNewList">
<schema datatype="string" />
<item default="true" value="Green" />
<item value="Red" />
<item value="Blue" />
</datalist>

3. Insert a new datalist item according to this pattern.
<datalist
name="MyNewList"
src="{url to xml data source}"
select="{xpath to data item element}"
captionxpath="{relative xpath to data item's display text}"
valuexpath="{relative xpath to data item's value}">

IMPORTANT: The datalist name must match the listchoice data attribute.
For example
<datalist
name="USPS-CA"
src="[eWebEditProPath]/uspsca.xsd"
select="/xsd:schema/xsd:simpleType/xsd:restriction/xsd:enumeration"
captionxpath="xsd:annotation/xsd:documentation"\
valuexpath="@value"
namespaces="xmlns:xsd='http://www.w3.org/2001/XMLSchema'"
validation="select-req">

In this example, the data list is stored in the uspsca.xsd file, located within the ewebeditpro
folder. However, it could be in any XML data source.

Group Box
A Group Box field lets you group related fields together by surrounding them with a box and
optionally placing a caption above them. After you insert a Group Box field, to insert other
kinds of fields within the box, place the cursor inside the box then select a field type button.
NOTE: The tabular data field type might better accommodate your needs. See Tabular Data on page 481.
Grouping fields in Data Entry mode lets you add another instance of a group. For example, if a
screen collects information about each telephone call, you can click Insert Below to insert a
new group of fields, ready to collect information about the next call.

Use the eyeglass icon to expand or collapse fields within a group.
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You also can suppress a group of irrelevant fields. For example, assume a screen includes 2
groups of fields that collect information about hardcover and paperback books. When adding
information about a hardcover book, you can collapse paperback book questions because
they are not relevant.

Group Box General Tab
l

l
l

Descriptive Name—Enter the name of this field, which is used internally as the field’s
caption. By default, the Data Designer assigns a name made up of Field followed by the
next available number. So, the first field’s default name is Field1, the second field’s
default name is Field2, and so on. You can change the default if you want.
Field Name—Enter the field’s element name. This defines the field in the XML.
Use—Click May not be removed if this field must be included on the screen.
Otherwise, click May be removed.
If you check May be removed, when this field appears on a data entry screen, an icon
( ) appears to the left of the field. If the user clicks the icon, a drop-down menu
provides an option to remove the field.
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If the user removes the field, field name replaces the field on the data entry screen to
indicate that the field was removed and can be re-added if necessary. For example, if
the field’s display name is street address, and the user removes the field,
appears in place of the field.
NOTE: The menu icon ( ) can also indicate that the user can add instances of a field (see the
Allow field). So, if a field is required, the icon could appear but omit a Remove option.
l

Allow—Check more than one if you want to let the user entering data add instances of
this field. Otherwise, check only one. For example, if a screen is collecting names and
addresses and you want to let the user enter several of them, check more than one. If
you check More than one here, you are allowing the user to insert an entirely new
table, not an additional table row.
IMPORTANT: Do not insert a calendar field into a Smart Form that allows multiple entries (using the
Allow more than One option on the dialog). If you do, you cannot search the Smart Form using that
field.
If the user entering data clicks , a menu appears, which lets the user click Duplicate
to add instances of the field to the screen.
NOTE: The menu icon ( ) can also indicate that the user can remove a field. So, even if a field
allows only one instance, the icon could appear but the menu would only display Remove.

l

l

Appearance—Click Show border and caption if you want to surround the fields in
this group with a box. You can also create a caption to appear in the top line of the box.
Click No border if you do not want to surround the fields in this group with a box.
Caption—If desired, enter text to describe this group of fields on the data entry screen.
For example:

After you insert this field onto the screen, you can use the editor's formatting capabilities
to modify its size, font, color, and other attributes.
NOTE: The Caption field only appears on this dialog when you create the Group Box field. If you
later try to edit the field, the Caption field is not on the dialog. However, you can edit Caption text
within the editor.
l

Advanced Tab—See Group Box Advanced Tab on the facing page.

l

Relevance—See Group Box Relevance Tab on page 465.

Using a Tag Other Than <Root>
By default, Ektron surrounds your Data Design with <root> tags. To replace <root> tags with
another element name:
1. After creating a new Data Design screen, insert a Group Box as the first field.
2. In the Group Box dialog’s Field Name field, enter the root text.
3. On the Group Box Dialog box, click the Advanced tab.
4. In the Root tag section, select Use this element as the Root tag and press OK.
5. Place all other screen elements within the Group Box field.
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Group Box Advanced Tab
The Advanced tab lets you generate XML microformats made up of standard XHTML tags and
attributes that contain a specific structure and values.
For example, the microformat of an event looks like this.
<span class="event">
<a class=
"url" href="https://www.lisa.org/events/2006nyc/
package_registration.html?from=fn1206 ">
LISA Global Strategies Summit</a>
</span>

NOTE: If the element is a group box or table, its type must be Element because it surrounds other
elements. If the element is a Rich Area field, its type must be Element or Content.
l

l

Element—A unique tag. The user’s response to the field becomes its value.
<Lastname>Rogers</Lastname>
Attribute—An attribute of the containing field. The containing field is typically a Group
Box. If you insert an Attribute field type, the Field Name field on the dialog box is
grayed out. The field name and type can only be edited on the Advanced Field properties
screen.
<PtInformation Lastname="Rogers">
</PtInformation>

l

Content—The content of the containing field, typically a Group Box. Note that, in this
case, field name is not used (it's is grayed out). The field name and type can only be
edited on the Advanced Field properties screen. Because most fields define their own
content, this option is typically used to define a value to a Group Box that contains other
fields defined as attributes.
NOTE: Only one Content type field is valid within a containing field.
<PtInformation>
Rogers
</PtInformation>

Data Entry View
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Data Design View

Replacing the XML <Root> Tag
By default, Ektron surrounds your Data Design with <root> XML tags. You can replace the
<root> tags with another element name by following these steps.
1. After creating a new Data Design screen, insert a Group Box as the first field.
2. In the Group Box dialog box Field Name field, enter the root text. For example, "state"
to replace <root> with <state>.
3. Click the Advanced tab.
4. In the Root tag section of that screen, select Use this element as the Root tag and
click OK.
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5. Place all other screen elements within the Group Box field.

Group Box Relevance Tab
The Relevance tab allows a group of fields to appear or disappear according to the value of
other fields in the configuration. It appears on both the Group Box and Tabular Data Box
dialogs.
Here are some example uses.
l
l

l

Questions about pregnancy that appear only if the patient is female.
A list of states that appears only if the user selects United States as the person's
country.
A list of car manufacturers. When a user chooses one, all of its models appear in a
second list.

Fields that can be Used in Relevance Conditions
Only the following field types can be used in a Relevance condition.
l

Check box

l

Text

l

Calculated

l

Choices

NOTE: If using a Choices field, in the Appearance area of the dialog, you can only choose List Box or
Drop Box. Vertical List and Horizontal List are not supported.
To apply relevance to a Group Box field:

Applying Relevance to a Group Box Field
1. Edit a Smart Form configuration in Data Design mode to which you want to apply
Relevance.
2. If necessary, insert the field(s) on which the group box’s appearance depends.
3. Insert a Group Box field. See Also: Group Box on page 460
NOTE: The location of the Group Box field is independent of the location of the fields to which you
will apply conditions.
4. Click the Group Box dialog’s Relevance tab.
5. The Relevance tab appears.
6. Scroll through the list of sample conditions to determine which one best fits your
situation.
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7. Select a field from the lower half of the screen to replace the first variable (X or Y) in the
condition. For example, if the condition is A checkbox field is checked ({X} =
'true'), click the check box field whose value must be true for this group to appear.
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Applying Relevance to a Group Box Field

8. Click Replace {X} in Condition.
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9. Notice that, in the Condition field, the variable was replaced by the selected field.

10. If the condition has another variable, repeat Steps 7 and 8.
11. Click OK.
You should switch to Data Entry mode and test the Relevance conditions.

Example of Applying Relevance to a Group Box Field
Assume you want a list of states in the United States to appear only if a user selects United
States from the Country field.
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Example of Applying Relevance to a Group Box

To accomplish this:
1. Create a Choices field and assign it 3 values:
l
United States
l

Canada

l

Other

See Also: Choices on page 456
2. Create a Group Box field and name it States.
3. With that Group Box field, create a new Choices field.
l
Name it US States.
l

In its List field, select U.S. States & Territories.

l

In Allow Selection, check First item is not a valid selection

l

In the Appearance field, select Drop List.
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4. Click OK. The field appears on the form.

5. Place the cursor on the States Group Box field and click Group Box.
6. Click its Relevance tab.
7. Pull down the Examples list.
8. Click A field has a given value ({X} = 'value').
9. Scroll through the lower half of the screen until you see the country Choices field.
10. Click Replace '{X}' in Condition. Notice that the Condition field now reads
/root/Country = 'value'.
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11. In the Condition field, replace Value with United States.

IMPORTANT: The text that replaces Value must exactly match the desired value of the selected
field.
12. Click OK.

Image Only
Use an Image Only field to place an icon on the screen, which the user can click to insert an
image into the content. You can insert a default image if desired. To let the user insert any
file, such as a Microsoft Word document, use a Link on page 473 field.
In Data Entry mode, the image’s caption appears, followed by a default image (if you specify
one) and this icon:
NOTE: The user can only insert a file whose extension is defined within the <validext> element of the
configdataentry.xml file. Your system administrator can help you do this.

Ektron 8.7

471

Managing Content

l
l

l
l

l

Descriptive Name—Enter the name of the field.
Indexed—Check if you want to index this field. For more information, see Searching
XML Information on page 438. The Indexed field may or may not appear, depending on
how your administrator has set up your system.
Field Name—Enter the field’s element name. This defines the field in the XML.
Tool Tip Text—Enter the text that appears when a user hovers the cursor over this
field.
Use—Click May not be removed if this field must be included on the screen.
Otherwise, click May be removed.
If you check May be removed, when this field appears on a data entry screen, an icon
( ) appears to the left of the field. If the user clicks the icon, a drop-down menu
provides an option to remove the field.
If the user removes the field, field name replaces the field on the data entry screen to
indicate that the field was removed and can be re-added if necessary. For example, if
the field’s display name is street address, and the user removes the field,
appears in place of the field.
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NOTE: The menu icon ( ) can also indicate that the user can add instances of a field (see the
Allow field). So, if a field is required, the icon could appear but omit a Remove option.
l

Allow—Check more than one if you want to let the user entering data add instances of
this field. Otherwise, check only one. For example, if a screen is collecting names and
addresses and you want to let the user enter several of them, check more than one. If
you check More than one here, you are allowing the user to insert an entirely new
table, not an additional table row.
IMPORTANT: Do not insert a calendar field into a Smart Form that allows multiple entries (using
the Allow more than One option on the dialog). If you do, you cannot search the Smart Form using
that field.
If the user entering data clicks , a menu appears, which lets the user click Duplicate
to add instances of the field to the screen.
NOTE: The menu icon ( ) can also indicate that the user can remove a field. So, even if a field
allows only one instance, the icon could appear but the menu would only display Remove.

l

Value—Whether the value is an element or plain text.
o Value is an element renders the field as <img src=”url” alt=”text” /> for an
image.
o

l

Value is plain text renders the field as just the url.

Default Image Location—If desired, you can insert a default image, which might be
the most common image or a reminder that an image needs to be inserted. To find the
image, click From File and navigate to image file. The image file's extension must
appear between the <validext> tags in the configdatadesign.xml file. For example:
<validext>gif,jpg,png,jpeg,jpe,doc,txt
</validext>

l
l

l

Cannot be blank—To require the user to enter a response, check this box.
Description—Enter the image’s alt text, which is used as a replacement for an image
whenever it cannot be seen. For example, a visually impaired person is using a screen
reader.
Data Style tab—You can specify the following data styles:
l
Font style and size
l
l

Bold and italic
Text alignment (especially helpful for formatting dollar amounts in a plain text
field)

l

Underline or strikethrough

l

Font color and background color
NOTE: The configuration data controls a command's appearance on the toolbar and on the
Data Style dialog. For example, if <button command="cmdfontname" /> is removed
from configdatadesign.xml, it disappears from the toolbar and the Data Style dialog.

l

Advanced tab—This is the same as the Group Box Advanced Tab on page 463.

Link
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Use a Link field to place an icon on the screen. A user in Data Entry mode can use the icon to
link to any Library file, such as a Microsoft Word document or a .gif image file. (You can also
use an Image Only field to let the user insert an image. See Also: Image Only on page 471)
The File Link field does not let you link to Ektronassets.
In Data Entry mode, the file link field’s caption appears, followed by this icon: . When the
user clicks the icon, a hyperlink screen prompts you to specify information about the link.
NOTE: Only insert a file whose extension is defined within the <validext> element of the
configdataentry.xml file. Your system administrator can help you do this.

l
l

l
l
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Descriptive Name—Enter the name of the field.
Indexed—Check if you want to index this field. For more information, see Searching
XML Information on page 438. The indexed field may or may not appear, depending on
how your administrator has set up your system.
Field Name—Enter the field’s element name. This defines the field in the XML.
Tool Tip Text—Enter the text that appears when a user hovers the cursor over this
field.

Ektron Reference

Link

l

Use—Click May not be removed if this field must be included on the screen.
Otherwise, click May be removed.
If you check May be removed, when this field appears on a data entry screen, an icon
( ) appears to the left of the field. If the user clicks the icon, a drop-down menu
provides an option to remove the field.
If the user removes the field, field name replaces the field on the data entry screen to
indicate that the field was removed and can be re-added if necessary. For example, if
the field’s display name is street address, and the user removes the field,
appears in place of the field.
NOTE: The menu icon ( ) can also indicate that the user can add instances of a field (see the
Allow field). So, if a field is required, the icon could appear but omit a Remove option.

l

Allow—Check more than one if you want to let the user entering data add instances of
this field. Otherwise, check only one. For example, if a screen is collecting names and
addresses and you want to let the user enter several of them, check more than one. If
you check More than one here, you are allowing the user to insert an entirely new
table, not an additional table row.
IMPORTANT: Do not insert a calendar field into a Smart Form that allows multiple entries (using
the Allow more than One option on the dialog). If you do, you cannot search the Smart Form using
that field.
If the user entering data clicks , a menu appears, which lets the user click Duplicate
to add instances of the field to the screen.
NOTE: The menu icon ( ) can also indicate that the user can remove a field. So, even if a field
allows only one instance, the icon could appear but the menu would only display Remove.

l

Value—Whether the value is an element or plain text.
o Value is an element renders the field as <img src=”url” alt=”text” /> for an
image.
o

l

l

l
l

Value is plain text renders the field as just the url.

Default Location—If desired, you can insert a default link, which can be the most
common link or simply an example. To help find the link, click the Select button and
navigate to a file. You can only insert a file whose extension appears between the
<validext> element of the configdatadesign.xml file. For example:
<validext>gif,jpg,png,jpeg,jpe,pdf,doc</validext>
Cannot be blank—If you want to require the user completing this field to enter a
response, click this check box.
Description—If desired, enter text that the user can click to access the linked file.
Target Frame—Use this field to indicate how the hyperlinked files will appear when
clicked.
o New Window(_blank)—In a new browser window, on top of the current browser.
o

Same Window(_self)—In the same position within the browser window. The new
window replaces the current one.

o

Parent Window(_parent)—If your page contains frames, in the frame that
contains the frame with the hyperlink.
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o

l

Browser Window(_top)—If your page contains frames, in the full display area,
replacing the frames.

Data Style tab—You can specify the following data styles:
l
Font style and size
l
l

Bold and italic
Text alignment (especially helpful for formatting dollar amounts in a plain text
field)

l

Underline or strikethrough

l

Font color and background color
NOTE: The configuration data controls a command's appearance on the toolbar and on the
Data Style dialog. For example, if <button command="cmdfontname" /> is removed
from configdatadesign.xml, it disappears from the toolbar and the Data Style dialog.

l

Advanced tab—This is the same as the Group Box Advanced Tab on page 463.

Resource Selector
A Resource Selector field lets you place elements of Ektron content, taxonomies, collections
or folders on a Smart Form. For example, on the following page, content in a selected folder
appears.
IMPORTANT: You can place content from these folder types on a Smart Form: standard, root, site, blog,
and eCommerce catalog. You cannot place content from Community, Discussion Board, or WebCalendar
folders on a Smart Form.
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Each content item in the folder is represented as a hyperlink followed by its summary. A site
visitor can click the link to view the content. An alternative display showing hyperlinks only
appears as follows.

A Resource Selector field acts like server controls that let you place content on a Web page,
such as the Content Block and List Summary server controls. The advantages of the Resource
Selector field are:
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l

l

You can add individual content or all content in a folder, collection or taxonomy category
to a Smart Form. So, you can position resources then surround them with text, images,
and so on, to place them into proper context.
Management is handled within the Workarea. So, Ektron administrators can display
content via a Smart Form without needing a developer to create/modify templates and
server controls.

These steps summarize how to use a Resource Selector on a Smart Form.
1. Create a Smart Form configuration.
2. Edit its Data Design, placing a Resource Selector field on it.
3. Set the Resource Selector properties. For example, determine whether the content
author can select content, a taxonomy category, a collection, or a folder.
4. Assign the configuration to an Ektron folder. See Also: Assigning a Smart Form
Configuration to a Folder on page 437
5. An author creates a Smart Form based on that configuration.
6. The author adds content, a collection, a taxonomy category, or a folder to the Smart
Form, along with other field types.
7. A site visitor browses to the page and views the assigned content.
To a content author, a Smart Form's Resource Selector fields appear as follows.

The upper field lets the author select content (ID 30 is the default), and the lower one lets the
person select a folder (ID 36 is the default). To select either one, click the folder to its right,
then select. If working with content, the tabs that appear on the dialog are determined when
the resource is placed on the Smart Form configuration.
NOTE: If someone changes the title of content used in a Resource Selector field, the title is not updated
on the Smart Form. In the illustration, if someone changed the title of content ID 30, you would still see
Sample Content Block when viewing the Resource Selector field.
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General Tab
l

l
l

l

Descriptive Name—Enter the name of this field. Internally, the name is used as the
field’s caption. By default, the Data Designer assigns the name Field followed by the
next available number. So, the first field’s name is Field1, the second field is Field2,
and so on. You may change the default.
Field Name—Enter the field’s element name. This defines the field in the XML.
Tool Tip Text— Enter the text that appears when a user hovers the cursor over the
field.
Resource Type—Select Content, Folder, Taxonomy, or collection.
IMPORTANT: You can place content from these folder types on a Smart Form: standard, root, site,
blog, and eCommerce catalog. You cannot place content from Community, Discussion Board, or
WebCalendar folders on a Smart Form.

l

l

l

Default Value—Select the default content, folder, taxonomy or collection item by
clicking the folder icon and selecting. The following example shows a taxonomy default
item. The author can accept the displayed default or change it by clicking on the folder
icon.

Minimum Number—Define the minimum number of content items that can appear
where you insert the Resource Selector.
Maximum Number—Define the maximum number of content items that can appear
where you insert the Resource Selector.
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These settings affect the content author’s work with this field on a Smart Form in the
following way. Assume you set a minimum of 1 and a maximum of 2. After the content
author adds 2 content items for this resource selector, the only options are to remove or
rearrange fields; you cannot add more.

Type Tab
Use the Type tab to limit the type of content that a content author may choose. It is available
only if the Resource type is Content Resource.
NOTE: eCommerce products are also known as catalog entries.

Configuration Tab
The Configuration tab determines how a content author may select content or a folder on a
Smart Form. It is available only if the Resource Type is Content or Folder.
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Appearance tab

l

l

l

Check Browsing folders to let content authors select content or a folder by browsing
through folders.
o If you want to set a beginning folder from which an author can browse, use the
Starting Folder field. Otherwise, browsing begins at the Root folder.
Check Browsing taxonomy categories to let a content author select content by
browsing through taxonomies. (Available only if the Resource Type is Content.)
Check Searching for key words to let a content author select content using the
Workarea search. (Available only if the Resource Type is Content.)

Appearance tab
The Appearance tab determines the default appearance of the resource on your website.

Tabular Data
The Tabular data button inserts a table into which you can place other types of fields. It’s
similar to a group box but its advantage over a group box is that it lets you place fields in
columns. After you insert a table, you can insert an appropriate field type into each column.
For example, the Description field type is plain text, while the In Stock? field type is a
choice.

If you insert a field into a table and its caption appears to the left of the data entry region,
move the caption to the column header.

l

To access table commands (such as add row and add column), place the cursor inside a
table cell and right click the mouse.
NOTE: To delete a column, place the cursor in the column, right click the mouse, and select Delete
Column. You cannot reduce the number of columns by editing the Tabular Data dialog’s Columns
field.

l

To edit tabular data, hover the cursor over a table border line until you see a 4-headed
arrow. Then, click the right mouse button and select Field Properties.
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IMPORTANT: Only table cells into which you place a field are available to visitors of your Web
page.

l

l

l

l

Descriptive Name—Enter the name of this table. By default, the Data Designer assigns
a name made up of Field followed by the next available number. So, the first field’s
default name is Field1, the second field’s default name is Field2, and so on. You can
change the default if you want.
Field Name—Enter the table’s element name. This will define the table in the XML. See
Also: Tabular data creates 3 levels of XML tags: on page 484
Tool Tip Text—Enter the text that appears when a user hovers the cursor over the
table’s column headers.
Use—Click May not be removed if this field must be included on the screen.
Otherwise, click May be removed.
If you check May be removed, when this field appears on a data entry screen, an icon
( ) appears to the left of the field. If the user clicks the icon, a drop-down menu
provides an option to remove the field.
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If the user removes the field, field name replaces the field on the data entry screen to
indicate that the field was removed and can be re-added if necessary. For example, if
the field’s display name is street address, and the user removes the field,
appears in place of the field.
NOTE: The menu icon ( ) can also indicate that the user can add instances of a field (see the
Allow field). So, if a field is required, the icon could appear but omit a Remove option.
l

Allow—Check more than one if you want to let the user entering data add instances of
this field. Otherwise, check only one. For example, if a screen is collecting names and
addresses and you want to let the user enter several of them, check more than one. If
you check More than one here, you are allowing the user to insert an entirely new
table, not an additional table row.
IMPORTANT: Do not insert a calendar field into a Smart Form that allows multiple entries (using
the Allow more than One option on the dialog). If you do, you cannot search the Smart Form using
that field.
If the user entering data clicks , a menu appears, which lets the user click Duplicate
to add instances of the field to the screen.
NOTE: The menu icon ( ) can also indicate that the user can remove a field. So, even if a field
allows only one instance, the icon could appear but the menu would only display Remove.

l

l

l

l

l

Row display name—Enter the text that appears when a user hovers the cursor over
the table’s cells. Use this field to describe the kind of information to be inserted into the
table’s cells.
Row name—Enter the name of the XML tag used to collect data for each entry in the
table.
Minimum number—If desired, enter the minimum number of rows for this table. If you
enter a number and the data entry user tries to save the screen without inserting at least
the minimum number of rows, the user is informed that Element content is
incomplete according to the DTD/Schema. By default, the user is allowed to cancel
or save the screen anyway. However, the system administrator determines whether or
not the user can save an invalid document.
Maximum number—If desired, enter the maximum number of rows for this table. If
you don’t want to assign a maximum number, check Unlimited. When this table
appears on a data entry screen, if a user adds the maximum number of rows, the Insert
Above and Insert Below menu options are grayed out.

Columns—Enter the number of columns to appear in the table.
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l

Caption—Optionally enter text to describe this table on the data entry screen. The
caption appears centered above the table. After you insert this field onto the screen, you
can use eWebEditPro+XML’s formatting capabilities to modify the caption’s size, font,
color, and other attributes.

l

Advanced Tab—This is the same as the Group Box Advanced Tab on page 463.

l

Relevance—This is the same as the Group Box Relevance Tab on page 465.

Tabular data creates 3 levels of XML tags:
l

inner level: each field in the table

l

middle level: each row in the table

l

outer level: the entire set of table data

To explain how this works, use the following contact list as an example.
l

John Doe, 555-1212, john.doe@example.com

l

Mary Smith, 555-8765, msmith@example.net

When you insert a field into a table, a dialog helps you define the field type. For example,
when inserting a plain text field, the Plain Text Field dialog appears. On that dialog, the value
of the Phone field defines the tags that enclose that field’s contents.
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To continue the example, every contact is represented in XML as:
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>
and
<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>

Each row of the table collects information for one contact. On the Tabular Data Box dialog, the
Row Name field defines the XML tag that groups information for each contact. For example,
the Row Name field value is Contact.
</AddressBook>
<contact>
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email></Contact><Contact>
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>
</Contact>
Contact>
<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>
</Contact>
</AddressBook>

Text
Use a text field when you want the user to enter a text response.
NOTE: If a plain text field tries to perform a numerical calculation with a value that is blank or contains
letters, NaN appears in the field. (NaN stands for “not a number.”)
If a plain text field tries to divide by zero, Infinity appears.
The following capabilities are available with a text field.
l

Text can be read-only or hidden

l

Can allow plain text only, or let the author apply formatting

l

Can consist of one or several lines
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l
l

l
l

l

l

Descriptive Name—Enter the name of the field.
Indexed—Check if you want to index this field. For more information, see Searching
XML Information on page 438. The Indexed field may or may not appear, depending on
how your administrator set up your system.
Field Name—Enter the field’s element name. This defines the field in the XML.
Tool Tip Text—Enter the text that appears when a user hovers the cursor over this
field.
Default Value—If you want to set a default value for this field, enter it here. The
default value appears in Data Entry mode, where the user can accept, change, or delete
it. For example, if this field collects a city, and most users enter New York, enter New
York as the value.
Dimensions—Set the size of the text field in characters.
o Size (or Width)—Enter the width of this textbox in characters. This field is
available only if Allow Rich Formatting is not checked.
o

l
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Height—Enter the height of this textbox in characters. This field is available only if
Allow Multiple Lines is checked and if Allow Rich Formatting is not checked.

Use—Click May not be removed if this field must be included on the screen.
Otherwise, click May be removed.
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If you check May be removed, when this field appears on a data entry screen, an icon
( ) appears next to the field. If the user clicks the icon, a menu provides a remove
option.
If the user removes the field, field name replaces the field on the screen to indicate
that the field was removed and can be re-added if necessary. For example, if the field’s
display name is street address, and the user removes the field,
appears in place of the field.
NOTE: The menu icon ( ) can also indicate that the user can add instances of a field (see the
Allow field). So, if a field is required, the icon could appear but omit a Remove option.
l

Allow—Check more than one if you want to let the user add instances of this field.
Otherwise, check only one. For example, if a screen is collecting names and addresses
and you want to let the user enter several of them, check more than one. If you check
More than one here, you allow the user to insert a new table, not an additional table
row.
IMPORTANT: Do not insert a calendar field into a Smart Form that allows multiple entries (using
the Allow more than One option on the dialog). If you do, you cannot search the Smart Form using
that field.
If the user entering data clicks , a menu appears, which lets the user click Duplicate
to add instances of the field to the screen.
NOTE: The menu icon ( ) can also indicate that the user can remove a field (see the Use field).
So, even if a field allows only one instance, the icon could appear but the menu would only display
Remove.

l

l

Allow Rich Formatting—Check this box if you want to let the Smart Form author
format text in this field. If you do not check the box, the author can enter plain text only.
If you allow rich formatting, a content author uses the editor selected in either the
web.config file's ek_EditControlWin key (for Windows computers) or the ek_
EditControlMac key (for Apple computers). Or, if UserPreferred is the web.config
value, the author uses the editor selected in the user profile.
Keep Single Blocking Tag—This checkbox is active only if Allow Rich Formatting is
checked. Check this box if you want the editor to maintain <p> tags around a single line
of text. Uncheck this box if you want the editor to strip <p> tags from a single line of
text.
NOTE: This checkbox has no effect if text that allows rich formatting consists of more than one line.
Sample Results
Checked: <p>Here is sample text</p>
Unchecked: Here is sample text

l

l

l

Allow Multiple Lines—Check here to let this text box expand to accommodate the
user’s input. If you do not check this box, a single line box appears on the screen to
accept user input.
Cannot be Changed—Check here to make this field read-only. You might use this
option to provide instructions for completing the screen.
Invisible—Check to make this field hidden in Data Entry mode. This option lets you
store unseen information in an XML document. An example might be putting a version
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number for the data design so that XML documents can be upgraded to newer versions
using an XSL transform.
l

Validation—Select the kind of validation to apply to this field. Your choices are:
o No validation—the user’s response is not checked.
o

Cannot be blank—the user must enter a response.

o

Custom—You can create custom validation. See Also: Creating Custom Validation
Criteria below

If you assign to this field any value other than No validation, the field is initially
surrounded by red dashes in Data Entry mode. If the user’s response does not meet the
validation criterion, the field remains surrounded by red dashes. The system
administrator determines whether or not the user can save an invalid document.
l

Data Style tab—You can specify the following data styles:
l
Font style and size
l
l

Bold and italic
Text alignment (especially helpful for formatting dollar amounts in a plain text
field)

l

Underline or strikethrough

l

Font color and background color
NOTE: The configuration data controls a command's appearance on the toolbar and on the
Data Style dialog. For example, if <button command="cmdfontname" /> is removed
from configdatadesign.xml, it disappears from the toolbar and the Data Style dialog.

l

Advanced tab—This is the same as the Group Box Advanced Tab on page 463.

Adding Standard Validation Options
By default, the Data Designer provides several standard validation options. You can see them
by clicking the down arrow to the right of the Validation drop-down.

Creating Custom Validation Criteria
If the standard validation options do not provide the flexibility you want, use the custom
validation feature to ensure the following about the user’s input.
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l

The data type—the default types are
o text
o

URL

o

whole number

o

decimal number

o

floating point number (Floating point includes scientific notation, so is appropriate
for scientific numbers. Decimals usually suffice for business numbers.)

NOTE: Your system administrator may customize the choices.
l

The field value has one of the following relationships with another field, a number, or an
expression—the default expressions are
o between 2 values (either another field or a number that you specify)
o

less than

o

equal to

o

not equal to

o

maximum length (usually for text responses)

NOTE: Your system administrator may customize the choices.
If the user’s response fails to meet the criteria, you can compose an error message that
appears when that happens. Your system administrator determines if a user can save the
invalid data.
As an example of custom validation, assume that a field collects telephone numbers, and you
want to make sure the user enters 10 digits. To accomplish this:
1. Click the Plain Text Field dialog and complete the screen.
2. In the validation section, click Custom Validation. The Custom validation screen
appears.
3. In the Data Type field, select Whole Number from the drop-down list. This ensures
that the user can only enter digits.
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4. Click the down arrow to the right of the Examples field to see sample logic.

5. Click Maximum text length.... This option lets you specify the length of the user’s
response.
string-length(.) <= {X} appears in the Condition field.
6. Because you want the user’s input to equal 10, remove the less than sign (<) from the
calculation. Now it looks like this: string-length(.) = {X}.
7. Replace the {X} with 10. Now, it looks like this: string-length(.) = 10.
8. Move the cursor to the Error Message field and compose a relevant error message. For
example: must be 10 digits. Your screen should look like this.

9. Click OK and return to the Plain Text field dialog.
10. Click OK to save that dialog and test the validation on the phone number field. To do this,
switch to Data Entry mode and enter more or fewer than 10 digits, as well as non-digit
characters to verify that validation works as expected.
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Working with Blogs
A blog is a form of online information sharing. You create a main blog post, and others can
comment on it. Or, you can use a blog to create an online diary of everyday life. Your most
recent blog post appears at the top with associated blogs following. Some blogs display a
calendar on which days when blogs were created are highlighted.

In the Workarea, a blog looks like a content folder but has a distinct icon (

).

You can use a Smart Form to implement structured blogging, which provides a form for the
blogger to complete instead of free-form writing. For example, you create a book review blog
and want to make sure that an author submitting a review provides:
l

Title

l

Author
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l

Date of review

l

Review text

For information about working with Smart Forms, see Working with Smart Forms on
page 423.
NOTE: Unlike the Smart Forms you can assign to regular folders, you cannot require the user to select a
Smart Form when creating a new post. It is only an option.
This section also contains the following topics.
Blog Workflow
Blog Elements
Editing Blog Properties
Adding a Blog
Deleting a Blog
Adding Blog Subjects
Removing Blog Subjects
Adding Blog Roll Links
Removing Blog Roll Links
Controlling Blog Comments
Working with Blog Posts
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Blog Workflow
The following list explains the workflow of a blog.
1. An administrator creates a blog in the Workarea, assigns blog subjects, creates a blog
roll, and decides how comments are handled. See Adding a Blog on page 494.
2. A developer adds the blog to a Web form using blog server controls, then publishes the
form. See the Blogs on page 1645 server controls.
3. Ektron users can add blog posts, either from the Workarea or the website. Depending on
permissions, the post is either published immediately or submitted to the blog’s approval
chain. See Working with Blog Posts on page 504.
4. When published, site visitors can view the post and add comments. See Controlling Blog
Comments on page 500.

Blog Elements
The following list shows elements commonly found in a blog.
l

l

Blog Title—The name of your blog as you want it to appear on the site. For example,
“My Life Story.”
Blog Post—The main entry for each topic. A blog post consists of these elements. See
Working with Blog Posts on page 504.
l
Headline—title of the post
l
l

l
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Commentary—details of the post
Comment Link—links to a comments page, where site visitors can view or add
comments
TrackBack URL—a URL visitors can use to notify you when they discuss the post
on their site. See Also: Trackback (Wikipedia)
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l
l

l

l

l

l

PingBack—Pings back any URLs in the blog post See Also: Pingback (Wikipedia)
Images—add images to a blog post the same way you add them to content. See
Also: Adding a Library File to Content on page 342

Blog Comments—A Comments link appears at the end of the blog post. The link
includes a number in parentheses (for example (3)), which denotes how many
comments have been made. Click this link to move to the comments page, where you
can read comments on the post and possibly enter your own. See Controlling Blog
Comments on page 500.
Blog Roll—Other blogs that the blog’s creator wants site visitors to view. See Adding
Blog Roll Links on page 497.
Blog Subjects—Subjects associated with the blog. If you click a subject, links to all
posts associated with the subject appear. See Adding Blog Subjects on page 496.
Calendar—Indicates when blog posts were made. This lets site visitors navigate your
blog by clicking a day that has blog posts.

A blog folder has the same functionality and features as other folders in the following areas:
l

Permissions

l

Approvals

l

Purge history

l

Language Support

l

Search

For more information, see Setting Approval Chains on page 262 and Managing Folder
Permissions on page 257.

Editing Blog Properties
PREREQUISITE
To edit blog properties, you must have permission to Edit Folders on the blog’s
Advanced Permissions screen.
To edit blog properties:
l

l

Workarea: navigate to the blog folder, click View > Properties, then click Edit
Properties.
website: log in, navigate to the blog, open the menu for the blog, and select Properties.

You have more options when you edit the properties of a blog than when you create it. This
saves time when you are adding multiple blogs to a site. You can set these properties when
creating or editing a blog.
l

l

l

Name—Create blog, Edit properties—The name of your blog as it appears in the content
folder tree.
Title—Create blog, Edit properties—The title of your blog as it appears on the website
blog. It only appears if the ShowHeader Blog server control property is set to true.
Visibility—Create blog, Edit properties
l
Public—any site visitor can view the blog
l

l

Private—Membership and Ektron users must log in to see the blog.

Tagline—Edit properties—A line of additional information that describes the blog. It
appears below the title if the ShowHeader Blog server control property is set to true. For
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example, the title of a blog is “John’s Blog Page.” The tag line could be “A place to learn
about John's past, present, future, and his current state of mind!”
l

l

l

l

l

l

Post Visible—Edit properties—The number of posts visible on the blog page. If the
number of posts exceeds this number, only this many of the most recent posts appear.
For example, if this property is set to 10 and you add 11 posts, only the 10 most recent
posts appear. This number can be from 1 to 999. If you leave this field blank, all posts
made during the current day are visible.
Comments—Create blog, Edit properties—Choose how to handle comments by checking
the appropriate boxes. For more information, see Controlling Blog Comments on
page 500.
Update Services—Edit properties—Enter a service that notifies a blog search site when
blog posts are added to your blog site. These blog search sites allow Web users to search
content contained in blogs around the world. To use this feature, check the Notify blog
search engines of new posts box and enter a path to a search site. An example path
is: http://rpc.technorati.com/rpc/ping.
Style sheet—Edit properties—If you want to provide a custom style sheet for the blog,
enter the path to it relative to the site root. For example, WorkArea/csslib/my_custom_
blogs.css. Leave this field blank to inherit the default style sheet, blogs.css, located in
Workarea/csslib. You can customize the default style sheet but your modifications will
get overwritten when you upgrade Ektron.
Content Searchable—Edit properties—Specify whether the blog can be found through
site searches.
Display Settings—Edit properties—Specify the tabs that you want displayed when you
create or edit blog content.

Adding a Blog
1. From the Workarea, choose Content.
2. Click the folder in which the blog will reside.
3. Choose New > Blog. (You also can right click on a content folder and choose Add
Blog.) The Add a Blog screen appears.
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4. Complete the Properties tab according described below.
l

Name—The name of your blog as it appears in the content folder tree.

l

Title—The title of your blog as it appears on the website.

l

l

l

l

l

l

Visibility—Choose whether the blog is private or public. If private, only logged-in
site visitors can see it.
Comments—Choose how to handle comments by checking the appropriate boxes.
See Controlling Blog Comments on page 500.
Taxonomy tab—Select taxonomy categories to apply to the blog. See Also: Using
Taxonomies on page 777
Templates tab—Select templates to apply to the blog. See Also: Working with
Templates on page 382
Subjects tab—Add subjects to the blog. See Also: Adding Blog Subjects on the next
page
Blog Roll tab—Add blog sites that you want blog readers to visit. See Also: Adding
Blog Roll Links on page 497

5. Specify the information in the tabs, and click Add Blog.
NOTE: To create a blog, you must have permission to Add Folders on the blog’s Advanced Permissions
screen. See Also: Managing Folder Permissions on page 257

Deleting a Blog
1. In the Workarea, navigate to Content then the blog folder. (From the website, open
the menu for the blog and click Properties.)
NOTE: To delete a blog from the website, you must be logged in and have permission to Delete
Folders on the blog’s Advanced Permissions screen.
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2. Choose Delete > This Blog. A dialog box asks you to confirm.
3. Click OK.
WARNING! Deleting a blog removes the blog and all of its posts, comments, and quicklinks. After a blog
is deleted, you cannot retrieve its posts, comments, or quicklinks.

Adding Blog Subjects
Subjects make it easier for site visitors scanning a blog page to find posts that interest them.
An author assigns one or more subjects to a blog post. When the post is published, a list of
subjects assigned to all posts appears in a column. A site visitor can click a subject to see all
related posts.
For example, a blog’s subjects are General Information, Cardiology, Oncology, and
Neurology. A blog is written about the importance of screening and then assigned to the
Oncology subject. When a user clicks Oncology, the screening blog appears with other blogs
related to Oncology. By default, a blog's subjects appear with other blog components when a
Blog Server control is placed on a Web page. A developer can place a list of blog subjects only
on a Web page via the BlogCalendar on page 1654server control.

A subject only can be assigned to the blog in which it is created—it cannot be reused with
other blogs. With each new blog, you must create new subjects. This gives you the flexibility
to tailor unique subjects to each blog.
To add or edit a blog subject:
NOTE: To add a blog subject from the website, you must be logged in.
1. In the Workarea, navigate to the blog folder. (From the website, open the menu for the
blog and click Properties.)
2. Choose View > Properties.
3. Click Edit Properties.
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4. Click the Subjects tab, then Add Subject.

5. Enter the subject. Add as many subjects as you want by clicking Add New Subjects.
6. Click Save.

Removing Blog Subjects
NOTE: To remove a blog subject from the website, you must be logged in.
1. In the Workarea, navigate to the blog folder. (From the website, open the menu for the
blog and click Properties).
2. Choose View > Properties.
3. Click Edit Properties.
4. Click the Subjects tab.
5. Click Remove Last Subject to remove the subject from the end of the list, or click
Remove to remove a specific subject.

6. Click OK to confirm removal of the last subject. You can continue to remove subjects at
the end of the list by clicking the Remove Last Subject link.
7. Click Save to save your changes.

Adding Blog Roll Links
Ektron 8.7
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A blog roll lists website links to your blog page; a list of related blogs, or blogs that you want
your visitors to view. See Also: BlogRoll on page 1659 server control.

NOTE: To add a blog roll link from the website, you must be logged in.
1. In the Workarea, navigate to the blog folder. (From the website, open the menu for the
blog and click Properties.)
2. Choose View > Properties.
3. Click Edit Properties.
4. On the Blog Roll tab, click Add Roll Link. The Add Blog Roll Link form appears.

5. Fill out the form. Add as many links to the blog roll as you would like.
l
Link Name—Describes the link in the blog roll.
l
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URL—Enter the URL of the blog you are adding to the blog roll. It must begin with
http://.
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l
l

Short Description—Add a short description of the site.
Relationship—Enter the relationship of the blog roll link to you or to the site. For
example, brother. Click Edit for a pop up screen that helps you choose the site's
relationship.
l
URL—Check this box if the address is owned by the same person or company.
l

l

l

l

l

Friendship—Choose your level of friendship with the site owner.
o Contact
o

Acquaintance

o

Friend

o

None

Physical—Check this box if you have physically met the person who owns this
blog.
Professional—Check if the site owner has a work relationship with you.
Select all that apply.
o Co-worker
o

Colleague

o

Geographical—Select one.

o

co-resident

o

neighbor

o

none

Family—If the site owner is a family member, select the relationship.
o Child
o

Parent

o

Sibling

o

Spouse

o

Kin

o

None

Romantic—Check your feelings toward the site owner.
o Muse
o

Crush

o

Date

o

Sweetheart

6. Click Save.

Removing Blog Roll Links
NOTE: To remove a blog roll link from the website, you must be logged in.
1. In the Workarea, navigate to the blog folder. (From the website, access the blog’s menu
from the site and click Properties.)
2. Choose View > Properties.
3. Click Edit Properties.
4. Click the Blog Roll tab.
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5. Click Remove Last Roll Link to remove the roll link from the end of the list, or click
Remove Roll Link to remove a specific roll link.

6. Click OK to confirm removal of the last blog roll link.
7. Click Save.

Controlling Blog Comments
Blog comments let site visitors add their thoughts about a blog post.
IMPORTANT: Do not confuse blog comments with history comments. You can add a history comment to
the blog post by clicking the Comment tab. This is not the same as adding a comment to a blog post on a
site. When you add a history comment, it has the same properties as a comment associated with content.
The blog administrator controls commenting by deciding who can add comments and whether
a comment requires approval for publication. By default, comments are fully controlled. This
means they are enabled, must be approved, and a site visitor must log in to create them. The
following blog properties control comments. See Also: Editing Blog Properties on page 493.
l

Enable Comments—Allows user in Workarea and site visitor to add blog comments.
Also displays comments on site and in Workarea.
NOTE: An Administrators group member can add comments, regardless of how this checkbox is
set.

l
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Moderate Comments—Determines if comments must be approved before they appear
on site. If this field is checked, only Ektron users with permission to edit the post can
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approve comments. If a user without edit permission adds comments, they only appear
on the website after being approved by someone with edit permission.
An unapproved comment is indicated by a red exclamation point ( ). If a user with edit
permission logs in, comments are automatically approved.
NOTE: Membership users cannot approve blog comments.
l

Require Authentication—Determines if a user must be logged in as an Ektron or
membership user to add comments via the website.

If comments are enabled but not moderated, any site visitor can add a comment. If you want
to ensure comments on your site meet certain criteria, moderate them.
IMPORTANT: If comments are not moderated, they appear on your site as soon as a site visitor submits
them.
On the site, blog post comments appear when you click the Comments link or the Title of the
blog post. The comment page contains the original post, any comments, and a form to post
new comments. Depending on how the page is designed, the calendar and blog roll also may
appear.
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The Workarea’s View Posts in Blog screen lets you add, view, approve, edit, and delete
comments for a blog post. The Comments column indicates the number of comments. An
unapproved comment is indicated by a red exclamation point ( ).

This section also contains the following topics.
Adding a Blog Comment
Deleting a Blog Comment
Approving a Blog Comment
Notification of Moderated Blog Comments
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Adding a Blog Comment
PREREQUISITE
To add a comment, you must have Add permission on the blog’s Standard
Permissions screen.
To add or edit a blog post comment from the Workarea:
1. From the Content area, navigate to the blog and find the post that you want to edit.
2. Click the number in the Comments column. The View Comments for Post screen
appears.
3. Choose New > Comment. The Add Comment screen appears.
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l

Name—The person submitting the comment. This information is required.
NOTE: This text box appears only when a site visitor, who is not a regular user or membership
user, is adding a comment. If a regular user or membership user adds a comment, their name
and email address is taken from their user profile.

l

Email—The email address of the person submitting the comment. This information
is required.
NOTE: This text box appears only when a site visitor, who is not a regular user or membership
user, is adding a comment. If a regular user or membership user adds a comment, their name
and email address is taken from their user profile.

l
l

Homepage—A URL for the person’s website.
State—Set the comment’s state to approved or pending.
o Approved comments appear on the site immediately.
o

l
l

Pending comments must be approved before they appear.

Comment Section—A text area to insert comments about the post.
Post Comment button—Post a comment by clicking this button. Depending on the
comment’s settings, it either posts immediately or is submitted for approval.

Deleting a Blog Comment
When a comment is deleted, you cannot retrieve it.
1. From the Content area, navigate to the blog.
2. Find the post that you want to edit.
3. Click the number in the Comments column. The View Comments for Post screen
appears.
4. Click Delete. A dialog box asks you to confirm.
5. Click OK to delete the comment.

Approving a Blog Comment
Comments can require approval if:
l

l

they are submitted from the website and Moderate Comments is checked in the blog’s
folder properties.
a user submits the comment from the Workarea and sets its state to Pending.

Only users with permission to edit content (posts) within the blog folder can approve
comments.
To approve a comment:
1. From the Content area, navigate to the blog.
2. Find the post that has a comment that requires approval.
3. Click the number in the Comments column. The View Comments for Post screen
appears.
4. Click Approve.
5. The comment’s status changes to approved.
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Notification of blog comments

Notification of Moderated Blog Comments
Whenever a moderated blog comment is published, the Notification system can notify
interested recipients. See Sending Notifications to a Community on page 1194.
Upon the posting a moderated blog comment, a Moderated Blog Comment message may be
generated.

Working with Blog Posts
Your website displays only published blog posts. However, you can see all blog posts in the
Workarea, regardless of status. In the Workarea, you can also create, edit, delete, and
archive blog posts in the same way you work with content. See Also: BlogPost on page 1656
server control.

504

Ektron Reference

Blog Posts on the Website

This section also contains the following topics.
Blog Posts on the Website
Blog Posts in the Workarea
Adding a Blog Post
Editing a Blog Post
Approving a Blog Post
Deleting a Blog Post
Adding or Editing Blog posts with Windows Live Writer
Subscribing or Unsubscribing to a Blog or Blog Post

505
506
507
507
507
508
508
513

Blog Posts on the Website
You can view published blog posts on the website. A blog post has a Title, Content, Comments
Link, Post Time, Date, and Editor Information.

l

l

l
l

Title—The headline of the post. Usually what a site visitor scans through to find a post to
read.
Permanent Link—If you click this link, a new screen appears. The new screen indicates
the permanent link to this blog post. As long as the blog post is active within Ektron, you
can access it via the URL in the browser’s address bar. Most blog pages show only recent
posts. After a post is moved off the blog’s front page, it is still accessible via this link.
Content—The body of the post.
Comments Information—The comments link shows the number in parentheses of
comments for a post . When this link is clicked, a new page of comments for the post
appears. Also on the page is a form to add comments about the post. The comments only
appear if a site visitor has logged in or authentication is not required for blog comments.
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l

Editor Information—The person who created or last edited the blog post.

l

Post Time and Date—The date and time a blog post was created or last edited.

Blog Posts in the Workarea
Viewing a blog post in the Workarea is similar to viewing content in the Workarea. Navigate
to the folder that contains the blog then click the title of the blog post in the View Posts in Blog
screen.

The View Posts in Blog screen shows the following information about each blog post.
l

l

Title—The headline of the post. Usually what a site visitor scans through to find a post to
read.
Comments Information—The comments link shows the number in parentheses of
comments for a post . When this link is clicked, the View Comments for Post screen
appears. If a red flag ( ) appears next to the comments icon, they are awaiting
approval.

l

Editor Information—The person who created or last edited the blog post.

l

Post Time and Date—The date and time the blog post was created or last edited.

l

Status—The status of the blog post. For example, if the blog post is checked in, the
status is I.

From this screen, you can perform all functions with a blog post that you can with content.
You can give it a summary, add metadata, associate a task, assign Web Alerts, and so on. You
must have Edit permission for the blog to perform these functions.
NOTE: You can also add a history comment to a blog post by clicking the Comment tab. This is not the
same as adding a comment to a blog post on a site. A history comment has the same properties as a
comment associated with content.
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Adding a Blog Post
NOTE: To be able to add a blog post, you must have Add permission on the blog’s Standard Permissions
screen. To add a blog post from the website, you must be logged in.
1. In the Workarea, navigate to the blog folder and choose New > HTML Post. (From the
website, open the menu for the blog then choose New Post.)
2. When the Add Content screen appears, use the editor to create the blog post. You create
a blog post the same way you create content. See Also: Editing in Ektron on page 207.
If you are a member of the blog’s approval chain, it is published immediately. If not, the
post is surrounded by a yellow border. An approval chain member must approve it
before it appears on the website

When the post is published, it appears within the blog on the website.
You can add tags to a blog post to further define information about it for blog search engines.
For example, you create a blog post about your favorite band and enter the following tags:
l

Music

l

Guitars

l

Rock & Roll

When a person visiting a blog search site searches for Rock & Roll music, your blog post
appears. Some blog search sites have a page specifically for searching blog tags.

Editing a Blog Post
NOTE: To be able to edit a blog post, you must have Edit permission on the blog’s Standard Permissions
screen. To add a blog post from the website, you must be logged in. Also, if another editor changes a blog
post, the posting information reflects the new editor, the date, and the time the information was changed.
This is important to remember if you want the original person who posted the blog to get credit for the post.
1. In the Workarea, navigate to the blog folder. (From the website, open menu for the blog
then choose Properties, then choose the post.)
2. Click the blog post title you want to edit.
3. Click Edit.
4. Change the blog post. When the blog is published, the changes appear in the blog post on
the website.

Approving a Blog Post
If someone who is not a member of the blog’s approval chain creates or edits a blog post, its
status is set to Submitted. It only appears on the website after a member of the approval
chain approves it. While its status is Submitted, it has yellow border on the View Posts in blog
screen. To approve a blog post, see Approving or Declining Content on page 267.

Ektron 8.7

507

Managing Content

Deleting a Blog Post
NOTE: To be able to delete a blog post, you must have Delete permission on the blog’s Standard
Permissions screen. To delete a blog post from the website, you must be logged in.
1. In the Workarea, navigate to the blog folder. (From the website, log in, open the menu
for the blog, choose Properties and then choose the post.)
2. From the menu, choose Delete > Posts. The Delete Contents screen appears.
3. Click the check box next to each post you want to delete. To select all posts, click the
check box next to Title.
4. Click Delete Contents ( ). A dialog box asks you to confirm.
5. Click OK to delete the selected posts.

Adding or Editing Blog posts with Windows Live Writer
TM

Ektron authors and membership users can use Windows Live Writer to add and edit blog
posts to your site. If users have the proper permissions, they upload images and attach files
from their system. For additional Windows Live Writer help from Microsoft, click here and
sign into the Microsoft website.
NOTE: Ektron only supports the 2010 version of Live Writer.
If you have previously set up Windows Live Writer, choose Weblog > Edit Weblog
Settings. Then, skip to step 4.
To set up Windows Live Writer to work with your Ektron blog:
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1. Go to Windows Essentials: Other Programs and download Windows Live Writer.
2. Begin to install Live Writer. The Welcome window appears. Click Next.

3. In the What blog service do you use? window, select Other services, then click Next.
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4. In the Add a blog account window, enter the following information:
l
Web address of your blog—the page that contains the blog. For example,
http://<your site>/CMS400Min/blogs.aspx.
l

Username—your username to log on to the Ektron site.

l

Password—your password to log on to the Ektron site.

l

Set Proxy...—if needed, edit the proxy settings, then click Next.

5. In the Select blog type window, from the Type of weblog that you are using dropdown, choose Custom (Metaweblog API).
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Adding or Editing Blog posts with Windows Live

6. In the Remote posting web address for your blog field, enter the path to the site's
xmlrpc.aspx file. The default location is http://site
root/Workarea/Blogs/xmlrpc.aspx. Then click Next.
7. The Select Blog window appears. Select the Ektron blog that you will edit with Live
Writer, then click Next.
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8. Windows Live Writer is installed.
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Subscribing or Unsubscribing to a Blog or Blog Post
Logged-in site users and Membership users can subscribe to a blog or a blog post.
l

By subscribing to a blog, you are notified whenever posts are added to it.

l

By subscribing to a blog post, you are notified whenever comments are added to a post.

If you want to stop receiving notices, you can unsubscribe.
The steps are the same for blogs and blog posts.
To subscribe to a blog or blog post:
1. Navigate to the blog on the site.
2. Click Subscribe (

). The Subscribe/Unsubscribe screen appears.

3. Select the Notification Type.
4. Click Add Subscription.
To unsubscribe to a blog or blog post:
1. Navigate to the blog on the site.
2. Click Subscribe (

). The Subscribe/Unsubscribe screen appears.

3. Select a Notification Type.
4. Check the Unsubscribe check box.
5. Click Update Subscription.
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Working with Calendars
Web Calendars keep site visitors informed about upcoming events. Any authorized user can
add events to a calendar. Ektron has System, User, and Group calendars. The calendar type
determines where events are stored in the database, and what permissions are needed to edit
them. See Also: WebCalendar on page 1859server control.
System Calendar

User Calendar

Group Calendar

Where events are
stored

Workarea > Content >
Calendar Folder

Community User
Calendar

Community Group
Calendar

Where events are
added or edited

The Web page or
Workarea folder

The community user’s
profile Web page

The community group’s
Web page

Where
permissions are
set

Folder Permissions

Community Users and
Colleagues

Community Group
Membership

How it appears on
a Web page
For more
information, see

Web page with Server Control or widget

Adding a Calendar on
the facing page

Creating a Calendar in My
Profile on page 522

Creating a Calendar in a
Group on page 523

When first viewed, a Web calendar shows the current day, month, or week, whether you are
on a Web page or in the Workarea. After logging in, you can add or edit calendar events if you
have permission to do so.
l

l
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To select the Day, Week or Month View, click a button in the top right corner to choose
the view. (The WebCalendar server control's DisplayType property determines the
appearance of these buttons.)

To select the previous or next period, click the left or right arrow to move the calendar
forward or backward one period of time.
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l

To choose a date, click the arrow to open the Date popup. Then, click a date to show on
your calendar.

This section also contains the following topics.
Adding a Calendar
Adding System Calendar Events
Viewing System Calendar Properties
Using Community Web Calendars
Creating a Calendar in My Profile
Creating a Calendar in a Group
Customizing the Web Calendar
Using the WebCalendar Widget
Combining Web Calendars (Mashups)
Using Taxonomy with Web Calendars
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Adding a Calendar
PREREQUISITE
To add, edit or delete a calendar, you must be a member of the Administrators Group
or have permission to Add, Edit, and Delete folders on the Advanced Permissions
screen. See Also: Setting Up Your CMS Folder Structure on page 241
To create a system calendar:
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1. In the Workarea, click Content > the folder to which you want to add a calendar.
2. Click New > Calendar. The Add Calendar screen appears.

3. Enter the Calendar Name.
4. Enter the Description.
5. Enter a Style Sheet.—Specify a style sheet that defines styles that may be applied to
event content in this folder. The style sheet must reside in the site root folder. Or, leave
this field blank to inherit the parent folder’s style sheet. The style sheet populates the
style drop-down list within the editor.

NOTE: This style sheet affects event content being edited. It does not necessarily affect the
content’s appearance on your website. To set or edit the style sheet that determines your Web
pages’ appearance, open the page’s Web form and place a <link rel=”stylesheet”... tag
within its <HEAD> tags. If desired, you can identify the same style sheet in both locations. To
include user-selectable styles, they must be generic classes.
6. Set the Content Searchable value. See Also: Ensuring Your Content is Searchable on
page 942
l

Calendar Properties Template Tab
o Inherit Parent Template Configuration—Check this box to inherit the template
from the parent content folder. Or, do not check this box and specify one or more
templates below.
o
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Page Templates—Specify one or more templates for Calendar events in this
folder. This folder’s content uses the specified template when appearing on your
website.
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l

Other Calendar Properties Tabs
o Taxonomy Tab—If you want this folder to inherit taxonomy configurations from
the parent folder, check Inherit Parent Taxonomy Configuration. If you
uncheck Inherit Parent Taxonomy Configuration, you can then select
taxonomies that can be applied to content in this folder. If you want all content in
this folder to be assigned at least one taxonomy category, check Required at
least one category selection. See Also: Inheriting Taxonomies from a Parent
Folder on page 791; Using Taxonomies on page 777.
o

Flagging Tab—Check this box if content in this folder inherits a flagging definition
from its parent folder. If you do not check the box, use the drop-down list to apply a
flagging definition to content in this folder. See Also: Defining Flags for Content on
page 1239, Assigning a Flagging Definition to a Folder on page 1241

o

Metadata Tab— See Working with Metadata on page 369.

o

Web Alerts Tab—See Assigning Web Alert Information to Folders and Content on
page 1581.

o

Breadcrumb Tab—See Creating Sitemap Breadcrumbs on page 820

7. Click Add Calendar.
Note that the system calendar icon is unique (

).

After creating a calendar, you may add events.

Adding System Calendar Events
PREREQUISITE
You logged into Ektron and have edit permission for the calendar. Calendars have the
same permission and approval settings as folders. See Also: Managing Folder
Permissions on page 257, Setting Approval Chains on page 262
To add or edit a system calendar event:
1. Navigate to your calendar from the Web page containing it or the Workarea > Content
tab.
2. Click any day. (You can also click New > Add Calendar Event.) The Edit Event screen
appears.
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l

Enter the event title into the Title text box. “Company Picnic” for example. The title
appears on the calendar and in the pop-up information. To customize this pop-up,
see Customizing the Web Calendar Tooltip on page 525.

l

Enter the Location.

l

Enter the Description.

l

Specify the Start time and the All day options at the bottom of the Edit
Appointment page.

l

For start date, click Calendar (

) and set the start date.

l

For start time, enter the time text or click Clock (

).

Ektron stores event times as UTC (also known as Greenwich Mean Time—GMT). For
members or visitors that login, events show in the member’s time zone. For visitors
that do not log in, events show in the Web server’s time zone. For information about
setting the user time zone, see Time Zone Field on page 1116.
3. If appropriate, set recurrences. Appointments can recur daily, weekly, monthly, or
yearly. They can be spaced at various intervals and have a finite duration or recur
indefinitely. For example, you can set a recurring event for each Friday for the next 5
weeks.
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Exporting Appointments to Other Calendars Using

When editing a recurring event, you are prompted to edit either the single occurrence or
the series.
4. Select a Taxonomy category. A typical calendar taxonomy screens events that a site
visitor might wish to see. For example, a college sports website shows all sports, but a
visitor only wants football games. To show only events related a specific category on
your calendar page, use a Taxonomy. See Also: Using Taxonomy with Web Calendars on
page 534.

5. If desired, set Metadata for the event. See Also: Working with Metadata on page 369.
6. If desired, set the event alias. See Also: Creating User-Friendly URLs with Aliasing on
page 835
7. Click Save. The event appears on the calendar.

Exporting Appointments to Other Calendars Using
iCal
You can export Web calendar appointments to any calendar that accepts an iCalendar *.ics
file. This is helpful if you want to track appointments on your Web calendar and a mobile
device calendar, for example.
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NOTE: Ektron uses accepted standards for producing the iCalendar ics file. This does not mean that all
calendar types use the recurring appointment data properly. Contact your calendar vendor if iCalendar
support is needed.
IMPORTANT: Changes to recurring appointments do not work correctly for iCal files used in Microsoft
Office 2003.
PREREQUISITES
You are logged into the Ektron website and are a member of the Administrators group
or assigned the Calendar-Admin role
To export a Web Calendar event to another calendar:
1. Hover over an event on the Web calendar.

2. Click download. The File Download screen appears.
3. Click Save and save to a folder on your computer.
4. After the file is downloaded, click Open Folder.
5. Double click the .ics file you saved. When you do, the appointment setting page for your
default calendar opens. For example, this file name was event-997.ics.
NOTE: If you are adding the appointment to a calendar other than the default calendar on your PC,
first open that calendar and import or add the *.ics file to it. For example,when using a Google
Calendar, click Add then choose import. See your calendar's instructions for importing iCalendar
appointments.
6. Save and close this appointment. It will now appear on your calendar.

Showing Calendar Events on Activity Streams
A new or updated Calendar event appears on a Community Activity Stream if the following
notification settings are checked on a user's or Membership Group's Profile > Activities tab.
For more information, see Notification Message Recipients on page 1196.
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Add Calendar Event

l

Update Calendar Event

l

Add Calendar Event

l

Update Group Calendar Event
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Viewing System Calendar Properties
The Calendar properties screen lets you set permissions as well as modify the calendar’s
metadata, taxonomy, templates, flagging, Web Alerts and Breadcrumbs. To view a system
calendar's properties:
1. From the Workarea, choose Content.
2. Click the calendar you wish to view. The View Events screen appears.
3. Click View > Properties. The View Properties screen appears. (To edit the properties,
click Edit Properties.)

To learn more about the properties, see Adding a Calendar on page 515

Using Community Web Calendars
Both community group and community user profile pages can display a Web Calendar. The
following example shows a user profile page with a personal calendar.
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The calendar on a personal community page obeys the same community rules as other
features in the community. You can restrict the visibility of your events to only colleagues or
make them public.

Creating a Calendar in My Profile
You can place a Web calendar on a user profile to track personal appointments. The following
code places a WebCalendar server control on a User Profile template. You must set
sourceType and dynamicParameter as shown.
<CMS:WebCalendar ID="WebCalendar1" runat="server" >
<DataSource>
<CMS:CalendarDataSource sourceType="UserCalendar" dynamicParameter="id” >
</DataSource>
</CMS:WebCalendar>

Creating the User Calendar in the Database
To use a personal calendar, you must add it to the database. Each user needs to do this when
they decide to use a calendar on their profile.
To add a user calendar to the database:
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1. Log in to your website.
2. Navigate to your personal Web page or your profile.
3. Click Edit Profile. In this example, Edit Profile is on a personal profile page of the
eIntranet Starter Site.

Alternatively, you can log into the Workarea then go to Settings > Users > User Profile.
4. When the Edit Profile window appears, click the Custom tab.
5. Check Create User Calendarto create a user calendar in the database.

WARNING! After you save this profile, you cannot later uncheck this option.
6. Click Save. Your calendar appears on your profile page.

Creating a Calendar in a Group
You can add a Web Calendar to any Ektron community group. The following is a sample
calendar on a group page.
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The calendar on a community group page obeys the same community rules as other
community features. You can restrict the visibility of group events to group members, or
make the calendar public.
NOTE: An alternate way to use group calendars is using the WebCalendar widget on a group dashboard.
See Using the WebCalendar Widget on page 527 for more information.
The following example provides the code for placing a WebCalendar server control on a Group
Profile template. You must set sourceType and dynamicParameter as shown for
CalendarDataSource.
<CMS:WebCalendar ID="WebCalendar1" runat="server">
<DataSource>
<CMS:CalendarDataSource sourceType="GroupCalendar" dynamicParameter="id”/>
</DataSource>
</CMS:WebCalendar>

To use a group calendar, you must add it to the database. Each group needs to do this once
when they decide to have a calendar for their group.
To add a group calendar to the database:
1. Log in to your website.
2. Navigate to your group Web page.
3. Choose Manage > Edit Group.
4. When the Edit Group window appears, check the Create Group Calendar checkbox to
create a group calendar in the database.
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WARNING! After you save this profile, you cannot later uncheck this option.
5. Click Save. A group calendar exists in the database and can appear on the group page.

Customizing the Web Calendar
The Web Calendar can be customized in many ways. The following examples show some
ways.
This section also contains the following topics.
Customizing the Web Calendar Tooltip
Customizing the Web Calendar Style Sheet
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Customizing the Web Calendar Tooltip
When you hover over a calendar event, a tooltip automatically shows its details.
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You can change how this tooltip looks and behaves by modifying the telerik:RadToolTip
properties. You can apply many changes to a tooltip, but the following example makes the
tooltip appear without delay and use fade-in animation. The example below uses the
EktronTech starter site.
First, add a calendar event and observe the default behavior. Then, follow these steps.
1. Open the EktronTech Website file folder in your editor.
2. Make a copy of the Display.ascx and Display.ascx.cs files from this folder
siteroot\workarea\WebCalendar\DefaultTemplate
3. Paste them into a new folder in the website, such as siteroot\CustomUserControls.
WARNING! You should copy these files and move them to a folder outside the \Workarea folder.
Upgrades overwrite \workarea folder files.
4. Edit the new .ascx file you just created.
5. Set these property values on the Telerik:RadToolTip server control.
l

ShowDelay-0

l

Animation-Fade

6. Save your changes.
7. Edit your template.
8. Update the WebCalendar server control's DisplayTemplatePath property with the
location of the revised display.ascx file. For example:
/CustomUserControls/display.ascx. See Also: WebCalendar on page 1859 server
control.
9. Save your changes.
10. Refresh the browser page containing the calendar.
11. Hover over the calendar event to see the new behavior.

Customizing the Web Calendar Style Sheet
The Web calendar style sheet is WebCalendar.css. It is located in the folder
siteroot\workarea\WebCalendar\View.
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Modify the .RadScheduler classes to change the Web calendar's style. Below are sample
changes.
Color CSS Style Change
.RadScheduler .rsDateHeader {
font-size: 12px;
padding: 1px 4px 3px;
text-decoration: none;
color: green
}

Uppercase CSS Style Change
.RadScheduler .rsSpacerCell,
.RadScheduler .rsVerticalHeaderTable th,
.RadScheduler .rsHorizontalHeaderTable th {
border-style: solid;
text-transform: uppercase
}

Using the WebCalendar Widget
The WebCalendar widget can display a combination of system, user, and group calendars.
You place a Web calendar on a Web page by using either a WebCalendar server control or a
WebCalendar widget. A WebCalendar widget is an easy way to add a calendar to a
PageBuilder page or Smart Desktop (See Also: Personalizing the Smart Desktop on
page 278.)

Adding a System Calendar to a Widget
A system calendar is one that is managed within Workarea. For more information, see Adding
a Calendar on page 515.
To add a system calendar to a WebCalendar widget:
1. Click Edit ( ) in the upper right corner of the WebCalendar widget.
2. Click the Folder tab.
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3. Locate the calendar to add. Note its unique icon.

4. Click Save. The calendar is added to the Selected Calendars list.

Adding a User Calendar to a Widget
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Adding a Group Calendar to a Widget

1. Click Edit ( ) in the upper right corner of the WebCalendar widget.
2. Click the User tab.

3. Specify a user that has a calendar set up and click Search Users to find a person's
calendar (that is available to you).
4. Click Add Calendar (

) to add the calendar to the Calendar widget list.

5. You can choose colors for events from each user's calendar to differentiate each use on
your calendar. AutoSelect uses the next available color.
6. To remove any calendar, click Remove ( ).
7. Click Save.

Adding a Group Calendar to a Widget
1. Click Edit ( ) in the upper right corner of the WebCalendar widget.
2. Click the Group tab.
3. Search for other group calendars by entering a group name and clicking Search
Groups.
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4. Click Add Calendar (

) next to a calendar you want to add. All chosen group calendars

appear on the Selected Calendars tab.

5. You can choose colors for events from each user's calendar to differentiate each use on
your calendar. AutoSelect uses the next available color.
6. To remove any calendar, click Remove ( ).
7. Click Save.

Combining Web Calendars (Mashups)
A Calendar Mashup combines events from different calendars into one calendar view. As an
example, you could combine company meetings from one calendar with a special seminar
series from another.
The ways to combine calendar events are described below.

Combining Calendars Using the Dynamic Method
The dynamic method uses the URL query string parameter to specify a calendar. This method
maintains one calendar template that can display many calendars on your site. The following
example uses the EktronTech starter site. The exercise combines calendars using a URL
whose query parameter is cal2:
http://<servername>/ektrontech/calendar.aspx?cal2=376
To combine 2 calendars:
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1. Create 2 calendars in the workarea. See Also: Adding a Calendar on page 515
2. Determine each calendar's ID number by examining its properties. This example uses
calendar folder IDs 88 and 376.

3. Edit the calendar.aspx template that contains the Web calendar. In this example, the
template is located on the Web server in this folder: d:\inetpub\wwwroot\EktronTech.
4. Add 2 CalendarDataSource tags: one for a static calendar, the other for a dynamic
calendar.
l
In the first (static) CalendarDataSource property, add defaultId = “88”.
l

In the second (dynamic) CalendarDataSource property, add queryParam =
“cal2”. This lets you display any calendar referenced in the query string.

5. In both CalendarDataSource tags, set the sourceType = “SystemCalendar” property.
The finished code looks like this.
<cms:WebCalendar ID="webcalendar" runat="server"
DynamicParameter="calendar_id" DisplayType="All" SuppressWrapperTags="True">
<cms:WebCalendar ID="webcalendar" runat="server"
DynamicParameter="calendar_id" DisplayType="All" SuppressWrapperTags="True">
<DataSource>
<cms:CalendarDataSource defaultId="88" sourceType="SystemCalendar"/>
<cms:CalendarDataSource queryParam="cal2" sourceType="SystemCalendar"/>
</DataSource>
</cms:WebCalendar>

6. Save calendar.aspx.
7. Enter the following URL to see the calendar:
http://<servername>/ektrontech/calendar.aspx?cal2=376
You see the combined calendar events. If there are too many events to show on a date,
clock more... to see all events.
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Combining Calendars Using the Static Method
The static method of combining calendars "hard codes" calendar id numbers instead of using a
query string parameter. This method creates a calendar whose event source does not change
dynamically.
1. Create 2 calendar folders in the workarea. See Also: Adding a Calendar on page 515
2. Determine the ID number for each calendar by examining the Calendar Folder
properties.
3. Edit the calendar.aspx template.
4. In the CalendarDataSource properties, add defaultId values for each calendar as
shown.
<cms:WebCalendar ID="webcalendar" runat="server"
DynamicParameter="calendar_id" DisplayType="All"
SuppressWrapperTags="True">
<DataSource>
<cms:CalendarDataSource defaultId="88" sourceType="SystemCalendar"/>
<cms:CalendarDataSource defaultId="376" sourceType="SystemCalendar"/>
</DataSource>

In this example, events for calendars 88 and 376 are combined on the calendar.aspx
page.

Combining a Static Mashup and Dynamic Parameter
The following example displays a calendar according to a dynamic parameter in the query
string. If the query string parameter is not used, the calendar shows a mashup of 3 calendars.
The following example assumes you created 3 calendars with IDs 88, 374, and 376.
This is the code for the events.aspx template.
<cms:WebCalendar ID="webcalendar1" runat="server">
<DataSource>
<cms:CalendarDataSource sourceType="SystemCalendar" >
</cms:CalendarDataSource>
</DataSource>
</cms:WebCalendar>

This is the code-behind which tests for a query parameter. If none is found, display a static
calendar mashup.
events.aspx.vb
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Combining a Static Mashup and Dynamic

‘This code is located in the Page_Load event
Protected Sub Page_Load(ByVal sender As Object,
ByVal e As System.EventArgs) Handles Me.Load
‘Create a CalendarDataSource instance and set the sourceType and queryParam
Dim cds As New Ektron.Cms.Controls.CalendarDataSource()
cds.queryParam = "calid"
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
‘Add the DataSource object
webcalendar1.DataSource.Add(cds)
‘If the queryString is used, show that calendar,
otherwise show the following mashup
If (Request.QueryString("calid") = String.Empty) Then
‘Create three CalendarDataSource instances and
add the sourceType and defaultId for each.
cds = New Ektron.Cms.Controls.CalendarDataSource()
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
webcalendar1.DataSource.Add(cds)
cds = New Ektron.Cms.Controls.CalendarDataSource()
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
cds.defaultId = 88
webcalendar1.DataSource.Add(cds)
cds = New Ektron.Cms.Controls.CalendarDataSource()
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
cds.defaultId = 376
webcalendar1.DataSource.Add(cds)
End If
‘Fill and return
webcalendar1.Fill()
End Sub

events.aspx.cs
//This code is located in the Page_Load event
protected void Page_Load(object sender, System.EventArgs e)
{
//Create a CalendarDataSource instance and set the sourceType and queryParam
Ektron.Cms.Controls.CalendarDataSource cds =
new Ektron.Cms.Controls.CalendarDataSource();
cds.queryParam = "calid";
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar;
//Add the DataSource object
webcalendar1.DataSource.Add(cds);
//If the queryString is used, show that calendar,
//otherwise show the following mashup
if ((Request.QueryString("calid") == string.Empty)) {
//Create three CalendarDataSource instances and add the
//sourceType and defaultId for each.
cds = new Ektron.Cms.Controls.CalendarDataSource();
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar;
webcalendar1.DataSource.Add(cds);
cds = new Ektron.Cms.Controls.CalendarDataSource();
cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar;
cds.defaultId = 88;
webcalendar1.DataSource.Add(cds);
cds = new Ektron.Cms.Controls.CalendarDataSource();
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cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar;
cds.defaultId = 376;
webcalendar1.DataSource.Add(cds);
}
//Fill and return
webcalendar1.Fill();
}

To see a single calendar such as 376, use this URL:
http://<server>/cms400developer/events.aspx?calid=376

To see all calendars together, do not use the query string parameter.
http://<server>/cms400developer/events.aspx

Using Taxonomy with Web Calendars
You can use taxonomy categories to filter calendar events. Calendar categories could include
meeting rooms, audience, or whether the event should appear on a special public calendar.
The following example organizes events based on locations and audience. See Also: Planning
a Taxonomy on page 778

After you create a taxonomy, you can assign its categories to events.
Use a CategoryID value in the CalendarDataSource to filter events according to taxonomy
categories. In the following example, the calendar shows events for the Training Center
(category 123) or Administrators (category 124).
<cms:WebCalendarID="webcalendar"runat="server">
<DataSource>
<cms:CalendarDataSourcedefaultId="726"sourceType="SystemCalendar">
<CMS:CategoryIDcategoryId="123"/>
<CMS:CategoryIDcategoryId="124"/>
</cms:CalendarDataSource>
</DataSource>
</cms:WebCalendar>

By using an ID of a higher category in the taxonomy tree, you can show all events under it.
For example, this taxonomy has 2 higher level branches with ID 100 and 200.
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If you set the category ID to 100, you see any events associated with categories 100, 111 or
112.
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Working with Discussion Boards
The discussion board feature provides topic discussions on your website. A site or
membership user with Add Topic permission creates a topic and posts a starter question. Site
visitors can then reply. Ektron supports an unlimited number of discussion boards. A
discussion board consists of a hierarchy. The following example shows the hierarchy with
sample data, to explain how each element is used.

On the website, if you click a discussion forum, you see its topics. If you click a topic, you see
its posts.
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In the Workarea, a discussion board appears as a top-level folder ( ) in the folder structure.
Forums appears under them. If you click a discussion board, its subjects and forums appear
in the right panel.

This section also contains the following topics.
Managing Discussion Boards
Working with Subjects
Working with Forums
Working with Topics
Working with Posts
Using Discussion Boards on Your Website
Using Discussion Boards in Community Groups
Discussion Board Server Controls

538
546
547
556
560
568
573
575
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Managing Discussion Boards
To implement a discussion board into your website, place a Forum on page 1740 server
control on a Web page. Then, select a discussion board. All subjects and forums within that
board appear on the Web page. You cannot selectively suppress subjects or forums. Keep this
in mind when determining the contents of a discussion board.
To view a discussion board, select it from the Folders display. When viewing the board, you
see all of its forums. You can click any forum to see its details.
An administrator determines the following discussion board features.
l

The subjects being discussed

l

A starter post that initiates a discussion

l

If users must sign in before posting to the forum

l

If a post appears as soon as someone submits it, or must be approved first
o If a post requires approval
n you can edit or delete it before it appears
n

anyone with permission to the board can edit, delete, or reply to a post from
the Workarea

This section also contains the following topics.
Creating a Discussion Board
Editing a Discussion Board
Deleting a Discussion Board
Modifying Permissions for a Discussion Board
Modifying Discussion Board Permissions for Membership Users
Granting Discussion Board Permissions
Removing Discussion Board Permissions
Editing Discussion Board Permissions
Changing Page Size for Discussion Boards
Defining Terms and Conditions
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542
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545
545
545
545

Creating a Discussion Board
1. From the Workarea’s Content tab, navigate to the folder in which you want to place the
discussion board.
2. Click New > Discussion Board. (You also can hover the cursor over the folder, right
click the mouse, and select Add Discussion Board.) The Add a Discussion Board to
folder screen appears.
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3. Complete the properties.
NOTE: Some items appear only when editing a discussion board’s properties.
l

l
l

Name (Enter, Edit)—Enter the name of the discussion board. This text describes
the board within the Workarea and on your website.
Title (Enter, Edit)—Enter the title of the board.
Accepted HTML (Enter, Edit)—A comma-delimited list of HTML tags allowed in the
eWebEdit400 editor. When left blank, all tags are available. Site visitors posting to
the forum can apply these tags to content when their forum editor is eWebEdit400
(set in the user profile). The default list is: br, hr, b, i, u, a, div, ol, ul,
li, blockquote, img, span, p, em, strong, font, pre, h1, h2, h3, h4,
h5, h6, address, embed
NOTE: Add the embed tag if you want users to insert WMV files into their posts.

l

Accepted Extensions (Edit only)—A comma-delimited list of file extensions that
can be uploaded. You can enter the extension with or without the period (.). Use a
comma to separate each extension.
The list appears at the bottom of the editor screen, notifying the person entering a
post which file types can be attached. The default list is: bmp, conf, doc, gif,
jpe, jpg, jpeg, png
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l

l

Max File Size (Edit only)—The maximum size of a file, in bytes, that a user can
upload. The default is 200000 bytes (.19 megabytes).
Topics: Require Authentication (Enter, Edit)—
Effect of this Field on the Website
Check this box if a site visitor must sign in to post to the discussion board. If the
user cannot access a login screen, the user cannot post. If this box is unchecked,
site visitors can post without signing in.
Effect of this Field within the Workarea
If this field is checked, only users with Add Topic or Edit Topic permissions for the
discussion board can create or reply to posts. See Also: Modifying Permissions for a
Discussion Board on page 542

l

l

Lock (Edit only)—Check this box if you want to prevent all posting to this discussion
board. You can do this temporarily or permanently. If a Board is locked, only
Administrator user group members can post to it, or edit or delete posts. Those
users can post from the website or the Workarea. You can alternatively lock any
forum underneath this Board via the forum properties screen.
CSS Theme (Enter, Edit)—Choose a style sheet to determine the appearance of the
discussion board on your website. Select any theme available in the CSS Theme
drop-down. The default is
siteroot/Workarea/threadeddisc/themes/standard.css. Alternatively, enter a
path below the site root folder to your custom CSS file in the path box. See Also:
Working with Discussion Boards on page 536
NOTE: If you edit a CSS file, you should save it under a new name. This prevents your
changes from being overwritten during an upgrade.

l

l

Page Template(Enter, Edit)—Lets you specify a template for the forum. If you do
not specify a template, the search results do not link properly to the forum. See
Also: Working with Templates on page 382. To preview what the forum looks like
within the selected template, click preview ( ) to the right.
Taxonomy: Required category selection (Edit only)—If you want all topics in
this discussion board to be assigned a taxonomy category, check Required
category selection. If you do, a signed-in user is prompted to select a taxonomy
category when creating a topic. This checkbox has no effect when creating new
topics within the Workarea. See Also: Using Taxonomies on page 777
l

Taxonomy: All taxonomies appear—Select a taxonomy whose categories will
be assigned to forum topics. The Taxonomies are applied on the Taxonomy
tab. The discussion board’s taxonomy represents another way to organize the
forum’s posts. See Also: Using Taxonomies on page 777
Effect of Assigning Taxonomy Categories to a Topic
When a discussion board server control is placed on a Web page, its display
includes a small taxonomy icon (circled below).

540

Ektron Reference

Editing a Discussion Board

When a site visitor clicks this icon, taxonomy categories are displayed. When
the user selects a category, the user sees its subcategories followed by all
forum posts assigned to that category. Below is an example of how a
discussion board’s posts might be organized by taxonomy category.

l

Subjects Tab(Enter, Edit)—Enter as many subjects as you wish. Each subject
contains one or more discussion forums. You must create at least one subject for
each discussion board.
NOTE: You can also add a subject by selecting a discussion board then selecting New >
Subjects.

l

Subject Sort Order—Subjects are the highest level of the hierarchy that appears
on your website. In the sample forum below, Latest Discoveries and Patient Care
are Subjects.

Subjects are sorted alphabetically unless you use the Sort Order field. The Sort
Order field accepts a number and uses it to sort a discussion board's subjects. The
lowest numbers appear near the top of the page.
To access the Sort Order field:
1. Save the discussion board.
2. Click the discussion board in the Workarea.
3. Click View > Properties.
4. Click the Subjects tab.
5. Modify the Sort Order field as needed.
l

Terms & Conditions Tab(Edit only)—Add the Terms & Conditions for using the
discussion board. By entering text in this text box and saving, you activate the
Terms and Conditions feature. See Also: Defining Terms and Conditions on
page 545

Editing a Discussion Board
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1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, navigate to the Discussion Board.
3. Click View > Properties.
4. Click Edit Properties.
5. Update the screen as needed.
6. Click Save Board Properties.

Deleting a Discussion Board
When you delete a discussion board, its subjects, forums, and posts are also deleted. When
deleted, they cannot be retrieved.
1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the discussion board.
3. Click Delete > This folder. A confirmation message appears.
4. Click OK.

Modifying Permissions for a Discussion Board
Discussion boards have a permission table that lets you determine the functions a user can
perform. (See Managing Folder Permissions on page 257.) Because discussion boards have
different functions than folders, the permission table is slightly different from regular folders.
In addition, each Forum has its own permission settings. By default, a forum inherits
permissions from its parent discussion board, but you can break inheritance and customize
permissions for a forum.
To access a discussion board’s permission table, navigate to and click the board so it appears
in the Workarea. Then, click View > Permissions (

).

NOTE: Only Administrators group members can access the discussion board Permission Table.
The following example shows a discussion board permission table for regular users.
Membership users have fewer permissions.
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When you create a discussion board, it gets it initial permissions from the parent folder but it
then is disconnected from the parent folder’s permission table. Subsequent changes to the
parent folder’s permissions have no effect on discussion board permissions.
The permission table has the following initial values from the parent folder (Parent Folder
Permission—Discussion Board Permission):
l

Read only—Read only

l

Edit—Edit Topic

l

Add—Add Topic

l

Delete—Delete Topic

l

Add Folders—Add Forum

l

Edit Folders—Edit Forum

l

Delete Folders—Delete Forum
NOTE: Because there are no corresponding permissions for the discussion board’s Moderate and
Post/reply permissions, their initial value is blank.

For example, if user JSmith has permission to perform all functions for a folder, and a
discussion board is created in that folder, JSmith initially receives the default permissions for
the discussion board. You can modify these permissions.
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The following table lists all permissions that you can grant to regular users. Only some
permissions can be granted to membership users.

Permission

Allows user to

Can be
assigned to
membership
users

Read only

View forums and posts; cannot submit a post

Yes

Edit Topic

Edit a topic’s title (Editing a Topic Title on page 558)

No

Add Topic

Add new topics (Adding a Topic to a Forum on page 556)

Yes

Delete Topic

Delete a topic (Deleting a Topic on page 559)

No

Post/Reply

Post a new topic or reply to an existing one, either from the Workarea
or the site. (Adding a Topic to a Forum on page 556 and Replying to a
Post on page 560)

Yes

Moderate

Approve and delete posts and topics. Also, receive notifications when
a post is reported using the report post feature; only applicable if the
forum’s properties field Moderate Comments is checked.
(Moderating from the Control Panel on page 561)

Yes

NOTE: Everyone who has Moderate permission will receive
notifications when a post is reported. See Also: Reporting a Post
on page 568
Add Forum

Create a new forum (Creating a Forum on page 548)

No

Edit Forum

Edit a forum (Editing a Forum on page 549)

No

Delete
Forum

Delete a forum (Deleting a Forum on page 550)

No

Modifying Discussion Board Permissions for Membership
Users
By default, membership users are assigned the following permissions:
l

Read only

l

Add Topic

l

Post Reply

They cannot be granted Edit or Delete topic nor advanced permissions (Add, Edit or Delete
forum). However, if a membership user creates a new topic, the user can delete it.
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1. Navigate to and click the discussion board so it appears in the Workarea.
2. Click View > Permissions.
3. Click the User Type drop-down field and choose Membership Users.
4. The View Permissions for Board screen appears.
5. Add new member users and groups, remove them, or change their permissions.

Granting Discussion Board Permissions
1. Navigate to and click the discussion board so it appears in the Workarea.
2. Click View > Permissions.
3. Click Add. All users and groups who are not currently assigned permissions appear.
4. Click any user or group. The Add Permission for Folder screen appears with the selected
user or group.
5. Assign appropriate standard and advanced permissions then click Save.

Removing Discussion Board Permissions
1. Navigate to and click the discussion board so it appears in the Workarea.
2. Click View > Permissions.
3. Click Delete ( ).
4. Select a user or group that you want to remove from the Permission table. A
confirmation message.
5. Click OK. The user is removed.
After you remove a user, discussion boards do not appear in that user's Workarea.

Editing Discussion Board Permissions
1. Navigate to and click the discussion board so it appears in the Workarea.
2. Click View > Permissions.
3. Click the user or group whose permissions you want to edit. The Edit Permissions screen
appears.
4. Change the settings as appropriate.
5. Click Save.

Changing Page Size for Discussion Boards
You can change the number of topics or posts shown on a page by changing the ek_PageSize
value in the web.config file.

Defining Terms and Conditions
A discussion board's Terms & Conditions convey your expectations to its users. If you add
Terms & Conditions, anyone posting to the board sees the following screen the first time a
post or reply is sent to a forum. Users can only post after agreeing to its Terms & Conditions.
To add terms and conditions text to a discussion board:
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1. Workarea Content tab > navigate to the discussion board to which you want to add
terms and conditions.
2. Click View>Properties.
3. Click Edit Properties.
4. Click the Terms & Conditions tab.
5. Add the terms and conditions text.
6. Click Save Board Properties.

Working with Subjects
This sections show you how to create and edit subjects in a Discussion board. See Also:
Subjects Tab(Enter, Edit)—Enter as many subjects as you wish. Each subject contains one or
more discussion forums. You must create at least one subject for each discussion board.You
can also add a subject by selecting a discussion board then selecting New > Subjects. on
page 541
This section also contains the following topics.
Creating a New Subject
Editing Subject Name and Sort Order

546
547

Creating a New Subject
1. Workarea Content tab > navigate to the discussion board to which you want to add a
subject.
2. Click New > Subject.
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Editing Subject Name and Sort Order

3. Enter a subject name and sort order.

4. Click Save Board Subject.

Editing Subject Name and Sort Order
1. Workarea Content tab > navigate to the discussion board that contains the subjects.
2. Click View > Properties.
3. Click the Subjects tab.
4. Click the subject that you want to edit. The current subject name and sort order appear
on a new screen. Edit as needed.

5. Click Save Board Subject.

Working with Forums
A forum is a particular thread within a discussion board. For each forum, you define:
l

name and Description

l

whether its posts must be approved before appearing on your website

l

if it’s accepting new posts

l

its sort order, which determines the sequence on the Web page within its subject

l

its subject

This section also contains the following topics.
Creating a Forum
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Editing a Forum
Deleting a Forum
Modifying Forum Permissions
Blocking an IP Address from a Forum
Adding an IP Address to the Restricted List
Editing a Restricted IP Address
Deleting a Restricted IP Address
Ranking Forum Users
Adding a User Rank
Deleting a User Rank
Changing a User’s Rank
Sending Notifications of Forum Activity
Creating the Email Message
Including Variables in the Default Message

549
550
550
550
550
551
551
551
552
553
553
555
555
555

Creating a Forum
PREREQUISITE
At least one subject.
1. Workarea Content tab > navigate to the discussion board to which you want to create a
forum.
2. Select a discussion board.
3. Click New > Discussion Forum. The Add a Discussion Forum to Board screen
appears.

4. Complete the fields.
l
Name—Enter the name of the discussion forum. The name identifies the forum in
the left side of the Workarea, next to a forum icon ( ). This icon distinguishes it
from content and blog folders. It also appears on the website.
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l

l

Description—Enter a more detailed description of the forum. The description
appears on the website, as illustrated above.
Moderate Comments—Checking this box causes comments to require approval
before appearing on the website and a post to be reported to all moderators of the
forum. See Also: Reporting a Post on page 568 and Setting Up Post Reporting on
page 568. Only users who are granted Moderate permission can approve
comments, thereby allowing them to be published on the site.
The Smart Desktop has a Forum Topics and Posts category. This tells you how
many posts currently require your approval before they appear on the site.

l

Lock Forum—Check this box to prevent all posting to this forum. You can do this
temporarily or permanently. If a forum is locked, only members of the
Administrators user group can post to it, or edit or delete posts. Those users can
post from the website or the Workarea.
A discussion board can also be locked. If a board is locked, a message on this
screen indicates that. In that case, no posting is allowed to this forum regardless of
this setting.

l

l

Sort Order—Enter a number if you want to arrange the sequence of forums within
the subject. If you do not, forums appear in alphabetical order within a subject.
Subject—Enter the subject within which this forum will appear on the website.

5. Click Add Discussion Forum.

Editing a Forum
1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the discussion board that contains the
forum.
3. Click the forum.
4. Click View Properties (

)

5. Click Edit Forum Properties.
6. Update the screen as needed. See Also: Name—Enter the name of the discussion forum.
The name identifies the forum in the left side of the Workarea, next to a forum icon ().
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This icon distinguishes it from content and blog folders. It also appears on the website.
on the previous page
7. Click Save.

Deleting a Forum
You can delete any forum. When you do, its topics and posts are also deleted. Once deleted,
they cannot be retrieved.
1. Workarea Content tab > navigate to the discussion board that contains the forum.
2. Click the forum.
3. Click Delete Forum (

). A message asks you to confirm.

4. Click OK.

Modifying Forum Permissions
You can use the discussion board permission features with any forum. See Also: Modifying
Permissions for a Discussion Board on page 542
1. Open CMS Workarea > Content.
2. Click the forum.
3. Click View Permissions (

). A permission table appears.

When you first view a forum’s permission table, you see a check box that lets you
maintain inheritance or break it. A forum initially inherits (that is, copies all permissions
from) its parent discussion board’s permission settings.
4. If you break inheritance by unchecking the Allow this object to inherit permissions
box, the forum permission screens change from view-only to edit. At this point, you can
modify the permissions.
To later restore inheritance, check the box. When you do, the parent discussion board’s
permissions overwrite any forum-specific changes. The forum then reverts to a readonly state. While inheritance is enabled, you must make permission changes at the
discussion board level.

Blocking an IP Address from a Forum
If you are not using authentication for the forums and want to block a site visitor from posting
to the forum, use the Restricted IP feature.

NOTE: In addition to using Restricted IPs for a specific forum, you can access the Restricted IP feature
from the Workarea > Settings > Configuration > Discussion Board > Restricted IPs. If you have
more than one forum, this lets you select the Discussion Boards to which the Restricted IPs are applied.

Adding an IP Address to the Restricted List
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1. In the Workarea, click the Content tab.
2. Select a forum from the folder structure.
3. Click New > Restricted IP.
4. Enter the IP Address to be blocked in the Block IP field.
5. Click Save. A list of restricted IP addresses appear.

Editing a Restricted IP Address
1. In the Workarea, click the Content tab.
2. Select a forum from the folder structure.
3. Click View > Restricted IPs. A list of restricted IP addresses appears.
4. Click the IP address to be edited.
5. Click Edit.
6. Edit the IP address in the Block IP text box.
7. Click Save.

Deleting a Restricted IP Address
1. In the Workarea, click the Content tab.
2. Select a forum from the folder structure.
3. Click View > Restricted IPs. A list of Restricted IP addresses appears.
4. Click the IP address to be deleted.
5. Click Delete ( ). A dialog asks if you are sure you want to delete the restricted IP
address.
6. Click OK to continue. A list of the remaining restricted IP addresses appear.

Ranking Forum Users
The User Ranking feature lets you recognize active forum contributors. You can create a
ranking system that moves a contributor to the next level after submitting a specified number
of posts. This is known as a ladder system, which lets forum contributors build credibility. For
example:
l

New User—Up to 9 posts

l

Intermediate User—10-19

l

Expert User—20 and up

To each rank, you can assign an image that appears below the user’s name on any post. The
rank also appears on a user’s forum profile.
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You can also create ranks that are independent of the ladder system. Such ranks have no
relationship to a contributor's number of posts. For example, after a forum user acquires
Ektron Developer Certification, the user is assigned the Ektron Developer rank.
You can move contributors from a non-ladder rank to the ladder system and vice versa.
Whether or not a contributor is in a ladder system, Ektron keeps a tally of posts. So, if the
user is moved into a ladder system at any time, he is assigned the correct rank.

Adding a User Rank
To add a user rank:
NOTE: You can also access the User Ranks screen from Workarea > Settings > Configuration >
Discussion Board > User Ranks. If you have more than one forum, this screen lets you pick the
discussion board to which a rank is assigned.
1. In the Workarea, click the Content tab.
2. Select a discussion board.
3. Click New > User Rank. The User Ranks screen appears.

l

552

Name—The name of the rank. For example, New User, Expert User, Developer, or
Associate.
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l

l

l

l

Rank Image—Click Upload to select an image to upload. When uploaded, the path
to the image appears in the text box.
Images are optional. If you assign an image, it appears below the user’s name on
any post.
Minimum Number of Posts—Enter the number of posts it takes to reach this
rank. If the Starting Rank box is checked, the number is 1 and cannot be changed.
Ladder System—Check this box if this rank is part of a ladder system. That is, a
rank based on the number of posts a user has submitted to this discussion forum. If
you uncheck Ladder System, Starting Rank and Number of Posts become
inactive, since they manage the ladder system.
Starting Rank—If you are using a ladder system, use this box to designate this as
the Starting Rank. A user is assigned to this rank after submitting the first post. A
discussion forum can only have one Starting Rank. Also, if this is the Starting Rank,
you cannot enter a number of posts.

4. Click Save.

Deleting a User Rank
1. In the Workarea, click the Content tab.
2. Select a discussion board.
3. Click View > User Ranks.
4. Select the rank you want to delete.
5. Click Delete ( ).
6. Click OK to the confirmation message.

Changing a User’s Rank
A user’s rank appears below the user name on any post the user has made. You can only
move a user into and out of a ladder system. You cannot change the person's rank—that is
determined by the number of posts.
To change a user’s current rank, you must know what it is. To change a user’s rank:
1. In the Workarea, go to Content and navigate to the forum to which the user has posted.
2. Click View > User Ranks.
3. Select the rank that you want to move the user out of. The User Ranks screen appears.
The lower half shows all users assigned that rank.
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4. Click the user that you want to move out of the rank. The screen displays all ranks. The
current one is selected.

5. Click next to the desired rank.
6. Click Save.
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Sending Notifications of Forum Activity
The discussion board’s Email Notification feature generates email for registered users when
certain forum activities occur. For example, you register to be notified when a new forum
post is created. When that event occurs, registered users receive an email with a link to the
new post. After the messages are set up, you don’t need to do anything—everything happens
in the background.

Creating the Email Message
You can create an email message to be sent when these discussion board events occur.
l

a new post is added

l

a new topic is added

l

someone reports a post See Also: Setting Up Post Reporting on page 568

A simple editor lets you apply some XHTML formatting the message. To create a message:
1. Workarea > Settings > Configuration > Discussion Boards > Messages.
2. Click Add.
3. Enter a title that describes the message.
4. At the Type field, select either NewForumTopic, ReportForumPost, or ForumPost.
5. Select whether to make the email message a Default message.
6. Enter the message subject.
7. In the editor, enter the message text. See Including Variables in the Default Message
below to display information about the about the new post or topic in the message.
8. Click Save.

Including Variables in the Default Message
Message text can include variables that retrieve information about the new post or topic. The
variables are surrounded by at signs (@). For example:
@appPosterDisplayName@ has created a thread you have subscribed to.

In the email, this text might read:
Alan Administrator has created a thread you have subscribed to.

Use the following variables in discussion board email notifications.
l

@appTopicTitle@—The title of the topic.

l

@appTopicId@—The integer ID of the topic.

l

@appRecipientDisplayName@—The display name of the email recipient.

l

@appRecipientId@—The email recipient’s integer ID.

l

@appRecipientFirstName@—The first name of the email recipient.

l

@appRecipientLastName@—The last name of the email recipient.

l

@appRecipientEmail@—The email address of the email recipient.

l

@appHostUrl@—The host site’s URL.

l

@appForumUrl@—The forum’s URL.

l

@appPostMessage@—The text of the message posted to the discussion board.
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l

@appPosterId@—The integer ID of the person who posted.

l

@appPosterDisplayName@—The display name of the person who posted.

l

@appPosterProfileUrl@—The profile URL for the person who posted.

l

@appPostUrl@—The URL of the post on the website.

Working with Topics
A topic is a specific issue to be discussed in a forum. For example, in a medical research
forum, a topic might be New Cancer Treatments. Before creating a topic, you must create a
forum into which to place it. To view a topic from the Workarea:
1. Workarea > Settings > Configuration > Discussion Boards > select a discussion
board.
2. Select a forum from the folder structure.
3. The forum’s topics appear in the right frame. Click the one that you want to view.
If an option is underlined, you may perform it; if not, you cannot. For example, if a post’s
status is approved, approve is not underlined because it is already approved.
This section also contains the following topics.
Adding a Topic to a Forum
Editing a Topic Title
Approving a Topic in the Workarea
Setting a Topic Priority
Locking a Topic
Deleting a Topic

556
558
558
559
559
559

Adding a Topic to a Forum
When you create a new topic, its first post is created from the topic message. If you add a
topic but are not a forum moderator, you only see the topic in the Workarea after it is
approved.
NOTE: You also can create new topics from the OnTrek user interface (Support > Support Forums).
To create a topic:
1. Workarea > Settings > Configuration > Discussion Boards > select a discussion
board.
2. Select a forum.
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3. Click New Topic. The Post New Topic screen appears.

l

l

l

l

Subject—Enter a short description of the topic. The topic subject appears on the
forum page.
Priority—Set the topic's priority, which determines where the topic appears in the
topic list on the site. The default setting is Normal.
o

Announcement—topic always appears at the top of the list. If a list has more
than one announcement, they are sorted by date with most recent on the top.
The Announcement icon (
) indicates its priority to the left of the title.

o

Sticky—topic appears near the top of the list, just below the announcements.
If a list has more than one sticky topic, they are sorted by date with most
recent on the top. The Sticky icon (
) indicates its priority to the left of the
title.

o

Normal—Topics with this priority follow Announcements and Sticky topics.
The Normal icon ( ) next to the topic indicates its priority.

Lock—Check this box if you want to prevent posting of replies to this topic. You can
do this temporarily or permanently. If a topic is locked, only Administrator user
group members can post to it, or edit or delete posts. Those users can post from
the website or the Workarea.
Message—Enter the topic text. This text appears on a new Web page after a
website visitor clicks a topic’s subject line.
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4. Click Save. The new topic appears in the list.

Editing a Topic Title
The only part of a topic you can edit is its title.
1. In the Workarea, click the Content tab.
2. Select a discussion board, then select a forum from the folder structure. The forum’s
topics appear in the right frame.
3. Click the one that you want to edit.
4. Click View Properties (

). The Edit Topic screen appears.

5. Modify the title as needed.
6. Click Save.

Approving a Topic in the Workarea
A topic needs approval if is created by a user without moderate permissions for the forum. An
unapproved topic is surrounded by a yellow border in the Workarea, and must be approved
before it appears on the website.
To approve a topic:
1. In the Workarea, click the Content tab.
2. Select a discussion board, then select a forum from the folder structure.
3. The forum’s topics appear in the right frame. Click the one that you want to approve. The
View Topic screen appears.
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4. Click approve.The topic is approved.

Setting a Topic Priority
In a forum, topics are sorted by priority. You can set a topic’s priority when you create it. A
forum moderator can change a topic’s priority. To set a topic property:
1. In the Workarea, click the Content tab.
2. Select a discussion board, then a forum from the folder structure.
3. Click on a topic.
4. Click View Properties (

).

5. Click Click here to Edit the Properties of this Topic. The Edit topic screen appears.
6. Choose one of the Priority options.
l
Announcement—topic always appears at the top of the list. If a list has more than
one announcement, they are sorted by date with most recent on the top. The
Announcement icon (
) indicates its priority to the left of the title.
l

l

Sticky—topic appears near the top of the list, just below the announcements. If a
list has more than one sticky topic, they are sorted by date with most recent on the
top. The Sticky icon (
) indicates its priority to the left of the title.
Normal—Topics with this priority follow Announcements and Sticky topics. The
Normal icon ( ) next to the topic indicates its priority.

7. Click Save.

Locking a Topic
Locking a topic prevents users from posting a reply to it. For example, you might create an
announcement, but don’t want people to reply to it. Or, you might decide that a topic has had
enough discussion and want to stop further replies. If a topic is locked, only Administrator
user group members can post to it, or edit or delete posts from the website or the Workarea.
To lock a topic:
1. In the Workarea, click the Content tab.
2. Select a discussion board, then a forum from the folder structure.
3. Click a topic.
4. Click View Properties (

).

5. Click Click here to Edit the Properties of this Topic. The Edit topic screen appears.
6. Check the Lock check box. (To unlock a topic, remove the check mark.)
7. Click Save.

Deleting a Topic
When you delete a topic, its posts are deleted, too. When deleted, they cannot be retrieved.
1. In the Workarea, click the Content tab.
2. Select a discussion board, then select a forum from the folder structure. The forum’s
topics appear in the right frame.
3. Click the one that you want to delete. The View Topic screen appears.
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4. Click Delete. A confirmation message appears.
5. Click OK if you are sure you want to delete it.

Working with Posts
When a new topic is created, the first post is created from the topic's message. Posts to a
topic are replies to the first post. You can search posts by clicking Search.
This section also contains the following topics.
Replying to a Post
Quoting a Post
Moderating from the Control Panel
Approving a Post
Editing a Post
Deleting a Post
Attaching Images and Files to a Post
Adding Video to a Post
Moving a Topic and Its Posts to Another Forum
Replacing Words in a Post
Using Regular Expressions
Viewing Replacement Words
Adding a Replacement Word
Editing a Replacement Word
Deleting a Replacement Word
Adding Emoticons to a Post
Creating or Editing an Emoticon
Deleting an Emoticon
Reporting a Post
Setting Up Post Reporting
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Replying to a Post
l

From the website:
1. Go to the Web page that hosts the discussion board.
2. Click the forum of interest.
3. Click Add Reply.
4. Enter the text of your post.
5. Click Post. If a topic is moderated, a message appears stating that your reply is
pending moderator approval.

l

From the Workarea:
1. In the Workarea, click the Content tab.
2. Navigate to a discussion board, then a forum. The forum’s topics appear in the right
frame.
3. Click the topic with the post to which you want to reply. The next screen, View
Topic, displays all posts to the selected topic.
4. Find the post to which you want to reply by reading its text.
5. Click Reply.
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6. In the Message field, enter the text of your post.
7. Click Save.

Quoting a Post
Quoting a post means that your reply begins with the original post. You can then add
comments and even edit the quoted post. For example, you can include only the portion on
which you are commenting. To quote a post:
1. Go to the Web page that hosts the discussion board.
2. Click the forum of interest.
3. Click a topic.
4. Find the post you want to quote.
5. Click Quote.
6. The editor appears with the quoted text at the top. You may edit the quoted post to focus
on the portion on which you are commenting.
7. Add your comments below the quote.
8. Click Post. The reply is added.

Moderating from the Control Panel
Users with forum moderate permissions can do so from the Control Panel by clicking the
Moderate link.
1. Log in to the site and navigate to the forum.
2. Click Control Panel.
3. Click the Moderate link. The forum’s control panel appears with a list of items requiring
approval.
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4. Click the item you want to approve. From this screen, you can edit, approve, or delete a
post.

Approving a Post
PREREQUISITE
Only users who are assigned the Moderate permission may approve a post.
When defining a forum, you can check the Moderate Comments field. If you do, forum
posts must be approved before they appear on the website. There are 2 ways to approve a
post in the Workarea.
l

From the website:
1. Log into the site and navigate to the forum.
2. Click Control Panel. The Control Panel appears.
3. Click the Moderate link.
4. Click the topic. The topic appears.
5. Click Approve. A message notifies you that the post was approved.

l

From the Workarea's discussion board:
1. In the Workarea, click the Content tab.
2. Select a discussion board, then a forum.
3. The forum’s topics appear in the right frame. Click the one that has the post that
you want to reply to. (Unapproved posts have an Approval Needed icon in the left
column ( ).
4. The next screen, View Topic, displays all posts to the selected topic.
5. Find the post you want to reply to. Unapproved posts have a yellow border.
6. Click approve under the post icon.

Editing a Post
You can edit the text of a post but you cannot edit its title.
l

From the website
1. Go to the Web page that hosts the discussion board.
2. Click the forum of interest.
3. Find the topic you want to edit.
4. Click Edit.

l

From the workarea
1. In the Workarea, click the Content tab.
2. Select a discussion board, then a forum from the folder structure.
3. The forum’s topics appear in the right frame. Click the one that has the post that
you want to edit. The View Topic screen displays all posts to the selected topic.
4. Find the post that you want to edit and click edit under the post icon. The Edit Reply
screen appears.
5. Update the text as needed.
6. Click Save.
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Deleting a Post
l

From the website
1. Go to the Web page that hosts the discussion board.
2. Click the forum of interest.
3. Find the topic you want to delete.
4. Click Delete.

l

From the Workarea
1. In the Workarea, click the Content tab.
2. Select a discussion board, then a forum from the folder structure. The forum’s
topics appear in the right frame.
3. Click the one that has the post you want to delete. The View Topic screen displays
all posts to the selected topic.
4. Find the post that you want to delete and click delete under the post icon.

Attaching Images and Files to a Post
You can add an attachment to a post. The Attached Files field lists allowed file types. The
list of file extensions and maximum file upload size are defined for the discussion board.
1. Create a new post or reply to an existing post.
2. Click Attachments. The Attachments window appears.

3. Click Browse... to navigate to the file that you want to attach.
4. Click Open.
5. Click Attach to attach the file to the post. The file appears in the list of Current File
Attachments.
6. After you add all attachments, click Close.
To remove a file from the list of attachments:
1. Click Attachments below the editor.
2. Highlight the attached item.
3. Click Remove.
4. Click Close.
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Adding Video to a Post
1. Click Insert Embedded Video (

) in a forum post. The Insert Embeded Media screen

appears.
2. Add your embedded HTML code. For example:
<object width="425" height="350">
<param name="movie"
value="http://www.youtube.com/v/8K_NQe57C-k"></param>
<param name="wmode"
value="transparent"></param>
<embed src="http://www.youtube.com/v/8K_NQe57C-k"
type="application/x-shockwave-flash"
wmode="transparent" width="425" height="350"></embed>
</object>

3. Click Insert. The video is embedded in the content.

Moving a Topic and Its Posts to Another Forum
To move a topic and its associated posts in one forum to another, the forum to which you
want to move the topic and posts must exist.
1. Access a page on your website that has a login button.
2. Sign in as a member of the Administrators group or as a Moderator of the board.
3. Navigate to a page with discussion board and select a forum.
4. Navigate to a topic page.
5. Click the Move to... drop-down list.
6. Select the topic to which you want to move.
7. Confirm that you want to move all posts.
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Replacing Words in a Post
You can configure Ektron to replace unwanted words in a post, such as obscene or indecent
words that should not appear on your site. You also can fix commonly misspelled words. For
example, the can replace teh.
The Replace Words feature works with exact matches but does not append words. For
example, if you replace car with auto, the sentence I bought the car from the cartel becomes
I bought the auto from the cartel. Note that cartel did not change to autotel even though the
word car appears in cartel.

Using Regular Expressions
If you want the Replace Words feature to modify words that contain a word you to replace,
use Regular Expressions. A Regular Expression, often referred to as regex, is a pattern of
metacharacters placed around a word that describes a string. Used for string manipulation,
regex lets you detail a succinct description of a group of words without having to detail each
word in the group.
l

l
l

l

l

l

l
l

l

l

l

.—Matches any character, similar to a wildcard. For example, .ar matches any 3-letter
word ending in ar, such as car, bar, tar or far.
|—An or operator. For example, steak|stake would find steak or stake.
[ ]—Matches one character between the brackets. For example, [rst] matches r, s or t.
[d-g] matches d, e, f, or g. Another example, [bc]ar matches bar and car. If you need to
match a dash (-), use it a the beginning or end of the group. For example, [xyz-] or [xyz].
[^ ]—Matches one character not in the group. For example, [^rst] matches any
character other than r, s or t. Another example, [^bc]ar does not match bar or car, but
does match tar and far.
^—Matches the beginning of any line. For example, ^[bc]ar matches bar or car, but
only at the beginning of a line.
$—Matches the end of any line. For example, ^[bc]ar matches bar or car, but only when
it appears at the end of a line.
( )—Marks a sub expression. For example, alt(a|e)r finds altar or alter.
*—When an expression is followed by *, it matches zero or more versions of the
expression. For example, [rst]* finds (blank), r, s, t, rs, sr, rt, tr, st, ts, rst, rts, srt, str,
trs and tsr.
+—When an expression is followed by +, it matches one or more versions of the
expression. This differs from * because it does not match (blank). It must match at least
one character. For example, r+ matches r, rr, rrr and so on.
{x,y}—Must match at least x times and not more than y times. For example, s{2,4}
matches ss, sss and sss. You can also use {x} to specify an exact match. For example, s
{3} matches sss. You can use {x,} to specify that the match is at least x amount of
times. For example, s{4} matches ssss, sssss, ssssss and so on.
?—Must match the preceding character zero or one times. For example, Boa?rder
matches boarder and border.

Viewing Replacement Words
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1. In the Workarea, click the Content tab.
2. Select a forum from the folder structure.
3. Choose View > Replace Words. A list of word to be replaced appears.

Adding a Replacement Word
NOTE: In addition to using Replace Words for a specific forum, you can access the Replace Word feature
from the Workarea > Settings > Configuration > Discussion Board > Replace Words. If you have
more than one forum, this allows you select to which discussion boards the Replace Words feature is
applied.
1. In the Workarea, click the Content tab.
2. Select a forum from the folder structure.
3. Click New > Replace Word. The Replace Words screen appears.
4. Click Add.
5. Add the word to be replaced in the Old Word textbox.
6. Add the replace word in the New Word textbox.
7. Select the language for the Replace Word.
8. Click Save.

Editing a Replacement Word
1. In the Workarea, click the Content tab
2. Select a forum from the folder structure.
3. Click View > Replace Words.
4. Click either the Old Word or the New Word to edit.
5. Click Edit.
6. Change the Old Word, New Word or Language.
7. Click Save.

Deleting a Replacement Word
1. In the Workarea, click the Content tab.
2. Select a forum from the folder structure.
3. Click View > Replace Words.
4. Click either the Old Word or the New Word to delete.
5. Click Delete. A dialog box asks if you are sure you want to delete.
6. Click OK.

Adding Emoticons to a Post
IMPORTANT: This topic applies to the eWebEdit400 editor only.
An emoticon is an icon used to express emotion in a forum post. In the post editor, click the
emoticon ( ) symbol.
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You can also enter a few characters that resemble the image. For example, to insert
,
enter O:\). While working in a post, the user only sees the text. But when the post is saved,
Ektron converts the text to the corresponding emoticon. In all subsequent work with the post,
users see only the emoticon. You can add new emoticons at Settings > Configuration >
Discussion Boards > Emoticons.

You also can place emoticon images in the following folder:
webroot\Workarea\threadeddisc\emoticons. Administrators reference these files when
editing or creating new emoticons.

Creating or Editing an Emoticon
1. Within the Workarea, go to Settings > Configuration > Discussion Boards >
Emoticons.
2. Click the emoticon text or image that you want to edit.
3. Click Add or Edit.
l
Emoticon Text—Enter or update the characters a forum participant enters to
insert this emoticon.

Ektron 8.7

567

Managing Content

l

l
l

Emoticon Image—Enter the name of the image file that appears after a user
enters the above Emoticon text and saves the post. Administrators place
emoticon images in the siteroot\Workarea\threadeddisc\emoticons folder.
Regex—See Using Regular Expressions on page 565
Language—Select the emoticon’s language from the drop-down list. If a forum is
language-specific, only emoticons assigned to that language or all languages are
available.

Deleting an Emoticon
1. Within the Workarea, go to Settings > Configuration > Discussion Boards >
Emoticons.
2. Click the emoticon that you want to delete.
3. Click Delete.
4. Reply to the confirmation message.

Reporting a Post
You can allow site visitors to report inappropriate posts, such as spam or offensive posts.
When a site visitor clicks the Report Post button, an email notification is sent to all forum
moderators. Any moderator can review the post and decide to edit, delete, or leave it alone.
To edit the report post message, go to the Workarea and choose Settings > Configuration
> Discussion Boards > Messages and select ReportForumPost.

Setting Up Post Reporting
When you set up forum post reporting, you add a Report Post button to the bottom of each
post to let site visitors report posts. Clicking Report Post sends an email to moderators, who
can view the post and decide whether to edit, delete or leave the post.
NOTE: Your Ektron Web server must be set up to send emails. See Installing Ektron on page 9.
1. From the Workarea, choose Content.
2. In the left panel, select a discussion board from the folder structure.
3. Select a forum.
4. Click Properties (

).

5. Click EditForum Properties.
6. Check the Moderate Comments box.
7. Click Save.

Using Discussion Boards on Your Website
This section explains how to work with a discussion board on your site.
This section also contains the following topics.
Using the Control Panel
Approving a Topic on Your Website
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Using the Control Panel

Sorting Topics
Deleting a Topic
Suppressing User Information from the Forum Profile Display
Outputting a Forum as an RSS Feed
Subscribing to a Discussion Board
Reviewing Subscriptions
Deleting a Subscription
Sending a Private Message to a Forum Member
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Using the Control Panel
The Control Panel lets logged in users view your profile, read, reply to, and delete private
messages. It also lets users with moderate permissions moderate the forum. The Control
Panel button is located at the forum level.
The Inbox view appears by default. From it, you can...
l

read a message by clicking on it. A read message's icon changes from unread (
read ( ).

) to

l

view information about the message sender by clicking the name.

l

delete the message by clicking the corresponding check box then the Delete button.

l

switch to a different view.

l

check your subscriptions.

l

reply to a message by clicking Reply (

).

IMPORTANT: When replying to a private message, you add your response to the existing message. Only
one message is created.

Approving a Topic on Your Website
A topic needs to be approved when a user who does not have moderate permission for the
forum adds a topic. When you view topics on the site, those that need approval have a
different background color.

From this screen, you can click Approve next to the topic’s title. You could also click the
topic’s title to view it and click Approve on that screen.

Sorting Topics
Ektron 8.7
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1. Go to the Web page that hosts the discussion board.
2. Click the forum of interest.
3. Click any column title to sort by alpha or numerical order.
On the first click, items are sorted first by numeric (1-10) values, then by alpha values
(A to Z). Click a column title a second time to sort the items in reverse. When first
viewed, the list is sorted by Last Post date and time.

Deleting a Topic
PREREQUISITE
Topics can be deleted from a forum by the users who created them or by users with
the Moderate permission. This includes Membership users.
WARNING! When you delete a topic, its replies and posts are also deleted.
1. Go to the Web page that hosts the discussion board and click the forum of interest.
2. Click the topic you wish to delete.
3. Click Delete Topic. A dialog asks you to confirm.
4. Click OK.

Suppressing User Information from the Forum Profile
Display
Anyone browsing a discussion forum can view contributor information by clicking the user
name. However, if the forum server control’s HideUserProfile property is true, nonadministrator users cannot see the profile, even if the Private Profile setting is set to
Public. Administrators can see the profile, regardless of how the HideUserProfile property
is set. The profile contains the following user information.
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l

First Name

l

Last Name

l

Email—email address

l

Joined—date the user joined

Ektron Reference

Outputting a Forum as an RSS Feed

l

Last Visit—date the user last visited the site

l

Number of Posts—the number of posts a user has contributed

l

Post History—a list of posts the user has contributed

Users can determine if their profile is viewable via the Private Profile drop-down box on
the Membership Registration screen and the Edit Profile screen. The Membership Registration
screen appears wherever your developer inserts the Membership Server Control. If Private
Profile is set to Private, profile information is suppressed. If it is set to Colleagues, only a
user’s colleagues can see the person's profile. When set to public, everyone can see a user’s
profile information.

NOTE: If the forum server control’s HideUserProfile property is set to true, non-administrator forum
visitors cannot see a user profile, even if the Private Profile field is set to Public.
If you want to suppress the display of user names as an administrator:
1. If the user is a regular user, go to Settings > Users and select the user whose
information you want to suppress.
If the user is a membership user, go to Settings > Community Management >
Memberships > Users and select the user whose information you want to suppress.
2. In the User Properties area of the screen, check the Private Profile checkbox.
NOTE: If the forum server control’s HideUserProfile property is set to true, non-administrator
forum visitors cannot see the profile, even if the Private Profile check box is unchecked.

Outputting a Forum as an RSS Feed
You can output a forum as an RSS feed by clicking the RSS feed button ( ). Each level of the
forum has an RSS feed button. This lets you output a specific topic as an RSS feed.
<?xml version="1.0" encoding="UTF-8" ?>
- <rss version="2.0">
<!-- Generated by Ektron -->
- <channel>
<title>Ektron Medical Center Forum</title>
<link>http://test/webform.aspx</link>
<description>Ektron Medical</description>
- <item>
<title>Research</title>

Ektron 8.7

571

Managing Content

<link>http://test/webform.aspx?g=topics&f=108</link>
- <description>
<![CDATA[ Latest medical research ]]>
</description>
<pubdate>Mon, 7 Feb 2012 09:56:00 GMT</pubdate>
</item>
</channel>
</rss>

Subscribing to a Discussion Board
1. After logging into a discussion board, you can subscribe to a forum post and replies by
clicking the Subscribe button ( ). The button appears at each discussion board level, so
that a user can subscribe to forums and topics of interest.

After clicking the button, the following screen appears.

2. Select a notification type, listed below.
l
All Posts—notifies you when any post or reply is added
l

Replies to Me—notifies you when someone replies to your post

3. Click Add Subscription.

Reviewing Subscriptions
To review forum subscriptions, go to the Control Panel and click Notifications in the lower
left corner. A screen indicates each discussion board level to which you have subscribed.
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Deleting a Subscription
To delete a subscription, check the corresponding box and click Delete.

Sending a Private Message to a Forum Member
Logged-in users can send a private message to the person who created a post or reply. Only
the sender and receiver can view private messages. This requires both users to be either an
Ektron user or a Membership user.
1. Navigate to a post and click the user’s name.
2. When the User Profile appears, click Message. The Message screen appears.
3. The To: field is filled automatically. You cannot add additional members.
4. Enter a subject.
5. Enter a message.
6. Click Post.

Using Discussion Boards in Community Groups
A Community Group can have its own discussion board. This provides a forum for communitybased discussions that are limited to forum members. All discussion board features are
available to a forum in a community group. The image below shows a discussion forum on a
community group page.
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To use a group discussion board, first add the group discussion forum to the database. Each
group needs to do this one time when they decide to host a discussion forum for their group.
To add a group discussion forum database:
1. Log in to your website.
2. Navigate to your group Web page.
3. Click Edit Group. The Edit Group Link appears.
4. Check the Create Group Forum box to create a group forum in the database. After the
group forum database is created, you cannot uncheck this option.

5. Click Save.

Determining which File Types may be Uploaded to a
Community Group
To view and update the file types that may be uploaded to a Community Group:
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1. Navigate to the group page as the group administrator.
2. Click Edit.

3. Edit the Accepted Extensions: field.

Discussion Board Server Controls
Ektron provides 3 server controls for use with discussion boards.
l

Forum on page 1740—place a discussion board on a Web page

l

ActiveTopics on page 1637—display the most active or most recent topics and posts

l

PostHistory on page 1813—display a user's list of posts

After creating at least one hierarchy of discussion board elements, place a Forum server
control on a Web page. If you want to require site visitors to authenticate, the Web page that
hosts the forum should also contain:
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l

l

a Membership server control (or a link to page that has one). This lets site
visitors/membership users register for discussion boards.
a Login server control that lets the site visitor/membership user log in

NOTE: You should add text below the Login server control to remind the site visitor to enter the person's
email address at the User field. For example, “At the User field, enter your email address.”
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Working with Content Reports
The Workarea’s Reports > Contents folder contains reports to help you manage the
workflow of Ektron content. In most cases, you choose a report that corresponds to a content
status, then view content in that status. If appropriate, you can perform tasks on the content.
For example, you can check in checked-out content.
This chapter explains how to access the Workarea’s reports folder, set criteria that determine
the information on the reports, and actions you can perform on them.

Approvals
Each content item awaiting your approval appears on this report. Thus, you can quickly find
all such content without searching through every folder.

l

Title—Title of content.

l

Request Type—Request made for the content. Either Publish or Delete.

l

Start Date—Start date, if any, assigned to the content. Determines when approved
content will go live on website.

l

Date Modified—Date the content was most recently changed.

l

Submitted By—User who submitted content for approval.

l

ID—Content ID number.

l

Language—Content language.

l

Path—Path to folder where content resides.

From the approvals report, you can approve or decline content that was submitted to you.
1. Go to the Workarea > Reports > Contents screen.
2. Click the content you want to approve or decline. The View Content Awaiting Approval
page appears.
3. Perform an action.
l
Publish—Accept changes to content and publish it to site.
If there is a subsequent approver in the content’s approval chain, a Submit button
appears instead. If you click Publish but the content has an incomplete task
assigned to another user, the content cannot be published. Instead, an error
message appears.
l

Decline—Reject changes and keep current content on website.
You are prompted to enter a comment for the decline. The author who made the
change is notified by email.
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The content inserted by the last editor remains in the file. If you do not want it to
remain, choose Edit.
l
l

l

Edit—Check out content and change it if desired.
View Published/Staged—Toggle between published and submitted versions of
content. This can help you compare differences.
Back—Go back to previous screen.

The selected content is either submitted to the next publisher, published immediately, or
deleted, depending on the content’s approval chain.

Checked In Content Report
Displays all the content currently in a checked-in status.
l

Title—Title of content.

l

ID—ID number assigned to content by Ektron.

l

Last Editor—Last user to edit the content.

l

Date Modified—Date and time content was last edited.

l

Path—Folder location of content in Ektron website.

Checked Out Content Report
Displays all content currently in a checked out status.
l

Title—Title of content.

l

ID—ID number assigned to content by Ektron.

l

Last Editor—Last user to edit the content.

l

Date Modified—Date and time content was last edited.

l

Path—Folder location of content in Ektron website.

After selecting content, check it in using the Checkin button.

New Content Report
Displays content in a new state, that is, it was created and saved but never published.
l

Title—Title of content.

l

ID—ID number assigned to content by Ektron.

l

Last Editor—Last user to edit the content.

l

Date Modified—Date and time content was last edited.

l

Path—Folder location of content in Ektron website.

Submitted Content Report
Displays all content in a submitted state. The report contains the following information.

578

l

ID—ID number assigned to content by Ektron.

l

Last Editor—Last user to edit the content.
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l

Date Modified—Date and time content was last edited.

l

Path—Folder location of content in Ektron website.

While viewing the Submitted Content report, you can view the content’s position is its
approval chain. Then, ask those individuals to complete their approval.
1. From the Submitted Content Report, click the content’s title. The View Content page
appears.
2. Click the Properties tab. The Approvals line indicates (in red text ) the content’s
position in the approval chain.

Content Pending Start Date Report
Displays all content that was approved, but whose start dates haven’t occurred. Each content
item on the report contains the following information.
l

Title—Title of content.

l

ID—ID number assigned to content by Ektron.

l

Last Editor—Last user to edit the content.

l

Start Date—Date and time content will go live on website.

l

Path—Folder location of content in Ektron website.

You may edit content on the Pending Start Date Content report by clicking the content you
want to view and using the toolbar at the top of the page, perform any action available.
See Also: Scheduling Content on page 296

Refresh Reminder
Displays all content whose end date has passed and whose archive option is set to Refresh
Report. This content is still visible on the website. Its appearance on this report indicates
that it is due for review.
l

Title—Title of content.

l

ID—ID number assigned to content by Ektron.

l

Last Editor—Last user to edit the content.

l

Date Modified—Date and time the content was last updated.

l

Path—Folder location of content in Ektron website.

If you review content and decide it should no longer appear on your site, follow these steps to
remove it. The content will be visible if you browse to it through the Workarea, but won’t
appear to site visitors.
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1. From the Refresh Reminder Report, click the content.
2. From the View Content screen, click Edit (

).

3. Click the Schedule tab.
4. Under Action on End Date:, click Archive and remove from site (expire).
See Also: Scheduling Content on page 296

Expired Content Report
Displays all content whose end date has passed. Such content is no longer visible on the
website.
l

Title—Title of content.

l

ID—ID number assigned to content by Ektron.

l

Last Editor—Last user to edit the content.

l

End Date—Date and time the content expired.

l

Path—Folder location of content in Ektron website.

You may edit any content on the Expired Content report by clicking the content you want to
view and using the toolbar at the top of the page to perform any action available.
See Also: Scheduling Content on page 296

Content to Expire
Lists all content whose end date will occur between today and a number of days that you
specify. For example, if today is January 1 and you select 10 days, the report lists all content
whose end date is January 1 through January 10.
After viewing the report, you can click any content and proceed to the View Content screen for
it. From there, you can edit information about it, including its end date if desired.
l

Title—Title of content.

l

ID—ID number assigned to content by Ektron.

l

Last Editor—Last user to edit the content.

l

End Date—Date and time the content expired.

l

Path—Folder location of content in Ektron website.

To select the report’s date range, you have 2 options:
l

Enter a number in the Days field. Then click View Reports (

l

Select a number from the drop-down list below the Days field

After selecting a number of days, click view (
time frame.

).

) to see all content that will expire within that

See Also: Scheduling Content on page 296

Site Update Activity Content Report
Provides a snapshot of the freshness of your website content. Specifically, it lists how many
content items were published within a folder and date range you select, organized by folder.
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For example:

To choose which content items appear on the report:
1. Choose a Start Date by clicking the calendar icon. You also can choose an End Date
using the same procedure. (Today is the default end date.)
2. At the Select field, choose a folder. The Root folder is the default selection. (Only
folders for which you have read-only or greater permission appear.) To change that
selection, click the folder name. To select all folders on the screen, click the Select All
checkbox. Otherwise, select folders by clicking the corresponding checkbox. There is
also an option to Include Sub-folders of the selected folders.
3. Choose the Report type, which determines the information you will see on the report.
Options are explained below.
l
Executive View
o name of each page that was published
o

how many times it was published

o

date it was last published
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o

users who published page

o

total numbers are not provided

l

Detail View Example

l

Combined View—combination of Executive and Detail views

4. To exclude users or user groups from the report, use the Exclude Users field. For
example, you want to see all updates other than those you have completed. When you
click Exclude Users, an alphabetical list of users appears, followed by user groups.
5. Click Get Result.

Asynchronous Log File Reporting
When the Message Queuing and Asynchronous Process are set up and running, you can access
a report of any problems with the Asynchronous Processor. You can also email it to any
Ektron user.
PREREQUISITE
Define the path to your website's asynchronous processor service on the Settings >
Configuration > Setup screen's Asynchronous Processor Location field.
To access the Asynchronous Process log:
1. From the Workarea, click Reports.
2. Click Contents > Asynchronous Log File Report.
3. Any problems appear on the screen.

Search Phrase Report
Displays terms entered into a Search field within a selected date range. Use the report to
discover the kind of information site visitors are searching for.
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Narrow down the search results by selecting any combination of these criteria.
l

l

l

language—the language of the search page (either Workarea or website search). The
user performing the search can choose a language before searching. If the user does not
choose a language, the search uses the default one. This report can show results from all
languages or one that you select.
a minimum number of occurrences of the word or phrase to return. For example, you
only want words or phrases entered into the Search Text field at least 10 times during
the last month.
date range

The report shows the number of occurrences of each term. Terms are arranged in this order.
l

words or phrases with the most occurrences appear first

l

if several terms have the same number of occurrences, they are arranged alphabetically

Also, terms entered into the website or Workarea search are surrounded by parentheses ().
Terms entered into the Advanced Workarea search have no parentheses. The Microsoft
search engine uses this syntax to find content.

Preapproval Groups
Lists all preapproval groups assigned to folders within Ektron. To access it, go to Workarea
> Reports > Contents > Preapproval Groups. See Also: Setting Up an Automatic Task
for Pre-approving Content on page 1043
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Bad Link Report
Lists invalid links to external URLs within your content. (An invalid link returns an error code
to your browser.) The report lists the following information about each item that contains a
bad link.
l

title

l

error description

l

Source, that is, item type followed by information about the item
o if the error is in a content block, you see Content followed by its id number and
language locale id
o

if the error is in a Smart Form, you see Smart Form followed by its ID number

o

if the error is in a menu, you see Menu Item (11,0,1033). The parameters are:
menu ID, menu item ID, and language ID.

o

if URL Aliasing is on, you see ASPX Template followed by the template name

l

the anchor (<a>) tag to which the bad link is assigned

l

URL that cannot be resolved (labeled Invalid Link)

NOTE: The report does not check quicklinks embedded in the content.
The report scans the following types of content.
l

published HTML content

l

published XML content

l

HTML forms

l

XML Smart Forms

l

menus

l

active system templates

When the scan is complete, the report lists any item that includes an invalid URL. From the
list, you can click a button to access the item, then update or remove the bad link.
To run the Bad Links Report, go to Reports > Contents > Bad link report. You
immediately see its status, either Done or Running.
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l

l

l

l

To begin, click Check Links (
new data.

). As the report progresses, existing data is replaced by

While the report scans content, you can work in other areas of Ektron and even sign off.
These actions have no effect on the collection of data.
After content is scanned, the report’s status changes to Done. If desired, print the
report by clicking Print.
To launch the broken link in a browser, move the cursor over it and click when the cursor
turns into a hand.

Fixing a Bad Link
1. Click Edit (

).

2. Select the indicated text.
3. Right-click and select Set Link Properties to access the hyperlink dialog.
4. Update or remove the bad link.
5. Save your changes.
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Excluding Pages from the Bad Link Report Process
You can exclude links or pages from the Bad Link Report process because it is unnecessary or
undesirable to test them. For example, you want to exclude pages with
l

links that log out of the site or Workarea

l

links that go to Pay-per-Click

l

links that start another process or register an event

l

links to new content you have not published

To exclude pages from this process:
1. Edit the file [siteroot] > Workarea > ekbadlinkrpt.excludes.
2. Enter a string to exclude—one per line. Any URL that contains this string is excluded.
Examples:
l
gif would exclude all links ending with .gif
l

/commerce/cart excludes links to /commerce/cart.aspx and
/commerce/mycart.aspx.

3. Save the file.
The following shows an excluded URL on the Bad Link Checker status page.

Content Flags
Display a list of flags assigned to content. See Also: Defining Flags for Content on page 1239

Content Reviews
Has pending reviews. See User-Ranking of Content on the facing page for more information.
See Also: Viewing Pending Reviews on page 589
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User-Ranking of Content
The Content Review feature lets you:
l

place a star-based scale on any page of your website

l

let users apply full or half-star rating increments and a comment

l

add reviews, depending on how the feature is used

l

moderate the review comments

l

display reviews and comments next to content for others to see

l

l

run reports to find the highest-rated content; tweak poorly-rated or reviewed content to
achieve optimal ratings
control which reviews get posted through a moderation feature

The ContentReview server control enables Ektron users, membership users, and site visitors
to rate and review content on a Web page, and lets you display the reviews on your site. See
Also: ContentReview on page 1712

Ektron restricts users to one review per page. If a regular or membership user logs in before
rating a piece of content, Ektron remembers the user ID. For any other site visitor, Ektron
places a cookie on the person's computer. So, when a page with a ContentReview server
control is visited, Ektron checks the user ID and cookie. If neither exists, it displays a rating
scale. If the user already rated the page, the user can edit the review but not enter a new
one.
NOTE: If you are not logged in as an Ektron or membership user, the browser must have cookies enabled
to submit a content review.

Viewing a History of Reviews
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1. Go to Workarea > Content > the folder that contains the content.
2. Click the content item.
3. Click View Content Reports (

). (For an eCommerce catalog entry, select Reports

> Content Statistics.) The Rating tab is selected by default. If desired, enter a range
of start and end dates.

4. Click Get Reviews.
5. If Microsoft Excel is installed on your computer, you can export the ratings detail to
Excel for further data manipulation. To do so, click Export to Excel at the bottom of the
Content Report.

Moderating Reviews
Ektron lets you moderate reviews. This means that a review must be approved by an Ektron
user who has Edit permission for the content before it appears on your site. You enable or
disable this capability via each ContentReview server control's Moderate property. The
options for authorized users to moderate reviews are as follows.
l

Workarea > Smart Desktop > Content Reviews

l

Workarea > Reports > Contents > Content Reviews

l

Content Rating screen associated with a content item

Upon viewing a pending review, an authorized user has 3 choices.
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l

approve it—your website displays the review

l

decline it—it is stored with the content's review history but is not visible on your site
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l

edit it—update then approve it; your website displays the edited version

If a ContentReview server control is moderated, the following occurs.
l
l

a site visitor sees a submitted review only after it is approved.
an Ektron user can view the status of his or her review by logging into the Workarea and
clicking Reports > Contents > Content Reviews.

If a review was rejected or has been pending for too long, the user can submit another.

Viewing Pending Reviews
1. From the Smart Desktop, click the Content Review widget.
You can approve or decline reviews from the Content Review widget. But if you click
View All> and proceed to the Pending Reviews screen, you have additional options.
2. Click View All>. The Pending Reviews screen appears. You can also access the Pending
Reviews screen from the Workarea > Reports > Contents > Content Reviews.
3. From there, you can
l
Approve or decline a review—click the appropriate radio button

l

l

l

l

l

Edit a review's rating, review, or status—click its title and an edit screen appears.
Change as needed.
Print pending reviews—click Print (

).

Email—click Email ( ) to email this report to Ektron users. Next, select
recipients, then click Email ( ).
Filter reviews by folder— Click Folder (
pending reviews. Then, click Save.

) and navigate to the folder that contains

Filter reviews by language—from the Language drop-down, select the language of
the pending reviews.
NOTE: To delete a review, use the Content Review Screen. See Also: Moderating Reviews
from the Content Review Screen below

4. After you approve or decline reviews, click Save. Approved reviews appear on the site.
NOTE: A site visitor can change his or her review at any time, even if its status is pending or
rejected; then, the information is updated in the Workarea, and the review's status changes to
pending.

Moderating Reviews from the Content Review Screen
1. In the Workarea, navigate to the content item.
2. Click View Content Reports (

).
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3. Click the Rating tab.
4. Click Get Reviews. A list of reviews appear for the content.
5. Click the date of content to be moderated. The View Content Review screen appears.

l

l

To change information on this screen, click Edit. From the Edit screen, you can
change the rating, review and status. When finished, click Save.
To delete the review, click Back (

) then Delete ( ).

Purging Review Data
1. Within the Workarea, navigate to the content.
2. Click View Content Reports (

).

3. Select the date range of the data you want to purge using Start Date and End Date.
4. Click Purge Reviews.
5. Click OK to the confirmation message.

Using the Map Server Control
The Map server control displays a map that flags locations of interest. Each location is an
Ektron content item to which map information was added. For example, if your site hosts a
school district, each location could represent one school. For information about Map server
control properties, see Map on page 1765.
You can zoom the map in and out, get directions to a location, and narrow the list of locations
using a text search. For example, if your map initially flags all schools in a geographic area,
you can redraw the map to show only schools with a gym.
If you want the map to show events, you can apply dates to Ektron content, which allows
searching by date or location.
IMPORTANT: As a map’s boundaries change, only locations within boundaries appear. Likewise, if a
date is assigned to content, only content within the selected date range appears.
If a map has at least one flagged location, a box can appear to its right with information about
each location, which are sorted by distance to starting location. From this box, you can:
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l

view content to which the location is assigned

l

find the distance to a location

l

center the map on a location

l

get directions to a location

l

No.—Map item number. The lowest numbered item is closest to the map’s center.

l

l

l

l

Title—The content that corresponds to the numbered map location. Click the title to
access that content on your website. The text below the title is the Metadata Map
Address field, followed by the Metadata Description field (see illustration below).
Distance—Distance from the map’s center to this content location.
Map—Click icon to recenter map on this content’s location.
Directions—Click icon to select the Directions tab and paste this content location’s
address into the end location box. You could then enter a starting location to get
directions to this location.

When you hover the cursor over a numbered map location, a text “bubble” appears.

Bubble information:
l

l

Title—Content that corresponds to the numbered map location. Click the title to proceed
to that content on your website.
Summary—Value of the content’s Summary tab.
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l
l

Metadata description—Value of the content’s Metadata Description field.
Get Directions—Click To Here or From Here to select the Directions tab and paste
this location’s address into the To or From location box. Then, supply the missing
location to get directions between locations.

Using Maps on the Sample Site
You can view maps on Ektron’s sample site. To do so, open the home page (http://your server
address/siteroot/default.aspx). Then, choose Contact Information > Map VE or Contact
Information > Map Google. If you want to work with these maps in VisualStudio.NET, the
Bing Maps for Enterprise map is on the map.aspx page. The Google map is on
mapgoogle.aspx.

Ektron provides a Google map key that you can use for testing on localhost. But, if you want
to use Google map with your production server, you must install a license key.

Obtaining a License to Use Google Maps
Before your production server can use Google’s map feature, follow these steps to obtain and
install a license key. For Google Map’s terms and conditions, see Google Maps/Google Earth
APIs Terms of Service.
1. Go to Google APIs.
2. Log into (or create) your Google account.
3. Click Services from the left navigation panel.
4. Enable Google Maps API v2.
5. Click API Access from the left navigation panel.
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6. Click Create new Server key...

7. Enter 1 or more server IP addresses and click Create. A key is created for server apps
and browser apps (such as AIzaSyBcN7RJzxr4f-iOOfdMwUq9op-5xrtOh3M).
8. Without closing that page, open the site root/web.config file.
9. Go to the line that begins <add key="GoogleMap".
10. Within that line, replace the following localhostkey with the key you just created.
key="AQWESyCAtPrvLE6I2RTS7xK1-3btrrTO0eO6543"/>

Controlling the Map Experience
NOTE: Within Visual Studio, you cannot see the map in design mode. But, you can right click the mouse
and select View in Browser to see the effect of changing properties in a browser.
For information about customizing the display using the Ektron Markup Language, see
map.ekml on page 1909.

Recentering the Map
The Search tab lets you recenter the map on a location. You can enter a combination of
street address, city, state and zip code and click Search. Only content within that geographic
area which satisfies other search criteria appears.

Ektron 8.7

593

Managing Content

Finding Locations with a Search Term
You can use the Find What tab to find only locations that include a search term. For
example, if a map flags hotels, you can click the Find What tab then insert pool in the text
box above to view only hotels with a pool. The Find What tab uses the same logic used in the
Web Search to find content on your site.

Getting Directions
Use the Directions tab to get directions between 2 locations. Enter a combination of street
address, city, state, and zip code into both text boxes above the tabs and click Get
Directions. The screen displays text directions on the left, and a map of the directions on the
right.
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Restricting Locations to Taxonomy Categories
If you use Ektron’s taxonomy feature to classify mapped content, you can click Display on
Map to restrict the map’s locations to content in your categories. The popup window also
prompts you to select one or a range of dates, and only retrieves content to which one of the
selected dates is assigned.

For example, the category Restaurant has 5 subcategories in Ektron’s sample site.
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When you use the map, you can click Display on Map, see your content’s categories, and
select those of interest. The map updates to show content in selected categories only. To
learn about assigning taxonomy categories to content, see Using Taxonomies on page 777.
NOTE: While an OR logical relationship among selected categories is the most intuitive and common,
you can set up AND or NOT relationships among categories.

Displaying/Suppressing Map Elements
You can use Map properties to display or suppress the following map elements.
l

Tabs/Search box—GeoControl

l

Text box—DisplayTextResult

l

l
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Zoom/direction—ZoomControl; for Bing Maps for Enterprise maps, this property also
controls the Map type selection.
Map type (road, satellite, combination)—TypeControl; affects only Google maps.
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Setting a Map’s Initial Boundaries
Because the map only displays content whose address lies within the map’s boundaries, focus
the initial display on your businesses/locations. Map properties let you specify a beginning
address (or longitude/latitude) and a starting zoom level. All content with address data within
that area is flagged on the map.
If your locations are too spread out to appear on a single map, create several regional maps.
Each map server control must appear on a separate Web form.
IMPORTANT: You cannot place more than one map server control on a Web form.

Setting Content Found on a Map
Whether you use Google or Bing Maps for Enterprise maps, content must have latitude and
longitude values to appear on a map.
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Google maps take a content item's address and return its latitude and longitude. You don’t
need to use Google’s automatic retrieval of latitude and longitude. Instead, you can enter the
values manually. To do so, open the content item, go to its metadata, and enter the latitude
and longitude values under Search Data.
To automatically obtain latitude and longitude information for a content item:
IMPORTANT: The following procedure assumes you are using Ektron’s sample site. If you are using the
Min site, you must create searchable metadata definitions for Map Address, Map Latitude and Map
Longitude. When defining Map Latitude and Map Longitude, set their Style to Double. If you are using
dates with metadata, set MapDate’s style to Date.

1. Obtain a Google maps license key. See Obtaining a License to Use Google Maps on
page 592
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2. Create the content if necessary. On the content’s Metadata tab, under Search Data,
enter a MapAddress (that is, any combination of street, city, state, and zip code).

If you enter only a zip code, the latitude and longitude are set to that post office.
3. Publish the content.
This action creates the Web Service call to Google maps, which retrieves the latitude and
longitude for each address. If Google maps cannot find a latitude and longitude (usually
due to insufficient or conflicting information), it writes failure information to your
server. You can view this under Windows Event Viewer > EktronLog. Any event’s
properties explain why the retrieval of latitude and longitude failed.

Restricting Content for a Particular Map
You may want a map to show a subset of all content with a latitude and longitude. For
example, your business includes restaurants and bakeries, and you want a map to show only
bakeries.
To accomplish this, place content for restaurants in one folder, and bakeries in another. Then,
in the map server control that shows bakeries only, at the FolderID property, identify the
bakeries folder.
If you want another map to show both restaurants and bakeries, create the restaurant and
bakery folders under a parent folder. Then, in that map server control’s FolderID property,
identify the parent folder, and set the Recursive property to true.
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Ektron has 2 types of analytics.
l

l

Business Analytics—uses Ektron server controls to track activity, store the
information in the database, and report on that information.
Web Traffic Analytics—uses an outside service provider, such as Google Analytics to
monitor all aspects of Web traffic to your site and report on that information. See
Analyzing Content on the previous page.

Business Analytics
The Business Analytics feature lets you track statistics about visits to your website. You can
use it to determine the following kinds of information:
l

how often your content was viewed

l

how many site visitors viewed for first time, and how many returned

l

the most popular referral pages (that is, the Web page from which visitors clicked to
arrive on your site)

Several options for selecting a date range let you compare activity across different weeks,
months, and years.
By default, the Business Analytics feature is disabled in the web.config file. To enable it, set
the value of the ek_enableClassicAnalytics property to true. If you set this property to
true and later change it to false, statistical data remains within Ektron, but no additional
data is collected.
<add key="ek_enableClassicAnalytics" value="true" />

Specifying the Frequency of Writing to the Database
After you set up the Business Analytics feature, your database is subject to a continuous
barrage of write activity, generated by visits to your site. To optimize your database’s
performance, you can hold visit activity in application server memory until a predetermined
amount of data is collected. When collected, it is moved in one packet to the database. So,
the database is “hit” much less frequently.
Specify the amount of data saved in memory prior to being written to the database using
these web.config file elements.
l

recordsBeforeWrite—the number of unique template visits

l

timeBeforeWrite—the number of seconds since the last time a database write occurred

When either element reaches the value set in web.config, all records stored in memory are
written to the database. That event resets both elements to zero (0).

Captured Statistics
For every template view, the following statistical information is captured.
l
l
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url—the visited page
content_id—the ID of the visited content. Captured by the Analytics server control.
Tracking Clicks by File Type on page 631

l

visitor_id—a unique GUID that identifies a visitor

l

hit_date—date and time when a page view occurred
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l
l

referring_url—the URL a user was viewing before jumping to the visited page
visit_type—zero (0) indicates new visitor, 1 indicates returning visitor, 2 indicates all
other views. After a user logs on, the first page hit tracks the visit as zero (0) (if the user
is new) or 1 (if the user previously visited the page). From then on, 2 is logged for that
user.

In addition to writing Business Analytics data to the database, you can write it to the IIS log.
To do this, enable the appendToIISLog element in the web.config file. Note that if you set
appendToIISLog to true, some Business Analytics data is only written to the IIS log and does
not appear in the Workarea.

Tracking New and Returning Site Visitors
The Business Analytics feature provides information about visits made by new versus
returning visitors. To capture this data, the feature asks this question whenever a page is
visited: is the user logged in as either a membership or regular user?
l

If yes, capture the user ID with the statistical data

l

If no, place a cookie on the visitor’s computer

The next time the user visits that page, the feature checks the visit history for the user ID, or
for a cookie. If either is found, the visit is considered a return.
The same user visit may be considered new on one view but not on another. For example,
someone visits on January 30 (Monday) then again February 2 (Thursday). On the monthly
statistics, that visitor is new, but on the weekly statistics, the February 2 hit would be a
return visit (his second this week).
Now consider a second visitor, who browses to your site on the first and 20th of the month.
These visits appear on weekly statistics as 2 new visits, but on the monthly statistics, only the
first visit would show up on that month's tally of new visitors. The second visit would add to
the return visitor statistics.

Reporting Business Analytics
The Business Analytics feature's reports let you drill down from the entire site to individual
templates to individual content items.
PREREQUISITE
In your site's web.config file, the ek_enableClassicAnalytics setting is set to
true.
NOTE: The Most Popular and Trends widgets also report on Business Analytics data. See Most Popular
Widget on page 607 and Trends Widget on page 610.
To access Business Analytics Reports:
Either
1. Browse to a content item for which Business Analytics data is being captured.
2. Right click the mouse.
3. Choose View Template Activity to see Business Analytics data for the current content
item (to learn more about data captured for one content item, see Content View on
page 605).
4. ChooseView Site Analytics to view Business Analytics data for the entire site.
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or
l

From the Ektron Workarea, choose Reports > Business Analytics to view analytic
data for the entire website. The following reports are available.
l
Analyzing Site Statistics below
l

Content View on the facing page

l

Templates on page 606

l

Referrers View on page 606

Analyzing Site Statistics
The following table shows analytic statistics available for each level of the site.
Type of Statistical Information

Site-wide

TemplateLevel

ContentLevel

Views of Any Template

Visitors: New and Return

Pie Chart of New vs. Return Visitor

Pie Chart of Views/Visitors Ratio

Bar Graph of Views/Visitors Ratio

Visited Pages

Visited Content Blocks

URLs from which Site Visitors Accessed Ektron

Site Statistics View
The Site Statistics view offers an overview of tracked activity within the selected date range.
You see actual data for the
l

number of views

l

number of visitors

l

ratio of visitors per view

l

number of new and returning visitors

l

ratio of new to return visitors
See Also: Tracking New and Returning Site Visitors on the previous page.

Below this are pie charts of the ratio of views to visitors and new vs. return visitors.
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Content View
The Content View shows the most frequently-accessed content on your website.

Click any content item to view:
l

l

l

Content Statistics—statistics for that content item only (See Also: Analyzing Site
Statistics on the previous page)
Content Activity—relative activity for that content item only (See Also: Content View
above)
Audit Content—all users who viewed the selected content; to the right of each user are
the date and time when content was viewed
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NOTE: Only users who viewed content after logging in appear on the list. Site visitors who do not log in
affect statistics but are not tracked on this report.

Templates
The Templates View shows all viewed templates on your website, with the most frequentlyaccessed ones on top.
By default, the templates at the top have the highest number of unique visitors. You can
change the sort by clicking any column header. For example, to sort templates by the number
of views, click Views.

You can click any template to view
l

Template Statistics—statistics for that template only

l

Template Activity—relative activity for that template only

l

Content in Template—if a content item was specified for the template in the Content
Analytic server control, this view show statistics for the template. You can click the
template to view Template Level activity.

Referrers View
The Referrers View shows domains from which your site was most frequently accessed.
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Changing the Date Range of the Statistical Data
When you first view statistical data, the default date range is today (one day).
If you view statistics for different date ranges, when you return to the screen, the last
selected date range is the default selection. You can change it if needed.

Using Quick View Options
Use Quick View options to view analytics for any of these time periods.
l

one day

l

one week

l

one month

l

one year

When you click Quick View [week], [month] or [year], the current end date is used as
the last day of the range. Here are some examples.
l

Week—If end date is today, begin date is one week earlier than today

l

Month—If end date is today, begin date is one month earlier than today

l

Year—If end date is today, begin date is one year earlier than today

Using Jump To Options
Use Jump To options to view statistics for a time period before and after the current date
range. The time period is determined by the Quick View increment. For example, if the Quick
View option is Day, you can jump to the previous day, the following day, or today.
Regardless of the Quick View increment, you can always view statistics for today.

Most Popular Widget
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The Most Popular widget reports on these categories of content on your website. By default,
every Most Popular widget tab shows up to 5 results.
l

Most Viewed

l

Most Emailed

l

Most Commented

l

Highest Rated

You can place the Most Popular widget onto any PageBuilder page. See Also: Creating Web
Pages with PageBuilder on page 659
NOTE: You cannot place more than one Most Popular widget on a PageBuilder page. Also, you can hide
up to 3 tabs if you do not want all of them seen.
The Most Popular widget references content events, which are Ektron events that are tracked
when used with various server controls. Here are 2 examples of a content event:
l

l

for the Most Viewed tab, the content was viewed and tracked by the Analytics Tracker
server control. See Also: Analytics Tracker on page 1642
for the Most Emailed tab, the content was emailed from the Social Bar server control

The Most Popular widget displays content items that meet these criteria.
l
l

l

l

the content is tracked by a server control
content events occurred within the date range set in the Most Popular widget properties.
The default value is 7 days, but you can change it if desired. See Also: Reporting
Business Analytics on page 603
the content is assigned to a selected folder or taxonomy. By default, the widget has no
folder or taxonomy restrictions. But the properties screen lets you restrict results by
folder or taxonomy.
the content is among the highest rated content items for that tab.
For example, if the Most Viewed tab shows the top 5 content items (the default
setting), content that has not been viewed as frequently as the top 5 does not appear.
Consider the following example.
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Content ID

Number of Times Content
has been Viewed within
Date Range

30

87

259

82

316

78
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Content ID

Number of Times Content
has been Viewed within
Date Range

12

78

658

67

243

62

In this case, content ID 243 does not appear on the Most Popular widget because it is
sixth in the frequency of viewing rank.
Each time a content item is used with one of the following server controls, its count for that
day is incremented by 1.
l

l

l

l

Analytics Tracker on page 1642—Most Viewed tab—A site visitor browses to a page that
is tracked by the Analytics Tracker server control. The control lets you determine which
content is counted when the page is viewed.
SocialBar on page 1845—Most Emailed tab—A community group member browses to a
page that hosts the Social Bar server control, and emails a content item to a friend. (The
SocialBar server control must be associated with content.)
MessageBoard on page 1786—Most Commented tab—A Community Group member
browses a page that hosts the Message Board server control and comments on a content
item on that board. (The MessageBoard server control must be associated with content.)
ContentReview on page 1712—Highest Rated tab—A site visitor browses to page that
hosts the Content Review server control, and uses the control to rate a content item.

Next to each content item is a count. The count indicates the number of times a content event
occurred for that content item within the specified time frame. See Also: Reporting Business
Analytics on page 603

Note that the date range may affect the count. For example, if a content item was viewed
once a day for the past 10 days but the date range is set to 7 days, the count is 7. To change
this maximum:
1. Open siteroot/widgets/mostpopular.ascx.cs.
2. Find the following line private int _PageSize = 5;.
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3. Change the number at the end of the line to the maximum number of results to display.
NOTE: This setting affects all tabs and instances of the Most Popular widget.
A logged in user can change the properties that determine what appears on the Most Viewed
tab. To do so, click Edit (
l

l

l

).

Tab text—The text that appears on this tab. In the above example, the left tab's text is
the default Most Viewed.
Visible—Determines if the tab you are editing appears on the widget. At least one tab
must appear. Checked is the default.
Number of days to report—The number of days for which to display the data. The
default is 7.
o The current day is not counted, since it is incomplete. So if you enter 1, you see
information for all of yesterday and today.
o

The date calculation is based on the clock on the website's server.
NOTE: You can change this to any number you wish. However, the widget can only show
data for days for which data is stored in your database.

l

l

Report—Determines the information appears when a tab is clicked.
o Tab 1—Most Viewed
o

Tab 2—Most Emailed

o

Tab 3—Most Commented

o

Tab 4—Highest Rated

Filter By—You can restrict the content appears on this widget by selecting a folder
(default) or a taxonomy.

While selecting a folder/taxonomy category, you have the option to include all
folders/categories under the selected one. If you later want to remove this restriction,
click Delete ( ).

Trends Widget

By default, the Trends widget shows the Most Viewed content on your website. You can edit
the widget's properties so that it displays any of the following categories of content instead.
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l

Most Emailed

l

Most Commented

l

Highest Rated
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Trends Widget

The Trends widget is a subset of the Templates on page 606, so you should be familiar with
that section before reading this. It explains topics such as how Ektron determines which
content appears for each category. You can place the Trends widget onto any PageBuilder
page. See Also: Developing Wireframe Templates on page 676
A logged in user can change properties that determine the appearance of the Trends widget.
To do so, click Edit (

l

l

). The Trends widget screen appears.

Report Type—Report types are:
o Most Viewed (default)
o

Most Emailed

o

Most Commented

o

Highest Rated

Number of days to report—The number of days for which to display the data. The
default is 7.
o The current day is not counted, since it is incomplete. So if you enter 1, you see
information for all of yesterday and today.
o

The date calculation is based on the clock on the website's server.

NOTE: You can change to any number you wish. However, the widget only shows data for days for
which data is stored in your database.
l

Order Direction—The direction in which search results are sorted. The default is
Descending.
o Ascending—Alphabetical results from A to Z; numeric values low to high; dates
from oldest to most recent
o

l

l

Descending—Alphabetical results from Z to A; numeric values high to low; dates
from most recent to oldest

Maximum Number of Items—Enter the maximum number of content items that may
appear on the Trends widget. The default is 5. The Ektron database maintains a count
(number of hits) for each content item, for each date. When you select a number of
days, the Trends widget displays the content with the most hits during that date range,
up to the number you set in this field.
Filter By—You can filter which content appears on this widget by selecting a folder or a
taxonomy.
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While selecting a folder/taxonomy category, you have the option to include all
folders/categories under the selected one. If you later want to remove this restriction,
click Delete ( )

Business Analytics API
The Business Analytics API's namespace is
Ektron.Cms.Framework.Analytics.BusinessAnalytics and consists of several static
methods arranged into 2 groups:
l

those that save events to the database

l

those that retrieve the event data from the database for use in reports

NOTE: The demonstration code in this section uses C# syntax.

Saving Event Data
The following illustration depicts saving event data to the database.
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To save events, use the static class EventLogger, which exposes the following methods.
l

IAnalyticsEventData CreateAnalyticsEventData()

l

void Log(IAnalyticsEventData eventObject)

l

void Log(string eventName)

l

void Log(string eventName, string xml)

l

void Log(string eventName, string xml, int count)

The EventLogger class is illustrated below.

As long as an event (myEvent) has been registered in the system, you can store an event like
this:
using Ektron.Cms.Framework.Analytics.BusinessAnalytics;
…
EventLogger.Log(“myEvent”);

This code saves the event data with default values. As shown, the Log method has several
overloaded versions. Each provides a different amount of control over the information saved
to the database. The following list shows the Log method's parameters.
l

l

l

eventName (String)—A name that uniquely identifies the event. This name must be
registered and enabled in the database for it to be recorded.
XML (String)—This parameter is purely for customization. By default, its value is null.
The API stack passes the string to the database, where the appropriate stored procedure
can use it. For example, it can store additional values that are not part of the current
event-object
count (Integer)—Allows increments other than the default value of one. For example,
you may want a specific event to increment the event counter by 5.

In addition to the parameters listed above, you can set other values by referencing the event
object that carries the information to the database. A call to CreateAnalyticsEventData
returns this object, and can be used as follows:
IAnalyticsEventData eventObject = CreateAnalyticsEventData();

Through the interface IAnalyticsEventData, the object provides the following additional
parameters, which allow more control over what information is saved with the event.
l
l

ObjectId (Long)—For a content related event, ObjectId should be set to a Content ID.
LanguageId (Integer)—The content object's Language ID. If that is not available, the
current request's Language ID.

Ektron 8.7

613

Analyzing Content

l

SiteId (Long)—The current request's Site ID
NOTE: A value of -1 means this value has not been set, and will be updated appropriately at a lower
level.

l

UserId (Long)—The current request's User ID (if logged in)

l

VisitorId (String)—The current request's Visitor ID (if not logged in)

l

EventDate (DateTime)—Defaults to current date and time

Retrieving Event Data
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Retrieving Event Data

This illustration depicts retrieving that data into reports.

Use the static class EventReporter to retrieve events stored in the database. This class
exposes the following methods.
l

IList<string> GetReportNameList()

l

IAnalyticsQueryRequest CreateQueryRequest()

l

IContentQueryRequest CreateContentQueryRequest()

l

IList<IAnalyticsEventItem> GetList(IAnalyticsQueryRequest queryRequest)

l

IList<IContentEventItem> GetList(IContentQueryRequest queryRequest)

l

void UpdateReportData(String eventName, DateTime eventDate)

The EventReporter classes are illustrated as follows.
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GetReportNameList Method
Use the GetReportNameList method to obtain a list of recognized (e.g., registered) report
names. You can extend this list by adding custom event types and their corresponding stored
procedure handlers.
For example, to obtain a list of the allowed report names, use the following code.
using Ektron.Cms.Framework.Analytics.BusinessAnalytics;
...
IList<String> names = EventReporter.GetReportNameList();

CreateQueryRequest Method
Use the CreateQueryRequest method to specify an event data report of the base-level type.
The method returns an object that implements the interface IAnalyticsQueryRequest, which
has the following parameters.
l

l

SiteId (Long)—The Site ID of the data being returned.

l

UserId (Long)—The User ID of the data being returned.

l

l

l
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ReportName (String)—Uniquely specifies the report, which is registered and
corresponds to one or more stored procedures which, when run, generate the requested
data.

EventStartDate (DateTime)—If desired, use to determine the earliest date for which
report data is returned. By default, data from the earliest date is returned.
EventEndDate (DateTime)—If desired, use to determine the latest date for which
report data is returned. By default, data through the most recent date is returned.
PagingInfo (Ektron.Cms.PageingInfo)—Page size and number let you display a small
portion of the report at a time. By setting page size and number, the report data is
reduced, and performance will improve. Conversely, performance degrades as page size
(RecordsPerPage) increases, especially if the amount of stored data is large. This type
has the following fields:
o CurrentPage
o

EndRow

o

RecordsPerPage

o

StartRow
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CreateContentQueryRequest Method

l
l

o

TotalPages

o

TotalRecords

OrderByDirection (EkEnumeration.OrderByDirection)—Descending or Ascending
XML (String)—This parameter is purely for customization. By default, its value is null.
While saving event data, the API stack passes the string to the database, where the
appropriate stored procedure can use it. For example, it can store additional values that
are not part of the current event-object. Within the CreateQueryRequest method, this
parameter can returns that string.

CreateContentQueryRequest Method
Use the CreateContentQueryRequest method to specify a report of event data that is related
to content. It returns an object that implements the interface IContentQueryRequest which, in
addition to those provided by interface IAnalyticsQueryRequest (see CreateQueryRequest
Method on the previous page) has the following parameters.
NOTE: You can use either the FolderID or the TaxonomyID parameter but not both. Also, you can only
use the IncludeChild parameter related to the selected parent parameter.
l
l

l

l

l

LanguageId (ID)—The Language ID of the content that the report returns.
FolderId (Long)—The folder of the content being returned. All content in the folder is
returned. It defaults to that of the current HTTP request.
IncludeChildFolders (Boolean)—Determines whether the report includes children of
the folder specified in the FolderID parameter.
TaxonomyId (Long)—The taxonomy category of the content being returned. All content
to which the category is applied the folder is returned. It defaults to that of the current
HTTP request.
IncludeChildTaxonomy (Boolean)—Determines whether the report includes children
of the folder specified in the FolderID parameter.

GetList Method
There are 2 versions of the GetList method.
One version takes an IAnalyticsQueryRequest object, and returns a list of objects that
implement IAnalyticsEventItem. That version has the following parameters.
l

ID (Long)—The object Id s supplied when the related events were saved.

l

XML (String)—This parameter is purely for customization. By default, its value is null.
While saving event data, the API stack passes the string to the database, where the
appropriate stored procedure can use it. It can store additional values that are not part
of the current event-object.

The other version of the GetList method takes an IContentQueryRequest object and returns
a list of objects that implement the interface IContentEventItem. That provides the
following parameters in addition to those of IAnalyticsEventItem (shown above).
l

LanguageId (Integer)—The Language ID of the content that the report returns.

l

Quicklink (String)—The object's URL.

l

Title (String)—Determines whether the report includes children of the folder specified in
the FolderID parameter.

Ektron 8.7

617

Analyzing Content

l

Teaser (String)—The content summary. See Also: Writing a Summary for Content on
page 292

l

Status (String)—The content's status. See Also: Content Statuses on page 307

l

FolderID (Long)—The FolderID of the content being reported.

l

l

Count (Integer)—The count of the object being reported. For example, if you are
retrieving the most frequently emailed content item, the count is the number of times it
was emailed. The count and average values may be used individually or together,
depending on the report. For example, the rating report returns both the average
(rating) and the count (the number of ratings), while the commented report uses only
the count.
Average (Decimal)—The a numerical value divided by the count. For example, when
Ektron calculates average content rating, it divides the total number of rating points (on
a scale of 1 thru 10) by the number of votes.

UpdateReportData Method
This method tells the database that an event's details should update that event's aggregated
data. This method is only required if the database does not automatically do this, such as
when the corresponding bit is disabled for that an type in the database. Disabling the
corresponding bit generally improves performance, especially if the event logging rate is
high. But, if you disable the corresponding bit, you must call this update method if you want
the report to show current data.
The UpdateReportData method takes the following parameters.
l
l

eventName (String)—The event whose data will be updated.
eventDate (DateTime)—The date of the event's occurrence. For example, if you pass
1/1/2009, one row in the aggregate table is updated. If the row does not exist, it gets
created. If you do not pass an event date, this method updates the aggregate table with
summary info for that event for all dates. For example, if today is February 1, the
system has been in use since the beginning of the year, and you pass NULL for the date,
32 table rows are updated (31 days in January plus 2/1).

Disabling the Saving or Reading of Events
You can disable the saving or reading of all events or of individual events.
It is useful to disable events when you want to minimize database traffic. To disable all
events:
1. Open siteroot/web.config.
2. Set the following parameters to false.
<!-- Enable saving business-analytics events to the database
(at API level) -->
<add key="ek_enableBusinessAnalyticsEventStorage" value="false"/>
<!-- Enable querying the database for business-analytics events
(at API level) -->
<add key="ek_enableBusinessAnalyticsEventReports" value="false"/>

NOTE: These settings are set to enabled (true) by default.
You can also enable or disable individual events in the database itself, but this does require a
call to travel through the full stack.
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Using a Custom Provider
Below the service level are providers that read and write event data. The default providers
simply pass calls through to the standard Ektron database-access-level code, which reads and
writes from the database. But you can modify this behavior to almost any conceivable
alternative. For example, you can
l

save the data to an alternate database on an alternate machine

l

call a Web service to handle the reads and writes

l

filter the data and/or requests

l

process information on its way to or from the database

The SDK contains sample providers, as well as full source code for the Ektron-supplied
providers. You can use this material as a basis for writing custom providers, which is the
preferred technique for customizing the behavior of the Business Analytics API stack and
subsystem.
The default providers for saving and reading event data (respectively) are
EktronEventProvider.cs and EktronQueryProvider.cs. Example custom-provider source
code has the following names for saving and reading event data (respectively):
DemoEventProvider.cs and DemoQueryProvider.cs. For the default providers, the
siteroot/web.config file must contain the following, inside
<configuration><configSections>.
<section name="businessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers
.BusinessAnalyticsQueryProviderConfiguration,
Ektron.Cms.BusinessObjects"
allowDefinition="MachineToApplication"
restartOnExternalChanges="true"/>
<section name="businessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers
.BusinessAnalyticsEventProviderConfiguration,
Ektron.Cms.BusinessObjects"
allowDefinition="MachineToApplication"
restartOnExternalChanges="true"/>

Additionally, the following must exist inside the <configuration> tags.
<businessAnalyticsQueryProvider
defaultProvider="EktronBusinessAnalyticsQueryProvider">
<providers>
<add name="EktronBusinessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers.EktronQueryProvider,
Ektron.Cms.BusinessObjects"/>
</providers>
</businessAnalyticsQueryProvider>
<businessAnalyticsEventProvider
defaultProvider="EktronBusinessAnalyticsEventProvider">
<providers>
<add name="EktronBusinessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers.EktronEventProvider,
Ektron.Cms.BusinessObjects"/>
</providers>
</businessAnalyticsEventProvider

To override the default Ektron provider with the a custom provider:
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1. Create a new solution with a project named CustomProviders.
2. Add the following references to your project.
l
Ektron.Cms.BusinessObjects.dll
l

Ektron.Cms.Common.dll

l

Ektron.Cms.ObjectFactory.dll

3. Add files DemoEventProvider.cs and DemoQueryProvider.cs (from the Ektron SDK).
4. Build.
5. Copy the CustomProviders.dll file to your Ektron site's bin file.
6. Update web.config by modifying the <configuration> section. Specifically, add demo
providers to the Business Analytics providers as shown below.
<businessAnalyticsQueryProvider
defaultProvider="DemoQueryProvider">
<providers>
<add name="EktronBusinessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers.EktronQueryProvider,
Ektron.Cms.BusinessObjects"/>
<add name="DemoQueryProvider"
type="Ektron.Cms.Analytics.Providers.DemoQueryProvider,
CustomProviders"/>
</providers>
</businessAnalyticsQueryProvider>
<businessAnalyticsEventProvider
defaultProvider="DemoEventProvider">
<providers>
<add name="EktronBusinessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers.EktronEventProvider,
Ektron.Cms.BusinessObjects"/>
<add name="DemoEventProvider"
type="Ektron.Cms.Analytics.Providers.DemoEventProvider,
CustomProviders"/>
</providers>
</businessAnalyticsEventProvider>

Web Traffic Analytics
By analyzing the user traffic coming to and interacting with your site, you can better
understand key elements of your Web presence. Traditional Web analytics packages help you
understand where your traffic is coming from, when the traffic is occurring (including high
and low points) and what pages users are interacting with. But this information is often
isolated from the Web content and is, therefore, lacking the context needed to take advantage
of it.
To view Web traffic analytics, you must have an Ektron Professional or Enterprise License,
and only the following users can view the Web Analytics data.
l
Members of the Administrators Group
l

Users assigned to the Analytics Viewer role. See Also: Defining Roles on page 1120

Ektron has a fully-developed, Web traffic analytics provider model. By hooking into best-ofbreed analytics software, like Google Analytics, your website’s information is integrated into
Ektron's Workarea and so is at your fingertips as you use it to optimize the site experience.

Using Web Traffic Analytics Data with Ektron
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Ektron’s Workarea provides customized reporting, reflecting exactly the information you care
about. The data can analyzed in many ways, such as:
l

number of visits per day

l

browser usage

l

visitor location

l

visitor language

l

top content

l

referring sites

Web Traffic Analytics data is available for your entire site and individual pages. A sample
Web Analytics display is below.

The Web Analytics widget can be placed on your dashboard, so that you have instant access.
Also, the software is integrated into the content history. This makes your traffic analytics
more relevant: you can see what modifications were made, when, and how they impacted
traffic to that page. You can react immediately, restoring content that performed better or
changing the current content to better reflect your goals.
This full integration makes your analysis more efficient; there is no reconfiguration of the
analytics tool and no learning curve. Customer reporting, segmentation, and legacy data are
easier to access, and Ektron becomes the central hub for all of your website’s information,
bringing it together so that it is no longer siloed. Having all information in one place puts it in
context, making it easier to draw the conclusions you need to optimize your Web presence.
When you set up Web Traffic Analytics, the Analytics Provider monitors every site visit. In the
Workarea, you can view this data from many perspectives.
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WARNING! No data is stored in Ektron -- Ektron retrieves it upon demand from your Web Analytics
provider.

Viewing Analytics Data
The analytics feature provides 3 basic types of data:
l

Page data—Page-Level Analytics Data below

l

Site data—Site-Level Analytics Data on page 625

l

Site report descriptions—Site Report Descriptions on page 626

Page-Level Analytics Data
After you enable analytics tracking, your provider retains data on every visited page (that is,
a unique URL) such as http://developer.ektron.com/articles.aspx or
http://developer.ektron.com/template.aspx?id=6572. Data is tracked when the
quicklink is used, as well as any alias assigned to the content. See Also: Creating UserFriendly URLs with Aliasing on page 835
You can view any page’s analytics data from the following locations.
l

Viewing Page-Level Analytics from the Site below

l

Viewing Page-Level Analytics from a PageBuilder Page on the facing page

l

Viewing Page-Level Analytics from the Workarea on page 624

Viewing Page-Level Analytics from the Site
Any authorized user can view analytics for a page on your website by following these steps.
1. Log in to the website.
2. Navigate to the page whose analytics data you wish to view.
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3. Hover the cursor over the Website Content menu.
4. Choose View Page Activity. The SEO page’s Traffic tab appears.

The Traffic tab of the SEO control graphs the analytics data of any 2 search criteria. Below the
graph is data for the 5 visit criteria tracked by the analytics provider.
l
l

l

l

l

Pageviews—number of pageviews for this page over the selected date range
Unique pageviews—number of unique visitors to this page over the selected date
range
Average time on page—how long a visitor spent on the page. It is calculated by
subtracting the initial view time for this page from the initial view time of the subsequent
page. So, this metric does not apply to exit pages.
Bounce rate—the percentage of single-page visits (that is, visits in which the visitor
exited your site from the entrance page)
% Exit—the percentage of site exits that occurred from this page

Note that you can change the date range, analytics provider, and either search criterion
(Pageviews and Time on Page in the example above). To learn about using the Segments
button (

), see .

You can also replace the URL with a different one, and view the page being analyzed (by
clicking Visit this page in the green bar).

Viewing Page-Level Analytics from a PageBuilder Page
Any authorized user can view analytics for a PageBuilder page by following these steps.
NOTE: You cannot drag and drop the Analytics widget onto a PageBuilder page.
1. Open the PageBuilder menu. See Also: Creating Web Pages with PageBuilder on
page 659
2. From the menu, choose View > Analytics. The SEO page’s Traffic tab appears.
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Viewing Page-Level Analytics from the Workarea
The Workarea provides 2 page-level views of analytics data.
l

The View Content History screen—compares analytics data for any 2 published versions

l

The Analytics toolbar button—displays the SEO page’s Traffic tab.

To view a content item’s analytics data from the Workarea:
1. Navigate to the folder containing the content whose analytics data you want to view.
2. Click the content item.
3. To compare analytics data between any 2 published versions, click History(
See Also: Comparing Versions of Content on page 301
To view analytics for the currently published version, click Analytics (
do, you see the Traffic tab of the SEO page.

).

). When you

On the View Content History screen, blue and orange radio buttons appear next to each
published version of content, as shown below.

To compare analytics data, click the appropriately-colored radio button next to each version,
then click Compare ( ). The Compare screen for the 2 versions appears.
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You can change the date range for each content version. You can also:
l
l

Use the Display pull-down to graph any visit data.
Click the URL Filtering tab to select the URLs being displayed. See Also: URL Filtering
below

l

Select a different site

l

Select a different analytics provider

l

Use the Segments button (

).

URL Filtering
Any content item can be viewed via several URLs, such as
l

its quicklink. See Also: Adding a Quicklink or Form to Content on page 346

l

manual alias

l

automatic alias See Also: Creating User-Friendly URLs with Aliasing on page 835

NOTE: While Regex-based aliases affect Analytics data, they do not appear on the URL Filtering tab.
The URL Filtering tab of the Compare Analytics screen lets you analyze the data by each of
these identifiers. So, for example, you can drill down to view only the data collected when
site visitors accessed a page by typing its manual alias into the browser.

Site-Level Analytics Data
You can view analytical data for any site via the Analytics Report widget and several reports.
See Also: Widget Reference on page 714
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You can drag and drop the Analytics Report widget onto the Smart Desktop. When you do, you
initially see the Direct Traffic report for the past 7 days.
You can click Edit ( ) to change the display using any of the options shown below.

There are 3 time interval choices:
l

last 7 days (the default)

l

last 30 days

l

last 90 days

Site Report Descriptions
You can customize the Analytics reports in the Workarea in the following ways.
l

Change the text that describes a report or folder

l

Remove reports or entire folders

To complete either task:
PREREQUISITE
Permission to edit files on your Ektron Web server
1. Open the following file:
C:\inetpub\wwwroot\CMS400Developer\Workarea\controls\NavigationTrees
\WebtrendsReportSubtree.ascx
2. To change a report's or folder's text, find the text and replace it.
To delete a report or an entire folder, find it and comment it out.

Google Web Analytics
Google Web Traffic Analytics is an enterprise-class solution that gives you rich insights into
your website traffic and marketing effectiveness. Powerful, flexible and easy-to-use features
let you see and analyze your traffic data in an entirely new way. Google Web Analytics
prepare you to write better-targeted ads, strengthen your marketing initiatives, and create
higher converting websites. Its main features are:
l
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Advertising ROI—Measure the success of your display, search, new media, and offline
advertising efforts.
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l

l

l

l

l

Cross Channel and Multimedia Tracking—Compare your site usage metrics with
industry averages and track Flash, video, and social networking sites and applications.
Visualizing Data—Uncover trends, patterns, and key comparisons with funnel
visualization, motion charts, mapping, and more.
Customized Reporting—Create reports, dashboards, and segments that make the
most sense for your business.
Sharing and Communicating—Administration controls and email reports let you share
data across your organization.
Google Integration and Reliability—Google Web Analytics complements a suite of
related products, all running on the same world-renowned infrastructure that powers
Google.

For more information, see the Google Analytics home page.

Deciding Which Google Analytics Version to Use
Ektron supports Google Analytics versions 2.4 and 3.0. To compare versions, see Migration
Guide: Moving from v2.3 APIs to v2.4 & v3.0 > Differences between v2.4 and v3.0.
You may use both versions. If you enable both, the Ektron Workarea displays a drop-down for
choosing a provider. Data is the same for both providers if you use the same Google analytics
profiles.
IMPORTANT: If you will use Google’s Core Reporting API v3.0, Ektron supports the ClientLogin
authentication method. OAUTH 2.0 is not supported at this time.

Setting up Google Analytics
This section explains how to set up Google analytics. After you complete these steps, Google
begins tracking your entire website. Alternatively, you can track individual site pages (see
Tracking a Single Page on page 630), or clicks by file type (see Tracking Clicks by File Type
on page 631).
WARNING! Enabling the tracking code may cause a significant increase in CPU usage.
1. Create a Gmail account (http://mail.google.com).
2. Sign up for Google Web Analytics (www.google.com/analytics/). When you set up a
Google Web Analytics profile for your site, you are assigned a profile ID and a User
Account. You need those to complete Step 8.
3. Open this Google Analytics help page: Migration Guide: Moving from v2.3 APIs to v2.4 &
v3.0.
4. Under "Create a Project in the Google APIs Console," follow steps 1 through 4. On the
API Access screen, under Simple API Access, click the Create new Browser key
button. Copy the new browser key. You will use this for your API key in Step 8.
5. On the server that hosts Ektron, go to C:\Program
Files\Ektron\CMS400vxx\Utilities\EncryptEmailPassword.exe.
6. Use that utility to encrypt the Gmail username and password that you obtained in Step 1.
Enter your full user name, including @gmail.com.
7. Open your site’s siteroot/web.config file and find the AnalyticsDataProvider tag. If
you enable versions 2.4 and 3.0, edit the GoogleV3.0 and GoogleV2.4 tags.
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<AnalyticsDataProvider defaultProvider="Google">
<providers>
<add name="GoogleV3.0"
type="Ektron.Cms.Analytics.Providers.GoogleAnalyticsProviderv3,
Ektron.Cms.BusinessObjects"
EmailAddress=""
KeyFilePassword=""
KeyFilePath="/Key/privateKey/xxxxxxxxx.p12"
Username="" Password="" ProfileId=""
SiteURL="" UserAccount=""
Endpoint="https://www.googleapis.com/analytics/v3/data/"
ApiKey="" CacheInterval="0"
GoogleAnalyticsTrackingCodePath="Analytics\template\googletrackingcode.ascx"
Version="3.0" />
<add name="GoogleV2.4"
type="Ektron.Cms.Analytics.Providers.GoogleAnalyticsProvider,
Ektron.Cms.BusinessObjects" Username="" Password="" ProfileId=""
SiteURL="" UserAccount=""
Endpoint="https://www.googleapis.com/analytics/v2.4/"
ApiKey="" CacheInterval="0"
GoogleAnalyticsTrackingCodePath="Analytics\template\googletrackingcode.ascx"
Version="2.4" />
</providers>
</AnalyticsDataProvider>

NOTE: If your web.config has several analytics providers and you want to turn off analytic
tracking for one of them, delete the value of the GoogleAnalyticsTrackingCodePath
property.
8. Complete each tag’s properties.
l
name—The free text name of the site being tracked and the Google version. You
should use the site name followed by the provider name and version. For example,
www.ektron.com-GoogleV3.0. When users view site-level displays of Web Analytics
data within the Workarea, you choose the site from a drop-down. If you change the
name, you must also change the value of the <AnalyticsDataProvider
defaultProvider element to match the name.

l

Username—The Gmail username you encrypted.

l

Password—The Gmail password you encrypted.

l
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ProfileID—The Google Analytics Profile ID you obtained in Step 2. Another way to
find your Profile ID is to go to Google Analytics and click Analytics Settings. Next
Edit a website profile. The Profile ID shows under the Profile Settings Title.
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NOTE: Tip! On the Google Analytics settings page, in the address bar, the &id= value is your
ProfileId.

l

l

SiteURL—Your site root name. For example, you could set up one <providers> tag
for the developer.ektron.com site, and another for the synergy.ektron.com site.
The SiteURL needs to match the development site URL when you test in your
development environment. For example, if the site path is
http://MyDevMachine/default.aspx, the SiteURL is MyDevMachine. If there is
no match, the Google beacon is not inserted onto your page.
UserAccount—The Google Analytics SiteURL you obtained.
NOTE: Tip! When you visit your Google Analytics Settings page at google.com, the UAxxxxxx-x string next to your site domain is the UserAccount assigned by Google.
NOTE: To track multiple providers or sites, copy the contents of the <providers> tag,
paste it below the existing tag and above </AnalyticsDataProvider>, and modify the
elements listed.

l

API key—Insert the API key that you created in Step 4.

9. Within the web.config's <analyticsSettings> tags is a suppressBeacon element that
lets you track or suppress the tracking of users on your website. Many site
administrators do not want to track user behavior in Traffic Analytics reports, as it
corrupts the data. (This setting does not apply to Business Analytics.) See Also:
Analyzing Content on page 601. The following are the settings for this element.
l
None—Track all users, including authenticated membership and Ektron users.
l

l

l

Members—Track unauthenticated and logged-in Ektron users only. Do not track
membership users.
Authors—Track unauthenticated and logged-in membership users only. Do not
track Ektron users.
All—Track unauthenticated users only. Do not track membership and Ektron users.

10. Within the web.config's <appSettings> tags is an ek_AutoInsertBeaconScript
element that either tracks or suppresses tracking activity on your website. Change its
value to true.
11. Save web.config.
IMPORTANT: No special server control is needed to track Web Analytics. After you enable Web
Analytics in the web.config file, the following JavaScript is automatically added to each
PageBuilder page and any site page that contains an Ektron server control.
<%@ Control Language="C#"
AutoEventWireup="true"
CodeFile="googletrackingcode.ascx.cs"
Inherits="Analytics_Template_GoogleTrackingCode"
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EnableTheming="false" EnableViewState="false" %>
<!-- Start Google Code -->
<script type="text/javascript">
var _gaq = _gaq || [];
_gaq.push(['_setAccount','<asp:literal id="GoogleUserAccount"
runat="server"/>']);
_gaq.push(['_trackPageview']);
<asp:literal runat="server" id="variables"/>
(function()
{ var ga = document.createElement('script');
ga.type = 'text/javascript';
ga.async = true;
ga.src = ('https:' == document.location.protocol ? 'https://ssl' :
'http://www') + '.google-analytics.com/ga.js';
s.parentNode.insertBefore(ga, s);
var s = document.getElementsByTagName('script')[0];
}
)();
/* Start Track Event binding Code */
//
// extracted from
// http://runtingsproper.blogspot.com/
//
2009/12/how-to-automatically-track-events-with.html
//
// un-comment the below if you would like google analytics to track your pdf
// download links on the website.
//$(document).ready(function () {
// TrackEventsForClicks();
//});
//
//function TrackEventsForClicks()
//{
// TrackEventByFileExtension(".pdf");
//
// add your file extension here
//}
//
//function TrackEventByFileExtension(FileExtension)
// {
// $("a[href$='" + FileExtension + "']").click(function()
//{
// var fileURL = $(this).attr("href");
// _gaq.push(['_trackPageview', fileURL]);
// });
//}
/* End Track Event Binding Code */
</script> <!-- End Google Code -->

Tracking a Single Page
As an alternative to tracking your entire site, you can track individual .aspx pages. To do that,
follow these steps on every page you wish to track.
PREREQUISITE
You completed all steps in Setting up Google Analytics on page 627
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1. Open the siteroot/web.config file.
2. Find the ek_AutoInsertBeaconScript tag.
3. Set its value to false.
4. Save web.config.
NOTE: The previous steps disable the tracking code on your website.
5. Open Visual Studio.
6. Open the .aspx page to which you want to apply the tracking code.
7. In the Solution Explorer tree, navigate to
Workarea/Analytics/template/googletrackingcode.ascx.
8. Drag and drop that user control onto the page.
9. Assign EktronAnalyticsTrackingCode as the ID of the control.

Tracking Clicks by File Type
To track the number of times that files on your site (for example, PDFs) are accessed, follow
these steps.
PREREQUISITE
You completed all steps in Setting up Google Analytics on page 627
1. Open the siteroot/web.config file.
2. Find the ek_AutoInsertBeaconScript tag.
3. Set its value to true.
4. Save web.config.
5. Open Visual Studio.
6. Open the .aspx page to which you want to apply the tracking code.
7. In the Solution Explorer tree, navigate to
Workarea/Analytics/template/googletrackingcode.ascx.
8. Uncomment the code shown below.
/* Start Track Event binding Code */
//
// extracted from
// http://runtingsproper.blogspot.com
//
/2009/12/how-to-automatically-track-events-with.html
//
// un-comment the below if you would like google analytics to track your pdf
//
download links on the website.
//$(document).ready(function () {
// TrackEventsForClicks();
//});
//
//function TrackEventsForClicks()
//{
// add your file extension here
// TrackEventByFileExtension(".pdf");
//
//}
//
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//function TrackEventByFileExtension(FileExtension)
//{
// $("a[href$='" + FileExtension + "']").click(function() {
// var fileURL = $(this).attr("href");
// _gaq.push(['_trackPageview', fileURL]);
// });
//}
/* End Track Event Binding Code */

The JavaScript tracks the opening of PDF files on your website. To add file types, copy
TrackEventByFileExtension(".pdf");, paste it below, and update the file type. See
example below.
xfunction TrackEventsForClicks()
{
TrackEventByFileExtension(".pdf");
TrackEventByFileExtension(".png");

Google Site Reports
You can access site-level Google Analytics reports from within the Workarea by selecting
Reports > Traffic Analytics > Google.
NOTE: The following text was adapted from Google Analytics Help Center. Check that site for additional
details on the reports.
Google sites reports show direct traffic on left side, top content on the right.

Search reports show terms used by site visitors to find content on your site. Note that this
data is not retrieved from Google Analytics. Instead, it is retrieved from Ektron’s site search.
The following sections describe Google’s site-level reports.

Visitors
This report shows the number of new and returning visitors who came to your site and how
extensively they interacted with your content. This traffic overview lets you view aspects of
visit quality (i.e. average pageviews, time on site, bounce rate) and visit characteristics (i.e.
first time visitors, returning visits).
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l

Locations—Countries of your site visitors.

l

New vs. Returning—The number of visitors to your site who are new or returning.
A high number of new visitors suggests that you are successful at driving traffic to your
site, while a high number of return visitors suggests that the site content is engaging
enough to keep visitors coming back. You can see how frequently visitors return and how
many times they return in ‘Recency’ report and the ‘Loyalty report’, both under ‘New vs.
Returning’ in the Visitors section.

l

Languages—Uses the language provided by the HTTP Request for the browser to
determine site visitors’ language. Values are given in 2- or 4-character language code
(for example, en-br for British English).
This report captures the preferred language that visitors have configured on their
computers. Understanding who your visitors are is crucial to developing the right content
and optimizing your marketing spend. Many times, geo-location is not enough. Many
countries have diverse populations speaking different languages which present
important market targeting opportunities.

l

User defined—If you modified the tracking code to provide a user-defined segment,
this field identifies that segment by the string you provide when setting up a userdefined segment.

Visitor Trending

l

l

Visits—The number of visits your site receives is the most basic measure of how
effectively you promote your site. Starting and stopping ads, changing your keyword
buys, viral marketing events, and search rank influence the number of visits your site
receives.
Absolute Unique Visitors—The number of unduplicated (counted only once) visitors to
your website over the specified time period. A Unique Visitor is determined using
cookies.
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l

l

Pageviews—The total number of pages viewed on your site. It is a general measure of
how much your site is used. It is more useful as a basic indicator of the traffic load on
your site and server than as a marketing measure.
Average Pageviews—Average pageviews is one way of measuring visit quality. A high
Average Pageviews number suggests that visitors interact extensively with your site. A
high Average Pageviews results from:
o Appropriately targeted traffic (that is, visitors who are interested in what your site
offers)
o

High quality content presented effectively

Conversely, a low average pageviews indicates that traffic coming to the site has not
been appropriately targeted to what the site offers or that the site does not deliver what
the visitor expected.
l

l

Time on Site—One way of measuring visit quality. If visitors spend a long time visiting
your site, they may be interacting with it extensively. However, Time on site can be
misleading because visitors often leave browser windows open when they are not
actually viewing or using your site.
Bounce Rate—The percentage of single-page visits (that is, visits in which the person
left your site from the entrance page).
Bounce rate is a measure of visit quality, and a high bounce rate generally indicates that
site entrance (landing) pages are not relevant to your visitors. You can minimize Bounce
Rates by tailoring landing pages to each keyword and ad that you run. Landing pages
should provide the information and services that were promised in the ad copy.

Browser Capabilities
Optimizing your site for the appropriate technical capabilities helps make your site more
engaging and usable and can result in higher conversion rates and more sales.
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l

Browsers—The browsers that your visitors use.

l

Operating Systems—The operating systems that your visitors use.
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l

Browsers and OS—The browser/operating system combinations that your visitors use.

l

Screen Colors—The number of screen colors your visitors use.

l

Screen Resolutions—The screen resolutions that your visitors use.

l

Flash Versions—The versions of Flash that your visitors have installed.

l

JavaSupport—Whether Java is supported on your visitors' platforms.

Network Properties

l

Network Location—The internet service providers that your visitors use. This report
lets you track the internet service provider (ISP) domains to which the user resolves.
The domain is determined by the internet service that owns the user's internet protocol
(IP) identifier.

l

l

Hostnames—Hosts from which people are visiting your site. Hostnames sometimes
provide insight into organizations that are interested in what you offer.
Connection Speeds—Connection speeds that your visitors are using. Optimizing your
site so that it loads quickly for most visitors can result in higher conversion rates and
more sales.

Traffic Sources
This section provides an overview of the different kinds of sources that send traffic to your
site. The graph shows traffic trends; the pie-chart and tables show what is driving the trends.

l

Direct Traffic—Visits from people who clicked a bookmark to come to your site or who
typed your site URL directly into their browser. Direct traffic can include visitors
recruited via offline (i.e. print, television) campaigns.

l

Referring Sites—Externals sites from which visitors linked to your site.

l

SearchEngines—Visitors who clicked to your site from a search engine result page.
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l

l
l

All TrafficSources—Visitors referred from search engines, sites, and tagged links. The
graph shows the overall trends while the table shows the specific sources (i.e. search
engines, sites, and tagged links) driving the trends.
Keywords—Compares traffic from search keywords to overall traffic to your site.
Campaigns—How people referred from your configured campaigns compare to the
“average” visitor to your site.
The graph shows overall trends, while the table lists each configured campaign. Because
all traffic in this report results from campaigns that you explicitly control, you can use
this information to add or delete campaigns, or to determine the effectiveness of tests
that you have set up using custom tags.

l

Ad Versions—Compares your AdWords ads (and configured campaigns in which you use
the “content” tag) against each other.
This report shows you which ad copy (in AdWords ads or in configured campaigns) is
most effective. Ads with high clickthrough rates show that the copy is effective at getting
the user to click, while high bounce rates, for example, indicate a need for landing pages
that are consistent with what the ad promises.

Content
This report provides an overview of pageview volume and lists the pages (Top Content) that
were most responsible for driving pageviews. You can also reach some useful reports that
reveal how users interact with your site and statistics related to how they found your site in
the first place.
NOTE: Content reports include a link icon ( ) and a hyperlink. If you click the link icon, you go to the
page. If you click the hyperlink, you see a more detailed Analytics report about that page.

l

Top Content—The most commonly viewed pages on your site, and how they are used.
The table lists all pages which were viewed on your site. A high bounce rate indicates a
landing page that should be redesigned or tailored to the specific ad which links to it. A
high 'Time on Page' may indicate content that is particularly interesting to visitors. The
significance of exits varies according to each page. For example, it may be common for
visitors to exit your site from a receipt or “thank you” page because they have
completed a conversion activity. In contrast, a high number of exits from a non-goal
page (from a funnel page, for example) may indicate that the page is confusing or that it
generates user errors.

l
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Content by Title—The most commonly viewed groups of pages on your site (grouped
by title), and how they are used. This report provides the same information in the “Top
Content” report, but aggregated by title tag value.
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l

l

Top Landing Pages—Data on how effectively your landing pages entice visitors to click
further into your site. You can lower bounce rates by tailoring landing pages to their
associated ads and referral links and placing a clear call-to-action on each landing page.
Top Exit Pages—Pages from which people exit your site.
The significance of an exit rate varies according to each page. For example, it may be
common for visitors to exit your site from a receipt or “thank you” page because they
have completed a conversion activity. In contrast, a large number of exits from a nongoal page (from a funnel page, for example) may indicate that the page is confusing or
that it generates user errors

Viewing Google Segments
Google Analytics has an Advance Segments tool that lets you "slice and dice" your Analytics
data with great precision. Advanced segments let you choose what types of visits you want to
be considered when generating the data for a report." (source: About Advanced Segments)
Google segments allow marketers using analytics reports to drill down to specific classes, or
segments, of site visitors, such as
l

Users

l

Sessions and visitors

l

Members and authors

This section explains how to select and view segments within Ektron.
NOTE: While you can view custom segments within Ektron, you must create them within Google
Analytics.
1. Browse to a view of Analytics data. See Also:
2. Click Segment (

).
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3. The Segments screen appears. Select up to 4 segments to display.
4. The screen refreshes and graphs each segment in a different color. In the following
example, new visitors are graphed in blue and returning visitors are orange. Also, the
screen breaks down data by each segment.

Webtrends Analytics
Marketers today face a new set of challenges. With the explosion of new digital channels such
as social and mobile, it is even harder to understand customer behaviors and optimize how to
communicate with them. Both Webtrends Analytics On Demand and On Premises deliver the
industry’s most accurate picture of how customers interact with your brand in the digital
space.
Real-time data, intelligent alerts, and the ability to easily share information within your
organization means you empower your team to make smart and timely decisions based on
solid data. You'll find new opportunities, ensure conversions are on track and respond to
needs faster than ever before.
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PREREQUISITE
Webtrends On Demand
To set up Webtrends Analytics to work with Ektron:
1. Create a Webtrends Account and create a tracking script.
a. Set up a Webtrends account: Webtrends Developer Network.
b. Webtrends sends you an account name, username, and password.
c. Log into Webtrends using this URL: Webtrends Developer Network Login.
d. Use your Webtrends account name, username, and password.
e. From that page, follow this menu path: Administration> Application Settings
> Data Sources.
f. Click New. A Data Source Wizard screen appears.
l
Enter a name for the data you will retrieve.
l

Select your server's time zone.

l

Click Next.

l

l

A summary of the information you entered appears along with a Webtrends
data collection server ID (DCSID) value.
Click Save. The Data Sources screen reappears with your new data source.

g. Copy your Data Source ID number (DCSID), indicated in the following figure. You
will use this number in the next step.

2. Build the Tracking Files. In this step, you tell Webtrends the type of data you want to
track. Webtrends then generates files that track that data.
a. Open Webtrends' Tag Builder page: Webtrends Tag Builder
b. From the Data Sources screen, you can click Build Tag (Tracking Code).
c. Complete this page, which prompts you to identify which data Webtrends should
track.
d. Into the page's Webtrends data collection server ID (DCSID)field, paste the
number you copied in Step 1g above. For help completing the Tag Builder page,
click the information button in the top right corner.
Ektron 8.7
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e. Click the Build Tag button. Webtrends generates files you will use to track usage
statistics. The Summary and Confirmation screen appears.
f. Click the Download tag button.

g. Save the .zip file to your computer.
3. Copy Webtrends Tracking Files to Ektron. You must have permission to edit files on
theEktron Web server. In this step, you
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l

l

replace the Webtrends.html file in your Workarea folder with the one you
downloaded.
replace the <div> tag in your Workarea's Webtrends.ascx file with the one in the
downloaded file of the same name

a. Extract the .zip file you downloaded.
b. Open the folder that contains the extracted files.
c. Copy Webtrends.js.
d. Paste it into the site root\Workarea\Analytics\template folder. This action
replaces a file of the same name.
e. In the folder that contains the extracted files, open Webtrends.html.
f. Copy the <div> tag highlighted below.

g. In the site root\Workarea\Analytics\template folder, open Webtrends.ascx.
h. Replace the <div> tag with the one you copied.
4. Update Ektron's web.config file. You must have permission to edit files on your Ektron
Web server.
a. Obtain a value for your web.config file's ProfileFileName property by going to
https://ws.Webtrends.com/v2/ReportService/profiles/?format=xml.
(Authentication required.)
l
In the User name field, enter your account name\username that you
obtained.
l

In the Password field, enter your password. A screen displays your
Webtrends profile as follows.
<?xml version="1.0" encoding="utf-8" ?> —
<list> —
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<ProfileDefinition>
<string name="ID">ABCD1234</string>
<string name="name">MyAnalyticsAccountName</string>
<decimal name="AccountID">234567</decimal>
<decimal name="TimeZoneID">-500</decimal>
</ProfileDefinition>
</list>

You will use the string name value (highlighted in red), ProfileFileName
property.
b. Open your siteroot/web.config file
c. Find the tag beginning with <add name="Webtrends".
d. Replace the Webtrends tag's properties.
l
Name—The name displayed on the report. If you have several accounts, you
can use names like these.
o Webtrends—developer.ektron.com
o

Webtrends—document.ektron.com

However, the value of this field for one analytics provider must match the
value of the <AnalyticsDataProvider defaultProvider> tag.
l
l

Type—Do not change.
Username, Password—
1. Go to C:\Program Files\Ektron\CMS400vxx\
Utilities\EncryptEmailPassword.exe.
2. Encrypt the Webtrends username and password you obtained.
3. Enter the encrypted values into these properties.

l
l

l
l

l

l

ProfileFileName—Enter the string name value you obtained.
SiteURL—Enter the URL visitors use to access your site. For example,
www.example.com.
UserAccount—Enter the account name you obtained.
Endpoint—The default value is
https://ws.Webtrends.com/v2/ReportService/. You only need to update
this value if you are not using the default Data Collection Server on the Tag
Builder page.
Cache Interval—Use to cache the Analytics provider's data. Enter a number
in seconds. The maximum 86400. Caching improves the performance of the
traffic report page.
AnalyticsTrackingCodePath—Do not change.

Displaying Webtrends Site Reports
You can access Webtrends analytics reports within the Workarea by selecting Reports >
Traffic Analytics > Webtrends.
Refer to the following WebTrends manual for information about specific reports: Webtrends
Administration User Guide > Chapter 32 : Webtrends Analytics Report Library
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Display Options
Webtrends reports provide the following display options.
Data table

Bar chart
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Heat map
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Pie chart
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From the pie chart, you can change the display to see percentages of the following factors.
l

Visits

l

Page views

l

Average visit duration (minutes)

l

Single page view visits

l

Entry page visits

SiteCatalyst Analytics
Adobe's SiteCatalyst® (formerly known as Omniture) provides marketers with actionable,
real-time intelligence about online strategies and marketing initiatives. SiteCatalysthelps
marketers quickly identify the most profitable paths through their website, determine where
visitors are navigating away from their site, and identify critical success metrics for online
marketing campaigns. (source: Adobe SiteCatalyst)
To set up and monitor Web traffic analytics using SiteCatalyst.
1. Log onto site and generate tracking code.
a. Contact Adobe and set up an account to use SiteCatalyst.
b. Use the information Adobe provides (URL, username, password, and so on) to log in
to Adobe Online Marketing Suite.
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c. Click Admin > Admin Console > Code Manager.

d. In the Select the type of code to generate drop-down, choose Javascript.
e. In the Select a Report Suite that collects data for your website drop-down,
choose a report suite you selected when setting up your SiteCatalyst account.
f. In the Match the Character-Encoding of your website drop-down, choose
UTF-8.
g. In the Choose your Currency for Tracking Conversion drop-down, choose
your currency.
h. In the How many periods are in your domain name? drop-down, enter the
appropriate number. The screen shows an example.
i. If your site uses SSL, check the box next to Use https:// instead of http://?.
See Also: Installing Ektron on page 9
j. Click Generate Code.
2. Copy the tracking code to sitecatalyst.ascx.
a. The Code Manager screen displays code to track analytics on your Ektron site. Copy
the code under the Page Code tab.
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b. Open the following file:site
root\Workarea\Analytics\template\sitecatalyst.ascx.
c. Delete all text below the following line.
<%@ Control Language="C#"
AutoEventWireup="true"
CodeFile="sitecatalyst.ascx.cs"
Inherits="Analytics_Template_SiteCatalyst"
EnableTheming="false" EnableViewState="false" %>

d. Paste the code you copied in Step 1 into sitecatalyst.ascx, below the line shown
above.
e. Save sitecatalyst.ascx.
3. Copy the s_code.js file to Workarea folder.
a. Use the Code Manager screen's Code Archive Name field to assign a name to the
files you created in the previous step.
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b. Use the Code Archive Description field to assign a more detailed description to
the files you created in Analyzing Content on page 601.
c. Click Save. Code Manager compresses the Page Code and Core Javsascript files
into a .zip file, and displays them under Saved Code.
d. Click Download next to the saved .zip file. You are prompted to download the .zip
file to your computer.
e. Click OK.
f. Open the downloaded .zip file.
g. Extract the s_code.js file to site root\workarea\analytics\template. You
may be prompted to confirm that you are overwriting a file of that name already in
the folder.
4. Update Ektron's web.config file.
NOTE: Your SiteCatalystWeb Services Username and Shared Secret. To obtain, log in to Adobe
Online Marketing Suite and click Admin > Admin Console > Company > Company Home >
Web Services.
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a. Open your siteroot/web.config file.
b. Find the tag beginning with <add name="SiteCatalyst".
c. Replace the SiteCatalyst tag's properties.
l
Name—Do not change.
l
l

Type—Do not change.
Username, Secret—
1. Go to C:\Program Files\Ektron\CMS400vxx\Utilities
\EncryptEmailPassword.exe.
2. Encrypt the SiteCatalyst Web Services Username and Shared Secret you
obtained.
3. Enter the encrypted values into these properties.

l

l

l
l
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CompanyName—Enter the company name obtained from Adobe when your
account was created.
ReportSuiteID—Enter the ReportSuiteID obtained from Adobe when your
account was created.
SiteURL—Enter the site URL. For example, www.example.com.
Endpoint—Enter your account's endpoint. You obtain one when you set up
your SiteCatalyst account. An endpoint looks like this: https://apisbx1.omniture.com/admin/1.2/rest/.
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l

l

CacheInterval—You can use this field to cache the Analytics provider's data.
Enter a number in seconds. The maximum 86400 (24 hours). Caching
improves the performance of the traffic report page.
AnalyticsTrackingCodePath—Do not change.

SiteCatalyst Reports
You can access site-level SiteCatalyst reports from within the Workarea by selecting Reports
> Traffic Analytics > SiteCatalyst.
NOTE: The descriptions were adapted from SiteCatalyst Analytics Help Center (Adobe Marketing Cloud
Sandbox Sign In). Check that site for additional details on the reports.
l

Analyzing Site Statistics on page 604

l

Site Content below

l

Mobile on the next page

l

Paths on the next page

l

Traffic Sources on page 635

l

Products on page 653

l

Visitor Retention on page 654

l

Visitor Profile on page 654

Site Metrics
Page views
Displays the number of times your website pages were viewed for the selected time period
(hour, day, week, month, quarter or year). This report lets you track page views for each
individual page on your site, as well as an aggregate of page views for your website as a
whole.
Visits
Displays the number of visits made to your website during the selected time period.
Daily unique visitors
Shows the number of unique visitors to your site for a selected daily time frame. A unique
visitor is counted the first time he/she visits your site within the selected time frame. If a
visitor returns again to your site, they are not counted as a unique user again until the
selected time frame has passed.
Time spent per visit
Reveals the length of time visitors spend viewing your site as a whole during each visit. It
also has an Average Time Spent on Site statistic that shows the average time that was spent
viewing your site, taken across all visitors.

Site Content
Pages
Ranks pages on your site based on those that receive the most traffic.
Site Sections
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Shows the areas of your site that were visited most by your site customers. Site Sections
could include (but are not limited to) groups of products, similar to Categories. Data for the
Conversion Site Sections report is imported from the Site Section report in the Traffic group,
which receives its information from the channel variable in the SiteCatalyst tracking code.
You can use this report to identify the greatest impact on site statistics from items in varying
site sections.
Servers
SiteCatalyst lets you group pages together that are being hosted by a particular server. For
example, if you have a website that is hosted on two different servers, you may want to see if
one server is serving more impressions than the other server. This report lists all of the
servers of your website that are being tracked by SiteCatalyst and tells you which servers are
being accessed the most.
Exit links
Shows links that your visitors click to leave your site and go to another site. Exit links are
those links that take your visitor to another site. Most common examples of exit links are
links to partners, affiliates, and so on.
Custom links
Shows links your site visitors prefer, helping you better understand the navigation patterns
within your site.
File downloads
Displays files that have been downloaded from your website. These files can be any type of
document you wish to track, including user manuals, presentations, audio, or video files. This
report requires that link tracking code to be installed on the site you are tracking.
Pages not found
Lists the number of times a Page Not Found (404- error) page appears to your site visitors
and lists the URLs of the pages that were not found.

Mobile
Mobile
Several criteria about mobile devices visitors use to access your site, such as device type,
screen size, audio support, and so on.

Paths
Reloads
Shows the number of times individual pages were reloaded by page visitors.
Page depth
Identifies the depth at which each page within your site is visited. Depth for a page is
measured by counting the number of pages viewed before that page. So, if your "About Us"
page is the third page visited by a given visitor, its depth for that visit is 3. You can use this
report to identify which pages compel your visitors to travel the deepest into your site and to
optimize content and navigation to make key content more accessible.
Time spent on page
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Displays the length of time that visitors browse individual pages in your site. The time spent
is divided into 10 categories: less than 15 seconds, 15-30 seconds, 30-60 seconds, 1-3
minutes, 3-5 minutes, 5-10 minutes, 10-15 minutes, 15-20 minutes, 20-30 minutes and
greater than 30 minutes.
Entry pages
Shows, by percentage and total visits, which pages on your site are the first ones seen by
new visitors.
Original entry pages
Shows the first page viewed of the first-ever visit to your site. Each user is counted only once
unless they delete their cookies or are not being tracked with cookie

Traffic Sources
Search keywords—All, Paid
Displays a breakdown of each search keyword that has been used to find your site. You can
sort this list by page views or search keywords by clicking the column title above the listing.
Click on the blue magnifying glass next to each search keyword to see the actual search
results screens where your site was listed.
Search engines—All, Paid, Natural
Helps you learn which search engines people are using to find your Web page. The graph
shows you the percentage breakdown of the search engines that have been used to find your
site.
All Search Page Ranking
Shows the results pages on which your site links were located in the user's searches that
were performed. For example, a user who came to your site from a search engine may have
seen you on the third of one hundred pages of results. This can help you quickly see and
optimize search engine efforts. Data for this report may be viewed for all but the 'Hourly'
time period.
Referring domains
Shows the domains that referred the customers that most impacted your site's Success
Metrics. Referrers fall into 2 main categories: Domains and URLs. Domains refer to the
domain name, and appear as the base domain without the query string or subdirectories
attached. URLs include the base domain name, as well as any query strings or subdirectories.
Original Referring Domain
Shows the original referrers that produced the customers on your site. Customers can visit
your site multiple times, and have a different referrer for each visit. This report shows how
they were referred the first time they arrived at your site. This can help you see if they
continued to use the same referrer and view patterns in how customers are referred to your
site. You can view the number of visitors generated by an original referrer or discover how
much revenue each original referrer was responsible for producing.

Products
Helps you identify how individual products and groups of products (categories) contribute to
your various conversion metrics, such as revenue or checkouts.
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Visitor Retention
Return frequency
Shows the number of visitors who returned to your site within one of the following categories
(representing the time lapse between visits): less than 1 day, 1-3 days, 3-7 days, 8-14 days,
14 days to 1 month and longer than 1 month.
Visit number
Provides another method for gauging visitor loyalty by displaying the visit number for each
visitor that comes to your site.

Visitor Profile
Geosegmentation
l

l

l
l

l
l

l

l

l
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Countries—Shows countries from which visitors access your site. In addition to the
standard "Ranked" and "Trended" views available on most reports, there is also a "Map"
view that color-codes the countries according to their relative contribution to your total
traffic-the more intense the color the greater the number of daily unique visitors from
that country that are visiting your site
Regions—Shows regions from which visitors access your site. To the right of each
region shown, the country of the region is also shown in parentheses. Clicking the
magnifying glass icon to the left of the region will open the line item in the SiteCatalyst
Cities Report. With this report, you can see how a selected region performed compared
to another on your web site.
State—The U.S. states from which visitors access your site.
Zip/postal code—Shows the zip and postal codes that produced the customers that had
the greatest effect on purchase success metrics.
Cities—Shows U.S. cities from which visitors access your site.
U.S. DMA (Designated Market Area)—Shows the marketing areas within the United
States from which visitors access your site. By clicking the link next to State in the
Report Status header, you may restrict the report to marketing areas within a particular
state. This data is provided via a partnership between Omniture and Nielsen Media
Research, Inc. By clicking the Visitors Per Capita link next to Display in the Report Status
header, you can adjust the data by the relative population of each marketing area.
Enabling this option shows both the number of daily unique site visitors per 10,000
people living in the market area as well as the percent above or below the national
average value. You can also generate a Correlation report by clicking the Correlation
icon next to one of the market areas and selecting the item with which you want to
correlate the data.
Visitor Home Page—Another method of gauging visitor loyalty and assessing the
perceived value your visitors place on your website's content. The report shows how
often your visitors mark a page on your website as their 'Home Page' in their browser.
Language—Displays your visitors' preferred languages. The Languages Report captures
the default browser language and displays those most used by visitors to your site.
Time zone—Displays the time zones your visitors are located in when they view your
site. This report superimposes a bar graph (indicating the number of visitors) on a map
of the world so you can quickly see what part of the world your visitors are from.
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l

l

Domains—Lists the organizations and ISPs your visitors use to browse your site. This
report differs from the Full Domains report in that the Full Domains report registers the
full ISP domain, whereas this report lists the secondary domain.
Top Level Domains—Identifies world regions that visitors come from, based on their
originating domain extension, and shows how many visitors come from these countries.
Domains ending in Commercial (.com), Network (.net), Education (.edu), Government
(.gov) and Organization (.org) are usually based in the United States, and are listed
separately from the rest of the domains.

Technology
l

Browsers—Identifies the types and versions of browsers that are used by your visitors.

l

Browser Type—Classifies the browsers visiting your site into their major families

l

l

l

l

l

l
l

Browser Width, Browser Height—Shows the most common widths or heights of the
browsers (in pixels) your visitors use to view your site.
Operating Systems—Shows which operating systems are being used by your site
visitors
Monitor Color Depth—Shows your visitors' most popular color-depth settings as
configured on their computer. Color-depth refers to the number of colors that can be
displayed on the screen.
Monitor Resolutions—Shows screen resolutions that visitors to your website most
commonly use, as configured on their computers.
Java, JavaScript —The JavaScript Version report displays the versions of JavaScript
your visitors' browsers use while viewing your site.
Cookies—Shows the percentage of visitors that prefer to use cookies while browsing.
Connection Type—Displays the percentage of your site's visitors that utilize highspeed Internet connections versus slower dial-up connections.

Setting Up Site Overlay
Site Overlay provides an easy-to-use visual map of popular links on a Web page, based on
the frequency of clicks. When Site Overlay is enabled, each link on a page is represented by a
horizontal bar graph. When you hover over the graph, you see its statistics. The following
image shows menu links and the overlay bar graphs.
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PREREQUISITES
l
l

Site Overlay requires Google Analytics as your Web Traffic provider.
Set the web.config key ek_AutoInsertBeaconScript to true.
<add key="ek_AutoInsertBeaconScript" value="true" />

To enable Site Overlay, access the Content Menu by hovering over the access point ( ) and
selecting Site Overlay.
NOTE: You must be assigned the Analytics Viewer role or a member of the Administrators group.

l

l

When Site Overlay is enabled, a toolbar appears at the top of the page and lets you
change the date range of the Site Overlay data.

Change the date range to view statistics for a different period. Default is one month
before today. To refresh the page, click Refresh (

l

).

Click Remove Overlay to disable Site Overlay.

On every place that a visitor can click on your Web page, a bar graph indicates the percentage
of clicks on this element. When you hover over a bar graph, you see a click count and a
percentage comparing these clicks to all clicks on the page.

Troubleshooting Site Overlay
You may encounter these issues.
l
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Error message—"Username and/or password not set. Please update the
AnalyticsDataProvider section on your web.config. Parameter name: Username,
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Remarks about the data

Password."
l
l

The Google Analytics provider must be configured in web.config. See
Clicks are not showing on the Overlay.
o Be sure enough time has elapsed since the clicks occurred and the Google Analytics
provider has recognized them. (24 hours)
o

Check that the key for ek_AutoInsertBeaconScript is true.

Remarks about the data
l

l

Data providers typically record clicks based on the link href parameter. If a link with
identical hrefs exists in more than one location on a page, the data provider reports each
one clicked the same, equal to the total of all clicks for that href on that page. This
means that if link A is clicked 10 times and link B is never clicked, but they have the
same href parameters, both show 10 clicks.
Some providers are case-sensitive in certain cases; Google data has been shown to
report data separately when a letter-case of the page's URL changes. Therefore, clicks
for “Test.aspx” might not show up for “test.aspx”.
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PageBuilder lets you easily create new pages on your website. The page template that you
choose is initially created by a developer, but you provide final content, design, and
placement of functionality on the Web page.
The PageBuilder work flow has the following stages:
1. Define the "look and feel" for your website.
Stakeholders may include the CIO, the marketing team, Ektron administrators, Web
designers, and developers. When a consensus is reached, the marketing team defines
the page layout and presents it to the whole team for review and approval.

2. Create the wireframe templates.
A developer creates a wireframe template, which is the basic architecture for a Web
page. The developer adds dropzone user controls where non-technical users into which
content authors place functional widgets and manage the content, design, and
messaging.
Developers manage the level of control non-technical users have. For example, a
developer can configure limits for the width of dropzones. The developer should
understand the requirements and use, modify, or build widgets based on the
requirements. PageBuilder lets IT develop the back-end of a system and address the
technical nuances that today’s websites generate.
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3. Create permissions for content authors.
After a wireframe is created, an administrator assigns the wireframe to a folder, creates
a page, and chooses the widgets that user can place on the page.
4. Build and maintain Web pages.
When wireframe templates are available, you choose the page template you want to use
and create new pages, drag-and-drop widgets, edit properties, and so on. You create
and maintain content.

PageBuilder pages have the same business-level controls as content blocks. Like other Ektron
content, PageBuilder pages maintain permissions, approval chains, enable SEO (through
metadata), taxonomy, Aliasing, and allow users to view histories and restore past versions.
Approvers can preview PageBuilder pages before they go live, and pages can be cloned and
then modified to maintain consistency across campaigns or to support A/B split testing.
Additional PageBuilder Video Resources
l

PageBuilder for Marketers

l

PageBuilder for Developers

Creating New PageBuilder Pages
You can create a new PageBuilder page from the PageBuilder menu on your website, or from
the Workarea. You must have permissions as a content author to log in and make changes to
your website. See Defining Roles on page 1120

Creating a New PageBuilder Page from Your website
1. Log into your website.
2. Open the PageBuilder menu and choose File > New Page. The Add New Page wizard
appears.
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3. Click on your choice of template. It is highlighted and shows a check mark on it.
4. Click Next. The wizard shows fields to define your new page.

5. Enter a title in the Title field, enable Content Searchable, and choose a taxonomy. By
default, the Manual Alias matches the Page Title.
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IMPORTANT: You should use automatic aliasing in most cases because you cannot standardize
an aliasing pattern with manual aliasing. Automatic aliasing standardizes alias naming. See
Creating Automatic URL Alias Rules on page 849 for information about automatic aliasing.
6. Click Next. The wizard shows Metadata and Summary information that you can enter.
See Also: Writing a Summary for Content on page 292; Working with Metadata on
page 369

7. Click Finish. A confirmation dialog box appears.

8. Click OK to start editing the page.

Creating a New PageBuilder Page In the Workarea
PREREQUISITE
You must have wireframes already created in a folder. See Assigning the PageBuilder
Wireframe to a Folder on page 686.
1. Click on the Pages folder (or one of its subfolders) where you want to add the new page.
2. Choose New > Page Layout.
3. The Add New Page screen appears. (Because only one template is assigned to the folder,
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it appears as the default.)

4. Click Next. A new screen appears, which lets you assign a title, Taxonomy, and aliasing
information to the page.

5. Enter a title in the Page Title field
6. By default, the Manual Alias matches the Page Title.
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7. Click Next. The following screen appears, which lets you assign metadata and a
summary to the page. See Also: Writing a Summary for Content on page 292; Working
with Metadata on page 369

8. Click Finish. A confirmation dialog box appears. Click OK to start editing the page.

Editing Content on a PageBuilder Page
After the page is created, a new page opens where you can design the page and other actions,
such as check in, view properties, and drop widgets onto the page. To keep the menu open,
click the pin icon ( ).
NOTE: For information about how to create a widget, see Creating the “Hello World” Widget on page 716.

The following image shows a page with a 2-column layout.
l

l

The left column, 35% wide, displays a list of content in the Marketing folder. website
visitors use the list to access Marketing collateral.
The right column, 65% wide, displays one content block.
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Step 1: Add New Column and Set Column Widths
NOTE: If your developer sets dropzone column widths programmatically (as explained in Setting a
Dropzone’s Column Width Programmatically on page 691), you cannot add a column as described here.
Many developers disable this option because it gives end users liberty to resize columns when you may
want to standardize your layout. If your developer has disabled this option, go to Step 2.
Add a second column to the right of the top one. Then, set the width of both columns.
1. Click Add Column (

). A new column appears to the right of the existing one.

2. Set the left column width to 35%. To do this:
a. Click Resize ( ).
b. Enter 35 into the New Width field.
c. Change the measurement to Percent.
d. Click Save.

3. Set the right column to 65% width by clicking the pencil icon, changing its width to 65
Percent, and clicking Save.

Step 2: Insert New Content Block Widget into Right
Column
When the columns are set, insert a ContentBlock widget into the right column.
1. From the PageBuilder tool bar, open the widget menu (
). It shows widgets that the
administrator assigned to the page wireframe in Creating a PageBuilder Wireframe on
page 676.
2. Drag and drop the Content Block widget to the right column. The Content Block Control
appears in the column.
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3. Click Edit (

). The Editing Widget screen appears.

4. On the Folder tab, choose Root > Mainsite > Content > Products > Software and
click New to place the new content in the Software folder. The Edit Content screen
appears.
5. Add a Title.
6. In the content area, enter some text and click Publish.

When published, the content appears in the column.
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7. If you want to edit content on this page, click the Access Point ( ). A menu displays.

Step 3: Insert a List Summary Widget into Left
Column
After you insert content in the right column, insert a List Summary widget in the left column.
1. From the PageBuilder menu, open the widget menu (
). Widgets assigned to the
page wireframe in Creating a PageBuilder Wireframe on page 676 appear.
2. Drag and drop the List Summary widget into the left column. The List Summary widget
appears, displaying a list summary for content in the root folder.

3. Click Edit (
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). The Editing Widget screen appears.
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4. On the Folder tab, choose Root > Mainsite > Content > Products > Software.

5. Clicks Save. The List Summary widget shows the Summary information from the
content in the Software folder.
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6. From the PageBuilder menu, choose File > Check In. You can review the page in
Preview mode and make sure it is formatted properly.
l
Choose View > Preview Layout to see the page in a browser.
l

Choose View > Mobile > iPhone, iPad, or Droid to see the page on a simulated
mobile device.

7. When the page is complete, choose File > Publish from the PageBuilder menu.

Using Responsive Frameworks with PageBuilder
You can modify the look of a page by adding columns that can contain dropzone elements.
Each column that you add responds according to the design rules that are applied to your site.
For Ektron releases prior to Version 8.7, when you added a column to a PageBuilder page, you
selected a unit of measurement (pixel, em, percent) and number of units (for example, 200).
With Version 8.7 and beyond, you also can choose your site's CSS framework (for example,
Bootstrap).
Responsive Web Design (RWD) lets columns fit in a window without horizontal scrolling. The
following image shows a Web page built with the Twitter Bootstrap framework and
PageBuilder. The highlighted section displays 3 columns within 1 PageBuilder dropzone. Each
column displays a different widget.
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When this page is resized, styles rearrange the columns so that they fit without horizontal
scrolling.
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If you want to add another column and more widgets to a row, apply styles to the column
according to the website's CSS framework.
To continue the example, the row now has 4 columns. Apply to each column a value of Span3,
so the combined width totals span12, the maximum width of a Bootstrap page. Now, 4
columns (each containing widgets) fit into this section of the page. If the browser is resized,
each column is sized according to the Bootstrap styles.
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If you view this page on a smart phone, the columns are rearranged.

You can use a variety of RWD frameworks, such as:
l

l

Twitter Bootstrap—a free collection of tools for creating websites and Web
applications that contains HTML and CSS-based design templates for typography, forms,
buttons, charts, navigation, other interface components, and optional JavaScript
extensions. See the Twitter Bootstrap website.
Foundation—a light-weight framework for rapidly building prototypes and production
websites. See the Foundation website.
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l

Skeleton—a small collection of CSS files for rapid development of sites that look
beautiful at any size. See the Skeleton website.

IMPORTANT: The pagebuilder.config file contains sample data from the Twitter Bootstrap and
Foundation frameworks. If you use a different RWD framework (such as Skeleton), add the necessary
CSS style sheets to your site, and update pagebuilder.config with the framework's class names
and CSS paths. See Creating Web Pages with PageBuilder on page 659.
Any element on the page can take as many columns as it needs, but all elements in a row
must not exceed the maximum number of columns. Twitter Bootstrap and Foundation have a
grid system of 12 columns per row; Skeleton has 16 columns per row. For example, the
following patterns represent how many columns each element uses in a row. No pattern
exceeds 12 (unless you use Skeleton's 16 columns); periods indicate offset columns (spaces).
An offset pushes a column to the right. See the following examples.
1
4
1
6
4
.
.
.

1
4
1
6
.
.
.
.

1 1 1 1 1 1 1 1 1 1 — 12 single columns
4
— 3 columns (4 columns-wide each)
2 3 4 1
— 6 columns (varying column widths)
— 2 columns (6 columns-wide each)
. . . 4
— 2 columns (4 columns-wide, with a
. 3 . . . 3
— 2 columns (3 columns-wide, with 2
. . 8
— 1 column (8 columns-wide, with a
5 . . . . .
— 1 column (5 columns-wide, with a

4-column offset)
offsets)
4-column offset)
2-column offset)

The following result occurs from adding 12 columns of Type: Bootstrap.

When you add a column to a PageBuilder page and click Resize (
Bootstrap, the following Resize form appears.

), then chooses the Type:

The following result occurs from choosing Type: Bootstrap, Width: 5 Columns, Offset: 2
Columns (which leaves 5 columns to the right).
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The following result occurs from adding a column to the previous example, and choosing
Type: Bootstrap, Width: 4 Columns, Offset: 1 Column for the new column. (Pattern: . .
5 . 4)

Note that if you shrink the window from right to left, the second column gets moved under the
first, as follows:
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Developing Wireframe Templates
NOTE: Internet Explorer cannot accommodate more than 32 style sheets in one page. This problem can
affect PageBuilder pages, because each widget may include one or more style sheets, and a page can
host any number of widgets.

Creating a PageBuilder Wireframe
You first create a wireframe. Next, define the dropzone, one or more areas of the page on
which a content creator drags and drops widgets. The relationship between a wireframe, a
dropzone, and a widget is illustrated below.
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To create a wireframe that contains one dropzone:
1. Open the website in Visual Studio.
2. Choose Web Site > Add New Item to add a new Web form to the site.
3. Select Web Form.
4. Set the Name to PageLayout.aspx, the Language to Visual C#, and check Select
master page.

5. Click Add.
6. When prompted to select a master page, choose from the directory
siteroot/components/templates.
7. Register the user controls directly below the @Page directive (at the top of the file).
<%@ Register Assembly="Ektron.Cms.Controls"
Namespace="Ektron.Cms.Controls" TagPrefix="CMS" %>
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<%@ Register Src="~/Workarea/PageBuilder/PageControls/PageHost.ascx"
TagPrefix="PH" TagName="PageHost" %>
<%@ Register Src="~/Workarea/PageBuilder/PageControls/DropZone.ascx"
TagPrefix="DZ" TagName="DropZone" %>
<%@ Register Assembly="Ektron.Cms.Widget"
Namespace="Ektron.Cms.PageBuilder" TagPrefix="PB" %>

8. Add code for a PageBuilder Menu (PH: PageHost) and Dropzone. To do this, locate the
ContentPlaceHolder1 and enter this code.
IMPORTANT: When inserting the following code, begin the <ColumnDefinitions> statements
with the TagPrefix on the widget assembly registration line (PB in the example above). Do not use
IntelliSense when entering <ColumnDefinitions> statements—it may insert an incorrect prefix.
<PH:PageHost ID="PageHost1" runat="server" DefaultPageID="937"
SelTaxonomyID="94" />
<DZ:DropZone ID="Middle" runat="server" AllowAddColumn="false"
AllowColumnResize="false">
<ColumnDefinitions>
<PB:ColumnData width="100" columnID="0" unit="pixels"></PB:ColumnData>
<PB:ColumnData width="100" columnID="1" unit="pixels"></PB:ColumnData>
<PB:ColumnData width="100" columnID="2" unit="pixels"></PB:ColumnData>
</ColumnDefinitions>
</DZ:DropZone>

With the PageBuilder menu (PageHost) and Dropzone in place, the template looks like
this when you are logged in and ready to configure a PageBuilder page.

This control lets a content author drop widgets on the page. It also provides the
save/check in/publish functions, and lets the author preview the page when it is
published. The content author uses a Dropzone control as a placeholder, into which you
insert widgets. You also can use it to insert additional placeholders as needed.
The pagelayout.aspx code now looks like this.
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BEST PRACTICE
Assign an appropriate value for the SelTaxonomyID property. See Assigning a Default
Page to a Wireframe on page 687 and Assigning a Default Taxonomy Category to a
Wireframe on page 688.
9. Open the code-behind page, PageLayout.aspx.cs.
10. Add a reference to the PageBuilder namespace by adding the following line after the last
using statement.
using Ektron.Cms.PageBuilder.

11. Inherit the PageBuilder class instead of System.Web.UI.Page. To do this, change:
public partial class PageLayout : System.Web.UI.Page

To:
public partial class PageLayout : PageBuilder

12. Add the following code after the Page_Load event to handle errors and notifications.
public override void Error(string message)
{ jsAlert(message);
}
public override void Notify(string message)
{ jsAlert(message);
}
public void jsAlert(string message)
{ Literal lit = new Literal();
lit.Text = "<script type=\"\"
language=\"\">{0}</script>";
lit.Text = string.Format(lit.Text, "alert('" + message + "');");
Form.Controls.Add(lit);
}

You do not need to use the jsAlert system defined here. But if you do not, you must add
overrides to handle errors and notifications.
The code page for pagelayout.aspx.cs looks like this.
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13. Save the PageLayout.aspx and PageLayout.aspx.cs files.

Creating a PageBuilder Master Layout
A Master Layout is a special type of PageBuilder template that may include a special kind of
dropzone called a Master Zone. A Master Zone is only editable by users assigned to the
Administrators group or the MasterLayout-Create role. All other dropzones on a Master Layout
template are called Layout Zones. Anyone can edit them.
An example use of this template is: a department head reserves one Master Zone on the
department pages for content that only the department head may edit. Content authors may
drag and drop a widget into other dropzones, but cannot edit the Master Zone.
The following diagram shows a Master Layout template that contains 2 dropzones and 4
widgets. In the example below, the Master Zone contains a Flckr widget.
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When a Master Layout is published, you can use it like any other template. The following
figure shows a sample page that uses a Master Layout.

After you created a wireframe with 2 dropzones, both of which are editable, you can set a
dropzone so that others may not edit it.
1. Workarea Content panel, choose New > Folder. The Add folder screen appears.
2. In the Name field, type Master Layouts.
3. In the Templates tab, uncheck Inherit parent configuration. Then, select a
wireframe template from the list of templates. For example, products.pb.aspx
(Wireframe Template).
4. Click Add (

) next to the Select Template field. The template is added to the list.

5. Click the radio button next to the selected template to make it the folder's default
template.
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6. Click Add Folder.
7. In the folders screen, click the new Master Layouts folder.
8. Choose New>Master Layout, as shown below.

9. Set the title to MasterLayout1.
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10. Click Next.

11. Set Metadata, Summary, and Taxonomy Categories if desired, then click Finish. A
confirmation message appears.

Setting a Dropzone to a Master Zone Type
After the wizard finishes, you see a new Master Layout page with dropzones that can be used
for Master Layout areas. You must unlock a dropzone to convert it to a Master Zone. The
following figure shows a Master Layout with dropzones.

1. Click Lock ( ) to change a dropzone from Layout Zone to Master Zone. A warning
appears. Click OK.
IMPORTANT: Unlocking this dropzone deletes columns and widgets that are on templates based
on this master layout. Click OK to unlock this dropzone.
2. Drag and drop appropriate widgets into the Master Zone. The figure illustrates dropping
a Flickr widget.
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3. On the PageBuilder menu, select File > Publish.

Assign a Master Layout to the Pages Folder
Before creating a PageBuilder page based on the Master Layout, you must add it to the
templates available to the Pages folder. To do this:
1. In the Workarea, choose Folders > Mainsite > Pages.
2. On the View Content screen, choose View > Properties.
3. Click Edit Properties.
4. Click the Templates tab.
5. Select the Master Layout.

6. Click Add (

) to add it to the template list.

7. Click Update.

Using a Master Layout to Create a New Page
After you create the Master Layout page and assign it to the Pages folder, you can use it for
other PageBuilder pages. To do this:
1. In the Workarea, choose Folders > Mainsite > Pages.
2. On the View Content screen, choose New > Page Layout. The Add New Page screen
appears.
3. Select the new Master Layout and click Next.
4. Complete the settings for Title, Taxonomy, and Aliasing and click Next.
5. Enter Metadata and a Summary and click Finish. A confirmation message appears.
You can now place widgets in the PageBuilder page's Layout Zones.

Changing a Master Zone to a Layout Zone
PREREQUISITE
You must be an Administrators group member or assigned to the MasterLayout-Create
role
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You may want to convert a Master Zone back to a Layout zone. To do this:
1. Access the Master Layout page that you want to edit.
2. From the PageBuilder menu, choose File > Edit.
3. On the layout zone, click Lock ( ) to change the dropzone type from Master Zone to
Layout Zone. A warning appears.
WARNING! Locking this dropzone deletes columns and widgets in the master zone, and affects all
templates based on this Master Layout.
4. The Master Zone now appears Locked. PageBuilder editors can use this Layout Zone for
widgets on PageBuilder pages derived from this Master Layout.

Adding the Wireframe and Widgets into Ektron
An Ektron administrator uses the wireframe that a developer made, and determines which
widgets will be available to the wireframe.
1. In the Workarea, choose Settings > Configuration > Template Configuration.
2. Click Add New Template to System. The Add a New Template screen appears.

3. Click Browse ( ) and navigate to PageLayout.aspx, the wireframe you created
earlier in Creating a PageBuilder Wireframe on page 676.
4. Click the PageBuilder Wireframe check box, which indicates that this template may
be used to create a PageBuilder page. Widgets that can be applied to the template
appear. Ektron provides many standard widgets. See Widget Reference on page 714.
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5. Click any of the widgets (for example, ContentBlock or ContentList). The background
color changes indicating that they are selected.
6. Click Add New Template to System.

Assigning the PageBuilder Wireframe to a Folder
Create a folder for the content that appears on the new page by performing these steps.
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1. Choose Workarea > Content > Folders. The View Contents screen appears.
2. Choose New > Folder.

NOTE: You should keep content and PageBuilder pages in separate folders, so you can later create
and configure a folder called “Content.” The content folder will contain content blocks, assets, and
sub-folders.
3. On the Proerties tab, type Pages in the Name field.
4. On the Templates tab, if Inherit parent configuration is checked, uncheck it.
5. Select the template that you created in Adding the Wireframe and Widgets into Ektron on
page 685as the default (and only) template for this folder. This ensures that only
PageBuilder pages can be created in this folder.
6. Click Add (

) to the right of the pull-down menu. PageLayout.aspx is added to the list

of page templates.
7. Create a corresponding content folder. However, instead of assigning pagelayout.aspx
as the template, assign a template for creating Ektron content.

Assigning a Default Page to a Wireframe
You can assign a default page to a wireframe. If you do, and a site visitor enters a URL with a
path to that wireframe that lacks a query string ID, the default page appears. The following
example explains this feature.
l

l

The following URL returns PageLayout ID 1036 in the PageBuilder folder:
http://
siteroot
/cms400developer/developer/PageBuilder/PageLayout.aspx?pageid=1036
The following URL returns the Page Layout page identified in the PageLayout.aspx file’s
PageBuilder menu user control DefaultPageID property.
http://siteroot/cms400developer/developer/PageBuilder/PageLayout.aspx
(Note lack of query string parameter)

To assign a default page to a wireframe:
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1. In the Workarea, create a PageBuilder page that will be used as the default pageid for a
wireframe.
2. In Visual Studio, open the wireframe file assigned to that folder.
3. Find the PageBuilder menu user control (circled below).

4. Add a new property, DefaultPageID.
5. For the property’s value, enter the ID of the page you created in Step 1.
Here is an example of that line with the DefaultPageID property added.
<ucPageBuilder:PageHost ID="ucCms400Developer" DefaultPageID=”1035” runat="server"
/>

6. Save your changes.
To continue the above example, if someone opens a browser and enters
http://siteroot/cms400developer/developer/PageBuilder/PageLayout.aspx, he
is redirected to
http://sitroot/cms400developer/developer/PageBuilder/PageLayout.aspx?page
id=1035

Assigning a Default Taxonomy Category to a
Wireframe
While creating a new PageBuilder page in the Workarea, the user can assign one or more
taxonomy categories that are set in the page’s folder properties. See example below.
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As a developer, you can assign a default taxonomy category to a wireframe. If you do, and
the user creating a page using that wireframe makes no changes, the default category is
assigned to the page. However, the user can change the taxonomy when the Add New Page
screen appears.
NOTE: Default taxonomies are applied only when a user logs into a website and adds a new page -- they
are not applied when creating new pages within the Workarea.
To assign a default taxonomy category to a wireframe:
PREREQUISITE
The ID number and the name of the top-level parent taxonomy for the default
taxonomy category. For example, the screen shows that the Products category ID is
190, and its parent taxonomy is OnTrek Site Navigation.

1. In the Workarea, navigate to the folder properties screen of the folder to which the
wireframe is applied.
2. Click Edit Properties.
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3. Locate the Taxonomy tab of the Edit Folder properties screen.

4. Check the box of the top-level taxonomy to the wireframe you want to assign.
5. Check the box of the parent taxonomy of a taxonomy category that you want to assign;
that is, a child node below a top-level taxonomy.
6. Click Update to save your changes to folder properties.
7. Open Visual Studio.
8. Open the wireframe to which you will assign a default taxonomy.
9. Find the PageBuilder menu user control (circled below).

10. Add the property SelTaxonomyID.
11. For the property’s value, enter the ID of the default taxonomy or category.
Here is an example of that control with the SelTaxonomyID property added.
<ucPageBuilder:PageHost ID="ucCms400Developer" SelTaxonomyID=”13”
runat="server" />
12. Save your changes.
To continue the above example, the next time someone creates a page based on that
wireframe, taxonomy ID 13 will be the page’s default taxonomy category. If desired, the user
can change it by navigating to the Taxonomy tab and assigning different or additional
categories.

Customizing a PageBuilder .aspx Page
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Setting a Dropzone’s Column Width Programmatically
To set a dropzone’s column widths programmatically:
1. Add the following Register statements to the page’s <head> tags.
IMPORTANT: The Widget and Dropzone assemblies must have the same Tag Prefix. See
example.
<%@ Register Assembly="Ektron.Cms.Widget"
Namespace="Ektron.Cms.PageBuilder" TagPrefix="PB" %>
<%@ Register Src="~/Workarea/PageBuilder/PageControls/PageHost.ascx"
TagPrefix="PB" TagName="PageHost" %>
<%@ Register Src="~/Workarea/PageBuilder/PageControls/DropZone.ascx"
TagPrefix="PB" TagName="DropZone" %>
<%@ Register Assembly="Ektron.Cms.Widget"
Namespace="Ektron.Cms.PageBuilder" TagPrefix="PB"%>

2. Within the page’s <body> tags, add the following code. The following example adds 3
columns of 100 pixels each.
<PB:DropZone ID="Middle" runat="server">
<ColumnDefinitions>
<PB:ColumnData width="100" columnID="0" unit="pixels"></PB:ColumnData>
<PB:ColumnData width="100" columnID="1" unit="pixels"></PB:ColumnData>
<PB:ColumnData width="100" columnID="2" unit="pixels"></PB:ColumnData>
</ColumnDefinitions>
</PB:DropZone>

Set width to an appropriate number. For the unit, the options are
l

pixels

l

percent

l

em

Overriding the Default Folder Where New Pages are
Saved
By default, when a site user creates a new PageBuilder page from an existing one, it is saved
to the same Ektron folder. For example, consider this folder/content structure.
-Root (folder id 0)
--Products (folder id 20)
---PageLayout: “Omaha Mailorder Steaks” (content id 35)
--Services (folder id 30)

If you are viewing content id 35 and click New Page or Copy/Save as, the new page is
saved to that content’s folder (Products, folder id= 20).
NOTE: When you create a new page layout from the Workarea, you first select a folder then begin
creating the page layout.
Use the PageBuilder control’s FolderID property in the .aspx page to override the default and
specify an Ektron folder to which new pages are saved. Here is an example of that property:
<ucPageBuilder:PageHost ID="ucPageHost1" FolderID="25" runat="server" />
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When a user is working on a page that hosts this PageBuilder control, and he saves a new
page, it is saved to folder id 25.

Setting a Cache Interval
Use the CacheInterval property to cache a page and its widgets that represent Ektron server
controls, such as a Collection widget. This property sets the amount seconds for which data is
cached. The default is 0 (zero).
<ucPageBuilder:PageHost ID="ucPageHost1" CacheInterval="25" runat="server" />

Letting Users Add Columns to a Dropzone
Use the AllowAddColumn property to let users add columns to a dropzone.
<ucPageBuilder:DropZone ID="ucDropZone1"
AllowAddColumn="true"
AllowColumnResize="true" runat="server" />

For example, a Dropzone initially contains one column, but the page creator wants 3. If this
property is set to true, this change is possible. This property’s default value is true.
NOTE: If you set dropzone’s column widths programmatically (as explained in Setting a Dropzone’s
Column Width Programmatically on the previous page), the user cannot add a column, regardless of this
setting.

Letting Users Resize a Dropzone
Use the AllowColumnResize property to let users change the width of columns in a dropzone.
<ucPageBuilder:DropZone ID="ucDropZone1"
AllowAddColumn="true" AllowColumnResize="true" runat="server" />

For example, column width is 100% by default. A page creator wants to change it to 50%. If
this property is set to true, this change is possible. This property’s default value is true.
NOTE: If you set dropzone’s column widths programmatically (as explained in Setting a Dropzone’s
Column Width Programmatically on the previous page), the user cannot add a column, regardless of this
setting.

PageBuilder Code Samples
The following shows a complete example of AcmeBooksMasterPage.master,
PageLayout.aspx, and PageLayout.aspx.cs.

AcmeBooksMasterPage.master
<%@ Master Language="C#" AutoEventWireup="true"
CodeFile="AcmeBooksMasterPage.master.cs"
Inherits="AcmeBooksMasterPage" %>
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
<html xmlns="http://www.w3.org/1999/xhtml">
<head runat="server">
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<title>Acme Books</title>
<asp:ContentPlaceHolder id="head" runat="server">
</asp:ContentPlaceHolder>
</head>
<body>
<form id="form1" runat="server">
<div>
<asp:ContentPlaceHolder id="ContentPlaceHolder1"
runat="server">
</asp:ContentPlaceHolder>
</div>
</form>
</body>
</html>

PageLayout.aspx
<%@ Page Language="C#"
MasterPageFile="~/AcmeBooksMasterPage.master"
AutoEventWireup="true"
CodeFile="PageLayout.aspx.cs"
Inherits="PageLayout" Title="Untitled Page" %>
<%@ Register
Assembly="Ektron.Cms.Controls"
Namespace="Ektron.Cms.Controls" TagPrefix="CMS" %>
<%@ Register
Src="~/Workarea/PageBuilder/PageControls/PageHost.ascx"
TagPrefix="PH" TagName="PageHost" %>
<%@ Register
Src="~/Workarea/PageBuilder/PageControls/DropZone.ascx"
TagPrefix="DZ" TagName="DropZone" %>
<%@ Register
Assembly="Ektron.Cms.Widget"
Namespace="Ektron.Cms.PageBuilder"
TagPrefix="PB" %>
<asp:Content ID="Content1"
ContentPlaceHolderID="ContentPlaceHolder1" runat="Server">
<PH:PageHost ID="PageHost1" runat="server"
DefaultPageID="937" SelTaxonomyID="94" />
<DZ:DropZone ID="Middle" runat="server"
AllowAddColumn="false" AllowColumnResize="false">
<ColumnDefinitions>
<PB:ColumnData width="100" columnID="0" unit="pixels"></PB:ColumnData>
<PB:ColumnData width="100" columnID="1" unit="pixels"></PB:ColumnData>
<PB:ColumnData width="100" columnID="2" unit="pixels"></PB:ColumnData>
</ColumnDefinitions>
</DZ:DropZone>
</asp:Content>

PageLayout.aspx.cs
using
using
using
using

System;
System.Data;
System.Configuration;
System.Collections;
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using System.Web;
using System.Web.Security;
using System.Web.UI;
using System.Web.UI.WebControls;
using System.Web.UI.WebControls.WebParts;
using System.Web.UI.HtmlControls;
using Ektron.Cms.PageBuilder;
public partial class PageLayout : PageBuilder
{ protected void Page_Load(object sender, EventArgs e)
{}
public override void Error(string message)
{jsAlert(message);}
public override void Notify(string message)
{jsAlert(message);}
public void jsAlert(string message)
{ Literal lit = new Literal();
lit.Text = "<script type=\"\" language=\"\">{0}</script>";
lit.Text = string.Format(lit.Text, "alert('" + message + "');");
Form.Controls.Add(lit);
}
}
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Multivariate testing lets you offer several variations of the same page, then measure site
visitors' reactions to each variation. The one that generates the most conversions is
automatically promoted to the design for that page, thereby maximizing your website's ROI.
The variations can alter any number of page elements (images, copy, buttons, form fields,
and so on) to find the combination that most effectively compels site visitors to take the next
step. No longer do you need to speculate on the best page design; now, you can use actual,
timely data drive those decisions.
Ektron Multivariate testing is easy to implement, requiring no help from a developer or
designer.
This section also contains the following topics.
How Multivariate Testing Works
An Example of Multivariate Testing
Using Widgets for Multivariate Testing
Using PageBuilder Pages and Content
Creating a Multivariate Experiment
Starting and Running an Experiment
Cookies in Multivariate Testing
Using a Target Page Outside of You Website
Repeating an Experiment
Scheduling an Experiment
Using Reports
Using Multiple Section Widgets
The Number of Variations Tested
Multivariate Target Widget Details
Multivariate Experiment Widget Details
Multivariate Section Widget Details
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How Multivariate Testing Works
Content variations appear to site visitors during an experiment. The page variation that a site
visitor sees is randomly selected by the system. When a visitor navigates to a special page
called the target, it is logged as a conversion. A conversion might be a donation, registration,
sales lead, and so on. Conversions are tracked, and the variation that produces the most
conversions is automatically promoted to the website.
Sometimes, this type of testing is called “A/B Testing”, but Multivariate Testing is far more
than that. A/B testing provides only a few variations. With Multivariate Testing, the number of
page combinations grows exponentially as the number of layout and content combinations
increase.
IMPORTANT: The Multivariate Testing feature requires the use of PageBuilder templates. For more
information, see Developing Wireframe Templates on page 676.
Also, the Multivariate testing feature is part of Ektron's Marketing Optimization Suite. For
more information about the suite, including webinars, white papers, instant demonstrations,
and so on, see Rapidly Test and Target to Optimize Results.

An Example of Multivariate Testing
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In the example below, the marketing manager wants to know which of 3 ads produces the
most visits to a registration page.

l

The experiment page contains ads that link to a registration form.

l

A target page contains the registration form.

l

A conversion is a visits to the target page produced by each ad.

When the target number of conversions occurs, the variation achieving it automatically
becomes the permanent page on the site. The optimum page runs on the website without
further effort by the website Admin.

Using Widgets for Multivariate Testing
You use the following PageBuilder widgets for Multivariate Testing:
l

Multivariate Experiment widget

l

Multivariate Section widget

l

Multivariate Target widget

The widgets look like this in the PageBuilder widget tray.
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The following list describes each widget type.
l

l

l

Multivariate Target widget (for the Target Page)—When a page view occurs on a page
containing this widget, the conversion count is increased. See Multivariate Target Widget
Details on page 707
Multivariate Experiment widget (for the Experiment Page)—This controls the
experiment. Settings include the target content number, start/stop button and the Report
hide/show button. This is only available when logged in and editing the PageBuilder
experiment page. See Multivariate Experiment Widget Details on page 707
Multivariate Section widget (for the Experiment Page)—This widget lets you drag and
drop various content widgets into it. These produce the variations used during the
experiment. A slider control selects each specific content used in the variations.

More than one Multivariate Section widget can be used on a page. See Multivariate Section
Widget Details on page 708

Using PageBuilder Pages and Content
Before you create a Multivariate Experiment, you will need to have 2 Web pages: the Target
page and the Experiment page.
Both pages are created with PageBuilder which lets you drag and drop widgets into your page.
For more information about PageBuilder, see Creating Web Pages with PageBuilder on
page 659. You may choose any type of widget for your pages.

Creating a Multivariate Experiment
PREREQUISITES
To run Multivariate Tests, you must be an Administrator or have the Multivariate
Tester Role assigned. For more information see Defining Roles on page 1120.
To create a Multivariate experiment:
1. Create a target page that contains the Target widget. See Also: Creating a Multivariate
Target Page below
2. Create an experiment page that contains the content variations with the Experiment and
Section widgets. See Also: Creating a Multivariate Experiment Page on the facing page
3. Run the experiment until it automatically ends or you stop it. See Also: Starting and
Running an Experiment on page 702

Creating a Multivariate Target Page
The target page is the Web page you wish your visitors to view. It contains the Multivariate
Target Wizard. Visitors arrive here by clicking links on the experiment page.
To create the target page:
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1. Create or edit the PageBuilder page with the target content.
2. Note and record the ID of the content number on this page. (For example: 948.) This ID
number is used in Step 3 below Creating a Multivariate Experiment Page below.
3. Add the Multivariate Target widget to any location on the page.

4. Publish this page
After creating the Target Page, create the Multivariate Experiment Page.

Creating a Multivariate Experiment Page
The Experiment page contains:
l

the Experiment widget

l

the Section widget(s)

l

the content variations

The following illustration shows the basic steps to create an experiment page with
Multivariate Test widgets.
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To create a multivariate experiment page:
1. Create or edit the PageBuilder page you wish to use during the experiment. See Also:
Creating Web Pages with PageBuilder on page 659
2. Place the Multivariate Experiment widget in any location on your Web page. Do not worry
about the appearance of this widget. Multivariate Test widgets do not appear on a Web
page when you are not logged in. Only the content shows. For more information, see
Multivariate Experiment Widget Details on page 707
3. Enter the Target Page Content Id number. (For example, 948.) (See step 2 of Creating a
Multivariate Target Page on page 698) To help find the content, browse the content
folders by clicking the Ellipsis button.

4. Enter the Conversions before promote value. Setting this to 1000 tells the experiment to
automatically end when one variation has reached 1000 conversions.
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5. Place at least one Multivariate Section widget into the location where your content
variations should appear. For more information, see Multivariate Section Widget Details
on page 708
6. Drag any type of content widget into the Multivariate Section widget.
7. Configure the content widget with the appropriate settings. (You may use any widget
inside the Multivariate Section widget. The Content widget was chosen for the purposes
of this example.)
8. Add more variations by clicking the Add Variations button (

) and repeat steps 6 and

7. You now have variation 2 of 2.

9. If you wish to add another section and variations, go back to step 5 and continue. The
image below shows a completed experiment page that has 2 Section widgets.
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10. Publish the PageBuilder page. Now you are ready to run the experiment.

Starting and Running an Experiment
When you create the Target Page and Experiment Page:
1. Select the PageBuilder page that contains the Multivariate Experiment widget.
2. Click File > Edit to see the Experiment widget.
3. On the Experiment widget, click the Start button.

4. After you click Start, you see the Stop and Show Report buttons.

When an experiment is running, visitors see a randomly-chosen page variation. The visitor
continues to see this variation until the experiment is ended.
NOTE: During an experiment, testers may modify variations and content within the Multivariate Section
widget.
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Displaying Reports During an Experiment
Click the Show Reports button to see the experiment’s progress. The reports shows:
l

the percentage of conversions compared to visits

l

the number of conversions

l

the total number of visits to each variation

Click the Preview button (

) to see the page variation associated with the progress bar.

For more information on using and interpreting reports, see Using Reports on page 705.

Enabling or Disabling a Variation
At any time during the experiment, you may disable any variation. Do this by clicking the (
) button which currently shows the variation is enabled. The variation then becomes disabled
and cannot be viewed by site visitors.
When a variation is disabled, visitors who have seen this page no longer see it but see
another variation instead.
You may re-enable a variation by pressing the ( ) button, which currently shows the
variation as disabled. The variation then becomes enabled and visitors can view it.

Stopping the Experiment
At any time during the experiment, click the Stop button on the Experiment widget.

This suspends the experiment. Counters stop incrementing, even though visitors continue to
see the page variations.
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While the experiment is stopped, cookies are neither set nor read. For more information
about cookies, see Cookies in Multivariate Testing below. When you stop an experiment, the
Multivariate Section widget remains on the experiment page.
You may restart the experiment again by pressing the Start button. All counters are reset to 0
and restarted.

Automatically Ending the Experiment
When one variation reaches the target number of conversions, it automatically becomes the
page variation all visitors see. All other variations are disabled.

Manually Ending the Experiment
During the experiment, you may click on the Promote button (

) of the specific variation you

wish to promote. This ends the experiment, and the selected variation becomes the page
variation all visitors see. All other variations are disabled. When the experiment
automatically or manually ends, the Multivariate Section widget is removed from the
experiment page.

Cookies in Multivariate Testing
When visitors view the experiment page, a cookie is set in the browser. This cookie indicates
the specific variation seen by the visitor. From this point forward, if they next visit the target
page, this cookie is read and the proper variation counter is increased.
A cookie persists forever or until the cookies are removed from the browser cache. The
cookie gives a visitor a consistent page variation each time they revisit during the
experiment.
Visitors that block cookies are not counted in conversions. Also, they see random page
variations each time they visit the page.

Using a Target Page Outside of You Website
When your target page is outside of your website, you must create an intermediate page that
contains the Target widget, and redirect the visitor to the outside address.
For example, to test visitors from your page to http://www.NFL.com:
1. Create a new PageBuilder page.
2. Add the target widget to it.
3. Add the code that will redirect the visitor from this page to www.NFL.com.
4. Create content with links to the target page you just created.
When the experiment is running, the experiment page links the visitor to this intermediate
page and the conversion is counted. Then, the redirect takes the visitor to the external page.

Repeating an Experiment
To repeat an experiment after it has ended, you first must restore the history of this page. To
restore history of a PageBuilder page, follow the steps in Restoring a Previous Version on
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page 303.
After you restore the previous version, you may edit the parameters of the experiment,
modify the content, and run the experiment again.

Scheduling an Experiment
The PageBuilder page has the same properties as other content types, including the Schedule
Property. To set the beginning and ending date of the page, edit the PageBuilder page and
follow the procedure for setting content schedules as described in Scheduling Content on
page 296.
Be sure to set the Schedule End Date to be long enough past the time you believe the
experiment will automatically end.

Using Reports
Reports show how each variation has performed during the experiment. Click on the Show
Report button in the Experiment widget to see the progress and results.

The bar graph shows the conversion percentage.
The numbers to the right of the bar graph show 2 values. The first value is the percent of
conversions compared to the total number of visits to the experiment page. On variation #2
above, the “79%” means that 568 visitors to this variation have successfully reached the
target page 451 times.
The numbers after the percentage show the actual conversations. The first number before the
forward slash (/) indicates the total number of conversions during the experiment. The
second number is the total number of times this variation was viewed by a visitor. Users that
are logged in are counted as a page view to the experiment page but not counted on the
target page as a conversion.
The following list describes how to use each button.
l

Preview—Shows the page configurations for this specific variation. Notice that not
only does the content in the Multivariate Section wizards change, but also the slider
number changes too.
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l

l

l

Variation Enabled—When this appears, this variation is currently selected to run.
Click this button to disable this variation.
Variation Disabled—When this appears, this variation is currently not selected to
run. Click this button to enable the variation.
Promote—Click this button to promotes this specific variation to become the actual
page seen by visitors. All other variations are disabled and the experiment is ended.

Using Multiple Section Widgets
You may create a PageBuilder page with more than one Section widget. This provides greater
flexibility in helping to identify combinations of content and images that provide the best
conversion results.
A page containing 2 Multivariate Section widgets is shown below.

The contents inside the Section widgets are part of the variations shown randomly during the
experiment.

The Number of Variations Tested
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The number of variations in a Multivariate Experiment grows exponentially as you add
sections and variations.
For example, if you have 2 sections with 3 variations in each section, there are a total of 8
(23) pages to be tested. If you increase this to 4 variations each, there are 16 (24) pages.

Multivariate Target Widget Details
The target widget is placed on the page containing the content you wish people to find.
The target widget does not have any configurations and need only reside somewhere on the
page. Use only one Target widget per PageBuilder page

The Target Page
The target (or results) page contains the Multivariate Target widget.
Whether you arrive at the target page by browsing to the variations page first or by browsing
to the target page directly, the views are counted with the following exceptions:
l

if you are logged in

l

if you have not first visited the experiment page to receive the cookie

l

if you have cleared the cookies before visiting the target page

NOTE: Users that are logged in are counted as a page view of the experiment page but not counted on the
target page as a conversion.

Multivariate Experiment Widget Details
The Multivariate Experiment widget contains all of the information about the variations you
use in an experiment. It also contains the Start/Stop button and the conversion limits. Use
only one Experiment widget per PageBuilder page.
The image below is an example of the Multivariate Experiment widget before the experiment
is started.

l
l

Target—This is the content ID of the target page.
Conversions—This is the number of conversions any variations must have before the
experiment is stopped automatically.

Set the target page's ID number and the value of Conversions. When this value is reached,
the experiment promotes the variation with the highest percent of success, and disables all
other variations.
To start the experiment, click the Start button.
Below is an example of a Multivariate Experiment widget while an experiment is running. If
desired, you can click the Stop button to stop the experiment.
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The experiment widget also shows reports to indicate how each variation has performed
during the experiment.
Click the Show Report button to see the conversion information during the experiment. For
further information about reports, see Using Reports on page 705.

Automatic Promotion
Automatic promotion occurs when the target number of conversions occurs on one of the
variations. For more information see Automatically Ending the Experiment on page 704.

Manual Promotion
During an experiment, you may choose a specific variation to be the page that all visitors see
and end the experiment. For more information see Manually Ending the Experiment on
page 704.

Multivariate Section Widget Details
The Multivariate Section widget contains the content variations for the experiment. By using a
variety of content combinations, the experiment tests the best arrangement of content to
accomplish the desired conversion goals. The content is presented randomly to the site
visitor. You may use one or more Section widgets per PageBuilder page.
The following sample Web page contains the Multivariate Section widget.

Variation Selector Slider
The slider bar at the top of the Multivariate Section widget is used to select the variation.
The sample Web pages below demonstrate the slider control for variation 1/2 and 2/2.
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Move the slider to see each variation.
Click Add Variation (

) to add another variation. Drag and drop the content widget into

this section. After configuring it, this content widget is now one of the variations used in the
experiment cycle.

Progress Bar
During the experiment, statistics are collected on:
l

the number of page visits to the target page

l

the number of page visits to a specific variation

The experiment progresses until it is either stopped or ended. For more information, see
Using Reports on page 705.
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A widget is a mini-application that can provide either specific functionality (search, social
bars, and so on) or areas into which you can add Ektron content (content blocks, list
summaries, collections, and so on). You can drag and drop widgets onto a page using a
wireframe, dropzones, and widgets.
To open the widget bar from the PageBuilder menu, click the up/down (
) controls.

) or down (

A widget consists of 3 file types.
l

.ascx—contains a widget’s source code

l

.ascx.cs or .vb—contains widget’s code-behind

l

.ascx.jpg—image that represents a widget in the widget selection tool

NOTE: Your widget might use additional files, such as .css or .js files.You should place these files in a
folder within siteroot/widgets, and give the folder the same name as the custom widget.
When you create a widget, save files to the siteroot/widgets folder. This folder path is
defined in the site root/web.config file, so if you need to change the folder name or path,
you must update the following web.configek_widgetPath element:
<add key=”ek_widgetPath” value=”Widgets/" />.

Ektron stores each page’s data (a serialized XML string) as a type of content within the Ektron
Workarea. The string is stored like other content types, such as HTML content and XML Smart
Forms.
After widgets are integrated into Ektron, you can add them to a dashboard in your profile
page or a community group’s page. You also can drag-and-drop these building blocks onto a
PageBuilder page. See Also: Personalizing a Web Page on page 825

The following figure shows the relationship between a wireframe, dropzones, and widgets.
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l

A wireframe can have several dropzones.

l

Each dropzone can have several columns.

l

Each column can have several widgets.

Widget States
Widgets placed on a PageBuilder page have 3 possible combinations of states.
l

l

View page mode—View widget mode—Widget content appears on page. For example:

Edit page mode—View widget mode—Widget can be placed on the page, moved, and
deleted. For example:
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l

Edit page mode—Edit widget mode—User defines widget information. For example:

In a widget’s user control file, you create an asp:MultiView element that determines
available actions when a widget is in View mode and Edit mode.
<%@ Control Language="C#" AutoEventWireup="true"
CodeFile="HelloWorld.ascx.cs" Inherits="widgets_HelloWorld" %>
<%@ Register Assembly="System.Web.Extensions, Version=1.0.61025.0,
Culture=neutral, PublicKeyToken=31bf3856ad364e35"
Namespace="System.Web.UI" TagPrefix="asp" %>
<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">
<asp:View ID="View" runat="server">
<!-- You Need To Do .............................. -->
<asp:Label ID="HelloTextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>
<!-- End To Do .............................. -->
</asp:View>
<asp:View ID="Edit" runat="server">
<div id="<%=ClientID%>_edit">
<!-- You Need To Do .............................. -->
<asp:TextBox ID="HelloTextBox" runat="server" Style="width: 95%">
</asp:TextBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" />
<br /><br />
<!-- End To Do .............................. -->
<asp:Button ID="CancelButton" runat="server" Text="Cancel"
OnClick="CancelButton_Click" /> &nbsp;&nbsp;
<asp:Button ID="SaveButton" runat="server" Text="Save"
OnClick="SaveButton_Click" />
</div>
</asp:View>
</asp:MultiView>

Widget Reference
Widgets are typically located in the Ektron webroot/siteroot/widgets/ folder. Ektron
assigns standard names to widgets. Ektron administrators can change a widget's name on the
Synchronize Widgets Screen.
If you want to remove a widget from use:
1. Delete the widget’s files from the /siteroot/widgets/ folder.
2. Navigate to Settings > Configuration > Personalizations > Widgets and click
Synchronize. The widget is removed from the list of widgets, and from the dashboard
of any users and community groups.
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Activity Stream—Displays activities of a user or group, depending on the type of page
on which it is placed. See Also: Using the ActivityStream Widget on page 1233
Blog—After you select a blog id, displays posts from that blog.
Brightcove Video—Plays a Brightcove video. See also Using a Brightcove Video Widget
on page 748.
Collection—Displays a collection. You select a Collection ID.See Also: Working with
Collections on page 355
ContentAnalytics—Displays information about a set of content or products. The
following figure shows the Highest Rated products in the default Software taxonomy.
Content Block—Lets user enter a content ID and display that content in the widget.
Alternatively, user can create new HTML content from the widget.
Content List—Displays a list of content blocks. In contrast to a List Summary, where
content must be in a specified folder, the ContentList control displays content from any Ektron
folder.
Content Review—Places a ContentReview server control on the page. This control
allows site visitors to rate and review the current page. See Also: ContentReview on
page 1712 server control
Flash—Displays a selected flash file which resides in Ektron. You can also set the
display’s height and width. See Also: Using the Flash Widget on page 746
Flickr—Display Flickr’s Most Recent or Most Interesting photos. The user also can select
the number of rows and columns for the image display.
GoogleGadget—Select from several Google feeds to display in the widget.
HelloWorld—Very simple widget. Created by Ektron to help developers understand how
to create their own widgets.
iFrame—Lets user enter a path to a Web page or an item on the Web page.
List Summary—Displays an Ektron List Summary, a list of certain types of content in a
selected folder. See Also: ListSummary on page 1756 server control
MessageBoard—Allows user to leave comments on the page. See Also: MessageBoard
on page 1786 server control
Metadata List—Displays content whose metadata fits a selected folder location and
keywords. See Also: MetadataList on page 1796 server control.
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Most Popular—Reports on the following categories of content on your website: Most
Viewed, Most Emailed, Most Commented, or Highest Rated. See Also: Most Popular Widget on
page 607
Multivariate Experiment—This controls the experiment. Settings include the target
content number, start/stop button and the Report hide/show button. See Also: Using Widgets
for Multivariate Testing on page 697
Multivariate Section—Lets you drag and drop various content widgets. These produce
the variations used during the experiment. See Also: Using Widgets for Multivariate Testing
on page 697
Multivariate Target—When a page view occurs on a page containing this widget, the
conversion count is increased. See Also: Using Widgets for Multivariate Testing on page 697
ProductAnalytics—Displays information about a set of content or products. The
following figure shows the Highest Rated and most Viewed products in the Hardware
taxonomy.
QRCode—Generates a QR code based on the information you provide.
RSS Feed—Allows a user to enter the path of an Really Simple Syndication (RSS) feed.
Spacer—Lets you create an unused space on the Web page.
TabPlus—Lets you display more than one type of content in a tabbed widget. You can
display a tab for a Content Block, a List Summary, a Collection, or Upcoming Events.
Targeted Content—Lets you create a set of conditions. As soon as any condition
evaluates to true, an appropriate widget appears. See Also: Creating Conditions with the
Targeted Content Widget on page 731
Taxonomy Summary—Displays content assigned to a taxonomy category. See Also:
Using Taxonomies on page 777, Directory on page 1718 server control
Trends—By default, the Trends widget shows the Most Viewed content on your website.
You can edit the widget so it displays any of these content categories instead: Most Emailed,
Most Commented, or Highest Rated. See Also: Trends Widget on page 610
Upcoming Events—Shows a list of scheduled calendar events.
WebCalendar—Provides full calendar functionality, including adding events. See Also:
Working with Calendars on page 514
YouTube Video—Lets you embed code for any YouTube video.

Creating the “Hello World” Widget
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Step 1: Copy, Paste, and Rename HelloWorld.ascx

NOTE: For more information on creating widgets, see Break It Down! Widget Development How-to (Part
1).
To learn how to create a widget, create a simple widget in the siteroot/widgets folder. This
widget is based on the Hello World widget that is installed with the sample site with the
following files:
l

HelloWorld.ascx—user control file

l

HelloWorld.ascx.cs—user control code-behind file

l

HelloWorld.ascx.jpg—image that represents this control on the widget menu

Step 1: Copy, Paste, and Rename HelloWorld.ascx
and HelloWorld.ascx.jpg
1. Open your website in Visual Studio.
2. In the Visual Studio Solution Explorer, open the widgets folder.
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3. Within that folder, scroll down to and select HelloWorld.ascx.

4. Right click the mouse and choose Copy.
5. Scroll up to the widgets folder.
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6. Right click the mouse and choose Paste.

7. Scroll down until you see Copy of HelloWorld.ascx.
8. Right click and choose Rename.
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9. Rename the file new_widget.ascx. Visual Studio automatically renames the code-behind
file to new_widget.ascx.cs.
10. Copy, paste, then rename the helloworld.ascx.jpg file to new_widget.ascx.jpg.The
image file is 48 x 48 pixels and 72 dpi. Ektron administrators and content authors drag a
widget’s image onto the page.

Step 2: Update the Class Names in the New Files
1. Double click on new_widget.ascx to open it.
2. On the first line of that file, replace the reference to HelloWorld (circled below) with
new_widget.

3. Double click on the code-behind file, new_widget.ascx.cs.
4. Replace the class HelloWorld with new_widget.

5. Save new_widget.ascx and new_widget.ascx.cs.
6. Check for errors by choosing Build > Build Page for each file. Correct any errors
before proceeding.

Step 3: Add Widget in Workarea
1. Open the Workarea.
2. Choose Settings > Configuration > Personalizations > Widgets.
3. Click Synchronize. The new user control file, new_widget.ascx, appears in the list.
4. Choose Settings > Configuration > Template Configuration.
5. Find the template that you created in Developing Wireframe Templates on page 676,
PageLayout.aspx. Or, any wireframe template that you are using to create a
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PageBuilder page.

6. Click Update Template. On the Update Template screen, scroll down until you see the
new widget.

7. Click Select All (circled in the figure).
8. Click Update Template. For directions on creating a PageBuilder page, see Developing
Wireframe Templates on page 676.
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9. Go to Content and select a folder that has a PageBuilder page.
a. Choose Content > Folders > PageBuilder and click on PageLayout.
b. Click Edit Page Layout.
10. Open the widget menu. Make sure your new widget appears on the menu.

After you create a new widget and enable it in the Workarea, you can begin to customize it.
For more information about customizing widgets, see Customizing Widgets on page 726.

Understanding the User Control (.ascx) File
Here is the new_widget.ascx file that is the basis of the widget.
<%@ Control Language=”C#” AutoEventWireup=”true”
CodeFile=”new_widget.ascx.cs” Inherits=”widgets_new_widget” %>
<%@ Register Assembly="System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"
Namespace="System.Web.UI" TagPrefix="asp" %>
<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">
<asp:View ID="View" runat="server">
<!-- You Need To Do .............................. -->
<asp:Label ID="TextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>
<!-- End To Do .............................. -->
</asp:View>
<asp:View ID="Edit" runat="server">
<div id="<%=ClientID%>_edit">
<!-- You Need To Do ............................. -->
<asp:TextBox ID="TextTextBox" runat="server" Style="width: 95%">
</asp:TextBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" />
<br />
<!-- End You Need To Do ......................... -->
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<asp:Button ID="CancelButton" runat="server" Text="Cancel"
OnClick="CancelButton_Click" />
<asp:Button ID="SaveButton" runat="server" Text="Save"
OnClick="SaveButton_Click" />
</div>
</asp:View>
</asp:MultiView>

Notice the following elements of the file.
l

The asp:MultiView element declares that the control has 2 possible modes: View and
Edit.
<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">

l

in view mode, the marketing team can see the control but not change it.

l

in edit mode, the developers can change the control’s content and properties.

l

Between the multiview tags is information about the control in view mode. It has 2
fields: one is a text field, and the other is a check box.
<asp:View ID="View" runat="server">
<asp:Label ID="HelloTextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>
</asp:View>

l

Also between the multiview tags is information about the control in edit mode. In edit
mode, a text box, a check box, and a Save button appear. The text box and check box
collect end-user input, and the Save button saves that input to the database.
<asp:View ID="Edit" runat="server">
<div id="<%=ClientID%>_edit">
<!-- You Need To Do .............................. -->
<asp:TextBox ID="HelloTextBox" runat="server" Style="width: 95%">
</asp:TextBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" /> <br />
<!-- End You Need To Do .............................. -->
<asp:Button ID="CancelButton" runat="server" Text="Cancel"
OnClick="CancelButton_Click" />
<asp:Button ID="SaveButton" runat="server" Text="Save"
OnClick="SaveButton_Click" />

Understanding the Code-behind (.ascx.cs) File
Review the code-behind file,new_widget.ascx.cs.
l

A series of using statements are at the top of the file. Notice the Ektron ones in
particular:
using
using
using
using
using
using

l

Ektron.Cms.Widget;
Ektron.Cms;Marketing team
Ektron.Cms.API;
Ektron.Cms.Common;
Ektron.Cms.PageBuilder;
System.Text.RegularExpressions;

Next, note a widget host class, which inherits the system.Web.UI.UserControl and
IWidget classes.
public partial class widgets_new_widget: System.Web.UI.UserControl, IWidget

The following figure summarizes the remaining elements of the code-behind file.
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l

In the next line, notice the widget’s properties: a string for the text field, and a boolean
for the check box. You define the variables and their type here. Possible types are string,
integer, long and date.
#region properties
private string _HelloString;
private bool _CheckBoxBool;
[WidgetDataMember(true)]
public bool CheckBoxBool { get { return _CheckBoxBool; }
set { _CheckBoxBool = value; } }
[WidgetDataMember("Hello Wolrd")]
public string HelloString { get { return _HelloString; }
set { _HelloString = value; } }
#endregion

l

The following is a widget host declaration.
private IWidgetHost _host;

l

The following is the widget’s page_init events.
protected void Page_Init(object sender, EventArgs e)
{ _host = Ektron.Cms.Widget.WidgetHost.GetHost(this);
_host.Title = "Hello World Widget";
_host.Edit += new EditDelegate(EditEvent);
_host.Maximize += new MaximizeDelegate(delegate() { Visible = true; });
_host.Minimize += new MinimizeDelegate(delegate() { Visible = false; });
_host.Create += new CreateDelegate(delegate() { EditEvent(""); });
PreRender += new EventHandler(delegate(object PreRenderSender, EventArgs Evt)
{ SetOutput(); });
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ViewSet.SetActiveView(View);
}

Comments about the page_init code
l

l

l

l

The gethost method returns a reference to the container widgethost for this widget.
This is the case in both Personalization and PageBuilder.
The Title property is the title of this widget. By setting it in page_init for the widget,
we inform the host what text to put in the title bar above the widget. This works in both
PageBuilder and Personalization.
The events below host.Title are raised by the widgethost. It’s up to the widget to
subscribe to them. In all cases, if we don’t subscribe to them, the icons don’t show up.
This is a method of attaching widget code to button clicks and other events that occur
outside the widget.
For PreRender: Ektron renders the contents of this widget on pre-render, thus ensuring
a single render event. Another option is to call SetOutput on the Load event, but you can
only do that if the widget is not in edit mode currently.

l

The final line sets the view to display mode.

l

The following is the declaration of the widget’s edit events.
void EditEvent(string settings) {
string sitepath = new CommonApi().SitePath;
ScriptManager.RegisterClientScriptInclude(this, this.GetType(),
"widgetjavascript", sitepath + "widgets/widgets.js");
ScriptManager.RegisterOnSubmitStatement(this.Page, this.GetType(),
"gadgetescapehtml", "GadgetEscapeHTML('" + HelloTextBox.ClientID + "');");
HelloTextBox.Text = HelloString;
MyCheckBox.Checked = CheckBoxBool;
ViewSet.SetActiveView(Edit);
}

Comments about the edit code
IMPORTANT: You must register JavaScript and cascading style sheet (css) instructions in an external
file.
l

l

l

l

l

The Edit event is triggered by the widgethost, and if you subscribed to it already, it will
call the delegate here.
Use sitepath to ensure that the correct path for included files is used across
installations.
Ensure that it works inside update panels by calling the scriptmanager to include the
script. Alternatively, you can use Ektron.Cms.Api.Js.RegisterJSInclude
ScriptManager.RegisterOnSubmitStatement(this.Page, this.GetType(),
"gadgetescapehtml", "GadgetEscapeHTML('" + HelloTextBox.ClientID +
"');");
The onsubmitstatement is JavaScript that is run when the widget is submitted. It calls
escape html, which cleans the submitted text to avoid any XSS.
Notice the editing fields, so users can see the existing data.
HelloTextBox.Text = HelloString;
MyCheckBox.Checked = CheckBoxBool;
ViewSet.SetActiveView(Edit);
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l

The following code is the widget’s save events.
protected void SaveButton_Click(object sender, EventArgs e)
{ HelloString = ReplaceEncodeBrackets(HelloTextBox.Text);
CheckBoxBool = MyCheckBox.Checked;
_host.SaveWidgetDataMembers();
ViewSet.SetActiveView(View);
}

l

The following code is the widget’s SetOutput events.
protected void SetOutput()
{ HelloTextLabel.Text = HelloString;
// client javascript remove brackets, server side adds back
CheckBoxLabel.Text = CheckBoxBool.ToString();
}

l

The following code is the widget’s Cancel events.
protected void CancelButton_Click(object sender, EventArgs e)
{ ViewSet.SetActiveView(View); }

l

The following code is for greater than and less than signs.
protected string ReplaceEncodeBrackets(string encodetext)
{ encodetext = Regex.Replace(encodetext, "&lt;", "<");
encodetext = Regex.Replace(encodetext, "&gt;", ">");
return encodetext; }

Customizing Widgets
The following topics let you further customize widget behavior.

Working with JavaScript and Cascading Style Sheets
You can use JavaScript or a cascading style sheet to add custom functionality or styling to a
widget. To do this, place the JavaScript or cascading style sheet (css) instructions in an
external file, then register it in the code-behind file.
Example of including a JavaScript file.
void EditEvent(string settings)
JS.RegisterJSInclude(this, _api.SitePath +
"widgets/contentblock/jquery.cluetip.js", "EktronJqueryCluetipJS");

Example of including a .css file.
Css.RegisterCss(this, _api.SitePath
+ "widgets/contentblock/CBStyle.css","CBWidgetCSS");

WARNING! You must register JavaScript and .css files in an external file, as shown above. If you do not,
the OnSubmit event places HTML in the TextArea field in encoded brackets (< >) and generates a
dangerous script error.
The JS.RegisterJSInclude and Css.RegisterCss functions take 3 arguments.
l

l
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1—A reference to the control that needs the script or style sheet on the page. Typically,
‘this’ or ‘me’. For example:
o this
2—The URL of the script or style sheet being included. You should prefix the URL with a
site path so it can be used with URLs like http://localhost/ektrontech and
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http://ektrontech. For example:
o _api.SitePath + "widgets/contentblock/jquery.cluetip.js"
o
l

_api.SitePath + "widgets/contentblock/CBStyle.css"

3—A unique key. Only include the script specified by a key once. Your organization
should develop a standard way to define JavaScript and .css keys. For example:
o "EktronJqueryCluetipJS"
o

“CBWidgetCSS”

NOTE: Widgets use an update panel for partial postbacks. As a result, the ASP.NET tree view and file
upload controls do not work with widgets. Ektron has workarounds for these functions. For an example of
a tree view, see the content block widget (siteroot/widgets/contentblock.ascx). For an Ajax
file uploader, see the flash widget (siteroot/widgets/flash.ascx).

Verifying that a Page is a PageBuilder Page
Whenever your code is interacting with a widget, you need to verify that it is on a PageBuilder
page (as opposed to another Ektron page that hosts widgets, such as personalization).
To check for this, insert the following code:
Ektron.Cms.PageBuilder.PageBuilder p = (Page as PageBuilder);
If(p==null) // then this is not a wireframe
When you want to check the mode, use code like this.
If(p.status == Mode.Edit) // we are in edit mode

Applying Global and Local Properties to Widgets
Global and local widget properties reduce your development effort by eliminating settings
data classes. While you can still use these classes and manage your own serialization, for the
vast majority of types, the built-in engine performs the necessary work.
Global properties apply to every instance of a widget. Local properties apply to one instance.
If both local and global values are assigned to a property, local overrides global.
As an example of using a local property to override a global, consider a ListSummary widget.
You may want its sort mostly by modified date in descending order, but in certain instances
you want to sort by title in ascending order.
l

Global—Workarea > Settings > Configuration > Personalizations > Widgets
[GlobalWidgetData()]
public string NewWidgetTextData {
get {return _NewWidgetTextData;} set {_NewWidgetTextData = value;
}}

l

Local—Drop the widget onto PageBuilder page, then click edit (Pencil icon).
[WidgetDataMember()]
public string NewWidgetTextData
{ get { return _NewWidgetTextData; } set { _NewWidgetTextData = value; } }

Setting a Widget’s Global Properties
A global property lets an Ektron developer or administrator assign properties and values that
apply to all instances of a widget. You apply a global property to the widget’s code-behind
page. Administrators could then set or update the property’s value in the Workarea’s Widgets
screen.
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For example, the Brightcove Video widget requires a player ID. You could insert that in the
widget’s code-behind file. Then, an administrator could review and possibly update that
information in the Workarea widgets screen. Whenever a user drops a Brightcove Video
widget onto a page, the player ID is already assigned.
If the developer does not set a default value in code-behind, an administrator must set one on
the Workarea’s Widgets screen.
If the developer does set a default value in code-behind, it will be applied unless changed by
an administrator on the Workarea’s Widgets screen.
Steps for Setting a Global Property
1. Open the widget’s code-behind file, which is located in the siteroot/widgets folder.
2. In the properties section, insert the GlobalWidgetData attribute (shown below) to set
the global property’s name and type.
[GlobalWidgetData()]
public string NewWidgetTextData
{ get { return _NewWidgetTextData; } set { _NewWidgetTextData = value; } }

The supported types for GlobalWidgetData are
l

Date Time

l

int

l

long

l

double

l

boolean

l

string

l

any enumeration

3. Save the code-behind file.
4. In the Workarea, go to Settings > Configuration > Widgets.
5. Click Edit for the widget whose code-behind file you edited in Step 1. A dialog box lets
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you view and edit global properties set in code-behind.

Setting a Widget’s Local Properties
A local property lets an Ektron user assign property values that apply to a particular instance
of a widget. For example, the Brightcove Video widget requires a Video ID, which identifies
the video that appears where you drop the widget.
To set a local property:
1. Open the widget’s code-behind file, which is located in the site root/widgets folder.
2. In the properties section, insert the WidgetDataMember attribute to set the property.
See example below.
[WidgetDataMember(150530105432)]1
public long VideoID
{ get { return _VideoID; } set { _VideoID = value; } }

3. If you want to set a default value for the widget, use the attribute’s optional argument,
which follows [WidgetDataMember. In the example above, the value is 150530105432.
4. Save the settings in your properties by populating them as you normally would.
5. In the Save event, call _host.SaveWidgetDataMembers();.

Adding a Field to a Widget
This section provides an example of adding a Content type drop-down to the List Summary
widget. The drop-down lets the person dropping the widget on the page select from these
choices.
l

all types of content

l

HTML content only

l

assets only

Here is what the drop-down looks like once it is implemented.
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To add this drop-down to the List Summary widget:
1. In Visual Studio, open the ListSummary widget, siteroot/widgets/ListSummary.ascx.
2. Find the text DisplaySelectedContent.
3. Below DisplaySelectedContent, add the following code to create a drop-down list for
the ContentType property.
<tr>
<td>DisplaySelectedContent:</td>
<td>
<asp:CheckBox ID="DisplaySelectedContentCheckBox" runat="server" />
</td>
</tr>
<tr>
<td>ContentType:</td>
<td>
<asp:DropDownList ID="ContentTypeList" runat="server">
<asp:ListItem Value="AllTypes">AllTypes</asp:ListItem>
<asp:ListItem Value="Content">Content</asp:ListItem>
<asp:ListItem Value="Assets">Assets</asp:ListItem>
</asp:DropDownList>
</td>
</tr>

4. Save the ListSummary.ascx file.
5. Open the code-behind file, ListSummary.ascx.cs.
6. In the properties region, declare a string variable for the ContentType property:
private string _ContentType;

7. Create a local property with default setting of AllTypes:
[WidgetDataMember("AllTypes")]
public string ContentType { get { return _ContentType; }
set { _ContentType = value; } }

8. In the EditEvent area, set the select list's value to ContentType:
ContentTypeList.SelectedValue = ContentType;
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9. In the SaveButton_Click event, set ContentType as the select list's value:
ContentType = ContentTypeList.SelectedValue;

10. In the SetListSummary() function, set the List Summary server control's ContentType
to the CMSContentType property:
ListSummary1.ContentType =
(CMSContentType)Enum.Parse(typeof(CMSContentType), ContentType);

11. Save the ListSummary.ascx.cs file.

Including Help for a Widget
You can include help for any widget that has the help icon (

).

The help icon only appears when a user is editing a PageBuilder page. The icon appears both
when a user is viewing a widget and editing its properties. It is not available to a page’s site
visitors.
To create a widget’s help file:
1. Create an HTML file with information for users who will drop the widget on the
PageBuilder page.
You could create a content block within Ektron then switch to source view, copy the
content into a word processor (like Notepad), and save it with an HTML extension.
2. Save the help file to the folder that contains the widget.
3. Add the WidgetHost’s HelpFile property to the code-behind of the page that hosts the
widget. See example below.
protected void Page_Init(object sender, EventArgs e)
{
_host = Ektron.Cms.Widget.WidgetHost.GetHost(this);
_host.HelpFile = "~/widgets/myWidget/help.html";

Creating Conditions with the Targeted Content
Widget
The Targeted Content widget lets you personalize a site visitor's experience by providing
content that matches their interests, thereby placing your site information in the context of
your users. For example, the search keywords used to find your site might determine the
best offer to show a prospect. Or, site members might explicitly state their interests by
adding to their user profile or filling out a survey.
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In both cases, the Targeted Content widget ensures the delivery of the right experience to
compel each site visitor to take action. The widget lets you gather information from each
interaction, and use that information to direct visitors to content that relates to their specific
interests.
Targeting content is as easy as creating an email rule in Microsoft Outlook, or a playlist in
iTunes. Each widget has 1 or more conditions. Each condition can have 1 or more criteria. For
example, a condition may stipulate that the URL parameter terms contains either "pizza" or
"Italian."

After assigning conditions to a Targeted Content widget, you assign one or more widgets to it.
The widgets appear on the page only if a condition evaluates to true. To continue the
example, if the page has a URL parameter that contains "pizza," display a Taxonomy
Summary widget showing content to which the taxonomy category "pizza" is assigned.
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You can assign any number of conditions to the Targeted Content widget. As soon as one is
true, its associated widgets appear, and any remaining conditions are ignored.
The Targeted Content widget can evaluate the following information about a page's site
visitor.
l

search engine or URL that directed the person to the page

l

the page's URL parameters

l

the user's device, such as a Smart Phone

l

the page from which he was directed

l

regional information about the visitor: U.S state or country

l

l
l

information in the visitor's Facebook profile, such as if the person's marital status is
single
whether a certain cookie is on the person's computer
if logged in
o user or membership group to which he belongs
o

l

any of the person's custom user properties that match your criteria

the current date and time on the Ektron server

Here are examples of using the Targeted Content widget.
l

Your jewelry store is promoting gold necklaces. You create a hyperlink with a Campaign
ID of gold. For example, http://www.mystore.com/product.aspx?cid=gold. In the
Targeted Content widget, set the condition URL Parameter CID contains gold.
If condition = true, the Targeted Content widget displays a ContentBlock widget that
promotes gold necklaces.

l

You are promoting a race to NASCAR fans. Your site has a membership group for
NASCAR fans, and anyone visiting the site can join. In the Targeted Content widget,
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create a condition If user is in Group NASCAR.
If condition = true, the Targeted Content widget displays a WebCalendar widget that lists
upcoming NASCAR races.
l

On Sunday Feb. 28, you are running a sale: all couches are 50% off. In the Targeted
Content widget, set Date is 2013-02-28.
If condition = true, the Targeted Content widget displays a TaxonomySummary widget
that lists all couches and the discounted price.

l

Display the "Engineering" Community Group's activity stream to its members. You have
a Community Group for the Engineering Department. In the Targeted Content widget, set
User is In GroupEngineering.
If condition = true, the Targeted Content widget displays an Activity Stream widget, set
up as follows:

l

l

ObjectID= ID of the Engineering group

l

FeedType = Community Group

If the referring page is a Search Engine and its keywords include Pizza, you want to show
a list summary of Pizza shops. Assume your content includes restaurant listings, and
taxonomy categories are applied to this content. One category is pizza. In the Targeted
Content widget, set Search Engine Keywords is Pizza.
If condition = true, the Targeted Content widget displays a TaxonomySummary widget
that lists all content assigned to the category Restaurants > Pizza.

l

If a site visitor's Facebook profile "likes" Sony, display Sony products. In the Targeted
Content widget, set the condition Facebook Info: Likes contains Sony.
If condition = true, the Targeted Content widget displays a ContentBlock widget that
promotes Sony products.

l

See Also: 4 Trends that Shape the Future of Content Targeting

Creating a Targeted Content Widget
PREREQUISITE
The Targeted Content widget must be on the list of widgets assigned to the page's
template. See Also: Adding the Wireframe and Widgets into Ektron on page 685
1. Drag and drop the Targeted Content widget onto a PageBuilder page.
2. By default, the first condition is added to the widget. Click Edit Condition.

3. Enter a condition name.
4. Click +or to set up the first condition.
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5. Select an option from the drop-down list of condition criteria.

The following table describes the criteria options.
Criterion

Use this criterion to specify widgets that will appear if
l

l

Search Engine

l

If the site visitor was referred to this page from any search engine (or
not)
If the search engine from which the site visitor was referred is one of the
following
o Google
o

Bing

o

Yahoo

o

Other

o

None

If the search engine's keywords are (are not, contain, start with, or end
with) a specified value

The referring host matches a string value (for example, www.example.com).
Referring URL

This is helpful for determining the site from which a visitor came to your site,
such as a Facebook fan page.
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Criterion

Use this criterion to specify widgets that will appear if
The current page contains the specified URL parameter.
For example, you create a campaign selling gold jewelry and base its content
on the URL parameter cid=gold.

URL parameter

If the URL of the page that hosts the Targeted Content widget contains
cid=gold (for example,
http://www.mystore.com/product.aspx?cid=gold), then display
widgets assigned to that Targeted Content widget.
A cookie matching the specified pattern is found on the site visitor's computer.
Cookies are generally stored as name value pairs, such as UserID—
A9A3BECE0563982D. When checking for a cookie, you complete 3 fields.

Cookie

l

cookie ID

l

logic (is, is not, contains, starts with, ends with)

l

a value

For example, if a certain campaign placed cookies beginning with A9A, you
would set up the criterion like this:

NOTE: The cookie criterion does not support subkeys, such as
ecm.userid or ecm.sitepath.
To work around this problem, use a contains operator and enter the
text following .ecm, such as sitepath.

Device
Configuration

The user's device matches a Device Configuration that you specify. For
example, a content block displays only if a user accesses your website with a
Smart Phone.
To learn about Device Configurations, see Ektron's Mobile-Driven Web
Experience on page 133.

BreakpointConfig

The user's device matches a breakpoint that was defined in Ektron's MobileDriven Web Experience on page 133.

Logged in

The user is or is not logged in.
NOTE: Only applies to logged-in users.

User is in group
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Criterion

Use this criterion to specify widgets that will appear if
NOTE: Only applies to logged-in users.

User is in
community

User is a member of an Ektron Community Group that you select from dropdown list.See Also: Managing Community Groups on page 1181
NOTE: Only applies to logged-in users.
The value of the logged-in user's custom property satisfies the logic for the
value you specify. See Also: Creating Custom User Properties on page 1108
Example:

User Properties

Zip code is a Custom User Property. You want to display a list of stores in
New Hampshire for users whose Zip Code begins with 03.

Condition / result
Zip code = 03458 true
Zip code = 02103 false
The actual date (according to the Web server's clock) and a date you enter
satisfy the specified logic.
Logic operators:

Date and Time:
Day

l

is

l

is not

l

less than

l

greater than

l

equal to or less than

l

equal to or greater than

Examples:
Assume today's date is 2010-01-01
Condition / result
Date = 2010-01-01 true
Date < 2010-01-01 false
Date >= 2009-12-01 true
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Criterion

Use this criterion to specify widgets that will appear if
The current day (according to the Web server's clock) satisfies the specified
logic.
Logic operators:

Date and Time:
Day of Week

l

is

l

is not

Examples:
Assume today's date is 2010-03-01 (Monday)
Condition / result
Day of week is Monday true
Day of week is Tuesday false
Day of week is not Tuesday true
The actual date (according to the Web server's clock) and a date you enter
satisfy the specified logic.
Logic operators:

Date and Time:
Day of Month

l

is

l

is not

l

less than

l

greater than

l

equal to or less than

l

equal to or greater than

Examples:
Assume today's date is 2010-03-01 (Monday)
Condition / result
Day of month is 01 true
Day of month is not 01 false
Date >= 2009-12-01 true

738

Ektron Reference

Creating a Targeted Content Widget

Criterion

Use this criterion to specify widgets that will appear if
The actual hour (according to the Web server's clock) and number between 1
and 23 you enter satisfy the specified logic. The numbers are based on a 24
hour clock so, for example, 5 p.m. is 17.
Logic operators:

Date and Time:
Hour of Day

l

is

l

is not

l

less than

l

greater than

l

equal to or less than

l

equal to or greater than

Examples:
Assume current time is 18:30:00
Condition / result
Hour of day is 18 true
Hour of day is 23 false
Hour of day >= 12 true

User Regional
Info

Enter the user's country or state, or both. State selections are limited to states
in the United States. This information is retrieved from the IP address of the
person who is using your website. To retrieve this information, see Using
GeoIP Information in the Targeted Content Widget on page 1901.
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Criterion

Use this criterion to specify widgets that will appear if
If the criterion matches information in the user's Facebook profile, display the
widgets inserted into this condition. For example, if the criterion is Marital
Status is Single and the user's Facebook Profile matches that value, display
the assigned widgets.This criterion only works with users who log in via
Getting Started with Ektron on page 5. You can apply any of these facebook
fields.

Facebook Info

l

Age

l

Gender

l

Marital Status

l

Likes

l

Employment

Use Contains with Free Text Fields
On fields that use free text (such as Likes), you should use the contains
operator, as opposed to is or is not. Contains is more flexible and finds a
partial match. For example, if the user likes U.S. Soccer and you enter the
term soccer and the contains operator, a partial match is made, so the user
sees the related widget. On the other hand, if the user likes U.S. Soccer and
you enter the term soccer and the is operator, an exact match is not made, so
the user does not see the related widget.
The Likes Field
The Likes field lets you search through users' Facebook profile Likes and
Interests. Or, you can narrow it down to a specific like/interest. For example,
you could display a widget promoting Red Sox merchandise if, in their
Facebook profile, users like a Sports Team that contains Red Sox.

Submitted Form
Data

Uses field and value for a form (by ID).

Persona Title

The site visitor matches the persona that you define in this condition.
No condition evaluates to true.

Otherwise

NOTE: You would typically use this criterion last, since it always
evaluates to true. Any conditions below this are ignored.

6. Add additional criteria as desired. See Also: Using Widgets on page 711
7. Click Save.
8. Drag to the area below the new condition one or more widgets that appear if the
condition evaluates to true.
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9. If the widget requires you to fill out properties, click Edit and complete the screen.

Using Multiple Criteria in a Condition
Any condition can have several criteria joined by and an AND operator.

In this example, all conditions must be true for the widgets assigned to this Target Content
widget to appear.
l

the user is logged in

l

today's date must be later than September 29, 2011

l

the user is a member of the Ektron user group Administrators

If any of these condition is not true, the next condition assigned to the widget is evaluated, if
one exists.
If all conditions are true, the widgets assigned to this Targeted Content widget appear.
Additional conditions assigned to this widget are ignored.
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You can also specify an OR relationship among criteria in one condition. To do so, click +or
below any condition (circled below), then enter the OR condition.

For example, assume you want the time zone criteria to include Eastern Time and Pacific
Time (but not in between).

Each set of criteria is evaluated independently. If any criteria set is true (that is, all of its
statements are true), the widgets assigned to this Targeted Content widget appear. Additional
conditions assigned to this widget are not evaluated. If none of the criteria sets is true, the
next condition assigned to the widget is evaluated, if one exists.

Editing a Condition
There are 2 aspects to editing a condition within a Targeted Content widget.
l

Editing a Condition's Criteria

l

Editing Widgets Assigned to the Condition

Editing a Condition's Criteria
NOTE: This assumes you are on the PageBuilder page that contains the widget and in Edit mode.
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1. Click the condition you want to edit.
2. The area below it expands. Any widgets assigned to the condition appear.

3. Click Edit Condition.
4. Edit the condition then click Save.
See also Using Multiple Criteria in a Condition on page 741 and Creating Conditions with the
Targeted Content Widget on page 731

Editing Widgets Assigned to the Condition
NOTE: This assumes you are on the PageBuilder page that contains the widget and in Edit mode.
1. Click the condition that has the widget you want to edit.
2. The area below it expands. Any widgets assigned to the condition appear.

3. If you want to delete the widget, click X in its upper right corner (circled above).
4. To edit the widget's properties, click the pencil icon in the upper right corner (circled
above). Click Save.
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Customizing the Targeted Content Widget
To create a custom version of the Targeted Content widget (for example, to add rule
templates):
1. Open the siteroot/widgets/Edit TargetedContent.ascx.cs file.
2. Create a class, for example, MyRuleTemplate, that inherits
Ektron.RuleEditor.RuleTemplate in #region Rule Templates.
3. Modify private void AddAllRuleTemplates.
4. Add an instance of your class to the rest of the rule templates. For example,
AddRuleTemplate(new MyRuleTemplate());

Using Targeted Content Configurations
Use the Targeted Content Configuration screen to create, store, edit and delete
configurations.
A Targeted Content Configuration is a Targeted Content widget that you create and store in
the Ektron Workarea. When users drop a Targeted Content widget onto a PageBuilder page,
they can select from any of the configurations defined in the Workarea. (See the following
example.) A configuration lets you reuse the same Targeted Content widget on any number of
pages.
After dropping a Targeted Content Configuration within a Targeted Content widget, you cannot
edit its conditions on that page. You can only edit its conditions within the Workarea. See
Editing a Condition's Criteria on page 742.

If you later change a configuration setting, all widgets using that configuration are
automatically changed.
IMPORTANT: If you apply no conditions to a configuration and reference it in a Targeted Content widget
on a PageBuilder page, nothing appears on the page.

Referring to a Targeted Content Configuration
To refer to a Targeted Content Configuration:
PREREQUISITE
The PageBuilder page must include the Targeted Content widget. See Also: Adding the
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Wireframe and Widgets into Ektron on page 685.
1. Edit a PageBuilder page.

2. Drag and drop a Targeted Content widget.
3. Click Select Global Configuration (circled below).
4. Select the Targeted Content Configuration you want to place on the page.

5. Save, check in, or publish the page.
NOTE: You can apply a global configuration to an existing widget. If you do, the global configuration
replaces all conditions and results you previously applied.

Creating a Targeted Content Configuration
If you have created a Targeted Content widget, the process of creating a Targeted Content
Configuration is almost identical.
PREREQUISITE
To access this screen, you must be a member of the Administrators group.
To create a Targeted Content Configuration:
1. In the Workarea, choose Settings >Configuration > Personalizations > Target
Content.
2. Click Add. The Add Target Content Configuration screen appears.
3. Enter a Title.
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4. Complete the steps to create a Targeted Content Configuration. For details on how to do
this, see .
5. Click Save.

Editing a Targeted Content Configuration
If you edit a Targeted Content Configuration that is placed on one or more PageBuilder pages,
they will reflect the edit after you publish the page.
PREREQUISITE
To access this screen, you must be a member of the Administrators group.
1. In the Ektron Workarea, choose Settings > Configuration > Personalizations >
Targeted Content.
2. Click Edit (

) to the left of the configuration you want to edit. The widget appears.

3. Edit as necessary. See Also:
4. Click Save.

Deleting a Targeted Content Configuration
IMPORTANT: If you delete a Targeted Content Configuration that was placed on one or more
PageBuilder pages, they display a blank area where the widget was dropped.
PREREQUISITE
To access this screen, you must be a member of the Administrators group.
1. In the Ektron Workarea, choose Settings > Configuration > Personalizations >
Targeted Content.
2. Click Delete ( ).
3. Check the box to the left of the configuration you want to delete.
4. Click Delete.

Using the Flash Widget

746

Ektron Reference

Using the Flash Widget

l
l

l

l

l

l

l

This widget supports both .flv and .swf file types.
If you will use .flv files, make sure it is added as a file type. See Also: Supported Types
of Assets on page 312
If the Flash file you want to display has already been added to Ektron, use the Select File
tab to it.
If the file has not been added to Ektron, first use the Select File tab to select a folder for
the Flash file. Then, use the Upload tab to navigate your computer’s file system, and
upload the file to the selected folder.
The thumbnail feature only works with .flv file types. If you select a Thumbnail, it
appears within the Flash player when the page loads. See example below.

The thumbnail is only applied to this instance of the widget—not the Flash file. If you
apply this video to a different widget on this page, you must reapply a thumbnail.
The thumbnail is an image file that was dropped into Ektron as an asset. It cannot be a
library image.
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l

l

The autostart feature works only with .flv files.

If you log in then upload a flash file, and certain requirements are not met for that file,
you see the following image where the widget appears.

The following conditions cause this image to appear.
o

The flash file’s folder properties require certain metadata and/or a taxonomy category to
be applied, and they have not.

o

The folder has an approval chain, and this content has not been approved.

Using a Brightcove Video Widget
IMPORTANT: You need an account on Brightcove to show videos in the Ektron Brightcove Video widget.
Your Brightcove.com account lets you upload, store, and play videos on your Web page with
the Ektron Brightcove Video widget.

Setting Up Your Account Information for the First
Time
You see the following screen the first time you use a Brightcove Video widget if you have not
entered account information in the Workarea. Enter your Brightcove account information
here. After you successfully save your account data, this screen does not appear again.

748

Ektron Reference

Adding a Brightcove Video Widget

Adding a Brightcove Video Widget
Follow these steps to play videos with the Brightcove Video widget.
1. Set the Brightcove Video widget Configuration in the Workarea if you did not use the first
timer screen shown in the previous section.
a. From the Workarea, choose Settings > Configuration > Personalizations >
Widgets.
b. Click Edit (

) next to BrightcoveVideo.ascx to set the properties shown below.

NOTE: Brightcove provides the values for the Global Settings for this widget on your
Brightcove Account pages. Log in to Brightcove and go to Account Settings > API
Management.
c. Click Save.
2. Place the Brightcove widget on a PageBuilder page.
a. Edit a PageBuilder page.
b. Drag and drop the Brightcove widget into a dropzone.
See Editing Content on a PageBuilder Page on page 665 for more information about
PageBuilder and widgets.
3. Upload Videos Using the Brightcove Video widget.
NOTE: You can upload your video using your Brightcove.com account or follow these steps and
upload a video using the Ektron Brightcove Video widget.
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a. Click Edit (

) on the Brightcove Video widget.

b. Notice there are 3 tabs across the top—Video List, Search, and Upload.
c. Click Upload.
d. Enter Video Name.
e. Enter Video Description.
f. Click Browse and choose the video file to upload.
g. Click Upload.
A message on the Edit window shows that the Video is being uploaded. In this
example, we are uploading the Training Program 8.0 video.

NOTE: Your video may not be available to view immediately after uploading. Allow time for
Brightcove to publish it or check its status on your Brightcove Account page.
4. Choose the Video to Play in the Brightcove Video widget.
a. Click Edit (

) on the Brightcove Video widget.

b. Click either the picture or title of the video you want to show in this widget.

The following image is an example of the Brightcove Video widget on an Ektron OnTrek
website page.
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Troubleshooting the Brightcove Video Widget
If your videos do not show in the Brightcove Video widget, check the following topics.
l

Did the video upload succeed?
Check the status of your video by logging into your account on Brightcove and looking for
it in the Media Library.

l

Is the video encoded according to requirements from Brightcove?
According to Brightcove's article Uploading Videos with the Media Module, "Your video
files can use most available file formats; if your files are not already encoded as VP6
(FLV—Flash video) or H.264, Brightcove transcodes them into one of those formats."

l

Do you see the video on the widget when editing the PageBuilder page but not when you
publish the page?
Check the publisherID setting in the widget Configuration.

Additional Information
l

Brightcove Documents: http://support.brightcove.com/en/docs

l

Brightcove: Setting Your HTML5 Video Delivery Options

l

Brightcove: Delivering Video with HTML5 and Smart Players

l

Brightcove: Test Your Browser for Brightcove HTML5 Video Player
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Ektron’s Menu feature lets users create and maintain a drop-down menu system for your
website. The menu options can link to content, library files, external hyperlinks, and
submenus. Below is a sample menu.

In this example (delivered with Ektron OnTrek sample site), the menu appears when a site
visitor moves the cursor over Products on the home page. If a content contributor with
permission to edit menus signs in to Ektron then views the menu, it has options for editing the
menu and adding content.
NOTE: If you choose to hide the border that surrounds content when you are logged in, the Add and Edit
options are also hidden. This lets you view the page as it appears when not logged in. If the page is set to
show borders and you still do not see Add and Edit, the feature may be turned off. Ask your administrator
or website Developer for more information.
Managing menus is a two-step process. The first sections in this chapter describe the first
step: how Ektron users create and update menus. In the second step, a developer places a
menu server control on a Web form. The control manages how the menu displays on your
website.

The Structure of Menus and Menu Items
Menus have the following structure:
l

l

menu—top-level structure that is a placeholder for menu items and submenus. It is
assigned to a content folder. A menu also identifies the page template used to display
menu options that are content.
menu item—options on a menu; can be any of the following
l
content of any type
l

library file

l

external hyperlink (link to a page outside your website)

l

754

submenu—a link to another menu. Below, the menu on the right is a submenu. It
appears when the user hovers the cursor over Company Profile.
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Accessing the Menus Feature
There are 3 ways to access the Menus feature:
l

the Workarea, by choosing the menu's content folder then clicking View > Menu

l

the Workarea, by choosing Content > Menus

l

the website's Edit Menu option, shown below

If you choose the first or second option, you select a specific menu. Then, it appears on the
View Menu screen. For the third option, the selected menu appears on the View Menu screen.
From the View Menu screen, you can perform the following actions on a menu.
l

Create a new menu

l

Edit its information (for example, the URL and template link)

l

Translate it

l

Delete it

l

Add or remove items

l

Change the sequence of items

l

Edit menu items

l

For submenus
o add /remove items
o

change sequence of items

o

edit menu information

o

edit menu items

Permission to Use Menus
To work with menus, a user must be one of the following.
l

a member of the Administrators user group

l

assigned the Collection and Menu Admin role See Also: Defining Roles on page 1120

l

assigned the Menu Admin role

Adding a Menu
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You can create a menu by navigating to a folder or by choosing Content > Menus from the
Workarea’s left frame. If you choose Content > Menus, it is automatically assigned to the
root folder. In contrast, if you choose a content folder then create a menu, it is assigned to
that folder.

Adding a Menu via Content Folder
1. Navigate to a content folder.
2. The current language appears as a flag next to the screen title. To create the menu in
this language, proceed to the next step. To change the new menu's language, click View
> Language and select the new language.
3. Click New > Menu. The Add Menu screen appears.

4. Use the following information to complete the screen.
Fields on the Add/Edit Menu Screen
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Field

Description

Title

The name given to the menu by its creator. It appears on the Web page to indicate
the kind of information on the menu.
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Field

Description
You can have an image appear next to or instead of the menu title. For example:

To do this:
Image Link

PREREQUISITE
The image must reside in the library. If it does not, add it before proceeding. For
more information, see Adding a File to the Library on page 340.
1. Click the icon to the right of the ImageLink field (

).

2. The library window opens.
3. Navigate to the folder that contains the image you want to use.
4. Click Insert.
Using Image to Replace Title Text
Alternatively, you can replace menu text with an image, so that only the image
appears on the menu. To do this, check the Use image instead of a title box.
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Field

Description
After you create a menu, your developer links it to text or an image on a Web page
by modifying a page template. When a site visitor moves the cursor over the text or
image, the menu appears. In the example below, the menu appears when the site
visitor moves the cursor over Products.

URL Link

You can also assign a URL link to a menu using this field. If you do, and the user
clicks the link text or image, he jumps to the specified page.
For example, in this field, you assign the product landing page,
siteroot/products.aspx. In the illustration above, if the user moves the
cursor over Products, the assigned menu appears. However, if the user
clicksProducts , he jumps to siteroot/products.aspx.
Entering the Path to the Landing Page
The path may be
l
l

l

Template
Link

relative to site root, such as siteroot/jobs.aspx
a static template path or a dynamic path, such as
wellness.aspx?id=40&wellness=Hemophilia
an external hyperlink, such as http://www.example.com.

NOTE: This field applies to content only. It has no effect on other types of
menu items (such as images). Also, this field only affects content that
dynamically references a content block, such as
/CMS400Min/therapies.aspx?id=84. If the menu option is a template
that includes content (for example, /CMS400Min/news.aspx), the template
identified here is ignored.
If you want to apply a template to this menu, enter it here. If you do, content on this
menu uses this template when selected from the menu.
If you do not, this menu's content uses the template specified in its Quicklink.
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Description

Add a more detailed description for the menu.

Folder
Associations

See Effect of Assigning a Folder to a Menu on page 772.

Template
Associations

See Effect of Assigning a Template to a Menu on page 774.
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5. Click Save.
After creating the menu, you may assign items to it. See Adding a Menu Item below.

Adding a Menu via the Menus Tab
If you choose a content folder then create a menu, it is assigned to that folder.
1. From the Workarea, click Content > Menus > Menus.
2. The current language appears in the View field. To create the menu in this language,
proceed to the next step. To change the new menu's language, select one from the View
field drop-down.
3. Click Add. The Add Menu screen appears.
4. To complete the fields on the Add Menu screen, see Fields on the Add/Edit Menu Screen
on page 756.
After creating the menu, you may assign items to it. See Adding a Menu Item below.

Adding a Menu Item
There are 3 ways to add a menu item.

Adding a Menu Item via Content Folder
To add a menu item via a content folder:
1. Navigate to the content folder that contains the menu to which you want to add items.
2. Click View > Menu.
3. In the View Language drop-down, select the menu's language.
4. Click the menu. The View Menu screen opens, displaying the menu's items. Submenus
look like this:

.

5. To add a new item to the menu, click Add Items.
The Add New Item screen displays a list of items you can add to the menu. Use to the
table below to select a type of menu item, and follow the steps to add it.

l

Menu item type

For more information, see

Content

Adding Content as a Menu Item on page 762

Any library file: image, file, Quicklink,
hyperlink to the menu

Adding a Library File as a Menu Item on page 763

External hyperlink

Adding an External Hyperlink as a Menu Item on
page 763

Submenu

Adding a Submenu as a Menu Item on page 764

After you insert menu items, you can view and modify information about them. To do
that, click the item's title. Use the following information to complete the fields on the
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Edit Menu Item screen.
Fields on the Add/Edit Menu Item Screen
Title—The name of the menu item. It appears on the Web page to indicate the item.
Image Link—You can have an image appear next to or instead of the menu title. For
example:

To do this:
NOTE: Before beginning these steps, the image must reside in the library. If it does not, add it
before proceeding. For more information, see Adding a File to the Library on page 340.
1. Click image (

).

2. The library window opens.
3. Navigate to the folder that contains the image you want to use.
4. Click Insert (

) to insert it.

Replacing Title Text with Image
Alternatively, you can have the image replace the menu text, so that only the image
appears on the menu. To do this, check the Use image instead of a title checkbox.

URL Link—After you create a menu, your developer links it to text or an image on a
Web page by modifying a page template. When a site visitor moves the cursor over the
text or image, the menu appears. In the example below, the menu appears when the site
visitor moves the cursor over Products.

You can also assign a URL link to a menu using this field. If you do, and the user clicks
the link text or image, he jumps to the specified page.
For example, in this field, you assign the product landing page,
siteroot/products.aspx. In the illustration above, if the user moves the cursor over
Products, the assigned menu appears. However, if the user clicks Products , he jumps
to siteroot/products.aspx.
Entering the Path to the Landing Page
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The path may be
l
l

l

relative to site root, such as siteroot/jobs.aspx
a static template path or a dynamic path, such as
wellness.aspx?id=40&wellness=Hemophilia
an external hyperlink, such as http://www.example.com.

Description—Add a more detailed description for the menu.
Target—
Determines the type of window that appears when you click a link in the server control.
o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

Link—Use this field if you want to override this content's menu template by using the
template specified in its Quicklink.

Adding a Menu Item via Menus Tab
1. From the Workarea, click Content > Menus.
2. Click the menu to which want to add a menu item.
3. In the View Language drop-down list, select the menu's language.
4. Click AddItems. The Add New Item screen displays a list of items you can add to the
menu. Select a type of menu item, and follow the steps to add it.
l
Content—Adding Content as a Menu Item on the next page
l

Any library file: image, file, Quicklink, hyperlink to the menu—Adding a Library File
as a Menu Item on page 763

l

External hyperlink—Adding an External Hyperlink as a Menu Item on page 763

l

Submenu—Adding a Submenu as a Menu Item on page 764

5. After you insert menu items, you can view and modify information about them. To do
that, click the item's title. See Also: Fields on the Add/Edit Menu Item Screen on the
previous page

Adding a Menu Item via Navigation Link on a Web
Page
1. Log in.
2. Access the Web page that contains the link to display the menu.
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3. Place the cursor on the hyperlink that causes the menu to appear. The menu appears.

4. Click Add. The Add Menu screen displays a list of items you can add to the menu.
5. Select the type of menu item and follow the steps to add it.
l
Content—Adding Content as a Menu Item below
l

l

l

Any library file: image, file, Quicklink, hyperlink to the menu—Adding a Library File
as a Menu Item on the facing page
External hyperlink—Adding an External Hyperlink as a Menu Item on the facing
page
Submenu—Adding a Submenu as a Menu Item on page 764

6. After you insert menu items, you can view and modify information about them. To do
that, click the item's title. See Also: Fields on the Add/Edit Menu Item Screen on
page 760
The following sections explain the kinds of content you can add to a menu.

Adding Content as a Menu Item
1. Follow the directions in Adding a Menu Item via Content Folder on page 759, Adding a
Menu Item via Menus Tab on the previous page, or Adding a Menu Item via Navigation
Link on a Web Page on the previous page.
2. Click the radio button next to Content Item.
3. Click Next... The Add New Item screen appears, listing all content folders.
4. By default, all content types are available. To limit your selection (for example, Word
documents), click the content types drop-down and select a type.

5. Content items in a folder appears below any subfolders. Click any subfolder to display its
content.
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6. Check all content you want to add from any single screen to the menu.
IMPORTANT: If you check items then proceed to another screen before clicking Add, the items on
the first screen are not added to the menu.
7. Click Add.
As an alternative, navigate to a content folder, click items to be assigned, right click the
mouse and select Copy. Then, locate the menu, right click the mouse, and select Paste
Items to Menu.

The View Menu screen reappears, showing the new content.
8. To access the Edit Menu Item screen for the new content, hover the cursor over the title,
then click. The Edit Menu Item screen lets you assign additional information to the menu
item, such as the target window. See Fields on the Add/Edit Menu Item Screen on
page 760.
9. Continue to add menu items as needed.

Adding a Library File as a Menu Item
To add a library file as a menu item via a content folder or menus tab:
1. Follow the directions in Adding a Menu Item via Content Folder on page 759, Adding a
Menu Item via Menus Tab on page 761, or Adding a Menu Item via Navigation Link on a
Web Page on page 761.
2. Click the radio button next to Library Asset.
3. Click Next. The Add New Item screen appears. Enter a title for the library file that will
appear on the menu.
4. Click Browse Library. The library screen opens.
5. In the right frame, select the type of file to insert (image, hyperlink, and so on).
NOTE: To insert assets, the menu’s folder must contain library assets. However, you can insert
library assets from other folders for which you have permission.
6. Select a library asset and click Insert. The Add New Item screen reappears.
7. Click Save.

Adding an External Hyperlink as a Menu Item
To add an external hyperlink as a menu item via a content folder or the Menus tab:
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1. Follow the directions in Adding a Menu Item via Content Folder on page 759, Adding a
Menu Item via Menus Tab on page 761, or Adding a Menu Item via Navigation Link on a
Web Page on page 761.
2. Click External Hyperlink.
3. Click Next. The Add New Item screen appears.
4. Complete the fields as needed.
l
Title—Title of the new menu item.
l

URL Link—The external hyperlink's URL. For example, www.example.com.

5. Click Save.
NOTE: When you add an external hyperlink menu item, the URL does not get added to the library
nor is an ID assigned to it. So, when you save the menu item, it is not added to the Ektron database
nor can it be retrieved for future use.

Adding a Submenu as a Menu Item
1. Follow the directions in Adding a Menu Item via Content Folder on page 759, Adding a
Menu Item via Menus Tab on page 761, or Adding a Menu Item via Navigation Link on a
Web Page on page 761.
2. Click Sub menu. The Add Menu screen appears.
3. Complete the fields using Fields on the Add/Edit Menu Item Screen on page 760 as a
reference.
4. Click Save.

Adding New Content to a Menu via Navigation Link on
a Web Page
NOTE: You can only use this feature after your Web developer has modified a page template to display
the menu. For more information, see Introduction to Menu Server Controls on page 774.
1. Access the Web page that contains the link to display the menu.
2. Place the mouse on the hyperlink that causes the menu to appear. A menu appears.

3. Click Add. The Add Menu screen opens, displaying items you can add.
4. Refer to the table below for selecting a menu item and follow the steps to add it.
l
Content—Adding Content as a Menu Item on page 762
l
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Any library file: image, file, Quicklink, hyperlink to the menu—Adding a Library File
as a Menu Item on the previous page
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l

External hyperlink—Adding an External Hyperlink as a Menu Item on page 763

l

Submenu—Adding a Submenu as a Menu Item on the previous page

Editing a Menu's Properties
This section describes each option for editing a menu's properties.

Editing a Menu's Properties via its Content Folder
1. From the Workarea, navigate to the content folder that contains the menu.
2. Click View > Menu.
3. Click the menu you want to edit.
4. If appropriate, click the submenu that you want to edit.
5. Click Properties (

). The View Menu screen appears.

6. Click Edit Menu.
7. Update the fields on the screen by referencing Fields on the Add/Edit Menu Screen on
page 756.
8. Click Save.

Editing a Menu's Properties via Menus Tab
1. From the Workarea, click Content > Menus.
2. Click the menu you want to edit.
3. Click Properties (

). The View Menu screen appears.

Alternatively, hover the cursor over the menu in the left panel, right click the mouse,
and click View Properties.

4. Click EditMenu.
5. Update the fields on the screen by referencing Fields on the Add/Edit Menu Screen on
page 756.
6. Click Save.

Editing a Menu's Properties via Navigation Link on a
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Web Page
1. Navigate to the Web page that contains the menu link.
2. Click the link. The menu appears.

3. Click Edit Menu. The menu's View Menu screen appears.
4. Click Properties (

).

5. Click Edit Menu.
6. Update the fields and by referencing Fields on the Add/Edit Menu Screen on page 756.
7. Click Save.

Viewing a Menu
Just like editing a menu, you can view a menu via...
l

its content folder

l

menus tab

l

navigation link on a Web page

When viewing a menu via the content or menu folder, you get an internal view of information
entered by menu creator. When viewing via a navigation link on a Web page, you get an
external view of the menu, as seen by anyone navigating website.

Viewing a Menu via its Content Folder
1. From the Workarea, navigate to the content folder that contains the menu.
2. Click View > Menu. The View All Menus screen displays all menus in the folder.
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3. Click the menu you want to view. The menu’s options appear.

Viewing a Menu via the Menus Tab
1. From the Workarea, click Content > Menus. The View All Menus screen appears.
2. Click the menu you want to view. The menu’s options appear.
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NOTE: If your Workarea language is set to all languages, you cannot view child menus—only parent
menus. To view a child menu, select its parent menu's language, using the View > Language menu
option.

Viewing Menus via Navigation Link on a Web Page
1. Access the Web page on which your Web developer inserted the link to display the menu.
2. Click the link that launches the menu on the Web page. A menu appears.

Reordering Menu Items
1. Navigate to the View Menu screen for the menu that you want to rearrange. See Viewing
a Menu on page 766.
2. From the toolbar, click Reorder ( ).
Alternatively, hover the cursor over the menu in the left panel, right click the mouse,
and click Reorder Items.
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The Reorder Items screen appears.

3. Click the item you want to move.
4. Click the up arrow to move it up, or the down arrow to move it down.
5. When finished, click Save.

Deleting a Menu
1. Access the View Menu screen, as described in Viewing a Menu via its Content Folder on
page 766 or Viewing a Menu via the Menus Tab on page 767.
2. Click the menu you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK to delete the menu.
NOTE: Deleting a menu automatically deletes all menu items associated with it. Do not confuse the
menu link with the item itself. For example, deleting a menu deletes its links to content but has no effect
on the content.

Deleting a Menu Item
Ektron 8.7
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1. Access the View Menu screen, as described in Viewing a Menu via its Content Folder on
page 766 or Viewing a Menu via the Menus Tab on page 767.
2. Click Remove Items (

).

3. Check the box next to items that you want to remove.
4. Click Remove.

Working with Menus in a Multi-Language System
NOTE: For background information about supporting multiple languages on your website, see Working
with Multi-Language Content on page 1057.
You can create an edition of any menu in every supported language. When a site visitor
selects a language and clicks a menu link, Ektron displays the menu in that language if it is
available. If it is not available, nothing appears.
Before creating or translating a menu, you should create or translate all content that will be
on the menu. In this way, you can link this content to the new menu. However, after creating
a menu, you can add new items to it.

Translating a Menu
To translate a menu into any supported language: You can navigate to the menu via the
website or from the Workarea. Each procedure is described below.

By Navigating the Site
1. Sign on to an Ektron website.
2. Select the menu’s current language.
3. Navigate to the page that has the menu you want to translate.
4. Click the menu and the Edit Menu option.

The View Menu screen appears for the selected menu.
5. From the Add drop-down list, select the language into which you want to translate the
menu.

The Add Menu screen appears.
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By Accessing the Menus Report Screen

6. Complete the screen for the menu in the selected language. See Fields on the Add/Edit
Menu Screen on page 756.
7. Click Save. The View Menu screen reappears. Now, the View drop-down displays the
menu’s new language.

8. Add items to the menu. See Adding a Menu Item on page 759. If adding content, you can
only insert an item in the selected language. Later, you can add more menu items, edit
them, delete them, view them, and so on.

By Accessing the Menus Report Screen
1. From the Workarea screen, click Content > Menus.
2. Click the menu you want to translate. The View Menu screen appears for the selected
menu.
3. From the Add drop-down list, select the language into which you want to translate the
menu.

The Add Menu screen appears.
4. Complete the screen for the menu in the selected language. See Fields on the Add/Edit
Menu Screen on page 756.
5. Click Save. The View Menu screen reappears. Now, the View drop-down displays the
menu’s new language.

6. Add items to the menu. See Adding a Menu Item on page 759. If adding content, you can
only insert an item in the selected language. Later, you can add more menu items, edit
them, delete them, view them, and so on.

Creating a Menu in Any Language
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1. From the Workarea screen, click Content > Menus > Menus.
2. From the language drop-down list, select the new menu’s language.

3. Create the menu. See Adding a Menu via the Menus Tab on page 759.

Assigning Folders or Templates to a Menu
Effect of Assigning a Folder to a Menu
If all of the following conditions apply...
l

you assign a folder to a menu

l

a user navigates to any content item that resides in the folder

l

a Flex Menu whose EnableSmartOpen property is true appears on the screen

...the Flex Menu automatically displays the items on the associated submenu.
NOTE: Navigation to the content can consist of clicking a quicklink, a menu option, a list summary item,
the result of a search, and so on.
In effect, you are instructing Ektron to expose a menu whenever a content item that resides
in a selected folder appears. As a result, a user looking for a specific item sees similar items.
As an example, assume your website sells books, and folders are organized by genre. One of
your folders is “Teen Fiction.” You create a submenu that contains the top 5 sellers in “Teen
Fiction.” You then associate the Teen Fiction folder with that submenu. When a site visitor
finds views a book in that category, a Flex Menu in the page’s left column displays the top 5
Teen Fiction titles.

Using the Select Folder Screen
The Select Folder screen lets you assign new folders to a menu, reorder folders, and delete
folders from the menu association. These tasks are described below.
When you click Change below Folder Associations on the Edit menu screen, the Select
Folder screen appears.
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The following table describes tasks you can perform on these screens.
Task

Add folder to list

Instructions
1. In the top of the screen, navigate to the
folder you want to add.
2. Click AddSelections.

Remove folder from list

1. In the lower section of the screen, click
the box to the left of the folder.
2. Click Delete ( ).
1. Click check box to the left of Folder.

Remove all folders from list

2. Click Delete ( ).
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Task

Instructions

Move a folder up or down on the list
NOTE: The folders' sequence has no impact on
how they are used. It only affects the appearance
of the Select Folders screen.

1. Click check box to the left of the folder.
2. Click the up or down arrow buttons.

Save changes and return to Edit Menu screen

Click Save.

Exit screen; do not save changes

Click Exit (

).

Effect of Assigning a Template to a Menu
If all of the following conditions apply....
l

you assign a template to a menu

l

a user navigates to any content item that uses the template

l

a Flex Menu whose EnableSmartOpen property is true appears on the screen

...the Flex Menu automatically displays the items on the associated submenu.
NOTE: Navigation to the content item can consist of clicking a quicklink, a menu option, a list summary
item, the result of a search, and so on.
In effect, you are instructing Ektron to expose a menu whenever a content item that uses one
or more selected templates appears on the screen. As a result, a user who begins looking for
a specific content item sees similar items.
As an example, assume your website sells books, and your templates are organized by genre.
One of your templates is “Teen Fiction.” You create a submenu that contains the top 5 sellers
in “Teen Fiction.” You then associate the Teen Fiction template with that submenu. If a site
visitor visit a page describing the book, the Flex Menu in the page’s left column displays the 5
top Teen Fiction titles.

Assigning a Template to a Menu
1. Move to the Template Associations area of the Edit menu screen.
2. In the box on the right, enter the template that you are assigning to this menu. It can be
an Ektron template, or any file that you wish.
3. Click Add.
To later change or remove the template, select it then click Change or Remove.

Introduction to Menu Server Controls
IMPORTANT: Starting from release 8.6, the Flex Menu and Menu server controls were replaced by the
FrameworkUI: <ektron:MenuView> templated server control. If you are already using the Flex Menu and
Menu server controls, you can continue to do so, but Ektron recommends using current versions of
functionality.
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Contrasting Menu Server Controls

Managing menus is a two-step process. The previous section describes the first step, which is
how Ektron users create and update menus. The second step involves a developer placing a
menu server control on a Web form. The server control manages the display of the menu on
your website. This section introduces concepts that affect all of them, and explains the
differences between them.
Ektron provides 2 menu server controls: Flex Menu on page 1728 and Menu on page 1781

Contrasting Menu Server Controls
Appearance
Type

Appearance

Flex

or
(Other styles are available)

Menu

Properties
Property

Flex Menu

Menu

508 compliant
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Property

Flex Menu

Menu

Shutter menu
(When you click a menu, it opens directly below the
menu title)

Secondary menu opens when cursor hovers over it

(alternative: secondary menu
opens when clicked)

Starts out collapsed; expands as site visitor selects
secondary menu
All menu levels open when page displays

(optional)

Can display secondary menu to the right of the root
menu, instead of directly below it

(optional)

How appearance is modified

Server control properties and
style sheet

Xslt and
style sheet

How behavior is modified

Xslt

Xslt and
style sheet

Option to launch menu links in a new window
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Ektron’s taxonomy is a content-level categorization system that uses one-to-many
relationships to create a scalable organization of content. For example, if you looked for
information about one Ronald Reagan, he may be found in many categories such as a US
President, a US Governor, or as a movie actor. When you apply Ronald Reagan to taxonomy
categories, you create a multiple relationship so that site visitors can find the content,
however they think about it.
A taxonomy hierarchy arranges content from general categories to specific categories. For
example, Books > Nonfiction > US Politics > Federal > Presidents. Content can relate to
multiple categories (also Entertainment > Movies > Actors), creating multiple “routes” to
information at the end of the hierarchy.

Taxonomies let you create a navigation structure that is independent of the folder structure.
You may have content about Ronald Reagan in a Famous People folder, but the Presidents and
Actors taxonomies are applied to that content, independent of the folder.
The following link shows a video that introduces Ektron taxonomies: Taxonomy Video.
You can use taxonomies in many way. For example, use them with GeoMapping to help site
visitors narrow shopping choices in the immediate vicinity, or organize a photo album by
categories, or group discussion board topics, and so on.
Ektron's URL aliasing uses taxonomy hierarchies to generate human-readable and SEOfriendly addresses, leveraging the various ways that people relate to the content to determine
the alias; search engines can find content with multiple terms.

Planning a Taxonomy
A taxonomy is comprised of a list of categories that you can place on a Web page. When that
page displays, the taxonomy’s categories appear, followed by all published items in the
taxonomy.
To help site visitors find your website’s content via a taxonomy, your developer places a
Directory server control on a Web page. See Also: Directory on page 1718. It looks something
like this.
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There is no limit to the number of category levels you can assign to a taxonomy.
Also, a taxonomy can link to all content in a folder, so the display is based on folder structure.
Alternatively, you can assign content items from various folders to a taxonomy.
To illustrate the benefits of a content-based taxonomy, assume your website is for a college.
Several items relating to the graduate school are organized under major departments:
Admissions, Academics, Faculty, Library, and so on. You can
1. Create a Graduate School taxonomy.
2. Use it to categorize all content relevant to graduate students (regardless of their
department).
3. Display them on a graduate students page.
It helps to design a taxonomy on paper before creating it in Ektron. This can let you
determine relationships among the kinds of information before you try to implement the
taxonomy.
As an example, here is a hierarchy of some content in the Ektron sample site. The top level
item is the taxonomy. All levels below it are categories.
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Next, review the site content and decide which content items and folders to assign to which
taxonomy categories. Some categories may map directly to a folders. Other categories may
refer to content from several folders. After you determine how content and folders will be
assigned to taxonomy categories, sign on to Ektron and set up those relationships.

Creating a Taxonomy
PREREQUISITE
Only administrators or users to whom the Taxonomy-Administrator role is assigned
see the Content > Taxonomy option See Also: Defining Roles on page 1120
1. Workarea >Content > Taxonomies > Taxonomies.
2. Use the View > language selector to choose a language for the taxonomy.

See Also: Creating a Taxonomy in a Multi-Language Environment on page 815
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3. Click Add Taxonomy. The Add Taxonomy screen appears.

4. Complete the screen with the following information.
l
Category Title—Give the taxonomy a title. The title identifies the taxonomy
wherever it appears. The title cannot contain most non-alphanumeric characters,
including commas and periods.
l

l

Category Description—If desired, enter a more complete description of the
taxonomy. It appears only on the Edit Taxonomy screen.
Taxonomy Image—If desired, you can assign an image to this taxonomy. For
example, in the eCommerce feature, you could display an image that indicates the
type of products that make up the taxonomy.
To display the taxonomy image, use Ektron’s API.

l

l

l

Template—If desired, select a template to apply to the taxonomy or category. See
Also: Applying a Template to a Taxonomy or Category on page 784
Inherit (only appears when creating a category underneath a taxonomy)—Check
this box if you want this category to inherit its template from the parent category or
taxonomy. If not, assign a template using the Template field (above).
Category Link—Use this field to direct a site visitor who clicks this taxonomy or
category to a page on your website. For example, when someone is using your
site’s company directory and clicks Human Resources > Benefits, he is directed to
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that area of your site.
Without a Category Link, if a site visitor clicks a taxonomy category, the results
appear on the same page.
Enter a path to a destination page relative to your site root folder. For example,
aboutus.aspx. When a site visitor clicks this taxonomy or category, the site visitor
is directed to http://your-URL/siteroot/aboutus.aspx.
You could also direct the user to a content ID, such as aboutus.aspx?id=62.
l

Synchronize Languages—Check this box to synchronize all language versions of
content assigned to this taxonomy. That is, maintain the same content in multiple
language versions of a taxonomy.
For example
o

you have English and Spanish versions of the taxonomy 'Press Releases'

o

content ID 406 exists in English and Spanish

If you add content ID 406 to the English 'Press Releases' taxonomy, Spanish content
ID 406 is added to the Spanish 'Press Releases' taxonomy.
Conversely, if you delete content ID 406 from the Spanish 'Press Releases'
taxonomy, content ID 406 is removed from the English 'Press Releases' taxonomy.
As another example
o

you have English and a Spanish versions of the taxonomy 'Press Releases'

o

content ID 407 exists in English only

If you add content ID 407 to the English 'Press Releases' taxonomy, the Spanish
'Press Releases' taxonomy is not affected, since content ID 407 does not exist in
Spanish.
Conversely, if you delete content ID 407 from the English 'Press Releases'
taxonomy, the Spanish 'Press Releases' taxonomy is not affected, since content ID
407 does not exist in Spanish.
See Also: Working with Metadata that does not work with XLIFF on page 1079
l

l

Create the Taxonomy in All Languages—Check this box if, whenever a
taxonomy is created in the default language, it is also automatically created in all
other enabled languages.
Enable—Check this box if you want this taxonomy or category, and its
subcategories, to appear when this taxonomy appears on your website.
Uncheck this box to block categories from appearing as part of this taxonomy. For
example, you have not finished creating content for a category.
If you uncheck this box, this node and its child nodes are indicated by a gray
background in the Workarea (see image below).
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The gray background also appears when users work with this taxonomy or category
on the Edit Content screen’s Category tab.
This setting does not prevent you from assigning taxonomies or categories in the
Workarea.
l

Configuration—Select a configuration with which to associate the taxonomy.
o Content
o

User

o

Group

NOTE: By default, a new taxonomy’s configuration is content. Also, this field only appears for
a taxonomy. It does not appear for categories, which are below the taxonomy.
Custom Properties tab—Let you extend the taxonomy's functionality by creating
custom fields to capture additional information.
5. Click Save. The View Taxonomies screen appears.
6. Add categories to this new taxonomy by clicking Add Category. The Add Category
screen appears.
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7. Enter the Category information. See Step 4 for information about these fields.
8. When finished, click Save.
9. Repeat this process for each category you wish to add to this taxonomy.
NOTE: You can also assign a Taxonomy to content using the Edit Content in Folder screen’s Category
tab.

Applying a Template to a Taxonomy or Category
Taxonomy categories are designed to help site visitors find content. To provide a taxonomybased search, your developer places a Directory server control on a Web page.
By default, when a user clicks a hyperlink on such a Web page, it uses the template assigned
to the linked content (as illustrated below). See Also: Working with Templates on page 382

784

Ektron Reference

Applying a Template to a Taxonomy or Category

To display the linked content in a different template:
1. When creating or editing a taxonomy or category, select the appropriate template at the
Template pull-down field (shown above).
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NOTE: Any category below the root level can inherit its parent’s taxonomy template. Use the
Inherit checkbox to do this.
You may need a developer’s help with the rest of these steps.
2. In Visual Studio.Net, open the .aspx page that contains the directory server control.
3. Look at the server control’s MarkupLanguage property.
4. If the property is blank, open the following file:
siteroot/workarea/template/taxonomy/taxonomy.ekml.
If the property displays an EkML file, open that file. Its path may be listed in the
property. If the .ekml file’s path is blank, it is workarea/template/taxonomy/.
5. Find the following line: [$HyperLink]<br/>[$Teaser]
6. Replace it with the following: <a href="[$TemplateQuickLink]">[$Title]</a><br/>
[$Teaser]
7. Save the .ekml file.
The content selected from this Directory server control will now use the template assigned to
the taxonomy or category.

Assigning a Taxonomy Configuration
There are 3 taxonomy configurations (that is, types).
Content—Associate this taxonomy with content. When this configuration is selected
l

you can assign content to the taxonomy or category

l

the taxonomy category appears on every folder’s properties screen (shown below)

User—Associate this taxonomy with Ektron or membership users. You select users for this
taxonomy on the Assign Items to Taxonomy screen.
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Group—This taxonomy‘s categories can be assigned to community groups from the
Category tab of the Edit Community Group screen.

If you do not check this box, users can only view taxonomy or category assignments on the
Category tab.
Whether or not this box is checked, you can assign taxonomy categories to community groups
via the View All Categories of Taxonomy screen.

Numbers on the View Categories Screen
When editing content, if you choose the Category tab, you see Taxonomy categories that
may be applied to this content. The number to the right of any taxonomy or category is the
total items assigned to it. For example, the Support taxonomy has 22 categories in it.

The number includes individual items plus all items in any assigned folders. So, for example,
if one content item and one folder are assigned to a category, and the folder has 5 items, the
category’s number is six.

Assigning Taxonomies and Categories
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The following table summarizes information about assigning a taxonomy or category to
content, users or community groups.
To assign a
taxonomy
category to

Available methods

Prerequisites

l

Content
NOTE:
Regardles
s of the
method
you use to
assign a
taxonomy
to content,
the result
is the
same.

Ektron Users

from the Edit Content in
Folder screen

from the Content Tab >
Taxonomy screen

from the Assign Item(s) to
Taxonomy screen

l

Membership
Users

l

l

Community
Group

l

l

from the Assign Item(s)
to Taxonomy screen
after logging into a
Community site, editing
the user profile

l

Must be
authorized to
edit the folder’s
content
You can only
select from
taxonomies
assigned to the
content’s folder

For more information,
see

Assigning a Taxonomy or
Categories to Content
below

Must be member of
administrators group
or Taxonomy
administrator

Assigning Content to a
Taxonomy or Categories
on the facing page

Taxonomy’s Configuration > User
check box is checked

Assigning a Taxonomy or
Categories to a User on
page 798

Taxonomy’s Configuration > User
check box is checked

Assigning a Taxonomy or
Categories to a Membership User on page 796

Taxonomy’s Configuration > Group
check box is checked

Assigning a Taxonomy or
Categories to a Community Group on page 792

from the Workarea’s
Assign Item(s) to
Taxonomy screen
from the Workarea’s
Community Group Area
after logging into a
Community site, editing
the community group
profile

Assigning a Taxonomy or Categories to Content
Ektron lets content authors assign a taxonomy or categories to content by navigating to a
content block, clicking its Category tab, opening a taxonomy, and checking the correct level.
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However, all taxonomies may not be available to every content item. Use a folder property's
Taxonomy tab to determine which taxonomies may be assigned to content in a folder.

For example, a folder’s content consists of restaurants, and you want to restrict users to the
Restaurant taxonomy—users cannot assign other categories to that folder’s content.

Assigning Content to a Taxonomy or Categories
PREREQUISITES
l

l

You can perform this procedure only if a taxonomy’s Configuration > Content
check box is checked.
Only Administrators Group members or taxonomy administrators can assign
taxonomy categories to content via the View All Categories of Taxonomy screen.
See Also: Defining Roles on page 1120

1. From the Workarea, go to Content > Taxonomies.
2. Select a language whose taxonomies you want to work with. You can choose All.

3. Select a taxonomy.
4. Select the category to which you want to assign content.
5. Click Assign Items to Taxonomy (

).

6. From the View drop-down, choose the type of the item to associate. See Also: Assigning
a Taxonomy Configuration on page 786
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7. If you select Content, choose the type of content you wish to see via the Type
pulldown.

l

All types—both archived and active content

l

Content—active content only

l

Library—library files

l

Archived Content—only content that has been archived and set to remain on site.

8. Navigate to the folder that contains the content you want to assign to the taxonomy or
category.
or
Search for the user or community group to assign to the taxonomy or category.
NOTE: Folder content appears below the folder list (see below). Also, only content in the selected
language appears.

9. Check the box to the left of content, user, or community group you want to assign. You
can assign all types of content, even blogs.

Assigning a Taxonomy or Categories to a Folder
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An administrator can make a taxonomy available to a folder:
1. From the Workarea, click Content > Folders then click a folder.
2. Choose View > Properties.
3. Click EditProperties.
4. On the Taxonomy tab, uncheck the Inherit parent configuration checkbox if it is
checked. See Also: Inheriting Taxonomies from a Parent Folder below
5. Check a taxonomy or categories that should be available to this folder.
From now on, users editing content in this folder can assign categories from the selected
taxonomies.

Inheriting Taxonomies from a Parent Folder
Unlike many folder properties, Taxonomy settings are not inherited from a parent folder by
default. But you can cause them to be inherited if that is appropriate. If you are not working
on the root folder and the appropriate set of Taxonomies is applied to a folder’s parent folder,
go to the folder’s properties screen and check the Inherit parent configuration checkbox.

Requiring the Assignment of at Least One Category
In folder properties, you can require all content to be assigned at least one taxonomy
category. If you do, when content in that folder is saved, Ektron verifies that at least one
taxonomy category is assigned. If none is found, the user must assign a taxonomy category
before saving the content.
To set a folder-level requirement for content to be assigned a taxonomy category:
1. Navigate to the folder.
2. Choose View > Properties.
3. Click Edit Properties.
4. Click the Taxonomy Tab.
5. Check the At least one category is Required checkbox.
6. Click Update.

Assigning a Folder to a Taxonomy or Categories
PREREQUISITES
l

l

You can perform this procedure only if a taxonomy’s Configuration > Content
check box is checked.
Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Content > Taxonomies option. See Also: Defining Roles on
page 1120

NOTE: If you assign a folder, a relationship is established between the folder’s content and the taxonomy
category. The folder is only a convenience for creating this relationship.
Because there is no relationship between a folder and a taxonomy category, if you delete the folder from
the taxonomy, the taxonomy category is still applied to the folder's content.
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You can assign a folder to a taxonomy, thereby displaying published content in the folder
when the page is viewed. As content is added to or deleted from the folder, the taxonomy on
the Web page changes dynamically.
For example, you have a “Top News Stories” folder, in which newer news items are
frequently added, and old ones are deleted. The taxonomy only shows the latest news items.
The updating of the content is handled by the taxonomy automatically.
IMPORTANT: If you move content from a folder to which a taxonomy category is assigned, the category
remains with the content in the new folder. If the new folder also has a taxonomy category assigned, the
new category is also applied to the moved content.
To assign a folder to a taxonomy category:
1. From the Workarea, choose Content > Taxonomies.
2. Select the language of the taxonomy on which to work.
3. Select the taxonomy or category to which you want to assign a folder.
4. Click Assign Folders to Taxonomy (

).

5. Navigate to the folder you want to assign to the taxonomy or category.
6. Check the folders you want to assign.

7. Click Update.
NOTE: Only checked folders are assigned to the taxonomy or category. Checking a parent folder
has no effect on its child folders.

Assigning a Taxonomy or Categories to a Community
Group
PREREQUISITE
You can perform this procedure only if a taxonomy’s Configuration > Group check
box is checked. See Also: Assigning a Taxonomy Configuration on page 786
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You can assign a taxonomy or categories to a community group from either a community
website or the Workarea.

Assigning a Taxonomy or Categories to a Community Group
from the Workarea Community Group Area
1. Navigate to Settings > Community Management > Community Groups.
2. Select a community group.
3. Click Edit this Community Group.
4. Click the Category Tab.

5. Check the taxonomies or categories to apply.
6. Click Save.

Assigning a Taxonomy or Categories to a Community Group
from the Workarea
Members of the administrators group or taxonomy administrators can assign a taxonomy or
categories to community groups via the View All Categories of Taxonomy screen. See Also:
Defining Roles on page 1120
1. From the Workarea, go to Content > Taxonomies.
2. Select a language whose taxonomies you want to work with. You can choose All.

3. Select a taxonomy.
4. Select the category to which you want to assign content.
5. Click Assign Items to Taxonomy (

).
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6. From the View drop-down, click Community Groups.

7. A search field appears. Click the search icon to see a list of all community groups. Or,
enter one or more letters, and only groups containing them appear.

8. Check the box next to community groups you want to assign.
9. Click Save.

Assigning a Taxonomy or Categories to a Community Group
from a Community Website
1. Log into the Community website.
2. Click the Community Groups link. The link's location varies, depending on your site
setup.
3. Click the community group that you want to edit.
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4. Click Edit Group.
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5. Click the Category tab.
6. Check taxonomies or categories to apply.
7. Click Save.

Assigning a Taxonomy or Categories to a
Membership User
You can assign a taxonomy or categories to a membership user from a Community website or
the Workarea.
PREREQUISITE
The taxonomy’s Configuration > User box is checked.

Assigning a Taxonomy or Categories to Community Group
from Website
1. Log into the Community website.
2. Click the Community Groups link. The location of this link varies, depending on your
site setup.
3. Click the community group whose members you want to edit.
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4. Click Members.

5. Click a user.
6. Click EditProfile.
7. Click the Category tab.

8. Check the taxonomies or categories to apply.
9. Click Save.

Assigning a Taxonomy or Categories to Community Group
from Workarea
PREREQUISITE
Members of the administrators group or taxonomy administrators can assign a
taxonomy or categories to community group members via the View All Categories of
Taxonomy screen. See Also: Defining Roles on page 1120
1. From the Workarea, go to Content > Taxonomies.
2. Select a language whose taxonomies you want to work with (see image below). You can
choose All.

Ektron 8.7

797

Using Taxonomies

3. Select a taxonomy.
4. Select the category to which you want to assign content.
5. Click Assign Items to Taxonomy (

).

6. From the View drop-down, click Members.

7. A search field appears. Click the search icon to see a list of all community members. Or,
enter one or more letters, and only members containing them appear. You can use the
pulldown to specify if you are searching the membership user's first name, last name or
user name.

8. Check the box next to membership users you want to assign.
9. Click Update.

Assigning a Taxonomy or Categories to a User
PREREQUISITE
Members of the administrators group or taxonomy administrators can assign a
taxonomy or categories to Ektron users via the View All Categories of Taxonomy
screen. See Also: Defining Roles on page 1120
1. From the Workarea, go to Content > Taxonomies.
2. Select a language whose taxonomies you want to work with (see image below). You can
choose All.
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3. Select a taxonomy.
4. Select the category to which you want to assign content.
5. Click Assign Items to Taxonomy (

).

6. From the View drop-down, click CMS Authors.

7. A search field appears. Click the search icon to see a list of all Ektron users (that is,
authors). Or, enter one or more letters, and only users containing them appear. You
can also use the pulldown to specify if you are searching the user's first name, last name
or user name.
8. Check the box to the left of the users you want to assign.
9. Click Update.

Additional Taxonomy or Category Tasks
This section also contains the following topics.
Viewing All Taxonomies
Viewing a Taxonomy
Editing the Fields of a Taxonomy or Category
Adding a Taxonomy or Category
Copying and Moving a Taxonomy or Category
Copying and Moving a Taxonomy or Category using a Toolbar Button
Copying and Moving a Category using Menu Options
Deleting a Taxonomy or Category
Deleting a Taxonomy from View All Taxonomies Screen
Deleting a Category from View All Categories Screen
Removing Content from a Taxonomy or Category
Removing a Folder from a Taxonomy or Category
Reordering Categories
Reordering Content Assigned to a Taxonomy Category
Importing and Exporting a Taxonomy
Importing a Taxonomy
Exporting a Taxonomy
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The View All Taxonomies screen displays all taxonomies currently in Ektron. The language
pull down lets you filter the list by a language. To work with any taxonomy, select it. When
you do, it appears within the View All Categories of Taxonomy screen.

Viewing a Taxonomy
The View All Categories of Taxonomy screen exposes all categories in a selected taxonomy.
Use this screen to perform tasks on a taxonomy or one of its categories, such as adding new
categories, assigning content to a category, and changing the order of items.
To access the View All Categories of Taxonomy screen:
1. From the Workarea, go to Content > Taxonomies
2. Click the top Taxonomy node to see all taxonomies.

3. Use the language pull-down to select the language of the taxonomy you want to work
with
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4. Click a taxonomy. The View Taxonomy screen appears.

Editing the Fields of a Taxonomy or Category
PREREQUISITE
Only administrators or users assigned to the Taxonomy Administrator role see the
Content > Taxonomies option. See Also: Defining Roles on page 1120
1. From the Workarea, go to Content > Taxonomies.
2. Select the taxonomy from the list of taxonomies.
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3. Click Edit (

). The following screen appears.

For a description of these fields, see Creating a Taxonomy on page 780.

Adding a Taxonomy or Category
PREREQUISITE
Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option.See Also: Defining Roles on
page 1120
To add a category to a taxonomy, or to add a subcategory to a category:
1. From the Workarea, go to Content Tab > Taxonomy.
2. Select the taxonomy or category under which you want to create a new category.
3. Click Add Category. The Add Category screen appears.
4. Complete the fields for the new category.
5. Click Save.

Copying and Moving a Taxonomy or Category
You can move any taxonomy category to any other taxonomy or category. There are 2 ways
to do this.

Copying and Moving a Taxonomy or Category using a
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Toolbar Button
1. From the Content > Taxonomies area of the Workarea, open the category that you
want to move or copy.
2. Click Move/copy (

).

3. A dialog appears. Select a taxonomy category to which you want to move/copy the
current category.

4. Click
l
l

right arrow (

) to move the taxonomy or category to the new location

Copy to the current Taxonomy to copy the taxonomy or category to the new
location

Copying and Moving a Category using Menu Options
1. From the left panel of the Taxonomy area, right click a category.
2. Choose Cut category name or Copy category name.
3. Hover over the destination category
4. Click Paste Taxonomy.

Deleting a Taxonomy or Category
NOTE: After you delete a taxonomy, it can no longer be assigned to content and folders. Further, existing
links to content (via the Category tab) are deleted. And, if a taxonomy was assigned to a folder (via the
Folder Properties screen), it is no longer assigned.
See Also: Deleting a Taxonomy in a Multi-Language Environment on page 816

Deleting a Taxonomy from View All Taxonomies Screen
NOTE: Only administrators or users to whom the Taxonomy Administrator role has been assigned see
the Content > Taxonomies option. See Also: Defining Roles on page 1120
1. From the Workarea, go to Content> Taxonomies.
2. From the View All Taxonomies screen, check the box next to the taxonomy you want to
delete.
3. Click Delete ( ).
NOTE: The delete button does not appear if the language selector is set to All.
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Deleting a Category from View All Categories Screen
1. From the Workarea, go to Content > Taxonomies.
2. Select a taxonomy from the list of taxonomies. The taxonomy items and properties
appear on the right.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.

Removing Content from a Taxonomy or Category
PREREQUISITE
Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option.See Also: Defining Roles on
page 1120
1. From the Workarea, go to Content > Taxonomies.
2. Select a taxonomy or category.
3. Check the box to the left of content you want to remove.

4. Click Remove Items.

Removing a Folder from a Taxonomy or Category
PREREQUISITE
Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option.See Also: Defining Roles on
page 1120
If you assign a content folder to a taxonomy category, the internal relationship is between the
folder’s content and a taxonomy category. A folder is merely a convenience for creating this
relationship. There is no data connection between a folder and a taxonomy category.
Therefore, if you delete a content folder from a taxonomy category, all content in that folder
remains assigned to it. To remove the folder’s content from the category, see Removing
Content from a Taxonomy or Category above.

804

Ektron Reference

Reordering Categories

However, after deleting a content folder, the connection between the folder and taxonomy
category is broken. So, content subsequently added to the folder is not assigned to the
taxonomy.
1. From the Workarea, go to Content > Taxonomies.
2. Select the taxonomy or category that has the folder that you want to delete.
3. From the View drop-down, select Folder(s).

4. Check the box next to folders you want to remove.
NOTE: To remove all folders, check the box in the title bar.
5. Click Remove Items.

Reordering Categories
PREREQUISITE
Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option.See Also: Defining Roles on
page 1120
You can reorder the categories of a taxonomy or one of its categories. Reordered
subcategories appear only within the Workarea.
To reorder the categories assigned to a taxonomy or category:
See Also: Adding a Taxonomy or Category on page 802
1. From the Workarea, go to Content > Taxonomy.
2. Select a taxonomy or category that has content that you want to reorder.
3. Click Reorder (

).

4. Set the Type drop-down list to Category.

5. Select an item that you want to move up or down.
6. Click the up or down arrow to move the item in that direction.
7. Continue steps 5 and 6 until all content is in the desired order.
8. If there are several language versions of this taxonomy, you can automatically reorder
all versions. To do that, check Apply ordering for all languages.
9. Click Update.
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Reordering Content Assigned to a Taxonomy
Category
You can reorder (that is, change the sequence of) content within a category. Reordered
content appears within the Workarea and can appear on your website of the Directory server
control’s ItemSortOrder property is set to taxonomy_item_display_order.
To reorder the content assigned to a category:
PREREQUISITE
Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option.See Also: Defining Roles on
page 1120
1. From the Workarea, go to Content > Taxonomies.
2. Select the taxonomy or category that has the content that you want to reorder.
3. Click Reorder (

).

4. Set the Type drop-down list to items.

5. All items assigned to the category appear.
6. Select content that you want to move up or down.
7. Click the up or down arrow to move the item in that direction.
8. Continue steps 6 and 7 until all content is in the desired order.
9. Click Update.

Importing and Exporting a Taxonomy
You can export any taxonomy as an xml file. Then, you can reuse it or send it to someone
else, who would import it to bring a copy of it onto their computer.
You can use the Export/Import feature like a “save as” feature. For example, you want to
create a taxonomy that is similar to an existing one but has a few differences. The easiest
way to do this is to export an existing one, import it under a new name, and edit it.
Below is an example of part of a taxonomy saved as an XML document.
<ArrayOfTaxonomyData
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<TaxonomyData>
<TaxonomyId>959</TaxonomyId>
<TaxonomyName>Bob Taxonomy</TaxonomyName>
<TaxonomyLanguage>1033</TaxonomyLanguage>
<TaxonomyLanguageName>English (U.S.)</TaxonomyLanguageName>
<TaxonomyDescription>Sample</TaxonomyDescription>
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<Taxonomy>
<TaxonomyData>
<TaxonomyId>960</TaxonomyId>
<TaxonomyName>Subnode</TaxonomyName>
<TaxonomyLanguage>1033</TaxonomyLanguage>
<TaxonomyLanguageName>English (U.S.)</TaxonomyLanguageName>
</TaxonomyData>
</Taxonomy>
</TaxonomyData>
</ArrayOfTaxonomyData>

Importing a Taxonomy
1. From the Workarea, go to Content > Taxonomies > Taxonomies.
2. Click Import Taxonomy (

). The Import Taxonomy screen appears.

3. In the Title field, enter a name for your new taxonomy.
4. Click Browse.
5. Navigate to the taxonomy file you want to import. The path appears in the Files field.
NOTE: Alternatively, you can enter or paste the xml into the XML box.
6. Determine the taxonomy’s configuration. See Also: Assigning a Taxonomy Configuration
on page 786
7. Click Import Taxonomy.
NOTE: If you assign a name that is already given to a taxonomy, Ektron appends a number to the
title, beginning with 1.
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Exporting a Taxonomy
Exporting a taxonomy means saving it as an .xml file on your computer or network drive. To
export a taxonomy:
1. From the Workarea, go to Content > Taxonomies.
2. Select the language of the taxonomy that you want to export.
3. All taxonomies in that language appear.
4. Click a taxonomy that you want to export.
5. Click Export Taxonomy (

).

6. You are prompted to select a folder into which to save it.

Assigning Custom Properties to a Taxonomy
Custom properties let you extend the functionality of taxonomies by creating custom fields to
capture additional information. Custom properties act like metadata for taxonomies and
categories.
For example, your organization manages a nationwide chain of retail stores. You create a
Sales Region taxonomy, where each category represents a different geographic region.
Sample categories are Northeast, Southeast, Midwest (as shown below).

You could create a custom taxonomy property named Regional Manager and use that to
create a list of regional managers.
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Next, access each region, click the Custom Properties tab, and apply a manager to the
region.
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PREREQUISITE
Only members of the Administrator User Group or those assigned to the taxonomy
administrator role can work with custom taxonomy properties.

Creating Custom Taxonomy Properties
1. Go to the Settings > Configuration > Custom Properties screen.
2. Select the language of the new custom property. You will only be able to apply the
custom property to taxonomies/categories in this language.
3. From the ObjectType pulldown, click Taxonomy.

4. Click Add. The Add Custom Property screen appears.
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l

l

l

l
l

l

l

l

Name—Enter the custom property name. The name identifies the custom property
on the Edit Taxonomy screen's Custom Properties tab.
Editable—Check this box to allow the user who is applying this custom property to
choose a value or edit the default value.
Uncheck the box if the user cannot choose or edit the value. In this case, he is only
applying the property. If a property is not editable and has several values (type
string: select from list or boolean), only the first or selected value is applied
to the property.
Example of an Editable Custom Property
Assume you manage an auto parts stores and want a custom taxonomy property to
indicate if a car can be repaired at a facility. You create a property named Repair
Services Available, and make it boolean and editable. Then, the person applying
that custom property to a taxonomy category can choose Yes or No to indicate if
repair services are available.
Enabled—Check this box if this property can be applied to a taxonomy or
categories. If you uncheck this box, this property does not appear on the Edit
Taxonomy screen's Custom Properties tab.
Data Type—
o String—a series of characters
o

Boolean—true (yes) or false (no)

o

Numeric—a series of numbers

o

DateTime—one or more dates and times selected from a calendar popup

Display Type/Value—If the Data Type is String, Numeric or DateTime, you have
2 choices.
NOTE: If the Data Type is boolean, select either Yes or No.
o

Select a single value—the property accepts one value

o

Select from a list—the property accepts several values. When you choose
this option, a lower field appears.

In the top field, insert a value then click Add. When you do, the value moves
to the lower field. Continue until all values are entered.
If you want to edit the order of the values, use the up/down arrows (circled
above).
NOTE: If Editable is checked and you insert several values, the user applying the
custom property can choose the value. If Editable is not checked, the first value is
applied to the custom property.
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5. Click Save.

Editing a Custom Taxonomy Property
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. Select the language of the custom property.
3. From the ObjectType pulldown, click Taxonomy.

4. Click the Title of the custom taxonomy property you want to edit.
5. The Edit Custom Property screen appears.
6. Move to the field you want to change. You can edit these fields:
l
Name
l

Editable

l

Enabled

l

Value

For descriptions of these fields, see Creating a Taxonomy on page 780.
NOTE: You cannot edit the ID, Language, CMS Object Type, Data Type, or Display Type fields.
If you need to change these fields, delete the custom property and create a new one.
7. Click Save.

Deleting a Custom Taxonomy Property
If you delete a custom taxonomy property
l

it remains assigned to all taxonomy and categories to which it is assigned

l

it cannot be assigned to additional taxonomy and categories

To delete a custom taxonomy property:
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the ObjectType pulldown, click Taxonomy.

3. Select the language of the custom property.
4. Click the Title of the property you want to delete.
5. Click Delete ( ).
6. A dialog box asks you to confirm.
7. Click OK.
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Reordering Custom Taxonomy Property Values
From the Edit Custom Property screen, you can change the order in which the values appear
on the Custom Properties tab.

To set the order of values in a custom taxonomy property:
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the ObjectType pulldown, click Taxonomy.

3. Select the language of the custom property.
4. Click the Title of the custom taxonomy property.
5. In the Value field, select item(s) to reorder.

6. Click the Up or Down arrows to move the value up or down.
7. Click Save.

Multiple Language Support for Custom Taxonomy
Properties
Like most Ektron objects, custom taxonomy properties have a language attribute. Each
taxonomy also has a language. You can apply custom properties to a taxonomy only if their
languages match.

Translating a Custom Taxonomy Property into Another
Ektron 8.7
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Language
When creating a custom property, you select its language. See Also: Creating Custom
Taxonomy Properties on page 810 This section describes how to save a custom taxonomy
property in a different language. The new version uses the same ID number as the original
language version. You can change the following fields from the original.
l

Name

l

Editable

l

Enabled

l

Data Type

l

Display Type

l

Value

For descriptions of these fields, see Creating a Taxonomy on page 780.
After you create the new language version, it is no longer linked to the original. For example,
if you edit or delete the original language version, that does not affect the new version.
To create a custom taxonomy property in another language:
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. Select the language of the custom property.
3. From the ObjectType pulldown, click TaxonomyNode (shown below).

4. Click the Title of the custom taxonomy property to be created in another language.
5. From the Add pulldown, select the language in which you want to create the custom
property.

NOTE: The Add drop-down shows enabled languages for which this custom property does not
already exist.
6. Information from the original language property fills the screen as default values. Edit
them as desired.
7. Click Save.

Working with Taxonomies in a Multi-Language
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Environment
This section explains how taxonomy is supported in a multi-language environment.
Initially, all related-language versions of a taxonomy inherit properties from the original
language version. For example, if you create a taxonomy in English and French is also
enabled, the French Taxonomy description is the same as the English one, as are the
taxonomy image, taxonomy template, value of Display? checkbox, and so on.
However, after the initial creation of the multiple-language versions, changes to taxonomy
properties affect the current language only -- they do not affect the related-language
versions.
If there are several language-related versions of a taxonomy and you select one of them then
edit a folder’s taxonomy properties, content in the related language inherits the taxonomy
folder properties.

For example, assume you select English, then edit a folder’s taxonomy properties and apply a
taxonomy or categories. If you later edit French content in that folder, the corresponding
French taxonomy’s categories are available to be assigned via the Category tab.
Further, the value of the At least one category is Required check box is also inherited.
This means that if a category must be applied to English content, it is also required for French
content.

Creating a Taxonomy in a Multi-Language
Environment
When you create a new taxonomy, you select a language. At that point, a version of that
taxonomy is created for each enabled language.
For example, you create a taxonomy in English, and French and Spanish are also enabled (in
the Settings > Language Settings screen). Ektron has versions of that taxonomy in
English, French, and Spanish. The ID of each taxonomy is the same, but the language ID is
different. You do not need to use all language versions. And, if you add categories to one
language taxonomy, those categories are automatically added to the other language versions
of that taxonomy.
The Synchronize Languages field on the taxonomy properties screen determines if all
language versions are linked. If that field is checked and you assign content to the English
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taxonomy, content with the same id in the other languages is assigned to the French and
Spanish versions.

Deleting a Taxonomy in a Multi-Language
Environment
If you delete a taxonomy, all related language versions are also deleted.

Enabling or Disabling a Taxonomy in a MultiLanguage Environment
If you enable a new Workarea language, a version of every taxonomy is automatically
created in that language.
If you disable a language, all of its taxonomies are deleted.
See Also: Determining Which Languages are Available on page 1059

Assigning Content to a Multi-Language Taxonomy
Ektron supports multiple language versions of content. When applying content to a taxonomy
category, you can only apply content whose language matches the taxonomy language. If that
content exists in other languages, the related-language version is also applied to the relatedlanguage taxonomy if the Synchronize Languages field is checked on the Taxonomy
Properties screen.
So, to continue the above example, assume there is a taxonomy in English and you apply
content item ID=30, Sample Content Block to one of its categories. If that taxonomy exists
in German, the content block titled Ektron Server Kontrollen (also ID=30) is applied to the
corresponding category in the related German taxonomy.
If there is no corresponding German content, nothing is applied to the German taxonomy
category.

Removing Content from a Multi-Language Taxonomy
If you remove content from a taxonomy in any language, it is removed from all languagerelated taxonomies.

Assigning Folders to a Multi-Language Taxonomy
When you assign a folder to a taxonomy category, you indicate that all folder content is
assigned to that node. Ektron folders are language-neutral, so the folder is also applied to the
corresponding taxonomy category in every language. However, only folder content that
matches the taxonomy’s language is assigned to the taxonomy category.
So, for example, a folder has 3 content blocks.
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l

English—Content in folder in language 100, 101, and 102

l

German—Content in folder in language 100
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If you apply that folder to a taxonomy, the English version of the taxonomy has 3 content
blocks assigned, but the German version only gets one content block (ID 100).
If content is later added to the folder, new English content is assigned to the English
taxonomy, and new German content is assigned to the German taxonomy.
NOTE: If you apply a folder to a taxonomy, numbers on the View Taxonomy screen indicate how many
content items are applied to it. Unless you have the same number of content items in each language, this
number is different for every language.

Removing Folders from a Multi-Language Taxonomy
If you remove a folder from its assignment to a taxonomy or category, the content in that
folder is still applied. So, you must also remove all of its content, as described in Removing
Content from a Multi-Language Taxonomy on the previous page.

Reordering Content in a Multi-Language Taxonomy
If you reorder the content assigned to a taxonomy or category, there is no change to
corresponding categories in other languages. This is because there is no guarantee that
content that exists in one language exists in the other languages.

Reordering Categories in a Multi-Language
Taxonomy
If you reorder categories assigned to a taxonomy or category, you have the option of
applying the changes to all language-related categories.

Using Taxonomies with Social Networking
If you have a community or social networking website, you can assign users and community
groups to a taxonomy. This allows site visitors to search for users and groups by category.
To enable a taxonomy-based search of users and community groups, a developer uses the
following server controls on your site.
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l

CommunityGroupBrowser control—lets a site visitor browse a taxonomy category
for community groups

See Also:

818

l

Managing Community Groups on page 1181

l

Assigning a Taxonomy or Categories to a Community Group on page 792
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A Breadcrumb displays a path to the current page, providing another type of site navigation.

Sitemap versus History Breadcrumbs
Ektron provides 2 kinds of breadcrumbs.
l

Sitemap—Displays a path to the current page, like the path shown in a Yahoo! directory
listing. Sitemap breadcrumbs always show the same path to a page, regardless of how it
was reached. You can also use sitemap breadcrumb information to deploy a site map.
Since you determine the organization of a sitemap breadcrumb, you must define the trail
in the Workarea. To do that, see Creating Sitemap Breadcrumbs below. To learn how to
place a sitemap breadcrumb on a template, see FolderBreadcrumb on page 1736server
control.

l

History—More accurately fulfilling the breadcrumb metaphor, history breadcrumbs
display a trail of recently-visited pages. Site visitors can click a link in a history
breadcrumb to jump to that page. For example, Products > Monitors > Flat Panel
shows that you arrived at the current page by clicking Products, then Monitors, then
Flat Panel.
A history breadcrumb requires no setup in the Workarea. To place a history breadcrumb
on a Web page, see BreadCrumb on page 1664 server control.

Creating Sitemap Breadcrumbs
The following topics explain how to create and manage Sitemap Breadcrumbs in the
Workarea.

Inheritance and Breadcrumbs
A folder can inherit a sitemap breadcrumb path from its parent, or you can break inheritance
and assign it a unique path. Use the Folder Properties screen Breadcrumb tab’s Inherit
Parent Configuration checkbox to retain or break inheritance.

Adding a Breadcrumb Trail
PREREQUISITE
Determine which topics should appear on a Sitemap Breadcrumb trail for content in a
folder. A trail typically consists of topics that introduce a folder's content, but you can
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create any sequence that makes sense. For example, on a university website, content
that describes the women's swimming team has this trail: Home > Athletics >
Women's Athletics > Swimming.
1. Navigate to the folder for which you want to add the breadcrumbs.
2. Click View > Properties.
3. Select the language of the breadcrumbs. You must set up a separate breadcrumb path
for every language for which you want to support breadcrumbs.
4. Click Edit Properties.
5. Click the Breadcrumb tab. The Edit Breadcrumbs screen appears.

6. If desired, uncheck the Inherit from parent folder box.
7. Add the following information.
l
Title—the breadcrumb name as you want it to appear in the breadcrumb trail
l

l

URL Link—the URL path to the breadcrumb’s destination, typically an Ektron
content item.
o

If you are not sure of the file path, click Select quicklink ( ) and select the
breadcrumb's content item. Only content in the language selected in Step 3 is
available. Alternatively, you can enter a URL, for example, www.example.com.

o

You typically enter items in the sequence in which you want them to appear in
the breadcrumb trail. If you do not, you can easily change the sequence of
items on this screen. See Also: Reordering Breadcrumb Items below

Description—add a description for the breadcrumb

8. Click Add. The first item in the breadcrumb path appears.
9. Repeat steps 6 and 7 for each item in the breadcrumb path.
10. Click Update.

Reordering Breadcrumb Items
1. Navigate to the folder for which you want to reorder breadcrumbs.
2. On the View Contents of Folder screen, click View > Properties.
3. Click Edit Properties.
4. Click the Breadcrumb tab. The Edit Breadcrumbs screen appears.
Ektron 8.7
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5. Click a breadcrumb item.
WARNING! Clicking the Remove button deletes the breadcrumb item. See Also: Removing a
Breadcrumb Item on the facing page

6. Click up and down arrows to move the item.
7. Click Update.

Editing a Breadcrumb Item
1. Navigate to the folder for which you want to edit breadcrumbs.
2. On the View Contents of Folder screen, click View > Properties.
3. Click Edit Properties.
4. Click the Breadcrumb tab. The Edit Breadcrumbs screen appears.
5. Click a breadcrumb item.
WARNING! Clicking the Remove button deletes the breadcrumb item. See Also: Removing a
Breadcrumb Item on the facing page.

7. Edit the Title, URL Link, and Description information.
8. Click Update.
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Removing a Breadcrumb Item
1. Navigate to the folder for which you want to remove a breadcrumb.
2. On the View Contents of Folder screen, click View > Properties.
3. Click Edit Properties.
4. Click the Breadcrumb tab. The Edit Breadcrumbs screen appears.
5. Click Remove ( ) next to the breadcrumb item you want to remove.

6. Click Update.

Using a Folder Breadcrumb Server Control
Add the Folder Breadcrumb server control to each Web form for which you want to create a
breadcrumb site map. For information about the control, see FolderBreadcrumb on
page 1736.
Follow these steps to use a Folder Breadcrumb server control.
1. In the Workarea, define breadcrumb information for a folder. See Also: Adding a
Breadcrumb Trail on page 820
2. Open a Web form for which you want to create a site map.
3. Drag and drop the Folder Breadcrumb server control onto the Web form.
4. Set the DefaultContentID or DefaultFolderID property. If you use
DefaultContentID, make sure the content is in a folder for which breadcrumb
information is defined. If you use DefaultFolderID, make sure breadcrumb information
is defined for that folder.
5. Save the Web form.
6. Open a browser.
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7. View a Web page that hosts the control to view the breadcrumb trail.
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Personalization is an integral part of websites like iGoogle and Facebook, and organizations
see personalization as a way to make their sites "stickier" and more engaging. Ektron
provides a framework on which to easily build personalized portals. Ektron’s portal
functionality lets you create a more interactive, engaging experience by giving power to the
user.
Your site becomes their site when membership users can personalize their experience by
adding widgets, application, and feeds, choosing and organizing content on their digital
dashboard. For example, a manager can use widgets to access information about the team.
An HR representative can update job postings through a widget instead of navigating to the
company’s careers site. Building personalization into your intranet empowers employees with
customization that fits their work and personal life.
Widgets have many functions such as photos, local weather, news, a personal work calendar,
a sales time line and tracker, or a feed to a discussion board about a new product release,
and so on. See Also: Widget Reference on page 714.

You can create individual and group personalization pages.
l

An individual personalization page is used by a membership user or an Ektron user to
personalize a page on your website. If a tab is private, only that user can view and edit
it. If the tab is public, anyone can view it but only the signed-in user can create and edit
the content.
OnTrek site > Login > My Profile > Dashboard
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l

A group personalization page is used by group members to set up a portal page that
addresses that group’s needs. Any group member can view and create or edit the page’s
content. If a tab on a group page is private, only group members can view and create or
edit it. If the tab is public, anyone can view it but only the group members can create
and edit the content.
OnTrek site > Login > Community > Community Groups > SelfServ HelpDesk
User Group > Dashboard

Using a Personalization Page
To access a personalization page, a membership user logs in then clicks My profile >
Dashboard.
Individual page
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Group page

Adding a Tab
On an Ektron website, you can create and add tabs to organize content by subject. Tabbed
content can be public or private. For example, a tab that displays personal financial
information can be private, so only you can see it. Each tab can have multiple columns, to
further customize the view.

You add a tab by clicking the down arrow choosing Add Tab from the menu. You decide if the
tab is public or private.
l

l

Any logged-in user can see a user’s public tab by visiting his or her profile and clicking
Dashboard.
A private tab is visible only to the user who created it.

Adding a Column
828
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You must add at least one column by clicking the down arrow and choosing Add Column.

Adding Widgets
Open the widget tray and select the widgets you want and place them on the page.

The selection of widgets that are available was determined when the widget space was
created. See Creating an Individual Personalization Page below

Creating an Individual Personalization Page
The following sections show you how to create a personalization page from scratch. After you
create a page, place a link to it on your site. Then, any authenticated membership user can
use the page to create a personal portal.

Widget Spaces
A widget space declares which widgets a user or community group member can drop on a
personalization page. Widgets appear in the personalization screen’s widget tray when a
membership user is personalizing a pageYou can create and modify these types of widget
spaces:
l
l

User space— widgets that can be applied to a user's profile.
Group space—widgets that can be applied to a community group. See Also: Creating a
Group Personalization Page on page 833
For example, NASCAR community group members are allowed to place only weather
and news feed widgets onto the group's personalization page. In this case, you would:
1. Create a widget space.
2. Select only weather and news feed widgets.
3. Sign on to Visual Studio to create the .aspx page.
4. Place a Personalization user control onto the page.
5. In the control’s widgetspaceID property, identify the widget space you created in
Step 1.
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NOTE: Another type of widget space, Workarea Dashboard, determines which widgets are available to
users when customizing their Smart Desktop.

Creating a Personalization Page
PREREQUISITE
To access this screen, you must be a member of the Administrators group
1. Go to Workarea > Settings > Configuration > Personalizations > Widgets. See
Also: Widget Reference on page 714
2. Click the Synchronize Widgets from the Website/Widgets Folder button make
sure all widgets are available.
3. Go to Settings > Configuration > Personalizations > Widget Space.
4. Click Add a Widget Space.
5. Enter a Title.
6. Click Group Space if this widget space will be used for a community group
personalization page.
Click User Space if this widget space will be used for a user's personalization page.
7. Select widgets that authorized users will be able to place onto a page.
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As you select a widget, its background color change
8. Click Add a Widget Space.
IMPORTANT: Remember your widget space’s ID number. You need it when setting up the
Personalization user control.
NOTE: The rest of this procedure explains how to create a personal portal for a membership user.
To learn how to create a portal for a community group, see Creating a Group Personalization Page
on page 833.
9. Open Visual Studio.
10. Create a new Web Form.
11. Switch to design view.
12. From the Toolbox, drag and drop an Ajax Extensions > Script Manager control.

NOTE: If you do not see a Script Manager control, install the Microsoft AJAX Library 3.5. To do this,
go to Microsoft ASP.net Download.
13. In the Visual Studio folder browser, open the workarea/personalization/ folder.
14. Drag and drop a Personalization user control (personalization.ascx).
15. Set the control’s widgetspaceid property to the ID number of the widget space you
added in Step 8.
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16. Save the Web Form.
17. Your page should redirect the user to the personalization page, or use an ASP.NET panel
to verify that user is authenticated. Here is sample code:
NOTE: The asp.net panels are implemented in eIntranet and Ektron Tech site.
Aspx.cs
// To check if user is logged in or not
Ektron.Cms.CommonApi IsUserLoggedIn = new Ektron.Cms.CommonApi();
if (IsUserLoggedIn.IsLoggedIn)
{
Response.Redirect(“dashboard.aspx”);
Or
pnlDashboard.Visible= true;
}
Else
{
pnlDashboard.Visible=false;
}
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Aspx
<asp:Panel ID="pnlDashboard" runat="server" Visible="False">
<asp:ScriptManager ID="ScriptManager1" runat="server"
EnablePartialRendering="true">
</asp:ScriptManager>
<ucEktron:Personalization ID="widgetSpace" WidgetSpaceID="1"
DynamicForeignIDParameter="id" runat="server" />
</asp:Panel>

18. The Synchronize Widgets screen helps you synchronize widgets in your website’s
siteroot/widgets folder with those in your Workarea. If you need to make them
available within the Workarea, click Synchronize Widgets from the
Website/Widgets Folder.
The Synchronize Widgets screen also lets you edit widgets by clicking the corresponding
Edit button ( ). For most widgets, you can change only the title and label. However,
you can change a few widgets' properties. For example, you can enter or update
properties of the Brightcove video widget.
After you click the button, you see new widgets on this screen and other Workarea
screens that let you select widgets. Conversely, clicking this button removes any
widgets that you delete from the siteroot/widgets folder.

Creating a Group Personalization Page
A community group personalization page is similar to an individual page. It lets group
members customize a page’s content by placing widgets.
To create a community group personalization page, follow the instructions in Creating an
Individual Personalization Page on page 829, with the following differences.
l

l

When creating a widget space, check the Group Space radio button.

When a developer creates an .aspx page and drops a personalization control, the
selected widget space must be one whose Group Space box is checked.
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l
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A private tab is visible only to group members.
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Ektron’s URL aliasing makes it easy to create descriptive, meaningful and SEO-friendly URL
aliases consistently, maximizing your website’s placement in search results. Use of words
and phrases that actually define the page increases an aliases’ search engine rankings. If you
follow a pattern, you can scale your aliases across your sites as they grow. Search engines
find URL aliases generated by Ektron. Ektron caches aliases to improve performance of your
site.
If you have a static website (for example, all HTML pages) that is indexed in a search engine,
create aliases for your site and retain complete content management without affecting your
search engine ranking.
If you have a PHP site, alias PHP pages and use the same query string names to pass needed
information to the new .aspx pages.
NOTE: Query strings appended to an aliased page pass to the .aspx page and may be used if necessary.
Existing sites migrate easily to Ektron, adopting the new aliasing scheme. Aliasing keeps old
links valid and you do not have to make changes to web.config. When URL aliasing is
configured and enabled, content inherits the new aliasing structure.
The following link, Creating User-friendly URLs with Aliasing, is a video that explains the
various types of URL aliases.

Types of URL Aliasing
l

l

l

l
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Manual URL Alias—give a content block a unique name. You can assign several manual
aliases to content then decide which one is the primary alias. If multiple alias types are
provided for a content item, you can enter any alias into the browser address field to
access that content. See Creating a Manual URL Alias on page 845.
Automatic URL Alias—create rules to be applied to the following types of CMS entities.
When you add content to any of the following types, it inherits the URL alias rules. See
Creating Automatic URL Alias Rules on page 849.
o Taxonomy—create an alias that is based on the taxonomy in your CMS by using
the levels of the taxonomy plus the title of the page. Because the alias is based on
taxonomy, you can have multiple aliases that have relevancy to multiple search
criteria.
o

Folder—create an alias that is based on the CMS folder structure. Descriptive
folder names and a well-organized folder structure makes a URL more relevant to
the content’s actual location.

o

User—create an alias using the name of a user in the URL. For example, a friendly
URL for Steve's profile page can be www.example.com/steve.

o

Group—create an alias using the name of a group to help make community pages
within your Ektron website easy to remember and find. For example, a friendly URL
for car enthusiasts would be www.example.com/cars.

Regular Expressions (RegEx)—create a URL match pattern that can redirect or
transform a range of URLs with a single setting. See Creating RegEx Expressions on
page 854.
Site Alias—lets an existing site URL have more than one URL for the same site. For
example, if your company‘s name just changed from Bionics to NewGen, (and the site is
essentially intact), you can use site aliasing so your customers can get to the same site
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content from the old www.bionics.com address and the new www.newgen.com address.
See Creating a URL Alias for a Site on page 856.
l

URL Redirect Alias—lets a link to an old URL find the new or changed URL that you
want. You use this alias when you need to add, change, or modify an existing URL. See
Creating a URL Redirect on page 858.

Configuring URL Aliasing
Before you can set up aliases, you must enable the feature using the URL Aliasing Settings
screen. Choose Workarea > Settings > Configuration > URL Aliasing > Settings.
Then, click Edit.
IMPORTANT: If you performed a database sync and the site being synched uses URL aliasing, you must
go to its URL Aliasing Settings screen and click Clear Cache ( ) to update its aliasing information. Also,
If you enable or disable any alias type or caching, you must run a full crawl of your Search Server. See
Also: Managing the Search Crawl on page 931
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l
l

Enable URL Aliasing—let CMS users with permissions create URL aliases.
Enable URL Redirects—let CMS users with permissions create redirected URLs (for
example, 301 redirects). See Creating a URL Redirect on page 858.

l

Manual—enable manual aliasing. See Creating a Manual URL Alias on page 845.

l

Folder—allow automatic folder aliases to be generated.

l

Taxonomy—allow automatic taxonomy aliases to be generated.

l

User—allow automatic user aliases to be generated.

l

Community Group—allow automatic community group aliases to be generated.

l

RegEx—allow RegEx aliases to be generated.

l

Extensions—Enter file extensions of pages for which aliases can be created and click
Add. Begin each extension with a period (.). By default, Ektron supplies the following
extensions (which cannot be removed).
o .aspx
o

/ (the slash is actually the lack of an extension at the end of a page’s name)

Do not add any extension entered into the Handler Mapping list. See Restrictions on
Extensions on page 842
The values in this field appear as drop-downs in the Add a New Manual Alias and Add a
New Automatic Alias screens.

See Also: Defining Unusual File Extensions Used in Aliasing on page 881
l

Override Template—A template and an alias can have the same name, for example,
www.example.com/dynamic.aspx. If this happens, and a site visitor types such an
address into the browser, this check box determines if the template page or the alias
appears. If this box is checked, the alias appears instead of the template.
NOTE: The template must be defined within the Workarea Settings > Template Configuration
screen.

l

Enable Language Awareness—
o Off (unchecked)—
n URL exists in the site visitor's current language: show target.
n

o

On (checked)—
n URL exists in the site visitor's current language: show target.
n

838

URL does not exist in site visitor's current language: 404 File Not Found
appears.

URL does not exist in site visitor's current language:
n If the URL exists in a language listed in the language fallback chain: show
target. (See Setting the Fallback Locale on page 1069.)
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l

l

n

If the URL does not exist in the language fallback chain, but does exist in
the site default: show target.

n

If the URL does not exist in the language fallback chain, and does not
exist in the site default, but exists as an alias in any language: get the
first URL match and show target.

n

If the URL does not exist in the language fallback chain, and does not
exist in the site default, and does not exist as an alias in any language:
404 File Not Found appears.

Default Replacement Character—replace spaces in taxonomy, folder, group or user
path names with a default character (such as underscore, _). You can specify
replacement characters for other characters in the Replacement Character Map on the
Add Aliasing Rule screen.
Query String Action—Set up a rule to handle an alias’s query string parameters. You
can set one rule for your entire site (via this field), and separate ones that override the
system-wide rule for specific manual aliases (using the Aliases screen). The following
options are available.
o None—If an aliased URL has a query string, it is ignored. Any query string on the
target URL is used.
o

Replace All Parameters within Alias—replaces a target’s query parameters
with the alias’ s query parameter. Example:
alias’s query string parameter:
http://www.ektron.com/Contact.aspx?id=84
Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
Result: http://www.ektron.com/aboutus.aspx?id=84

(The target parameters id=35&Userid=1 are replaced by the alias parameter
id=84)
o

Append Parameters to Alias—appends the alias’s parameters to the target URL.
Example:
Alias: http://www.ektron.com/Contact.aspx?id=84&lang=1033
Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
Result: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
& id=84&lang=1033

(The parameter from the alias is appended to the target)
o

Resolve Matched Parameters within Alias—Ektron tries to resolve matching
parameters (it is case sensitive). If a match is found, the alias’s query string
parameter takes precedence. Example:
alias’s query string parameter:
http://www.example.com/Contact.aspx?id=84
Target: http://www.example.com/aboutus.aspx?id=35&UserId=10
Result: http://www.example.com/aboutus.aspx?id=84&UserId=10

(id=35 is replaced by id=84 since it matched the query string parameter.
UserId=10 was not affected because it did not match the alias query string
parameter.)

Setting Default Documents for URLs
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You can set the default document file (for example, default.aspx) in the ek_DefaultPage
element of siteroot/web.config for client requests of a website that did not specify a
document name. For example, if someone types www.example.com/jobs, and the default
document is default.aspx, this URL resolves to www.example.com/jobs/default.aspx.
NOTE: The concept of default document is explained in the following Microsoft KB article: Configure the
List of Default Documents in IIS 7
The ek_DefaultPage element determines your website’s default document regardless of
whether you are using URL aliasing.
If a site visitor enters an address without a page name, Ektron refers to ek_DefaultPage’s
values. For example, the first page is default.aspx. If found, that page displays. If not, it
looks for the second page listed, and so on. If no pages are found or a page is not specified in
ek_DefaultPage, Page not found appears in browser.

Permissions for Working with URL Aliasing
l

l
l

Alias-Admin privileges apply to members of the CMS Administrators group and CMS
users with the Alias Administrator role.
Alias-Author privileges apply to any CMS user with the Alias Author role.
CMS User privileges apply to users that do not have the Alias-Author or Alias
Administrators role applied.
NOTE: By default the Alias-Author role is applied to the Everyone group. This role can however be
removed to further restrict the permissions to the CMS User state.

Task

View Settings Page

Edit Settings

View Rule List Pages

View Rule

Edit Rules

View Alias List Page

View alias
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Alias-Admin

AliasAuthor

CMS User

Where Aliasing Cannot Be Applied

Task

Alias-Admin

AliasAuthor

CMS User

Add Aliases

Edit Alias

Delete Alias

View Redirects Page

Edit Redirects Page
View Alias on content
tab
Edit Alias on content
tab

Where Aliasing Cannot Be Applied
IMPORTANT: After you enable Aliasing, relative links embedded in your Web pages that are not
preceded by a slash (/) may demonstrate symptoms such as runtime error notifications, broken images
(you see a red X where the image should be), or missing text styling. The following Ektron Knowledge
Base article analyzes this problem and presents solutions: Avoiding Style Problems, JavaScript Errors,
and Broken Images When Using URL Aliasing.
You cannot apply aliasing to the following areas of Ektron.
l
l

l
l

l
l

l

images
content in root folder (cannot be automatically aliased, although you can alias it
manually and by taxonomy)
forums (discussion boards) (links within forum posts can be aliased)
forms/polls/surveys—the form is aliased but the postback screen is not (for a
workaround, see Tip/Trick: Url Rewriting with ASP.NET)
a link to an HTML form
eCommerce—items in a (Shopping) Cart server control use an alias unless you assign an
.aspx page in the control’s TemplateProduct property. If you assign a page, it is used in
the product’s URL, not the alias.
If you enable .asp as an extension, the alias does not appear when a site visitor hovers
the cursor over assets. Instead, the actual file name appears.
If a site visitor hovers the cursor over HTML content, the alias does appear.
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l

l

The alias does not appear when a site visitor viewing an RSS page hovers the cursor
over assets. Instead, the actual file name appears.
content links within the Directory server control. If a template is assigned to a
taxonomy, the template takes precedence over an alias for content found by a Directory
server control.

Restrictions on Extensions
IIS7 handles Web page extensions other than .aspx. There are 2 scenarios.
l

If your site has non-aspx pages, you need to modify the IIS7 Handler Mapping list. In the
Handler Mapping list, extensions that are below ek* in the list are handled by aliasing.
You need to move non-aspx extensions (for example, .asp, .php, .cfm) above the ek*
extensions in the list.
1. Open IIS7.
2. Right click your website.
3. Click Handler Mappings.
4. Click View Ordered List.
5. Move non-aspx extensions used on your site above ek*. For example, if your site
uses .aspx pages, move ASPclassic above ek*.

842

Ektron Reference

Restrictions on Extensions

NOTE: After you do this, you cannot use these extensions as part of an alias. So, do not enter
them into the Extension field of the URL Aliasing Settings screen.

l

If your site previously had non-aspx pages but now it does not, set up aliases to the
previous non-aspx pages so that a visitor's bookmarks will continue to work.
1. Open IIS7.
2. Right click your website.
3. Click Handler Mappings.
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4. Click View Ordered List.
5. On the Handler Mappings screen, move non-aspx extensions that you want to alias
below ek*. For example, if your site uses .aspx pages, move ASPclassic below
ek*.
6. Enter the extensions in the Extension field of the URL Aliasing Settings screen. See
Also: Types of URL Aliasing on page 836

Clearing the Cache
An alias is cached whenever anyone uses it. You should periodically clear the cache so that
aliases are kept current.
IMPORTANT: If your Ektron supports multi-site configurations, you must sign in to each site’s Workarea,
then manually clear its cache.
1. Choose Settings URL Aliasing > Settings.
2. Click Clear Cache (

).

Assigning an Alias to Multi-Language Content
When a site visitor selects a language for viewing your site and enters the alias, Ektron
displays the aliased content in the selected language. See Also: the Enable Language
Awareness field in Configuring URL Aliasing on page 837.
You can assign a different alias to each language version of content. To do this, select the
content, language, go to the Alias tab, and assign a language-specific alias. For example,
your English home page’s alias is default, while your Spanish alias is defecto.

Also, alias names must be unique only within a language. So, for example, you cannot have 2
aliases named Ektron within U.S. English content. But, you can have 2 two aliases
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namedEktron if one is applied to U.S. English content, and the other applies to Spanish
content.

Filtering Aliases
You can have many aliases. Ektron lets you sort and filter the aliases to make it easy to
isolate a subset of aliases, to work on, activate, deactivate, delete, and so on. The Aliases
screen (Workarea > Settings > Configuration > URL Aliasing > Aliases) has the
following features for filtering. You can combine these filters to narrow your focus.
l

l

Type—filters aliases by taxonomy, filter, manual, user, or group. For example, choose
user and only user aliases appear.
Language—filters aliases by the selected language. For example, choose Spanish, and
only the Spanish aliases appear.

l

Default—filters aliases by site, if you have multiple sites; otherwise, default.

l

Search—Type in a string to filter the aliases.

l

Sort column—Click on a column heading to sort the entries A-Z or Z-A.

Creating a Manual URL Alias
You can choose a page name that makes complex URLs easier to read and remember. For
example, you can create an alias for www.example.com/help.aspx?id=27 that resolves to
www.example.com/help.htm. From then on, the content can be identified either by its
original URL or its alias. You can create any number or aliases for a content block.
NOTE: You cannot apply an alias to the root website. For example, you cannot alias www.example.com
with www.example2.com. However, you can alias anything below the root folder.
On multi-site environments, you can apply an alias to a folder on the root site, or to a folder on other sites,
but not both. For example, you can have the alias content.aspx applied to a root-folder, but then the
content.aspx alias cannot be used on a site-folder at the same time. However, if you apply
content.aspx to site1-folder, you can also apply content.aspx to site2-folder.
To activate or disable manual aliasing, choose Settings > Configuration > URL Aliasing
> Settings. The URL Aliasing Settings screen appears, which indicates if manual aliasing is
on or off. To change its state, click Edit, check or uncheck the box, and click Save.

To view a manual URL alias:
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1. Choose Workarea > Settings > Configuration > URL Aliasing > Aliases.
2. On Aliases screen, click the alias you want to view. The alias information appears.

Adding/Editing a Manual URL Alias
To add or edit a manual alias, manual aliasing must first be enabled.
1. Choose Workarea > Settings > Configuration > URL Aliasing > Aliases. The
Aliases screen appears. You can specify the following filters, or go right to Step 2.
NOTE: If there are many aliases, use the search to find one. You can filter by alias name, Content
ID, and so on.
a. Choose Manual from the Type drop-down field. The manual aliases appear in the
Aliases screen.

b. Choose the language from the Language drop-down field.
c. If your Ektron version supports multi-site configurations, use the Site drop-down to
choose the site.
2. To create a new alias, click Add Manual Alias. (To edit a manual alias, click an alias
then Edit.) The Alias Data screen appears.
NOTE: After you enable manual aliasing, every content block includes an Alias tab. You can create
a new alias by clicking Add Manual Alias from that Alias tab. However, if you insert/update an
alias from the Alias tab, the alias is available only after you publish the content.
Also, a folder may require its content to have a manual alias. In this case, you must add a manual
alias before you can check in or submit content.
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3. Check Active to activate the alias when you save it.
4. Optionally, check Default if you want this alias to be the primary alias. Even if the
content already has a primary alias, this alias will become primary.
5. Optionally select another language for this alias.
6. Enter a name in the Alias field. It must be unique within the site and language, and
cannot include the following characters: (comma), (space), \, <, >, “, :, |.
7. To the right of Alias is a pull-down menu of valid extensions. Select an extension to
apply to this alias. Extensions are defined on the URL Aliasing Settings screen.
8. Use the Query String Action field to set up a rule to handle an alias’s query string
parameters. You can set one rule for your entire site (via this field), and separate ones
that override the system-wide rule for specific manual aliases. 4 options are available.
o None—If an aliased URL has a query string, it is ignored. Any query string on the
target URL is used.
o

Append—Ektron appends the alias’s parameters to the target URL. Example:
Alias: http://www.ektron.com/Contact.aspx?id=84&lang=1033
Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
Result: http://www.ektron.com/aboutus.aspx?id=35&Userid=1 |
& id=84&lang=1033

(The parameter from the alias is appended to the target)
o

Replace—Ektron replaces a target’s query parameters with the alias’ s query
parameter. Example:
Query string parameter: http://www.ektron.com/Contact.aspx?id=84
Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
Result: http://www.ektron.com/aboutus.aspx?id=84

(The target parameters id=35&Userid=1 are replaced by the alias parameter
id=84)
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o

Resolve—Ektron tries to resolve matching parameters (it is case sensitive). If a
match is found, the alias’s query string parameter takes precedence. Example:
Query string parameter: http://www.example.com/Contact.aspx?id=84
Target: http://www.example.com/aboutus.aspx?id=35&UserId=10
Result: http://www.example.com/aboutus.aspx?id=84&UserId=10

(id=35 is replaced by id=84 because it matched the query string parameter.
UserId=10 was not affected because it did not match the alias query string
parameter.)
9. Enter the Additional Variables. These are used as query string parameters that can
track how visitors arrived at the aliased page. You might use these in marketing
campaigns to analyze the source of an aliased page’s visitors. For example, the
Additional Variables field has ?gclid=CO7gs_L0_ZICFRkTIgodBgV9CQ. Your website's
analytics software can track the source of the query through the variable.
NOTE: Within the page load event that returns the query string parameters, use the
Request.RawURL() property instead of request.querystring.
10. In the Content Block section, click Browse. The QuickLink Select window appears.
NOTE: Content choices are affected by value of the Language field on the Add Manual Alias screen.
Only content in the language of the selected alias appears. Also, only approved content appears.
11. Browse through the folder structure and click on the content to which you are assigning
the alias. The Title and Quicklink fields are filled.
NOTE: A folder’s content appears below its subfolder list. You may have to scroll down to see the
content.
12. Click Save.

Activating/Deactivating a Manual URL Alias
1. Go to Workarea > Settings > Configuration > URL Aliasing > Aliases. The
Aliases screen appears.
2. Click Edit.
3. In the Active column, check the box next to any alias to activate it; uncheck the box to
deactivate it. Check the box next to the Active heading to activate all aliases in the list;
uncheck to deactivate.
4. Click Save.

Removing a Manual URL Alias
1. Choose Workarea > Settings > Configuration > URL Aliasing > Aliases. The
Aliases screen appears.
2. Select Manual from the Type drop down to display only manual aliases.
3. Click Edit.
4. In the Delete column, check the box next to any alias that you want to remove. Check
the box next to the Delete heading to select all aliases in the list; uncheck to clear the
check boxes.
5. Click Save.
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Creating Automatic URL Alias Rules
Automatic aliasing lets you create rules for several types of CMS entities, based on
taxonomy, folder, user, or group designations. You can select additional elements of the alias
pattern and save all information as a configuration. Because you can assign a single content
block to several taxonomies, that content block can have many automatic aliases. When you
activate an automatic alias configuration, any content added to the taxonomy, folder, user, or
group in the future is assigned that alias (as long as the configuration is active).
To enable automatic aliasing, choose Settings > Configuration > URL Aliasing >
Settings. The screen indicates if automatic aliasing for taxonomy, folder, community user,
and community group is on or off. To change the state for any of these, click Edit, then check
or uncheck the box, and click Save.
To view an automatic URL alias assigned to a content item, go to a content item and view the
content, then click the Alias tab. Manual aliases appear near the top, followed by any
automatic aliases.

Automatic URL Alias Pattern
Automatic URL alias pattern combines the following elements—separated by a slash (/)—in
the following order.
1. site root
2. taxonomy, folder, group, or user path.
o Spaces are replaced by the replacement character; the default is underscore (_).
When you create a new rule, you can specify replacement characters in the
Replacement Character Map field on the Add Aliasing Rule screen.
o

A taxonomy path has taxonomy nodes from the top to the level at which content is
assigned. For example: www.example.com/Medical_Conditions/Kidney_
Disease/.

o

A folder path has folders from the top-level to the folder that contains the content.
For example: www.example.com/CMS400Developer/CMS400Demo/About_
Us/Company_Profile/Board_of_Directors.aspx. You can determine which path
components appear in the Customize Alias Path field on the Add Aliasing Rule
screen.

o

A group path may identify the Marketing group:
http://www.example.com/Marketing/.

o

A user path may identify a community profile for a user: http://<website>/John/

3. content name source
Spaces are replaced by the replacement character.
4. extension
NOTE: Aliases must be unique. If you try to create a duplicate alias, a value is appended to the alias to
make it unique.
Examples:
Folder-based automatic alias
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Suppose that you assign an automatic folder alias called “History” to the
MainSite/Content/Company/Company_News/ folder and you specify the additional rule that
excludes some of the folder path from the URL. When you create NewHistoryEvent.aspx and
put it in the Company_News folder, it has the following URL automatically generated:
www.example.com/Company_News/New_History_Event.aspx

Taxonomy-based automatic alias
Suppose that you create a new job posting called SalesAdministrator and give it the
Administration and Sales taxonomy categories.
SiteNavigation
Company
Jobs
[x] Administration
[x] Sales
[ ] Marketing
[ ] Engineering
[ ] Support

A taxonomy-based alias automatically generates the following URLs based on the taxonomy
selections:
www.example.com/Jobs/Sales/SalesAdministrator
www.example.com/Jobs/Administration/SalesAdministrator

User-based automatic alias
A user alias can simplify a reference to someone’s profile page.
www.example.com/member/steve

Group-based automatic alias
A group alias can simplify a reference to a group page.
www.example.com/group_interest/sports_cars

NOTE: Activity streams, SMS, and email notification messages that include links to users or community
groups use the community URL alias in their links. If you want to show the template alias, use the proper
token in the message. For example, to use the alias for the SubjectUser, use the
@SubjectUser.TemplateAlias@ token in your message. See Also: Working with Tokens on
page 1213.
If you enable a user-based community alias, community users display their alias name on
their profile's Profile Links tab.

Similarly, if you enable a group-based community alias, community groups display their alias
name on the profile's Links tab.

850

Ektron Reference

Creating/Editing Automatic URL Aliasing Rules

Creating/Editing Automatic URL Aliasing Rules
After enabling automatic URL aliasing, you can create rules in a configuration, which lets you
l

identify the content source (that is, a taxonomy, folder, user, or group)

l

choose elements of the aliasing pattern

l

preview sample original and aliased URLs

NOTE: You cannot create a configuration whose values match an existing one.
1. Choose Settings > Configuration > URL Aliasing > Aliasing Rules > Automatic.
The Automatic Aliasing Rules screen appears.

2. Click on an existing rule, or click Add Aliasing Rule. A rules screen appears.
a. Specify a unique name for the new automatic rule.
b. Check the Active field if you want the rule to apply immediately after it is created.
WARNING! If you uncheck this box, automatic aliases set up using this configuration are
deleted from the associated content.
c. If you have more than 1 site, choose the site to which the rule applies.
d. Select the Source Type (Taxonomy, Folder, User, Group).
e. Click Next. The rules screen appears. (The following image shows a sample
Taxonomy rules screen.)
3. Specify the following rules:
l
Alias Root (Taxonomy, Folder)—Navigate to and choose a taxonomy or folder to
which you want to assign an automatic alias.
o If you choose a taxonomy, the automatic alias is applied to all content
assigned to it and its child nodes. Furthermore, if your Ektron supports multisite configurations, the automatic alias applies to content in all sites. This is
because taxonomy is site independent.
o

If you choose folder, the automatic alias applies to content in that folder and
its subfolders. The taxonomy or folder is part of the automatic alias pattern.
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l

l
l

l

Exclude from Path (Taxonomy, Folder)—The automatic alias pattern displays
folders or taxonomy levels from the top to the level you select. You can use this
field to control which folders or taxonomy levels appear in the pattern. For
example, if your Alias Root is based on the following folder path:
/CMS400Demo/About Us/Careers, you can choose any option from the drop-down
menu to indicate the folder or taxonomy path in the automatic alias pattern.
Alias Prefix (User, Group)—Add a prefix to the alias.
Alias Format (Taxonomy, Folder)—Use this field to help construct the automatic
alias pattern. Choose 1 of the following items to identify the content within the
alias.
o Content Title—Example: Sample Content Block
o

Content Id—Example: 30

o

Content Id and Language—Example: 30/1033

Extension—Use this field to help construct the automatic alias pattern. Choose an
extension from the list to identify the end of the aliased URL. Extensions are defined
in the Extension field of the URL Aliasing Settings screen.
Do not add any extension entered into the Handler Mapping list. See Restrictions on
Extensions on page 842

l

Template (Taxonomy)—Choose Taxonomy Template or Quicklink. The alias
target URL will be the template of the content item being aliased, along with any
querystring parameters (for example, content.aspx?id=123). Taxonomy
Template can have its own template assigned to the taxonomy node. When
creating the automatic alias, this setting indicates which template to use for the
target URL. Quicklink uses the behavior just described. Taxonomy Template
uses the template assigned to the designated taxonomy along with the querystring
parameters from the Quicklink. For example:
o Taxonomy Template
n Content ID 123, assigned to template content.aspx

o

l

n

Content assigned to Taxonomy X

n

Taxonomy X has a template taxtemplate.aspx

n

Taxonomy alias rule created targeting Taxonomy X

Quicklink
n Quicklink = /content.aspx?id=123
n

Alias Target with Quicklink Template Field selected =
/content.aspx?id=123

n

Alias Target with Taxonomy Template Field selected =
/taxtemp.aspx?id=123

Query String Param (Taxonomy, Folder)—Enter the query string parameter for
this alias. For example, if the alias uses a taxonomy, you could entertaxid. Here is
an example of the parameter in a URL:
http://localhost/eIntranetv2/Blogs.aspx?id=238&blogid=115&taxId=28
IMPORTANT: Do not enter id here because that will clash with the content id.
Do not enter more than one parameter.
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l

l

Example Preview—shows what the alias will look like. To see any content item’s
fully aliased URL, view the content and click the Alias tab; the alias is in the
Automatic section.
Replacement Character Map—Accept the default values, or enter the character
that replaces prohibited characters in content titles when they appear within an
automatic alias. Examples of prohibited characters are a space and question mark
(?). So, for example, if the content title is About Us, and you enter an underscore
(_) here, the aliased version of the title is About_Us. Specify other replacement
characters in the Replacement Character Map section.
You cannot enter one of the following as the replacement character: [, \ / < >
(Space): |? '] # * &%
NOTE: If you're using IIS Admin, and specify a plus sign (+), you get this error: HTTP Error
404.11 Not Found The request filtering module is configured to
deny a request that contains a double escape sequence. For a solution,
see Error message when you visit a website that is hosted on IIS 7.0: "HTTP Error 404.11 –
URL_DOUBLE_ESCAPED".

Deactivating an Automatic URL Aliasing
Configuration
If you deactivate an automatic alias configuration, automatic aliases created by that
configuration are removed from content to which they are applied. The configuration is
saved, so you can reactivate it.
1. Choose Settings > Configuration > URL Aliasing > Aliasing Rules > Automatic.
2. Click the alias that you want to deactivate.
3. Click Edit.
4. Uncheck the Active checkbox.
5. Click Save.

Deleting an Automatic URL Aliasing Configuration
If you delete an automatic aliasing configuration, automatic aliases are removed from
content to which they are applied.
1. Choose Settings > Configuration > URL Aliasing > Aliasing Rules > Automatic.
2. Click Edit List.
3. Check each configuration that you want to delete.
4. Click Save.
WARNING! No confirmation message appears when you save the Automatic Aliasing Rules
screen, so be deliberate when checking the Delete boxes.

Troubleshooting Group or User URL Aliases
If you do not see the community alias when you hover over or click a link to a community
group or user, check the following.
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l

The alias is set to Active.

l

The alias is the primary alias.

l

l

The server control that displays the link does not use the TemplateUserProfile setting.
If it does, that value takes precedence over the URL alias.
If you are using eSync, refresh the cache after a database sync.

Creating RegEx Expressions
A RegEx (regular expression) lets site visitors enter a descriptive URL into the browser
address field and transform that entry into the query string component of an Ektron page.
This lets site visitors “guess” other pages based on a recognizable pattern. For example, a
RegEx expression aliases blogs.aspx?blogmonth=3&blogyear=2013&blogid=14 as
blogs/2013/03/14. From that, a site visitor can infer that blogs/2013/03/13 would display
the previous post, and blogs/2013/03 would display March 2013 posts, and so on.
To view a RegEx, choose Workarea > Settings > Configuration > URL Aliasing >
Aliasing Rules > RegEx, then click the expression that you want to view.

Creating/Editing a RegEx Expression
1. Find a site page (such as a blog) whose query string parameters let users guess similar
pages using a pattern. For example:
http://ecmintranet/blogs.aspx?blogmonth=3&blogyear=2013

2. Choose Workarea > Settings > Configuration > Url Aliasing > Aliasing Rules >
RegEx. The RegEx Rules screen appears.

3. Do 1 of the following:
l
To create a new expression, click Add a Regular Expression. The RegEx Alias
screen appears.
l

To edit an existing expression:
a. Click Edit List.
b. Click the expression you want to modify. The RegEx Rule screen appears.
c. Click Edit.
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4. Specify the following RegEx Alias parameters (example entries shown):

l

l
l

l

l

l

Active—Check this box to activate the expression. If the expression is active, site
visitors can enter an aliased URL to access a page on your site. For example, they
can enter www.example/com/blogs/2013/03/14 to access a blog page even
though the actual URL is
www.example/com/blogs/blogs.aspx?blogmonth=3&blogyear=2013&blogid=4
Site—If you have more than 1 site, choose the site to which this RegEx applies.
Expression Name—Assign an easily recognizable name to this regular
expression. It appears on the RegEx Rules screen to help users identify it.
Expression Library—A link that displays sample expressions.

Expression—Enter a RegEx expression that will replace the variables (for
example, $1, $2, and so on.) in the Expression map. If you want to insert a
question mark into the Expression, you must precede it with a backslash (\).
Expression Map—Enter a map of original URL elements. The map lets you replace
query string parameters with variables, such as $1, $2, and so on. As a result, a
site visitor can identify other pages that use this pattern by changing the variable
values. You can click Expression Library to view sample RegEx expression maps.
To copy any map that resembles your page pattern, click it then modify it.
As another example, you can create a pattern without knowing in advance what URL
a user may type, using a querystring variable. When a user types:
www.example.com/catalog/search/christmas

The alias can use a querystring variable after catalog/search/ to see if content
is available in the catalog using the following aliased URL:
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www.example.com/catalogsearch.aspx?term=christmas
l
l

Example URL—Displays an example Web page that follows this pattern.
Priority—Assign a priority to this expression from the following choices.
o high (assign to the most frequently-used expressions)
o

medium

o

low

o

none

This field enhances the aliasing feature's response time—it first tries to match a site
visitor’s entry with high priority expressions, then medium, then low.

Deleting a RegEx Expression
1. Choose Workarea > Settings > Configuration > URL Aliasing > Aliasing Rules
> RegEx.
2. Click Edit List.
3. Check the box in the Delete column next to any RegEx you want to delete.
4. Click Save.

Creating a URL Alias for a Site
If your site supports the multi-site feature, you can enter aliases for any site. For example,
suppose that your company changed its name from Bionics to NewGen, but the content of
your site remains essentially the same. By adding a site alias, along with appropriate DNS
mappings and domain registration, customers can still get to your site with the bionics.com
URL and now also with the new company URL newgen.com.
Note the following conditions for creating a site alias:
l

l

l

If your Ektron supports multi-site configurations, an automatic alias assigned to a
taxonomy will apply to content in all sites. This is because taxonomy is site independent.
If the site being aliased resides in a folder under your server’s Web root folder (for
example, ser4325/min), you must add the subfolder to the alias. For example, you
could not enter http://www.myalias.com as an alias for that site. Instead, enter
http://www.myalias.com/min/.
You cannot apply an alias to the root website. For example, you cannot alias
www.example.com with www.example2.com. However, you can alias anything below the
root folder. On multi-site environments, you can apply an alias to a folder on the root
site, or to a folder on other sites, but not both. For example, you can have the alias
content.aspx applied to a root-folder, but then the content.aspx alias cannot be used
on a site-folder at the same time. However, if you apply content.aspx to site1-folder,
you can also apply content.aspx to site2-folder.

To create a site alias:
1. Open the site folder for which you want to create aliases. (Site folders have a globe icon,
like this:
).
2. Click View > Properties.
3. Click Edit Properties.

856

Ektron Reference

Editing a Site Alias

4. Click the Site Alias tab.

5. Enter the alias into the Alias Name field.
NOTE: The alias cannot end with a slash (/).
From now on, if a site visitor enters the alias into a browser address field, he is
redirected to the site URL (set on the folder properties tab’s Production Domain field).

6. Add each site alias as an IIS host. To learn how do this for your server, please consult
IIS help.

Editing a Site Alias
1. Open the site folder for which you want to create aliases. (Site folders have an icon, like
this:

).

2. Click View > Properties.
3. Click Edit Properties.
4. Click the Site Alias tab.
5. Click the alias that you want to edit. When you do, it is highlighted and appears in the
Name field.
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6. Change the alias text.
7. Click Save.
8. Click Update.

Deleting a Site Alias
1. Open the site folder for which you want to create aliases. (Site folders have a globe icon,
like this:

).

2. Click View > Properties.
3. Click Edit Properties.
4. Click the Site Alias tab.
5. Click the alias that you want to edit. When you do, it is highlighted and appears in the
Name field.
6. Click Delete ( ). The alias is deleted.

Creating a URL Redirect
You may have an old or original URL that you want to continue to work after you have moved
the content to a new URL. So, you create a URL redirect from an original URL to a new URL,
essentially leaving a "forwarding address" to a new URL. For example, you can redirect an
previously known link (/OnTrek/default.aspx) to a new one
(http://www.example.com/home/).
NOTE: When adding a redirect, the 404 target URL field is optional. If you do not provide a target URL,a
404 error is handled by the configuration in either the web.config or IIS.
1. Go to Workarea > Settings > Configuration > URL Aliasing > Settings. The URL
Aliasing Settings screen appears.
2. Ensure that Enable URL Redirects is checked. If it is not:
a. Click Edit.
b. Check the box
c. Click Save. Redirects appears in the URL Aliasing folder.
3. Go to Workarea > Settings > Configuration > URL Aliasing > Redirects. The
Redirects screen appears.
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4. Click Add Redirect. The Add Redirect screen appears.

l
l

l

Active—Check the box to activate the redirect.
Site—If you have a multi-site environment, choose the site on which the redirect is
active.
Redirect Code—Choose the desired redirect code.
o 200 - OK—The original URL and new URL must be relative path URLs; returns
a success status when a person accesses the original URL.
o

301 - Moved Permanently—Use this code to change from one URL to
another. If a person tries to access the original URL, it is replaced with the new
URL. The Original URL must be relative; the new URL can be a relative or
absolute (fully qualified) path.
IMPORTANT: Create separate 301 redirects for your http:// and http://www versions of
your website. They are considered separate URLs.

l

l

o

302 - Temporary Redirect—Use this code to change from one URL to
another URL, but some information is not passed to servers and Search
engines. (This could affect SEO.) For example, if your website sold seasonal
items, you can redirect each seasonal site to 1 URL, keeping each season
separate, but having 1 branded face to your customer. The original URL must
be relative; the new URL can be a relative or absolute (fully qualified) path.

o

404 - File Not Found—Use this code for a Web page that no longer exists, or
to force the expiration of a page that may exist. Specify only the Original
URL. If a person tries to access the page in Original URL, a 404 Not Found
message is returned.

Original URL—Enter the URL of the Web page that will be redirected to the new
URL.
New URL—Enter the URL of the Web page to which people will be redirected.
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5. Click Save. The new URL redirect appears on the Redirects screen.
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Ektron Web search finds relevant results within several parts of the CMS structure and offers
massive scalability, scaling to tens of millions of items and beyond. Search capability is based
on Microsoft Search Server 2010 technology, which provides superior search capability with
performance and extensibility currently demanded by enterprises world wide. There are
specific search functions for the visitor using the website and the administrator using the
Workarea. You can search content, documents, metadata, keywords, descriptions, titles,
community content, users, groups,and activity streams.
For more information about Search, see the Ektron Framework API >
Ektron.Cms.Framework.Search and the Framework UI > Templated Server
Controls > Search in the Ektron Online Developer's Reference.
Online Search webinar: V8.6 Enterprise Search - What's New and Best Practices Video
BEST PRACTICES
l

The server hosting your search provider needs at least 120 GB free space.

l

Install SQL Server on a standalone server

l

The optimal operating system is Microsoft Windows Server 2008 R2 or 2012

You can choose from the following search providers. Use the following guidelines to
determine which search server is best for you. For a more details, see Search Technologies
for SharePoint 2010 Products.
l

l

l

Microsoft Search Server Express 2010
o A free enterprise search solution that is simple and flexible to configure, and
powerful enough to meet your needs. Also, you are using Windows 7; Search
Server Express is its only supported search provider.
o

Requirements: Hardware and software requirements (Search Server 2010)

o

Installation: Setting Up Microsoft Search Server 2010 Express on page 864

Microsoft Search Server 2010
o You are indexing more than 10 million items.
o

Requirements: Hardware and software requirements (Search Server 2010)

o

Installation: Setting Up Microsoft Search Server 2010 on page 871

Microsoft FAST Search Server 2010
o You are indexing more than 100 million items.
o

Requirements: Hardware and software requirements (FAST Search Server 2010 for
SharePoint)

o

Installation: Setting Up a Microsoft FAST Search on page 899

Search Provider Comparison Table
The following table compares functionality available with search providers.
Deciding between Microsoft Search Server 2010 or FAST
1. Decide if you will install Microsoft Search Server 2010 on the server that hosts Ektron, or
on a separate server. Ektron strongly recommends a separate server for Microsoft
Search Server 2010. If you must install both on the same server, use the configuration
for testing purposes only.
2. Install Microsoft Search Server 2010. If you will use Microsoft FAST Search Server 2010,
see Setting Up a Microsoft FAST Search on page 899. If your server has Windows 7, see
Setting Up Microsoft Search Server 2010 on page 871.
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3. Install or upgrade to Ektron Release 8.6 or higher.
4. When the installation finishes, Microsoft Search Server 2010 kicks off a crawl of your
entire website. During this process, Search Server builds the indexes that return search
results. As you add and edit Ektron content, crawls run in the background to give
Microsoft Search Server 2010 the latest information. To learn more about this topic, see
Managing the Search Crawl on page 931.
5. When the crawl has finished, Ektron authors and site visitors can begin using the search.
6. Searching a Microsoft Search Server Website on page 938—explains the site visitor
experience of finding content on your website
7. Searching the Workarea on page 966—explains the Ektron user experience of finding
content on your website
8. You can extend the search's functionality by working with Providing Suggested Results
on page 952, Using Synonym Sets on page 945, and the Including External Files in Your
Search on page 946.
9. While the pre-8.5 Web Search server control is supported for customers upgrading from
a previous version, Ektronstrongly recommends using the 8.5 and higher search controls
or API to deploy search functionality on your website.

Function

Microsoft FAST
Search Server

Microsoft
Search
Server

Microsoft
Search Server
Express

Providing Suggested
Results on page 952
Synonym sets

Integrated search

Load balanced search

Profile ranking

Faceted search

Document promotion
High degree of relevant
results/Similar Results
Autosuggest

This chapter also contains the following topics.
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l

Setting Up Microsoft Search Server 2010 Express below

l

Setting Up Microsoft Search Server 2010 on page 871

l

Setting Up a Microsoft FAST Search on page 899

l

Managing a Microsoft Search Server on page 925

l

Searching a Microsoft Search Server Website on page 938

l

Searching the Workarea on page 966

l

Using Search Server Controls on page 971

l

Troubleshooting Search on page 988

See Also: Why Site Search Matters

Setting Up Microsoft Search Server 2010
Express
IMPORTANT: If your server uses Windows 7, Microsoft Search Server Express 2010 is the only
supported search provider.
PREREQUISITES
l

l
l

An understanding of Microsoft Search Server 2010 Express; See Also:
http://technet.microsoft.com/en-us/sharepoint/ee263912.aspx
Both servers can browse to each other across the network
On your Ektron server
o Open ports 6080 and 6081 (used by the CMS File Helper Service to
communicate Ektron services and copy files between the Web and Search
servers)
o

Set SQL Security to SQL Server and Windows Authentication mode

o

Create a SQL user login with the sysadmin role. Microsoft Search Server
2010 uses that login to access the Ektron database.
BEST PRACTICE
You should update your Ektron site's web.config file's
<connectionstrings> tag with the username and password of that
SQL user. Set Integrated Security to False. Then, log into Ektron
to verify that the connection string is valid. See Also: Managing the
web.config File on page 67

l

l
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On your Microsoft Search Server Express 2010
o Obtain the username and password of a user with Windows administrator
privileges
o

Verify that the server meets the Optimizing Microsoft Search Server 2010
with Ektron on page 880

o

Open port 6080 (used by the Protocol Handler Service)

On your database server
o Open Port 1433
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Installing Microsoft Search Server 2010 Express
Prerequisite:
1. Install or upgrade Ektron on its server, using the normal procedure. See Also: Installing
Ektron on page 9, Upgrading to Version 8.7 on page 35.
2. When prompted to choose a search provider, choose Microsoft Search Server 2010
Express.
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3. After the Ektron database setup, the following dialog appears. Click No.

The Ektron installation completes.
4. On the Ektron server, copy C:\Program
Files\Ektron\CMS400
versionnumber\Utilities\SearchServer\SearchServerExpressInstall.exe.
5. On the server that will host Search Server Express, paste and run
SearchServerExpressInstall.exe.
6. The following dialog appears. Choose Download Setup File (unless you previously
downloaded the Search Server Express setup file). Click Next.
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The Search Server Express installation file is downloaded. If your server uses Windows
7:
l
l

an Ektron program installs the Search Server Express prerequisites
a dialog provides helpful links and notifies you that the server will be rebooted.
Click OK. Restart the server.

The Microsoft Search Server Express 2010 installation begins.
7. Accept the Microsoft Software License Terms. Click Continue.
8. When asked to install as a Standalone or ServerFarm, choose ServerFarm.
9. On the Server Type dialog, choose Complete then click Install Now. The Installation
Progress screen appears.
10. The following screen appears. Click Run the SharePoint Products Configuration
Wizard now then Close.
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11. The SharePoint Products Configuration Wizard appears. Click Next.
12. If you are installing on Windows 7, a warning appears. Click OK.
13. A notice about services that may be affected during the configuration appears. Click
Yes.
14. The Connect to a server farm dialog appears. Select Createa new server farm
then click Next.
15. Enter the database server and name along with account information. Then click Next.
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16. The Specify Farm Security Settings screen appears. Enter any password. You will need
this to work with the SharePoint Products farm.
17. The Configure SharePoint Central Administration Web Application screen appears.
Accept the default port number or enter a different one.

18. Under Configure Security Settings, choose NTLM. Click Next.
19. The final configuration wizard screen appears, summarizing all details that the wizard
collected. If the information is acceptable, click Next.
20. The Configuration Successful message appears. Click Finish.
21. The SharePoint Central Administration opens with dialog about Customer Experience
Improvement. Select No (or Yes) then click OK.
22. Click the Start the Wizard button on the Central Administration > Configure your
SharePoint farm page.
23. Select Use existing managed account then click Next.
24. The page to create a top-level website displays. Click Skip.
25. The Farm Configuration Wizard complete page appears. Click Finish.
26. On the Ektron server, copy C:\Program
Files\Ektron\CMS400
versionnumber\Utilities\SearchServer\EktronSearchConfiguration.exe.
27. On the Search Server Express server, paste and run EktronSearchConfiguration.exe
as an administrator. The Search Administrator Credentials screen appears.
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28. Enter the domain, username, and password of a user who is a member of the Windows
Administrator group on the Search Server Express server. Click Next.

29. Determine the location of the folder that maintains the Ektron query service files.

870

Ektron Reference

Setting Up Microsoft Search Server 2010

30. Select the port number to use with the Ektron query service website.

31. The following screen appears. Click Yes even though you are using Search Server
Express.

32. The Ektron Search Configuration files are installed and configured.
33. You are prompted to run the Ektron Search Configuration Utility. Click OK.
34. The InstallShield Wizard Complete dialog appears. Click Finish.
35. Run the Search Configuration utility on the Ektron server. For documentation of that
process, see Managing a Microsoft Search Server on page 925.

Setting Up Microsoft Search Server 2010
BEST PRACTICE
In general, do not install Microsoft Search Server 2010 on a server that also hosts
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Ektron. Only install both programs on the same server in a development environment.

Prerequisites
l

l

You have purchased and deployed Microsoft Search Server 2010. See also: Product
Licensing Search.
An understanding of Microsoft Search Server 2010, Best practices for Search Server
2010
Before beginning the installation, review these Microsoft documents.
o

Hardware and software requirements: https://technet.microsoft.com/enus/library/bb905370(v=office.14).aspx#BKMK_hw_reqs

o

User requirements: https://technet.microsoft.com/en-us/library/ff717834
(v=office.14).aspx

o

Installation of Microsoft Search Server 2010: https://technet.microsoft.com/enus/library/ee808898(v=office.14).aspx

l

Both servers can browse to each other across the network.

l

The search, SQL, and CMS servers must be on the same domain.

l

l

On your Microsoft Search Server 2010 server
o Create a Windows user for search purposes. The user should be
n a domain user
n

assigned the "log-on as a service" role

n

a member of the administrators group. That user must be logged in when
Microsoft Search Server 2010 is being installed.

o

Verify that the server meets the Optimizing Microsoft Search Server 2010 with
Ektron on page 880

o

Open port 6080 (used by the Protocol Handler Service)

On your Ektron server
o Open ports 6080 and 6081 (used by the CMS File Helper Service to communicate
Ektron services and copy files between the Web and Search servers)
o

Set SQL Security to SQL Server and Windows Authentication mode

o

Through SQL Management Studio, add the Windows login that you created on your
Microsoft Search Server 2010 server. Assign to that user
n db_creator role
n

securityadmin SQL role

Microsoft Search Server 2010 uses that login to access the Ektron database.

You should update your Ektron site's web.config file's
<connectionstrings> tag with the username and password of that SQL
user. Set Integrated Security to False. Then, log into Ektron to verify
that the connection string is valid. See also: Managing the web.config File on
page 67.
l
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On your database server
o Open Port 1433
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Microsoft Search Server 2010 Features
l

A configuration screen for connecting Ektron server with the server hosting Microsoft
Search Server 2010. That screen also monitors the status of search crawls.
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l

l

You can also manage search via SharePoint 2010's Central Administration console.

Workarea screens that let you
o view the status of search crawls
o

874

begin new ones if needed
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l

Create and maintain synonym sets

l

Create and maintain suggested results

l

Manage the Integrated Search

l

Templated controls let developers deploy search functionality to the website

l

Workarea search, which lets Ektron administrators and editors find content within the
Workarea

Ektron 8.7

875

Setting Up Search for Your Website

Installing Microsoft Search Server 2010
1. Log into the search server as the user created for search purposes. As explained in
Prerequisites on page 872, the user must be
l
a domain user
l
l

assigned the "log-on as a service" role
a member of the administrators group. That user must be logged in when Microsoft
Search Server 2010 is being installed.

2. Install Microsoft Search Server 2010.
NOTE: If your server has Windows 7, you must use Microsoft Search Server Express 2010. See
Setting Up Microsoft Search Server 2010 Express on page 864.
3. Install or upgrade Ektron on its server, using the normal procedure. See Installing
Ektron on page 9, Upgrading to Version 8.7 on page 35. If you already installed Ektron,
skip to Step 6.
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4. During the Ektron installation, choose Microsoft Search Server 2010 (Full).

5. After the Ektron database setup, the following dialog appears. Click No.
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The Ektron installation completes.
6. On the Ektron server, copy C:\Program
Files\Ektron\CMS400
versionnumber\Utilities\SearchServer\EktronSearchConfiguration.exe.
7. Log onto the Microsoft Search Server 2010 server as the same user who ran the Search
Server 2010 Install.
8. On the Microsoft Search Server 2010 server, paste and run
EktronSearchConfiguration.exe. The Search Administrator Credentials screen
appears.
9. Enter the domain, username, and password of a user with Windows Administrator
privileges on the server you will use for Microsoft Search Server 2010.
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10. Determine the location of the folder that maintains the Ektron query service files.

11. Select the port number to use with the Ektron query service website.

12. The following screen appears. Click Yes if you are using Microsoft Search Server 2010.
Click No if you are using Microsoft FAST Search Server 2010
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13. The Ektron files are installed and configured. A message instructs you to run the Search
Configuration utility on the Ektron server. For documentation of that process, see
Managing a Microsoft Search Server on page 925.
During installation, Ektron creates a new website in IIS to host the search services.

Optimizing Microsoft Search Server 2010 with Ektron
After installing Microsoft Search Server 2010, you can do several things to optimize Ektron's
use of that technology. These actions ensure you are doing everything possible to help site
visitors find Ektron content.
l

l

l

You want Ektron to search text within Visio files. See Installing the Visio IFilter on
page 943.
You want Ektron to search aliased pages, and their extension is not one of Search
Server's standard file types. See Defining Unusual File Extensions Used in Aliasing on
the facing page.
The crawl is taking a long time and your website has over 1 gigabyte of assets, and over
100 PDFs. Install Foxit PDF Filter from Foxit® PDF IFilter - Server.
After installing, update the registry:
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[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office
Server\14.0\Search\Setup\Filters\.pdf] "Extension"=".pdf"
"FileTypeBucket"=dword:00000001
"MimeTypes"="application/pdf"
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
Office Server\14.0\Search\Setup\ContentIndexCommon\Filters\Extension\.pdf]
@="{987f8d1a-26e6-4554-b007-6b20e2680632}"

See Also: Index and Search PDF Files in SharePoint Server 2010
l

Either the crawl or the response time for search queries is too slow. See Setting Up
Microsoft Search Server 2010 on page 871.

Defining Unusual File Extensions Used in Aliasing
Ektron's Aliasing feature lets you create human-readable URLs, such as
www.ektron.com/support. The URL Aliasing Configuration screen lets you define file types
that may be applied to aliased pages. See Also: Creating User-Friendly URLs with Aliasing on
page 835
If you define an aliasing file type that is not on Search Server's file type list, you must add
the missing type to Search Server. Follow these steps to accomplish that.
1. Go to Windows Start button > All Programs > Microsoft Search Server > Search
Administration.
2. Click File Types (as illustrated in the following figure).

3. Review the Search Server's file type list.
4. If you do not see all extensions defined on the URL Aliasing Configuration screen, click
New File Type (shown in the previous image), then add the missing file types.

Windows Services Used by Microsoft Search Server
2010
Ektron's search feature uses several Windows services to monitor database updates,
determine if a new crawl needs to be launched, and perform the database crawl. This section
explains the operation of these services.
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l

l

l

Ektron Search Server Service
o Runs on search server and Ektron site server.
o

Responsible for communicating between servers. It triggers search tasks such as
crawling, synonym sets, and so on.

o

Whenever content is added, updated or deleted, this service changes the Search
Status screen's Incremental Crawl Request Pending flag to Yes. As a result,
the next time the crawl interval is reached, this service launches the Ektron CMS
File Helper Service. See Also: Managing a Microsoft Search Server on page 925

Ektron ProtocolHandler File Helper Service
o Uses protocolhandler.dll file
o

Runs on Ektron server during a crawl

o

Gets content updates from database server and feeds them to Search Server

Ektron CMSFileHelper Service
o Runs on Ektron site server
o

l

Indexes assets and sends them to Ektron ProtocolHandler File Helper Service

Ektron Query Service—Passes search term from Ektron server to Microsoft Search
Server 2010 and returns results

How Services Process Content Updates
1. As Ektron content is added, changed or deleted, the Ektron database is updated.
NOTE: To learn about which events trigger a crawl, see Full vs. Incremental Crawls on page 931.
2. If the change warrants a full crawl, it is launched immediately.
3. If the change warrants an incremental crawl, the Ektron Search Server Service updates
the flag that determines if a crawl needs to be started to Yes. You can view this flag on
the Search Status screen's Incremental Crawl Request Pending field. When the
crawl interval expires, the Ektron CMS File Helper Service sends content updates to the
Ektron Protocol Handler Service.
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4. The Ektron Protocol Handler Service feeds the content updates to Search Server.

How Queries are Processed
Querying is the process by which Ektron retrieves content from the search index.
The Ektron site uses Ektron's Query Service to connect to Microsoft Search Server 2010.

Default Settings for Managed Properties Created by Ektron
Ektron 8.7
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When Ektron content is crawled by Microsoft Search Server 2010, the following default values
are set for these metadata properties. You can edit the values using the Microsoft Search
Server 2010 Central Administration console.
l

Queryable—True

l

StemmingEnabled—False

l

RefinementEnabled—False

l

MergeCrawledProperties—True

l

SubstringEnabled—False

l

DeleteDisallowed—False

l

MappingDisallowed—False

l

MaxIndexSize—1024

l

MaxResultSize—64

l

DecimalPlaces—10

l

SortableType—SortableEnabled

l

SummaryType—Static

Monitoring Microsoft Search Server 2010 from the
Workarea
Use the Search Status screen to monitor information about search crawls. You can also launch
an incremental or full crawl from the screen. See Also: Managing the Search Crawl on
page 931
PREREQUISITE
You are a member of the Administrators group or assigned to the Search Admin role.
1. Choose Workarea > Settings >Configuration > Search > Status. The Search
Status screen appears.

l
l

l
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Search server—The Search Server instance that hosts your search index.
Content source name—The Search Server content source that identifies your
website.
Query credentials—The Windows user authorized to communicate with the query
service.
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l

l

l

l

l

l

Incremental Crawl Request Pending—Yes appears if there is a pending
request to begin an incremental crawl. See Also: Managing a Microsoft Search
Server on page 925. Otherwise, No.
Current and Next scheduled search action—at any time, there may be an
action that will start when the current one completes. There is never more than
one.
o Idle—Search Server is taking no action.
o

None—(appears for Next Action only) Nothing is scheduled to occur when
the current action completes.

o

Incremental Crawl—Search Server is performing a crawl of content that
changed since the last crawl.See Also: Full vs. Incremental Crawls on
page 931

o

Full Crawl (Property Discovery)—Search Server is performing a crawl of
Ektron content, looking for new searchable properties.

o

Full Crawl—Search Server is performing a crawl of all content.

o

Property Mapping—Search Server is mapping searchable properties that
were found.

Most recent start and end times—When the most recent crawl began and
ended.
Duration (last if no crawl currently running; current if crawl currently running)—
If last, the length of time (in seconds) required to complete the most recent crawl.
If current, the length of time (in seconds) since the current crawl began. Click the
Refresh button ( ) to get the latest information.
incremental crawl interval—See Also: Setting the Incremental Crawl Interval
on page 931
Crawl filters—See Managing the Search Crawl on page 931.

2. If you want to launch a crawl from the toolbar:
l
click (
) to launch an incremental crawl (note black color)
l

click (

) to launch a full crawl (note blue color)

Setting Up a Load-Balanced Search with Microsoft
Search Server 2010
You can use load balancing to distribute your search's workload across multiple servers. Load
balancing improves search's performance by significantly decreasing the time to complete
search crawls and process search queries (especially when the site is under a heavy load).
This section describes 2 scenarios for setting up Load Balanced search.
l

l

You already installed Microsoft Search Server 2010 on one server, and now want to bring
additional servers into the cluster—see Adding a Site to a Server that Hosts Microsoft
Search Server 2010 and Ektron below
You have not yet installed Microsoft Search Server 2010—see Installing Microsoft Search
Server 2010 to a Primary Server in a Load Balance Cluster on page 887

Adding a Site to a Server that Hosts Microsoft Search
Ektron 8.7
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Server 2010 and Ektron
1. On the Ektron server, run the Site Setup utility: Windows Start button > Programs >
Ektron >version> Utilities > CMS400 Site Setup. See Also: Installing a Site on
page 17
2. During the Ektron installation, you are prompted to choose a search provider. Choose
Microsoft Search Server 2010 Full.

3. The setup continues as normal. After the installation is complete, the following dialog
appears. Click Yes.
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Installing Microsoft Search Server 2010 to a Primary

The Search Configuration screen appears. For documentation of that process, see
Managing a Microsoft Search Server on page 925

Installing Microsoft Search Server 2010 to a Primary Server
in a Load Balance Cluster
Use this procedure if you have not installed Microsoft Search Server 2010 on the primary
server in a Load Balance cluster.
PREREQUISITE
See Hardware and software requirements (Search Server 2010).
1. Obtain, download, and install Microsoft Search Server 2010.
NOTE: You may be informed that you need to run the Products Preparation Tool before beginning
the installation.
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2. Choose Server Farm when you are prompted for an installation type.

3. On the Server Type tab, select Complete then click Install Now. Search server is
installed.

4. Run the Configuration Wizard, which lets you set up Microsoft Search Server 2010. The
SharePoint Configuration Wizard is launched.
5. Choose Create a new server farm on the Connect to a server farm screen.

6. Specify a database server, name, and user name and password for access to the
account.
a. For Database name, accept the default of SharePoint_Config.
b. Enter a Username and Password of a SQL user with the sysadmin role. Microsoft
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Installing Microsoft Search Server 2010 to a Primary

Search Server 2010 uses them to access your Ektron database. Click Next.

7. Enter a password for access to the server farm.

8. Enter a port number and Security settings. You may enter any open http port. For
Security Settings, choose NTLM.
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9. Click OK to confirm the information you entered.
10. Click Finish to launch the SharePoint Central Administration site to allow for additional
configuration and provisioning. Noted that the first installation in a farm does not create
a Web application or provision a site. See Also: SharePoint 2010 Central Administration.
The following screen appears within SharePoint.

11. Click Start the Wizard and complete the wizard.

Adding Servers to a Load Balance Cluster
PREREQUISITE
You need 2 servers running Microsoft Search Server 2010; the servers cannot use
Search Server Express.
See Hardware and software requirements (Search Server 2010)

890

Ektron Reference

Part 1: Install Microsoft Search Server 2010

When setting up search load balancing, you need to decide which server is the primary one,
and which is/are the secondary one(s). This procedure describes how to set up a single
secondary server in a load balanced cluster. To set up additional secondary servers, follow
these instructions for each secondary server. See Also: Installing Microsoft Search Server
2010 to a Primary Server in a Load Balance Cluster on page 887

Part 1: Install Microsoft Search Server 2010
1. Obtain, download, and begin to install Microsoft Search Server 2010.
NOTE: You may be informed that you need to run the Products Preparation Tool before beginning
the installation.
2. For an installation type, choose Server Farm.

3. On the Server Type tab, select Complete then click Install Now.

Search server is installed.
4. Run the Configuration Wizard, which lets you set up Microsoft Search Server 2010. The
SharePoint Configuration Wizard is launched.
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5. On the Connect to a server farm screen, choose Connect to an existing server farm.

6. On the Specify Configuration Database Settings screen, in the Database server field,
enter the primary server in the load balance cluster.
7. Click Retrieve Database Names. The primary server's database appears in the
Database name field.

8. Enter the same passphrase that you entered when setting up the primary server. See
Also: Installing Microsoft Search Server 2010 to a Primary Server in a Load Balance
Cluster on page 887
9. Complete the remaining prompts; the wizard uses information to configure Microsoft
Search Server 2010.

Part 2: Set up Query Components
In this procedure, you create 2 query components. One defines this secondary server as a
failover server, which takes over processing if the primary server goes offline. The second
query component distributes the processing of search queries among search servers.
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Part 2: Set up Query Components

1. Open Microsoft Search Server 2010's Central Administration screen.

2. Click Manage service applications (highlighted). The Service Applications screen
appears.
3. Click Search Service Application 1. The Search Service Application 1: Search
Administration screen appears.
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4. Scroll down to Search Application Topology and click Modify (highlighted).

5. To set up the failover server, under Index partition 0, click Query Component, then
Add Mirror.
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Part 2: Set up Query Components

6. Use the following information to complete the Add Mirror Query Component screen.
l
Server—Enter the server to which you are currently signed on.
l

l
l

Associated Property database—Select the primary server and the database you
specified in Step 4.
Location of Index—Accept the default.
Failover-only Query Component—Ektron recommends checking this box. If you
do, when the primary search server goes offline, the secondary server processes
all search queries until the primary server returns.

7. The Search Service Application 1: Search Administration screen reappears. Click Apply
Topology Changes.
The secondary server now appears under Index Partition (highlighted).
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8. Set up a query component to distribute the workload of handling search queries. To do
that, from the Search Application Topology area, click New > Index Partition and
Query Component.

9. The Add Query Component Screen appears. Complete Setting Up Microsoft Search
Server 2010 on page 871, but this time do not check the Failover-only Query
Component box.

10. The Search Service Application 1: Search Administration screen reappears. Click Apply
Topology Changes.
11. To do that, from the Search Application Topology area, click New > Crawl
Component.
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Part 2: Set up Query Components

12. Specify the fields when the Add Crawl Component screen appears.

l
l

l

Server—Enter the server to which you are currently signed on.
Associated Crawl database—Select the primary server and the database you
specified in Step 4.
Temporary Location of Index—Accept the default.

13. The secondary server appears under Crawl (highlighted).
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14. Close Search Server Administration.
NOTE: You only need to follow the next 2 steps once. So, if you are setting up multiple secondary
servers, you can skip these 2 steps after setting up the first one.
15. On the Ektron server, copy C:\Program
Files\Ektron\CMS400
versionnumber\Utilities\SearchServer\EktronSearchConfiguration.exe.
16. On both search servers, paste EktronSearchConfiguration.exe and run it.
17. On your Ektron Web server, open the Search Configuration screen, available from
C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SearchServer\Ektron.Cms.Search.Config.UI
.exe.
18. Click Advanced Options.
19. In the Secondary Search Servers section, click Add (
secondary server(s).

20. Click Register Site.
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) then insert the name of the

Setting Up a Microsoft FAST Search

Setting Up a Microsoft FAST Search
You have the following advantages with Microsoft FAST Search:
l

l
l

l

Profile ranking, which forces topics to the top of search results—See Managing Rank
Profiles on page 920
Faceted searching—See Using Faceted Search on page 916
Documentation promotion—See Add, remove and display document promotions for a
keyword by using Windows PowerShell (FAST Search Server 2010 for SharePoint) and
Add document promotions.
o Supported for CMS content
o

Entirely configured within SharePoint/FAST

o

No explicit API or templated control support required

High degree of relevant results/Similar Results—See Improving Relevance for FAST
Search Server 2010 for SharePoint and Find Similar (FAST Search Server 2010 for
SharePoint)
o Supported for CMS content
o

No configuration required

o

Support exists within the API and templated controls to add this to search criteria.

PREREQUISITES
You purchased and deployed Microsoft FAST Search Server 2010 and SharePoint
Server 2010. See Also: Licensing Q&A: Determining Your Licensing Needs, Product
Licensing Search
Configuring Ektron to work with Microsoft FAST Search Server 2010 and SharePoint Server
2010 involves the following major tasks.
l
l

l

l
l

Part 1: Install SharePoint 2010 and Microsoft FAST Search Server 2010 below
Part 2: Set up Microsoft FAST Search Server 2010 for SharePoint 2010 Search on the
next page
Part 3: Enable Querying from SharePoint to Microsoft FAST Search Server 2010 on
page 906
Part 4: Enable Indexing of Additional Formats on page 908
Part 5: Verify that Microsoft FAST Search Server 2010 can Communicate with SharePoint
2010 on page 909

l

Part 6: Set up Ektron to Work with Microsoft FAST Search Server 2010 on page 911

l

Part 7: Make FAST SharePoint’s Query Search Application on page 914

After you complete the tasks...
l

the FAST service is configured to crawl the Ektron site.

l

Ektron events that affect content trigger a FAST crawl.

l

Ektron templated search controls can execute FAST queries to retrieve search results.

Part 1: Install SharePoint 2010 and Microsoft FAST
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Search Server 2010
1. Install SharePoint 2010 and Microsoft FAST Search Server 2010, each on its own server,
on the same domain. Please refer to Microsoft's installation documentation for details.
NOTE: When installing Microsoft FAST Search Server 2010, you are prompted to enter a certificate
password. Note this password, because you need it in Part 2c: Set up SSL-Enabled Communication
on page 903.
2. Create 2 domain user accounts: one for Microsoft FAST Search Server 2010 and one for
SharePoint 2010.
3. Add the SharePoint site administrator to the Microsoft FAST Search Server 2010
administrators group (located on the Microsoft FAST Search Server 2010 server).

Part 2: Set up Microsoft FAST Search Server 2010 for
SharePoint 2010 Search
Follow the steps below to set up Microsoft FAST Search Server 2010. You need to create 2
Search Service Applications.
l
l

FAST Search Connector—for crawling content.
FAST Search Query—for accepting search terms, querying the database, and returning
results.

In this section, you complete these tasks.
l
l

Part 2a: Create a Collection for the Content Source below
Part 2b: Create a FAST Search Connector Service Application for Crawling Content on the
facing page

l

Part 2c: Set up SSL-Enabled Communication on page 903

l

Part 2d: Create a Search Service Application for Querying on page 904

Part 2a: Create a Collection for the Content Source
Before creating the FAST Search Connector, create a collection for the Ektron content source.
The collection lets you clear only Ektron content from the index. To learn more, see Manage
content collections (FAST Search Server 2010 for SharePoint).
1. On the Microsoft FAST Search Server 2010 server, go to Start > All Programs.
2. Right click Microsoft FAST Search Server 2010 for SharePoint and click Run as
Administrator. A PowerShell window for managing Microsoft FAST Search Server 2010
appears.
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Part 2b: Create a FAST Search Connector Service

3. Enter the following command:
New-FastSearchContentCollection –Name ektroncms –Pipeline ”Office14
(webcluster)”
NOTE: * The Name is the new collection name.
* Surround the Pipeline name in quotes (as shown above).
* Surround webcluster with curly brackets ().
* See Also: New-FASTSearchContentCollection

Part 2b: Create a FAST Search Connector Service
Application for Crawling Content
1. Open SharePoint 2010 Central Administration home page.
2. Under Application Management, click Manage Service Applications.
3. On the Manage Service Applications page, click New > Search Service Application.

4. Complete the screen.
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l

Name—Enter a unique name for this application.

l

Fast Service Application—Select Fast Search Connector.

l

l

l

902

Search Service Account—Click Register new managed account to create a
new account for this search service.
Application Pool for Search Admin Web Service—Select Create new
application pool and enter a name. Under Select a security account, select
Configurable and select the account under which the SharePoint search service is
running. You created this account in Part 1: Install SharePoint 2010 and Microsoft
FAST Search Server 2010 on page 899.
Content Distributors—On the Microsoft FAST Search Server 2010 server, open
the %FASTSEARCH%\Install_Info.txt file. Copy the value of Content
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Part 2c: Set up SSL-Enabled Communication

Distributors (for GUI SSA creation) to this field.
===============================================================
FASTSearch: Installation Details
===============================================================
--------------------------------------------------------------FAST Search Query Search Service Application configuration
--------------------------------------------------------------Query Service Location HTTP (default):
http://ektsqa20.fsqa.ektron.com:13287
Query Service Location HTTPS:
https://ektsqa20.fsqa.ektron.com:13286
Administration Service Location HTTP (default):
http://ektsqa20.fsqa.ektron.com:13257
Administration Service Location HTTPS:
https://ektsqa20.fsqa.ektron.com:1325
8Resource Store Location:
http://ektsqa20.fsqa.ektron.com:13255
Account for Administration Service:
fsqa\fsuser
--------------------------------------------------------------FAST Search Content Search Service Application configuration
--------------------------------------------------------------Content Distributors (for PowerShell SSA creation):
ektsqa20.fsqa.ektron.com:13391
Content Distributors (for GUI SSA creation):
ektsqa20.fsqa.ektron.com:13391
Default Content Collection Name: sp
--------------------------------------------------------------Other services.....

NOTE: Keep the Install_Info.txt file open—you need it in Part 2d: Create a Search
Service Application for Querying on the next page.
l

Content Collection Name—Enter the name you entered for the Name parameter
in Part 2a: Create a Collection for the Content Source on page 900.

Part 2c: Set up SSL-Enabled Communication
To authorize SSL communication between SharePoint 2010 and Microsoft FAST Search Server
2010: Source: Create and set up the Content Search Service Application (FAST Search Server
2010 for SharePoint)
PREREQUISITE
You will need the password you supplied when setting up Microsoft FAST Search
Server 2010.
1. Log on to the Microsoft FAST Search Server 2010 server.
2. Open \FASTSearch\installer\scripts.
3. Copy securefastsearchconnector.ps1 to any folder on the SharePoint server.
4. Open \FASTSearch\data\data_security\cert.
5. Copy FASTSearchCert.pfx to any folder on the SharePoint server.
6. Log onto the SharePoint server.
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7. Open a Microsoft SharePoint 2010 Management Shell using Start >All Programs >
Microsoft SharePoint 2010 Products.
8. Right click SharePoint 2010 Management Shell and click Run as Administrator.
9. Navigate to the directory to which you copied the securefastsearchconnector.ps1 script
in Step 3.
10. Run the script, replacing parameters with your environment's values. For example:
.\SecureFASTSearchConnector.ps1
–certPath "path of the certificate\FASTSearchCert.pfx"
–ssaName "name of your content SSA"
–username “domain\username”

Replace the following parameter values:
l
l

l

certPath—the folder path to which you copied the certificate in Step 5.
ssaName—enter the Name you assigned to your FAST Search Connector service
application in Part 2b: Create a FAST Search Connector Service Application for
Crawling Content on page 901.
username—enter the domain and username under which the SharePoint 2010
service runs. You set up this account in Part 1: Install SharePoint 2010 and
Microsoft FAST Search Server 2010 on page 899.

11. When prompted to enter a certificate password, enter the password you supplied when
you ran the post-setup configuration of Microsoft FAST Search Server 2010.

Part 2d: Create a Search Service Application for Querying
(Source: Create and set up the Query Search Service Application (FAST Search Server 2010
for SharePoint))
1. Open the SharePoint 2010 Central Administration home page.
2. Under Application Management, click Manage Service Applications.
3. On the Manage Service Applications page, click New > Search Service Application.
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Part 2d: Create a Search Service Application for

4. Complete the screen.

l

Name—Enter a unique name for this application.

l

Fast Service Application—Select Fast Search Query.

l

l

Search Service Account—Click Register new managed account to create a
new account for this search service.
Application Pool for Search Admin Web Service—Select Create new
application pool and enter a name, such as EktQueryAdmin. Under Select a
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security account, select Configurable and select the account under which the
SharePoint search service is running. The application pool must run in the context of
a FAST Search administrator.
l

l

Application Pool for Search Query and Site Settings Web Service—Select
Create new application pool and enter a name, such as EktQuerySettings.
Under Select a security account, select Configurable and select the account
under which the SharePoint search service is running.The application pool must run
in the context of a FAST Search administrator.
Query Service Location—Open the %FASTSEARCH%\Install_Info.txt file to
obtain the value for this field. (See example below.) Use the HTTPS value if you
want to use secure communications between the SharePoint 2011 and Microsoft
FAST Search Server 2010 servers.
===============================================================
FASTSearch: Installation Details
===============================================================
--------------------------------------------------------------FAST Search Query Search Service Application configuration
--------------------------------------------------------------Query Service Location HTTP (default):
http://ektsqa20.fsqa.ektron.com:13287
Query Service Location HTTPS:
https://ektsqa20.fsqa.ektron.com:13286
Administration Service Location HTTP (default):
http://ektsqa20.fsqa.ektron.com:13257
Administration Service Location HTTPS:
https://ektsqa20.fsqa.ektron.com:13258
Resource Store Location:
http://ektsqa20.fsqa.ektron.com:13255
Account for Administration Service:
fsqa\fsuser
--------------------------------------------------------------FAST Search Content Search Service Application configuration
--------------------------------------------------------------Content Distri.......
---------------------------------------------------------------

l

l

l

Administration Service Location—Obtain the value for this field from
%FASTSEARCH%\Install_Info.txt. (See example above.) Use the HTTPS value if
you want to use secure communications between the SharePoint 2011 and Microsoft
FAST Search Server 2010 servers.
Resource Store Location—Obtain the value for this field from
%FASTSEARCH%\Install_Info.txt. (See example above.)
Account for Administration Service—specify a domain account for a user who
is a member of the FAST Search Administrators group on the Microsoft FAST Search
Server 2010 server.

5. You see a confirmation that a new Query Search service application is created.

Part 3: Enable Querying from SharePoint to Microsoft
FAST Search Server 2010
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Part 3: Enable Querying from SharePoint to

Part 3 describes how to transfer a Microsoft FAST Search Server 2010 STS certificate (MOSS_
STS) from SharePoint Server 2010 to FAST servers. This certificate enables SharePoint query
servers to provide security-trimmed queries. See Also: Enable queries from Microsoft
SharePoint Server (FAST Search Server 2010 for SharePoint)
PREREQUISITE
You will need a SharePoint Server 2010 directory that is accessible to Microsoft FAST
Search Server 2010 servers.
1. On the Microsoft FAST Search Server 2010 server, go to Start > All Programs.
2. Right click Microsoft FAST Search Server 2010 for SharePoint and click Run as
Administrator. A PowerShell window for managing Microsoft FAST Search Server 2010
appears.
3. At the Windows PowerShell command prompt, enter the following commands.
$stsCert = (Get-SPSecurityTokenServiceConfig)
.LocalLoginProvider.SigningCertificate
$stsCert.Export("cert") | Set-Content -encoding byte MOSS_STS.cer

4. The MOSS_STS.cer file is created in the directory in which you run the commands.
5. Copy MOSS_STS.cer to a directory accessible to the Microsoft FAST Search Server 2010
server(s).
6. Import the SharePoint STS certificate to each Microsoft FAST Search Server 2010
server. To do that:
a. On the Microsoft FAST Search Server 2010 server, click Start >All Programs >
Microsoft FAST Search Server 2010 for SharePoint.
b. Right click Microsoft FAST Search Server 2010 for SharePoint and select Run
as administrator.
c. At the Windows PowerShell command prompt, browse to
<FASTSearchFolder>\installer\scripts\, where <FASTSearchFolder> is the
path to the Microsoft FAST Search Server 2010 folder. For example,
C:\FASTSearch\installer\scripts\.
d. Enter the following command:
.\InstallSTSCertificateForClaims.ps1
-certPath <"full path of MOSS STS certificate">

Where full path of MOSS STS certificate is the path to the location to which
you copied the MOSS_STS.cer file in Step 5.
7. Repeat steps 6a through 6d for all query servers (if you have more than one).
8. Within the PowerShell window, check the status of FAST services by entering the
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following command: nctrlstatus. The results should look something like this.

Part 4: Enable Indexing of Additional Formats
Advanced Filter Pack is a Microsoft FAST Search Server 2010 feature that enables text and
metadata extraction from several hundred file formats (such as PDF), complementing the
document formats supported by the Microsoft Filter Pack.
PREREQUISITE
Install 1 of the following PDF filters on the Microsoft FAST Search Server 2010 server:
l

l

Foxit PDF filter (Foxit® PDF IFilter - Server—recommended if you will index a
large number of PDF files)
Adobe 64-bit PDF iFilter (installed on Ektron server C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\iFilterPack)

1. On the Microsoft FAST Search Server 2010 server, go to Start > All Programs.
2. Right click Microsoft FAST Search Server 2010 for SharePoint and click Run as
Administrator. A PowerShell window for managing Microsoft FAST Search Server 2010
appears.
3. Navigate to the [FASTSEARCH] folder (represented by the environment variable
%FASTSEARCH%).
4. Move to the installer\scripts folder using this command: cd
.\installer\scripts.
5. Insert the command .\AdvancedFilterPack.ps1 –enable.
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Part 5: Verify that Microsoft FAST Search Server

6. When you see Are you sure you want to continue, enter Y.

7. Open the file %FASTSEARCH%\etc\config_
data\DocumentProcessor\formatdetector\user_converter_rules.xml.
8. Enable PDF format detection by adding the text in red below.
<ConverterRules>
<IFilter>
<trust>
<!-- A list of extensions that bypasses the builtin format detection.
Any extension that is not supported out-of-the-box, need to be
added here along with the mimetype if you have installed an IFilter
for that type and want to use it. A mime element should also be
added to the MimeMapping element with a human-friendly description
of the type.
<ext name=".xxx" mimetype="application/xxx" />
<ext name=".yyy" mimetype="image/yyy" /> -->
<ext name=".pdf" mimetype="application/pdf" />
</trust>
</IFilter>
<MimeMapping>
<!-- A mapping between mime types and the description of them.
<mime type="application/xxx">XXX Document</mime>
<mime type="application/postscript">YYY Image</mime> -->
<mime type="application/pdf">PDF Document</mime>
</MimeMapping>
</ConverterRules>

IMPORTANT: Back this file up in a safe location, so that you can re-enter these changes if you later
need to apply a FAST service pack, patch, or hotfix.
9. Stop the FAST service by going to Windows Services, find FAST Search for
SharePoint, and click Stop.
10. Restart the Microsoft FAST Search Server 2010 server.

Part 5: Verify that Microsoft FAST Search Server 2010
can Communicate with SharePoint 2010
1. On the SharePoint 2010 Central Administration Screen, go to Application
Management>Create Site Collections. The Create Site Collection screen appears.
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2. Enter a Title, Description, and URL, assigning any name.
3. In the Template Selection area, click the Enterprise tab then select FAST Search
Center.
4. In the User name field, enter the name of the SharePoint user you created in Part 1:
Install SharePoint 2010 and Microsoft FAST Search Server 2010 on page 899.
5. Click OK to create a site collection.
6. On the SharePoint 2010 server, create a new folder and share it with the Microsoft FAST
Search Server 2010 user that you created in Part 1: Install SharePoint 2010 and
Microsoft FAST Search Server 2010 on page 899.
7. On the folder's Security tab, grant the Microsoft FAST Search Server 2010 user full
control.
8. Drag and drop a few text files into that folder. If you enabled PDF support (as explained
in Part 4: Enable Indexing of Additional Formats on page 908), drop some PDFs.
9. Create a Content Source for the folder. To do this:
a. On the SharePoint 2010 Central Administration screen, click Manage service
applications.
b. Click the Ektron content service application you created in Part 2b: Create a FAST
Search Connector Service Application for Crawling Content on page 901.
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Part 6: Set up Ektron to Work with Microsoft FAST

c. On the Search Administration screen, under Crawling, click Content Sources.

d. On the New Content Source screen:
o Enter a Name.
o

For Content Source Type, select File Shares.

o

For Start Addresses, enter the folder that you created in Step 6.

o

For Crawl Settings, select Crawl the folder and all subfolders of each
start address.

o

Check the Start full crawl of this content source box.

o

Click OK.

10. Verify that the search works by navigating to the FAST search site and searching for
content in the test folder you indexed. If correct results are returned, Microsoft FAST
Search Server 2010is configured correctly. If not, or if you see errors in the Crawl Log,
there is a configuration issue with your setup.

Part 6: Set up Ektron to Work with Microsoft FAST
Search Server 2010
Install Ektron, setting it up for your environment. When prompted to select a search provider,
choose Microsoft FAST Search Server 2010. When prompted to connect the site to a Microsoft
Search Server 2010 instance, click No. Complete the Ektron installation. See Also: Installing
Ektron on page 9
In this section, you complete these additional tasks.
l

Part 6a: Set up the Ektron Search Connection on the SharePoint Server on the next page

l

Part 6b: Set Credentials for the Ektron Search Server Service on the next page

l

Part 6c: Run the Ektron Search Configuration Utility on page 913
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Part 6a: Set up the Ektron Search Connection on the
SharePoint Server
EktronSearchConfiguration.exe enables communications between your site and the FAST
search service.
1. From the Ektron server, copy the following file to any folder on the SharePoint server.
%SystemDrive%\Program Files (x86)\Ektron\Utilities\SearchServer
\EktronSearchConfiguration.exe

2. From the SharePoint folder, run the file.

Part 6b: Set Credentials for the Ektron Search Server
Service
1. On the SharePoint server, open the Windows Services control panel.
2. Right click Ektron Search Server Service.
3. Click Properties.
4. Select the Log On tab.

5. Select This account.
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Part 6c: Run the Ektron Search Configuration Utility

6. Enter the credentials of the user under whom the SharePoint Server Search service runs.
You created this user in Part 1: Install SharePoint 2010 and Microsoft FAST Search
Server 2010 on page 899.
7. Click OK.
8. Restart the Ektron Search Server Service.

Part 6c: Run the Ektron Search Configuration Utility
1. Log on to the Ektron server as an administrator.
2. Click the Windows Start menu > All Programs > Ektron >
CMS400vreleasenumber > Utilities > Search Config. The Step 1 configuration
screen appears.

3. Enter the Ektron server name.
4. Enter the SharePoint Administration URL. See Also: Managing a Microsoft Search Server
on page 925
5. Click Next. The Step 2 configuration screen appears.

6. At the Content Service Application field, select the application you created in Part 2b:
Create a FAST Search Connector Service Application for Crawling Content on page 901.
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7. At the Query Service Application field, select the application you created in Part 2d:
Create a Search Service Application for Querying on page 904.
8. Click Next. The Ektron Search Configuration screen appears. For documentation, see
Managing the Search Configuration on page 927.
9. When you complete the screen, click Register Site. Progress appears in a window.

During this process, the FAST search index is populated with your data, and the schema
is modified to include your site’s searchable properties. This process can be lengthy
when registering a site for the first time. You can monitor these activities in the
Workarea. See Also: Monitoring Microsoft Search Server 2010 from the Workarea on
page 884

Part 7: Make FAST SharePoint’s Query Search
Application
In this section, you complete these tasks.
l

Part 7a: Update web.config with Query Service Application below

l

Part 7b: Set FAST Search Query as Default Search Service Application below

Part 7a: Update web.config with Query Service Application
1. On the SharePoint server, navigate to %CommonProgramFiles%\Microsoft Shared\Web
Server Extensions\14\ISAPI\EktronWebService.
2. Open the web.config file.
3. Find the following entry: <add key="QuerySSA" value="FAST Query SSA" />
4. Replace the value property with the name of the Query Service application you entered
in Part 2d: Create a Search Service Application for Querying on page 904. To continue
that example, the line would look like this: <add key="QuerySSA" value="EktQuery"
/>
5. Restart the Ektron search site application pool. See Also: Start or Stop an Application
Pool (IIS 7)

Part 7b: Set FAST Search Query as Default Search Service
Application
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Making the Title Property Sortable

1. Open the SharePoint 2010 Central Administration Page.
2. Navigate to Application Management >Service Applications > Configure
service application associations.

3. Under Web Application, click SharePoint-80. The Configure Service Application
screen appears.
4. If EKTQUERYSSA is the default, exit the screen. Otherwise, click the Edit the
following group of connections pulldown and choose [custom]. The screen
refreshes and the check boxes are active.

5. Check EKTQUERYSSA[default] then click OK.

Making the Title Property Sortable
By default, the Title property is not sortable. To change it so that it is sortable, follow these
steps.
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1. Log into the Fast Central Administrator console.
2. Choose Manage Service App > Query Service Application > Fast Search
Administrator > Managed Properties.
3. Find the Title Managed Property.
4. Edit it and check the Sort property box.

IMPORTANT: When used to sort, the Title property follows an ASCII sort pattern. As a result, titles that
begin with a capital letter precede ones that begin with a lower case letter. For example:
Better Business Bureau
Tiramisu recipe
american foreign policy
See Also:
l
l

Enable a managed property as sort option by using Windows PowerShell
Make a managed property sort option available in the web front-end by using the
graphical user interface

Using Faceted Search
Facets are content properties that allow site visitors to filter search results. For example,
your site lists job postings. So, your search results page offers a Region facet, which visitors
use to select jobs within regions of interest.
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Faceted search has these limitations:
l

l

l

If the metadata definition type is integer or date, facet categories only appear if a
metadata value is assigned to 2 or more content items. For example, if the South region
was assigned to only one content item's metadata, South would not appear on the
facets list. However, the content would be returned in search results.
If the same metadata value is applied to all content, no facet categories appear. To
continue the above example, if all content to which the Regions metadata definition
may be applied have South for their value, no facets list appears.
The refiner count may be inaccurate if you are using duplicate removal. For more
information, see Refiner count is wrong when using duplicate removal.

This section explains how to implement faceted searching using Ektron and Microsoft FAST
Search Server 2010.

Creating Facets
1. Create searchable Ektron metadata definitions. See Also: Creating and Deploying a
Search Tag Definition on page 374.
IMPORTANT: Carefully plan capitalization, spelling, spacing, and so on of metadata definitions for
Faceted Search. Minor inconsistencies can result in duplicate entries, as shown below.

2. Apply metadata values to appropriate content.
3. Run a full crawl. The metadata become managed properties within Microsoft FAST
Search Server 2010.
4. Update search server controls to look for the metadata/managed property. They appear
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as selectors on your search results page.

Creating a Faceted Search
1. Create a metadata definition in the Workarea. See Working with Metadata on page 369.
This example uses a text metadata definition called region.
2. Apply the new metadata definition to a folder. See Assigning Metadata to a Folder on
page 377.
3. Within that folder, apply the new metadata definition to appropriate content. See Adding
Metadata to Content on page 379
4. Sign on to Microsoft FAST Search Server 2010.
5. Navigate to Search Central Administrator > Manage Service Applications >
click the query content source > Fast Search Administration > Managed
Properties.
6. In the Search field, enter emt followed by the metadata definition you created in Step
1. To continue the example, enter emtregion.
NOTE: You enter emt because this is a text-style metadata definition. Use these prefixes for other
styles.
Microsoft FAST Search Server 2010 prefixes for Ektron metadata definition styles:
l

Text, select from list, multiple selections—emt

l

Integer and number—emi

l

Boolean—emb

l

Date—emd

l

Double— emf

l

If the content is an XML Smart Form, use these prefixes instead:
o Text, select from list, multiple selections—est
o
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o

Boolean—esb

o

Date—esd

o

Double—esf

7. Click the metadata definition/managed property.

8. Scroll down to Refiner Property.
9. Check it and the Deep Refiner box.

10. Complete Steps 1 through 9 for all metadata definitions that you want to add.
11. Run a full crawl. See Managing a Microsoft Search Server on page 925.
12. To enable a search server control to display a metadata selector, modify the
SearchController control using a <Refiners> tag as shown. The tag references the
managed property name, emtregion in our example.
<ektron:SiteSearchController ID="controller" runat="server">
<Refiners>
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<ektron:Refiner Name="emtregion"/>
</Refiners>
</ektron:SiteSearchController>
<ektronUI:Pager runat="server" ResultsPerPage="50"
PageableControlID="controller" >
</ektronUI:Pager>

Here are sample search results. If you click a checkbox next to a region, the page
refreshes and displays only content to which that metadata property is applied.

Managing Rank Profiles
Microsoft FAST Search Server 2010 lets you adjust the rank of search results, enabling you to
control which content appears near the top. This feature is sometimes called "Advanced
Sorting." You typically use the Rank Profile feature when site visitors are not getting expected
search results. For example, your manage a university website and, when people enter
Admissions, the Admissions department page is not among the top search results. To fix
that, use a Rank Profile to force search results to the top.
See Also: Tune relevance factors (FAST Search Server 2010 for SharePoint), Manage rank
profiles (FAST Search Server 2010 for SharePoint), Ranking and Sorting (FAST Search Server
2010 for SharePoint)

Increasing the Search Rank of a Content Item
Here is an overview of how to increase the search rank for selected content.
1. Create a metadata definition to define searchable properties.
2. Apply metadata values to selected content. When the content is crawled, the metadata
values become managed properties in Microsoft FAST Search Server 2010.
3. Use Microsoft FAST Search Server 2010 to create a Rank Profile. While defining the
profile, you
l
list the metadata values/managed properties
l

modify the search rank of the managed properties, which in turn, modifies the
search rank of content to which they are applied

4. Update a search server control or the API to use the rank in the search results algorithm.

Part 1: Create Metadata Definitions
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Part 1: Create Metadata Definitions

To increase a content item's search rank, first create searchable Ektron metadata definitions.
They contain the content attribute by which site visitors will search. Then, apply those
metadata definitions to relevant folders and content.
NOTE: The process of creating and applying metadata is abbreviated here. For full details, see Creating
and Deploying a Search Tag Definition on page 374.
To continue the above example, create a searchable metadata definition named
Departments, of the type Select from a List. Add Admissions to the list of values. Then,
apply that metadata to all folders that contain relevant content.

Next, find Ektron content that describes your Admissions department. Edit that content, click
the Metadata tab, and apply the Admissions metadata to the content.
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Part 2: Create a Rank Profile
PREREQUISITE
The Microsoft FAST Search Server 2010 type and metadata value name you use to
increase the search rank. To continue the above example, use emtadmissions. For a
list of types, see Using Faceted Search on page 916.
NOTE: For more information on Index schema cmdlets, see Index schema cmdlets (FAST Search Server
2010 for SharePoint).
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Part 3: Incorporate the Rank Profile into the Search

To create a Rank Profile:
1. On the Microsoft FAST Search Server 2010 server, go to Start > All Programs.
2. Right click Microsoft FAST Search Server 2010 for SharePoint and click Run as
Administrator. A PowerShell window for managing Microsoft FAST Search Server 2010
appears.
3. Create and enter a name for the Rank Profile.
New-FASTSearchMetadataRankProfile
-name (your profile name)

4. Define the Microsoft FAST Search Server 2010 type and name of the metadata value
used to increase search rank.
$mp = Get-FASTSearchMetadataManagedProperty
-Name (your managed property)

5. Set a variable to your profile. This is typically the same as the name you entered in Step
3.
$rp = Get-FASTSearchMetadataRankProfile
-name (your profile name)

6. Add a managed property boost to your profile. The $mp command has 2 parameters:
l
string,int—the Microsoft FAST Search Server 2010 type and name of metadata
value whose search rank you want to increase
l

boost number—a relative value by which you want to increase the profile's search
rank. See Also: Change the managed property field boost weight by using Windows
PowerShell
$rp.CreateManagedPropertyBoostComponent($mp,
"<string/integer managed property value>,<boost number>)”)

Replace values within angle brackets (< >) with actual values.
7. Update your profile
$rp.Update()

Here’s an example:
New-FASTSearchMetadataRankProfile -name departments
$mp = Get-FASTSearchMetadataManagedProperty -Name emtadmissions
$rp = Get-FASTSearchMetadataRankProfile -name departments
$rp.CreateManagedPropertyBoostComponent($mp, "admissions,20000")
$rp.Update()

Part 3: Incorporate the Rank Profile into the Search Result Display
This section explains how to use a Rank Profile to modify search results, using either the
SiteSearchInputView server control or the API.
1. Add the rank to a Search server control:
Modify all SiteSearchInputView server controls that you want the ranking to modify. See
Also: Using Search Server Controls on page 971. To achieve that, use
<SortProperties> tags as shown below. Inside the tags, set these parameters.
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l

DisplayName—Enter any unique name to identify this profile.

l

RankId—Your profile name that you created on the FAST server.
<ektron:SiteSearchInputView ID="SiteSearchInputView1"
runat="server" ControllerID="SiteSearchController1">
<SortProperties>
<ektron:RankSearchProperty DisplayName="Custom Relevance"
RankId="departments" />
</SortProperties>
</ektron:SiteSearchInputView>

2. Add the rank using the API:
The following illustrates how to modify search results via the Rank Profile using the API.
criteria.OrderBy = new List<OrderData>()
{ new OrderData(new RankPropertyExpression("rank profile name"),
OrderDirection.Ascending) };

For example:
criteria.OrderBy = new List<OrderData>()
{ new OrderData(new RankPropertyExpression("departments"),
OrderDirection.Ascending) };

Removing a Boost
1. Set a variable to the profile. Use the same profile name that you used in Part 1: Install
SharePoint 2010 and Microsoft FAST Search Server 2010 on page 899.
$rp = Get-FASTSearchMetadataRankProfile -name (your profile name)

2. Set to a variable the Microsoft FAST Search Server 2010 type and name of the metadata
value used to increase search rank.
$mp = Get-FASTSearchMetadataManagedProperty
-name Name (your managed property)

3. Set a variable for the boost you want to delete.
The $_.BoostValue command has 2 parameters: string,int and boost number. Use
the same values you used when creating the Rank Profile. See Part 1: Install SharePoint
2010 and Microsoft FAST Search Server 2010 on page 899.
$boost1 = $rp.GetManagedPropertyBoosts()
| Where-Object{$_.BoostValue -like '*(string/int),(boost number)*'}

4. Delete the boost.
$boost1.Delete()

5. Update your profile.
$rp.Update()

Here’s an example:
$rp = Get-FASTSearchMetadataRankProfile -name departments
$mp = Get-FASTSearchMetadataManagedProperty -name emtadmissions
$boost1 = $rp.GetManagedPropertyBoosts()
| Where-Object{$_.BoostValue –like '*admissions,20000*'}
$boost1.Delete()
$rp.Update()

Viewing all Boosts
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Troubleshooting Boosts

Run this query: $rp.GetManagedPropertyBoosts()

Troubleshooting Boosts
l
l

Problem: The boost does not affect search results
Solution: Verify that the FreshnessResolution is set to second. See Also: Change the
freshness resolution and weight by using Windows PowerShell

Troubleshooting FAST
Problem: Documents are not being indexed.
Solution: Provide full control rights on the %FASTSEARCH%\bin and %FASTSEARCH%\tmp
folders for the user running Microsoft FAST Search Server 2010
More information: Crawling and processing Office documents with FAST for Sharepoint
2010 results in document conversion errors in the crawl log

Managing a Microsoft Search Server
The Search Configuration screen lets you manage the Ektron's implementation of a search
server.
IMPORTANT: Ektron‘s Search Configuration screen provides access to a few commonly-used features
of Microsoft’s Search Server. To fully use Search Server’s capabilities, use the SharePoint 2010 Central
Administration utility. Also, if you remove or edit Ektron website information using IIS, you must restart
the Ektron Windows Service before using the Search Server Configuration screen.

Before You Log into the Search Configuration Screen
l

Is the Ektron Search Server Service started?

l

For ports opened between the Ektronserver and the search server, are firewalls off?

l

Verify that the user entered during the Search Server installation is also the user running
these Windows services:
o SharePoint 2010 Timer
o

l

SharePoint Server Search 14

Verify that the user entered during the Search Server installation is also the user set in
the Advanced Settings > Identity field running these Application Pools:
o <GUID> (there may be more than one)
o

SecurityTokenServiceApplicationPool

o

SharePoint Central Administration v4
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Logging into Ektron's Search Server Configuration
Screen
1. Log on to Microsoft Search Server 2010 as an administrator.
2. Click the Windows Start menu > All Programs > Microsoft SharePoint 2010
Products > SharePoint 2010 Central Administration. The port number appears in
the browser address bar, following http://server name
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Managing the Search Configuration

3. Log onto the Ektron server as an administrator.
4. Click the Windows Start menu > All Programs > Ektron >
CMS400vreleasenumber> Utilities > Search Config. The Connection Information
screen appears.

5. In the CMS ServerMachine Name field, enter the Ektron server.
6. In the Search Server Administration URL field, enter http:// , your search server
name, colon(:), and port number (see Managing a Microsoft Search Server on page 925)
For example, http://MySearchServer:12345.
7. The Search Service Application screen appears. Select appropriate Content and Query
Service applications.

Ektron's Search Server Configuration screen appears.

Managing the Search Configuration
This section explains how to use the Search Configuration screen.
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When your Search Server configuration is properly set to connect to your Web server, the
following appears on the Search Configuration screen.

l

l

l
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CMS Database—shows information about Search Server's connections to your website.
o Site ID—The IIS site ID found on the Web server.
o

Database—The database that Search Server crawls.

o

Database Server—The name or IP address of the site's Web server.

o

Site URL—The URL that visitors use to view the website.

o

Version—The website's Ektron version.

CMS Database Connection String—Microsoft Search Server 2010 uses the
CMS Database Connection string to connect to your Ektron site's database. If the
database is on the same domain as your search server, set Integrated Security to
true. Otherwise, set Integrated Security to false and enter a SQL username and
password.
Crawl Interval—Set the incremental crawl interval.
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Updating the Site Registration Panel

l

l

Search Server Credentials—Enter the domain, username, and password of a user
with privileges to connect to the Microsoft Search Server 2010 server.
Advanced Options—See the following sections:
o Crawl Tracing—Use the drop-down to specify a level of detail collected by the
crawl log. A separate log is created for each crawl, and is saved to the Data
Directory.
o

Data Directory—Identify the folder on your Search Server that stores a copy of
Ektron content needed by Microsoft Search Server 2010. The directory also stores
protocol logs, which track crawl activity. The default value is
C:\EktronSearchData.

o

Secondary Search Servers—Use this area to add secondary search servers to a
load-balanced cluster. You would only do this on a primary server, to identify its
secondary servers. See Also: Setting Up a Load-Balanced Search with Microsoft
Search Server 2010 on page 885.
1. In the Secondary Search Servers section, click Add ( ).
2. Insert the name of the secondary servers.
3. Click Register Site.

Updating the Site Registration Panel
If you make changes to the Site Registration panel, you need to register the site again.
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1. Start the Search Configuration Utility. See Also: Logging into Ektron's Search Server
Configuration Screen on page 926
2. If the Ektron server has several databases, select one from the drop-down.

NOTE: If your Ektron version supports multi-site, the CMS Databases drop-down lists the multi-site
database only once. The site Url may correspond to the main site or any sub-site (depending on their
order in IIS).
3. In the Search Server Credentials area, enter the Domain, Username, and
Password for your Search Server.
4. Click Register Site. A confirmation window appears.
5. Click Yes. Progress appears in a window.

6. When finished, click Close.

Troubleshooting Site Registration
Error: Failed to connect to specified Search Server. Please verify that your Search Server
URL and port number are valid and try again.
Possible solution:
1. Open the Windows Services control panel.
2. Right-click Ektron Search Server Service.
3. Choose Properties from the context menu.
4. Select the Log On tab from the properties dialog window.
5. Select the radio button labeled This account.
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6. Enter the credentials to match those of the SharePoint Server Search 14 (OSearch14)
service.
7. Commit your changes.

Managing the Search Crawl
Crawling is the process of preparing index files for searching. When Ektron content is added,
deleted, or updated, a crawl makes that content available (or no longer available) to the
search. In general, Ektron manages the crawl automatically—you do not need to do anything.
This section explains the automatic crawl: what starts one, how to monitor its status, and so
on. In addition, if your search has a problem, you can run a manual crawl to troubleshoot it.

Full vs. Incremental Crawls
Microsoft Search Server 2010 supports 2 types of crawls.
l
l

Full—occurs immediately after events that significantly change data structure
Incremental—occurs after incremental crawl interval passes for less significant events
that still require a crawl

A full crawl registers searchable Ektron properties with the search provider and ensures that
search results reflect the latest information for all Ektron content. An example of a full-crawl
triggering event is the registration of a new site.
Other Ektron events trigger an incremental crawl, which is run when the specified time
interval passes. See Setting the Incremental Crawl Interval below. Typical incremental-crawl
triggering events include the creation of new content and the editing of existing content.
If you are using eSync, a sync can trigger a full or incremental crawl, depending on the data
being synched and the profile selected.

Setting the Incremental Crawl Interval
Use the Search Configuration Screen Site Registration panel's Interval field to define the
incremental crawl interval in seconds.
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Starting Crawls Manually
You should not need to start a crawl. Ektron initiates crawls as necessary. You would typically
begin a manual crawl for troubleshooting purposes.
PREREQUISITE
You are a member of the Administrators group or assigned to the Search-Adminrole.
l

l

To start an incremental crawl immediately, go to Workarea > Settings >
Configuration > Search > Status. Click Request Incremental Crawl.

To start a full crawl immediately, go to Workarea > Settings > Configuration >
Search > Status. Click Request Full Crawl.

Improving Search Performance with Crawl Filters
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Improving Search Performance with Crawl Filters

When you set up the connection to Microsoft Search Server, you determine the types of
content that will be crawled using the following screen.

If your crawl is taking too long, you might consider removing content types, especially those
you do not use. To update the list of crawled content types, use the Search Configuration
Screen's Site Registration panel > Advanced Options > Crawl Filters fields.
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The following list describes the content covered by each type of crawl filter.
HTML—Content blocks, forms, blogs, content-associated library items, completed Smart
Forms, calendar events.

l

Documents—Uploaded Office documents, PDFs, images, and so on. See Working with
Assets in the Document Management System on page 310

l

Products—eCommerce catalog entries. See Conducting eCommerce on page 1279

l

Forums—Discussion topics, replies, and so on. See Working with Discussion Boards on
page 536.

l

Community members—Community user and groups. See Managing Community
Groups on page 1181. Also, Ektron users and groups.

l

Community content—Community user and group photos, blogs, and so on.

l

l

NOTE: Metadata and tags are crawled regardless of the crawl filter settings. Also, changes to other
Ektron data objects result in the appropriate crawl, regardless of these settings. See Also: Full vs.
Incremental Crawls on page 931

Monitoring Crawls
934
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The Data Directory stores a log of information about each crawl. The logs are stored in the
Managing a Microsoft Search Server on page 925. The Search Configuration screen's
Managing a Microsoft Search Server on page 925 field lets you determine the amount of detail
you want the log to collect.
The following errors may appear in the crawl log.
l

l

Error—<url_path_to_asset>: The filtering was stopped because of a user action, such
as stopping the crawl
Problem—An asset is referenced in the Ektron database, but the physical file was
deleted from the file system.

The following screens also let you monitor and manage crawls.
l

l

Search Status screen in the Workarea. See Also: Monitoring Microsoft Search Server
2010 from the Workarea on page 884

Search Configuration Screen's Crawl Management panel

The following table compares the screens.

Options

How to access

Workarea's Search Status
screen

Search Configuration Screen

Workarea > Settings > Configuration > Search > Status

On server that hosts Search Server: Windows Start > All Programs > Ektron >
CMS400vreleasenumber> Utilities >
Search Config
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Options

Workarea's Search Status
screen
l

search server

l

content source name

l

query credentials

l

l

View crawl
information

if there is a pending request to
begin incremental search
current and next scheduled
search action See Also:
Monitoring Microsoft Search
Server 2010 from the Workarea
on page 884

l

most recent start and end times

l

duration

(last if no crawl currently running;
current if crawl currently running)
l

l

On Site Registration panel
l

Crawl IntervalSee Also: Setting the
Incremental Crawl Interval on
page 931

l

Crawl Filters

l

Crawl Tracing Level

On Crawl Management panel
l
l

content source name
crawl status (same as Current
Action on Search Status screen)

l

most recent start and end times

l

duration

crawl filters

Start full crawl
See Also:
Managing a
Microsoft
Search Server
on page 925

Not available

Start incremental crawl
See Also:
Managing a
Microsoft
Search Server
on page 925

Not available

Set incremental
crawl interval
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interval See Also: Setting the
Incremental Crawl Interval on
page 931

Search Configuration Screen
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View only

Site Registration panel > Crawl Interval
field
See Also: Setting the Incremental Crawl
Interval on page 931

Troubleshooting Crawl Errors

Options

Workarea's Search Status
screen

Set the type of
data that is
searched

View only

Search Configuration Screen

Site Registration panel > Advanced
Options > Crawl Filters

Troubleshooting Crawl Errors
The following information lists errors that may appears during a crawl, and how to resolve
them. Errors appear in Microsoft Search Server 2010's administration portal. They do not
appear in Ektron.
Condition—What happens if a crawl is running when a new one is scheduled to start?
l
If a crawl request is issued while a crawl is running, the new crawl will start only after
the current crawl completes.
l

A pending full crawl starts before any pending incremental crawls.

Problem—A content block based on a Smart Form has a blank content_html field. An error
occurs: Exception from HRESULT: 0xC00CEE2D
Solution—Remove the field or insert content into it.
Problem—The crawl is taking a long time, your website has over 1 gigabyte of assets, and
over 100 PDFs.
Solutions
l

Install Foxit PDF Filter

l

Install Foxit PDF filter from Foxit® PDF IFilter - Server
After installing, update the registry as shown below:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office Server\14.0
\Search\Setup\Filters\.pdf]
"Extension"=".pdf"
"FileTypeBucket"=dword:00000001
"MimeTypes"="application/pdf"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office Server\14.0
\Search\Setup\ContentIndexCommon\Filters\Extension\.pdf]
@="{987f8d1a-26e6-4554-b007-6b20e2680632}"

See Also: Index and Search PDF Files in SharePoint Server 2010
l

Use the Filters Screen
The Crawl Filters screen lets you decide which file types are crawled. You can exclude
non-critical file types to speed up the crawl. See Also: Managing a Microsoft Search
Server on page 925
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Searching a Microsoft Search Server Website
Visitors choose search to navigate your website more frequently than any other navigation
option. Search usage often exceeds links, menus, or site maps. This is especially true when
visitors have a term or phrase in mind. Advanced visitors may narrow down search results by
adding special terms or query strings.
As an administrator or developer, you want to provide the optimum search results quickly,
with the most relevant results near the top. To accomplish this, adjust the search engine
results by setting Using Synonym Sets on page 945, Suggested Results, and keywords.
In some cases, you can anticipate what the visitor is looking for and provide a convenient way
to display results with the click of a button or image. To do this, developers can create
automated queries that provide the unique combination of keywords and terms that provide
results that are highly targeted to the visitor's quest. These queries are found in the codebehind and use the search API.
The website search should provide a simple user interface and relevant results.
This section also contains the following topics.
Basic versus Advanced Website Search
Basic Search
Advanced Search
Search Result Ranking
Ensuring Your Content is Searchable
Installing the Visio IFilter
Searching for Metadata
Displaying Search Results
Customizing the Postback Message
The "Did you mean?" Feature
Using Synonym Sets
Creating a Synonym Set
Editing a Synonym Set
Deleting a Synonym Set
Including External Files in Your Search
Step 1—Place Content in an External Folder
Step 2—Create a New Content Source for the External Folder
Step 3—Create Scope for New Content Source
Step 4—Add External Folder to Ektron Website Scopes
Step 5—Add a New Crawl Rule for the Integrated Search User
Step 6—Complete the Integrated Search Mappings Screen
Troubleshooting Integrated Search
Formulating Queries
Providing Suggested Results
Using Suggested Results to Enhance Business Opportunities
Using Suggested Results to Direct Site Visitors
Creating a Set of Suggested Results
Displaying Suggested Results
Adding a Link to a Suggested Result Set
Editing a Link in a Suggested Result Set
Removing a Link from a Suggested Result Set
Rearranging the Sequence of a Suggested Result Set
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939
939
941
942
942
943
943
943
944
944
945
945
946
946
946
947
947
948
949
950
950
950
951
952
953
954
956
958
959
959
960
960

Basic versus Advanced Website Search

Deleting a Suggested Result Set
Using Autosuggest
EktronQuerySuggestion Logs
EktronSearchStatistics Logs

960
960
965
965

Basic versus Advanced Website Search
To provide your website with search capabilities, your developer places Site Search server
controls on a page. See Also: Site Search Server Controls on page 1836
The search may look like the image below, although your developer has total control over its
"look and feel".

Basic Search
NOTE: You can designate a folder outside of Ektron to be searched. For more information, see Including
External Files in Your Search on page 946.
The Basic Search finds content that satisfies these criteria.
l

Published. Changes checked in but not published are not accessible.
NOTE: New and updated content is available only after the next crawl completes. See Also:
Managing the Search Crawl on page 931

l

l
l

Active. Also, expired content appears if the archive option is Archive and remain on
Site.
Content’s Content Searchable box is checked.
Public. Private content is only available to those with permission to view it, such as
membership users after logging in. See Also: Making Content Private on page 294
IMPORTANT: Private content is hidden from search results if your search provider is Microsoft
Search Server 2010. It is not hidden if you are using another search provider.

l

l

Library items are searchable by title and file name. To make the content of non-image
files (for example Word documents) searchable, add them as assets. See Also: Working
with Assets in the Document Management System on page 310
Language:
o website search: Content in selected site language appears unless the developer
sets the language via Advanced Query Text or API
o

l
l

Workarea search: Content in the Workarea’s current language appears (user
selects Workarea language via the View > Language menu option)

Search text is contained in title or content
If the search text is more than one term, all terms must be found. So, multiple terms
have an AND relationship.
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NOTE: A user may force an OR relationship by entering OR between search terms, or using the
Advanced Search's any of these words option. Developers may create an OR-based search using
the API property ImplicitAnd.
IMPORTANT: If you have a multi-site configuration and a search is conducted from any site, results
from all sites appear. To limit a search to single site, use a syntax like this:
AdvancedQueryText=' AND ( "parentsiteid"=0 OR "parentsiteid"=161 ) '
l

Satisfies content type criterion selected on screen, if chosen (see below)

NOTE: The search does not find documents inside compressed files, such as *.zip, *.cab, and so
on.
The following list explains the values in the Advanced Search tab's Content Type field.
l

Site
o

Content from all options listed below.

o

Any document file type defined in the Asset Server Setup screen
NOTE: You can find these files using Site as the content type criterion, but not using
Documents.

l

l

HTML
o HTML
o

HTML form (but not data submitted on form)

o

XML Smart Form (field values but not field labels)

o

Blog entries (not comments)

o

Web calendar events

Documents
o MS Office documents (includes Powerpoint, Excel)
NOTE: To search Visio documents, you must install the Visio IFilter. See Also: Installing the
Visio IFilter on page 943
n
o

Document properties (categories, comments, and so on)

PDF file

IMPORTANT: The search only finds text in the first 16 MB of any PDF document. So, for
example, if the file is 32 MB, only the first half of the text is searchable.
o

940

.txt file
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l

Images added as assets and through the library
o Search text in file name (including file type extension) and summary.
NOTE: If you assign several images to an eCommerce catalog entry, and want to allow
searching for that catalog entry by image file name, the search only works with the first image
assigned to the catalog entry.

l

l

l

l

Multimedia (Flash, .mp3, and so on)
o Search text in file name (including file type extension) or summary
Forums
o Forum posts and replies
Tags
o Tags applied to content and library items See Also: Tagging Content, Library Items,
Users, and Groups with Keywords on page 1245
PageBuilder Pages
o PageBuilder page: properties (summary, metadata, and so on) and content within
the page's widgets.
IMPORTANT: If a content block is added to a PageBuilder page, the search only returns its
appearance on the PageBuilder page. The search does not find such content on a nonPageBuilder page.

Advanced Search
The Advanced Search uses the same search criteria as the Basic Search. (See Basic Search
on page 939). The differences are additional options and the fact that you cannot use queries.
NOTE: The advanced search screen may look like the following image, although your developer has total
control over its appearance." See Also: Modifying Templated Server Controls on page 972
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l

l
l

l

all of these words—Web page includes all submitted terms; their position on the page
does not matter.
none of these words—Web page does not contain the submitted term
the exact phrase—Web page must include the exact phrase. For example, if you enter
Ektron healthcare, a page with the term Ektron provides healthcare is not found
because it is not an exact match.
any of these words—Web page includes any submitted term

Search Result Ranking
NOTE: This topic describes search rank using Microsoft Search Server 2010. To learn about search rank
using Microsoft FAST Search Server 2010, see Setting Up Microsoft Search Server 2010 on page 871.
Each content item found by search is given a numerical rank. Search results are sorted by
rank. Criteria used to calculate rank include the
l

number of occurrences of the search term

l

proximity of search term to beginning of file

l

proximity of search term to other occurrences of the term

l

whether the term is in the title

If you need to ensure that certain content appears at the top of search results when certain
terms are entered, use suggested results. See Also: Providing Suggested Results on page 952
To learn about customizing ranking for Microsoft Search Server 2010, see
l

Custom Ranking Models with SharePoint 2010: Background, Value and Administrative
Overview

l

Creating Custom Ranking Models

l

SharePoint 2010 enterprise search developer training

Ensuring Your Content is Searchable
Search only accesses data about the content if the Content Searchable field is checked.
NOTE: Despite the value of this checkbox, if an Ektron user places this content item in a Suggested
Results list, it appears in the Suggested Results area of the Search Results screen. See Also: Providing
Suggested Results on page 952.
Also, even if Content Searchable is unchecked, the Advanced Workarea search can find the content.
The default value of this field is determined by the ContentSearchable folder property.
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Installing the Visio IFilter
The search finds text within Visio documents if the Visio IFilter is installed to the Microsoft
Search Server used by the Ektron Web server. Use the following links to download and install
the Visio IFilter.
Microsoft Office 2010 Filter Packs

Searching for Metadata
The following rules apply when searching for values inside metadata.
l

l

The search finds text within Searchable type and Content Tag metadata fields. For
example, a content block has a searchable type metadata field, MapAddress, that
contains 131 Amherst St. Searching for 131 returns that content.
To find content with searchable metadata whose style is yes or no, enter true or
false.

See Also: Working with Metadata on page 369

Displaying Search Results
See Also: Search Result Ranking on the previous page
The following example shows the website search results screen. Your developer can
customize it using the appropriate ResultsView server control. For example, to display
eCommerce catalog entry results, the developer uses the Using Search Server Controls on
page 971.
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Customizing the Postback Message
By default, if a search term yields no results, a message appears.

To customize this message:
1. In your site root folder, find the workarea/resources folder.
2. Open the resource file that corresponds to your site’s language. For example, if your site
is in American English, open EkResource.en-US.resources. To learn how to work with
a resource file, see Translating the Workarea on page 1086.
3. If your site supports multiple languages, follow these steps for each corresponding
resource file.
a. Within the resource file, find the key lbl search no results.
b. The default text (shown above) follows this key. Modify the text as needed.
c. Save the file.

The "Did you mean?" Feature
If a site visitor enters a word that is similar to a crawled term, the "Did you mean?" feature
often suggests close alternatives. If you click a suggested term, a search is performed on it.

The "Did you mean?" feature works only with single word queries.
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NOTE: If your search provider is Solr, the "Did you mean?" feature only works with words in the content
title.

Using Synonym Sets
PREREQUISITE
You must be a member of the Administrators Group or assigned the Search-Admin
role to access Synonym Sets. See Also: Defining Roles on page 1120
IMPORTANT:
*Changes to a Synonym Set reset Search Server. To minimize impact on your visitors, make such
changes during off-peak hours.
* Synonym Sets apply to all Ektron sites associated with a Search Server instance. For example, if Site
A, Site B, and Site C use the same Search Server instance, they share Synonym Sets. This means that a
Synonym Sets created in Site A may affect Site B's search results.
You can create sets of synonyms to work with the search. If a site visitor enters into the
search field any term in a synonym set, the search returns results for that term plus all other
terms in the set.
For example:
l

Synonym Set: Tuition

l

Terms: tuition, bill, payment, pay, fee, charge, price, amount, cost, balance

If a site visitor inserts bill into the search field, Ektron uses bill or tuition or payment or
pay or fee or charge, and so on., to determine search results.
The Synonym feature typically produces more “hits.” So, while visitors do no more work,
their chances of finding the right information are greatly increased.
NOTE: Previous to version 8.5, you could use Synonym sets in Suggested Results. This is no longer
provided in versions 8.5 and higher.
BEST PRACTICES
A search term can consist of several words as long as the term is entered the same
way in the Synonym Set. For example, love seat is part of a Synonym Set that
includes sofa. As long as both love and seat are in a content item, the search finds it
even if the words are separated. But, entering a single term, like love, will not find
that Synonym Set. So, if you think people may search using loveseat or love seat,
enter both terms into the Synonym Set.
The metadata search does not use or support Synonyms Sets.
If a search term consists of several words, it does not return synonym match results.
For example, you create a synonym set that contains {cms; content management
system}. If a site visitor enters CMS, the search results include matches for cms and
content management system. But, if the site visitor enters content
management system, the results do not include matches for cms.

Creating a Synonym Set
IMPORTANT: A term can only appear in one Synonym set.
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1. Choose Workarea > Settings > Configuration > Search > Synonyms.
2. Select a language for the Synonym Set from the language drop-down menu. (The search
is language-specific. When site visitors begin using your site, they select a language.
Only synonyms sets in that language are considered.)
3. Click Add Synonym. The following screen appears.

4. Enter all terms in the set. Separate each with a semicolon (;). You cannot enter a comma
(,) or parenthesis character (().
5. Click Check for Duplicates. Ektron compares these terms against other Synonym Sets
in this language. If the same term is found in another set, you are notified and must
remove it.
6. Click Save Synonyms.

Editing a Synonym Set
1. Choose Workarea > Settings > Configuration > Search > Synonyms.
2. Select a language for the Synonym Set from the language drop-down menu.
3. Click the Synonym Set that you want to edit.
4. Click Edit. The Edit Synonym Set screen appears.
5. Add or remove terms. Be sure to separate each term with a semicolon (;).
6. Click Check for Duplicates. Ektron compares these terms against other Synonym Sets
in this language. If the same term is found in another set, you are notified and must
remove it.
7. Click Save Synonyms.

Deleting a Synonym Set
1. Choose Workarea > Settings > Configuration > Search > Synonyms.
2. Select a language for the Synonym Set from the language drop-down menu.
3. Click the Synonym Set that you want to delete.
4. Click Delete ( ).
5. Confirm your action.

Including External Files in Your Search
Use integrated search when you want the search to find files outside of Ektron but located on
your Web server. For example, you want a folder full of press releases to be searchable but
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do not want to add them to Ektron. Instead, you follow the steps below to make the folder
searchable, and search results include the press releases.
NOTE: The descriptions below refer to the folder with content that is not part of Ektron as the external
folder.
You can search all non-Ektron content by file title. For example, you can find Ektron.gif by
inserting Ektron into the search field. In addition, you can search a variety of file types like
.doc, .pdf, and .txt by searching their text. Finally, Microsoft Search Server 2010 searches
file metadata for media files.
Follow these steps to include external files in search results.

Step 1—Place Content in an External Folder
External folders must reside in the website so IIS has permission to access their content.
Best practice is to create the external folder under the Webroot. Then, place content in th
folder for the integrated search. Next, follow the steps below to set permissions and
configure Search Server.

Set Permissions for the External Folder
The top-level folder that contains the external files must be accessible to the website, and the
user account used by search server must have permission to read it.
The following example creates a user called IntegratedSearchUser and shares the external
folder. Search Server uses the IntegratedSearchUser account to access the external folder's
content.
1. On the Web Server, start Control Panel > Administrative Tools > Computer
Management and create a new user called IntegratedSearchUser.
2. Using Windows Explorer, right click the external folder and choose Share.
3. Enter the IntegratedSearchUser user.
4. Click Add.
IntegratedSearchUser now has read permission for the external folder.

Step 2—Create a New Content Source for the External
Folder
1. On your search server, open the SharePoint 2010 Central Administration screen.
2. Go to Manage service applications > Search Service Application > Content
Sources > New Content Source.
If you are using Microsoft FAST Search Server 2010, go to Manage service
applications > FastContent Connector > Manage Content Sources > New
Content Source
3. Enter the following values.
l
Enter a Name for the content source.
l
l

In the Content Source Type field, choose File Shares.
In the Start Addresses field, enter the external folder as a UNC path
(\\server\directory) or full file URI (file://server/directory).
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o

l

To make sure the search can access the external folder, you may want to use
C$ in the path, like this: \\server1\c$\integratedsearch.

Set up Crawl Schedules for your integrated search folder contents to
automatically refresh search indexes as frequently as you need to keep search
results reliable. (This schedule is different than the crawl schedule for Ektron
content.)

l

Begin a crawl by checking Start full crawl of this content source.

l

Click OK to save your changes.

If you successfully set this up, you see your new content source, and the status shows
"starting".

Step 3—Create Scope for New Content Source
NOTE: If you are using Microsoft FAST Search Server 2010, you can ignore Steps 3 and 4 proceed to
Step 5.
1. On your Search Server, open the SharePoint 2010 Central Administration screen.
2. Go to Manage service applications > Search Service Application > Queries and
Results > Scopes.

3. Click New Scope.
4. Give it a Name (no spaces) and Description.
5. Leave Use the Default Search Results Page checked.
6. Click Ok. The View Scopes screen reappears.
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7. Use the pull-down next to the new scope name and select Edit Properties and Rules.

8. Add a New Rule.
9. In the Scope Rule Type field, select Content Source.
10. In the Content Source field, select the content source you created in Step 2—Create a
New Content Source for the External Folder on page 947.
11. Set Behavior to Include.
12. Click Ok.

Step 4—Add External Folder to Ektron Website Scopes
NOTE: If you are using Microsoft FAST Search Server 2010, you can ignore Step 4 proceed to Step 5.
This step assures that your external folder content is included in Ektron search results.
1. Open the SharePoint 2010 Central Administration screen.
2. Go to Manage service applications > Search Service Application > Queries and
Results > Scopes.

3. Use the pulldown next to your Ektron website's content source and select Edit
Properties and Rules.
4. Click New Rule.
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5. In the Scope Rule Type field, select Content Source.
6. In the Content Source field, select the external folder that you created in Step 2—
Create a New Content Source for the External Folder on page 947.
7. In the Behavior field, select Include.
8. Click OK.

Step 5—Add a New Crawl Rule for the Integrated Search
User
This step sets the permission for the search server to access the external folder.
1. On your Search Server, open the SharePoint 2010 Central Administration screen.
2. Go to Manage service applications > Search Service Application > Crawling >
Crawl Rules.
3. Click New Crawl Rule.
4. Set the path to the external folder. (For example: \\ws10196\PressReleases\*.)
5. Set the Crawl Configuration to Include all items in this path.
6. Set Specify Authentication to Specify a different content access account.
7. Enter the Account. (For example: IntegratedSearchUser.)
8. Enter the Password and Confirm the Password.
9. Uncheck Do not allow Basic Authentication.
10. Click Ok.

Step 6—Complete the Integrated Search Mappings Screen
PREREQUISITE
You are a member of the Administrators Group or assigned the Search-Admin role See
Also: Defining Roles on page 1120
1. Choose Workarea > Settings > Configuration > Search > Integrated Search
Mappings.

2. In the Start Address field, find the external folder.
3. In the Mapping field, enter the path to the external folder relative to your site root.
4. Click (

) to save.

Troubleshooting Integrated Search
950
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l

Problem—The protocol handler cannot be found. Check that the handler has been
installed
The protocol handler is normally installed in this folder.
c:\windows\system32\DatabaseProtocolHandler.dll
Solution—If the handler is in the correct place, check that all folder names and paths
are correctly entered in the Content Sources, Crawl Rules and Scopes in the Search
Service Application settings.

l

Problem—Item was not crawled because of a password change. Update password and
retry crawling.
Solution—Verify that the Search Server user account has permission to read and write
to the content database. You may have to create a unique user on the content server for
this purpose.

Formulating Queries
NOTE: Following text extracted from Free-Text Keyword Queries.
To search for any word or phrase on a website, enter the word into the field and click Search
to begin.

The following rules apply to formulating queries:
l

By default, multiple words have an "and" relationship. So, the search term calendar
server returns pages that have both words.
o To find pages with either term, use the OR operator. For example, calendar OR
server returns pages that have either word.
IMPORTANT: You must capitalize boolean operators, such as AND.
o

To find pages with several terms in exact order with no intervening words, use
quotes. For example, “calendar server” returns pages that have both terms in
that order.

o

To find pages that have one term without another, use the NOT operator. For
example, For example, calendar NOT server returns pages that have calendar
and do not have server.

o

To find several terms close together, use NEAR. For example, treatment NEAR
immunoglobulin finds pages with the word “treatment” near the word
“immunoglobulin.”
The NEAR operator is like AND because it finds pages that include both search
words. However, the rank assigned by NEAR depends on the proximity of the
search words. A page with search terms closer together has a higher rank than a
page where they are farther apart.
NOTE: The NEAR operator can be applied only to words or phrases.
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l

Search terms are case-insensitive.

l

Punctuation marks, such as period (.) and comma (,), are ignored by the search.

l

l

l

l

l

l

Operators (<, >, and &) are ignored by a search. Also, the search does not find text
within angle brackets, for example <Ektron>.
To include in a query special characters that are not operators, such as +, |, ^, #, @, $,
(,), enclose the query in quotation marks (“).
Use the wildcard character (*) to find words that start with a certain letter sequence. For
example, esc* returns Web pages with “ESC,” “escape,” and so on.
To nest expressions within a query, add parentheses. Expressions within parentheses
are evaluated before the rest of the query.
Use double quotes (“) to ignore a boolean or NEAR operator keyword. For example,
“Abbott and Costello” finds pages with the entire phrase, not pages that match the
Boolean expression.
The AND operator has a higher precedence than OR. For example, the first 3 queries are
equal, but the fourth is not:
o a AND b OR c
o

c OR a AND b

o

c OR (a AND b)

o

(c OR a) AND b

Providing Suggested Results
PREREQUISITE
You are a member of the Administrators Group or assigned the Search-Admin role See
Also: Defining Roles on page 1120
Your website may contain thousands of content items. Sometimes, depending on the search
phrase, you want to focus the visitor's attention on a few topics. The Suggested Results
feature lets you create a set of search terms, then specify content to appear at the top of the
results when someone searches on a term.
Suggested Result links can jump to your website or an external website.
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IMPORTANT:
* Prior to Ektron version 8.5, Suggested Results could be language-specific. Beginning with version 8.5,
Suggested Results do not filter based on language.
* As of version 8.5, Suggested Results do not use terms from the Synonyms Set feature.
This section also contains the following topics.
Using Suggested Results to Enhance Business Opportunities
Using Suggested Results to Direct Site Visitors
Creating a Set of Suggested Results
Displaying Suggested Results
Adding a Link to a Suggested Result Set
Editing a Link in a Suggested Result Set
Removing a Link from a Suggested Result Set
Rearranging the Sequence of a Suggested Result Set
Deleting a Suggested Result Set
Using Autosuggest
EktronQuerySuggestion Logs
EktronSearchStatistics Logs
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You can use Suggested Results to direct site visitors to business partners' websites. One
example is a smoking cessation clinic near your hospital. When someone visits your website
and searches for smoking, you can set the clinic to be the top Suggested Result.
As another example, your organization creates widgets but does not implement or customize
them. Over time, several agencies develop experience at deploying and customizing your
widgets. Therefore, you want to promote the supporting businesses on your site. The
following steps describe how this works.
1. Create a phrase with synonyms—deploy, install, implement, customize, modify, adapt.
2. Assign the websites of approved agencies to the Suggested Results list.
3. When a site visitor searches for the word implement, he gets links to those agencies’
websites.
Suggested Results can also be used to advertise products, as used in the sponsored results
section of search engines like Google® search and Yahoo!®.

Using Suggested Results to Direct Site Visitors
Use this feature to provide search results that do not naturally appear at the top of the page.
For example, you manage a university’s website. When a site visitor wants to know where to
mail a tuition payment, he enters bill into the search field and gets these results.
l

Faculty member Bill McDermott

l

The Student Bill of Rights

l

How a Bill Becomes Law

Frustrated, many people call the business office to get information that exists on the website
but is difficult to find.
Using Ektron, you create Suggested Results to direct site visitors to the correct Web pages. To
continue this example, you could create
l
l

l

954

a title (such as Tuition) that describes a set of terms and links
a list of synonyms that visitors might enter when searching for the tuition page on your
site
a Suggested Results list, where you assign the content “Tuition & Fees”
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After you set up Suggested Results, this is a typical sequence of events.
1. A site visitor enters text on your Search page.

2. The text matches a term in the Phrases list of a Suggested Results set.

3. Suggested Result links assigned to the phrase appear in a special area of the results
page. They appear in the same order that you created in the Suggested Results set.
NOTE: The illustration below is an example of how suggested results may appear. Your developer
styles suggested results in the ResultsView server control.
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4. The search term’s regular results may also appear. Your developer determines their
location on the results page.

Creating a Set of Suggested Results
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1. Workarea >Settings > Configuration > Search > Suggested Results.
2. Click Add New Suggested Result Set. The following screen appears.

3. Complete the fields.
l
Name—A word that names the Suggested Results set and is the first synonym.
(You cannot repeat the phrase in the Synonyms.)
l

l

Phrases—The list of words that triggers the Suggested Results you will create
below. That is, if a user enters a search phrase that matches any term in the
Synonyms, the Suggested Results appear.
Suggested Results—The links to appear when a phrase or synonym is found. To
define them, place the cursor in this field and click. A menu appears.

4. Click Add. A screen appears.
5. Add the URL, title, and summary for each suggested result.
l
Link—To create a link to...
o content on your website, click the Browse to CMS content button. Then,
navigate to the folder that contains the content, select it, and click Save.
NOTE: Only content in the Workarea language appears. To change the language, exit
this screen, go to the root folder, and click View > Language.
o

l

an external website, enter its full address, starting with its protocol, such as
http://.

Title—If you created a link to...
o content on your website, its title is retrieved and displayed here. You may edit
it as needed.
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o

an external website, enter the text of the link that will appear on the
Suggested Results display.
Site visitors use this text (circled in the example below) to select the linked
Web page.

l

Summary—If you created a link to...
o content on your website, its summary appears here. You may edit it as
needed.
o

an external website, nothing appears. Enter text to further describe this link on
the search results page.
The summary cannot exceed 320 characters (including HTML tags). For
example:

6. Click Add New Suggested Result Set. The Add Suggested Results screen reappears.
You can add more links, edit existing ones, and so on.
7. Click Save Suggested Results.

Displaying Suggested Results
To display suggested results using templated server controls, set up a SiteSearchResultsView
control whose Eval statement refers to SuggestedResults.
<ektron:SiteSearchResultsView ID="r" runat="server" ControllerID="c">
<ItemTemplate>
<h3>Suggested Results</h3>
<asp:ListView ID="suggestedResults" runat="server"
DataSource='<%# Eval("SuggestedResults") %>'>
<ItemTemplate>
<span class="highlight">
<a href="<%# Eval("Url") %>"><%# Eval("Title") %></a>
<%# Eval("Summary") %>
</span>
</br>
</ItemTemplate>
</asp:ListView>

958

Ektron Reference

Adding a Link to a Suggested Result Set

</ItemTemplate>
</ektron:SiteSearchResultsView>

The suggested results class displays only 3 fields: title, URL, and summary.
If you want regular search results to appear below suggested results (as shown in Providing
Suggested Results on page 952), your developer may want to style the suggested results to
stand out. Some styling is shown above.
To display regular search results below suggested results and customize the standard result
template, make the following modifications.
<ektron:SiteSearchResultsView ID="r" runat="server" ControllerID="c">
<ItemTemplate>
<h3>Suggested Results</h3>
<asp:ListView ID="suggestedResults" runat="server"
DataSource='<%# Eval("SuggestedResults") %>'>
<ItemTemplate>
<span class="highlight">
<a href="<%# Eval("Url") %>"><%# Eval("Title") %></a>
<%# Eval("Summary") %>
</span>
</br>
</ItemTemplate>
</asp:ListView>
<asp:ListView ID="suggestedResults" runat="server"
DataSource='<%# Eval("Results") %>'>
<ItemTemplate>
. . .
</ItemTemplate>
</asp:ListView>
</ItemTemplate>
</ektron:SiteSearchResultsView>

However, if you want to display standard results and use the default template, insert a
separate SiteSearchResultsView control below the suggested results control. See Also: Using
Search Server Controls on page 971

Adding a Link to a Suggested Result Set
1. Choose Workarea > Settings > Configuration > Search > Suggested Results.
2. Select the suggested results set to which you want to add a link.
3. Click Edit.
4. Place the cursor over the first result in the Suggested Results area of the screen.
5. Click once and a menu appears.
6. Click Add. The Add New Suggested Results screen appears.
7. See Click Add New Suggested Result Set. The Add Suggested Results screen reappears.
You can add more links, edit existing ones, and so on. on the previous page
8. Click Add New Suggested Result Set.
9. Click SaveSuggested Results.

Editing a Link in a Suggested Result Set
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1. Choose Workarea > Settings > Configuration > Search > Suggested Results.
2. Select the suggested results set that you want to edit.
3. Click Edit.
4. Place the cursor in the suggested results area of the screen.
5. Place the cursor on the result that you want to edit.
6. Click once and a menu appears.
7. Click Edit.
8. See Click Add New Suggested Result Set. The Add Suggested Results screen reappears.
You can add more links, edit existing ones, and so on. on page 958
9. Click Add New Suggested Result Set.
10. Click SaveSuggested Results.

Removing a Link from a Suggested Result Set
1. Choose Workarea > Settings > Configuration > Search > Suggested Results.
2. Select the suggested results set from which you want to remove a link.
3. Click Edit.
4. Place the cursor in the suggested results area of the screen.
5. Place the cursor over the result that you want to delete.
6. Click once and a menu appears.
7. Click Delete. A confirmation message appears.
8. Click OK.
9. Click SaveSuggested Results.

Rearranging the Sequence of a Suggested Result Set
1. Choose Workarea > Settings > Configuration > Search > Suggested Results.
2. Select the Suggested Results set from which you want to remove a link.
3. Click Edit.
4. Place the cursor in the suggested results area of the screen.
5. Place the cursor over the result that you want to move up or down.
6. Click once. A menu appears.
7. Click Move Up or Move Down.
8. Click SaveSuggested Results.

Deleting a Suggested Result Set
1. Choose Workarea > Settings > Configuration > Search > Suggested Results.
2. Select the suggested results set that you want to delete.
3. Click Delete ( ).
4. Click OK to the confirmation message.

Using Autosuggest
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Enabling Autosuggest

Autosuggest is a search feature that suggests similar terms or common refinements that
searchers have used in the past which are related to the search term. As a user enters text,
possible matches appear. This immediate feedback may preclude the user from typing an
entire search phrase, and instead choose a term with which to launch the search.

Terms appear on the list if they
l

include the submitted letters, and

l

were previously submitted by site visitors, and

l

have resulted in the viewing of a search result

Autosuggest only works with the Site Search Control.

Enabling Autosuggest
1. Every Web page that retrieves search results requires a SiteSearchController server
control. See Also: XMLSearchController on page 1862
In Visual Studio, add the following properties and values to each SiteSearchController
control that will use Autosuggest.
l

EnableQueryStatistics="true”

l

EnableAutoSuggest="true"

l

AutoSuggestMaxCount—the maximum number of entries in the autosuggest list

2. On your search server machine:
a. Go to IIS Manager and expand the EktronSearchSite IIS Site.
b. Right click EktronSearchStatistics and choose Explore.
c. Under EktronSearchStatistics, open web.config.
d. Within that file, set NumberOfClicksToTrigger to 1, 2 or 3. This key defines the
number of times a user chooses an autosuggest search term and then clicks on a
search results page before the term is added to the suggested results list.
For example, you decide that a term is added to the list only after it is selected and
users click on the results page 3 times.

Adding a Term to Autosuggest
Normally, you would not add autosuggest terms, because the terms list is built from previous
successful searches. However, there may be times when you want to add autosuggest terms
that direct searches to specific content. To manually add terms to the autosuggest list, follow
these steps.

Ektron 8.7

961

Setting Up Search for Your Website

PREREQUISITE
Knowledge of SharePoint Powershell cmdlets
1. Log on to your search server.
2. Open the SharePoint 2010 Management Shell.
3. Add a term to the autosuggest list by inserting this command.
New-SPEnterpriseSearchLanguageResourcePhrase
–SearchApplication <Search Service Application>
-Name <Name of the term>
-Language <en-US>
-Type QuerySuggestionAlwaysSuggest

Command Parameters
l

l

l

If you are using a Microsoft FAST search server, for <Search Service
Application>, enter the Search Service Application you created for FAST Query
in Searching a Microsoft Search Server Website on page 938.
If the search term has more than one word, surround it with double quotes. For
example, "Phrase Term."
For Language, enter a language code followed by the locale code (as examples: enUS, en-UK).

4. Remove the term from the block list (if it exists there) by inserting this command.
Remove-SPEnterpriseSearchLanguageResourcePhrase
–SearchApplication <Search Service Application>
-Identity <Name of the term>
-Language <en-US>
-Type QuerySuggestionBlockList

5. Run the timer job.
Get-SPTimerJob
-Identity "Prepare Query Suggestions" | Start-SPTimerJob

6. Check the Last Run time against the current time.
7. When the Timer Job shows the Last Run Time as the current time, the operation has
succeeded, and the term is added to the suggested terms list.

Example of Adding a Term to Autosuggest
To manually add a suggestion for ektron:
$app = Get-SPEnterpriseSearchServiceapplication "FASTQuery"
New-SPEnterpriseSearchLanguageResourcePhrase
-SearchApplication $app
-Language en-us
-Type QuerySuggestionAlwaysSuggest
-Name “ektron”

If ektron was added to the Block list, it must be removed. (If it does not exist and you run
these commands, you get an error: Given key not present in the dictionary.)
Remove-SPEnterpriseSearchLanguageResourcePhrase
–SearchApplication $app
-Identity ektron
-Language en-us
-Type QuerySuggestionBlockList

962

Ektron Reference

Removing a Term from Autosuggest

(Get-SPTimerJob –Identity “Prepare Query Suggestions”).RunNow()

Wait 3 minutes to see results.

Removing a Term from Autosuggest
You may need to remove inappropriate or derogatory terms from the autosuggest list. To do
that, a term to the block list by following these steps.
PREREQUISITE
Knowledge of SharePoint Powershell cmdlets
1. Log on to your search server.
2. Open the SharePoint 2010 Management Shell.
3. Add a term to the block list by inserting this command. See Also: Command Parameters
on the previous page
New-SPEnterpriseSearchLanguageResourcePhrase
–SearchApplication <The Search Service Application>
-Name <Name of the term>
-Language <en-US>
-Type QuerySuggestionBlockList

4. Run the timer job.
Get-SPTimerJob
-Identity "Prepare Query Suggestions" | Start-SPTimerJob

5. Check the Last Run time against the current time.
6. When the Timer Job shows the Last Run Time as the current time, the operation has
succeeded, and the term is blocked from the autosuggest list.
If you later decide to remove a term from the block list, use this command.
Remove-SPEnterpriseSearchLanguageResourcePhrase
–SearchApplication <The Search Service Application>
-Identity <Name of the term>
-Language <en-US>
-Type QuerySuggestionAlwaysSuggest

Example of Removing a Term from Autosuggest
To block the term ontrek
$app = Get-SPEnterpriseSearchServiceApplication "FASTQuery"
New-SPEnterpriseSearchLanguageResourcePhrase
–SearchApplication $app
-Language en-us
-Type QuerySuggestionBlockList
-Name ontrek

Remove the term from the suggestion list, if it exists. (If it does not exist and you run these
commands, you get an error: Given key not present in the dictionary.)
Remove-SPEnterpriseSearchLanguageResourcePhrase
–SearchApplication $app
-Identity ontrek
-Language en-us
-Type QuerySuggestionAlwaysSuggest
(Get-SPTimerJob –Identity “Prepare Query Suggestions”).RunNow()
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Wait 3 minutes to see results.

Viewing the Blocked Words List
To view the blocked words list, enter
Get-SPEnterpriseSearchLanguageResourcePhrase
–SearchApplication <Search Service Application>
-Language en-US
-Type QuerySuggestionBlockList

Troubleshooting Autosuggest
If you don’t see the autosuggest drop-down, try the following.
1. Open all (3) web.configs and verify that they contain the same values for the QuerySSA
and ProviderAdmin keys.
2. Open C:\Program Files
(x86)\Ektron\EktronSearchServerService\EktronSearchServerHelperService.ex
e.config and verify that the following keys have correct paths.
l
QueryServiceEndpoint
l

QueryStatisticsEndpoint

l

QuerySuggestionEndpoint

3. In the SharePoint Management Shell, enter
Get-SPEnterpriseSearchQuerySuggestionCandidates -SearchApplication
"<Search Service Application Name>". Inspect the command for your autosuggest
word.

l

l

If the command returns a blank screen, check the
C:\inetpub\EktronSearchSite\EktronSearchStatistics directory for a logs
folder. If this folder is empty, verify that the SiteSearchController contains
EnableQueryStatistics="true” and EnableAutoSuggest="true”.
If your list appears but the autosuggest drop-down does not, verify that your
SiteSearchController contains EnableAutoSuggest="true".

4. Manually test that autosuggest words are returned to your site by entering the URL on
the Ektron server.
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http://<Your EktronSearchSite website:Port # >
/EktronQuerySuggestion/SPQuerySuggestion.svc
/QuerySuggestionForCulture?keywordPrefix=sa&culture=en-US

NOTE: ‘sa’ is the prefix you used to return autosuggest entries.
After submitting this url, download and open QuerySuggestionForCulture file in Notepad to
see autosuggest results. To continue the above example, you might see
{"QuerySuggestionForCultureResult":{"Suggestions":["sample"]}}

EktronQuerySuggestion Logs
This log shows the number of entries for the query prefix. For the example below, the user
entered ‘samp’ and Autosuggest found one entry (sample). To access the log, sign on to the
Search Server machine > EktronSearchSite Web root > click EktronQuerySuggestion folder.
PID:7900 TID:5168
MTID:
2012-04-04T08:51:18
Verbose QueryContext.Create: Creating QueryContext /
PID:7900 TID:5168
MTID:
2012-04-04T08:51:18
Verbose QueryContext.Create: Created QueryContext /
PID:7900 TID:5168
MTID:
2012-04-04T08:51:18
Verbose QueryServiceInfoProcessor.GetSearchApp for
QuerySSA:Search Service Application
PID:7900 TID:5168
MTID:
2012-04-04T08:51:18
Verbose QueryServiceInfoProcessor.GetSearchAppProxy for
QuerySSA:Search Service Application
PID:7900 TID:5168
MTID:
2012-04-04T08:51:18
Verbose SPQuerySuggestionReporter.GetQuerySuggestions:
Q:[samp] Profile:[]
PID:7900 TID:5168
MTID:
2012-04-04T08:51:18
Verbose SPQuerySuggestionReporter.GetQuerySuggestions:
Response for Q:[samp] : [1]
PID:7900 TID:5168
MTID:
2012-04-04T08:51:18
Verbose SPQuerySuggestionFeed.QuerySuggestionForProfileFeed:
completed feed request: Q:samp Culture:en-US

EktronSearchStatistics Logs
This log shows submission of the query statistics. It is updated only after a site visitor inserts
a search term, clicks the search button, and clicks a result. To access the log, sign on to the
Search Server machine > EktronSearchSite Web root > click EktronSearchStatistics folder.
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose
Publishing Search Statistics : Begin
PID:7284 TID:7056
MTID:
2012-04-03T14:55:1
Verbose QueryContext.Create: Creating QueryContext /
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose QueryContext.Create: Created QueryContext /
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose QueryServiceInfoProcessor.GetSearchApp for
QuerySSA:Search Service Application
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose QueryServiceInfoProcessor.GetSearchAppProxy
for QuerySSA:Search Service Application
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose MSStatsRecorderProxy.Record: Recording
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PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose MSSearchStatsHelper.SubmitStatistics:
Beginning statistics recording to SharePoint!
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose MSSearchStatsHelper.FetchClicksToRegisterValue:
Will be using 2 click(s) to complete
statistics recording to SharePoint!
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose MSSearchStatsHelper.SubmitStatistics:
Ending statistics recording to SharePoint!
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose MSStatsRecorderProxy.Record: Recorded!
PID:7284 TID:7056
MTID:
2012-04-03T14:55:15
Verbose
Publishing Search Statistics :
Ends with Status SUCCESSFUL: 0

Searching the Workarea
You can search any folder to quickly locate content within it. The following sections explain
how to use the Workarea search.

Searching a Folder Hierarchy
1. Navigate to the folder from which you want to begin the search.
NOTE: To search the entire site, search from the top-level (Root) folder. To limit the search to a
folder (and its subfolders), select it then enter search criteria.
2. Click Action > Search. The Search Content Folder screen appears.

l

l

Search Published is the same as the Site Search, except your results are only
retrieved from the current folder and its subfolders. You must have read-only or
greater permission for the folder.
Advanced Search lets you expand search to include internal properties, such as
last editor, date created/modified, status, and comments. See Also: Using
Advanced Search in the Workarea below

Using Advanced Search in the Workarea
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The Workarea Advanced Search lets you find content using information that content authors
and publishers would typically know. For example, you can search for content edited by a
particular author within a date range.
When performing a search, enter one or more words into the text box, select search
preferences, then click Search.
You can use an asterisk as a wildcard character to stand for any character. For example, the
phrase CMS*00 returns topics that include the following text: CMS400, CMS300, CMS200 and
CMS100.
Your system administrator can add custom search fields that only appear if a user is logged
in. For more information, see Working with Metadata on page 369.
IMPORTANT: The Advanced search finds content whether or not it is marked Searchable.
The Workarea Advanced Search finds content that satisfies these criteria.
l

user has read-only or greater permission for content’s folder

l

matches selected language, if site is multilingual

l

satisfies criteria entered on the screen

The Advanced Search screen lets you find Ektron content by specifying the following criteria.
While the fields are optional, the search only returns content that satisfies all criteria.
l
l

l

content type (for example, HTML content, forms, assets)
one or more search terms. Unlike the Search Published screen, you cannot use a
query.
to search title only, enter search text into the Title field
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l

to search comments, enter search text into the Comments field

l

a range of created or modified dates

l

the editor who created or most recently updated the content

l

the content’s status

l

any searchable metadata assigned to the folder

This section also contains the following topics.
Specifying Content Type to Search
Specifying a Search Word or Phrase
Specifying Additional Search Criteria

968
968
969

Specifying Content Type to Search
Near the top of the screen, check boxes let you determine the types of content to search.

l

Content—HTML content, blogs entries, and XML Smart Form field values

l

Forms—HTML forms

l

l

Assets—Content that is neither HTML nor XML, such as Office documents and managed
files. See Also: Working with Assets in the Document Management System on page 310
Include Archived—Content, forms and assets that were archived using the Archive
and remove from site or Archive and remain on Site option

Specifying a Search Word or Phrase
In the Search Text field, enter one or more words that you want to find within content,
forms, and assets. Entering text here is optional. That is, you can use the other fields to find
content.
If you enter several terms, specify a logical relationship among them in the pulldown below
the Search Text field.

l

968

All the words—all words in the Search Text field. All Words is an “and” function. The
search returns only content that has the words content and management and system.
The words can be in any order within the content.
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l

l
l

Any of the words—any word in the Search Text field. This is an “or” function. It
returns content that has at least one of the words in the Search Text field; it returns
content with the word content or management or system.
Exact Phrase—all words in the order specified in the Search Text field.
Content ID—To find content by ID number
1. In the Search Text field, enter the ID number.
2. From the pulldown below Search Text, select Content ID.
3. Click Search.

Specifying Additional Search Criteria
l

Title—The title of the content. You can enter a partial word. For example, entering Part
yields the following results.
o Multi-Hospital Nurse Executive Participation
o

Ektron Partners and Customers

You can enter more than one word or phrase as long as they are in the correct sequence.
The Search Text field also searches content title.
l

Comments—The content’s comments, which can be inserted via the Comment tab.
NOTE: If you enter multiple terms into the Comments field, they must be in the order in which they
appear in the content's comments.

l

l

l

Date Created—The file’s creation date. You can enter a single date or a range of dates.
The search returns content with that creation date that satisfy the other criteria.
Date Modified—The last date when the file was modified. You can enter a single date
or a range of dates. The search returns items with that edit date that satisfy the other
criteria.
Last Editor’s Last Name—The last name (surname) of the user who most recently
changed the content. This is taken from the Last Name field on the User Information
screen. The search returns items last edited by that user that satisfy the other criteria.
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l

Status—The content status. See Also: Content Statuses on page 307
NOTE: Search results display only the most recently-published version. Also,content that has never
been approved does not appear.

Printing a Search Phrase Report
The Search Phrase Report displays terms that were entered into a Search field within a
selected range of dates. You can use it to discover terms being submitted to the search.
The report is gathered from the query text of keyword-based queries. The queries include
those submitted through the search field of search server controls, the keyword search API,
and the Workarea’s Search Published tab.

You can narrow down the search by selecting any combination of these criteria.
l

l

l

language—the language of the search page (either Workarea or website search). The
user performing the search can choose a language before inserting the search text. If he
does not explicitly choose a language, the search uses the default one. This report shows
results from all languages or one that you select.
a minimum number of occurrences of the word or phrase to return. For example, you
only want words or phrases searched for 10 times or more during the last month.
range of dates when searches were conducted

After entering search criteria, click Get Result.
The search results show the number of times each word or phrase that satisfies the selection
criteria appears. They are arranged in this order.
l
l

words or phrases with the most occurrences appear first
if several words or phrases have the same number of occurrences, they are arranged
alphabetically

NOTE: Search terms are added to the Search Phrase Report according to rules explained in Specifying
the Frequency of Writing to the Database on page 602.
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Using Search Server Controls
Beginning with Ektron version 8.5, search capabilities are enhanced with several new server
controls.
l

l

l

l

Site Search—Content, documents, file created or imported to the Workarea. See Also:
Site Search Server Controls on page 1836
XML Search—XML content created with Smart Forms. See Also: XMLSearch Server
Controls on page 1861
User Search—Ektron users, members, and membership groups. See Also: User Search
Server Controls on page 1855
Product Search—An eCommerce site for products in the eCommerce system. See
Also: Product Search Server Controls on page 1822

NOTE: To apply paging to a search results page, use an EktronUI:Pager.
Alternatively, you may continue to use Ektron's legacy Web Search Server Control on
page 981.
Templated server controls are more specialized than their predecessors, which typically used
1 control to retrieve and display results. To provide search functionality, use 3 templated
controls.
l

SearchInputView—accepts user input of search terms

l

SearchController—takes input from InputView control and retrieves search results

l

SearchResultsView—shows search results; you can modify the results' display, and so
on.

The following example shows this relationship using site search controls.

Benefits of these controls include the ability to:
l

exercise more granular control over each function

l

customize display of input and results using standard CSS markup

l

eliminate XSLTs. Use ASP.NET templates to control markup

l

use several SearchInputView or SearchResultsView controls on a template

To replicate all of the previous search server controls' functionality, use a combination of
templated controls. For example, use the Pager control to manage the paging of search
results. Also, use the Advanced Query Text parameter to limit results to those in a selected
folder, in a selected taxonomy category, and so on.
Search server controls have no Ektron-specific properties. In contrast, the pre-8.5 Search
server control properties let you configure language, Display XSLT, folder ID, and so on.
References
l

ASP.NET MVC Overview

l

Building Web Apps without Web Forms

l

ASP.NET Data-Bound Web Server Controls
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Modifying Templated Server Controls
You modify the behavior of templated controls by editing their markup. You no longer use
Ektron server control properties nor an XSLT to edit the control's behavior.
You can edit a control's default markup, as well as the markup on any page that contains it.
See Also: Modifying the Text Displayed by Templated Server Controls on page 974

Customizing a Single Instance of a Templated Search
Server Control
1. Open a page in Visual Studio.
2. Drag an InputView or a ResultsView control onto the page. This section uses the
SiteSearchResultsView server control as an example.
3. Insert <ItemTemplate> tags between the control's opening and closing tags.
<ItemTemplate> tags instruct the server control to ignore the default properties.
<ektron:SiteSearchResultsView ID="SiteSearchInputView1"
ControllerID="Scontroller" Visible="true" runat="server">
<ItemTemplate> </ItemTemplate>
</ektron:SiteSearchResultsView>

4. Copy the default markup from the control's corresponding .ascx file. Here is a portion of
that.
<ektron:SiteSearchResultsView ID="SiteSearchInputView1"
ControllerID="Scontroller" Visible="true" runat="server">
<ItemTemplate>
<h1>Search Phrase:<%# Eval("QueryText") %></h1>
<asp:ListView ID="aspResults" runat="server"
DataSource='<%# Eval("Results") %>'
ItemPlaceholderID="aspPlaceholder">
<layouttemplate>
<ul class="results">
<asp:PlaceHolder ID="aspPlaceholder" runat="server"> |
</asp:PlaceHolder>
</ul>
</layouttemplate>
<itemtemplate>
<li class="result ektron-ui-clearfix">
<h3 class="title">
<a href="<%# Eval("Url") %>"><%# Eval("Title") %></a>
</h3>
<div class="summary">
<%# Eval("Summary") %>
</div>
<span class="url ektron-ui-quiet">
<%# Eval("Url") %>
</span>
<span class="date ektron-ui-quiet">
<%# Eval("Date") %>
</span>
</li>
</itemTemplate>
</asp:ListView>
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</Itemtemplate>
</ektron:SiteSearchResultsView>

5. Modify the markup to your specifications.

Modifying the Default Markup
InputView and ResultsView controls have a corresponding .ascx template that contains their
default markup. To change a control's default markup, modify its template.
To find a control's template file, open the folder
siteroot\workarea\FrameworkUI\Templates\Search, and locate the .ascx file that
matches the control's name. For example,
siteroot\workarea\FrameworkUI\Templates\Search\SiteSearchResultsView.ascx.
NOTE: "Controller"controls only process data. Because they have no UI component, they do not have a
template file.
The default .ascx file affects all instances of a control on your website. However, you may
customize single instances of a control. To do so, see Customizing a Single Instance of a
Templated Search Server Control on the previous page.

Modifying a Templated Control's Markup
Within an </ItemTemplate> tag, use an eval statement <%# Eval() >) to access Ektron's
Search API object and expose its properties to the data binder. For example, <%# Eval
(“QueryText”)%> displays the search term in the search results.
As an example, you can remove the summary from the search results by deleting this line.
<div class="summary"><%# Eval("Summary") %></div>

Data Fields Available to an Eval Statement
Use an <%# Eval()> statement to determine which field properties appear in search results.
For example, <%# Eval("Summary")%> displays each content item's summary.
When you insert <%# Eval()> between a set of </ItemTemplate> tags, a model is passed to
the statement. Each set of controls has a model that determines available fields and
properties. For example, the SearchModel's Results property includes these fields:
l

Date (late edited)

l

Summary

l

Title

l

Type

l

Url

Discovering a Model's Fields Using the Object Browser
1. Open your Ektron website within Visual Studio.
2. Open the Object Browser.
3. In the Browse field, enter the set of controls whose model you want to view. For
example, ProductSearchModel.
Other models are SearchModel (covers content and XML Smart Forms) and
UserSearchModel. The model's fields appear in the right pane.
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4. To view any field's properties, enter its name into the object browser. Omit the angle
brackets (<>).

Modifying the Text Displayed by Templated Server Controls
To modify the text displayed by a templated control (for example, no results found), edit
the corresponding .resx file in the
siteroot\workarea\FrameworkUI\Templates\Search\app_loclaresources folder.
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For example, to edit text supplied by the Site Search template, edit
siteroot\workarea\FrameworkUI\Templates\Search\app_
loclaresources\SiteSearchInputView.ascx.resx.

Adding Search Server Controls to Visual Studio
1. Open your Ektron project in Microsoft Visual Studio 2010.
2. Open the Visual Studio Toolbox.
3. Add a tab and give it a name like Ektron Search.
4. Click Choose Items....
5. Click Browse.
6. Choose siteroot/bin/Ektron.Cms.Framework.UI.Controls.dll.
7. Click OK. The controls appear on the Toolbox tab

You should also add EktronUI controls to the Visual Studio toolbox at this time. See Adding UI
Server Controls into Visual Studio on page 1602.

Customizing Templated Server Controls
Injecting Your Own Service
Ektron's templated server controls use an MVC architecture, which is a common design
pattern for user interfaces. MVC consists of a
l

l
l

Model, which stores the state and accesses the application code used by the control;
resides in the service layer
View, which renders the data
Controller, which maps action inputs to the model and elements view; also performs the
business logic of the UI
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Because MVC architecture separates the display layer from the data layer, a designer can
work on the styling of the search results page, while a developer focuses on data being
rendered.

Creating a Custom Service
You can extend the functionality of templated server controls by creating a custom service.
For example, you can dynamically replace the content of the search results. You might want
to do this to create a profanity filter, or to implement a "blacklist" of replacement terms in
search results.
The following image illustrates the location of a custom (passthru) service within MVC
architecture.

.
The passthru service completes these steps.
1. Takes user input from View and Controller Layers.
2. Modifies it.
3. Sends modified data to Model Layer.
4. On the way back, can modify results again.
5. Send results to Controller.
6. Controller pushes results to the View Layer.

Creating a Custom Service Procedure
Use the siteroot/ektron.cms.framework.ui.unity.config file to map each search type to a
service. Below is the section of the file that accomplishes the mapping. By default, Ektron
search controls use ISearch.Service to take in and return data.
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Note separate register statements for regular searches, product searches, and user searches.
NOTE: The ISearchController service handles regular content and XML Smart Form searches.
<register
type="Ektron.Cms.Framework.UI.ISearchController, Ektron.Cms.Framework.UI"
mapTo="Ektron.Cms.Framework.UI.Services.SearchController,
Ektron.Cms.Framework.UI.Services"/>
<register
type="Ektron.Cms.Framework.UI.IProductSearchController,
Ektron.Cms.Framework.UI"
mapTo="Ektron.Cms.Framework.UI.Services.ProductSearchController,
Ektron.Cms.Framework.UI.Services"/>
<register
type="Ektron.Cms.Framework.UI.IUserSearchController,
Ektron.Cms.Framework.UI"
mapTo="Ektron.Cms.Framework.UI.Services.UserSearchController,
Ektron.Cms.Framework.UI.Services"/>

Follow these steps to create your own service and map it to a search type.
1. In Visual Studio, open siteroot/unity.ui.services.config.
2. Update the service registration with a new service name. This example assigns to
ISearchService a service named DemoSearchService.
<register
type="Ektron.Cms.Framework.UI.ISearchService,
Ektron.Cms.Framework.UI"
mapTo="Demo.DemoSearchService"/>

3. In Solution Explorer, right click the AppCode folder and select Add New Item.
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4. Select C# Class and give your new service a name.

5. Within the .cs file, insert this statement: using Ektron.Cms.Framework.UI;
6. Assign the name of the service that you are overriding. (Service names are listed in
unity.ui.services.config.)
public class DemoSearchService: ISearchService
{
}

7. Right click the mouse and select Implement Interface > Implement Interface.

8. Several statements like the one below are inserted. They provide inputs to the search
service.
public void AdvancedSearch(SearchModel model)
{
throw new NotImplementedException();
}

9. To create a passthru service, first instantiate the old mock search service. See Also:
Creating a Custom Service on page 976
public class demosearchservice : ISearchService
ISearchService searchService;
public DemoSearchService()
{
this.searchService= new MockSearchService();
}
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10. Inside the Advanced, Basic, GetXmlSearchFieldList and XmlSearch methods, call the old
service and pass in the same data. For example
public void BasicSearch(SearchModel model)
{
this.searchService.BasicSearch(model);
}

Now, when you drop inputview and resultsview controls on a page...
l

it instantiates the controller.

l

it ties the input and results view controls to the controller.

l

it instantiates the service, which ties the controller to the service.

Example 1: Any search returns “fifteen” for a result
1. Open the site search template page.
2. Within SiteSearchResultsView tags, insert a set of <itemtemplate> tags.
3. Within the <itemtemplate> tags, insert <%# Eval(“QueryText”) %>
<ektron:SiteSearchResultsView ID="SiteSearchResultsView1"
ControllerID="Scontroller" runat="server">
<ItemTemplate> <%# Eval(“QueryText”) %> </ItemTemplate>
</ektron:SiteSearchResultsView \>

4. Within the new.cs file that you created in Creating a Custom Service Procedure on
page 976, modify the value of QueryText. For this example, change the query text to
"fifteen." To do this, edit the .cs file, like this.
‘Public void BasicSearch(SearchModel model)
{
model.Querytext = “fifteen”; }

Example 2: Replace “Summary” with “Ektron” in all Results
This example shows how search results may be modified after they are retrieved (that is, on
the way back). To do this, edit the .cs file that you created in Creating a Custom Service
Procedure on page 976 like this.
Public void BasicSearch(SearchModel model)
{
model.Results.ForEach(result =>
{ result.Summary = result.Summary.Replace(“Summary”, “Ektron”); });
}

The above code loops through all results (Results.ForEach) and replaces "Summary" with
"Ektron" in each one.

Example 3: Remove First Result
This example shows how to remove the first search result that is retrieved. To do this, edit
the .cs file that you created in Creating a Custom Service Procedure on page 976 like this.
Public void BasicSearch(SearchModel model)
{
model.Results.RemoveAt(0);
}

Using the Advanced Query Text Parameter
Ektron 8.7
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The AdvancedQueryText parameter lets you customize the behavior of the search controller.
As examples, you can restrict search results to
l

content properties, such as
o content in a folder, or a folder and all of its child folders
o

l

user properties, such as
o tags set to "Race Car Fans"
o

l

Spanish-language content

email address includes "widgets.com"

eCommerce product properties, such as
o catalog number is between 1 and 10,000
o

sale price is less than $50 US

Here is a sample AdvancedQueryText statement that restricts search results by language and
folder.
(Assumes a SiteSearchController named siteSearchController1 is defined on my page)
<ektron:SiteSearchController ID="siteSearchController1"></ektron:SiteSearchController>

Set the AdvancedQueryText property in the code-behind for that page:
protected void Page_Init(object sender, EventArgs e)
{
siteSearchController1.AdvancedQueryText = string.Format(
"({0}:1033 AND {1}:10)",
SearchContentProperty.Language.Name,
SearchContentProperty.FolderId.Name);
}

The value assigned to AdvancedQueryText is appended to the user’s input.

Retrieving Folder vs. FolderPath
l

To reference a folder by id number, use folderid:10

l

To reference a folder and all of its children, use folderidpath:'10'

l

To exclude a folder but include all of its child folders, use (folderidpath:'10' AND NOT
folderid:10)
NOTE: You cannot use the root folder as part of the foldernamepath.

Obtaining Searchable Properties
The following links go to Ektron's searchable properties from the API.
l

http://reference.ektron.com/developer/framework/Search/SearchContentProperty/

l

http://reference.ektron.com/developer/framework/Search/SearchCustomProperty/

l

http://reference.ektron.com/developer/framework/Search/SearchECommerceProperty/

l

http://reference.ektron.com/developer/framework/Search/SearchGroupProperty/

l

http://reference.ektron.com/developer/framework/Search/SearchMetadataProperty/

l

http://reference.ektron.com/developer/framework/Search/SearchSmartFormProperty/

l

http://reference.ektron.com/developer/framework/Search/SearchUserProperty/

Allowed Operators in the AdvancedQueryText Parameter
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l

equals (=)

l

greater than (>)

l

less than (<)

l

contains (:)

Web Search Server Control
The Web Search server control lets you customize the behavior of search. You place this
control on any Web form from which a site visitor can search your site. For more information
about the site visitor experience, see Setting Up Search for Your Website.
The Web Search server control is deprecated in Ektron version 8.5 and higher. So, pages
created prior to 8.5 that use the Web Search server control should work with one important
exception: the Solr search provider is incompatible with the Web Search server control.
For new pages, developers are encouraged to replace the Web Search server control with
Templated Search server controls. See Also: Modifying Templated Server Controls on
page 972.
Property usage table

Property Usage Table
Web Search server control properties generally affect the control in one of three ways.
l

l

Search Display—the server control’s appearance on a Web page
o ButtonImgSrc
o

ButtonText

o

DisableForumSearch

o

EnableAdvanced Link

o

Hide

o

Language

o

MaxCharacters

o

ShowSearchOptions

o

Text Box Size

o

WrapTag

Search Criteria
o CustomSearch
o

FolderID

o

Language

o

Recursive

o

SearchFor

o

ShowCategories

o

ShowSearchOptions

o

ShowSuggested Results
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l

Search Results Display
o CustomOrderBy
o

DynamicContentTemplate

o

DisplayXslt

o

Hide

o

Language

o

LinkTarget

o

MaxTeaserLength

o

OrderBy

o

OrderDirection

o

RemoveTeaserHtml

o

ResultsPageSize

o

ResultTagId

o

ShowCustomSummary

o

ShowSearchBoxAlways

WebSearch property description

WebSearch Property Descriptions
The following table describes the Web Search server control properties. See Also: Property
Usage Table on the previous page.
The following are Ektron-specific server control properties. For information about native .NET
properties such as font, height, width and border style, use Visual Studio® help.
l

l

Authenticated (Boolean)Indicates if you are logged into the CMS Explorer and can use
it to browse to content, collections, and so on. See Also: Browsing Your Ektron Site Using
CMS Explorer on page 1610.
ButtonImgSrc(String)
If you want to display an image on the submit button, enter the server path to the image.

l

ButtonText(String)
The button text if no image source is identified in the ButtonImgSrc property. If an
image source is identified, this is alternate text for the button.

l

CustomOrderBy(String)
Provide a property’s Friendly Name defined in the Indexing Service to sort search results
by that property. For example, if you define DocAuthor, results are sorted by the
document’s author. A property's Friendly Name can be found in Computer
Management > Services and Applications > Indexing Service > Your Index >
Properties > Friendly Name column.
Results can be ascending or descending based on OrderDirection. If you enter an
invalid property, no search results are returned.
If you specify CustomOrderBy and OrderBy, the OrderBy property is ignored.

l
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If you want the search to include folders outside of Ektron, enter the folder names here.
Separate multiple items with a comma. You do not need to enter the folder path, but it
must reside within the site root folder. See Also: Including External Files in Your Search
on page 946.
l

DisableForumSearch(Boolean)
Set to true if you want to remove Forums from the list of content types that appears on
the Search server control. The default value is false. Regardless of this setting, if a user
selects Site from the list, forum posts are searched.

l

DisplayXslt(String)
Determines the display of the search results page.
o

None—databind only

o

ecmNavigation—lists the title of every content item found by the search

o

ecmTeaser—lists the title and summary of every content item found by the search
See Also: ecmTeaser Display Example on page 1682.

o

ecmUnOrderedList—sorts in no particular order. Shows the title and content
summary.

o

Path to Custom Xslt—Enter the path to an Xslt that determines the display of the
page.
WARNING! If you specify an external Xslt file, it is strongly recommended that you do not
store this file in your site's Workarea folder. If you store this file in the Workarea folder, the file
will be lost when you upgrade.
WARNING! If you enter a valid EkML file at the MarkupLanguage property, this property value
is ignored.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicContentTemplate(String)
Sets the template for dynamic content. This property overrides any quicklink template
for the content.

l

EnableAdvancedLink (Boolean)
Set to true to display an additional tab (Advanced) on the Search control. See Also:
Advanced Search on page 941.

l

FolderID(String)
The folder at which the search begins. The starting folder need not be the root folder.
The Recursive property determines if the search examines this folder’s subfolders. See
Also: Browsing Your Ektron Site Using CMS Explorer on page 1610.

l

Hide (Boolean)
Select False to display this server control on the page. Select True to suppress it.
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l

Language (Integer)
If the template on which this server control resides includes a language selection
control, and you want to let the site visitor select the language, enter zero (0).
Otherwise, click the field, then the ellipsis button and a popup box appears. Select a
language from the list.
This property shows results in design-time (in Visual Studio) and at run-time (in a
browser).

l

l

LinkTarget(String)Determines the type of window that appears when you click a link in
the server control.
o _Self (default)—opens in same window.
o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage(String)
Enter the template markup file (.ekml) that controls the display of this server control. To
use the default .ekml file, leave this field blank.
The default file follows this pattern: \siteroot\Workarea\template\this
object\objectname.ekml. For example,
\siteroot\Workarea\template\collection\collection.ekml.
To customize the default .ekml file, copy it to a folder outside the siteroot\workarea
folder and edit it. Next, in this property, enter the path to that file relative to the site root
folder.
See Also: Controlling Output with Ektron Markup Language on page 1905,
websearch.ekml on page 1916.
NOTE: If you enter a valid EKML file at the Markup Language property, the Dispay xslt property
value is ignored. If the EkML file contains the [$ImageIcon] variable, the IncludeIcons
property acts as True.

l

MaxCharacters(Integer)
The maximum number of characters the Search text box accepts. If you enter less than
50, set the TextBoxSize property to the same number.

l

MaxTeaserLength(Integer)
Limits the length of any returned content’s abstract. To allow unlimited length, set to
zero (0). This property is active only if both of these conditions are true.

l

o

You use the DisplayXslt property to identify an xslt and ecmteaser as a value of
that property. If you enter an .ekml file at the MarkupLanguage property, this value
is ignored.

o

the ShowCustomSummary property is set to false. If it is set to true, the entire
summary appears in search results.

OrderBy(String)
The field that determines the sorting of search results.
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NOTE: The Order Direction field determines the direction of the search results. For example, if
you sort by ID and Order Direction is set to Descending, the results sort by ContentID with
the highest ID number at the top of the list.

l

o

Title—The content title (alphabetical)

o

ID—The content ID number

o

Date Created—The date the content was created

o

Date Modified—The date the content was most recently modified

o

Editor—The user who last edited the content (alphabetical)

o

Rank—The content's rank. See Also: Search Result Ranking.

OrderDirection(String)
The direction in which search results are sorted. The default is Ascending.
Ascending—Alphabetical results from A to Z; numeric values low to high; dates from
oldest to most recent
Descending—Alphabetical results from Z to A; numeric values high to low; dates from
most recent to oldest

l

Recursive(Boolean)
Determines whether to search sub-folders of the starting folder. The FolderID property
determines the starting folder.

l

RemoveTeaserHTML(Boolean)
Set to true if you want to remove HTML tags from the content summary within search
results.

l

ResultsPageSize (Integer)
Set the maximum number of search results on a page. If a search returns more than this
many results, the following text appears below the last one:
Result Page: 1 2 3 Next
The user can click Next or a number to view additional results.
This property defaults to the value set at the ek_PageSize element in the
siteroot\web.config file.
Property’s Effect on Suggested Results
Only the number of Suggested Results up to this maximum appear. If more than this
number should display, they do not. This is unlike natural search results, whose
additional links are available via numbers below the maximum page size.
See Also: Providing Suggested Results on page 952.

l

ResultTagId(String)
Lets you designate where search results appear. You can place search criteria in one
area of a Web form and results in another. For example, you have the following tag.
<span id=”results”></span>

In this case, enter results for this property's value.
l

SearchFor(String)
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Choose the type of content that may be searched via this control.
o

All

o

HTML

o

Documents

o

Images

o

Multimedia

o

Discussion Forums

o

Tags

o

eCommerce products

o

PageBuilder

If the value is anything other than All, this server control only examines the selected
content type.
IMPORTANT: If this property is set to anything other than All, the search options drop-down does
not appear.
l

SearchSynonyms (Boolean)
If set to true, the Synonym Search is included with the search. If false, Synonym Sets
are ignored. See Also: Using Synonym Sets on page 945.

l

ShowCategories (Boolean)
If set to true, this server control displays a Filter by Category option, which helps a
site visitor zero in on relevant content. If false, Filter by Category does not appear.
IMPORTANT: In order for the Filter by Category option to appear, the ShowSearchBoxAlways
property must be set to true.
As explained in Organizing Content with Taxonomies, the Taxonomy feature lets users
assign information categories to content. For example, if your organization is a
university, taxonomy categories might be Athletics, Alumni, Admissions, Academic
Departments, and so on. As new content is created, users should apply relevant
taxonomy categories to it. This enables a site visitor to search by category and search
terms. For example, if the search term is calendar and the category is Athletics, the
search would typically return calendars of sports teams but not other calendars, such as
those for graduation, exams, or parent weekend.
NOTE: This property depends on the assignment of taxonomy categories to content. If they are not,
the filter hides relevant but unclassified content.
For example, an author creates an article on “Treating Heart Disease” but doesn't assign a
taxonomy category to it. If a site visitor on a search page selects Filter by Category then the
Medical Forum > Heart Disease category, he will not find that article.
A developer can control whether results must match all categories selected in the Filter
by Category tree, or at least one category. To display results that must match all
categories, set the TaxonomyOperator property to And. To show results that match one
or more categories, set TaxonomyOperator to Or. By default, the property is set to Or,
which provides a wider range of results.
Effect of Setting ShowCategories to True
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If you set ShowCategories to true, initially the site visitor sees no difference. Upon
entering a search term that exists in content to which a taxonomy category is assigned
and clicking Search, Filter by Category appears above the results (illustrated below).
—Image—

l

ShowCustomSummary (Boolean)
If set to true, the search results display the content item’s summary. If false, the
search results display the characterization. The default is false.
NOTE: If this property is set to true, the MaxTeaserLength property is ignored. So, the entire
summary appears with search results, regardless of length.

l

ShowSearchBoxAlways (Boolean)
If set to true, the search box appears on the PostBack screen. If false, the search box
does not appear on the PostBack screen. The default is true.

l

ShowSearchOptions (Boolean)
If set to true, the following drop-down appears to the right of the Search box.
—Image—

A site visitor can click an option to limit the search by content type. If the user accepts
the default value, Site, all content types are searched.
WARNING! If the SearchFor property is set to anything other than All, the search options dropdown does not appear.
NOTE: If the DisableForumSearch property is set to true, Forums does not appear in the dropdown.
l

ShowSuggestedResults (Boolean)
If set to true, Suggested Results related to the search term appear. If false, Suggested
Results do not appear. See Also: Providing Suggested Results on page 952.
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NOTE: If the ResultsPageSize property value is less than the number of suggested results
applied to a term or synonym set, only the property’s number of results appears. For example, if you
assign five links to a Suggested Result set but set ResultsPageSize to three, only the first three
results appear.
l

Stylesheet(String)
If you want to define a style sheet for the search results page, specify its path relative to
the site root folder. For example: Workarea\csslib\mytest.css. Leave blank to use
the default style sheet, webroot\Workarea\csslib\search.css.
WARNING! If you enter a valid EkML file at the MarkupLanguage property, or a value at the
DisplayXslt property, this property is ignored.

l

SuppressWrapperTags (Boolean)Suppresses the output of the span/div tags around
the control.
o True—Suppress wrap tags.
o

l

False (default)—Allow wrap tags.

TaxonomyOperator (Enum-TaxCategoryOperator)
Select whether to use an And or Or operator when filtering results by taxonomy. the
default value is Or.
And—Only results that match all categories selected in the Filter by Category tree
appear. For example, if a site visitor is searching for a medical document in the Hospital
and Doctor’s Office categories, only documents assigned to both categories appear.
Or—If more than one category is selected in the Filter by Category tree, results needs to
only match one category to be shown.
NOTE: For this property to be active, the ShowCategories property must be set to true.

l

TextBoxSize (Integer)
The size of the search text box for user input, in number of characters.

l

WrapTag(String)Lets a developer specify a server control’s tag.
o Span (default)—designate an inline portion of an HTML document as a span
element.
o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Troubleshooting Search
Problem: You publish a Visio® document but the search cannot find it.
Solution 1: Make sure the Visio iFilter is installed. See Installing the Visio IFilter on
page 943.
Solution 2: Does the content have a non-standard alias extension? Aliases that use standard
extensions are not a problem. However, you can create custom alias extensions. See Also:
Creating User-Friendly URLs with Aliasing on page 835. If you do, that content is searchable
only if you add the custom extension to Search Server's extension list. From the Search
Server Administration page, click File types > New File Type, and add the custom
extension. Then, run a full crawl to index these pages.
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Solution 3: Is the content stored in a Smart Form field whose type is content? Search does
not support Smart Form fields with an Advanced type of Content (instead of Attribute or
Element). Smart Form fields that need to be indexed must have a type of Attribute or
Element.
Problem: SearchConfigUI.exe crashes while building search indexes and catalogs
Solution:
1. Make sure the metaconfig.doc file exists in the siteroot/uploadedfiles directory. If
it does not, ask Ektron Support to send you a new file.
2. If anyone uploaded Visio documents to your server, make sure the iFilter is installed.
See Installing the Visio IFilter on page 943.
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The Digital Experience Hub (DxH) lets users of SharePoint®, HubSpot®, Salesforce®,
Marketo® Lead Management, Microsoft Dynamics® CRM seamlessly interact with your
Ektron-powered website.
l

SharePoint—After an Ektron administrator sets up DxH to map SharePoint content to
Ektron, an end user only needs to place content in a SharePoint folder to update their
Ektron-powered website; the content is automatically transferred to the
EktronWorkarea. See Why SharePoint Can Make Your Web Content Management Project
Successful.
You also can manually import SharePoint content from the Ektron Workarea.

l

HubSpot, Salesforce, Marketo Lead Management, Microsoft Dynamics CRM—transfer
content from Ektron HTML forms to the external application. A site visitor can submit a
form, questionnaire, or survey that automatically creates a record with that data in the
external application.

Connections vs. Mapping
Connections and mappings are key concepts in DxH configuration.
l

l

A connection specifies an endpoint (URL or API path) and authentication credentials that
allow communication between 2 software instances. First, you connect Ektron to DxH,
then you connect DxH to external applications.
o An inbound connection is a special type that updates Ektron content as content is
changed in an external application.
A mapping determines what data is passed between 2 software instances in a
connection. Each mapping varies according to the needs of the external application.
o Mapping to SharePoint involves importing content from a SharePoint site into
Ektron.
o

Mapping to Marketo, Microsoft Dynamics, HubSpot, or Salesforce creates a
relationship between fields in an Ektron HTML form and fields in the external
application. When a site visitor submits a mapped form, its data is routed from
Ektron through DxH to the external application.

DxH Architecture
DxH architecture connects Ektron to external systems, and shares data and content with
third-party applications. DxH includes these components:
l

Digital Experience Hub—The core component that transfers information between
Ektron and external applications through application-specific connectors.

l

Inbound Connector—Transfers information between Ektron and DxH.

l

HubSpot Connector—Transfers information between HubSpot and DxH.

l

Marketo Connector—Transfers information between Marketo Lead Manager and DxH.

l

Microsoft Dynamics® Connector—Transfers information between Microsoft
Dynamics CRM and DxH.

l

Salesforce® Connector—Transfers information between Salesforce and DxH.

l

SharePoint® Connector—Transfers information between SharePoint and DxH.

The following figure shows the relationship among DxH components, Ektron, and external
applications.
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Example: Adding a Case to Salesforce
You want to let customers alert you about an issue on your website and use that information
to create a Salesforce case and subsequent customer contact.

1. An Ektron administrator has previously set up:
l
an inbound DxH connection, which exchanges information between Ektron and DxH
l

a Salesforce connection, which coordinates with the Salesforce administrator to
determine path and authentication information
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2. The Ektron user coordinates with their Salesforce business partner to determine what
data is required to create a Salesforce case.
3. The Ektron user creates a form to capture customer information concerning an issue,
such as name, contact information, product name, issue type and description.
4. The Ektron user maps the form's fields to fields in Salesforce.
5. The Ektron user publishes the form to the website.
6. A customer accesses the website and submits the form reporting an issue.
7. The form goes to DxH, which uses the Salesforce Connector to route the data to
Salesforce.
8. Salesforce creates a case and, if applicable business logic is in place, routes the case to
a call center.
For details about the using Salesforce with DxH, see Configuring DxH for Mapping Form Data
on page 1018.
Example: Targeting Content Based on a Lead
You want to capture site visitor information, create a lead based on it, then display targeted
content when that visitor revisits the site.
The Targeted Content widget lets you personalize your site visitors' experience by providing
content that matches their interests, thereby placing your site information in the context of
your users. For example, the search keywords used to find your site might determine the best
offer to show a prospect. Or, site members might explicitly state their interests by adding to
their user profile or filling out a survey. For information about the Targeted Content widget,
see Using Widgets on page 711.

1. An Ektron administrator has previously set up:
l
DxH inbound connection
l
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Salesforce connection, coordinating with the Salesforce administrator to determine
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2. Ektron user coordinates with a Salesforce business partner to determine data required to
create a Salesforce lead.
3. Ektron user creates a form to capture required information from a customer, such as
name, contact information, and product of interest.
4. Ektron user maps the form's fields to fields in Salesforce.
5. A customer accesses the website and submits the form.
6. The form goes to DxH, which uses the Salesforce Connector to route the data to
Salesforce.
7. Salesforce creates a lead and, using the mapping, associates it with the visitor.
8. When the visitor returns to the site, DxH queries Salesforce for the associated lead
properties.
For details about the DxH > Targeted Content connection, see Using the Targeted Content
Widget with External Application Data on page 1022.
Example: Importing SharePoint Content
You want to display SharePoint content on your website. The content is updated when changes
are made in SharePoint.

1. An Ektron administrator has previously set up:
l
a DxH inbound connection
l

a SharePoint connection, coordinating with the SharePoint administrator to
determine path and authentication information.

2. A user places content into a SharePoint folder that is mapped to the Ektron Workarea. A
copy of the content is updated in the Workarea.
3. As that content is updated in SharePoint, it is automatically updated in the Workarea.
For details on the DxH > SharePoint connection, see Setting Up the Import of SharePoint Files
to Ektron on page 1009.
Webinars
l

Overview of DxH

l

DxH Developer Webinar

API Reference
l

DxHConnectionManager

l

DxHUserConnectionManager

l

DxHMappingManager

Sample DxH Connector and Documentation
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Installing and Configuring DxH
DxH System Requirements
l

Ektron 8.6 or higher

l

DxH version 1.2—See Also: Upgrading DxH to Version 1.2 on the facing page

l

Server—Same as Installing Ektron on page 9

l

l

Network—By default, DxH uses port 808 to communicate between Ektron and external
applications. Whichever port you use, ensure it is open on your firewall.
o You must enable the Microsoft Windows Net.TCP Port Sharing Service (see How to:
Enable the Net.TCP Port Sharing Service).
External applications
o SharePoint®
o SharePoint 2010: Foundation, Standard, or Enterprise Editions
o

l

SharePoint 2007: Windows SharePoint Services 3.0, MOSS 2007

o

Salesforce®—Group, Professional, Enterprise, and Unlimited Editions

o

Marketo—Spark, Professional, and Enterprise Editions

o

Microsoft Dynamics® CRM—Microsoft Dynamics CRM 2011, Workgroup,
Professional, Enterprise, and Service Provider Editions

o

HubSpot®—Enterprise

You have administrator privileges or privileges to install DxH and create database

Installing DxH
You can install DxH on the Ektron server or on its own server.
NOTE: If you previously installed DxH, you can upgrade to the current version. See Also: Upgrading DxH
to Version 1.2 on the facing page
1. Contact your Ektron account manager to obtain a link to download the Digital Experience
Hub. See Also: Contact Ektron.
2. If you want to install DxH on the Ektron server, log into the Ektron server as an
administrator (or as a user with privileges to create a database).
3. Download DxHInstaller.exe to the server to which you will install it.
4. Run DxHInstaller.exe.
5. Accept the license agreement and click Next. The port setup screen appears.
Port 808 is the default value. If you want to use a different port, change it on this screen
then follow Step 14.
6. The SQL Server DB Setup screen appears. In the Server field, enter the machine hosting
the Microsoft SQL database. By default, the field is populated with (local). If you are
using SQLExpress, use machine_name\SQLExpress.
You can use either a domain or SQL Server account when creating the DB. For Ektron, we
typically create a dedicated domain or SQL Server account for the database.
7. Enter the Username and Password for the server. For Trusted Connections, leave the
fields empty.
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8. Click Next. The database connection is tested. If the test is passed, the Ready to Install
the Program screen appears.
9. Click Install. The Setup Status screen appears, followed by several screens indicating
components being installed.
10. The finish screen appears, displaying the URL for connecting to DxH from Ektron. Save
this information for later use.
NOTE: You can access this information at any time via the Windows Start button > All Programs
> Ektron > Dxh > Dxh Connection URL.

11. Click Finish.
12. Open your siteroot/web.config file and find this tag:
<endpoint address="net.tcp://localhost:808/EktronConnector/tcp/EktronFormService"
binding="netTcpBinding"
bindingConfiguration="ContextBusNetTcpBinding" contract="IEktronFormService"
name="NetTcpBinding_IEktronFormService" />

13. Change localhost to the site domain where DxH is installed. For example, if DxH is
installed to the domain myDxhService, the endpoint address would be
net.tcp://
myDxhService:808/ContextBus/EktronConnector/tcpEktronFormService.
14. If you changed the port in Step 5, edit the port number in the following line of
web.config.
<endpoint address=”net.tcp://localhost:808/EktronConnector/tcpEktronFormService”
binding=”netTcpBindding” contract=”IEktronFormService” name=”NetTcpBinding_
IEktronFormService” />

Upgrading DxH to Version 1.2
Ektron 8.7
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PREREQUISITE
You downloaded DxH version 1.2. If you have not done that, contact your Ektron
account manager.
To upgrade from version 1.0 or 1.1 to 1.2 of DxH:
1. Identify the port and database used by DxH. To find this information:
a. Navigate to the folder C:\Program Files
(x86)\Ektron\DigitalxHub\ContextBusServiceHost.
b. Open the CBSvcHost.exe.config file.
c. Find the <endpoint tag.
<endpoint name="ContextBus_IEventManager"
address="net.tcp://SQA003:1234 /ContextBus" binding="netTcpBinding"
bindingConfiguration="ContextBusNetTcpBinding"
contract="Ektron.DxH.Events.IEventManager">

d. To find the port within the endpoint tag, locate the address field, following the
server name. Write down the port number (red in the above example).
e. Within CBSvcHost.exe.config, find the <connectionStrings tag.
<add name="CBDatabase" providerName="System.Data.SqlClient"
connectionString="server=(local);database=EktronDxH;Integrated
Security=true;user=;pwd=;" />

f. To find the database within the add tag, locate the database field's first value (red
in the above example).
2. Using SQL Server, back up the database you identified in Step 1f.
3. Uninstall DxH 1.0 or 1.1. If you are prompted to reboot, do so.

4. Install DxH 1.2. See Installing DxH on page 996.
5. When asked for port, use the port number you found in Step 1d.
6. Open C:\Program Files
(x86)\Ektron\DigitalxHub\ContextBusServiceHost\CBSvcHost.exe.config.
7. Edit the CBDatabase entry to point to the database name you found in Step 1f.
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New IConnector.DeleteObjectInstance Method
To support consistent and standard communication between DxH and connectors for deleting
data, a new IConnector method was added, DeleteObjectInstance. Since IConnector
already has save and get methods, this method rounds out data persistence operations with
the ability to delete.
This method lets users optionally delete content from Ektron when related content is deleted
from SharePoint. As such, only the Ektron connector’s implementation of this method is
required for 8.7. Other connectors only need to be updated to maintain technical compatibility
with DxH.
Connector-specific operations that support deletes are still supported. However, all
connectors need to implement this method to maintain technical compatibility with DxH 1.2,
as part the 8.7 release. DxH does not load connectors that do not accommodate this new
method. Instead, a message is logged, indicating that the connector is not loaded.

Minimal Implementation
The following minimal implementation maintains compatibility with DXH 1.2.
public List<DeleteMessage> DeleteObjectInstance(ObjectInstance objectInstance)
{
try
{
throw new NotImplementedException();
}
catch (Exception ex)
{
string msg = string.Format("DeleteObjectInstance could not delete
ObjectInstance:
{0}", ex.Message);
log.LogMessage(msg, "MyConnector", LogSeverity.Error, EventID.ENDPOINT_
ERROR);
throw new FaultException<ExceptionDetail>(new ExceptionDetail(ex), new
FaultReason(msg));
}
}

Using this implementation, any solution which asks your connector to delete data receives an
error that the method is not supported on the connector.

DeleteMessage
In Ektron 8.7, no out-of-the-box solutions call this method on connectors beyond what is
outlined above, But, Ektron recommends implementing the DeleteObjectInstance to make
your connector more flexible for solution developers.
To accomplish this, treat the return type DeleteMessage the same way you treat
SaveMessage when persisting data in your connector, via the SaveObjectInstance method.
DxH interacts with DeleteMessages (and SaveMessages) by logging the message text with
the appropriate severity in the DxH log. Naturally, the connector developer is responsible for
the work of deleting and reporting success.

Setting up a DxH Connection to Ektron
After installing DxH, set up a connection between DxH and Ektron.
Ektron 8.7
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NOTE: If you are setting up a SharePoint connection, and your SharePoint version contains multiple
sites, create a connection for each SharePoint site with which you want to connect.
1. Go to Workarea > Settings > Digital Experience Hub > Connect to DxH. The
Connection to the Digital Experience Hub screen appears.
2. Insert the URL that you obtained in Step 10 of Installing DxH on page 996 and click Test
Connection.
NOTE: You can access this information from Windows Start menu > All Programs > Ektron >
DxH > DxH Connection URL.

3. Click Connect to DxH. If everything is working properly, you see a message that the
connection was successful.
4. You are prompted to set up an inbound connection. See Configuring an Inbound
Connection on the facing page.

Editing a DxH Connection
IMPORTANT: Editing a DxH connection may change the relationship between Ektron and DxH, which
may interrupt data transfer between external applications and Ektron.
1. Go to Workarea > Settings > Digital Experience Hub > Connections. The View
All Digital Experience Hub Connections screen appears.
2. Hover over a DxH connection and choose Edit. The Edit Connection to the Digital
Experience Hub dialog appears.

3. Edit the information as required.
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4. Click Test Connection. If the test fails, an error message appears. Verify that you have
the correct URL and that it was entered correctly.
5. Click Update Connection.

Deleting a DxH Connection
IMPORTANT: Deleting a connection stops data transfer between Ektron and an external application.
1. Go to Workarea > Settings > Digital Experience Hub > Connections. The View
All Digital Experience Hub Connections screen appears.
2. Hover over a DxH connection and choose Delete. The Delete Connection to the Digital
Experience Hub dialog appears.

3. Click Confirm.

Configuring an Inbound Connection
After installing and connecting DxH to Ektron, you can establish an inbound connection, which
lets you transfer information between Ektron and DxH. From DxH, the information can be
sent to external applications. See Also: DxH Architecture on page 992
1. Go to Workarea > Settings > Digital Experience Hub > Connections. The View
All Digital Experience Hub Connections screen appears.
2. Click Add Connection > Add Inbound Connection. The Add Inbound Connection
dialog appears.
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3. In the Connection Name field, enter a unique, user-friendly name.
4. Optionally change the UserID field (which defaults to the logged-in user) to the Ektron
administrator who will act as the connection manager.
IMPORTANT: Enter an Ektron Administrators group member. Many DxH features use the Inbound
Connector user, not the logged-in user, to perform DxH functions. Administrative privileges are
required to complete many DxH tasks.
5. Enter the password for the user.
6. If Active Directory is being used for authentication, enter your Active Directory server
Domain.
7. If you are using a multi-site setup, select another instance in the Site URL field (which
defaults to the current Ektron instance).
8. Click Test Connection. If the test fails, check your credentials and Site URL and try
again.
9. When the connection test is successful, click Save Connection.
10. Click OK. The View All Digital Experience Hub connections screen appears.

Configuring a Connection to an External Application
Adding an External Application Connection
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PREREQUISITES
l

l

l

You are a member of the Ektron Administrators group or assigned a DxH
Administrator role.
The following components are installed and configured: DxH, DxH connection,
and inbound connection. See Installing DxH on page 996.
You have access information for external applications that will connect with
Ektron via DxH. Obtain this information from the external application
administrator before adding a connection.
l
Marketo
o API path (URL)

l

l

l

l

o

Client ID

o

Encryption Key

Microsoft Dynamics
o Username
o

Password

o

Fully Qualified Domain Name

o

Organization Name

Salesforce
o API Key (security token)
o

Username

o

Password

SharePoint
o URL
o

Domain

o

Username

o

Password

HubSpot
o API Key (hapikey)

IMPORTANT: After you create a connection, you cannot change its name. This restriction prevents you
from accidentally overwriting a connection. To rename a connection, delete it then add it again with a new
name, as described in Deleting Connections to External Applications on page 1005.
To add an external application connection:
1. Go to Workarea > Settings > Digital Experience Hub > Connections. The View
All Digital Experience Hub Connections screen appears.
2. Hover over Add Connection and select a connection. The Add Connection dialog
appears.
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3. Enter a unique, user-friendly name in the Connection Name field.
4. Enter required information.
5. Click Test Connection.
l
If the test is successful, proceed to the next step.
l

If the test fails, an error message appears. Verify that you entered the correct
connection information.

6. Click Save Connection.

Editing a Connection to an External Application
IMPORTANT: If you rename a SharePoint Connection, the associated Workarea folder is also renamed.
1. Go to Workarea > Settings > Digital Experience Hub > Connections. The View
All Digital Experience Hub Connections screen appears.
2. Hover over the connection and choose Edit from the pop-up menu. The Edit Connection
dialog appears.
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3. Edit the path or authentication information as required. You cannot edit the connection
name.
4. Click Test Connection. If the test fails, an error message appears. Verify that you have
the correct path and authentication information
5. Click Save Connection. The View All Digital Experience Hub connections screen
appears.

Deleting Connections to External Applications
IMPORTANT: Deleting a connection removes the relationship between the instance of the external
application and DxH.This action stops all data transfer.
1. Go to Workarea > Settings > Digital Experience Hub > Connections. The View
All Digital Experience Hub Connections screen appears.
2. Hover over the connection and choose Delete from the menu. A confirmation dialog
appears.
3. Click Delete.

Setting up the SharePoint Receiver
The SharePoint Receiver automatically transfers updated SharePoint content to Ektron. Any
edit to a SharePoint document/file or its properties triggers an update.
After you import SharePoint content to Ektron (as described in Importing SharePoint Files,
Lists, and Libraries to Ektron on page 1012), the receiver monitors that content, and transfers

Ektron 8.7

1005

Setting Up the Digital Experience Hub

updated files from SharePoint to Ektron with no intervention. The imported file overwrites the
current version, if one exists.
This section explains how to set up the SharePoint Receiver.
NOTE: Do not confuse the SharePoint Receiver (described above) with a SharePoint connection. A
connection specifies an endpoint (URL or API path) and authentication credentials that allows
communication between 2 software instances.
PREREQUISITES
l

l

The SharePoint Receiver installation file. Contact your Ektron account manager to
obtain a link to download this file.
Permission to install and edit files on the SharePoint server.

Setting Up the SharePoint 2010 Receiver
1. Run the SharePoint Receiver installation file on a SharePoint server.
2. Go to the SharePoint Central Administration screen > System Settings >
Manage Farm Solutions. Make sure the status of ektronsharepointreceiver.wsp is
Deployed.
3. Log into your SharePoint Web application.
4. Access the Site Settings screen > Manage Site Features.
5. Click Activate to activate the EktronSharePointReceiver.

6. Place the following bindings into each SharePoint Web application's top-level
web.config file (which resides within the content root folder). Insert bindings within the
<system.servicemodel> section.
<bindings>
<netTcpBinding>
<binding name="SharePointConnectorNetTcpBinding"
portSharingEnabled="true" closeTimeout="00:02:00"
openTimeout="00:02:00" receiveTimeout="00:10:00"
sendTimeout="00:02:00" maxBufferSize="2147483647"
maxConnections="10" maxReceivedMessageSize="2147483647">
<readerQuotas maxStringContentLength="2147483647"
maxArrayLength="2147483647" maxBytesPerRead="2147483647"
maxNameTableCharCount="2147483647"/>
<security mode="None">
</security>
</binding>
</netTcpBinding>
</bindings>
<client>
<endpoint name="SharePointAdapter_ISharePointEventReceiver"
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address="net.tcp://localhost:9002/SharePointConnector/tcp/SharePointEventReceiver"
binding="netTcpBinding"
bindingConfiguration="SharePointConnectorNetTcpBinding"
contract="Ektron.DxH.SharePointConnector.Common.ISharePointEventReceiver">
</endpoint>
</client>

7. In the <endpoint> address property, update the text following net.tcp:// (in red
above) to indicate the path and port to which DxH is installed.

Setting Up the SharePoint 2007 Receiver
1. On the SharePoint server, run the SharePoint Receiver installation file.
2.

Verify the SharePoint receiver is deployed. To do this:
a. Click Start > Administrative Tools > SharePoint 3.0 Central
Administration.
b. Log in to the Central Administration site.
c. Under Global Configuration, select Solution Management.
d. Check that the entry for SharePoint receiver is deployed.

3. Log into your SharePoint site.
4. Click Site Actions > Site Settings.

5. Select Site Features.

Ektron 8.7

1007

Setting Up the Digital Experience Hub

6. On the Site Features screen, click Activate to activate the EktronSharePointReceiver.
7. Open each SharePoint Web application's top-level web.config file (which resides within
the content root folder).
8. Place the following bindings into that file, within the <system.servicemodel> section.
<bindings>
<netTcpBinding>
<binding name="SharePointConnectorNetTcpBinding"
portSharingEnabled="true" closeTimeout="00:02:00"
openTimeout="00:02:00" receiveTimeout="00:10:00"
sendTimeout="00:02:00" maxBufferSize="2147483647"
maxConnections="10" maxReceivedMessageSize="2147483647">
<readerQuotas maxStringContentLength="2147483647"
maxArrayLength="2147483647" maxBytesPerRead="2147483647"
maxNameTableCharCount="2147483647"/>
<security mode="None">
</security>
</binding>
</netTcpBinding>
</bindings>
<client>
<endpoint name="SharePointAdapter_ISharePointEventReceiver"
address="net.tcp://localhost:9002/SharePointConnector/tcp/SharePointEventReceiver"
binding="netTcpBinding" bindingConfiguration="SharePointConnectorNetTcpBinding"
contract="Ektron.DxH.SharePointConnector.Common.ISharePointEventReceiver">
</endpoint>
</client>

9. In the <endpoint> address property, update the text following net.tcp:// (in red
above) to indicate the path and port to which DxH is installed.
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Deactivating the SharePoint Receiver
To suspend automatic updating of SharePoint content in Ektron:
1. Log into your SharePoint Web application.
2. Access the Site Settings screen > Manage Site Features.
3. Deactivate the Ektron SharePoint Receiver.

Monitoring DxH Transactions
Use the DxH Error Log to monitor transactions related to DxH connections and troubleshoot
problems. For example, connection failures involving multiple connector types may
correspond to network outages, or a specific connector failure may correspond to an event
such as an application upgrade in progress.
1. Go to Workarea > Settings > Digital Experience Hub > Connections. The View
All Digital Experience Hub Connections screen appears.
2. Click View Error Log. The DxH log includes the following information:
l
Severity—The category of log entry: information, warning, or error.
l

l

Log ID—The system-assigned identifier for the event. Use this ID when
communicating with others about issues to help them locate the specific event.
Date/Time—The date and time that the event occurred, displayed in the time zone
of the server hosting DxH, and formatted based on the user's language settings.
The Coordinated Universal Time (UTC) variance is shown in the bottom right corner
to facilitate sharing log information between time zones.

l

Source—The component in which the event was detected.

l

Event ID—An identifier indicating the type of event detected.

l

Message—Text describing the error. Message is truncated at 180 characters. To
display the remainder, click more...

You can sort and filter the DxH log as required.

Setting Up the Import of SharePoint Files to
Ektron
NOTE: For background about how DxH can import SharePoint content, see Example: Importing
SharePoint Content on page 995.
This section explains how to set up the import of SharePoint files to Ektron. Before beginning
the import process, you should
l

l

l

Install DxH, set up an inbound connection then a SharePoint connection—see Installing
and Configuring DxH on page 996
Install the SharePoint Receiver, which handles the automatic update of content imported
from SharePoint to Ektron—see Setting up the SharePoint Receiver on page 1005
Prepare Ektron metadata definitions to match SharePoint metadata—see Preparing
Ektron Metadata to Support SharePoint Import on the next page
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After completing these tasks, you select SharePoint content to import. This involves selecting
SharePoint lists, libraries or individual files and then mapping Ektron metadata fields to
SharePoint metadata fields. Once the import is set up, the SharePoint Receiver automatically
transfers the following changes to the Ektron import folder.
l

Within selected SharePoint lists or libraries, content is added, deleted, or updated

l

Selected content is updated or deleted
NOTE: While setting up the import,users determine if deletes to SharePoint content affect the
Ektron version of that content.

Preparing Ektron Metadata to Support SharePoint
Import
NOTE: If you are not familiar with Ektron metadata, please read Working with Metadata on page 369.
While setting up the import of SharePoint files to Ektron, you may map SharePoint metadata
to Ektron metadata. (In SharePoint, extra information about files is stored in columns, which
are equivalent to metadata.) If you map, as SharePoint content is imported to Ektron,
SharePoint metadata values are applied to corresponding Ektron metadata fields.

NOTE: To complete step 1, you must either have access SharePoint, or ask your SharePoint
administrator for the information that is collected.
To prepare Ektron metadata to map to SharePoint fields:
1. Obtain the type of each SharePoint column/metadata field you want to import to Ektron.
To do so,
a. Go to the SharePoint library or list that contains the content.
b. Click Library Settings > Columns.
c. Within the Columns area, find each SharePoint column/metadata field applied to
the folder and its type.
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IMPORTANT: You can only choose SharePoint column types that correspond to these Ektron metadata
types:
* Byte
* Date
* Double
* Float
* Integer
* Long
* Multiple selections
* Number (generic)
* Select from a list
* Short
* Text
* Yes or no
For example, you cannot choose the SharePoint column type Person or Group, because there is no
corresponding Ektron metadata type.
2. Ektron Workarea > Settings > Configuration > Metadata Definition.
3. Click Add Metadata Definition.
4. Enter a Name for the metadata definition.
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5. For Type, choose Searchable Property.
NOTE: You can only map Searchable Property metadata types to SharePoint files.
6. In the Style field, select a type that matches the SharePoint column field type obtained
in Step 1. See Also: Adding a Metadata Definition on page 370
l
The SharePoint type of Choice > Drop-Down Menu or Radio Buttons maps to
the EktronSelect From a List style.
l

The SharePoint type of Choice > Checkboxes (allow multiple selections)
maps to the Ektron Multiple Selections style.

l

The SharePoint type of Currency maps to the Ektron Float style.

l

The SharePoint type of Yes/no (check box)maps to the Ektron Yes or No style.

7. Repeat Steps 3 through 6 for each metadata definition you want to import.
8. Assign the metadata definitions to folders to which you will import SharePoint content.
See Also: Assigning Metadata to a Folder on page 377
9. Import one SharePoint document to Ektron and verify that its metadata imports
correctly. If it does not, try applying a different Style to the Ektron metadata definition.
NOTE: If you add a new metadata definition but do not see it on the DxH Map Metadata to Ektron Folder
screen, reset IIS on the Ektron server.
After you verify that the SharePoint fields are properly mapped to Ektron metadata fields,
proceed with the other aspects of importing SharePoint content to Ektron.

Importing SharePoint Files, Lists, and Libraries to
Ektron
This section explains the importing of SharePoint files to Ektron. This process, which maps
SharePoint lists, libraries, or individual files to an Ektron folder, accomplishes 2 tasks:
l
l

Immediately starts to import selected SharePoint files, lists, and libraries.
If the SharePoint Receiver is activated, all updates to and deletions of SharePoint files
trigger an automatic update/deletion to the version stored in Ektron. Also, new files
added to SharePoint lists and libraries are automatically copied to the mapped Ektron
folder.

Prerequisites
PREREQUISITES
l
l

l

l

l

DxH is installed See Also: Installing and Configuring DxH on page 996
An inbound connection is established See Also: Setting up a DxH Connection to Ektron on
page 999
A SharePoint connection is established See Also: Configuring a Connection to an External
Application on page 1002
SharePoint Receiver is installed See Also: Setting up the SharePoint Receiver on
page 1005
To set up the mapping of SharePoint metadata to Ektron metadata, complete the steps in
Preparing Ektron Metadata to Support SharePoint Import on page 1010.

You can import these SharePoint content types to Ektron:
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l

Library files are imported as Ektronassets.
NOTE: Only files types listed in the Asset Management Configuration screen's File Types field
may be imported. See Also: Configuring Document Management on page 312

l

l

l

Libraries and folders are not imported, but items within them are imported. Any folder
hierarchy is lost upon import.
Custom List items, including these data types
o Single line of text (String)
o

Multiple lines of text (String, HTML)

o

Choice from menu (Select)

o

Number, such as 11.0, 100 (Number)

o

Currency, such as $, ¥, € (Formatted number)

o

Date and time (DateTime)

o

Yes/No check box (Boolean)

o

Hyperlink or picture (Hyperlink, Image)

o

Calculation, based on other columns (String)

SharePoint List items are imported as an Ektron Smart Form of the type CustomList.
o Each field in a SharePoint list item is created as a Smart Form field. Field types are
matched appropriately.
o

Attachments to list items are not imported.

o

The import procedure adds fields to an Ektron Smart Form to manage ongoing
updates, such as: created and modified date/time, version, and if any files are
attached.

The following SharePoint authentication modes are supported:
l

Claims Based authentication mode > Windows Authentication > NTLM and Kerberos

l

Classic authentication mode > NTLM and Kerberos

To set up the SharePoint-to-Ektron mapping:
1. On the Ektron Workarea's Content tab, navigate to the destination folder.
2. Choose New > DxH Content > Add SharePoint Content.
3. The Select SharePoint Connection screen appears. Choose a SharePoint Connection, and
click Start.
4. The Select SharePoint Content screen appears. At the What SharePoint® content
would you like to add from "My SP" Connection? field, choose one of these
options.
l
All current and future items from SharePoint® Lists or Libraries—When
you select a list or library, all files within it and its subfolders are imported. And,
any files added to or deleted from or updated within that list or library in the future
are updated in the selected Ektron folder.
NOTE: Deletions depend on your choice in the next field.
l

Items from SharePoint® Lists or Libraries—You choose individual files from
several lists and libraries. If the files are updated or deleted in the future, they will
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be updated in the selectedEktron folder.
NOTE: Deletions depend on your choice in the next field.
5. At the If the content you select is deleted from SharePoint® in the future,
what should happen to the Ektron copy of that content? field, choose one of
these options.
l
Do NOT delete it from Ektron—If the file is deleted from SharePoint, leave the
Ektron copy as is.
l

Delete it from Ektron—If the file is deleted from SharePoint, delete it from
Ektron.

6. The next screen depends on your response to the What SharePoint® content would
you like to add from "My SP" Connection? field. If you chose
l
All current and future items from SharePoint® Lists or Libraries—The
following screen appears. Choose SharePoint lists/libraries that you want to import.

l
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Items from SharePoint® Lists or Libraries—Choose files from several lists
and libraries. When you click a list or library, its items appear in the top right grid.
As you check items to import, they appear in the lower grid.
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7. The Map Metadata to Ektron Folder screen appears. For background information on this
screen, see Preparing Ektron Metadata to Support SharePoint Import on page 1010.

You may map as many Ektron metadata fields to SharePoint metadata fields as you
wish.
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Required Ektron fields have an asterisk (*). If you do not map required metadata fields,
you may proceed but when the content is imported to Ektron, its status is Checked-In.
The content can only be published after required metadata values are entered.
8. Click Next then Done. It takes a while to import the SharePoint files. The length of time
depends on the number and size of the files.

SharePoint-to-Ektron Import Notes
l

l

l

If you import SharePoint content to an Ektron folder then later to the same folder, the
second document is imported with different ID, and its title is appended with a unique
number.
Ektron authors can edit content imported from SharePoint. But if the content is updated
in SharePoint and the SharePoint Receiver is active, the version in the Ektron folder is
automatically updated, overwriting the file (and any edits the Ektron author made).
SharePoint content can depend on other SharePoint files. These are handled as follows:
o

SharePoint content items that include other content (for example, a SharePoint
document that includes a SharePoint image) are stored in Ektron as separate items.
Changes to SharePoint content are automatically updated in Ektron.
Also, you can manually update any imported file at any time. See Also: Updating
SharePoint Content Manually on the facing page
NOTE: Files attached to a custom list are not imported.

o

If SharePoint content includes a link to other content, such as a hyperlink to another
document, only the selected content is copied to Ektron.
For example, SharePoint Document A includes a hyperlink to SharePoint Document
B. When Document A is copied to Ektron, Document B is not. If Document B is not
copied to Ektron, the link in Document A does not resolve correctly.

l

l

l
l

l

l

l
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You can search content imported from SharePoint if it is tagged as searchable. See Also:
Ensuring Your Content is Searchable on page 942
Imported content's last editor is the user set to log into the Inbound Connection. It is not
the user who completed the Add SharePoint Content screen.
Do not copy imported SharePoint content from its import folder to another Ektron folder.
If a SharePoint library document does not have a title, its file name is used for a title in
Ektron. If a SharePoint custom list does not have a title, it is imported with (no title)
as the title. If several items are imported to the same folder with no title, an integer is
appended. For example: (no title)(1).
Checked-out Ektron content may be updated automatically (by the SharePoint
Receiver) or manually.
If you import a SharePoint custom list into Ektron, and then a SharePoint user adds a
column to that list, you cannot update it in Ektron, neither automatically nor manually.
You must either import it to a different Ektron folder, or delete it in Ektron and then reimport it from SharePoint.
If the Ektron folder receiving SharePoint content requires a taxonomy category or alias
(or both), the content is imported but its status is set to Checked In (I). If you try to
publish the content, you must first supply the required category or alias. See Also:
Requiring the Assignment of at Least One Category on page 791

Ektron Reference

Content Deletion Notes

To improve the performance of the SharePoint import, Ektron sets a caching value of
900 seconds in the following siteroot/web.config file key: <add key="ek_dxh_
sharepoint_cache" value="900" />. You may disable caching by changing this value
to zero (0). If you do, the import screen's performance may be a bit slower.

l

Content Deletion Notes
If a deleted SharePoint content is restored from the recycle bin, if it was imported using
the All current and future items from SharePoint® Lists or Libraries option, the
content returns to the Ektron folder.

l

However, if the user selected Items from SharePoint® Lists or Libraries during
import, content restored from the SharePoint recycle bin does not return to Ektron.
If content is imported from SharePoint then deleted in Ektron, it no longer appears in
Ektron.

l

Changing the Language of Imported Content
NOTE: You can translate content imported from SharePoint, but the translated content resides only in
Ektron and is not associated with SharePoint. See Also: Creating Multi-language Content on page 1062
PREREQUISITE
You need the ID of the language in which SharePoint® content will be imported. To
obtain the language ID, go to Workarea > Settings > Localization > Languages
and Regions, and look in the ID column.
By default, SharePoint content is imported in US English (ID 1033). To import it in another
language:
1. Open C\Program Files
(x86)\Ektron\DigitalxHub\ContextBusServiceHostCBSvcHost.exe.config.
2. Find the <appSettings> section.
3. Add the following line
<add key=”ek_DefaultContentLanguage” value=”xxxx” />

where xxxx is the desired language ID. For example, the ID for Español [Spanish] is
1034.
4. Restart the Ektron ContextBus Service Host service.

Updating SharePoint Content Manually
This section explains how to manually transfer SharePoint files to Ektron. Typically, the
SharePoint Receiver handles this task for you. You only need the manual import if the
SharePoint receiver is not installed or is inactive. See Also: Setting up the SharePoint
Receiver on page 1005
PREREQUISITE
You have 1 of the following Ektron designations:
l

Administrators group member

l

DxH Connection User Role

Ektron 8.7
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l

Folder-Admin role

l

Edit permissions for the folder containing SharePoint content

Use the manual update feature to transfer a file to Ektron immediately. You also can manually
transfer an updated image file that is embedded within SharePoint content. Without a manual
update, that image only transfers to Ektron when the related SharePoint content is updated.
1. In SharePoint, edit either the SharePoint document/file or its properties.
2. Navigate to the folder that contains the content you want to update.
3. Click the arrow to the right of the content title.
4. Click Update DxH Content.

NOTE: When a user imports a SharePoint content item to an Ektron folder that already contains the item,
that action also updates the Ektron content.

Configuring DxH for Mapping Form Data
This section explains how to map an Ektron HTML form to an external application. For
example, you create a form that prompts a site visitor for contact information (name, mailing
address, physical address, and phone number) to create a sales lead. After completing the
mapping, you publish the form on your Ektron website. As site visitors complete the form, its
information is sent to the external application. For background on using DxH to transfer
Ektron form data to an external application, see Setting Up the Digital Experience Hub on
page 991 and Setting Up the Digital Experience Hub on page 991.
This section also explains how to use information collected through Ektron forms and stored in
an external application in a Targeted Content widget. See Also: Using Widgets on page 711

Creating a Mapped Form
PREREQUISITES
l

l

l

DxH and inbound connections are established See Also: Setting Up the Digital
Experience Hub on page 991
A connection to an external application is established (Salesforce, HubSpot,
Marketo, or Microsoft Dynamics) See Also: Configuring a Connection to an
External Application on page 1002
Either you have permission to publish the form, or it was already published

To create a mapped form:
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1. Obtain the following from the external application's administrator:
l
Form/record name
NOTE: Only these forms are supported:
* Marketo Lead Management—Lead
* Salesforce—Lead, Contact, Account
* Microsoft Dynamics CRM—Lead, Contact, Account
* HubSpot—Contacts
l
l

Form fields that you will map to an Ektron form.
Data type for each form field. Only these types are available in Ektron, so the
external application field's data types must match one of them.
o
Checkbox—User’s response is checked or unchecked (boolean)
o

Choices—Several choices available. User selects any number of choices

o

Calendar—A date

o

Text—Free text

IMPORTANT: Coordination is critical when mapping form fields to external applications.
Before creating a form, contact your business partner for the application and determine which
fields are required to complete the desired action.
2. Create a new HTML form. See Also: Creating a Form on page 386
NOTE: You may only create a form in the Ektron default language.See Also: Setting the Default
Language on page 1061
3. On the second screen of the Create Form wizard, check DxH Mapping.

4. Complete the steps for creating the form. When inserting form fields, refer to
information collected in Step 1.
5. Publish the form.
6. Edit the form and, from its toolbar, click Map to DxH. The Map Form to DxH screen
appears.
7. Enter a name for this mapping. It must be unique and easy to recognize.
8. Select the connection to the external application. You created this in Configuring a
Connection to an External Application on page 1002.

Ektron 8.7

1019

Setting Up the Digital Experience Hub

9. From the Object Type drop-down, select the external form with which to map this
Ektron form. The following forms are supported:
l
Marketo Lead Management—Lead
l

Salesforce—Lead, Contact, Account

l

Microsoft Dynamics CRM—Lead, Contact, Account

l

HubSpot—Contact

NOTE: You obtained the form name in Step 1.
10. Click Next. The Map Required Form Fields screen appears. All required external fields
appear in the left column. Use the drop-down in the right column to map one Ektron form
field to each required field.
IMPORTANT: The external application field's data type must match the Ektron form field .

11. When the Map Optional Form Fields screen appears, follow instructions in Step 10 to map
Ektron form fields to optional external fields.
12. Click Publish. The Form Mapping Completed screen appears.
13. Click Test Form Mapping. A new form appears, showing fields that you mapped.
14. Enter sample data into each field and click Test Mapping. You are notified if the sample
data is valid.
15. Click OK.
IMPORTANT: The Form Mapping Complete dialog indicates that mapping between form fields and the
external application object has been established, but does not indicate that the mapping is valid. You
should perform end-to-end system testing to ensure that form fields pass successfully between systems.
When a site visitor submits a mapped form, the external application creates a record (Lead,
Account, or Contact). You may edit the record in the external application.

Mapping an Existing Form to an External Application
1. Go to Workarea > Content > the folder that contains the form.
2. Click the form. The View Form screen appears.
3. Click Map to DxH. The Map Form to the Digital Experience Hub dialog appears.
4. Enter a name for this mapping. It must be unique and easy to recognize.
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5. Select the connection to the external application. You created this in Configuring a
Connection to an External Application on page 1002.
6. From the Object Type drop-down, select the external form with which to map this
Ektron form. The following forms are supported:
l
Marketo Lead Management—Lead
l

Salesforce—Lead, Contact, Account

l

Microsoft Dynamics CRM—Lead, Contact, Account

l

HubSpot—Contact

NOTE: You obtained the form name in Step 1.
7. Click Next. The Map Required Form Fields screen appears. All required external fields
appear in the left column. Use the drop-down in the right column to map one Ektron form
field to each required field.
IMPORTANT: The external application field's data type must match the Ektron form field .

8. When the Map Optional Form Fields screen appears, follow instructions in Step 7 to map
Ektron form fields to optional external fields.
9. Click Publish. The Form Mapping Completed screen appears.
10. Click Test Form Mapping. A new form appears, showing fields that you mapped.
11. Enter sample data into each field and click Test Mapping. You are notified if the sample
data is valid.
12. Click OK.

Editing a Form Mapping to an External Application
After a form is mapped to an external application, you can edit the map properties.
1. Go to Workarea > Content > the folder that contains the form.
2. Click the form. The View Form screen appears.
3. Click Edit DxH Mapping. The Map Form to the Digital Experience Hub dialog appears.
4. Edit the form properties as required.
5. Click Publish. The Form Mapping Completed dialog box appears.
6. Click Close.
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Deleting a Mapped Form
If you try to delete a form mapped to an external application, a dialog notifies you that by
deleting the form, you are also deleting the mapping. Click Delete to delete the form and
mapping.

Using the Targeted Content Widget with External
Application Data
You can use data collected through Ektron forms and stored in an external application in a
Targeted Content widget. When a user submits a mapped form, the external application
connector writes a user ID for that login back to Ektron. This enables the delivery of targeted
content based on the user's identity.
You can use the Targeted Content widget to personalize a Web page by displaying content
based on information from a user-completed form. For example, if the Salesforce lead's
industry is healthcare, the page may display content of interest to healthcare professionals.
See Also: Using Widgets on page 711
To use DxH with a Targeted Content widget:
1. Determine Targeted Content widget criteria from the external application forms and
fields in the siteroot/dxhTargetingRules.config file. The following sample shows a
portion of this file (which are
in the file by default).
<dxhRules> <Adapter name="Salesforce"> <AdapterObject name="Lead"> <add
name="Company Name" value="Company"/> <add name="Industry" value="Industry"/> <add
name="Number of Employees" value="NumberOfEmployees"/> <add name="Revenue"
value="AnnualRevenue"/> <add name="Products Owned" value="Products Owned"/> <add
name="Product Interest" value="ProductInterest"/> <add name="Score"
value="Rating"/> </AdapterObject> </Adapter>
l
l

l

l
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dxhRules—The file's root tag.
Adapter—The adapter for which to display object rules, such as Salesforce or
MSDynamics. It is not the connection name (for example, marketingSF).
AdapterObject—The system name of the object within the specified adapter. For
example, to enter a Salesforce lead, insert the system name Lead (case-sensitive).
add—The field. The name attribute contains text that the end user sees (as shown in
the following image). The value attribute contains the system name of the field.
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NOTE: The field's datatype is recognized and automatically surfaced into the correct rule type;
numeric rule for an integer or decimal, string rule for a string, a multi-select rule for a pick list, and so
on.
2. Access either a Targeted Content widget or a Targeted Content configuration. See Also:
Using Widgets on page 711; Using Targeted Content Configurations on page 744
3. Click the Or+ button to add a criterion for the widget.
4. Select an adapter and field. For example, Salesforce Lead > Industry.
5. Enter additional fields as you would in any Targeted Content widget or configuration.
6. Save the widget and test it.

Troubleshooting Broken Connections
After creating connections to external applications and mapping forms to those applications,
you should test the mappings before exposing the forms on a production site. The following
errors can occur:
l
l

l

System errors—DxH or the external application connection is not available.
Business rule errors—DxH or the external application connection is available, but the
contents of the form violate the external application's business rules
Validation errors—DxH or the external application connection is available, but the
contents of the form violate the external application's form field validation rules

Network or server issues may cause a DxH connection to become unavailable. If this
happens, a message displays on the View All Digital Experience Hub Connections screen, and
the connections are shown as disabled.
Access to SharePoint content is dependent on the following connections:
l

An active DxH connection—If the DxH connection is unavailable, no content is
imported into the CMS and no form data is submitted to external applications.
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l

l

An active inbound connection—If the inbound connection is unavailable, DxH cannot
communicate with the Ektron.
An application-specific connection—If a specific external application connection is
inactive, no content is imported into Ektron or no form data is submitted to that external
application, but other application connections continue to work normally.

To address the problem, choose from these options:
l

l

l

Click Retry to attempt to re-establish the connection using the same URL as when the
connection was first established.
Select Add Connection > Connect to DxH or click on the link in the error message to
display the Connect to the Digital Experience Hub page. This lets you change the DxH
URL if required.
Contact your IT Administrator.

An external application or SharePoint connection can become unavailable due to network
issues, user account changes, or issues with the server hosting the application.
Use the DxH log to display recent information, warning, and error messages about DxH,
inbound, and external application connections, as described in Monitoring DxH Transactions
on page 1009.

Using DxH with HubSpot
DxH's HubSpot connectors help marketers customize and personalize the site visitor
experience. These visitors benefit from a consistent message, as marketers can access
customer data available from HubSpot, resulting in more meaningful conversations and
enhanced customer experience.
When a prospect submits a form on an Ektron-powered website, a HubSpot lead is
automatically created, and campaign information is updated. This process can trigger a
HubSpot business rule, which sends an email response to the customer, and routes the lead to
the appropriate sales representative.
This section explains how to implement the Ektron DxH to HubSpot connection.
1. Contact your HubSpot partner to obtain
l
authentication information (a hapikey)
l

fields to be collected on the HubSpot form (typically, only an email address)

2. After installing DxH, create an inbound and a HubSpot connection. See Configuring an
Inbound Connection on page 1001, Configuring a Connection to an External Application
on page 1002
3. Create an Ektron HTML form to capture customer information. On the second screen of
the Create Form wizard, be sure to check DxH Mapping. Map the form fields to
HubSpot fields. See Creating a Mapped Form on page 1018.
4. Publish the form to your Ektron website.
5. A visitor to your website submits the form.
6. The form goes to DxH, which uses HubSpot Connector to route the data to HubSpot.
7. HubSpot creates a contact and, if applicable business logic is in place, associates the
form information with the visitor.
8. Use HubSpot contact information in the Targeted Content widget to create a personalized
experience when the site visitor return to your site. See Using the Targeted Content
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Widget with External Application Data on page 1022, Managing Web Experience With
DxH and HubSpot.
The Targeted Content widget can determine page content based on information transferred to
HubSpot via DxH, such as:
l

lifecycle stage, for example, sales qualified lead

l

title, for example, Chief Marketing Officer

Use HubSpot's website to learn how to maximize the information collected above. See Also:
HubSpot Academy
You can also use Ektron's HubSpot/Aloha plugin to bring HubSpot keywords into the editor
experience. The plugin enables content authors to see how well they are targeting keywords
as they create content. See Also: Using Hubspot with the editor

Ektron 8.7

1025

(This page intentionally blank.)

25

Assigning and Managing
Tasks

Ektron Reference

1027

Assigning and Managing Tasks

A task is a required action within Ektron, such as updating or publishing content, reordering a
collection, or updating an image. You can attach a task to a content item, so that as it
progresses through editing and approval, a task tracks those activities.
When working with tasks, you need to understand the following.
l

l

Permissions for creating, redirecting, editing, and deleting tasks.
o You can create and view tasks for yourself.
o

Administrators can perform all task activities.

o

Others must have roles that let them create a task, redirect a task to another user
or group, or delete a task.

o

Only Administrators group members and the user who created a task are authorized
to edit it. This is because the Task feature is designed to restrict the actions that
most users can perform on their tasks, so that tasks progress through a prescribed
series of states.

You can create and manage tasks from multiple places. For example:
o If you are setting up tasks for a project that does not yet have content or for work
items not related to specific content, create tasks through the Workarea
> Reports > Tasks folder.
o

If you are browsing a website and notice that a content change is required, create a
task from the website.

o

If you are reviewing Workarea content and recognize that a new task is needed,
create one from the View Content screen.

l

The difference between a task assigned to content and one not assigned to content.

l

How task preapproval works.

l

How to create and manage task categories and types, which are used to filter tasks.

l

How to use task states to indicate the status of a content-associated task

Task states

Task States
Tasks are assigned one of the following states.
l

Not Started

l

Active

l

Awaiting Data

l

On Hold

l

Pending

l

Reopened

l

Completed

l

Archived

l

Deleted

l

Purged

Contrasting tasks assigned to content with tasks not assigned to content
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Contrasting Tasks Assigned to Content with
Tasks not Assigned to Content
There are 2 kinds of tasks, contrasted below. The difference between them involves how a
task's state can change.
Tasks assigned to content—Task state changes automatically as the assigned content's
status changes. For example, if content is checked out, the task state changes to active.
Administrators can manually change the task state at any time. See Also: How Content
Events Change a Task's State on page 1033
Tasks not assigned to content—authorized users manually change a task's state at any
time. For example, when a task is finished, you change its state to Completed. Ektron events
do not affect these tasks.
This section also contains the following topics.
Working with tasks assigned to content

Working with Tasks Assigned to Content
This section explains how to work with tasks that are assigned to content items.
Creating a task assigned to content

Creating a Task Assigned to Content
l

Only members of the Administrators groups and users assigned to the TasksCreate role can create tasks.

1. Create a task and assign it to content from any of these locations.
NOTE: In the second and third options, you choose a content item then select a task. In these
cases, you have already selected the task's content and language.
l

l

l

Workarea > Reports > Tasks > Assigned by and to me > click Add. The Add
Task screen appears.
Workarea > Content > folder > content > View Content screen > click Add
Task ( ).
a website by clicking the access point ( ) or content menu (

) > Add Task.

2. Complete the Add Task screen.
l
Title—Enter a title for the task.
l

Assigned To—To assign the task to anyone who can edit the assigned content (All
Authors), proceed to the next field. Otherwise, click Select User or Group and
choose a user or group.
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NOTE: You can only assign a task to someone else if you are a member of the Administrators
group or assigned the Tasks-Redirect role. If you don't have this capability, the task is
assigned to anyone who can edit the assigned content (All Authors).
The user to whom a task is being assigned must have edit permission for the content.
l

l

l

l

l

l

Language—Select the language of the content to be assigned to the task.
If you accessed the Add Task screen from the View Content screen or a website, the
language is selected, and you cannot change it.
Content—Click Select. A new window appears from which you can navigate to the
content. You see only content in the selected language and for which you have at
least read-only permission.
If you accessed the Add Task screen from the View Content screen or a website, the
content is selected, and you cannot change it.
Priority—Select the priority of the task. Your choices are High, Normal, and Low.
You can sort tasks by priority on the View Tasks screen.
Category—If desired, select a category for the task. If you choose a Task
Category, the Task Type drop-down box is auto-filled with task types associated
with that category. See Also: Setting Up Task Types and Categories on the facing
page.
Type—If desired, select the Task Type for this task. You must specify a Task
Category before you assign a task type. See Also: Setting Up Task Types and
Categories on the facing page.
Add—If you want to add Task Categories and Task Types, click Add. See Also:
Setting Up Task Types and Categories on the facing page
WARNING! If you add a Task Category or Task Type while adding a task, the task
information entered (Task Title, Assigned To, Language, and so on) is lost when the screen
refreshes.

l

Edit—By clicking the Edit link, you can edit the Task Type.
WARNING! If you edit a Task Type while adding a task, the task information (Task Title,
Assigned To, Language, and so on) entered will be lost when the screen refreshes.

l

l

l

State— The state is set to Not Started and cannot be edited. You can sort tasks by
state on the View Tasks screen. To learn more about the interaction of content
status and task state, see How Content Events Change a Task's State on page 1033.
Start Date—Using the calendar button, choose a start date for the task. The start
date appears on the View Tasks screen, where users can sort tasks by start date.
Due Date—Using the calendar button, choose the date by which the task needs to
be completed. The due date appears on the View Tasks screen, where users can
sort tasks by due date.
If you see a mix-up of the month and date of your entry (for example, you select
March 2 but see February 3), make sure the date format specified in the Windows
Control Panel Regional Settings dialog matches your current language. Also, make
sure the settings apply to the default user.

l

Description—Add additional information to describe the task. The description
appears on the View Task screen.

3. Click Save. If email notification is enabled, an email is sent to the user or group to which
the task was assigned.
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Setting Up Task Types and Categories
You can organize tasks by category and type. You can assign several types to each category.
For example:
l

l

Task Categories: Content Maintenance, Engineering, Sales, Documentation, Web Design,
and so on.
Task Types: Hardware content update, Software content update, Edit Content, Update
Documents, Contact Customer, and so on.

You can use task categories and types to filter tasks. See Filtering Tasks By Task Type on
page 1039.
1. Go to Workarea > Settings > Configuration > Task Types. To collapse a Task
Category, click

next to the Task Category name; to expand one, click

.

NOTE: The View Categorization screen has a system-defined category (Form Submission Task)
that can only be used with forms. You can change its name but cannot delete it. For more
information, see Working with HTML Forms on page 386.
2. From the View Categorization screen, click Add Task Type. The Add Task Type Screen
appears.
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3. In the Task Category area, choose an existing Task Category from the drop-down menu,
or enable the Add Task Type to New Task Category radio button and enter a new
category name in the text field.
4. Add a Task Type name in the Task Type field.
5. Enter a Task Type Description.
6. Choose a Task Type Availability.
You can hide Task Types from users by enabling Not Available in the Add Task Type
and Edit Task Type screens. If you make a Task Type unavailable, the assigned task's
Type and Category are changed to Not Specified.
7. Click Save Task Type.
Editing a task category

Editing a Task Category
1. From the View Categorization screen, click the task category whose name you want to
change.
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2. In the text box screen next to the category name, enter the new name.

3. Click Save Category (

).

Deleting a task category or task type

Deleting a Task Category or Task Type
1. From the View Categorization screen, click the check boxes next to the Task items you
want to delete.
2. Click Delete ( ). A confirmation box appears.
3. Click OK.
How content events change a task's state

How Content Events Change a Task's State
A task assigned to content typically moves through a series of states, from creation to
completion to removal. A task's history shows each state, when it was assigned, and who
assigned it.
Many states are assigned automatically when associated content undergoes a change. For
example, when content is submitted for approval, the task’s state changes to Pending. Some
states are manually assigned by users.
IMPORTANT: At any time, an Administrators group member can change a task’s state to any other state.
Here is the sequence of user and system actions that change a task’s state.
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Here is the progression of states for tasks assigned to content.
l
l

l

Not Started—System action—Automatically assigned when task is created.
Active—System action—The task’s content was checked out at some point. It may
currently be checked in.
Awaiting Data—User action—The task is started but the assigned-to user is awaiting
information from an external source. Use comments to indicate the data required for
task reactivation.

l

On Hold—User action—Task cannot be worked on at this time.

l

Pending—System action—Content is submitted for approval.
If the current approver edits content then submits it for approval, its status changes to T
(awaiting completion of associated tasks), and all tasks assigned to the content are set
to Pending. At that point, an authorized user must change the status of all assigned tasks
to Completed. Then, all approvers must approve the content to publish it.

l

l
l

l
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Reopened—System action—Content is declined by an approver in the approval
processworkflow. Or, if someone edits content whose task state is Pending, it changes to
Reopened.
Completed—System action—The content is published.
Archived—User action—After a task is completed, administrators can assign this state.
It no longer appears on open task lists but is kept for reviews and reports. Only the
administrator can view Archived tasks. See Archiving a Task on page 1036.
Deleted—User action—When an archived task is no longer needed for reporting or
reviewing, administrators can assign this state. While in this state, the task remains in
the database. See Deleting a Task on page 1036.
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l

(Purged*)—User action—When you purge a task, it and all of its transactions are
removed from the database, so the purged state does not actually show. Only
administrators and users with Task-Delete role can purge. See Purging a Task on
page 1037.

You can receive email notification of changes in status for tasks and associated content. See
Installing Ektron on page 9 about setting up email notifications.
Editing a task

Editing a Task
Only Administrators group members and the user who created a task are authorized
to edit it. If the person to whom a task is assigned is not authorized, that person can
only view it and insert a comment. The Task feature restricts most users' ability to
edit tasks, so that they progress through a prescribed series of states.
Authorized users can manually edit any task information (except Assigned By, Task ID,
and Created By).
NOTE: System events automatically change a task's state. See Also: How Content Events Change a
Task's State on page 1033
1. Go to Workarea > Reports > Tasks > All open Tasks.
2. Click the task. The View Task screen appears.
3. Click Edit. The Edit Task screen appears.
4. Edit task information and click Update.
Adding comments to a task

Adding Comments to a Task
Only members of the Administrators group, the user who created a task, and the user
to whom a task is assigned can add comments to it.
Comments can be added to a task to record its progress from assignment to completion.
Comments appear on the Comments tab of the View Task screen. If a task is assigned to
content, and an approver approves or declines content from the Content Awaiting Approval
screen, the Add Comments to Task screen appears. The screen lets the approver add
comments about the task associated with the content.
Authorized users also can add comments to a task at any time to provide additional
information about its status. For example, if you update a task’s status from In progress to
Waiting on Someone Else, you can use a comment such as: Please review for grammar and
punctuation.
1. Go to Workarea > Reports > Tasks > All open Tasks (or any other type of task).
2. Click Add Comment (

). The Comments window appears.

3. Enter a comment.
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4. Click Insert. The View Task screen reappears. The comment appears on the Comments
tab.

To update a comment, click its Date/Time link.
Archiving a task

Archiving a Task
l

Only members of the Administrators group or users to whom a task is assigned
can change its status to archived.

To clean up completed tasks while keeping a record of the tasks, move selected tasks to the
Archived Tasks list. This helps you focus on more recent task completions.
1. Go to Workarea > Reports > Tasks and choose the type of task that you want to
archive. (Typically, you archive completed tasks.) The View Task screen appears.
2. Select tasks one at a time, or click the check box in the top left corner to select all.

3. In the Change to State field, choose Archived from the drop-down list.
4. Click Set.
Deleting a task

Deleting a Task
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l

l

Only Administrators group members and users assigned to the Task-Delete role
can delete a task.
Users can only delete tasks that they can view. See Determining Which Tasks are
Visible on page 1039

You can delete a task that is no longer needed, such as after it is completed or archived,
depending on your organization’s policies.
1. Go to Workarea > Reports > Tasks.
2. Choose the type of task that you want to delete (for example, All Open Tasks). The
View Task screen appears.
3. Click the task that you want to delete.
4. Click Delete ( ). A confirmation message appears.
5. Click OK.
Deleting several tasks at once

Deleting Several Tasks at Once
1. Go to Workarea > Reports > Tasks and choose the state of tasks that you want to
delete. The View Task screen appears.
2. Select 1 or more tasks, or click the check box in the top left corner to select all.
3. Choose Deleted from the Change to State drop-down.
4. Click Set.
Purging a task

Purging a Task
l

Only members of the Administrators group or users to whom the Task-Delete
role is assigned can purge a task.

WARNING! Purging removes a task and its history from the database.
1. Go to Workarea > Reports > Tasks > Deleted.
2. Select tasks one at a time, or click the check box in the top left corner to select all.
3. Click Purge.
Viewing a task

Viewing a Task
Only members of the Administrators group, the user who created a task, and the user
to whom a task is assigned can view it. See Also: Determining Which Tasks are Visible
on page 1039
You can view a task in the following ways.
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l

If a task is assigned to content
1. Go to Workarea > Content > folder and click content associated with a task.
2. Click the Tasks tab to see the content's tasks.

l

Whether or not a task is assigned to content
1. Go to Workarea > Reports > Tasks > type of task. For example, All open
Tasks.
2. Click the task you want to view.

l

Viewing a task's history
Ektron maintains a history of events and comments in the life of a task. For example, the
history shows when and by whom the task was created, when it changed to Active, was
linked to content, its state changed, it was approved, and so on.
NOTE: You can view a task’s history until it is purged.
1. Go to Workarea > Reports > Tasks > type of task. For example, All open
Tasks.
2. Click a task. The View Task screen appears.
3. Click History (

). The history of task events appears.

Viewing task reports

Viewing Task Reports
The Workarea > Reports > Tasks folder displays all tasks, many filtered by task state.

Only Administrators group members , the user who created or assigned a task, or the
user to whom a task is assigned can view it. See Also: Determining Which Tasks are
Visible on the facing page
The following list shows the types of tasks that authorized users can view, filter, and assign to
other users.
Show the types of tasks
l
All open Tasks—shows all tasks whose status is one of the following:
NOTE: Authorized users also can edit a task from this task state.
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l

l

not started

l

active

l

awaiting data

l

on hold

l

reopened

l

pending

Assigned by and to me—tasks assigned to you, and tasks you assigned to yourself or
someone else

l

Assigned to me—tasks assigned to you

l

Assigned by me—tasks you assigned to someone else

l

Created by me—tasks you created

l

Assigned to User—tasks you assigned to a user

l

Not started—tasks whose state is Not started

l

Active—tasks whose state is Active

l

Awaiting Data—tasks whose state is Awaiting Data

l

On Hold—tasks whose state is On Hold

l

Pending—tasks whose state is Pending

l

Reopened—tasks whose state is Reopened

l

Complete—tasks whose state is Complete

l

Archived—tasks whose state is Archived

l

Deleted—tasks whose state is Deleted
NOTE: You can also purge tasks from the Deleted task state.

Filtering tasks by task type

Filtering Tasks By Task Type
Every View Task screen lets you filter tasks by type. Use the Show Task Type drop-down to
choose a Task Type. Only Task Types that are applied to a task appear in the Show Task Type
drop-down box.
NOTE: Words in bold italics are Task Categories. You cannot filter by Task Categories.

Determining which tasks are visible

Determining Which Tasks are Visible
To provide security, Ektron restricts which users can view which tasks. The following table
shows the Viewing options by user or group.
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View
option

Administrator
group member

All Open *

User or group member to
whom task assigned

User who
assigned
task

User who
created
task

X

Assigned
by Me *

X

Assigned
to Me *

X

Created by
Me *

X

Assigned
to User

X

Not
Started

all tasks in
specified state

only tasks assigned to user in
Not Started state

Active

all tasks in
specified state

only tasks assigned to user in
Active state

Awaiting
data

all tasks in
specified state

only tasks assigned to user in
Awaiting data state

On hold

all tasks in
specified state

only tasks assigned to user in
on hold state

Pending

all tasks in
specified state

only tasks assigned to user in
Pending state

Reopened

all tasks in
specified state

only tasks assigned to user in
Reopened state

Completed

all tasks in
specified state

only tasks assigned to user in
Completed state

Archived

all tasks in
specified state

Deleted

all tasks in
specified state

*—user can only view tasks in a not started, active, awaiting data, on hold, pending, or
reopened state
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Working with Tasks Unrelated to Content
This section explains how to create tasks for activities that are unrelated to specific content
items.

l

Only members of the Administrators groups and users assigned to the TasksCreate role can create tasks.

1. Workarea > Reports > Tasks > Assigned by and to me > click Add. The Add
Task screen appears.
2. Enter the following information.
l
Title—Enter a title for the task.
l

Assigned To—Click Select user or group and choose a user or group to assign to
the task.

l

Language—Ignore.

l

Content—Ignore.

l

l

l

l

Priority—Select the priority of the task. Your choices are High, Normal and Low.
The priority appears on the View Tasks screen, where a user can sort tasks by
priority.
Category—If desired, select a category for the task. If you choose a Task
Category, the Task Type drop-down box is auto filled with task types associated
with that category. See Also: Setting Up Task Types and Categories on page 1031.
Type—If desired, select the Task Type for this task. You must specify a Task
Category before you assign a task type. See Also: Setting Up Task Types and
Categories on page 1031.
Add—If you want to add Task Categories and Task Types, click Add. See Also:
Setting Up Task Types and Categories on page 1031
WARNING! If you add a Task Category or Task Type while adding a task, the task
information entered (Task Title, Assigned To, Language, and so on) is lost when the screen
refreshes.

l

Edit—By clicking the Edit link, you can edit the Task Type.
WARNING! If you edit a Task Type while adding a task, the task information (Task Title,
Assigned To, Language, and so on) entered will be lost when the screen refreshes.

l

State— Select a task state to indicate the task's completion status. To find any
task, users can select from options below the Tasks folder to view all tasks in that
state.
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l

l

Start Date—Using the calendar button, choose a start date for the task. The start
date appears on the View Tasks screen, where users can sort tasks by start date.
Due Date—Using the calendar button, choose the date by which the task needs to
be completed. The due date appears on the View Tasks screen, where users can
sort tasks by due date.
If you see a mix-up of the month and date of your entry (for example, you select
March 2 but see February 3), make sure the date format specified in the Windows
Control Panel Regional Settings dialog matches your current language. Also, make
sure the settings apply to the default user.

l

Description—Add additional information to describe the task. The description
appears on the View Task screen.

3. Click Save. If email notification is enabled, an email is sent to the user or group to which
the task was assigned.
What happens to a task unrelated to content after it is created
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What Happens to a Task Unrelated to Content after it
is Created
After a task is created, the user to whom it is assigned would typically perform some aspect
of the task. Then, that user would use the Assigned to me screen to change its state as
appropriate. For example, the user might change its state to Completed. Or, the user might
change its status to On Hold and assign it to someone else.
The following activities can be performed on a task not related to content.
l

Setting Up Task Types and Categories on page 1031

l

Editing a Task on page 1035

l

Adding Comments to a Task on page 1035

l

Archiving a Task on page 1036

l

Deleting a Task on page 1036

l

Purging a Task on page 1037

l

Viewing a Task on page 1037

l

Viewing Task Reports on page 1038

Setting up an automatic task for pre-approving content

Setting Up an Automatic Task for Pre-approving
Content
You can set up a preapproval task to require 1 or more users to approve content before it
enters the regular approval process. See Also: Creating an Approval Chain for a Content
Folder on page 264
NOTE: You also can create a task automatically when a form is submitted. See Also: Assigning a Task to
a Form on page 421
Overview
When a user submits content for approval, Ektron checks to see if an open task exists for it.
(An open task is one whose state is Not Started, Active, Awaiting Data, On Hold, or Pending.)
If none exists but a preapproval group is assigned to its folder, a task is automatically
created for the content. When the task is reviewed by any preapproval group member, there
are 2 choices.
l

l

Assign the task to another user, such as an editor. (The user to whom the task is being
assigned must have permission to edit the content.) The editor reviews the content,
updates it as needed, and submits it into the regular workflowapproval process.
Review the content and submit it for publishing. This action completes the preapproval
process and submits the content into the regular workflowapproval process.

NOTE: The user submitting the content does not need permission to create tasks. Also, the user
assigned to the task should not change its state using the task system. Instead, the user should review
and approve content using the content approval mechanism. That mechanism automatically changes the
task’s state.
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The new task has the following default information.
l

Title—A string formulated by joining the content title, content ID number, underscore
(_), and Task. For example, Private Content2_Task.

l

Assigned to—The preapproval group

l

Assigned by—The user who submitted the content

l

Content—The content submitted for approval

l

Priority—Normal

l

State—Not Started

l

Due date—none

l

Start date—none

l

Created by—User who submitted content

l

Description—none

The following list shows the sequence of changes to content and its associated task. All
changes are logged in the task’s history. Also, email is automatically generated for automatic
tasks as it is for manually-created tasks.
Task/content statuses (author cannot approve)
Task/Content Statuses (Author cannot approve)
l

Content is created and checked in
o Content status: Checked In
o

l

Task state: No auto task assigned

Content is submitted for approval
NOTE: This action creates an automatic task for the content.

l

o

Content status: Waiting for completion of associated tasks

o

Task state: Not Started

Content is assigned by a preapproval group member to an editor
l
Content status: Waiting for completion of associated tasks
l

1044

Task state: Not Started

Ektron Reference

Enabling Task Preapprovals

l

Editor updates content then checks it in
o Content status: Checked In
o

l

Task state: Active

Content is submitted for approval; it enters any workflowapproval process set for the
folder or content
NOTE: Because the task requires an approval, it appears in the task list of the current approver.
When the content is approved, the task is moved to the next approver’s task list.

l

o

Content status: Submitted for Approval

o

Task state: Pending

Approver denies request
o Content status: Checked In
o

l

Task state: Reopened

Approver approves content
o Content status: Approved
o

Task state: Complete

Task/content statuses (author can approve)
Task/Content Statuses (Author can approve)
l

Content is created then checked in
o Content status: Checked In
o

l

Content is edited then checked in
o Content status: Checked In
o

l

Task state: No auto task assigned

Task state: Active

Content is submitted for approval
NOTE: Although an author can approve content, the author must click publish twice: once to
change content status to Awaiting Completion of Associated Task, and a second time to change it
to Approved.

l

o

Content status: Pending

o

Task state: Not Started

Content is published
o Content status: Approved
o

Task state: Completed

Enabling task preapprovals

Enabling Task Preapprovals
To set up an automatic preapproval group:
1. Go to Workarea > Settings > Configuration > Setup > Application Setup
> Workarea tab > Enable Preapproval Group and check the box.
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2. Assign user groups to folders whose content must complete the preapproval process
before it enters the regular workflowapproval process.

You can choose (or update) a preapproval group only if these criteria are both true.
l
l

The Enable Preapproval Group field is enabled (see Step 1 above)
You are an administrator or a user that has the Modify Preapproval permission
enabled on the Advanced tab of a folder's View Permissions screen. To view
permissions, click a folder, then choose View > Properties > Advanced
> View Permissions ( ).

a. Go to the folder's properties screen and click Modify PreapprovalGroup (
access the PreApproval Group field. The Edit Properties screen appears.
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b. Check the Inherit parent configuration box if you want this folder to inherit the
preapproval group from its parent folder. If you choose a user group, an automatic
task is assigned to that group whenever content in that folder is created or updated.
NOTE: The Preapproval Groups Report lists all preapproval groups assigned to Ektron folders. To
access it, go to Workarea > Reports > Contents > Preapproval Groups.
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PREREQUISITE
Only members of the Administrators user group and those defined in the Manage
Members for Role: Add Role Member Business Rule Editor screen can work with
Business Rules. See Also: Defining Roles on page 1120
Business Rules let you define conditions for Web pages on your site. You choose an action
based on whether the conditions are true or false when a site visitor browses your site. For
example:
l

Condition—a site visitor visits your site for the first time

l

Action—add a cookie to the site visitor’s computer and display a welcome message

With Business Rules, you do not write code to set conditions and initiate actions. You simply
complete the Business Rules wizard, have your developer add a Business Rules server control
to your Web form, and assign a Business Ruleset to the server control. See Also:
BusinessRules on page 1671 server control.
Business Rules start out with a ruleset made up of one or more rules. Rules consist of
conditions and actions. There are several predefined conditions and actions for rules.
Conditions include:
l

Cookie Parameter = value

l

Form Parameter = value

l

QueryString Parameter = value

l

Server Variable = value

l

Custom Parameter = value

Actions include:
l

Display a calendar

l

Display a message

l

Open a URL in a new window

l

Pop up a message

l

Redirect to a new URL

l

Set a cookie value

l

Display content

When a rule is defined, you can add it to multiple rulesets. This is useful if several rulesets
use a common rule.
This section also contains the following topics.
Selecting a Rule
Creating a New Business Ruleset
Working with Rulesets

1050
1051
1051

Selecting a Rule
There are 2 ways to select an existing rule:
l

1050

Check boxes—allow you turn a rule on or off by clicking the check box. Checked, the
rule is active; unchecked, the rule is inactive.
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l

Highlighting—used when you want to work with a rule; for example, you want to edit
or delete a rule. To highlight a rule, click its title.

Creating a New Business Ruleset
1. Navigate to Settings > Business Rules.
2. Click Add New Ruleset. The Add New Ruleset screen appears.
3. In the Name text box, add a unique, descriptive name for the ruleset.
4. Click Save Ruleset. The View Ruleset screen appears.
You can now add a rule (as described in Add a New Rule to a Ruleset on page 1053) or click
Back (

) and return to add a rule later.

Working with Rulesets
After creating a ruleset, you typically add rules to it via the View Ruleset screen. This screen
is the launch pad for working with existing rulesets or creating new rulesets.

Edit a Ruleset
You can edit a ruleset from 2 locations: the Web page or the Workarea. To edit a ruleset from
the Web page, navigate to a Business Rule on a Web page while logged in. Then, right click
the Business Rule icon and click Edit.

Ektron 8.7

1051

Creating Business Rules for Your Website

To edit from the Workarea:
1. Navigate to Settings > Business Rules. The Business Ruleset screen appears.
2. Click the ruleset name.
3. Click Action > Edit Ruleset. The Edit Ruleset screen appears.
4. From this screen, you can make a rule inactive (Selecting a Rule on page 1050), remove
a rule from the ruleset (Remove a Rule From a Ruleset below), or change the order in
which rules are applied (Change the Order of Rules in the Ruleset below).

Remove a Rule From a Ruleset
1. Navigate to the Edit Ruleset screen, as explained in Edit a Ruleset on the previous page.
2. Highlight the rule you want to remove.
IMPORTANT: The rule must be inactive (check box deselected) for you to remove the rule. If the
check box is not empty, the rule will only appear as though it has been removed.
3. Click Remove Rule (

). A window indicates that the rule will be removed from this

ruleset only.
4. Click OK. The rule is removed from the Edit Ruleset screen.
5. Click Save Ruleset.

Change the Order of Rules in the Ruleset
The order of rules in a Ruleset affects their application when a site visitor views a page. For
example, you want to display a welcome message before a content item. To accomplish this,
move the rule for the welcome message above the rule for a content item.
1. Navigate to the Edit Ruleset screen, as explained in Edit a Ruleset on the previous
page.
2. Highlight the rule you want to reorder.
3. Click the up and down arrow buttons to move the rule within the list.
4. Click Save Ruleset.

Delete a Ruleset
When you delete a Ruleset, it is removed from the system permanently. However, rules in a
Ruleset are not deleted because they can be used in multiple Rulesets.
1. Navigate to Settings > Business Rules. The Business Rulesets screen appears.
2. Click the ruleset name.
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3. Click Action > Delete Ruleset. A dialog asks you to confirm the deletion.
4. Click OK.

Add a New Rule to a Ruleset
1. Navigate to Settings > Business Rules. The Business Rulesets screen appears.
2. Click the Business Ruleset for which you want to create a new rule.
3. Click New > Add New. The Rules Wizard launches and helps you define a rule.

4. Wizard Step 1 prompts you to create conditions for the rule and decide whether a site
visitor needs to match Any or All conditions. Click the param and value links to open a
dialog to enter information.

5. Place a check next to any condition you want to use. Use the following list to help you
complete the param and value fields.
l
Cookie param equals value—Use a cookie for this condition.
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o

param—enter Name in this field.

o

value—enter the name of the cookie in this field.

Does the site visitor's system have an Ektron cookie?
Usage: Cookie param “Name” equals value “Ektron”
l

Form param equals value—Use a form elements field name and match the value
entered into the element.
o param—enter a form’s element Field Name from a form.
o

value—enter the value you want the form element to match.

A form has a Choices Field element with the Field Name “Favorite_Food” and
choices of Pizza, Steak and Chicken. When a site visitor chooses Pizza and clicks
submit, your rule launches a Pizza company’s website.
Usage: Form param “Favorite_Food” equals value “Pizza”
l

QueryString param equals value—Use the QueryString for this condition
o param—the name of the QueryString. For example, ID.
o

value—the value associated with the parameter. For example, 18.

Is content with the ID of 18 being displayed?
Usage: QueryString param “ID” equals value “18”
l

Server Variable param equals value—Use server variables from the site visitor.
o param—enter the name of a server variable. For example, HTTPS.
o

value—the value associated with the parameter. For example, On.

Is the site visitor’s browser using SSL?
Usage: Server Variable param “HTTPS” equals value “On”
l

Custom param equals value—Use custom parameters from the user. User
parameters are defined in the code-behind of a Web page.
o param—enter the name of a custom parameter. For example, AcctBlnc
o

value—the value associated with the parameter. For example, 1000

Is the user's account balance $1000?
Usage: Custom param “AcctBlnc” equals value “1000”
6. Click Next. Wizard Step 2 prompts you select an action to take if conditions are true.
Check the boxes for the actions to take. Click the blue links to add the appropriate
information.
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l

Display Calendar ID—Enter an Ektron Calendar ID.

l

Display a Message—Enter a message to be displayed.

l

Open URL—Enter a URL. This opens a new window with the URL.

l

Popup A Message—Enter a message that appears in a popup dialog box.

l

Redirect to a URL—Enter a URL to redirect a the site visitor’s browser.

l

l

Set Cookie to Value—Creates a cookie on the site visitor’s system. Enter Name
for Cookie and the name of the cookie for Value.
Display Content Block ID—Enter an Ektron content block’s ID.

7. Click Next. Wizard Step 3 lets you select actions to take when conditions are false. This
works the same as Wizard Step 2.
8. Click Next. Step 4 of the Wizard asks you to enter a name for the rule in the text box.
9. Click Done. The View Ruleset screen appears. Your rule appears in the Ruleset box.

Add an Existing Rule to a Ruleset
You can add a rule to multiple Rulesets. To do so:
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1. Navigate to Settings > Business Rules. The Business Rulesets screen appears.
2. Click a Business Ruleset to which you want to add a rule.
3. Choose New > Add Existing. The Add an Existing Ruleset screen appears.
4. Check one or more rules to add to the Ruleset.
5. Click Save Ruleset.

Edit a Rule in a Ruleset
1. Navigate to Settings > Business Rules. The Business Rulesets screen appears.
2. Click on the Ruleset that contains the rule to be changed. The View Ruleset screen
appears.
3. Click on the name of the rule to be changed. The rule is highlighted.
4. Choose Action > Edit Rule. The Rules Wizard appears with the rule loaded.
5. Edit as necessary. The Rules Wizard is explained in Add a New Rule to a Ruleset on
page 1053.
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Ektron enables authoring, organizing, publishing, and versioning of Web content—in multiple
languages. Ektron has a fully-developed, Web content localization solution that combines Web
content management with localization/translation management, and supports creating
content in any language supported by the Unicode standard. Ektron provides multi-language
support for the following areas:
l

Content—seen by content contributors; visitors to your site.

l

Spell check dictionary—seen by visitors to your site.

l

Special Character Encoding—seen by visitors to your site.

l

Workarea screen labels, alt text, system messages—seen by content contributors.

Multi-language editions of the same content have the same ID number but are differentiated
by a language attribute. As a result, a Web page template can link to a content item, but what
appears is determined by the selected language. There are 2 ways that content’s language
can be selected:
l

l

a language cookie, which is created when a visitor browses to your site and selects a
language
the link to another page includes the language (langType) parameter. For example,
mytemplate.aspx?LangType=1033. For a list of the decimal values for each supported
language, see Ektron Workarea > Settings > Localization > Languages and
Regions.

Developers can use the following server controls for multi-language content:
l

LanguageAPI on page 1754—to specify a language for a site.

l

LanguageSelect on page 1755—to display a drop-down list of available languages.

The following Ektron components are affected by multi-language support:
l

l

l

l

l

l
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Approval chains—You can set up a language-specific approval chain and method (just
as you can create separate editions of content for each enabled language). For more
information, see Setting Approval Chains on page 262
Calendars—You can create calendars in any supported language. When you enter the
calendar and event information in the foreign language, the calendar display (that is, day
and month names) automatically appears in that language. Also, regional conventions
for first-last days of the week, and date and time formats are maintained. For more
information, see Working with Calendars on page 514.
Collections—You can create a language-specific instance of each collection. For more
information, see Working with a Collection in a Multi-Language System on page 365.
Menus—You can create an instance of any menu in every supported language so that
site visitors can see a menu displayed in the user-selected language. (If a menu in the
selected language is not available, nothing appears.) For more information, see Working
with Menus in a Multi-Language System on page 770.
Tasks—If you create content then add a task to it, the task can be in any enabled
language. For example, this is helpful if you review English content then want to assign
the task of translating it into another language in that language. If you create a task then
try to assign content to it, you can only choose from content in the language of the task.
For more information, see Assigning and Managing Tasks on page 1027.
Taxonomies—Multi-language support affects the way you create, maintain, and
manage taxonomies. See Working with Taxonomies in a Multi-Language Environment on
page 814.
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Setting Up a Multi-lingual Website
The following steps provide an overview for setting up a multi-lingual website.
1. Enable multi-lingual support in web.config. See Enabling/Disabling Support for Multiple
Language Content below
2. Enable languages that your site will support. See Determining Which Languages are
Available below
3. Set a default content language, one that will be used by the majority of your site’s
content. If you had a previous version of Ektron and selected a default language on the
Database Upgrade Utility, be sure that default language matches the one in web.config.
4. Add language selection function to templates so that your site can be viewed in another
language. See Viewing Your Site in Another Language on page 1062
5. Create multi-language content. See Creating Multi-language Content on page 1062 and
Translating Content into Another Language on page 296
6. Modify page content based on language selection. See Modifying Page Content Based on
Language Selection on page 1064
7. Modify an image based on language selection. See Modifying Images Based on Language
Selection on page 1064
8. Create a metadata definition for each supported language. See Working with Metadata
on page 369
9. Set up approval chains for new content. See Setting Approval Chains on page 262
10. Set up multi-lingual collections. See Working with a Collection in a Multi-Language
System on page 365
11. Set up multi-lingual menus. See Working with Menus in a Multi-Language System on
page 770
12. Set up multi-lingual taxonomies. See Working with Taxonomies in a Multi-Language
Environment on page 814

Enabling/Disabling Support for Multiple Language
Content
1. Open siteroot\web.config.
2. Set the value of ek_EnableMultilingual to 1.
NOTE: To disable, set the value to zero (0).
3. Save web.config.

Determining Which Languages are Available
PREREQUISITE
Only members of the Administrator Group or those assigned to the XLIFF-Admin role
can view, add, or edit language settings. See Also: Using the Roles Screens on
page 1121.

Ektron 8.7

1059

Working with Multi-Language Content

A locale consists of a language and a region. For example, English (United States) describes
the variation of English used in the United States, as opposed to English (English U.K.) used in
the United Kingdom.
Each locale's identifier consists of a language code and region code.
l

fr-FR = Language:French + Region:France

l

pt-BR = Language:Portuguese + Region:Brazil

l

es_419-AR = Language:Latin American Spanish + Region Argentina

You can create a new locale, if needed.
To determine which locales are available for creating content:
1. Go to Workarea > Settings > Localization > Languages and Regions. The Edit
Language Details screen lists locales in which you can create content on your site.
2. Click Enable. The Enable Languages and Regions screen appears.

3. Each language has 2 check boxes:
l
To enable a language in the Workarea and let site visitors select it when viewing the
site, check the box in the check mark (
) column.

NOTE: If you select
, the box in the
column is checked automatically. This is because,
if you let users view the language on the site, it must be enabled in the Workarea.
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The default content language on a drop-down list is determined in the ek_
DefaultContentLanguage element of the web.config file.
l

To enable a language in the Workarea only, check a box in the triangle (

)

column. The language populates the language drop-down lists in Ektron. So, you
can enable languages in the
column while you are translating the site but are not
ready to publish that content. When you complete the translation, check the
column.

If you enable only one language on the Enable Languages and Regions screen, fields that
prompt the user to select a language do not appear in Ektron. Instead, all content is created
in that language.

Disabling a Language
To disable any language, uncheck its box in the
Regions screen.

column of the Enable Languages and

Before disabling the default language, you must assign a new one. If you disable a language
for which content exists, that content remains in the database but no one can access it, either
from within Ektron or when visiting your site, unless you later re-enable that language.

Setting the Default Language
When you install Ektron, the default language is US-English (1033). The default language
determines which edition of content is displayed if a site visitor does not select a language, or
a visitor selects a language other than the default and navigates to page for which content
does not exist in the selected language. In that case, Ektron looks for the selected language's
Fallback Locales. For more information, see Setting the Fallback Locale on page 1069. If
content is not available in any of its Fallback locales, Ektron displays that content in the
default language (if available).
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IMPORTANT: You must enable a language before setting it as the default. See Also: Determining Which
Languages are Available on page 1059
To change the default language for your multi-language website:
1. Open yourwebsite\web.config.
2. Set the value of ek_DefaultContentLanguage to the locale id of the default language.
For example, 1031 for German. For a list of locale ids, see Ektron Workarea >
Settings > Localization > Languages and Regions.
3. Save web.config.

Viewing Your Site in Another Language
When a site visitor selects a language then navigates to a page on your site, Ektron uses the
following criteria to determine which language edition of content to display.
1. Display content in the selected language, if available.
2. If that edition is not available, check the language's Fallback Locale. If it is set and
content is available in that language, display that. See Also: Setting the Fallback Locale
on page 1069
3. If content is not available in the Fallback Locale, display it in the default language. See
Also: Setting the Default Language on the previous page
4. If no editions are available, display nothing.
To let site visitors to view your site in any enabled language, your developer places a
LanguageSelect server control on any template. See Also: LanguageSelect on page 1755

You can also indicate a language-edition by adding a language parameter to a quicklink. For
example, products.aspx?LangType=1033 displays the English (US) edition of the
products.aspx content. This syntax automatically sets the language cookie.
NOTE: For a list of the decimal value of each supported language, see Ektron Workarea > Settings >
Localization > Languages and Regions.
Creating an external link to a page of foreign content
If another website links to a multi-lingual page on your site, the URL must include the
language ID parameter. For example:
www.ektron.com/web-content-management-solutions.aspx?LangType=1036

Creating Multi-language Content
PREREQUISITE
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You have permission to add content to the folder.
1. Navigate to the content folder in which you want to create the content.
2. Choose View > Language and select the language in which you want to create the
content. If the desired language is not available, see Determining Which Languages are
Available on page 1059.
You can also view all content in a folder, regardless of language. This menu makes it
easy to find content in a selected language.

The View Contents of Folder screen displays the language of each content item.

3. Click Add Content ( ) and create the content as you would any content. See Also:
Creating New Content on page 287
4. When applying metadata, you can only use metadata definitions created for the selected
language. See Also: Working with Metadata on page 369
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You can set up a separate approval chain for each edition of a content, and can create
collections, menus, taxonomy categories, and tasks in any supported language.
NOTE: Alternatively, you can designate certain sections of text within a content item to be included or
excluded from certain languages. See Also: Creating One or More Localized Paragraphs on page 1073

Modifying Page Content Based on Language
Selection
If a template’s text should change according to a user’s language selection, use a case
statement to provide the language-specific content. Assume you want to create editions of the
menu that runs under the header in 3 languages: English, French, and German:
NOTE: This procedure uses the header.asp file delivered with the RC International sample site as an
example.
1. In the template file, declare each menu option a variable. For example:
Dim t_search, t_products, t_support, t_news, t_careers,
t_calendar, t_home, t_login, t_site_lang, t_contact,
t_copyright, calendar_id

2. Enter case statements that provide the value of each variable in each language. (1031—
German; 1036—French.) The following case statement is for the search menu option.
Select
Case
Case
Case
Case

ContentLanguage
"1031" t_search = "Suche"
"1036" t_search = “Recherche"
else t_search = "Search" End Select

When a user visits a page controlled by this template and selects French or German as the
site language, the page is refreshed and the translated values appear on the template.

Modifying Images Based on Language Selection
Many Web page templates also include images that require translation. To set up templates to
invoke images in the user-selected language:
1. Add to the library each image that should change when the language changes. For
example, if your company’s tag line is translated into 3 languages, upload the 3 images
into the library.
2. You should include the language in the title of the image. For example, tagline_English,
tagline_French.
3. Create a separate content block for each language-specific image. Each content block
must have a unique ID number.
4. Insert the appropriate image into a content block for each language. For example, insert
the tagline_English image into the English content block.
5. Insert the content blocks into the appropriate templates. For example, insert the English
content block into the English template.

Setting Up Locales
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Ektron provides locales for every language and region supported by your Windows server.
You can create a new locale on the Edit Language Details screen by picking a combination of
language and region, as defined by the Unicode Common Locale Data Repository. On
Windows Vista and later versions, you can use the Microsoft Locale Builder to create custom,
supplemental ASP.NET cultures. Custom cultures are helpful if no ASP.NET culture matches
either the language or the region; for example, eo-150 (Esperanto in Europe). You also can
create custom cultures for new combinations, for example, fr-US (French in U.S.). For
information about custom cultures and the Locale Builder, see the following Ektron Knowledge
Base article: Using Locale Builder to create custom locales. After you create a locale, Ektron
authors can create content, menus, collections, and so on in that locale, and your site visitors
can view content based on it.

Creating a New Locale
1. Go to Workarea > Settings > Localization > Languages and Regions.
2. Click Add (

). The Edit Language Details screen appears. A partial image is shown in

the following image.

l

l

Language—can display the major languages in every country (via the Show All radio
button), or the most common world languages (use the Common radio button). If you
are unsure about which languages are used in a country, move to the Region field,
select a country, and click the Recommended radio button. Then, go back to the
Languages field; you will see all languages spoken in the selected country by
percentage.
Region—provides several options for finding the new locale's region or country.
o If you selected a language above, you can select from a list of countries that use
the language. To do that, click Recommended and scroll below the list of
multinational regions. Click the country of the locale you are defining.
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l

l

o

To select from an alphabetical list of all countries, click Show All and scroll below
the list of multinational regions.

o

If the language's locale is not tied to a specific country but is connected to a region,
select the region from the regions list.

Locale—assign a locale ID to the new language. The locale ID must be unique, but is
free-form, so you can customize it. It could be based on a target market, for example,
“youth” for English US young adults (for example, youth-US), or “euro” for English in
Europe (euro-UK), or even “klingon” (klingon-US). If you select a language, the field is
filled in for you. Typically, the suggested value is adequate.
Fallback Locale—For every language, you can set a Fallback Locale, a language in
which content appears if it is not available in the selected language. If content is not
available in the fallback locale, Ektron looks for content in the fallback locale's Fallback
Locale. If content in that language is not found, Ektron looks for up to 4 additional
fallback locales. At that point, if content is still not found, Ektron tries to display the
content in the default language.
For example, your website's default language is US English. You have some content in
Swiss German (de-CH). The fallback language for that is Austrian German (de-AT), and
the fallback language for Austrian German is German (de-DE). If the content on a page is
not available in Swiss German, Ektron tries to find an Austrian German edition. If it
cannot find that, it looks for a German edition. If that is not available, it tries to display
an English edition. See also Setting the Fallback Locale on page 1069.
In certain situations, you may want no fallback locale. That is, you want to display
nothing if content is not available in the selected language. To accommodate this, None
is an option in the Fallback Locale drop-down list.
NOTE: If you set None as the Fallback Locale for any language, and content is not available in the
selected language, nothing appears on the page and no other languages are checked.

l

Language Tag—assign a language code to the language. This section of the screen
contains important information about this field.
IMPORTANT: Unlike the Locale field, the Language Tag field must conform to the IETF BCP 47
(Best Current Practice).

l

l

Alphabet—Some languages can be written in more than one alphabet. For example,
Serbian can be written using the Latin or Cyrillic alphabet.
Custom Ext.—choose between 2 strategies when exporting content for translation:
machine translation and pseudolocalization.
Using a MachineTranslation Strategy
When you export content for translation and apply the MachineTranslation strategy,
Ektron translates the content using machine translation then immediately imports it. See
Also: Using Machine Translation on page 1071
The following is an example of how to implement the strategy. See Also: Customizing
Behavior with Extensions on page 1867
<objectFactory>
<objectStrategies>
<add name="MachineTranslation">
<strategies>
<add name="MachineTranslationStrategyTemplate"
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type="Cms.Extensions.Templates
.MachineTranslationStrategyTemplate,
Cms.Extensions.Templates"/>
</strategies>
</add>
</objectStrategies>
<objectImplementations> </objectImplementations>
</objectFactory>

Using a PseudoLocalization Strategy
NOTE: For background information, see Pseudolocalization (Wikipedia).
When you export content for translation and apply the PseudoLocalization strategy,
Ektron converts the content to pseudo-language text and the immediately imports it..
The following is an example of how to implement the strategy. See Also: Customizing
Behavior with Extensions on page 1867
<objectFactory>
<objectStrategies>
<add name="PseudoLocalization">
<strategies>
<add name="PseudoLocalizationStrategyTemplate"
type="Cms.Extensions.Templates
.PseudoLocalizationStrategyTemplate,
Cms.Extensions.Templates"/>
</strategies>
</add>
</objectStrategies>
<objectImplementations> </objectImplementations>
</objectFactory>

Here is an example of how to override the PseudoLocalize method.
public override void
PseudoLocalize(ref string content, PseudoLocalizationEventArgs
eventArgs)

Here are the PseudoLocalizationEventArgs properties.
LocaleData
Locale
LocalizableCmsObjectType
ObjectType
long
ObjectId

Developers use the PseudoLocalize property to write custom code that
programmatically starts the export process. Here is an example:
Ektron.Cms.Localization.LocalizationExportJob.PseudoLocalize = true;
Ektron applies the PseudoLocalization strategy if either of the following conditions is
met:
l

The target locale’s language tag contains x-pseudo.

l

The export job’s PseudoLocalize property is true.

Applying PseudoLocalization Strategy to a Locale
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You can apply PseudoLocalization Strategy to a locale's language tag in the Workarea.
Use the Settings > Localization > Languages and Regions screen's Custom EXT
field, as illustrated in the following figure. Programmatically, LocaleData.XmlLang
contains x-pseudo.

Overriding the Translate Method
Here is an example of overriding the Translate method.
public override void
Translate(ref string content, MachineTranslationEventArgs
eventArgs)

The MachineTranslationEventArgs have intellisense, but the following is a list of its
properties.
LocaleData SourceLocale
LocaleData TargetLocale
LocalizableCmsObjectType ObjectType
long ObjectId

Ektron applies the Machine Translation strategy if either of the following conditions is
met.
l

The target locale’s language tag contains x-mt

l

The export job’s MachineTranslate property is true

Developers use the MachineTranslate property to write custom code that
programmatically starts the export process. Here is an example:
Ektron.Cms.Localization.LocalizationExportJob.MachineTranslate = true;

Applying Machine Translation Strategy to a Locale
You can apply Machine Translation Strategy to a locale's language tag in the Workarea.
Use the Settings > Localization > Languages and Regions screen's Custom
EXTfield. Programmatically,LocaleData.XmlLang contains x-mt.
l
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For instructions on setting a custom culture, see the following Ektron Knowledge Base
article: HOW TO: Using Locale Builder to create custom locales
l

l

l

l

ASP.NET UICulture—specifies the natural language of resource strings. This value is
assigned to the ASP.NET UICulture property. See Also: How to: Set the Culture and UI
Culture for ASP.NET Web Page Globalization
Flag Icon—used in the Workarea as a quick, visual indicator of the locale, it is
important for each locale to have a unique flag. Flag files must be 16x16 pixel .gif
images. Ektron provides several flags, which are installed to the
/siteroot/WorkArea/images/application/flags/ folder. Any flags with elements in
common with the locale's language and region appear as choices. If there is no flag next
to the locale you are creating (for example fr-017, French in Africa), you can create an
image, assign that name to it, and place it in the designated folder. Then return to this
screen, select the locale, and select the image.
Native Name—the name of the locale in its native natural language. That is, what the
people in that locale call their own language and region.
English Name—the name of the locale in English.

Setting the Fallback Locale
1. Go to Workarea >Settings > Localization > Languages and Regions.
2. Click Edit (

).

3. Click Rename or Change Fallback Locale (

) for the language of interest.

4. Use the pulldown in that language's Fallback Loc column to select a fallback locale.

NOTE: If you set a language's Fallback Locale to None and the language is part of a fallback
chain, if content is not available in that language, the chain terminates there.
5. Click Save (

) in the row of the language you are changing.

Translating Content
You have the following options for translating content.
l

Translating Content Manually on the next page—Copy original content to a new
content item in new language, then translate content manually.
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l
l

l

Error prone because some translatable text is hidden (such as ‘alt’ text in images).
Also, some text might be translated that should not be translated (for example,
Smart Form choice field values).

Using Machine Translation on the facing page—Use the computer-based
translation tool provided with Ektron.
l
Readily available as a browser add-on.
l

l

Only one content block at a time.

Results in a poor quality translation.

Exporting Content to XLIFF on page 1072—best option for translating, whether
in-house or outsourcing. Use an XLIFF editor.
l
Supports batch processing of several content blocks.
l

l

The XLIFF file is sent to a translation agency and returns translated to the new
language(s). Then, import the translated files into Ektron.
Free XLIFF editors may not adequately support the XLIFF standard so may not be
compatible.

IMPORTANT: Before using machine translation services, you must first register with Google
Translation services and then add your Google key value into the following code in the web.config
file:
<machineTranslation>
<add key="GoogleTranslator" value="[your Google key value],
https://www.googleapis.com/language/translate/v2?key=" />
</machineTranslation>

Translating Content Manually
Use this procedure to initialize new foreign language content with content from a source
language, then translate the content manually. The copying should facilitate the translation.
For example, an editor translates content from French to German. The editor copies the
French edition to new content whose language is German. As the editor translates the French
edition into German, the French content is deleted. Any images in the content usually would
remain, and all formatting (tables, bullets, and so on) is retained.
1. Go to the View Contents of Folder screen for the content you want to translate. Its status
must allow editing (it cannot be submitted or pending).
2. Choose View >Language and select an original language.
3. Click the content you want to translate. It appears on the View Content screen.
4. Use the Add drop-down list in the upper right corner to select a language into which you
want to translate the content. The original language content appears.

5. Translate into the new language then delete the original content. At this point, you can
click Translate Content ( ) to have the software translate the content. You can then
edit as needed to perfect the translation. When done, click the Paste Content button.
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NOTE: You cannot translate XML Smart Forms using the Translate Content (

) button.

6. Translate the Title and Summary.
7. To add metadata to content, metadata specifications must have been created for the
selected language. See Also: Working with Metadata on page 369
8. When you save the content, it is saved as the edition of that content in the selected
language.

Using Machine Translation
Ektron includes a machine translation feature, which is powered by the Google Translation
Service. To see a list of supported languages, go to http://translate.google.com/.
NOTE: Machine translation is not supported for all languages in the Language Settings screen. Also, you
cannot translate XML Smart Forms using this method.
Like most software-based translation, someone fluent in the new language should verify that
the translation is appropriate within the context of the page.
The machine translation feature lets you choose a glossary (that is, a field, industry, or
subject area). This helps the software find the best translation for a term or phrase in that
field.
Follow these steps to use the machine translation feature.
PREREQUISITE
Your Ektron administrator has enabled the feature. See Also: Enabling Machine
Translation on the next page
1. In the Workarea, open the folder that contains content to be translated.
2. Choose View > Language and select an original language (that is, the language from
which it will be translated).
3. Click the content you want to translate. Its status must allow editing (that is, its status
cannot be submitted or pending). It appears on the View Content screen.
4. Use the Add drop-down list in the upper right corner to select a new language for the
content.
NOTE: If you do not see the language on the drop-down, you need to enable the language. See
Also: Determining Which Languages are Available on page 1059

5. The original language content appears.
6. Edit the title if appropriate.
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7. Click Translate Content (

). The Translation screen appears.

8. Select the source (old) and target (new) languages.
9. If the content should refer to a specific glossary, select one from the drop-down list.
10. Click Translate. The translation appears.
11. If the translation looks OK, click Paste Content. The translated content replaces the
original content in the editor. Modify as needed.
12. Translate the Title and Summary.
13. To add metadata to the content, metadata specifications must have been created for the
selected language. See Also: Working with Metadata on page 369
14. When you save, the content is saved as the selected language edition of the content.
NOTE: When the View Contents of Folders screen reappears, it is probably set to the source language. In
this case, you do not see the new content in the target language. To see it, click View > Language and
select All or the target language.

Enabling Machine Translation
Follow these steps to enable Ektron's machine translation feature.
1. Using the information on the Web page https://developers.google.com/translate/v2/faq,
obtain a Google Translation API key.
NOTE: The Google Translate API is only available as a paid service.
2. Open the Ektron siteroot folder\web.config file.
3. Find the following element:
<machineTranslation>
<!-- ex. value="[API_KEY_FROM_GOOGLE],
https://www.googleapis.com/language/translate/v2?key="-->
<add key="GoogleTranslator" value="" />
</machineTranslation>

4. Insert the API key you obtained in Step 1 into the value attribute.

Exporting Content to XLIFF
You can copy content into XLIFF files that you can submit to a translation agency, or translate
the content "in house." When the translation is complete, you import translated content to
Ektron.
You can translate these kinds of Ektron information.
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l

content, including summary, comments, and metadata

l

a portion of a content (see Creating One or More Localized Paragraphs below)

l

forms, including response message, comments, and metadata

l

all menus (you cannot choose individual menus)

l

assets (Office documents, managed files, and so on. You cannot export. zip files.)

l

taxonomy data

XLIFF (XML Localization Interchange File Format) is a format for exchanging localization data
between participants in a translation project. This format lets translators concentrate on the
text to be translated, without worrying about its layout. XLIFF is supported by a large group
of localization service and tools providers. To learn more about XLIFF, visit these websites:
l

XML in localisation: A practical analysis

l

OASIS XML Localisation Interchange File Format (XLIFF) TC

Ektron supports versions 1.0, 1.1, and 1.2 of the XLIFF standard. You specify the version you
are exporting in the web.config file, using the ek_XliffVersion element. Any listed version
can be imported.

Creating One or More Localized Paragraphs
IMPORTANT: This button is only available in the eWebEdit400 editor.
The Localize Section button ( ) lets you designate paragraphs to localize for the XLIFF
translation process. For example, an author creates content in English, and does not want a
specific paragraph to be translated into French. So, the author uses the Localize Section
feature to exclude that paragraph from the French version of content. When the content is
exported, the selected paragraph does not appear in the French XLIFF file.
1. Open the content with paragraphs that you want to localize.

2. Select one or more paragraphs. You must select entire paragraphs. You cannot select
individual words or sentences within a paragraph. Also, if the content is a bulleted or
numbered list, you must select the entire list.
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3. Click Localize Section (

). The Localize Section dialog appears.

4. For each language on the list, Include or Exclude the selected text.
l
If you include one or more languages, all unchecked languages are excluded.
l
l

If you exclude one or more languages, all unchecked languages are included.
If you include some languages and exclude others, all unchecked languages are
excluded.

5. Click OK. From now on, when editing that content, authors see a <localize> box that
shows the localized sections that are exported/imported when using the XLIFF process.

On the following sample screen, Dutch and U.S. English are excluded. This means that
French, German and Italian are included even though the Include box is not checked.
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On the following sample screen, German and Italian are included. This means that Dutch,
U.S. English, and French are excluded even though the Exclude box is not checked.

On the following sample screen, Dutch is included and U.S. English is excluded. In this case,
because one language is included and another is excluded, German, Italian, and French are
excluded even though the Exclude box is not checked.
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Editing a Localized Section
1. Edit the content that contains the localized section. A localized section looks like a table
within the editor.
2. Place the cursor in the table header, near <Localize>.
3. Right click and choose Localize Section.
4. Choose Locale Languages to Include or Exclude.
5. Click OK.

Removing a Localized Section
1. Edit the content that contains the localized section. A localized section looks like a table
within the editor.
2. Place the cursor in the table header, near <Localize>.
3. Right click and choose Remove Localize Section. The localization information is
removed but the text remains.

Importing Translation Files
The following is an overview of importing translation files.
1. You select content to translate.
l
a content item
l

a folder—all content in the folder is selected; you may include its subfolders

l

all menus

l

all taxonomies

Alternatively, select a Translation Package. See Also: Creating Multi-language Content
on page 1062.
2. Ektron converts the selected content to XLIFF files. (Only content whose state is marked
"Ready for translation" is converted to XLIFF format.) You can prepare the files for
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translation into several languages at once. A separate .xlf file is created for each item.
Then, all .xlf files for each language are compressed into one .zip file.
3. Transmit the .zip files to a translation agency.
4. The agency translates and returns the files. Alternatively, the files can be translated "in
house."
5. Import the files into Ektron. If the content does not exist in the target language, it is
created.
PREREQUISITE
Only members of the Administrator User Group and those defined in the Manage
Members for Role: XLIFF-Admin screen can create or import XLIFF files. See Also:
Using the Roles Screens on page 1121
IMPORTANT: Make sure the files have been translated before you import them.
1. From the Workarea, choose Settings > Localization > Import Translated Files.
2. Click Browse and navigate to the folder that contains the translated files.
3. Select the files to import.
4. Click Import Translated XLIFF Files. Ektron creates new or updates existing foreignlanguage editions of the imported content/menu/taxonomy.
5. Information about the imported file appears in the history area of the screen. You can
click plus signs (+) to see increasing levels of information about imported content.

For each new edition:
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l

l

l
l

If the content title is the same as the source edition, the next available number is
appended to the title to distinguish it from the source. For example: Henry
Williams(1).
its status matches the source content's status. Typically, its status is checked out.
When imported, the content can enter the approval process just like other content.
its history indicates it was checked in at the time the report was run
for content, the following properties are inherited from the original content:
o Smart FormSee Also: Working with Smart Forms on page 423
o

content searchable See Also: Ensuring Your Content is Searchable on page 942

o

approval method See Also: Setting the Approval Method on page 271

l

date created and last edit date are captured from when the content is imported

l

the last user to edit is captured by user who imported the file

Marking Translation Statuses
PREREQUISITE
Member of Administrators group, or assigned to the Translation State Admin or XLIFF
Admin role See Also: Defining Roles on page 1120
Each Ektron content item has a translation status. Only content marked "ready for translation"
is included when you create an .xlf file. Use Mark Translation Status on the View Content
screen to mark the translation status. See Also: Content Statuses on page 307

The Mark Translation Status button may have any of 3 icons, which also indicate the
content's status.
l

Ready for translation—Automatically applied when content status changes to
Approved. Manually applied when authorized user clicks button and changes status to
Ready for Translation.
NOTE: You may apply this status to unapproved content if it needs translation before the site goes
live.

l

Not ready for translation—Automatically applied when content status changes to
anything other than Approved. Translation status changes if
o authorized user clicks button and chooses ready for translation
o

l

content's status changes to approved

Do not translate—Prevents content from being translated. Translation status
changes only if authorized user clicks button and chooses ready for translation.

If you click Mark Translation Status (
Note that Export for Translation (

), a menu appears that lets you change its status.
) appears on the toolbar only if the content's

translation status is Ready for Translation.
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If you create an .xlf file for a folder, only content whose translation status is ready is included
in the file.
NOTE: The Localization Dashboard provides an overview of translation activity within Ektron.

Applying Translated Metadata to Translated Content
Prior to version 8.5, translated metadata is ignored when importing XLIFF files. Starting with
version 8.5, key metadata fields are recognized in the XLIFF process and will be
imported/exported.
After you import the translation files, Ektron removes them from the file system.
NOTE: If an error exists in any of the files, the erroneous files are moved into a subdirectory. The directory
is created using a timestamp. For example:
uploadedFiles\localization\merged\xlf20060208T141841_u1\error\.

Metadata that Works with XLIFF Export and Import
The following metadata field names may be used for translation using the XLIFF export and
import process.
l

XliffReferenceSource—Content Selector

l

XliffReference—Content Selector

l

XliffGlossary—Content Selector

l

XliffNote—Meta Data

Working with Metadata that does not work with XLIFF
This section describes how to have translated metadata applied to the translated content that
does not use the above special names.

Background Information
Although metadata exists in the XLIFF files, it does not appear in the content's metadata even
if metadata is defined for that language. This is because metadata definitions have unique IDs
across languages. While a content ID is the same for a corresponding content block in other
languages, the same is not true for metadata.
As a result, the ID for the source language (for example, English) metadata is not
automatically mapped to metadata for other languages (for example, Spanish).
To solve this problem, create a mapping between the IDs of metadata definitions of different
languages that are synonymous. For example, consider the following metadata definitions.
ID

Name

Language

102

Paper form number

en-US

104

Original page count

en-US

106

Número de papel de la forma

es-ES
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ID

Name

Language

108

Cuenta de la página original

es-ES

110

Estado de la minoría

es-ES

In this example, IDs 102 and 106 are synonymous as are 104 and 108. Definition 110,
however, only exists in Spanish.
The mapping is stored in an XML file. The mapping informs the XLIFF import process that
metadata for ID 102 in English corresponds to ID 106 in Spanish and likewise with 104 and
108.

Setting up the Process to Apply Translated Metadata to Content
1. Open the folder siteroot/workarea/xslt/ and look for metadatadefinitions.xml. If it
exists, go to step 2.
If it does not, download it from XliffMetadata.zip. After unzipping the file, copy the .xslt
files to the siteroot/workarea/localization/xliff folder. Copy the xml file to the
siteroot/workarea/xslt folder.
2. Create metadata definitions in the other language(s). Be sure to use the same data type.
To do this, log in, open the workarea, go to Settings > Configuration > Metadata
Definition.
3. Make note of the definitions in the original language (for example, English).
4. Switch to view another language (for example, Spanish) and add a new definition. Assign
it the same data type and other properties as the original. Note the new ID numbers.
5. Create metadata definitions in all languages you wish to support. You may add other
languages and define more metadata definitions at any time.
6. Edit workarea/xslt/metadataDefinitions.xml. For each Metadata Definition, enter a
<dd> element within the <dl> element. The <dd> element has the following form.
<dd title="Name of the metadata definition">
<dfn id="ID" xml:lang="language-country code"/>
<dfn id="ID" xml:lang="language-country code"/> :
</dd>

For example:
<dl>
<dd title="Paper form number">
<dfn id="102" xml:lang="en-US"/>
<dfn id="106" xml:lang="es-ES"/>
</dd>
<dd title="Original page count">
<dfn id="104" xml:lang="en-US"/>
<dfn id="108" xml:lang="es-ES"/>
</dd>
</dl>

The definition for ID 110 is not included because it applies to only one language.
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Now, the XLIFF import process accesses the metadataDefinitions.xml file to determine
which definitions in the target language (for example, Spanish) correspond to the definitions
in the source language (for example, English).

Creating the .zip File
To create one or more .zip files for translation:
PREREQUISITE
Only members of the Administrator User Group or those assigned to the XLIFF-Admin
role can create, export, or import XLIFF files. See Also: Using the Roles Screens on
page 1121.
1. Select the content to be exported:
l
To translate one content item, navigate to its folder then click it.
l

l
l

l

To translate all content in a folder (and, if desired, its subfolders), navigate to its
View Contents of Folder screen.
To translate a menu, go to Content Tab > Menus.
To translate a taxonomy, go to Content Tab > Taxonomy and check taxonomies
to translate.
To translate a Translation Package, see Creating Multi-language Content on
page 1062.

2. Click Export for Translation (

). (On the View Contents of Folder Screen, choose

Action > Export for Translation.) The Export for Translation screen appears.

NOTE: The Include Subfolders field appears only if you click Export for Translation from the
View Contents of Folder screen.
3. To include content in all of a selected folder’s subfolders, check Include Subfolders.
4. From the Source Language pull-down, select the language of items being translated.
5. All enabled languages are selected under Target Language. (See Also: Determining
Which Languages are Available on page 1059).
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6. To translate the content into all languages, proceed to the next step.
To translate the content into some languages, uncheck the languages that you do not
want. You can uncheck the box in the header row (illustrated below) to uncheck all, then
only check the ones you want.

7. Click Create XLIFF Files for Translation.
8. Ektron creates one .zip file for each language. The .zip file includes an XLIFF file for each
selected content item. (If content in a target language was edited more recently than the
source language edition, that content is excluded from the .zip file. Also, the content's
translation status must be ready. See Also: Marking Translation Statuses on page 1078)
The History section of the Export for Translation screen displays the translated files.

The history lists the .zip file created for each language. The top of the history window
displays the most recently exported/imported files. ZIP files are indicated by the WinZip
icon (

). To the right of the icon are:

l

the source language's flag

l

an arrow indicating the direction of the translation

l

the destination language's flag and name

l

the zip file size

9. To review items in a zip file, click + next to Extracted. When you do, each content
item’s ID number, title, and last edit date appear.
10. Click the .zip file icon (under Downloadable Zipped XLIFF Files). The File Download
window appears. If you want to review the XLIFF files within the .zip file, click Open.
11. Click Save. The Save As window appears.
12. Navigate to the folder where you want to place the zip file and click Save.
13. Transmit the files to the translation agency.
NOTE: When the translation agency returns XLIFF files, their extension must be .xlf or .xml. Other than
that, the file name is not important.

File Naming Patterns
XLIFF
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l

l

item identifier[item ID]_[new language hexadecimal code][2 letter new language
code].xlf
o item identifier options:
o

content: cont

o

form: form

o

menu: s

o

menu item: s

o

taxonomy: t

item ID varies, depending on whether the item is content, a form, a menu, or a menu
item
o content: content ID number
o

form: form ID number

o

Menu: menu ID number

o

Menu item: menu ID number

ZIP
l

xlf[timestamp in format yyyymmddThhmmss]_u[user ID] _ [new language hexadecimal
code]-[2 letter language code].zip
The user ID indicates which user performed the export or import.

Creating a Multi-language Translation Package
Use the Multi-language Translation Package to create and control groups of content that
require translation. Translation packages contain any type of content managed by Ektron
including
l

HTML

l

XML Smart Forms

l

assets like Microsoft Word documents, PDFs

l

images. Images (.gif, .png, .jpg and so on) are also managed with their associated
source documents like Photoshop (.psd) files.

For ease of use, you may add content and folders to one or more Translation Packages.
After creating a Translation Package, you use the Export for Translation screen's Select
Packages field to export the content for translation. See Also: Exporting Content to XLIFF on
page 1072
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Only content that’s selected for that package and marked “Ready for Translation” is exported.
See Also: Marking Translation Statuses on page 1078
PREREQUISITE
You must be a member of the Administrators group or be assigned to the XLIFF Admin
role. See Also: Defining Roles on page 1120

Viewing Translation Packages
When you first view the Translation Packages screen, you see all packages in the default
language. To view existing packages in any (or all) languages, change the language dropdown.

Adding a Translation Package
1. Go to Workarea > Settings > Localization > Translation Packages.
2. Choose a language for this Translation Package using the View: drop-down.
3. Click Add Translation Package. The Add Translation Package screen appears.
4. Enter a translation package title and description.
5. Click Save. TheItems and Properties tabs appear.
6. Below the tabs, a screen appears. Use toolbar buttons to add items to the Translation
Package.
l

l

l

l

l
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—Assign languages into which the package's content is exported for translation.
See Creating the .zip File on page 1081.
—Assign content to Translation Package. SeeAssigning Items to a Translation
Package on the facing page .
—Assign folders to Translation Package. See Assigning Folders to a Translation
Package on the facing page.
—Edit Translation Package.Change the title or description. To change other
elements of the package (content, folders, and so on), click the appropriate button.
—Delete Translation Package.
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Assigning Items to a Translation Package
1. Go to Workarea > Settings > Localization > Translation Packages.
2. Choose a language for this Translation Package in the View: drop-down.
NOTE: You can add more languages to the package after you create it.
3. Click a Package Name to view it.
4. Click Assign Items (

). The following image shows an example of the

\Content\Company\Careers folder.

5. Check items to include in this package. Only content in the selected language appears.
6. Click Update Translation Package.

Assigning Folders to a Translation Package
If you select a folder, only content in that folder that matches the Translation Package's
source language is included. For example, you create a Translation Package in English. In
that package, you select folder which has 1 content item in English, 2 in Spanish, and 1 in
German. When the package is exported for translation, it includes the English content only.
1. Go to Workarea > Settings > Localization > Translation Packages.
2. Click on a Package Name to view it.
3. Choose a language for this Translation Package in View:.
4. Click Assign Folders ( ). The following image shows an example of the
MainSite\Content\Company\Careers folder.
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5. Check folders to include in this package.
NOTE: To check subfolders, open the folder tree to show the subfolders then check the top folder. If
you do not want to include the subfolders, do not open the folder tree or uncheck the specific
subfolders.
6. Click Update Translation Package.

Linking a Photoshop Source File to an Image for Translation
Complex images often contain text that you wish to translate. Because the image is a "flat"
non-layered file, it is difficult to make text changes. However, the text may be on a layer
within a Photoshop (.psd) file.
1. Create a Metadata key called XliffReferenceSource of the type Content Selector.
NOTE: The key name XliffReferenceSource is a reserved name and recognized by the
XLIFF import/export process.
2. Assign XliffReferenceSource metadata to the folder where the images are stored.
3. Add the Photoshop file as an asset in the folder.
4. Go to the Library and edit the image to which you associate the psd file.
5. Click the metadata tab and add the Photoshop file to the XliffReferenceSourcefield.
6. Click Publish.

Translating the Workarea
By default, the Workarea is in English. Ektron provides US English strings in a text file.
Workarea text (that is, screen titles, Workarea menus, messages, alt text for buttons, and so
on) is stored in a resource file. Resource files are installed to the
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siteroot\Workarea\resources directory. Workarea images that include text are stored in
the workarea/images/language folder. For example, Workarea\images\french_standard.
Ektron provides a resource files for the following languages. The English resource file is
complete, so translate the English file into the desired language. The others are partially
complete.
l

German

l

English—United States

l

Spanish

l

French

l

Italian

l

Dutch—Netherlands

l

Dutch—Belgium

A resource file is not human-readable. To make it so, use Microsoft’s resgen utility, then
translate the human-readable, .txt version of the file. The following example shows a portion
of it.
add menu title=Add Menu
lbl ad serverip=Domain Controller IP
alt: remove collection items text=Click here to remove items
from this collection

Each string has the following components:
English description—includes information about where the text appears. For example,
btn text appears on a button.

l

an equal sign (=)

l

English text—The text displayed on the screen, for example, a button label, menu item,
or mouse-over text.

l

For each string, translate the text to the right of the equal sign. Then, run the resgen utility
on the .txt file again, indicating the translate-to language. This converts the file back to a
machine-readable format. Finally, move that file to the appropriate language folder under
workarea/images, and enable the new language in the Workarea.
PREREQUISITES
l

l

The alphabetical, 4-character identifier of the country/language into which you
are translating. See CultureInfo Class from the MSDN website.
The server that hosts Ektron must have Visual Studio.NET.

1. Copy the resgen.exe utility from C:\Program Files (x86)\Microsoft
SDKs\Windows\v7.0A\Bin to the your-web-site\Workarea\resources folder.
In Visual Studio 2008, the resgen.exe utility is typically located in the <SDK dir>\bin
directory, located via HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft
SDKs\Windows.
2. Go to Windows Start button > Microsoft Visual Studio 2010 > Visual Studio
Tools > Visual Studio Command Prompt to open a command window.
3. In the command window, change the directory to the your-website\Workarea\resources folder. For example, cd
C:\Inetpub\wwwroot\CMS400Min\Workarea\resources.
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4. Insert the following text: resgen EKResource.en-US.resources anyfilename.txt
You can assign any name to the .txt file. A .txt file of resource strings converted to a
human-readable format is created in the resources directory.
5. Open the .txt file.
6. Replace all single backslashes (\) with a double backslash (\\).
7. Translate the text following every equal sign (=). Be careful not to change any
occurrences of n surrounded by double backslashes (\\n\\).
8. Save and close the .txt file.
9. Open the command window (as described in Step 2) and insert the following:
resgen anyfilename.txt EKResource.two-character country
code-two-character language code.resources.

Replace anyfilename.txt with the file you named in Step 4. In this example, the .txt
file is named span_translation.txt. For example, to indicate that the Workarea is
being translated into the Spanish/Spain, enter resgen.exe span_translation.txt
EKResource.es-ES.resources.
When the conversion is complete, Writing Resource File ...Done appears in the
command window.
10. The Workarea\resources folder includes several resource files. If one exists for the
translate-to language, it is overwritten. If one does not exist, it is created. To follow our
example, the EkResource.es-ES.resources file was updated with your changes.
11. **Your website's Workarea\images folder contains text images that need translation. If
the country/language into which you are translating has subfolder within
Workarea\images, inspect its images to see if they need translation. If the
country/language into which you are translating does not have a subfolder within
Workarea\images:
a. Create a new folder whose name is the language code into which you are
translating.
b. Copy the files in the Workarea\images\en folder.
c. Paste those files to the folder you created in Step 10a.
d. Review the files in the folder you created in Step 10a. Translate text as needed.
12. Enable the new language in the Language Settings screen. See Determining Which
Languages are Available on page 1059
13. Make the new language the default language in the Configuration Setup screen. See
Getting Started with Ektron on page 5.

Setting the Language of Spell Checking for
eWebEdit400
NOTE: If you use the default editor, your browser manages the spell checking.
Ektron’s spell checker for eWebEdit400 refers to a standard dictionary of the content’s
language. So, for example, if the content is U.S. English, the U.S. English dictionary is
referenced.
The spell checker also references a language-specific custom dictionary. Words are added to
this list when a user stops at a misspelled word and chooses the Add to Dictionary option.
Both dictionaries reside on the server that hosts Ektron.
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The spell checker compares each word against both sources. If a word is in either one, the
spell checker moves to the next word. If a word is missing from both sources, the spell check
options shown below appear, and the user decides what to do.

Ektron provides the following standard dictionaries.
l

uk-UA—Afrikaans

l

ar-AR—Arabic

l

bg-BG—Bulgarian

l

cs-CZ—Czech

l

da-DK—Danish

l

de-CH—German (Switzerland)]

l

de-DE—German

l

en-GB—English (Great Britain)

l

en-US—English (United States)

l

es-ES—Spanish

l

fr-FR—French

l

he-IL—Hebrew

l

it-IT—Italian

l

nl-NL—Dutch

l

nn-NO—Norwegian (Nynorsk)

l

pl-PL—Polish

l

pt-PT—Portuguese

l

pt-BR—Portuguese (Brazil)

l

ru-RU—Russian

l

sl-SL—Slovenian

l

sv-SE—Swedish

l

uk-UA—Ukrainian

If Ektron does not have a dictionary that matches the content language, it proceeds through
these steps in the following order:
1. If the language begins with en (for example, en-AU), use the en-GB dictionary.
If it begins with zh, use zh-CHS.
2. Each language has a default version, indicated by letters before the dash matching the
ones after the dash. For example fr-FR. If the default version’s dictionary is available,
use it.
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3. Use the first dictionary (alphabetically) that begins with the content language. For
example, the content language is es-AR, but its dictionary does not exist. The first
dictionary alphabetically beginning with es that is available is es-CO, so use that.
4. If none of the above is available, use en-US.

Editing eWebEdit400’s Standard Dictionaries
The following topics explain how to access a screen for working with standard dictionaries,
and how to update, edit, replace, and delete individual words as well as entire dictionaries.
You cannot edit a word. Instead, delete a word then add the corrected version.

Accessing the Spell Check Dictionary Update Screen
Ektron provides a special screen that lets you create, update, and delete the standard
dictionaries. To access this screen, use this URL:
http://your-server/siteroot/workarea
/contentdesigner/dictionaryconfigurator
/dictionaryconfigurator.aspx
This screen looks like this.

NOTE: If you want to remove the red text from the top of the screen, open the .aspx file and delete that
text.
To use this screen, the ASP.NET user must be granted read and write permission to the
following folder: your-server\siteroot\Workarea\Foundation\RadControls\Spell\TDF.
NOTE: If ASP.NET user has full permission but you still cannot edit a dictionary, open the folder listed
above, right click the TDF file and verify it is not read-only.

Adding a Word to a Dictionary
1. Open the Dictionary Update screen. See Also: Accessing the Spell Check Dictionary
Update Screen above
2. Click Edit Dictionary.
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3. At the Select Dictionary drop-down, choose the language of the dictionary you want to
update.
4. In the Add a word field in the lower right corner of the screen, enter the word to add.

5. Click Add.
NOTE: Tip! Enter the word you just added into the Find Word field and click Find to verify that the word
was successfully added.

Deleting a Word from a Dictionary
1. Open the Dictionary Update screen. See Also: Accessing the Spell Check Dictionary
Update Screen on the previous page
2. Click Edit Dictionary.
3. At the Select Dictionary drop-down, choose the language of the dictionary you want to
update.
4. In the Find word field in the top left of the screen, enter the word to delete.

5. Click Find.
6. In the results box below, click the word.
7. Click Delete Selected.
NOTE: Enter the deleted word into the Find Word field and click Find to verify that the word was
successfully removed.

Adding a Word List
You can add a list of words to a standard dictionary. For example, you work in a hospital and
want to add medical terms. While you can add words one at a time using Adding a Word to a
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Dictionary on the previous page, it is more efficient to place all words in a text file then
import the file into a dictionary.
1. On your server, create a .txt file.
2. Place all words into the .txt file, one on each line.
3. Save the file using the language code of the dictionary you are updating. For example, if
you are adding to the French dictionary, name the file fr-fr.txt.
4. Open the Dictionary Configurator screen. See Accessing the Spell Check Dictionary
Update Screen on page 1090.
5. Click Edit Dictionary.
6. Next to Import Wordlist, click Browse.

7. Navigate to the text file you saved in Step 3.
8. Click Import. All words on the list are added to the dictionary whose name matches the
.txt file. For example, words in the fr-fr.txt file are added to the fr-FR.TDF dictionary
file.
NOTE: While on the screen, enter one of the words in the word list into the Find word field, then click
Find to verify that the import succeeded.

Importing a Dictionary
Typically, you want to import a dictionary because the language of some Ektron content is not
included in the set of standard dictionaries. For example, your content is Japanese.
You also can delete a standard dictionary then import one to replace it if you have a word list
that you consider superior to the standard dictionary. See Also: Deleting a Dictionary on the
facing page.
To import a dictionary:
NOTE: The following procedure assumes the words do not yet exist in a .TDF file. If they do, open the
Dictionary Configurator screen, click Browse, select the file, and click Import. See Also: Accessing the
Spell Check Dictionary Update Screen on page 1090.
1. Create a blank .tdf file.
a. On your server, use Notepad to create a blank .tdf file named after the language
code of the dictionary you are importing. For example, if you are importing a
French dictionary, name the file fr-fr.tdf.
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b. Open the Dictionary Configurator screen. See Also: Accessing the Spell Check
Dictionary Update Screen on page 1090.
c. Next to the Pick a file to import field, click Browse.
d. Navigate to the .tdf file you created in Step 1.
e. Click Import. This action places the TDF file into the correct folder.
2. Create and import the word list.
a. Follow the procedure described in Adding a Word List on page 1091 to insert all
dictionary words into a .txt file.
b. Click Edit Dictionary.
c. Next to Import Wordlist, click Browse.

d. Select the text file you created in Step 1.
e. Click Import. All words in the list are added to the dictionary whose name matches
the .txt file name.
NOTE: Use the Edit dictionary screen to select the dictionary. Then, use the Find word field to verify that
the import succeeded.

Deleting a Dictionary
You typically would delete a standard dictionary to replace it if you have a word list that you
consider superior to the standard dictionary.
1. Open the Dictionary Configurator screen. See Also: Accessing the Spell Check Dictionary
Update Screen on page 1090.
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2. In the available dictionaries list, find the language whose dictionary you want to import.

3. To the right of the language, click Delete.

Editing eWebEdit400’s Custom Dictionary
A language’s custom dictionary is created the first time a user uses the Add to Dictionary
option while spell checking content in that language. From then on, the dictionary is updated
when anyone using that server edits content in that language and uses the Add to
Dictionary option. The name of the custom dictionary is formed using:
l

the language code of the content

l

a dash (-)

l

the word custom

l

the file extension .txt

So, if the content is French, the file’s name isfr-fr-custom.txt. The file is saved to the
root/Workarea/Foundation/RadControls/Spell/TDF folder.
You can edit the custom dictionary manually using an application that updates .txt files, such
as Notepad.

Using the Localization Dashboard
PREREQUISITE
You must be a member of the Administrators group or assigned to the XLIFF Admin
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role. See Also: Defining Roles on page 1120
The Localization Dashboard provides an overview of translation activity occurring in Ektron.
To access the Localization Dashboard from the Workarea, go to Settings > Localization >
Dashboard. The top of the screen lets you choose criteria. The lower section then displays
content that meets the criteria. For example, you can find all US English content whose
translation status is Ready for Translation, and resides in the /Clients folder. The lower
section of the screen also lets you perform tasks on its content, such as print a list or change
its Translation Status. See Also: Marking Translation Statuses on page 1078

This section also contains the following topics.
Selection Criteria
Viewing Content on the Localization Dashboard
Editing the Content's Export Languages
Changing the Content's Translation Status
Estimating the Content's Word Count
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Selection Criteria
The following list explains the fields at the top of the screen. After you enter the selection
criteria, click Filter Results to apply the new selections.
IMPORTANT: These criteria have an AND relationship. This means that, if you select several criteria,
only content that satisfies all appears in the lower section of the screen.
l

l

l

Lang/Dialect—Select the language whose content you want to view. To ignore this
field, choose NULL. Alternatively, you can select all content not in the selected
language. To do that, check the Does not Include box.
Trans Status—Select the translation status of content you want to view. To disregard
this criterion, choose (Any). See Also: Marking Translation Statuses on page 1078
Date Created—If desired, enter a range of content creation dates. If you do, only
content created within those dates appears below.
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l

Last Modified—If desired, enter a range of content modification dates. If you do, only
content edited within those dates appears below.

l

ContentID—To see a particular content item, enter its ID number.

l

Folder—If desired, select a folder whose content you want to view.

l

Author—If desired, select the person who last edited the content you want to view.

l

Title—If you know one or more words in the title of content that you want to view, enter
them. You may enter one partial word and find all content whose title includes it.

Viewing Content on the Localization Dashboard
When you open the Localization Dashboard, the lower section displays all content in the
Default Application Language.
NOTE: The pagination of the content list is controlled by the <add key="ek_PageSize"> element of
your siteroot/web.config file.
On the lower section, you can:
l
l

sort by any column in ascending or descending order by clicking on the column header
view and work with any content item by clicking it, if you have permission to do so See
Also: Managing Folder Permissions on page 257

l

print current results by clicking Print

l

export current results to a Microsoft Excel spreadsheet by clicking Create Report

l

edit the selected content's export languages

l

change the content's Translation Status

l

estimate the word count for one or more pieces of content

Editing the Content's Export Languages
As described in Creating the .zip File on page 1081, when exporting content for translation,
you select one or more target languages.
You can add, edit, or remove target languages for content in the lower section of the
Localization Dashboard using Action menu options.

The actions associated with the menu options are performed the next time the Create XLIFF
Files for Translation button is clicked:
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l

Set Locales—View and modify locales into which selected content will be exported.

l

Add Locales—Add locales into which selected content will be exported.
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l

Remove Locales—Remove locales into which selected content will be exported.

To change the target language assigned to content in the lower section of the Localization
Dashboard:
1. Check the box next to each content item that you want to modify. To check all items,
check the box in the header row.
2. Click Action > menu option. For example, Action > Set Locales.
3. Select desired locales and click Save.

Changing the Content's Translation Status
To learn about Translation Status, see Marking Translation Statuses on page 1078.
1. Check the box next to each content item that you want to modify. To check all items,
enable the check box in the header row.
2. Click Action > Set Translation Status.
3. Select the appropriate Translation Status and click Save.

Estimating the Content's Word Count
1. Enable the checkbox associated with one or more pieces of content.
2. Choose Action > Estimate Word Count. The Estimated Word Count screen appears.
3. Click Save. The screen is dismissed. (Note that the word count is not saved.)

Configuring Character Encoding
The following Ektron Knowledge Base articles describe issues surrounding the display of
special characters within Ektron eWebEditPro, Ektron’s deprecated WYSIWYG editor
embedded within Ektron.
Wherever these articles contain references to eWebEditPro’s configuration data or file
(config.xml), you should instead update the web.config file, located in your site’s root
folder.
l

Produce UTF-8

l

Character Encoding

l

Encoding special characters

Ektron 8.7
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NOTE: Only members of the Administrators User Group and those defined in the Manage Members for
Role: User Admin screen can view, add, or edit users and user groups.
Users are people who administer the website, create content, or publish content. Without
users, the website would be blank. In Ektron, you can add, edit, and delete users to and from
the application through the Settings folder in the Workarea.
Every Ektron user belongs to a User Group. When you create a user, the user is added to the
Everyone group by default. User groups are used when creating permissions and an approval
chain for content folders. User groups can be departments in your company (Human
Resources, Sales, Engineering) or indicate a user’s role (Publishers, Administrators, Editors,
and so on).
All user and user group information is accessible from the Workarea.
To access the user folder in Ektron, navigate to Workarea > Settings > Users. The View
Users screen appears. From this screen, you can add, edit, and delete users.
To access the user group folder in Ektron, navigate to Workarea > Settings > User
Groups. The View User Groups screen appears. From this screen, you can add, edit, and
delete user groups.
IMPORTANT: This chapter only applies to systems that do not use Active Directory Integration. If your
system uses the Active Directory Integration Feature, see Using Active Directory with Ektron on
page 1127 to learn about user management functions. If your system uses LDAP Authentication, see
Using LDAP with Ektron on page 1151.
This section also contains the following topics.
Managing Users
Managing User Groups
Creating Custom User Properties
Defining Roles
Using Active Directory with Ektron
Setting Up Active Directory
Implementing Active Directory
Using LDAP with Ektron
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1106
1108
1120
1127
1127
1129
1151

Managing Users
Creating a New User
Before you can assign a user to a user group, you must add the user to the system.
1. Go to Workarea > Settings > Users.
2. Click Add User. The Add a New User to the System screen appears.
NOTE: To learn about the lock and unlock buttons (

), see Account Locked (below). The

buttons provide a shortcut to that field for users with a check in the box to the left of their name.
3. Enter the following information about the user. An asterisk next to a field name indicates
that the field is required and cannot be blank.
—Editable by a non-administrator user. Non-admin users can edit their own profiles
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only, and only fields indicated.
General Tab (tabs only appear when editing)
l
l

Username—Insert a username for the user you want to create.
Path—This field is only available when using LDAP Authentication. See Also: Adding
User Information from an LDAP Server to Ektron on page 1154.

l

First Name—Enter the first name of the user.

l

Last Name—Enter the last name of the user.

l

Display Name—Enter the name that is used to identify a user in the Workarea
and on the website. This can be different from the Username, which is the name
used to log in.
NOTE: The Display Name cannot be blank.

l

l

l

Password—Enter a password for the user. See Also: Getting Started with
Ektron on page 5.
Confirm Password—Confirm the password by typing it again.
User Language—Select the language in which the user will view Ektron
screens and messages. The language also determines the default value whenever a
drop-down list of languages appears within Ektron.
The drop-down list is derived from the Language Settings screen, available from
the Settings > Configuration folder.
Do not confuse the system language with the user’s ability to create and edit
foreign editions of content. This field does not prevent a user from working with
multiple language content.
See Also: Working with Multi-Language Content on page 1057
NOTE: If the selected language is not English, French or German, it is only supported after
you download the Ektron Language Support Program from Ektron and translate the website.

l

l

l

Email Address—Enter the email address of the user. Notification email is sent
to this address unless the Disable E-mail Notification field is checked. Also, this
address identifies the user sending Instant email. See Also: Installing Ektron on
page 9
Account Locked—Check this box to lock or unlock this user. Locked users
cannot log in. For information on events that automatically lock a user out, see
Getting Started with Ektron on page 5. You can manually lock or unlock users via
the lock buttons (
) on the View Users in Groups screen.
Content and Forum Editor—Uses the default editor.
NOTE: If an editor is defined in the siteroot/web.config file's ek_EditControlWin or
ek_EditControlMac tag, this field is disabled.

Ektron 8.7

1101

Managing Users and User Groups

l

Avatar—An image or icon to represent you in the Forum.

Insert a Web path to the image. For example:
http://www.example.com/smileyface.gif. Alternatively, you can click Upload
to browse to a file on your network.
By default, an avatar's maximum size is 200 kilobytes, and its height and width are
reduced 125 pixels, preserving the aspect ratio. To change the file size limit, edit
Siteroot\Workarea\Upload.aspx.vb. In this file, change the line shown below to the
maximum file size.
If (numFileSize > 200) Then

To change the avatar's default height and width, edit Siteroot\App_
Code\VBCode\Utilities.vb. In this file, change the following lines to the desired
size.
Dim Width As Integer = 125
Dim Height As Integer = 125
l

l

l

Disable Receiving of Workflow and Task Email—Select to disable the
workflow and task email notifications for the user. If you do, the user does not
receive the automatic email notification described in Installing Ektron on page 9.
However, this field has no effect on the user’s ability to receive instant email.
Address—Enter the address used to find this user’s location when a search based
on location is being performed. You can enter either a full address or a postal code.
Latitude, Longitude—The Google GeoCoder strategy uses the information from
the Address field to determine the user's latitude and longitude. These values are
used to identify a user’s location when someone performs a search based on
location.

Custom Properties Tab
l

l

Features—Create User Calendar—See Working with Calendars on page 514
Additional custom user properties—See Creating Custom User Properties
on page 1108

If email notification is turned off in the setup page, you are notified when editing,
adding, or viewing a user.
4. Click Save. The View Users in Group Everyone screen appears with the new user
included in the table. When you add a new user, he is automatically placed in the
Everyone user group. To assign users to other groups, see Assigning Users to User
Groups on page 1106.
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5. Continue this process until you add all website users, or reach the maximum allowed by
your license.
NOTE: Contact Ektron Sales for pricing of adding more users to your license.

Viewing a User
After adding a user, you can view that information. While viewing a user, you can edit or
delete the user.
1. Access the user folder as described in Managing Users and User Groups on page 1099.
2. Click the Username of the user you want to view. The View User Information screen
appears. To learn about the fields, see Creating a New User on page 1100.

Editing a User
NOTE: If you are using Active Directory to edit a user, see Adding and Maintaining User Information on
page 1143.
When editing a user, you can change the fields set when adding the user, such as username,
first name, last name, password, user language, and email address. Also, while editing, you
can change fields that were not available when the user was created.
1. Access the view user screen of the user you want to edit, as described in Viewing a User
above.
2. Click the Username of the user you want to edit. The View User Information screen
appears.
3. Click Edit. The Edit User screen appears.
—Editable by a non-administrator user. Non-admin users can edit their own profiles
only, and only fields indicated.
General Tab
l

l

l

l

ID—A unique identifier assigned to a user by the system. This field is not editable.
Account Locked—Check this box to lock or unlock this user. Locked users
cannot log in. For information on events that automatically lock a user out, see
Getting Started with Ektron on page 5.
Forum Signature—Adds a signature to your posts in the forum. You do not see
the signature in the editor. It is added after you click the Post button.

Tags—Select from a predefined list of Tags that describe yourself. Or, create a
new tag by clicking Add Tag. Placing a check mark in the check box next to a tag
activates it for your profile. See Also: Tagging Content, Library Items, Users, and
Groups with Keywords on page 1245.
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l

User Groups Tab (Tab only appears when viewing properties) -Lists user groups
to which the user belongs. See Also: Assigning Users to User Groups on page 1106.

Workarea Tab
l

l

l

l

l

l

Full Screen—When a check mark appears in this check box, the Workarea opens
up to the size of the full screen. In addition, the Width and Height options are
hidden. See Getting Started with Ektron on page 5.
Width—If desired, change the width of the screen in which Ektron appears for
this user. The width in pixels must be between 400 and 2400. This field
accommodates users who have larger monitors and/or prefer a smaller resolution,
such as 1280 x 1024. If a check mark appears in the Full Screen check box, this
option is hidden.
Height—If desired, you can change the height of the screen in which Ektron
appears for this user. The height in pixels must be between 300 and 1800. This field
accommodates users who have larger monitors and/or prefer a smaller resolution,
such as 1280 x 1024. If a check mark appears in the Full Screen check box, this
option is hidden.
Landing Page after login—See Getting Started with Ektron on page 5.
Set smart desktop as the start location in the Workarea—If you want the
Smart Desktop to appear as soon as this user enters the Workarea, click this check
box. See Also: Personalizing the Smart Desktop on page 278. If you leave this
check box blank, when this user enters the Workarea, he goes to the folder of the
content specified at the Landing Page after login field.
Restore Default Preferences—Restore the default Workarea settings
specified by the Administrator

Custom Tab (same as when adding a user)
Activities Tab
If you disable Notifications, the Activities tab (which lets the user pick Notifications to
receive and send) disappears.
l

l

Colleagues Sub—Select notifications you want to receive when a colleague
performs an activity, and the agent that transmits the notification. For example, if
you want to receive email notifications when a colleague posts a blog message,
check inside the box for Blog Post in the email column. See Also: Sending
Notifications to a Community on page 1194
Community Groups Sub—This tab sets preferences for all community groups.
Select notifications you want to receive when a community group member performs
an activity relating to the group, and the agent that transmits the notification. For
example, you want to receive email notifications when a community group member
posts to group’s blog. To enable this, check inside the Group Blog Post box in the
email column. See Also: Sending Notifications to a Community on page 1194
For Developers:Ektron has created a UserGroupPreferences user control. If you
add the control to a community group’s profile page, users can specify notification
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preferences for individual groups. This control is installed with Ektron and is located
in:
[Drive:]\webroot\siteroot\Workarea\Notifications\Controls
l

l

l

My Activities Sub—Select notifications you want publish when performing
various activities on the website. For example, if you want to publish notifications
when you post to your blog, check the box for Blog Post in the Publish column.
See Also: Sending Notifications to a Community on page 1194.
Profile Links—Displays the user's alias if community aliasing is set for users. See
Also: Creating User-Friendly URLs with Aliasing on page 835
Roles—This tab shows the roles assigned to this user. See Also: Defining Roles on
page 1120

4. Make necessary changes to user information.
5. Click Update.

Deleting a User
NOTE: If you are using Active Directory to delete a user, see Maintaining AD User Information on
page 1139.
When you need to remove a user from the application, you can easily do it from the User’s
Folder in the Workarea.
1. Access the view user screen for the user you want to delete, as described in Viewing a
User on page 1103.
2. Click the Username of the user you want to delete. The View User Information screen
appears.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.
WARNING! When a user is deleted from the database, the user is permanently deleted. The process
cannot be undone.

Removing Users from User Groups
NOTE: If you are using Active Directory to remove a user from a group, see Maintaining AD User Group
Information on page 1141.
Removing a user from a user group does not delete the user from Ektron. Also, you cannot remove users
from the Everyone group.
1. Workarea > Settings > User Groups.
2. Click the name of the group that includes the user you want to remove. Members of the
group appear.
3. Click Remove to the far right of the user that you want to remove. A confirmation
message appears.
4. Click OK.
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Managing User Groups
NOTE: If you are using Active Directory to manage user groups, see Setting Up Active Directory
Integration Mode on page 1131.
Every Ektron user belongs to at least one User Group. User groups are used when creating
permissions and an approval chain for content folders.

Creating a New User Group
1. Access the User Groups folder in the administrator Workarea, as described in Managing
Users and User Groups on page 1099.
2. Click Add User Group. The Add a New User Group to the System screen appears.
3. Enter a name and brief description of the user group you want to create.
4. Click Save.

Assigning Users to User Groups
When you create a user group, no user is initially assigned to it. To add a user to a user
group:
1. Access the Workarea > Settings > User Groups.
2. Click the user group to which you want to add a user. The View Users in Group screen
appears.
3. Click Add User. Users who do not belong to the group appear.
4. Select the users to add to the group using one or more of the following methods:
l
To select specific users, check the box to the left of their name.
l
l

l

To select all users, check the box in the column header row.
Enter characters into the Search field and find only users that match them. For
example, you could enter bill, click the Search button, and see only users with
those characters in their name.
Use the drop-down menu to sort the display by User Name, Last Name or First
Name.

5. Click Save. A confirmation message appears.
6. Click OK. The selected users are now members of the selected group.
7. Continue this process until you add all users into User Groups.
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Viewing the Users in a User Group
1. Access the User Group folder in the administrator Workarea, as described in Managing
Users and User Groups on page 1099.
2. Click the user group whose members you want to view. The View Users in Group screen
appears with a list of users who are members of the group. From this screen, you can
edit or delete user groups, as well as add and remove users to and from the user group.

Editing a User Group
When editing a User Group, you can only change its name.
NOTE: You cannot edit the default Administrators and Everyone user groups.
1. Access the View Users in Group screen for the user group you want to edit, as described
in Viewing the Users in a User Group above.
2. Click the User Group you want to edit. The View Users In Group screen appears.
3. Click Edit (

). The Edit User Group screen appears.

4. Edit the group name as required.
5. Click Update.

Deleting a User Group
When you do not need a User Group anymore, you can delete it from the system.
NOTE: You cannot delete the Administrator and Everyone groups.
1. Access the View Users in Group screen for the user group you want to delete, as
described in Viewing the Users in a User Group above.
2. Click the User Group you want to delete. The View Users In Group screen appears.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The User Group is deleted from the Ektron website.

Removing a User from a User Group
See Removing Users from User Groups on page 1105.
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Creating Custom User Properties
PREREQUISITE
Only members of the Administrators Group can work with Custom User Properties.
Custom User Properties let you create custom fields that collect user information beyond the
standard Ektron properties. Examples include employee ID, phone number, start date,
position, department, and IP address. Custom fields appear on the User Properties and
Membership User Properties screens on the Custom tab, and on the Membership on
page 1771 server control.

Viewing Custom Properties
Use the View Custom Properties screen (Settings > Configuration > Custom
Properties) to create custom properties for users and membership users. From the View
Custom Properties screen, you can:
l

add a new custom property. See Adding a Custom User Property on page 1110.

l

edit a custom property. See Editing Custom User Properties on page 1116.

l

l

1108

reorder the way custom properties appear on the users and membership users screen.
See Setting the Order of Custom User Properties on page 1117.
work with custom properties in different languages. See Managing Users and User
Groups on page 1099.
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o

Add—Add custom user properties. See Adding a Custom User Property on the next
page.

o

Reorder—Change the order of the custom user properties on the Users or
Membership User Properties screen. See Setting the Order of Custom User
Properties on page 1117.

o

Language Selection drop-down list —lets you view custom
user properties by language. See Viewing Custom User Properties By Language
below.

o

Object Type drop-down list—lets you choose users or
taxonomies whose custom user properties you want to manage. See Adding a
Custom User Property on the next page and Assigning Custom Properties to a
Taxonomy on page 808.

o

Title field—Displays the title of a custom user property. When viewing by
language, the title changes to the title used in a specific language if it has been
defined. Click a Title to edit the property. See Editing Custom User Properties on
page 1116. Title and label are the same field. On some screens, Title is used; on
others Label is used.

o

ID—A unique property identifier assigned by the system. This field is not editable.

o

Type field—Shows the Type that was chosen for a custom user property.

Viewing Custom User Properties By Language
From the View Custom User Properties screen, you can view the custom users properties by
languages.
NOTE: If there is only an English version of the property, the English version appears in all the languages.
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All custom user properties, in languages other than English, are tied to the English version of
the property. If you delete the English version of the property, all other language versions of
the properties are deleted.
To view the custom user properties by language:
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the Object Type pulldown, select User.
3. Choose the language in which to view the properties from the language drop-down box.
The View User Custom Languages screen for that language appears.

4. In the following example, some properties have not been translated, so the English
versions appear instead.

Adding a Custom User Property
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the Object Type pulldown, select User.
3. Choose the standard language used in your Workarea.
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4. Click Add. The Add User Custom Property screen appears.

o

Label—Title of the property you are adding. For example, Employee ID.
NOTE: The Title and Label are the same field. On some screens the word Title is used, on
others the word Label is used.

o

Type—The property’s data type. When a type is selected and saved, you cannot
change it. You must delete the custom property and re-enter it.
l
String—Accepts all alpha, numeric, and symbol characters. Text Box, Text
Area, and Hidden input types are available. All validations are available. See
Also: ”Validation” on page 15-23
l

l

l

l

Boolean—Accepts a true or false response. Check Box and None input types
are available.
Numeric—Accepts numbers only. The following input types are available.
o Text Box
o

No Validation

o

Cannot be blank

o

Numeric Only

o

U.S. Zip Code

o

Dollar Amount

Date—Only a date can be entered. The following input types are available.
o Text Box
o

No Validation

o

Cannot be blank

o

Date Only

SelectList—Select a response from a list of choices.
Use a SelectList field to present the user completing the User Information or
Membership User Properties screen with a list of choices.
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When you create a custom user property and specify its type to be Select
List, the screen changes, allowing you to add, change, or remove list entries.

Completing a SelectList Field Entry
To add an item to the list, enter its text in the Text field, then click Add .
Added items then appear in the larger box on the left. You can then:
l

l

l

remove any item from the list by clicking it. It appears in the Text field.
Click Remove.
change the text of any list item by clicking it. It appears in the Text field.
Make changes then click Change.
change the sequence of list items by selecting an item then clicking the up
or down arrow to move the item

Using the First List Item to Prompt a Response
You can use the first list item to prompt the user to make a selection instead of
being a valid response. For example, the first list item may say Select from
a list of choices. To do this, check the First item is not a valid selection
for example, “[Select]” check box.
If this option is selected, the field has an asterisk (*) next to it (indicating it is
required) on the User Information and Membership User Properties screens.
The user completing the screen must choose any selection other than the first
item. If he tries to file the screen without choosing a different item, the
following error message appears: Please fill in all required fields (*)
l

Multi SelectList—Select any number of responses from a list of choices.
Use a MultiSelectList field to present the user completing the User
Information or Membership User Properties screen with a list of choices. The
user can choose as many responses as appropriate.
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Selected items are indicated by a blue background.
When you create a custom user property and specify its type to be
MultiSelect List, the screen changes.

For information about completing the screen, see Completing a SelectList Field
Entry on the previous page.
l

o

Category—A system-defined type that appears when the first subscription is
created. One entry covers all subscriptions. See Also: Defining Subscriptions
on page 1578.

Input Type—Choose how a user is able to enter a response to the property.
l
Text Box—Creates a standard text box. Use this with a String, Numeric, or
Date. For example:

l

l

l

Text Area—Creates a multi-lined area for entering text (String). Typically
used when more than one line of text needs to be added. For example:

Hidden—Hides the input field (String). This can be used by an administrator to
add additional values at postback time. This requires a developer to add clientside JavaScript. If you change a String field’s Input Type from Text Box or
Text Area to Hidden, then sign in as a member of the Administrators group,
the field and its value still appear on the user’s profile.
Check Box—Creates a boolean checkbox. Used when the field requires a
boolean (true / false) response. For example:
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o

Validation—Ensures the right type of data is entered in a text box or text area.

Validation

No Validation

Cannot be
blank

Numeric Only

Description

The entry is not checked.

A response must be entered.

The response must be a number.

Text Only

The response must be characters (any combination of
alpha, numeric, and symbol ).

Date Only

The response must be entered in the following format:
mm/dd/yyyy.

l

String

l

Numeric

l

Date

l

String

l

Numeric

l

Date

l

String

l

Numeric

l

String

l

String

l

Date

Email Only

The response must be entered as an Email address.
For example,
username@domain.domainextention.

l

String

Credit Card
Only

The response must be entered as a credit card
number. For example, nnnn nnnn nnnn nnnn

l

String

Social Security
Only

The response must consist of 9 digits in this
pattern:nnn-nn-nnnn.

l

String

U.S. State
Code

A 2-letter state code. For example: NH = New
Hampshire.

l

String.

l

String

l

Numeric

l

String

The response must consist of 5 (nnnnn) or 9 digits
separated by a dash after the fifth (nnnnn-nnnn).
U.S. Zip Code
NOTE: If you use the Numeric Type, you cannot
have a dash or space when using a 9 digit Zip Code
Valid US
Phone Number
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The response must consist of a 10 digits in this
pattern: nnn-nnn-nnnn.

Features Field

Validation

Description

Canadian
Postal Code

The response must consist of 6 (xnx nxn) alpha or
numeric characters with a space after the first 3
characters.

An Option
When Used
With

l

String

l

String

l

String

l

String

l

Numeric

l

String

Time is entered in one of the following 3 formats.
Time HH:MM
or HH:MM:SS
or
HH:MM:SS.mm

l
l

l

IP Address

HH:MM—Hours and Minutes 09:30
HH:MM:SS—Hours, Minutes and Seconds
09:30:45
HH:MM:SS.mm—Hours, Minutes, Seconds and
milliseconds 09:30:45.002

The response must be in the form of an IP address.
This validation works differently depending on the
Type used. If used with the String Type, you can have
a dollar sign ($) along with the money amount in the
text field.

Dollar Amount

Canadian
Social
Insurance
Number

When used with the Numeric Type, you are not
allowed to have a dollar sign ($) in the text field. The
following are examples of each type with validation:
l

String—$3.00

l

Numeric—3.00

The response must consist of 9 digits in this pattern
(nnn nnn nnn).

o

Min Value—If desired, enter the minimum value you want to allow. The Min Value
only appears when the following Validation methods are used: Numeric Only, Date
Only and U.S. Zip Code. The following is an example of a Date Only Min Value:
01/01/1900.

o

Max Value—If desired, enter the maximum value you want to allow. The Max
Value only appears when the following Validation methods are used: Numeric Only,
Date Only and U.S. Zip Code. The following is an example of a Date Only Max
Value: 01/01/1987.

o

Message—A message that appears when information entered in a user property
violates the validation criteria. For example, if the validation is U.S. Zip Code, you
might use the following message: Please enter a valid zip code

Features Field
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This field is automatically included on the User or Member profile Custom Tab to let the
profile owner edit events on a Web calendar. When this is checked, it cannot be
unchecked. For more information about Web Calendar, see Adding System Calendar
Events on page 517.

Private Profile Field
This field is automatically included on the User or Member profile Custom tab. It lets the
profile owner determine which other users can see the owner's community activities. For
example, Using the ActivityStream Widget on a PageBuilder Page on page 1236 explains
how this setting affects other users' ability to see your activities.
The Private Profile field value also determines if a user's profile is visible on a forum.
See Also: Using Discussion Boards on Your Website on page 568
When a Micro-message server control is placed on a page in TimeLine mode, micromessages only appear for users whose Private Profile setting is set to Public. See
Also: Server Control Reference on page 1636

Time Zone Field
The Time Zone property field is a special field used by the Web Calendar feature.

Select the time zone of the User or Member here. When they are logged in, appointment
times will show in this time zone. For more information, See Also: Adding System
Calendar Events on page 517.
5. Click Save. The new property appears on the View Custom User Properties screen.

Editing Custom User Properties
Click a custom user property’s title to display the Edit Custom Property Screen. From this
screen, you can edit and delete a custom property or create a version of the custom property
in a non-English language. When you edit a custom user property, the changes are applied to
all users and membership users when the Save button is clicked. These changes are also
applied to any other language versions of the custom user properties that exist.
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the Object Type pulldown, select User.
3. Click the Title of the Custom User Property you want to edit.
4. Choose the field you want to change. You can edit the following fields:
l
Label
l

Input Type

l

Validation

l

Min Value

l

Max Value

l

Message

5. Click Save.
6. When you click a user or membership user, you see your changes. For descriptions of
these fields, see Creating Custom User Properties on page 1108.
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NOTE: You cannot edit the Type field. If you need to change the type, you must delete the custom user
property and create a new one.
WARNING! If you delete a custom user property, it is removed from all users and membership users.
Any information that has been collected about users and membership users for that property will be lost.
In addition, any language versions of the custom user property are deleted.

Deleting a Custom User Property
If you delete a custom user property, it is removed from all users and membership users.
Any information that has been collected about users and membership users for that property
will be lost. In addition, any language versions of the custom user property are deleted.
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the Object Type pulldown, select User.
3. Click the Title of the custom user property you want to delete.
4. Click Delete ( ).
5. A dialog box appears asking if you are sure you would like to delete the item.
6. Click OK. The View Custom User Properties screen appears, and the property is no
longer available.

Setting the Order of Custom User Properties
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the Object Type pulldown, select User.
3. Click Reorder ( ). The Reorder User Custom Properties screen appears.

4. Click a property.
5. Click the Up or Down arrows to move the property up or down the list.
6. Click Save.
7. On the View Custom User Properties screen, you now see the properties in the new
order. If you go to the User or Membership User Properties screen, the order of the
properties there reflects the changes.
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Creating a Non-English Custom User Property
Like content, custom user properties have a language attribute. This is useful if you have
users or membership users that only use a specific language. It can also be used if you want a
custom user property to appear in the language in which the user is signed in.
Unless a language other than English is defined for a custom user property, the property
defaults to the English version. For example, if you have 2 properties called Birthday and

1118

Ektron Reference

Removing a Non-English Custom User Property

Phone Number in English and you can translate the French version of Birthday to
Anniversaire, when you view the properties in French, you see the English version of Phone
Number and the French version of Birthday.
When creating a custom user property, it must be created in English then translated to the
desired language. This is done by editing the property, changing languages, filling out the
Translate Custom Property Label screen and saving the property.
WARNING! All custom user properties in languages other than English are tied to the English version of
the property. If you delete the English version of the property, all other language versions of the properties
are deleted also. However, you can remove a non-English language version of the custom properties
without deleting the English version. See Removing a Non-English Custom User Property Title below
To translate the Title/Label of a property into French.
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the Object Type pulldown, select User.
3. Choose a custom property to be defined in another language.
4. Choose a language from the language select drop-down box. The Translate Custom
Property Label screen appears.

5. Enter a Label for the property in the language you have chosen. For example, if you are
creating a French version of a Birthday custom user property, you would enter
Anniversaire in the label text field. For information on the Label property, see Adding a
Custom User Property on page 1110
6. Click Save.

Removing a Non-English Custom User Property Title
Removing a non-English version of a custom user property title does not remove the English
version of the property. When you remove the non-English version of a property, you are
basically removing the label for that specific language in the custom property.
1. In the Workarea, click Settings > Configuration > Custom Properties.
2. From the Object Type pulldown, select User.
3. Choose the language in which the custom user property appears from the Language
drop-down box.
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4. Click the Title you want to delete. The Translate User Custom Property Label screen
appears.

5. Click Delete ( ). A dialog box appears asking if you would like to remove the translated
custom property title.
6. Click OK. The English version of the Edit Custom Property screen appears.
7. Click Back (

).

WARNING! Do not click the delete button on the Edit Custom Property screen. This action deletes the
English version of the custom user property. If you click the delete button, you lose all information
collected by the property and all language versions of the property.

Defining Roles
Ektron contains an Administrators User Group. Any user who is a member of that group
automatically has full administrator privileges. The Roles feature lets you assign limited or
specific administrator privileges to users who do not require full administrator privileges. For
example, you can let certain users create, redirect, or remove tasks but deny them other
privileges normally granted to administrators.
The Permissions Table lets you control which users can manage a folder’s properties, its
content, library items, and create or edit collections. (See Also: Managing Folder Permissions
on page 257) Together, the Roles feature and the Permission Table enable you to assign
administrative privileges to users who are not members of the Administrators group.
BEST PRACTICE
When creating new user groups to use with roles, assign names as a mnemonic aid for
the role, especially for folder-specific rules. For example, the Marketing Folder
Admins user group could be used for all role members who administer the marketing
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folder.

Using the Roles Screens
Use the Roles screens to assign limited administrator privileges. To access the Roles screens,
go to Workarea > Settings > Roles > Built-In > Folder Specific or System-Wide.
NOTE: In the Roles screens, you can select users or groups. However, you cannot select the
Administrators group, because that group already has full permissions.
To view all roles assigned to any user, go to Workarea > Settings > Users. Then, select a
user and click the Roles tab.

Folder Specific Roles
When setting up users and groups for administrative access over folders, keep these
guidelines in mind.
l

l

l

After being identified on the Manage Members for Role: Folder User Admin screen, users
or groups must also be given at least Read-Only permission for individual folders on the
Folder Properties > View Permissions for the Folder screen. See Also: Managing
Folder Permissions on page 257
You must use the same identity on the Manage Members for Role: Folder User Admin
and Folder properties screens. If a user group is listed for the role, use the same group
when assigning folder permissions, not simply a group member. Conversely, if
individual users are listed on the role screen, they must be specified in the folder
permission.
Ektron strongly recommends adding only user groups to the Folder User Admin role, not
individual users. If you set up an individual user as a role member, he could accidentally
receive administrative rights to other folders.

Folder-User Admin
View and edit folder properties. These users can update properties, permissions, the approval
chain, metadata, Web alerts, purge history, and so on. For example, create a user group and
give it permission to manage the top-level marketing folder. Group members can do
everything to that folder and its subfolders, but cannot manage other folders.See Also:
Creating a Custom Permissions Role on page 1125 and Setting Folder Properties on page 253.

Move or Copy
Move or copy content. An Ektron best practice is to create a User Group for this purpose, then
assign the group to this role. You should not assign the role to individual users. After
assigning the User Group here, go to the folders whose content these users will be allowed to
move or copy, and assign to that User Group at least Read Only and Traverse permissions.
See Also: Managing Folder Permissions on page 257 and Moving or Copying Content on
page 290.

System-Wide Roles
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Alias-Admin
Perform all URL Aliasing functions. See Creating User-Friendly URLs with Aliasing on page 835

Alias-Author
Perform all functions related to URL Aliasing except viewing and editing the URL Aliasing
Setting screen and Editing aliasing rules.

Analytics Viewer
Can view:
o

Web Traffic Analytics reports

o

Analytics button on the View Content Screen

o

Analytics from the website's Access point menu ( )

o

Analytics from a PageBuilder page

See Viewing Analytics Data on page 622

Business Rule Editor
Create or edit business rules and rule sets. See Creating Business Rules for Your Website on
page 1049.

Collection and Menu Admin
Create, edit and delete collections and menus via the Content tab.
NOTE: To manage permissions for creating collections and menus via the folder’s New > Collection or
New> Menu option, use folder permissions. See Also: Managing Folder Permissions on page 257
See Working with Collections on page 355 and Permission to Use Menus on page 755.

Collection Admin
Create, edit and delete collections via the Content tab.
NOTE: To manage permissions for creating collections via the folder’s New > Collection option, use
folder permissions. See Also: Managing Folder Permissions on page 257
See Working with Collections on page 355.

Collection Approver
If approval is required for a collection, approve changes to it, including the deletion of a
collection. See Setting Up Collection Approval on page 366.

Commerce Admin
Use the eCommerce feature from the Workarea. See Conducting eCommerce on page 1279.

Community Admin
Perform the following community activities:
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l
l

l

Set system default preferences
View and create new
o Activity Types
o

Agents

o

Messages

Enable or Disable Notifications

See Sending Notifications to a Community on page 1194 and Micro-messaging on page 1801.

Community Group Admin
Create, edit and delete and manage all community groups. These users have the same
privileges as the group Administrator and members of the Administrators group. See
Managing Community Groups on page 1181.

Community Group Create
Create and manage community groups. A user with this role can only manage community
groups she or he has created. See Managing Community Groups on page 1181.

DxH Connection Admin
Create and manage DxH connections via the Workarea > Settings > Digital Experience
Hub > Connect to DxH screen.

DxH Connection User
Import and update DxH content into Ektron folders.

MasterLayout-Create
Create and edit PageBuilder Master Layouts. See Creating a PageBuilder Master Layout on
page 680.

Menu Admin
Create, edit and delete Menus via the Content tab.
NOTE: To manage permissions for creating menus via the folder’s New> Menu option, use folder
permissions. See Also: Managing Folder Permissions on page 257
See Permission to Use Menus on page 755

Member Admin
Manage membership users and membership user groups. Member admin role members
cannot work with Ektron users. Users assigned to this role can create, edit, and delete
membership users and groups through the following screen.
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See Also: Membership Users and Groups on page 1161; Membership Groups on page 1165

Message Board Admin
Approve pending comments or delete existing comments on a message board. See Who Can
Moderate Message Board? on page 1177

Metadata-Admin
View, create and edit metadata definitions. See Working with Metadata on page 369.

Multivariate Tester
Perform multivariate testing. Optimizing Page Layout with Multivariate Testing on page 695.

Search-Admin
Create and edit Synonym Sets, Suggested Results, Integrated Search Mappings, and the
Search Status screen. See Providing Suggested Results on page 952, Using Synonym Sets on
page 945, Including External Files in Your Search on page 946.

Smart Forms Admin
Create and edit Smart Forms. See Working with Smart Forms on page 423.

Synchronization Admin
Access the Workarea > Settings > Configuration > Synchronization screen, which lets
the user perform all synchronization activities, such as:
o

manage sync configurations and profiles

o

run a sync

o

perform content and folder-level sync

See Synchronizing Servers Using eSync on page 1473.

Synchronization User
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Sync content and folders

o

View Sync logs
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Task Create

o

Run a sync

o

Sync content and folders

See Synchronizing Servers Using eSync.

Task Create
Create tasks. See Assigning and Managing Tasks on page 1027.

Task Delete
Delete tasks. See Assigning and Managing Tasks on page 1027.

Task Redirect
Redirect tasks. See Assigning and Managing Tasks on page 1027.

Taxonomy Administrator
Create and manage taxonomies. See Using Taxonomies on page 777.

Template Configuration
View, create, update, and delete system templates. See Working with Templates on
page 382.

Translation State Admin
Change the translation status of content. See Marking Translation Statuses on page 1078.

User-Admin
Create, view, edit, and delete users and user groups. See Managing Users and User Groups
on page 1099.

XLIFF-Admin
Use the Language Xport feature, which copies content into XLIFF files that can be submitted
to a translation agency. Can change the translation status of content. See Exporting Content
to XLIFF on page 1072 and Marking Translation Statuses on page 1078.

Widget Synchronizer
Update widgets and edit their title, label, and parameters.

Creating a Custom Permissions Role
The custom permissions role lets your Web developer create a site page, and then extend or
restrict access to that page’s content (or areas with a page) to users assigned to a custom
role.
Items you could show and hide could be as simple as a content block. But they could be more
complicated, such as displaying buttons and fields for one user group, and something
completely different for another.
Custom roles have no effect inside the workarea.

Examples of Custom Roles
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l

l

l

l

Most of your site visitors belong to different political parties, while some are not
registered with any party. By checking the user’s ID against custom roles, you could
present registered voters with selections for their party’s primary, and prevent
unregistered voters from participating.
Your Ektron site visitors fall into 2 categories: suppliers and buyers. You could check the
current user against a custom role and show buyers one set of data and suppliers a
different set.
On your eCommerce site, registered students see a list of coupons that are not displayed
for anyone else. Or, only registered adults can order age-controlled items, such as
tobacco or alcohol.
Control your pages’ background colors, images, and skins based on custom roles. For
example, mothers get family-oriented background images while teenagers get rock
images and related styling.

Setting up a Custom Role
1. Set up user groups and add to them users who will have some level of access to the
custom page. See Also: Creating a New User Group on page 1106
2. To continue the above example, create one group of auditors (who will have read-only
access), and another group of administrators (who will have edit access).
3. Create a folder to hold the content that will appear on the custom page. Use the folder’s
permission table to assign users and groups appropriate access to the folder’s content.
See Also: Managing Folder Permissions on page 257
4. Go to Workarea > Settings > Roles > Custom Permissions.
5. Click Add Custom Roles. The Manage Custom Roles screen appears.
6. Enter a name for the custom role.
7. Click Save. The Manage Custom Roles screen appears, displaying the new custom role.
8. Click the name of the role you created. The Manage Members for Role screen appears.
9. From the Show drop-down menu, select the type of users you want to add to the role.
10. Click AddRole Member.
11. Check the box next to the users or groups that you want to add to the role.
12. Click Save. The Manage Members for Role screen appears.
13. Your Web developer creates the custom page.
14. You create content to appear on the custom page. Place the content in the folder you
created in Step 2.

Information about Custom Roles for your Developer
The API provides 2 methods that determine if the current user is logged in, and if he is a
member of the Administrators group. The methods let you test customizable roles with
conditions outside the standard Is-Logged-In / Is-Admin tests. API methods are listed below.
GetRolePermissionSystem(RoleName As String, nUserId As Long) is a Boolean value
indicating if the user belongs to the system-wide custom role.
GetRolePermissionFolder(RoleName As String, nFolderId As Long, nUserId As
Long)is a Boolean value indicating if the user belongs to the custom role for the given folder.

Administrator Role Privileges
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Administrator privileges include access to the screens that appear when you select Settings
> Configuration.
Administrators can also
l

l

edit folder properties (including Web alerts, metadata, permissions, and the approval
chain)
manage aliasing features, such as turn aliasing on or off, activate and deactivate manual
aliases, and create automatic aliases

l

manually alias content

l

add, edit, or delete a calendar

l

add, edit, or delete a business rule

l

create, view, edit, and delete metadata definitions

l

create, view, edit, and delete taxonomies

l

create, redirect, and delete tasks

l

require a collection to go through an approval process

l

export content for translation to another language using XLIFF

l

run an eSync

l

access the eCommerce Module

Using Active Directory with Ektron
Active Directory lets you retrieve user and user group information from the Microsoft
Windows Active Directory (AD) into Ektron. As a result, you can administer user information
from 1 place, and users need to remember only 1 username/password combination to sign on
to the network and Ektron.
l
l

To learn more about Active Directory, see Access & Information Protection.
To learn how to sign on using NTLM (NT Lan Manager), see HOW TO: Enabling NTLM
Authentication (Automatic logon).

Setting Up Active Directory
IMPORTANT: Ektron strongly recommends configuring SSL, especially if you are using Active Directory
Integration. SSL encrypts passwords that are otherwise sent as clear text to the Ektron server. See Also:
Updating web.config to Use SSL on page 67
You can set up Active Directory in the following ways:
l

l

Advanced Domains—Set up through editing the web.config file and entering
information in the Workarea. Use this method if:
o You are using a firewall.
o

The Ektron server need not be part of an Active Directory domain.

o

You are connecting to multiple Active Directory domains, even ones that do not see
each other.

Legacy—The domain connects to the AD domain within the web.config. Use this
method if you are using auto discovery and Active Directory single signon.

Setting Up Active Directory via the Advanced
Ektron 8.7
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Domains Method
1. Verify AD information because, after you enable AD integration, logon name and domain
are imported to Ektron.
2. If your Active Directory forest has multiple domains, decide if you want Ektron to
reference the listed domains or if you want to choose a specific one. (You will use this
when completing the Domain field of the Active Directory Setup Screen.)
3. Edit the web.config file to the following values:
<add key="ek_ADEnabled" value="true"/>
<add key="ek_ADAdvancedconfig" value="true"/>
<add key="ek_AUTH_Protocol" value="LDAP"/>
<identity impersonate=“false”>

NOTE: When using the Advanced Domains Method, the domains screen's credentials are used.
4. Set up your domains on the Edit Domains screen.
5. Configure the AD setup page. See Setting Up Active Directory on page 1133.
6. Assign AD groups to Ektron user groups. See Importing AD User Group Information on
page 1139.

Setting Up Active Directory via the Legacy Method
1. Make sure each AD user to be used in Ektron is defined correctly in the Active Directory.
Remember that, when you enable AD integration, logon name and domain are copied
from AD to Ektron.
2. If you have multiple domains in your Active Directory forest, decide if you want Ektron
to reference all domains or if you want to choose a specific one. (You will use this when
completing the Domain field of the Active Directory Setup Screen.)
3. Set the following elements in the web.config.
l
Set the ek_ADEnabled element to true. It should look like this:
<add key="ek_ADEnabled" value="true"/>
l

l

Make sure the ek_ADAdvancedconfig element is set to False. (This is the default
value.)
Set the ek_AUTH_Protocol element to GC. It should look like this:
<add key="ek_AUTH_Protocol" value="GC"/>

l

Declare a domain account through ek_adusername and ek_adpassword. (Before
entering the password, encrypt it using Ektron’s password encryption utility. To
access that utility, go to the Windows Start menu > All Programs > Ektron >
current release > Utilities > Encrypt Email Password.) It should look like
this:
<add key="ek_ADUsername" value="[username]@domain" />
<add key="ek_ADPassword" value="YourPasswordHere" />

l

For the authentication element, change the value of the impersonate attribute to
False. It should look like this:
<identity impersonate="false" userName="" password=""/>

4. Configure the AD setup page. See Setting Up Active Directory on page 1133.
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5. Assign AD groups to Ektron user groups. See Importing AD User Group Information on
page 1139.

Implementing Active Directory
You can implement Active Directory in 1 of 2 modes.
l

l

Active Directory Integration mode—the following information is shared between Active
Directory and Ektron:
o user logon name
o

domain

o

password

User authentication only mode—the following information is shared between Active
Directory and Ektron:
o user logon name
o

domain

o

password

o

user’s first and last name

o

email address

o

user groups

o

user’s group memberships

Implementing Active Directory Integration Mode
Active Directory Integration maintains consistent user and user group information between
AD and Ektron. First, user information is imported from AD into Ektron. When this is
complete, user group information is imported.
Ektron does not write to Active Directory; it only reads from it. This changes the way Ektron
manages user and user group information.
l

l

l

l

After you enable AD integration, many changes to user and user group information must
be made in AD. Several fields on the Edit User and User Group screens become viewonly.
When adding new users or groups, you can only select from users and groups in AD. If a
user or group does not exist in AD, create it there then import it to Ektron.
Integration requires Read Membership Group Permissions within Active Directory. See
Also: AD integration not reading user group memberships correctly
When using Integration, you must select a Administrator group. (There can only be one
admin group per Ektron CMS.) Click the search option and select Domain users or an
admin group created in AD specifically for CMS.

Ektron imports the following AD user information.
l

l

Authentication (user logon name and domain) for signing in to Ektron. The AD password
is not stored in Ektron but only refers to it during sign in.
Group name (AD attribute cn), which corresponds to the Ektron domain and user group
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name.
l

User information
Field in AD

AD Attribute

Corresponding Field in Ektron

User logon name (pre-Windows 2000)

sAMAccountName

Domain and Username

Last Name

sn

Lastname

First Name

givenName

Firstname

Email

mail

email Address

NOTE: Users and user groups can share a name in different domains, for example, juser@example.com
and juser@example.net. Otherwise, user names must be unique.
The following diagram illustrates the Active Directory feature's components.
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Setting Up Active Directory Integration Mode
The Active Directory feature uses multiple Ektron screens to edit domains, set up Active
Directory, display AD status, and view and search for users and user groups.

Adding Domains to AD
Ektron 8.7
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Use the Edit Domains screen to identify each network domain you will use with Ektron's
Active Directory Integration. The screen lets you add new domains, modify existing ones, or
delete obsolete ones. Use this screen to define domains, as opposed to using auto discovery
to find them.
Domains are used during signon. In addition to username and password, users must select a
domain. Domains are also referenced when defining the users and user groups that map to
the Ektron users and groups.
PREREQUISITES
l

l

l

Edit web.config as explained in Setting Up Active Directory via the Advanced
Domains Method on page 1127.
You need your NetBIOS and setting, if it is different from your domain name.
Contact your server administrator for this information.
You need your domain’s DNS. Contact your server administrator for this
information.

To add a new domain:
1. Navigate to Workarea > Settings > Configuration > Active Directory >
Domains.
2. Click Edit. The Add New Domain and Remove Last Domain options appear.
3. Click Add New Domain. The Edit Domains screen appears.

Domain DNS—Enter the domain’s DNS. Contact your server administrator for this
information. For example, corp.example.com.
NetBIOS—If your NetBios is the same as your domain name, leave the box checked.
Otherwise, uncheck the box and enter your NetBIOS setting in this field. Contact your
server administrator for this information.
Username—Enter the name of the user with permission to sign on to the domain server.
The name is in the format username@domainDNS. For example,
jsmith@corp.example.com.
Password—Enter the password of the user in the Password field.
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Domain Controller IP—Enter the IP address or DNS name of your domain controller.
If using Active Directory with LDAP across a firewall, the IP address should be that of the
firewall. On the firewall, traffic on port 389 (LDAP) should be allowed. Active Directory
with GC uses different ports.

Setting Up Active Directory
The Active Directory Setup screen lets you enable or disable AD and manage other AD
settings, such as whether users and groups are automatically updated.
To enable AD and manage settings:
1. Go to Settings >Configuration > Active Directory > Setup. The Active Directory
Setup screen appears.
2. Click Edit.
3. Enable options or enter information in fields as required.
Active Directory Installed
l

l

l

Disable Active Directory and LDAP Authentication—Disables the use of
Active Directory and LDAP Authentication. See Disabling AD Integration on
page 1141.
Enable LDAP Authentication—If enabled, you must complete the LDAP-related
fields (Type, LDAP Server, Port, Organization, Domain, Attribute, Use SSL, Path).
See Enabling LDAP on page 1152.
Enable Active Directory Authentication—If enabled, user authentication is
functional, and you can enable the following 3 fields. If you do not enable these
fields, you are using Implementing User Authentication Mode on page 1142. For
information on LDAP, see Using LDAP with Ektron on page 1151
l
Enable Active Directory Integration—If enabled, the Active Directory
Integration feature is functional and you can enable the next 2 fields.
l

l

Enable automatic addition of user from AD—If enabled, user information
is imported from AD to Ektron when that user logs in or when the user is added
to Ektron.
Enable automatic addition of user to groups—If enabled, a user’s group
membership is first imported from AD when a user logs in or is added.

Auto Add
l

User Type—Choose the type of user to be automatically added: Author or Member.

User Property Association
l

l

l

EmailAddr1—Enter the Active Directory property that maps to the user’s last
name in Ektron. By default, this is mail, but you can change it to any AD property.
FirstName—Enter the Active Directory property that maps to the user’s first name
in Ektron. By default, this is givenName, but you can change it to any AD property.
LastName—Enter the Active Directory property that maps to the user’s last name
in Ektron. By default, this is sn, but you can change it to any AD property.
For more information on user properties, see MSDN Library
User Object User Interface Mapping (Windows)

Ektron Administrator Group Association
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l

l

AD Group Name @ AD Domain—Enter the Active Directory user group and
domain name that map to the Ektron administrator group. If your AD does not have
a user group that includes all Ektron administrators, you should create one then
enter it here. See Mapping the Administrator Group on page 1140.
Domain—If you want to restrict the search of new users and groups to one AD
domain, select that domain. The Search Active Directory for Users and Search
Active Directory for Groups screens let you search the selected domain only.
Also, if any Ektron user or group names include a domain (for example,
admin@saturn.example.com) that is excluded by your selection, those
users/groups are flagged on the Active Directory Setup and Active Directory Status
screens because the names include an invalid domain.

4. Messages may be displayed near the top of the Active Directory Setup screen to notify
you that additional configuration steps are required. If either message appears, click it.
The Active Directory Status screen appears, which helps you resolve the discrepancies.
Active Directory Authentication is Enabled and Requires More Configuration—Some
Ektron users are not associated with AD users. Also, if you are using full active directory
integration mode, user groups and/or user group relationships may not be associated.
Active Directory Authentication is disabled, but needs further configuration—Some
Ektron users and/or groups are no longer unique. This happens because, in AD, users
and groups can share a logon name as long as their domains are different. But, if AD
authentication is disabled, 2 users or groups can no longer share a name—each must be
unique.

Displaying Active Directory Status
Use the Active Directory Status screen to identify and resolve discrepancies between Ektron
and AD:
l

An Ektron user must be associated with an AD user

l

An Ektron user group must be associated with an AD user group

l

An Ektron user’s group membership must be associated with the same AD user’s group
membership

Any combination of these messages may be displayed depending on the issues requiring
resolution. The following procedure provides steps to resolve all 3 issues.
1. Go to Settings > Configuration > Active Directory > Status.
2. Click a link on the Active Directory Status screen to display a new screen lets you
resolve the discrepancy.
3. Click CMS users need to be associated with Active Directory users on the Active
Directory Status screen. The Associate CMS Users with Active Directory Users screen
appears. Use this screen to associate Ektron users with AD users.
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4. Depending on the user, perform the appropriate action:
l
If a user with the same username exists in AD, that name and domain appear in the
AD Username and AD Domain fields. If the user exists in more than one AD
domain, select a domain from the pull-down list.
l

l

l

If there is no default and you know the AD user name to associate with an Ektron
user, enter that in the AD Username and AD Domain fields. If you do not know
the AD username, click Search to find the user in AD.
If you decide to change the username in AD to match the Ektron username, make
the change in AD. Then, click Refresh ( ) to update Ektron and resolve the
discrepancy.
If a user should not exist in Ektron, click the Delete box.

5. After you complete the changes, click Save.
6. Click CMS relationships need to be associated with Active Directory
relationships on the Active Directory Status screen. The Associate CMS Relationships
with Active Directory Relationships screen appears. The screen displays a user’s group
membership that exists in Ektron, but does not exist in AD. Use this screen to coordinate
Ektron user group membership with AD user group membership.
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7. After viewing the discrepancy, perform the appropriate action:
l
To associate the user with the same user group in AD, go to AD and assign the user
to the group. Then, return to this screen and click Refresh ( ) to update user
group information in Ektron. See Also: Importing a User’s AD Group Information to
Ektron on page 1140
l

To remove the user’s group membership in Ektron, check the Delete box and

8. After you complete the changes, click Save (

).

9. Click CMS groups need to be associated with Active Directory groups on the
Active Directory Status screen, the Associate CMS User Groups with Active Directory
Groups screen appears. Use this screen to associate Ektron groups with AD groups.
10. Depending on the group, perform the appropriate action:
l
If there is no default, enter that in the AD Group Name and AD Domain fields. If
you do not know the AD group name, click Search to find the group in AD.
l

If a group should not exist in Ektron, click the box under the Delete column to
delete the group.

11. After you complete the changes, click Save.

Viewing and Searching for Users
1. Click Settings > Users from the Workarea. The View users screen appears.
2. Click a user to display detailed information for that user. The View User Information
screen appears.

3. If you are using user authentication mode, Username and Domain can only be edited
in AD. You can edit all other fields on this screen.
If you are using full AD Integration mode, Username, Domain, First Name, Last
Name, and email Address can only be edited in AD. You can edit all other fields on this
screen.
The screen also displays the following buttons.
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l
l
l

Edit—Edit information on screen.
—Delete user.
—Retrieve latest information from AD into Ektron. This button is not displayed in
user authentication mode.

l

—Replace CMS user with different AD User.

l

—Return to previous screen

If you cannot easily locate specific users on the View Users screen, use the search
function.
4. Click Add User. The Search Active Directory for Users screen appears.

5. Enter as many search criteria as you know to reduce the number of users that the search
returns. For example, if you know the user’s last name is Jackson and he is in the
planets domain, enter those criteria to get fewer results.
6. Click Search. The Active Directory Users screen appears.
7. Check the box next to each user you want to add to Ektron.
8. Click Saveto import the information.

Viewing and Searching for User Groups
The View User Groups Screen displays all AD user groups that have been imported to Ektron.
1. Go to Settings > User Groups. The View User Groups screen appears.
2. Click the group name to display detailed information for the group. The View Users in
Group screen appears, showing the following information for each user in the group:
l

username and domain

l

first and last name

l

language

3. To add AD groups to Ektron, click the toolbar button ( ) that lets you add AD groups to
Ektron. The Search Active Directory for Groups screen appears.
4. If the Domain setting on the Active Directory Setup screen is set to restrict AD
integration to one domain, you can only search for groups in that domain.
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5. Click Search. A new screen appears that lists all AD groups that satisfy the search
criteria.
6. Click the box next to groups you want to create in Ektron.
7. ClickSaveto import their information.

Importing AD User Information to Ektron
This section explains importing AD user information when integration is first enabled and on
an ongoing basis.
AD user information is initially imported to Ektron in different ways depending on whether:
l
l

l

the Ektron database has already been populated with users
the Ektron database has not yet been fully populated with users. (At least one user is
always present because of the default admin user.)
users are manually added to the Ektron database

For a populated Ektron database:
1. If Enable automatic addition of user from AD is checked on the Active Directory
Setup screen, user information is imported from AD to Ektron when that user logs in or is
added to Ektron. See Also: Setting Up Active Directory on page 1133
2. At that time, AD information overwrites all Ektron information.
3. If 2 or more AD users have the same Ektron user logon name but different domains (for
example, JDoe in Eng.Example.com and JDoe in Mkt.Example.com) and that username
(JDoe) also exists in Ektron, the Active Directory Setup and Active Directory Status
screens indicate this discrepancy via this message: CMS users need to be
associated with Active Directory users.
4. Click the message to proceed to the Associate Ektron Users to Active Directory Users
screen. From there, you can link an AD user to an Ektron user. See Also: Maintaining AD
User Information on the facing page
For a Ektron database with only a few users, go to the Search Active Directory for Users
screen and select AD users that will use Ektron. You can only select AD users that do not exist
in Ektron. Also, the Active Directory Setup screen can restrict AD integration to one domain.
If it does, you can only search for users in that domain.When you add a user, AD information
is imported to Ektron. See Also: Viewing and Searching for Users on page 1136
You can also manually add AD users to Ektron:
1. From the Workarea, click Settings >Users.
2. Click Add Users. The Active Directory Users screen appears.
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3. From the Domain pull-down list, select the domain from which you want to add a user.
4. Enter as much information as you know into the other fields.
5. Click Search. A screen displays all users that satisfy the search criteria.
6. Check the box next to each user you want to add.
7. Click Save.

Maintaining AD User Information
When AD integration has been established, new AD user information is imported to Ektron
when either of these events occurs:
l

the user logs in

l

someone clicks Refresh (

) on the user’s View User Information screen

Maintenance tasks include:
l

l

Editing—Because Ektron does not write to AD, you can only change some fields on the
Edit User screen. Edit read-only fields from AD.
Deleting—If a user is deleted in AD, Ektron does not delete the user. However, the login
fails because the user cannot be authenticated. To delete the user from Ektron, use the
Delete User function described in Deleting a User on page 1105.
If you mistakenly delete all users with administrative privileges, you can still sign in
using the builtin user’s username and password. For more information, see Getting
Started with Ektron on page 5.

l

Replacing—If you associate the wrong AD user with an Ektron user, you can replace the
user. If you do, all Ektron permissions and approval process responsibilities transfer
from the old to the new user.

1. Go to Settings > Users.
2. Click the user you want to replace.
3. Click Associate CMS User with Different AD User (

).

4. Select a user to replace the previously selected user.
5. Click Save. The first user is deleted from Ektron.

Importing AD User Group Information
This section explains how a user’s group membership is imported from AD to Ektron after
integration is enabled. When assigned to a group, the user automatically receives all Ektron
permissions and approval process responsibilities associated with it.
NOTE: Active Directory has 2 kinds of user groups: security and distribution. Ektron does not distinguish
between them. As long as a user is a member of either kind of group, group information can be imported to
Ektron.
Before using AD integration, import all AD groups you will use into Ektron:
1. From the Workarea, choose Settings > User Groups.
2. Click Add Groups. The Search Active Directory for Groups screen appears.
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3. From the Domain drop-down list, select the domain of the user group you want to add.
NOTE: The Active Directory Setup screen can restrict AD integration to one domain. If it does, you
can only search within that domain.
4. Enter as much information as you know into the Active Directory Group field.
5. Click Search. A screen displays all groups that satisfy the search criteria.
6. Check the box to the left of each group you want to import to Ektron.
7. Click Save.

Importing a User’s AD Group Information to Ektron
Users' membership in AD Groups are imported to Ektron in different ways depending on the
state of existing Ektron user groups:
l

If CMS user groups already exist—If Enable automatic addition of user to
groups is checked on the Active Directory Setup screen, a user’s group membership is
imported from AD to Ektron when a user first logs in or is added. At this time, any AD
group memberships overwrite Ektron group memberships except the Everyone group, to
which all users belong.
In the case of a discrepancy between AD and Ektron user groups:

l

l

o

If a user belongs to an AD user group that does not exist in Ektron, no action is
taken. The AD Integration feature assumes that not all AD groups are meaningful in
Ektron.

o

If a user belongs to an Ektron user group that does not exist in AD, the discrepancy
is flagged on the Active Directory Setup and Active Directory Status screens. From
these screens, you can import AD group information into Ektron.

o

If the user should belong to an AD group, add the group membership within AD.
Then, refresh the user on the View User Information screen to import AD group
information into Ektron.

If only default user groups exist in the CMS—Follow the procedure described in
Importing AD User Information to Ektron on page 1138 to import AD user groups to
Ektron. Then, as users in those groups are added to Ektron, their group memberships are
applied.
After AD integration is enabled—a user’s group memberships in Ektron are updated
when all of the following are true:
o The Enable automatic addition of user to groups field is checked on the Active
Directory Setup screen
o

A user is added to Ektron or the user's AD group membership changes

o

The user logs in or someone clicks Refresh (

) on the user’s View User

Information screen
Alternatively, if Enable automatic addition of user to groups field is unchecked, you can
add the user to (or remove the user from) groups independently of AD group memberships.

Mapping the Administrator Group
On the Active Directory Setup screen, you identify the AD group that maps to the Ektron
Administrator group using a syntax of AD group name@AD domain. Members of this group
receive administrator privileges.See Also: Administrator Role Privileges on page 1126
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If such a group does not exist in AD, create it, then assign it on the Active Directory Setup
screen.
Note that only one AD group can be mapped to the Ektron Administrator group. You cannot
have an AD administrator group within each AD domain.
NOTE: Unlike other Ektron user groups, whose names are imported from AD, the Ektron Administrator
and Everyone group names cannot be changed.

Maintaining AD User Group Information
Maintenance tasks include:
l

l

l

l

Removing users from a group—If you delete a user from an AD group, the user is
removed from the associated Ektron group the next time the user's information is
updated.
Adding user groups—If AD integration is enabled, you can only add user groups in AD.
Then log on to Ektron and use the Search Active Directory for Groups screen to import
the AD user group to Ektron as described in Importing AD User Group Information on
page 1139.
Adding a user to a group—You cannot add a user to a user group within Ektron; you
must do so in Active Directory.
Replacing a group—If you associated the wrong AD user group with an Ektron user
group, replace the user group.
1. From the Workarea, click Settings >User Groups.
2. Click the user group that you want to replace.
3. Click Associate CMS Group with Different AD Group (

).

4. Select a group to replace the group you selected in Step 2.
5. Click Save.
l

Deleting a group—You can delete a user group from AD or Ektron. When deleting user
groups, consider the following behaviors:
o If you delete a user group in AD and users are assigned to the group within Ektron,
the group is not deleted in Ektron. However, any Ektron users who were members
of the group are no longer members the next time their Ektron information is
updated. The discrepancy is flagged on the Active Directory Setup and Active
Directory Status screens.
o

If you delete a user group in Ektron and users are assigned to that group within AD,
nothing happens. This is because AD Integration assumes that the Ektron
administrator only maintains user groups that are meaningful to Ektron, and some
AD groups are not meaningful to Ektron.

Disabling AD Integration
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When you disable AD integration, domain names are dropped, which may cause user and user
group names to not be unique. For example, 2 users are named JJackson@example.net and
JJackson@example.com. When AD is enabled, domain names make the users and user groups
unique. However, when AD is disabled and domain names are dropped, the names are now
identical. You need to make the users and user groups unique.
To disable AD authentication or integration:
1. Go to Settings > Configuration > Active Directory > Setup. The Active Directory
Setup screen appears.
2. Enable the Disable Active Directory and LDAP Authentication radio button. If any
users or groups have the same name with different domains, the following message
appears: Active Directory Authentication is disabled, but needs further
configuration
3. Click the message. The Active Directory Status screen appears.
4. Click the CMS users need to be made unique message. The Make CMS Users Unique
screen appears.

User group names are handled in the same manner. Click the CMS user groups need
to be made unique message. The Make CMS Groups Unique screen appears.

5. Click Save to accept the suggested new names as recommended by Ektron. By accepting
the suggested name, you allow the software to automatically associate AD andEktron
users or groups if you later decide to re-enable AD integration.

Implementing User Authentication Mode
In user authentication mode, AD is used only to authenticate users logging in to Ektron. User
groups are managed within Ektron, not AD.

Transferring User Information from AD to Ektron
Ektron does not write to AD; it only reads from it. This changes how usernames, domains, and
passwords are handled in Ektron.
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l

l

Changes to user logon name, domain and password must be made in AD. You cannot
update these fields in the Ektron Edit User screens.
When adding a new user to Ektron, you can only select AD users. If the user does not
exist in AD, create the user there and then import the user into Ektron.

Ektron refers to the following AD authentication information during sign-in: password, user
logon name, and domain. Note that the password is not stored in Ektron; Ektron only refers to
the password during sign-in.

Adding and Maintaining User Information
Adding user information in user authentication mode is the same as in AD integration mode.
If a user’s logon name changes in AD, it no longer matches the Ektron logon name. This
discrepancy is flagged on the Active Directory Setup and Active Directory Status screens. Go
to the Associate CMS Users to Active Directory Users screen, where you can update the user
information.
Alternatively, you could:
1. Go to the View User Information screen.
2. Select the user whose AD name changed.
3. Click Associate the CMS user with Different AD user (

).

4. Select the AD user and domain.
See Also: Maintaining AD User Information on page 1139

Editing User Information in Ektron
Ektron does not write to AD. This means that you can only change the Username and
Domain fields from AD. You can change the following fields on the Ektron Edit User screen:
l

First Name

l

Last Name

l

E-Mail Address

l

User Language

l

Disable Receiving of Workflow and Task Email

IMPORTANT: If you replace a user in user authentication-only mode, the user’s first name, last name,
and email address are not overwritten with information in AD.

Using AD Integration Screens in User Authentication Mode
Because the scope of user authentication mode is limited to authentication, only some fields
on AD Integration screens are used:
l

l

l

On the Active Directory setup screen, the only relevant fields are authentication and
domain. See Also: Setting Up Active Directory on page 1133
On the Active Directory Status Screen, only one discrepancy message may appear:
CMS user needs to be associated with an AD user
See Also: Maintaining AD User Information on page 1139
The View Users Screen works the same for both modes. See Also: Viewing and
Searching for Users on page 1136
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Because AD usernames and passwords are stored by domain, the AD sign-on procedure
requires the user to select a domain. When AD integration is enabled, the sign-on screen
includes a domain drop-down list.
This section also contains the following topics.

Single Sign On
The Single Sign On feature retrieves a user’s login information from Active Directory to
authenticate access to Ektron. The user does not need to enter a password. After clicking
Login, he immediately logs in.
Single Sign On uses a variable called User.Identity.Name. This maintains the user's account
and domain in Active Directory, and has the format [domain]\[username]. For example,
EKTRON1\ssmith. The variable's value is set when a user authenticates against a Windows
server.
When a user clicks the Login server control, if the variable passes successfully and Active
Directory is enabled, the server control opens the autologin.aspx page. Next, the opening
window refreshes like a normal login, except the user is not prompted for a username,
password, and domain.
However, if the user‘s computer is not on a domain, not on the same domain as Ektron, or
does not include the Ektron server as a trusted site, the following login screen appears.

If Active Directory is not enabled, the normal login.aspx page appears.
Single Sign On uses the autologin.aspx file in the workarea/SSO directory. When set up,
user authentication is enabled from any domain that this server can reach. For example, if
Ektron is located in a third level domain, users from third, second, and first level domains can
authenticate.
To allow membership users to use single signon, see Authenticating Membership Users with
AD or LDAP on page 1156. When enabling this functionality, create one login page for Ektron
users and another for membership users. For example, use the membership user login as the
front-facing login, and then secure a /cmslogin.aspx for Ektron user. Next, secure the login
with IIS security because Windows authentication only allows the Ektron administrators group
in AD to read permissions on the /cmslogin.aspx page.
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NOTE: Single signon may not work directly on servers, due to security settings on the server and its
browser. Try a different machine and make sure it works elsewhere before troubleshooting further.
See Also: Enabling NTLM Authentication (Automatic logon)
Use the setup instructions that correspond to the IIS version running on your server.
After completing these procedures, enable Active Directory within Ektron (if it isn’t already
enabled). See Also: Setting Up Active Directory on page 1127
You should enable the automatic addition of users and groups.
Use the following line of codebehind when troubleshooting user login with Single Signon. If
this .NET code cannot get the user login, then Ektron cannot either.
Response.Write("UserName:" & Request.ServerVariables("LOGON_USER"))

Setting up Single Sign On Using IIS7 or IIS7.5
Setting up Single Sign On with IIS 7 or IIS7.5 involves modifying the web.config file and
editing security settings.

Modifying Web.config for Single Sign On
1. Open site root/Web.config.
2. Find the ek_AUTH_protocol element and change its value to LDAP:
<add key="ek_AUTH_Protocol" value="LDAP" />

3. Find the authentication element and change the value of authentication mode to
Windows.
4. Change the value of impersonate to False:
<authentication mode="Windows" />
<identity impersonate="false" userName="" password=""/>

5. Comment out the MyDigestAuthenticationModule only.
<modules>
<!--add name="MyDigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,
Ektron.ASM.EkHttpDavHandler" /-->
<add name="ScriptModule" type="System.Web.Handlers.ScriptModule,
System.Web.Extensions, Version=1.0.61025.0, Culture=neutral,
PublicKeyToken=31bf3856ad364e35" preCondition="integratedMode" />
<add name="EkUrlAliasModule" type="UrlAliasingModule"
preCondition="integratedMode" />
</modules>

Adjusting Security Settings for the Site Root Folder
1. Go to Start menu > Administrative Tools > Internet Information Services.
2. Within IIS, go to Sites and select your Ektron site.
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3. From the right panel, select Authentication.

4. On the Authentication screen, enable Anonymous Authentication.

Adjusting Security Settings for autologin.aspx
1. Make sure that Windows Authentication is installed on this server. To do this:
a. Open Start menu > Administrative Tools > Server Manager.
b. Click Roles > WebServer (IIS) Role Services > Security > Windows
Authentication.
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c. If the status of Windows Authentication is Installed, proceed to Step 2.
If the status of Windows Authentication is Not Installed, click Add Role
Services. The Add Role Services screen appears.
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d. Check Windows Authentication.
e. Click Next and follow the prompts to install Windows Authentication.
f. Close Server Manager.
2. Open IIS Manager.
3. Go to Sites > your website’s root folder > Workarea > SSO and right click
Switch to Content View.
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4. In the center panel, right click autologin.aspx and select Switch to Features View.

5. In the center panel, click Authentication.
6. From the center panel, check the status of Windows Authentication. If it is disabled,
enable it by selecting it, right clicking, and choosing Enable from the menu.
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7. From the center panel, check the status of Anonymous Authentication. If it is
enabled, disable it by selecting it, right clicking, and choosing Disable from the menu.
As a result of this procedure, autologin.aspx passes credentials from the logged-in
user's desktop.

Updating the Login Server Control for Single Signon
This sample shows how to modify the Login server control to accommodate single signon. See
Also: Login on page 1763 server control
/Cmslogin.aspx <cms:login> Control
<cms:login runat="server" AutoLogin="True" AutoAddType="Author"
id="cmslogin" />
/login.aspx.cs
bAutoLogin = true;

Active Directory and eSync
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An Active Directory configuration does not get Synched.
In an eSync environment, add all users to one environment. Then, sync the users if multiple
servers are using AD login.

Using LDAP with Ektron
Lightweight Directory Access Protocol (LDAP) is a set of protocols that enable the hierarchical
arrangement of corporate directory entries in a structure, which may reflect geographic or
organizational boundaries. Active Directory and LDAP are not the same. While they perform
similar functions, LDAP (when used with Ektron) only verifies login information and creates
the user in the Everyone group.
Ektron's LDAP feature lets you retrieve user login information from an LDAP server. As a
result, you can administer user information from one place, and users only need to
remember one password/username combination to sign on to the network and Ektron.
The hierarchical structure of LDAP authentication can be organized in several different ways.
For example, if you had the following LDAP structure, the domain would typically span
multiple countries.
NOTE: Abbreviations: CN = Common Name, OU = Organizational Unit, O = Organization, C= Country,
DN = Distinguished Name.
CN=j_smith, OU=Sales, O=MyCompany, C=US, DN=example.com
By changing the order of C and DN, the hierarchy indicates that the domain example.com is
located in the US.
CN=j_smith, OU=Sales, O=MyCompany, DN=example.com, C=US.
In some instances, it may be necessary to have an Organization appear below an
Organizational Unit. For example, your Organizational Unit has it own Organizations.
Below is a visual example of an LDAP hierarchical structure.
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Enabling LDAP
You enable LDAP by editing the web.config file and editing settings on the Active Directory
Setup screen. See Also: Setting Up Active Directory on page 1133
IMPORTANT: Before enabling LDAP in Ektron, make sure your LDAP server is ready for use. Be sure to
include an Ektron administrator account for yourself. After you enable LDAP, only the BuiltIn account can
access Ektron without LDAP authentication. See Also: Getting Started with Ektron on page 5
1. In the siteroot\web.config file, change the ek_AUTH_Protocol property to GC:
<add key="ek_AUTH_Protocol" value="GC"/>
2. Go to Settings > Configuration > Active Directory > Setup. The Active Directory
Setup screen appears.
3. Click Edit.
4. Select Enable LDAP Authentication.
5. Complete the LDAP-related fields and click Update.
l
Type—Choose the type of LDAP authentication you are using. Depending on your
choices, the fields below may be required or disallowed. The following choices are
available:
o Active Directory (LDAP)—Domain allowed, Organization is not. For more
information, see Using LDAP to Connect to Active Directory on the facing page.
o
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l
l

l

l

l

l

l

l

o

Sun Iplanet/JSDS—Domain allowed, Organization is not.

o

Other—Allows Domain and Organization

LDAP Server—The IP address or name of the LDAP server.
Port—The LDAP server port with which Ektron communicates. If you are unsure of
the port number, consult your Directory Service documentation .
Organization—The name of your company or organization. For example, Ektron,
Inc. You can leave this field blank if you enter a domain in the Domain field.
Domain—Your domain name. For example, www.ektron.com. This should be the
name you used when purchasing your license key. You can leave this field blank if
you enter an organization in the Organization field.
Attribute—Enter the key value used to reference accounts inside LDAP. As
examples: dn, sn, cn, uid, and so on.
Use SSL—Check if you want to enforce a secure connection in traffic to the LDAP
server.
Path—The next levels below your Organization or Domain. These can include
multiple levels of Organizational Units. For example, Content Editors, Marketing,
East Coast. Click the Expand link to display the Add field.
Add—Enter the path to which you would like access in the text field. Then click the
Add link.
When adding Organizational Units, paths are comma-separated and run from
specific to general. For example, ou=Amherst,ou=New Hampshire,o=US. For more
information, see Adding an Organizational Unit During Setup on the next page.
Do not add individual Common Names here. Only add Organizational Units that
contain people who should have access to Ektron. To add a single individual from a
different Organizational Unit, see Adding User Information from an LDAP Server to
Ektron on the next page

NOTE: You can add additional Organizations below an Organization Units as long as the path on your
LDAP server is the same.

Using LDAP to Connect to Active Directory
1. In the \web.config file, add the Username and Password for ek_ADUsername and ek_
ADPassword. For example:
<add key="ek_ADUsername" value="mwright@ektron.com" />
<add key="ek_ADPassword" value="mypasswordisthis" />
2. Go to Settings > Configuration > Active Directory > Setup. The Active Directory
Setup screen appears.
3. Click Edit.
4. Use the following settings in the Active Directory Setup screen.
l
Type—Active Directory (LDAP)
l

LDAP Server—[IP Address of the AD domain controller]

l

Port—389

l

Organization—[leave this blank]

l

Domain—[dns name of the AD domain]. For example: internal.domain.com
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l

Path (Organizational Units)—[any OUs that you want to draw users from] For
example: Support, Users, Ektron Corporate or Engineering, Users, Ektron
Corporate

Adding an Organizational Unit During Setup
Things to consider when adding Organizational Units:
l
l

l
l

l

Should everyone in the OU have access to Ektron?
When LDAP is enabled, users are added to the Everyone group upon login. While
everyone in the OU has access to Ektron, every user should not necessarily have
permission to edit content. To control permissions, set up user groups, add users to
groups, and assign permissions to the group. See Also: Managing Users and User Groups
on page 1099 and Managing Folder Permissions on page 257
Do users in other Organizational Units need access?
Sometimes, managers or editors are in a different OU. They need to be added manually,
or you need to add their OU.
When adding an Organizational Unit, several entries might cover the same hierarchical
path. For example, you might have
ou=Sales, ou=Sales_Service, and ou=MyCompany, which lets you authenticate users
listed in Sales, Sales_Sevice, and MyCompany.

Adding User Information from an LDAP Server to
Ektron
Users at each level are automatically available for adding to Ektron. You do not have to be at
the OU or CN level to add a user. If a user is at the DC or OU level, they are available.
After LDAP is enabled, there are several ways to add LDAP user information to Ektron:
l

The user logs in. As a result, the user appears in the Users list and is added to the
Everyone group. After a user logs in, some fields on the Add User screen can be filled in
manually, such as first and last name. For a description of these fields, see Manually
Adding an LDAP User on the facing page

l

Search an LDAP server for LDAP users.

l

Add the user’s LDAP information manually.

l

A combination of searching and manually completing the remaining fields.

Searching an LDAP Server for Users
PREREQUISITE
LDAP is enabled. See Enabling LDAP on page 1152.
To search for a user on an LDAP server and add the user to Ektron:
1. From the Workarea, navigate to Settings >Users.
2. Click Add Users. The Add a New User to the System screen appears
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3. Click Browse LDAP (

). The Search LDAP Users screen appears.

4. Enter one or more search criteria.
l
Username—the username of the user on the LDAP server
l

Firstname—the first name of the user on the LDAP server

l

Lastname—the last name of the user on the LDAP server

l

Path—select a path from the drop-down list. These are the paths that were enabled
when you configuredEktron for your LDAP server. If you select a path and enter no
other information, you get all users in that path.

5. Click Search. The search returns users that match the criteria entered.
6. Check each user to be added.

7. Click Save The user is now added to Ektron and the Everyone group. To learn how to
assign the user to another user group, see Assigning Users to User Groups on page 1106.

Manually Adding an LDAP User
PREREQUISITE
LDAP is enabled. See Enabling LDAP on page 1152.
1. Go to Settings > Users.
2. Click Add User. The Add a New User to the System screen appears.
3. Fill out the fields according to Creating a New User on page 1100.
4. Click Save. The View Users in Group Everyone screen appears, displaying the new user
and the other Ektron users. To learn how to assign the user to another group, see
Assigning Users to User Groups on page 1106.

Using the Browse Feature to Add an LDAP User
The Browse LDAP feature provides a friendly and intuitive way to find usernames,
domains/organizations and organizational units.
IMPORTANT: The default server IP/DNS name and port are taken from the settings specified in the
Configuration > Setup page. These settings must be specified before connecting to the LDAP server.
Before using the browse feature, you must specify an Organizational Unit that can see the user in the
Configuration > Setup page.
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PREREQUISITE
LDAP is enabled. See Enabling LDAP on page 1152.
1. Go to Settings > Users.
2. Click Add Users. The Add a New User to the System screen appears.
3. Click Browse LDAP (

). The LDAP Explorer appears.

4. Navigate the LDAP server’s folders by clicking on the folder images. Each folder
represents an Organizational Unit (OU). When you choose an OU level, its users appear.
NOTE: In the LDAP Explorer, the Path and Org/Domain fields update dynamically as you navigate
through the LDAP tree.
5. Select a user. The user is added to Ektron and the Everyone group. To learn how to
assign this user to another group, see Assigning Users to User Groups on page 1106.

Editing LDAP User Information
It is important to note that Ektron does not write to the LDAP server. So, while you can
change fields when editing a user in Ektron, you also need to make the same changes on the
LDAP server.
1. Go to Settings > Users.
2. In the Username column, click a user to edit. The View User Information screen
appears.
3. Click Edit.
4. Change the information as needed. For more information on the fields you can edit, see
Creating a New User on page 1100.
5. Click Save.

Deleting Users
If a user is deleted on the LDAP server, Ektron does not automatically delete the user.
However, the user’s login fails because the login cannot be authenticated. In this case, delete
the user from Ektron using the Delete User function.
NOTE: If you mistakenly delete all users with administrative privileges, you can still sign in using the
builtin user’s username and password. See Also: Getting Started with Ektron on page 5

Authenticating Membership Users with AD or LDAP
Usually Membership users are not included in AD or LDAP directories. Ektron's default
settings ignore AD or LDAP for membership authentication.
If you want Membership users to authenticate with AD or LDAP, follow these steps.
1. Edit the siteroot\web.config file.
2. Set LDAPmembershipUser to true.
<add key "ek_LDAPMembershipUser" value="true" />
If ek_LDAPmembershipUser is false, membership users are not authenticated with AD or
LDAP.
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Disabling LDAP Authentication
To disable LDAP authentication or integration, edit the Active Directory Setup screen and
select Disable Active Directory and LDAP Authentication.
See Also: Setting Up Active Directory on page 1133
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A community is a group of people who network with each other to share information, ideas,
likes and dislikes. Typically, people or members in the community are connected by a
relationship. For example, they work for the same company, went to the same school, share
values, or have a friendship.
When you visit a community site, look around to see the kind of information, people and
groups that are on the site. Typically, you can see only limited information initially. To see all
information, you need to become a member. When you sign up to be member, you enter
information about yourself in a member profile. After becoming a member, you can:
l

maintain a personal profile, including an avatar

l

search for other members and add them to a friends list

l

join or create a community group

l

invite non-members to join a community and become a friend

l

add photos and documents to a personal or group profile page

l

determine which other users and groups can view and update those files

l

update status and share that update with selected members

l

post public or private messages to another member’s message board

l

keep a journal of your thoughts

l

create a list of favorite Ektron content links

l

have a list of content that you have added

l

write content reviews

l

flag content

The Community Platform in Ektron is a group of features that lets users network socially on a
website. Access to the community platform is available from the website or the Workarea but
only Ektron users and administrators can access their information via the Workarea. As an
Administrator, you can manage Community features from the Workarea. Membership Users,
Ektron users, and administrators can access their profile pages via a website.
This section also contains the following topics.
l

Membership Users and Groups on the facing page

l

Accessing a User Profile on page 1175

l

Moderating a Message Board on page 1175

l

Managing Community Groups on page 1181

l

Distributing Content to Another Ektron Folder on page 1188

l

Sending Notifications to a Community on page 1194

l

Setting Up Email to Communicate Community Activities on page 1223

l

Activity Streams on page 1231

l

Using Ektron's Micro-messaging Bookmarklet on page 1249

l

Defining Flags for Content on page 1239

l

Generating email Invitations for Community Management on page 1230

l

Tagging Content, Library Items, Users, and Groups with Keywords on page 1245

To learn about the server controls that let membership users log into an Ektron site, see
Getting Started with Ektron on page 5 and Login on page 1763 server control. For other
community-related server controls, see the following:
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l

CommunityDocuments on page 1685

l

CommunityGroupBrowser on page 1688

l

CommunityGroupList on page 1691

l

CommunityGroupMembers on page 1695

l

CommunityGroupProfile on page 1698

l

Favorites on page 1723

l

Friends (Colleagues) on page 1747

l

Invite on page 1751

l

MessageBoard on page 1786

l

Micro-messaging on page 1801

l

PhotoGallery on page 1808

l

SocialBar on page 1845

Membership Users and Groups
Membership users have limited privileges to Ektron. Unlike regular Ektron users, they cannot
use the Workarea. When membership users log in, they can view, add and edit content from
the website (as permitted)—all other functionality is disabled.
Membership users can be allowed to view private content. This is helpful if your organization
has partners who need access to Web pages that should not be visible to the general public.
See Also: Making Content Private on page 294 If you have a Social Network or Community
website, a membership user can create an online area for themselves.
PREREQUISITE
To work with membership users, you must be a member of the Administrators group
or assigned to the member admin role. See Also: Defining Roles on page 1120

Membership User Privileges
A typical membership scenario is a Partners section of your website that contains private
content for partners only. Set up a membership user group with users from your partner’s
organization. The group is given add and edit permissions to the Partners section.
Membership privileges are:
l

Create, edit, and view content after log in.

l

Subscribe to receive Web Alerts. See Also: Administering Web Alerts on page 1567

l

View private content.

l

Use these Community features See Also: Managing User Communities on page 1159
o Share Document Workspace and Photo Gallery with other site visitors
o

Join a community group

o

Mark content the member likes and allow site visitors to see the list of these
Favorites

o

Designate other members or site users as Colleagues

o

Keep a Journal

o

Add and read Message Board comments
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l
l

o

Send and receive messages with other registered users

o

If a Discussion Board requires sign in, they can view and post to them. See Also:
Working with Discussion Boards on page 536

Post blog comments. See Also: Working with Blogs on page 491
If a poll or survey is set up to track participating users, membership users’ names
appear on the Form reports.

Viewing Membership Users
Use the Membership Module folder to add and edit membership users and user groups.
1. Navigate to the Workarea > Settings > Community Management >
Memberships.
2. From that folder, you can access the following screens.
l
Users—You can sort the Username, Last Name, and First Name columns by clicking
the column headers.
l

l

Users not Verified—If you are using the Web Alert feature, any site visitor can sign
up to be a membership user. How Users Sign up for Subscriptions on page 1586
User Groups—Membership Groups on page 1165

NOTE: The ek_PageSize setting in the web.config file determines the maximum number of users
that can appear on a page before it “breaks.” When a page breaks, additional entries appear on another
screen, and the following text appears near the bottom of the list:
Page 1 of 2 [First Page] [Previous Page] [Next Page] [Last Page]

Adding Membership Users
1. From the Workarea, click Settings > Community Management > Memberships >
Users.
2. Click Add Membership User. The Add Membership User screen appears.
3. Complete the form using the following list as a reference.
l
Username—Enter a unique username for the membership user.
l

First Name—Enter the first name of the user.

l

Last Name—Enter the last name of the user.

l

Display Name—The name used to identify a Membership user on the website. This
can be different from the Username, which is the name you use to log into the
Ektron website.
IMPORTANT: This name needs to be unique inside Ektron and it cannot be blank.

l

Password—Enter a password for the user.

l

Confirm Pwd—Re-type the password to confirm it is correct.

l
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User Language—Select the language in which the user viewsEktron screens and
messages. The language also determines the default value whenever a drop-down
list of languages appears within Ektron. The drop-down list of choices at this field is
derived from the Language Settings screen, available from the Settings >
Configuration folder. Do not confuse the system language with the user’s ability to
create and edit foreign editions of content. This field does not prevent a user from
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working with multiple language content. See Also: Working with Multi-Language
Content on page 1057. If the selected language is not English, French or German, it
is only supported after you download the Ektron Language Support Program from
Ektron and translate the website.
l
l

l

Email Address—Enter an email address for the user.
Forum Editor—Determines which editor is used when this user replies to a
Discussion Board. See Also: Using Discussion Boards on Your Website on page 568
Avatar—Click on "Click to upload your Avatar" and choose an image file that you
want to associate with your profile. By default, the maximum file size of an avatar
is 200 kilobytes. Also, the avatar's height and width cannot exceed 125 pixels
preserving the aspect ratio.
Changing the Default File Size
To change the file size limit, edit Siteroot\Workarea\Upload.aspx.vb. In this
file, change the line below to the maximum file size you want to allow.
If (numFileSize > 200) Then

For example, to allow 500 kb files, change 200 to 500.
NOTE: Remember, this number is in kilobytes.
Changing the Default Height and Width
To change the default height and width, edit YourSite\App_
Code\VBCode\Utilities.vb. In this file, change the following lines to the size you
wish to allow.
Dim Width As Integer = 125
Dim Height As Integer = 125

For example, to set avatars' height and width to 166 pixels, change 125 to 166 in
both lines.
l

l

l

Address—The address used to find your location when a user is performing a
search based on location.
Latitude—The latitude used to find your location when a user is performing a
search based on location. Google maps provides a service that takes the address of
user and returns its latitude and longitude. You don’t need to use Google’s
automatic retrieval of latitude and longitude. Instead, you can enter the values
manually.
Longitude—The longitude used to find your location when a user is performing a
search based on location. Google maps provides a service that takes the address of
content and returns its latitude and longitude. You don’t need to use Google’s
automatic retrieval of latitude and longitude. Instead, you can enter the values
manually.

User Groups Tab (Tab only appears when editing)—Lists user groups to which the
user belongs. See Also: Assigning Users to User Groups on page 1106
l

Custom Tab—Lists any custom user properties. See Also: Creating Custom User
Properties on page 1108

Activities Tab (Tabs only appear when editing)
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NOTE: If you disable Notifications, the Activities tab (which lets the user pick Notifications to
receive and send) disappears.
l

l

Colleagues Sub Tab—Select the notifications you want to receive when a
colleague performs an activity, and the agent that transmits the notification. For
example, if you want to receive email notifications when a colleague posts a blog
message, you would place a check mark in the box for Blog Post in the email
column. See Also: Sending Notifications to a Community on page 1194
Community Groups Sub Tab—Select notifications you want to receive when a
member of a community group performs an activity relating to the group, and the
agent that transmits the notification. For example, you want to receive email
notifications when a community group member posts a blog message to group’s
blog. To enable this, place a check mark in the box for Group Blog Post in the
email column. See Also: Sending Notifications to a Community on page 1194
This tab sets preferences for all community groups.
For Developers:Ektron has created a UserGroupPreferences user control. If you
add the control to a community group’s profile page, users can specify notification
preferences for individual groups. This control comes with Ektron and is located in:
[Drive:]\webroot\siteroot\Workarea\Notifications\Controls

In this site, when a logged-in member of a community group accesses the group’s
profile page, there is an Edit Group Notifications Preferences link. Clicking this
link opens the user control. When you select your preferences, they are stored for
that group only.
l

My Activities Sub Tab—Select notifications you want publish when performing
various activities on the website. For example, if you want to publish notifications
when you post a blog message to your blog, place a check mark in the box for Blog
Post in the Publish column. See Also: Sending Notifications to a Community on
page 1194

Profile Links Tab—Lists The user's alias if community aliasing is set for users. See
Also: Creating User-Friendly URLs with Aliasing on page 835
4. Click Save.

Deleting Membership Users
1. From the Workarea, click Settings > Community Management > Memberships >
Users.
2. Check the boxes next to the users you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.

Searching for Membership Users
If there are many membership users, use the search to find users who meet your criteria. For
example, find members whose username includes @example.com. Only users with those
characters in that sequence in their username, first name, or last name appear. The search is
case-insensitive, so MI produces the same results as mi.
You can also search by First and Last name.
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Troubleshooting Problems with Membership Users
and Groups
If you get the following error:
Response object error 'ASP 0251 : 80004005'
Response Buffer Limit Exceeded
Increase the limit as follows:
1. Stop IIS.
2. Locate the file %WinDir%\System32\Inetsrv\Metabase.xml
3. Modify the AspBufferingLimit value. The default value is 4194304, which is about 4 MB.
Changing it to 20MB (20971520).
4. Restart IIS.

Membership Groups
You can use a membership group to group similar membership users, reducing the effort
required to assign identical permissions to many users.
IMPORTANT: Membership Groups and Community Groups are different concepts. Community Groups
allow users with similar interest to join together in a social networking environment. See Managing
Community Groups on page 1181. Membership User Groups are explained below.
To make friendly URLs that are easy to use and remember for a community user and group,
Ektron provides a Community URL Aliasing feature. Creating User-Friendly URLs with
Aliasing on page 835 for more information.
NOTE: Membership users may also be managed with Active Directory and LDAP. For more information,
see Authenticating Membership Users with AD or LDAP on page 1156.
PREREQUISITE
To work with membership users, you must be a member of the Administrators group
or assigned to the member admin role. See Also: Defining Roles on page 1120

Viewing Users in a Membership Group
1. From the Workarea, click Settings > Community Management > Memberships >
User Groups.
2. Click the membership user group you want to view. The View Users In Group screen
appears.
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Adding a Membership Group
1. From the Workarea, click Settings > Community Management > Memberships >
User Groups.
2. Click Add Membership Usergroup. The Add a New User Group screen appears.
3. Enter a unique name for the group, and optionally add a description.
4. Click Save.

Deleting a Membership Group
1. From the Workarea, click Settings > Community Management > Memberships >
User Groups.
2. Select the group you want to delete. The View user in Group screen appears.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.

Adding Users to a Membership Group
NOTE: Only membership users can be added to membership user groups.
1. From the Workarea, click Settings > Community Management > Memberships >
User Groups.
2. Click Add Membership User. The Add User to Group screen appears.
NOTE: Only membership users who do not already belong to the group appear.
3. Click the user you want to add.
4. Click Save. A confirmation message appears.

Deleting Users from a Membership Group
1. From the Workarea, click Settings > Community Management > Memberships >
User Groups.
2. Click the name of the membership user you want to remove. The View Users screen
appears.
3. Check the boxes next to the users you want to delete.
4. Click Delete ( ). A confirmation message appears.
5. Click OK.

Assigning Membership Permissions
After you create membership users and groups, you can assign them permissions for
Community folders only. See Also: Community Folders on page 1171
1. Access the permissions table for the content or folder to which you want to assign
membership permissions.
l
Content folders—Managing Folder Permissions on page 257
l
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2. If necessary, break the inheritance for the content or folder.
3. If desired, set the folder or item to Private. See Also: Making Content Private on
page 294
4. Click View Membership Users on the right side of the permissions table. The
membership users/user groups added to the permissions table appear.

5. Click Add. The Add Permissions screen appears.
6. Click a username or user group name to add to the permissions table. The Add
Permissions Options screen appears.
7. Check appropriate permissions for the membership user or group.
8. Click Save.

Assigning Templates to Groups and Members
Ektron's Community Management feature supports both community and individual member
pages. Like other Ektron content, Community Management content appears on a dynamic
Web page. Page templates determine each page’s layout and location of elements (menus,
content, blogs, and so on). The following samples show the Community Management
template.
Sample Group Template in Visual Studio.NET

Sample Group Template on a Web Page
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The Community Management feature includes six templates:
l

l

Community Group
o documents
o

photos

o

journal

User
o

documents

o

photos

o

journal

Ektron provides a sample for each template. You can use the sample or create your own. If
you begin with a sample template and modify it, be sure to save it under a different name to
prevent it from being overwritten when you upgrade.
Use the Workarea Settings > Community Management > Templates screen to assign
templates to Community Management pages.
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Group Templates
l

l

Community Document—Page hosts the CommunityDocuments server control;
ObjectType property is set to Group
Photo Gallery—Page hosts the PhotoGallery server control; ObjectType property is set
to Group

l

Journal—Page hosts the Blog server control, and the blog was created for a group page

l

Profile—Page that hosts a CommunityGroupProfile server control.
Note, however, that a site visitor, while viewing a page, may click an icon to visit a
community group profile from there.
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In this case, if the original control has a TemplateUserProfile defined, that value
overrides this field and defines the template in which the community group profile
appears.
User Templates
l

l

Community Document—Page hosts the CommunityDocuments server control;
ObjectType property is set to User
Photo Gallery—Page hosts the PhotoGallery server control; ObjectType property is set
to User

l

Journal—Page hosts the Blog server control, and the blog was created for a user page

l

Profile—Page that hosts a User Profile server control.
Note that a site visitor may click a user icon to visit a user profile from another page.
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In this case, if the original control has a TemplateUserProfile property value defined,
that value overrides this field and defines the template in which the user profile appears.
See the Server Control Reference on page 1636 for information about server controls.

Community Folders
Community folders resemble regular folders in most ways. The only difference is that
membership users can add and edit content in these folders only. Community folders have a
unique icon, which looks like 2 people (
).
Membership users add and edit Community folder content after signing in to the website.
They do not use the Workarea to add or edit content.
NOTE: Authorized Ektron users can also create and update Community folder content.

Creating a Community Folder
1. In Workarea > Content, go to the folder in which you want to create the community
folder.
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2. Select New > Community Folder. Alternatively, you can hover the cursor over the
folder, right click the mouse, and choose Add Community Folder.
3. Assign properties as you would any other folder. See Adding a Folder on page 247
NOTE: The folder properties screen lets you require metadata for any content item. However,
membership users cannot enter metadata. Therefore, this requirement is ignored when membership
users edit community folder content. If an Ektron user tries to edit that content, the user is required
to enter a metadata value.

Assigning Permissions for a Community Folder
Because Community folders are intended for membership users, this section explains how to
assign permissions for them. To assign folder permissions for regular users, see Managing
Folder Permissions on page 257.
1. Navigate to the folder.
2. Choose View > Properties.
3. Click View Permissions (

).

4. If necessary, uncheck the Allow this object to inherit permissions checkbox.
5. Click User Type: Membership Users.

6. Click Add Permissions.
7. Select the membership user or group to which you want to assign permission for this
folder.
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8. Check the permission boxes as appropriate.

Adding and Updating Assets as a Membership User
First, your developer must create a template, then drop an Asset server control onto it. While
adding the Asset Server Control, the developer specifies Add at the Upload Type property,
and the community folder to which the asset will be saved at the DefaultFolderID property.
When a membership user is authorized to add content navigates to the page with the server
control, the person sees an Asset control area like the one that appears when Ektron users
add assets. The user then can drag and drop assets into Ektron.

To update an asset, your developer adds the Asset Server Control, as previously described,
but specifies Update at the Upload Type property, and a community folder to which the
asset will be saved at the DefaultFolderID property. Then, the developer specifies an asset
ID number at the DefaultAsset ID property. Using that control, the membership user can
update the identified asset only.

Additional information about administering assets is found in Working with Assets in the
Document Management System on page 310.

Viewing and Editing Community Folder Content
When a user with Read-only or higher permission navigates to a page whose content is in a
community folder, the user can view it. If the user has edit permission, a menu appears.
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WARNING! Membership users can edit only HTML content and assets. They cannot edit other content
types (HTML forms, Smart Forms, and so on).
When a membership user clicks Edit (
editor.

), a new window displays the content within an

Other membership buttons are View History (

) and Log out (

).

This editor has fewer capabilities than Ektron’s editor. However, a membership user can
l

l
l
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add images and files via library ( ) if the membership user has Add Images and Add
Files permission. See Also: Working with the Library on page 333
add a wiki using page link( ). See Also: Using the Wiki Feature on page 1966
assign a taxonomy category to the content by clicking the Category tab. See Also:
Using Taxonomies on page 777

Ektron Reference

Accessing a User Profile

NOTE: The Category tab only appears if a Taxonomy is applied to the content’s folder.
l

replace the content summary with the first 40 words of the content, using the Auto
Generate New Summary check box. See Also: Automatically Creating a Summary on
page 293

When a membership user finishes editing, the user clicks Publish. If the content’s folder has
an approval chain, the content’s status changes to submitted, and the border color changes to
yellow. If there is no approval chain, the content is published immediately.

Accessing a User Profile
A profile stores and maintains information about a user.
l

l
l

An Ektron developer inserts a profile on a page using the UserProfile on page 1852
server control.
A membership user can access his or her profile page only from the website.
An Ektron user can access his or her profile from the Workarea or the website. Navigate
to Settings > Users. See Managing Users on page 1100
IMPORTANT: For Ektron users, some profile information in the Workarea’s View User
Information screen is not available on the website profile page. That information involves Workarea
settings.

l

An administrator can access user profiles from the Workarea. Navigate to Settings >
Community Management > Memberships > Users. See Membership Users and
Groups on page 1161

Moderating a Message Board
A Message Board can be moderated, which means that comments and replies must be
approved by an authorized user before they appear. Those users can either approve or delete
the comment/reply. To learn which users are authorized to moderate, see Who Can Moderate
Message Board? on page 1177.
You can force all message boards associated with a MessageBoard control to moderate
comments/replies. To do this, set theModerate property to True. On the other hand, you can
allow the Message Board owners to decide if it will be moderated. To do this, set the control’s
Moderateproperty to False. Then, users and community group administrators can set this
property in their user or group profile.
Users determine whether their Message Board is moderated by checking their profile’s
Moderate check box (see below).
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Community group members determine if the group's Message Board is moderated by editing
the Group Profile's Group MessageBoard Moderation check box.

NOTE: If a Group administrator submits a comment to a moderated Group Message Board, it is
automatically approved.
If a comment is submitted to a moderated Message Board, users who can see it notice a
green dot border. The user who submitted the comment sees an hour glass icon ( ) until it’s
approved. At any time, the user can delete the comment using the delete button (
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Who is Authorized to Comment and Reply to a

Who is Authorized to Comment and Reply to a
Message Board?
l

l

l

User
o the logged-in user
o

colleagues

o

users assigned to Message Board Admin role; See Also: Defining Roles on
page 1120

o

Administrators group member

Group
o group members
o

users assigned to Community Group Admin role; See Also: Defining Roles on
page 1120

o

Administrators group member

Content item
o anyone who can view the content
For example, if a content item is set to private, a user must have at least ReadOnly permission for the folder containing the content.

Who Can Moderate Message Board?
l
l

If you submit a comment or reply, you can view and delete it.
Any of the following can view, delete, and approve pending comments or replies.
o Administrator group members
o

If you or a group member owns the message board to which a comment or reply
was added.

o

Community group administrator

o

User that is assigned to a Message Board Admin role

Approving Message Board Comments
On a moderated message board, approval activity appears on the Approve tab. To approve a
single Message Board comment, an authorized user clicks Approve. An authorized user any
can approve several or allcomments at once. To select several comments, place a check next
to each, then click Approve. To select all comments, click Select: All then Approve.
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To approve comments from the Ektron Workarea:
1. Navigate to Settings > Community Management > Message Board.
2. A list of all unapproved comments appears. You can restrict the list using the drop-down.
3. Place a check next to comments you want to approve. To select all comments, check the
box next to Messages in the header row.
4. Click Approve.

Deleting Message Board Comments
To delete a single comment, find the comment and click Delete.
Deleting unapproved comments from Workarea:
1. Navigate to Settings > Community Management > Message Board.
2. A list of all unapproved comments appears. You can restrict the list using the drop-down
shown below.
3. Select the comments that you want to delete. To select all comments, check the box next
to Messages in the header row, as shown below.
4. Click Delete ( ).

Replying to Message Board Comments
Users can reply to comments on a user’s, community group’s, or content item’s Message
Board. For community groups, the group must be public and not restricted; otherwise, only
group members can reply.
NOTE: To learn which users are eligible to reply to Message Board comments, see Who is Authorized to
Comment and Reply to a Message Board? on the previous page
If you are in a load-balanced environment, the same reply may appear several times. If this problem
occurs, stop the Ektron notification service on all but one of the servers in the cluster.
To add a reply, click Reply (

) in a comment’s lower right corner (circled below).

Next, a dialog box displays the original comment and a Reply field.
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When the reply is submitted, a Replies link appears below the comment. The number of
replies appears next to the link.

Click the link to view comments. They are arranged from oldest at top to newest at bottom.

Like comments, if the message board is moderated, replies must be approved before
everyone can see them.

Enabling Message Board Notifications
You can send email notifications to Message Board owners and community group members
whenever someone posts a comment to a board. If a comment is posted to a community
group’s Message Board, all group members are notified.
IMPORTANT: Users' profiles must include a valid email address to receive email notifications.
You can turn this feature on or off in the siteroot/web.configfile. By default, the feature is
turned off. To turn it on, open theweb.configfile and set the following key’s value toTrue.
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<add key="ek_EnableMessageBoardEmail" value= "False"/>

NOTE: Message Board notifications are sent from the same email address as the invite system.
When activated, this feature applies to all user and community group message boards.

Filtering Spam
Ektron lets you filter spam from your message boards. Ektron defines spam filtering as
setting the following limits in MessageBoard server control’s SpamControlType property:
l

l

l

l

SameUserSameMessageSameDay—Prevent a user from posting the same comment
more than once a day.
SameUserTimeDelay—set the SpamTimeSpan property to 1800 to prevent a user from
posting any other comment for 30 minutes.
SameMessageTimeDelay—set the SpamTimeSpan property to 7200 to prevent a user
from posting identical comments for 2 hours.
Custom (and add the code to the code-behind page of the template containing the
MessageBoard on page 1786 server control)—Use your own spam filter code.

You can create your own spam filter in the code-behind of the page that hosts the Message
Board. To do this, set the SpamControlType property to Custom, call the CustomSpamMethod
in the page load event, and point it to your custom spam filter method. Your method’s
signature must include the following parameters:
l
l

l

l
l

long objectId—the numeric ID of the object defined in the object type
Ektron.Cms.Common.EkEnumeration.MessageBoardObjectType objectType—the type
of object with which the Message Board is associated.
long userId—the numeric ID of a user. For example, you want to block a user with the
ID 18 from posting to the board.
string messageText—a string of text you want to block
int interval—the amount of time, in seconds, to block posting on the Message Board.
For example, if you want to block a user from posting for 30 minutes, set this property to
900.

The following C# example blocks the text Hello World.
using System;
using System.Data;
using System.Configuration;
using System.Collections;
using System.Web;
using System.Web.Security;
using System.Web.UI;
using System.Web.UI.WebControls;
using System.Web.UI.WebControls.WebParts;
using System.Web.UI.HtmlControls;
public partial classWebformCB : System.Web.UI.Page
{
protected void Page_Load(object sender, EventArgs e)
{
this.MessageBoard1.CustomSpamMethod(SpamControl);
}
private bool SpamControl(long objectId,
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Ektron.Cms.Common.EkEnumeration.MessageBoardObjectType
objectType, long userId, string messageText, int interval)
{
if (messageText == "Hello World")
{
return true;
}
return false;
}
}

Associating Message Board Comments with Content
in the Workarea
Message Board comments can be associated with content. This allows a user who views the
content on the site to add comments about the content.
NOTE: Message Boards can also be associated with users and groups. See Also: MessageBoard on
page 1786 server control.
Message Board comments are not the same as the Comments tab on the View Content screen.
You can view these comments in the Workarea.
1. Click the Content folder button.
2. Navigate to the content block for which to view messages.
3. Click that content item. The View Content screen appears.
4. Click View Content Reports (

).

5. Click the Messages tab. A list of comments associated with the content appears.

Managing Community Groups
IMPORTANT: Membership User Groups and Community Groups are different concepts. Membership
User Groups let an administrator create a group of membership users, thereby reducing the effort required
to assign identical permissions to many users. See Membership Groups on page 1165. Community
Groups are explained in this section.
Community groups are another aspect of a community sites. Group members can easily meet
people with similar interests, such as car racing for example.
Groups have similar features and functions to user features. For example, a community
group can have a Message Board, Discussion Board, maintain a membership list, and keep a
group journal. You can manage community groups from the website or the Workarea.
You can assign a taxonomy category to community groups so that users can browse and
search for groups by category. You also can assign Tags to a community group which lets
users find the group when searching by tag name.
You can access community group information in the following areas of the Workarea:
l

My Workspace > Community Groups—displays groups to which you belong; also
lets you remove yourself from them.
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l

Workarea > Settings > Community Management > Community Groups—
displays all groups. You can define a group’s details or add and remove members from
the group when you are:
o a Group’s Leader (Group’s Administrator)
o

an Ektron Administrator

o

an Ektron user or Membership user with the Community Group Admin or
Community Group Create role

To view a list of all community groups in the Workarea, click the Settings > Community
Management > Community Groups.
The following server controls are associated with community groups:
l

l

l

l

CommunityGroupBrowser on page 1688—lets you browse a taxonomy structure for
community groups
CommunityGroupList on page 1691—displays a list of community groups, sorted by
name, newest, most popular, and so on.
CommunityGroupMembers on page 1695—lets you display a list of group members, as
well as those who have been invited to join or requested to join the group
CommunityGroupProfile on page 1698—lets you display the group profile

Viewing a Community Group’s Details
Any user with access to the Workarea can view a group’s details. However, they cannot see
the members of the group. If a person is the Group Leader (Group’s Administrator), an
Administrator, or Ektron User with the Community Group Administrator role, that person can
edit the group’s information, add and remove members, or delete the group.
1. Click Settings > Community Management > Community Groups.
2. Click Group Name. The group’s detailed information appears.

Viewing Community Group Members
Only the Group Leader (Group’s Administrator), Administrators or Ektron Users with the
Community Group Administrator role can view members of the group. In addition to viewing
community group members, you can see add and remove members. You can also accept or
decline members’ requests to join the group if the group’s membership is set to Restricted.
1. Click Settings > Community Management > Community Groups.
2. Click on a group name.
3. Click View Community Group Members (

). A list of group members appears.

Adding or Editing a Community Group
1. Click Settings > Community Management > Community Groups.
2. If you are adding a new group, click Add New Community Group. If you are editing a
group, click on the group name and then click Edit This Community Group.
l
Group Name—The name of the group.
l
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Community Group Admin role also have these privileges. By default, the person
who created the group is the group administrator. Click Browse to change the
administrator.
l

Membership—Select whether the group is Open (anyone can join) or Restricted
(only invited members can join). See Also: Accepting/Declining Requests to Join a
Community Group on page 1185
NOTE: Restricted groups can be found in the same way that open groups can. Also, their
activities are published as notifications. For example, Tom posted a reply to the
forum topic titled 'RoboTech Acquisition'. So, do not create a group or publish
activities that you want to keep secret.

l

l

Features: Create Group Calendar—Click inside this circle if you want to allow
the group administrator to create a group calendar. See Also: Creating a Calendar
in a Group on page 523
Features: Create Group Forum—Click inside this circle if you want to allow the
group administrator to create a group forum. See Also: Using Discussion Boards in
Community Groups on page 573

l

Image—Upload an image to use as an avatar for the group.

l

Location—The geographical location of the group.

l

Short Description—A brief description of the group.

l

Description—A fully detailed description of the group.

l

l

l

l

l
l

l

l

Enable Distribute—Check this box if you want the group and system
administrator to be able to distribute content to any Ektron folder. See Also:
Distributing Content to Another Ektron Folder on page 1188
Allow member to manage photo/workspace folders—Check this box to allow
members to add, remove and control the sharing of folders in a community group’s
Photo Gallery or Document’s Workspace. See Also: Allowing Community Group
Members to Work with Folders on the next page.
Group MessageBoard Moderation—Check this box if you want this Message
Board to be moderated. That is, comments and replies must be approved by an
authorized user before they appear. See Also: MessageBoard on page 1786
Attach Documents in Email Notifications—Check this box if you want set up
activity message attachments for a community group. See Also: Step 6: Enable
Attachments to Notifications on page 1227
Group Email—Check this box to allows emails to be sent to the group.
Group Tags (Tags tab)—From this screen, you can either create a new tag or
select from a default list of community group tags. See Also: Assigning a Tag to a
Community Group on page 1186
Category List (Categories tab)—The categories tab lists all of taxonomy
categories associated with the community group. If you have not defined at least
one taxonomy for community groups, this tab does not appear.See Also: Creating a
Taxonomy on page 780
Links Tab—Displays the group's alias if aliasing is set for community groups. You
can click the alias to view the community group page. See Also: Creating UserFriendly URLs with Aliasing on page 835

3. Click Save.
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After you create a group, you can add members to it. See Also: Adding Members to a
Community Group below and Managing Community Groups on page 1181
NOTE: The CommunityGroupBrowser server control also has a Create Group link, which lets you create
a community group from the website. See Also: CommunityGroupBrowser on page 1688 server control

Deleting a Community Group
Only the Group Administrator, Ektron Administrators, or Ektron users with the Community
Group Administrator role can delete a group.
1. Click Settings > Community Management > Community Groups.
2. Click a group name.
3. Click Delete This Community Group ( ).

Adding Members to a Community Group
Only the Group Leader (Group’s Administrator), Administrators or Ektron Users with the
Community Group Administrator role can add members to a group.
1. Click Settings > Community Management > Community Groups.
2. Click on a group name.
3. Click View Community Group Members (
for the group screen appears.

). The View Community Group Members

4. Click Add User(s) to Community Group. The Add Members screen appears.
5. Using the drop-down box, select the type of name (Display name, Last name, First
name, Username) for which to search.
6. Enter a name in the text box.
7. Click Search. The results are returned.
NOTE: If you leave the text box blank and click Search, all results for the name type are returned.
8. Place a check mark in the box next to each member to add.
9. Click Add Selected User(s) to This Community Group.

Removing Members from a Community Group
Only the Group Leader (Group’s Administrator), Administrators, or Ektron Users with the
Community Group Administrator role can remove members from a group.
1. Click Settings > Community Management > Community Groups.
2. Click a group name.
3. Click View Community Group Members (
for the group screen appears.

). The View Community Group Members

4. Place a check mark in the box next to members you want to remove.
5. Click Remove from Community Group (

).

Allowing Community Group Members to Work with
1184

Ektron Reference

Allowing Community Group Members to Work with

Folders
When you associate the CommunityDocuments or PhotoGallery server control with a
community group, you can let members of the group add, remove, and control the sharing of
folders in these controls.
1. In the Workarea, navigate to Settings > Community Management > Community
Groups.
2. Click a community group.
3. Click Edit This Community Group.
4. Check the Allow member to manage photo/workspace folders check box.
5. Click Save.

Accepting/Declining Requests to Join a Community
Group
If a group’s membership is set to Restricted (on the Community Group screen), users must
request to join the group. (If membership is Open, users join a group immediately.) In the
Workarea, use the Pending tab on the View Community Group Members screen to accept or
decline a user’s request to join a group.
Only a Group Administrator, Ektron Administrator, or Ektron users with the Community Group
Administrator role can do this.
NOTE: On the eIntranet's groups page, a special tab flags users who requested to join a group. The
administrator can click the plus sign in the top left corner to admit the user to the group.
To accept or decline a member's request to join a group in the Workarea:
1. From the Workarea, go to Settings > Community Management > Community
Groups.
2. Click the group for which you want to accept or decline requests to join.
3. Click View Community Group Members (

).

4. Click the Pending tab.
5. Check the box next to each member whose request you want to approve or decline.
l
To approve the request, click Approve.
l

To decline the request, click Decline.

Searching for a Community Group
You can search for a Community Group in the Workarea by using the Search box on the View
All Community Groups page (circled below).
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To search for Community Groups, click Settings > Community Management >
Community Groups. Enter text in the search box and press Enter. Community Groups that
match the search term appear.

Assigning a Tag to a Community Group
On the website, Tag information for a group appears in the Group’s profile. In the Workarea,
Tag information is on the View Community Group’s > Tag tab. From this tab, you can either
create a new tag or select from a list of group tags.
1. In the Workarea, go to the Settings > Community Management > Community
Group.
2. Click the community group for which to create a new tag.
3. Click Edit This Community Group.
4. Click the Tags tab.
5. Click Add Tag.
6. Add a tag to the Name text box.
7. Select a language.
8. Click Save.
When the Tag is saved, it appears in the Group Tags area with a check mark in the check box,
which means the tag is active for the community group. If you have several tags, use the
check boxes to choose the default tags that you want associated with the group.

Using Discussion Boards for Community Groups
You can use the Discussion Board feature within a community group to provide Web-based
discussions on topics of interest to a group. To use this feature, each group must add the
Discussion Board for their group into the database before posts can be added. To do this, see
Using Discussion Boards for Community Groups above.
Group discussions may include these topics:
l

project requirements

l

scope and scheduling

l

team issues

l

frequently asked questions

The following image shows a discussion board on a community group page.
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Using Calendars for Community Users and
Groups
Ektron's Web Calendar provides the same function as a paper calendar—it keeps visitors
informed about upcoming events. Combined with the powerful community features of the
Ektron platform, the calendar enhances communication between individuals and groups. To
use this feature, each group must add Calendar into the database before events can be
added; see Creating a Calendar in My Profile on page 522.
Communities calendars events could include
l

personal vacations

l

special personal occasions

l

group milestones

l

group meetings

The following image shows a calendar on a personal profile page.
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Distributing Content to Another Ektron Folder
Ektron supports the distribution of a community document to any CMS folder. For example,
your Marketing Department uses the Community Documents server control to create and edit
content. After completing a press release, they use the Distribute menu option to copy it
from the private collaboration folder to a public content folder. When there, the document can
pass through an approval chain or be published immediately.
The Distribute option can insert new content or overwrite existing content in any folder.

Enabling the Distribute Option
Only a member of the Ektron Administrators group can enable the Distribute option. Do this
for every community group that will use it. You can do so from the Workarea or after logging
in to the website.

From the Workarea
1. From the Workarea, go to Settings > Community Management > Community
Groups.
2. Click the group for which you want to enable the Distribute option.
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3. Click Edit.
4. Check the Enable Distribute check box.
5. Click Save.

From the Website
1. Log in to a site that uses the Community Management features as a CMS administrator
or a Group Administrator.
2. Navigate to a Web page that hosts a Group Profile page.
3. Click Edit Group.
4. Check the Enable Distribute check box.
5. Click Save.

Distributing a Community Document
WARNING! After a community document is distributed the first time, the original document is forever
linked to the destination document. You cannot break the link.
PREREQUISITES
l

l
l

You log in as one of the following
o Administrator of the group whose documents are being distributed
o

Ektron user assigned Community Group Administrator role for that group

o

CMS administrator

The content’s status is Approved.
You have permission to add, delete, and restore content to the destination folder.
(If you do not, the folder doesn’t appear on the folder selection screen.) See
Also: Managing Folder Permissions on page 257

Distributing a New Community Document
When you distribute a community document that does not exist in Ektron for the first time,
you identify a destination folder and, if required, metadata and taxonomy categories. This
information is collected through a series of screens that guide you through the process.
1. Log in to the website that contains content you want to distribute.
2. Navigate to the Web page that contains content you want to distribute.
3. Click the triangle to the right of the content or asset you want to distribute.
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4. Click Distribute from the drop-down menu. The following screen appears.

5. Click in the top box, which begins I want to distribute a copy of this item. The
following screen appears.

6. Select the folder to which you want to distribute the content and click Next. The
following screen appears if metadata or a taxonomy category is required for the folder.
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7. Enter any required metadata or taxonomy. A confirmation message appears.
8. Click Done. Ektron copies the selected document to the designated folder.

Distributing and Overwriting a Community Document
NOTE: This process only occurs the first time you overwrite a document. For a description of subsequent
updates, see Distributing Content After the First Distribution on page 1193.
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During this procedure, you identify a destination folder and content to be replaced. Because
the content’s type that you are distributing must match the content being replaced, you only
see content whose types match.
Upon replacing, any metadata and taxonomy categories applied to the existing content are
applied to the new. Also, the content title and ID number from the existing content are
maintained—they are not replaced by the title and ID number of the new content. Finally, the
existing content’s summary is maintained and can be edited if needed.
1. Log in to the website that contains the content you want to distribute.
2. Navigate to the page that contains that content.
3. Click the triangle to the right of the document you want to distribute. Distribute appears
on the drop-down menu.
4. Click Distribute. The following screen appears.
NOTE: The following screen only appears the first time you overwrite a file. To overwrite the file
subsequently, see Distributing Content After the First Distribution on the facing page.

5. Click the lower box, which begins I want to replace an existing item. The following
screen appears.
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6. Navigate to and select the content you want to replace. Only content whose type
matches the document you selected appears.
7. Click Next. A confirmation message appears.
8. Click Done.

9. Ektron overwrites the selected document with the one you selected.

Distributing Content After the First Distribution
If you later try to Distribute the same document (whether you added a new document or
overwrote an existing one), a screen like the following appears.
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If you really must distribute the document to another folder, delete the document in the
destination folder. This action breaks the link between documents. When the link is broken,
you can distribute the document to another folder.
To copy the latest version of the document to the distribution folder, click the gray box whose
text begins I want to redistribute... However, you cannot distribute the document to
another folder. (If you want to do so, first delete the document from the destination folder.
Then, you can use either procedure to distribute the document to any folder.)
When distributing content after the first time, its metadata and taxonomy categories appear
on the Metadata/Category screen by default. You can change them if desired.
As with the replace option, the existing content’s title and ID number are maintained -- they
are not replaced by the new content’s title and ID number. And, the existing content’s
summary is maintained and can be edited if needed.

Sending Notifications to a Community
Notifications help you build a tighter, more robust community. They drive users to your site
by notifying them of a recent event, then directing them to the affected page.
Ektron's notification system creates and transmits a notification message to recipients
through various agents, based on Ektron activities. The activities may be performed by a
community group, membership user, or an Ektron user. For example, a membership user
wants to notify colleagues whenever a documented is uploaded to the profile page. When this
occurs, an Ektron event is triggered, which causes a notification agent to send an email to the
person's colleagues.
The following overview of the notification system is for developers and database
administrators:
1. A user performs an activity in Ektron.
2. Ektron raises a corresponding event.
3. The activity’s data is written to the Activity table in the database.
4. Activity information is sent to the activity queue.
5. Ektron verifies that the notification system is enabled.
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6. The notification service gets a list of users who signed up to be notified about that
activity when performed by that user. That list also includes the agents that send the
message (for example, email or SMS).
7. The notification service gets the message associated with the activity, formats it, and
sends it to the appropriate Notification agents.
8. Notification agents send the message to users compiled in Step 6.
Users can decide:
l

which activities should send a Notification to their colleagues or community groups

l

which Notifications they want to receive from colleagues and community groups

Conditions for Notification Messages
l

l

l

Notifications must be turned on in Workarea > Settings > Community
Management > Notifications > Settings.
A message for the activity must be enabled in Workarea > Settings > Community
Management > Notifications > Messages. (By default, a message is enabled for
each activity.)
A user who wants to receive notifications must enable each type of Notification for each
agent in the profile’s Activities tab.
NOTE: A user's profile Activities tab has a Community Groups subtab, which lets the user set
notification preferences for all community groups. To refine preferences further, a user can access
the profile of any community group and click Edit Group Notification Preferences to set
preferences for that particular group.

l

l
l

The user performing the action must allow the Notification to be generated by enabling it
on the profile’s Activities tab.
To receive notifications for another user’s activities, you must be colleague of the user.
To receive notifications for another user’s activities, a community group’s activities, you
must be a group member.
NOTE: The above points regarding message recipients are general. For specific details about which
recipients receive notification messages, see Notification Message Recipients on the next page

l

The Notification system respects Ektron’s content permissions. As a result, contentrelated Notifications are only sent to users with at least read-only permission for the
content. See Also: Managing Folder Permissions on page 257
For example, Julia adds content to an Ektron folder for which her colleague, Tyler, does
not have permission. Tyler is not notified when content is added, even though he signed
up to be notified about colleagues’ activities.
However Kristin, another colleague who has permission to edit the folder’s content and
who signed up to be notified about colleagues’ activities, does receive Notification of that
event.
Similarly, private content is only viewable by authorized Ektron users or membership
users with at least Read-Only permissions for its folder.

Triggering a Notification Message
Ektron 8.7
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The following list shows the standard activities that can trigger a notification message, and
the Activities sub-tab on which they can be enabled or disabled.
C—Colleague Action (available of Colleagues sub-tab)
G—Community Group Action (available on Groups sub-tab)
U—User Action to Notify Others about (available on My Activities sub-tab)
l

Add Colleague (C, U)—user adds a colleague

l

Add/Edit Group Content (G, U)—user uploads content to community group Workspace

l

Add/Edit User Workspace Content (C, U)—user uploads content to a profile

l

Add Site Content (C, U)—user adds content to Ektron

l

Add/Update Site Calendar Event (C, U)—event is added or changed on site Calendar
Add/Update User Calendar Event (C, U)—event is added or changed on user Web
Calendar

l

Add/Update Group Calendar Event (G, U)—event is added or changed on Web
Calendar

l

l

Add User Workspace Content (C, U)—user uploads content to a profile

l

Blog Comment (C, U)—user comments on a blog post

l

Blog Post (C, U)—user posts to a blog

l

Community Group Forum Post (G, U)—user posts to forum

l

Community Group Forum Reply (G, U)—user replies to forum post
Content Messageboard Post (C, U)—user posts to a message board associated with
content

l

l

Create Community Group (C, U)—user creates a community group

l

Edit Content (C, U)—user edits content

l

Forum Post (C, U)—user posts to a Forum

l

Forum Reply—user replies to a Forum post

l

Group Blog Comment (G, U)—user comments on a community group’s blog post

l

Group Blog Post (G, U)—user posts to community group blog

l

Group Messageboard Post (G, U)—user posts to a community group message board

l

Join Community Group (C, U)—user joins community group

l

Micro-message (C, U)—user posts micro-message
User Messageboard Post (C, U)—user posts to a message board associated with a
user

l

Notification Message Recipients
The following table connects Notification message activities with users who receive the
notification.
PREREQUISITES
l

l
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users performing the activity must have the Publish check box checked for the
activity in their profile
users being notified must have the Activity Stream, SMS, or email box
checked for that activity in their profile
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Activity that Triggers Message

Users who receive
notification
l

Add Colleague—user adds a colleague
l

Add Group Content—user uploads content to community group Workspace

colleagues of
user who adds
added colleague

Community group
members
Depends on folder’s
share setting, which
can be
l

l

Add/Edit User Workspace Content—user uploads content to the user profile

l

l

Public—all
colleagues
Colleagues—all
colleagues
Selected
colleagues See
Also: Server
Control
Reference on
page 1636
Private—no
email

Add Site Content— user adds content to Ektron

User's colleagues

Add/Update Site Calendar Event—event is added or changed on site Web
calendar

User's colleagues

Add/Update User Calendar Event—event is added or changed on site Web
calendar

User's colleagues

Add/Update Group Calendar Event—event is added or changed on site Web
calendar

Community group
members

Blog Post—user posts to the user's blog

User's colleagues

Content Messageboard Post—user posts to a message board associated
with content

Users who have permission to view the
content
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Activity that Triggers Message

Users who receive
notification

Create Community Group—user creates a community group

Colleagues of user
who creates group

Edit Content—user edits content

User's colleagues

Edit Group Content—user edits community group content

Community group
members
l

Forum Post—user posts to a Forum

l

Forum owner
and owner's
colleagues

Forum Reply—user replies to a Forum post

Posting user's
colleagues

Group Blog Comment—user comments on a community group’s blog post

Community group
members

Group Blog Post—user posts to community group blog

Community group
members

Group Messageboard Post—user posts to a community group message
board

Community group
members
l

Join Community Group—user joins community group
l

Micro-message—user posts micro-message

User Messageboard Post—user posts to a message board associated with a
user

User or Community Blog Comment—user comments on a blog post
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Community
group members
Colleagues of
user who joined

User's colleagues
l
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Posting user's
colleagues

l

colleagues of
user who posts
message board
owner and the
owner's
colleagues

Posting user's
colleagues

Setting Up Notifications

Setting Up Notifications
This section shows how to set up email notification to alert a user when someone uploads a
document to the Workspace.

Setting up Ektron to Send Notifications
An Ektron Administrator performs these steps.
NOTE: For this example to work, Ektron must be set up to send emails. See Installing Ektron on page 9.
1. Navigate to Settings > Community Management > Notifications > Settings.
2. Verify that Notifications can be published. If not:
a. Click Edit.
b. Click the Publish Notifications check box.
c. Click Save.

3. Make sure the email agent is enabled by navigating to Settings > Community
Management > Notifications > Agents.
a. If the Ektron Email agent does not appear in the list of agents, click Add Agent.
b. Select EktronEmail from the Name drop-down.
c. Click the Enabled check box.
d. Click Save.

4. Ektron provides a standard Notification message that is sent when you add content to
your Workspace. The message’s name is User Workspace Content Added. Optionally
edit the message.
a. Navigate to Settings > Community Management > Notifications >
Messages.
b. Click User Workspace Content Added.
c. Click Edit.
d. Update the email’s subject in the Subject text box.
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e. Edit the message in the text editor using a combination of Tokens and text:
The document @Content.Title@ was added to @SubjectUser.UserName@’s Workspace.

f. If you want SMS type messages, create a shorter version of the message in the
Plain Text text box.
5. If you want to enable SMS messages, do the following:
l
Configure the SMS Agent in the web.config file. See Setting Up SMS on page 1212
l

l

Inform users receive SMS messages to perform the verification step on a cell
phone.
Inform users to check the SMS column on the notifications page for Activities by
Colleagues.

6. Click Save.
From now on, an email is sent whenever you upload a document to your Workspace to
colleagues who signed up to receive them.

Enabling Notification Publishing
You must enable the Add User Workspace Content activity in your profile so that
whenever you add content to your Workspace, a notification is sent.
1. Log into the site.
2. Navigate to your profile page.
3. Click EditProfile.
4. Click the Activities tab.
5. Click the My Activities sub tab.

6. Click the Add User Workspace Content check box.
7. Click Save.

Receiving Notifications
1200
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Receiving SMS Messages on Your Cell Phone

You must enable the receipt of notifications that are sent whenever colleagues upload an item
to their Workspace.
1. Log into the site.
2. Navigate to your profile page.
3. Click EditProfile.
4. Click the Activities tab.
5. Click the Colleagues sub tab.

6. Click the Add User Workspace Content check box in the Email column.
NOTE: If you want to receive SMS messages, also check the box in the SMS column.
7. Click Save.

Receiving SMS Messages on Your Cell Phone
NOTE: The following procedure requires that your website has the template
SMSAgentSettings.aspx. If it does not, you may copy it from the Ektron Developer starter site, or the
Ektron eIntranet site.
1. Go to the website page: http://<host>/SMSAgentSettings.aspx.
2. Enter a phone number and carrier.
3. Click Save. Within a few minutes, you will receive a verification code on your phone.
4. Enter the code into the Verification Code field.
Ektron 8.7
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5. Click Verify. The page shows that the account is verified. You can begin receiving SMS
notification messages on your phone.

Setting Default Notification Preferences
Ektron provides a default set of Notifications that apply to all newly-created users. After a
user is created, the use can change the preferences by editing the profile, selecting the
Activities tab, and checking or unchecking activities and agents. Similarly, a community
group member can access any community group profile and click Edit Group Notification
Preferences to set the group's preferences. You can apply 3 types of default settings via
screens on the Workarea Settings tab.
l

l

Colleagues—Activities involving colleagues that the logged-in user wants to be notified
about
Community Groups—Activities involving community groups that the logged-in user
wants to be notified about
NOTE: The Community Groups subtab sets notification preferences for all community groups. To
refine preferences further, a user can access the profile of any community group and click Edit
Group Notification Preferences to set preferences for that particular group.

l

My Activities—Activities involving the logged-in user to display to colleagues and
community group.
NOTE: The Activities tab appears only after the user is registered and if the Workarea > Settings >
Community Management >Notifications > Settings > Publish Notification setting is checked.

NOTE: Activities are checked for the Activity Stream agent by default. No activities are checked for the
other agents by default.
1. Log in to the Workarea as an administrator.
2. Navigate to Settings > Community Management > Notifications > System
Default Preferences > Colleagues.
3. Click Edit.
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4. Place a check mark next to each a default notification.
5. Click Save.

Raising a Custom Activity
Ektron's Notification system lets you create and raise your own activity types. Custom
activity types can generate notifications, just like standard activity types.
1. In the Workarea, go to Settings > Community Management > Notifications >
Activity Types.
2. Click Add Activity Type. The Add Activity Type screen appears.

3. Enter a unique name.
4. Select an Action Scope.
l
User—an activity raised by users; their colleagues are notified
l

CommunityGroup—an activity raised by a community group user; group
members are notified

5. Save the screen. The following image shows a sample custom activity on the View All
Activity Types screen.

6. Interested users go to their User Profile screen’s Activities tab where they indicate if
they want be notified when the custom activity occurs, and if they want to notify others.
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7. To raise a custom activity, call the
Ektron.Cms.Framework.Activity.Activity.Publish method. The method takes an
ActivityData class. You supply the following:
l
the Id of the Activity Type you want to raise (1001 in this example)
l

the user causing the activity

l

a message
NOTE: Custom activity types cannot use Community Management messages as the
standard Ektron activities do.
Here is an example of that method.
Activity activityApi = new Activity();
ActivityUserInfo user = new ActivityUserInfo();
user.Id = activityApi.UserId;
ActivityData activityData = new ActivityData();
activityData.ActionUser = user;
activityData.ActivityTypeId = 1001;
activityData.Message = "John Doe just rated Ektron a buy!";
activityData.LanguageId = 1033;
activityApi.Publish(activityData);

When publish is called, the notification service notifies users who signed up to be
notified of this activity.

Working with Notification Agents
A notification agent is a component that sends notification messages. Each Agent is
responsible for sending notifications to users when Ektron activity occurs. How that
notification is sent is up to the Notification Agent itself. When a Notification Agent is created
and registered, users can begin setting up notification preferences that use it.
Ektron has predefined Notification agents, including email, SMS, and Activity Stream agents.
l

l
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SMS Notifications are sent to a cell phone or another device that receives SMS
messages. See Also: Setting Up SMS on page 1212
Activity stream Notifications are posted via the ActivityStream server control. See Also:
ActivityStream on page 1638
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l

email Notifications are delivered to appropriate recipients inboxes. See Also: Setting Up
Email to Communicate Community Activities on page 1223

You can customize these providers or create your own using the extendable Notification agent
architecture.

Enabling or Disabling an Agent
NOTE: Ektron’s predefined agents are enabled by default.
1. Log in to the Workarea as an administrator.
2. Navigate to Settings > Community Management > Notifications > Agents.
3. Click the name of an agent.
4. Click Edit.
5. Check (or uncheck) the Enabled check box.
6. Click Save.

Creating a Custom Agent
Ektron comes with several standard Notification Agents, including email, SMS, and Activity
Stream. You can customize these agents or create your own using the extendable Notification
Agent provider architecture. This section explains how to extend the object model to build a
customized Notification Agent.
Each type of Notification Agent accepts configuration parameters. For example, email and
SMS require an SMTP server, username, and password. These parameters can be specified in
the web.config file, and read when the Agent is initialized the first time.
Each agent may also require storing settings for each user receiving notifications. For
example, the SMS agent requires the user’s cell phone number and carrier, which it stores as
an SMS email address. To save these properties, each Notification Agent has an associated
NotificatAgentSettingsData class. This class defines any properties needed to be supplied by
the user. Ektron provides APIs for storing and retrieving this information, but the developer
must create an interface for users to supply the information. The SMSAgentSettings.aspx
page, supplied with the Developer and Intranet starter sites, provides a good example.

Implementing Your Own Notification Agent Provider
Object Model
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The NotificationAgent is the abstract base class you must extend to implement your own
notification agent. Details on the class, available properties, and methods you are required to
implement are below.
l

virtual void Initialize(string name, Amenable config);
The initialize method comes from the ProviderBase base class. It supplies all name value
pairs specified in the Providers web.config section.
If custom settings need to be provided to your agent, add them to your provider’s
web.config key, and they will be provided to you at runtime in the Initialize method. If
you have no custom settings, this class does not need to be overridden.

l

abstract NotificationAgentSettingsData GetAgentSettings();
This method should return a new instance of the NotificationAgentSettingsData class
associated with your Agent.

l

abstract void Send(NotificationMessageData message);
This method should send the actual notification. It will be called by the notification
engine for each user that needs to be notified.
The NotificationMessageData has all the information you need for sending the
notification, including
o

the message itself

o

the user to be notified

o

the NotificationAgentSettingsData for the user to be notified.

If your agent has a custom NotificationAgentSettingsData, you need to cast the supplied
NotificationAgentSettingsData to the appropriate type so that you can access the
appropriate properties.

Adding a Custom Agent
1. Insert the provider between the Notification agent’s providers tags in the
siteroot/web.config file.
<notificationAgent>
<providers>
<add name="CustomAgent1"
type="Ektron.Cms.Notifications.Providers.CustomAgent1,
Ektron.Cms.Providers" setting1="" setting2=""/>
<add name="EktronEmail"
type="Ektron.Cms.Notifications.Agents.EktronEmailAgent,
Ektron.Cms.BusinessObjects" useSystemSettings="false"
smtpServer="amh010" smtpPort="25" userName="" password=""
fromEmail="admin@example.com"/>
<add name="SMSAgent"
type="Ektron.Cms.Notifications.Agents.SMSAgent,
Ektron.Cms.BusinessObjects" smtpServer="amh010" smtpPort="25"
fromEmail="SMSAgent@example.com" validationRequired="true"/>
<add name="ActivityFeed"
type="Ektron.Cms.Notifications.Agents.ActivityFeedAgent,
Ektron.Cms.BusinessObjects" validationRequired="false"/>
</providers>
</notificationAgent>
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After you add an agent to web.config, it appears in the list of available agents in the
Workarea.

2. Log into the Workarea as an administrator.
3. Navigate to Settings > Community Management > Notifications > Agents.
4. Click Add.
5. Select the custom agent from the Name drop-down box.
NOTE: If you do not see the custom agent in the Name drop-down, check theweb.config file to
verify it is listed between the <notificationAgent> tags.
6. Place a check mark in the Enabled check box.
7. Click Save.

Removing an Agent
When you no longer need an agent, you can remove it. This can be a 2 step process,
depending on the level of removal you are trying to achieve. First, remove the agent from the
list of agents in the Workarea. At this time, you can easily return the agent to the list. In the
second step, you remove the agent from the web.config file.
1. Log in to the Workarea as an administrator.
2. Navigate to Settings > Community Management > Notifications > Agents.
3. Click the title of the agent.
4. Click Delete ( ).
5. In the Delete Agent dialog box, click OK. The page refreshes, and the agent is removed
from the agents list.
NOTE: To completely remove the agent from Ektron, follow these additional steps.
6. Open the site root folder’s web.config file.
7. Between the <notificationagent>’s <providers> tags, remove the agent. The
following example shows agents that might appear in the web.config file.
<notificationAgent>
<providers>
<add name="CustomAgent1" type="Ektron.Cms.Notifications...
<add name="EktronEmail" type="Ektron.Cms.Notifications...
<add name="SMSAgent" type="Ektron.Cms.Notifications...
<add name="ActivityFeed" type="Ektron.Cms.Notifications...
</providers>
</notificationAgent>
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Managing Notification Messages
Messages are used by the notification system to communicate site activities. You can view
each activity’s default message from the Workarea > Settings > Community
Management > Notifications > Messages screen.

You can create an HTML-based and a plain text message for each activity. Typically, HTML
messages are sent as email or to the ActivityStream server control, while plain text is used in
SMS style messages. Messages typically combine text and tokens. See Also: Working with
Tokens on page 1213

Creating a Message
1. Log into the Workarea as an administrator.
2. Navigate to Settings > Community Management > Notifications > Messages.
3. If you are using the Multi-Site feature, select the site with which this message will be
associated.
4. Click Add Message. The Add Notification Message screen appears.
5. Complete the fields as described below.
l
Title—Enter a name for the message.
l

Type—Select the type of message you want to create. Choices are:
o User—message sent when user activity occurs
o

l
l
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Community Group—message sent when group activity occurs

The activity is specified at the Sub Type field.
Sub Type—Select the activity which triggers the sending of this message. See
Also: Choosing a Message Type on the facing page.
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l

Tokens—A list of available tokens for the selected Sub Type appears. To easily
insert a token into a message, highlight a token, then copy and paste it into the
message. For a list of tokens and their sub types with, see Working with Tokens on
page 1213. To learn about how to make tokens into hyperlinks, see Making a Token
into a Hyperlink on page 1214.
WARNING! A message is limited to 3000 characters after its tokens are converted to text.
After 3000, any remaining characters are removed.

l

l
l

l

l

Default—Click this check box if you want the message to be the default one that is
sent. See Also: Choosing a Message Type below
Subject—Enter a subject to be used if the message is sent as email.
Text—Enter the text and tokens that comprise the message. The editor lets you
format the text.
Use this editor for HTML, email, and activity stream messages. See Also: Making a
Token into a Hyperlink on page 1214
Plain Text—Enter the text and tokens that comprise the message you want to
send. Use this field for SMS type messages and messages to be sent as plain text.
(If you already composed the message in the editor above, you can select that text,
then copy and paste it into the Plain Text field.)
NOTE: Most SMS systems impose a 160 character limit on messages. If you create a plain
text message greater than 160 characters, Ektron divides it into several, smaller messages.

6. Click Save. The message now appears in the list of Notification messages. If it is the
default and an activity occurs on your website that matches the type and sub type, the
message is sent.

Choosing a Message Type
User and Community Group messages contains several sub types of messages. The sub type
is the activity that triggers the message. For example, to edit the message that notifies
colleagues when you upload a document to your Workspace, select User from the Type
drop-down and AddWorkspaceItem from the Sub Type drop-down.
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When you create a new message, you assign it to a type and sub type, such as User Activity
> Blog Post. Only the default message is active for any combination of type and subtype.
So, while creating a new message, you must make it the default (via the Add Notification
Message screen’s Default check box) if you want it to be sent. When you do, if another
message was the default for that type and sub type, it is no longer used. For a list of Sub
types, see Triggering a Notification Message on page 1195.

Removing a Message
1. Log into the Workarea as an administrator.
2. Navigate to Settings > Community Management > Notification > Messages.
3. Click the title of the message you want to delete.
4. Click Delete ( ).
5. Click OK on the confirmation message. The message is removed.

Managing Notifications in a Multi-Site Environment
1210
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Using SSL with Notifications

In a Multi-site environment, notifications stay within the site where the activity happened. For
example, if there are 2 sites—an Intranet and Social Club site—when a user from the Intranet
site performs an activity that generates a message, it does not trigger notifications on the
Social Club site. Exception: A user’s colleagues receive notifications regardless of the site
from which the message originated.
When a message type is created, it becomes the default message and is used by all sites. You
can assign new messages of the same type to each site in your environment.
To view the messages assigned to each site, go to the View All Notification Messages screen,
click the Site drop-down, and select the site.

When you create notification messages in a Multi-Site environment, you specify the site
associated with message. This lets you create customized messages for each site. For
example, you want a “Status Update” message targeted one way for an Intranet site and
another way for your Social Club site. To accomplish this, create a 2 messages. The message
for the Intranet site might state:
@SubjectUser.username@ has an updated status on Intranet with the following:
@MicroMessage.Message@.

While your Social Club site might have a message that states:
@SubjectUser.username@ has an updated status on the
Social Club with the following: @MicroMessage.Message@

Using SSL with Notifications
If your site uses SSL, you need to update the link in the Ektron notification service
configuration file with that information. The file is at: your-server\Program
Files\Ektron\EktronNotificationService\Ektron.Notification.Service.exe.confi
g.
Change the following tags.
<siteNotification>
<sites>
<add name="769723537"
url="https://your server"
connectionString="server=your server;
database=Intranet2;
Trusted_Connection=true;
User ID=;Password=;" />
</sites>
</siteNotification>

You must restart the Ektron Notification Service to enable these changes.

Ektron 8.7

1211

Managing User Communities

Using eSync with Notifications
When using eSync with Notifications, new agents are not synched. This means that you must
manually add new agents to each server in your configuration.
When the agent exists on all servers in your configuration, eSync keeps them updated. For
example, assume a membership user logs into the production server and updates the profile’s
Activities tab by changing the activities a custom agent will perform. eSync will sync those
changes with the staging server.

Setting Up SMS
SMS sends community notification messages from the Ektron website to wireless devices
such as a cell phone or PDA. To accomplish this, you must configure several items.
l

web.config—Add SMS Agent information.

l

Cell phone—Verify your Cell Phone with your website.

l

SMS Notification Agent—Configure the SMS Agent in the Workarea.

l

l

Messages you send to the community—Set your activities to publish by SMS in your
community profile.
Messages you receive from the community—Set activities to receive by SMS in
your community profile.

Setting up web.config for SMS
1. Find web.config in your website root directory.
2. Make a copy of it for safe keeping.
3. Find the SMSAgent tag.
4. Enter the proper value for smtpServer for the server that sends emails in your company.
For example:
smtpServer="EKMAIL291.internal.mycompany.com"

5. Replace the value of fromEmail with the email from whom the notices are sent. For
example:
fromEmail = "noreply@mycompany.com"

6. Save the file. The completed code looks like this.
<add name="SMSAgent"
type="Ektron.Cms.Notifications.Providers.SMSAgent,
Ektron.Cms.Providers" smtpServer="EKMAIL291.internal.mycompany.com" |
smtpPort="25" fromEmail="noreply@mycompany.com" validationRequired="true" />

Verifying Your Cell Phone for SMS Messages
To verify that you have made a proper connection to your cell phone, you must send a
verification message from the Ektron website to your phone. To verify your phone, do the
following steps.
NOTE: The following procedure requires that your website has the template
SMSAgentSettings.aspx. If it does not, you may copy it from the Ektron Developer starter site, or the
Ektron eIntranet site.
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1. In a browser, enter the following address:
http://<hostname>/SMSAgentSettings.aspx. A screen appears that looks similar to
the following:

2. Enter your cell phone area code and phone number.
3. Select your provider.
4. Click Save. In a few minutes, your phone receives a message with a validation code.
5. Enter that code into the Verification Code field.
6. Click Verify. If the proper code is entered, the follow screen appears, showing that the
SMS account is verified. If not, check the other configuration settings and try again.

NOTE: When the phone number is verified, the Account Verified checkmark appears. This will not
change unless you change the cell phone number or provider.

Working with Tokens
A token is an Ektron-defined variables surrounded by at signs (@). When a message is
generated, tokens retrieve information about Ektron users, groups, and objects. For
example, the following message:
@SubjectUser.FirstName@ added a new document, ‘@Content.title@’, to the profile page.

Ektron 8.7

1213

Managing User Communities

might look like this:
“Paul added a new document, ‘How to Write Code’, to the profile page.”
In this example, @SubjectUser.FirstName@ is the first name of the user performing the
action. @Content.title@ is the title of the object that was uploaded.
A message can include several token types.
l

SubjectUser tokens—represent the user who performs the activity

l

DirectObjectUser tokens—represent the user to which the activity is happening

l

Content tokens—represent the content that was a part of the activity

l

CommunityGroup tokens—represent the community group that was involved in the
activity

l

Blog tokens—represent the blog use in the activity

l

webEvent tokens—represents the Web Calendar used in the activity

l

MicroMessage tokens—represent micromessages used in the activity

Making a Token into a Hyperlink
A message token represent Ektron users, groups, or content. It can become a link that, when
clicked, brings the user to content, a user’s profile, or community group’s profile.

To make a token into a clickable link:
1. Create the message as described in Creating a Message on page 1208.
2. While editing the message text, highlight a token and click Hyperlink Manager (
The hyperlink dialog box appears.
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3. In the URL field, enter the path to the page that displays the content, user, or
community group.

Make sure you include the QueryString parameter used to identify the object. The
parameter should point to an ID token. For example, a message notifies your colleagues
whenever you add a new colleague. The message might be:
@SubjectUser.UserName@ and @DirectObjectUser.UserName@ are now colleagues.

When creating a link for @SubjectUser.UserName@, insert the path to the user’s profile
page into the URL field. It might look like this:
http://localhost/Intranet/UserProfile.aspx?id=@subjectUser.Id@

Note, the QueryString parameter (?id=) points to a token that represents the logged-in
user’s ID, @subjectUser.Id@. See Also: Working with Tokens on page 1213
For @DirectObjectUser.UserName@, enter the same path and change the dynamic
parameter token to ?id=@DirectObjectUser.Id@.
When hyperlinking content, use its QuickLink token in the path defined in the URL field.
For example, a message that sends a Notification when a user adds content might look
like:
@SubjectUser.username@ added new content, @Content.Title@.

4. Click OK.

Message Tokens: User and Content-Based
Add Calendar Event and Update Calendar Event
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l

@SubjectUser.DisplayName@

l

@SubjectUser.Id@

l

@SubjectUser.FirstName@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

l

@WebEvent.EndTime@

l

@WebEvent.Id@

l

@WebEvent.Quicklink@

l

@WebEvent.StartTime@

l

@WebEvent.Title@

AddColleague
l

@DirectObjectUser.FirstName@

l

@DirectObjectUser.Id@

l

@DirectObjectUser.LastName@

l

@DirectObjectUser.TemplateAlias@

l

@DirectObjectUser.UserName@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@,

l

@System.UserProfileTemplate@

AddContent
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l

@Content.Icon@

l

@Content.Id@

l

@Content.Quicklink@

l

@Content.Title@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@
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l

@System.SiteURL@

l

@System.UserProfileTemplate@

AddWorkspaceItem
l

@Content.Icon@

l

@Content.Id@

l

@Content.Quicklink@

l

@Content.Title@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteURL@

l

@System.UserProfileTemplate@

BlogComment
l

@BlogComment.Id@

l

@BlogComment.Message@

l

@SubjectUser.DisplayName@

l

@SubjectUser.Id@

l

@SubjectUser.FirstName@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

BlogPost
l

@Content.Icon@

l

@Content.Id@

l

@Content.Quicklink@

l

@Content.Title@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@
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l

@System.SiteUrl@

l

@System.UserProfileTemplate@

CreateCommunityGroup
l

@CommunityGroup.Id@

l

@CommunityGroup.Name@

l

@CommunityGroup.TemplateAlias@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

ContentMessageBoardPost
l

@Content.Icon@

l

@Content.Id@

l

@Content.Quicklink@

l

@Content.Title@

l

@MessageBoard.Message

l

@MessageBoard.ObjectId@

l

@MessageBoard.ObjectType@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.UserName@

l

@SubjectUser.TemplateAlias@

l

@System.GroupProfileTemplate

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

EditContent
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l

@Content.Icon@

l

@Content.Id@

l

@Content.Quicklink@

l

@Content.Title@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@
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l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

EditWorkspaceItem
l

@Content.Icon@

l

@Content.Id@

l

@Content.Title@

l

@Content.Quicklink@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl

l

@System.UserProfileTemplate@

ForumReply
l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

l

@Topic.Id@, @Topic.Title@

l

@Topic.Quicklink@

l

@TopicReply.Id@

ForumPost
l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@
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l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

l

@Topic.Id@, @Topic.Title@

l

@Topic.Quicklink@

l

@TopicReply.Id@

JoinCommunityGroup
l

@CommunityGroup.Id@

l

@CommunityGroup.Name@

l

@CommunityGroup.TemplateAlias@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

MicroMessage
l

@MicroMessage.Id@

l

@MicroMessage.Message@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

UserMessageboardPost
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l

@DirectObjectUser.Id@

l

@DirectObjectUser.FirstName@

l

@DirectObjectUser.LastName@

l

@DirectObjectUser.UserName@

l

@MessageBoard.Message@

l

@MessageBoard.ObjectId@

l

@MessageBoard.ObjectType@

l

@SubjectUser.DisplayName@
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Message Tokens: Community Group-Based

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.UserName@

l

@SubjectUser.TemplateAlias@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

Message Tokens: Community Group-Based
Add Calendar Event and Update Calendar Event
l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@,

l

@System.UserProfileTemplate@

l

@WebEvent.EndTime@

l

@WebEvent.Id@

l

@WebEvent.Quicklink@

l

@WebEvent.StartTime@

l

@WebEvent.Title@

AddWorkspaceItem
l

@CommunityGroup.Id@

l

@CommunityGroup.Name@

l

@Content.Icon@

l

@Content.Title@

l

@Content.Id@

l

@Content.Quicklink@

l

@DirectObjectUser.FirstName@

l

@DirectObjectUser.Id@

l

@DirectObjectUser.LastName@

l

@DirectObjectUser.UserName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@
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l

@System.SiteURL@

l

@System.UserProfileTemplate@

BlogComment
l

@BlogComment.Id@

l

@BlogComment.Message@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.UserName@

BlogPost
l

@Content.Id@

l

@Content.Quicklink@

l

@Content.Title@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.UserName@

CreateCommunityGroup
l

@CommunityGroup.Id@

l

@CommunityGroup.Name@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.UserName@

GroupMessageBoardPost

1222

l

@CommunityGroup.Id@

l

@CommunityGroup.Name@

l

@CommunityGroup.TemplateAlias@

l

@MessageBoard.Message@

l

@MessageBoard.ObjectId@

l

@MessageBoard.ObjectType@

l

@SubjectUser.DisplayName@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.TemplateAlias@

l

@SubjectUser.UserName@

l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@
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JoinCommunityGroup
l

@CommunityGroup.Id@

l

@CommunityGroup.Name@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.UserName@

UserMessageboardPost
l

@DirectObjectUser.FirstName@

l

@DirectObjectUser.Id@

l

@DirectObjectUser.LastName@

l

@DirectObjectUser.UserName@

l

@MessageBoard.Message@

l

@MessageBoard.ObjectId@

l

@MessageBoard.ObjectType@

l

@SubjectUser.FirstName@

l

@SubjectUser.Id@

l

@SubjectUser.LastName@

l

@SubjectUser.UserName@

Message Tokens: Email Reply Message
Email Message Reply
l

@System.GroupProfileTemplate@

l

@System.SiteUrl@

l

@System.UserProfileTemplate@

Setting Up Email to Communicate Community
Activities
Ektron's community feature can generate email when a user completes an activity. For
example, if a member posts a comment to a community message board, group members who
signed up for email notification in their user profile receive an email that contains the
comment. Recipients can reply to the email. Replies are posted on the community group's
message board.
You can also enable the attachment of files to email notifications. So, if a group manager
uploads a PDF file to a group message board, the email notification message contains the PDF
file as an attachment. Users can reply to that message and, if they attach an updated version
of the file, it can replace the file on the group's message board.
Finally, you can set up an email address for a group. This makes it easy for anyone to
broadcast a message to all group members.
To set up email delivery of and replies to notification messages:
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PREREQUISITES
Notifications must be enabled. See Conditions for Notification Messages on page 1195.

Step 1: Enter Sending Email Address Information
IMPORTANT: You must have permission to edit files on the Ektron server to complete this step.
The siteroot/web.config file collects the outgoing email address information. To define the
"From:" address of community email sent from your website:
1. On the server that hosts your website, open the siteroot/web.config file with a text
editor (such as Notepad).
2. Find the section below the <notificationAgent> <providers> elements.
3. Define the following elements. Do not change other elements in that section.
l
smtpServer—Enter the name of the server that hosts your Ektron website.
l
l

l
l

smtpPort—Enter the port that sends outgoing email from the site.
username—Optionally, enter the username to authenticate against the smtp
server.
password—Optionally Enter the password to authenticate against the smtp server.
from Email—Enter the “from” email address of all outgoing community email.
When a recipient gets an email, this value appears in the From: field.

Step 2: Review the Community Activity Notification
Message
Ektron provides a message that is emailed when each community activity is completed. To
view the message in the Workarea, choose Settings > Community Management >
Notifications > Messages and click Email Message Reply.

Step 3: Set Up email Preferences
Ektron provides a default set of notifications that apply to all newly-created users. This step is
almost exactly the same as Setting Default Notification Preferences on page 1202.

Step 4: Set up the email Reply Feature
1224
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Step 4: Set up the email Reply Feature

The optional email Reply feature consists of additional text in a community notification that
prompts a recipient to reply, as shown in the following example.

If the recipient replies, the resulting email is posted to the group's message board.
IMPORTANT: The Community email Reply feature is only available with group activities, such as
uploading a document to a group workspace. It is not available with user activities.
Also, you must enable the community notification features as described in Setting Up Email to
Communicate Community Activities on page 1223.
1. From the Workarea, choose Settings > Community Group > Notifications >
Settings.
2. Specify the email address to receive email replies in the Edit Notification Settings
screen. (You must be a member of the Administrators group or the community group
administrator to do this.)

l

l

Enable Email Replies—Check this box to access the fields in the lower part of the
screen.
Email Account Name—Enter the address that receives email delivered to your
website. The email account must be the same as the account used to send email.
See Also: Step 1: Enter Sending Email Address Information on the previous page
IMPORTANT: Each community group's email address must be unique.

l

Email Account Password—Enter the password for that email address.
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l

Email Server—Enter the POP mail server that retrieves email for this account.

l

Email Server Port—Enter the port number used to retrieve email for this account.

l

Use SSL—Check this box if you use SSL when retrieving email.

l

Test Connection—After you complete the above fields, click this button to verify
the information and your ability to connect to the mail server.
NOTE: If you are using Gmail as the SMTP server to fetch email replies, after the notification
service processes the emails, you probably want to delete them from the Inbox. To set up
automatic deletion of this email from the Inbox, got to Gmail's Settings screen > Forwarding
and POP/IMAP tab > Pop Download Area > 2. When messages are accessed with POP
> select delete Gmail's copy.

Step 5: Review the email Reply Message
Community activity that generates an email also can include a reply statement, as shown in
the following example.

NOTE: The activity message text is determined by the activity. For example, if the activity is a blog post,
the message text is retrieved from the New Blog Post notification message.
To review and modify email reply text:
1. In the Workarea, choose Settings > Community Management > Notifications >
Messages.
2. Click Email Message Reply.
3. You cannot edit the Title, Type, Sub Type or Default check box.
4. The Subject field is not used.
5. Edit the message text. You can create an HTML-based and a plain text message for each
activity. Typically, HTML messages are sent as email or to the ActivityStream server
control, while plain text is used in SMS style messages.
The line of dashes separates the activity message from the email reply.
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Step 6: Enable Attachments to Notifications

Messages typically combine text and tokens, Ektron-defined variables surrounded by at
signs (@). When a message is generated, tokens retrieve information about Ektron
users, groups, and objects. See Also: Working with Tokens on page 1213
6. Optionally change the Message's Start and End Delimiters. By default, the email
message reply begins with a new line character and ends with the line of dashes you see
in the message text. If desired, you can change those defaults. For example, you want
to limit the reply to a single paragraph.
a. On the server that hosts Ektron, open C:\program
files\ektron\ektronnotificationservice\
ektron.notification.service.exe.config.
b. Find the <siteNotification> <sites> element.
c. Insert the following properties at the end of the <Add> tag.
l
replyStartDelimitter—marks the beginning of the reply
l

replyEndDelimitter—marks the end of the reply

For example:
<siteNotification>
<sites>
<add name="dev" url="http://localhost/eintranet"
connectionString="server=.;database=eintranet;
Integrated Security=TRUE;user=;pwd=;" services="All"
replyExtractor="Ektron.Notification.Service.EktronReplyExtractor"
replyStartDelimitter="^" replyEndDelimitter="\r\n" />
</sites>
</siteNotification>

You use RegEx expressions to indicate the start and end delimiters. In the above
example, the start delimiter (^) is a new line, and the end delimiter (\r\n) is a page
break. So, only the first paragraph in the email reply is used.

Step 6: Enable Attachments to Notifications
Ektron can attach assets to a notification. For example, a user uploads a PDF document to a
group workspace, which generates a Group Content Added notification and attaches the
asset. If you enable attachments and the email Reply feature, message recipients can:
l

Download the attached asset to their computer.

l

Modify it.

l

Reply to the email .

l

Attach the modified asset.

If they do, Ektron replaces the community group asset with the attached file.
If a group administrator does not want the revision, the administrator can use the asset
history to restore the original asset. See Also: Restoring a Previous Version on page 303
IMPORTANT: If a message's email signature includes an image, the email Reply feature uploads it as a
group asset. To avoid this, remove the image from the signature before replying.
To set up notification attachments for a community group:
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1. From the community group page, click Edit Group.
2. Alternatively, in the Workarea, choose Settings > Community Management
>Community Groups > click a community group.
3. Near the bottom of the screen, check the Attach Documents in Email Notifications
box.
4. Click Save.

How email Replies are Handled
Activity notifications can prompt recipients to reply. The following table shows how each
activity treats email replies.
NOTE: If you are in a load-balanced environment, the same reply may appear several times. If this
problem occurs, stop the Ektron notification service on all but one of the servers in the cluster.
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Activity that Triggers Message

How email Reply Handled

User adds a colleague

Comment on Activity Stream

User adds content to Ektron

Post to Content Message Board

Event is added or changed on Web Calendar

Comment on Activity Stream

User uploads content to community group Workspace

Post to Content Message Board

User comments on group workspace content or asset

Comment on Activity Stream

User uploads content to the user's profile

Post to Content Message Board

Comment on user workspace content or asset

Comment on Activity Stream

User comments on a blog post

Comment to same blog post

User posts to the user's blog

Comment on post

User posts to a message board associated with content

Reply to post

User creates a community group

Comment on Activity Stream

User posts to a Forum

Reply to post

User replies to a Forum post

Reply to post

User comments on a community group’s blog post

Comment on same blog post
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Creating an Email Address for a Community Group

Activity that Triggers Message

How email Reply Handled

User posts to community group blog

Comment on post

User posts to a community group message board

Reply to post

User joins community group

Comment on Activity Stream

User posts micro-message

Comment on Activity Stream

User updates status

Comment on Activity Stream

User posts to another user's message board

Reply to post

Message board reply

Reply to same post

Creating an Email Address for a Community Group
You can set up Ektron's Community Feature to let anyone email a post to a community
message board. To set this up, each community group administrator (or Ektron
administrator) must define information about the receiving email account.
1. On community site's group page, choose Manage > Edit Group. The Edit Group screen
appears.
Alternatively, from the Workarea, choose Settings > Community Management >
Community Groups. Click the group, then click its Properties tab and check the
Enable Group emails checkbox.
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2. Enter the group's email address, account name and password.

Generating email Invitations for Community
Management
The Community Platform’s email notification feature enables Ektron to generate email that
invites other users to join a community group, join the site, or become a colleague.
To create a message:
1. In the Workarea, go to Settings > Community Management > Messages.
2. Click Add Email Message.
3. Enter a title that describes the message.
4. At the Type field, click the drop-down arrow to choose the message type.
5. Select whether to make the email message a Default message.
6. In the editor, enter the message text. Use the variables in the table below to retrieve
information into the invitation.
7. Click Save.
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Messages can include variables that retrieve information about the user sending the invitation
or the link to join a group and display it in the message text.
Variables are surrounded by at signs (@). For example: @appSenderName@ displays the name
of the user sending the invitation. In the email, this text might read:
Alan Administrator has invited you to join the Marketing Community Group.

You can use the following variables in the body of email notifications.
l

@appFriendDisplayName@—The recipient's name.

l

@appFromUserDeleted@—Token message is from a user that was deleted.

l

@appFromUserDisplayName@—The name of the user from whom the private
message was sent.

l

@appFromUserID@—The ID of the user from whom the private message was sent.

l

@appGroupName@—The group a person is being invited to join.

l

@appInvitedEmail@—The recipient's email address.

l

@appInviteId@—Appends the invite ID to the registration URL. For example:
Click <a href=http://www.example.com/register.aspx&fInvId=
@appInviteId@>here</a> to accept.

l
l

@appMessage@—The Message field of the private message (message body text).
@appOptionalText@—Text a user types into the Optional Message box on the Invite
server control.

l

@appPrivateMessageID@—The CMS ID for the particular private message.

l

@appSenderName@—The sender of the invitation.

l

@appSubject@—The Subject field of the private message.

l

@appToUserDisplayName@—The name of the user receiving the message.

l

@appToUserID@—User ID of the user receiving the message.

l

@appToUserMessageID@—The CMS ID of the recipient's message object.

Activity Streams
An activity stream is a series of chronologically-arranged notification messages describing
activities within Ektron's Community Feature. See also: Sending Notifications to a Community
on page 1194.
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The following table describes the various waysof presenting an Activity Stream on your
website.
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For this kind of
Web page

Use this

.aspx

ActivityStream on page 1638server
control

PageBuilder

ActivityStream widget
See Also: Using the ActivityStream
Widget on a PageBuilder Page on
page 1236

Ektron
Personalization

ActivityStream widget
See Also: Using the ActivityStream
Widget on a PageBuilder Page on
page 1236

To see Notifications for

The user or group identified in the
page’s query string.
If none is identified, the logged-in
user sees his or her own
notifications.

l

Yourself

l

Your colleagues

l

Your community groups

Community Feature:
your profile page

No action required—Activity Stream
appears by default

Yourself

Community Feature:
a colleague’s profile
page

No action required—Activity Stream
appears by default

Colleagues

Community Feature:
group profile page

No action required—Activity Stream
appears by default

Community group of which you are
a member
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Using the ActivityStream Widget
The ActivityStream widget is installed with Ektron.
When you drag and drop an ActivityStream widget onto a Personalization page, it displays
activities performed by
l

you, the logged-in user

l

your colleagues

l

community groups to which you belong

When you view another user’s personalization page containing this widget, the activities you
see are controlled by that user’s Private Profile setting and whether that person is your
colleague.

The following table describes when you can see another user’s Activity Stream.
If the user’s Private
Profile Setting is...

and the user
is...

you can...

Public

a colleague

view the person's activities

Public

not a colleague

view the person's activities

Private

a colleague

view the person's activities

Private

not a colleague

only view the person's
activities if you are an
administrator

Colleague

a colleague

view the person's activities

Ektron 8.7

1233

Managing User Communities

If the user’s Private
Profile Setting is...

and the user
is...

you can...

Colleague

not a colleague

only view the person's
activities if you are an
administrator

If you can view another user’s activities, you see activities that person performs and
activities that person's colleagues perform.
From this widget, you can filter the Activity Stream to view only activities from specific users
and community groups. Filtering the ActivityStream widget means restricting notifications to
those from selected users or groups. For example, you want to see only activities performed
by Kay Milford. In the filter, select Kay Milford, and the ActivityStream widget shows
messages only from her.

As another example, you are the head of the Engineering department and want to see your
employees’ activities. To accomplish this, add them as colleagues. Then, in an ActivityStream
widget, create a filter with their names. That widget only shows your employees’ activities.
If your department has a community group, you could add that group to the filter. Then, in
addition to your employees’ activities, you would see the group’s activities.
This feature, combined with the ability to add multiple ActivityStream widgets to a page, lets
you create separate activity streams that focus on people and groups of interest.
The following image shows 1 ActivityStream widget that displays a user’s colleagues (on the
left), and 3 other widgets with filters that focus on individual users.
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Filtering the ActivityStream Widget

You could take this example one step further. If Leah Mathis and Scott Markey both work in
“Sales & Marketing” and Bill Smith, Works in “Engineering,” you might only have 2 widgets,
one for Scott and Leah and another for Bill.

Filtering the ActivityStream Widget
1. Click Filter at the bottom of the widget.
2. In theUsers and Groups box, enter the name of a user or community group by which
to filter. As you start typing, AutoComplete helps you narrow the selection.
3. Click Add. The ActivityStream widget refreshes and only activities performed by the
selected user or community group members appear.
IMPORTANT: A valid name is one that exactly matches a user’s Display Name or community
group’s Group Name. If your entry does not match, the widget refreshes and no filter is added.
Also, the users or community groups you selected appear in the widget’s filter area.
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You can add as many users or community groups to the filter as you like, one at time. After
you finish, you can hide the filter by clicking Hide.

Removing an Entry from the ActivityStream Widget Filter
NOTE: If you remove all users and groups from the filter, the widget shows notifications from all users
whose activities you can view.
1. If you cannot see the filter’s users or community groups, click Filter at the bottom of
the widget.
2. Click Delete ( ) next to the user or community group you want to remove. The
ActivityStream widget refreshes, and the removed user or community group’s activities
disappear from the stream.

Using the ActivityStream Widget on a PageBuilder
Page
NOTE: To learn about Ektron's PageBuilder functionality, see Creating Web Pages with PageBuilder on
page 659.
When used on PageBuilder page, the ActivityStream widget shows the logged-in user’s
activities by default. However, you can modify the widget to focus on another user’s or
community group’s activities.
For example, you create a PageBuilder page about your company's CEO and want to display
notifications about activities that the CEO, colleagues, and community groups perform on the
site.
To accomplish this, add the ActivityStream widget to a “See what the CEO is Up To” page.
While doing that, specify the user ID assigned to your CEO (available from the CEO's User
Profile). When an Intranet user visits the page, the user sees a list of the CEO’s activities.
To display another user’s or community group’s activities in the ActivityStream widget:
PREREQUISITE
The ID number of the user or community group whose notifications will appear
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Sharing an Activity Stream Event on Your Profile

1. Drag and drop the ActivityStream widget. The following dialog appears.

2. Use the Feed Type drop-down to select User or Community Group.
3. In the Object ID field, enter the user’s or community group’s ID.
4. Click Save.

Sharing an Activity Stream Event on Your Profile
Each activity in a stream has a Share link below its text.

When you click Share on someone's status, it appears in your profile's status, too.

Commenting on an Activity Stream Event
Each activity in a stream has a Comment link below its text. When you click it, a Comment
box opens for you to add a comment. When you finish, the comment link displays the
number of comments on that activity. Users can click the number to view the comments.

Ektron 8.7

1237

Managing User Communities

Only the user who made the comment or a member of the Ektron Administrators group can
delete the comment.

Setting Up a Time Display for Activity Stream Events
You can set up an activity stream to assign a time ago link to each event.

When a site visitor clicks that link, the activity stream event is launched in a new browser.
From there, the site visitor can use the page's URL to uniquely identify the event. For
example, the user can forward the URL to other users to notify them about the event.
To add a time ago link to a page:
1. Create a Template Activity page. It must be an .aspx template with an activity stream
server control that includes these properties.
l
ObjectType—enter Activity
l

DynamicObjectParameter—enter id

NOTE: A sample of this page, activity.aspx, is provided with the Ektron Tech site, in the site
root folder.
2. Open the template that hosts the ActivityStream server control to which you want to add
a time ago link.
3. To the ActivityStream server control, add the TemplateActivity property. As the value
for that property, enter the template page you created. That page appears when a site
visitor clicks the time ago link.
Here is an example of an Activity Stream server control with a sample value for that
property.
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Displaying RSS Feed Links

<CMS:ActivityStream ID="ActivityFeed1"
runat="server" EnablePaging="true" DynamicObjectParameter="id"
TemplateUserProfile="profile.aspx" TemplateActivity="activity.aspx" />

NOTE: A sample of this page, profile.aspx, is provided with the Ektron Tech site, in the site
root folder.

Displaying RSS Feed Links
Ektron provides the following RSS feed links that can display activity stream events.
l

http://your website/workarea/webservices/feeds.svc/userstatuses/user ID
number.rss
For example: http://your zwebsite/workarea/webservices/feeds.svc/userstatuses/1.rss
Displays the specified user’s status updates. For example, 1.rss shows all status
updates of the user whose ID is 1.

l

http://your website/workarea/webservices/feeds.svc/publictimeline.rss
Displays all public status updates

l

http://your
website/workarea/webservices/feeds.svc/publictimeline.rss?search=new
Displays all public status updates that include the term "new"

You can use these feeds with Ektron's API to access and display status updates.

Troubleshooting Activity Streams
Problem: Notifications do not appear in my Activity Stream and the configurations are set
for Notifications and User/Group Activities. Also, the Application Event log shows the
following error: An exception occurred while enqueueing a message in the target queue.
Error: 15404, State: 11, Could not obtain information about Windows NT group/user 'WINI2VJT0GQ8I2\Administrator', error code 0x534.
This occurs when the person who created the database is not the same person who created
the queues. This creates permission issues when trying to write to the queue.
Solution: Do 1 of the following:
l
l

Set the user that writes to the queue with the permission level of "dbo."
Run the script sp_changedbowner "sa" where "sa" is the user name who writes to the
queue.

Defining Flags for Content
Flagging lets site visitors provide feedback about a piece of content, thereby enabling site
visitors to moderate your site. This is especially important for sites with large amounts of
visitor-generated content. Flagging also helps site visitors feel invested in the site.
For example, a flagging list can describe types of inappropriate content, such as:
l

Sexually Explicit

l

Mature (over 18 only) content
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l

Graphic Violence

l

Hate Speech

Flagging can also indicate the quality of content, so can help create a recommended content
list. For example:
l

I loved this content.

l

I hated this content.

l

I am neutral about the content.

Flagging is similar to the ContentReview server control, except flagging feedback is not
displayed on the site. Also, the Flagging control provides a list of reasons for the flag. So, a
flagging definition describes how a content item may be reviewed, and provides a list of
reasons for the flag. For example:

After creating a flagging definition, you assign it to relevant folders. All content in those
folders can be flagged with that definition.
IMPORTANT: As the final step in letting site visitors flag content, a developer adds a ContentFlagging on
page 1707 server control to a Web page, and assigns to it the ID of the content being flagged.
Flagged content appears in the following Workarea locations.
l

ContentFlags list on the Smart Desktop

l

Settings > Community Management > Flagging > Flagged Content

l

a content item’s View Content Reports > Flagging tab

The Flagging Definitions screen is located in the Workarea > Settings > Community
Management > Flagging. Here, you can view a list of flagging definitions, work with them,
or create new ones.
This screen contains the following information about a flagging definition.
l

ID—The ID of the flagging definition.

l

Name—The name of the flagging definition.

l

Description—A description of the flagging definition.

l

Language—The national flag of the language. For example, American English is

l

.

Items—The number of flags in a definition. For example, the number is 4 if you have a
flag definition for these movie ratings: G, PG, PG-13, and R.

Adding a Flagging Definition
1. In the Workarea, navigate to Settings > Community Management > Flagging >
Flagging Definitions.
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2. Select a language with which the flagging definition will be associated.
3. Click Add New Flag Definition. The Add Flagging Definition screen appears.
4. Enter a Name and Description for the flagging definition.
5. Click Option (

) to add a flag choice to this flagging definition.

6. Continue to click the Option button to add additional flag choices.
7. Optionally change the order of the flag choices by clicking the Sorting buttons (

).

8. Click Save.

Editing a Flagging Definition
1. In the Workarea, navigate to Settings > Community Management > Flagging >
Flagging Definitions.
2. Click the flagging definition Name link or the ID link.
3. Edit the options. If desired, you can change the order of the flagging options by clicking
the Sorting buttons (
).
4. Click Save.

Deleting a Flagging Definition
When a flagging definition is deleted, it is removed from all folders with which it was
associated.
1. In the Workarea, navigate to Settings > Community Management > Flagging >
Flagging Definitions.
2. Click the flagging definition Name link or the ID link.
3. Click Delete ( ).

Assigning a Flagging Definition to a Folder
After creating a flagging definition, you may assign it to folders. If you do, the flagging
definition is applied to all content in that folder.
Like other folder properties, a folder’s flagging definitions may be inherited by its child
folders, although this does not occur by default.
To assign a flagging definition to a folder:
1. Create a flagging definition, as explained in Adding a Flagging Definition on the previous
page.
2. Click the Workarea Content tab.
3. Navigate to the folder that contains the content to be flagged.
4. Select View > Properties from the View menu. The View Properties screen appears.
5. Click Edit Properties.
6. Click the Flagging tab.
7. Make sure the Inherit Parent Flagging Configuration check box is not checked.
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8. Select a flagging definition from the Flagging drop-down.

9. Click Update.

Working with Flagged Content
From the Smart Desktop
To see content flags, you must add the Content Flags widget to your desktop. The Content
Flags widget lists the 10 most recently-added content flags. From there, you can view a flag
by clicking its title. To view all recent flags, click the View recent flags link. Clicking this
link takes you to the Content Reports: Recent Flags screen.

From the Settings Tab
Settings > Community Management > Flagging > Flagged Content shows all flagged
content.
NOTE: You can also access this report from the Workarea > Reports > Contents > Content Flags.

l

l

Showingflagsforthelast#days—Enter a new number of days for which to show
Flagged Content. Click Report to refresh the display.
Title—The title of the content block being flagged. Clicking this link brings you to a
detailed description of the content’s flag.

l

Display Name—The name of the user who flagged the content.

l

Date—The date the content was flagged.

l

Flag—The specific flag from the flagging definition for this content.

l

Comment—Comments added by the site visitor who flagged the content.

To print the flagged content report, click Print (

).

Filtering Flagged Content by Folder
From the Content Reports: Flagged Content screen, you can filter flagged content by folder.
To do so:
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1. In the Workarea, navigate to Settings > Community Management > Flagging >
Flagged Content.
2. Click Filter Reports by Filter (

). The Select Folder screen appears.

3. Select a folder.
4. Click Save. The page refreshes, and any flagged content in the folder is shown.
NOTE: Only content flagged within the time frame for the Showing flags for the past # days field is
shown. For example, if the field is set to 5, only content that’s been flagged in the last 5 days appears.

Filtering Flagged Content by Language
To see flagged content for a specific language, select the language from the Language dropdown box.

From the Content Report
You can also view flags for a content from the Content Report screen's Flagging tab. You
can filter flags by a date range or see all flags associated with the content. This screen also
contains a purge button, which removes all flags associated with this content.

Viewing Flags Applied to a Content Item
1. In the Workarea, find the content for which to retrieve content flags.
2. Click the content title. The View Content screen appears.
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3. Click Content Reports (

4. Click Start Date (

). The Content Report screen appears.

) and End Date (

) to select a date range.

NOTE: To retrieve all flags, leave Start Date and End Date blank.
5. Click Get Flags. A list of flags applied to that content within the selected date range
appears.

Purging a Content Item’s Flags
1. In the Workarea, find the content block for which to purge content flags.
2. Click the content title. The View Content screen appears.
3. Click Content Reports (
4. Click Start Date (

).

) and End Date (

) to select a date range.

NOTE: To retrieve all flags, leave Start Date and End Date blank.
5. Click Purge Flags.

Viewing the Details of a Flag
Viewing a flag’s detail lets you read the entire comment, even if it is truncated in one of the
lists. You can also edit or delete a flag from this screen.
1. Navigate to one of these area in the Workarea:
l
Smart Desktop > Content Flags widget
l

Settings > Community Management > Flagging > Flagged Content

l

Reports > Contents > Content Flags

2. Click either a flag’s content title or its date. The flag’s detail information appears.

Editing the Details of a Flag
Edit a flag when you want to change the selection or the comments of a flagged content item.
This can be useful if a user selects a flag by mistake, or you want edit its comments. For
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example, a user selected the “Offensive Content” flag but the user meant to choose
“Copyright Violation”.
1. Navigate to one of these area in the Workarea:
l
Smart Desktop > Content Flags
l

Settings > Community Management > Flagging > Flagged Content

l

Reports > Contents > Content Flags

2. Click either a flag’s content title or its date. The flag’s detail information appears.
3. Click Edit.
4. Change the flag or edit the comments.
5. Click Save. The flag’s information is changed.

Deleting a Flag
NOTE: To remove all flags for a content item, see Purging a Content Item’s Flags on the previous page.
1. Navigate to one of these area in the Workarea:
l
Smart Desktop > Content Flags
l

Settings > Community Management > Flagging > Flagged Content

l

Content Reports > Flagging tab for a content item

2. Click either a flag’s content title or its date. The flag’s detail information appears.
3. Click Delete ( ).

Tagging Content, Library Items, Users, and
Groups with Keywords
Tags are keywords that you can assign to users, groups, content, and library items. On a
website, tags for a user or group appear in a profile, helping site visitors learn about a user or
group.

You also can perform tag-based searching.
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For example, you tag content related to a new product release with “Widgets 2.0.” Anyone
could enter that term into the Search box, click Tags from the drop-down list, then Search to
find all related content.
Tags are used in these Workarea locations:
l

User Information screen’s Tags tab, for users or membership users

l

Community Group screen’s Tags tab

l

A content item’s Metadata tab > Tags area

l

A library item’s Metadata tab > Tags area

l

Settings > Community Management > Tags

NOTE: The CommunityGroupBrowser, CommunityGroupProfile, and CommunityGroupList server
controls can display group tags and link them to a list of all groups that share the tag. Also, the TagCloud
on page 1848 server control displays a weighted list of tags.

Tag Types
There are 2 tag types:
l

Default
o Created by system administrator in Settings > Community Management >
Tags area
o

l

Appear as checkbox options where tags can be applied

User-created
o Created by user wherever tags can be applied

Creating Default Tags as Administrator
An Ektron administrator can create default tags for each object (user, user group, content or
library item). For example, you want to let users associate themselves with a favorite race
car driver. You create a default user tag for each driver’s name. When a user creates or edits
an item for which you created the default tags, the tag appears and the user clicks check
boxes to assign them.
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Ektron provides screens for creating default tags for user groups, users, content and library
items. They are available via Settings > Community Management > Tags.
1. In the Workarea, navigate to Settings > Community Management > Tags and
select on the the default tag items.

2. Select a language for the tag.
3. Add the tag in the empty text box. If no empty box appears, click Add (
the tag.

) then enter

4. Click Save Tag.

Creating Tags as End User
Users, community group leaders, and content editors can create their own tags. For example,
while you are editing content, you decide that none of the default tags is correct. So, you
create and assign a new tag: Rosebud. That tag is now applied to that content.

The tag also appears on the Settings > Community Management > Tags screen, where
you can see its ID number. If someone creates another tag with the same name, it shares the
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ID number with the previous one, and the Times Used increases from 1 to 2. However, the
new tag does not appear as a default on any screen.

Managing Tags
Administrators manage tags from the Settings > Community Management > Tags
screen. This screen displays all default and user-created tags. You can filter the list by
language. Click any tag’s name to see its details.

This screen displays the following information about each tag.
l

ID—Tag's integer ID

l

Name—Tag's title

l

Times Used—The number of times a tag has been assigned

l

Language—Its language. This appears as a national flag. For example, American
English appears as
.

When you click a tag’s name, its details appear on the View Tag screen.
l

ID—Tag's integer ID

l

Language—Tag's language

l

Name—Tag's title

l

l

Tagged Type—Shows how the tag is assigned: to a community group, user, content, or
library item.
Times Used—The number of times this tag is assigned to each Tagged Type

Deleting Tags
To delete each tag type:
l

User-created
o Deleting a single tag
1. Open the item’s Tags area. For example, for content, edit the Metadata tab.
2. Uncheck the checkbox next to the tag.
3. Publish the content.
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o

Deleting all occurrences of a tag
1. Go to the Settings > Community Management > Tags screen.
2. Click the tag.
3. Click delete (

). A confirmation message appears.

4. Click OK.
l

Default—There are 2 methods for deleting default tags. Each has different results.
o Deleting a Default Tag
n No longer available for assignment to users, content, and so on.
n

Existing links to it remain

1. Go to Settings > Community Management > Tags
2. Select the screen for the kind of tag you want to delete (group, user, content
or library).
3. Select the language.
4. Click ( ) to the right of the tag you want to delete. You are asked if you are
sure. Click OK.
5. Click Save.
o

Deleting a Default Tag and All of its Links
n No longer available for assignment to users, content, and so on.
n

Existing links to it are deleted

1. Go to the Settings > Community Management > Tags screen.
2. Click the tag.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.

Using Ektron's Micro-messaging Bookmarklet
A Micro-messaging bookmarklet, a feature of Ektron's Community Management, lets you use
a micro-message to inform colleagues about a Web page without leaving it. To create this
micro-message:
1. Navigate to a Web page.
2. Click a Share This link on the browser's Bookmark or Favorites menu/toolbar.
NOTE: In Internet Explorer, these toolbar shortcuts are known as favorites. In Firefox, they are
known as bookmarks. This documentation calls them bookmarks.

3. That action generates a link to that Web page as a micro-message. You can add a
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comment.

Submitting a Web Page Link as a Micro-message
PREREQUISITE
To enable the Bookmarklet feature, a developer places a Bookmarklet on
page 1661server control on a page and (if desired) Review and Modify the Post to
Profile Form on the facing page.
Before anyone can use the Micro-messaging bookmarklet feature, you must add a
Bookmarklet link to your bookmark toolbar or menu.
1. Navigate to a page that contains a Micro-messaging bookmarklet link.

NOTE: The text of the Micro-messaging bookmarklet link changes according to the user's browser.
Also, the image above text reflects default text; developers can easily change it.
2. Right click a bookmarklet link and follow the screen instructions to add it as a Bookmark.
The Bookmarklet appears on the toolbar.
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3. Navigate to a page that you want to post as a micro-message.
4. Click the bookmarklet link. The following screen appears.
NOTE: If you are not logged in to Ektron, you are prompted to do so.

5. Add comments to replace What would you like to say?
6. Click to edit the title and description.

7. Click Share. The post is shared in a micro-message with colleagues.

The micro-message appears in the user's Activity Stream if it is set up to track micromessages.

Review and Modify the Post to Profile Form
Ektron provides the following sample form to appear when a user clicks the Micro-messaging
bookmarklet link on the browser's Bookmarks menu.
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The sample form is siteroot/Workarea/share.aspx. To modify this form or create your
own, enter the new path into the Micro-messaging Bookmarklet server control's FormURL
property.
NOTE: If you specify an external file, do not store this file in the Workarea folder. If you store this file in
the Workarea folder, the file will be lost when you upgrade.
Here are a few things to note about this form's behavior.
l

l

If a user is not logged it, a Login server control must be added to prompt the person to
do so.
The form lets the user enter or update 3 fields
o comment entered by user
o

title tag text

o

meta description

l

All text on the form (including the URL) cannot exceed 2000 characters.

l

The form accepts plain text only—no formatting or images are allowed.

l

l

This size of the screen is determined by the Bookmarklet server control's PopupHeight
and PopupWidth properties.
The form generates a Micro-message, so it follows the conditions for how Micromessages are published.

Using the Friends Server Control
The Friends server control displays a list of:
l

l

l

current colleagues—users who accepted your invitation to be a colleague, or whose
invitation to be a colleague you accepted
pending colleagues—users who sent you a colleague request, which you have not yet
accepted
invited colleagues—users to whom you have sent colleague requests, which have not
yet been accepted

The control can lets you navigate between views.
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The Friends server control also lets you designate a Selected Colleague, a special category
whose members can view documents and photos that regular colleagues and the public
cannot view. For information about the Friends server control properties, see Friends
(Colleagues) on page 1747.

To manage existing colleagues on the website, find the Colleague area of your profile page
where you can view, approve, and remove colleagues.

Managing Colleagues
The following sections explain how to manage colleagues.

Viewing Pending Colleague Requests
Pending colleagues are users who sent you a colleague request which you have not yet
accepted. To view pending colleagues on the website, navigate to the Pending Colleagues
area of your profile page. From this area, you can accept or decline colleague requests.

Accepting a Colleague Request
Accepting a colleague request adds the user to your colleagues list. This lets you access
additional information on the colleague's profile page.
1. Navigate to the Pending colleagues area of your profile page.
2. Place a check in the box next to each colleague whose request you want to accept.
3. Click Approve. The page refreshes, and the selected users are removed from the
Pending Colleagues list and added to the colleagues list.

Declining a Colleague Request
Declining a colleague request cancels the request. When you decline the request, it is
removed from your Pending Colleagues list and the requester’s Invited list.
1. Navigate to the Pending Colleagues area of your profile page.
2. Place a check in the box next to each colleague whose request you want to decline.
3. Click Remove Selected. A dialog box asks you to confirm that you are declining the
colleague.
4. Click OK. The page refreshes, and the selected users are removed from your Pending
Colleagues list and requester’s Invited list.
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Viewing Invited Colleagues
The Invited colleagues list displays users to whom you’ve sent colleague invites. From this
screen, you can delete requests that have not yet been accepted. See Also: Viewing Invited
Colleagues above To view sent colleague requests, navigate to the Invited Colleagues area
of your profile page.

Canceling Invited Colleagues
1. Navigate to the Invited Colleagues area of your profile page.
2. Place a check in the box next to each colleague whose invite you want to cancel.
3. Click Remove Selected.

Removing Colleagues
1. Navigate to the Colleagues area of your profile page.
2. Place a check in the box next to each colleague you want to remove.
3. Click Remove Selected.

Designating a Selected Colleague
Selected colleague is a special category of user who can be given access to documents and
photos that regular colleagues cannot view. A user makes this designation when sharing a
Workspace, which can be shared with the Public, all colleagues, or selected colleagues. See
Also: Using the Friends Server Control on page 1252
1. Navigate to the Colleagues area of your profile page.
2. Check the box next to each colleague you want to make a Selected Colleague.
3. Click Update. Selected Colleague appears next to the colleague.

To change a selected colleague back to a colleague, check the box next to a selected
colleague and click Update.

Creating a Colleague Group Folder
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Grouping lets you organize colleagues by folder. For example, you place all family members
in a "Family" folder. You can only group current colleagues, not colleagues who are pending
or invited.
The following sections explain how to work with Colleague folders.
n

Creating a Colleague Group Folder below

n

Placing a Colleague in a Group Folder below

n

Renaming a Folder below

n

Deleting a Folder below

Creating a Colleague Group Folder
1. Make sure the DisplayMode property of the Friends server control is set to Directory.
2. Log in to the website.
3. Navigate to your profile page or a page the contains a Friends server control.
4. Click Add Folder in the Friends server control.
5. Enter a Name and Description for the folder.
6. Click OK.

Placing a Colleague in a Group Folder
1. Navigate to your profile page or a page the contains a Friends server control.
2. Check one or more colleagues.
3. Click Move on the Friends server control. A list of folders appears. Select the folder to
which you want to move them.
4. Click OK.

Renaming a Folder
1. Navigate to your profile page or a page the contains a Friends server control.
2. In the Colleagues section of the screen, click Edit Folder (

) next to the folder’s title.

A dialog box appears.
3. Change the name, description or both.
4. Click Save.

Deleting a Folder
WARNING! Deleting a folder deletes all colleagues within it. To retain the colleagues, move them from
the folder first by clicking the folder, checking the colleague, and clicking MoveUp One Level.
Deleting a folder also deletes all of its subfolders.
1. Navigate to your profile page or a page the contains a Friends server control.
2. In the Colleagues section of the screen, click Edit Folder (
A dialog box appears.

) next to the folder’s title.

3. Click Delete.
4. Click Save.
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Using the Micro-messaging Server Control
The Micro-messaging server control allows users to post brief messages. It resembles microblogging services like Twitter. For information about the Micro-messaging server control
properties, see Micro-messaging on page 1801.

A user can reply to another user’s micro-message.

The control also lets users search micro-messages. See Also: Searching for Micro-messages
on page 1263
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In addition, Micro-messages are a type of notification.
This feature builds tighter-knit communities by allowing members to share information and
feel they have a personal stake in that information.
NOTE: If you are in a load-balanced environment, the same reply may appear several times. If this
problem occurs, stop the Ektron notification service on all but one of the servers in the cluster.
This section also contains the following topics.
Micro-Message Controls on Sample Sites
Micro-messages are an Activity Type
Micro-messaging Display Modes
Associating the Control with a User
User Mode
Colleagues Mode
TimeLine Mode
Message Mode
Making a Hyperlink to a Single Page Version of a Micro-message
Searching for Micro-messages
Enabling the Micro-message Search
Running a Micro-message Search
Entering Multiple Search Terms
Replying to a Micro-message
Filtering Micro-message Spam
Creating a Custom Spam Filter

1257
1257
1259
1259
1260
1260
1261
1261
1262
1263
1264
1264
1265
1265
1266
1267

NOTE: A user’s Private Profile setting has 3 possible values: Public, Private and Colleague. When
discussing this control and these settings, Private and Colleague both act as Colleague.

Micro-Message Controls on Sample Sites
You can find examples of the Micro-message server control in these Ektron sample sites. You
can copy and edit the samples as needed to build your own pages.
l

Ektron Technology site > Login
l
user or colleague mode—User Profile page (top right corner)
l

time line mode—http://your server/Ektrontech/timeline.aspx

Micro-messages are an Activity Type
Ektron 8.7
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A micro-message is type of Ektron activity, like adding content or joining a Community
Group. As such, a new micro-message can generate a notification. See Also: Sending
Notifications to a Community on page 1194
Like other notifications, Micro-messages can appear on an Activity Stream control.

Users can determine if they want to be notified about colleagues' Micro-messages on the
User Profile > Activities > Colleagues tab, and if want to notify others on the My
Activities tab.
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Micro-messaging Display Modes
This Micro-messaging server control has 4 modes, which let you control the messages being
displayed.

Associating the Control with a User
Like other Ektron server controls, there are 2 ways to specify the user associated with the
control.
l

l

the server control’s DefaultObjectID property. Do this to display a particular user’s
micro-messages on a page.
the user ID is retrieved from the page URL, which typically contains the logged-in user
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ID (see example below). Do this to display micro-messages of the logged-in user.

User Mode
Use this mode to show micro-messages for a specified user, such as on a User Profile page.
For example, when you view your own page in User Mode, you can
l

see your messages

l

submit a new micro-message. For example, you update your status.

l

search micro-messages. See Also: Searching for Micro-messages on page 1263.

The following example of the Micro-messaging server control with the Mode property set to
User.

In User Mode, you can view the control that is associated with another user. For example,
when you view another's profile, which contains the Micro-messaging control in User Mode,
you see only micro-messages of the user who owns the profile. You cannot submit a micromessage from your colleague’s profile page, nor can you search micro-messages. For
example, you and Steve are colleagues. When you view Steve’s profile page:
l

you can see all of Steve’s messages

l

you can see messages from colleagues they have in common

l

you cannot update Steve's status

l

you cannot search messages

Colleagues Mode
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Colleagues Mode displays micro-messages from the user associated with the control and the
user's colleagues. Use this mode to show micro-messages for these users, such as on a user
profile page. When you are logged in and visit a page containing a Micro-messaging control in
colleagues mode, you can:
l

see the colleague's messages

l

see the colleagues’ messages from other colleagues

l

update the colleague's profile

l

search micro-messages. See Also: Searching for Micro-messages on page 1263

You also can view the control in Colleagues Mode when it is associated with another user. For
example, when you view another user’s profile, which contains the Micro-messaging control
in Colleagues Mode, you see only micro-messages from the user who owns the profile and the
colleagues that you have in common with the user. You cannot submit a micro-message from
the colleague’s profile page, nor can you search micro-messages. For example, you and
Steve are colleagues. When you view Steve’s profile page:
l

you can see Steve’s messages

l

you can see messages from colleagues you have in common

l

you cannot update Steve's status

l

you cannot search messages

TimeLine Mode
This mode displays micro-messages for a site’s users whose Private Profile setting is set to
Public. This mode displays a chronological stream of micro-messages from all such users,
with the most recent at top.

Whenever a user whose profile is set to Public submits a micro-message, it’s added to the
time line.
From the time line page, logged in users can reply to and search micro-messages. See Also:
Replying to a Micro-message on page 1265, Searching for Micro-messages on page 1263

Message Mode
This mode displays a single micro-message on a page.
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For example, John sends his boss a link to a micro-message that praises his work. When
John's boss clicks the link, a page that contains this control appears. See Also: Making a
Hyperlink to a Single Page Version of a Micro-message below

Making a Hyperlink to a Single Page Version of a
Micro-message
Each micro-message includes a time lapse, that is, the length of time since a message was
submitted. See example below.

Each micro-message’s time lapse can become a hyperlink that contains the ID of that
message and a destination window. Users can click the link to view that message in the new
window.

The destination window must
l

l
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be identified in the properties of the Micro-messaging server control that displays the
original message
contain a Micro-messaging server control in Message Mode
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Users can also copy the link and send it to another user, who can then view the message. To
copy a time lapse’s link information, hover over the link, right click, and select Copy
Shortcut (if using Internet Explorer) or Copy Link Location (if using Firefox).
NOTE: If someone sends a micro-message link to another user who is ineligible to see the message, it
does not appear. To see the message, either the user who submitted it has the profile set to Public, or the
link recipient must be a colleague of the message's creator.
The following example shows how to set up this capability.
l

l

Page1.aspx contains a Micro-messaging server control that displays a user’s micromessages. The messages’ time lapses are hyperlinks.
Page2.aspx has a Micro-messaging server control in Message Mode. It displays the
individual message whose time lapse was clicked on the first page.

NOTE: For a full description of the Micro-message properties, see Using the Micro-messaging Server
Control on page 1256.
1. On Page1.aspx, add a Micro-messaging server control.
2. Set the DynamicObjectParameter to id.
3. Set the TemplateMessage to the path to Page2.aspx.
4. Set the Mode property to anything other than Message.
5. Save Page1.aspx.
6. On Page2.aspx, add a Micro-messaging server control.
7. Set the DynamicObjectParameter to id.
8. Set the Mode property to Message.
9. Save Page2.aspx.
Now, when you log in to your site and navigate to Page1.aspx, you see a list of your micromessages. If you click the time lapse on any message, Page2.aspx loads, showing the
message you clicked.

Searching for Micro-messages
The Micro-messaging server control includes search functionality that prompts a user to enter
terms and returns micro-messages that match them. The search looks through micromessages only. It does not search content, products, users, or groups.

When searching, a user can only find micro-messages submitted by
l

one's self

l

one's colleagues
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l

users whose profile is set to public

The following topics explain how to enable and use the micro-message search.

Enabling the Micro-message Search
The micro-message search requires your server to have the Full Text Search component of
Microsoft SQL Server.

You can install the Full Text Search component during the installation of Microsoft SQL Server.

Installing the Full Text Search Component
If the Full Text Search component is not installed, and you want to use the Micro-messaging
search functionality, insert the SQL Server installation disc into your computer and look for
Full Text Search.
After the Full Text Search is installed, run the FullTextIndex.sql script on your database. This
script is located in:
Program Files\Ektron\CMS400vxversionnumber\
Utilities\SiteSetup\Database\FullTextIndex.sql

Running a Micro-message Search
When Micro-message search is enabled, a Search tab appears on the control. To use the
search, click the tab and enter search terms.
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When results appear, you can click any message’s time span to proceed to the message
itself. If a reply appears among search results, you can click the link indicated below to view
the original message.

Entering Multiple Search Terms
You can enter more than one search term. If you do, the terms have an “and” relationship.
For example, if you enter Community and Group, only messages containing both
Community and Group are found.

Replying to a Micro-message
The Micro-message control lets users reply to micro-messages and nests the reply with the
original message. Anyone who can see a message can reply to it, and see all other replies.
To add a reply, hover over a message and click Reply ( ). When you do, a dialog box
prompts you to submit a reply of up to 2000 characters. The box also displays the original
message.

Ektron 8.7

1265

Managing User Communities

Replies do not appear when a micro-message is viewed. Instead, a Replies link appears
below the comment. The number of replies appears next to the link.

Click Replies to view them. The newest replies are at the top.

To remove a reply, click Delete ( ), which appears when you hover over the reply. Only the
user who submitted the reply and the message board owner can delete replies.
NOTE: If you are in a load-balanced environment, the same reply may appear several times. If this
problem occurs, stop the Ektron notification service on all but one of the servers in the cluster.

Filtering Micro-message Spam
You can filter spam from Micro-messages. Ektron defines spam filtering as preventing users
from posting a micro-message or replying using:
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l

the same message more than once a day

l

any second message within a specified time period after posting a first

l

the same message within a specified time period
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NOTE: If a user enters a micro-message and a reply that have the same text, each can be sent once
without being stopped by the spam filter. However, if either is sent a second time within the specified time
period, the spam filter blocks it.
The Micro-messaging server control also lets you define custom spam filters.
To define a spam filter, use the SpamControlType property on the MessageBoard server
control. The table below provides possible values and examples of how to set that property.
Ektron lets you filter spam from your message boards. Ektron defines spam filtering as
setting the following limits in MessageBoard server control’s SpamControlType property:
l

l

l

l

SameUserSameMessageSameDay—Prevent a user from posting the same comment
more than once a day.
SameUserTimeDelay—set the SpamTimeSpan property to 1800 to prevent a user
from posting any other comment for 30 minutes.
SameMessageTimeDelay—set the SpamTimeSpan property to 7200 to prevent a user
from posting identical comments for 2 hours.
Custom (and add the code to the code-behind page of the template containing the
MessageBoard server control)—Use your own spam filter code.

Creating a Custom Spam Filter
You can create your own spam filter in the code-behind of the page that contains the Micromessaging control. To do this, set the SpamControlType property to Custom, call the
CustomSpamMethod in the page load event, and point it to your custom spam filter method.
The following Visual Basic example blocks the text “Hello World.”
Partial Class Default
Inherits System.Web.UI.Page
Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles
Me.Load
Me.MicroMessaging1.CustomSpamMethod(AddressOf SpamHandler)
End Sub
Private Function SpamHandler(ByVal data As
Ektron.Cms.MicroMessageData) As Boolean
If data.MessageText = "Hello World" Then
Return True
End If
End Function
End Class

Using the PhotoGallery Server Control
NOTE: The PhotoGallery server control is deprecated. If you are already using the PhotoGallery server
control, you can continue to do so, but Ektron recommends using current versions of functionality.
The PhotoGallery server control helps users and community groups track and manage
images. They can organize the images in any number of taxonomy categories. For example,
a user might have the following organization.
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l

Science
l
Biology
l
Animals
l
Mammals
l
Lions
l

Bears

After you upload an image to the a Photo Gallery, site visitors can navigate through its
taxonomy and view the image.
When you associate this control with a community group, you can allow group members to
add, remove and control the sharing of folders in a workspace. Because this feature is
implemented on a group-by-group basis, it is controlled in the Workarea's Edit Community
Group screen. See Also: Allowing Community Group Members to Work with Folders on
page 1184
For information about PhotoGallery properties, see PhotoGallery on page 1808.
This section also contains the following topics.
l

Adding a Category below

l

Renaming a Category on the facing page

l

Deleting a Category on the facing page

l

Adding Photos to a Photo Gallery on the facing page

l

Changing a Photo Title or Description on page 1271

l

Moving and Copying Photos on page 1271

l

Deleting a Photo on page 1271

l

Sharing Photos on page 1271

l

Saving a Photo to Your Local System on page 1272

Categories
Adding a Category
You can add categories to your photo gallery to sort your photos. You also can use categories
to identify the types of users who can view the photos. For example, one category of photos
may be private, while another may be shared with all of your colleagues.
1. On the website, navigate to a User’s Profile Page > Photo Gallery.
2. Click Manage Folder (

). The Add box appears.

3. Enter a Name for the folder.
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4. In the Share area, select with whom you want to share your photos.
l
Public—Anyone who can access your profile
l

l

l

Colleagues—Only colleagues (either you accepted their invitation, or they
accepted yours)
Selected Colleagues—Colleagues that you designated as selected. See Also:
Using the PhotoGallery Server Control on page 1267
Private—Only you

5. Click Add. When the page refreshes, it opens to the newly added folder.

Renaming a Category
1. On the website, navigate to a User’s Profile Page > Photo Gallery.
2. Click Edit (

), located to the left of the category’s title. The Edit box appears.

3. Change the name of the category.
4. Click Save.

Deleting a Category
WARNING! Deleting a category permanently deletes all photos, as well as its subcategories.
NOTE: You can not delete the top-level folder, Albums.
1. On the website, navigate to a User’s Profile Page > Photo Gallery.
2. Click Edit (

), located to the left of the category’s title. The Edit box appears.

3. Click Delete. A dialog box appears asking you to confirm.
4. Click OK.

Photos
Adding Photos to a Photo Gallery
1. On the website, navigate to a User’s Profile Page > Photo Gallery.
2. Select a category where the photo will be added. If you want to create a new category,
see Adding a Category on the previous page
3. Click Add Photo. The Add Photo box appears
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4. In the Photo Data area, enter a Description and Maximum Width.

5. Click Next. The Add Photo dialog appears. Its appearance varies according to your
browser, as explained in Working with Assets in the Document Management System on
page 310.

6. User the Browse or Choose File button to navigate to the photo in your file system. Or,
you may be able to click the Drag Drop tab and drop a photo in the Add box. A status
box shows the files being uploaded. The page refreshes, and the photo appears in the
gallery.
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Changing a Photo Title or Description
1. On the website, navigate to a User’s Profile Page > Photo Gallery.
2. Select the category which contains the photo you want to change.
3. Click the triangle to the right of the photo’s title and choose Edit Properties.
4. Edit the photo’s Title, Description, or both.
5. Click Save.

Moving and Copying Photos
1. On the website, navigate to a User’s Profile Page > Photo Gallery.
2. Select the category from which to move or copy the photo.
3. Click the triangle to the right of the photo’s title and choose Copy.
4. Select the category to which the photo will be moved and click Manage.
5. Click Move or Copy. A dialog box asks you to confirm the action.
6. Click OK.

Deleting a Photo
1. On the website, navigate to a User’s Profile Page > Photo Gallery.
2. Select the category which contains the photo you want to delete.
3. Click the triangle to the right of the photo’s title and choose Delete. A dialog box asks
you to confirm.
4. Click OK.

Sharing Photos
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The Photo Gallery lets you share photos with your colleagues. You can share photos with the
Public, Colleagues, Selected Colleagues, or keep them private. You apply sharing options to
categories, not individual photos. See Also: Public—Anyone who can access your profile on
page 1269
1. On the website, navigate to a user’s Profile Page > Photo Gallery.
2. Click Manage Folder (

3. Click Share Folder (

). The Add box appears.

). The Share Workspace box appears.

4. Select with whom to share your photos.
l
Public—Anyone who can access your profile
l

l

l

Colleagues—Only colleagues (either you accepted their invitation, or they
accepted yours)
Selected Colleagues—Colleagues that you designated as selected. See Also:
Using the PhotoGallery Server Control on page 1267
Private—Only you

5. Click Share.

Saving a Photo to Your Local System
1. On the website, navigate to a User’s Profile Page > Photo Gallery.
2. Select the category that contains the photo you want to save.
3. Click the triangle to the right of the photo’s title and choose Save As... A dialog box asks
you to open or save the file.
4. Click Save.
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Using the SocialBar Server Control
The SocialBar server control lets users of a community website bookmark colleagues,
community groups, and content. The following table explains the details.
Item being
bookmarked

Users

Group

Content

Description

l

Sends colleague requests

l

Removes colleagues when a user visits another user’s profile page

l

Join and leave community group

l

Invite others to join group

Add or remove content and URLs from a user’s Favorites. See Also: Favorites on
page 1723

The Social Bar control also is used to bookmark Web pages with Social Bookmarking
services, such as Digg.com or del.icio.us. By default, Digg.com and del.icio.us are loaded in
the Items property of the server control.
In addition, the Social Bar control can print or email a Web page, and invite non-site users to
become members of the site. Clicking Invite links to a Web page that hosts the Invite server
control. See Also: Using the SocialBar Server Control above.
For information about SocialBar properties, see SocialBar on page 1845.

Adding a Web Page URL to a Favorites Via the Social
Bar
You can let users add a Web page’s URL to their Favorites when they click Add to Favorites
on the Social Bar. Typically, you would do this if more than one content item appears on a
Web page, but you want only one Social Bar control on the page.
1. Drag and drop a SocialBar server control on a Web form.
2. Set the DefaultObjectID property to 0 (zero).
3. Leave the DynamicObjectParameter property blank.
4. If it is not already there, copy the comma-separated list of items from the Items
property to the Addto item property.
5. Set the ObjectType property to Content.
The image below shows a Web page with several content items. A Social Bar control is
associated with each one. In this example, when a you click Add to Favorites, you add the
associated content item to your Favorites.
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In the second image, one Social Bar appears on the Web page with several content items. In
this example, if you click Add to Favorites on the Social Bar, you add the Web page’s URL to
your Favorites.

See Also: Using the SocialBar Server Control on the previous page

Sending a Private Message from the Social Bar
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You can send private messages to another user or the community group administrator from
the Social Bar control.
1. Drop a SocialBar server control on a user’s profile or community group’s page.
2. Set the ObjectType property to User or Group.
3. Add either PrivateMessageUser or PrivateMessageAdmin to Items property.
l
Use PrivateMessageUser to let a user send a message to the user whose profile is
being viewed.
l

Use PrivateMessageAdmin to let a user send a message to the group
administrator.

4. In the MessagingUrl property, identify a page that contains the Messaging server
control. See Also: Using the SocialBar Server Control on page 1273
5. Make sure the DynamicObjectParameter is set, if necessary.

Tweeting the Current URL
You can let site visitors use Twitter to tweet their current browsing location by adding the
Twitter item to the list of parameters in the SocialBar’s Items property. After the item is
added, a Twitter icon and link appear in the Social Bar. When you click the link, Twitter is
launched. After you log into your Twitter account, your current browsing location appears in
the “What are you doing?” status box. You then can click Twitter’s Update button to post the
status.
1. Drag and drop a SocialBar server control on a Web form.
2. Make sure the DefaultObjectID property is set to 0 (zero).
3. Leave the DynamicObjectParameter property blank.
4. If it is not already there, add the Twitter item to the comma-separated list in the Items
property.
5. Set the ObjectType property to Content, User or Group, depending on the type of
page you are editing.

Using the CommunityDocuments Server Control
Part of the Community Platform, this server control lets users create and upload individual
user content to the user profile or group content to the group profile. The content can be HTML
content or an asset, such as a .PDF document or a .jpeg file. For reference information, see
CommunityDocuments on page 1685.

Using the CommunityDocuments Server Control in an
Individual User Profile
Adding Folders to Your Workspace
1. On the website, navigate to a User’s Profile Page > Workspace.
2. Click Manage Folder (

). The Add Folder box appears.

3. Enter a Name for the folder.
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4. Determine with whom you want to share the folder's documents. For a description of the
Share options, see Sharing Workspace Content on the facing page.
5. Click Add. The page refreshes and displays the newly added folder.

Editing a Folder Name in Your Workspace
1. On the website, navigate to a User’s Profile Page > Workspace.
2. Click Edit (

), located to the left of the folder’s title. The Edit Folder dialog appears.

3. Change the name of the folder.
4. Click Save. The page refreshes and shows the folder's new name.

Deleting a Folder from Your Workspace
NOTE: You can not delete the top-level folder, Workspace.
WARNING! Deleting a folder permanently deletes the assets and HTML content in the folder, and its
subfolders.
1. On the website, navigate to a User’s Profile Page > Workspace.
2. Click Edit (

), located to the left of the folder’s title. The Edit Folder dialog appears.

3. Click Delete. A dialog box asks you to confirm.
4. Click OK.

Adding Assets to a Workspace
Assets are files that are not HTML content, such as an Office document or PDF.
1. On the website, navigate to a User’s Profile Page > Workspace.
2. Select a folder to which the asset will be added. If you want to create a new folder, see
Adding Folders to Your Workspace on the previous page
3. Click Add Asset (

). The Add Asset box appears. Its appearance varies depending on

your browser, and so on. To learn about these variations, see Methods for Importing
Assets on page 315.
4. Import one or more assets, depending on the screen. A status box shows the files being
uploaded and then the asset(s) appear in the file list.

Creating HTML Content in Your Workspace
1. On the website, navigate to a User’s Profile Page > Workspace.
2. Select a folder where the content will be added. If you want to create a new folder, see
Adding Folders to Your Workspace on the previous page
3. Click Add HTML Content (

). The Add HTML Content window appears.

4. Add a title and content.
5. Click Publish to publish the content.
6. The HTML content appears in the file list.

Moving and Copying Content in Your Workspace
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You can move or copy assets and HTML content from one folder to another. To accomplish
either action:
1. On the website, navigate to a User’s Profile Page > Workspace.
2. Select the folder from which to move or copy the content.
3. Click the drop-down triangle to the right of the content title.

4. From the drop-down list, select Copy.
5. Select the folder to which the content will be moved.
6. Click Manage.
7. Click Move Items (

) or Copy (

). A dialog box asks you to confirm.

8. Click OK. The moved or copied content appears in the folder.

Sharing Workspace Content
The Workspace area allows users to share content with colleagues. Users can share content
with the Public, Colleagues, Selected Colleagues or keep the content private.
Users apply sharing options to folders, not individual content items. To share a folder:
1. On the website, navigate to a user’s or community group's Profile Page >
Workspace.
2. Locate the folder you want to share.
3. Click Manage Folder (
4. Click Share Folder (

). The Add or Share Folder dialog box appears.
) in the top right corner. The Share Folder dialog box appears.

5. Select with whom to share your folders.
l
Public—Everyone viewing your Workspace
l

l

l

Colleagues—Only colleagues. See Also: Using the CommunityDocuments Server
Control on page 1275 server control
Selected Colleagues—Only selected colleagues See Also: Using the
CommunityDocuments Server Control on page 1275
Private—Only you
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6. Click Share.
Documents in the folder are now available for viewing by the selected viewer type.

Using CommunityDocuments with a Group Profile
Adding Folders to the Group Workspace
Community group members can add folders to the Workspace to help organize items in the
Documents area.
1. On the website, navigate to a community group’s Profile Page > Workspace.
2. Click Manage Folder (

). The Add Folder dialog appears.

3. Enter a Name for the folder.
4. Determine with whom you want to share the folder's documents.
l
Public—anyone can view and edit the document
l

Private—only group members can view and edit the document

NOTE: If you want to later change a folder's share setting, follow the directions in Sharing
Workspace Content on the previous page.
5. Click Add. The page refreshes and displays the newly added folder.

Editing a Folder Name in a Group Workspace
1. On the website, navigate to a community group Profile Page > Workspace.
2. Click Edit (

), located to the left of the folder’s title. The Edit Folder dialog appears.

3. Change the name of the folder.
4. Click Save. The page refreshes and shows the folder's new name.

Deleting a Folder from a Group Workspace
NOTE: You can not delete the top-level folder, Workspace.
WARNING! Deleting a folder permanently deletes all of the assets and HTML content in the folder, as
well as its subfolders.
1. On the website, navigate to a community group's Profile Page > Workspace.
2. Click Edit (

), located to the left of the folder’s title. The Edit Folder dialog appears.

3. Click Delete. A dialog box asks you to confirm.
4. Click OK.
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NOTE: eCommerce requires a special license from Ektron. If you do not see the Commerce folder under
Settings tab of the Workarea, it may be because your license does not support eCommerce. For licensing
information, contact sales@ektron.com.
Ektron eCommerce gives you an entire tool set for building the online marketplace you want.
Ektron lets you manage both your website and online marketplace from the same interface.

eCommerce Feature Overview
Ektron’s eCommerce solution is a flexible and feature-rich platform that offers the
functionality that shoppers expect in an online marketplace.
l

l

l

l
l

eCommerce reuses many standard Ektron components, so you can leverage existing
Ektron experience to quickly build the store and use server controls to create the Web
pages that customers (site visitors) use to purchase goods and services on the site.
Administrators manage products, review inventory, and use Ektron’s powerful taxonomy
to enhance product SEO.
Developers use the flexible and scalable API to import an existing store, configure a
customized integration with a payment gateway and integrate with financial software.
You can sell memberships and/or access to premium content.
State and local governments can process online vehicle registration and tax payments,
and event sites can sell tickets.

NOTE: Only members of the Administrators group or those assigned the Commerce Admin role can
access the eCommerce screens within the Workarea. See Also: Defining Roles on page 1120.

Core Features
l

l
l

l

Shared data—As a .NET application, eCommerce uses the same database as Ektron (to
maximize efficiencies) and takes advantage of SQL cluster capabilities to be scalable.
You do not need “glue code” to tie a third-party eCommerce application to your website.
Ektron eCommerce integrates with an IT infrastructure using Ektron’s existing
customizability. Open architecture and a new ektron.cms.commerceAPI makes any
commerce configuration possible, letting you connect it to your back-end systems.
Imported data—Import existing product data into eCommerce using Ektron’s API.
Flexiblility—eCommerce supports single items, complex products (for example, movies
on DVD, Blu-ray®, or other formats), bundles, and kits.
Enhance your SEO—You can enhance product SEO in the Smart Form by setting
attributes, adding metadata, and including photos and other media.
o eCommerce uses key Ektron technologies, including Smart Forms, taxonomy and
search. Smart Forms standardize how product information is entered; information,
attributes, and descriptive text are entered in one place and goes into the database
as structured XML data (making it easy to re-purpose this content wherever and
whenever you need it).
o
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Adding images of products automatically generates thumbnail images and gives you
complete control over sizes and number of images, as well as a click-through image
gallery. You also can define images for a product type via the taxonomy.
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l

l

l

Classify products in multiple ways—taxonomies help customers find what they are
looking for by associating them with multiple categories. For example, a wireless mouse
and an external hard drive may each belong to a computer peripherals category, but
also in categories about mouses and disk storage. Control over your product catalog
extends to cross-sell and upsell features.
Web 2.0 controls—include memberships, ratings, forums and commenting that let you
quickly implement an eCommerce site with the community-based information customers
want to help them to make buying decisions. Your customers can post opinions and
ratings on products. The product search uses taxonomy, which you can filter by price,
ratings, reviews, and more.
eCommerce customer memberships—Customers can create and save shopping baskets
for future purchases, or create wish lists and registries. Your site administrators can see
which baskets are open.
o When an order is reviewed and submitted (and payment is authorized), it can go
through a simple or complex routing through your processing setup or plug-in to
your existing CRM or ERP to process the order.
o

When the order is processed, the CRM/ERP notifies Ektron that it is complete.
Online inventory is kept up-to-date; you can set properties so that when items on
hand drop below a certain level, it triggers a sequence to notify your inventory
control.

o

You can display the checkout process on a single page or distribute them across
multiple pages. Customers can save one or more shipping addresses, or check
“same as billing” when they check out.

o

You can accept credit cards, checks, and PayPal accounts. Ektron also supports
payment gateways (such as Payflow and Authorize.Net) to authorize and capture
transactions. You can create your own payment gateway (that allows terms or
other payment options, for example).

o

Connect with external providers to use real-time rates for shipping, or you can use
your own rates by setting up an internal shipping provider. You can customize rates
and set up rates by package size, product weight, and even product price ranges.

Coupons, Taxes and Pricing
l

l

l

l

eCommerce supports an array of pricing schemes: individual pricing, separate pricing
within complex products, tiered pricing to support volume discounts, and more.
Online coupon capability is also included, letting you set the type (dollar amount,
percentage) and at what level those coupons are applied (product level, basket level and
type of item).
For global business opportunities, international currencies are available. You can use
conversion rates to determine prices or set flat costs for each product. This goes handin-hand with the tax options available.
Set tax classes, including country, state, and local (by postal code), and taxes for
specific classes of goods.

Sample eCommerce Site
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Ektron OnTrek is a sample eCommerce site. Within that site, you can try out a customer
shopping experience by going to http://[siteroot]/OnTrek/. Login to OnTrek and go to
Products > Software. A product catalog screen appears. For information about Ektron
OnTrek, see the .
Click the Add to Cart link below a product. You can proceed through a sample checkout
process.
OnTrek uses the following eCommerce server controls to facilitate this process.
l

Cart on page 1672

l

Checkout on page 1673

eCommerce Architecture
The Ektron eCommerce architecture is composed of several key systems:
l

Catalog/Inventory systems

l

Order system

l

Shipping system

The eCommerce API sits within the core Ektron system with customization and integration
points. The following figure shows how the eCommerce API fits into the overall Ektron
architecture.
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The following topics provide an overview of several key eCommerce systems.
l

eCommerce Workflow below

l

eCommerce Order Fulfillment on the next page

l

eCommerce Inventory Process on page 1285

l

eCommerce Subscription Model on page 1286

l

eCommerce Shipping Process on page 1287

l

Conducting eCommerce on page 1279

eCommerce Workflow
Ektron leverages Windows Workflow Foundation for order processing.
Windows Workflow Foundation is a framework that enables users to create system or human
workflows. It consists of a namespace, an in-process workflow engine, and designers for
Visual Studio. It comes with a programming model, a re-hostable and customizable workflow
engine, and tools for quickly building workflow-enabled applications on Windows.
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Windows Workflow Foundation gives site developers complete control over how your store
“works”. The workflow is completely extensible and can integrate with third-party ERP/CRM
systems. There are default Ektron activities such as email notification and inventory checks,
and the workflow can be customized to match the organization's business processes.

eCommerce Order Fulfillment
Order processing in Ektron includes the management of custom coupons, shipping providers,
tax calculation and payment providers.
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eCommerce Inventory Process
The inventory process uses an inventory provider model. You can use the inventory system
included as part of Ektron’s eCommerce module, or plug into external systems. It is called
from the order workflow and is completely extensible.
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eCommerce Subscription Model
Ektron’s eCommerce solution lets you not only sell durable goods, but also memberships and
subscriptions. It uses a provider model, and the default implementation provisions users into
groups.
You let shoppers buy membership directly on your site (access to assets or content) and
configure recurring billing at any interval.
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eCommerce Shipping Process
The shipping system calculates real-time shipping rates from FedEx or UPS by default.
However, its provider model lets you configure the API to access rates from any provider. It
is completely customizable and extensible.

Ektron 8.7
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Additional eCommerce Topics
This chapter also contains the following topics.
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l

Designing an eCommerce Site on the facing page

l

Setting Up an eCommerce Website on page 1293

l

Configuring eCommerce on page 1305

l

Creating Product Types and Catalogs on page 1343

l

Recommending Related Products to a Customer on page 1371

l

Using Coupons on page 1373

l

Managing Customer Orders on page 1381

l

Viewing Customer Information on page 1395

l

Generating eCommerce Reports, Widgets, and Logs on page 1397

l

Using the eCommerce Server Controls on page 1404

l

Customizing eCommerce on page 1435
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Designing an eCommerce Site

See Also: Using eSync with eCommerce on page 1563

Designing an eCommerce Site
This chapter uses a fictitious site, EktronStore.com, to demonstrate how to set up, build, and
deploy an online marketplace using Ektron. EktronStore.com sells furniture and accessories
and leverages many eCommerce features.
Before starting to build EktronStore.com, consider the goals of your online marketplace. Do
you want to simply sell as many products as possible? Or, do you see your store as a valueadded component designed to enhance the customer (site visitor) experience?
When considering store design and functionality, what you intend to sell plays a significant
role in this endeavor. For example, are you selling durable goods? Subscriptions? Access to
premium content? All of the above? Make sure you consider this when planning the store's
layout.
Shipping options, payment methods, taxation, and the general look-and-feel of your store
also need to be determined. Make sure you address the general workflow of your store—that
is, how shoppers are guided through the entire shopping experience.

Designing the Sitemap
It all starts by planning the basic architecture of the store. This is called a “sitemap,” and
depicts the architecture of the website. It can be either a document used as a planning tool
for Web design, or a Web page that lists the pages on a website, typically organized in
hierarchical fashion.
Essentially, the sitemap identifies the major pages, sections, sub-sections, and shared
elements of the site.

Ektron 8.7
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Designing the Wireframes
Next, plan and scope out the major pages in your store. Using pencil and paper or software,
sketch the basic architecture and components of individual store pages. This visual guide is
referred to as a “wireframe”.

Creating Mockups
The wireframe helps inform visual design. Typically, a graphic artist creates mockups (or
visual preview) of store pages for stakeholders to see without actually building Web pages.
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Creating Callouts

Creating Callouts
Callouts help identify functional areas on store pages. Using the mockups, identify navigation
areas, locations for promotional information, header and footer details, and the location of
Ektron controls.

Ektron 8.7
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Using Images in eCommerce
When using eCommerce, a customer sees images that represent products or services for
sale. The following list shows each image that appears on an eCommerce website, and its
source.
l

Product Server Control, main image, located on the catalog entry's Content tab.
NOTE: The sample catalog entries are based on Product Types whose XML Smart Form includes
an Image field. As a result, the product description, (which appears at the top of the Product Server
control) includes an image. This is not required, merely a suggested implementation.
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Setting Up an eCommerce Website

l

Product Server Control, thumbnails, located on the catalog entry's Media screen.
NOTE: To control the thumbnail display, use the XSLT files generated by the Product, Product List,
Product Search, and Recommendation server controls.
When a customer clicks a thumbnail, the corresponding full image appears.
Because the Media screen can have several images, several thumbnails can appear.
They appear left to right reflecting their sequence (top to bottom) on the Media screen.
If an image’s Gallery Display field is set to Yes, its smallest thumbnail appears on the
Product server control, below the content area. (This assumes you are using the
control’s default XSLT.) See Also: Determining Thumbnail Size on page 1367

l

Product List, Product Search, and Recommendation server controls located on the
catalog entry’s Media tab, the image designated as Product Icon. See Also: Entering a
Catalog Entry’s Media on page 1366

Setting Up an eCommerce Website
This section describes how to set up a basic eCommerce website. This walkthrough explains
everything you need to set in the web.config file and the Workarea. It also includes a list of
templates needed and how to set up Ektron’s eCommerce server controls on them.

Required Templates
To create a basic eCommerce site, you need the following templates.
l

Master page—recommended, but not absolutely necessary. This template could
contain any of the following:
l
Select Currency—allow customers to choose a currency with the CurrencySelect
on page 1716server control.

Ektron 8.7
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l

l

l
l

l

l

l

l

l

View Cart link—links to the template containing the Cart on page 1672 server
control.
View My Account / Orders link—links to the template containing the MyAccount
on page 1804 and OrderList on page 1806 server controls.
Login server control—allows customers and users to log in from any page.

Landing page—this page should enable customers to start shopping and could contain a
Product on page 1815 server control.
Product Display page—use the Product on page 1815 server control on a template to
display the details of a catalog entry (product). If you are using the Cross Sell or Up Sell
functionality, add a recommendation server control to this template.
Product Search page—use the Product Search Server Controls on page 1822 on a
template to let customers search for product.
Cart page—use the Cart on page 1672 server control on a template to allow a customer
to work with the items they have selected to purchase.
Checkout page—use the Checkout on page 1673 server control on a template to
facilitate the check out process.
My Account / Order History page—use a MyAccount on page 1804 and an OrderList
on page 1806 server controls to display a customer’s account information and a list their
order history.

Step 1. Set Keys in web.config File
WARNING! Do not change the settings for the default currency or measurement system after the site is
live.
In the website’s web.config file, set the following keys:
l

<add key=”ek_ecom_DefaultCurrencyId” value=”840” />
This key determines the base currency for your website. The default is 840 (the US
Dollar). If needed, change this to the Numeric ISO code for the default currency. A list of
currencies and their Numeric ISO codes can be found in the Workarea > Settings >
Commerce > Configuration > Currencies section. The ID is the Numeric ISO
code.See Also: The Default Currency on page 1308

l

<add key=”ek_MeasurementSystem” value=“English” />
For each item sold on your website, you define a height, length, depth, and weight. If
English, the units are inches and pounds. If Metric, the units are centimeters and
kilograms. This information is used to calculate shipping costs. By default, this is set to
English. Change to Metric to use the Metric system. See Also: Configuring Packages on
page 1330

l

<add key=”ek_ecom_ComplianceMode” value=”false” />
Set this key to “true” when you want your site to be Security Compliant. This means the
Workarea will be encrypted in an SSL session and Logging is started.

Step 2. Select Inventory System
Decide whether you want to use Ektron’s inventory system or another system.
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Step 3. Select a Default Payment Gateway

If you are not using Ektron’s inventory system, create a custom inventory provider and add it
to the web.config file’s InventoryProvider. Ektron’s Inventory Provider feature lets you work
with an existing inventory system.
Add the custom provider between the InventoryProvider’s <providers> tags and change the
default provider to the name of your custom inventory provider. For example:
<inventoryProvider defaultProvider=”MyCustomInventoryProvider”>
See Also: Customizing the Inventory Provider on page 1463

Step 3. Select a Default Payment Gateway
1. Navigate to Settings > Commerce > Configuration > Payment Gateway.
2. Click a payment gateway’s name.
3. Click Edit.
4. Add your User ID, Password and any needed Custom Values.
5. Click the Default check box to make that selection the default.
6. Click Save.
NOTE: If you decide to use PayPal instead of one of the default payment options, see Using PayPal with
Ektron eCommerce on page 1312.
If you are not using one of these gateways, create a custom payment provider and add it to
the web.config file’s EktronPaymentGateway. Add the custom provider between the
EktronPaymentGateway’s <providers> tags. When added, the option should appear in the
Workarea’s Payment Gateway screen.
If you want to override the Workarea settings, change the default provider in the web.config
file from “Automatic” to the name of the desired payment gateway. For example:
<EktronPaymentGateway defaultProvider=”AuthorizeNet”>
See Also: Configuring Payment Options on page 1311.

Step 4. Set up a Shipping Provider
If you are not using the default flat rate shipping provider, open the shipment.config file and
set the default provider in formation in: <shipmentProvider
defaultProvider=”FlatRateShipmentProvider”> to either “FedExShipmentProvider” or
“UPSShipmentProvider”. If you are using either of these shipping methods, make sure you fill
in the following information in the <providers> tags. This information is provided by FedEx
and UPS.
l

key=””

l

password=””

l

accountNumber=””

l

meterNumber=””

In addition to using these providers, you can add additional providers.
See Also: Configuring eCommerce Shipping Screens on page 1329

Step 5. Enable Countries
Ektron 8.7
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Enabling a country where your website will sell its products:
l

l
l

makes it available for customers to use as part of an address for shipping and billing
purposes
makes it available when you add a warehouse
automatically enables its corresponding tax table in the Country Tax Table section of the
Workarea

NOTE: The United States is enabled by default.
To enable countries:
1. Navigate to Settings > Commerce > Configuration > Countries.
2. Click a country’s name.
3. Click Edit.
4. Click the Enabled check box.
5. Click Save.
See Also: Configuring Countries on page 1305

Step 6. Add and Enable Regions
Add and enable regions for each country your eCommerce site will service.
NOTE: All states in the US are enabled by default.
Regions can represent states, provinces, territories, and so on and further define areas of a
country. Adding and enabling regions:
l

l
l

makes it available for customers to use as part of an address for shipping and billing
purposes
makes it available when you add a warehouse
automatically enables its corresponding tax table in the Regions Tax Table section of the
Workarea

To add and enable regions:
PREREQUISITE
The region’s country is defined in the Countries screen.
1. Navigate to Settings > Commerce > Configuration > Regions.
2. Click New > Region.
3. Enter a name.
4. Click the Enabled check box.
5. In the Code box, enter an abbreviation for this region.
6. Select this region’s country from the pull down list.
7. Click Save.
See Also: Configuring Regions on page 1306

Step 7. Enable Currencies
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Step 8. Select Credit Cards

If your website is selling products in another country and you want to display prices in its
currency, enable it in the Workarea:
NOTE: By default, U.S. dollar, Euro, and Australian dollar are enabled.
1. Navigate to Settings > Commerce > Configuration > Currencies.
2. Click a currency.
3. Click Enable.
4. Set the Exchange Rate. The default currency (set in the web.config file) is the base
reference currency when setting an exchange rate.
5. Click Save.
See Also: Configuring Currencies on page 1307

Step 8. Select Credit Cards
Decide which credit cards your eCommerce site will accept.
Credit cards are used during the checkout process, by the Checkout server control, during the
submit phase. During this phase, all enabled credit cards appear in a drop-down, which
customers use to select their choice.
Add credit card types in the Workarea.
1. Navigate to Settings > Commerce > Configuration > Credit Card.
2. Choose New > Credit Card Type.
3. Enter the credit card’s name; for example, Visa.
4. Check the Accepted check box.
5. Add an image.
6. Add a Regex Expression to validate the credit card number.
7. Click Save.
See Also: Configuring Credit Card Types on page 1327

Step 9. Add or Edit Notification Messages
Email notifications are sent to your customers after their order has been received, canceled,
shipped or completed. Ektron provides 4 predefined messages, 1 for each event. For
messages to be sent, content notifications must be enabled and the customer must enter a
valid email address.
1. Navigate to Settings > Commerce > Configuration > Messages.
2. Click the title of the message.
3. Click Edit.
4. Change the properties and fields as necessary.
5. Change the text as needed.
See Also: Configuring eCommerce on page 1305

Step 10. Create Tax Classes (Optional)

Ektron 8.7
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If you are collecting taxes for transactions on your eCommerce site, create a Tax Class for
each taxable category of products. For example, if your eCommerce site sells alcohol and
tobacco, set up a tax class for each type. Ektron provides 4 default tax classes:
l

Alcohol

l

Goods

l

Services

l

Tobacco

Tax classes are applied to Postal, Regional and Country Tax Tables. In those tables, you
define a separate rate for each Tax Class.
1. Navigate to Settings > Commerce > Tax > Tax Classes.
2. Choose New > Tax Class.
3. Enter a name; for example, Food.
4. Click Save .
See Also: Cataloging Entries that Can Be Taxed on page 1338

Step 11. Set Tax Rates
When your Tax Classes are set up, set a tax rate for each class in the Postal, Regional, or
Country Tax Tables.
l

l

l

Postal Tax Tables—use when there is a city or county tax. If there are postal, regional
and country taxes applied to a given area, roll them all into this table.
Regional Tax Tables—Use when there is a state, provincial or territorial tax. If only
regional and country taxes are applied to a given area, roll them into this table.
Country Tax Tables—Use when there is country-wide tax. If only country level taxes are
applied to a given area, use this table.

Ektron checks these tables in the following order: Postal, Regional, then Country. When it
finds a tax, it stops. Therefore, if a postal zone has several taxes (for example, a local tax
and a regional tax), build the combined percentage into the postal code tax. So, if New York
City has a 4% tax, and New York state has a 3% tax, enter 7% into all Postal Tax Tables
within New York City.
While you need to create each Postal Tax Table, Regional and Country Tax Tables are
automatically generated when a country or region is added to Ektron. However, no tax rates
are defined in these tables.
To create a new Postal Tax Table:
1. Navigate to Settings > Commerce > Tax > Postal Tax Tables.
2. Choose New > Postal Code.
3. Enter a Postal Code.
4. Select the Country and Region.
5. Enter a tax rate for each Tax Class as needed.
6. Click Save.
To edit a Region’s or Country’s Tax Table:
1. Navigate to Settings > Commerce > Tax > Regional Tax Tables or Country Tax
Tables.
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Step 12. Select Shipping Methods

2. Click the Id or Code of the Region or Country.
3. Click Edit.
4. Change the information as needed.
5. Click Save.
See Also: Applying Local Taxes on page 1339, Configuring Regional Tax Tables on page 1340,
Configuring Country Tax Tables on page 1341

Step 12. Select Shipping Methods
When you set up a shipping provider, define your customers' shipping options. For example,
if you use UPS, define whether to allow Next Day, 2nd Day, 3rd Day, Ground, World Wide
Standard, and so on. When enabled, a Shipping Method appears in the Shipping Method phase
of the Checkout server control.
1. Navigate to Settings > Commerce > Shipping > Methods.
2. Choose New > Shipping Method.
3. Enter a Name. This name represents the option in the Shipping Method phase of the
checkout server control.
4. Click the Active check box to enable this method.
5. Click View Options.
6. From the Provider Service drop-down, select a shipping method.
7. Click Save.
8. Repeat these steps for all shipping methods.
See Also: Configuring Shipping Methods on page 1331

Step 13. Add a Warehouse
Add a warehouse from which your products will be shipped. This does not have to be the
actual shipping address for the products. Ektron uses this information to determine the “from”
address when calculating shipping cost.
1. Navigate to Settings > Commerce > Shipping > Warehouses.
2. Choose New > Warehouse.
3. Complete the address information fields. Only countries and regions that have been
enabled for eCommerce appear in the drop-down lists.
4. Click the Default Warehouse check box if you want this to be the default warehouse.
Only the default warehouse is used in the checkout process.
5. Click Save.
See Also: Using a Warehouse on page 1329

Step 14. Define Package Sizes
Define each package size your shipping department uses to ship your products. Tangible
products have size and weight dimensions. Ektron’s shipping calculator uses this information
to fit the order into the smallest-sized and fewest packages. It then passes packaging
information (number, sizes and weight) to the shipping provider, which returns the order’s
shipping costs.

Ektron 8.7
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1. Navigate to Settings > Commerce > Shipping > Packages.
2. Choose New > Package.
3. Enter a Name, Length, Height, Width and Maximum Weight a package can handle.
4. Click Save.
5. Repeat these steps for all package sizes your company uses.
See Also: Configuring Packages on page 1330

Step 15. Create Product Type Definitions
NOTE: The remaining steps in this example are based on selecting a Product for the Product Type Class.
Product types are applied to catalog folders and let you control the way product information is
added to a catalog. This is similar to how Smart Form configurations, once applied to content
folders, affect the way Smart Forms are created. You can apply multiple product types to a
catalog.
1. Navigate to Settings > Commerce > Catalog > Product Types.
2. Choose New > Product Type.
3. Define the Product Type.
4. Click Save and move to the next step.
More Information: Creating Product Types on page 1343

Step 16. Create Content Page
After clicking Save from the previous step, a content editor appears and lets you enter XML
Smart Form information. A user completes this Smart Form when creating a Catalog Entry
(Product).
The information appears on a product’s details page on your website.
You might want to create these fields on your smart form.
l

Title

l

Description

l

Image

After you complete the Smart Form, click Save.
See Also: Creating Product Types and Catalogs on page 1343, Working with Smart Forms on
page 423

Step 17. Create a Catalog
A catalog folder is an Ektron folder designed to hold eCommerce catalog entries (products).
This is similar to the way content folders hold HTML or Smart Form content. By assigning a
product type to the folder, you can control the way products are added to the catalog.
1. Click the Content folder bar to display the list of content folders.
2. Choose New > Catalog.
3. Set the catalog’s Properties, Metadata, Web Alerts and Breadcrumb information.
(Similar to creating a Content Folder.)
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Step 18. Add Catalog Entries

4. On the Product Types Tab, select a Product Type from the drop-down list.
5. Click Add.
6. Click Save.
See Also: Creating a Catalog Folder on page 1354, Assigning a Catalog Folder’s Product Type
on page 1355

Step 18. Add Catalog Entries
Catalog Entries are products you offer on your eCommerce website. For example, a catalog
entry could be a CD, a subscription-based service, or a computer that a customer can
customize and the price adjusts accordingly.
1. Navigate to a catalog folder.
2. Click New and select a product type.
3. In the Title field, enter a name for the catalog entry.
4. Fill out the fields in the Smart Form as necessary.
5. Select the Summary tab and add a summary. (Optional)
6. Select the Properties tab and enter an SKU and the number of units that equal one
purchase.
7. Select a Tax Class.
8. If the product is a tangible product, click Expand next to Dimensions, click the Tangible
check box and enter the product’s physical dimensions. If you are using Ektron as your
inventory system, click Expand next to Inventory and enter the information.
9. Select the Pricing tab and enter the product’s list and sales price. If you offer a quantity
discount, click Add Pricing Tier and add a quantity and a tier price. If you enabled
multiple currencies, select a currency from the drop-down and add pricing information
as needed.
10. Select the Attributes tab and fill out or change attributes as needed. (If you did not
define attributes in Step 15. Create Product Type Definitions on the previous page, the
Attributes tab does not appear.)
11. Select the Media tab and click Add Images to associate images with the catalog entry.
12. The Items tab is used to create a complex product. This lets you offer variants of a
product at different price points. For this example, we will skip this tab. See Also:
Creating a Complex Product on page 1348.
13. Enter information as needed on these tabs: Metadata, taxonomy and Schedule.
14. Choose Action > Publish.
To add Cross Sell or Up Sell items associated with this catalog entry, click its Title and then
click View > Cross Sell or Up Sell. These items appear in the Recommendation server
control when it is associated with this catalog entry.
See Also: Creating a Catalog Entry on page 1356

Step 19. Create a Master Page
Create a master page and add the following items to a header area or left side column.
l

CurrencySelect server control—Lets customers select from available monetary
types. This control displays currencies that have been enabled in Step 7. Enable

Ektron 8.7
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Currencies on page 1296. A My Cart link that leads to a template containing the Cart on
page 1672 server control. See Also: CurrencySelect on page 1716 server control
l

l

l

l

My Account / Order History link—Leads to a template containing the MyAccount and
OrderList server controls. See Also: OrderList on page 1806 server control
Product Search link—(Optional) Adds a link that leads to a template containing a
ProductSearch server control. See Also: MyAccount on page 1804 server control
Product Search server control—(Optional) Allows user to search for a product from
anywhere on the site. Note: Adding this option is involves more than just dragging and
dropping a server control to the header or the left side column. It includes advanced
customizations and coding to pass a search term from one form to another. See Also:
ProductSearchInputView on page 1823 and ProductSearchResultsView on page 1824
server controls
Login server control—(Optional) Allows existing customers to log in upon arrival at
your site. If you only want customers logging in through this control, set the
OnlyAllowMemberLogin property to True. See Also: Login on page 1763 server control.

Step 20. Create a Landing Page
This template should be the first page a customer sees when arriving at your site. It should
have a mechanism that lets customers start shopping. Make sure this page has one of the
following:
l

ProductList server control—Use this control to display products by taxonomy,
Catalog or ID. See Also: Creating Product Types and Catalogs on page 1343
l
To display a single taxonomy, set the SourceType property to Taxonomy and enter
a single Taxonomy ID in the SourceId property.
l

l

l

l

l

l

To display multiple taxonomies, set the SourceType property to TaxonomyList and
enter a comma-separated list of Taxonomy IDs in the IdList property.
To display a single catalog, set the SourceType property to Catalog and enter a
single catalog ID in the SourceId property. If you want to display sub catalogs for a
given ID, set the Recursive property to True.
To display multiple catalogs, set the SourceType property to CatalogList and enter a
comma separated list of catalog IDs in the IdList property.
To display products by their ID, set the SourceType property to IdList and enter a
comma-separated list of product IDs in the IdList property.
Set the TemplateProduct property to the template containing the Product server
control.

ProductSearch server control—This control provides the means for customers to
search your website for products. If this control is not on your landing page or part of
your master page, you should create a separate template containing this control.
l
Set the CatalogId property to the ID of the catalog to search.
l

l

Set the TemplateCart property to the template containing the Cart on page 1672
server control.
Set the TemplateProduct property to the template containing the Product server
control.
See Also: Product Search Server Controls on page 1822
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Step 21. Create a Product Page

Step 21. Create a Product Page
This page allows a customer views a product’s details. It contains a Product server control
and optionally a Recommendation server control.
l

Product server control—This control displays a product’s details. See Also: Product
on page 1815 server control
l
Make sure the DynamicParameter property is set to the parameter name used to
pass product IDs to the QueryString.
l

If you want a default product to display when no ID is passed, set the
DefaultProductID property to the ID of a product.

Set the TemplateCart property to the template containing the Cart on page 1672
server control.
Login server controlLogin server control
l

l

Recommendation server control—This control displays Cross Sell and Up Sell
opportunities associated with a product. These are set in Workarea, under the View
menu’s Cross Sell and Up Sell selections for a catalog entry. See Also: Recommendation
on page 1826 server control
l
Set the RecommendationType property to CrossSell or UpSell.
l

l

l
l

Make sure the DynamicProductParameter property is set to the parameter name
used to pass product IDs to the QueryString.
If you want a product’s default Cross Sell or Up Sell items to display when no ID is
passed, set the DefaultProductID property to the ID of a product.
Set the TemplateCart property to the template containing the Cart server control.
Set the TemplateProduct property to the template containing the Product server
control.

Step 22. Create a Product Search Page
This page lets customers search for products on your website.
l

ProductSearch server control—This control provides the means for customers to
search your website for products. If this control is not on your landing page or part of
your master page, you should create a separate template containing this control.
l
Set the CatalogId property to the ID of the catalog to search.
l
l

Set the TemplateCart property to the template containing the Cart server control.
Set the TemplateProduct property to the template containing the Product server
control.
See Also: Product Search Server Controls on page 1822

Step 23. Create a Cart Page
This template contains a Cart server control.
l

Cart server control—This control allows a customer to work with products they have
selected to purchase. As a customer navigates around your site selecting products to
purchase, they are added to a cart. See Also: Cart on page 1672 server control

Ektron 8.7
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l

l

l

l

Set the TemplateCheckout property to the template containing the CheckOut server
control.
Set the TemplateProduct property to the template containing the Product server
control.
Set the TemplateShopping property to the Landing page template or a template
containing a ProductList or ProductSearch server control.
If you are using coupons, make sure the EnableCoupons property is set to True.

Step 24. Create a Checkout Page
This template contains a Checkout server control.
l

Checkout server control—This control allows a customer to navigate through the
checkout process.See Also: Checkout on page 1673 server control
l
Set the DefaultCountryID property to the country you want to be the default
selection in the Billing and Shipping address sections.
l
l

l

l

Set the TemplateCart property to the template containing the Cart server control.
Set the TemplateOrderHistory property to the template containing the OrderList
server control.
Set the TemplateShopping property to the landing page template or a template
containing a ProductList or ProductSearch server control.
If you are using SSL Encryption, set the IsSSLRequired property to True.

WARNING! You should use SSL Encryption for this page because credit card information is entered into
the Checkout server control.

Step 25. Create a My Account Page
This template contains a MyAccount and an OrderList server control. See Also: MyAccount on
page 1804 server control
l

MyAccount server control—This server control lets customers view billing, shipping
and alternative shipping information associated with their account.
l
Set the DefaultCountryID property to the country you want to be the default
selection in the Billing and Shipping address sections.
l

l

OrderList server control—This server control lets customers view a list of their
processed orders.
l
Make sure the DynamicOrderParameter is set to the parameter name used to pass
order IDs to the QueryString.
l

1304

(Optional) Set the CustomPropertyID property to the ID or list of comma separated
IDs that represent custom properties associated with users. Custom Properties are
set up in Ektron’s Workarea > Settings > Configuration > Custom Properties.

Make sure the DynamicProductParameter is set to the parameter name used to
pass product IDs to the QueryString.

Ektron Reference

Configuring eCommerce

Configuring eCommerce
This section describes the configuration screens located in the Workarea at Settings >
Commerce > Configuration and Settings > Commerce > Tax.
This section also contains the following topics.
Configuring Countries
Configuring Regions
Configuring Currencies
Configuring Payment Options
Configuring Credit Card Types
Configuring eCommerce Shipping Screens
Configuring eCommerce Tax Screens
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1306
1307
1311
1327
1329
1334

Configuring Countries
Use the Countries screen to modify existing country information or add new countries to
eCommerce.

How Countries are Used
l

l

to define country tax tables—For example, assume Canada has a national tax of 5%
that applies to the sale of certain goods. National tax tables are defined in the Country
Tax Tables screen.
to determine shipping costs—In the checkout process, a purchaser selects a shipping
address, which includes country. So, be sure to enable countries from which customers
(site visitors) can enter orders. Countries are also part of the location on the Warehouse
screen. An order’s shipping cost is determined by the distance between the warehouse
and the destination.

Default Countries
By default, Ektron provides information for countries on the ISO list of English country names
and code elements (ISO 3166-1-alpha-2 code).
The following is provided for each country.
l

name

l

numeric ISO code

l

long alphabetical ISO code

l

short alphabetical ISO code

The countries screen lets you enter new countries, and edit information for provided
countries.

Creating a Country
PREREQUISITE

Ektron 8.7
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The new country’s ISO codes.
To add a new country:
1. From the Workarea, choose Settings > Commerce > Configuration > Countries.
2. Click New > Country.
3. Enter information in the following fields:
l
Name—Enter the country’s name.
l

l

l

l

Numeric ISO—Enter the country’s ISO 3166-1 3-digit numeric ISO code. See Also:
ISO 3166-1 numeric
Enabled—Check this box if you want this country to be active. Only active countries
can be selected on the Edit Billing Information screen, which appears during the
Checkout procedure.
Long ISO—Enter the country’s ISO 3166-1 alpha-3, 3-letter country code. See
Also: ISO 3166-1 alpha-3
Short ISO—Enter the country’s ISO 3166-1 alpha-2, 2-letter country code. See
Also: ISO 3166-1 alpha-2

4. Click Save.

Editing a Country
1. Go to Workarea > Settings > Commerce > Configuration > Countries.
2. Click the name of the country that you want to edit.
3. Click Edit.
4. Edit any of the fields, which are described in Creating a Country on the previous page

Deleting a Country
1. Go to Workarea > Settings > Commerce > Configuration > Countries.
2. Click the name of the country that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The country is deleted.

Configuring Regions
The Regions screen lets you define geographic regions within countries that your eCommerce
site services. For example, in the United States of America, each state is a region.
Regions are used in the same way that countries are used. See Also: How Countries are Used
on the previous page By default, the Regions screen includes 50 United States of America, the
District of Columbia, and 9 Canadian Provinces.

Creating a Region
PREREQUISITE
The region’s country is defined in the Countries screen
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Editing a Region

1. Go to Workarea > Settings > Commerce > Configuration > Regions.
2. Choose New > Region.
3. Use the following information to complete the screen.
l
Name—Enter the region’s name.
l

l
l

l

Enabled—Check this box if you want this region to be active. Only active regions
can be selected on the Edit Billing Information screen, which appears when
customers enter billing information during the Checkout procedure.
Code—Enter an abbreviation for this region.
Country—Select this region’s country from the pull down list. If the country is not
there, exit this screen, and create the country using the Countries screen.
Add another region to this country?—This field saves the effort of selecting a
country when entering several regions for one country.
To add more regions for this country, check this box and press Save. When you do,
the screen refreshes, and the most recently selected country appears as the
default.

4. Click Save.

Editing a Region
1. Go to Workarea > Settings > Commerce > Configuration > Regions.
2. Click the name of the region that you want to edit.
3. Click Edit.
4. Edit any of the fields, which are described in Creating a Region on the previous page

Deleting a Region
1. Go to Workarea > Settings > Commerce > Configuration > Regions.
2. Click the name of the region that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.

Configuring Currencies
eCommerce supports all currencies. However, customers can choose only enabled
currencies. The Currency screen lets you enable and edit information for installed currencies.

Installed Currencies
By default, Ektron provides currencies on the ISO 4217 Current Currency & funds code list.
The following information is provided for each installed currency.
l

name

l

enabled (yes or no)

l

numeric ISO code

l

alpha ISO code

l

exchange rate
Ektron 8.7
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Enabling Currencies
When users are setting prices in the Workarea or site visitors are shopping, they can only
choose enabled currencies. When you install Ektron, the following currencies are enabled.
l

U.S. dollar, the default currency. See Also: The Default Currency below

l

Euro

l

Australian dollar

To see which currencies (other than the default) are enabled, click Action > Edit Exchange
Rates from the Currencies screen. Only non-default, enabled currencies appear.
WARNING! The Euro and Australian dollar are shipped with a default exchange rate. If you will support
these currencies, you should update the rate to its current value before going live. See Also: Defining and
Updating Exchange Rates on page 1310
To enable any installed currency:
1. From the Workarea, choose Settings > Commerce> Configuration > Currencies.
2. Click the currency you want to enable. (Use the Search box to quickly find a currency.)
The Edit Currency screen appears.
3. Check the Enabled check box.
4. Click Update.

The Default Currency
The default currency is the reference currency when setting the exchange rate on the Edit
Currency screen. For example, if the default is US dollars, USD appears on the left of the
exchange rate equation, as shown below.
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Viewing and Changing the Default Currency

The default currency is also the default value in the Currency Selector server control, and on
the Pricing tab of the View/Edit Catalog Entry screen. See Also: CurrencySelect on
page 1716

Viewing and Changing the Default Currency
When you install Ektron, the default currency is U.S. dollars, indicated by the Numeric ISO
code 840. At that time, you can change this by editing the value for the web.config file’s ek_
ecom_DefaultCurrencyId tag. You must enable the new default currency in the Workarea
before changing it in the web.config file.
WARNING! After your eCommerce feature goes live, do not change the ek_ecom_
DefaultCurrencyId value in web.config.
IMPORTANT: If you edit the siteroot/web.config file's ek_ecom_DefaultCurrencyId property, you
must begin a manual crawl. See Also: Starting Crawls Manually on page 932 You will only see the new
default currency in search results when that crawl is complete.

How Currencies Are Used in the CurrencySelect
Server Control
If your developer places a CurrencySelect server control on a page, a site visitor can use it to
select any enabled currency. See Also: CurrencySelect on page 1716
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After a currency is selected, the prices change to that currency. From that point on, the cart
and order use the selected currency. See Also: Defining and Updating Exchange Rates below

Defining and Updating Exchange Rates
The Edit Currency screen lets you define an exchange rate between the default and any other
currency. A good website for finding exchange rates is http://www.xe.com.

The exchange rate can dynamically adjust prices when the rate changes. See Also: Alternate
Currency Pricing on page 1362
You can update the exchange rates using:
l

the Ektron API

l

the Edit Exchange Rates screen

The following Ektron API supports calling an exchange rate service to update rates
automatically: Ektron.Cms.Commerce.ExchangeRateApi. For more information, see the
Ektron API documentation (http://reference.ektron.com/developer/).
The Edit Exchange Rates screen lets you update the exchange rate for enabled currencies:
1. In the Workarea, go to Settings > Commerce > Configuration > Currencies.
2. Choose Action > Edit Exchange Rates. The Edit Exchange Rates screen appears,
showing enabled currencies and their exchange rates.
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Editing a Currency

3. Update rates as needed.
4. Choose Action > Update.

Editing a Currency
1. Go to the Workarea > Settings > Commerce > Configuration > Currencies.
2. Click the currency you want to edit.
3. You can only edit the Name, Enabled, and Exchange Rate fields. The Numeric ISO
Code and Alpha ISO Code are not editable and are determined by the currency selected.
l
Name—Enter the currency’s name.
l
l

Enabled—Check this box to enable this currency.
Exchange Rate—Enter the exchange rate between this currency and the default
one.

4. Click Update.

Deleting a Currency
1. Go to the Workarea > Settings > Commerce > Configuration > Currencies.
2. Check the box next to the currency that you want to delete.
3. Choose Action > Delete Selected. A confirmation message appears.
4. Click OK. The currency is deleted.

Configuring Payment Options
The Payment Options screen lets you determine which options are available for your
customers to pay for their purchases.
l

l

PayPal—The PayPal checkbox is not available for selection until you have set up a
PayPal account. See Also: Using PayPal with Ektron eCommerce on the next page
a Payment Gateway, such as AuthorizeNet—See Also: Configuring Payment Gateways
on page 1317

Both options can be enabled, but only one gateway can be enabled at a time.
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PayPal payments work like checks in that they need to be settled. After an order is placed, the
payment must be marked as “settled” for the workflow to proceed.

Using PayPal with Ektron eCommerce
Customers can use PayPal to pay for purchases from either of 2 points in the checkout
process
l

the shopping cart screen

l

the payment screen

IMPORTANT: PayPal requires you to place the Pay with PayPal option on both the shopping cart and
payment screens.
If you access PayPal via the shopping cart screen, you follow these steps.

Here is the sequence illustrated above.
1. From the Cart screen, a site visitor clicks PayPal.
2. The site visitor logs into his or her PayPal account.
3. Account information populates the shipping and billing addresses.
4. The site visitor can change addresses if needed. If the PayPal account address is used for
the order, it is saved as part of the site visitor’s eCommerce account information.
5. Shipping costs are added.
6. The order is confirmed.
7. Site visitor checks out via PayPal.
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PayPal Documentation

Alternatively, the site visitor can use the standard eCommerce checkout process, select
PayPal on the payment screen, and complete the order using the PayPal payment screen.
That sequence is illustrated below.

PayPal Documentation
Use the following PayPal technical documentation resources when integrating PayPal into
your eCommerce site: PayPal Express Checkout Integration Guide and Payflow ACH Payment
Service Guide, located at PayPal: Development & Integration Guides.

Enabling PayPal Support
1. Create a Sandbox Account below. This step includes updating Ektron’s web.config file.
2. Begin Using PayPal on page 1316
3. Enable PayPal in the Workarea on page 1317

Create a Sandbox Account
1. Sign on to PayPal Sandbox.
2. Sign up for an account.
3. You receive an email confirmation that directs you to another page.
4. Log in using the information you provided in Step 2.
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5. Under Test Accounts, click Create a preconfigured buyer or seller account.

6. Create a buyer account. You will use this to test the customer experience.
7. Change the password to one you can easily remember.

8. Click Home > Test Accounts > Create a preconfigured buyer or seller account.
9. Click Account Type Seller.

10. Create a seller account. You will use this to test the merchant experience.
11. Change the password to one you can easily remember.
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Encrypting PayPal Authentication Values

12. In the upper left corner of the screen, click API Credentials.

13. Open your siteroot/web.config file.
14. Copy the following values from the API Credentials screen into the web.config’s
providers/paypal element. Save web.config.
l
API Username > PayPalUser
l

API Password > PayPalPwd

l

Signature > PayPalSignature

The following illustration shows the PayPal API Username copied into the web.config file’s
PayPalUser property.

Encrypting PayPal Authentication Values
Follow these steps to encrypt the following values in the web.config file’s
providers/paypal element.
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l

PayPalUser

l

PayPalPwd

l

PayPalSignature

1. Open the siteroot/web.config file.
2. Set the AuthValuesEncrypted element to true.

3. Save and close web.config.
4. Open C:\Program Files\Ektron\CMS400vxx\Utilities.
5. Run EncryptEmailPassword.exe. The Encrypt Utility dialog appears.

6. Enter the PayPal user name into the Text field.
7. Click Encrypt. The screen displays encrypted text in the Encrypted field.
8. Copy the encrypted text and paste it into the web.config file’s PayPalUser element
value.
9. Repeat Steps 6 through 8 for PayPalPwd and PayPalSignature.

Test the Sandbox Account
1. Sign into Workarea > eCommerce > Cart.
2. Click the PayPal button.
3. Enter the buyer account user name and password that you created in Create a Sandbox
Account on page 1313. You proceed to the Ektron Checkout screen.
After completing these steps, you have verified your PayPal buyer experience and are ready
to begin using PayPal.

Begin Using PayPal
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Enable PayPal in the Workarea

1. Sign on to PayPal.
2. Create a new account.
3. Follow the instructions to obtain API credentials.
4. Copy the following values from the API Credentials screen into the web.config’s
providers/paypal element. Save web.config.
l
API Username > PayPalUser
l

API Password > PayPalPwd

l

Signature > PayPalSignature

5. If you want to encrypt these values, see Encrypting PayPal Authentication Values on
page 1315.
6. Enable PayPal in the Workarea below.
7. If desired, customize the PayPal page on your website.

Enable PayPal in the Workarea
1. From the Workarea, choose Settings > Commerce > Configuration > Payment
Options.
2. Click Action > Edit Payment options. The Edit Payment Options screen appears.
3. Check PayPal.
4. Click Save.

Customizing the PayPal Page
If you are using Ektron’s sample site and PayPal is enabled, the login screen contains an
Ektron logo for demonstration purposes.
You can replace the logo using the apiparamHDRIMG property of the <providers> add
name=”PayPal” element in the web.config file.

To change the logo, change the referenced image.
To learn how to customize other aspects of the page, see PayPal’s “Express Checkout
Integration Guide” section “PayPal Page Style.” The guide is located at PayPal: Development
& Integration Guides.
When setting values in the web.config’s providers/add name=” PayPal” element, prefix
any variable with apiparam. For example, to set the header background color, enter
apiparamHDRBACKCOLOR=”FFF666”.

Configuring Payment Gateways
Ektron 8.7
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A payment gateway provider is a pluggable component that is integrated into the Ektron
eCommerce module. A payment provider handles eCommerce customer payments by using
third-party payment gateways. Ektron eCommerce module accepts payments such as credit
cards or checks. Then, it passes that information to a third-party service. The third-party
service processes the payment and returns a transaction ID that is stored with the customer's
order.
Your company needs to set up an account with a third party payment service before using the
payment provider. Ektron provides 4 standard payment gateways: authorize.net, Payflow,
Sage Pay and PayFlowWebsite Payments Pro along with manual. The manual gateway accepts
credit cards. In this case, the merchant emails the credit card information to the credit card
company. You can customize these providers or create your own using the extendable
Payment Gateway Provider architecture. See Customizing the Payment Gateway Provider on
page 1449.
In addition, some payment gateways might support recurring payments, while others might
not. Recurring payments let you create a payment that recurs at a given interval for a
specified period of time. For example, you could create a payment for $9.99 that occurs on
the first of every month for the next 12 months. This is something to consider if your site
relies on a subscription service.
Ektron lets you edit information on any provided gateway as well as create a new one.

Processing Credit Card Transactions via a Gateway
The following sequence explains typical processing of credit card transactions. (source:
www.authorize.net)
1. A customer purchases a product from your site and submits payment information.
2. Ektron passes the information to your payment gateway.
3. The payment gateway provider (PGP) receives secure transaction information and
passes it via secure connection to the Merchant Bank’s Processor.
4. The Merchant Bank’s Processor submits the transaction to the Credit Card Interchange (a
network of financial entities that manage credit card transactions).
5. The Credit Card Interchange sends the transaction to the customer’s Credit Card Issuer.
6. The Credit Card Issuer approves or declines the transaction, based on the customer’s
available funds. It then passes the transaction results and, if approved, the appropriate
funds back through the Credit Card Interchange.
7. The Credit Card Interchange relays the transaction results to the Merchant Bank’s
Processor.
8. The Merchant Bank’s Processor relays the transaction results to PGP.
9. The PGP stores transaction results and sends them to the customer and/or the merchant.
This communication process averages 3 seconds or less.
10. The Credit Card Interchange passes the transaction’s funds from the Credit Card Issuer
to the merchant’s bank account.

Processing Check Transactions via a Gateway
The following sequence explains how a payment gateway processes checks. (source:
www.authorize.net)
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Establishing a Relationship with a Payment

1. Customer authorizes merchant to charge the customer's bank account for an amount.
2. Order and payment information is securely transmitted via the Internet to the payment
gateway.
3. The transaction is accepted or rejected based on initial data validation and security
criteria defined by the payment gateway.
4. If accepted, the transaction is sent to the ACH Network for settlement.
5. The ACH Network uses the transaction’s bank account information to determine the bank
that holds the customer’s account (the RDFI).
6. The ACH Network instructs the RDFI to charge or refund the customer’s account.
7. The RDFI transfers funds from the customer’s account to the ACH Network. The RDFI
also notifies the ACH Network of any returns (if funds could not be collected from the
customer’s bank account) or charge backs (if a customer disputes a purchase).
8. The ACH Network transfers funds for the transaction to the payment gateway’s bank.
9. After a holding period, the payment gateway provider initiates a ACH transaction that
deposits the funds into the merchant’s bank account.

Establishing a Relationship with a Payment Gateway
Provider
You need to set up an account with a third-party payment service before using a payment
provider. Each payment gateway provider accepts configuration parameters. For example,
Authorize.NET requires a username and password, while PayFlow requires a Username,
password, vendor, and partner.
In addition, some payment gateways do not support subscription payments. Consider this if
your site relies on subscriptions. See Also: Creating a Subscription on page 1349

The Default Gateway
The eCommerce checkout uses the default gateway only. Additional gateways are unused
unless one is changed to the default.
You cannot delete the default gateway. If you want to delete it, you must first make another
gateway the default.
To change the default gateway:
1. Go to Settings > Commerce > Configuration > Payment Options.
2. Click the Payment Gateways tab. The currently-defined default has a check in the
Default column.
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3. Click the radio button next to the gateway you want to make the default.
4. Choose Action > Mark as Default. A confirmation message appears.
5. Click OK.

Adding a Payment Gateway
NOTE: To create a new payment gateway provider, see Customizing the Payment Gateway Provider on
page 1449.
1. In Ektron, go to Settings > Commerce > Configuration > Payment Options.
2. Choose New > Payment Gateway.
3. Enter information or select options for the following fields:
l
l

l

l
l

Name—Enter the name of the gateway.
Default—Check this box if this is the default gateway. If you do, and another
gateway is currently the default, it is replaced by this one.
User ID—Enter your User ID. This ID will identify your account with this gateway
provider.
Password—Enter the password for your account with this gateway provider.
Expand Custom Values—If this gateway provider needs additional fields of
information, enter those values into the Custom 1 and Custom 2 fields.

l

Credit Cards—Check if this payment gateway accepts credit cards.

l

Checks—Check if this payment gateway accepts checks.

The following sections explain how to set up standard Payment gateways.
l

Setting up a PayFlow Payment Gateway on the facing page

l

Setting up a PayFlowWebsite Payments Pro Payment Gateway on the facing page

l

Setting up an Authorize.Net Payment Gateway on page 1322

l

Setting up a SagePay Payment Gateway on page 1322

NOTE: When setting up a payment gateway, you are asked to enter authentication codes, such as user
name and password. To keep them safe, Ektron encrypts these values when saving them to the
database.
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Setting up a PayFlow Payment Gateway

Setting up a PayFlow Payment Gateway
NOTE: See PayFlow's website for additional instructions on setting up the PayFlow Gateway.
When setting up a PayFlow payment gateway:
1. Set up an account with PayFlow. To do this, go to Paypal: Payflow Payment Gateway.
During this process, you should obtain a Login ID and password.
2. Go to Settings > Commerce > Configuration > Payment Options.
3. Choose New > Payment Gateway.
4. Enter information or select options for the following fields:
l
Name—Choose Payflow.
l
l

Default—Check this box to make PayFlow the default gateway.
User ID—Enter the user ID provided to you by the authorized PayPal Reseller who
registered you for the Payflow SDK. If you purchased your account directly from
PayPal, use PayPal.
Limitations: 64 alphanumeric, case-sensitive characters.

l

Password—Enter the password you defined while registering for account.
Limitations: 6- to-32 alphanumeric, case-sensitive characters

l

Expand Custom Values—Click this text to open the Custom 1 and Custom 2
fields.
o Custom 1—Enter the merchant login ID sent to you when you registered the
account.
Limitations: 64 alphanumeric, case-sensitive characters.
o

Custom 2—Enter the Partner ID sent to you by the authorized PayPal Reseller
who registered you for the Payflow SDK. If you purchased your account
directly from PayPal, use PayPal.
Limitations: 12 alphanumeric, case-sensitive characters.

l

l

Credit Cards—Check if this payment gateway accepts credit cards. You should
verify that this payment gateway supports credit card payments.
Checks—Check if you will accept checks with this payment gateway. You should
verify that this payment gateway supports check payments.

Setting up a PayFlowWebsite Payments Pro Payment
Gateway
The PayFlowWebsite Payments Pro payment gateway is used in the United Kingdom and
Australia.
1. Set up an account with PayFlowWebsite Payments Pro. To do this, go to Paypal: Payflow
Payment Gateway.
2. In the Workarea, go to Settings > Commerce > Configuration > Payment
Options.
3. Choose New > Payment Gateway.
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4. Enter information or select options for the following fields:
l
Name—Choose PayFlowWebsite Payments Pro.
l

l

Default—Check this box to make PayFlow the default gateway. See Also: The
Default Gateway on page 1319
User ID—Enter the API username sent to you by the authorized PayPal Reseller
who registered you for the Payflow SDK. For example, sellUK_1271963915_biz_
api1.ektron.com. If you purchased your account directly from PayPal, use PayPal.
Limitations: 64 alphanumeric, case-sensitive characters.

l

Password—Enter the API password you defined while registering for the
account.For example,1234567891.
Limitations: 6- to-32 alphanumeric, case-sensitive characters

l

Expand Custom Values—Click this text to open the Custom 1 and Custom 2
fields.
o Custom 1—Enter the API signature sent to you by the authorized PayPal
Reseller who registered you for the Payflow SDK. For example,
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
Limitations: 64 alphanumeric, case-sensitive characters.
o

l

Custom 2—Not used

Credit Cards—Check if this payment gateway accepts credit cards. You should
verify that this payment gateway supports credit card payments.

After defining the payment gateway, you typically want to test it. See Testing a Payment
Gateway on the facing page

Setting up an Authorize.Net Payment Gateway
1. Set up an account with Authorize.Net. To do this, go to Authorize.Net . During this
process, you should obtain a Login ID and password.
2. In the Workarea, go to Settings > Commerce > Configuration > Payment
Options.
3. Choose New > Payment Gateway.
4. Enter information or select options for the following fields:
l
Name—Choose Authorize.Net.
l

Default—Check this box to make Authorize.Net the default gateway.

l

User ID—Enter the Login ID you obtained in Step 1.

l

Password—Enter the password you obtained in Step 1.

l

Custom 1 and Custom 2—Not used.

l

Credit Cards—Check if you will accept credit cards with this payment gateway.
You should verify that this payment gateway supports credit card payments.

This gateway accepts only credit cards. No checks.
After defining the payment gateway, you typically want to test it. SeeTesting a Payment
Gateway on the facing page

Setting up a SagePay Payment Gateway
NOTE: SagePay does not support recurring billing nor check payments.
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Testing a Payment Gateway

1. Set up an account with SagePay. To do this, go to Sage Pay. During this process, you
should obtain a Login ID and password.
2. Set up a SagePay simulator account using Sage Pay Account Registration.
3. From the Simulator Main Menu, click Account > Valid Currencies for this Account. Enable
currencies set up in your Workarea’s Currencies screen. See Also: Configuring
Currencies on page 1307
4. In Ektron, go to Settings > Commerce > Configuration > Payment Options.
5. Choose New > Payment Gateway.
6. Enter information or select options for the following fields:
l
Name—Choose SagePay.
l

Default—Check this box to make SagePay the default gateway.

l

User ID—Enter the User ID you obtained in Step 1.

l

Password, Custom 1, Custom 2—Not used.

l

l

Credit Cards—Check if this payment gateway accepts credit cards. You should
verify that the gateway supports credit card payments.
Checks—Not available with SagePay.

After defining the payment gateway, you typically want to test it. SeeTesting a Payment
Gateway below and Testing SagePay Payment Gateway below

Testing a Payment Gateway
Typically, you test a default payment gateway before going live with it. eCommerce provides
a test mode for this purpose. While eCommerce is in test mode, customers cannot purchase
goods. So, disable test mode before going live with a new default payment gateway.
To test a payment gateway, open the siteroot/web.config file and set <ektronCommerce>
ek_ecom_TestMode to true.
<ektronCommerce>
<add key="ek_ecom_ComplianceMode" value="false" />
<!-- This is used only when compliance mode is on, and cannot be less than 4. -->
<add key="ek_ecom_PasswordHistory" value="4" />
<add key="ek_ecom_OrderProcessingDisabled" value="false" />
<add key="ek_ecom_TestMode" value="true" />
....

When testing is done, change the value of ek_ecom_TestMode to false.

Testing SagePay Payment Gateway
Do not use the following cards with the SagePay test card number when testing the SagePay
payment gateway:
l

Japan Credit Bureau (JCB)

l

Mastercard

l

Visa Electron UK Debit

l

Visa Delta Debit

l

American Express

Because these cards do not have a cardholder field, the following error is displayed: The
CardHolder field should be between 1 and 50 characters long.
To test the SagePay Payment Gateway:
Ektron 8.7
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1. Follow instructions in Testing a Payment Gateway on the previous page.
2. Open your siteroot/web.config file.
3. Set <EktronPaymentGateway>/<providers> SagePay SimulatorMode to true.
<EktronPaymentGateway defaultProvider="Automatic">
<providers> . .
<add name="SagePay"
type="Ektron.Cms.Commerce.Providers.Payment.SagePayGateway"
SagePayVersion="2.23" SimulatorMode="true"
Description="Ektron CMS Order" />
</providers>
</EktronPaymentGateway>

4. When testing is complete, change the value of SimulatorMode to false.

Editing a Payment Gateway
1. Go to Workarea > Settings > Commerce > Configuration > Payment Options.
2. Click the payment gateway that you want to edit.
3. Click Edit.
4. Edit any of the fields, which are described in Adding a Payment Gateway on page 1320.
5. Click Save.

Deleting a Payment Gateway
NOTE: You cannot delete the default gateway. If you want to delete it, you must first make another
gateway the default.
1. From Workarea, choose Settings > Commerce > Configuration > Payment
Options.
2. Click the payment gateway that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.

Check Support
Payment gateways generally offer 2 payment mechanisms: credit cards and checks. You can
enable or disable check support for a gateway via the Settings > Commerce >
Configuration > Payment options > Edit Payment Gateway screen.
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Check Support Integration Documentation

If checks are enabled for the default payment gateway, a site visitor can pay by Check on
the payment screen. If check support is not enabled, the Payment Method field does not
appear.

Check Support Integration Documentation
Use the following resources to familiarize yourself with integrating checks into your
eCommerce site.
l
l

Authorize.Net: eCheck.Net Operating Procedures and User Guide
PayFlow: Payflow Link User’s Guide ; see the chapter “Integrating TeleCheck
Transactions.”

Effect of Check Payment on Order Processing
The following describes a typical sequence of events when processing a check for eCommerce
payment.
However, Ektron is very flexible and does not enforce this sequence. For example, you can
enter a tracking number and mark an order shipped even though its payment has not been
captured yet.
1. eCommerce user accesses the View Payment screen’s Capture option, which submits a
payment request to the customer’s bank.
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2. A few days later, the funds are transferred to the merchant’s account.
3. eCommerce user accesses the View Payment screen’s Mark as Settled option to
confirm the receipt of funds.

4. If goods are tangible, eCommerce user ships the merchandise, using the View Payment
screen’s Enter Tracking Number option to insert the tracking number and confirm the
shipment.
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5. If goods are not tangible, the workflow sends the customer an email with purchase
details, such as how to download it.

Configuring Credit Card Types
Use this screen to enter types of credit cards that your eCommerce system may use. By
default, Ektron’s sample sites provide the following card types.
l

American Express

l

Diners Club (not accepted by default)

l

Discover

l

MasterCard

l

Visa

You can edit the information provided for these types or enter a new one.

Where Credit Card Types are Used
During the checkout process (managed by the Checkout on page 1673 server control), the
Payment screen includes a drop-down list of enabled credit cards.
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Creating a Credit Card Type
To create a new credit card within Ektron:
1. From the Workarea, choose Settings > Commerce > Configuration > Card.
2. Choose New > Card Type to see the Add Card Type screen.
3. Enter the credit card's name in the Name field.
4. Enable the Accepted check box if site visitors can use this card to make purchases on
your website.
5. Add an image for the credit card. The image must reside on your computer.The image
does not appear on the standard checkout screen, but it is a field in the XML, so you can
enable it using XSLT.
a. Click Change. The Library Upload screen appears.
b. Click Add Library.
c. Click Browse and navigate to the folder that contains the image.
d. Choose the image file.
e. Enter a title in the Title field.
f. Click Add Library. The file name appears in the Image field with the image directly
below.
6. Enter a Regex expression. See Also: Using RegEx Expressions for Validation below
7. Click Save.

Using RegEx Expressions for Validation
A RegEx expression is a simple way to validate a credit card account number. (See Also:
http://regexlib.com/.) Validation occurs when a site visitor completes the Checkout
procedure’s Submit Order screen
RegEx prevents the submission of invalid account numbers to a payment gateway, which may
charge a fee for such failures.
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Ektron provides a RegEx expression for the credit cards supplied with the medical sample
site. You can modify them as needed. If you enter a new credit card, you can enter a RegEx
expression for it.

Editing a Credit Card Type
1. From the Workarea, choose Settings > Commerce > Configuration > Card.
2. Click the Credit Card Type that you want to edit.
3. Click Edit.
4. Edit any of the fields, which are described in Creating a Credit Card Type on the previous
page
5. Click Save.

Deleting a Credit Card Type
1. From the Workarea, choose Settings > Commerce > Configuration > Card.
2. Click the Credit Card Type that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The Credit Card Type is deleted.

Configuring eCommerce Shipping Screens
The eCommerce shipping screens let you specify information about where catalog entries are
stocked, how they are packaged, and the available shipment methods.
This section contains the following topics.
l

Using a Warehouse below

l

Configuring Packages on the next page

l

Configuring Shipping Methods on page 1331

Using a Warehouse
Use the Warehouses screen to enter information about warehouses that stock your catalog
entries. eCommerce uses this location as the “from” address when calculating shipping costs.
Only the default warehouse is used by the checkout process. Additional warehouses are
unused until they are made the default. See Also: Changing the Default Warehouse on the
next page
PREREQUISITE
Configuring Regions on page 1306 and Configuring Countries on page 1305 must be
set up

Creating a Warehouse
1. Go to Settings > Commerce > Shipping > Warehouses.
2. Choose New > Warehouse.
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3. Enter information or select options as follows:
l
Name—Enter the warehouse’s name.
l

Street1, Street2—Enter the warehouse’s street address

l

City—Enter the warehouse’s city.

l

Postal Code—Enter the warehouse’s postal code.

l

Country—Select the warehouse’s country from the pull-down list.

l

State/Province—Select the warehouse’s state or province from the pull-down list.

l

Default Warehouse—This check box indicates if this is the default warehouse.

4. Click Save.

Changing the Default Warehouse
NOTE: You can also specify a warehouse as the default via the Edit Warehouse screen’s Mark Default
Warehouse toolbar button ( ).
1. Go to Workarea > Settings > Commerce > Shipping > Warehouses.
2. Click the radio button next to the warehouse that you want to make the default.
3. Choose Action > Mark Default Warehouse. A confirmation dialog appears.
4. Click OK.

Editing a Warehouse
1. Go to Workarea > Settings > Commerce > Shipping > Warehouses.
2. Click the warehouse that you want to edit.
3. Click Edit.
4. Edit any of the fields as described in Creating a Warehouse on the previous page.
5. Click Save.

Deleting a Warehouse
You cannot delete the default warehouse. However, you can designate another warehouse as
the default, then delete the one that was the default.
1. Go to Workarea > Settings > Commerce > Shipping > Warehouse.
2. Click the warehouse that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The warehouse is deleted.

Configuring Packages
How Packaging Information Is Used
Each item in an order has size and weight dimensions. The shipping calculator uses them to fit
the order into the smallest-sized and fewest packages. It then passes packaging information
(number, sizes and weight) to the shipping provider, which returns the order’s shipping costs.
If a catalog entry’s dimensions exceed all box sizes, eCommerce passes those dimensions to
the shipping provider.
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NOTE: Some shipping providers, FedEx and UPS for example, have size and weight limits on packages.
If the size or weight exceeds the limit, shipping rates may not be returned when a site visitor is checking
out. In this case, a site visitor cannot continue the checkout process and an application error is logged in
the Event Viewer.

Size and Weight Units of Measure
By default, Ektron uses English units of measure (inches and pounds) for package size and
weight. At the beginning of your eCommerce implementation, you can change to metric units
of measure by updating the web.config file’s ek_measurementsystem tag value to metric.
WARNING! After your eCommerce feature goes live, do not change the web.config ek_
measurementsystem value.

Creating a New Package
1. Go to Settings > Commerce > Shipping > Packages.
2. Click New > Package.
3. Enter package information in the following fields:
l
Name—Enter a text description of this package size.
l

l

l

l

Length—Enter the package’s length in the units of measure that appear to the right
(inches or centimeters). See Also: Size and Weight Units of Measure above
Height—Enter the package’s height in the units of measure that appear to the right
(inches or centimeters).
Width—Enter the package’s width in the units of measure that appear to the right
(inches or centimeters).
Max Weight—Enter the package’s weight in the units of measure that appear to
the right (pounds or kilograms).

4. Click Save.

Editing a Package
1. Go to Workarea > Settings > Commerce > Shipping > Packages.
2. Click the package that you want to edit.
3. Click Edit.
4. Edit any of the fields, which are described in Creating a New Package above.
5. Click Save.

Deleting a Package
1. From the Workarea, choose Settings > Commerce > Shipping > Packages.
2. Click the package that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The package is deleted.

Configuring Shipping Methods
Ektron 8.7
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Use the Shipping Methods to define choices your site visitors will have for delivering their
purchases.
PREREQUISITES
l

Default warehouse with an address

l

A default shipping provider is defined in the siteroot\shipment.config file

Defining Shipping Providers
When you instEktron, several providers exist in the siteroot\shipment.config file:
l

FedExShipmentProvider

l

FlatRateShipmentProvider

l

UPSShipmentProvider

However, the FedEx and UPS information is for testing purposes only. To use FedEx, UPS, or
another shipping provider, obtain the following information from them. (The information can
vary slightly for each provider.)
l

service URL

l

key

l

password

l

account number

l

meter number

l

transactionId

Then, enter that information into shipment.config, following the format of providers already
in the file.
The shipment.config file also contains name and type properties for each provider. The
specific text you insert is not important, but the name and type strings must match.
name="FedExShipmentProvider"
type="Ektron.Cms.Commerce.Shipment.Services.FedExShipmentProvider,
Ektron.Cms.Commerce"

To define a custom shipping provider, see Customizing the Shipment Provider on page 1456.

Defining the Default Shipping Provider
While you can define any number of shipping providers in the shipment.config file, only one
can be active. The active provider appears on the Settings > Commerce > Shipping >
Methods > New > Shipping Method screen when you click View Options.
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Specify the default shipping provider via the defaultprovider property in
siteroot\shipment.config.
<?xml version="1.0" encoding="utf-8" ?>
<shipmentProvider defaultProvider="FedExShipmentProvider">
<providers>
<add name="FedExShipmentProvider" ...
</shipmentProvider>

Adding a Shipping Method
Use the Add Shipping Method screens to select shipping methods you will support. When a
site visitor submits an order, these shipping choices appear on the Shipping screen.
1. Go to Workarea > Settings > Commerce > Shipping > Methods.
2. Choose New > Shipping Method. The Add Shipping Method screen appears.
3. Enter information or make selections in the following fields.
l
Name—Enter the name of the shipping method. Site visitors select a shipping
method for their order using this name
l

l

Active—Check this box if you want site visitors to be able to select this shipping
method.
Provider Service—As explained in Defining the Default Shipping Provider on the
previous page, a default shipping provider is defined in your site’s shipment.config
file. To view the methods offered by that provider, click View Options. Then,
select from the drop-down list that appears.

4. Click Save.

Editing a Shipping Method
1. Go to Workarea > Settings > Commerce > Shipping > Methods.
2. Click the Shipping Method that you want to edit. The View Shipping Method screen
appears.
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3. Click Edit (

).

4. Edit the fields described in Adding a Shipping Method on the previous page.

Deleting a Shipping Method
1. Go to Workarea > Settings > Commerce > Shipping > Methods.
2. Click the Shipping Method that you want to edit.The View Shipping Method screen
appears.
3. Click Delete ( ).

Changing the Order of the Shipping Method
Each shipping method you define has an Order field. This determines the sequence in which
shipping methods appear on the Shipping Rates screen when a site visitor is submitting an
order.
The shipping method with 1 in the Order field appears at the top of the list.
By default, every shipping method’s order is set to 1. To set a sequence for shipping methods,
follow these steps
1. Go to Workarea > Settings > Commerce > Shipping > Methods.
2. Choose Action > Reorder Items.
3. Use the selection bar and arrows to arrange methods in the desired sequence.

4. Choose Action > Save.

Configuring eCommerce Tax Screens
eCommerce provides a set of tax screens in the Workarea that lets you:
l
l

l

set up tax classes (for example, goods, services, tobacco)
define tax rates for these geographic entities (from most to least specific)
l
postal code
l

region

l

country

apply tax classes
l
for tax classes except shipping
l

applying shipping taxes

This section also contains the following topics.
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Applying Tax Classes to Catalog Entries on the facing page

l

Calculating an Order’s Tax Amount on the facing page
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Applying Tax Classes to Catalog Entries

l

Calculating an Order’s Tax Amount below

l

Cataloging Entries that Can Be Taxed on page 1338

l

Applying Local Taxes on page 1339

l

Configuring Regional Tax Tables on page 1340

l

Configuring Country Tax Tables on page 1341

Applying Tax Classes to Catalog Entries
You assign a tax class (except shipping) to a catalog entry via its Properties tab’s Tax
Class field (Content tab > select catalog entry > Action > Edit).

Calculating an Order’s Tax Amount
During checkout, Ektron tries to find a tax rate for each catalog entry’s Tax Class and the
shipping address’s geographic entity.
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Ektron checks the
shipping address
for each item's
tax class

If it finds a tax rate for the geographic entity

If it does
not find a
tax rate for
the
geographic
entity

It adds that amount and stops.
For example
1. Postal code

l

an item costs $100.00

l

the postal code tax rate = 5%

l

a tax of $5.00 is applied

It checks the
shipping
address for a
regional tax
code.

It adds that amount and stops.
For example
2. Region

l

an item costs $100.00

l

the regional tax rate = 7%

l

a tax of $7.00 is applied

It checks the
shipping
address for a
country tax
code.

It adds that amount.
For example
3. Country

l

an item costs $100.00

l

the country tax rate = 10%

l

a tax of $10.00 is applied

No tax is
added to the
order.

If a postal zone has several taxes (for example, a local tax and a regional tax), build the
combined percentage into the postal code tax. So, assume New York City has a 4% tax, and
New York state has a 3% tax. Enter a combined total of 7% into postal zones within New York
City. See Also: Cataloging Entries that Can Be Taxed on page 1338
For example, the atrium chair is assigned to the Goods Tax Class. A person who lives in New
York state purchases the chair. Although no postal tax class is defined for the shipping
address, a regional tax of 8.5% is set up for New York state, and so is applied to the order.
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Calculating an Order’s Shipping Tax Amount
The shipping tax is separate from the other taxes, and appears on a separate line of the
order.
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A shipping tax is applied to an order if
l

shipping tax is enabled in web.config
and

l

a tax rate is applied to one of the geographic regions in which the shipping address falls.

Unlike the other tax classes, you do not apply shipping tax to catalog entries. Instead, you
apply them to geographic regions only. However, each tax class compares an order's shipping
address against regional tax tables to calculate the tax.

Enabling the Shipping Tax within Ektron
To enable the shipping tax, open your siteroot/web.config file and change the value of the
ek_ecom_ApplyTaxestoShipping element to True.

Enabling the Shipping Tax for a Geographic Region
You apply a shipping tax to every applicable geographic region. As explained in Calculating an
Order’s Tax Amount on page 1335, the eCommerce module first looks for a tax applied to the
order's postal code. If one is found, that shipping tax is applied. If none is found, eCommerce
looks for a shipping tax applied to the order's region. If no regional shipping tax is found,
eCommerce looks for a shipping tax applied to the order's country.

Applying a Shipping Tax to a Geographic Region
You apply a shipping tax rate to geographic regions as you do with the tax classes. See Also:
Applying Local Taxes on the facing page, Configuring Regional Tax Tables on page 1340,
Configuring Country Tax Tables on page 1341

Cataloging Entries that Can Be Taxed
Use the Tax Class screen to define classes of catalog entries that can be taxed. When you
install eCommerce, the following tax classes are installed.
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l

tobacco

l

shipping

You can modify or delete all classes except shipping, which you can modify but not delete.
You also can add new classes.

Creating a New Tax Class
1. Go to Settings > Commerce > Tax > Classes.
2. Choose New > Tax Class.
3. Enter the name of the tax class.
4. Click Save.

Editing a Tax Class
1. Go to Settings > Commerce > Tax > Classes.
2. Click the Tax Class that you want to edit.
3. Click Edit.
4. Edit the name of the tax class.
5. Click Save.

Deleting a Tax Class
If a tax class has been assigned to a catalog entry that appears on any order, the Delete
button does not appear.
1. Go to Settings > Commerce > Tax > Classes.
2. Click the Tax Class that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The Tax Class is deleted.

Applying Local Taxes
Use postal code tax tables to identify local areas (cities, counties, and so on) that apply taxes
to eCommerce catalog entries. The areas are identified by their postal code. For example,
London, England taxes alcohol delivered to addresses within it.
You only need to create a postal tax table if the area that applies the tax is smaller than a
country’s geographical regions (states, provinces, and so on). If an entire region applies a
tax, use a regional tax table.

Creating a New Postal Code Tax Table
PREREQUISITE
The postal code’s country and region are defined in the Regions and Countries screens
1. Go to Settings > Commerce > Tax > Postal Tax Tables.
2. Choose New > Postal Code.
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3. Enter information into the following fields:
l
Postal Code—Enter the postal code for which you want to enter a tax rate. If this
is for a US state, the code must consist of 5 or 9 digits.
l

l

Region—Enter the geographic region (for example, state or province) in which the
postal code resides.
Country—Enter the country in which the postal code resides.

4. Select the Tax Rates tab and specify values for the tax rates, for example, Alcohol,
Goods, Services, Shipping, Tobacco. For any tax class, enter a tax rate as a whole
number. For example, if the tax is 7%, enter 7.
5. Click Save.

Editing a Postal Code Tax Table
1. Go to Settings > Commerce > Tax > Postal Tax Tables.
2. Click the ID of the tax table that you want to edit.
3. Click Edit.
4. Edit the fields described in Creating a New Postal Code Tax Table on the previous page.
5. Click Save.

Deleting a Postal Code Tax Table
1. Go to Settings > Commerce > Tax > Postal Tax Tables.
2. Click the ID of the tax table that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The postal code tax table is deleted.

Configuring Regional Tax Tables
Use regional tax tables to identify regions (states, provinces, and so on) that apply taxes to
eCommerce catalog entries. For example, within the United States of America, the state of
New Jersey applies a 5% tax on goods purchased on the internet and shipped to it.
You only need to define a regional tax table if the area that applies the tax is smaller than a
country. If an entire country applies a tax, use a country tax table.

Editing a Regional Tax Table
A regional tax table is automatically created for every existing region. By default, tax rates
are zero (0). To change any tax rate:
1. Go to Settings > Commerce > Tax > Regional Tax Tables.
2. Click on the name of the region for which you want to set tax rates. The View Region Tax
Rate screen appears.
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3. Click Click here to edit the tax rates.

4. Click Edit.
5. Enter information into the following fields.
l
Name—Select the region for which you want to enter a tax rate.
l

Enabled—Enable or disable the regional tax entry as required.

6. Select the Tax Rates tab and specify regional tax rates by class. For example, Alcohol,
Goods, Services, Tobacco, and Shipping. For any tax class, enter a tax rate.
7. Click Save.

Deleting a Regional Tax Table
1. Go to Settings> Commerce > Tax > Regional Tax Tables.
2. Click the ID of the tax table that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The regional tax table is deleted.

Configuring Country Tax Tables
Ektron 8.7
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Use country tax tables to identify nations that apply taxes to eCommerce catalog entries. For
example, Ethiopia applies a 5% tax on goods purchased on the internet and shipped to it.

Editing a Country Tax Table
A country tax table is automatically created for every existing country. By default, tax rates
are zero (0). To change any country tax rate:
1. Go to Workarea > Settings > Commerce > Tax > Country Tax Tables.
2. Select the country for which you want to edit a tax table. The View Country Tax Rate
screen appears.
3. Click Click here to edit the tax rates.
4. Click Edit.
5. Select the Tax Rates tab and edit the tax rates, for example, Alcohol, Goods, Services,
Tobacco, and Shipping. For any tax class, enter a tax rate.
6. Click Save.

Deleting a Country Tax Table
1. Go to Workarea > Settings > Commerce> Tax > Country Tax Tables.
2. Click the ID of the tax table that you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK. The country tax table is deleted.
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Creating Product Types and
Catalogs
After you configure the eCommerce site, build eCommerce products in the following order:
1. Creating Product Types below
2. Creating a Catalog Folder on page 1354
3. Creating a Catalog Entry on page 1356

Creating Product Types
Create a separate product type definition for each category of catalog entries that you sell.
For example, you might have a product type for movies, another for books, a third for
electronics, and so on.
When thinking about creating new product types, the most significant differences are the
Class field and the content page, which defines the XML Smart Form for products you will
create for a Product Type.

Product Classes
A catalog entry’s product class affects customers’ purchasing options. Classes are explained
below.
l

Kit—Lets a customer (site visitor) select from any number of free-text options. Options
can increase or decrease the overall price. See Also: Creating a Kit on page 1345
Example: A computer whose price changes as a customer selects RAM, hard drive,
monitor, and so on.

l

Bundle—A catalog entry consisting of several other catalog entries bundled together. Its
pricing, shipping, images, and so on, are independent of the individual items. See Also:
Creating a Bundle on page 1347
Example: A living room set: couch, end tables and lamps. Instead of buying each item
separately, the customer buys all for a “package” price.

l

Product—Simple or complex catalog entries. A complex product is a “wrapper” that
provides links to related simple products. Each simple product has its own SKU, price,
inventory data, and so on. See Also: Creating a Complex Product on page 1348
Example: A movie in 3 formats and prices:

l

l

VHS ($12.95)

l

DVD ($14.95)

l

Blu-ray ($17.95)

Subscription—A catalog entry which can provide access to designated site pages, and
may billed on a recurring basis. See Also: Creating a Subscription on page 1349
Example: website content that is only available to subscribed members
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How Product Types Affect the Creation of Catalog
Entries
Catalog folders generally contain the same kind of catalog entries, such as DVDs or digital
cameras. Some information applied to a catalog folder is inherited by all entries in the folder.
After you create product types, apply appropriate types to existing catalog folders using the
Catalog Properties screen’s Product Types tab. Then, when creating a new catalog entry,
you first navigate to a catalog folder. Next, click New and choose a product type assigned to
the folder. See Also: Assigning a Catalog Folder’s Product Type on page 1355
A product type determines the following aspects of the associated catalog entries:
l
l

l

l

Product class—Product Classes on the previous page
Attributes—Step 1: Defining Properties, Attributes, and Media Defaults below Attributes
define additional information about catalog entries based on this product type. For
example, if the Product Type is for movies, attributes might be Actors, Running Time,
Rating, Year Released, and so on. In another example, you want an attribute that
describes a chair’s dimensions. You create a text-based attribute for the Product Type
you will use to add chairs to a catalog. Then, whenever you add a new chair to the
catalog, you enter its dimensions into the Attributes tab’s Dimensions field. By
default, Attributes appear on the Product server control.
Media defaults (that is, size of thumbnail images added to a catalog entry)—Step 1:
Defining Properties, Attributes, and Media Defaults below
Content page—Step 2: Creating the Content Page on page 1353

There are 2 steps to creating a product type.
l

Step 1: Defining Properties, Attributes, and Media Defaults below

l

Step 2: Creating the Content Page on page 1353

Step 1: Defining Properties, Attributes, and Media
Defaults
To create a product type:
1. Go to Workarea > Settings > Commerce > Catalog > Product Types > New >
Product Type.
2. Click the Properties tab.
3. Enter a unique product type title in the Title field. The title identifies this entry on the
View Product Types screen. Also, when creating a new catalog entry, users must pick a
product type from the catalog’s New menu.
4. Enter a description for the product type in the Description field.
5. Select a product class from the Class drop-down menu. For information about how class
types affect how products are displayed, see Creating a Kit on the facing page, Creating
a Bundle on page 1347, Creating a Complex Product on page 1348 and Creating a
Subscription on page 1349. In some cases, you will need to perform additional steps on
other screens.
6. Click the Attributes tab.
7. Click Add Attribute. The Add Attribute dialog box appears.
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8. Enter an attribute name in the Name field, such as color.
9. Choose a data type from the Type drop-down menu.
l
Text
l

Date

l

Number

l

Yes or No (boolean)

10. Click OK. When a customer views the chair’s product page, the customer sees the
attribute text below the thumbnails.
11. Click the Media Defaults tab.
12. Click Add thumbnail. The Add thumbnail dialog box appears.
13. Enter a name for the thumbnail in the Name field.
14. Specify the size if the thumbnail in pixels using the Width and Height fields.
15. Click OK.
16. Click Save. The XML Smart Form editor appears, as described in Step 2: Creating the
Content Page on page 1353.

Creating a Kit
A kit is a type of catalog entry that allows a customer to select from free-text options, which
can affect the item’s price. The options can also be placed into logical groups.
For example, if a catalog entry is a laptop computer, one group may let you enter options for
RAM, another for operating system version, and a third could present hard drive options.

There is no limit to the number of groups you can add, nor the number of options in a group.
All groups and options are simple text, created on a kit’s Items tab as needed, and can
accommodate a price modifier. The example below shows how to set up chair color
combinations.
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In this example, the options do not affect the price. Here is how the options appear on a
product page.

Consider another example in which the price does change. In this case, use the Item screen’s
Price Modifier field to adjust price based on the chair frame. As shown below, if the chair
frame is teak, the sale price increases by $25.00.

Other chair materials might adjust the price.
l

Wrought Iron—$0.00

l

Aluminum— +$15.00

l

Steel— -$10.00

Note how the Price Modifier can either increase or decrease the sale price. Here are these
options on the product page.
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The chair’s base price is $79.99, and the teak frame increases it to $104.99.

Creating a Bundle
A bundle consists of several simple products. You would use it to combine several existing
products into one “umbrella” catalog entry. That entry captures pricing, SKU number,
shipping, and inventory information for the bundle. The information for the individual entries
that make up the bundle are not affected when one is ordered.
As an example of a bundle using furniture, assume your eCommerce site sells a chair, a
table, and an ottoman separately. You also sell them together as a set.
Use a bundle to define the set, add pictures, pricing, and so on. On the bundle’s Items tab,
you select the individual catalog entries that make up the bundle.

Here is how this bundle looks on a product page.
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Creating a Complex Product
A Complex Product is similar to a bundle in that one catalog entry serves as an “umbrella” for
other entries. However, unlike a bundle, a customer must select one of the catalog entries.
So, the price is that of the selected entry, not the umbrella item.
The advantage of a Complex Product is its ability to consolidate several related items under
one title, yet lets customers choose the item they want. Because each item under the
umbrella is its own catalog entry, it is priced and tracked separately.
For example, a site sells movies in 3 formats: VHS, DVD, and Blu-ray. Each is priced
differently. To accommodate this, create catalog entries for the movie in each format,
assigning images, SKU number, pricing, dimensions, and so on. Then, create a Complex
Product, make its title the title of the movie, and use the Items tab to select the catalog
entries of the individual formats.
The Product List or Product Search control displays the Complex Product, which is the movie
title. When a customer selects that, the customer sees the product page, which lists the
format and price of each assigned catalog entry. The customer can only choose one.
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Unlike the Kit or Bundle, a complex product does not have its own product class. Instead, you
create a catalog entry whose product class is Product, then assign other catalog entries to it
via the Items tab. As soon as you assign one catalog entry via the Items tab, the original
catalog entry is converted to a Complex Product.

Note that the price of the “umbrella” product appears on the Product List and Product Search
server controls. This can be misleading, since the price of individual items within the complex
product can vary.
You cannot apply tier pricing to a complex product. See Also: Tier Pricing on page 1363

Creating a Subscription
A subscription is a good or service which
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l
l

can be billed on a one-time or a recurring basis
places users who purchase it into a designated membership group, letting you grant
them access to private content

Examples include
l

content only available to members who purchase a subscription

l

a gym membership

l

a book club, in which a customer makes the same payment and receives a different book
each month

l

anti-virus software that expires after 12 months

l

a 3-year maintenance contract on a digital television, payable yearly

If you use the recurring billing feature (a series of scheduled payments), the bill can be
generated for any number of months or years, but no other time increments. Each payment
must be the same for the subscription’s term. The term begins when a customer submits the
order.
Customers cannot apply a cart-level coupon to a subscription-based catalog entry. See Also:
Creating a Coupon on page 1373

Creating a Subscription-Based Catalog Entry
Creating a subscription is the similar to creating a regular catalog entry:
1. Create a subscription-based Product Type. On the Product Type screen’s Class dropdown, select Subscription.
2. Assign the Product Type to a catalog folder. See Also: Creating a Catalog Folder on
page 1354
3. In that folder, create a catalog entry for each subscription.
4. On the Pricing tab, enter the cost.
If using recurring billing, enter the term of the subscription. To learn about Recurring
Billing fields, see Entering Recurring Billing Information below
If this product does not use recurring billing, click No at the Use Recurring Billing
drop-down. To learn about the Unit Pricing fields, see Entering a Catalog Entry’s Price
Information on page 1362.
5. On the Items tab, assign membership and Ektron user groups. See Also: Assigning
Groups to a Subscription-Based Catalog Entry on page 1352
6. If a subscription provides access to Ektron content, use its folder Permission Table to
grant permission to the membership and Ektron user groups you defined in Step
5.Subscriptions Involving Ektron Content on page 1352
Subscription-based products do not support tier pricing. See Also: Tier Pricing on page 1363

Entering Recurring Billing Information
IMPORTANT: Due to differences in the way payment gateways work, you should test recurring
payments with your gateway before processing live transactions.
The Pricing tab’s Recurring Billing area of a subscription-based catalog entry lets you
determine if a subscription is billed on a one-time or a recurring basis. If recurring, it helps
you define the terms.
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Entering Recurring Billing Information

To set up recurring billing:
1. Select Yes from the Use Recurring Billing drop-down. The recurring billing term
begins when a customer submits an order, and is based on a number of months or years.
2. Select a time interval from the Billing Cycle drop-down.
3. Enter a number of Billing Intervals for which a customer is charged. For example, if a
customer should be charged once a month for 12 months, complete the screen as shown
above. If a customer purchases the item on June 1, 2013, the person's credit card will be
billed on the first of each month from June 1, 2013 to May 1, 2014.
As another example, if a customer should be charged once a year for 3 years, complete the
screen as shown below.

If a customer purchases the item on June 1, 2013, the person's credit card will be charged on
the following dates.
l

June 1, 2013 (purchase date)

l

June 1, 2014
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l

June 1, 2015

Assigning Groups to a Subscription-Based Catalog Entry
You must assign a membership user group to a subscription-based catalog entry. Optionally,
you can assign an Ektron user group. You assign groups via the subscription’s Items tab.
See Also: Membership Groups on page 1165
So, as part of setting up a subscription, you must either create new membership and
(possibly user) groups, or use existing groups.

All users (identified by their email address) who purchase the product are automatically
added to one of the groups. Ektron checks a user’s email address to determine if the user is
an Ektron or a membership user.
l
l

Ektron users are added to the group defined in the CMS Author Group field
Non-Ektron users are added to the membership group defined at the Member Group
field

Subscriptions not Involving Ektron Content
If a subscription does not involve access to Ektron content, the membership group provides a
list of customers who purchased the subscription. You can use the list to manage the
accounts, notify them when the subscription is about to expire, and so on.

Subscriptions Involving Ektron Content
If a subscription involves access to Ektron content:
Create a folder and enable one or more subscription-based product types on its Product Type
screen.
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Step 2: Creating the Content Page

Place the subscription products in that folder. Customers shop for and purchase this content
on your website as they do all products, via eCommerce server controls.
Then, create a regular content folder in which to create the confidential content. Next, use the
content folder’s permission table to grant the subscription user groups access to that folder.

See Also: Managing Folder Permissions on page 257 and Assigning Membership Permissions
on page 1166

Step 2: Creating the Content Page
After you complete and save the Add Product Type screen, a new screen lets you enter XML
Smart Form information. On this screen, you set up fields to collect information for the
content page of catalog entries based on this product type. See example below.
The content page appears on the Product server control, describing this catalog entry to
customers. The process of creating a product type content page is the same as creating an
XML Smart Form, described in Copying a Smart Form Configuration on page 427.

Editing a Product Type
1. In the Workarea, go to Settings > Commerce > Catalog > Product Types.
2. Click the product type that you want to edit.
3. See Step 1: Defining Properties, Attributes, and Media Defaults on page 1344.
NOTE: You cannot edit a Product Type’s Class.

Viewing an Attribute's Published Status
Ektron 8.7
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Each attribute has a publication status. To view attribute status, go to Settings >
Commerce > Catalog > Product Types, select a product type and click the Attributes
tab.
l
l

l
l

Active—Attribute can be assigned to catalog entries
Inactive—Attribute already assigned to one or more catalog entries, but can no longer
be assigned. To make an attribute inactive, click the corresponding Mark for Delete (
).
Not Published—Attribute has been created but Product Type not saved yet
Active (marked for delete with strike through)—Attribute will be deleted when Product
Type is saved.

You can delete an attribute only if it is not applied to a catalog entry. If you try to delete an
attribute applied to a catalog entry, it is marked “Inactive.” Inactive attributes can no longer
be assigned.

Deleting a Product Type
PREREQUISITE
The product type is not assigned to any catalog entries.
1. In the Workarea, go to Settings > Commerce > Catalog > Product Types.
2. Click a product type you want to delete.
3. Click Delete ( ). A confirmation message appears.
4. Click OK.
Although you cannot delete a product type that is being used, you can prevent users from
creating new catalog entries based on it. To do this, go to each applicable folder’s Catalog
Properties > Product Types screen and remove that product type.

Creating a Catalog Folder
PREREQUISITE
One or more product types.
A catalog folder is a special kind of Ektron folder designed to hold eCommerce entries. Its
unique icon ( ) distinguishes it from other folder types. If you are familiar with content
folders, much of that information applies to catalog folders. See Also: Setting Up Your
CMS Folder Structure on page 241
A Catalog folder's properties screen has several tabs/screens. The following screens are the
same as regular content folders.
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l

Properties—See Setting Folder Properties on page 253

l

Taxonomy—See Using Taxonomies on page 777

l

Templates—See Working with Templates on page 382

l

Flagging—See Defining Flags for Content on page 1239

l

Metadata—See Assigning Metadata to a Folder on page 377

l

Breadcrumb—See Using Breadcrumbs on page 819

l

Aliasing—See Creating User-Friendly URLs with Aliasing on page 835
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Assigning a Catalog Folder’s Product Type

The unique screen is Product Types. See Also: Assigning a Catalog Folder’s Product Type
below
Like content folders, the following catalog folder information can be inherited from its parent
or uniquely set for each catalog. You can only make changes after creating the catalog.
l

Permissions—See Managing Folder Permissions on page 257

l

Approvals—See Setting Approval Chains on page 262

l

Purge History—See Purging History on page 252

l

Restore Web Alert Inheritance—See Assigning Web Alert Information to Folders and
Content on page 1581

Assigning a Catalog Folder’s Product Type
A catalog folder’s Product Types screen lets you identify product types upon which catalog
entries can be based. For example, you created a lawn mower Product Type, and want only
lawn mowers to be entered in a catalog folder. In this case, open a catalog folder’s Product
Types tab, break inheritance if necessary, and select Lawn Mower as the catalog’s only
product type.

Then, when an Ektron user creates an entry in this catalog, the user must use the Lawn
Mower product type.

Deleting a Catalog Folder
PREREQUISITE
No catalog entries in the folder have been placed on an order
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1. Navigate to the folder that you want to delete.
2. Choose Delete > This Catalog. A confirmation message appears.
3. Click OK.

Searching a Catalog Folder
Searching a Catalog folder is the same as searching any other type of Workarea folder. This
procedure is described in Searching the Workarea on page 966.

Creating a Catalog Entry
PREREQUISITE
One or more catalog folders.
A Catalog entry is the eCommerce term that describes a product sold on your website. It is
similar to content in the rest of Ektron, so those concepts also apply to catalog entries.
Catalog entries are built from Ektron XML Smart Forms, so use the same content and folder
structure as other Smart Forms. See Also: Working with Smart Forms on page 423
Catalog entries share the following features with regular content:
l

content status

l

approvals and permissions

l

metadata

l

schedule

l

can be private

l

history and the ability to restore previous versions

l

search

l

taxonomies to categorize products

Catalog entries also have unique information:
l

Tax Class—Determines which taxes apply to item

l

Physical dimensions—Used to calculate shipping costs

l

Inventory tracking

l

l

Pricing—Can be fixed or variable for any currency
l
tier pricing—Pricing adjusts when quantity reaches new plateau. For example, 1-9
items cost $500 each. But if 10 are sold, the price drops to $450 each.
Images (full sized and thumbnail) to display the product on your website

Because there is so much information to provide about managing catalog entries, this section
takes 2 approaches:
l
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Creating a Catalog Entry above describes how to work with catalog entries: create them,
delete them, and so on.
o Creating/Updating Catalog Entries on the facing page
o

Deleting a Catalog Entry on page 1358

o

Recommending Related Products to a Customer on page 1371
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Creating/Updating Catalog Entries

l

o

View and restore a previous version of a catalog entry—Navigate to catalog
folder > select catalog entry > View Menu > Content History option. See
Also: Managing Versions of Content on page 299

o

Edit permissions for a catalog entry—To enable this, break permission inheritance.
Then, assign permissions to selected users. See Also: Setting Permissions for
Content on page 261

o

Edit inherited approval chain—First break permission inheritance, and assign
permission to users who need to be in the approval chain. Then, update the catalog
entry’s approval chain. See Also: Creating an Approval Chain For Content on
page 266

o

Make a catalog entry private, so that the website search does not find it—See
Making Content Private on page 294

o

Archive a catalog entry—See Setting Archive Options on page 298

o

Displaying Catalog Entries on your Website on page 1370

The following topics describe all accessible options (tables, menus, and so on) from the
catalog entry screen
o Tabs on the Catalog Entry Screen on page 1359
o

Menu Options on the Catalog Entry Screen on page 1360

o

Folder View Menu options on page 1368

o

Content View Menu Options on page 1369

Creating/Updating Catalog Entries
Follow these steps to create a new catalog entry or update an existing one.
1. Navigate to a catalog folder in which you want to create or update a catalog entry.
2. Choose New then select a product type on which to base the entry.
3. Complete the screens as needed. (For information about the catalog entry screens, see
Tabs on the Catalog Entry Screen on page 1359) The required fields are:
l
content Title
l
l

Properties tab > SKU Number
any fields on the content screen that your Ektron administrator has designated as
required

4. Check in or submit/publish the content.
After signing in to your website, you can also update a catalog entry’s information from there
using the context menu.
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If a new catalog entry is similar to an existing one, you might find it quicker to copy the
existing entry then edit the fields that are different. Moving a catalog entry is the same as
moving content. See Moving or Copying Content on page 290

Deleting a Catalog Entry
PREREQUISITES
l
l

Catalog entry is not on an order, or checked out.
You have delete permission for this catalog folder. See Also: Managing Folder
Permissions on page 257

BEST PRACTICE
Avoid deleting catalog entries due to the affect on your website. For example, if you
delete an entry from your staging site, then run eSync, that entry is removed from all
active carts on your live site. Instead of deleting entries, you should archive them
using the Properties tab’s Archived checkbox.
If you want to prevent customers from purchasing an item, but you cannot delete it because it
has been placed on existing orders, you have 2 options.
l

l

Uncheck its Buyable checkbox, located on the Properties screen. If you do, the product
still appears on your website, but the Add to Cart button does not appear next to it.
archive it, using the Archived check box on the Properties screen (circled above). In
this case, the product does not appear on your website.

To delete a catalog entry:
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Tabs on the Catalog Entry Screen

1. Navigate to the catalog folder that contains the entry.
2. Click the entry.
3. Choose Action > Delete. A warning message appears.
4. Click OK. The catalog entry is deleted.

Tabs on the Catalog Entry Screen
l

l

l

Content—The entry’s content page. See Also: Entering a Catalog Entry’s Content on the
next page
Summary—The content summary, by default the first 40 characters of the content text.
See Also: Entering a Catalog Entry’s Summary on page 1361
Properties—eCommerce information about the catalog entry:
l
SKU number
l

Number of Units

l

Tax Class

l

Archived

l

Buyable

l

Dimensions

l

Inventory
See Also: Entering a Catalog Entry’s Properties on page 1361

l

Pricing—Lets you define list and sales price
l
For each enabled currency, you can set a fixed price or have it float with exchange
rate
l

Allows tier pricing

l

For subscription products, you enter recurring billing interval and term
See Also: Entering a Catalog Entry’s Price Information on page 1362

l

l

l

Attributes—Additional information to help describe a catalog entry. See Also: Entering
a Catalog Entry’s Attributes on page 1364
Media—Lets you add images that appear on several eCommerce server controls. See
Also: Entering a Catalog Entry’s Media on page 1366
Items—Catalog entries that you are adding to this “umbrella” item. See Also:
l
If you add catalog entries to a simple product, it becomes a complex product. See
Also: Creating a Complex Product on page 1348
l

l
l

l

For bundles, add catalog entries that make up a bundle.Creating a Bundle on
page 1347
For kits, enter groups and their options.See Also: Creating a Kit on page 1345
For subscription products, define membership and Ektron user groups to which
users are assigned when they purchase the subscription.Creating a Subscription on
page 1349

Metadata—Enter meta tags, title tags, and so on. Working with Metadata on page 369
When viewing the metadata screen in view mode only, you see the catalog entry’s
Product Icon. The product icon is set on the Media tab. See Also: Using Images in
eCommerce on page 1292
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l

l

l

l

l

Alias—View and edit the catalog entry’s manual primary alias. View all automatic
aliases assigned to this catalog entry. This tab only appears if Aliasing is enabled.See
Also: Creating User-Friendly URLs with Aliasing on page 835
Schedule—Lets you control when a version of a catalog entry becomes visible on the
website. Similarly, you can remove a catalog entry on a predetermined date and time.
The Archive and remain on the site option is not available with catalog
entries.Scheduling Content on page 296
Comment—View comments on changes made when editing a catalog entry. To view and
edit catalog entry comments, open the editor and choose Change > Comment. The
comment also appears on the View Content and Content History screens. Use it to help
distinguish one version from another.
Tasks—View tasks assigned to this catalog entry. To add a task from the View Entry
screen, click Action > Add Task. See Also: Assigning and Managing Tasks on
page 1027
Category—Add a taxonomy category to the catalog entry. A list of available taxonomies
and whether one is required are defined on the Catalog properties screen. This tab only
appears if at least one taxonomy is assigned to the catalog folder.Using Taxonomies on
page 777

Menu Options on the Catalog Entry Screen
l

Action Menu
l
Save—Saves the catalog entry without leaving the editor. It is a good idea to save
your work frequently.
l

l

Check in—Save and check-in the document. This action returns the changed
content to the database and exits the editor. It does not submit the content into the
approval chain. Rather, it allows you and other users to continue changing it.
Submit/Publish
l
Submit the content into the approval chain. This action also returns the new or
updated content to the database and exits the editor.
l

l

l

Publish the content to the website. Only the last approver in the approval
chain sees this button. If no approval chain is assigned to the content’s folder,
every authorized user sees this button. See Also: Setting Approval Chains on
page 262. This action also returns the changed content to the database and
exits the editor.

Undo checkout—Exit screen and do not save changes made since you began
editing this catalog entry.

Change Menu
l
Comment—Enter comments on changes made when editing a catalog entry. The
comment also appears on the View Content and Content History screens. Use it to
help distinguish one version from another.
l

Template—A folder’s default template is automatically applied to all content in the
folder. However, you can change a content item’s template to any of those assigned
to the folder.

Entering a Catalog Entry’s Content
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Entering a Catalog Entry’s Summary

The Content tab displays the content page of this catalog entry’s product type. Because the
format is customized for your system, this documentation cannot explain how to respond to
the fields.
To learn about working with the editor, see Editing in Ektron on page 207.

Entering a Catalog Entry’s Summary
Creating summary information for a catalog entry is done the same as with any other type of
content. See Writing a Summary for Content on page 292.

Entering a Catalog Entry’s Properties
The Properties screen collects eCommerce-specific information about your catalog entries:
l

l

SKU—Enter a unique SKU code for this catalog entry. This is a required field that does
not accept a value of zero (0) or a space character.
Number of Units—If this item has a quantity other than one (1) for internal recordkeeping purposes only, enter that number.
For example, a 12 pack of soda. Set Quantity is 12 to represent the number of units.
But a customer still orders 1 of the item.
The quantity is not used when this item is ordered, nor does it affect inventory levels. It
is used for clerical purposes only.

l

l

Tax Class—Select the catalog entry’s Tax Class. See Also: Cataloging Entries that Can
Be Taxed on page 1338
Archived—Check this box if you want to archive this catalog entry. When archived,
customers can no longer see nor order it. Also, Ektron users cannot view an archived
catalog entry in its catalog folder via the View Folders screen. To view it, open its
catalog folder then select View > Archive.
To make the entry available again on your website, open its archive folder, edit the
entry by unchecking the Archived check box, and publish it.
A catalog entry can also be set to Archived status if it reaches its expiration date and its
Schedule tab > Action on End Date field is set to Archive and remove from site
(expire).

l

Buyable—To let customers add this catalog entry to a shopping cart, check this box.
Otherwise, uncheck it.
If a product is not buyable, it can still be seen by customers, but its product page does
not display an Add to Cart button.

l

Dimensions—Used to calculate packaging containers and shipping costs. See Also:
Packages
o Tangible Item—
Check this box if the item is tangible, that is, it has dimensions, weight, and will be
shipped to a customer. Examples of non-tangible items are services, warranties,
and downloadable software. If a catalog entry is tangible, you must enter its height,
width, length, and weight.
o

Height—Enter the catalog entry’s height. The units of measure are specified in the
web.config file’s ek_measurementsystem property.
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l

o

Width—Enter the catalog entry’s width.

o

Length—Enter the catalog entry’s length.

o

Weight—Enter the catalog entry’s weight.

Inventory—eCommerce’s inventory system is a provider model, allowing you to
connect with third-party inventory systems.
o Disable Inventory—Check this box if you do not want to track inventory activity
for this catalog entry. As examples, it is a service contract or a subscription to
confidential content on your site.
o

In Stock—Enter the number of items on hand for this catalog entry. This number is
automatically adjusted when an order containing this entry is submitted. For
example, there are 100 items in stock. When an order for 10 is submitted, the In
Stock value changes to 90. If the amount placed on an order exceeds the In Stock
amount, the customer see this message “The item ... is not available for purchase.
Please remove from cart before submitting order.”

o

On Order—The number of items that have been ordered but not yet delivered
appears.

o

Reorder—Enter the In Stock quantity at which you need to reorder this item.
When the In Stock quantity reaches this level, an event is triggered which can be
used by an external inventory system to generate a new order.

Entering a Catalog Entry’s Price Information
Use the Pricing screen to enter price information for catalog entries.
l

l

l

l
l

Currency selector—Use this drop-down to select a currency for the prices. See Also:
Alternate Currency Pricing below. Only enabled currencies appear. See Also: Enabling
Currencies on page 1308.
List Price—Enter the catalog entry’s list, or manufacturer’s suggested retail, price. The
list price appears on most eCommerce controls but is not used in any calculations.
Our Sales Price—Enter the catalog entry’s sale price. This price is used to calculate
line item totals, coupon discounts, shipping costs, and so on. The sales price appears on
most eCommerce controls. .
Add Pricing Tier—See Also: Tier Pricing on the facing page
Recurring Billing (appears only for subscription-based products)—See Also: Creating a
Subscription on page 1349

Alternate Currency Pricing
By default, the Pricing screen converts prices to every enabled currency using the exchange
rate. Customers who select a non-default currency see these prices. See Also: Defining and
Updating Exchange Rates on page 1310
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Tier Pricing

The Float checkbox (checked by default) indicates that prices change as the exchange rate
changes.
If you do not want to float a catalog entry’s price, but instead fix it for a currency, select the
currency, uncheck Float, edit the price, and publish. From then on, if a customer selects that
currency and catalog entry, the price set on this screen is used. The exchange rate is ignored.
For example, a television costs 700 Euros, regardless of its cost in US dollars or the exchange
rate. To incorporate this, do not check the Float checkbox.
When you first select EUR on the Pricing screen, the default currency’s prices are converted
using the exchange rate. For example, the television’s sale price is $1000 US dollars, and
today’s exchange rate is .7811. When you select Eur from the Pricing screen’s currency
selector, the television’s cost is set at 781.10 Euros. You change the price to 700.00 Euros.
From that point on, the Euro price only changes if an authorized user accesses this screen and
changes it manually.

Tier Pricing
eCommerce supports tier pricing, that is, a pricing schedule that adjusts according to order
quantity. Typically, the price is reduced as more items are ordered. For example, if a visitor
orders 1-5, items are $10.00 each; 6-10, $9.00 each; 11 or more, $8.50 each.
Tier pricing is not supported for subscription products, nor for complex products.
To set up tier pricing:
1. In the Workarea, open the catalog folder containing the entry to which you want to apply
tier pricing.
2. Edit the catalog entry.
3. Click the Pricing tab
4. Click Add Pricing Tier. The Tier Pricing screen section appears.

5. In the left column, enter the quantity of items above which the tier price is used.
6. In the right column, enter the price to be used when an order quantity exceeds the
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number in the left column.
7. Enter as many tiers as necessary.
NOTE: To remove a tier, check the box to its left, then click Remove Pricing Tier.

Tier Pricing and Non-Default Currencies: When Floated
If a non-default currency is floated, then that currency’s pricing tiers mirror the default
currency’s pricing tier values. The amounts are adjusted by the exchange rate.
These values appear on pricing screen in view-only mode and cannot be changed.

If pricing tiers are set up for the default currency and the user unchecks the Float box, the
user is notified that the pricing tiers can now be edited. Next, Tier Pricing fields are loaded
with the existing values but the user can change values, remove existing tiers, and add new
ones.

Tier Pricing and Non-Default Currencies: When Not Floated
If a non-default currency is not floated, its pricing tiers are independent of the default
currency’s. That is, they do not exist initially regardless of whether they exist for the default
currency. If the user clicks Add Pricing Tier, Tier Pricing fields appear and let the user
enter number of units and corresponding tier price per unit.
If pricing tiers are set up for a non-default currency and the user checks the Float box, the
pricing tiers are changed to mirror those of the default currency. If the default currency has
no pricing tiers, then that currency has none. You cannot independently edit a non-default
currency’s pricing tiers if Float is checked.

Entering a Catalog Entry’s Attributes
Attributes are additional pieces of information that help describe a catalog entry. Attribute
fields, data types, and default values are created as part of a Product Type. When you create
a catalog entry, you base it on a product type. The product type’s Attribute information is
imported to the catalog entry. Like metadata that follows Ektron content, if a catalog entry is
moved to another folder, its attributes stay with it.
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Entering a Catalog Entry’s Attributes

To illustrate the concept, the following attributes are applied to furniture in Ektron’s sample
site.

In the Workarea, you select a catalog entry then click the Attributes tab to enter or modify
attribute values. If no attributes are assigned to the product type on which a catalog entry is
based, you will not see an Attributes tab when working with that catalog entry. You could
change model year to 2009, or style to Woodland. You cannot however change fields, field
names, or data types.
On your website, a catalog entry’s Attribute field names and values appear by default on the
Product server control.
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Entering a Catalog Entry’s Media
Use the Media tab to add product images that appear on the following server controls.
l

Product (the smallest thumbnail may appear)

l

Product List

l

Product Search

l

Recommendation

See Also: Using Images in eCommerce on page 1292

Adding a New Image
1. Click the Media tab.
2. Click Add New Image. The add New Image dialog box appears.
3. Enter an image Title (required).
4. Enter the image’s Alt text (required).
5. Click Browse and navigate to the image you want to add.
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Editing an Existing Image

6. Click Upload. The image is uploaded to the siteroot/uploadedimages folder and you
are returned to the Media tab. The uploaded image appears on the screen, below any
existing images.
7. Determine if you want the image’s smallest thumbnail to appear on the Product server
control by selecting Yes or No next to Gallery Display. (See example below).
8. If you want to designate the image as the product icon, click Set as Product Icon.
Image thumbnails and product icons are described in Using Images in eCommerce on
page 1292.
When an image is uploaded to the Media tab, the original image and any thumbnails
associated with it are added to the Library. For example, if you add an image named
“TestImage” (actual file name: “case.jpg”) with a 150px and 50px thumbnails, you see the
following entries in your library (File Name - Path):
TestImage - /~siteroot~/uploadedImages/case.jpg
case[filename]150 - /~siteroot~/uploadedImages/case[filename]150.jpg
case[filename]50 - /~siteroot~/uploadedImages/case[filename]50.jpg
If you assign several images to an eCommerce catalog entry, and want to allow searching for
that catalog entry by image file name, the search only works with the first image assigned to
the catalog entry.

Editing an Existing Image
NOTE: You cannot change an existing image. If you need to do this, delete the image you do not want,
then add the correct one. You can only edit the Title and Alt Text.
1. Click the Media tab.
2. Move the cursor to the field that you want to edit.
3. Click the pencil icon to the right of the field.>

4. Update the text as needed.
5. Click OK (

).

Determining Thumbnail Size
When you create a catalog entry, you base it on a Product Type. The selected product type’s
Media Defaults information determines the sizes of thumbnails created for each image
assigned to the Media tab.
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l

l

If the image is less than both thumbnail dimensions (height and width), it appears full
size.
If the image is greater than the thumbnail’s dimensions, the image is reduced
proportionately, scaling its dimensions to the thumbnail size.

The Default Image
If you do not assign an image to a catalog entry, but one is assigned to appear on a server
control, the following default image is used.

If you want to change the default image, edit the following file:
siteroot/WorkArea/images/application/Commerce/productImageBackground.gif

Entering a Catalog Entry’s Items
Use the Items tab to add additional information to the current entry. You can only choose a
catalog entry whose language matches the language of the original item. It is used in these
situations:
l

to select the catalog entries that make a product into a complex product.

l

to select the catalog entries that make up a bundle.

l

to select the groups and their options that make up kits.

l

to select a subscription-based catalog entry’s user groups. See Also: Assigning Groups to
a Subscription-Based Catalog Entry on page 1352

Folder View Menu options
New Menu
l
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Catalog—Create a new catalog folder underneath the current one. See Also: Creating a
Catalog Folder on page 1354
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l

product types assigned to folder—Create a new catalog entry based on one of the
displayed product types. Your product types may not match the ones shown below.
Product types are assigned to a catalog’s via the Product Types screen. See Also:
Creating Product Types on page 1343

View Menu
l

l

All types, Products, Kits, Bundles, Subscriptions—Lets you change the display of
catalog entries. You can see all entries in folder, or only those of a selected product
class.
Language—Limits display of catalog entries to one language. Also determines the
language of any new catalog entries you create in this folder.

l

Archive—Displays archived catalog entries.

l

Catalog Properties—Lets you view and edit catalog folder information.

Delete Menu
l
l

This Catalog—Lets you delete a catalog folder.
Entries—Lets you delete a catalog entry within a folder. You cannot delete a catalog
entry that has been placed on any order. The order’s status is irrelevant.

Action Menu
l

l

Move entry—Move catalog entry. You can only move catalog entries -- you cannot copy
them. See Also: Managing Versions of Content on page 299
Search—Search for a product. See Also: Searching the Workarea on page 966

Content View Menu Options
Action Menu
l

Edit—Edit the catalog entry.

l

Delete—Delete a catalog entry.

l

l

Link Search—Locates all content that includes a Quicklink to the displayed catalog
entry. This feature is useful before deleting a catalog entry, because it informs you of
every entry that will include a “dead” link if you delete that entry. You should then edit
those catalog entries and remove or change the obsolete Quicklinks.
Add Task—Assigning and Managing Tasks on page 1027

View Menu
l

l

l

l

l

Content History—Lists every version of the content available in Ektron. After viewing
the View Content History window, you can click any version to see its detail. See Also:
Managing Versions of Content on page 299
View Approvals—Access the catalog folder’s approval chain. See Also: Setting
Approval Chains on page 262
View Permissions—Access the catalog folder’s permissions table. See Also: Managing
Folder Permissions on page 257
Cross Sell—Lets you assign cross sell items to this catalog entry. See Also:
Recommending Related Products to a Customer on page 1371
Up Sell—Lets you assign up sell items to this catalog entry. See Also: Recommending
Related Products to a Customer on page 1371
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l

View Properties—Lets you:
l
view the catalog entry’s product type
l
l

view the Flagging Definitions assigned to the catalog entry’s folder
view and edit the Content Searchable setting See Also: Ensuring Your Content is
Searchable on page 942

Reports Menu
l
l

Content Statistics—User-Ranking of Content on page 587
Analytics—Provides a visual display of order information for a selected catalog entry.
See Also: eCommerce Analytics on page 1403

Editor View Menu Options
Action Menu
l

l

l

l

Save—Save the content without leaving the editor. It is a good idea to save your work
frequently.
Check in—Save and check-in the document. This action returns the changed content to
the database and exits the editor. It does not submit the content into the approval chain.
Rather, it allows you and other users to continue changing it.
Submit or Publish—Submit the content into the approval chain. Publish the content to
the website. These actions also return the new or updated content to the database and
exits the editor. Only the last approver in the approval chain sees this button. If no
approval chain is assigned to the content’s folder, every authorized user sees this
button. See Also: Setting Approval Chains on page 262
Undo Checkout—Close the editor without saving changes.

Change Menu
l

l

Comment—Briefly describe the content, or comment on changes made when editing
content. The history comment appears on the View Content and Content History screens.
Template—Lets you specify one or more templates for catalog entries in this folder.
These entries use the specified template when appearing on your website. See Also:
Working with Templates on page 382

Displaying Catalog Entries on your Website
The eCommerce Module provides the following server controls for displaying catalog entries
on your website.
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l

Product on page 1815

l

ProductList on page 1818

l

Product Search Server Controls on page 1822
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Recommending Related Products
to a Customer
Ektron eCommerce lets you recommend related products to a customer (site visitor) based
on products they are currently viewing.
Cross sell and upsell tactics are designed to increase the amount of cart sales. Use the
Recommendation on page 1826 server control to add cross sell and upsell offers.
Cross sell offers items related to a catalog entry. So, for example, if someone is purchasing a
digital camera, cross sell items might be a carrying bag, digital photo printer, larger memory
cards, additional warranty, and so on.
Up Sell refers to similar but more expensive items. So, for example, if someone is viewing a
7 megapixel digital camera, upsell items might be a 10 megapixel camera, or a digital SLR
camera.

Displaying Cross Sell and Upsell Items on Your
Website
Use the Recommendation on page 1826 server control to place cross sell or upsell items
anywhere on a Web page. A single control can only show either cross sell or upsell items.

Assigning Cross Sell and Upsell Items to a
Catalog Entry
1. Open the catalog folder containing the catalog entry to which you want to assign cross
sell items.
2. Click that entry.
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3. Click View > Cross Sell or Up Sell.

4. Click Add. A screen displays all catalog folders.

5. Open the folder that contains the cross sell or upsell catalog entry.
6. Click that catalog entry.
7. Click OK.
8. Enter additional cross sell entries as needed.
9. Choose Action > Save.
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Using Coupons
Most eCommerce sites periodically offer coupons to provide discounts to customers, either to
attract new business or reward loyalty. Ektron’s eCommerce feature lets you generate
coupons with the features such as:
l

percentage discounts—you can set a maximum coupon value regardless of the amount
calculated by percentage.

l

limit to catalog entries that you accept

l

limit to most or least expensive entry

l

limit to 1 use per customer

l

limit from being used with other coupons

l

limit to a date range when coupon is active

l

specify a maximum number of redemptions

l

specify a minimum order amount required to activate coupon

This section also contains the following topics.
Creating a Coupon
Deleting a Coupon
Disabling a Coupon

1373
1379
1379

Creating a Coupon
Create coupons in the Workarea by going to Settings > Commerce > Catalog >
Coupons. To make it easy to complete the information, the screens are arranged in
numbered steps. Subsequent screens are context-sensitive, so that you only see fields that
are a logical result of previous decisions.
The following list summarizes the information collected on each screen.
1. Type Screen
l
whether discount is based on amount or percentage
l

code (unique identifier)

l

description

l

currency (for amount-based coupons only)

l

enabled or disabled

2. Discount Screen
l
if amount, dollar amount
l

if percentage, percentage and maximum coupon value

3. Scope Screen
l
applies to entire cart, accepted items only, most/least expensive item only
l

limit to one per customer

l

allow combination with other coupons

l

apply to subscription-based products

l

apply amount-based coupons on a "per quantity" basis
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l

limit maximum number of redemptions

l

require minimum cart value

l

start and end dates

4. Items Screen—if coupon is restricted to certain items, designate the items

Creating a Coupon Type

1. Select the type of coupon you are creating/editing using the Type radio buttons:
l
Amount—discount is a dollar amount. If you select this type, choose a currency at
the Currency field (below). Then, enter the dollar amount on the Discount screen.
l

Percentage—discount is a percentage. If you select this type, enter the
percentage on the Discount screen. That screen also lets you enter a maximum
amount.
Also, if the coupon type is percentage, the Currency field is disabled. Percentagebased coupons are currency neutral.

2. Enter the coupon code in the Code field. The code cannot contain
l
spaces
l

angle brackets (<, >)

l

single (‘) or double quotes (“)

l

ampersand (&)

l

slash (/) or back slash (\)

l

plus sign (+)

3. Click Validate Code. When you do, Ektron verifies that the code contains the correct
characters and is not already in use. Customers (site visitors) enter this code to redeem
the coupon on a page that hosts the Cart on page 1672 server control. The following page
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gives suggestions about eCommerce coupons, including coupon-naming strategies:
ecommerce-guide
4. Enter a free text description of the coupon in the Description field. This helps describe
it on the initial Coupons screen in the Workarea.
5. Select the currency to which this coupon applies from the Currency drop-down menu. If
the coupon type is percentage, this field is disabled.See Also: Configuring Currencies on
page 1307
IMPORTANT: The coupon is only valid if a customer selects this currency. So, for example, if you
create a coupon for a USD amount, and a customer selects Euros when shopping on your site, the
coupon is not accepted. To work around this restriction, create a coupon for every applicable
currency.
6. Set the status pf the coupon using the Status drop-down. Set to enabled to let
customers uses this coupon (providing all other conditions are met). Or, set to disabled
to keep the coupon in the eCommerce feature but prevent it from being used.

Setting a Discount
The discount screen displayed depends on the discount type selected in the first screen:
amount or percentage. If an amount discount was selected, enter the coupon’s discount
amount.

If the coupon amount exceeds the sum of all items to which it is applied, it is reduced to the
sum of the items. For example, a coupon amount is $10.00 and applies to the least expensive
item. If that item is $3.00, the amount changes to $3.00.
If a percentage discount was selected:
1. Enter the percentage of the discount in the Percentage field.
2. Enter the maximum value of this coupon in the Maximum Amount field.
For example, if you set a discount of 10% and a Maximum Amount of $20.00, the
discount will never exceed $2.00 (that is, 10% of the Maximum Amount) regardless of
the amount of the goods ordered. Typically, you would include a Maximum Amount in the
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email or announcement that describes the coupon.

Setting the Coupon Scope

1. Select an Apply Coupon to setting:
l
Entire cart—coupon applies to all items in cart
l
l

l
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All accepted items—coupon applies all accepted items in cart.
Most expensive accepted item—coupon applies to most expensive accepted
item in the cart.
Least expensive accepted item— coupon applies to least expensive accepted
item in the cart.
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IMPORTANT: If you select All accepted items, Most expensive accepted item, or Least expensive
accepted item, you must identify accepted items on the Items tab. If you do not, the coupon is
effectively inactive.
You cannot apply a cart-level coupon to a subscription product. However, you can apply
an item-level coupon to a subscription product. (An an item-level coupon is one that
applies to all accepted items, or the most or least expensive item.) See Also: Creating a
Subscription on page 1349
2. Check the One per customer box if you want to limit each customer to one use of the
coupon. If you do and a customer completes an order with the coupon then tries to use it
a second time, the customer is notified that the coupon is not valid.
3. Check the Can be combined with other coupons box if this coupon can be combined
with other coupons in the same order. If you do not check this box and a customer tries
to add this coupon to an order to which a coupon is already applied, the customer is
notified that the coupon is not valid.
4. Check the Apply to Subscriptions box if customers can use this coupon to purchase
subscriptions.
Customers can use only coupons with subscription items that have a sale price and are
set to recurring billing. See Also: Creating a Subscription on page 1349
Customers can apply only an item-level coupon to a subscription product. (An an itemlevel coupon is one that applies to all accepted items, or the most or least expensive
item.) See Also: Select an Apply Coupon to setting:Entire cart—coupon applies to all
items in cartAll accepted items—coupon applies all accepted items in cart. Most
expensive accepted item—coupon applies to most expensive accepted item in the
cart.Least expensive accepted item— coupon applies to least expensive accepted item in
the cart.If you select All accepted items, Most expensive accepted item, or Least
expensive accepted item, you must identify accepted items on the Items tab. If you do
not, the coupon is effectively inactive.You cannot apply a cart-level coupon to a
subscription product. However, you can apply an item-level coupon to a subscription
product. (An an item-level coupon is one that applies to all accepted items, or the most
or least expensive item.) See Also: Creating a Subscription on page 1349 on the
previous page
5. Check the Apply to Quantities box if you want the coupon amount to discount each
accepted item in a cart. For example, if a coupon amount is $1.00, and a customer
purchases 5 of one item, the discount is $5.00.
If you do not check this box, the discount would be $1.00, regardless of the quantity of
an item purchased. This field is only available for an amount based coupon.
6. If desired, enter a maximum number of times this coupon can be used in the Maximum
Redemptions field. It does not matter which customers use the coupon. If you set a
maximum, and the coupon is applied that number of times, the next time someone tries
to use the coupon, the customer is informed it is not valid.
7. If desired, enter the minimum order amount required to activate this coupon in the
Minimum Required Cart Value field. The order amount does not include tax or
shipping charges. For example, enter $50.00. If a shopping cart total is $40.00, and a
customer adds this coupon to an order, the customer is informed the coupon is not valid.
8. Enter the date range within which this coupon is valid using the Start Date and End
Date selectors..
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For example, you enter a Start Date of January 1, 2013 and an End Date of December
31, 2013. If a customer inserts this coupon on February 9, 2014, the customer is
informed the coupon is not valid.

Defining the Coupon Items
PREREQUISITE
The Coupon Scope screen’s Apply Coupon to field must be set to one of the
following:
l

All accepted Items

l

Most Expensive accepted Item

l

Least Expensive accepted Item

Use this screen to identify items to which this coupon applies. If Entire Shopping Cart was
selected, the following message appears: This coupon is accepted for all items.

IMPORTANT: Item-level coupon types apply only to items selected on this screen. If a customer orders a
catalog entry that’s not defined on this screen, an item-level coupon does not apply to the item.
For example, you create a coupon worth 10% off any digital camera. The coupon is only
applicable if a digital camera is in the shopping cart. Typically, the email or announcement
that describes the coupon includes item restrictions. The discount is applied to each accepted
item in the cart. For example, a coupon provides a 10% savings on items 1, 3, and 5 but not 2
and 4 because 2 and 4 are not on the accepted items list.

Selecting a Coupon’s Accepted Items
There are 3 ways to select items for the Include or Exclude list:
l

l
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Individual items—Click Include Product and navigate through the Ektron folder
system to that content. You can only select items in a category folder (which are blue to
distinguish them from regular folders).
All items in a catalog folder—Click Include Catalog and navigate through the
Ektron folder system to that folder. You can only select items in a category folder (which
are blue to distinguish them from regular folders).
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NOTE: If you choose a parent catalog, its child catalogs are not selected. Only products in the
parent catalog are eligible for the coupon.
If you want to select a parent catalog and its child catalogs, first select the child catalogs. Then,
navigate to the parent catalog and select it.
l

All items in a taxonomy or category—Click Include Category and navigate
through the Ektron taxonomies to the desired taxonomy or category. All content applied
to the category will be eligible for the coupon.

Include vs. Exclude
You can both include and exclude using any of the criteria listed above. If any product
appears on both lists, it is excluded from coupon eligibility.
So for example, one of your folders contains 500 digital cameras that your site offers. You
want the coupon to apply all but a few cameras.
On the Include tab, select the cameras folder. Then, use the Exclude tab to select the few
cameras to which the coupon does not apply. In this way, you can easily select the majority
of items but exclude a few.

Deleting a Coupon
If a coupon is applied to an order, you cannot delete it but you can disable it.
To delete a coupon that is not applied to an order:
1. Go to Ektron Workarea > Settings > Commerce > Coupons.
2. Locate the coupon that you want to delete.
3. Click delete on the far right of the coupon information.

4. A strikethrough line appears over all coupon text, and Restore ( ) replaces Delete. If
you change your mind and do not want to delete the coupon, click Restore.
5. Click Save.
If the coupon cannot be deleted, it remains on the main Coupons screen and No appears in
the Enabled field. This coupon can no longer be used.

Disabling a Coupon
When the coupon’s status is Disabled, customers can no longer apply it to an order. Coupons
can be disabled automatically (according to a schedule) or manually.
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Using an Expiration Date to Disable a Coupon
When you create a coupon, a default end date is set for 10 years from the end of the current
year. At that time or at any time the coupon is active, you can change its end date.
When the coupon’s end date is reached, its status changes to Disabled.

Manually Disabling a Coupon
1. Go to Ektron Workarea > Settings > Commerce > Coupons.
2. Locate and click on the coupon that you want to delete. The Coupon Propties screen
appears and the Type tab is selected.
3. Choose Disabled from the Status drop-down.
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Managing Customer Orders
The fulfillment aspect of eCommerce involves:
l

l

tracking submitted orders, including
o order status
o

charge capture

o

shipping

o

cumulative sales information on customers

customer information, such as
o orders submitted
o

addresses

o

current shopping carts

PREREQUISITES
To process orders, the Distributed Transaction Coordinator (DTC) Windows service
must be running. It is started by default when you install Ektron.
This section also contains the following topics.
Order Workflow
Creating the Order Process
Processing Orders
Sending eCommerce Messages
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Order Workflow
Ektron uses Microsoft’s Windows Workflow Foundation to create and implement order process
workflows to handle the ordering process. The workflow can be as simple or complex as your
business requires.
For example, you have a simple workflow that sends one email to the customer when an
order is received, and another to your shipping department. Or, you could have a more
complex workflow that:
l
l

sends an email to the customer when the order is received
checks to see whether the item is a tangible product or a virtual product. Then, continues
down the workflow path that’s appropriate for the item.

l

handles shipping notifications and updates the account throughout the shipping process

l

handles the order if it is canceled

l

handles the order if it is determined to be fraudulent

l

marks the order as complete when activities are finished

For more information about workflows, see Customizing Workflows on page 1435.

Creating the Order Process
Ektron 8.7
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This section summarizes the shopper experience using Ektron's eCommerce feature. See Cart
on page 1672 and Checkout on page 1673 for information about the Cart and Checkout server
controls used to implement the order process.
1. As a shopper, you can add items (physical goods, subscriptions, or soft goods) to your
cart by clicking Add to Cart.

2. When you are ready to pay, click Checkout to begin the checkout process.
NOTE: Shoppers have the option of checking out using PayPal’s checkout system. Order
information is exported, and you can use your PayPal account to fund the purchase. See Also:
Configuring Payment Options on page 1311.

3. When you return, you can log into your account and continue the checkout process. Your
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shipping and billing information appears.
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4. Click Create Profile and Checkout and complete the Billing Page.

5. Click Next Page to create an account. After confirming the information, you can enter a
different shipping address.
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6. When you click Next Page, you can select the delivery method. If the cart contains a
subscription or soft goods (such as downloadable software), this page is typically
bypassed.

7. On the Review Page, you can modify the order by clicking Edit your cart. Otherwise,
move forward to the Payment options page.
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8. Specify payment information and submit the order.

An order invoice page displays to confirm the order. If the order was for a subscription or
downloadable software, additional information appears.

Processing Orders
The orders screen provides information about all orders in your eCommerce system. To
access it, go to Workarea > Settings > Commerce > Fulfillment > Orders.
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Initially, orders are sorted by submission date and time, with the most recent at the top.

Selecting Orders by Criteria
You can select orders by any of the following criteria.
l

entry date range

l

customer

l

catalog entry

To use any filter, choose Reporting (see below) then the appropriate filter option:
l

l

Most Recent—This is the the default select and sort order: all orders with the most
recent on top.
By Date(s)—If you choose to view orders By Date(s) and want to view orders for
today, enter tomorrow as the ending date.

l

By Customer

l

By Product

l

By ID

Order Statuses
NOTE: The following table assumes you use the default workflow installed with eCommerce. If you
customize the workflow, the following table may be inaccurate. See Also: Customizing Workflows on
page 1435
Status

Description

How to Set

Received

Order has been submitted.

Customer submits order

Fraud

Your organization has determined that the
order is fraudulent.

View Order Screen > Action Menu >
Mark as Fraud

Ektron 8.7

1387

Conducting eCommerce

Status

Description

How to Set
View Order Screen > Action Menu >
Ship Order

Order has been shipped. This status can
be the workflow’s end point. You do not
need to use the Completed status.

or

Shipped

Completed

All order activities are finalized. No events
can occur to a Completed order.

View Order Screen > Action Menu >
Process Order

Cancelled

Order has been canceled.

View Order Screen > Action Menu >
Cancel Order

InProcess

Automatically assigned when order is
submitted.

Order placed but not yet captured

View Order Screen > Action Menu >
Enter/Edit Tracking Number >
CheckMark as Shipped checkbox and
save

Viewing Orders
To view the details of any order, click it. When you do, the View Order screen appears.

If the Workflow tab does not display a flowchart, verify that the server’s Distributed
Transaction Coordinator (DTC) Windows service is running. It is started by default when you
install Ektron, but if it stops for some reason, the Workflow does not appear on this screen.

Capturing Orders
It is important to distinguish between authorization and capture in relation to orders:
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l

l

Authorization occurs while a customer is using the Checkout server controls. It submits a
customer’s payment information to a payment gateway, bank, or PayPal, and returns
either an approval with an authorization number (transaction ID) or a decline along with
an explanation.
Capture is the process of submitting encrypted order information (including the
transaction ID) to a payment gateway account, bank, or PayPal. At this time, the account
is charged for the order amount.

Take into account the following:
l

l

In many states, you must ship an item before you can charge a customer’s credit card
for it.
Items that are not tangible are automatically captured if paid by PayPal or a credit card.

After an order has been captured, you receive confirmation from the paying agency that the
money has been deposited to your account and is available. At this time, you use the Mark
as Settled option to inform the eCommerce feature that payment has been received. This
changes the order status to Complete. Confirmation occurs:
l

PayPal or credit card—when the goods are shipped.

l

Check—When the check clears.

See Also: Configuring Payment Options on page 1311

Capturing an Order
1. From the Workarea, choose Settings > Commerce > Fulfillment > Orders.
2. Click the order that you want to capture.
3. Click the Payment tab.
4. Click the payment to display. The View Payment screen appears, showing information
about the transaction captured when the customer (site visitor) submitted payment
information.
5. Choose Action > Capture. You are asked to confirm the action.
6. Click OK.

Canceling an Order
Click Action > Cancel Order to stop all processing on the order. If you do, the order’s
status changes to Canceled.

Deleting an Order
To delete any order, select it from the Orders screen then click Delete ( ).
After deleting an order, you cannot recover its information.

Entering a Tracking Number
When an order is shipped, the shipping provider typically provides a tracking number to help
locate the shipment within the delivery chain. Use the Enter Tracking Number option to
enter this part of the order information.
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After entering the tracking number, you can indicate whether the order has shipped.

Viewing the Tracking Number
You can display an order’s tracking number on the View Order screen by clicking the Address
tab and looking under the Shipping Address.

Marking the Order as Shipped
When you enter an order's tracking number, the screen lets you mark it as shipped. See Also:
Entering a Tracking Number on the previous page
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If you did not mark the item as shipped at that time, a Ship Order option appears on the
Action menu. To denote that such an order has shipped:
NOTE: If that order has not yet been captured, it will be captured as part of the shipping of the order.
1. From the Workarea, choose Settings > Commerce > Fulfillment > Orders.
2. Click the order that is being shipped.
3. Choose Action > Ship Order.

Marking the Order as Fraudulent
Use this option if your organization determines that the order is fraudulent. These orders
cannot be processed any further.

Entering Order Notes
After selecting an order, you are allowed to submit a note about it. You can use the note to
record information about the item, the buyer, shipping irregularities, and so on.
Only one note can be saved per order. If you edit and save a note, the previous note text is
permanently removed.

Sending eCommerce Messages
Ektron’s eCommerce feature provides a messaging feature that can notify a purchaser or the
Ektron administrator when the following events occur. Each message has a unique type that
corresponds to an event and, in one case, a recipient.
l
l

OrderReceived message type sends email to the purchaser when an order is submitted.
OrderReceivedToAdmin message type sends a message to the Ektron administrator
when an order is submitted.

l

OrderCancelled message type sends email to the purchaser when am order is cancelled.

l

OrderShipped message type sends email to the purchaser when an order is shipped.

l

OrderComplete message type sends email to the purchaser when an order is completed.

You can create any number of messages for each event, assigning one as the default. Only
the default message is sent when the corresponding event occurs. Here is a sample message
as set up within Ektron.
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Here is a portion of the same message as delivered to a recipient’s inbox.

How Messages are Created and Generated
Ektron provides sample text for each type of message. To view and edit a message, go to the
Workarea > Settings > Commerce > Configuration > Messages.
The Message Type determines the event that causes a message to be sent. For example, the
Orderreceived message is sent to a purchaser when the order is submitted.
If content notification emails are being generated, the site visitor provided an email address,
and a message is defined for the event, emails are sent when eCommerce events occur. No
additional set up is required.
NOTE: eCommerce messages are distributed in the same way as content notification emails. For
information on setting this up, see Installing Ektron on page 9.
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Creating or Editing an eCommerce Message
1. From the Workarea, choose Settings > Commerce > Configuration > Messages.
2. If a message of the type you want to create already exists, select it. Otherwise, click
Add Email Message.
3. Assign a Title, Subject (for the email subject line), Message Type, and message text.
4. When the message is complete, click Save.

Message Variables
An eCommerce message can include the following variables, which pull order information into
the message:
l

@CustomerFirstName@—Customer’s first name

l

@CustomerLastName@—Customer’s last name

l

@OrderCouponTotal@—The order’s coupon discounts

l

@OrderId@—The order’s ID number

l

@OrderItemQuantity@—The quantity of any item on the order

l

@OrderItemSalePrice@—The sale price of any item on the order

l

@OrderItemStart@ and @OrderItemEnd@— Use the start and end markers to show
information for ordered items.
The markers show no information by themselves. Instead, they repeat the variables
between them for every item on the order.So, for example, assume an order has 10
items, and your message looks like this:
@OrderItemStart@
@OrderItemTitle@
@OrderItemQuantity@
@OrderItemSalePrice@
@OrderItemTotal@
@OrderItemEnd@
The message prints the title, quantity, sale price, and total for each item on the order.

l
l

l
l

l
l

l

@OrderItemTitle@—The title of any item on the order
@OrderItemTotal@—The total cost of one item. For example, if orderItemSalePrice
= $10 and orderItemQuantity = 2, orderItemTotal = $20.
@OrderShippingTotal@—The order’s shipping cost
@OrderSubTotal@—The order’s subtotal, that is the amount of ordered items prior to
shipping costs, taxes, and coupon discounts
@OrderTaxTotal@—The order’s tax amount
@OrderTotal@—The order’s final cost (which includes taxes, shipping, and coupon
discounts)
@TrackingUrl@—The link to a Web page that tracks your package. It is usually a
combination of the shipper’s URL and the tracking number.

Setting up a Recipient for the
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OrderReceivedToAdmin Message
The OrderReceivedToAdmin message type requires additional setup. Specifically, you must
update the following values in the web.config file.
l

l

1394

adminEmail—email address of eCommerce administrator to receive order confirmation
message
ek_ecom_SendOrderReceivedEmailToAdmin—Set to true to enable this
functionality. Set to false to disable it.
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Viewing Customer Information
Customers create an account the first time they complete the checkout procedure. The
Customers screen provides information about all customers who order from your website.
The first screen presents the
l

customer ID number

l

user name

l

number of orders

l

amount of all orders

l

average order amount

You can click any customer’s ID number or name to see more details about the person's order
history. The View Customer screen (shown below) provides information about the customer’s
l

summary information (name, number of orders, total of all orders, average order
amount)

l

orders (see Processing Orders on page 1386)

l

addresses (you can edit any address or enter a new one)

l

l

Whenever a user creates a new order and enters a new or selects an existing
billing/shipping address, that becomes the new default
shopping carts (see Creating the Order Process on page 1381)
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Generating eCommerce Reports, Widgets, and

Generating eCommerce Reports,
Widgets, and Logs
eCommerce provides several ways to measure and monitor your commerce activity:
l

l

l

View a set of standard reports by choosing Settings > Commerce > Reports. These
are also found in the Reports > Commerce section.
View a log of your eCommerce activity in Workarea > Settings >Commerce >
Audit.
View a visual display of order information for a selected catalog entry by viewing the
entry and choosing Reports > Analytics.

The eCommerce reports are also available as widgets for the Smart Desktop. See also
Personalizing the Smart Desktop on page 278.

Customer Report
The Customer Report shows 5 customers ranked according to account date, total sales, or
orders.

The report contains the following fields:
l

Name—Customer first and last name

l

Orders—Total number of orders by this customer

l

Order Value—Total amount of sales to this customer

l

Date Created—The date this person first became a customer

To change the report type, follow these steps.
1. Click Most Recent.
2. Select the type of report to view:
l
Most Recent—the newest customers joining the site
l

Most Valuable—customers ranked by order value

l

Most Active—customers ranked by number of orders

Inventory Report
Ektron 8.7
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The Inventory Report displays the following information for each catalog entry.
l

amount in stock

l

amount on order (number of items were been ordered but not delivered)

l

l

amount on reorder (quantity at which you need to reorder this item). When the In Stock
quantity reaches this level, an event is triggered which an external inventory system can
use to generate a new order.
inventory status of item (enabled or disabled)

The screen also lets you edit any amount and the inventory status. Any changes made on the
screen update the inventory fields on the catalog entry's Properties tab.
See Also: Entering a Catalog Entry’s Properties on page 1361

Sorting the Inventory Report
You can restrict the display to catalog entries in a selected Product Class. To do this, click the
Reporting button. For example, you can display complex products only.

See Also: Product Classes on page 1343

Editing Inventory Information
You can edit any catalog entry's inventory information. To do so, select it from the Inventory
Reports screen then click Edit.
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Key Performance Indicators Report

NOTE: When editing the In Stock field, select a plus (+) or minus (-) sign from the drop-down menu then
enter the adjustment amount. The screen automatically recalculates the in-stock amount for you.

Key Performance Indicators Report
The Key Performance Indicators report compares sales and orders for 2 time periods.

To change the periods to compare:
1. In the Period column, click This Month. Choices are shown below.

2. Click the first period for which you want to compare performance.
3. Repeat steps 1 and 2 for the second period with which you want to compare
performance.
4. Click Refresh (

).

Reconciliation Reports
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The Reconciliation report lists payments for a specific time period. Your accounting
department may used it reconcile bank statements with the order system.

The report includes the following fields:
l

Date Captured—Date the payment was captured. See Also: Capturing Orders on
page 1388.

l

CardID—The last 4 digits of the credit or debit card used for payment.

l

Type—Type of payment used. See Also: Configuring Payment Options on page 1311.

l

TransactionId—The unique number returned from the Payment Provider for this
payment. See Also: Capturing Orders on page 1388.

l

Amount—Total amount of the payment for this transaction.

l

Voided—Total amount voided in the transaction.

To run a report, follow these steps.
1. Click Calendar (

) next to Start Date to open the calendar.

2. Click a date to set the start date.
3. Click Calendar (

) next to End Date to open the calendar.

4. Click a date to set the end date.
5. Click Set New Dates to refresh the report.

Sales Trends Report
The Sales Trends reports graphs the number of orders for the past 8 periods. You can choose
monthly or daily orders. The top of the graph display the total number of orders and sales.
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Top Products Report

To change the graph's duration, click a time period from the drop-down.

Top Products Report
The Top Products reports shows the most popular products on your site.
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To create the report:
1. Click the link text next to the calendar icon.
2. Select the time period of sales from the drop-down.

3. To change the maximum number of products to show, click the value next to Quantity,
enter a value, and click Update.

eCommerce Audit Log
As an administrator, you should regularly review the eCommerce Audit Log. This is vital to
keeping your site secure and, if data is compromised, the log helps you determine the source.
While it is important that Ektron captures this information, it is even more important that you
review, analyze and use it. For example, while reviewing the Audit Log, you might find that
one eCommerce administrator has an unusually large number of login failures. This could
indicate that someone is trying to break into your system.
You can view a log of your eCommerce activity in the Workarea > Settings >Commerce
> Audit.
To enable eCommerce logging, open the website’s web.config file and change the following
key to True:
<addkey="ek_ecom_ComplianceMode" value="false"/>

When compliance mode is turned on, Ektron logs and displays the following events.
l

l
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Actions affecting administrators (Administrator Group member, Commerce Admin Role,
Builtin Account).
o An administrator logs in or out
o

An administrator's login attempt fails

o

An administrator password is changed

Actions affecting an Ektron user’s rights to eCommerce.
o Adding a user to the Commerce Admin Role
o

Removing a user from the Commerce Admin Role

o

Adding a user to the Admin group

o

Removing a user from the Admin group
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eCommerce Analytics

l

Actions affecting order information.
o Updates to an order's address
o

The transaction ID and response from the payment gateway

o

Any action conducted with the payment gateway. For example, when capturing a
previously authorized transaction.

o

Workflow activities. For example, sending an email.

o

Whenever the default gateway or payment options are changed in the Workarea.

eCommerce Analytics
The eCommerce Analytics screen provides a visual display of order information for a selected
catalog entry. Display a catalog entry and choose Reports > Analytics.

l

Top left section graphs the quantity of this catalog entry ordered over the past 7 days

l

Top right charts the number of orders that used a coupon versus the number that did not

l

l

Below that pie chart is another that shows the number of returning customers versus the
number of new ones
The lower part of the screen shows the following order information
l
order number
l

date/time when order was entered

l

site from which order was entered

l

order status

l

customer information: new or returning, name, number of orders entered, value of
all orders entered, average order monetary value

l

order monetary value

l

if a coupon was used
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Using the eCommerce Server
Controls
Ektron provides a complete set of eCommerce server controls that let you set up an online
marketplace where customers (site visitors) can purchase merchandise, services or content.
Customers interact with these server controls on your site.
l

Cart on page 1672—view products in a shopping cart, create new carts, and apply
discounts.

l

Checkout on page 1673—check out.

l

CurrencySelect on page 1716—select a currency.

l

MyAccount on page 1804—view and change their account information.

l

OrderList on page 1806—view a list of processed orders.

l

Product on page 1815—view a product's details and add it to their shopping cart.

l

ProductList on page 1818—search for products or view a list of products.

l

Recommendation on page 1826—get recommendations on other products.

Most eCommerce server controls let customers move from one control to another via
template properties that let you define the location of another server control. For example, if
you define the path to the Cart server control in the Product server control’s TemplateCart
property, customers are directed to the Cart control when they click the Product control's Add
to Cart button.
Ektron’s server controls let you insert standard methods and properties within the Visual
Studio environment. This means that you can see the effect of your changes in real time; you
don’t have to modify a page and then compile to see results.
You can insert server controls using drag and drop or programmatically. You can also use
databinding to retrieve and display data from Ektron.
Ektron provides a complete set of eCommerce server controls that let you set up an online
marketplace where customers can purchase merchandise, services or content.
The following list shows typical actions a customer might perform when visiting your
eCommerce site and how you can facilitate these actions.
l

l

l

l
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Viewing account information—Create a link in the master page that leads to the template
containing the MyAccount server control. This link should be available from any page.
Viewing previous and current orders—Create a link in the master page that leads to the
template containing the OrderList server control. This link should be available from any
page.
Changing the currency type—Add the CurrencySelect server control to a master page.
This server control should be available from any page.
Searching for products—Either create a link to the template containing the
ProductSearch server control. Or, on the master page, add a textbox that passes the text
to a hidden ProductSearch server control and post the results to a separate template.
This link or textbox should be available from any page.
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Customizing eCommerce Server Controls with

l

l

l

l

Viewing a list of products—Create a template that contains the ProductList server
control. This template might be the first page customers see when they view the
eCommerce portion of your site. Whenever you want to display a list of products based
on a catalog, taxonomy or a list content IDs. For example, you could create a list of
products in a panel on the right side of your website.
Viewing a product’s details—Create a template that contains the Product server control.
Use this whenever a customer needs to view details of a product. Set any of the
following server control’s TemplateProduct property to the path of this control. This
makes a product’s title being displayed by one of these controls a clickable link that
takes the customer to this control.
o ProductSearch
o

ProductList

o

OrderList

o

Cart

o

Recommendation

Viewing additional products associated with another product—Add the Recommendation
server control to a template that contains a Product server control and set the
Recommendation control’s DynamicProductParameter property to the QueryString
parameter that’s used to pass a products ID. When ever you want to present a customer
with cross-sell and upsell opportunities associated with a given product.
Adding a product to their shopping cart—Set the TemplateCart property in the following
server controls to the path of the Cart server control. Setting this property is one of the
requirements for the Add to Cart button or link to appear in these controls.
o ProductSearch
o

ProductList

o

Product

o

Recommendation

NOTE: In addition to setting the above property, a product must be in-stock, not archived and
buyable. Otherwise, the Add to Cart button or link does not show for a product.
l
l

l

Use this when you want to let customers add products to their shopping cart.
Viewing products in their shopping cart—When a customer adds a product to their cart,
they are sent to the Cart server control. You should also create a link in the master page
that leads to a template containing this control. The link should be available from any
page.
Checking out and paying for their selected product—Add the Checkout server control to a
template and add that template’s path to the Cart server control’s TemplateCheckout
property. When you do, the Checkout button in the Cart server control becomes active.
You must set this up for customers to checkout.

Customizing eCommerce Server Controls with
Event Hooks
The eCommerce server controls contain event hooks so you can customize or manipulate
them. To use these event hooks, create a handler for each needed event in the code-behind of
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the ASPX page that contains an eCommerce server control. Then, in that page’s OnInit
method, hook each event.
l

l

l

l

l

PhaseChange—Used only in the Checkout server control and called when the current
phase is about to change. Supervise phase changes and allow or prevent changing as
needed. It also lets you jump to a specified phase. For example, you could jump to a
passed phase, prevent the phase from changing from the current one under certain
conditions, or jump to a phase that is not necessarily the next one in line.
PreProcessXml—Called immediately before the control’s XML is transformed. Inspect
or manipulate the server control’s XML before being processed. This is the only time the
XmlDoc property should be used to access the controls XML.
PostProcessXml—Called immediately after the control’s XML is transformed. Work
with processed transformed XML output inside the Text property before sending it to the
browser. This allows simple string manipulation of the server control’s markup.
FilterAjaxCallback—Called when an Ajax-Callback event occurs. Inspect or modify
callback parameters. For example, you could use this event to receive custom values
entered in a page.
PostLogin—Used only in the Checkout server control and called immediately after a
(possibly new) user logs in with this control. Calls custom code immediately after a
returning user logs in with an email and password. Or, immediately after a new
customer fills out the billing info screen. For example, you could add code that lets new
customers sign up for Web Alerts after they add their information to the billing screen.

Using the Cart Server Control
A customer typically reaches the Cart server control from a product description or list page. A
product description page contains a Creating Product Types and Catalogs on page 1343.
Product list pages contain server controls that create a list of products, such as ProductList,
ProductSearch or Recommendation controls. These controls contain a button or link that
allows a customer to add the product to the cart. For reference information, see Cart on
page 1672.

You could also create a link to the cart from a master page or menu that lets customers view
their cart. This link lets a customer navigate directly to the cart when they arrive at your site.
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Flow of the Cart Server Control

Flow of the Cart Server Control
A customer typically arrives at this control by clicking Add to Cart in the Product,
ProductList, ProductSearch or Recommendation server controls. Below is an image depicting
the flow of the Cart server control.

Cart Server Control Areas
The Cart server control consists of 2 major areas. The top part (My Cart) represents the cart
with which the customer is currently working. The bottom (My Saved Carts) represents a
visitor’s saved carts. Saved cart information appears only when a customer is logged in. See
Also: Creating a New Cart on page 1409.
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The My Cart area displays the Item, SKU, Quantity, List Price, Sale Price, Subtotal and Total.
From this cart, a customer can remove items, update the quantity and subtotal information,
apply coupons and check out. The customer can also choose to continue shopping or empty
the cart.
The My Saved Cart area contains a list of carts the customer has saved and are awaiting
checkout. This allows the customer to select products and save them for future purchase. This
area contains:
l

the name of each cart

l

the last time it was updated

l

how many items in each cart

l

the subtotal of each cart

l

options to
o delete a saved cart
o

create a new cart

o

continue shopping

Clicking a saved cart makes it the current cart, and displays its products in the Your Cart
area. A customer can then proceed to check out.

Working with a Cart
This section explains how a logged-in customer would use the Cart server control. The
following figure helps you locate key features of the Cart.
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Adding an Item to a Cart

1. Create New Cart button.
2. Item name link.
3. Cart name edit button.
4. Item quantity field.
5. Delete item button.
6. Continue Shopping button.
7. Apply coupon button.
8. Empty cart button.
9. Checkout button.
10. Delete cart button.

Adding an Item to a Cart
Items are added to a cart when a customer clicks Add to Cart in the following server
controls.
l

Product

l

ProductList

l

ProductSearch

l

Recommendation

When Add to Cart is clicked, the item is appended to the current cart’s list of items. If the
customer does not have a cart, one is created.

Creating a New Cart
A customer automatically creates a new cart the first time a product is added to it. If needed,
a customer can create multiple carts while using the Cart server control. This allows for the
grouping of products being purchased. For example:
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l
l

l

customers create carts based on concepts, such as, Son’s Birthday or Item Type.
customers use separate payment types. For example, a customer places some products
on one credit card and the rest on another. By having 2 carts, a customer can proceed
with 2 separate checkouts.
customer needs to prioritize purchases. For example, a customer wants to purchase
certain products, but cannot afford them right now. The customer can add these products
to a separate cart, then continue to purchase affordable products now. This helps
customers remember purchases they want to make, driving additional sales for your
site.

To create a new cart:
1. Click Create New Cart in the Saved Cart area. (See Callout 1.) The button is replaced
with a text box.
2. Enter the name of the new cart in the text box.
3. Click OK.
When the customer clicks OK, the cart is added to the list of Saved Carts and becomes the
active cart. A customer can then click Continue Shopping to select products to add to the
new cart.

Displaying an Item’s Information
In the Cart server control, a product’s title is a link. When clicked, it takes you to the
product’s detail page. (See Callout 2.) To navigate back to the cart, click your browser's Back
button.
By default, the server control uses the product’s QuickLink information to provide a path to
the product. You can override this functionality by adding a new path to the TemplateProduct
property.

Assigning or Changing the Name of the Cart
Assigning a name to a cart makes it easier for customers to identify a cart in their saved cart
list. A customer can assign or change the name of a cart by clicking Edit ( ) next to the
cart’s name. (See Callout 3.)
When clicked, the button and name are replaced with a text box that allows the customer to
enter a new name for the cart.

Changing an Item’s Quantity
To change a product’s quantity, enter the new amount in the Quantity column’s textbox,
located in the same row as the product you want to change. (See Callout 4.) Next, click
Update Subtotal. This recalculates the price of the product and updates the subtotal. The
image below shows the Atrium Table quantity change to 3.

Removing an Item from the Cart
A customer can remove a product from the cart by clicking Remove From Cart ( ) in the
Quantity column. (See Callout 5.) When the customer clicks the button, the product is
removed from the cart, and the subtotal is updated.
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Continuing to Shop
A customer can continue to shop by clicking Continue Shopping. (See Callout 6.) This
redirects the visitor to a template defined in the cart server control’s TemplateShopping
property. For example, you might send the customer to a page containing a ProductList or
ProductSearch server control. See Also: Using the ProductList Server Control on page 1430
and Using the eCommerce Server Controls on page 1404.
As a developer, you need to add the path to this page to the TemplateShopping property. If
the page is in the same folder as the page that contains the Cart server control, just enter the
page’s name.

Applying Coupons
If coupons are defined in the Workarea and the EnableCoupons property is set to True, a
customer can enter coupons to discount the purchase. How coupons affect the purchase is
defined in the Workarea > Settings > Commerce > Catalog > Coupons. See Also:
Using Coupons on page 1373
To apply a coupon, a customer clicks Apply Coupon. (See Callout 7.)
The button area changes to text box where the customer can enter the Coupon Code. The
customer then enters a code and clicks OK. Next, the discount appears above the Subtotal,
and the customer can continue to shop, check out, view other carts, or delete the coupon by
clicking Remove Coupon.

Emptying the Current Cart
To remove all products from the current cart, a customer clicks Empty Cart. (See Callout 8.)
When clicked, a dialog box appears and the customer can click OK or Cancel.

Checking Out
When a customer is satisfied that the cart contains all products they want, the quantity of
each product is correct and all coupons have been applied, the customer can click Checkout.
(See Callout 9.) At that point, the customer is redirected to the page that hosts the Checkout
server control. The path to the page is defined in the TemplateCheckout property. If the page
containing the Checkout server control is in the same folder as the Cart server control, just
enter the page name.
If a cart includes an item that is out of stock, the Checkout button is disabled (hidden).

Deleting a Saved Cart
A customer can delete a saved cart by clicking Delete Cart. (See Callout 10.)

Using the Checkout Server Control
Customers typically arrive at this server control by clicking Checkout on the Cart server
control. They also might reach this server control from a Checkout link you create on your
site. For reference information, see Checkout on page 1673.
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IMPORTANT: When using the Checkout server control, your website should have an SSL certificate
installed. Set its IsSSLRequired property to True. This protects your customers’ payment information
during transmission. Do not use a self-signed SSL certificate—obtain one from a trusted certificate
authority.
The control provides a navigational aid that indicates the customer's step in the checkout
process. At any point, the customer can move forward to the next step or back to a previous
one. When appropriate, some steps do not appear. For example, if merchandise is not
tangible, the shipping screen does not appear.
The following chart represents the options and processes of the Checkout Server Control.

Logging In or Setting Up an Account
The login portion of the Checkout server control accommodates these types of customers.
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Logging In or Setting Up an Account

l

Existing customers
If an existing customer is not logged in when the customer reaches this server control, it
prompts the customer to log in. Optionally, this screen could have a link that lets an
existing user to recover a password. To enable this link, add a template path to the
control's TemplateRecoverPassword property.
After a customer who previously purchased from this site logs in, billing and shipping
information is retrieved and appear by default. The visitor can review and edit this
information. However, Ektron does not store credit card numbers, so that information
must be entered each time.

l

First-Time Customer—customers who have not logged in before but who wish to
create an account
If a customer has not purchased from your site before and wants to set up an account,
the customer clicks Create Profile and Checkout. On the new screen, the customer
enters billing information including a password. After completing that screen, a
membership user account is created, and the customer is logged in. The new user can
then proceed through the checkout. The next time this visitor logs in, the customer is
treated as an existing customer.

l

Guest Account Registration—customers who wish to make one-time only purchase
and not set up an account.
The Checkout server control provides a guest checkout feature (circled below) for
customers who do not want to set up an account on your site. To enable this feature, set
the AllowGuestcheckout property of the Checkout server control to true.

If a user clicks Checkout Without Profile, the customer proceeds to a version of the
billing screen that does not ask for a password. The rest of the checkout is the same.
Although the customer can proceed through the checkout like other customers, if the
customer wants to checkout in the future, the customer must re-enter billing and
shipping information. Customers who use the guest checkout feature can view their
orders using the Order List server control if its GuestOrderView property is set to true.
See Also: Managing Customer Orders on page 1381
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Checkout Screens
The Checkout server control has several sections, each representing a portion of the checkout
process.

Billing Information
Prompts customers to enter or update billing information, including:
l

Name

l

Company (Optional)

l

Street Address, City, State, Postal Code, Country
NOTE: If a customer chooses a country other than the United States, no field validation is applied to
the postal code by default. To apply country-specific postal code validation, see Applying Field
Validation for non-U.S. Postal Codes on the facing page.

l
l

l
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Phone
email address (appears when a visitor is creating a new account or doing a guest
checkout)
Password (appears when a visitor is creating a new account or doing a guest checkout)
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Applying Field Validation for non-U.S. Postal Codes
1. Search the XSLTs for EktronCheckout_PostalField. The standard US Postal RegEx is
applied to all input fields of this class.
2. Remove that class.
WARNING! Be careful to remove only this class name; otherwise, the CSS styling may not be
applied properly and the layout will be altered.
3. Add an attribute to each postal-code input field in the XSLTs with the following name:
data-ektron-validation-regex. Then, add the desired RegEx as the value of this
attribute. The RegEx expression will validate the user's input.
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For the RegEx expression, you should be able to find one for the target country via a Web
search. Alternatively, you can start here: http://www.regular-expressions.info/.
Canadian Postal Code Solution
The following example shows how to apply field validation for Canada.
Attribute for U.S. postal code regex:
<xsl:attribute name="data-ektron-validation-regex">/^\d{5}(-\d{4})?$/
</xsl:attribute>

Attribute for Canadian postal code regex:
<xsl:attribute name="data-ektron-validation-regex">/^([ABCEGHJKLMNPRSTVXY]
\d[ABCEGHJKLMNPRSTVWXYZ])\ {0,1}(\d[ABCEGHJKLMNPRSTVWXYZ]\d)$/
</xsl:attribute>

The following sample shows the entire postal code input block taken from billing info XSLT.
Three checkout-related files that need these changes (Checkout_BillingInfo.xsl,
Checkout_BillingInfoEntry.xsl and Checkout_ShippingInfo.xsl) are updated in the
sample below for Canadian only postal codes.
<input class="EktronCheckout_PostalCode EktronCheckout_Row_RightContents" >
<xsl:attribute name="name">EktronCheckout_BillingInfo_PostalCode_
<xsl:value-of select="$ControlId"/></xsl:attribute>
<xsl:attribute name="id">EktronCheckout_BillingInfo_PostalCode_
<xsl:value-of select="$ControlId"/></xsl:attribute>
<xsl:attribute name="value"><xsl:value-of select="/root/billingInfo/postalCode"/>
</xsl:attribute>
<xsl:attribute name="data-ektron-validation-regex">/^([ABCEGHJKLMNPRSTVXY]
\d[ABCEGHJKLMNPRSTVWXYZ])\ {0,1}(\d[ABCEGHJKLMNPRSTVWXYZ]\d)$/</xsl:attribute>
</input>

Shipping Information
Add or edit shipping information. By default, it uses the billing address as the shipping
address. From this screen, customers can:
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l

add new addresses

l

edit or delete existing addresses

l

if more than one address is entered, pick address for current order

l

proceed to the next step or back to the previous page
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When a logged-in customer adds a new address, it is stored with the account information in
Ektron.

Shipping Method
Select the type of shipping for products. Shipping methods that appear are defined in the
Workarea > Settings > Commerce > Shipping > Methods. See Also: Configuring
Shipping Methods on page 1331.

Review Order
Displays information about products being purchased: their price, shipping charges,
discounts, and taxes. At this point, if customers want to modify their cart, they click Edit

Ektron 8.7
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your cart. For example, a customer wants to apply a coupon to the cart. For this link to work
properly, add the path to the template that contains the Cart server control to the Checkout
server control’s TemplateCart property.

Submit Order
On the Submit Order page, a customer enters payment information. The customer can pay by
check, credit card, or PayPal, depending on what has been set up in the eCommerce Payment
Options screen. When a customer enters the information, the customer clicks Submit. At that
point, the charge is submitted to the payment gateway, and the order is posted in Ektron. See
Also: Processing Orders on page 1386
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Order Complete
The Order Complete page displays a Thank You note, the order ID, and links to continue
shopping or view an order’s history.
The Continue Shopping link appears when you add the path of a template that allows a
customer to find products to the TemplateShopping property. For example, you send them to
a template containing a ProductSearch or ProductList server control.
The Order History link appears when you add the path of a template containing the
OrderList server control to the TemplateOrderHistory property.

Adding a Custom Field to the Checkout Control
This example demonstrates how to add a custom field to the Checkout control's Billing Info
entry screen.

Step1: Add a Field to the XSL
In the workarea/XSLT/Commerce/Checkout/ folder, look for the Checkout_BillingInfo.xsl file.
In the file, locate EktronCheckout_BillingInfo_Company_. Under the bulleted list item for
company, add the following:
<li class="EktronCheckout_Required EktronCheckout_SerializableContainer">
<label class="EktronCheckout_Row_LeftContents">
<xsl:attribute name="for">
EktronCheckout_BillingInfo_CustomField_<xsl:value-of select="$ControlId"/>
</xsl:attribute>
<span class="EktronCheckout_RequiredSymbol">*</span>
A custom field
</label>
<input class="EktronCheckout_Company EktronCheckout_Row_RightContents">
<xsl:attribute name="name">
EktronCheckout_BillingInfo_CustomField_<xsl:value-of select="$ControlId"/>
</xsl:attribute>
<xsl:attribute name="id">
EktronCheckout_BillingInfo_CustomField_<xsl:value-of select="$ControlId"/>
</xsl:attribute>
<xsl:attribute name="value">ABCXYZ</xsl:attribute>
</input>
</<li>

Important notes:
l

l

l

EktronCheckout_Required—Denotes that the field is required and will impose validation.
EktronCheckout_NotRequired is also acceptable.
EktronCheckout_SerializableContainer—Tells the checkout control to process and include
the field in this <li> tag with the callback.
EktronCheckout_BillingInfo_CustomField_ —The name of the field, where
EktronCheckout_BillingInfo is replaced with param__ internally. The last portion,
CustomField, is how the field will be referenced (see below).
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Step2: Get the Value of the Field
In the codebehind of the page with the Checkout control, you need the following imports:
using Ektron.Cms.Controls;
using Ektron.Cms.Controls.ECommerce;
using Ektron.Cms.Controls.ECommerce.Checkout;

Next, place the following into the Page_Init method:
cmsCheckout.FilterAjaxCallback += this.HandleFilterAjaxCallback;

Then implement the HandleFilterAjaxCallback method:
protected void HandleFilterAjaxCallback(object sender,
FilterAjaxCallbackEventArgs e)
{
string callbackParameters = e.EventArgs;
System.Collections.Specialized.NameValueCollection data =
Ektron.Cms.Common.EkFunctions.ConvertToNameValueCollection(callbackParameters,
true);
string customFieldValue = data["param__customfield"];
}

Upon completing the Billing Info screen, the data is returned as part of the EventArgs, with
the prefix param__ (note the double underscore).

It can then be obtained directly by converting the string to a NameValueCollection (or other
construct). Developers are free to call their own methods from here.

Using the MyAccount Server Control
If the customer is not logged in and arrives at this control, one of the following happens:
l

l
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the visitor receives a message about not being logged in. This happens when the server
control’s RedirectUrl property is empty and the web.config file’s <add key=”ek_
RedirectToLoginURL” value=”” /> value is blank.
the visitor is redirected to a login page and once logged in, is sent back to the template
containing the MyAccount server control. This happens when either the server control’s
RedirectUrl property contains the path of a template that contains a Login server
control or when the web.config file’s <add key=”ek_RedirectToLoginURL” value =””
/> value is set to the path of a template that contains a Login server control. If the
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Using the MyAccount Server Control

control’s RedirectUrl property and the web.config file contain different locations, the
RedirectUrl property in the control overrides the web.config file.
For information about the MyAccount server control properties, see MyAccount on page 1804.
Typically, the information displayed in this control is collected the first time a customer goes
through the checkout process. A customer’s information might appear in the Personal
Information area before they have been through the checkout process if they are a current
Ektron user or registered membership user.

If a logged-in customer arrives at this server control and is missing required information, it
must be entered before continuing. For example, a customer needs to provide a Last Name or
E-mail Address.

As a developer, you need to create a link to this control in a site location that appears only
after log in. For example, you might place the link on a menu or on a master page that
appears after a customer logs in.
A customer typically arrives at this control by clicking a link placed on a main page, master
page, or menu. The following figure shows the flow of the MyAccount server control.
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Editing Personal Information
The Personal Information area lets customers view and edit some information contained in
their profile. By default, a customer can edit their First Name, Last Name, email Address, and
Password. By adding a list of Custom User Property IDs to the CustomPropertyID property,
you can let customers view and edit custom properties in their profile. See Also: Creating
Custom User Properties on page 1108.
A customer can change the information in the Personal Information area by clicking Edit in
the lower left corner of this area. The resulting page lets the person change any information
in this area. When done, the customer clicks Save Changes to save the changes and return
to the My Account page.
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Editing a Billing Address
The Billing Address area lets customers view and edit their billing address information. A
customer can edit their Name, Company, Address, City, State, Postal Code, Country, and
Phone number. This information is used for billing purposes when the customer makes a
purchase. Credit card companies typically want part or all of this information to match a
customer’s credit card account information when making a purchase.
To edit a customer’s billing address, click Edit in the lower left corner of the Billing Address
area.The resulting page let the person change any information in this area. When done, a
customer clicks Save Changes to save the changes and return to the My Account page.

Editing a Shipping Address
The Shipping Address area lets customers view, edit, delete or add a new address to their
shipping address information. The fields in this area are the same as those in the Billing
Address area with 2 exceptions: a Same as Billing check box, and a Default Address
check box. The Same as Billing Address check box lets customers place a check mark in
the box and use their billing address information as their shipping address. The Default
Address check box lets customers specify the current shipping address as the default they
want to use when making future purchases.
To edit a customer’s shipping address, click Edit in the lower left corner of the Shipping
Address area. The resulting page let the person change any information in this area. Note that
a customer must uncheck Same as Billing to be able to edit the shipping address.
Otherwise, it is locked to the billing address. When done, a customers clicks Save Changes
to save the changes and return to the My Account page.

Adding a New Shipping Address
To add a new shipping address, the customer clicks Add New Address located in the bottom
center of the Shipping Address area.The resulting page lets the person enter new shipping
address information. Note that the Same as Billing checkbox is not available when adding a
new address. When done, a customer clicks Save Changes to save the changes and return
to the My Account page.

Deleting a Shipping Address
To delete a shipping address, the customer clicks Delete Address at the bottom of the
Shipping Address area. The visitor is asked to confirm. If the customer does and there are no
other shipping addresses, the billing address is used as the shipping address. If the shipping
address is the same as the billing address, you cannot delete it.

Using the OrderList Server Control
Customers also can reach this control through a link at the end of the Checkout process. The
link appears when the Checkout server control’s TemplateOrderHistory property contains
the path to the template containing the OrderList server control. For information about the
OrderList server control properties, see OrderList on page 1806.
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The following image depicts the flow of the OrderList Server Control.

Viewing a Customer Orders List
When customers arrive at this server control, they see the View All Orders portion of the
server control.

This part of the server control displays a list of submitted orders. Customers can view each
order's date, confirmation number, and status. When the number of orders exceeds the
number defined in the MaxResults property, the list is paged and a user can navigate among
pages with the links provided.
A customer can click the confirmation number to view the Order Details screen.
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To navigate back to the list of all orders, customers click View All Orders.

Viewing Order Details
l
l

l
l

Status—The status of the order. See Also: Order Statuses on page 1387
Order Date—The date the order was submitted. This is the date an order went through
the checkout process.
Order Number—The order's ID number.
Ship To:—Information needed to ship the order to customer.
l
Person to whom the product is being shipped
l

Company Name (optional)

l

Street Address

l

City and State or Region

l

Country

l

Zip Code

l

l

Tracking Number—this field appears if a tracking number has been entered in the
View Order screen in the Workarea.

Bill To:—Displays information about who is being billed for the order.
l
Person paying for the order
l

Credit Card information—For security purposes, only the last 4 digits appear.

l

Company Name (optional)

l

Street Address

Ektron 8.7
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l

l

City and State or Region

l

Country

l

Zip Code

Description—A list of products in the order. When the path to the product server control
is entered in the TemplateProduct property, the product’s title becomes a hyperlink.

l

Quantity—The total number of each product.

l

Sale Price—The per unit price of each product.

l

l

l
l

l

l

Total—The total amount paid for each product ordered. This is the Unit Price multiplied
by the Quantity.
Subtotal—The sum of all the order’s line products before additional charges or
discounts, such as tax, shipping and coupons.
Coupon Total—The total amount discounted, based on all applied coupons.
Tax—The tax amount applied to this order. See Also: Calculating an Order’s Tax Amount
on page 1335
Shipping—The amount charged to ship the order to the recipient. See Also: Configuring
eCommerce Shipping Screens on page 1329
Total—The sum of all charges, including all line items, tax, shipping and handling.

Using the Product Server Control
This control handles each class of product Ektron provides such as Products, Kits, Bundles or
Subscriptions without having to make any adjustments to the control. For information about
the Product server control properties, see Product on page 1815.
Customers typically reach this server control when they click a product from either the
ProductSearch or ProductList server control. When customers clicks a product, title or image
in either of these controls, they are forwarded to the Product server control.
In addition, customers can reach this control from the Cart server control. In that control,
customers click a product’s title and are taken to the Product server control.
When a customer has viewed the product and decided to purchase it, they click Add to Cart
in the control.

Displaying a Product
A product is an item that has no kit, bundle or subscription information associated with it.
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When displaying a simple product, the Product server control displays the following
information:
l

l

l

l

l

Title (optional)—The Title field in the product’s Smart Form. A content editor enters
this information when creating a product in the Workarea. This area does not use the
title of the product in Ektron’s Workarea.
Description (optional)—The Description field in the product’s Smart form. A content
editor enters this information when creating a product in the Workarea.
Image Gallery—The Media tab when creating or editing a product. The Gallery Display
property for each image on the Media tab must be set to Yes. In the Image Gallery,
images are displayed at their smallest size. When a customer clicks an image, the full
size version appears. See Also: Using the eCommerce Server Controls on page 1404
Price—The Pricing tab when creating or editing a product. This is the price defined in the
Our Sales Price area. This is not the list price. See Also: Using the eCommerce Server
Controls on page 1404
Add to Cart—This button appears in the server control when:
o a path to the Cart server control is defined in the Templatecart property
o

the product is buyable. When a product is not buyable, information about the
product appears, but customers cannot add it to their cart. This property is set in
the Workarea when creating or editing a product.

o

the ShowAddToCart property is set to True

When customers click this button, the product is added to their cart and they are sent to
a template containing the Cart server control.
You can hide this button by setting the ShowAddToCart property to false. This lets you
show details of a product, but not offer it for sale. For example, you have a product that
is no longer for sale, but you want to allow people who purchased the product to view its
details.

Ektron 8.7
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Also, by using code-behind to dynamically set the property, you could create code that
looks at your inventory system and hides the button depending on whether a product is
in stock.

Using the Add to Cart Button with Aliasing
When a product has an alias path associated with it:
l

Make sure the TemplateCart property’s path is relative to the site root. For example:
TemplateCart="Developer/Commerce/CartDemo.aspx"

l

Add the following to the code-behind page. This example is in C#:
protected void Page_Init(object sender, EventArgs e)
{ Utilities.RegisterBaseUrl(this.Page); }

Displaying a Bundled Product
A bundled product is made up of multiple products that have been grouped together for sale
as one product.

See Also: Using the eCommerce Server Controls on page 1404
When displaying a bundled product, the Product server control displays all information
displayed in a Product as well as information about the individual components of the bundle.
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The This Bundle Includes area includes products listed on the Items tab for a Product
Bundle in the Workarea. A content editor adds existing products to this tab when creating the
bundle.
Any products on the tab are displayed with the image, title and description for each product. A
link to additional information about each product is also displayed.

Displaying a Complex Product
A Complex Product lets the customer choose between variations of a product. For example, if
your site sells books, variant selections might be Paperback or Electronic.

See Also: Using the eCommerce Server Controls on page 1404
When displaying a Complex Product, the Product server control displays all of the information
displayed in a Product in addition to information on product variants. The Variants area
includes products listed on the Items tab. A content editor adds products to this tab when
creating content.
Products on the Items tab are displayed with a radio button, image, title and description. A
link to additional information about each product is also displayed. The radio buttons are used
to select which product will be added to the cart.

Displaying a Kit
Ektron 8.7
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A kit lets the customer select product options, which can affect the product’s price. There is
no limit to the types of options you can add, nor to the number of items in an option. For
example, a customer purchasing a computer can add RAM, a hard drive, and a larger monitor.

See Also: Using the eCommerce Server Controls on page 1404
When displaying a kit, the Product server control displays all information displayed in a
product in addition to options and subtotal information.
The Options area displays product options based on the Item tab for a kit in the Workarea.
Options are divided into groups. A radio button, name and price appears for each item. The
radio button lets you select one item from each group.
The Subtotal area shows the updated cost of the product with all options.

Using the ProductList Server Control
The ProductList server control displays a list of products on a Web page. For information
about the Product server control properties, see Product on page 1815.
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NOTE: Private catalog entries appear in display of the Product List server control only if the user is logged
in and has at least Read-Only permissions for its catalog folder. See Also: Making Content Private on
page 294
You decide which products appear by selecting a SourceType and populating either the
SourceId or the IdList property, depending on the source type. You can choose from these
source types.

If you want to display

Set the
SourceType
property to

In the SourceId
property, enter

All products for a
selected catalog

Catalog

The ID of the
catalog

All products across
multiple catalogs

CatalogList

All products for a
selected taxonomy

Taxonomy

All products across
multiple taxonomies

TaxonomyList

All products for a selected collection

Collection

In the IdList property,
enter

A comma separated list of
catalog IDs
The ID of the
Taxonomy
A comma separated list of
taxonomy IDs
The ID of the Collection
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If you want to display

Set the
SourceType
property to

Display a list of products

IdList

In the SourceId
property, enter

In the IdList property,
enter

A comma separated list of
product IDs

There are several ways customers might arrive at the ProductList server control, such as
l

when a list of products appears on the side of a page

l

through a link in a master page

l

when they click Continue Shopping on the Cart or Checkout server control.

Sorting the Product List
The ProductList server control lets a customer sort by:
l

Title

l

SKU

l

Price High to Low

l

Price Low to High

l

Highest Rated

l

Lowest Rated and Most Ratings

You can set the default sort order by setting the SortMode property.
For the Highest Rated, Lowest Rated and Most Ratings sorting options to work as intended,
ContentReview server control should be associated with each product. (See Also: UserRanking of Content on page 587) This lets customers rate your products.
For example, place a ContentReview control on the Master page of the template that display
products, and set its DynamicParameter property to ID. Then, when customers view the
product, they can rate and comment on it.

Using the Recommendation Server Control
PREREQUISITE
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Cross sell or upsell products have been assigned to a catalog entry.
Typically, this control appears on a page along with a Product server control. By using this
control in conjunction with the Product control, a customer can view the details of a product
and also receive suggestions on additional purchases. A customer can click the title to view
the suggested product to view its details. For information about the Recommendation server
control properties, see Recommendation on page 1826.

For example, if your site is selling a hat, mitten and scarf set, you might use this server
control to cross-sell winter jackets. You could also use the control to up-sell a more
expensive hat, mitten and scarf set, or a set that includes additional items.
See Also: Recommending Related Products to a Customer on page 1371
The RecommendationType property determines whether the Recommendation server control
is used for up-selling or cross-selling.

Enabling the Add to Cart Button
Customers can add a product to their cart directly from the Recommendation server control
by clicking Add to cart next to a product. This link appears below the price and allows them
to skip the product’s information page and add the product directly to their cart.
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By default, this button appears when the following conditions are met:
l

The product is buyable. That is, there is a check mark in the Buyable property for a
product in the Workarea. See Also: Creating a Catalog Entry on page 1356

l

The product has an In Stock quantity of at least one.

l

The TemplateCart property has a cart’s template location defined.

In addition, if a product has an alias path associated with it, you need to:
l

Make sure the TemplateCart property’s path is relative to the site root. For example:
TemplateCart="Developer/Commerce/CartDemo.aspx"

l

Add the following to the code-behind page. This example is in C#:
protected void Page_Init(object sender, EventArgs e)
{ Utilities.RegisterBaseUrl(this.Page); }
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Customizing eCommerce
Ektron's eCommerce Module lets you set up an eCommerce website, which delivers a full set
of functionality for building an online marketplace.
As a developer, you can use Ektron’s standard functionality and out-of-the-box server
controls to quickly create an eCommerce website. See Using the eCommerce Server Controls
on page 1404 for more information about the eCommerce server controls.
Ektron also lets you partially or fully customize your website. For example, you can
customize your site’s order process workflow.
This section also contains the following topics.
Customizing Workflows
AdvancedEmailActivity
BasicEmailActivity
CaptureOrderActivity
CheckStockActivity
OrderCancelledEventActivity
OrderCapturedEventActivity
OrderFraudEventActivity
OrderProcessedEventActivity
OrderReceivedEventActivity
OrderShippedEventActivity
OrderUpdatedEventActivity
UpdateOrderActivity
Customizing the Payment Gateway Provider
Customizing the Shipment Provider
Customizing the Inventory Provider
Customizing Shipping Calculations
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1444
1445
1445
1446
1446
1447
1447
1448
1448
1448
1449
1449
1456
1463
1466

Customizing Workflows
IMPORTANT: If you customize the workflow then upgrade to a new version of Ektron, you need to point
to the new references then compile the workflow.
Ektron uses Microsoft’s Windows Workflow Foundation to create and implement order process
workflows in Ektron. Within Ektron eCommerce functionality, you use a workflow to handle
the ordering process after your site has received an order. The workflow can be as simple or
complex as your business requires.
For example, you could have a simple workflow that sends an email to the customer when
their order is received, and sends another to the person shipping product for you. Or, you
could have a more complex workflow that:
l
l

sends an email to the customer when the order is received
checks to see whether the item is a tangible product or a virtual product. Then, continues
down the workflow path that’s appropriate for the item.

l

handles shipping notifications and updates the account throughout the shipping process

l

handles the order if it is canceled
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l

handles the order if it is determined to be fraudulent

l

marks the order as complete once all activities are finished

Ektron’s default sample workflow is shown below.

Windows Workflow Foundation (Released with Microsoft’s .NET 3.0) is a development tool
that lets you create activities-based workflow that can persist over a given length of time or
be paused and restarted depending on events. For more information on WF, visit Windows
Workflow Foundation.
Workflows are comprised of activities; each activity represents a portion of your Business
Process. When activities have finished within a workflow, it terminates. There are 2 types of
activities:
l
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Activities—executed inside the workflow once the activity is reached. For example, an
email might be sent to a customer once their order is received by using the
AdvancedEmailActivity placed after the OrderReceivedEventActivity. This email is
automatically sent with no human interaction needed, and the workflow would continue.
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l

Event Activities—pauses the workflow until the event occurs. When the event takes
place, the associated activity is executed. Think of events as road blocks in the workflow
that are not opened unless a matching action happens. When the event happens, the
workflow follows the path associated with that event.
For example, an OrderFraudEventActivity in a workflow would keep the workflow from
going through the Fraud Event portion of the workflow unless the order is marked as
fraud.
l

l

l

l

l

l

l

l

l

l

l

l

AdvancedEmailActivity on page 1442—Send an email based on the order ID and a
specified message type.
BasicEmailActivity on page 1444—Send a generic email message when this activity
is reached in the workflow.
CaptureOrderActivity on page 1445—Customize the handling of an order when it is
captured.
CheckStockActivity on page 1445—Verify whether the item is an in-stock item or
not.
OrderCancelledEventActivity on page 1446—Customize the handling of an order
when it is canceled.
OrderCapturedEventActivity on page 1446—Customize the handling of an oder when
it is captured.
OrderFraudEventActivity on page 1447—Customize the handling of an order when
it’s marked as fraud.
OrderProcessedEventActivity on page 1447—Customize the handling of an order
when it’s being processed.
OrderReceivedEventActivity on page 1448—Customize the handling of an order
when it’s marked as received.
OrderShippedEventActivity on page 1448—Customize the handling of an order when
it’s marked as shipped.
OrderUpdatedEventActivity on page 1448—Customize the handling of an order when
it’s updated.
UpdateOrderActivity on page 1449—Update the order when this activity is reached.

Ektron supports Sequential Workflows and State Machine Workflows. Sequential Workflows
are structured; a step-based process where one activity leads to the next. State Machine
Workflows typically move from one activity to another when their state changes.
You can have multiple workflow projects associated with your eCommerce site and change
workflow projects at any time. However, only 1 workflow project can run at a time. When an
order process starts with a specified workflow, it continues through that Workflow.

Installing Ektron’s Sample Workflow Template
PREREQUISITE
Ektron SDK is installed See Also: Using Ektron’s Developer SDK on page 1633
Ektron provides a C# workflow template sample for a sequential workflow. You can modify
this sample or use it to create new workflows. It is based on the Ektron default workflow.
To install Ektron’s sample workflow template, copy and paste the Ektron Ordering Sequential
Flow.zip file using the From & To information below.
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From:
C:\Program Files\Ektron\CMS400SDK\Commerce\Workflow\Templates\VS2010

To:
C:\Documents and Settings\~user name~\My Documents\
Visual Studio 2010\Templates\ProjectTemplates\Visual C#\Workflow

NOTE: Make sure you replace ~user name~ in the path with the user name under which Visual Studio
project templates are saved.
In Windows 7, the path looks like this:
C:\Users\~user name~\Documents\Visual Studio 2010\
Templates\ProjectTemplates\Visual C#\Workflow

Extract the .zip file in the To location. Then, you can work with a sample workflow. See Also:
Working with the Sample Workflow below

Working with the Sample Workflow
PREREQUISITE
You installed Ektron’s sample workflow template. See Installing Ektron’s Sample
Workflow Template on the previous page.
1. Open Visual Studio.
2. Choose File > New > Project.
3. If you are using C#, expand the Visual C# project type. Otherwise, expand the Visual
Basic project type.
4. Click Workflow.
5. From the My Templates area, select Ektron Ordering Sequential Flow.
6. Select a new Name. If necessary, change the Location, Solution and Solution Name.
7. Click OK.
8. If a prior version of the software developer's kit (SDK) is installed, the assemblies in the
sample may be older than those in your site. To avoid an issue:
a. From your project's bin folder, remove Ektron.Cms.Common.dll and
Ektron.Workflow.dll.
b. Copy those files from the bin folder of your Ektron site to the bin folder of the
newly-created workflow project.
c. Re-establish the References to these dlls from the project's bin folder.
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9. Open the Workflow.cs file in the Solution Explorer.

10. Make any necessary changes to the workflow. For information on Microsoft’s Workflow
Activities, see Build Custom Activities To Extend The Reach Of Your Workflows.
11. Debug as needed.
12. Build the workflow. This creates a DLL of the workflow and places it in the project’s
bin/debug folder.
13. Navigate to the DLL's folder. For example, C:\Documents and Settings\~user
name~\My Documents\Visual Studio
2010\Projects\MyWorkFlow\MyWorkFlow\bin\Debug.
14. Move or copy the new workflow DLL file to your website’s bin folder.

Adding Workflow Activities to Your Toolbox
1. Open or create a Workflow in Visual Studio. See Installing Ektron’s Sample Workflow
Template on page 1437
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2. Display the Toolbox (View > Toolbox).
3. Right-click the mouse within the Toolbox and choose Add Tab.
4. Type Ektron Workflow Activities then press Enter.

5.
6. Click the Ektron Workflow Activities tab.
7. Right-click the mouse in the empty area and choose Choose Items. The Choose
Toolbox Items dialog appears.

8. In Visual Studio 2010, select the .NET Framework Components tab.
9. Browse to webroot\siteroot\bin\Ektron.Workflow.dll file. This file provides access
to Ektron’s workflow activities.
NOTE: Alternatively, you could use the following location: C:\Program
Files\Ektron\CMS400vxx\bin. The file is identical in both places. Using the bin folder in your
site provides better speed. However, if you use the bin folder in Program Files, you do not have to
worry about deleting the .dll file if you change or delete your site.
10. Click OK.
For easier viewing, right-click the workflow activities and select Sort Items
Alphabetically.
NOTE: Ektron’s workflow activities appear only when the workflow is opened in design mode.

Removing Workflow Activities
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1. Display the Visual Studio toolbox (View > Toolbox).
2. Right-click the mouse within the Toolbox.
3. Click Choose Items.
4. Click the Activities or .NET Framework Components tab.
5. Click Namespace or Assembly Name to sort Workflow Activities.
6. Uncheck all boxes that begin with Ektron.Workflow.Activities.
7. Click OK.
8. Right-click the Ektron Workflow Activities tab.
9. Click Delete Tab.

Updating Workflow Activities
To update workflow activities, remove the existing ones in Visual Studio, then add new ones.
l

l

For information on removing workflow activities, see Removing Workflow Activities on
the previous page.
For information on adding workflow activities, see Adding Workflow Activities to Your
Toolbox on page 1439.

Inserting Workflow Activities Using Drag and Drop
Because Visual Studio is a visual environment, lines that connect events and activities change
as you add or remove them. To add an activity to a workflow:
1. Display the Visual Studio toolbox (View > Toolbox).
2. Click the Ektron Workflow Activities tab. Ektron’s Workflow Activities appear.

3. Drag an activity and drop it into the desired location in the Workflow.
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4. As desired, modify the activity’s properties using Visual Studio's Properties area.

AdvancedEmailActivity
Send an email notification, based on an order ID in Ektron, after an event takes place in the
workflow. For example, after an order is shipped, you might choose to send an email that
notifies customers when their orders are shipped. Or, you might send an email to a customer
when their order is received.
With this activity you can choose to send a predefined email message. These messages are
defined in the Workarea under Settings > Commerce > Configuration > Messages. See
Also: Configuring eCommerce on page 1305.
Two event handler properties in this activity let you add custom code to SendingEmail and
SentEmail events. The SendingEmail event fires immediately before the email is sent. The
SentEmail event fires immediately after the email sent.
Key properties of this activity are:
l

EmailArgs—Set this property to OrderId to associate the activity with orders in Ektron.

l

MessageTypes—Set this property to the type of email message this activity sends.

Associate email activity with orders in Ektron. You can either supply information such as, To:,
From:, Body:, and so on. or use information associated with the order. It also lets you specify
the type of message type that’s sent. (The BasicEmailActivity, on the other hand, is a
generic email activity where you specify To:, From:, Body:, and other email information.)
Activities
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

Email Message
l
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Bcc (String)—A blind carbon copy of the email is sent to the address entered in this
property. If you select OrderId for the EmailArgs property, the Bcc property is
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dynamically populated with the order’s information.
l

l

l

l

l
l

l

Body (String)—Enter the main content of the email. If you select a parameter from the
MessageType property, the Body property uses the corresponding content for that
message type.
CC (String)—A carbon copy of the email is sent to the email address entered in this
property. If you select OrderId for the EmailArgs property, the CC property is
dynamically populated with the order’s information.
From (String)—The address from which the email is sent. If you select OrderId for the
EmailArgs property, the CC property is dynamically populated with the order’s
information.
HtmlBody (Boolean)—Select whether to send the email in HTML or plain text. True
(default), use HTML; False, use plain text.
ReplyTo (String)—Specify the address to which the recipient of the email replies.
Subject (String)—Enter subject information for the email. If you select a parameter
from the MessageType property, the Subject property uses the subject information for
that message type.
To (String)—The email is sent to the address in this property. If you select OrderId for
the EmailArgs property, the To property is dynamically populated with the order’s email
information.

Email Server
l

l

Port (Integer)—Set this value to the port your system uses access to retrieve email. In
most cases, the port is set to 25. If that is not the case, see your System Administrator.
The default is 25. If blank, this property uses the ek_SMTPPort value in the site’s
web.config file.
SmtpHost (String)—The address of the server hosting the email system. If blank, this
property uses the ek_SMTPServer in the site’s web.config file.

Handlers
l

l

SendingEmail (String)—Event handler to add custom code to the sending email event.
This event fires right before the email is sent.
SentEmail (String)—Event handler to add custom code to the sent email event. This
event fires right after the email is sent.

Misc
l

EmailArgs—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (

l

) and select OrderId from the list.

MessageType—Select the type of message that is sent for this activity. If you select
None, the message is sent with the text in the Body property.
o None (default)—uses the text in the Body property.
o

OrderReceived—Sends the Order Received email defined in the Workarea >
Settings > eCommerce > Configuration > Messages screen when an order is
received.

o

OrderCancelled—Sends the Order Cancelled email defined in the Workarea >
Settings > eCommerce > Configuration > Messages screen when an order is
received.
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o

OrderShipped—Sends the Order Confirmation email defined in the Workarea >
Settings > eCommerce > Configuration > Messages screen when an order is
received.

For information on defining the messages, see Configuring eCommerce on page 1305.

BasicEmailActivity
Send an email after an event takes place in the workflow. These emails are usually generic
and contain the same information for To:, From:, Subject, Body, and so on.
There are 2 event handler properties in this activity that let you add custom code to the
SendingEmail and SentEmail events. The SendingEmail event fires right before the email is
sent. The SentEmail event fires right after the email sent. For example, you want to notify a
supervisor when orders are received, but you don’t want the notification to contain any order
specific information.
Key properties of this activity are:
l

To—enter the address to receive the email.

l

From—enter the address from which the email is being sent.

l

Subject—enter a brief summary for the email.

l

Body—enter the main subject text of the email.

BasicEmailActivity sends a generic email. In the activity, you specify To:, From:, Body:, and
other email information. (The AdvancedEmailActivity, on the other hand, lets you send an
email associated with orders in Ektron.) You can either supply information such as, To:,
From:, Body:, and so on, or use information associated with the order. It also lets you specify
the type of message type that’s sent.
Activities
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

Email Message
l

l
l

l
l

Bcc (String)—A blind carbon copy of the email is sent to the address entered in this
property.
Body (String)—Enter the main content of the email.
CC (String)—A carbon copy of the email is sent to the email address entered in this
property.
From (String)—The address from which the email is sent.
HtmlBody (Boolean)—Select whether to send the email in HTML (True) or plain text
(False).

l

ReplyTo (String)—Specify the address to which the recipient of the email replies.

l

Subject (String)—Enter a brief summary for the email.

l

To (String)—The email is sent to the address in this property.

Email Server
l
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default is 25. If blank, this property uses the ek_SMTPPort value in the site’s
web.config file.
l

SmtpHost (String)—The address of the server hosting the email system. If blank, this
property uses the ek_SMTPServer in the site’s web.config file.

Handlers
l

SendingEmail (String)—Event handler to add custom code to the sending email event.

l

SentEmail (String)—Event handler to add custom code to the sent email event.

CaptureOrderActivity
Initiate the capture of an order in Ektron. When the Workflow reaches this activity, the
process of submitting encrypted order information (including the transaction ID) to a
payment gateway account happens. At this time, the account is changed for the order
amount.
Use this activity when you want the capture to take place automatically in the Workflow. This
activity is the same as an Ektron user going to the Workarea and marking an order as
Captured. For information on how a Capture works in the Workarea, see Capturing Orders on
page 1388.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

Handlers
l

MethodInvoking—Select a method to call before the order is captured.

Misc
l

Select OrderId to dynamically associate this activity with orders in Ektron. Click
Browse (

) and select OrderId from the list.

CheckStockActivity
Verify the quantity of items ordered is available for shipping. When the workflow reaches this
activity, the quantity of each product in the order is checked. If the required quantity exists
for each item, the activity returns True. Otherwise, the activity returns False.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

Handlers
l

MethodInvoking—Select a method to call before the stock level is checked.

Misc
l

orderId—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (

) and select OrderId from the list.
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l

ReturnValue (Boolean)
o True—the quantity of each product ordered is in stock.
o

False (default)—there is not enough product in stock to fulfill the order.

OrderCancelledEventActivity
Block the workflow from going down a cancel path until the order actually has been canceled.
This activity does not cancel the order. It waits for a user, API code or UpdateOrderActivity
to mark the order canceled in Ektron before it continues down the order cancel path. Think of
it as gate that’s waiting for a certain event to happen before it can continue. When the event
happens, the path is opened in the workflow. For information on how to cancel an order in the
Workarea, see Canceling an Order on page 1389.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

l

Roles—

Handlers
l

Invoked (String)—Specify code that executes when the order is canceled.

Misc
l

Select OrderId to dynamically associate this activity with orders in Ektron. Click
Browse (

) and select OrderId from the list.

OrderCapturedEventActivity
Block the workflow from continuing down a path until the order actually has been captured.
This activity does not capture the order. It waits for a user or API code to mark the order as
captured in Ektron before it continues down the path. Think of it as gate that’s waiting for a
certain event to happen before it can continue. When the event happens, the path is opened in
the workflow. For information on how an order is captured in the Workarea, see Capturing
Orders on page 1388.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

l

Roles—

Handlers
l

Invoked (String)—Specify code that executes when the order has been captured.

Misc
l

OrderId—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (
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OrderFraudEventActivity

OrderFraudEventActivity
Block the workflow from going down a path that handles fraudulent orders until the order
actually has been marked as fraud.
This activity does not mark the order as fraudulent. It waits for a user, API code or the
UpdateOrderActivity to mark the order as fraud in Ektron before it continues down the
path. Think of it as gate that’s waiting for a certain event to happen before it can continue.
When the event happens, the path is opened in the workflow. For information on how to mark
an order as fraud in the Workarea, see Marking the Order as Fraudulent on page 1391.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

l

Roles—

Handlers
l

Invoked (String)—Specify code that executes when the order has been marked as
fraud.

Misc
l

OrderId—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (

) and select OrderId from the list.

OrderProcessedEventActivity
Block the workflow from going down an order process path until the order actually has been
processed. This is a generic event activity that lets you specify custom code to somehow
process the order.
This activity does not start the process. It waits for a user, API code or the
UpdateOrderActivity to kick off the Process Order action in Ektron before it continues down
the path. Think of it as gate that’s waiting for a certain event to happen before it can continue.
When the event happens, the path is opened in the workflow. For information on how to
cancel an order in the Workarea, see Canceling an Order on page 1389.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

l

Roles—

Handlers
l

Invoked (String)—Specify code that executes when the order has been processed.

Misc
l

OrderId—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (

) and select OrderId from the list.
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OrderReceivedEventActivity
Usually the first item in an order workflow, this activity does not mark the order as received,
but instead waits for Ektron to register a new order. When the order is received, this activity
allows the workflow to start. Think of it as gate that’s waiting for a certain event to happen
before it can continue. When the event happens, the path is opened in the workflow.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

l

Roles—

Handlers
l

Invoked (String)—Specify code that executes when the order has been received.

Misc
l

OrderId—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (

) and select OrderId from the list.

OrderShippedEventActivity
Block the workflow from going down a shipped order path until the order actually has been
shipped.
This activity does not mark the order as shipped. It waits for a user, API code or
UpdateOrderActivity to mark the order as shipped in Ektron before it continues down the
path. Think of it as gate that’s waiting for a certain event to happen before it can continue.
When the event happens, the path is opened in the workflow. For information on how to mark
an order as shipped in the Workarea, see Marking the Order as Shipped on page 1390.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

l

Roles—

Handlers
l

Invoked (String)—Specify code that executes when the order is shipped.

Misc
l

OrderId—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (

) and select OrderId. from the list.

OrderUpdatedEventActivity
Block the workflow from going down an updating order path until the order actually has been
updated.
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This activity does not update the order as shipped. It waits for a user, API code or
UpdateOrderActivity to update an order inEktron before it continues down the path. Think
of it as gate that’s waiting for a certain event to happen before it can continue. When the
event happens, the path is opened in the workflow.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

l

Roles—

Handlers
l

Invoked (String)—Specify code that executes when the order has been updated.

Misc
l

OrderId—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (

) and select OrderId. from the list.

UpdateOrderActivity
Automate updating of an order’s status. This activity is the same as an Ektron user going to
the Workarea and performing any of the above actions on an order. For information on how to
manually complete these tasks in the Workarea, see Processing Orders on page 1386.
Activity
l

Name (String)—Enter a name for the Activity.

l

Description (String)—Enter a description for the Activity.

l

Enabled (Boolean)—True (default), enable the activity; False, disable.

Handlers
l

MethodInvoking—Select a method to call before the stock level is checked.

Misc
l

OrderId—Select OrderId to dynamically associate this activity with orders in Ektron.
Click Browse (

l

) and select OrderId. from the list.

orderStatus
o Received (default)—marks an order as received
o

InProcess—marks the order as in process

o

Shipped—marks the order as shipped

o

Completed—marks the order as completed

o

Canceled—marks the order as canceled

o

OnHold—puts the order on hold

o

Fraud—marks the order as fraud

Customizing the Payment Gateway Provider
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A Payment Gateway Provider is a pluggable component that is integrated into Ektron's
eCommerce module. A Payment provider handles eCommerce customer payments by
utilizing third party payment gateways. Ektron’s eCommerce module accepts payments such
as credit cards. Then, it passes that information to a third party service. The third party
service processes the payment, and returns a transaction ID that’s stored with the customer's
order.
NOTE: Your company needs to set up an account with a third party payment service before utilizing the
payment provider. This includes payment providers such as Authorize.NET and PayFlow, which are
included with Ektron’s eCommerce Module.
Ektron comes with several payment providers, including Authorize.NET and PayFlow. You can
customize these providers or create your own using the extendable Payment Gateway
Provider architecture.
Each type of payment gateway provider accepts configuration parameters. For example,
Authorize.NET requires a username and password while PayFlow requires a username,
password, vendor, and partner.
In addition, some payment gateways may support recurring payments, while others may not.
Recurring payments provide the ability to create a payment that recurs at a given interval for
a specified period of time. For example, you could create a payment for $9.99 that occurs on
the first of every month for the next 12 months. This is something to consider if your site
relies on a subscription service. Contact your provider to find out if they support recurring
payments.
The following scenario shows the flow of payment information for a customer purchasing a
product from your site through you receiving the money in your account.
1. A customer purchases a product from your site and submits payment information.
2. Ektron passes the information to your payment gateway.
3. Your payment gateway provider passes the information to your bank’s processor.
4. The bank’s processor submits the information to a credit card interchange for
processing, clearing and settlement.
5. The interchange notifies the customer’s credit card company of the transactions details.
6. The credit card company accepts or declines the transaction based on the customers
account information.
7. If the transaction is approved, the funds are transferred to the interchange.
8. The credit card interchange sends information about whether the transaction is approved
to your bank’s processor.
9. This information is passed to your payment gateway provider.
10. The provider notifies your site of the information. The results of the transaction are
displayed on the page the customer is viewing.
11. The credit card interchange sends funds to your merchant account.
This section explains how to extend Ektron’s Payment Gateway Provider Architecture to build
your own customized Payment Gateway Provider.
See Also: Configuring Payment Options on page 1311
The following figure shows the Object Model for Ektron’s Payment Gateway Provider.
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The PaymentGatewayProvider is the abstract base class you must extend to implement your
own payment gateway. Details and descriptions of the PaymentGatewayProvider API can be
found in the Ektron API Reference Manual’s Providers API > PaymentGatewayProvider
section.

Creating a Custom Payment Gateway Provider
In addition to the out-of-the-box payment gateways providers shipped with Ektron, you can
create your own custom payment providers that connect with any payment gateway you
choose. Below are the basic code steps you need to complete when creating a custom
gateway provider. Additional code examples used by Ektron to create the PayFlow and
Authorize.NET providers are located in: C:\Program
Files\Ektron\CMS400SDK\Commerce\Providers\Commerce.Providers\PaymentGateways
The complete C# code sample used in this example is available at the end of this section. See
CustomGatewayProvider Code Example on page 1455
1. Create a class library project in Visual Studio.
2. Add references to these DLLs:
l
Ektron.Cms.Commerce
l

Ektron.Cms.Common

l

Ektron.Cms.ObjectFactory

l

Ektron.Cms.Instrumentation

l

System.Configuration
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l

Add these using statements to the code-behind:
using
using
using
using
using
using

System;
System.Collection;
System.Collection.Specialized;
Ektron.Cms;
Ektron.Cms.Common;
Ektron.Cms.Commerce;

3. Change the namespace to:
namespace Ektron.Cms.Extensibility.Commerce.Samples

4. Rename your class and inherit as below:
public class CustomPaymentProvider:
Ektron.Cms.Commerce.PaymentGatewayProvider.PaymentGatewayProvider

5. Add the following constructor.
#region constructor, member variables
public CustomPaymentProvider() { }
#endregion

6. Add the methods required by the PaymentGatewayProvider base class. The Initialize
method reads configuration information, the others are related to the payments and will
be completed later in the example.
public override void
Initialize(string name,
System.Collections.Specialized.NameValueCollection config)
{ if (config == null)
{ throw new ArgumentNullException("config");
// Assign the provider a default name if it doesn't have one
if (String.IsNullOrEmpty(name)) name = "CustomPaymentProvider";
if (string.IsNullOrEmpty(config["description"]))
{ config.Remove("description");
config.Add("description", "CustomPaymentProvider");
}
// Call the base class's Initialize method
base.Initialize(name, config);
// Throw an exception if unrecognized attributes remain
if (config.Count > 0)
{ foreach (string key in config.AllKeys)
{ EkException.WriteToEventLog("Unrecognized Payment Gateway
Provider attribute: " + key,
System.Diagnostics.EventLogEntryType.Warning);
}
}
}
}
public override string Authorize()
{
}
public override string AuthorizeAndCapture()
{
}
public override string CapturePreauthorization(string transactionId)
{
}
public override string VoidPreAuthorization(string transactionId)
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{
}

7. Implement the Authorize method that you added in the previous step. This method is
called to authorize a given amount of money when an order is submitted.
public override string Authorize()
{ if (PaymentMethod.GetType() != typeof(CreditCardPayment))
throw new Ektron.Cms.Commerce.Exceptions
.AuthorizationException("Invalid Payment Type");
CreditCardPayment creditCard = (CreditCardPayment)this.PaymentMethod;
if (creditCard.ExpirationDate.IsExpired())
throw new Ektron.Cms.Commerce.Exceptions.Payment.CreditCard
.CardExpiredException("Card Is Expired");
IsSubmissionSuccess = true;
Authorization.AuthorizedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();
return Authorization.TransactionId;
}

In this example, the card number and card holder name are not checked. In a real world
scenario, there would be additional validation (for example, via checksum) and the
authorization may be obtained via a Web service or HTTP post.
NOTE: If the authorization fails, you can choose to either throw an exception or manually set the
failure. For example:
SubmissionError = "Not enough Funds";IsSubmissionSuccess = false;
8. Implement the AuthorizeAndCapture, CapturePreauthorization and
VoidPreAuthorization methods you added earlier.
9. AuthorizeAndCapture requires that Authorization.CapturedOn be set, as the
capture occurs at the same time as the Authorization.
10. For CapturePreauthorization and VoidPreAuthorization, set the appropriate dates
for these actions, so they are recorded in the system properly.
public override string AuthorizeAndCapture()
{ IsSubmissionSuccess = true;
Authorization.AuthorizedOn = DateTime.Now;
Authorization.CapturedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();
return Authorization.TransactionId;
}
public override string CapturePreauthorization(string transactionId)
{ IsSubmissionSuccess = true;
Authorization.CapturedOn = DateTime.Now;
return Authorization.TransactionId;
}
public override string VoidPreAuthorization(string transactionId)
{ IsSubmissionSuccess = true;
Authorization.VoidedOn = DateTime.Now;
return Authorization.TransactionId;
}

11. Save and build the project.
12. Copy your project’s DLL file to your Ektron website’s bin directory.
13. Register the provider in your site’s web.config file. The web.config file provides the
facility to manage payment gateway providers within Ektron.
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14. To do this, locate the EktronPaymentGateway section and change the
defaultProvider parameter to the name of your custom provider. Note that changing
this from “Automatic” to the name of your provider overrides the settings in Workarea
> Settings > Commerce > Configuration > Payment Gateways. Ektronnow will
use the new provider.
15. If you start your search from the top of the file, it is the second instance.
<EktronPaymentGateway defaultProvider="CustomPaymentProvider">

16. Add your custom payment provider between the EktronPaymentGateway’s <providers>
tags. Note that the name defined here must match the defaultProvider from the
previous step.
<providers>
<add name="CustomPaymentProvider"
type="Ektron.Cms.Extensibility.Commerce.Samples.CustomPaymentProvider,
CustomPaymentProvider" />
</providers>

17. Save the web.config file.
18. Next, add the payment gateway to the Workarea.
a. Go to Workarea > Commerce > Configuration > Payment Options.
b. Select New > Payment Gateway.
c. In the Name drop-down, select customerPaymentProvider.
d. Check both Cards and Checks checkboxes.
e. Save these changes. Your custom payment provider is now the default provider.
Whenever a payment provider needs to be contacted, the information routes
through the new custom provider.

Displaying Your Custom Provider an Option in the
Workarea
In the example above, you changed the web.config file’s EktronPaymentGateway
defaultProvider parameter to the name of your custom payment provider. This overrides the
payment provider settings in the Workarea. To manage all payment providers from the
Workarea > Settings > Commerce > Configuration > Payment Gateways screen:
1. In the web.config file, locate the EktronPaymentGateway section and make sure the
defaultProvider parameter is set to Automatic.
<EktronPaymentGateway defaultProvider="Automatic">

2. Save the web.config file.
3. Navigate to the Workarea > Settings > Commerce >Configuration > Payment
Gateways screen.
4. Choose New > Payment Gateway.
5. From the Name drop-down list, select the name of the your new custom gateway.
6. Check the Default box if you want this to be the default payment gateway. The default
payment gateway is the gateway all payment information is routed through.
7. Enter the User ID for this payment gateway. This ID will identify your account with this
gateway provider.
8. Enter the password for your account with this gateway provider.
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9. If this gateway provider expects additional parameters when contacting it, click the
Expand Custom Values link and enter those values into the Custom 1 and Custom 2
fields.
10. Click Save. The custom gateway provider has been added and can now be managed
from the Workarea.

CustomGatewayProvider Code Example
WARNING! Copying, pasting, and using the following code without modification to create a DLL will not
result in a working custom payment provider. This code is provided as an outline of what is needed to
create an actual custom payment provider.

using System;
using System.Collections;
using System.Collections.Specialized;
using System.Configuration.Provider;
using Ektron.Cms;
using Ektron.Cms.Common;
using Ektron.Cms.Commerce;
namespace Ektron.Cms.Extensibility.Commerce.Samples
{
public class CustomPaymentProvider :
Ektron.Cms.Commerce.PaymentGatewayProvider
{
public CustomPaymentProvider() { }
public override void Initialize(string name,
System.Collections.Specialized.NameValueCollection config)
{
if (config == null throw new ArgumentNullException(;
// Assign the provider a default name if it doesn't have one
if (String.IsNullOrEmpty(name))
name = CustomPaymentProvider"
if string.IsNullOrEmpty(config(["description"]))
{
config.Remove("description");
config.Add("description", "CustomPaymentProvider";
}
// Call the base class's Initialize method
base.Initialize(name, config);
// Throw an exception if unrecognized
attributes remain
if (config.Count > 0)
{
foreach (string key in config.AllKeys)
{
EkException.WriteToEventLog("Unrecognized
Payment Gateway Provider attribute:
" + key,
System.Diagnostics.EventLogEntryType.Warning);
}
}
}
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public override string Authorize()
{
if (PaymentMethod.GetType() != typeof(CreditCardPayment))
throw new Ektron.Cms.Commerce.Exceptions.
AuthorizationException("Invalid Payment Type");
CreditCardPayment creditCard = (CreditCardPayment)
this.PaymentMethod;
if (creditCard.ExpirationDate.IsExpired())
throw new Ektron.Cms.Commerce.Exceptions.Payment.CreditCard.
CardExpiredException( "Card Is Expired";
IsSubmissionSuccess = true;
Authorization.AuthorizedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();
return Authorization.TransactionId;
}
public override string AuthorizeAndCapture()
{
IsSubmissionSuccess = true;
Authorization.AuthorizedOn = DateTime.Now;
Authorization.CapturedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();
return Authorization.TransactionId;
}
public override
string CapturePreauthorization(string transactionId)
{
IsSubmissionSuccess = true;
Authorization.CapturedOn = DateTime.Now;
return Authorization.TransactionId;
}
public override string VoidPreAuthorization(string transactionId)
{
IsSubmissionSuccess = true;
Authorization.VoidedOn = DateTime.Now;
return Authorization.TransactionId;
}
}
}

Customizing the Shipment Provider
A Shipment Provider is a pluggable component integrated into Ektron's eCommerce module.
The Shipping provider handles eCommerce real-time shipping rate retrieval by utilizing third
party shipping services such as FedEx or UPS, or you can create your own fixed rate logic.
Ektron's eCommerce shipping module calculates the package(s) needed for an order and then
passes the following information to the company providing the shipping services via a
Shipping Provider.
l

l
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package information—for example, how many, height, width, depth and weight of
each package.
warehouse address—the address from which the items will be shipped. A warehouse’s
information can be set in the Workarea > Settings > Commerce > Shipping >
Warehouses screen.

Ektron Reference

Customizing the Shipment Provider

l

l

destination address—the shipping address a customer entered when making the
purchase.
desired shipping options—for example, if you have Next Day, 2-Day Ground and 3Day Ground as shipping options, you can pass the option chosen by the customer.

Ektron comes with several shipping providers, including FedEx and UPS. You can customize
these providers or create your own using the extendable Shipping Provider architecture.
Your company will need to set up or have an existing account with a third party shipping
service before utilizing the shipping provider. This includes shipping providers such as, FedEx
or UPS, which are included with Ektron's eCommerce Module.
Each type of shipping provider accepts configuration parameters. For example, FedEx
requires a username, password, account number, and meter number while UPS requires a
Username, password, and account number. These configuration parameters along with the
provider definitions are stored in the SiteRoot/shipment.config file. Below is a provider
definition example for FedEx.
<add name="FedExShipmentProvider"
type="Ektron.Cms.Commerce.Providers.Shipment.FedExShipmentProvider,
Ektron.Cms.Commerce.Providers"
serviceUrl="https://gatewaybeta.fedex.com/web-services"
key="" password=""
accountNumber=""
meterNumber=""
transactionId="Ektron FedEx v3"

The following steps show the flow of shipping calculations for a customer purchasing a
product from your site.
1. A customer adds 2 books to the cart and clicks checkout.
2. The shipping calculator looks for the smallest possible package that will fit the items.
3. The shipping calculator calls the registered shipping provider for each package in the
order.
4. The shipping calculator combines all the rates received if more than one package is
being shipped and returns the shipping method rates to the checkout control.
5. The customer selects the desired shipping method and it is saved with the cart.
NOTE: Many Ektron settings affect your shipping calculations. A default warehouse must be defined with
a valid shipping address. Shipping methods you would like to offer customers must be defined. For
example, the FedEx provider supports over 10 possible shipping methods, but you may only be concerned
with Priority, 2 Day, and Ground. This must be defined in Ektron. You can also define the shipping
packages your business uses. The Shipping calculator will try and fit the order items into any packages
defined in Ektron. If no packages are defined, the item's dimensions are passed to the provider instead.
The following figure shows the Object Model for Ektron’s Shipment Provider.
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The ShipmentProvider is the abstract base class you must extend to implement your own
Shipping Provider. Details and descriptions of the ShipmentProvider API can be found in the
Ektron API Reference Manual’s Providers API > Shipment > Provider >
ShipmentProvider.

Creating a Custom Shipment Provider
In addition to the out-of-the-box shipment providers that come with Ektron, you can create a
custom provider that connects with any shipping company you choose. Below are the basic
code steps you need to complete when creating a custom shipment provider. Additional code
examples used by Ektron to create FedEx, Flat Rate and UPS shipment providers are located
in:
C:\Program Files\Ektron\CMS400SDK\Commerce\Providers\Commerce.Providers\Shipping

The complete C# code sample used in this example is available at the end of this section. See
CustomShipmentProvider Code Example on page 1461.
1. Create a class library project in Visual Studio.
2. Add references to these DLLs:
Ektron.Cms.Commerce
Ektron.Cms.Common
Ektron.Cms.ObjectFactory
Ektron.Cms.Instrumentation
System.Configuration

3. Add these using statements to the code-behind:
using System.Configuration.
using Ektron.Cms.Commerce.Shipment.Provider;
using Ektron.Cms.Commerce using Ektron.Cms.Instrumentation

4. Change the namespace to:
namespace Ektron.Cms.Extensibility.Commerce.Samples
{

5. Rename your class and inherit as below:
public class CustomShipmentProvider : ShipmentPovider
{
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6. Add the following constructor private variables and properties. The items added to the
shippingOptionList are the shipping methods exposed as a service type in the
management screen inside the Workarea.
#region constructor, member variables
public CustomShipmentProvider()
{ IsTrackingSupported = false;
_shippingOptionList = new List<string>();
_shippingOptionList.Add("CustomOption_1");
_shippingOptionList.Add("CustomOption_2");
}
private List<string> _shippingOptionList;
#endregion

7. Add the following methods required by the ShipmentProvider base class.
l
Initialize—reads configuration information
l

GetServiceTypes—returns a List <string> of the shipping options available

l

GetTrackingUrl—exposes tracking support

l

GetRates—returns a list of shipping rates for the items being shipped. The
contents of this method will be added in the next step.

#region ShipmentProvider Implementation
public override void
Initialize(string name,
System.Collections.Specialized.NameValueCollection config)
{ if (config == null)
{ throw new ArgumentNullException("config");
// Assign the provider a default name if it doesn't have one
if (string.IsNullOrEmpty(name)) name = "CustomShipmentProvider";
if (string.IsNullOrEmpty(config["description"]))
{ config.Remove("description"); config.Add("description",
"CustomShipmentProvider Provider"); }
// Call the base class's Initialize method
base.Initialize(name, config);
// Throw an exception if unrecognized attributes remain
if (config.Count == 0) throw new
ProviderException("Shipment provider attribute missing.");
else {
//read all config attributes.
ServiceUrl = config["serviceUrl"];
Key = config["key"];
Password = config["password"];
AccountNumber = config["accountNumber"];
MeterNumber = config["meterNumber"];
TransactionId = config["transactionId"];
}
}
public override List<string> GetServiceTypes()
{ return _shippingOptionList;
}
public override string GetTrackingUrl(string trackingId)
{ return "";
}
public override List
<ShippingOptionData>GetRates(IEnumerable
<ShippingMethodData>
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expectedOptions, AddressData origin, AddressData destination,
Weight weight, Dimensions dimensions)
{
}
#endregion

8. Implement the GetRates method. Add this code to public override for GetRates which
was added during the previous step. (This example uses flat rates for your shipping
methods. In a real world scenario, the shipping methods and their corresponding rates
can be obtained via FedEx, UPS, a third party application or a Web service.) When
complete, the code should look like this.
public override List <ShippingOptionData>
GetRates(IEnumerable<ShippingMethodData>
expectedOptions, AddressData origin, AddressData destination,
Weight weight, Dimensions dimensions)
{ List <ShippingOptionData> availableOptions =
new List <ShippingOptionData>();
try
{ foreach (ShippingMethodData expectedOption in expectedOptions)
{ Log.WriteInfo("Custom Shipping Provider.ExpectedOption:" +
expectedOption.Name);
switch (expectedOption.ProviderService.ToLower())
{ case "customoption_1": ShippingOptionData customOption1 =
new ShippingOptionData();
customOption1.Id = expectedOption.Id;
customOption1.Name = expectedOption.Name;
customOption1.ShippingFee = 25.00M;
customOption1.ProviderService = "CustomOption_1";
availableOptions.Add(customOption1);
break;
case "customoption_2":
ShippingOptionData customOption2 = new ShippingOptionData();
customOption2.Id = expectedOption.Id;
customOption2.Name = expectedOption.Name;
customOption2.ShippingFee = 50.00M;
customOption2.ProviderService = "CustomOption_2";
availableOptions.Add(customOption2);
break;
}
}
}
catch (Exception e)
{ Log.WriteError("Custom Shipping Provider: Error retrieving shipping
rates." + e.Message); throw;
}
return availableOptions;
}

9. You can use the GetRates method to restrict countries to which you ship. For example, if
you want to prevent shipping to all countries except Canada, add these lines of code to
the GetRates method.
if (destination.Country.Id != 124)
throw new Ektron.Cms.Commerce.Exceptions.Shipping.InvalidAddressException
("We ship only to Canada.");

10. Save and build the project.
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11. Copy your project’s DLL file to your Ektron website’s bin directory.
12. Register the provider in your site’s shipment.config file. This file provides the facility
to manage shipping providers within Ektron. Locate the shipmentProvider section and
change the defaultProvider parameter to the name of your custom provider.
<shipmentProvider defaultProvider="CustomShipmentProvider">

13. Add your custom shipping provider between the shipmentProvider’s <providers> tags.
Note that the name defined here needs to match the name defined as the defaultProvider
in the previous step.
<providers>
<add name="CustomShipmentProvider"
type="Ektron.Cms.Extensibility.Commerce.Samples.CustomShipmentProvider,
CustomShipmentProvider" serviceUrl="" key="" password=""
accountNumber="" meterNumber=""
transactionId="CustomShipmentProvider based transaction" />
</providers>

14. Save the web.config file.
15. Your custom shipping provider is now the default provider. Whenever you need to obtain
shipping rate information, the information routes through the new custom provider.
16. Add the shipping methods that are available for your provider in the Workarea >
Settings > Commerce -> Shipping > Methods screen.
a. Select New > Shipping Method.
b. Enter a name. This is what a customer sees during the checkout process. An
example is “Ground” or “Next Day”. For this example, use “Custom1”.
c. Check the Active checkbox.
d. Click View Options and select CustomOption_1 from the list.
e. Click Save).
f. Repeat this process for the CustomOption2 shipping method type.
The options are now available in the checkout process, and are shown on the shipping method
selection screen.

CustomShipmentProvider Code Example
WARNING! Copying, pasting, and using the following code without modification to create a DLL does not
result in a working “real time” shipping provider. This example uses fixed rates and should be modified to
meet your needs.

The following code example is used in Creating a Custom Shipment Provider on
page 1458.
using System.Configuration.Provider;
using Ektron.Cms.Commerce.Shipment.Provider;
using Ektron.Cms.Commerce;
using Ektron.Cms.Instrumentation;
namespace Ektron.Cms.Extensibility.Commerce.Samples
{
public class CustomShipmentProvider : ShipmentProvider
{
#region constructor, member variables
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public CustomShipmentProvider()
{
IsTrackingSupported = false;
_shippingOptionList = new List<string>();
_shippingOptionList.Add("CustomOption_1");
_shippingOptionList.Add("CustomOption_2");
}
private List<string> _shippingOptionList;
#endregion
#region ShipmentProvider Implementation
public override void Initialize(string name,
System.Collections.Specialized.NameValueCollection config)
{
if (config == null)
throw new ArgumentNullException("config");
// Assign the provider a default name if it doesn't have one
if (string.IsNullOrEmpty(name))
name = "CustomShipmentProvider";
if (string.IsNullOrEmpty(config["description"]))
{
config.Remove("description");
config.Add("description", "CustomShipmentProvider Provider");
}
// Call the base class's Initialize method
base.Initialize(name, config);
// Throw an exception if unrecognized attributes remain
if (config.Count == 0)
throw new ProviderException("Shipment provider attribute missing.");
else
{
//read all config attributes.
ServiceUrl = config["serviceUrl"];
Key = config["key"];
Password = config["password"];
AccountNumber = config["accountNumber"];
MeterNumber = config["meterNumber"];
TransactionId = config["transactionId"];
}
}
public override List<string> GetServiceTypes()
{
return _shippingOptionList;
}
public override string GetTrackingUrl(string trackingId)
{
return "";
}
public override List<ShippingOptionData>
GetRates(IEnumerable<ShippingMethodData>
expectedOptions, AddressData origin, AddressData destination,
Weight weight, Dimensions dimensions)
{
List<ShippingOptionData> availableOptions = new List<ShippingOptionData>();
try
{
foreach (ShippingMethodData expectedOption in expectedOptions)
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{
Log.WriteInfo("Custom Shipping Provider.ExpectedOption:"
+ expectedOption.Name);
switch (expectedOption.ProviderService.ToLower())
{
case "customoption_1":
ShippingOptionData customOption1 = new ShippingOptionData();
customOption1.Id = expectedOption.Id;
customOption1.Name = expectedOption.Name;
customOption1.ShippingFee = 25.00M;
customOption1.ProviderService = "CustomOption_1";
availableOptions.Add(customOption1);
break;
case "customoption_2":
ShippingOptionData customOption2 = new ShippingOptionData();
customOption2.Id = expectedOption.Id;
customOption2.Name = expectedOption.Name;
customOption2.ShippingFee = 50.00M;
customOption2.ProviderService = "CustomOption_2";
availableOptions.Add(customOption2);
break;
}
}
}
catch (Exception e)
{
Log.WriteError("Custom Shipping Provider:
Error retrieving shipping rates." + e.Message);
throw;
}
return availableOptions;
}
#endregion
}
}

Customizing the Inventory Provider
An Inventory Provider is a pluggable component that’s integrated into Ektron's eCommerce
module. An Inventory Provider handles the retrieving and updating of inventory information
for products within Ektron. Out of the Box, Ektron comes with a default Ektron Inventory
Provider that tracks inventory within its database.
If your business has an Accounting or Enterprise Resource Management solution that
manages inventory, you can create a custom Inventory Provider that retrieves and updates
inventory information directly from that system. Inventory data can be stored in any number
of locations, including databases, ERP or CRM systems, or even XML files.
The following figure shows the Object Model for Ektron’s Inventory Provider.
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The InventoryProvider is the abstract base class you must extend to implement your own
Inventory Provider. Details and descriptions of the InventoryProvider API can be found in the
Ektron API Reference Manual’s Providers API > Inventory > Provider >
InventoryProvider.

Creating a Custom Inventory Provider
In addition to the out-of-the-box inventory provider that comes with Ektron, you can create
your own custom provider that connects with an existing inventory system. Below are the
basic code steps you need to complete when creating a custom inventory provider. A code
example for the inventory provider used by Ektron is located in:
C:\Program Files\Ektron\CMS400SDK\Commerce\Providers\Commerce.Providers\Inventory

The complete C# code sample used in this example is available at the end of this section. See
CustomInventoryProvider Code Example on the facing page.
1. Create a class library project in Visual Studio.
2. Add references to these DLLs:
l
Ektron.Cms.Commerce
l

Ektron.Cms.Common

l

Ektron.Cms.ObjectFactory

l

System.Configuration

3. Add these using statements to the code-behind.
using
using
using
using
using

Ektron.Cms.Commerce.Inventory.Provider;
Ektron.Cms.Commerce.Data;
Ektron.Cms.Commerce; using Ektron.Cms.Common;
Ektron.Cms.Extensibility;
Ektron.Cms.Extensibility.Commerce;

4. Change the namespace to:
Ektron.Cms.Extensibility.Commerce.Samples {

5. Rename your class and inherit as below:
CustomInventoryProvider InventoryPovider

6. Add the following constructor, private variables and properties.
Public CustomInventoryProvider() { } private CmsInventory _inventory;
protected CmsInventory Inventory

1464

Ektron Reference

CustomInventoryProvider Code Example

{ get
{ if (_inventory == null)
{ _inventory = CmsInventory(RequestInformation);
} return_inventory;
}
}

7. Override the following methods. These methods area called when the inventory system
is queried.
l
GetInventory—returns an InventoryData data class for a given product id.
l

SaveInventory—persists updates to the stock levels inside the inventory system.
In this example, we trigger Ektron extensibility events, such as
OnBeforeInventorySave() and OnAfterInventorySave(). In a real world
scenario, your existing inventory system may have its own inventory events that
are used.

public override InventoryData GetInventory (long entryId)
{ return Inventory.GetInventory(entryId); }
public override void SaveInventory(InventoryData inventory)
{ OnBeforeInventorySave(inventory);
Inventory.SaveInventory(inventory);
OnAfterInventorySave(inventory);
if (inventory.UnitsInStock < inventory.ReorderLevel)
{ OnInventoryReorderLevelReached(inventory); }
}

8. Save and build the project.
9. Copy your project’s DLL file to your Ektron website’s bin directory.
10. Register the provider in your site’s web.config file. The web.config file provides the
facility to manage inventory providers within Ektron. Locate the InventoryProvider
section and change the defaultProvider parameter to the name of your custom
provider. If you start your search from the top of the file, it will be the second instance.
<inventoryProvider defaultProvider="CustomInventoryProvider">

11. Add your custom payment provider between the EktronPaymentGateway’s <providers>
tags. Note that the name defined here needs to match the name defined as the
defaultProvider in the previous step.
<providers>
<add name="CustomInventoryProvider"
type="Ektron.Cms.Extensibility.Commerce.Samples.CustomInventoryProvider,
CustomInventoryProvider"/>
</providers>

12. Save the web.config file.
Your custom inventory provider is now the default provider. Whenever the inventory is
queried, the call routes through the new custom provider.

CustomInventoryProvider Code Example
WARNING! Copying, pasting, and using the following code without modification to create a DLL does not
result in a working “real time” shipping provider. This example uses fixed rates and should be modified to
meet your needs.
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The following code example is used in Creating a Custom Inventory Provider on
page 1464.
using Ektron.Cms.Commerce.Inventory.Provider;
using Ektron.Cms.Commerce.Data;
using Ektron.Cms.Commerce;
using Ektron.Cms.Common;
using Ektron.Cms.Extensibility;
using Ektron.Cms.Extensibility.Commerce;
namespace Ektron.Cms.Extensibility.Commerce.Samples
{
public class CustomInventoryProvider : InventoryProvider
{
public CustomInventoryProvider() { }private CmsInventory _inventory;
protected CmsInventory Inventory
{
get
{
if (_inventory == null)
{
_inventory = new CmsInventory(RequestInformation);
}
return _inventory;
}
}
public override InventoryData GetInventory(long entryId)
{
return Inventory.GetInventory(entryId);
}
public override void SaveInventory(InventoryData inventory)
{
OnBeforeInventorySave(inventory);
Inventory.SaveInventory(inventory);
OnAfterInventorySave(inventory);
if (inventory.UnitsInStock < inventory.ReorderLevel)
{
OnInventoryReorderLevelReached(inventory);
}
}
}
}

Customizing Shipping Calculations
The shipping system provides an easy and extensible way to override the shipping
calculations inside Ektron. This example sets up a custom shipping calculator to get shipping
rates with a different source location for a class of products. It has 2 major parts.
l

Creating the Calculator Code below

l

Registering the Event with the System on page 1471

Creating the Calculator Code
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1. Create a class library project in Visual Studio named
Commerce.CustomShippingCalculator. You need to import the necessary Ektron
namespaces. To do this, add references to:
l
Ektron.Cms.Api
l

Ektron.Cms.Commerce

l

Ektron.Cms.Common

l

Ektron.Cms.Instrumentation

l

Ektron.Cms.ObjectFactory

l

Microsoft.Practices.EnterpriseLibrary.Validation

l

System.Configuration

2. Add the following using statements.
using
using
using
using
using
using
using
using
using
using
using

System.Collections.Generic;
Microsoft.Practices.EnterpriseLibrary.Validation;
Ektron.Cms;
Ektron.Cms.Common;
Ektron.Cms.Commerce;
Ektron.Cms.Commerce.Shipment.Provider;
Ektron.Cms.Extensibility;
Ektron.Cms.Extensibility.Commerce;
Ektron.Cms.Instrumentation;
Ektron.Cms.Commerce.Exceptions;
Ektron.Cms.Commerce.Exceptions.Shipping;

3. Change the namespace to Ektron.Cms.Extensibility.Commerce.Samples. Then,
rename your class to CustomShippingCalculator and inherit from the
ShippingCalculatorStrategy class. See sample code below.
namespace Ektron.Cms.Extensibility.Commerce.Samples
{ public class CustomShippingCalculator : ShippingCalculatorStrategy
{

4. Add a few helper variables, properties, and functions. The function GetFlatPackageList
"flattens" the items in the basket, returning 1 for each item quantity. So, if we have 4
widgets, we'll have 4 packages, each with one widget.
5. The following logic fits the goods into packages, adding a function to get another
warehouse location. (It is hard-coded in this example.)
namespace Ektron.Cms.Extensibility.Commerce.Samples
{ public class CustomShippingCalculator : ShippingCalculatorStrategy
{ private EkRequestInformation _requestInfo;
private IShippingMethod _shippingService;
protected EkRequestInformation RequestInformation
{ get
{ if (_requestInfo == null)
{ _requestInfo =
ObjectFactory.GetRequestInfoProvider().GetRequestInformation();
}
return _requestInfo;
}
}
}
protected IShippingMethod ShippingService
{ get
{ if (_shippingService == null)
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{ _shippingService = ObjectFactory.GetShippingMethod();
}
return _shippingService;
}
}
protected List<ShippingMethodData> GetActiveShippingMethodList()
{ Criteria<ShippingMethodProperty>
criteria = new Criteria<ShippingMethodProperty>
(ShippingMethodProperty.DisplayOrder,
EkEnumeration.OrderByDirection.Ascending);
criteria.AddFilter(ShippingMethodProperty.IsActive,
CriteriaFilterOperator.EqualTo, true);
return ShippingService.GetList(criteria);
}
protected List<ShippingPackageData>
GetFlatPackageList(List<AdjustedBasketItem> basketItems)
{ List<ShippingPackageData> flatList = new List<ShippingPackageData>();
foreach (AdjustedBasketItem item in basketItems)
{ if (item.IsTangible)
{ for (int x = 1; x <= item.Quantity; x++)
{ ShippingPackageData package =
new ShippingPackageData(item.Dimensions, item.Weight);
package.Items.Add(item);
flatList.Add(package);
}
}
}
return flatList;
}
private AddressData GetWarehouseAddressData()
{ AddressData address = new AddressData();
address.Name = "Ektron";
address.AddressLine1 = "542 Amherst St.";
address.City = "Nashua";
address.Country = new CountryData();
address.Country.Id = 840;
// USA
address.Region = new RegionData();
address.Region.Id = 31;
// NH
address.PostalCode = "03063";
return address;
}
}

6. Override the OnBeforeCalculate method, which is called when shipping is calculated for
the basket.
public override void OnBeforeCalculate(BasketCalculatorData basketData,
ShippingMethodData shippingMethod, CancellableEventArgs eventArgs) { }

7. In this method, add code to ship items with a tax class id of 4 from another warehouse,
versus the default one specified (package.Items[0].TaxClassId == 4 ).
public override void OnBeforeCalculate(BasketCalculatorData basketData,
ShippingMethodData shippingMethod, CancellableEventArgs eventArgs))
{ bool hasTangibles = basketData.Basket.HasTangibleItems;
List<ShippingMethodData>
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availableShippingMethods = GetActiveShippingMethodList();
List<ShippingPackageData>
shippingPackages = GetOrderPackages(basketData.AdjustedItems);
//convert list of items into flat list - all 1 quantity.
List<ShippingPackageData>
shippingPackages = FlattenItemsIntoPackages(basketData.AdjustedItems);
if (shippingPackages.Count == 0)
{ Log.WriteInfo("No packages to calculate shipping for.");
return;
}
Dictionary<string, int> rateCount = new Dictionary<string, int>();
//Get Rate for each package
foreach (ShippingPackageData package in shippingPackages)
{ List<ShippingOptionData> shippingRateList;
Log.WriteVerbose(string.Format("Shipping package:
{0} x {1} x {2} {3}, {4} {5}", package.Dimensions.Height,
package.Dimensions.Length, package.Dimensions.Width,
package.Dimensions.Units.ToString(), package.TotalItemWeight.Amount,
package.TotalItemWeight.Units.ToString()));
//Get rate for each available option and populate the
// BasketCalculatorData.ShippingRates list.
if (package.Items[0].TaxClassId == 4) shippingRateList =
ShipmentProviderManager.Provider.GetRates(availableShippingMethods,
GetWarehouseAddressData(), basketData.ShipTo, package.TotalItemWeight,
package.Dimensions);
else shippingRateList = ShipmentProviderManager.Provider.GetRates
(availableShippingMethods, basketData.ShipFrom, basketData.ShipTo,
package.TotalItemWeight, package.Dimensions);
if (shippingRateList.Count == 0)
{ EkException.ThrowException(new NoRatesAvailableException
("No shipping rates are available for the supplied item."));
}
//add rates to basket.ShippingRates
foreach (ShippingOptionData rate in shippingRateList)
{
//if there are multiple packages, we need to total up rates for each
//shipping method.
//NOTE: we can only return rates that are applicable to ALL packages.
//For example, package 1 has rates for ground, priority, freight
// package 2 has rates for ground, priority
//only return rates for ground and priority since freight will only be
//a partial quote.
//check if this shipping method has already been added.
ShippingOptionData existingMethodRate =
basketData.ShippingRates.Find(delegate(ShippingOptionData match)
{ return match.ProviderService == rate.ProviderService; });
if (existingMethodRate == null)
{ basketData.ShippingRates.Add(rate); }
else
{ existingMethodRate.ShippingFee += rate.ShippingFee; }
//need to keep count of how many times this shipping method rate is added
//to make sure we have a method rate for each package.
if(rateCount.ContainsKey(rate.ProviderService))
{ rateCount[rate.ProviderService]++; }
else
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{ rateCount.Add(rate.ProviderService, 1); }
}
}
//default exchange rate
ExchangeRateData exchangeRate = new ExchangeRateData(0, 0, 1m, null);
if (basketData.ShippingRates.Count > 0
&& basketData.ShippingRates[0].CurrencyId
!= RequestInformation.CommerceSettings.CurrencyId)
{ IExchangeRate rateService = ObjectFactory.GetExchangeRate();
exchangeRate = rateService.GetCurrentExchangeRate();
if (exchangeRate == null)
{ Log.WriteError(string.Format("No exchange rate found for
current currency {0}. Shipping rates could not be converted
to current currency.",
RequestInformation.CommerceSettings.CurrencyId));
EkException.ThrowException(new CmsException(string.Format
("No exchange rate found for current currency {0}. Shipping
rates could not be converted to current currency.",
RequestInformation.CommerceSettings.CurrencyId)));
}
}
//go through all shipping methods and remove any that don't have rates
//for packages.
for(int x = 0; x < basketData.ShippingRates.Count; x++)
{ bool removed = false;
if(rateCount[basketData.ShippingRates[x].ProviderService]
< shippingPackages.Count)
{ basketData.ShippingRates.RemoveAt(x); x--;
//need to decrement loop counter so we don't skip any as we loop through
removed = true;
}
if (!removed)
{ if (basketData.ShippingRates[x].CurrencyId
!= RequestInformation.CommerceSettings.CurrencyId)
{
//if shipping rate currency is not current currency, convert it
basketData.ShippingRates[x].ShippingFee
= exchangeRate.ConvertPrice(basketData.ShippingRates[x].ShippingFee);
}
//is this the selected shippingmethod for basket? If so, set shipping cost
//on basket
if (shippingMethod != null
&& shippingMethod.ProviderService
== basketData.ShippingRates[x].ProviderService)
{ basketData.TotalShippingCost
+= basketData.ShippingRates[x].ShippingFee;
}
}
}
if (basketData.ShippingRates.Count == 0 && hasTangibles)
{ basketData.ValidationResults.AddResult(new ValidationResult
("No shipping rates are available for the supplied item.", this,
"", "", null)); } eventArgs.IsCancelled = true;
}
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8. When shipping is calculated for the basket, the above function runs first. Setting the
IsCancelled property to true on eventArgs instructs Ektron to stop further execution of
the shipping calculations. This, in effect, overrides the shipping functionality.
9. Build the project, and copy the assembly into the Ektron site's bin directory.

Registering the Event with the System
After you create the event assembly and place it inside the bin directory, you need to register
the event. Use the objectfactory.config file to register custom events within Ektron. To do
that:
1. Open the siteroot/objectfactory.config file.
2. Find the objectStrategies section of the file.
3. Within that section, locate or add this key: name="ShippingCalculator".
4. Add a reference to the class created earlier in the <strategies> key, as shown below.
<objectStrategies>
<add name=ShippingCalculator">
<strategies>
<add name="CustomShippingCalculator"
type="Ektron.Cms.Extensibility.Commerce.Samples.CustomShippingCalculator,
Commerce.CustomShippingCalculator"/>
</strategies>
</add>
</objectStrategies>
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Ektron’s eSync keeps websites up-to-date efficiently. From single sites, global multi-sites,
and server farms, eSync provides scalable, geo-synchronization capabilities that let you
easily update exactly what you want, when you want to update it. The following video
introduces eSync: eSync—Website Synchronization With Ektron.
Ektron’s eSync lets users update content anywhere safely by employing certificate-based
authentication to secure your website, whether it is on a production server or a development
environment. Also, your updates can take place on the safe side of your firewall before being
moved to the live site. Within complex IT infrastructures, eSync can synchronize content,
assets, HTML pages and other website components, whether they are managed by Ektron or
not.
eSync efficiently makes updates and eliminates site downtime by moving only the changes
you want to move; single pieces of content to entire sites. With its intelligent synchronization
technology, eSync securely moves selected content bidirectionally: Web 2.0 sites have a
wealth of user-generated content and membership information which can be synchronized
back to the development side of the firewall. To track changes to Ektron data between syncs,
eSync sets up a c:\sync folder structure that mirrors your site’s Windows folder structure.
This structure is created on each server when sync relationships are first established. No
Ektron files reside in the \sync folders. Instead, each folder has four .sync files that monitor
changes to Ektron files in the corresponding folder.
eSync manages content dependencies. Ektron content can reference other files, such as
images. eSync automatically handles the synchronizing of such content dependencies, so you
do not need to worry about these extra files. Adjusting Relationship Settings on page 1533
explains how to control content dependency sync.
You can synchronize at any time with single or multiple servers; strategic times that assure
optimal performance, while facilitating site updates; low-traffic times to coordinate global
multi-site setups. You also can schedule time-sensitive events.
If conflicting versions of content exist, eSync’s configurable conflict resolution engine ensures
that you will not lose your most recent content. The version that isn’t posted is saved in a
history log (along with other previous versions), letting you track changes or restore if the
need arises.
If you have multiple development servers, eSync can create a copy of the live site to work
with. As your developers changes the site, their updates can by synchronized to the staging
and production servers. eSync also can support advanced infrastructures, including load
balancing and failover server configurations.
Every server in a sync relationship is assigned a unique number. The originating server is 1,
the first server with which it establishes a relationship is 2, and so on. The server number is
stored in the c:\sync\serverinfoXX.xml file.
<SyncServerInfoList>
<SyncServerInfo IsSyncRunning="false" Migrated="false" MaxId="2" ServerNumber="1" ...

All Ektron data is assigned a unique ID number to distinguish it from similar objects.
Examples are content (see illustration), folders, menus, users, and so on.
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When you create a sync relationship, Ektron applies a new ID numbering range to each server
to ensure that, from then on, objects created on either server have a unique ID. This prevents
collisions when synchronizing between servers. For example, since membership users
created on a production server have a different ID number range from those created on the
staging server, eSync does not overwrite them.
To view a server’s ID number range, open its C:\sync\serverinfoXX.xml file, and check the
MaxId value as shown in the following example.
<SyncServerInfoList>
<SyncServerInfo IsSyncRunning="true" MaxId="2" ServerNumber="1"....

Multiply that number by 1 trillion to get the largest ID number which that server can assign.
For example, if MaxId = 3, ID numbers range from 2,000,000,000,001 to 3,000,000,000,000.

Setting Up eSync
This section explains several scenarios for installing and setting up eSync.
l

Scenario 1: Synchronizing 2 Sites on the Same Server on page 1480

l

Scenario 2: Synchronizing a Local Server with a Remote Server on page 1483

l

Scenario 3: Setting up a Development > Staging > Production Environment on
page 1493

PREREQUISITES FOR USING ESYNC
To use eSync, you must have the following:
l

Ektron software and files
o Ektron Version 8.5 or higher
IMPORTANT: The version of Ektron on every server in the sync relationship must match.
You cannot upgrade nor downgrade Ektron using eSync.
o

An Ektron base installation file (for example, cms400Base8x.exe). Use to install a
second site with which to sync your current site.

o

Ektron licenses that support Enterprise or Professional with eSync on every server
being synched

o

Matching security certificates on every server being synched See Also: Managing
eSync Security Certificates on page 1521
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l

Microsoft Software
o See Ektron System Requirements
o

Microsoft Sync Framework 2.1
NOTE: It is not a problem if your templates were created using the 2.0 Framework.

o

l

User Permissions
o You are a member of the Ektron Administrators group or assigned the
Synchronization Admin role. See Also: Defining Roles on page 1120
o

l

Database servers may use different SQL server versions. (For example, your
development server uses SQL 2008 Express, and your production server uses SQL
Server 2008 R2.)

The user performing the sync is assigned the following SQL database roles
o db_owner (needed for initial sync only; after that is complete, you may
remove this role)
o

db_datawriter

o

db_executor (created by Ektron installer when setting up database)

o

db_ddladmin

o

db_datareader

Server
o GMT time on each server’s clock must be within 5 minutes of each other.

Characteristics of eSync
You administer eSync through the Workarea > Settings > Configuration >
Synchronization> Profiles screen. The screen lets you establish a sync relationship
between 2 websites, then specify any number of sync profiles for each relationship.

A profile lets you specify data to sync, a direction, and a schedule. You can sync immediately
by clicking Sync (

).

You create profiles to sync these kinds of data.
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database objects (content, menus, users, and so on).

l

Workarea folder files

l

remaining site files
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File types or individual files can be included or excluded from a sync profile. Alternatively,
you can sync content or folders. See Also: Synchronizing Content and Folders on page 1537

Sync Relationships
You can synchronize any server to or from any other server with one important exception:
you cannot initiate a sync from a server outside the firewall. You can only initiate a sync from
a server inside the firewall because an outside server does not know the address of servers
inside the firewall. However, your staging server can push to and pull from a production
server.
IMPORTANT: All eSync transmissions use port 8732. This is not configurable.

Relationship 1: One Staging Server, One Production Server
The most basic eSync relationship involves a staging and a production server. Each server
has a database and one site.

eSync can automatically create a production server from your staging server. See Also:
Initializing a New Site on page 1480
For installation instructions for this relationship, see Scenario 2: Synchronizing a Local Server
with a Remote Server on page 1483.

Relationship 2: One Development, One Staging, One
Production Server
This relationship includes a development server. Developers can use it to create new features
and modify existing ones. When they are done, they can sync changes to the staging server,
where they can be verified before being moved to production.

For installation instructions for this relationship, see Scenario 3: Setting up a Development >
Staging > Production Environment on page 1493.

Relationship 2a: Multi-site Staging and Production Servers
The following relationship illustrates synchronizing several sites on a staging server with
those sites on production.
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Relationship 3: Several Dev. Servers, One Staging, One
Production Server
As shown in the illustration, any number of development servers can sync to each other and
your staging and production servers.

Relationship 4: One Dev., One Staging, One Production
Site, One Production DB Server
In this relationship, the production site has 2 servers: one for site files, and another for the
database.
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Relationship 5: Relationship 4 Plus Pre-Production

To synchronize these servers, set up several eSync profiles. One syncs the database, assets,
and templates to the production database server. Another profile syncs the staging server’s
Workarea files with the production site server.
NOTE: When using separate site and database servers, assets are stored on the site server.

Relationship 5: Relationship 4 Plus Pre-Production Server
This relationship adds a server between staging and production. The preproduction server can
be used for review and testing of changes before they are moved to production.

Relationship 6: Multi-site: Each Site and DB on own
Production Server
In this relationship, each production server has its own database plus the site files. As an
alternative, you could have a separate server for each production database, with all sites on
one production server.
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NOTE: The above relationship also supports separate site and database servers.
To synchronize this type of relationship, set up several eSync profiles, one for each site.
l

3 database and template profiles

l

3 Workarea profiles

Initializing a New Site
Typically, before you begin using eSync, one server hosts an Ektron website, and you want to
bring other servers into the relationship. After the servers are synchronized, one is the
staging server, the one on which content is created or updated, then published. Another
server, production, hosts your live website.
IMPORTANT: The names of the site and all folders must match on both servers. This is because paths to
images, XSLT files, and so on, refer to a site and its folders. If the names do not match, the links break.
First, use eSync to initialize new servers from the existing one. Afterwards, use eSync to
periodically sync updated content, folders, users, menus, and so on.

Scenario 1: Synchronizing 2 Sites on the Same Server
It is unlikely that you will use this relationship in “real-life” situations, but it provides the
simplest way to begin testing and learning eSync.
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Scenario 1: Synchronizing 2 Sites on the Same

IMPORTANT: Only use this scenario in a test environment. For a live environment, use either Scenario 2:
Synchronizing a Local Server with a Remote Server on page 1483 or Scenario 3: Setting up a
Development > Staging > Production Environment on page 1493.
1. Log into your Ektron server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
2. Begin to install the first site. See Also: Installing Ektron on page 9.
3. During installation, the following dialog appears. Check eSync.
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4. Near the end of the installation, the following dialog appears.

a. At the Site Name drop-down, select the site you just installed.
b. Check the radio button next to Generate Certificates.
c. Click Generate.
5. Install a second site on the same server, again using the credentials of the service
account used by Ektron Windows Service 4.0 and your site's AppPool.
IMPORTANT: Install both sites to a physical folder relative to the root folder. Do not install one site
to a physical folder relative to the root folder and the other site to a virtual directory.
6. Repeat Steps 2 and 3 above for the second site.
7. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
The security configurator screen appears.
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Scenario 2: Synchronizing a Local Server with a

8. In the Web Site Description drop-down, select the first site.
9. Click Apply Remote Server Certificates.
10. Click Browse next to that field.
11. Browse to C:\Program Files
(x86)\Ektron\CMS400vxx\Utilities\SOFTWARE\SecurityConfigurator.
12. Click Apply.
NOTE: Ektron Windows Services stop and restart at this point.
13. Repeat Step 7 through 11 for the second site.
Now that both sites’ security certificates are configured, continue from Part 3: Connect Local
and Remote Servers on page 1487.

Scenario 2: Synchronizing a Local Server with a
Remote Server
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To sync a local to a remote server, install a minimal Ektron site to a new, remote server.
Next, use eSync to upload your Ektron site from the local to the remote server. After the you
complete the initial and template syncs explained in this chapter, the 2 sites are mirror
images of each other.
Follow these steps to configure 2 servers to sync with each other.
PREREQUISITE
See Prerequisites for Using eSync on page 1475
Here’s a preview of the steps you will follow.
l

Part 1: Set up a Min Site on the Remote Server below

l

Part 2: Generate and Copy Security Certificates below

l

Part 3: Connect Local and Remote Servers on page 1487

l

Part 4: Upload the Local Server’s Database and Resources to the Remote Server on
page 1488

l

Minimizing the Time of the Initial Sync on page 1490

l

Part 5: Upload Local Server’s Templates to Remote Server on page 1491

Part 1: Set up a Min Site on the Remote Server
1. Upgrade the local server to the latest version of Ektron if necessary.
2. On the remote server, install a minimum Ektron site whose version matches the local
server by running the Ektron base installation file (CMS400Base8x.exe). For more
information, see System Requirements.
IMPORTANT: Install both sites to a physical folder relative to the root folder. Do not install one site
to a physical folder relative to the root folder and the other site to a virtual directory.
3. If the local site is pre-compiled, you must also pre-compile the remote site.

Part 2: Generate and Copy Security Certificates
Security certificates authorize file synchronization between servers. In this part, you
generate security certificates on the local server, then copy them to the remote.
IMPORTANT: Near the end of the installation procedure, you are prompted to generate security
certificates. If you completed that screen, skip steps 2 through 6.

1. Sign on to the local server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
2. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
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The following screen appears.

3. At the Web Site Description field, select the website on the local server.
4. Click Generate.
5. Click Yes. The certificates are created on the local server.
NOTE: Ektron Windows Services stop and restart at this point.
6. Close the dialog.
7. Open 2 Windows Explorer windows side-by-side: one showing the local server’s file
system, and the other showing the remote server’s file system.
8. In the remote server window, create a folder underneath the root folder. Name the
folder local security certificate.
WARNING! Do not create the new folder under the Web root, C:\inetpub\wwwroot.
9. In the local server window, open the following folder:
32-bit:
C:\ProgramFiles\Ektron\CMS400vxx\Utilities\Software\SecurityConfigurator
64-bit:
C:\ProgramFiles
(x86)\Ektron\CMS400vxx\Utilities\Software\SecurityConfigurator
10. From that folder, copy these files.
l
servername_SyncClient.pfx
l

servername_SyncClient.pvk

l

servername_SyncClient.cer

l

servername_SyncServer.pfx
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l

servername_SyncServer.pvk

l

servername_SyncServer.cer

11. Paste the files into the remote folder you created in Step 8. Make sure there are no other
security files in the folder.
12. Close both windows you opened in Step 7.
NOTE: After copying security certificates to the remote folder, they need to be registered and
moved to the correct folders. The Security Configurator screen does this.
13. Sign on to the remote server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
14. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
The security configurator screen appears.

15. Click Apply Remote Server Certificates.
16. Click Browse next to that field.
17. Browse to the local security certificate folder where you pasted the security
certificates in Step 11.
18. Click Apply.
NOTE: Ektron Windows Services stop and restart at this point.
19. Click Yes to continue.
20. The security configurator copies the certificates you pasted in Step 11 to the correct
folder, and configures them for the remote server.
21. Click OK when you see All sites are now configured for eSync.
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22. Next, generate security certificates on the remote server, then copy them to the local.

To accomplish this, repeat the steps in Part 2: Generate and Copy Security Certificates
on page 1484, but this time, treat the remote server as the local server and vice versa.

Part 3: Connect Local and Remote Servers

WARNING! Back up your database before beginning this procedure.
1. On the local server, sign on to the Workarea > Settings > Configuration >
Synchronization > Profiles. The View All Synchronization Configurations screen
appears.

2. Click Create Synchronization Server Relationship. This screen appears.

3. At the Remote Server field, enter the remote server name. The remote server appears
in the Choose Certificate field.
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4. Click Connect. A screen shows the remote server's databases.

5. Click the database with which you want to sync then Next. A screen appears, showing
both servers.
6. Click Switch Synchronization Direction. The screen indicates that the database will
be uploaded from your local server to the remote server.
7. Click Create. This action connects the local and remote servers.

Part 4: Upload the Local Server’s Database and Resources
to the Remote Server

NOTE: If your Ektron has a very large database or number of assets, and you want to reduce the time
required to complete the initial sync, see Minimizing the Time of the Initial Sync on page 1490.
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Part 4: Upload the Local Server’s Database and

1. From the View All Synchronization Configurations screen, click Start Initial Sync (

).

2. The initial sync uploads the local server’s database and resources to the remote server.
A screen tracks the progress.

3. When the sync is finished, Synchronization is Complete appears.
The initial sync creates a default database profile. The profile remembers sync
information, such as source and destination databases, sync direction, and items to
synchronize. You can reuse this profile to sync database/resource files in the future.
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Minimizing the Time of the Initial Sync
Use the following procedures if you have a large database or number of assets and want to
minimize the time to complete an initial sync. In both cases, you use a tool other than eSync
for the initial copy. From then on, use eSync to sync your servers.

Copying the Initial Database
To quickly copy a database between servers:
1. On your Ektron server, open the folder C:\Program Files
(x86)\Ektron\EktronWindowsService40.
2. Open Ektron.ASM.Services40.exe.config.
3. Set the <add key="skipDataSyncChanges"> element to true.
4. Restart the Ektron Windows Service.
5. Back up the database of the local server.
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Copying Initial Assets

6. Restore that backup to the remote server.
7. Run an initial sync.
8. Restart the Ektron Windows Service.
9. Update your license key.
For example, if the original database is backed up from staging and restored on
production, the license key in the database may be for the Staging.abc.com domain.
But, on the production server, you need a production domain key, such as abc.com. See
Also: License Keys on page 10
10. Change the <add key="skipDataSyncChanges"> element to false.

Copying Initial Assets
Assets consist of files in these folders:
l

siteroot/assets

l

siteroot/privateassets

l

siteroot/uploadedfiles

l

siteroot/uploadedimages

l

C:/assetlibrary

If your Ektron has a large number of assets, you may want to reduce the initial sync time. To
copy asset files between servers quickly:
1. On your Ektron server, open C:\Program Files
(x86)\Ektron\EktronWindowsService40\Ektron.ASM.Services40.exe.config.
2. Set the <add key="skipFileSyncChanges"> element to true.
3. Restart the Ektron Windows Service.
4. Using Windows Explorer, copy the folders listed above from the local to the
corresponding folders on the remote server.
5. Run an initial sync.
6. Change the <add key="skipFileSyncChanges"> element back to false.
7. Restart the Ektron Windows Service.

Part 5: Upload Local Server’s Templates to Remote Server

1. From the View All Synchronization Configurations screen, click Add Sync Profile (
The Add Synchronization Profile screen appears.

).
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2. At the Synchronization name field, give this profile a name, such as Local - Remote
Template Sync.
3. At the Items to Synchronize field, select Template.
4. Check bin to include dlls and assembly changes.
5. For Synchronization Direction, choose Upload.
6. For Schedule, choose None.
7. Save the profile.
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Scenario 3: Setting up a Development > Staging >

8. Click Sync (

) to the right of the template profile.

9. A screen tracks the sync’s progress. When it is complete, Synchronization is
Complete appears. You can use the template profile to sync templates in the future.

Scenario 3: Setting up a Development > Staging >
Production Environment
Before

>After

In this scenario, Ektron initially resides on one server. Consider that your production server
and use it to initialize the staging and development servers.
NOTE: In this scenario, you cannot sync between the development and production servers. The sync can
only be run between Development and Staging or Staging and Production.
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Here’s a preview of the steps you will follow.
l

Part 1: Set up Min Site on the Staging and Development Servers below

l

Part 2: Generate and Copy Security Certificates below

l

Part 3: Connect Staging and Production Servers on page 1501

l

Part 4: Download Production Server Database to Staging Server on page 1502

l

Part 5: Download the Production Server’s Templates to Staging on page 1504

l

Part 6: Connect Development and Staging Servers on page 1506

l

Part 7: Download Staging Server Database to Development Server on page 1508

l

Part 8: Download Staging Server Templates to Development on page 1509

PREREQUISITE
See Prerequisites for Using eSync on page 1475

Part 1: Set up Min Site on the Staging and Development
Servers
1. Upgrade your server to the current version of Ektron if necessary.
2. Install a minimum site on the staging and development servers by running the Ektron
base installation file (CMS400Base8x.exe). See System Requirements.
IMPORTANT: Install both sites to a physical folder relative to the root folder. Do not install one site
to a physical folder relative to root and the other sites to virtual directories.

Part 2: Generate and Copy Security Certificates
Security certificates authorize synchronization between servers. In an eSync relationship,
every server needs a security certificate from every other server, as shown below.

To generate and copy these certificates:
l

1494

2a. Generate Certificates on Production and Copy to Staging and Development on the
facing page

Ektron Reference

2a. Generate Certificates on Production and Copy

l

l

2b. Generate Certificates on Staging and Copy to Development and Production on
page 1497
2c. Generate Certificates on Development and Copy to Staging and Production on
page 1499

2a. Generate Certificates on Production and Copy to Staging and
Development
IMPORTANT: Near the end of the installation procedure, you are prompted to generate security
certificates. If you completed that screen, skip steps 2 through 4.

1. Sign on to the production server using the credentials of the service account used by
Ektron Windows Service 4.0 and your site's AppPool.
2. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
The following screen appears.
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3. In the Web Site Description field, select the production server website.
4. Click Generate. The certificates are created on the production server.
5. Open 2 Windows Explorer windows: one showing the production server’s file system, and
the other showing the staging server’s file system.
6. In the staging server window, create a folder underneath the root folder. Name the
folder Prod security certificates.
WARNING! Do not create the new folder under the Web root, C:\inetpub\wwwroot.
7. In the production server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400vxx\Utilities\Software\SecurityConfigurator.
8. From that folder, copy these files.
l
servername_SyncClient.pfx
l

servername_SyncClient.pvk

l

servername_SyncClient.cer

l

servername_SyncServer.pfx

l

servername_SyncServer.pvk

l

servername_SyncServer.cer

9. Paste the files into the folder you created in Step 6. Make sure there are no other
security files in the folder.
10. Close both windows.
After copying security certificate files to the staging folder, they need to be registered
and moved to the correct folders. The Security Configurator screen does this.
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2b. Generate Certificates on Staging and Copy to

11. Sign on to the staging server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
12. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
The security configurator screen appears.
13. Click Apply Remote Server Certificates.
14. Click the browse button next to that field.
15. Browse to the folder to which you pasted the security certificates in Step 9.
16. Click Apply. The security configurator copies the certificates you pasted in Step 9 to the
correct folder, and configures them for the staging server.
17. Follow the same procedure to move production certificates to the development server.
To do this, begin at Step 6 and follow all steps. Wherever the instructions mention a
staging server, substitute the development server.

2b. Generate Certificates on Staging and Copy to Development and
Production

1. Sign on to the staging server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
IMPORTANT: Near the end of the installation procedure, you are prompted to generate security
certificates. If you completed that screen, skip steps 2 through 4.
2. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
The following screen appears.
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3. At the Web Site Description field, select the staging server website.
4. Click Generate. The certificates are created on the staging server.
5. Open 2 Windows Explorer windows: one showing the staging server’s file system, and
the other showing the production server’s file system.
6. In the production server window, create a folder underneath the root folder. Name the
folder staging security certificates.
WARNING! Do not create the new folder under C:\inetpub\wwwroot.
7. In the staging server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400vxx\Utilities\Software\SecurityConfigurator.
8. Copy these files.
l
servername_SyncClient.pfx
l

servername_SyncClient.pvk

l

servername_SyncClient.cer

l

servername_SyncServer.pfx

l

servername_SyncServer.pvk

l

servername_SyncServer.cer

9. Paste the files into the folder you created in Step 6. Make sure there are no other
security files in the folder.
10. Close both windows opened in Step 5.
NOTE: After copying the security certificate files to the production folder, they need to be registered
and moved to the correct folders. The Security Configurator screen does this.
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2c. Generate Certificates on Development and

11. Sign on to the production server using the credentials of the service account used by
Ektron Windows Service 4.0 and your site's AppPool.
12. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
The security configurator screen appears.
13. Click Apply Remote Server Certificates.
14. Click the browse button next to that field.
15. Browse to the folder to which you pasted the security certificates in Step 9.
16. Click Apply. The security configurator copies the certificates you pasted in Step 9 to the
correct folder, and configures them for the production server.
17. Follow the same procedure to move staging certificates to the development server. To
do this, begin at Step 6 and follow all steps. Where the instructions mention a production
server, substitute the development server.

2c. Generate Certificates on Development and Copy to Staging and
Production

1. Sign on to the development server using the credentials of the service account used by
Ektron Windows Service 4.0 and your site's AppPool.
IMPORTANT: Near the end of the installation procedure, you are prompted to generate security
certificates. If you completed that screen, skip steps 2 through 4.
2. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
The following screen appears.
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3. At the Web Site Description field, select the website on the development server.
4. Click Generate. The certificates are created on the development server.
5. Open 2 Windows Explorer windows: one showing the development server’s file system,
and the other showing the staging server’s file system.
6. In the staging server window, create a folder underneath the root folder. Name the
folder Dev security certificates.
WARNING! Do not create the new folder under C:\inetpub\wwwroot.
7. In the development server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400vxx\Utilities\Software\SecurityConfigurator.
8. Copy these files.
l
servername_SyncClient.pfx
l

servername_SyncClient.pvk

l

servername_SyncClient.cer

l

servername_SyncServer.pfx

l

servername_SyncServer.pvk

l

servername_SyncServer.cer

9. Paste the files into the staging server folder you created in Step 6. Make sure there are
no other security files in the folder.
10. Close both windows you opened in Step 5.
11. After copying the security certificate files to the staging folder, they need to be
registered and moved to the correct folders. The Security Configurator screen does this.
12. Sign on to the staging server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
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Part 3: Connect Staging and Production Servers

13. Click the Windows Start button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator. Right click and choose Run As Administrator.
The following screen appears.
14. Click Apply Remote Server Certificates.
15. Click the browse button next to that field.
16. Browse to the folder you created in Step 6.
17. Click Apply.
18. The security configurator copies the certificates you pasted in Step 9 to the correct
folder, and configures them for the staging server.
19. Follow the same procedure to move development certificates to the production server.
To do this, begin at Step 6 and follow all steps. Wherever the instructions mention a
staging server, substitute the production server.

Part 3: Connect Staging and Production Servers

WARNING! Back up your database before beginning this procedure!
1. On the staging server, sign on to Ektron.
2. In the Workarea, go to Settings > Configuration > Synchronization> Profiles.
The View All Synchronization Configurations screen appears.

3. Click Create Synchronization Server Relationship. That screen appears.

4. In the Remote Server field, enter the production server.
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5. In the Choose Certificate field, the name of the production server appears.
6. Click Connect. This action connects the staging with the production server. A new
screen appears showing the production server's database.

7. Click Next. A new screen appears, showing both servers.

8. Click Create. This action connects the staging and production servers.

Part 4: Download Production Server Database to Staging
Server
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Part 4: Download Production Server Database to

NOTE: If your Ektron has a very large database or number of assets, and you want to reduce the initial
sync time, see Minimizing the Time of the Initial Sync on page 1490
1. From the View All Synchronization Configurations screen, click Start Initial Sync (

).

2. The initial sync downloads the production server’s database and resources to the staging
server. A screen tracks progress.

3. Synchronization is Complete appears.
The initial sync creates a default database profile. The profile remembers information
about the sync, such as the source and destination databases, sync direction, and which
database and resource files are synched. You can use the profile to run
database/resource syncs in the future.
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Part 5: Download the Production Server’s Templates to
Staging
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Part 5: Download the Production Server’s

1. From the View All Synchronization Configurations screen, click Add Sync Profile (
The Add Synchronization Profile screen appears.

).

2. At the Synchronization name field, give this profile a name, such as Prod - Staging
Template Sync.
3. At the Items to Synchronize field, select Template.
4. Check bin to include dlls and assembly changes.
5. For Direction, choose Download.
6. For Schedule, choose None.

7. Save the profile.
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1505

Synchronizing Servers Using eSync

8. Click Sync (

) to the right of the profile. A screen tracks the sync’s progress.

9. When the sync is complete, Synchronization is Complete appears. You can reuse the
template sync profile in the future.

Part 6: Connect Development and Staging Servers

1. Sign on to Ektron development server.
2. In the Workarea, go to Settings > Configuration > Synchronization> Profiles.
The View All Synchronization Configurations screen appears.

3. Click Add (

1506
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Part 6: Connect Development and Staging Servers

4. At the Remote Server field, enter the name of the staging server.
5. At the Choose Certificate field, the name of the staging server appears.
6. Click Connect. This action connects the development with the staging server. After you
connect to the staging server, a new screen appears showing its database.

7. Click Next. A new screen appears, showing both servers.
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8. Click Create. This action connects the development and staging servers.

Part 7: Download Staging Server Database to Development
Server

NOTE: If your Ektron has a very large database or number of assets, and you want to reduce the initial
sync time, see Minimizing the Time of the Initial Sync on page 1490.
1. From the View All Synchronization Configurations screen, click Start Initial Sync (

).

The initial sync downloads the staging server’s database and resources to the
development server. A screen tracks the sync’s progress.

2. When the sync is complete, Synchronization is Complete appears.
The initial sync also creates a default database profile. The profile remembers
information about the sync, such as the source and destination databases, sync
direction, and the fact that it syncs the database and resource files (see example below).
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Part 8: Download Staging Server Templates to

You can reuse this profile to sync the database/resources between these 2 servers at
any time in the future.

Part 8: Download Staging Server Templates to Development
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1. From the View All Synchronization Configurations screen, click AddProfile (
Add Synchronization Profile screen appears.

). The

2. At the Name field, give this profile a name, such as Staging-Dev Template Sync.
3. At the Items to Synchronize field, select Template.
4. Check bin to include dlls and assembly changes.
5. For Direction, choose Download.
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Part 8: Download Staging Server Templates to

6. For Schedule, choose None.

7. Save the profile.
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8. Click Sync (

) to the right of the profile. A screen tracks the sync’s progress.

9. When the sync is complete, Synchronization is Complete appears. You can reuse the
profile to sync templates in the future.

Setting up eSync Profiles
To minimize data entry, eSync saves an job specifications in a profile. After you enter
specifications once, select the profile when you want to sync using the same details. A profile
contains the following information:
l

source and destination databases

l

type of data being synched

l

files to include/exclude

l

direction

l

schedule

Use the Add/Edit Synchronization Profile screen to manage eSync profiles.
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Setting up eSync Profiles

While Setting Up eSync on page 1475, you created a default database and a template profile.
This section explains how to modify those profiles and create new ones.
To sync a website, you need at least 2 profiles: one for the siteroot/Workarea folder, and
another for all other site files. To create a profile for
l
l

your Workarea folder, check Items to Synchronize > Workarea
all other site files, check Items to Synchronize > Database/Resources, Template,
and bin

The following list explains which files are synched by each grouping under Items to
Synchronize.
l

Database/Resources—Synchronizes database tables plus the following site root
folders. See Also: Setting up a Profile to Sync a Database on the next page.
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o

assets

o

PrivateAssets

o

uploadedimages

o

uploadedfiles

Workarea—Synchronizes files in the site’s Workarea folder. See Also: Setting up a
Profile to Sync Workarea Files on page 1517

l

Template—Synchronizes files in the site root folder. See Also: Setting up a Profile to
Sync Template and Bin Files on page 1518

l

IMPORTANT: If you run a template sync and Bin is checked, and one server is running is 32-bit
mode while the other is running in 64-bit mode, users will not be able to drag and drop DMS files on
the staging server.
NOTE: If you perform an initial sync of a recently-installed min site with your staging site, the min
site’s templates could overwrite templates on your staging site. This is because, when 2 templates
have the same name, the most recently-modified one overwrites the other.
To avoid this, rename the only template installed with the min site (login.aspx) before performing the
initial template sync. You should also rename login.aspx’s supporting files, such as login.aspx.vb.
Bin—Synchronizes the siteroot/bin folder, including DLLs and assemblies.

l

The following file types are not synched by default.
l

.config files

l

.txt files

l

.sln files

You may add these file types to a Workarea or Template profile via the Include/Exclude
Files field.

Setting up a Profile to Sync a Database
PREREQUISITES
l

l

You created a Sync relationship and ran an initial sync. See Also: Setting Up
eSync on page 1475.
If your profile is based on an eSync package, it has been set up. See Also:
Synchronizing a Package on page 1542.

To set up a profile:
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Setting up a Profile to Sync a Database

1. Go to the Settings > Configuration > Synchronization > Profiles screen.

2. Click Add Sync Profile (

). The Add Synchronization Profile screen appears.

3. At the Name field, enter a name for this profile.
4. At the Profile Type field, choose Scope or Local Package.
l
To define a Scope, continue through the steps below.
l

To define a Local Package, see Synchronizing a Package on page 1542. After
selecting the package, you still choose a Synchronization Direction, Conflict
Resolution Policy, and a Schedule.

5. At the Items to Synchronize field, select Database/Resources.
The following list describes the database scope filter checkboxes.
NOTE: The Include/Exclude Files field is available only for Workarea, Template, or bin syncs.
Use these checkboxes to choose groups of database tables. You must choose one scope
if you check Database/Resources.
NOTE: Click any label under Database/Resources to see the database tables synched by that
scope.

l

CMS Core—essential Ektron tables; includes Targeted Content rules

l

Workflow(eCommerce)—eCommerce event history

l

l

History—content history. Lets users on the destination server review content
changes (edited, published, and so on).
ASP.NET—Microsoft .Net ASP provider
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l

l

l

l

Search—tables to support search functionality:
o Using Synonym Sets on page 945
o

Providing Suggested Results on page 952

o

Including External Files in Your Search on page 946

Custom—Custom tables (if defined) See Also: Synchronizing Custom SQL Database
Tables on page 1540.
Notification—Notification activities See Also: Sending Notifications to a
Community on page 1194.
User Generated Content—Content created by membership users and other site
visitors. For example:
o A membership user logs in and creates a new account
o

A site visitor rates content

o

Community members reply to forum questions and blog posts

o

A Community member creates a community folder

Whenever user-generated content is synched, the profile of the user who created
the content is also synched.
User-generated content is a subset of CMS Core, so you would not choose both for
the same sync. But you may select user-generated content with any other scope.
When you set up a sync profile for user-generated content, you typically choose
Bidirectional as the direction. In this case, if a membership user updates his or
her profile on the production server, eSync copies the changes to staging. On the
other hand, if your administrator changes that information on staging, the next
eSync copies it from staging to production.
NOTE: Since notifications are part of the User Communities feature, they are automatically
checked if you check User Generated Content.
6. For the Include/Exclude files field, see Include/Exclude Files Field on the facing page.
7. At the Synchronization Direction field, select the direction of the copy. Your choices
are:
l
Bidirectional—Changed data on either server is updated on the other. If the same
data (for example, a membership user profile) is updated on both servers, the
conflict resolution policy determines the outcome. See Also: Choosing a
Bidirectional Sync on page 1520.
l

l

Upload—database copied from the local server (the one to which you signed on) to
the remote server (specified at the Remote Site field above). Items on the remote
server are overwritten.
Download—database copied from remote to local server. Items on the local server
are overwritten.

8. At the Conflict Resolution Policy field, decide what to do if Synchronization Direction
is Bidirectional, and the same data changed on both servers since the last sync. Your
choices are:
l
Version on Remote Site Wins—the remote version overwrites the local version
l
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Setting up a Profile to Sync Workarea Files

9. If desired, select a schedule on which sync runs automatically. The choices are
l
None—Don’t set up a schedule. Sync as needed via the Sync Profile screen‘s Sync
Now button.
l

One Time—specify a start time and date. The profile runs once at that date/time.

l

Hourly—specify a start minute. The profile runs every hour at this minute.

l

Daily—specify a start time. The profile runs every day at this time.

l

l

Weekly—specify a start time and weekday. The profile runs on this day every
week at this time.
Monthly—specify a start time and calendar day (numbers 1 through 31). After the
start date, the profile runs on this day every month at this time.
NOTE: If you enter a date greater than 28, the sync will not run in a month that does not
include that date. For example, if you enter 31, the sync will not run in February, April, June,
September, and November.

Setting up a Profile to Sync Workarea Files
Setting up a profile to sync Workarea files is the same as Setting up a Profile to Sync a
Database on page 1514 with the following exceptions:
l
l

At the Items to Synchronize field, select Workarea.
You may use the Include/Exclude Files field to refine the files to be synched. See
Also: Include/Exclude Files Field below

Include/Exclude Files Field
Use the Include/Exclude Files field to include files not normally synched, or exclude files
or directories that are synched by default. This screen section is active only if you choose a
Template or Workarea sync and no Database/Resources scopes.
NOTE: By default, eSync ignores .config and .txt files.
For example, .txt files are not normally synched, but you want to sync several of them. In
this case, check Include and enter *.txt into the Files field.
Examples of the Exclude Files option:
l

l

you do not want to sync Flash (.swf) files. If you check the Exclude button, and enter
.swf into the Files field, eSync ignores them.
you do not want to sync files in the widgets folder. If you check the Exclude button, and
enter widgets into the Directories field, eSync ignores them.

You can exclude file types and directories. eSync ignores files that satisfy either criterion.

Files Excluded from the Workarea Sync
Workarea synchronizes all files in the site’s Workarea folder, except files in these
subfolders:
l

ewebeditpro

l

explorer

l

ewebdiff

l

foundation
Ektron 8.7
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l

resources

l

sync

Setting up a Profile to Sync Template and Bin Files
Setting up a profile to sync Workarea files is the same as Setting up a Profile to Sync a
Database on page 1514 with the following exceptions:
l

At the Items to Synchronize field, under Files, select Templates and Bin.

l

You may use the Include/Exclude Files field to refine the list of files to be synched.

Regardless of how you complete the Include/Exclude Files field, the following siteroot
folders are not synched:
l

App_GlobalResources

l

App_WebReferences

l

Workarea

l

assetlibrary

l

assets, privateassets, uploadedfiles, uploadedimages (individual checkboxes under
Files)

l

latestchanges

l

app_webreferences

l

app_globalresources

Choosing Files and File Types via Include/Exclude Files
Within a template/bin sync's folders, you can select individual files. For example, you
updated template files and related .css files on the staging server, and want to update the
production server without moving everything else.
After saving the profile, click Synchronize files ( ) from the View Profiles screen to access
the Sync Files screen. Here, you can select individual files. If you included files types, only
they are available for selection. If you excluded file types or directories, they are
unavailable.
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Previewing a Sync Profile

IMPORTANT: If you select one or more files on the Sync Files screen, the profile includes only those
files. If you select no files, the profile includes all files indicated by your responses to the
Include/Exclude Files field.

Previewing a Sync Profile
Before running a sync profile, you can view what will be synched. To do this, click Sync
Preview.

Ektron recommends this feature to help confirm that tables, assets, private assets, uploaded
files, uploaded images and assetlibrary files that you delete, add, or change will be synched
between servers as you expect. Also, you can predict how long a sync will take, because the
preview takes the same amount of time.
The Sync Preview produces Sync Log files. See Also: Viewing eSync Activity on page 1546
NOTE: You cannot preview a sync profile that includes only Workarea files.

Pausing the Sync Schedule
If a sync profile runs on a schedule, you can pause it by clicking the profile's pause/play
button.

While paused, the sync will not run. To resume the schedule, click the pause/play button
again.
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For example, a sync is scheduled to run every hour @ :50: 1:50, 2:50, 3:50, and so on. At
10:30 a.m., you pause the sync profile. So, at 10:50 a.m., the sync does not run. At 12:00
noon, you click the pause/play button again. The next sync starts at 12:50 p.m.

Choosing a Bidirectional Sync
Although most Ektron data is created and updated on the staging server, some data is
collected on the production server. This information can be viewed and edited on the staging
server. Here are some examples:
l

membership users

l

content ratings

l

forum and blog posts

l

community folders

When you set up a profile to sync this kind of data (maintained in the database), you typically
choose Bidirectional as the direction, and Notifications and User Generated Content
under Database/Resources. So, if a membership user updates his or her profile on the
production server, eSync copies the changes to staging. On the other hand, if your
administrator changes that information on staging, the next eSync copies it from staging to
production.
If the same file on both servers was updated since the last sync, your conflict resolution
policy determines which data is saved.
NOTE: The first time you run a sync for templates or Workarea files, the sync is bidirectional, regardless
of the direction you specify on the Synchronization Direction screen.
If you are using a bidirectional sync, and the same item changed on both servers since the
last sync, eSync must decide which version to keep, and which version to overwrite.
NOTE: If you use bidirectional sync and only one version was updated since the last sync, the updated
version overwrites the unchanged version.
Use the Synchronization Profile screen's Conflict Resolution Policy field to determine
which version ends up on both servers after synchronization. The choices are:
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l

Version on Remote Site Wins—the remote version overwrites the local

l

Version on Local Site Wins—the local version overwrites the remote

Managing eSync Security Certificates
eSync uses security certificates to secure communication between servers. All servers in an
eSync relationship must have matching, encrypted security certificates to establish an eSync
relationship.
NOTE: If your relationship includes separate database servers, you do not need to install security
certificates on them. You only need to install certificates on servers that host Ektron.
This section also contains the following topics.
Viewing Security Certificates
Installing Security Certificates
Step 1: Create Security Certificates on Your Local Server
Step 2: Create Security Certificates on the Remote Server
Step 3: Copy Local Client Certificate to Remote Server
Step 4: Copy Remote Client Certificate to Local Server
Step 5: Test the Security Certificates
Regenerating Security Certificates
Troubleshooting Security Certificates
Could Not Connect Error
No Endpoint Error
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See Also: Create eSync Security Certificates for a Load Balanced Cluster on page 1558
Before you can establish an eSync relationship between servers, each server must have its
own (local) security certificates and certificates from every other server in the relationship.

As another example, if an eSync relationship consists of 5 servers, each server requires 5
security certificates: one local and 4 remote.
Each server creates 2 certificates: a server and a client. Then, you copy the client certificate
to the other servers in the relationship. The local machine’s server certificate must match a
client certificate on the remote server, and vice versa.
You typically copy certificates only when establishing an eSync relationship between servers.
After that, any eSync activity triggers a background check, and you can only proceed if
certificates match.
Each certificate consists of these files.
l

l

Server certificate
o servername_SyncServer.pfx
o

servername_SyncServer.pvk

o

servername_SyncServer.cer

Client certificate
o servername_SyncClient.pfx
o

servername_SyncClient.pvk

o

servername_SyncClient.cer

The security certificates can apply to one site or all sites on a server. You determine this
when installing them.

Viewing Security Certificates
Use Certificate Manager to view security certificates installed on your server. Check marks
indicate the certificates. You can also delete all certificates for a server.
NOTE: You can only remove certificates from remote servers. You cannot remove them from the server
to which you are logged in.
To view (and delete) certificates:
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Installing Security Certificates

1. Right click Start > Program Files > Ektron > CMS400vxx > Utilities > Security
Configurator > right click and choose Run as Administrator.
2. Click Manage Certs. Your server's security certificates appear.

3. To remove a remote server's certificates, select that row and click Remove.

Installing Security Certificates
PREREQUISITE
Permission to copy and paste files between local and remote servers
To create and place eSync security certificates in the correct locations:
l

Step 1: Create Security Certificates on Your Local Server below

l

Step 2: Create Security Certificates on the Remote Server on page 1525

l

Step 3: Copy Local Client Certificate to Remote Server on page 1525

l

Step 4: Copy Remote Client Certificate to Local Server on page 1527

l

Step 5: Test the Security Certificates on page 1528

Step 1: Create Security Certificates on Your Local Server
1. Log on using the credentials of the service account used by Ektron Windows Service 4.0
and your site's AppPool.
2. During the Ektron installation, you are asked if you want to install eSync security
certificates. The eSync checkbox (second from the top) is only accessible if your license
key contains an eSync modifier.
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3. If you check eSync, near the end of installation, the following screen prompts you to
create the certificates.
NOTE: You can access this screen at any time screen by clicking the Windows Start button > All
programs > Ektron > CMS400 v8x > Utilities > Security Configurator > right click and choose
Run as Administrator.
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Step 2: Create Security Certificates on the Remote

4. Use the following information to understand this screen.
l
Generate Certificates—Use this screen area to create security certificates that
must be copied to a remote server with which you want to sync.
l

l

Site Name—If more than one site is installed on this server, use the pull-down list
to select the website for which you are installing security certificates. Or, click All
to apply certificates to all sites on the server.
Apply Remote Server Certificates—Use this screen area to apply security
certificates that were copied from a remote server to your local server. See Also:
Step 3: Copy Local Client Certificate to Remote Server below

5. Click Generate.
6. Local security certificates are created and configured.

NOTE: Only click Generate once. The status field at the bottom of the screen updates as it
progresses. If you click OK more than once, you delay the certificates’ creation.

Step 2: Create Security Certificates on the Remote Server
1. Sign on to the remote server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
2. Generate security certificates for the remote server, following instructions in Step 1:
Create Security Certificates on Your Local Server on page 1523.

Step 3: Copy Local Client Certificate to Remote Server
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1. On the local server, open 2 Windows Explorer windows: one showing the local server’s
file system, and the other showing the remote server’s file system.
2. On the remote server window, create a folder underneath the root folder. The folder
name is not important.
IMPORTANT: Do not create the folder under the Web root folder, for example
C:\inetpub\wwwroot.
3. In the local server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400vxx\Utilities\Software\SecurityConfigurator.
4. Copy the following files.
l
servername_SyncClient.pfx
l

servername_SyncClient.pvk

l

servername_SyncClient.cer

l

servername_SyncServer.pfx

l

servername_SyncServer.pvk

l

servername_SyncServer.cer

NOTE: These files were created when you completed the eSync Security Configurator Screen in
Step 1.
5. Paste the files to the remote server folder that you created in Step 2. Make sure there
are no other security files in the folder.
After you copy the local server’s security certificates to the remote server, they need to
be registered and moved to the correct folders. The Security Configurator screen does
this.
6. Log into the remote server, using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
7. Open the security configurator screen using this path: Windows Start Button > All
programs > Ektron > CMS400 v8x > Utilities > Security Configurator > right
click and choose Run as Administrator.
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Step 4: Copy Remote Client Certificate to Local

8. The security configurator screen appears.

9. Click Apply Remote Server Certificates (circled above).
10. Click the browse button next to that field.
11. Browse to the folder to which you pasted the security certificates in Step 5.
12. Click Apply.
13. The utility copies the security certificates you pasted in Step 5 to the correct folder, and
configures them for the remote server.

Step 4: Copy Remote Client Certificate to Local Server
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1. Sign on to the remote server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
2. Follow the steps described in Step 3: Copy Local Client Certificate to Remote Server on
page 1525, except substitute remote for local.

Step 5: Test the Security Certificates
1. From the local server, sign on to Ektron using the credentials of the service account used
by Ektron Windows Service 4.0 and your site's AppPool.
2. In the Workarea, go to Settings > Configuration > Synchronization> Profiles.
3. Click Create Synchronization Server Configuration.
4. Enter the name of the Remote Server.
5. Select the security certificate you are testing.
6. Click Connect. If the next screen appears, the security certificates are working
properly.

Regenerating Security Certificates
Follow these steps to regenerate security certificates. You would do this if they stop working,
or you are concerned about a security breach.
1. Log into the Ektron server using the credentials of the service account used by Ektron
Windows Service 4.0 and your site's AppPool.
2. Access the eSync Security Configurator screen via Windows Start Button > All
programs > Ektron > CMS400 v8x > Utilities > Security Configurator > right
click and choose Run as Administrator.
3. Use the Web Site Description field to select a site on your server, or choose All sites.
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4. Check the Discard Existing Keys box (circled below).

5. Click Generate. Security certificates are removed from your local server.
6. Reopen the Security Configurator screen.
7. Choose the correct website, verify the other settings, and click Generate. See Also:
Step 1: Create Security Certificates on Your Local Server on page 1523. This action
creates new security certificates on your server.
8. Copy the new certificates to all other servers in the eSync relationship. This is explained
in Step 3: Copy Local Client Certificate to Remote Server on page 1525.

Troubleshooting Security Certificates
Could Not Connect Error
When trying to connect to a remote server, after selecting a security certificate, you may see
the following message.

Ektron 8.7

1529

Synchronizing Servers Using eSync

To resolve the problem:
l

l

Check the Windows Event Viewer > EktronL2 log for the error. If the service is hosted
but already exists, stop then start the service (do not restart).
The certificates may be corrupted. To resolve this, see Regenerating Security
Certificates on page 1528.

No Endpoint Error
The following error indicates that
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l

the remote site may not be on the same Ektron version as the local site, or

l

the Ektron Windows Service is not started
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Specifying eSync Settings
The eSync Settings screen lets you define many eSync settings.
Workarea > Configuration > Synchronization > Settings.

l

l

l

Maximum configured memory for an eSync session (kb)—Define a maximum
amount of memory that your server uses during a sync. The default is 32 MB. You can
change it to any size up to the amount of RAM in your eSync server.
Remote SQL connection type—Data sync runs in one of 3 contexts: Direct, Proxy, or
Auto detect.
o Auto detect: Try to connect using TCP. If successful, the mode is switched to direct.
Otherwise, the mode is proxy. Auto detect is the default.
o

Proxy: Use Windows Communication Foundation (WCF) service.

o

Direct: Direct SQL Connection (direct TCP connection used instead of WCF
connection)

Application transaction size—This value is typically the same as Maximum
configured memory for an eSync session. The commit occurs after the data
reaches this size.
Ektron 8.7
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l

Encrypt scripts—If you check this box, all stored procedures and triggers are
encrypted.
The default value is false because Azure does not support encryption. You should only
check this box if you are using eSync in an on-premises environment.

l

l

Backup action, Backup location—Define when you want to run the backup (only
initially or each time) and the backup file location. See Also: Backing up the Destination
Server During an eSync on page 1536
Types of data (for which e-sync collisions will be resolved)—Select data types
for which you want to resolve collisions. See Also: Determining which Collisions are
Resolved on page 1551

Running eSync
IMPORTANT: The names of the site and all folders must match on both servers. This is because paths to
images, xslt files, and so on, refer to a site and its folders. If the servers’ site and folder names do not
match, the links break.
NOTE: You cannot run 2 syncs simultaneously.
This section also contains the following topics.
Optional Steps before Running a Sync
Replacing the File Sync
Adjusting Relationship Settings
Beginning a Sync
Forcing the Initial Sync
Backing up the Destination Server During an eSync

1532
1532
1533
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1535
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Optional Steps before Running a Sync
You may want to adjust the web.config and db.config settings before running a Sync. The
following topics explain eSync features that you control via the .config files.
l

Synchronizing Content and Folders on page 1537

l

Using eSync with Web Alerts on page 1563

l

Using eSync with eCommerce on page 1563

l

Forcing the Initial Sync on page 1535

l

Replacing the File Sync below

l

Synchronizing Servers Using eSync on page 1473

l

Adjusting Relationship Settings on the facing page

Replacing the File Sync
Some Ektron customers prefer a tool other than eSync to sync assets; for example RoboCopy.
To disable eSync's asset sync:
1. On your Ektron server, open C:\Program Files
(x86)\Ektron\EktronWindowsService40\Ektron.ASM.Services40.exe.config.
2. Set the <add key="disableFileSyncProvider"> element to true.
3. Save Ektron.ASM.Services40.exe.config.
1532

4. Restart the Ektron Windows service.
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From now on, eSync will not copy assets. Set up your replacement tool to do that.

Adjusting Relationship Settings
You can modify settings in the Ektron Windows service (EWS) config file (C:\ProgramFiles
(x86)\Ektron\EktronWindowsService40\Ektron.ASM.EktronServices40.exe.config) to
accommodate your preferences. The settings are:
l

l

l

l

l

l

l

l

l

l

l

DebugEnabled—By default, this is set to zero (0). If PDB files are present in the EWS
folder or it is a DEBUG build, this value is set to 1. Setting this value to 2 works as in
version 8.5.
DependencyImageSyncExtensSprtForThumbnls—All valid image file extensions.
This list determines if a content item being synched is an image. If true, a thumbnail is
also synched. If this value is BLANK, no thumbnails are synched while synchronizing
dependent images (including the file sync retry and content dependency sync).
DependencySyncRecursionDepth—The depth of recursion for the content
dependency sync. Zero (0) indicates that all dependencies are evaluated, regardless of
the number of recursions necessary. If you enter a number more than zero, EWS only
evaluates as far as the specified depth.
DownloadFileStreamsInParallel—If this is set to true on a server with more than 1
processor,, then it will download file streams from the remote server in parallel, using
as many threads as specified in MaxNumberOfParallelThreads. Ensure that BOTH the
local and remote server has enough resources to handle normal load if the number of
MaxNNumberOfParallelThreads processors run at 100% CPU.
EnableMetadataEvalInDependencySync—If set to True, metadata evaluation
occurs during the content dependency sync. If set to False, files specified in metadata
are not synched during a content sync. Default value is True.
EnableRecursiveDependencySync—If set to True, recursive dependency sync is
enabled for content sync. This means that if a content's metadata or HTML references
other content blocks, their dependencies are also evaluated and synched. Default value
is True. See Also: Resource Selector on page 476, Creating and Deploying a Related
Content Definition on page 375
EnableSiteFileHashIndexingAtStartup—If set to true AND if
UseFileHashForFolderSyncChangeDetection OR
UseFileHashForFilteredFolderSyncChangeDetection are also true, then the EWS will start
indexing all the files in the site which are synced using file sync, without using high CPU.
This process starts 5 minutes after the service starts.
FileSyncFailureMaxRetries—The maximum number of times the EWS tries to sync a
file that was not synched in the initial try. Default value is 5.
FileSyncFailureSleepBetweenRetriesInSeconds—The time (in seconds) the EWS
"sleeps" before it attempts to retry a failed file sync. Default value is 5.
LoadFileStreamsInParallel—If this is set to true on a server with more than 4
processors, then it will load file streams locally, in parallel, using as many threads as
specified in MaxNumberOfParallelThreads. Ensure that the server has enough resources
to handle normal load if the number of MaxNumberOfParallelThreads> processors run at
100% CPU.
MaxNumberOfParallelThreads—Specifies the maximum number of threads created.
You should increase this value if you have an adequate CPU resources to significantly
improve performance.
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UploadFileStreamsInParallel—If this is set to true on a server with more than 1
processor, then it will upload file streams to the remote server in parallel, using as many
threads as specified in MaxNumberOfParallelThreads. Ensure that BOTH the local and
remote server has enough resources to handle normal load if the number of
MaxNumberOfParallelThreads processors run at 100% CPU.

l

UseFileHashForFilteredFolderSyncChangeDetection—Similar to
UseFileHashForFolderSyncChangeDetection, but used for file syncs where folder sync is
filtered by file name.

l

UseFileHashForFolderSyncChangeDetection—Runs file sync in
CompareFileStreams mode as described here: FileSyncOptions Enumeration

l

This is set to false by default because file hash mode can fail when the file is locked for
reads.
PREREQUISITES FOR RUNNING A SYNC
l
l

l

Prerequisites for Using eSync on page 1475
You created an eSync relationship and profiles. See Setting Up eSync on
page 1475.
You are not signed on to a production server that is outside the firewall. You
cannot sync from a production server outside the firewall to other servers—you
can only sync to this production server.

Beginning a Sync
You can run eSync on a schedule, or on demand. To sync a profile immediately:
1. Go to the Settings > Configuration > Synchronization> Profiles screen.
2. If a profile is ready to sync, a sync button (

3. Click Sync (

) appears in the right column.

).

NOTE: If another sync is running, you are notified. You can only begin a new sync when the current
one finishes.
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4. A screen monitors progress and indicates when the sync is complete.

NOTE: You can close the window and reopen it at any time by clicking Sync (
current status appears.

). If you do, the sync’s

IMPORTANT: If you performed a database sync and the site being synched uses URL aliasing, you must
go to its URL Aliasing Settings screen and click Refresh ( ) to update its aliasing information.

Forcing the Initial Sync
Use the Force Initial Sync button to reinitialize a server that was previously initialized.

Here is an example of when to use Force Initial Sync.
1. You initialized a test server from your current Ektron server.
2. You experimented on the test server by adding new content, deleting content, and so on.
3. You no longer want the test server’s database. Instead, you want to reinitialize the test
server from your current Ektron server.
To accomplish step 3, use the Force Initial Sync button. The button only appears when
all of the following conditions are present.
FORCING INITIAL SYNC CONDITIONS
The Force Initial Sync feature requires these conditions.
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l

The server’s web.config file’s ek_ForceReInit property is set to true.

l

The site is not part of a multi-site relationship.

l

The server has only one sync server relationship.

l

The server is the destination (that is, on the download side) of the sync
server relationship.

The following image illustrates the last 2 conditions.

NOTE: The Force Initial Sync procedure ignores the checks that are normally made prior to
synchronization:
* the destination database is smaller than the source database
* the site has not been previously staged

Backing up the Destination Server During an eSync
You can create a backup of the destination server’s database. If you do and problems occur
during the sync, the database is restored to its pre-backup state. You can specify the backup
to occur on the initial sync only, or every time you sync.
NOTE: No backup is made when you sync a package, folder, content. See Also: Synchronizing Content
and Folders on the facing page, Synchronizing a Package on page 1542
To set up database backup:
1. Go to Workarea > Settings > Synchronization > Settings.
2. At the Backup action field, select an option.
l
Before initial sync—Run backup before the initial sync only.
l

Before each sync—Run backup before each sync.

3. At the Backup location field, enter a local or network path to the folder to which the
backup file will be saved. The user account that runs the Ektron Windows Service must
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have read and write permission to the folder.
4. Click Save.
The backup file format is [dbname][yyyy][mm][dd][hh][mm][ss][mmm].[product].bak.
For example: cms400min20120216075946765.esync.bak.

Synchronizing Content and Folders
This section explains how to sync content and folders using context menu options.

This section also contains the following topics.
Rules Governing Folder and Content Sync
Content Sync
Folder Sync
Synchronizing a Content Item
Synchronizing a Folder

1538
1538
1538
1538
1540

PREREQUISITES FOR CONTENT /FOLDER SYNC
See Also: Prerequisites for Using eSync
l

l

You are a member of the Administrators group or assigned the Synchronization
Admin Role.
Content/folder sync is enabled.
Set up content and folder sync
1. On the server on which content editors will sync content and folders, open
the site root/web.config file.
2. In the following area, set eSyncEnabled to true.
<eSyncSettings>
<!-- Set this key to true to enable content/folder sync if the eSync
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feature is available -->
<add key="eSyncEnabled" value="false"/>
</eSyncSettings>

3. Save.
l

The server has a sync relationship and its initial sync has been run.

Rules governing folder and content sync

Rules Governing Folder and Content Sync
Content Sync
l
l

l

l
l

You can only sync content whose status is Approved.
If you try to sync content, and its folder was created or modified since the last full sync,
you are warned that you must sync the folder before synching the content.
o An example of folder modification is the assignment of a new metadata value.
If new tags or taxonomy categories were added to content since the last full sync, you
must run a folder sync before you can sync that content. You must also run a full sync for
all other sync profiles that use those tags or taxonomy categories. See also: Tagging
Content, Library Items, Users, and Groups with Keywords on page 1245.
Forum posts are not synched.
When you sync a content item, all physical files (DMS assets and library files) in the
content’s folder are also synchronized.

Folder Sync
l

blogs and forum posts are not synched.

Synchronizing a Content Item
Content sync copies selected content to another server. The sync also copies all entities on
which the content is dependent, such as
l
l

l

library resources within that content, such as images and quicklinks
content selector metadata, file selector metadata, image selector metadata See Also:
Creating and Deploying a Related Content Definition on page 375
aliases

NOTE: When you sync one content item, all physical files (DMS assets and library files) in the content’s
folder are also synched.
You can only synchronize Approved content. See Also: Prerequisites for Content/Folder Sync
on the previous page
To sync a content item:
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1. In the Workarea, navigate to the content.
2. Click the arrow to its right to see its drop-down menu.

NOTE: A Synchronize button appears on the View Content screen.

3. Click Synchronize.
4. All profiles whose direction is Upload or Bidirectional appear. Select the appropriate
one.

5. Click Sync Now.
6. The content is synchronized with the selected database.
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Synchronizing a Folder
The folder sync updates all content in a folder with the same folder in another server. It does
not affect content in folders underneath the selected folder.
See Also: Synchronizing Content and Folders on page 1537
To sync a folder:
1. Navigate to the folder.
2. Choose Action > Synchronize Folder. A screen asks you to select a sync profile.

3. Click Start Sync. All content in the folder is synched with the selected database.

Synchronizing Custom SQL Database Tables
You can use eSync to synchronize custom SQL database tables. To do this, you must create
the custom table on all servers. eSync does not create the tables, but will follow rules for
populating records in them.
IMPORTANT: Table names are case sensitive. Names must be identical on all servers.

Adding an Empty Custom Table to your Database on
the Source and Destination Servers
Run the following SQL Query on the database. The table must have a primary key and cannot
use identity columns.
Here is an example of a valid table.
Create table foo3(Id int not null primary key clustered,
Id2 int not null, company nvarchar(50) null)

Here are examples of invalid tables, which incorrectly use identity columns.
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create table foo1(Id int not null identity(1,1) primary key clustered,
company nvarchar(50) null)
create table foo2(Id int not null primary key clustered,
Id2 bigint not null identity(1,1),
company nvarchar(50) null

Adding a Custom Table to an eSync Configuration
NOTE: The Manage Custom Table Configuration button (

) appears only if your database has custom

tables.
To add custom tables to an eSync Configuration, follow these steps on the source server.
1. Go to Workarea > Settings > Configuration > Synchronization> Profiles.
2. Click Manage Custom Table Configuration (
Configurations screen appears.

). The Manage Custom Table

3. Click Edit Custom Table Configuration.
4. Click a custom table from the Available column to select it.
5. Click the right arrow button to move it to the Selected column.
6. Click Save Custom Table Configuration.
After you add a custom table, your eSync profile displays a new Database/Resource scope,
Custom Tables. Select it to sync custom tables.
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Synchronizing a Package
You can group Ektron objects (content, folders, taxonomies, and so on) into a package, which
can be synched at any time. So, you can synchronize these objects without having to run a
complete sync. Advantages of a sync package include:
l

Much quicker than a full sync

l

More granular control over which items are synched

l

Can sync individual items even if their dependencies were modified
NOTE: As described in Prerequisites for Content/Folder Sync on page 1537, eSync's content and
folder sync has restrictions and dependencies. A sync package, on the other hand, includes
modifications to parent objects. So, a package can sync content and folders whether or not a parent
folder’s properties were edited recently.

l

Can sync various object types in a single action

For example, you are developing a new marketing campaign which consists of content in 2
folders, all library files in those folders, and 2 menus. After assembling the items into a sync
package, you can sync it from development to production at any time without affecting other
site files.
For a video tutorial on eSync packages, see eSync Packages (Ektron 8.6.1).
Objects that may be included in a package:
l

Folders

l

Content

l

Library images and files

l

Files within the site root folder and its children (for example, .css and .js files)

l

Taxonomies—includes all assigned categories, content, users, and groups

l

Menus—includes submenus along with content assigned to any menu in the "tree"

l

Collections—includes all assigned content

l

Other package definitions—do not include objects in those packages

Creating a Package
1. Workarea > Settings > Configuration > Synchronization > Packages.
2. Click Create Package.
3. Enter a unique Name and optional Description.
4. Click the tab of objects you want to add to the package.
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5. Check items to include in the package.
Notes on the Packages Screen
l

An item is added to the package as soon as you check it. There is no submit button. Click
Save Package to save all items in a package.

l

To view a package's contents at any time, click the Package Contents tab.

l

When you view a tab, items in the package are checked.

l

The Package Contents tab lists all objects in the package. Use the Show drop-down to
display only objects of a selected type.

o

Use the delete button ( ) to remove items. You can also remove an item by
clicking its tab and unchecking it there.

o

If you choose a taxonomy, menu, or collection, only the top-level object appears on
the Package Contents tab. However, all child objects (taxonomy categories,
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submenus, and so on) and all assigned content, users and groups are synched with
the package.
l

Content and Folders tab lets you select folders or content within them.
IMPORTANT: You cannot select eCommerce catalog folders.

l

l

1544

o

Unlike content sync, content status does not affect your ability to sync it within a
package.

o

If you select a folder, the package includes the folder's content, in all languages,
when the package sync is run.

o

Folder selection is not recursive. So, you must select each child folder.

o

If you view a selected folder, its content is checked and grayed out (see example
below). This indicates that the content's folder is included in the package.

Library tab lets you select library images or files. Do not choose those inserted into
selected content, since they are automatically included.
o All attributes of folders (described in Content and Folders, above) apply to
library folders.
File System tab lets you select files within the siteroot folder and its children.
o Exception: You cannot add these file types to a package: thumbs.db, .cer, .pfx,
.pvk, .refresh, .ekt, .config, .dll, .exe, .metadata, .sln, .svn, .tekt, ._svn, .log,
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metaconfig.doc. They do not appear in the selection grid.
l

Taxonomy tab lets you select top-level taxonomies only. You cannot select categories
within them. By selecting a taxonomy, you also add to the package
o all categories below it
o

all content, users and groups assigned to the taxonomy and its categories

As a taxonomy's content changes, the package automatically includes the current files.
NOTE: If you add a taxonomy to a package, you automatically select all language versions of that
taxonomy.
l

Menus tab lets you select top-level menus only. You cannot select submenus. By
selecting a top-level menu, you also add to the package
o all of its submenus
o

all items assigned to the menu and its submenus: content, library assets,
hyperlinks, and additional submenus

As a menu's content changes, the package automatically includes the current files.
Folders assigned to menus are not synched with them. See Also: Assigning Folders or
Templates to a Menu on page 772
NOTE: If you add a menu to a package, you automatically select all language versions of that
menu.
l

l

l

Collections tab lets you select any collection. By selecting a collection, you also add to
the package all content assigned to it. As a collection's content changes, the package
automatically includes the current files.
Local Packages tab lets you include other package definitions in the package. This lets
you re-use the packages on other servers in your eSync relationship. Other package
definitions do not include objects assigned to them (content, folders, and so on).
Orphan Items tab lists records referenced in a package which, for some reason, are
not in the database.

Synchronizing a Package
To sync a package, add it to a sync profile, then sync the profile.
IMPORTANT: The package sync requires but does not validate identical folder structure on both servers.
You must verify that folder structures on both servers match before beginning a package sync.
PREREQUISITES
One or more eSync packages See Also: Creating a Package on page 1542
1. From the View All Synchronization Configurations screen, click Add Sync Profile (
The Add Synchronization Profile screen appears.

).

2. In the Profile Type field, check Local Package.
3. Use the Select Package drop-down to choose the package.
4. Complete the remaining fields, which are documented in Setting up a Profile to Sync a
Database on page 1514.
5. Click Save Synchronization Profile.
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6. From the View All Synchronization Configurations screen, click the profile.
7. Click Sync Now (

).

Deleting a Package
1. Workarea > Settings > Configuration > Synchronization> Packages.
2. Click Delete in the right column of the package that you want to delete.

Viewing eSync Activity
eSync provides the following logs of sync activity.

Viewing Synchronization Configurations
The View All Synchronization Configurations screen lets you perform the following eSyncrelated activities.

l

l

l

Work with eSync relationships
o Create a new one See Also: Setting Up eSync on page 1475
o

Run the initial sync for one See Also: Initializing a New Site on page 1480

o

View information about

o

Delete

Work with eSync profiles See Also: Setting up eSync Profiles on page 1512
o Create
o

View and edit

o

Sync a profile See Also: Running eSync on page 1532

o

Delete

Review Resolved Collisions

Viewing a Log of a Profile’s Most Recent Sync
You can view a log of any profile’s most recent sync by clicking Get Status (
profile.
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) next to the

Viewing a Log of a Sync Server Relationship’s Most

Get Status (

) appears only for previously-synched profiles.

The sync log is the one that appears upon completing a sync.

Viewing a Log of a Sync Server Relationship’s Most
Recent Sync
You can view a log of a Sync Server Relationship’s most recent sync by clicking Get Status (
) in the header section of the screen.

The sync log appears upon completing a sync.

Viewing a Log of all Syncs for a Sync Server
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Relationship
The View All Synchronization Relationships screen provides a Synchronization Logs button (
) that displays a chronological log of all syncs on your server, with the most recent at the
top.

Click the icon in the Status column to view any sync's details. If the column contains a check
mark, the sync was successful.
If the column contains a warning ( ), the sync failed for some items. If you click the icon, a
screen lists causes for the failure, as shown below. Ektron support can use this log to
troubleshoot the problem.
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Reviewing Collisions
To verify the accuracy of the data being synchronized, eSync may check for and resolve
collisions between the following matching items.
l

user names

l

folder names

l

metadata definitions

l

messages

l

eCommerce products

l

URL aliases

l

tag entries

l

tag statistics

l

taxonomy counts

l

eCommerce price entries

l

multi-site staging URLs

l

menus
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For example, on the staging server, a user creates a folder under the root folder called
Marketing, and a user on the production server does the same.
NOTE: * Folders only match if they have the same name and folder path.
* Both Ektron and membership users are included.
A collision only occurs if both items were entered since the last synchronization.
Although matching items have different ID numbers, their names are the same, so users may
be unable to distinguish them. So, eSync appends a number to the more recently-created
item. For example, the folder Marketing becomes Marketing11329. This is an example of a
resolved collision.
To track resolved collisions, the View All Synchronization Configurations screen has a button (
) that appears only after a collision is resolved. If the eSync direction is a download, the
collision resolution information appears on the local server; if upload, then it appears on the
remote server; if bi-directional, it appears on both servers.

When you click the button, you are asked if you want to review resolved collisions. If you
click Resolve, the following button appears on the toolbar.

Click that button to see the Review Synchronization Collisions screen, showing the original
and changed items.

Reviewing Resolved Collisions
This Review Synchronization Collisions screen shows resolved collisions. Upon viewing it, you
should notify appropriate content authors, who may want rename the object.
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After noting these changes, you can check the box in the left column, then click Mark
Reviewed to remove it.
The Users tab has an additional button, Mark Reviewed and Email. Use it to remove the
user from the screen and send an email to the user (using the address from the Add/Edit User
screen’s E-Mail Address field). The email text is below.
lbl sync collision email subject = Your username has been changed
lbl sync collision email body = For security purposes, your username has been
changed.
Your new username is {0}. You will need to use this new username the next time
you login. Thank you.

NOTE: You can change the text in the resource file. To learn about editing it, see Translating the
Workarea on page 1086.

Determining which Collisions are Resolved
On the eSync Settings screen, use the Types of data field to identify objects for which you
want to resolve collisions. Unchecked items are ignored.
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Ektron recommends disabling the Resolve Collisions during Synchronization boxes for
everyday use, because resources required to search for collisions may negatively impact
your website's performance.
While activity that might cause collisions occurs, you may temporarily enable checkboxes,
then disable them again once the activity is complete.

Using Performance Counters to Monitor the Ektron
Windows Service
You can use the Windows Performance Counter to view the progress of a file sync without
affecting the EWS's performance. You can also use the Performance Counter to debug and
monitor the EWS.
You can set up the Performance Counter to write to a file, so that you may monitor its activity
over a few days or weeks.
You can use the Performance Counter to monitor a sync's progress, especially if it has been
running for a long time. If the counter's values stop changing, nothing is happening. This
information can help you determine that it is safe to stop the service.
Notes about using the Performance Counter
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l

Most counters increment over time—they do not rise and fall.

l

Restarting the service resets the counters.

Performance Counter Display Options
l

Line

Ektron 8.7
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l

Histogram

l

Report

You have the following performance counters available to you:
NOTE: Definitions:
Initiating Server—The server from which file sync is initiated (via the website).
Peer Server—The other server(s) in a sync relationship.
Ektron Windows Service Data
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l

l

l

l

l

EWS Approximate Total Number of Threads Alive Currently—if eSync is running,
at least one thread is alive
EWS Approximate Total Number of Timers Alive Currently—increases as the
number of scheduled syncs increases
EWS Database Write Operations Total—increases when the EWS inserts/ updates or
deletes rows in a site’s database.
EWS Database Read Operations Total—increases when the EWS reads rows from a
site’s database.
EWS Exceptions Total—if eSync or load balancing exceptions occur while the service
is running, they increment the performance counter and appear on the graph. A
continual increase indicates a problem.

eSync Data
l

eSync—Total Number of Remote WCF Calls Made from Service—increases when
the EWS makes network calls to other EWS instances on the network.

File Sync Data
l

l

l

l

l

l

l

l

l

l

l

l

l

File Sync—Applying Changes (Total) on Initiating and Peer Servers—
incremented when a file change is about to be attempted
File Sync—Changes Applied (Total) on Initiating and Peer Servers—counter is
incremented when a file change is applied
File Sync—Changes Detected (Total) on Initiating and Peer Servers—counter is
incremented when a change detection pass is completed
File Sync—Changes Skipped (Total) from Initiating and Peer Servers—eSync
was supposed to do something but the action was skipped. This may occur if, for
example, a file is locked.
File Sync—Completed Work on Initiating Server—amount of work completed out
of total work to be done
File Sync—Conflicts Detected (Total) from Initiating and Peer Servers—
indicates conflicts between servers in a sync relationship. This number always
increases, never decreases unless someone restarts the EWS.
File Sync—Copying File (Total) on Initiating and Peer Servers—incremented
periodically to show progress while a file is being copied
File Sync—Detecting Changes (Total) on Initiating and Peer Servers—
incremented for every directory , including the root directory, during a change detection
pass. This is incremented before change detection begins for that folder.
File Sync—File Download Requests (Total) on Peer Server—total number of
download requests
File Sync—Files Skipped Change Detection (Total) from Initiating and Peer
Servers—eSync was supposed to do something but the action was skipped. This may
occur if, for example, a file is locked
File Sync—File Upload Calls (Total) from Initiating Server—indicates the total
number of upload calls from the initiating server to the remote EWS server
File Sync—File Upload Requests (Total) on Peer Server—total number of upload
requests received on the peer server
File Sync—File Upload Preview Calls (Total) from Initiating Server—total
number of upload preview calls made from the initiating server
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l

l

File Sync—Temporary Files Deleted Total—total number of temporary files deleted
by EWS so far. This number should never be zero (0) on the destination server while a
sync is running.
File Sync—Total Work on Initiating Server— total work to be done by file sync

Setting up the Performance Counter Display
To set up the display of the Ektron Windows Service performance counters:
1. Click the Windows Start button > Administrative Tools > Performance Monitor.
2. Click the Add button (

).

3. From the list in the upper left corner, click Ektron Windows Service - Performance
Counter, then Add and OK.

Using eSync with Other Ektron Features
eSync in a Load Balanced Environment
Ektron supports a load-balanced environment, in which several servers share your website’s
processing load. This feature is explained in Balancing the Load on Your Servers on page 89.
If your site uses load balancing, you can set up eSync so that, after one server in a load
balance cluster is synchronized, the other servers are automatically synchronized. Note that
if a separate database server is outside the load balance cluster (as shown below), eSync
only synchronizes documents and files used by the search among the clustered servers. It
does not touch the database.
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Beginning with Ektron version 8.5, the load-balance chain of servers is updated
automatically, and servers that are not available are removed. A typical load balanced cluster
is below.

IMPORTANT: In a load balanced environment, only update templates on the staging server. Do not
update them on the production server and assume they will be synchronized with the staging server.
IMPORTANT: Assume your load balanced cluster consists of 2 staging servers (S1 and S2) and 2
production servers (P1 and P2).
If you add/modify/delete a file on S1, to get the file to S2, you must run either a download sync on S2, or
an upload sync on S1, or a bidirectional sync from either server. If you run a download sync on S2, you
also need to run an upload sync to push the file to P2, which will then Load Balance with P1.
The best way to make sure that the added/modified/deleted file is changed on all servers is to initiate the
sync from the server on which the file was changed. In this example, since you changed the file on S1, if
you initiate a sync from S1, it will be automatically updated on S2, P1, and P2.
PREREQUISITES
l
l

l

The connection string on all servers in the cluster matches
You must initiate eSync relationships, and the actual synchronization, from a
staging server
If your staging servers are clustered, you must remove one from the cluster
before you can sync

Follow these steps to set up this capability.

Install a Min Site on Every Server in the Cluster
1. Upgrade each server to the same version of Ektron. If Ektron is already installed on one
server, install a minimum site on the others. To do this, run the Ektron base installation
file (CMS400Base8x.exe). For more information, see Installing the CMS Base on
page 13.
2. If the site with which you will sync is precompiled, precompile all min sites.

Update the Assetmanagement.config File
Ektron 8.7
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1. Sign on to the first server in your load balanced cluster.
2. In the site root folder, open assetmanagement.config.
3. Change the value of LoadBalanced to 1 and save.
4. Do this on every server in the cluster.

Update the Ektron Windows Service Config File
1. Sign on to the first server in your load balanced cluster.
2. Open
C:\ProgramFiles\Ektron\EktronWindowsService40\Ektron.ASM.EktronServices40
.exe.Config.
3. Change the value of LoadBalanced to 1 and save.
4. Do this on every server in the cluster.
5. Stop and then Start the Ektron Windows Service on every server in the cluster.

Create eSync Security Certificates for a Load Balanced
Cluster
You should be familiar with eSync security certificates before beginning this procedure. See
Also: Managing eSync Security Certificates on page 1521
Assume the load balance cluster has 3 servers: mach1, mach2, and mach3.

Part one: Generate Security Certificates
In this part, create the security certificates.
1. Sign on to mach1 using an account with administrative privileges and generate security
certificates. To do this, click the Windows Start button > All programs > Ektron >
CMS400 v8x > Utilities > Security Configurator > right click and choose Run as
Administrator.
2. The security configurator screen appears. See Managing eSync Security Certificates on
page 1521. Select the Generate Certificates radio button. Click the Generate button
then click OKwhen the Ektron Windows Service’s warning dialog appears.
This action creates security certificates for your server and applies them to all the sites
on the server. Optionally, you can select a single site from the Web Site Description
drop-down to install certificates to a selected site.
3. Create a new folder (for example, mach1_certitificates) on the desktop.
4. Open the following folder:
C:\ProgramFiles\Ektron\CMS400vxx\Utilities\Software\SecurityConfigurator.
5. Copy the following files from the SecurityConfigurator folder into the folder you created
in Step 3.
l
mach1_SyncClient.pfx
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l

mach1_SyncClient.pvk

l

mach1_SyncClient.cer

l

mach1_SyncServer.pfx

l

mach1_SyncServer.pvk

l

mach1_SyncServer.cer
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6. Repeat steps 1 to 5 for every server in your load balance cluster.

Part Two: Apply Security Certificates
In this part, copy then apply the certificates to all other servers in the cluster.
1. Copy each server's certificates folder to the other servers in the cluster.
2. Run the Security Configurator (Start button > All programs > Ektron > CMS400
v8x > Utilities > Security Configurator) and apply the certificates from every other
server in the cluster. For example, apply certificates from mach2 and mach3 on mach1;
and apply certificates from mach1 and mach3 on mach2.
To apply certificates, follow these steps.
a. Select the Apply Remote Server Certificates radio button.

b. Click the browse button next to that field.
c. Browse to the remote server’s certificates folder (which you copied in Step 1).
d. Click the Apply button. Then, click OK when the Ektron Windows Service warning
dialog appears.
e. Repeat the above steps for all remote server certificate folders.
f. Repeat steps on every server in the load balance cluster.

Set Up and Run eSync
Set up and run eSync in a load balanced environment the same way you run it normally. See
these sections for details.
l

Initializing a New Site on page 1480

l

Setting up eSync Profiles on page 1512
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l

Optional Steps before Running a Sync on page 1532

l

Running eSync on page 1532

Using eSync in a Multi-site Environment
If you want to use eSync in a multi-site environment, you must do so before the initial
synchronization of a relationship. That is, you cannot set up a eSync relationship in a singlesite environment and then later change to multi-site. You can set up a new relationship at any
time. See Also: Supporting Multi-Site Configurations on page 76
Limitations on Using eSync in a Multi-site Environment
l

l

In a multi-site environment, you cannot create a staging site from a production site (as
described in Initializing a New Site on page 1480). You must first create all sites on the
staging server, then set up production sites with which they sync.
You should log into the main site then synchronizing it and all multi-sites from there.

Setting up eSync in a Multi-Site Environment
WARNING! Back up your database before beginning this procedure!
1. Set up all sites on the staging server, following the instructions in Supporting Multi-Site
Configurations on page 76.
2. Install an Ektron min site on each production server that will host a site. To do this, run
the Ektron base installation file.
3. Install security certificates between the staging server and all production servers. This
procedure is described in Managing eSync Security Certificates on page 1521.
4. Sign on to the staging server.
5. In the Workarea, go to Settings > Configuration > Synchronization> Profiles.
6. The View All Synchronization Configurations screen appears. Click Create
Synchronization Server Configuration. The screen appears.

NOTE: If you see the following error, The system cannot find the file specified, you must set up
security certificates. See Also: Managing eSync Security Certificates on page 1521
7. Use the following information to complete the screen.
WARNING! The first time you sync an Ektron website, all of its data is overwritten. Make sure that
no important information resides on the production server before beginning the first sync.
8. Remote Server—Select a production server by choosing the path to the site’s physical
location on the remote server.
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9. Choose Certificate—If you selected a single server above, its name appears here.
Proceed to the next step.
If you selected a domain or IP address above, click the drop-down arrow to view all
servers whose client security certificates reside on this server. Then, select the server
with which you want to set up an eSync relationship.
10. Click Connect. After you connect to the production server, all eligible databases on it
appear. The top one has a green check mark, indicating it is selected by default.

11. Click the database with which you want to sync. When you do, a green check mark
appears on it, and its background color changes.
12. Click Next.
13. A new screen appears, showing both servers and allowing you to change the direction of
the initial database copy. Make sure you are copying from staging to production.
Because the staging server is multi-site, the staging server area has a Site Path
pulldown field, which lets you select a site.
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14. When you are satisfied, click Create. This sets up the server relationship but does not
launch the initial sync.
15. The View All Synchronization Configurations screen appears with the new relationship. If
you are ready to overwrite the production database with the staging one, click Start
Initial Sync (

). A confirmation message appears.

16. A screen monitors the sync’s progress.
17. The initial sync creates a default profile, which appears on the View All Synchronization
Configurations screen.
18. Set up and launch sync profiles to sync Workarea files and templates on the staging
server with those on the production server. (This is described in Setting up eSync
Profiles on page 1512 and Running eSync on page 1532.) For synchronization direction,
choose Running eSync on page 1532.

Setting up Staging Multi-sites
By default, if you sign on to a staging server then insert library items (images, quicklinks, and
so on) into content, the path to those items includes the production server. For example, your
server setup includes 2 multi-sites: sales.ektron.com and support.ektron.com.
NOTE: Multi-site names are defined in the site’s folder properties screen’s Production Domain field, as
described in Supporting Multi-Site Configurations on page 76.
So, library links in the sales.ektron.com site’s content look like this:
http://sales.ektron.com/template?id=id number. However, you may wish to change
library links so they refer to the staging server. This would help you verify that the linked
items exist on it.
To change library links to refer to your staging server:
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1. Go to Settings > Configuration > Setup.
2. Click Edit.
3. Check the Staging Server checkbox.
4. Click Update.
5. Go to Content > the staging site folder.
6. Choose View > Properties.
7. Click Edit Properties.
8. Scroll down to the section labeled Multi-Site Domain Configuration:
9. In the Staging Domain field, enter the URL of your staging server.
10. Click Update.
From now on, when a user signs on to the staging server and works with library links, the
links include the staging server instead of the production server.

Using eSync with Web Alerts
The Web Alert feature enables Ektron to generate email for a list of registered users
whenever new content appears on your site, or existing content is updated. For more
information, see Administering Web Alerts on page 1567.
In an eSync environment, you need to determine which servers send Web Alerts. For
example, Web Alerts should probably not be generated when content is published on a staging
server, but you would want them when content is published on a production server.
To determine if a server generates Web alerts, use the following property of each website’s
web.config file.
<add key="ek_DisableWebAlerts" ..... />

Set the property’s value to true to suppress Web Alerts on a server.
Set the property’s value to false to generate Web Alerts to on a server.
Also, the server clock on the download side of the eSync relationship must be exactly the
same time as or slightly ahead of the clock on the sending server.

Using eSync with eCommerce
When using eSync with an eCommerce site, you need to prevent orders from being processed
on your staging server to prevent orders from being processed twice.
For example, a customer on your production site purchases a product. If the staging server
and production server are synched before the credit card is processed, it might be charged
twice: once from the production server and again from the staging server.
To prevent orders from being processed on your staging server, edit your staging site’s
web.config file and set the following property to true:
<add key="ek_ecom_OrderProcessingDisabled" value="true" />

When the property is set to true, you cannot process or edit orders from the Workarea’s View
Order screen on the staging server. Also, if you try to create an order from the staging
server’s website, you receive the following message.
“We're sorry, an error occurred while processing your request. Please try again later...”
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It is important to note that all other eSync functions still work properly. For example, when
you create catalog entries on a staging server and perform a sync, the entries are moved to
the production server. The ek_ecom_OrderProcessingDisabled key only affects the
processing of orders.

Using eSync with Notifications
When using eSync with Notifications, any new agents are not synched. This means that you
must manually add new agents to each server in your relationship.
When the agent exists on all servers in your relationship, eSync keeps them updated. For
example, assume a membership user logs into the production server and updates the profile’s
Activities tab by changing the activities a custom agent will perform. eSync will sync those
changes with the staging server.
See Also: Adding a Custom Agent on page 1206; Sending Notifications to a Community on
page 1194

Running 8.5 and 8.7 eSync Simultaneously
If you install an 8.7 Ektron site to a server that is also running an 8.5 version, the 8.7 Ektron
Windows Service replaces the 8.5 version. Also, the dbSync.config file was removed for 8.7.
To manage settings you previously configured in dbsync.config file, run the following script.
IF(NOT EXISTS(SELECT NAME FROM SYS.OBJECTS WHERE (NAME='sync_settings') AND (type='u')))
begin
create table [dbo].[sync_settings
(
profile_id bigint not null,
memory_data_cache_size int not null default (32768),
remote_sql_connection tinyint not null default(2),
application_tran_size bigint not null default (0),
script_encryption bit not null default (0),
collision_action bigint not null default(0),
backup_action tinyint not null default(0),
backup_device nvarchar(max) null,
log_retain_count int not null default(50),
CONSTRAINT [PK_sync_settings] PRIMARY KEY CLUSTERED (profile_id)
)
end
go
if(not(exists(select 1 from sync_settings where profile_id=0)))
begin
insert into sync_settings(profile_id)values(0)
end
go

The following list describes some lines in the script.
l

l
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memory_data_cache_size int not null default (32768—Define a maximum
amount of memory that your server uses during a sync. The default is 32 MB. You can
change it to any size up to the amount of RAM in your eSync server.
remote_sql_connection tinyint not null default(2)—0-direct; 1-proxy; 2autodetect
o autodetect is generally the best solution
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l

l

l

l
l

application_tran_size bigint not null default(0)—if changes are expected in
multiple batches, set this value to memory_data_cache_size
collision_action bigint not null default(0)—The value of the Resolved
Collisions during Synchronization field, which specifies types of data for which
collisions will be resolved See Determining which Collisions are Resolved on page 1551
o 0=NONE
o

1=USER

o

2=FOLDERS

o

4=METADATA

o

8=EMAIL MESSAGE

o

16=URL ALIAS

o

32=TAG ENTRIES

o

64=STATISTICS ON TAG

o

128=TAG REGENERATION

o

256=TAXONOMY COUNTS

o

512=PRICE ENTRIES

o

1024=MULTISITE STAGING URL

o

2048=MENU

backup_action tinyint not null default(0)—1-backup always; 2-backup only
before initial sync; determines when to back up destination database before a sync
backup_device nvarchar(max) null—backup location
log_retain_count int not null default(50)—set the number of logs retained in
the database See Viewing eSync Activity on page 1546

Troubleshooting eSync
Problem: Synchronization has failed
There was no endpoint listening at
http://alphatest:8732/
Ektron.Sync.Communication/SyncCommunicationScheduleService.svc that could accept
the message. This is often caused by an incorrect address or SOAP action. See
InnerException, if present, for more details.
One server in the relationship cannot resolve the address of the other server. This may be
due to security restrictions or because the Ektron Windows service is off.
Solutions:
l

Modify the hostname of the other server so that it can be found.

l

Restart the Windows service

l

Reconfigure security

Problem: The identity check failed for the outgoing message. The expected identity is xxx for
the xxx target endpoint.
Local site cannot communicate with service.
Solution:
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1. Load the security Configuration utility:
C:\Program
Files\Ektron\CMS400vxx\utilities\software\securityconfigurator\securityco
nfigurator.exe.
2. Select the website that is failing.
3. Click OK. This recopies client certificates to the site and updates web.config to use
them.
Problem: No viable CMS sites were found on the remote server specified. Please check the
remote server and try again.
No Ektron site exists on the remote server.
Possible Solution: Install an Ektron min site on the remote server.
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The Web Alert feature lets you generate email for a list of registered users whenever new or
existing content is published. Interested site visitors register to be notified when new
information about your product is published. When content is published, the users receive an
email with a link to the new/updated page. The recipient clicks the link to access the page.
As a result, a self-selected group of users are notified of changes relating to their interests.
When the Web Alert feature is set up, you don’t need to do anything—everything happens in
the background.

Sample Web Alert email

PREREQUISITE
Only members of the Administrator Group or users assigned to the Folder User Admin
role can work with Web Alerts

How Web Alert Works
The following explains the Web Alert feature.
1. Content is published.
2. Ektron checks the Staging Server checkbox on the Settings > Configuration >
Setup screen. If it is unchecked, proceed to the next step. If the box is checked, no Web
alerts are issued for this server.
3. Ektron checks to see if any subscriptions are assigned to folders or content.
4. If no subscriptions are assigned, the Web Alerts tab does not appear when editing
content.
l
If any subscription is assigned, Ektron checks to see if an email should be created
for this content. The settings appear under the Web Alerts tab. For example, some
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content only triggers an email when first published, while other items always
generate an email.
5. If an email should be generated, Ektron composes the email by retrieving information
from the Folder Properties screen > Web Alerts tab > Web Alert Contents fields.
6. Ektron determines which subscription lists should receive the email. These are identified
on the Available Web Alerts area of the Web Alerts tab. The lists contain
subscribers' email addresses.

Server Configuration
The following is a typical Web Alerts server configuration.

l

Firewall—the Ektron business tier (which maintains the Ektron files) must have Web
access to the asynchronous server. This configuration enables proper communication
between Ektron and the asynchronous processor.
o The asynchronous processor must have port 25 (SMTP) access to a valid mail
server to send emails
o

l

l

The mail server (omitted from the illustration) must be allowed to send out port 25
(SMTP) traffic and can reside on the asynchronous server

Queuing—Message queuing must be enabled on the asynchronous server.
o You must create a message queue on the asynchronous machine and record its
name. The message queue is specified in the exe.config file for the service, and in
the web.config file for the Web Service interface.
CMS—The web.config file includes a key for the location of the asynchronous
processor. This needs to be verified as working.
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l

Other—IIS must be installed on the asynchronous processor. IIS allows a Web service
call to schedule a file download and send commands.
o The asynchronous machine should only allow HTTP traffic from Ektron servers. This
provides additional security on the asynchronous processor.

Verifying Connections
l

l

l

You can verify the Web service > queue connection by
o leaving the Ektron asynchronous processor service off, submitting content with
notifications, and verifying that a message arrived in the queue
o

turning on journaling for the queue. Submit a message in the queue. The Ektron
asynchronous processor service picks it up and places it in the journaled messages.

o

turning on logging for the Ektron asynchronous processor service

To verify the Ektron > Web service connection, open the asynchronous processor
location inside a Web browser and test the Web services.
o To verify the writing of files, ensure that Ektron has write access to the
[sitepath]subscriptions directory and submit content that will trigger
notifications. This action places a file inside that directory.
To verify that the Ektron asynchronous processor service can download a file, open a
Web browser on the asynchronous machine and connect to the location of the notification
command files. Attempt to download one.

Enabling the Web Alert Feature
1. Set up message queue and asynchronous processor.
See Also: Setting Up Message Queuing and the Asynchronous Processor on page 1572
2. Create messages—Define components of the email to be sent to subscribers.
See Also: CreatingMessage Components on page 1576
3. Define subscriptions—Categories of information on your site. Site visitors can subscribe
to be notified when content in a category is added or updated.
See Also: Defining Subscriptions on page 1578
4. Assign Web Alert information to folders and content—For each folder or content item to
which you assign subscriptions, determine
l
activities that trigger emails (for example, initial publishing of content)
l
l

the email content
subscription lists to which the email is sent
See Also: Assigning Web Alert Information to Folders and Content on page 1581

5. Create and publish site visitor registration page—Create a new Web form and drop the
membership server control onto it. Then, publish that form on your website. See Also:
Membership on page 1771 server control
NOTE: This task is typically done by a developer.
6. Site visitors subscribe to lists of interest—Someone signs up to be notified when changes
in a selected subscription (category) are published. See Also: How Users Sign up for
Subscriptions on page 1586
7. Ektron users can also subscribe. See Also: CMS User Subscription Sign Up on page 1589
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8. Subscribers are notified when content is first published or updated—If at least one
subscription is assigned to the content or its folder, email is sent according the folder's
Web Alert settings.

Message Components
A Web Alert email is made up of the following components, defined on the Folder properties
Web Alerts tab. See Also: Assigning Web Alert Information to Folders and Content on
page 1581

NOTE: If you reached this screen while creating an eCommerce message, see Configuring eCommerce
on page 1305.
NOTE: To set or modify this information, you must have permission to edit the folder.
l
l

l

From address (required)—See Creating “From” Addresses on page 1578
Recipient (required)—Users who signed up for subscriptions that are enabled for the
folder. See Also: How Users Sign up for Subscriptions on page 1586.
Subject line—The Subject field on the Web Alerts tab of the Folder Properties screen.
See Assigning Web Alert Information to Folders and Content on page 1581

l

Default message—See Creating Default Message Text on page 1577.

l

Opt out message (required)—See Creating Opt Out Message Text on page 1577

l

Content summary—The Summary of the content whose creation or change generates
the email. See Also: Writing a Summary for Content on page 292.
NOTE: The Summary can include variables that retrieve information about the content. See
Including Variables in the Default Message on page 1577.

l

Content link—Link to content whose creation or change generates the email.

l

Any CMS content item—You may include Ektron content in the email.
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l

Unsubscribe message (required)—See Creating Unsubscribe Message Text on
page 1578.

The elements appear in the sequence shown above.

Setting Up Message Queuing and the
Asynchronous Processor
After installing Ektron, set up Microsoft Message Queuing and the Ektron Asynchronous
Processor. The installation places the following directories and files on your server.
l

C:\Program Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_Service\

l

C:\inetpub\wwwroot\siteroot\bin\EktronAsyncProcessorWS.dll

l

C:\inetpub\wwwroot\
siteroot\Workarea\webservices\EktronAsyncProcessorWS.asmx

NOTE: If you need to move Web services file, use the Asynchronous Processor Location field in the
Configuration > Setup screen to specify the new folder location.
This section also contains the following topics.
Setting Up Message Queuing and the Asynchronous Processor
Manual Setup of Message Queue and Asynchronous Processor

1572
1575

Setting Up Message Queuing and the Asynchronous
Processor
1. On the server that hosts Ektron,
l

If you are using Windows 7 or 2008 R2, go to Control Panel > Add/Remove
programs > Add/Remove Windows Components.
NOTE: In some Windows versions, you access Turn Windows features on or off then select
Microsoft Message Queue (MSMQ) Server.

l

If you are using Windows 8 or 2012,

2. If it is not checked, check Message Queuing Services.
Windows 2008 R2
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Windows 7

3. If Message Queuing Services was checked when you viewed it, go to step 5. If it was
not checked, click Next. A wizard creates the component.
The rest of this procedure employs a wizard that saves several manual steps. If you
have a problem using the wizard, or prefer to install Web Alerts manually so you can
track the files being installed to your server, see Manual Setup of Message Queue and
Asynchronous Processor on page 1575.

Ektron 8.7

1573

Administering Web Alerts

4. From the Windows Start Menu, click All Programs > Ektron > CMS400vxx >
Utilities > Web Alert Setup. The Web Alert Wizard setup screen appears.
5. Click Next. The wizard begins installing the Web Alerts feature.
The following screen appears.

6. At Message Queue Name, enter the name of the message queue that will manage the
Web Alert email.
7. At SMTP Port, enter the port number that sends Web Alert email.
8. At SMTP Server, enter the name of the server that hosts your Ektron website.
9. Enter the username and password that will be used to send and receive email.
10. If you want a very detailed log file, click Logfile Verbose.
11. If your Asynchronous Processor service is not running, the following message appears.
If you see this message, click OK then click Finish.

12. Go to Control Panel > Administrative Tools > Computer Management >
Services and Applications > Services.
13. Start the Ektron Async Processor service.
14. When specifying the SMTP port in Step 7, if you entered a port number other than 25
a. Open C:\Program Files (x86)\Ektron\CMS400vxx\EktronAsyncProcessor_
Service\Ektron.Services.EktronAsyncProcessor.exe.config.
b. Change the value of ek_SMTP_EnableSsL to False.
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Manual Setup of Message Queue and Asynchronous
Processor
This section describes manual steps for setting up the Message Queue and Asynchronous
Processor. You can use this procedure if you had a problem using the wizard, or you want to
know which files are being installed on your server.
1. Go to Control Panel > Administrative Tools > Computer Management >
Services and Applications > Message Queuing.
NOTE: In some Windows versions, you access this screen by clicking Start > Computer >
Manage.
2. Right click the Services and Applications > Message Queuing > Private Queues
folder and select New > Private Queue.

3. Create a private queue named msmq_web.
4. Right click msmq_web and select Properties.
5. Go to the Security tab. You can give the Everyone group Full Control if you are in a
testing environment. If you are on a production server or want better security, delete
the following permissions for the local system account (the account under which the
EktronAsyncProcessor Service runs):
l
Receive Message
l

Peek Message

l

Send Message
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6. Give the ASP.NET account (the account under which the Web services interface runs)
Send Message permission.
7. Click OK.
8. Open the following file: C:\Program
Files\Ektron\CMS400vxx\EktronAsyncProcessor_
Service\RegEktron.Services.EktronAsyncProcessor.bat
9. Review and update as necessary the paths to the .NET directory and
Ektron.Services.EktronAsyncProcessor.exe file.
10. Update the paths to the .NET Directory and the .exe file if necessary.
11. Execute the .bat file. Or, from a command line or Start Menu > Run, enter:
C:\Windows\Microsoft.NET\Framework\v2.0.50727\installutil “C:\program
Files\Ektron\CMS400vxx\EktronAsyncProcessor_
Service\Ektron.Services.EktronAsyncProcessor.exe”
12. Open the following file and enter your SMTP connection settings: C:\Program
Files\Ektron\CMS400vxx\EktronAsyncProcessor_
Service\Ektron.Services.EktronAsyncProcessor.exe.config.
13. Go to Control Panel > Administrative Tools > Computer Management >
Services and Applications > Services. Start the Ektron Async Processor Service.

CreatingMessage Components
Before you can create an email message, define the following components.
l

default message text

l

opt out message

l

unsubscribe message

l

“from” address

You can define several of each item. You must define at least one opt-out message,
unsubscribe message, and “from” address to use the Web Alert feature.
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After setting up message components, they are referenced on the folder's properties screen's
Web Alerts tab. See Also: Message Components on page 1571

Creating Default Message Text
1. From the Workarea, choose Settings > Configuration > Web Alerts > Messages.
2. Click Add Email Message.
3. Enter a Title that describes the message.
4. At the Type field, select DefaultMessage.
5. In the editor, enter the message text.
6. Click Save.

Including Variables in the Default Message
The default message can include variables that retrieve content information into the message
text. The variables are surrounded by at signs (@). For example
The following content was recently updated: @AppContentLink@

The email text might read:
The following content was recently updated: The Effect of Coumadin on Cardiac
Patients
Use the following variables in a Web Alert message.
l

@appContentTitle@—The title of the content block.

l

@appCRLF@—A carriage return. Moves text down one line.

l

@appContentLink@—The link to the content block on the website.
NOTE: You must be logged in to see the changes.

l
l

l
l

l

@appContentURL@—The URL of the content, from the quicklink and domain.
@appSubscriptionNames@—Comma separated list of subscriptions that a user
selected.
@appComment@—The comments for the content block.
@appSubmitterFirstName@—The first name of the user who submitted the content
block.
@appSubmitterLastName@—The last name of the user who submitted the content
block.

Creating Opt Out Message Text
An Opt-Out message appears as the first line of every email. It directs the reader to the
Unsubscribe message at the bottom. Here is an example:
You have subscribed to receive alerts from the Ektron email alert system.
See below for removal instructions.

You can add variables to the Opt Out text. See Also: Including Variables in the Default
Message above
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1. Go to Settings > Configuration > Web Alerts > Messages.
2. Click Add Email Message.
3. Enter a Title that describes the Opt-Out message.
4. At the Type field, select OptOut.
5. In the editor, enter the message text.
6. Click Save.

Creating Unsubscribe Message Text
An Unsubscribe message helps an email recipient remove himself from the subscription list.
You can add variables to the Unsubscribe text. See Also: Including Variables in the Default
Message on the previous page
1. Go to Settings > Configuration > Web Alerts > Messages.
2. Click Add Email Message
3. Enter a title that describes the Unsubscribe message.
4. At the Type field, select OptOut.
5. In the editor, enter the message text.
6. Click Save.

Creating “From” Addresses
Web Alert emails must have a “from” address.
1. Go to Settings > Configuration > Web Alerts > Email From List.
2. Click New > Email From.
3. Enter an email address to be used in the "From" field of Web Alert messages.
4. Click Save.

Defining Subscriptions
Create a subscription for each type of information site visitors might want to be notified
about. For example, if your site sells electronics, create subscription for televisions,
computers, and smart phones. Site visitors subscribe to areas of interest. Ektron and
membership users can also sign up for subscriptions.

Creating Subscriptions
1. Go to Settings > Configuration > Web Alerts > Subscriptions.
2. Click Add Subscription.
3. Enter a name for the subscription.
4. Check the Enabled box if the subscription is active.
5. Click Save.

Appearance of Subscriptions on Custom User
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Properties Screen
When you create a subscription, a new entry is created on the User Properties screen's
Custom tab. By default, its name is Subscriptions, and its type is Category.

Subscriptions appear on the
l

Site Visitor Registration screen

l

Membership user information screen > Custom tab

l

User information screen > Custom tab

l

User group information screen > Custom tab

By default, the label Subscriptions appears on the screen. To change it to something more
helpful, such as Select Areas of Interest:
1. In the Workarea, go to Settings > Configuration > Custom Properties.
2. In the Object Type field, select User.
3. Click Subscriptions.
4. Edit the Label field.
The following graphic illustrates the relationship among the Subscriptions, Custom Properties,
and the Site Visitor Registration screen's Custom tab.
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Using Subscriptions in a Multi-Language System
When you create a subscription, a version is created for every enabled language. You can edit
the subscription name and Enabled value for any language, but cannot change the ID
number.
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1. Choose Settings > Configuration > Web Alerts > Subscriptions.
2. From the View Languages drop-down list, select the language into which you want to
translate the subscription.
3. Click the subscription that you want to translate.
4. Click Edit.
5. In the Name field, enter the translation for the subscription name. If desired, you can
check or uncheck the Enabled checkbox. Only enabled subscriptions appear.
6. Click Update.

Assigning Web Alert Information to Folders and
Content
After creating messages (as explained in CreatingMessage Components on page 1576) and
subscriptions (as explained in Assigning Web Alert Information to Folders and Content
above), you identify which folders include content that, when updated, trigger a Web Alert.
For example, new product announcements are placed in the Marketing folder.
NOTE: To set or modify Web Alert information, you must have permission to edit the folder. See Also:
Managing Folder Permissions on page 257
For each folder, you can assign the following kinds of message information.
l

whether Web Alert information is inherited from a parent folder or customized

l

when email is sent: always, only on initial publication, or never

l

the content of the Web Alert email
the subscriptions assigned to the folder. These determine which recipients receive the
Web alert email.

l

Customizing Web Alert Information for a Folder
Like other folder-level information in Ektron, Web Alert information is inherited from a parent
folder. By default, all folders inherit Web Alert settings from the root (Content) folder.
However, you can break inheritance and customize the settings for any folder or content
item. See Also: Assigning Web Alert Information to Content on page 1584
To modify folder-level Web Alert information:
PREREQUISITES
l

l

l

You defined at least one opt-out message, unsubscribe message, and “from”
address. See Also: CreatingMessage Components on page 1576
You defined at least one subscription. See Also: Defining Subscriptions on
page 1578
You have edit permissions for the folder

1. Navigate to the folder whose Web Alert information you want to edit.
2. Click View > Properties.

Ektron 8.7

1581

Administering Web Alerts

3. Click the Web Alerts tab. The Web Alert options appear.

l

l

l

l

l
l

l
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Inherit parent configuration—To inherit Web Alert settings (described below)
from this folder’s parent folder, leave this box (Break Inheritance) checked.
To assign custom Web Alert settings for this folder, uncheck this box and use the
fields below.
Restore Web Alert inheritance to the content in this folder—Check this box
if Web Alert inheritance has been broken for some content in the folder, and you
want to restore inheritance. If you do, all folder content uses the Web Alert
properties applied to this folder.
Options—Check when Web Alert emails are sent as content in this folder is
published.
o Notify Always—send email whether content is being published for the first
time or updated
o

Notify Only on Initial Publication—send email only the first time content is
published. After that, email is not sent.

o

Notify Never—email is never sent for content in this folder.

Web Alert Subject—Enter the email's subject line.
Web Alert email From Address—Select the address from which email for this
folder is sent. See Also: Creating “From” Addresses on page 1578
Web Alert Contents—Check the following components to determine the email
text . See Also: Message Components on page 1571
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o

OptOut Message—see Creating Opt Out Message Text on page 1577

o

Use Default message—see Creating Default Message Text on page 1577

o

Use Summary—include the content summary in the email

o

Use Content—You may include Ektron content in the email.
NOTE: If the content item is an Office document or a managed file, a link to that item
appears within the email, not the item itself.

l

l

n

To select existing content, click Select next to the Use Content
checkbox. Then, navigate to the content item.

n

To select the content whose creation or change triggers the Web Alert,
click Use Current.

n

To create new content to be inserted into the Web Alert message for this
folder, click Select next to the Use Content checkbox. When the folder
navigation window appears, click Add Content. Then, see Creating New
Content on page 287.

Unsubscribe message—See Creating Unsubscribe Message Text on page 1578.
The components appears within the email in the order listed above.
Available Web Alerts—All enabled subscriptions set up in the Subscriptions
screen appear. Check those to be notified when content in this folder is added or
updated. See Also: Defining Subscriptions on page 1578
IMPORTANT: If you uncheck all subscriptions, you disable the Web Alert feature for this
folder and all of its content, even if unique subscription information is assigned to content
within the folder.

Previewing the email Message
To preview the email message, click Preview (

) on the Web Alerts tab.
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Assigning Web Alert Information to Content
You can customize Web Alert settings for any content item. If you do, you break the
inheritance from its folder. From then on, the content’s Web Alert settings are independent of
the folder’s settings.
IMPORTANT: If all subscriptions are unchecked for a folder, the Web Alert feature is disabled for all
content in the folder. This applies even if unique Web Alert information is assigned to content.
To customize the Web Alert settings for any content item:
1. Navigate to the folder that contains the content.
2. Click the content. The View Content screen appears.
3. Click Edit.
4. Click the Web Alerts tab.
NOTE: The Web Alerts tab only appears if required messages, “from” email addresses, and at least
one subscription are assigned to the content’s folder.
The Web Alert settings for the content appear
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l

Options—Check when Web Alert emails are sent as this content is published.
o Notify Always—send email whether content is being published for the first time or
updated
o

Suspend Next Notification (override)—check this box to suspend the next
email to be sent for this content. You might use this feature if you noticed a small
error in the content and don’t want to notify subscribers that the page was updated.
NOTE: - This setting only applies until the next time this content is published. When that
happens, this box is automatically unchecked.

o

Notify only on Initial Publication—send email the first time content is
published. After that, email is not sent.

o

Send Next Notification (override)—send email to all subscribers the next time
this content is published. Use this checkbox to send a one-time mailing to all
subscribers about content that was already published.
NOTE: - This setting only applies until the next time this content is published. When that
happens, this box is automatically unchecked.

o
l

Notify Never—email is never sent when this content is published.

Subject—Same as for a content folder.
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l

email From—Same as for a content folder.

l

Contents—Same as for a content folder.

l

Available Alerts—Only Web Alerts assigned to the folder appear. Check ones that you
want to assign to this content item.

Restoring Folder-level Web Alert Information to Content
If you customize Web Alert information for content and later decide to standardize that
information for all content in a folder, use the Restore Web Alert Inheritance checkbox on
the folder properties Web Alerts tab. This action copies the folder's Web Alert information to
every content item in the folder, replacing any content-level information.

How Dragged and Dropped Content is Handled
Web Alert emails are not generated for files that are dragged and dropped into Ektron and
immediately published. To generate email for these files, you must manually publish them.
Like HTML content, these files must reside in a folder for which the Web Alert feature is
enabled.

How Users Sign up for Subscriptions
After setting up subscriptions, you create a Web page that lets site visitors subscribe to areas
of interest.

To place this form on a Web page, your developer inserts a Membership Server Control. See
Also:
Any user who subscribes via the above screen becomes an Ektron membership user, and is
automatically added to the All Members user group. For more information, see Membership
Users and Groups on page 1161.
NOTE: The email address collected on the screen is used as the membership Username field.
What happens next depends on the Enable Verify email check box in the Application Setup
screen (shown below).
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What Happens if Verification email is Not Used
If the Enable Verify email checkbox is not checked, everyone who signs up automatically
becomes a membership user.

What Happens if Verification email is Used
IMPORTANT: When using the Checkout Server Control on an eCommerce site, the Enable Verify
Email setting must be unchecked. Otherwise, new users will receive an error message when they sign-up
using this control. See Also: Using the eCommerce Server Controls on page 1404
Typically, when managing a self-subscribe list, you want new users to confirm their intention
of being on the list. This prevents people from being subscribed without their permission.
If the Enable Verify email checkbox is checked, everyone who signs up is placed on the
Users Not Verified list. (To see this list, go to Workarea > Settings > Community
Management > Memberships > Users Not Verified.)
These people then receive an email. (You define its content in Workarea > Settings >
Community Management > Messages.) The email should direct the unverified user to a
Web page that asks for confirmation of the person's interest in the subscription. (See
Customizing the Verification Message below.) New users are activated when the subscriber
confirms interest.
To create this page, your Web developer creates or updates a Web Form using the
Membership Server Control. Set the control’s DisplayMode property to AccountActivate.
NOTE: Users can also be manually activated or removed via the View Not Verified Users screen. For
more information, see The View Not Verified Users Screen on the next page.

Customizing the Verification Message
By default, Ektron supplies a generic message asking the user to confirm the password and
directing the person to your website's activateuser.aspx page. To customize that message:
1. Go to Workarea > Settings > Community Management > Messages.
2. Click AddEmail Message.
3. Assign a title to the message, such as Verification Message.
4. In the Type drop-down, select Verification.
5. Click the check mark in the Default box.
6. In the Subject field, enter a subject line for the message.
7. Enter the message. You must insert the @appQueryLink@ variable in the message to
create a link to the confirmation page. For example:
Welcome to example.com. You registered to be notified of updates
to our site. Before we can do this, you need to activate your
account. To do so, please visit @appQueryLink@.

The @appQueryLink@ variable gets resolved as follows (one line):
http://sitepath/workarea
/activateuser.aspx?uid=[username]&acc=[accountID]

For example (one line):
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http://www.example.com/Workarea
/activateuser.aspx?uid=john.edit@example.com&acc=ce5w84o936477

You can insert these membership variables into the confirmation message.
l

@appEmail@—email address

l

@appActivateId@—Account ID

l

@appUserName@—UserName

l

@appFirstName@—First name

l

@appLastName@—Last name

l

@appDisplayName@—Display name

l

@appAvatar@ —Avatar

l

@appSignature@—Signature

The View Not Verified Users Screen
Users who signed up for a subscription but who have not been verified appear on the View Not
Verified Users Screen. This screen is available via Settings > Community Management >
Memberships > Users not Verified.
On this screen, you can activate accounts by selecting users then clicking ActivateUsers.
Alternatively, you can delete members by selecting and clicking Delete ( ).
NOTE: The ek_PageSize setting in the web.config file determines the maximum number of users
that can appear on a page before it “breaks.” When a page breaks, additional entries appear on another
screen, and the following text appears near the bottom of the list:
Page 1 of 2 [First Page] [Previous Page] [Next Page] [Last Page]
To select all members, click the check box next to Username.

You can also change the way membership users are sorted, or use the Search button to find
users that match your criteria (for example, users whose username includes example.com.)

Setting up Other Web Pages for Site Visitors
You can set up other Web pages that let subscribers perform these actions:
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l

Activate their account

l

Reset their password

l

Unsubscribe
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To create these pages, place a Membership server control on the page. Then use its
DisplayMode property to determine the kind of screen you want to place. For example, to
create a screen that lets the user reset a password, set the control’s DisplayMode property
to ResetPassword. See Also: Membership on page 1771 server control

CMS User Subscription Sign Up
CMS users can subscribe to any subscription list. This is particularly useful on an intranet
where, for example, employees are notified when job-related information is updated.
Another example is your internet site. The Marketing manager can sign up to be notified
whenever Marketing content is added or updated. To do so, go to Settings > Users > Edit
User > Custom tab.

See Also: Using eSync with Web Alerts on page 1563
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Versions of Ektron previous to 8.5 featured 2-tier architecture, in which the Application and
Presentation tiers resided on the same server. In 3-tier architecture, you can locate the
Application tier in the client’s environment or an Ektron hosting environment. This represents
a true separation of the Web server from the database. The Application tier does the bulk of
the work, while the Presentation tier does basic processing.
IMPORTANT: You are not required to use 3-tier architecture—Ektron continues to run successfully on 2tier architecture.
A 3-tier architecture lets you spread the processing of Ektron data among 3-Tiers, as shown in
the following figure. Each tier should reside on its own server.

NOTE: You may run all 3 tiers on a single server for development purposes only.
The 3 tiers are Data, Application, and Presentation.
l

l

l
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Data—Contains SQL and Ektron database objects (stored procedures, views, tables, and
so on).
Application—Full Ektron installation.
o Ektron DLLs
o

Ektron Workarea

o

Ektron Windows Services

o

Ektron WCF Services

o

Custom WCF Services

Presentation—
o Handles site visitor requests and displays Web pages
o

Minimal footprint, lightweight

o

Requires IIS

o

No Ektron installation
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o

Contains
o Standard ASP.NET website
o

Minimal set of Ektron.dlls in bin folder

o

Configuration files (web.config, unity.config)

o

Workarea required only if website uses PageBuilder or templated server
controls.

The Presentation tier was added in Ektron Version 8.5.
The Ektron Framework API uses the Microsoft Unity Framework to inject business logic
implementations into our Framework API. When running in 3-Tier mode, the Framework
API on the Presentation tier uses a WCF service client implementation, thereby routing
Framework API calls through WCF services, while the actual logic is running on the
Application server.
To minimize network requests the between Presentation and Application tiers, Ektron
includes a caching tier.
NOTE: 3-tier architecture is different from MVC coding style, which consists of a data layer, business
logic layer, and an API layer.
NOTE: To communicate between servers, you can choose any unused port. If you choose a port other
than 80, Ektron recommends using one outside of the well-known port range (0 to 1023).
Benefits of 3-Tier Architecture
3-tier architecture provides the following benefits.
l

l

l

Scalability—Each tier can scale horizontally. For example, you can load-balance the
Presentation tier among 3 servers to satisfy more Web requests without adding servers
to the Application and Data tiers.
Performance—Because the Presentation tier can cache requests, network utilization is
minimized, and the load is reduced on the Application and Data tiers. If needed, you can
load-balance any tier.
Availability—If the Application tier server is down and caching is sufficient, the
Presentation tier can process Web requests using the cache.

Limitations of 3-Tier Architecture
3-tier architecture has the following limitations.
l

l

l

l

You must manually push templates, assets, private assets, uploaded images, and
uploaded files from the Application tier to the Presentation tier. You may use a tool like
Robocopy to do this.
You create content (HTML, assets, PageBuilder pages, and so on) only in the Application
tier. You can only view content from Presentation tier.
Because 3-tier architecture uses WCF, it requires:
o the 8.5 or higher Framework API and databinding. You cannot use API calls outside
of the Framework API
o

templated server controls

o

widgets created by the Framework API

Because the business logic executes on the Application tier, its website directory must
be identical to the Presentation tier's.

Impact of 3-Tier Setup on a Developer
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The Unity Framework provides the same developer experience, whether you use 2- or 3-tier
architecture, by defining which container to use in the web.config file. See Also: Introduction
to Unity, Creating a Sample Content Block in 3-Tier Architecture on page 1597
NOTE: You do not need to know about the Unity Framework—it is mentioned here to help you understand
how Ektron achieves 2-tier and 3-tier architecture.
Ektron has 3 main containers, which transmit data between tiers.
l

l

l

Business object (BusinessObjects.Content)
o contains the implementation of business logic for Ektron
o

used in 2-tier architecture

o

in 3-tier architecture, executed in the Application tier

WCF service proxy (Framework.Services.Content.ContentServiceClient)
o used in 3-tier architecture to communicate between Application and Presentation
tiers
Cache (BusinessObjects.Caching.Content)
o Ektron uses the Unity Framework to insert a caching layer
o

When an API call is made (or a templated server control is used) from the
Presentation tier, Ektron caches frequently-used objects

o

Caching minimizes API calls between Application and Presentation tiers
NOTE: Caching uses a provider model. By default, Web caching is implemented, but you can
replace it with other caching options.

The following chart shows how the Framework API uses the containers.
1. Content manager gets initialized and implements the IContentManager interface.
2. The Presentation tier uses the container specified in web.config. In web.config, if
defaultContainer= “Default”, the Presentation tier first looks in cache for the
requested data object. If the data object is not there, the Presentation tier looks in the
ChildContainer property value, which is WCF by default.
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This section also contains the following topics.
Setting up 3-Tier Architecture
Creating a Sample Content Block in 3-Tier Architecture
Creating a PageBuilder Page with 3-Tier Architecture
Aliasing with 3-Tier Architecture
Using eSync with 3-Tier Architecture
Using Search with 3-Tier Architecture
Using Microsoft FAST Search Server 2010 with 3-Tier Architecture
Additional 3-Tier Architecture Resources
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Setting up 3-Tier Architecture
1. On your Web Application server, install an Ektron website to the site root folder (if you
don’t already have one). During installation, install the Ektron database to a remote SQL
Server.
NOTE: The 8.5 and higher installation includes a startersites\3TierMin\Content folder
that contains files needed for the Presentation tier.
2. On the Web application server, copy the C:\Program Files
(x86)\Ektron\CMS400vxx\startersites\3TierMin\Content folder.
3. On the Presentation tier server, paste that folder to the website root folder.
4. On the Presentation tier server, open IIS and make the new folder a website. See Also:
Creating Multiple Websites on a Single Server on page 86
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5. On the Presentation tier server, open the site root/web.config file.
6. Update ek_ServicesPath to point to the workarea/services folder on your Application
tier server.
<appSettings>
<!-- This is the path to your CMS App Site.
It should always end in workarea/services/ -->
<add key="ek_ServicesPath" value="http://[YOUR_CMS_SERVER]
/workarea/services/" />
</appSettings>

7. If you want to turn on caching, set the following values in the web.config file:
<ektron.cacheProvider defaultProvider="webCache">
<providers>
<add name="webCache" cacheTimeSeconds="300"
type="Ektron.Cms.Providers.Caching.WebCacheProvider,
Ektron.Cms.Providers" />
</providers>
</ektron.cacheProvider>

8. Make sure the value of the framework defaultContainer tag is Cache, and the
framework childContainer tag is WCF.
<framework defaultContainer="Cache" childContainer="WCF">
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9. Open a browser and browse to your site.
10. Deploy templates and supporting files to the Presentation server.
Files Copied to the Presentation Tier
The following lists files are copied from the Application tier server to initialize the
Presentation tier after you complete the set up. The files are located in the
startersites\3TierMin\Content folder.
l

l
l

l

l

App_Code folder—contains URL Aliasing module See Also: Aliasing with 3-Tier
Architecture on page 1599
Bin folder—subset of full bin folder; contains binaries for Presentation tier only
Workarea folder—subset of full Workarea folder; Framework UI is required to run
templated controls and PageBuilder controls on Presentation tier
The following configuration files:
o Ektron.cms.framework.ui—contains default templates for templated server
controls
o

Ektron.cms.framework.unity—has mapping interfaces and implementation

o

Ektron.cms.framework.ui.unity—has mapping for templated control to services

Within web.config
o Within <configsections> tags— <sectionGroup> settings define how the
Presentation tier communicates with the Application tier
o

ek_ServicesPath—defines the path to the Application tier's Web services file

o

The following UI elements for templated server controls
<ui.unity configSource="ektron.cms.framework.ui.unity.config" />
<ui configSource="ektron.cms.framework.ui.config" />

l

The <ektron.framework.services> tag defines the container.
<ektron.framework.services>
<unity configSource="ektron.cms.framework.unity.config"/>
<framework defaultContainer="Default" childContainer="WCF"/>
</ektron.framework.services>

If defaultContainer= “Default”, the Presentation tier first looks in cache for the requested
data object. If the data object not there, the Presentation tier looks in the ChildContainer
property value, which is WCF by default.
l
l

content of <pages> tag. Controls used by PageBuilder and templated server controls.
The <modules> section manages Aliasing. See Also: Aliasing with 3-Tier Architecture on
page 1599
<system.webServer>
<modules runAllManagedModulesForAllRequests="true">
<add name="EkUrlAliasModule" type="UrlAliasingModule"
preCondition="integratedMode"/>
</modules>
</system.webServer>

Creating a Sample Content Block in 3-Tier
Architecture
Ektron 8.7
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This example illustrates how the same code can work in the Application and Presentation
tiers. Ektron uses the Framework API to get a content item.
1. In Visual Studio, open the Presentation tier's website.
2. Add a new Web form.
3. Add a label control that can render a content block.
<asp:Label ID=”contentblock1” runat=”server”> </asp:Label>

4. Open the form’s code-behind file.
5. Insert the following code.
NOTE: This example assumes that ID 30 is a valid content item in Ektron.
long id = 30;
if (!string.isNullorEmpty(Request.QueryString[“id”]))
{ long.TryParse(Request.QueryString[“id”].ToString(), out id);
}

6. While in the code-behind file, initialize content manager as the logged in user.
ContentManager contentManager = new ContentManager();

7. Get the content and return it to the asp Label control.
ContentData data = contentManager.GetItem(id);
contentblock1.Text = data.Html;

8. Build and run.
9. Open a Web browser.
10. Insert the Presentation server/page you just created into your browser address field,
where you will see Ektron content through the Presentation tier.

Creating a PageBuilder Page with 3-Tier
Architecture
PREREQUISITES
l

l

A PageHost file in the Presentation tier used specifically to support 3-tier
architecture. The file lets you view only; you cannot edit.
A widget built using the Framework API (for example, the sample Content Block
widget)
NOTE: While a 3-Tier site contains many widgets, only those built using the Framework
API work on the Presentation tier.

l

A wireframe template (content.pb.aspx) that exists on the Application and
Presentation tiers.

1. Go to the Application tier website's Workarea.
2. Create a sample PageBuilder page. See Also: Developing Wireframe Templates on
page 676
3. Navigate to a folder to which the content.pb.aspx wireframe template is applied.
4. Create new Page Layout.
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5. Drag and drop a content block widget onto the page layout and assign an Ektron content
item.
6. Publish.
7. Browse to the Presentation website to see the content.

Aliasing with 3-Tier Architecture
URL Aliasing works within 3-tier architecture. See Also: Creating User-Friendly URLs with
Aliasing on page 835
NOTE: Aliasing code is stored in the App_Code/CSCode/UrlAliasingModule.cs file.
PREREQUISITE
3-tier architecture requires the Aliasing module files (UrlAliasingModule.cs and
UrlAliasingBase.cs in the App_Code/CSCode folder), and the registration of that
module in the web.config file. To verify the registration:
1. In the Presentation website, open siteroot/web.config. See Also: Setting up
3-Tier Architecture on page 1595
2. Go to the <Modules> tag.
3. Verify that the URL alias module is registered, as shown in the following code.
<modules runAllManagedModulesForAllRequests="true">
<add name="EkUrlAliasModule" type="UrlAliasingModule"
preCondition="integratedMode" />
</modules>

To test the URL aliasing, follow these steps.
1. Go to the Application tier website.
2. Create a content block.
3. On its Alias tab, enter a manual alias.

4. On the Template tab, choose a template that exists on the Application and Presentation
tiers.
5. Publish the content.
6. Verify that Aliasing works on the Application tier.
7. Verify that Aliasing works on the Presentation tier.
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Using eSync with 3-Tier Architecture
You may use eSync to move files among tiers and sites, but eSync is not a prerequisite of 3tier architecture.
You can use eSync to move changes from the development to the staging to the production
sites. You also can use eSync to move changes from the Data to Application tier. Then, use
Web Services to move files from the Application tier to the Presentation tier. However, see
Limitations of 3-Tier Architecture on page 1593.
Using search with 3-tier architecture

Using Search with 3-Tier Architecture
If you use Microsoft Search Server 2010 with 3-tier architecture, you do not need to make
any adjustments.
To use Microsoft FAST Search Server 2010 search with 3-tier architecture, see Distributing
Resources with 3-Tier Architecture on page 1591.
Using Microsoft FAST Search Server 2010 with 3-tier architecture

Using Microsoft FAST Search Server 2010 with 3-Tier
Architecture
If you are using Microsoft FAST Search Server 2010 for your presentation layer, follow these
steps to prepare it for FAST.
1. Open the presentation layer's site root/ektron.cms.framework.unity.config file.
2. Locate the following line.
<typeAlias alias="BusinessObjects.ISearchProvider"
type="Ektron.Cms.Search.SS2010.SS2010SearchProvider, Ektron.Cms.Search"/>

3. Replace that line with the following line.
<typeAlias alias="BusinessObjects.ISearchProvider"
type="Ektron.Cms.Search.FS2010.FS2010SearchProvider, Ektron.Cms.Search"/>

Additional 3-Tier Architecture Resources
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l

The 3-Tier Architecture (Ektron 8.5 and newer)

l

Advanced Development in a 3-Tier Environment (Ektron 8.5 and newer)

l

Your Questions Answered - '3-Tier or 2-Tier'

Ektron Reference

34

Using Ektron Building Block
Server Controls

Ektron Reference

1601

Using Ektron Building Block Server Controls

Ektron building block server controls provide the basic modular components used to construct
a website with easy-to-use server controls. These controls allow your site to use themes, and
complex coding is reduced.
Ektron building block server controls are based on jQuery, a commonly used open source
library that makes Web development easy and the user interface engaging. See Also:
www.jquery.com.
l

Ektron extends jQuery functionality to easily integrate into .Net code and Ektron best
practices. While simplifying the coding effort with server controls and reducing the codebehind work, it also provides basic functionality for the developer to build on simple
components to quickly create highly functional Web pages. Input fields extend Microsoft
WebControls and only expose properties that are useful to the designer. In many cases,
user input can be limited to particular data types and value ranges.

IMPORTANT: The Ektron Developer Reference site contains documentation and examples of the
Framework UI, Framework API, and templated controls.

How Templated Server Controls Work
Server controls that have a template property lets a developer do more with the UI
components and styles without using extensive XSLT.
You can modify the user interface of server controls with markup inside the <ItemTemplate>
element as shown in the following code.
<ServerControl [properties]>
<ItemTemplate>example html markup and eval functions
<p><%# Eval([Model Property]) %></p>
</ItemTemplate>
</ServerControl>

In this example, ServerControl has a property called ItemTemplate. The ItemTemplate
allows markup that describes UI components rendered in the browser.
All controls in the namespace EktronUI use their name in the outermost wrapper of the HTML.
This provides an easy way to adjust margins and padding styles for specific controls. The
naming convention for this class is ektron-ui-control. For example, when using the
EktronUI: EktronDatePicker, you will see this html rendered to your browser.
<span id="ctl00_datepicker1_DatePicker_uxDatePicker" class="ektron-ui-datepicker">

An exception to this rule is EktronUI:Blueprint, which is a wrapper control.
For more information, see:
l

ASP.NET Web Server Controls Templates

l

How to: Create ASP.NET Web Control Templates Declaratively

Adding UI Server Controls into Visual Studio
1. Open your Ektron project in Microsoft Visual Studio 2010.
2. Open the Visual Studio Toolbox.
3. Add a tab and give it a name like EktronUI Controls.
4. Right click and select Choose Items....
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5. Click Browse.
6. Choose siteroot/bin/Ektron.Cms.Framework.UI.Controls.EktronUI.dll
7. Click OK. The controls appear on the Toolbox tab.

Building Block Server Control Common
Properties
l

l

l

l

l
l

l

l

AppRelativeTemplateSourceDirectory (String)—Gets or sets the application-relative
directory of the System.Web.UI.Page or System.Web.UI.UserControl object that
contains this control.
Attributes (AttributeCollection)—Sets the collection of arbitrary attributes (for
rendering only) that do not correspond to properties on the control.
ClientIDMode—Gets or sets the algorithm that is used to generate the value of the
ClientID property.
o AutoID—Sets the id automatically depending on the heirarchy of the nested
element.
o

Inherit—Inherits from the immediate parent element's ID.

o

Predictable—Used if the control is in data-bound control

o

Static—Sets the clientID of the control.

Controls (ControlCollection)—Provides a collection container that enables ASP.NET
server controls to maintain a list of their child controls.
ControlStyle (Style)—Gets the style of the Web server control.
ControlStyleCreated (Boolean)—Gets a value indicating whether a
System.Web.UI.WebControls Style object has been created for the
System.Web.UI.WebControls.WebControl.ControlStyle property.
ControlStyleCreated (Boolean)—Gets a value indicating whether a
System.Web.UI.WebControls Style object has been created for the
System.Web.UI.WebControls.WebControl.ControlStyle property.
CssClass—Gets or sets the Cascading Style Sheet (CSS) class rendered by the control
on the client.

l

HasAttribues (Boolean)—Sets a value indicating whether the control has attributes set.

l

ID (String)—Gets and sets the programmatic identifier assigned to the server control.

Ektron 8.7
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l

l

l

l

l

l

l

l

l

l

l

1604

NamingContainer (Control)—Sets a reference to the server control’s naming
container. This creates a unique namespace for differentiating server controls with the
same System.Web.UI.Contorl.ID property value.
Page (Page)—Gets a reference to the System.Web.UI.Page instance that contains the
control.
Parent (Control)—Sets a reference to the server control’s parent control in the page
control hierarchy.
RenderingCompatibility (Version)—Sets a value that specifies the ASP.NET version
that is compatable with the rendered HTML.
Site (ISite)—Sets information about the container that hosts the current control when
rendered on a design surface.
Style (CssStyleCollection)—Gets a collection of text attributes that is endered as a style
attribute on the outer tag of the Web server control.
SupportsDisabledAttribute (boolean)—Sets whether the control should set the
disabled attribute of the rendered HTML element to “disabled” when the control’s
System.Web.UI.WebControls.WebControl.IsEnabled.
TemplateControl (TemplateControl)—Gets and sets a reference to the template that
contains this control.
TemplateSourceDirectory (String)—Sets the virtual directory of the
System.Web.UI.Page or System.Web.UI.UserControl that contains the current server
control.
UniqueID (String)—Gets the unique hierarchically qualified identifier for the server
control.
Visible—Gets or sets a value indicating whether the control and all its child controls are
displayed.
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A server control uses API language to interact with the CMS and Framework UI to display the
output. You can drag and drop a server control onto an ASPX page to coexist with other
components. This includes control for almost everything from content, to user management,
breadcrumbs, and social network controls—to provide out-of-the-box markup and
functionality. In addition to having a set of properties that you can use to change the controls'
output and behavior, you can access the server control API. Server Control Reference on
page 1636 describes the Ektron server controls.
Ektron’s server controls let you insert many standard methods and properties within the
Visual Studio environment. This means that you can see the effect of your changes in real
time—you do not have to modify a page then compile a sample project to see the results.
You can insert server controls using drag and drop or programmatically. You can also use
databinding to retrieve and display data from Ektron.
Additional information and examples for Ektron server controls are available online after you
install the following sample site.
http://localhost/samplesite/Default.aspx
Replace localhost with the webroot where you installed the sample site.
IMPORTANT: For improved security,you should rename or remove the Web services file when you move
it to your production server. After installation, this file is named ServerControlWS.asmx in the
/siteroot/Workarea/ folder in your Web root.
ServerControlWS.asmx is the Web service that lets server controls communicate with
Ektron. The path is coded in the web.config file, as follows. Edit this line if you change the
location or name of the ServerControlWS.asmx file.
<!-- Web Service URL for Server Controls design time -->
<add key="WSPath"
value="http://localhost/siteroot/Workarea/ServerControlWS.asmx" /

This section also contains the following topics.
Server Control Reference
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Installing Server Controls
This section describes how to install server controls (other than Search Server controls; to
install those, see Adding Search Server Controls to Visual Studio on page 975).
NOTE: You must copy the dlls to a local drive before installing them. You cannot copy them from a
network drive.
1. Display the Visual Studio 2010 toolbox (View > Toolbox).
2. Right click the mouse within the Toolbox and click Add Tab.
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3. Type Ektron Server Controls then press Enter.

4. Click the Ektron Server Controls tab to open it.
5. Right click the mouse in the empty area and click Choose Items. The Customize
Toolbox dialog appears.

6. Click Browse... on the .NET Framework Components tab and find the directory that
stores Ektron‘s dll files (siteroot/bin).
7. Select Ektron.Cms.Controls.dll file and click Open. This file provides access to
Ektron’s server controls.
NOTE: Alternatively, you could use the following location, C:\Program
Files\Ektron\CMS400vxx\bin. The file is identical in both places. Using the bin folder in your
site provides better speed when loading Web pages. However, if you use the bin folder located in
Program Files, you do not have to worry about deleting the .dll file if you change or delete your site.
8. Click OK on the Choose Toolbox Items dialog box. The controls are added to the Ektron
Server Controls tab of the Visual Studio Toolbox.
For easier viewing once the server controls are installed, you can right click on them and
select Sort Items Alphabetically. You can only see the server controls when an ASPX
template is selected.
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Removing Server Controls from the Visual Studio
Toobox
1. Display the Visual Studio toolbox (View > Toolbox).
2. Right click the mouse within the Toolbox.
3. Click Choose Items....
4. Click Namespace or Assembly Name to sort the server controls by manufacturer.
5. Uncheck boxes next to the server controls you want to remove.
6. Click OK.
NOTE: If you want to delete all of the server controls from the Ektron Server Control tab, right
click on the tab and choose Delete Tab.

Opening a Sample Project in Visual Studio
1. Using Visual Studio, choose Open > Project/Solution and browse to and double click
Ektron‘s solution file, localhost/siteroot/projectname.sln. For example, for the
OnTrek sample site, the file is OnTrek.sln. The sample site project opens.
2. To work on a template page, open the Solution Explorer and click the page you want.

When you select a page, its properties appear in the Properties Window, and the page
appears in the center of the screen. A control’s properties include several standard .NET
properties along with Ektron-specific ones. The Ektron properties are labeled as
illustrated below.
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Creating a New Template in Visual Studio
1. Choose Website > Add New Item....
2. On the Add New Item screen, click Web Form and assign a name.

Ektron 8.7
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3. Add controls to determine the page content.
After you open the solution file in Visual Studio and add the required files, build the project.
After the project is built, a browser opens and it appears as a Web page. You can also view a
Web page while working on it by right clicking on the Web form and clicking View in
Browser.

Browsing Your Ektron Site Using CMS Explorer
CMS Explorer lets you browse your website to identify Ektron objects such as folders,
calendars, blogs, and content blocks. You access the CMS Explorer from the Properties
window. For example, if you insert a ListSummary server control, its FolderID property
identifies the folder whose contents are displayed.
1. If you are not sure of the folder path, click the ellipsis (...) button next to the property
field. A login screen appears.
NOTE: You cannot be logged into the CMS Explorer and the Workarea at the same time. If you log
into the CMS Explorer while logged into the Workarea, an error message appears. If you log into the
Workarea while logged into the CMS Explorer, you will need to re-login to the CMS Explorer when
you return to using it.

2. Enter your Ektron username and password. The CMS Explorer window appears so you
can browse your Ektron website.

3. Navigate through the folders, select an object, then click Select. The selected object is
pasted to the server control property.
NOTE: Although you see the object in the selected language in Visual Studio, the language is not
stored. For example, if you select a German content block whose ID=2, Ektron only stores
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content block ID=2. When a visitor to your site browses to that page, the content block does
not appear in the selected language. Instead, it is determined by a cookie or the user’s language
selection.

Inserting a Server Control Using Drag and Drop
Because Visual Studio is a visual environment, you can watch the page layout change as you
add or move a control and adjust its properties. Use the CMS Explorer whenever you need to
identify an Ektron object (such as content block or collection).

Ektron 8.7
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1. Display the Visual Studio toolbox (View > Toolbox).
2. Click the Ektron Server Control tab. Ektron’s server controls appear.

3. Drag a server control and drop it into the desired location on the page.
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4. As desired, modify the control’s properties using the Properties window of Visual Studio.

Modifying a Server Control after Drag and Drop
You can manipulate a server control after dragging and dropping it on a Web form by using
the code-behind. The following example shows using a drag and drop ListSummary server
control then modifying it programmatically.
1. Drag and drop a ListSummary on your Web form and set your properties.

Ektron 8.7
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2. Add the following code to the code-behind.
Dim myString As String
Dim i
For i = LBound(ListSummary1.EkItems)To UBound(ListSummary1.EkItems)
myString &= "<a href=""" & ListSummary1.EkItems(i).QuickLink & """>"
& ListSummary1.EkItems(i).DateCreated & "</a><br>"
ListSummary1.Text = myString
Next

ListSummary1 is the ID of the object. It is used to get access to its properties.
3. Create a string that contains the output (myString).
Dim myString As String

4. Set the object’s Text property to that string.
myString &= "<a href=""" & ListSummary1.EkItems(i).QuickLink & """>"
& ListSummary1.EkItems(i).DateCreated & "</a><br>"

5. Wrap in a loop so it loops through each of the items.
Dim i
For i = LBound(ListSummary1.EkItems) To UBound(ListSummary1.EkItems)
Next

This example outputs the date created for each content block in a List Summary.

Inserting a Server Control Programmatically
You can insert server controls programmatically for several reasons:
l

l

You want the control to be loaded into memory only under certain conditions. In this
case, insert the logic that only displays the control if the condition exists.
You want to display only certain properties of an object, such as the title of last edited
date of a content block.

To insert an Ektron server control programmatically:
1. Declare the Namespace at the top of the code-behind Visual Basic file.
NOTE: You do not need to declare a namespace. However if you do not, you must fully qualify
objects that you create. For any customization of Ektron, classes or controls that inherit from Ektron
classes, you should create your own namespace within 'Ektron.Cms.Custom'. For example, if your
company is 'AcmeExampleTech, Inc.' you should create all of your custom classes within the
namespace 'Ektron.Cms.Custom.AcmeExampleTech'.
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2. Create an instance of the new control by declaring a control as an object in the codebehind; in this example, a collection named MyColl.
Ektron.Cms.Controls.Collection MyColl =
new Ektron.Cms.Controls.Collection();

You can declare any server control as an object by using the server control name. See
Working with Ektron Server Controls on page 1605. Another example would be: Dim
MyMdl as New MetaDataList.
3. Set the properties that you want to display on the page. For example:
Dim MyColl as New Collection
MyColl.DefaultCollectionID = 4
MyColl.Page = Page

For descriptions of the properties and how to use them, see Accessing Server Control
Properties in Code-behind Programmatically on the next page.
With C#, use this syntax.
>
Ektron.Cms.Controls.Collection MyColl =
new Ektron.Cms.Controls.Collection();
MyColl.DefaultCollectionID = 4;
MyColl.ID = “Collection1”;
MyColl.Page = Page;

These lines tell the page to display CollectionID 1 unless otherwise specified.
IMPORTANT: When using code-behind to add a server control to your Web form, you must set the
Page object for the server control to Page. For example, Mycoll.Page = Page
This line needs to appear between Dim new server control line and the Fill() line. This line is not
added when dragging and dropping a server control on a Web form. See Also: Referencing a Parent
Page on page 1621.
If you do not know an object’s ID number, you can switch to Design mode, drag and drop
the object, then use the CMS Explorer to find the ID number. (See Browsing Your Ektron
Site Using CMS Explorer on page 1610.) If you do this, remember to delete the dropped
object when you are done. You can also obtain the ID number via the Workarea. This line
sets the Random property to true.
Dim MyColl as New Collection
MyColl.ID = “Collection1”
MyColl.DefaultCollectionID = 4
MyColl.Page = Page
MyColl.Random = True

4. Call the Fill method to fill an object’s properties on the page because there is no render
event when using objects as components not as controls.
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>
Dim MyColl as New Collection
MyColl.ID = “Collection1"
MyColl.DefaultCollectionID = 4
MyColl.Page = Page
MyColl.Random = True
MyColl.Fill()

5. Use the property to determine what appears on the Web page. For example, to display
the first item in a collection, use this syntax.
NOTE: Before adding this line you need to drag and drop a label on your Web form.
>
Dim MyColl as New Collection
MyColl.ID = “Collection1”
MyColl.DefaultCollectionID = 4
MyColl.Page = Page
MyColl.Random = True
MyColl.Fill()
Label1.Text = myColl.EkItems(0).Title

To display all items in a collection, use this syntax.
Dim myColl As New Ektron.Cms.Controls.Collection
Dim ekitem As New Ektron.Cms.Common.ContentBase
MyColl.DefaultCollectionID = 2
MyColl.ID = “Collection1”
MyColl.Page = Page
MyColl.Fill()
Label1.Text = "<ul>"
For Each ekitem In myColl.EkItems
Label1.Text &= "<li><a href=""" & ekitem.QuickLink & """>"
& ekitem.Title & "</a>"
Next
Label1.Text &= "</ul>"

This example displays the quick link for every content block in the collection, formatted
as a bulleted list. You can use similar code to display a List Summary or search results.
The following explains the new (red) code above.
l
l

l

label1.Text = "<ul>" displays the opening tag for the bulleted list
For Each ekitem In myColl.EkItems creates a loop for all content blocks in the
collection
label1.Text &= "<li><a href=" & ekitem.QuickLink & ">" & ekitem.Title
& "</a></li>" for each content block in the collection, displays its quicklink and
title

l

Next loops through all content blocks in the collection

l

label1.Text &= "</ul>" closes the bulleted list

Accessing Server Control Properties in Codebehind Programmatically
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Every server control has properties associated with it that you can access only
programmatically. This section explains what they are, how to access them, and how to use
them.
You can use Visual Studio’s intellisense feature to display a control’s properties. The
intellisense box appears as soon as you insert the period (.) after the object, as illustrated
below.

The intellisense box displays all properties that can be applied. To learn about native Visual
Studio properties, see the Visual Studio documentation.
The property’s tooltip text indicates its type. In the previous example, note that the
DefaultCollectionID’s type is integer.
For more information about accessing Ektron object properties, see Customizing a Server
Control in the code-behind on page 1623.

Personalizing a Page with User Names and IDs
Every server control has the following read-only properties in the code-behind that let you
personalize any page with user names and IDs, and show if they are logged in.
NOTE: The properties do not display values within Visual Studio during design time. Instead, they only
display values at run time, which are dependent on the user’s login status.
l

IsLoggedIn (Boolean)
Tells if a user is logged in to Ektron.

l

o

True—User is logged in

o

False—User is not logged in

LoggedInUserName (String)
Gets the Ektron user name to display.

l

LoggedInUserID (Integer)
Gets the Ektron ID of the user to display.

The following example shows these properties in code-behind.
NOTE: You must be logged in to Ektron for this example to show your name and ID.
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1. Drag an Ektron server control onto a Web form.
2. Drag 3 Literals onto the Web form.

3. Open the code-behind for the Web form.
4. Add the following code to the Page_Load event.
Literal1.Text = ContentBlock1.IsLoggedIn
If ContentBlock1.IsLoggedIn Then
Literal2.Text = ContentBlock1.loggedInUserName
& " is logged in " Literal3.Text = ContentBlock1.loggedInUserID
& " is the User ID "
End If

5. Build and run the solution.
6. Browse to the login page and log in.
7. Browse to the new Web form you added. The login information appears.

Accessing Additional Properties
Ektron provides access to additional properties for the following objects.
l

ListSummary

l

collection

l

Search

l

ContentBlock

l

FormBlock

You can use intellisense to select from a list of additional object properties.
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To access additional properties, use the standard property's syntax but add .ekitem or
.ekitems after the object.
l

EkItem is a single Ektron.Cms.Common.ContentBase

l

EkItems is an array of Ektron.Cms.Common.ContentBase

dim MyCB as New ContentBlock
MyCB.DefaultContentID = 30
MyCB.ID = “ContentBlock1”
MyCB.Page = Page
MyCB.Fill()
label1.text = MyCB.EkItem.dateCreated

or
dim MyCB as new Ektron.Cms.Controls.ContentBlock
MyCB.DefaultContentID = 30
MyCB.ID = “ContentBlock1”
MyCB.Page = Page
MyCB.Fill()
label1.text = MyCB.EkItem.dateCreated

IMPORTANT: To access additional properties for the Collection, ListSummary, and Search objects, use
ekitems, not ekitem. For example: MyColl.ekitems(0).dateCreated. where (0) is the index of the
array.See Also: Accessing Items in an Array on page 1621.
The additional properties are as follows.
NOTE: The following properties are read-only. For example, you can get a content block’s ID and pass it
to another part of the code. However, you cannot set a content block ID to be shown.
For example, mycb.Ekitem.id = 8 does not set a content block’s ID. To set a content block's ID,
use DefaultContentID = 8.
l

Comment—The content block’s comment.

l

ContentStatus—The status of the content block. See Content Statuses on page 307.

l

ContentType—One of the following: See Scheduling Content on page 296.
o all types
o

archived content

o

archived forms
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l

l

l
l

l

l

l

l

l

l

l
l

l

content

o

forms

DateCreated—The date when the content block was created, formatted as a .NET date
type.
DateModified—The date when the content block was modified, formatted as a .NET
date type.
DefaultXslt—The default XSLT used to display the content.
DisplayDateCreated—The date when the content block was created. It is formatted as
a string that represents Ektron’s display of the date.
DisplayDateModified—The date when the content block was edited. It is formatted as
a string that represents Ektron’s display of the date.
DisplayEndDate—The content block’s end date. It is formatted as a string that
represents Ektron’s display of the date. See Scheduling Content on page 296.
DisplayGoLiveDate—The content block’s start date. It is formatted as a string that
represents Ektron’s display of the date. See Scheduling Content on page 296.
DisplayStartDate—The content block’s start date. It is formatted as a string that
represents Ektron’s display of the date. See Scheduling Content on page 296.
EndDate—The content block’s end date, formatted as a .NET date type. See Scheduling
Content on page 296.
EndDateAction—One of the following: See Scheduling Content on page 296.
o archive display
o

archive expire

o

refresh report

FolderID—The ID of the folder that contains each content block.
GoLiveDate—The content block’s start date formatted as a .NET date type. See
Scheduling Content on page 296.
Html—The content that makes up the content block. If content block is in XML it will
return it as raw XML content.

l

Hyperlink—Content block title wrapped by <a href> tags.

l

Id—The content block ‘s ID number.

l

l
l

l

InheritedFrom—If folder permissions are inherited, the folder from which they are
inherited.
IsInherited—Whether a content block’s permissions are inherited.
IsPrivate—Whether or not a content block is private. See Making Content Private on
page 294.
Language—The content block’s language. See Working with Multi-Language Content on
page 1057.

l

LastEditorFname—The first name of the last person to edit the content block.

l

LastEditorLname—The last name of the last person to edit the content block.

l

PackageDisplayXSLT—If the content block is XML, the name of its XSLT.

l

l
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QuickLink—The content block’s quicklink. See Adding a Quicklink or Form to Content on
page 346.
StartDate—The content block’s start date formatted as a .NET date type. See
Scheduling Content on page 296.
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l

Status—The status of the content block. See Content Statuses on page 307.

l

Teaser—The content block summary. See Writing a Summary for Content on page 292.

l

TemplateLink—Currently empty and not being used with the ContentBlock server
control.

l

Title—The content block title.

l

UserID—Last user who edited the content.

l

Xslt1—The content block’s first Xslt, as defined in Ektron.

l

Xslt2—The content block’s second Xslt, as defined in Ektron.

l

Xslt3—The content block’s third Xslt, as defined in Ektron.

l

l

Xslt4—The developer can use this property programmatically. Ektron only uses Xslt1, 2
and 3 in the workarea.
Xslt5—The developer can use this property programmatically. Ektron only uses Xslt1, 2
and 3 in the workarea.

Accessing Items in an Array
To access and manipulate content blocks returned by an object, use the common class
Ektron.Cms.Common.ContentBase. For example, Search, Collection and ListSummary have
EkItems (an array of ContentBase), while ContentBlock has a single EkItem. This example
creates a bulleted list of every item in the collection.
dim MyC as new Ektron.Cms.Controls.Collection
MyC.DefaultCollectionID = 1
MyC.ID = “Collection1”
MyC.Page = Page
MyC.Fill()
dim item as Ektron.Cms.Common.ContentBase
MyC.Text = "<ul>"
for each item in MyC.EkItems
MyC.Text &= "<li>" & item.Title & "</li>"
next
MyC.Text &= "</ul>"
Response.Write(MyC.Text())

NOTE: For information on using ekitems with eCommerce server controls, see Using the Cart Server
Control on page 1406.

Referencing a Parent Page
Server controls require a reference to their parent page (for example, using the
DynamicParameter property on a content block to check for a query string). You must provide
access to the page object if you declared your control in the code-behind. To do this, set the
control's Page property to the Web page you're working on, as shown in the following
example.
Ektron.Cms.Controls.Search MySearch = new Ektron.Cms.Controls.Search();
MySearch.Page = Page;
MySearch.Fill();

Ektron 8.7
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This relationship only is required when inserting a control in the code-behind. When dragging
and dropping, even if you make changes in code-behind, the relationship is automatically
generated.
BEST PRACTICE
You should include the Page property reference when using server controls as
components in the code-behind.

Customizing a Server Control
Visual Studio separates coding and logic from presentation. Web page formatting is handled
by a page’s HTML, while the logic is handled by the code-behind, which is stored in the
corresponding .vb file. For example, if the ASP.NET page is mypage.aspx, the code-behind
file is mypage.aspx.vb.
NOTE: If you do not see the code-behind files, click Show All Files on the Visual Studio Solution
Explorer toolbar (circled in the following figure).

Within the Visual Basic file, you can use Visual Basic to insert code to manipulate the events
that occur on the page.
This subsection contains the following topics:
l

Viewing a Server Control in HTML below

l

Viewing a Server Control in the Code-behind below

l

Customizing a Server Control in the code-behind on the facing page

l

Troubleshooting Error Creating Control Message on the facing page

Viewing a Server Control in HTML
Within a Web page’s HTML, a <cms> tag wraps the Visual Studio object. The following is an
example of the Search and Contentblock server controls.
<cms:Search id="Search1" runat="server" ButtonText="Search"
Display="Vertical">
</cms:Search>
<cms:ContentBlock
id="ctrlMainContentBlock"
runat="server"
DefaultContentID="1"
DynamicParameter="id”
OverrideXslt="Default">
</cms:ContentBlock>

Viewing a Server Control in the Code-behind
1622
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Within a Visual Studio code-behind file, the Ektron server controls appear (along with the
Visual Studio controls) in the Web Form Designer Generated Code section. When you click +
to display this section, you see something like the following. The content block listed in HTML
(from the previous section) is circled to help you see their relationship.

The next section of the code-behind page loads the page into the browser.
Private Sub Page_Load(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles MyBase.Load

You want your events to occur while the page is loading, so add the custom code following
this line.

Customizing a Server Control in the code-behind
To customize an Ektron server control in the code-behind, insert code similar to the following
after the Page_load command.
Dim MyObj As New Ektron.Cms.Controls.ContentBlock

This code declares a variable named MyObj and assigns to it the value of a content block. The
content block is part of the Ektron.CMS.Controls content base, so it has access to the Ektron
database.
After defining MyObj as a content block, you can access its properties. For example, to assign
a defaultID of 24, insert the following.
Dim MyObj As New Ektron.Cms.Controls.ContentBlock
MyObj.DefaultContentID = 24

The content block can be specified dynamically in the URL of the hyperlink that calls it. If not,
content block 24 displays.
This is an example of programmatically applying property values to content blocks.

Troubleshooting Error Creating Control Message
If you get an Error Creating Control message while trying to use a server control, you can
view the message by hovering the mouse over the control.

Ektron 8.7
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Using Ajax-Enabled Server Controls and Custom Code
BEST PRACTICE
When using Ajax server controls and custom code, wrap the custom code in a check
for “is not a callback,” so it is not executed when a callback from an Ajax server
control occurs.
If you use an Ajax-enabled server control and write custom code, it may generate an
exception, indicating the server control does not work. This issue happens during callback for
the Ajax server control when custom code accesses a property that is filled during page load,
but not filled during callback.
For example, a Poll server control is on a Web form, and you want the title of a content block
to appear in a literal on that form. The EkItem.Title property for the content block is filled
upon page load. When a site user answers a poll question, an exception occurs during the
callback because the EkItem.Title property is not refilled. However, the site user does not
see the exception because it looks like the Poll server control is not working.
The following example shows custom code that makes the content block’s title appear in the
literal:
Literal1.Text = ContentBlock1.EkItem.Title

To solve this issue, wrap the custom code in a check for “is not a callback”. This prevents the
code execution when callback occurs. For example:
[C#]
If( !IsCallback )
{
Literal1.Text = ContentBlock1.EkItem.Title
}
[VB]
If
( Not IsCallback )
Literal1.Text = ContentBlock1.EkItem.Title
End If

Data Binding with Server Controls
With data binding, you can bind Ektron server controls to a GridView Control, DataList
Control, or Repeater Control. This gives more flexibility when you use data from the Ektron
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server controls. Benefits of data binding include ease of data manipulation and the ability to
format data.
WARNING! When HTML is bound to a column, you need to add HtmlEncode = False to it.
Otherwise, the HTML appears as code. For example, <p>Ektron Inc., an innovator in Web
content management software, today announced...</p>.
The following are data bindable Ektron server controls.
l

Collection

l

ContentList

l

IndexSearch

l

ListSummary

l

MetaDataList

l

RssAggregator

The following example shows code-behind that uses a GridView to display a Collection:
NOTE: For the example code to work properly, you need to drag and drop a GridView server control on a
Web form.
Dim myCol As New Ektron.Cms.Controls.Collection
MyCol.ID = “Collection1”‘‘‘Create an ID for the Collection
myCol.DefaultCollectionID = 4
myCol.Page = Page
myCol.Fill()
GridView1.DataSource = myCol
GridView1.DataBind()

Steps to data binding using drag and drop server controls are as follows:
1. Create a new Web form.
2. Drag and drop a data bindable Server Control on the Web form. For example, a
Collection server control.

3. In properties, choose a DefaultCollectionID for the Server Control and make sure
DisplayXslt is set to None- DataBind Only.

Ektron 8.7
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4. Drag and drop a GridView on the Web form.

5. In the GridView Tasks, choose the DataSourceID.
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6. In code-behind, add the following line of code to the Page add field.gifnit event:\
Collection1.Fill()

7. Select the columns to be databound by clicking Add New Column in GridView Tasks.
8. Complete the Add Field window.

l

Choose a field type—BoundField

l

Header text—The title name for each column.

l

Data field—The data to bind to each column. Choose one of the following:
o ID—the content block ID
o

Title—the content block title

o

Teaser—the content summary

o

Html—the html content

o

StartDate—the content’s start date

o

DateModified—the content’s last modified date

o

EndDate—the content’s end date

o

LastEditorFname—the last editor’s first name

o

LastEditorLname—the last editor’s last name

o

QuickLink—the content’s quicklink

o

HyperLink—the content’s hyperlink

o

DisplayStartDate—the string representation of the start date

o

FolderID—the folder ID where the content is located

o

ContentStatus—the content’s status

o

Language—the content’s default language

o

DisplayDateModified—string representation of the content’s last modified
date

o

DisplayEndDate—string representation of the content’s end date

o

EndDateAction—an action tied to end date. For example, Refresh_Report

o

Comment—the content’s comments

9. Click OK.

Ektron 8.7
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10. Repeat steps 6, 7 and 8 for each column you want to add.

11. If you want to add all of the columns automatically, in the GridView Task menu click Edit
Columns. Otherwise, skip to step thirteen.

12. Click the Auto-generate fields checkbox.

13. Click OK.
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14. From the Build menu, click Build Page.
15. In design view, right click the form and select View in Browser.

For more information on GridView, DataList, Repeater and DetailsView, see the help inside
Visual Studio.

Caching with Server Controls
High-performance, scalable Web applications store items in memory after the first time they
are requested. The items include data objects, pages, and parts of a page. Caching saves and
later reuses page output or application data across HTTP requests. You can store items on the
Web server or other software in the request stream, such as the proxy server or browser.
Caching saves time and resources because the server does not have to recreate information,
particularly things that demand significant processor time or other resources. The following
image contrasts data flow in non-cached and cached environments.

Ektron 8.7
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Ektron provides 2 kinds of caching.
l

l

Caching While Logged In below—lets you cache part of a Web page; available with some
server controls
Page-Level Caching below—lets you cache an entire page while not logged in; available
with all server controls

Caching While Logged In
When a user is logged in, changes appear on the site only after time defined in the cache
interval. This reduces the number of database hits, which improves your server’s
performance. For example, if you add a new item to a Collection, the change only appears on
the site when the cache interval expires. In the meanwhile, use Preview mode to see the
updated Collection immediately.
The following server controls can cache individual content while you are logged in.
l

Collections

l

ContentList

l

DhtmlMenu

l

ListSummary

l

MetadataList

l

Menu

IMPORTANT: Caching while logged in does not work with Private content. See Also: Making Content
Private on page 294
To set up caching of content for a Web page:
1. Set the siteroot/Web.config file’s ek_CacheControls property’s value to “1”.
2. Add to a Web form a server control that supports caching of individual content.
3. Set the control's CacheInterval property to the number of seconds for which data
should be cached. For example, to cache for 5 minutes, set CacheInterval to 300.
The default value is 0 seconds. So, you must change the default to enable caching.

Page-Level Caching
The following controls can cache individual content while you are not logged in.
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l

ActiveTopics

l

All blog controls

l

Collections

l

CommunityDocuments

l

CommunityGroupBrowser

l

CommunityGroupList

l

CommunityGroupMembers

l

CommunitySearch

l

ContentBlock

l

ContentList

l

DhtmlMenu
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l

Directory

l

Favorites

l

FlexMenu

l

FormBlock

l

Forum

l

Friends

l

ListSummary

l

MetadataList

l

Menu

l

Poll

l

PostHistory

l

SiteMap

l

SmartMenu

l

TagCloud

l

UserProfile

The following example shows a page-level cache for non-logged-in users. You use a server
control to define whether a user is logged in, then define if the page is cached, based on the
user’s status.
1. Create a new Web form in your Ektron project.
2. Add the following text to the Web form:
Refresh the page. The page will cache for 20 seconds when not logged in:
Time is =

3. Next to Time is =, add a literal.

4. Below that, add a ContentBlock Server Control.
5. Set the DefaultContentID. For this example, DefaultContentID = 20.
6. Add the following to the Page_Load event in the code-behind.
If Not ContentBlock1.IsLoggedIn Then
Response.Cache.SetExpires(DateTime.Now.AddSeconds(20))
Response.Cache.SetCacheability(HttpCacheability.Public)
Response.Cache.SetValidUntilExpires(True)
Response.Cache.VaryByParams("id") = True

NOTE: On a PageBuilder page, you would use Response.Cache.VaryByParams("pageid")
= True.

Ektron 8.7
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Response.Cache.SetVaryByCustom("cmsCache")
End If
Literal1.Text = Now()

7. Build your Web form.
8. Browse to your Web form using a browser.
9. Press your browser’s refresh button. If you are not logged in to Ektron, the time remains
for twenty seconds. After twenty seconds, when you refresh, the new time appears.
NOTE: You can use the same code in a user control to cache output in a particular region of the
page.

Displaying Custom XML in Ektron’s Server
Controls
Several Ektron server controls have a CustomXml property to add custom XML to a control’s
generated XML before it is processed by its XSLT. Use the CustomXml property in code-behind
with these server controls:
l

Cart

l

Checkout

l

CurrencySelect

l

MyAccount

l

OrderList

l

Product

l

ProductList

l

ProductSearch

l

Recommendation

The following examples shows a C# usage of the CustomXml property in code-behind.
protected void Page_Load(object sender, EventArgs e)
{
product1.CustomXml =
"<banner>Save $$$ While Christmas Shopping!</banner>
<specials><special><link>ProductDemo.aspx?id=1013</link>
<text>A great gift for Dad!</text></special><special>
<link>ProductDemo.aspx?id=1015</link><text>
A great gift for Mom!</text></special></specials>";
}

The following example shows the XML sent to the XSLT file.
<root>
<customXml>
<banner>Save $$$ While Christmas Shopping!</banner>
<specials>
<special>
<link>ProductDemo.aspx?id=1013</link>
<text>A great gift for Dad!</text>
</special>
<special>

1632

Ektron Reference

Learning About Visual Studio

<link>ProductDemo.aspx?id=1015</link>
<text>A great gift for Mom!</text>
</special>
</specials>
</customXml>
</root>

Learning About Visual Studio
This section provides background information about Microsoft’s Visual Studio. For more
information, use the help feature installed with Visual Studio and Microsoft’s developer
Center (Microsoft Visual Studio).
NOTE: The following definitions are from Visual Studio Help.
l

l

Grid Layout—Absolute positioning attributes are inserted into elements that are added,
and updated in elements that are moved. Elements can be dragged across the Design
view surface. The positioning grid and Snap to Grid are available.
Flow Layout—Elements are added without absolute positioning attributes. Web
browsers arrange elements in the order that they occur on the page, from top to bottom.
You cannot drag elements across the Design view surface or use the positioning grid.

Grid layout is the default, which means that all controls drawn to the Web form in the
designer window have absolute positioning. Here is an example.
<body MS_POSITIONING="GridLayout">
<form id="Form1" method="post" runat="server">
<asp:Button id="Button1" style="Z-INDEX: 101;
LEFT: 160px; POSITION: absolute;
TOP: 80px" runat="server" Text="Button">
</asp:Button>
<asp:Button id="Button2" style="Z-INDEX: 102;
LEFT: 480px; POSITION: absolute;
TOP: 88px" runat="server" Text="Button">
</asp:Button>
<asp:GridView id="GridView1" style="Z-INDEX: 103;
LEFT: 208px; POSITION: absolute;
TOP: 152px" runat="server">
</asp:GridView>
</form>
</body>

In Grid layout, you can position your controls like a WYSIWYG editor with no knowledge of
HTML. However, because absolute positioning is not rendered consistently by all browsers,
the page layout can be flexible based on the size of other controls on the page, and the Web
browser window.
When other controls are dynamically populated, such as a GridView, controls that appear
beneath it in the Web form would be obscured if they were positioned absolutely at design
time. In addition, when utilizing globalization of pages with different languages, the size of
text areas can vary and cause obstructions.

Using Ektron’s Developer SDK
Ektron 8.7
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The Developer SDK for Ektron contains the following components to help you extend and
customize your site.
l

l

Developer API, which includes:
o Server Control API: An interface for calling the methods and properties of the
Ektron server controls. For additional information on the server controls, see
Introduction to Server Controls and the Developer API Documentation.
o

Web Services API: Exposes a method’s functionality for use with SOAP over
HTTP. For additional information on the Web Services, see Web Services and the
Developer API Documentation.

o

.NET Assembly API: Similar to the Business API provided in previous version, the
.NET Assembly API provides an interface for calling the methods and properties that
are exposed in Ektron. See Also: the Developer API Documentation.

Developer API Documentation
The API Documentation contains a detailed description of the functions included in each
of the APIs. To access the Developer’s API documentation in Visual Studio, choose Help
> Contents. Next, choose Ektron API Documentation from the list of contents. You can
also filter the documentation so you see only Ektron’s API documentation. Click Ektron
API Documentation in the filter drop-down box.
You can also access the API documentation online by clicking Ektron Developer
Reference.

l

Extensions
Extensions are developer-defined software modules that modify the behavior of Ektron.
In versions previous to Ektron version 8.0, developers used the Plug-in Extension Wizard
to extend the system. As of version 8.0, Extensions are preferred over the Plug-in
system.See Also: Customizing Behavior with Extensions on page 1867

l

Ektron Server Controls Toolbox
Ektron controls are installed with the Developer SDK. Server controls let you insert, via
drag and drop or programmatically, many standard methods and properties within the
Visual Studio environment. This means that you can see the effect of your changes in
real time -- you don’t have to modify a page then compile a sample project to see the
results.

An opportunity to install the Developer SDK appears during the installation or upgrade of
Ektron (see third checkbox from top in the following dialog box).

1634

Ektron Reference

Using Ektron’s Developer SDK

If Developer SDK is not checked during installation, you can install it by going to Windows
Start button > All Programs > Ektron > CMS400vxx > Utilities > CMS400SDK
Install.

Ektron 8.7
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Server Control Reference
This section also contains the following topics.
ActiveTopics
ActivityStream
Analytics Tracker
AssetControl
Blogs
Bookmarklet
BreadCrumb
Using the BreadCrumb Server Control
Displaying a Content Block’s Title in the Breadcrumb Trail
BusinessRules
Cart
Checkout
Collection
CommunityDocuments
CommunityGroupBrowser
CommunityGroupList
CommunityGroupMembers
CommunityGroupProfile
ContentBlock
ContentFlagging
ContentList
ContentReview
CurrencySelect
DesignTimeDiagnostic
Directory
Favorites
Flex Menu
FolderBreadcrumb
FormBlock Server Control
Forum
Friends (Colleagues)
ImageControl
Invite
LanguageAPI
LanguageSelect
ListSummary
Login
Map
Membership
Menu
MessageBoard
Messaging
Metadata
MetadataList
Micro-messaging
MyAccount
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1642
1644
1645
1661
1664
1668
1670
1671
1672
1673
1677
1685
1688
1691
1695
1698
1701
1707
1708
1712
1716
1717
1718
1723
1728
1736
1738
1740
1747
1750
1751
1754
1755
1756
1763
1765
1771
1781
1786
1790
1793
1796
1801
1804

ActiveTopics

OrderList
PhotoGallery
Poll
PostHistory
Product
ProductList
Product Search Server Controls
Recommendation
RssAggregator
SEO (Search Engine Optimization)
SiteMap
Site Search Server Controls
SiteSearchController
SocialBar
TagCloud
UserProfile
User Search Server Controls
WebCalendar
Web Search
XMLSearch Server Controls

1806
1808
1811
1813
1815
1818
1822
1826
1828
1831
1833
1836
1840
1845
1848
1852
1855
1859
1861
1861

ActiveTopics
The ActiveTopics server control displays a forum's most active or most recent topics. The
most active are determined by the number of new posts in a topic, or how many replies a
post receives. The most recent are determined by the date of the post. The following example
shows 2 ActiveTopics server controls: one is set to Active, the other to Recent.

The items in the list are clickable links, which open to the topic.
NOTE: On a PageBuilder page, you can drop the Recent Forum Posts widget, which displays a selected
number of the most recent forum posts. See Also: Widget Reference on page 714

ActiveTopics Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (Boolean)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BoardID (Long)
The ID of the board from which to get entries. If you don’t know the ID, click Ellipses (
), then sign in, browse to, and select a discussion board.
Ektron 8.7

1637

Working with Ektron Server Controls

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DisplayMode (eDisplayMode)
Choose between Active or Recent. The default is Active.

l

o

Active—lists the most active posts.

o

Recent—lists recently added posts.

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Select False to display this server control on the page. Select True to suppress it.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MaxNumber (Integer)
The maximum number of topics listed. The default is 10.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

URLPath (String)
Enter the path to the Forum server control’s Web page. For example: http://<your
site>/siteroot/forum.aspx or /CMS400Developer/forum.aspx. If your Forum page
and your Active Topics page are in the same folder, just enter the name of the page. For
example: forum.aspx.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

ActivityStream
The ActivityStream server control displays notification messages generated by Ektron’s
Notification system. Sending Notifications to a Community on page 1194
When this control is added to a Web page, Ektron looks for a DefaultObjectID defined in
properties. If one is found, the activity stream is based on that user or group. If none is
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found, notifications are based on the pages’s dynamic query string parameter, which typically
identifies the logged-in user.
You can exclude any user or a group from the activity stream. To achieve this, open the page
that hosts the Activity Stream server control, find the control, and add the following to the
control’s code-behind.
//activityStream
cmsActivityStream.ExcludeUserIds.Add(this.ProfileId);
You can also exclude groups.
cmsActivityStream.ExcludeGroupIds.Add(GroupId1);
cmsActivityStream.ExcludeGroupIds.Add(GroupId2);
:
cmsActivityStream.ExcludeGroupIds.Add(GroupIdN);

To add this control to a page, drop it on a Web form and set the following properties.
l

l

l

l

DefaultObjectID—If you want a user’s or community group’s activity stream to appear
in the control, enter that ID.
DefaultObjectParameter—enter the default object parameter used on the
QueryString to define an object’s ID. For example, if you are passing the ID value of a
community group, you might enter ‘gid’ for this property. So, if you pass
http://~yoursite~/CGHome.aspx?gid=21 in the query string to a page containing this
control, you see the activity stream for the community group whose ID is 21.
ObjectType—select the whether the control is associated with a user or Community
Group
TemplateUserProfile and ProfileParamName—If you want a user’s avatar in the
activity stream to be a clickable link that leads to the user's profile page, set these
properties.

ActivityStream Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultObjectID (Long)
The ID of the object whose activity stream will appear where you place this server
control. For example, if you want this control to display Scott Markey’s activities, and his
USER ID is 142, place 142 here, and set the ObjectType property to User. To display
the activity stream for the logged-in user, enter zero (0).

l

DisplayXslt (String)
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If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.If you specify an external file, do not store this file in the Workarea folder. If you
store this file in the Workarea folder, the file will be lost when you upgrade.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicObjectParameter (String)
Gets or sets the QueryString parameter to read a object ID dynamically. To use the
default object ID, leave blank. For example, if you are passing the ID value of a
community group, you might enter ‘gid’ for this property. So, if you passed
http://~yoursite~/CGHome.aspx?gid=21 on the Query Strings to a page containing
this control, you would see the activity stream for the group with an ID of 21.

l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905

l

MaxResults (Integer)
The Maximum number of notifications to fetch. 0 (zero) = unlimited.

l

ObjectType (ActivityFeedType)
The type of object to which this control is assigned. Choices are:

l

o

User—control is assigned to an individual

o

Group—control is assigned to a community group

ProfileParamName (String)
The parameter name to pass in the QueryString to the TemplateUserProfile page, if you
want it to be anything other than id. For example, you may prefer userid, because it is
more descriptive, as shown in the following example.
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l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TemplateActivity (String)
The URL path to a page that contains another ActivityStream server control.
When this property contains a path and the destination page has an ActivityStream
control whose ObjectType property is set to Activity, a user can click an Activity
Stream’s time span on the first page to open a second page that contains just that
activity. See Also: Server Control Reference on page 1636

l

TemplateUserProfile (String)
The URL path to a page that contains the UserProfile server control. The path can be
relative or absolute. If you enter a path, a user can click a user’s name or avatar from
the Message Board server control and be forwarded to the profile page. See illustration.

User templates can be defined in the Ektron Workarea > Settings > Community
Management > Templates screen. However, if you assign a template in this field,
this setting takes precedence over the setting on the Workarea Template screen.
l

WrapTag (String)
Lets a developer specify a server control’s tag.
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o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Analytics Tracker
Track Business Analytics statistics about visits to your site, such as:
l

how often content is viewed

l

how many site visitors viewed for first time, and how many returned

l

the most popular referral pages

The data recorded by this server control is used by the Most Popular and Trends widgets'
Most Viewed category. See Also: Business Analytics on page 602

The data recorded is also used by the Classic Analytics Reports, available from the Ektron
Workarea > Reports > CMS Site Analytics section.
IMPORTANT: Your site license key must support Analytics. You must also set the control's
enableanalytics property to true or set the enableanalytics property to ConfigSpecified,
and the enableAnalytics key in your web.config file to true
The AnalyticsTracker server control provides 3 properties for determining which content
items are viewed when a site visitor browses to a page that contains the control. The
properties are additive, that is they can be used together.
l
l

l

DefaultContentID—tracks one content item
ContentIdsList—tracks additional content items. For example, a page contains 4
content blocks, and you want to track a hit for each of them when a site visitor views the
page. Insert one ID into the ContentID property, and the other 3 into this property.
DynamicParameter— tracks the content ID in the query string parameter of the URL
used to access the page

If you want to track your entire site, place an Analytics Tracker server control on your master
pages on your site templates, and use the DynamicParameter property.

Analytics Tracker Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Authenticated (Boolean)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

ContentIdsList (String)
Enter a comma-separated list of content IDs to be tracked. The DefaultContentId and the
dynamicParameter are also tracked. See Also: Business Analytics on page 602

l

DefaultContentID (Long)
The ID of a content block being tracked by this server control. It typically would be the
content directly above the analytics tracker if no other content block is identified, or is
not available. If you don’t know the ID number of the content block, use the CMS
Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
To make this control dynamic, select id. When you do, this server control is attached to
the content block passed as a URL parameter.

l

EnableAnalytics (String)
Set one of these values to determine if this server control tracks Business Analytics
statistics.
o

true—this control tracks analytics

o

false— this control does not track analytics

o

ConfigSpecified—use the setting in the site
root/web.configfile'senableAnalytics key. For example, if that key =true, this
control tracks analytics.

Note that the first 2 options (true and false) let you enable/disable this particular
control. Use the last option, ConfigSpecified, if you want to use a single web.config
setting to enable/disable all analytics controls.
l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.
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o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

AssetControl
The AssetControl server control, when viewed on a Web form, displays a drag and drop icon
that lets you upload a new asset or update an existing one. When you click this icon, a drag
and drop box appears. This box is similar to the upload box in the Workarea. The difference
between the Workarea and the server control is, in the Workarea users can only upload
assets. With the AssetControl server control, you can upload a new asset or update an
existing one by overwriting it. If the asset is overwritten, the previous version is available
through Ektron’s history feature. See Also: Managing Versions of Content on page 299.
The appearance of the AssetControl server control can vary depending on your browser. See
Also: Methods for Importing Assets on page 315.

AssetControl Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DefaultAssetID (Long)
The ID of the asset you want to update. This property is used when the UploadType
property is set to Update. If you don’t know the ID number of the asset, use the CMS
Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610

l

DefaultFolderID (Long)
The ID of the folder where assets are added. This property is used when the UploadType
property is set to Add. If you don’t know the ID number of the folder, use the CMS
Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a content ID or folder ID dynamically.
The content ID is read when the UploadType property is set to Update. The folder ID is
read when UploadType property is set to Add. To use the default content ID or default
folder ID, leave blank.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.
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l

o

True—Hide the control output.

o

False—Display the control output.

IsImage (Integer)
Setting this control to 1 (one) restricts the control so only images can be uploaded.

l

o

1 (one)—restrict the control to uploading images only.

o

0 (zero)—upload all types of assets.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

OverrideExtension (String)
Lets you restrict the type of asset that can be uploaded by its extension. For example, to
restrict the control to uploading Word documents, enter doc in the property.
NOTE: When using this property, enter only the extension’s letters not the wildcard (*) or the dot (.).
You can add multiple extensions by creating a comma separated list of extensions. You
should limit the list to 5 extensions.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TaxonomyID (Long)
The ID of the taxonomy with which to associate the asset.

l

UploadType (UploadTypeEnum)
Select whether the control adds new assets or updates existing ones.

l

o

Add (default)—add assets and use the DefaultFolderID property. If a file of the
same name already exists in the folder, the new file is created using the naming
convention filename(2).

o

Update—update assets. In this case, you must identify an asset at the
DefaultAssetID property.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Blogs
Ektron provides server controls for displaying a blog on a website. The Blog server control
lets you display pieces that typically make up a blog site on a Web form, such as blog entries,
posts, subjects, recent posts, RSS feed, archive, calendar, and a blog roll.
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Additional Blog server controls let you display each item individually and offer additional
ways to customize the layout and appearance. For example, you might display Blog entries
and a Blog roll but not a Blog calendar. The individual Blog server controls also let you further
define the display details.
The Blog server controls are as follows:
l

Blog below

l

BlogArchive on page 1650

l

BlogCalendar on page 1654

l

BlogCategories on page 1655

l

BlogEntries on page 1651

l

BlogPost on page 1656

l

BlogRecentPosts on page 1658

l

BlogRoll on page 1659

l

BlogRSS on page 1660

NOTE: On a PageBuilder page, you can insert a blog using the Blog widget.

Blog
The Blog server control lets you add a blog to a Web form. This control has the items
commonly found on a blog page, such as blog posts, comments link, a blog roll, blog subjects,
recent blog posts, the blog's RSS feed, archive, and a blog calendar.
The Blog server control lets you easily maintain the overall look of the blog. Any change to
display properties, such as background color or font, affects the entire blog. However, you
cannot change the location of each server control item. The title always appears on top, with
the tagline below it. The blog posts always appear to the left,and the calendar, blog roll, blog
subjects, recent blog posts, RSS feed, archive and blog roll to the right.
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NOTE: You can use individual blog server controls to change the page layout.
To customize a blog's styling, edit the Blog.css file located in
webroot\siteroot\Workarea\csslib.

Blog Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

ArchiveMode (String)
Select whether the archive appears in month format or year format. The default is
month

l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.
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l

BlogID (Long)
The ID of the blog in Ektron. For example: 41. If you don’t know the blog ID, use the
CMS Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610

l

BlogStartDateRange (String)
Set the date range of the Blogs to show. For example, if you want to display blogs for
only the past 3 months, set this value to Quarterly.

l

o

None—no start date range

o

Monthly—current month

o

Quarterly—past 3 months

o

BiYearly—past 6 months

o

Yearly—past 12 months

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DateToStart (DateTime)
The date of the most recent blog entries to appear. For example, to display blog entries
for January 1, 2012 and before, enter 1/1/2012. Click the drop-down box to access a
calendar.

l

DefaultUserID (Long)
The ID of the user who owns the blog to be displayed. This property is used when the
server control displays a user's blog. To display a blog not associated with a user, leave
this property set to 0 (zero) and enter the blog's ID in the BlogID property.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a Blog ID dynamically. Set to None—
Use Default if you want to always display the default blog.

l

o

None—Use Default—use the default Blog ID list

o

ekfrm—reads a form block’s ID dynamically

o

You may display blogs dynamically by entering any value other than id. id is the
default parameter for PostParameter.

DynamicUserParameter (String)
Gets or sets the QueryString parameter to read a user ID dynamically. Set to Use
Default if you wish to always display the default user's blog (static).

l

EditorHeight (Integer)
Sets the height of the blog editor in pixels.

l

EditorWidth (Integer)
Sets the width of the blog editor in pixels.
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l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MaxResults (Integer)
Set the maximum number of posts to display. If set to 0 (zero), there is no limit. If set
to
-1—all posts for the day are shown
-2—all posts for the month are shown
-3—use the # of Post Visible setting in the Workarea.
The default is -3.

l

PostParameter (String)
Works like the DynamicParameter for content blocks. When id is selected, this server
control passes the blog post ID as a URL parameter. The default setting is id.

l

o

Blank—the list of blog posts is static. The links in the blog posts are inactive.

o

id—the id of the blog post is passed to the URL as a parameter.

o

None use default—the list of blog posts is static. The links in the blog posts are
inactive.

RecentPosts (Integer)
The number of post links contained in the Recent Posts list. The default is 5.

l

RssTemplate (String)
Specify the .aspx page used to render the RSS for blogs. The default value is
WorkArea/blogs/blogrss.aspx.

l

ShowHeader (Boolean)
o True (default)—show title and tagline.
o

l

ShowRSS (Boolean)
o True (default)—show RSS feed icon ( ).
o

l

False—do not show header and tagline.

False—do not show RSS feed icon.

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.
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o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

BlogArchive
The BlogArchive server control displays past months or years that have blog posts. Use this
control with the BlogEntries and Calendar controls to let site users scan for older Blog posts.

When a site visitor clicks a month in the archive, the blog posts for that month appear.
Typically this control appears along side other individual Blog server controls.

BlogArchive Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

ArchiveMode (String)
Select whether the archive appears in month format or year format. The default is
month

l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BlogID (Long)
The ID of the blog in Ektron. For example: 41. If you don’t know the ID of the blog, use
the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS
Explorer on page 1610
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l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

DynamicParameter (String)
Sets the QueryString parameter to read a Blog ID dynamically. Leave blank to always
display the default blog.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

BlogEntries
The BlogEntries server control displays several blog posts or a user’s Journal (personal blog)
on a Web form. You can change this server control's appearance without changing the other
blog controls. Below is an example of a BlogEntries server control.
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To use this server control to dynamically display a blog’s entries, set the following properties:
l

l

DynamicParameter—set this property to the parameter name used to pass a blog ID to
the QueryString. The default is blogid.
BlogPostParameter—set this property to the parameter name used to pass a blog post’s
ID to the QueryString. The default is id.

To use this server control to dynamically display a user’s Journal, set the following
properties:
l

l

DynamicUserParameter—Set this property to the parameter name used to pass a user’s
ID to the QueryString.
BlogPostParameter—set this property to the parameter name used to pass a blog post’s
ID to the QueryString. The default is id.

BlogEntries Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BlogID (Long)
The ID of the blog in Ektron from which blog entries are displayed; for example, 41. This
is the default ID that is used when a blog ID is not passed dynamically to the
QueryString. To pass a blog ID dynamically, set the DynamicParameter property. If you
don’t know the ID of the blog, use the CMS Explorer to browse to it.See Also: Browsing
Your Ektron Site Using CMS Explorer on page 1610
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l

BlogPostParameter (String)
Set this property to the parameter name used to pass a blog post’s ID to the
QueryString. The default is id. When a parameter is defined, this server control passes
the blog post’s ID as a URL parameter. If you do not set this parameter to id, you will
not be forwarded to the blog post’s page when you click on any links in the post. The
default setting is id.

l

o

Blank—the list of blog posts is static. The links in the blog posts are inactive.

o

id—the ID of the blog post is passed to the URL as a parameter.

o

None use default—the list of blog posts is static. The links in the blog posts are
inactive.

BlogStartDateRange (String)
Set the date range of the Blogs to show. For example, if you want to display blogs for
only the past 3 months, set this value to Quarterly.

l

o

None—no start date range

o

Monthly—current month

o

Quarterly—past 3 months

o

BiYearly—past 6 months

o

Yearly—past 12 months

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DateToStart (DateTime)
The date of the last blog entries you want to appear. For example, if you want to display
blog entries for January 1, 2012 and before, enter 1/1/2012. Click the drop-down box to
access a calendar.

l

DefaultUserID (Long)
The ID of the user who owns a Journal from which to display journal entries. To display
journal entries not associated with a user, leave this property set to 0 (zero) and enter
the blog's ID in the BlogID property.
WARNING! If you define a DefaultUserID, it overrides the BlogID property.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.
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l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a Blog ID dynamically. Set to “None—
Use Default” if you want to always display the default blog. The default is blogid.
NOTE: If an ID for this property is passed on the QueryString and a an ID for the
DynamicUserParameter property is passed the control displays blog entries for a user.

l

DynamicUserParameter (String)
Gets or sets the QueryString parameter to read a User ID dynamically. Set to Use
Default if you wish to always display the default user's blog (static.)
NOTE: If an ID for this property is passed on the QueryString and a an ID for the
DynamicUserParameter property is passed the control displays blog entries for a user.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MaxResults (Integer)
Set the maximum number of posts to display. The default is -3.
o

l

0 (zero)— no limit

o

-1—all posts for the current day

o

-2—all posts for the current month

o

-3—the # of Post Visible Workarea setting

ShowHeader (Boolean)
Shows the title and tagline when set to True. The default is True.

l

o

True—show title and tagline.

o

False—do not show header and tagline.

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

BlogCalendar
The BlogCalendar server control displays a calendar on a Web page and associates it with a
blog. Days with blog posts are highlighted on the calendar. You can use a BlogCalendar server
control with a BlogEntries server control to display blog posts for a given day.

BlogCalendar Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BlogID (Long)
The ID of the blog in Ektron. For example: 41. If you don’t know the ID of the blog, use
the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS
Explorer on page 1610

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

BlogCategories
The BlogCategories server control displays a blog’s subjects as a clickable list of links on a
Web form. When a link is clicked, it displays all subjects associated with the category. See
Also: Adding Blog Subjects on page 496. Typically this control appears with other Blog server
controls.

BlogCategories Properties
Ektron 8.7
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The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BlogID (Long)
The ID of the blog in Ektron. For example: 41. If you don’t know the ID of the blog, use
the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS
Explorer on page 1610

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

BlogPost
The BlogPost server control displays an individual blog post on a page. There are 2 ways that
this control displays a blog post.
l

l

If a user is logged in as an Ektron or a membership user, the control displays the blog
post, comments, and comments from the Web page.
If a user is not logged in, the control displays only the blog post.

NOTE: The Enable Comments property in the Workarea must be enabled for comments and the
comments form to appear.

BlogPost Properties
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The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultContentID (Long)
The ID of a default blog post that appears where you inserted this server control if no
other content block is identified, or is not available. If you don’t know the ID number of
the blog post, use the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site
Using CMS Explorer on page 1610

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
To make this blog post dynamic, select id. When you do, this server control uses the
blog post passed as a URL parameter.

l

GetThankYouMessage (Boolean)
Determines whether a message appears after adding a blog comment.

l

o

True—Displays "Thank you" message after adding a blog comment

o

False—Do not display the message.

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

ShowType (String)
Shows a blog post’s content and its comments or only its comments. The default is
Content.
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l

o

Content—Show blog post’s content and comments.

o

Description—Show comments only.

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

BlogRecentPosts
The BlogRecentPosts server control displays a list of recent blog post links on a Web form.
When you click a link, you are directed to the blog post. The NumberofPosts property lets you
control how many links appear. Typically, this control appears with other individual Blog
server controls.
NOTE: On a PageBuilder page, you can display recent blog posts using the Recent blog posts widget.
See Also: Widget Reference on page 714

BlogRecentPosts Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BlogID (Long)
The ID of the blog in Ektron. For example: 41. If you don’t know the ID of the blog, use
the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS
Explorer on page 1610

l

BlogStartDateRange (String)
Set the date range of the Blogs to show. For example, want to display blogs for the past
3 months, set toQuarterly.
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o

None—no start date range

o

Monthly—current month

o

Quarterly—past 3 months

o

BiYearly—past 6 months

o

Yearly—past 12 months
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BlogRoll

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

NumberofPosts (Integer)
Sets the number of post links to display. The default is 5.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

BlogRoll
The BlogRoll server control displays a blog roll on a Web form. A blog roll is a list of links to
other blogs. For more information, see Adding Blog Roll Links on page 497. Typically, this
control appears with other individual Blog server controls.

BlogRoll Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BlogID (Long)
The ID of the blog in Ektron. For example: 41. If you don’t know the ID of the blog, use
the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS
Explorer on page 1610

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.
Ektron 8.7
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l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

BlogRSS
The BlogRSS server control displays a blog’s RSS feed icon ( ) on a Web form. When the
icon is clicked, the blog's RSS feed appears. Typically this control appears along side other
individual Blog server controls.

BlogRSS Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BlogID (Long)
The ID of the blog in Ektron. For example: 41. If you don’t know the ID of the blog, use
the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS
Explorer on page 1610

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.
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l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

Bookmarklet
The (Micro-messaging) Bookmarklet server control detects the user's browser and modifies
the text accordingly. For more information, see Using Ektron's Micro-messaging Bookmarklet
on page 1249.

Bookmarklet Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CssClass (String)
Use this field if you want to change the .css class used in the default template’s
outermost wrapper (DIV tag). This lets you change the styling and appearance of the
server control without having to change the markup.

l

FormURL (String)

Ektron 8.7
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The path to the page that appears when a user clicks the Micro-messaging bookmarklet
link. By default, when a user clicks a link, he is redirected to the
siteroot/Workarea/share.aspx page.
l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

ID (String)
A unique name you apply to this instance of the control.

l

IncludeCSS (Boolean)
Lets you include or exclude the control's default .css file, which provides the "look and
feel" of the control on a Web page.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkText (String)
The text that appears on the Micro-messaging bookmarklet link.

To modify the look and feel of this area, edit the
ektron.micromessaging.bookmarklet.css file in the siteroot/Workarea/csslib folder.
l

OutputLinkIcon (Boolean)
o False—suppress the icon
o

True—show the Micro-messaging bookmarklet link icon on the button

To modify the look and feel of this icon, edit the
ektron.micromessaging.bookmarklet.css file in the siteroot/Workarea/csslib folder.
l

PopupHeight (Integer)
The height of the Micro-messaging bookmarklet link window in pixels.

l

PopupWidth (Integer)
The width of the Micro-messaging bookmarklet link window in pixels.

l

SiteName (String)
The name of the website using this server control. The SiteName value is embedded in
the instructions for adding the bookmarklet to the toolbar. See example below.
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l

Visible (Boolean)
o True—the control is visible and rendered
o

False—the control is not visible

Customizing the Bookmarklet Server Control
The (Micro-messaging) Bookmarklet server control is template-based which means you can
change the control's appearance without an extensive XSLT or EkML file.
The JavaScript used to render the Bookmarklet control is loaded into the Href property of the
control's anchor tag.

The following code shows the first Bookmarklet server control in bookmarklet.aspx.
<li>
<div class="controlWrapper">
<h3>Default</h3>
<CMS:micromessagingbookmarklet ID="bookmarkletDefault" runat="server" />
</div>
</li>

Because Bookmarklet is a templated server control, you can enter any valid markup, and it
will be rendered exactly as you entered it. As examples, you can enter the following items
within the <div> tags that surround the control.
l

another Ektron server control

l

any third-party server control

l

HTML syntax

Ektron 8.7
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l

databinding syntax

l

style classes

l

style tags, such as <strong>

BreadCrumb
Your website is made up of Web forms. Each page depends on a form to determine much of
its appearance. Forms and pages have a parent > child relationship. That is, a form can be
associated with any number of pages. When you define breadcrumb properties, you define
them for a form. All pages that use a form inherit its breadcrumb properties.
Assume, for example, that a Web form is used for the Human Resources section of your
website. You might use the title Human Resources to identify the form in the BreadCrumb
server control. Whenever a page is visited that uses that form, Human Resources appears
on the breadcrumb trail -- that is, the form title appears, not the individual page.
For information about how to use the Breadcrumb server control, see Using Breadcrumbs on
page 819.

Types of BreadCrumb properties
BreadCrumb properties are divided into 2 categories:

Properties that Determine a Breadcrumb Trail’s Appearance
For each Web form, you can customize the breadcrumb trail. For example, you might want
the breadcrumb trail to appear horizontally on one Web form and vertically on another. The
following property list determines the breadcrumb trail's appearance.
l

CurrentPageIndicator—Symbols or characters to identify the current page.

l

DisplayStyle—Whether it appears horizontally or vertically.

l

LinkLastItem—Whether the last item is a hyperlink.

l

LinkTarget—The type of window that appears when a user clicks an item.

l

MaxItems—The maximum number of items.

l

Mode—whether the breadcrumb trail appears as hyperlinked text or plain text.

l

Separator—Symbols or characters that separate items.

Properties that Determine How Form Pages Appear on
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Breadcrumb Trail
Use these properties define how any page that uses this form appears within a breadcrumb
trail. It does not matter where the trail appears.
Note that you can use text, an image, or both to describe the form within the breadcrumb
trail. If you use both, the image appears first, followed by the text. The following property list
determines how the Web form appears on a breadcrumb trail.
l

DisplayTitle—Text to describe it.

l

IconAlt—“Alt” text associated with image specified in IconPath property.

l

IconPath—Image to define it.

BreadCrumb Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CurrentPageIndicator (String)
If desired, enter one or more symbols or characters that identify the current page in the
breadcrumb trail. See example below.

These characters appear after the image or title that identifies the current page in the
breadcrumb trail.
l

DefaultContentID (Long)
Gets or Sets the ContentID for the BreadCrumb display title.

l

DisplayStyle (String)
Indicate how to display the breadcrumb trail: horizontally or vertically. The default is
Horizontal.

l

DisplayTitle (String)
Enter text to describe this Web form in the breadcrumb trail. For example, if the Web
form’s properties you are defining is used for all Human Resources pages on your site,
enter Human Resources.
If you define an image in the IconPath property below, the image appears in the trail,
followed by this text.
IMPORTANT: This property is for code-behind only. It cannot be set in design time.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.
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l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a content ID dynamically.

l

Hide (Boolean)
Used to hide the breadcrumb trail in design time and run time.

l

o

True—Hide breadcrumb trail

o

False—Show breadcrumb trail

IconAlt (String)
If you define an image in the IconPath property, enter “Alt” text that should appear
when a site visitor hovers the cursor over that image. Here is an example.

l

IconPath (String)
If you want the breadcrumb trail to display an image to identify this Web form, enter the
path to the image. For example: \CMS400Developer\Workarea\Images\bc_meta_
icon.gif
IMPORTANT: The image location must be relative to the Web root.
On the breadcrumb trail, the image precedes any text defined in the DisplayTitle
property.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkLastItem (Boolean)
Use this property to determine whether the last breadcrumb item appears as a hyperlink
on this Web form. If this property is set to True, and a user clicks the item, the current
page reappears.

l

o

True—last item is a hyperlink

o

False—last item is an image or text only; the user cannot click on it

LinkTarget (String)
Determines the type of window that appears when you click a link in the server control.
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o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.
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l

MaxItems (Integer)
Enter the maximum number of items in the breadcrumb trail on this Web form. The
default is 5. If you set a value of 1 or greater and the user navigates beyond that
number of pages, only the most recent pages appear. The older pages disappear from
the trail. 0 (zero) = unlimited.

l

MetadataName (String)
Specify the name of a Metadata Type that you want to associate with the page.

BreadCrumb Metadata Type
To associate a Metadata Type with the BreadCrumb server control:
1. In the properties window for the BreadCrumb server control, click on the
MetadataName property.
2. Click Ellipses (

).

3. If you are not logged in, log in using the CMS Explorer window.
4. The Browsing Metadata screen appears.

5. Select a Metadata Type to apply to the BreadCrumb server control.
6. Set the DynamicParameter to ID. This allows the metadata to reflect the content
block on the page.
l

Mode (String)
Lets you display the breadcrumb trail as non-hyperlinked, plain text. The default is
Normal.

l

o

Normal—breadcrumb trail is hyperlinked

o

DisplayOnly—breadcrumb trail is plain text

Separator (String)
Enter one or more characters to separate breadcrumb trail items on this Web form. The
default character is the greater than sign (>).
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l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

l

WrapTag (String)

l

Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Using the BreadCrumb Server Control
NOTE: Do not add a BreadCrumb server control to a Web form that contains a Calendar server control.
When both controls appear on a page and a site visitor clicks on different months, the BreadCrumb trail
could look like this: Calendar > Calendar > Calendar > Calendar > Calendar. This happens because each
time a site visitor clicks on a month, you are in effect opening a new Web form.
To learn about the Breadcrumb server control properties, see BreadCrumb on page 1664.
Add a BreadCrumb server control to each Web form for which you want to create a
breadcrumb trail. To use the BreadCrumb server control:
1. Open a Web form for which you want to create a breadcrumb trail.
2. Drag and drop the BreadCrumb server control onto the Web form.
3. Set the DisplayTitle property.
4. Save the Web form.
5. Repeat steps 1 through 4 for all Web forms in the breadcrumb trail.
6. Open a browser.
7. View a Web page with a BreadCrumb server control in it.
8. Navigate to the rest of the Web pages that contain BreadCrumb server controls.
9. As you move around, the pages are added to the breadcrumb trail.
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The Trail Created by the Breadcrumb Server Control
A breadcrumb trail can appear vertically or horizontally on a Web page. In addition, you can
define how many breadcrumbs are left for site visitors to navigate back. You can also use an
image and Alt text instead of, or in addition to, text to display the breadcrumb trail. These
variations are illustrated below.
NOTE: If a site visitor revisits a page that is in the breadcrumb trail already, the breadcrumb trail reverts
back to that point in the trail. For example, if you visit the following pages Dev > FAQ > WebForm > PR,
and then return to FAQ, the breadcrumb trail looks like this: Dev > FAQ.
l

Horizontal; text only

l

Horizontal with images

l

Horizontal with images and Alt text

l

Vertical; text only

l

Vertical with images

l

Vertical with images and Alt text
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To implement sitemap breadcrumb navigation, add a BreadCrumb server control to every
Web form in your site. Doing this ensures that a breadcrumb trail may appear on each Web
page.

Displaying a Content Block’s Title in the
Breadcrumb Trail
By adding a line or 2 of code, the breadcrumb trail can display a content block's title. You can
add a line of code to each Web form. Or, if your content is dynamic, add the code once and,
each time a new piece of content is called dynamically, a new breadcrumb is created.
You can only use one content block per Web form with the breadcrumb. If a page has multiple
content blocks, select one that best describes the page.

Steps to Use a Content Block’s Title as a Breadcrumb
1. Drag and drop a ContentBlock server control on a Web form.
2. Choose a DefaultContentID for the content block.
3. Drag and drop a BreadCrumb server control on the same form.
4. Remove the word Title from the DisplayTitle property.
5. Add the following line of code to the pageload event code-behind:
BreadCrumb1.DisplayTitle = ContentBlock1.EkItem.Title

6. Build the project.
7. View the Web form in a Web browser.
The following example content block shows titles used as breadcrumbs.

The word Title appears in the breadcrumb trail when the DisplayTitle property is left
empty. Even with the added code, if the breadcrumb loads before the content block, the
breadcrumb has no information in the DisplayTitle property and therefore displays the
word title by default.
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If the word Title appears in the breadcrumb trail, check to make sure the word Title does not
appear in the DisplayTitle property. Next, if Title still appears, add the following line of
code to the page load event of the code-behind:
ContentBlock1.Fill()

The code in the page load event should now look like this:
ContentBlock1.Fill()
BreadCrumb1.DisplayTitle = ContentBlock1.EkItem.Title

This ensures that the content block information is loaded first.

BusinessRules
The BusinessRules server control lets you add a Business Rule created in the Workarea to a
Web form. It also lets you add a place holder for a Business Rule. Then, an Ektron
administrator can create a business rule at a later date.

BusinessRules Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

RuleID (Long)
The ID of the Ruleset to evaluate. If you don’t know the ID number of the Ruleset, use
the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS
Explorer on page 1610

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.
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l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Cart
The Cart server control lets a customer (site visitor) select products to purchase; an online
"shopping basket." Products are added to the cart when the customer selects them. See Also:
Using the Cart Server Control on page 1406

Cart Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l
l

CustomXml (Code-behind Only) (String)
Lets you inject custom XML into the generated XML before being processed by the XSLT.
Enter a string of XML that you want to make available to the XSLT as follows:
<root><customXml>custom-xml-inserted-here</customXml></root>

See Also: Displaying Custom XML in Ektron’s Server Controls on page 1632.
l

DisplayXslt (String)—If desired, enter a relative or absolute path to an Xslt that
determines the display of the page. By default, the control uses Cart.xsl. This file is
located in <siteroot>\Workarea\Xslt\Commerce.
IMPORTANT: If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)—Controls when Fill occurs.
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

l
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DynamicProductParameter (String)—The QueryString parameter name which is used
to pass the product ID to the product details page. For example, if your QueryString
parameter for products is ID, enter that in this property. Then, when a customer clicks a
product’s title, this parameter is passed with the product’s ID to the product details
page.
EnableCoupons (Boolean)—Set to true to allow a customer to enter coupon codes for
discounts. When set to false, the Apply Coupon button is hidden. Default value is True if
this property is not set. See Also: Applying Coupons on page 1411, Using Coupons on
page 1373.
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l

Hide (Boolean)—Used to hide the control in design time and run time.
o True—Hide the control
o

l

False—Show the control

Language (Integer)—
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

l

LoadingImage (String)—The image to display while the cart is loading. The default is
ajaxloader_circle_lg.gif. This file is located in
siteroot\Workarea\images\application.
Stylesheet (String)—Specify the path to a style sheet for use with this server control.
The location can be relative or absolute. Leave blank to use the default style sheet. The
default is Cart.css. This file is located in: siteroot\Workarea\csslib\Commerce
IMPORTANT: If you want to edit this file, make a copy, change its name and move it outside of the
Workarea folder. If you make changes to this file and do not move it out of the Workarea, this file
and the changes will be lost when you upgrade.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TemplateCheckout (String)—The template that contains the Checkout server control.
A customer is directed to this page when he clicks Checkout. If the template file is
located in the same folder as the Web form containing this server control, just enter its
name. The path can be relative or absolute.See Also: Checking Out on page 1411.
TemplateProduct (String)—The template that contains the Product server control. A
customer is directed to this page when a product in the cart is clicked. This page
provides details about the product.See Also: Displaying an Item’s Information on
page 1410.
If this property is blank, the server control uses the Product’s QuickLink information.
If the template file is located in the same folder as the Web form containing this server
control, just enter its name. The path can be relative or absolute.See Also: Displaying an
Item’s Information on page 1410.

l

TemplateShopping (String)—The URL to navigate to when the customer clicks
Continue Shopping. This URL could direct the customer to a template containing a
ProductSearch or ProductList server control, which lets the person select additional
products. See Also: Continuing to Shop on page 1411.
See Also: Using the ProductList Server Control on page 1430 or Product Search Server
Controls on page 1822

Checkout
IMPORTANT: When using the Checkout server control, your website should have an SSL certificate
installed. Set its IsSSLRequired property to True. This protects your customers’ payment information
during transmission. Do not use a self-signed SSL certificate—obtain one from a trusted certificate
authority.
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The Checkout server control lets a customer navigate through the checkout process. This
process includes:
l

adding billing and shipping information

l

selecting a shipping method

l

reviewing the order

l

submitting the order and credit card information

l

notification that checkout process is complete

See Also: Using the Checkout Server Control on page 1411.

Checkout Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

CurrentPhase (code-behind Only) (ControlPhase)
Reports or selects the current page (or phase) of the checkout control. This lets you
customize the flow of the control. For example, if you only offer one shipping option,
skip the ShippingInfoEntry phase.
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o

Login—allows existing users to log in. See Also: Logging In or Setting Up an
Account on page 1412

o

BillingInfo—displays a customer’s billing information. See Also: Billing
Information on page 1414

o

BillingInfoEntry—allows entry of a customer’s billing information. See Also:
Billing Information on page 1414.

o

ShippingInfo—allows entry of a customer’s shipping information.

o

ShippingInfoEntry—allows entry of a customer’s shipping information. See Also:
Shipping Information on page 1416

o

ShippingMethodSelect—allows selection of the shipping method. See Also:
Shipping Method on page 1417

o

ReviewOrder— displays the current order’s details. See Also: Review Order on
page 1417

o

SubmitOrder—lets customers add payment information. See Also: Submit Order
on page 1418

o

Complete—displays completion message. See Also: Order Complete on page 1419

o

Error_EmptyBasket— used when a cart has no items and the customer somehow
enters the control.
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o

l

Error_UnhandledException—occurs when there’s an error that the control
cannot resolve.

CustomXml (code-behind Only) (String)
Lets you inject custom XML into the generated XML before being processed by the XSLT.
Enter a string of XML that you want to make available to the XSLT as follows:
<root><customXml>custom-xml-inserted-here</customXml></root>

See Also: Displaying Custom XML in Ektron’s Server Controls on page 1632.
l

DefaultCountryId (Integer)
The ID of the default country that appears in the Billing Address and Shipping Address.
Set this to the country from which the majority of your customers make purchases. If a
customer is from a different country, he can change it when editing the Billing or
Shipping Address.
To find a country’s numeric ID, go to Workarea > Settings > Commerce >
Configuration > Countries. The Numeric ID is in the left column of that screen.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicPhaseParameter (String)
The name of the parameter on the QueryString that identifies desired phase ID.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page. By default, the control uses Checkout.xsl. This file is located in
siteroot\Workarea\Xslt\Commerce\Checkout\Standard
IMPORTANT: If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

FriendlyErrorMessage (String)
The message displayed when an unhandled error occurs. Details are sent to the event
log.
The default message is “We're sorry, an error occurred while processing your request.
Please try again later...”

l

AllowGuestCheckout (Boolean)
Set to true if you wish to allow the Guest Checkout feature. See Also: Logging In or
Setting Up an Account on page 1412

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.
o

True—Hide the control output.

o

False—Display the control output.
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l

IsSSLRequired (Boolean)
When set to True, switches to an SSL encrypted URL. For the SSL encryption to work,
you must have an SSL certificate installed for your site. See Also: Installing Ektron on
page 9. Information on SSL can be found at the following websites.
o

Secure Sockets Layer (SSL) (Tech-FAQ)

o

Introduction to SSL (Symantec)

NOTE: Ektron, Inc. is not associated with TechFAQ or VeriSign. However, both sites offer good
explanations of Secure Sockets Layer.
Installing and using an SSL is one of the most important things you can do to protect
your customer’s credit card data.
l

Language (Integer)
Set a language for viewing the checkout control. This property shows results in designtime (in Visual Studio) and at run-time (in a browser).

l

LoadingImage (String)
The image to display while the control is fetching data. The default is
siteroot\Workarea\images
\application\ajax-loader_circle_lg.gif.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTag (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TemplateCart (String)
The URL path of the template that contains the Cart server control. The path can be
relative or absolute.
When a path is entered, a link appears in the Review Order part of the process that
allows a user to navigate to the template containing the Cart server control. See Also:
Review Order on page 1417 and Using the eCommerce Server Controls on page 1404

l

TemplateOrderHistory (String)
The URL path of the template that contains the OrderList server control. The path can be
relative or absolute. When a path is entered, a link appears at the end of checkout
process that allows a user to navigate to the template containing the OrderList server
control. See Also: Order Complete on page 1419 and Managing Customer Orders on
page 1381.

l

TemplateRecoverPassword (String)
The URL path of the template that helps a customer recover a password. The path can be
relative or absolute. When a path is entered and a customer has not logged in, a link
appears at the beginning of checkout process that lets the customer navigate to a
template containing information to recover the password. The Membership server
control contains an option for recovering passwords. See Also: Logging In or Setting Up
an Account on page 1412 and Membership on page 1771 server control
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l

TemplateShopping (String)
The URL path of the template that allows the customer to continue shopping. If a path is
entered, a link appears at the end of checkout that allows a user to navigate to a
template that lets the person continue shopping; for example, the template containing a
ProductList or ProductSearch server control. See Also: Order Complete on page 1419,
Using the ProductList Server Control on page 1430 and Product Search Server Controls
on page 1822

Collection
IMPORTANT: Starting from release 8.6, the Collection server control was replaced by the
FrameworkUI: <ektron:ContentView> templated server control. If you are already using the Collection
server control, you can continue to do so, but Ektron recommends using current versions of functionality.
The Collection server control displays a collection that you create in the Workarea. The
control lets you customize the display of the collection on a Web page.
When added to a template and visited, collections can look like the following illustration,
which shows 3 collections on the same page of a sample site. You can modify the display by
editing its properties.

NOTE: On a PageBuilder page, you can insert a collection using the Collection widget. See Also:
Collection—Displays a collection. You select a Collection ID.See Also: Working with Collections on
page 355 on page 715
This section also contains the following topics.
Collection Properties
ecmNavigation Display Example
ecmNavigation XSL code
ecmTeaser Display Example
ecmTeaser XSL code
Using the Collection Server Control Programmatically Example
Retrieving the XML Structure of a Collection
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The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

AddText (String)
Override the control’s default text for the Add Content menu item. For example, If you
have a News website, you could change Add Content to Add News Item.

l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l
l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.
NOTE: If the EnablePaging property is set to True, the CacheInterval property is disabled.

l

ContentParameter (String)
Checks the QueryString for this value and replaces the collection with a content block
when specified. Leave blank to always display the Collection.

l

DefaultCollectionID (Long)
The ID of a collection that appears where you insert this server control if no other
collection is identified, or is not available. If you don’t know the ID number of the
collection, use the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site
Using CMS Explorer on page 1610

l

DisplayXslt (String)
Determines how the information on the page appears.
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o

None—databind only

o

ecmNavigation—lists the title of every content block in the collection
See Also: Collection on page 1677

o

ecmTeaser—lists the title of every content block in the collection plus the content
summary
See Also: ecmTeaser Display Example on page 1682

o

Path to Custom Xslt—If desired, enter a relative or absolute path to an Xslt that
determines the display of the page.

WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
To make this collection dynamic, select coll_id. When you do, this server control uses
the collection passed as a URL parameter.

l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen.See the following example.

For example, if a collection has 9 items and the MaxResults property is set to 4, the
screen displays only the first 4 items. When the site visitor clicks [Next], he sees items
5, 6, 7 and 8, and so on.
NOTE: If the EnablePaging property is set to True, the CacheInterval property is disabled.
l

GetAnalyticsData (Boolean)
Set this property to True if you want the following information for each content in the
list. Returns Content View Count, Content Rating, Content Rating Average.
Create your own XSLT styles to display this data. This property only provides reliable
data when the Business Analytics Feature is on. Analyzing Content on page 601.
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l

GetHtml (Boolean)
Set to True if you want to retrieve and display content (html body) for all content blocks
in the collection. For example, to display content inside a Web server control such as a
GridView.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeIcons (Boolean)
Choose whether to display icons next to the collection list’s links.
IMPORTANT: This property only works when ecmSummary or ecmTeaser are used in the
DisplayXslt property. If the [$ImageIcon] variable is used in an EkML file and that file is
assigned to the MarkupLanguage property, this property acts as True.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905.
See Also: collection.ekml on page 1906
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NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property
value is ignored. If the EkML file contains the [$ImageIcon] variable, the IncludeIcons
property acts as True.
l

MaxResults (Integer)
Enter the maximum number of items to appear in the initial display of this server
control. To set no maximum, enter zero (0). To let site visitors view more than the
maximum but limit the amount of space, enter the maximum number of results per page
here. Then, set the EnablePaging property to True. If you do and more than the
number of MaxResults are available, navigation aids help the site visitor view
additional items. See example below.

l

MemberMenuActive (Boolean)
Set this property to True to hide the drop-down menu next to a content item when a
membership user is logged-in.
l
l

True—Hide the drop-down next to a content item from membership users.
False—Membership users can have access to the drop-down menu next to content
item.

NOTE: This only affects membership users. Ektron users always see the drop-down menu when
they are logged-in.
l

Random (Boolean)
Set to True if you want to randomly display one collection item. The item changes each
time a site visitor views the page.
NOTE: If you use a custom XSLT or EkML file, the type of content displayed can be manipulated.
For example, if you use an EkML file that has the [$Html] variable in it, the actual content appears
instead of a link. See Also: Controlling Output with Ektron Markup Language on page 1905 and
[$Html] on page 1937.

l

SelTaxonomyID (Integer)
Set the ID of the taxonomy with which content is associated if a logged-in site visitor
uses the Silver Access Point’s Add HTML Content option to add content to a Collection
server control.

l

SuppressWrapperTags (Boolean)
This property is set to false because Ajax uses <div> tags to rewrite the region around
the tag. You cannot change the value to true.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.
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o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

ecmNavigation Display Example
The following figure shows a collection being used as a navigation menu.

ecmNavigation XSL code
The following XSL code creates the ecmNavigation Display. You can use this code as the basis
to design your own XSLT.
WARNING! If you create a custom file, do not store it in the Workarea folder. If you do, the file will be
overwritten when you upgrade.
<?xml version="1.0" encoding="ISO-8859-1"?>
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:template match="/">
<table border="0" cellspacing="0" cellpadding="0" width="100%">
<xsl:for-each select="Collection/Content">
<tr>
<td>
<a>
<xsl:attribute name="href">
<xsl:value-of select="QuickLink"/>
</xsl:attribute>
<xsl:value-of select="Title"/>
</a>
</td>
</tr>
</xsl:for-each>
</table>
</xsl:template>
</xsl:stylesheet>

ecmTeaser Display Example
The following example shows a collection using the ecmTeaser display style.
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ecmTeaser XSL code
The following XSL code creates the ecmTeaser Display. You can use this code as the basis to
design your own XSLT.
WARNING! If you create a custom file, it is strongly recommended to not store the file in the Workarea
folder. If you do, the file will be overwritten when you upgrade.
<?xml version="1.0" encoding="ISO-8859-1"?>
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:template match="/">
<table border="0" cellspacing="0" cellpadding="0" width="100%">
<xsl:for-each select="Collection/Content">
<tr>
<td>
<a>
<xsl:attribute name="href">
<xsl:value-of select="QuickLink"/>
</xsl:attribute>
<xsl:value-of select="Title"/>
</a>&#160;
</td>
</tr>
<tr>
<td>
<xsl:value-of select="Teaser" />
</td>
</tr>
<tr>
<td>&#160;</td>
</tr>
</xsl:for-each>
</table>
</xsl:template></xsl:stylesheet>

Using the Collection Server Control Programmatically
Example
The following is an example of using code-behind, and a drag and drop Collection server
control to display random content from a collection.
1. Drag and drop a Collection server control on your Web form.
2. Set the properties in the properties window.
NOTE: In this example, the Random and GetHtml properties must be set to True.
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3. Add the following code to the code-behind.
Dim str As String
str = "<h1>Hello There</h1><br>"
str &= Collection1.EkItems(0).Html
Collection1.Text = str

4. Build and browse your Web form.

Retrieving the XML Structure of a Collection
Retrieving the XML structure of a collection allows for greater control over developing XSLs.
The following is an example of how to do that.
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1. Open a new Web form.
2. Drag and drop a Collection server control onto it.
3. Set the DefaultCollectionID property.
4. Drag and drop a textbox on the Web form.
5. Set the TextMode property to MultiLine.
NOTE: Set the text box width to at least 400px.
6. On the code-behind page, add the following line.
Textbox1.Text = Collection1.XmlDoc.InnerXml

7. Build the project.
8. View the Web form in a browser.
9. The XML structure of the collection appears in the textbox.
For an additional example, see the Collection XML page on the Developer samples page. It is
located at:
l

In a browser:
http://sitroot/CMS400Developer/Developer/Collection/CollectionXML.aspx

l

In the source code:
siteroot/CMS400Developer/Developer/Collection/CollectionXML.aspx
and CollectionXML.aspx.vb

CommunityDocuments
The control displays a list of uploaded content filtered by category. In addition, a logged-in
member can manage files, create categories, and decide which users can view the
documents. This server control is typically placed on a user’s or a group profile page.
NOTE: When you drag and drop this control on a Web form in Visual Studio, the following message
appears in the label of the control: “Workspace for user does not exist”. This happens because no ID is
assigned to the control. When you assign an ID, the control’s name and the ID are displayed. If you use
the DynamicParameter property to dynamically pass an ID from the QueryString, the above message
appears because an ID is not assigned to the control.

CommunityDocuments Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.
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l

DefaultObjectID (Long)
The default object ID for this control to use when there is no matching dynamic
parameter value passed.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicContentBoxHeight (Integer)
The height of the dynamic content box in pixels

l

DynamicContentBoxWidth (Integer)
The Width of the dynamic content box in pixels

l

DynamicContentTemplate (String)
The template to use when displaying dynamic content. Leave blank to use the dynamic
box.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a object ID dynamically. To use the
default object ID, leave blank.

l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeIcon (Boolean)
Choose whether to display icons next to the navigation list’s links.
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o

True—Show icons

o

False—Hide icons
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l

ItemSortOrder
Specify the sort order of results. Choices are:
o

taxonomy_item_display_order—the order of taxonomy items as set in the
Workarea. For additional information, see Reordering Content Assigned to a
Taxonomy Category on page 806.

o

content_title—alphabetical order by title

o

date_created—chronological order by creation date

o

last_edit_date—chronological order by last edit date

You can specify the direction of the items with the SortDirection property.
l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkTarget (String)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905Controlling Output with Ektron Markup Language on page 1905

l

MaxResults (Integer)
Enter the maximum number of items to appear in the initial display of this server
control. To set no maximum, enter zero (0). To let site visitors view more than the
maximum but limit the amount of space, enter the maximum number of results per page
here. Then, set the EnablePaging property to True. If you do and more than the
number of MaxResults are available, navigation aids help the site visitor view
additional items.

l

ObjectType (CommunityDocumentsObjectType)
The type of object to which this control is assigned. Choices are:
o

User—control assigned to an individual

o

Group—control assigned to a community group
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l

ShowCount (Boolean)
Determines if an integer representing the number of items in a category appears next to
the category.

l

o

True—Show number next to category

o

False (default)—Do not show number next to category

SortDirection (String)
Select the direction of the itemSortOrder property. Choose Ascending or Descending.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

TaxonomyCols (Integer)
Enter the number of columns in which this taxonomy/category appear on the page.

l

TaxonomyItemCols (Integer)
Enter the number of columns in which the taxonomy item appears on the page.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

CommunityGroupBrowser
The CommunityGroupBrowser server control allows a user to browse a taxonomy structure
for community groups. As the user browses, community groups at each level appear in a
results box.
In addition, a user can click Create Group to create a new group. When the group is created,
it is automatically added to the taxonomy you are viewing.
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CommunityGroupBrowser Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

AvatarHeight (Integer)
The display height of the avatar in the results box.

l

AvatarWidth (Integer)
The display width of the avatar in the results box.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade. If you enter a valid EkML file at
the MarkupLanguage property, the DisplayXslt property value is ignored.
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l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Link (String)
Add a link to the group’s profile page. This allows a user to click a link in the community
group list and be taken to the group’s profile page. There are 2 variables used within the
link that represent the group ID and the group name.
o

{0}—represents the group’s ID.

o

{1}—represents the group’s name.

You need to have both variables in the link. The Web form can be relative or absolute.
Below is an example.
groupprofilepage.aspx?gid={0}&gn={1}
l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905

l

MaxResults (Integer)
The Maximum number of items to fetch. 0 (zero) = unlimited.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.
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l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TagTemplate (String)
Add a path to another Web form to create links for the tag text. The path can be relative
or absolute. By providing the path to CommunitySearch server control, a user viewing
the list of groups can click a tag and search for other groups with the same tag. There
are 5 parameters that are automatically added to the link’s QueryString that let you pass
information about tag.
o

searchgrptag—the tag’s text for community groups.

o

TagId—the tag’s ID.

o

TagLanguage—the tag’s language.

o

TagCount—the tag’s count (the number of times a tag has been used.)

o

TagType—the tag’s type: user or community group.

In addition to these parameters, you can add your own by defining them in the path. If
you do, these parameters are appended to yours.
l

TagTemplateTarget (String)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

TaxonomyId (Long)
Enter the ID number of the taxonomy or category to appear in this server control. If you
don’t know the number, click the button and navigate to the taxonomy or category.
When you select one, it appears in the center of the Visual Studio window.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

CommunityGroupList
The CommunityGroupList server control, part of Ektron's Community Platform, displays a list
of community groups. It can be configured to sort groups by name, newest, or most popular.
When associated with a user, this control can show
l

community groups with which a user is associated

l

community groups the user has been invited to join

l

community groups for which the user's request to join is pending
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CommunityGroupList server control displays the following information about each community
group.
l

Community Group Avatar—An image representing the group.

l

Community Group Name—The name of a community group.

l

l

Type—Whether the community group is Public or Restricted. See Also:
Accepting/Declining Requests to Join a Community Group on page 1185
Short Description—The community group’s description, as entered in the Short
Description field of the group’s properties.

l

Tags—Tags associated with the community group.

l

Founded—When the community group was created.

l

Members—The number of users in the community group.

CommunityGroupList Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

AllowGroupCreation (Boolean)
If the user has permission to create community groups and this property is set to True,
the Create Groups link appears in the control.

l

o

True—Create Group link appears on the control.

o

False—Create Group link is hidden on the control.

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

AvatarHeight (Integer)
The display height (in pixels) of the avatar in the results box.

l

AvatarWidth (Integer)
The display width (in pixels) of the avatar in the results box.
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l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultUserID (Long)
The default User ID for this control to use if no matching dynamic parameter value is
passed.

l

DisplayMode (eDisplayMode)
Select the way this control initially displays community group information. Choices are:
l

Newest—newly added community groups.

l

MostPopular—community groups with the most members.

l

Name—community groups sorted alphabetically by name

l

MyGroups—community groups to which the logged-in user belongs

l

l

MyPendingGroups—community groups to which the logged-in user has asked to
join, but has not yet been accepted

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicUserParameter (String)
Gets or sets the QueryString parameter to read a user ID dynamically. To use the
default user ID, leave blank.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Link (String)
Add a link to the group’s profile page. This allows a user to click a link in the community
group list and be taken to the group’s profile page. The link includes these 2 variables.
o

{0}—group ID

o

{1}—group name

Ektron 8.7

1693

Working with Ektron Server Controls

The link requires both variables. The Web form can be relative or absolute. Below is an
example.
groupprofilepage.aspx?gid={0}&gn={1}
l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905Controlling Output with Ektron Markup Language on page 1905

l

MaxResults (Integer)
The Maximum number of items to fetch. 0 (zero) = unlimited.

l

ShowMySortingOptions (Boolean)
If this control is associated with a user and this property is set to True, the controls
displays the following sorting options:
o

My Groups—a list of community groups to which the user belongs.

o

Group Requests—a list of community groups to which a user has requested to
join, but has yet to be accepted.

o

Group Invitations—a list of community group that the user has been invited to
join, but has yet to accept.

When set to False, Leave Selected Group is the only option that appears.
Depending on how the DisplayMode property is set, you may see additional sorting
options.
l

ShowSortingOptions (Boolean)
If this control is used to display a general list of community groups and this property is
set to True, the following sorting options appear.

l

o

Newest—recently added community groups

o

Most Popular—community groups with the most members.

o

Group Name—community groups sorted alphabetically

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
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l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TagTemplate (String)
Add a path to another Web form to create links for the tag text. The path can be relative
or absolute. By providing the path to CommunitySearch server control, a user viewing
the list of groups can click a tag and search for other groups with the same tag. There
are 5 parameters that are automatically added to the link’s QueryString that let you pass
information about tag.
o

searchgrptag—the tag’s text for community groups.

o

TagId—the tag’s ID.

o

TagLanguage—the tag’s language.

o

TagCount—the tag’s count. The tag’s count is the amount of times a tag has been
used.

o

TagType—the tag’s type. The tag’s type will be user or community group.

In addition to these parameters, you can add your own by defining them in the path.
When you do, these parameters will be appended to your parameters. See Also: Tagging
Content, Library Items, Users, and Groups with Keywords on page 1245
l

TagTemplateTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

CommunityGroupMembers
The CommunityGroupMembers server control allows you display a list of members
l

in a community group

l

pending approval to join the group

l

invited to join the group

In addition, if a logged-in user is the community group’s administrator, assigned the
Community Group Administrator role, or a site administrator, the user can approve pending
members, remove members, and cancel invitations.
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The following links appear on the CommunityGroupMembers Server Control when a
community group’s administrator or Ektron administrator is logged in and viewing the control.
l
l

l

l

Members—Current members.
Pending Members—Members who have asked to join the group, but have yet to be
accepted. This link is used when access to the community group is restricted. See Also:
Accepting/Declining Requests to Join a Community Group on page 1185
Invitations—Members who were invited to join the group but have not accepted. This
link is used when access to the community group is restricted.
Remove—Removes member from community group.

CommunityGroupMembers Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

AvatarHeight (Integer)
The display height (in pixels) of the avatar in the results box.

l

AvatarWidth (Integer)
The display width (in pixels) of the avatar in the results box.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultCommunityGroupID (Long)
The default community group ID for this control to use if no matching dynamic
parameter value is passed.
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l

DisplayMode (eDisplayMode)
Select whether this control displays a community group’s current members or their
pending members. Choices are:

l

o

Members—current group members

o

PendingMembers—users who asked or were invited to join the group

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a community group ID dynamically. To
use the default community group ID, leave blank.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Link (String)
Add a link to the member profile page’s Web form. This allows a user to click a link in
the community group members list and be taken to a member’s profile page. Two 2
variables used within the link represent the user’s ID and name.
o

{0}—user ID

o

{1}— user name

The link needs both variables. The Web form can be relative or absolute. For example:
userprofilepage.aspx?gid={0}&gn={1}
l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.
o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.
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l

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905Controlling Output with Ektron Markup Language on page 1905

l

MaxResults (Integer)
The maximum number of items to fetch. 0 (zero) = unlimited.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

CommunityGroupProfile
The CommunityGroupProfile server control displays the profile of a community group. You
can see an example of the CommunityGroupProfile Server Control in the Ektron Tech site >
Community > Community Groups > select any group. The profile includes:
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l

an image associated with the group

l

a description of the group

l

tags assigned to the group

l

whether the group is Public or Restricted

l

the date the group was founded

l

location information

l

group members

l

group administrator
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l

an Edit link that lets you update profile information and group settings

CommunityGroupProfile Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DefaultGroupID (Long)
The default community group ID for this control to use when no matching dynamic
parameter value is passed.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.
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l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a community group ID dynamically. To
use the default community group ID, leave blank.

l

GroupAdminLink (String)
Add a link to the administrator’s profile page. This lets a user click a link in the
community group page's profile area and be directed to the administrator’s profile page.
Two variables in the link identify the administrator.
l

{0}—administrator’s ID

l

{1}—administrator’s name

Both variables must be in the link. The Web form can be relative or absolute. Below is an
example.
adminprofilepage.aspx?aid={0}&an={1}
l

GroupAdminLinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
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True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

Ektron Reference

ContentBlock

l

TagTemplate (String)
Add a path to another Web form to create links for the tag text. The path can be relative
or absolute. By providing the path to CommunitySearch server control, a user viewing
the profile can click a tag and search for other groups with the same tag. Five
parameters, which are automatically added to the link’s QueryString, let you pass
information about the tag.
o

searchgrptag—the tag’s text for community groups

o

TagId—the tag’s ID

o

TagLanguage—the tag’s language

o

TagCount—the tag’s count. That is, the number of times a tag has been used.

o

TagType—the tag’s type: user or community group

You can also add your own parameters by defining them in the path. If you do, these
parameters will be appended to yours. See Also: Tagging Content, Library Items, Users,
and Groups with Keywords on page 1245
l

TagTemplateTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

ContentBlock
IMPORTANT: Starting from release 8.6, the ContentBlock server control was replaced by the
FrameworkUI: <ektron:ContentView> templated server control. If you are already using the ContentBlock
server control, you can continue to do so, but Ektron recommends using current versions of functionality.
The ContentBlock server control displays the following types of content blocks on an Web
page.
l

Static—displays one specified content block

l

Dynamic—displays the content block of the ID passed through a URL parameter

l

XML—displays the content from the XML or XHTML code

Using a Static Content Block
A static content block displays one identified content block on a Web page. The following
image shows a server control that retrieves content block ID=28 and displays it in the
browser.
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ContentBlock Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultContentID (Long)
The ID of a content block that appears where you insert this server control. If you don’t
know the ID number of the content block, use the CMS Explorer to browse to it.See Also:
Browsing Your Ektron Site Using CMS Explorer on page 1610
NOTE: If you identify a content block that displays an Office document which will be published as
HTML, make sure the template sets <span> tags to display the content as a block.

l

DisplayXslt (String)
Ignore for a non-XML content block.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Select None - Use Default. This parameter is used for dynamic content blocks.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).
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l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

IMPORTANT: If you want to let content authors edit this content using Ektron’s Edit in Context
feature, this must be set to false.
l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Using a Dynamic Content Block
Use a dynamic content block to display a content block whose ID is passed through a URL
parameter. You would use this server control with a dynamic template.

The following example uses the ContentBlock server control to pass the id as a URL
parameter. When a user clicks a link that passes the content block ID as a URL parameter,
that content block appears. If that content block is not available, content block 1 appears

The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.

Dynamic ContentBlock Properties
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.
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l

DefaultContentID (Long)
The ID of a content block that appears where you insert this server control. If you don’t
know the ID number of the content block, use the CMS Explorer to browse to it.See Also:
Browsing Your Ektron Site Using CMS Explorer on page 1610
NOTE: If you identify a content block that displays an Office document which will be published as
HTML, make sure the template sets <span> tags to display the content as a block.

l

DisplayXslt (String)
Ignore for a non-XML content block.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Select id. When you do, this server control uses the content block passed as a URL
parameter.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

IMPORTANT: If you want to let content authors edit this content using Ektron’s Edit in Context
feature, this must be set to false.
l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

XML ContentBlock properties
Use an XML content block to display an XML content block on an Ektron Web page.
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultContentID (Long)
The ID of a content block that appears where you inserted this server control if no other
content block is identified, or is not available. If you don’t know the ID number of the
content block, use the CMS Explorer to browse to it.See Also: Browsing Your Ektron Site
Using CMS Explorer on page 1610

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page. If you do not define the DisplayXslt property, the OverrideXslt property
specifies an XSLT identified in the Edit Smart Form Configuration screen. See Also:
Working with Smart Forms on page 423, Ektron KB article "HOW TO:Add acceptable
XSLT files to the system"

WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

Ektron 8.7

1705

Working with Ektron Server Controls

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
To make this content block dynamic, select id. When you do, this server control uses the
content block passed as a URL parameter.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Retrieving the XML Structure of an XML ContentBlock
Retrieving the XML structure of XML content allows for greater control over developing XSLs.
The following example shows how to retrieve the XML structure.
1. Open a new Web form.
2. Drag and drop a Content Block server control onto it.
3. Set the DefaultContentID to an XML content block.
IMPORTANT: This does not work with HTML content blocks, as there is no XML structure to
output.
4. Drag and drop a textbox on the Web form.
5. Set the TextMode property to MultiLine.
6. It is also recommended that you set the width of the text box to at least 400 px.
NOTE: On the code-behind page, add the following line.
TextBox1.Text = ContentBlock1.EkItem.Html
7. Build the project.
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8. View the form in a browser. The XML structure of the content block appears in the text
box.

Using ContentBlock Programmatically
The following code displays a content block:
NOTE: Before adding these lines of code, drag and drop a literal box on your Web form.
Dim MyContentBlock As New ContentBlock
MyContentBlock.DefaultContentID = 8
MyContentBlock.Page = Page
MyContentBlock.Fill()
Literal1.Text = MyContentBlock.EkItem.Html

To display a content block with the content block title:
NOTE: Before adding these lines of code, drag and drop a 2 literal boxes on your Web form.
Dim MyContentBlock As New ContentBlock
MyContentBlock.DefaultContentID = 8
MyContentBlock.Page = Page
MyContentBlock.Fill()
Literal1.Text = MyContentBlock.EkItem.Title
Literal2.Text = MyContentBlock.EkItem.Html

ContentFlagging
See Also: Defining Flags for Content on page 1239
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DefaultContentID (Long)
The default content ID for this control to use when there is no matching dynamic
parameter value passed.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.
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l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a content ID dynamically. To use the
default content ID, leave blank.

l

FlagImage (String)
Enter a path to an image that overrides the text in the FlagText property. When the
image is clicked, the flag dialog appears.

l

FlagText (String)
Text for the link that is shown to allow flagging. For example, you might use “Click here
to flag this content.” The FlagImage property overrides this property. When the text link
is clicked, the flag dialog appears.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

ContentList
IMPORTANT: Starting from release 8.6, the ContentList server control was replaced by the
FrameworkUI: <ektron:ContentView> templated server control. If you are already using the ContentList
server control, you can continue to do so, but Ektron recommends using current versions of functionality.
The ContentList server control displays a list of content blocks on a Web page. In contrast to a
List Summary, where content must be in a specified folder, the ContentList server control
displays content from any Ektron folder. Depending on the setting you choose for
DisplayXslt, you can change information displayed for each content block.
When added to a template and visited, a ContentList Summary looks similar to the following.
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The ContentList server control has the following options to display a content list.
l

Define a content list in a content block's metadata. Then, assign that content block’s ID
in the DefaultContentID property. See Also: Server Control Reference on page 1636
When using this option, an administrator typically sets up the Workarea portion of the
process. Then, a developer adds the server control to a Web form and assigns the
content block ID and the metadata name to the appropriate properties. Because the
content list is assigned to a content’s metadata, you can pass the content ID dynamically
in a Web form and display a list for each content block you defined.

l

Assign a comma-delimited list of content blocks to the ContentIds property. See Also:
Server Control Reference on page 1636
Using the ContentIds process, a developer adds the ContentList server control to Web
form. Then, the developer defines a list of content IDs in the ContentIds property. If
the server control or the list in the ContentIds property is deleted, it is not available
and will have to be created again.

The following describes the ContentList properties.

ContentList Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

ContentIds (String)
A comma delimited list of content block IDs. See Also: Server Control Reference on
page 1636

l

DefaultContentID (Long)
Set content ID value. When set, content IDs are generated from the MetaTag value for
this content.

l

DisplayXslt (String)
Determines how information appears on the page.
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o

None—databind only

o

ecmNavigation—lists the title of each content block See Also: ecmNavigation
Display Example on page 1682

o

ecmTeaser—lists the title of each content block plus the content summary. See
Also: ecmTeaser Display Example on page 1682

o

ecmUnOrderedList—sorts the list in no particular order. Shows the title and
content summary

o

Path to Custom Xslt—If desired, enter a relative or absolute path to an Xslt that
determines the display of the page.

WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Uses the QueryString parameter to read a content ID dynamically.

l

o

None - Use Default—use the default content ID list.

o

ID—reads a content block’s ID dynamically.

o

ekfrm—reads a form block’s ID dynamically.

GetAnalyticsData (Boolean)
Set this property to True if you want the following information for each content in the
list. Returns Content View Count, Content Rating, Content Rating Average.
Create your own XSLT styles to display this data.
IMPORTANT: This property only provides reliable data when the Business Analytics Feature is on.
Analyzing Content on page 601.

l

GetHtml (Boolean)
o True—retrieve and display content (html body) for all content blocks in the list
summary. For example, to display content inside a Web server control such as a
GridView.
o

l

False—Do not get and display HTML.

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeIcons (Boolean)
Choose whether to display icons next to the content list’s links.
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IMPORTANT: This property works only when ecmSummary or ecmTeaser are used in the
DisplayXslt property. When the [$ImageIcon] variable is used in an EkML file and that file is
assigned to the MarkupLanguage property, this property acts as True.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905
See Also: contentlist.ekml on page 1907
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property
value is ignored. If the EkML file contains the [$ImageIcon] variable, the IncludeIcons
property acts as True.

l

MetaTag (String)
Specify a Metadata definition whose type is Content Selector. When you do, the
associated list of content items will appear where you place the server control.
NOTE: You cannot insert other metadata types.
This works with the DefaultContentID property. For more information about using
metadata to assign a list of related content to a content item, see Creating and
Deploying a Related Content Definition on page 375.
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l

OrderByDirection
(Ektron.Cms.Controls.CmsWebService.ContentListOrderByDirection)
Determines which direction to sort content determined by the OrderBy property.
o

ascending—items are arranged A, B, C or 1,2,3.

o

descending—items are arranged. Z,Y,X or 3,2,1.

If sorting by date, descending puts the most recent first. When ascending is selected
and the OrderBy property is set to OrderOfTheIds, the order of the IDs are preserved.
When set to descending, the order is reversed.
l

OrderBy (Ektron.Cms.Controls.CmsWebService.ContentListOrderBy)
Sort the list by one of these values:

l

o

Title—alphabetically, by content title

o

DateModified—the last date content was modified

o

DateCreated—the date content was created

o

LastEditorFname—the last editor’s first name

o

LastEditorLname—the last editor’s last name

o

OrderOfTheIds—preserves content ID order based on ContentIds property

o

ContentRatingAverage—Business Analytics Content Rating

o

ContentViewCount—Business Analytics Content Views

Random (Boolean)
o True—randomly display one content block link from the content list. The content
changes each time a user views the page.
o

False—display the content list normally.

NOTE: If you use a custom XSLT or EkML file, the type of content displayed can be manipulated.
For example, if you use an EkML file that has the [$Html] variable in it, the actual content appears
instead of a link. See Also: Controlling Output with Ektron Markup Language on page 1905 and
[$Html] on page 1937
l

SuppressWrapperTags (Boolean)
This property is set to false because Ajax uses <div> tags to rewrite the region around
the tag. You cannot change the value to true.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

ContentReview
The ContentReview server control lets site visitors rate content on your site. Place this control
on a template that displays content items or eCommerce products. For example, you place
this control on a Master page and set its DynamicParameter property to ID. Then, when a
Web form containing a content item or product passes its ID to the QueryString, a site visitor
can use the control to record a review.
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You can use the ContentReview server control as follows:
l

l

Place a star-based scale on a Web page. Site visitors use the scale to rate a content
item. Depending on the XSLT, they can also submit review comments.
Display reviews and comments about a content item, or by a specific site or membership
user.

See Also: User-Ranking of Content on page 587
NOTE: On a PageBuilder page, you can insert a ContentReview server control using the Calendar
widget. See Also: Widget Reference on page 714. The eCommerce Product List server control also can
display the star-based scale.
The following shows the ContentReview properties.

ContentReview Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (Boolean)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DefaultContentID (Long)
The ID of a content block being rated by this server control. If you don’t know the ID
number of the content block, use the CMS Explorer to browse to it.See Also: Browsing
Your Ektron Site Using CMS Explorer on page 1610

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DisplayXslt (String)
Select the type of review to display, or enter the path to a custom XSLT. For additional
information, see Using the DisplayXSLT Property on page 1715. Choices are:
o

Ajax 5 Stars—a 5 star rating system utilizing Ajax for display.

o

Ajax 5 Stars Comment—a 5 star rating system utilizing Ajax for display. When
you hover over the stars, a comment box appears. Comments that are added are
submitted via an Ajax call.

o

Ajax 5 Stars with Increments—a 5 star rating system with half star increments
that utilizes Ajax for display.

o

5 Stars—a 5 star rating system that allows visitors to add text reviews of content.

o

5 Stars with Increments—a 5 star rating system with half star increments that
allows visitors to rate and add a text review of the page's content.

o

Review List—displays a list of reviews for content or a user. See Also: Server
Control Reference on page 1636 and Server Control Reference on page 1636.

o

Path to Custom Xslt—If desired, enter a relative or absolute path to an Xslt that
determines the display of the page.
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WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
l

DynamicParameter (String)
To make this content review control dynamic, select id. When you do, this server control
is attached to the content block passed as a URL parameter.

l

DynamicUserParameter (String)
When using this control to retrieve a user’s reviews, set this property to UserId to make
the user’s ID dynamic.

l

GetReviews (ReviewTypes)
Returns a list of reviews for content or a user.

l

o

None—do not return reviews.

o

Content—returns reviews based on the content ID provided in the
DefaultContentID property.

o

User—returns reviews based on the User ID provided in the UserId property.

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MaxReviews (Integer)
The number of reviews to retrieve if the GetReview property is set to Content or User. 0
(zero) = unlimited.

l

Moderate (Boolean)
Setting this property to True allows Ektron users to moderate reviews. See Also:
Moderating Reviews on page 588

l

RatingsMinimum (Integer)
Sets a minimum number of reviews before displaying the average rating. When set to 0
(zero), the average rating appears as soon as content is rated.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

UserID (Long)
The user ID for which to get reviews. If left blank, reviews from all users are returned.
If a user ID is specified, only reviews for that user are returned.
IMPORTANT: The GetReviews property must be set to User for the control to use this property.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
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o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Using the DisplayXSLT Property
Reviews communicate your site community's feelings about a product or article. They also
empower community members by giving them a voice. The ContentReview server control’s
DisplayXSLT property manages the display of reviews on your site. The control can display
reviews for specific content or a specific user.
The following list shows an example of each XSLT as it appears on a Web page with a
description and the XSL file being used. The files are located in
webroot\siteroot\Workarea\Xslt.
WARNING! If you want to edit an existing file, you are strongly urged to make a copy, change its name
and move it outside of your site's Workarea folder. If you make changes to this file and do not move it out
of the Workarea, this file and the changes will be lost when you upgrade. The files are copies of files built,
transformed and used, internally.
l

l

l

l

l

Ajax 5 Stars—rating5star.xsl—A 5-star rating system utilizing Ajax for display.

Ajax 5 Stars Comment—rating5starComment.xsl—A 5-star rating system utilizing
Ajax for display. When you hover over the stars, a review box pops-up. Visitor
comments are submitted via an Ajax call.

Ajax 5 Stars with Increments—rating5starinc.xsl—A 5-star rating system with
half-star increments that uses Ajax for display.

5 Stars—rating5starAddEdit.xsl—A 5-star rating system that lets visitors add text
reviews of content.

5 Stars with Increments—rating5starincAddEdit.xsl—A 5-star rating system with
half star increments that allows visitors to add text reviews of content.
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l

Review List—ratinglist.xsl—Displays a list of reviews for content or a user.

Retrieving the XML Structure of a ContentReview
Retrieving the XML structure of XML content allows for greater control over developing XSLs.
1. Open a new Web form.
2. Drag and drop a ContentReview server control onto it.
3. Set the DefaultContentID property.
4. Drag and drop a textbox on the Web form.
5. Set its TextMode property to MultiLine. You should set the width of the text box to at
least 400px.
6. On the code-behind page, add the following line.
7. Textbox1.Text = ContentReview.XmlDoc.InnerXml
8. Build the project.
9. View the Web form in a browser. The XML structure of the collection appears in the
textbox.

CurrencySelect
The CurrencySelect server control lets a customer select the monetary type he will use to
make purchases. When a currency is selected, eCommerce server controls use it for that
order. If the customer closes the browser, the currency needs to be selected again the next
time the site is visited.

For a currency to appear in the CurrencySelect server control, enable it in the Workarea >
Settings > Commerce > Currencies screen. See Also: Configuring Currencies on
page 1307

CurrencySelect Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

CustomXml (Code-behind Only) (String)
Lets you inject custom XML into the generated XML before being processed by the XSLT.
Enter a string of XML that you want to make available to the XSLT as follows:
<root><customXml>custom-xml-inserted-here</customXml></root>

See Also: Displaying Custom XML in Ektron’s Server Controls on page 1632.
l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.. By default, the control uses CurrencySelect.xsl. This file is located in
siteroot\Workarea\Xslt\Commerce
IMPORTANT: If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

DesignTimeDiagnostic
IMPORTANT: This control is for use in design-time only. Nothing is rendered at run-time.
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The DesignTimeDiagnostic server control is used to verify the connection to Ektron’s server
controls Web service. When added to a Web form, this control provides the following
information:
l
l

l

Web Service Path—the server control Web service path in your web.config file.
Web Service Exists—calls a method in the Web service that returns True if the Web
service exists. If it does not, it returns False.
Test Login Control—displays a Login server control to show that the Web service is
connected and working properly. When not connecting properly, an error message
appears.

The DesignTimeDiagnostic server control has no definable Ektron properties.
The following example shows the control on a page connected to the Web service.

The following example shows the control on a page not connecting to the Web service. Note
that the path is not the correct path. It should be:
http://192.168.0.82/siteroot/Workarea/ServerControlWS.asmx

Directory
The Directory server control lets you customize the behavior of the taxonomy feature. You
place this control on any Web form to display a taxonomy. See Also: Using Taxonomies on
page 777
NOTE: To display a taxonomy on a PageBuilder page, use the taxonomy summary widget.

Improving Taxonomy Performance
To minimize taxonomy’s impact on the performance of your production server, follow these
guidelines.
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l

l

Use the default page size (50). If you need to customize page size, use Ektron’s
Developer Reference Sample SiteAPI, but do not increase it above 800.
For large databases, do not increase the value of the TaxonomyDepth property above 1.
Changing this value dramatically slows down your production server’s performance.
However, you can increase depth on your staging server for testing purposes.

Directory properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

AddItemFolderID (Long)
Define the Ektron folder ID where content is stored when an item is added to the
taxonomy via the Add Asset link or the Add Content link. To enable adding content items
via the Directory server control, you must use an EkML file with the [$AddAsset] and
[$AddArticle] variables. See Also: taxonomy.ekml on page 1913

l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.
NOTE: If the EnablePaging property is set to True, the CacheInterval property is disabled.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a content ID dynamically.

l

EnableAjax (Boolean)
Set to true to enable Ajax searches. When enabled, the MaxResults property determines
the maximum number of results per page.
o

True—Enable Ajax Search (default value)

o

False—Original HTML Search
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l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen. See example below.

So, for example, if a taxonomy has 9 items and MaxResults is set to 3, the screen
displays only the first 3 items. When the site visitor clicks [Next], he sees items 4, 5
and 6, and so on.
IMPORTANT: If the EnablePaging property is set to True, the CacheInterval property is
disabled.
l

EnableSearch (Boolean)
Set to True if you want a search box (shown below) to appear above this taxonomy
display. A site visitor can use the search to find content within a taxonomy/category that
includes terms of interest. To suppress the search box, set to False.

l

GetAnalyticsData (Boolean)
Set this property to True if you want the following information for each content in the
list. Returns Content View Count, Content Rating, Content Rating Average.
Create your own XSLT styles to display this data.
IMPORTANT: This property provides reliable data only when the Business Analytics Feature is
enabled. Analyzing Content on page 601.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeIcon (Boolean)
Choose whether to display icons next to the taxonomy’s links.
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This property only works when ecmSummary or ecmTeaser are used in the
DisplayXslt property. When the [$ImageIcon] variable is used in an EkML file and that
file is assigned to the MarkupLanguage property, this property acts as True.

l

o

True—Show icons

o

False—Hide icons

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905
See Also: taxonomy.ekml on page 1913
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property
value is ignored. If the EkML file contains the [$ImageIcon] variable, the IncludeIcons
property acts as True.

l

MaxResults (Integer)
Enter the maximum number of items to appear in the initial display of this server
control. If you set this value to zero (0), the maximum is 50. To let site visitors view
more than the maximum but limit the amount of space being occupied, enter the
maximum number of results per page here. Then, set the EnablePaging property to
True. If you do and more than the number of MaxResults are available, navigation aids
appear below the last item to help the site visitor view additional items. See following
example below.
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l

OrderItemsBy
Specify the sort order of results. Choices are:
o

taxonomy_item_display_order—the order of taxonomy items as set in the
Workarea. For additional information, see Reordering Content Assigned to a
Taxonomy Category on page 806.

o

content_title—the content is listed in alphabetical order by title.

o

date_created—content is listed in the order by which it was created.

o

last_edit_date—content is listed in order, by its last edit date.

o

content_rating_average—Business Analytics Content Rating

o

content_view_count—Business Analytics Content Views

Use the the SortDirection propertyYou can to specify the direction of the items with
the SortDirection property.
l

PreserveUrlParameters (Boolean)
Set to true if this control needs to preserve the URL parameters on the page. For
example, if a server control displays a list of content items, the URL parameter passes to
the control the template names and id values that the template expects. Set to false if
the server control does not need to pass the URL parameters to the server control. The
default value is false.

l

Recursive (Boolean)
Set to True to include child folders of the parent folder.

l

ShowAllChecked (Boolean)
When set to True, a check box appears in the Show All check box.

l

ShowCount (Boolean)
Indicates if the number of taxonomy items appears next to each category when
displayed in the website. (See example below.) Default value is false.

l

ShowRoot (Boolean)
l
False—Top represents the first node of the taxonomy path
l
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l

SortDirection (String)
Select the direction of the ItemSortOrder property. Choose Ascending or Descending.

l

TaxonomyCols (Integer)
Enter the number of columns in which this taxonomy/category will appear on the page.

l

TaxonomyDepth (Integer)
Enter the number of taxonomy levels to retrieve below each taxonomy/category if you
are accessing a taxonomy’s XML using code-behind. For example, if the taxonomy is
Businesses > Restaurants > Pizza, and you set Taxonomy Depth to 2, only
Business and Restaurants are available in code-behind. This setting has no effect on the
display generated by the Directory server control, which always displays only one level
below the current. To retrieve all categories for a taxonomy recursively, enter -1. The
default value is 1.
IMPORTANT: For a live site, leave this value at 1. Increasing this value can slow down your live
Web server. However, for testing on a staging server, you can increase the depth.

l

TaxonomyId (Long)
Enter the ID number of the taxonomy or category to appear in this server control. If you
don’t know the number, click the button and navigate to the taxonomy or category.

l

TaxonomyItemCols (Integer)
Enter the number of columns in which this taxonomy/category items (articles) will
appear on the page.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Favorites
Ektron 8.7
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The Favorites server control displays a list of Ektron content and external Web links (URLs)
that a user has designated as favorite content. Within the control, Ektron content and URLs
appear in separate lists. To view favorite content, click Content. To view a list of external
URLs, click Link.

To learn about designating Ektron content as a favorite, see SocialBar on page 1845.

Adding a URL to Your Favorites
1. Log in and navigate to the profile page that hosts the Favorites control.
2. Click Add Link.
3. In the Name field, add a name for the URL link.
4. In the Link field, add the URL.
5. In the Description text area, add a description for the URL. This is optional.
6. Click OK.
After a URL is added, it appears on the control's Links list.
You also can add a URL to your Favorites by clicking the Add to Favorites link on the Social
Bar server control. See Server Control Reference on page 1636.

Grouping Favorites by Folder
The DisplayMode property controls whether a user’s Favorites are displayed as a basic list,
or if they can be organized in folders. For example, a user groups all content created by a
certain author in a folder with that author’s name. If you add a folder to a user’s favorites,
content in the folder appear in the Content list; URLs in the folder appear in the Links list.
To move a Favorite to a folder:
1. Make sure the Favorites server control's DisplayMode property is set to Directory.
2. Log in to the website.
3. Navigate to your profile page or the page the contains the Favorites server control.
4. In the Favorites server control, click Add Folder.
5. Enter a Name and Description for the folder.
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6. Optionally check one or more favorite items then click OK.

7. Click Move on the Favorites server control.

8. Select a folder to which the items will be moved.

9. Click OK. A dialog box appears asking you confirm moving the items. You can find the
Favorite content in the folder. Click the folder to see all content in that folder.

Deleting a Favorites Folder
WARNING! Deleting a folder also deletes all content links and URL links in the folder. If you want to
retain the links, move them out of the folder before deleting it. To remove a link from a folder, click the
folder, check the link, and click MoveUp One Level. Deleting a folder also deletes all of its subfolders.
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1. Navigate to your profile page or a page the contains a Favorites server control.
2. In the Favorites section of the screen, click Edit Folder (
dialog box appears.

) next to the folder’s title. A

3. Click Delete. A confirmation box appears.
4. Click OK. The folder is deleted.

Favorites Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultUserID (Long)
The default user ID for this control to use when there is no matching dynamic parameter
value passed.

l

DisplayMode (eDisplayMode)
Select the way this control displays community group information. Choices are:

l

o

List—shows a list of Favorites sorted in alphabetical order.

o

Directory— groups favorites by folder. If this selection is chosen, the following
menu items are added to the control:

o

Add Folder—allows a user to add a sub folder.

o

Move—allows a user to move content to a folder. This item only appears if at least
one folder exists. See Also: Grouping Favorites by Folder on page 1724

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.
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l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a user ID dynamically. To use the
default user ID, leave blank.

l

FavoritesTitle (String)
The title shown at the top of the control.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.
o

True—Hide the control output.

o

False—Display the control output.

l

Language (Integer)(missing snippet link)

l

Link (String)
Enter a link to the content Web page. This allows a user to click a link in the Favorites
control and be taken to the content.
o

{0}—content ID

o

{1}—content language

o

{2}—content title

The link must have all 3 variables. The Web form can be relative or absolute. Below is an
example.
contentpage.aspx?cid={0}&lang={1}&title={2}
l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905Controlling Output with Ektron Markup Language on page 1905

l

MaxResults (Integer)
The Maximum number of items to fetch. 0 (zero) = unlimited.
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l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Flex Menu
IMPORTANT: Starting from release 8.6, the Flex Menu server control was replaced by the
FrameworkUI: <ektron:MenuView> templated server control. If you are already using the Flex Menu
server control, you can continue to do so, but Ektron recommends using current versions of functionality.
The Flex Menu server control displays a menu on a Web form. A Flex Menu creates XML, so
you can modify its behavior using an XSLT file, and change its appearance using a cascading
style sheet (.css) file.
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Before you can use this server control, you must create one or more menus in the Workarea.
See Also: Using Menus on page 753, Contrasting Menu Server Controls on page 775
This section also contains the following topics.
Working with the Flex Menu Xslt File
How Flex Menu Determines Which Item is Selected
Analyzing Flex Menu's Selection of Menu Items
Flex Menu Properties
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Working with the Flex Menu Xslt File
This section explains some non-intuitive elements of the *.xslt file.
l

MenuFragment
<xsl:when test="/MenuDataResult/Info/menuFragment='false'">
A flag that indicates the XML data is not complete. Instead, it’s a fragment that begins
deeper than the top level (for example, a submenu fragment).
Because the data is incomplete, the XSLT processes the fragment differently. For
example, don’t generate JavaScript startup code.

l

menuConst
<xsl:attributename="id"><xsl:value-ofselect="$menuConst"/>0_
ekflexmenu</xsl:attribute>
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Each menu generates several elements, which the client code (JavaScript) accesses via
a unique ID. For example, JavaScript needs to identify the selected submenu or item
when a user clicks on an element.
menuConst is only used is when creating elements without a corresponding XML block,
such as when creating a structure to hold the menu.
l

#NoScroll
<xsl:attribute name="href">#NoScroll </xsl:attribute>
NoScroll is sent to the href portion of a link when there is nothing to put there (for
example, when the link is supposed to run JavaScript).
NoScroll prevents the page from refreshing, going to another page, or scrolling when it
should not.

l

event
<xsl:attribute name="onkeydown">returnekFlexMenu.menuBtnKeyHdlr
(event);</xsl:attribute>
To make the xslt cross-browser compatible, it must support different methods of
obtaining/passing the event object. In this example, the global event object is passed to
the handling function.
NOTE: event corresponds to window.event. window. is implied.

How Flex Menu Determines Which Item is Selected
The Flex Menu server control can select (highlight) options in a Flex menu as site visitors
navigate around the website. For example, a site visitor arrives at a Web page through a link
in an email. If the QueryString matches the an item in a Flex menu, the item is shown as
selected.
Below is the logic the Flex menu uses to decide when a menu item should show as selected.
The list is presented in the order in which the code checks to see if an item should be
highlighted.
If any menu item is selected, its parent menu is marked selected. If any menu is selected, all
ancestor menus are selected. When all tests have been performed and no matches are found,
the Flex menu is rendered with no items selected.
NOTE: As soon as one condition is satisfied, the item is shown as selected and the testing stops.
NOTE: Steps 2 through 8 are each repeated recursively throughout the menu data hierarchy until either a
match is found or the end is reached. If there are no matches for a test, the control continues with the next
one.
1. Inspects the QueryString to see if the ekxmensel parameter is present with a matching
menu node ID. This parameter is used to specify the exact node a user clicked. The
node, its parent, and ancestor menus are all marked as selected.
2. Inspects the QueryString to see if a Content ID parameter value matches a menu item.
If the Content ID in the QueryString matches a menu item, it is highlighted. For
example, the QueryString includes ExamplePage.aspx?id=123, and a menu item links to
Content ID 123.
3. Inspects the QueryString to see if a Form ID parameter value matches a menu item. If
the Form ID passed in the QueryString matches a Flex menu item, it is highlighted. For
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example, the QueryString includes ExamplePage.aspx?ekfrm=456, and a menu item
links to Form ID of 456.
4. Inspects the QueryString for a direct match with a menu item link. If there is a match,
the menu item is selected. For example, if the QueryString has ExamplePage.aspx and
there is an item on the menu that matches, the menu item is shown as selected.
5. Inspects the QueryString for a id, ekfrm or pageid parameter. If one is found, the
control looks for a folder association between submenus and the folder that contains the
object with the given ID. If the association exists, the menu item is shown as selected.
6. Inspects the QueryString to see if there is a direct match with a menu button link. If
there is a match, the menu button is selected. For example, the QueryString has
ExamplePage.aspx and there is a button on the menu that matches.
7. Inspects the QueryString to see if there’s a template association with the filename. If
there’s a match, the menu item is shown as selected.
8. Inspects the QueryString for the id or ekfrm parameter and whether a value greater
than zero is associated with it. If so, the control checks menu buttons for use of
LinkIt.aspx. If a button is using LinkIt.aspx and either id or ekfrm parameter
matches, the menu button is selected.

Analyzing Flex Menu's Selection of Menu Items
The Flex Menu server control performs a complex sequence of tasks to determine which
menu option to select. If you are unsure of a Flex Menu's behavior, you can view a log that
lists the reasons for a menu selection. Use the log to troubleshoot issues with a Flex Menu.

Setting Up Log of Flex Menu Information
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Follow these steps to set up the ability to view a log of Flex Menu display information.
1. Open your site root/web.config file.
2. Under system.diagnostics, set LogLevel to 4. Save and close web.config.

3. Edit the .aspx or .ascx page that hosts the Flex Menu control.
4. Set the control's LogInfo property to true and save the page.
<CMS:FlexMenu ID="FlexMenu1" LogInfo="True" runat="server" />

NOTE: It may be helpful to temporarily disable the menu's cache by setting
CacheInterval="0".
5. Refresh the browser that contains the Flex Menu you edited in the Step 4.

6. Using the Windows Event Viewer, look for the newest information-level event that
contains Message: Flex Menu (under the timestamp line).
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The event message identifies the reason the menu node was selected. Or, if no matches were
found, the message indicates that nothing is selected.

Flex Menu Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (Boolean)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

AutoCollapseBranches (Boolean)
o True—whenever a new submenu opens, all other submenus close.
o

l

False—other submenus remain open when a new one opens.

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultMenuID (Long)
The ID of a menu that appears where you insert this server control if no other menu is
identified or available. If you don’t know the ID number of the menu, use the CMS
Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610
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NOTE: If you want to change the Default menu's Starting menu, use the StartMenuID property.
l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page. If nothing is specified, the menu is output as raw XML. Flex menus are designed to
use the xsl file to control the menu’s behavior, and the .css file to control its display.
Ektron provides several sample menus, and each has an xslt file. If this is a new menu,
you may find it easier to copy and edit an xslt file provided with a sample menu. See
Also: SampleMenu on page 1783
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

EnableAjax (Boolean)
Set to True to enable Ajax, which only downloads sub-menus as needed.

l

EnableMouseOverPopup (Boolean)
o True—submenus appear as soon as the cursor moves over them.
o

l

False—submenus only appear if a site visitor clicks them or a keyboard equivalent.

EnableSmartOpen (Boolean)
Lets you prevent submenus from opening by default. Under some circumstances, such
submenus look cluttered.

l

o

True—submenu can open automatically. To learn how to do this, see Assigning
Folders or Templates to a Menu on page 772.

o

False—even if all required conditions are present, submenus on a Flex Menu do not
automatically open.

IncludeJS (Boolean)
o True—load the menu's JavaScript.
o

l

False—ignore the menu's JavaScript. This would be useful if you redefine the
menu's output with an XSLT.

MasterControlId (String)
Only use this property if you are setting up a master/slave menu relationship, and this
menu is the slave. If both are true, enter the ID of the master menu.

l

MenuDepth (Integer)
To let site visitors browse through all menu levels, enter zero (0). To restrict site visitors
to a menu level, enter the number of the lowest level. In the following example, if you
set this property to 1, a site visitor can browse through the About Us menu options but
would not see the level 2 options (Company Profile and Careers).
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l

StartCollapsed (Boolean)
If you set to True, when the menu first appears, all submenus are closed.

l

StartLevel (Integer)
Enter a number to indicate the level at which you want this menu to display when it first
appears. To begin the menu display at the root level, enter zero (0). In the following
example, the Home folder is level 0. The others are level 1.

A site visitor can click a menu option to navigate to folders below the displayed level.
NOTE: If you set a StartMenuID, the StartLevel property is ignored.
l

StartMenuId (Integer)
Use this property to have the default menu begin somewhere other than its root. That is,
at any submenu under the default menu. For example, menu ID 46 (Products) is the
default menu. However when that menu displays, you only want to show its submenus,
beginning with Products Support (ID 58). In this case, enter 46 into the DefaultMenuID
property and 58 into the StartMenuID property.
NOTE: If you set a StartMenuID, the StartLevel property is ignored.
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l

Stylesheet (String)
Enter the style sheet that will determine the appearance of the menus. Flex menus use
an .xsl file to control their behavior, and a .css file to control their display. Ektron
provides several sample menus, and each has a .css file. If this is a new menu, you may
find it easier to copy and edit a .css file provided with a sample menu. See Also:
SampleMenu on page 1783

l

SuppressAddEdit (Boolean)
When set to True, suppress the Add and Edit buttons on the menu when a user is logged
in to Ektron. The default is False.

l

o

True—suppress the Add and Edit button when a user is logged in to Ektron.

o

False—show the Add and Edit buttons when a user is logged in to Ektron.

SuppressWrapperTags (Boolean)
This property is set to false because Ajax uses <div> tags to rewrite the region around
the tag. You cannot change the value to true.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

FolderBreadcrumb
Use a FolderBreadcrumb server control to display Sitemap breadcrumbs. This trail typically
consists of the current content’s folder path. For example, the FolderBreadcrumb below
matches the content’s folder structure.

The FolderBreadcrumb server control does not read your folder structure and display its path.
Instead, administrators define a folder’s breadcrumb trail on the Folder properties >
Breadcrumb tab.

FolderBreadCrumb Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

AddContentTitleToBreadcrumb (Boolean)
When set to true, the content title is added to the end of the breadcrumb path, as shown
below.
Home > Content > Content_Title
By default, the value is set to false. In that case, the breadcrumb path looks like this.
Home > Content

l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DefaultContentID (Long)
Display the breadcrumb trail for the folder in which the given content ID resides. To use
this property, breadcrumb information for a folder must be defined in the Workarea >
[Specified Folder] > Folder properties > Breadcrumb tab.

l

DefaultFolderID (Long)
The folder ID for which you want the breadcrumb trail to display. If a DefaultContentID
is given, it overrides this property. To use this property, breadcrumb information for a
folder must be defined in the Workarea > [Specified Folder] > Folder properties >
Breadcrumb tab.

l

DisplayStyle (DisplayStyles)
Indicate how to display the breadcrumb trail: horizontally or vertically. The default is
Horizontal.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a content ID dynamically.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.
o

_Self (default)—opens in same window.

o

_Top—opens in parent window.
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l

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

Mode (Modes)
Lets you make the breadcrumb trail appear as non-hyperlinked plain text.

l

o

Normal (normal)—breadcrumb trail is hyperlinked

o

DisplayOnly—breadcrumb trail is plain text

Separator (String)
Enter one or more characters to separate the items in a breadcrumb trail on this Web
form. The default character is the greater than sign (>).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

FormBlock Server Control
The FormBlock server control displays a content block associated with a form. When added to
a template and visited, the form content block might look like the following example. You can
change the display to suit your needs by modifying its properties. See Also: Working with
HTML Forms on page 386
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IMPORTANT: If you create a template for an existing form content block, you must manually change its
quicklink to point to the new template. This change does not occur automatically. This procedure is
described in Adding a Quicklink or Form to Content on page 346.

FormBlock Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

AddValidation (Boolean)
The AddValidation property is obsolete and ignored. It has no effect. It is always true.

l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultFormID (Long)
The ID of a FormBlock that appears where you inserted this server control if no other
form block is identified. If you don’t know the ID number of the form block, use the CMS
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Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
To make this form block dynamic, select id. When you do, this server control uses the
form block passed as a URL parameter.

l

Fields (FormFieldCollection)
Displays a list of fields that are defined in the form. These fields are read only. This is an
excellent way of displaying the field names used on the form. With this list of names,
you can create events using the fields without having to enter the Workarea to see the
names.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeTags (Boolean)
Determines if tags are generated automatically of manually.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Forum
After creating at least one hierarchy of discussion board elements, place a Forum server
control on a Web page. The Forum server control displays a discussion board on a Web page.
You should add text below the Login server control to remind the site visitor to enter an email
address at the User field. For example, “At the User field, enter your email address.” See
Also: Working with Discussion Boards on page 536
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If you want to require site visitors to authenticate, the Web page that hosts the forum should
also contain
l

l

a Membership server control (or a link to page that has one). This lets site
visitors/membership users register for discussion boards.
a Login server control that lets the site visitor/membership user log in

IMPORTANT: After placing a Forum server control on a page, follow the procedure described in Updating
the Page Command on page 1746. Otherwise, the user may get an error when posting a reply.

Forum Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

AllowAnonymousPost (Boolean)
Set to True to allow site visitors the option of posting anonymously to the forum. When
true, a Post Anonymous checkbox appears above the text editor used to create a post.

If a site visitor adds a check mark to this box, the word Anonymous appears where the
Display Name normally appears. The default is True.

l

o

True—display Post Anonymous checkbox when site visitors create a post.

o

False—disable Post Anonymous checkbox.

Authenticated (Boolean)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.
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l

BoardID (Long)
The ID of the discussion board to display on this page if one is not defined in a query
string parameter. If you don’t know the ID, click Ellipses (
discussion board.

l

), then sign in and select a

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

CustomOrderBy (String)
Provide a property’s Friendly Name to order search results by that property. For
example, if you define DocAuthor, results will be sorted by the document’s author.
Results can be ascending or descending based on OrderDirection. If you enter an
invalid property, no search results are returned. If you specify both CustomOrderBy and
OrderBy, the OrderBy property is ignored.

l

DefaultObjectID (Long)
The Static ID of a community group.

l

DynamicForumParameter (String)
Gets or sets the QueryString parameter to read a forum ID dynamically. The default is
“f”. Note that a Forum resides one level below a discussion board.

l

DynamicGroupParameter (String)
Gets or sets the QueryString parameter to read a group’s ID dynamically. The default is
“g”.

l

DynamicObjectParameter (String)
Dynamic Parameter for the community group id. Default is “id”.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a discussion board’s ID dynamically. Set
to None - Use Default—if you want to always display the default discussion board.
Note that a discussion board is one level above a Forum.

l

o

boardid—reads a Threaded discussion board’s ID dynamically.

o

None - Use Default—use the default discussion board’s ID.

o

ID—reads a discussion board’s ID dynamically.

DynamicThreadParameter (String)
Gets or sets the QueryString parameter to read an individual thread’s ID dynamically.
The default is “t”. Note that a Thread resides 2 levels below a discussion board and one
level below a Forum.

l

EditorCSS (String)
Set the style sheet for the Editor when a site visitor creates or edits a post. By default,
this property is blank. When a style sheet is not supplied, the style sheet defined in the
Theme property is used.

l

EditorToolbar (String)
Enter a comma separated list of items that you want to appear on the Editor’s toolbar.
The default is StyleMenu, FontMenu, ParagraphMenu, TextFormatMenu,
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LinkMenu, ClipBoardMenu, SymbolsMenu, EmoticonSelect, WMV, Table. See
Also: Adding and Removing Toolbar Items From the Editor on page 1747.
l

EnableForumQuickSelect (Boolean)
If you set this property to true, a drop-down list of all forums appears below the topic
list. The site visitor can click a forum and jump immediately to it.

l

EnableThreadRating (Boolean)
If you set this property to true, a ContentReview server control appears on any topic
screen run by this server control. The site visitor can use the control to rate the topic
thread. An average rating for the thread appears next to each topic on the forum screen.

l

ExcludeList (String)
Enter a comma-separated list of custom user properties to exclude from the Forum’s
profile page. For example, to suppress the Subscriptions field value, enter
subscriptions.

l

FilterXslt (String)
Enter the path to an XSLT file used to filter forum content, such as, HTML Attributes,
Tags and unwanted words in a user’s forum post. The path can be relative or absolute.
The user’s post is filtered when the user clicks Submit. By default, this property points
to <webroot>/siteroot/Workarea/Xslt/ForumFilter.xslt. This file removes hrefs
with javascript:, vbscript: and “on” events in the link. You can modify this file or create a
new one.
WARNING! If you want to edit this file, make a copy, change its name and move it outside of your
website’s Workarea folder. If you make changes to this file and do not move it out of the Workarea
folder, this file and the changes will be lost when you upgrade.
For additional sample code used to create a filter XSLT, see the following KB article:
XSLT: Gallery of Templates

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

HideUserProfile (Boolean)
o True—hide user profiles from non-administrator users.
o

False—display user profiles for non-administrator users.

The default is True. An administrator can view a profile regardless of how this property
is set.
On the other hand, if the Private Profile is set to Private for any user, the profile
information is not visible, regardless of this setting. If Private Profile is set to
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Colleagues, only colleagues can see profile information. When the profile is visible, only
properties and their values not listed in the ExcludeList property (above) appear.
l

JavascriptEditorHeight (Integer)
Set the height in pixels for the eWebEdit400 editor. The default is 400. The minimum
height is 300.

l

JavascriptEditorWidth (Integer)
Set the width in pixels for the eWebEdit400 editor. The default is 625. The minimum
width is 500.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).
Set property to -1 if you want the Forum server control to display topics from all
available languages.

l

ObjectType (String)
Describes the type of forum displayed by this server control.

l

o

CommunityGroup—Used for forums inside a Community page.

o

DiscussionBoard—Used for forums on templates that are not Community pages.

OrderBy (String)
The order of search results. For example, you want to sort search results by last
modified date.
o

Title—Content title (alphabetical).

o

ID—Content ID number.

o

Date Created—Date the content was created.

o

Date Modified—Date the content was most recently modified.

o

Editor—User who last edited the content (alphabetical).

o

Rank—Rank assigned to the content.

NOTE: The OrderDirection field determines the direction of the search results. For example, if you
sort by ID and OrderDirection is set to Descending, the results sort by ContentID number with the
highest number at the top of the list.
IMPORTANT: Specifying a CustomOrderBy property overrides this property.
l

OrderDirection (String)
The direction in which search results are sorted. The default is Ascending.

l

o

Ascending—Alphabetical results from A to Z; numeric values low to high; dates
from oldest to most recent

o

Descending—Alphabetical results from Z to A; numeric values high to low; dates
from most recent to oldest

ProfileLink (ItemLinkTargets)
Enter a link to the user’s social networking profile page, a part of Ektron’s community
platform. This allows a user to click another user’s name link or avatar and be taken to
the user’s profile page. The link has 2 variables that represent the user’s ID and display
name.
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o

{0}—user ID

o

{1}—user display name

You need to have both variables in the link. The Web form can be relative or absolute.
For example:
userprofilepage.aspx?uid={0}&dn={1}
The default for this property is ?g=profileu={0}.
When the default for this property is used, users are forwarded to a user’s profile page
that is included with the forum control.
l

ProfileLinkTarget
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

ShowCategories (Boolean)
If set to True, when this server control appears, the user see a Filter by Category
option. This option helps a site visitor zero in on relevant content. If False, the Filter
by Category option does not appear.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TaxonomyCols (String)
Use this property to determine the number of columns on the Taxonomy screen
available from this discussion board. In the illustration below, taxonomy categories are
arranged in 3 columns (the default value).

l

TaxonomyMarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905
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l

Theme (String)
Enter the custom theme’s folder name. The theme can be relative to the site root or
located in the current folder. For example:
o

Relative—Theme=”/workarea/csslib/themes/winter”

o

Current Folder—Theme=”mytheme”

If you do not specify a theme, the property uses the location defined by the discussion
board’s CSS theme property in the Workarea. See Also: Using a Custom Theme below
l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Updating the Page Command
To prevent an error from appearing when a user posts a reply to the Web page that hosts the
Forum server control:
1. Open the Web form onto which you inserted the Forum server control.
2. Access Source view.
3. Go to the top line of the Web form, which begins with @ Page.
<%@ PageLanguage="VB"AutoEventWireup="false"
CodeFile="Default2.aspx.vb"Inherits="Default2" %>

4. Near the end of the line, enter validaterequest=false.
5. Build the page.

Using a Custom Theme
This property lets you specify a custom location for your themes. By doing so, you prevent
them from being overwritten when you upgrade.
If you do not specify a theme in the server control, Ektron uses what is defined in the
discussion board’s properties CSS Theme field.
To create a custom theme:
1. Create a new subfolder on your site. In this example, we use a winter theme:
<web root>/<your site>/Workarea/csslib/winter.

2. Copy all files in the /Workarea/Threadeddisc/themes folder to the winter folder.
3. Change the image files to match your theme. To find the name of an image:
a. Right click on it while viewing it in a browser.
b. Select Properties. The name appears at the top of the dialog box.
4. Change the discussion board’s .css file to match your theme and save it with a custom
name. (You do not need to do this if an existing .css file meets your theme’s needs.)
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IMPORTANT: Make sure the CSS theme property in the Workarea is pointing to the proper CSS
file.
5. View the discussion board in a browser to see the changes.

Adding and Removing Toolbar Items From the Editor
IMPORTANT: You cannot create new buttons and add them to the Forum Editor. You can only add and
remove existing buttons.
You can add and remove toolbar items on the Forum Editor by editing the EditorToolbar
property. This property contains a series of string values that represent each item, listed
below.
l

l
l

l

l

l

l

StyleMenu—Display a list of paragraph styles. Users can select from the list to apply a
style to selected text.
FontMenu—Display a list of available font styles, sizes and colors.
ParagraphMenu—Controls the display of buttons that affect a paragraph. This includes:
o Numbered List
o

Bullet List

o

Outdent

o

Indent

o

Align Left

o

Align Center

o

Align Right

o

Justify

o

Horizontal Rule

TextFormatMenu—Controls the display of buttons that format text. This includes:
o Bold
o

Italics

o

Underline

LinkMenu—Controls the display of buttons that allow a user to add and remove
hyperlinks links and work with the library. This includes:
o Hyperlink Manager
o

Remove Link

o

Library

ClipBoardMenu—Controls clipboard buttons that allow a user to cut, copy, and paste
content. This item also controls the Undo and Redo buttons.
SymbolsMenu—Controls the display of the Symbol button, which allows users to insert
symbols and special characters.

l

EmoticonSelect—Controls the display of the Emoticon button.

l

WMV—Controls the display of the Insert WMV button.

l

Table—Controls the display of the Insert table button.

Friends (Colleagues)
Ektron 8.7
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Part of the Community Platform, the Friends server control typically appears on your profile
page and displays your colleagues. If you browse to another user's profile, you see that
user's colleagues. See Also: Using the Friends Server Control on page 1252

Friends Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

AvatarHeight (Integer)
The display height in pixels of the avatar in the results box. 0 (zero) = unlimited.

l

AvatarWidth (Integer)

l

The display width in pixels of the avatar in the results box. 0 (zero) = unlimited.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultUserID (Long)
The default user ID for this control if no matching dynamic parameter value is passed.

l

DisplayMode (eDisplayMode)
Select the way this control displays colleagues. Choices are:

l

o

Directory—allows users to group colleagues by folders. In this mode, these menu
items appear.

o

Add Folder—lets user add a folder.

o

Move—lets a user place colleagues in a folder. This option appears only if a folder
exists.

o

List—lists colleagues in alphabetical order

o

Pending—lists users who have sent colleague requests to the logged-in user. The
user can approve or decline these requests.

o

SentInvites—lists users to whom the logged-in user sent colleague requests. The
user can cancel invitations that have not been accepted yet.

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.
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l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a user ID dynamically. To use the
default user ID, leave blank.

l

FriendLabel (String)
Set the singular text to be used as a title for the Friends server control. The default value
is Colleague.

l

FriendsLabel (String)
Set the plural text to be used as a title for the Friends server control. The default value is
Colleagues.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Link (String)
Enter a link to the user profile page template. The path can be relative or absolute. This
value is referenced when a user clicks another user in the Friends control. Upon clicking
the link, the selected user’s profile page appears. The link requires these variables.
o

{0}—represents user ID

o

{1}—represents user display name

For example: userprofilepage.aspx?uid={0}&dn={1}
l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905

l

MaxResults (Integer)
The maximum number of colleagues to display in the control. 0 (zero) = unlimited.
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l

RenderOutput (Boolean)
Lets you determine whether or not to generate output. If you do not, CSS and JS are not
registered.

l

o

True (default)—The control's output is generated.

o

False—The control fetches data from the backend but generates no output. You are
responsible for generating output using XML or DataClasses

ShowSortingOptions (Boolean)
Determines if sorting options appear on the control. If set to True, the following options
appear:

l

o

Colleagues—all current colleagues

o

Pending—colleagues who sent you a colleague request that you have not yet
accepted

o

Invited—colleagues to whom you have sent colleague requests

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

ImageControl
The ImageControl server control, when viewed on a Web form, displays an image stored
within the Ektron Document Management feature. If you log in and have permission to edit
the image, you can right click the image and select Edit. This action displays a dialog box
with which the user can update the image.
IMPORTANT: Images are stored as assets using the Document Management feature. This control does
not use the Ektron Library.

ImageControl Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DefaultImageID (Long)
The image asset’s content ID you want to display. If you don’t know the ID number of
the asset, use the CMS Explorer to browse to it.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read an image asset’s ID dynamically. To
have the default image ID used, leave blank.

l

FolderID (Long)
The ID of the folder where images are added. If you don’t know the ID number of the
folder, use the CMS Explorer to browse to it.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TaxonomyID (long)
The ID of the taxonomy to which assets are added.

l

Title (String)
Set the image’s alt/title text. By default, the image file name is used.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Invite
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The Invite server control lets a site visitor invite people to join a site or become a colleague.
The control displays a dialog box that prompts for several email addresses. The dialog
includes an optional message, which appears in the body of the email. The site visitor can edit
or delete the message.

NOTE: Messages are defined in the Workarea. For more information, see Generating email Invitations for
Community Management on page 1230.
Invitations have a single "from" email address. Its default value is
invitations@example.com. Your site administrator should change it to one that is
appropriate for your organization. To change the "from" email address for invitations, open
your site’s web.config file and change the value of following key.
<add key="ek_InvitationFromEmail" value="invitations@example.com"/>

WARNING! The default From email address used to send all invitations is invitation@example.com.
Ektron, Inc. strongly recommends changing this address.

Invite Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.
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l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

FriendMessageId (Long)
The ID of the message to send in the link section of a FriendInvitation type email. This
message is defined in the Workarea > Settings > Community Management >
Messages. See Also: Generating email Invitations for Community Management on
page 1230. If set to 0 (zero), the server control uses the default message.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

InviteMessageId (String)
The ID of the message to send in the link section of a GroupInvitation or FriendInvitation
email. This message is defined in the Workarea > Settings > Community
Management > Messages. See Also: Generating email Invitations for Community
Management on page 1230. If set to 0 (zero), the server control uses the default
message.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

OptionalMessageText (String)
The body text of the email message. The text appears in the Invite server control’s
dialog box and can be edited by site visitors when they use the Invite control.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.
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LanguageAPI
The LanguageAPI server control lets a developer force a particular language for a website.
You can do this by dropping the server control on the page and setting a language in the
SiteLanguage property box. You can also override site language logic by programmatically
using the LanguageAPI server control to detect the browser’s language, and display the site in
that language.

LanguageAPI Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

SiteLanguage (String)
Sets the site language. Runs through the IsValid function to verify that the language is an
active language in the system.

l

SiteLanguageID (Integer)
Numeric value of the site language. This is the property you will use if you are using
code-behind to set the sites language ID.
Example: 1036 = French
For a list of supported languages, go to Workarea > Settings > Configuration >
Language Settings.

LanguageAPI Code-Behind Only Properties and
Methods
The following is a list can only be used programmatically.
l

CurrentLanguage (String)
Read only. Returns the current language.

l

CurrentLanguageID (Integer)
Read only. Returns the current language ID.

l

DefaultLanguage (String)
Read only. What the default language of the site is set to. For example, the demo site is
“English (Standard)”.

l

DefaultLanguageID (Integer)
Read only. Returns the value that is the default language ID of the site. For example,
the demo site is “1033” for English.

l

GetLanguage (Integer Argument)
This method returns a string. Pass in a valid language ID and it will return the language
name.

l

GetLanguageID (Sting Argument)
This method returns an integer. Pass in a valid language name and it will return the
language ID.
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l

IsValid (Argument)
This method returns a boolean. You can pass in a language ID or a string and it will tell
you if the system is supporting it.

l

LanguageIdList (Array of Integers)
Read only. Lists all the language IDs that are activated in Ektron. For information on
how to enable languages, see Determining Which Languages are Available on page 1059.

l

LanguageTitleList (Array of Strings)
Read only. Lists all the languages that are activated in Ektron.

l

MultiLanguageEnabled (Boolean)
Read only. Tells if the site supports multi-language mode.
o

True (default)—Multi-language enabled

o

False—Multi-language not enabled

Using LanguageAPI Programmatically
This example uses a logo that is not managed through Ektron. It retrieves the current
language from the LanguageAPI control, and uses that information to choose the logo version
to display. The code-behind looks like this.
Select Case LanguageAPI1.CurrentLanguageID
Case 1031
Image1.ImageUrl = "germanlogo.png"
Case 1033
Image1.ImageUrl = "englishlogo.png"
Case 1036
Image1.ImageUrl = "frenchlogo.png"
End Select

LanguageSelect
The LanguageSelect server control displays a language selection drop-down list on an Ektron
Web page. The control lets a site visitor select a language in which to view the site. Here is
what the control looks like when published on a Web page.

It lists all languages selected on the Settings > Configuration > Language settings
screen. (For more information, see Working with Multi-Language Content on page 1057.)
You can place this control in any location of any page on your site.

LanguageSelect Properties
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The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

LabelName (String)
Lets you define the label next to the language select drop-down box.

l

Language (Integer)
Set a language for the Language Select Box. This property shows results in design-time
(in Visual Studio) and at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

ListSummary
IMPORTANT: Starting from release 8.6, the ListSummary server control was replaced by the
FrameworkUI: <ektron:ContentView> templated server control. If you are already using the ListSummary
server control, you can continue to do so, but Ektron recommends using current versions of functionality.
The ListSummary server control displays a list of content in a selected folder on a Web page.
Optionally, the display can include content in all subfolders of the selected folder. When added
to a template and visited, a List Summary looks like this.
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It displays each content block’s title and summary information. You can modify the display to
suit your needs by modifying its properties.
NOTE: To display a List Summary on a PageBuilder page, use the ListSummary widget.
This section also contains the following topics.

NOTE: In contrast to a List Summary, a ContentList server control displays selected content items from
any Ektron folder. See Also: ContentList on page 1708

ListSummary Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

AddText (String)
Override the control’s default text for the Add Content menu item.
For example, you have a News website. You could change Add Content to Add News
Item.
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l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.
NOTE: If the EnablePaging property is set to True, the CacheInterval property is disabled.

l

ContentParameter (String)
Checks the QueryString for this value and replaces the list summary with a content block
when specified. Leave blank to always display the list summary.

l

ContentType (String)
Determines the type of content that appears in the list summary. The default is Content.
Choices are:

l

o

AllTypes—all content types for the given folder

o

Content—a list of content items.

o

Forms—forms appear in the list summary

o

Archive_Content—archived content blocks appear in the list summary

o

Archive_Forms—archived forms appear in the list summary

o

Assets—assets, such as offices documents, appear in the list summary

o

Archive_Assets—archived assets appear in the list summary

o

LibraryItem—library items appear in the list summary

o

Multimedia—multimedia items appear in the list summary

o

Archive_Media—archived multimedia items appear in the list summary

o

NonLibraryContent—all content types except library items.

o

DiscussionTopic—forum topics appear in the list summary.

o

CatalogEntry—displays all catalog entries (products) for a specified catalog.

DisplayXslt (String)
Determines how information on the page appears
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o

None—databind only

o

ecmNavigation—lists the title of every content block in the folder See Also:
Collection on page 1677

o

ecmTeaser—lists the title of every content block in the folder plus the content
summary See Also: ecmTeaser Display Example on page 1682

o

Path to Custom Xslt—If desired, enter a relative or absolute path to an Xslt that
determines the display of the page.

WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property
value is ignored.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen.
See example below.

So, for example, if a List Summary has 9 items and the MaxResults property is set to 3,
the screen displays only the first 3 items. When the site visitor clicks [Next], he sees
items 4, 5 and 6, and so on.
o

True—Use paging feature

o

False—Ignore paging feature

NOTE: If the EnablePaging property is set to True, the CacheInterval property is disabled.
l

FolderID (Long)
The folder that contains the items which appear in the list summary. See Also: Browsing
Your Ektron Site Using CMS Explorer on page 1610. The Recursive property determines
whether content blocks in this folder’s child folders also appear.

l

GetHtml (Boolean)
Set to True to display the HTML body for all content in the list summary. For example, to
display content inside a Web server control such as a GridView.
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l

o

True—Get and display HTML for each content block in the list summary

o

False—Do not get and display HTML.

GetAnalyticsData (Boolean)
Set this property to True if you want the following information for each content in the
list. Returns Content View Count, Content Rating, Content Rating Average.
Create your own XSLT styles to display this data.
IMPORTANT: This property only provides reliable data when the Business Analytics Feature is on.
Analyzing Content on page 601.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeIcons (Boolean)
Choose whether to display icons next to the list summary’s links.
IMPORTANT: This property works only when ecmSummary or ecmTeaser are used in the
DisplayXslt property. When the [$ImageIcon] variable is used in an EkML file and that file is
assigned to the MarkupLanguage property, this property acts as True. See Also: Controlling
Output with Ektron Markup Language on page 1905

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkTarget (String)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
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relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905
See Also: listsummary.ekml on page 1907
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt
property value is ignored. If the EkML file contains the [$ImageIcon] variable, the
IncludeIcons property acts as True.
l

MaxResults (Integer)
Enter the maximum number of items to appear in the initial display of this server
control.
If you enter no value or 0 (zero), the maximum is 50. This is done for performance
reasons.
To let site visitors view more than the maximum but limit the amount of space being
occupied, enter the maximum number of results per page here. Then, set the
EnablePaging property to True.
If you do and more than the number of MaxResults are available, navigation aids
appear below the last item to help the site visitor view additional items. See example
below.

l

OrderbyDirection (Ektron.Cms.Controls.CmsWebService.OrderByDirection)
How to order the hyperlinks on the list. The sort field is determined by the OrderKey
property.
o

ascending—hyperlinks are arranged A, B, C or 1,2,3.

o

descending—hyperlinks are arranged Z, Y, X or 3,2,1

If sorting by date, descending puts the most recent first.
l

OrderBy (Ektron.Cms.Controls.CmsWebService.TeasersOrderBy)
NOTE: For releases 8.0.1 and later the OrderKey property has replaced by this OrderBy property.
Sort the list by one of the values.

l

o

Title—Content Title

o

DateModified—Date content last modified

o

DateCreated—Date content created

o

LastEditorFname—First name of user who last edited content

o

LastEditorLname—Last name of user who last edited content

o

Start Date—Go Live date of content

o

Rated—Business Analytics Content Rating

o

ContentViewCount—Business Analytics Content Views

Random (Boolean)
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Set to True if you want to randomly display one content block in the specified folder. The
content changes each time a user views the page.
o

True—randomly display one content block.

o

False—display the list summary normally.

If you use a custom XSLT or EkML file, the type of content displayed can be manipulated.
For example, if you use an EkML file that has the [$Html] variable in it, the actual
content appears instead of a link. See Also: Controlling Output with Ektron Markup
Language on page 1905 and [$Html] on page 1937
l

Recursive (Boolean)
Determines if the display includes content in child folders of the selected folder.

l

o

True—include content from child folders.

o

False—do not include content from child folders.

SelTaxonomyID (Integer)
Set the ID of the taxonomy that content will be associated with when a logged in site
visitor uses the Silver Access Point’s Add HTML Content to add content to a list
summary server control.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Retrieving the XML Structure of a List Summary
Retrieving the XML structure of XML content allows for greater control over developing XSLs.
The following example shows how to retrieve the XML structure.
1. Open a new Web form.
2. Drag and drop a ListSummary server control onto it.
3. Set the FolderID property.
4. Drag and drop a textbox on the Web form.
5. Set the TextMode property to MultiLine.
NOTE: You should set the width of the text box to at least 400px.
6. On the code-behind page, add the following line.
Textbox1.Text = ListSummary1.XmlDoc.InnerXml

7. Build the project.
8. View the Web form in a browser.
9. The ListSummary’s XML structure appears in the textbox.
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Login
The Login server control paints a login button on the template when displayed in a browser.
The Login server control displays the following buttons on a Web page. See Also: Getting
Started with Ektron on page 5
—When user is not logged in, this button appears. Clicking the button opens the
login window, where a user can enter a username and password. Upon authentication, the
user is logged in to the Ektron website.
—After a user logs in, this button replaces the login button to let the user log out.
—When logged in, this button appears under the logout button, allowing the user to
access the Workarea.
—Lets the user preview the entire website as if all checked-in content were
published.
—Turns off site preview mode.
—Launches online help for Ektron.

Placing a Login Button
You can add any number of login buttons to a template. You can insert a login button on each
template, or set up a special Web page, called login.aspx, from which users can log into the
Ektron site without the public being able to access the page.

Login Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

AutoAddType (Common.EkEnumeration.AutoAddUserType)
When using Single Signon, the Login Server Control can be used to add users to Ektron.
In this scenario, when a user signs on with Active Directory credentials, that user is
created within the Ektron database. Use this property to define the type of user that is
automatically added to Ektron. See Also: Single Sign On on page 1144

l

o

Author—Ektron user

o

Member— membership user

AutoLogin (Boolean)
If this property is set to true and Active Directory Integration is enabled, users are
automatically logged in using Active Directory authentication. They do not need to enter
a username or password. See Also: Single Sign On on page 1144
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l

o

True—Use Active Directory authentication when logging in.

o

False (default)—Do not use Active Directory authentication when logging in.

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for the Login server control. This property shows results in design-time
(in Visual Studio) and at run-time (in a browser).

l

OnlyAllowMemberLogin (Boolean)
Allows only membership users to log in. This property prevent users from logging as an
Ektron user and accessing the Workarea. If an Ektron user tries to log in using this
control, this message appears: “Only members are allowed to login here.” The default is
False.

l

o

True—Only membership users can log in

o

False—Ektron users and membership users can log in

PromptLogout (Boolean)
When set to False, the logout process omits the Logout window (shown below).

l

o

True—Users must click Logout to log out.

o

False—The Logout window does not appear

SuppressHelpButton (Boolean)
Hides the Help button that appears below the Login button when set to true.
o
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o

False (default)—Display Help button.

If you are editing this server control from a text file and want to suppress the Help
button, add the following code to the login tag source:
<CMS:Login ID="Login1" runat="server" SuppressHelpButton="True" />
l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Map
The Map server control displays a map that flags locations of interest. Each location is an
Ektron content item to which map information was added. For example, if your site hosts a
school district, each location could represent one school. See Also: Using the Map Server
Control on page 590

Map Properties
Within Visual Studio, you cannot see the map in design mode. However, you can right mouse
click the mouse and select View in Browser to see the effect of changing the properties.
You cannot place more than one map server control on a form.
Troubleshooting
l

If Map does not render on Web page, change the VirtualEarthMap web.config element
as follows:
<add key="VirtualEarthMap"
value="https://dev.virtualearth.net/mapcontrol/
mapcontrol.ashx?v=6.1&amp;s=1" />

l

l

If a user must click a warning away before users can see map on page, upgrade Google
Maps to a premier subscription. For more information, see Google Maps for Business.
Do not use a percentage value to set the native .NET properties Height and Width.
Percentages do not work with these properties.

The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Address (String)
To set a default map center, enter its address. The address appears in the Search field
when the map first displays. If you only enter a zip code, the map centers on its post
office. If you enter an address, the latitude and longitude properties are ignored.

l

Authenticated (Boolean)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

ContentId (Long)
Use this field in conjunction with the EnableSearchResult field to limit the map to a
single content item. Here, you identify the content item to be mapped. Content must
have latitude and longitude values to appear on a map.

l

CustomIcon (Boolean)
Use this field if you want the Category popup box to display an icon to the left of each
category, as shown below.

PREREQUISITE
To use this value, open the webroot/Workarea/images/application/maps/tree folder.
In that folder, create a new folder whose name is the same as the Taxonomy category
assigned to the Map server control at the MapCategory property. (In the sample site,
this Taxonomy’s name is MapCategory.) Then, place the icons in that folder by category
title name with a .png extension. Use an underscore (_) to separate taxonomy levels.
For example, the image for the category Restaurant > American must be named
Restaurant_American.png.
l

DateSearch (Boolean)
Set to True to assign a date to content. This feature is helpful for date-related content,
such as concerts, meetings, or sporting events. You can filter what appears on the map
by date. If you set this property to true, assign a date to date-related content using the
MapDate standard metadata field. Then, publish the content. When you click a map’s
Display on Map button, the popup screen includes date criteria, as shown below. You
can select map items by a single date or a range of dates.
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l

DisplayTextResult (Boolean)
If you want to display a box of information about each map item to the right of a map,
enter True. To suppress the text box, enter False.

l

DistanceUnit (Unit)
Enter the map's units of distance. Choices are miles and kilometers. The default value is
miles.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

EnableSearchResult (Boolean)
Use to determine if the Map server control accesses the Ektron search to return results.
True is the default value. You would change it to False if you want to display a map with
only one content item, that is, a single location. Specify this item at the ContentID
property. In this case, the map does not find other Ektron content whose longitude and
latitude are within the map’s boundaries. Site visitors viewing the map can still use the
Search and Directions tabs to get directions to the location. For example, your site
features homes for sale, and you want a map to show a featured home of the week. To
do so, set this property to False, and enter the content that describes that home in the
ContentID field.

l

FolderId (Long)
Enter the ID number of the folder whose content is searched on this map. If the
recursive property is true, folders below this folder are also searched.

l

ForceCategory (Boolean)
When set to true, this property causes the map to only show content associated with the
taxonomy category defined in the MapCategory property. When set to false, the map
shows all content within the map’s boundaries. For example, if 5 content blocks appear
on a map and 3 are assigned to a taxonomy, set this property to True and the
MapCategory property to the ID of the taxonomy. When a user views the map, it
displays the 3 content items associated with the taxonomy.

Ektron 8.7

1767

Working with Ektron Server Controls

l

GeoControl (Boolean)
If you want to see a search box with tabs above a map, enter True. To suppress the text
box, enter False. See Also: Server Control Reference on page 1636

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Latitude (Decimal)
To set a default map center via latitude and longitude (as opposed to an address), enter
the latitude here.

l

Longitude (Decimal)
To set a default map center via latitude and longitude (as opposed to an address), enter
the longitude here.

l

MapCategory (Long)
Enter the ID number of the taxonomy whose categories appear when up click this map’s
Display on Map button. When a map first appears, all eligible content appears. If you
click Display on Map, you can choose categories and limit the map to items assigned to
them. For example, you could view restaurants only. As another example, a map could
initially display all campuses in your state college system. Use the Display on Map
popup window to limit the map to community colleges.
While an OR relationship among categories is the most intuitive and common, you can
set up an AND or NOT logical relationship among selected categories.

l

MapProvider (Provider)
Select the service that provides the map, either Google or Bing Maps for Enterprise.

l

MapStyle (Style)
Enter the map’s display mode: Road, Satellite or Hybrid. This setting only affects Bing
Maps for Enterprise maps.
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l

MarkupLanguage (String)
Enter the template markup file that controls the map page display. For example,
mymapmarkup.ekml. If you enter no EkML file, the default one at
Workarea\Template\map\map.ekml is used. If the *.ekml file is located in the
\workarea\template\map folder, just enter its name. If the file is in another folder,
enter the path relative to site root. For example,
\workarea\customfiles\markup\mymapmarkup.ekml See Also: Controlling Output with
Ektron Markup Language on page 1905 and map.ekml on page 1909

l

MinZoomLevel (Integer)
If you want to set a map zoom level below which map locations will not appear, enter
that value. The default value is 4. Possible values are between 1 (most detailed) and 19.

l

PageSize (Integer)
Enter the number of locations that can appear on one page of the text box after a search
is executed. See Also: Server Control Reference on page 1636. If more than this number
of locations are available, use [First] [Previous] [Next] [Last] at the bottom of the
page to view additional locations.

l

Recursive (Boolean)
In the FolderID property, you specify a folder whose content is searched on this map.
To extend the search to all folders below this folder, set this property to true.

l

SelectedCategoryLogicalType (LogicalType)
Use this property to determine the logical relationship among several categories on the
Display on Map tab. (See Server Control Reference on page 1636). There are 3 choices:
OR, AND, and NOT.
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By default, an OR relationship exists among your selections. So, for example, if all 3
Restaurant categories are checked, then any restaurant that is defined as American,
Chinese or Pizza appears on the map. If you change this property’s value to AND, only
content to which all selected categories apply appear on the map. In the above example,
only restaurants defined as American and Chinese and Pizza appear on the map.
Alternatively, you can set the property’s value to NOT. In this case, only content to which
the selected categories are not applied appear on the map. To continue the above
example, if you select Chinese, only restaurants that are not assigned the Chinese
category appear on the map.
l

StartZoomLevel (Integer)
Enter the zoom level at which the map initially appears. See Also: Server Control
Reference on page 1636. Zoom level 1 is the least detailed, showing the entire world.
Zoom level 19 is the most detailed, showing the smallest streets. By default, maps in the
sample site have a zoom level of 12, which shows an area of about 10 miles (16
kilometers). A site visitor can adjust the level using the zoom control (circled below).

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TemplateParamName (String)
Sets a QueryString parameter for the ID of users that are returned in the search results.
This parameter is passed to the template page defined in the TemplateUserProfile
property when a user clicks the Location (map) icon associated with a user.

l

TemplateUserProfile (String)
The URL path of the user profile template. The path can be relative or absolute.
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l

TypeControl (Boolean)
If this map uses Bing Maps for Enterprise maps, this property enables or disables the
zoom/direction/type control (highlighted below). It lets you zoom the map in and out,
move the center in any direction, and change the display style (Road or Aerial).

If this map uses Google Earth maps, this property enables or disables the type control
(highlighted below). It lets you change the display style (Map, Satellite, or Hybrid). Use
the ZoomControl property to display or suppress Google Earth’s zoom and direction
controls.

l

WrapTag (String)
Lets a developer specify a server control’s tag.

l

o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

ZoomControl (Boolean)
Use this property to display or suppress the Google map zoom control (highlighted
below). For Bing Maps for Enterprise maps, the TypeControl property determines the
zoom control display.

Membership
The Membership server control has a tabbed form that lets a site visitor create or update a
profile. The control also can present new membership users with terms and conditions for
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using Discussion Boards when needed. Membership Users and Groups on page 1161
NOTE: You can view the Membership server control on the OnTrek starter site when you edit your profile.
You can specify the following information in the Membership server control tabs.
General Tab
Fields with a red asterisk (*) are required fields.

l

First name—Enter your first name.

l

Last Name—Enter your last name.

l

Password—Enter a password.

l

Confirm Password—Re-enter the password.

l

l

l
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E-Mail Address—Enter your email address. Notification email is sent to this address
unless the Disable E-mail Notification field is checked. Also, this address identifies
the user sending Instant email. See Also: Installing Ektron on page 9
Display Name—Enter the name you want to display to others, which can be a nickname
or title.
User Language—Select from available languages.
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l

Address—Enter the address (or just the zip code) of where you are located.

l

Latitude—This field is automatically determined by the address.

l

Longitude—This field is automatically determined by the address.

l

Avatar—Click Click to upload your Avatar and choose an image file that you want to
associate with your profile. By default, the maximum file size of an avatar is 200
kilobytes. Also, the avatar's height and width cannot exceed 125 pixels preserving the
aspect ratio.
Changing the Default File Size
To change the file size limit, edit Siteroot\Workarea\Upload.aspx.vb. In this file,
change the line below to the maximum file size you want to allow.
If (numFileSize > 200) Then

For example, to allow 500 kb files, change 200 to 500.
NOTE: Remember, this number is in kilobytes.
Changing the Default Height and Width
To change the default height and width, edit YourSite\App_
Code\VBCode\Utilities.vb. In this file, change the following lines to the size you wish
to allow.
Dim Width As Integer = 125
Dim Height As Integer = 125

For example, to set avatar's height and width to 166 pixels, change 125 to 166 in both
lines.
Forum Tab

l

l

l

Content and Forum Editor—Choose eWebEdit400, Provider, or eWebEditPro.
Choose Provider to use a third-party editor (if installed).
Topics per Page—Select a number of topics to display on a page. If the number of
topics exceeds the number you select, a scroll bar lets you see the additional topics. For
example, if you select 10, and there are 25 topics, only 10 are displayed at one time, but
you can scroll down to see all topics.
Forum Signature—Click Edit to enter or modify a signature that appears below each
post you make to a forum topic.

Tags Tab
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l

Tags—Keywords that you can assign to content and library items, which allows for tagbased searching. For example, you can add the tag EAC (Employee Activity Committee),
and tag users related to the EAC. In this way, you can search for the users to which the
EAC tag is applied. A tag cannot exceed 25 characters, and can include only alphabetical
or numeric characters, a hyphen, or an underscore.

Custom Tab
Fields with a red asterisk (*) are required fields.
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l

l

l

l
l

Moderate—Check this box to give this user privileges on a message board to approve
and delete posts. Regular users in a group message board can create and delete only
their own posts.
Features—Check this box to give the user an individual calendar. (There may be other
features to grant also.)
Private Profile—Choose one of these options:
l
Public—User information is accessible by others.
l

Private—User information is not accessible by others.

l

Colleagues—User information is accessible only by colleagues of the user.

Title—Enter the title of the user.
Department—Select the department to which this user belongs. The list contains any
departments that you have created.

l

Extension—Enter the user's telephone extension.

l

Phone—Enter the user's company telephone number.

l

Cell—Enter the user's cell phone number.
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l

l

l

Desk—Enter the value that identifies the location of the desk (or cubicle, or office), if
your office identifies such things. This can be valuable in locating an employee on an
office map.
Reports to—Enter the person to whom the user reports. This can be valuable for
developing organizational charts.
Time Zone—Select the time zone where the user works.

Activities Tab
By default, all activity is checked to display in the Activity Stream widget. By checking the
boxes, you can select criteria for the types of content you want to see when colleagues or
community groups create the content. You can also select (publish) the types of content that
you want colleagues to see under the My Activities category. See Also: Sending
Notifications to a Community on page 1194

l

l
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SMS—A checked box indicates that the type of content will be sent to your cell phone
Short Message Service (SMS).
Activity Stream—A checked box indicates the type of content that will appear in the
Activity Stream widget.
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l

Email—A checked box indicates that the type of content will be sent to your Email
address, which is specified in the General tab of your profile.

Category Tab
The Category tab lets you select from a list of taxonomy categories with which you want to be
associated. You determine which taxonomy appears on the tab by setting the TaxonomyID
property.
IMPORTANT: The Category tab appears only when an ID is assigned to the TaxonomyID property.

Membership Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

AllowAvatarUpload (String)
When set to Active, Click to upload your avatar appears on the General tab. This
allows site visitors to upload an avatar when registering for the site. When set to
Disable, the link is hidden. To force site visitors to choose from a gallery of avatars,
enter a path to the template containing them. The predefined gallery appears in a pop-up
window. To adjust this window's properties, edit the
siteroot\workarea\java\membershiptabs.js file.

l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

BoardID (Long)
The ID of the Discussion Board for which to show the Terms and Conditions. If you don’t
know the ID, click Ellipses, then sign in, browse to and select the Discussion Board.

l

DisplayMode (Mode)
Lets a developer decide what type of membership form is added to the Web form. The
following describes possible settings.
o

User Registration—Lets a site visitor register as a membership user. Also allows
membership users to update their information and preferences when logged in.

o

Reset Password—Lets a membership user reset a password.

o

Unsubscribe Secured—Lets membership user unsubscribe by entering a
username and password.
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l

o

Unsubscribe Unsecured—Lets membership user unsubscribe by entering a
username.

o

Account Activate—Let a site visitor activate a membership by entering the ID
number sent in the account verification email.

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter
To make this control dynamic, select id. When you do, this server control is attached to
the user passed as a URL parameter.

l

EnableCaptcha (Boolean)
Use to add Captcha interface for more security. It looks like this.

o

True—Show Captcha

o

False—Hide Captcha

If this property is set to true, Captcha appears while the control is in User
Registration, Account Activate, or Reset Password mode. See www.captcha.net
for more information about Captcha.
l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for the server control. This property shows results in design-time (in
Visual Studio) and at run-time (in a browser).

l

RedirectFailedURL (String)
The URL to which a membership user is sent if the registration fails.

l

o

If the page resides in the same folder as the registration page, enter the page
name. For example, RegFailed.aspx.

o

If the page resides in a subfolder, enter its path. For example,
members\RegFailed.aspx.

RedirectSucessURL (String)
The URL to which a membership user is sent when the registration succeeds.
o
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If the page resides in the same folder as the registration page, enter the page
name. For example, RegSucceed.aspx.
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o

l

If the page resides in a subfolder, add its path. For example,
members\RegSucceed.aspx.

RegisterButtonImg (String)
Lets you replace text on the register button with an image. Enter a path to the image.
For example:
http://www.example.com/buttons/registerbutton.gif
If the image is located in the site root, enter only the subfolder path and image name.
For example: /buttons/registerbutton.gif

l

RegisterButtonText (String)
Text that appears on the Register button. The default is Register. If you use a register
button image, you do not see this text.

l

ResetButtonImg (String)
Lets you replace text on the reset button with an image. Enter a path to the image. For
example:
http://www.example.com/buttons/resetbutton.gif
If the image is located in the site root, enter only the subfolder path and image name.
For example: /buttons/resetbutton.gif

l

ResetButtonText (String)
Text that appears on the reset button. The default is Reset. If you use a reset button
image, you do not see this text.

l

SaveButtonImg (String)
Lets you replace text on the Save button with an image. Enter a path to the image. For
example:
http://www.example.com/buttons/savebutton.gif
If the image is located in the site root, enter only the subfolder path and image name.
For example: /buttons/savebutton.gif

l

SaveButtonText (String)
Text that appears on the save button. The default is Save. If you use a save button
image, you do not see this text.

l

ShowExtended (String)
Decide if the Custom User Properties Tab is available when using this control. The
default setting is True.

l

o

True—Show Custom User Properties tab.

o

False—Hide Custom User Properties tab. For more information, see Creating
Custom User Properties on page 1108.

ShowTerms (Boolean)
Terms and Conditions are defined for the Discussion Forum specified in the Membership
server control's BoardID property. If you set the ShowTerms property to True, the Terms
and Conditions for the forum identified in the control's BoardID property appear near the
bottom of the Membership Server Control. A membership user must check the box to
complete a registration.
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If Terms and Conditions are defined for the specified Discussion Board and ShowTerms
property is set to False, you must accept the Terms and Conditions the first time you
create a post or a reply.
l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TaxonomyID (Long)
The ID of a taxonomy available to users. A user editing or creating a profile can select
which categories from this taxonomy to associate with their profiles.

l

UserExistsMessage (String)
The message that appears when a membership user already exists. The default message
is: Username(email) already exists!

l

UserSuccessMessage (String)
The message that appears when a membership user successfully registers. The default
message is: You have registered successfully. You can also use this property to set
the message that appears when users successfully unsubscribe or reset their password.
To do this, enter the success message in this property and set the DisplayMode property
to the proper usage.

l

UserUpdateSuccessMessage (String)
The message that appears when a membership user successfully updates their
information. The default message is: You have successfully updated your
information.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
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o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Menu
IMPORTANT: Starting from release 8.6, the Menu server control was replaced by the
FrameworkUI: <ektron:MenuView> templated server control. If you are already using the Menu server
control, you can continue to do so, but Ektron recommends using current versions of functionality.
The Menu server control calls a menu to be displayed on a page. Using the Menu server
control, you can manipulate a menu by using the DisplayXslt property. Below is a menu
display with the SampleMenu XSLT.

Before you can use the Menu server control, you must create a menu in the Workarea. See
Also: Using Menus on page 753
This section also contains the following topics.
Menu Properties
Using DisplayXslt Samples
SampleMenu
SampleMenu XSL code
TreeMenu
TreeMenu XSL Code
Retrieving the XML Structure of a Menu
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Menu Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.
Ektron 8.7
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l

DefaultMenuID (Long)
The ID of a menu that appears where you insert this server control if no other menu is
identified or available. If you don’t know the ID number of the menu, use the CMS
Explorer to browse to it.See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610

l

DisplayXslt (String)
The XSLT to use to render the menu.
o

None—databind only

o

SampleMenu—A sample display, formatted as a bulleted menu list

o

TreeMenu—A sample display, formatted as a folder tree. You can expand the tree
by clicking on the folder icon.

o

Path to Custom Xslt—If desired, enter a relative or absolute path to an Xslt that
determines the display of the page.

For more information on using the SampleMenu and TreeMenu DisplayXslt, see Using
DisplayXslt Samples on the facing page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Select menu_id. When you do, this server control uses the menu passed as a URL
parameter.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).
For more information, see Working with Menus in a Multi-Language System on page 770.

l

Stylesheet (String)
Specify the location and style sheet for the menu. For example:
\Workarea\csslib\mytest.css. Leave blank to use the default. global.css is the
default style sheet. It is located in \webroot\siteroot\Workarea\csslib.

l

SuppressAddEdit (Boolean)
o True—suppress the Add and Edit buttons when a user is logged in.
o

False—show the Add and Edit buttons when a user is logged in.

The default is False.
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l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Using DisplayXslt Samples
Two DisplayXslt samples are provided with the Menu server control, SampleMenu and
TreeMenu. This section explains how to use them.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store this file
in the Workarea folder, the file will be lost when you upgrade.

SampleMenu
The SampleMenu DisplayXslt lets you display an Ektron menu as a bulleted item list. See
below for an example.

When you are logged in to your Ektron site, 2 menu items are added to each section of the
menu: Add and Edit Menu. The user can use these to add a new menu item or edit an existing
one. See example below.
For information on a adding or editing a menu item, see Adding a Menu Item via Navigation
Link on a Web Page on page 761.
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SampleMenu XSL code
For an example of the XSL code used in the SampleMenu, click the following link and choose
the appropriate version.
Built-in CMS400 XSLs

TreeMenu
The TreeMenu DisplayXslt lets you display an Ektron menu as a clickable folder list. You can
expand and collapse the menu by clicking on the folder icons.

When you are logged in to your Ektron site, 2 menu items are added to each section of the
menu: Add and Edit Menu. The user can use these to add a new menu item, or edit an existing
menu item. See example below.
For information on a adding or editing a menu item, see Adding a Menu Item via Navigation
Link on a Web Page on page 761.
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NOTE: When using the TreeMenu server control with Visual Studio and Windows 2003, the folder images
do not display during design-time. They do, however, display correctly during run-time.

TreeMenu XSL Code
For an example of the XSL code used in the MenuTree, click the following link and choose the
appropriate version.
Built-in CMS400 XSLs

Retrieving the XML Structure of a Menu
Retrieving a menu's XML structure provides greater control over developing XSLs. The
following is an example of how to retrieve the XML structure:
1. Open a new Web form.
2. Drag and drop a Menu server control onto it.
3. Set the DefaultMenuID properties.
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4. Drag and drop a textbox on the Web form.
5. Set the TextMode property to MultiLine.
6. Set the width of the text box to at least 400px.
7. On the code-behind page, add the following line.
Textbox1.Text = Menu1.XmlDoc.InnerXml

8. Build the project.
9. View the Web form in a browser.
10. The XML structure of the menu appears in the textbox.

MessageBoard
The Message Board server control allows a user to submit comments on a Web page about a
l

user

l

community group

l

content item

Comments are presented in a “wall” type format, which means that the newest one appears
at the top, and older comments are pushed down as new ones arrive.

Other users can reply to comments. Replying to Message Board comments facilitates
community building by allowing members to share information and, thereby, feel they have a
personal stake in the discussion.
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Comments are posted to the Message Board immediately unless the board is moderated. See
Also: Moderating a Message Board on page 1175
On a PageBuilder page, you can insert a Message Board using the Message Board widget.

MessageBoard Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

CommentBoxLocation
Defines the location of the comment box. By default, bottom is selected. Choices are:

l

o

Bottom—comment box appears below the comments

o

Top—comment box appears above the comments

o

Data Type: EkEnumeration.MessageBoardCommentBoxLocation

DefaultObjectID (Long)
The default object ID for this control to use when there is no matching dynamic
parameter value passed.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicObjectParameter (String)
Gets or sets the QueryString parameter to read a object ID dynamically. To use the
default object ID, leave blank.

l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
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True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen.
l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905Controlling Output with Ektron Markup Language on page 1905

l

MaxResults (Integer)
Enter the maximum number of items to appear in the initial display of this server
control. To set no maximum, enter zero (0). To let site visitors view more than the
maximum but limit the amount of space, enter the maximum number of results per page
here. Then, set the EnablePaging property to True. If you do and more than the
number of MaxResults are available, navigation aids help the site visitor view
additional items.

l

Moderate (Boolean)
Set to True to force moderation of the Message Board. If set to false, moderation is
controlled by the user or community group with which the Message Board is associated.
See Also: Moderating a Message Board on page 1175

l

ObjectType (EkEnumeration.MessageBoardObjectType)
The type of object to which the Message Board is assigned. Choices are:

l

o

Content—a content item

o

User—an individual

o

CommunityGroup—a community group

ProfileParamName (String)
The parameter name to pass in the QueryString to the TemplateUserProfile page, if you
want it to be anything other than id. For example, you may prefer userid, because it is
more descriptive, as shown in the following example.
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l

ShowMaxCharacter (Integer)
The maximum number of characters to display in the comment. If the number of
characters in a comment exceeds this, a ... more >> link appears. Users click the link
to see the full text.

l

SpamControlType (EkEnumeration.MessageBoardSpamControlType)
Assigns a spam filter to the Message Board. Ektron provides 3 spam filters, and the
ability to define your own. Spam control is turned off by default. Filter choices are:

l

o

SameUserMessageDay—a user cannot post the same comment to a board more
than once per day

o

SameUserTimeDelay—prevents user from posting another comment for period of
time, specified in the SpamTimeSpan property.

o

SameMessageTimeDelay—prevents user from posting an identical comment for
a period of time, specified in the SpamTimeSpan property.

o

Custom—Message Board uses your custom spam filter code. See Filtering Spam on
page 1180.

SpamTimeSpan (Integer)
The number of seconds for which the SameUserTimeDelay or SameMessageTimeDelay
spam filters delay a user from posting a second time. See Also: Filtering Spam on
page 1180

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TemplateUserProfile (String)
The URL path to a page that contains a UserProfile server control. The path can be
relative or absolute. If you enter a path, a user can click any user’s name or avatar from
the Message Board server control and be forwarded to that profile page. See illustration
below.
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Note that user templates can be defined in the Workarea > Settings > Community
Management > Templates screen. However, if you assign a template in this field, this
setting takes precedence over the setting on the Workarea Template screen.
l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Messaging
The Messaging server control lets a site user send and receive messages. You can limit
message recipients to a user’s colleagues or expand it to all Ektron users. The Messages
control can appear on a site or also in the Workarea. Typical messaging functions apply, such
as compose (
print (

in the Workarea), reply (

in the Workarea), delete (

in the Workarea), forward (

in a sample site,

in the Workarea),

in the Workarea).

Populating the To: Field of a Message
You can populate a message's To: field with user names by setting the RecipientParamName
property to a QueryString parameter. This feature lets you create a link on a page, such as
Send a Message to this user or Send a message to all users in this group. For
example, you create a Web page link to a template containing the Messaging server control,
pass a user’s ID in the QueryString as UID, and populate the RecipientParamName property
with UID. As a result, the server control reads the user’s ID and completes the To: field with
the user’s name.
Here is how the link might look: messaging.aspx?g=pmessage&uid=1
You can pass multiple user IDs. For example:
messaging.aspx?g=pmessage&uid=1&uid=20&uid=12&uid=18
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IMPORTANT: You must include the g=pmessage parameter in the QueryString to open the Messaging
server control to its editor. Otherwise, the server control opens to the Inbox.
The VB example below creates a dynamic hyperlink that populates a message's To: field with
a logged in user’s colleagues. For this example to work, add a Literal control to a Web form
and name it Lit1. Notes are included as comment text.
Protected Sub Page_Load(ByVal sender As Object,
ByVal e As System.EventArgs) Handles Me.Load
Dim frnds As New Ektron.Cms.API.Community.Friends()
Dim apicontent As New Ektron.Cms.ContentAPI
Dim dirUsrData() As Ektron.Cms.DirectoryUserData
If (apicontent.UserId > 0) Then
dirUsrData = frnds.GetFriends(apicontent.UserId)
If ((Not IsNothing(dirUsrData)) AndAlso (dirUsrData.Length > 0))
Then
Dim idx As Integer
Dim friendsList As String = String.Empty
For idx = 0 To dirUsrData.Length - 1
'friendsList += "&uid=" + dirUsrData(idx).Id.ToString()
friendsList = friendsList + "&uid="
+ dirUsrData(idx).Id.ToString()
Next
Lit1.Text = "<a href=""MsgSample.aspx?g=pmessage" + friendsList
+ """>Send a message to my friends</a>"
'
'Replace MsgSample.aspx with the Web form that contains
'the messaging server control.
'Set the RecipientParamName property to "uid" for this example.
'
Else
Lit1.Text = "The logged in user currently has no friends"
End If
Else
Lit1.Text = "You must be logged in to run this demo"
End If
apicontent = Nothing
frnds = Nothing
End Sub

Messaging Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
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WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

EnablePreSearch (Boolean)
When set to True, all users are pre-loaded and displayed in the search results when
browsing for users (an empty string search). If the FriendsOnly property is set to True,
only colleagues are pre-loaded and displayed.

l

FriendsOnly (Boolean)
When set to True, users can only send messages to their colleagues.

l

o

True (default)—send messages to colleagues only

o

False—send messages to all Ektron users

GroupParamName (String)
Enter the QueryString parameter used to pass the ID of a community group. The default
is gid. Use this property to email all members of a group.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

ProfileParamName (String)
The QueryString parameter used to pass the ID of a user to a profile page or location
template when a user name is clicked in the Browse User screen. The default is ID. The
parameter defined in this property is appended to the QueryString of the path defined in
the ProfileUrl property. The default is ID.
IMPORTANT: This parameter must match the parameter set in the UserProfile server control’s
DynamicParameter property on the page defined in the ProfileUrl property.

l

ProfileUrl (String)
The URL of the profile page template. This page opens in a new window when a user
clicks a display name on the Browse Users screen. This provides additional profile
information about the potential message recipient.

l

RecipientParamName (String)
Enter the QueryString parameter used to pass a user ID. For example, if the QueryString
is ?uid=1, enter uid in this property. To pass several users, enter a comma -separated
list of user IDs. For example: ?uid=1,20,12,18. This property is typically used when
you want to populate a message's To: field. See Also: Populating the To: Field of a
Message on page 1790
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l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

UserSearchDisplayXslt (String)
The XSLT used to display the user search control inside the Messaging server control.
The default is MsgUserSelect.xsl.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Metadata
The Metadata server control lets you add the metadata from content blocks to a Web page.
This lets developers add metadata quickly without having to type it in. You can add metadata
from a single content block, multiple content blocks, or dynamically pass a content ID from a
URL.
In contrast, the MetaDataList server control lets you create a list of content blocks to display
on your site, based on metadata assigned to the content. See Also: MetadataList on
page 1796.
The Metadata properties are described below.

Metadata Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
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The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.
l

DefaultContentID (Long)
Enter the ID of the content block whose metadata is added to the page. If you don’t know
the ID number of the content block, use the CMS Explorer to browse to it.See Also:
Browsing Your Ektron Site Using CMS Explorer on page 1610. If you want to add
metadata from several content blocks, set this property to 0 (zero) and use the
DefaultItemList property to identify them.

l

DefaultItemList (String)
A bracket-separated list of content block IDs whose metadata added to the page. This
list is used only if the DefaultContentID property is set to 0 (zero). For example:

In the ID list, you can specify metadata definitions to exclude for each content block. To
exclude a metadata definition, insert a semicolon after the ID and enter the metadata
definition. For example,

In the above example, the control will:
o

add all metadata definitions for content block 30

o

exclude the Title metadata definition for content block 10

o

exclude the Title and Description metadata definitions for content block 23

Note the following criteria for metadata definitions that may be excluded:

l

o

the definition is case-sensitive, so must exactly match how the Name field of the
Metadata Definitions screen.

o

The metadata definition type must be Meta Tag

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a content ID dynamically.
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l

GenerateDublinCore (Boolean)
When enabled, this property automatically creates 7 of the Simple Dublin Core metadata
fields from standard Ektron system properties. The default is false.
o

True—Generate Simple Dublin Core metadata fields

o

False—Do not generate Simple Dublin Core metadata fields

The 7 fields and how they are associated with the Ektron properties is explained in
Applying Simple Dublin Core Metadata on page 380
l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

These steps show how to use the MetaData server control.
1. Drag a MetaData server control onto a template.
2. Set the properties of the Metadata server control. This will create the following HTML in
the HTML body.
<cms:MetaData id="MetaData1" runat="server"
DefaultContentID="12"></cms:MetaData>
Or, if you are using multiple content block IDs in the DefaultItemList, the following
HTML is created.
<cms:metadata id="MetaData1" runat="server" DefaultItemList="[12,7,4]">
</cms:metadata>
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3. Click the HTML tab and copy that line from the <body> tag to the <head> tag.

4. Save the Web form and rebuild the solution.
5. Open the Web page in the browser.
6. Right click the Web page and click View Source.
7. In the <head> tag, you see meta tags from the content block added to the page, as
shown in the following image.

MetadataList
IMPORTANT: Starting from release 8.6, the MetadataList server control was replaced by the
MetadataFilters of the FrameworkUI: <ektron:ContentView> templated server control. If you are already
using the MetadataList server control, you can continue to do so, but Ektron recommends using current
versions of functionality.
Use the MetadataList server control to create lists based on Keyword Names and Keyword
Values contained within content metadata. The list can display the information as a list of
hyperlinks. You can choose, based on properties you set, to display the summary and how to
order the display. See Also: Working with Metadata on page 369
NOTE: On a PageBuilder page, you can insert a metadata list using the MetaDataList widget. See Also:
Widget Reference on page 714
The MetadataList properties are described below.

MetadataList Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.
IMPORTANT: If the EnablePaging property is set to True, the CacheInterval property is
disabled.

l

ContentType (Ektron.Cms.Controls.CmsWebService.CMSContentType)
Select a type of content for this control. Choices are:

l

o

All Types

o

Content

o

Forms

o

Archive_Content

o

Archive_Forms

o

Assets

o

Archive_Assets

o

LibraryItem

o

Multimedia

o

Archive_Media

o

NonLibraryContent

o

DiscussionTopic

DisplayXslt (String)
Determines how the information on the page appears
o

None—databind only

o

ecmNavigation—lists the title of every content block in the folder. See Also:
ecmNavigation Display Example on page 1682

o

ecmTeaser—lists the title of every content block in the folder plus the content
summary. See Also: ecmTeaser Display Example on page 1682

o

Path to Custom Xslt—If desired, enter a relative or absolute path to an Xslt that
determines the display of the page.

WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property value is
ignored.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
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event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.
l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen. See example below.

So, for example, if specified metadata is found in 9 items and the MaxResults property
is set to 3, the screen displays only the first 3 items. When the site visitor clicks [Next],
the visitor sees items 4, 5 and 6, and so on.
NOTE: If the EnablePaging property is set to True, the CacheInterval property is disabled.
l

ExactPhrase (Boolean)
Determines whether the KeyWordValue needs to match the metadata value exactly. For
example, if “site” is the KeyWordValue, the title of a content block is “Welcome to the
site” and ExactPhrase is set to True, you would not see the content block in the
metadata list. This is because “site” does not equal “Welcome to the site”.

l

o

True—Match the exact phrase

o

False—Doesn’t need to match exact phrase

FolderID
The folder ID from which content is retrieved. At the Recursive property, you determine
if content in this folder’s subfolders are also retrieved.

l

GetAnalyticsData (Boolean)
Set this property to True if you want the following information for each content in the
list. Returns Content View Count, Content Rating, Content Rating Average.
Create your own XSLT styles to display this data. This property only provides reliable
data when the Business Analytics Feature is on. Analyzing Content on page 601.

l

GetHtml (Boolean)
Set to True if you want to display the content (html body) for all content to appear on
this metadata list. For example, you want to display content inside a Web server control
such as a GridView.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeIcons (Boolean)
Choose whether to display icons next to the metadata list’s links.
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NOTE: This property only works when ecmSummary or ecmTeaser are used in the DisplayXslt
property. When the [$ImageIcon] variable is used in an EkML file and that file is assigned to the
MarkupLanguage property, this property acts as True.

l

KeyWordName (String)
KeyWordName represents a metadata definition, that is, the container for the
KeyWordValues. Examples of a KeyWordName are Keywords and Title. If you are
authenticated, you can click the ellipsis button and select from a list of existing metadata
definitions. For information on creating metadata definitions, see Adding a Metadata
Definition on page 370.

l

KeyWordValue (String)
Enter the values associated with the KeyWordName. Only content whose metadata
(defined at the KeyWordName property) matches this value appears on the metadata list.
Examples of a KeyWordValue are “home; page; company.” To view an illustration of the
relationship between KeyWordName and KeyWordValues, see MetadataList on
page 1796.
NOTE: The character that separates multiple items is defined at the KeyWordValueSeparator
property. At the KeyWordValueMatchAll property, you determine if all metadata definition values
must match or any one of them.

l

KeyWordValue MatchAll (Boolean)
This property is only used if you enter more than one keyword value. If you do, and only
want content to appear on the metadata list if all values entered at the KeyWordValue
field match its metadata values, enter True. If metadata can appear on the list as long
as any value defined at the KeyWordValue field matches the selected metadata value for
a content item, enter False.
Example:
KeyWordValue for Title (assigned for this server control): home; page; company.
Metadata values for a content item’s Title metadata definition field: software; ektron;
company.
o

If KeyWordValueMatchAll =true, content does not appear on metadata list
because some items do not match.

o

If KeyWordValueMatchAll = false, content item appears on metadata list
because one item (company) matches.
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l

KeyWordValueSeparator (String)
Enter the character used to separate the list of keyword values. An example is a
semicolon(;).

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905
See Also: metadatalist.ekml on page 1912
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Displayxslt property
value is ignored. If the EkML file contains the [$ImageIcon] variable, the IncludeIcons
property acts as True.

l

MaxNumber (Integer)
Enter the maximum number of items to appear in the initial display of this server
control. To set no maximum, enter zero (0). To let site visitors view more than the
maximum but limit the amount of space being occupied, enter the maximum number of
results per page here. Then, set the EnablePaging property to true.
If you do and more than the number of MaxResults are available, navigation aids appear
below the last item to help the site visitor view additional items. See example below.

l

OrderBy (Ektron.Cms.Controls.CmsWebService.ContentOrderBy)
The order of the list to be returned.

1800

o

Title—The title of the content block

o

ID—The content block ID number

o

Date Created—The date the content block was created

o

Date Modified—The date the content block was last modified

o

LastEditorLname—The last editor’s last name
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l

o

LastEditorFname—The last editor’s first name

o

ContentRatingAverage—Business Analytics Content Rating

o

ContentViewCount—Business Analytics Content Views

Recursive (Boolean)
Whether to search sub-folders of the identified root folder. The starting folder is
identified in the FolderID property.

l

SortOrder (String)
Choose the order direction of the list, Ascending or Descending.

l

SuppressWrapperTags (Boolean)
This property is set to false because Ajax uses <div> tags to rewrite the region around
the tag. You cannot change the value to true.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Retrieving the XML Structure of a MetadataList
Retrieving the XML structure of XML content allows for greater control over developing XSLs.
The following is an example of how to retrieve the XML structure:
1. Open a new Web form.
2. Drag and drop a MetadataList server control onto it.
3. Set the KeyWordName and KeyWordValue properties.
4. Drag and drop a textbox on the Web form.
5. Set the TextMode property to MultiLine.
NOTE: You should set the width of the text box to at least 400px.
6. On the code-behind page, add the following line.
Textbox1.Text = Metadata1.XmlDoc.InnerXml

7. Build the project.
8. View the Web form in a browser.
9. The XML structure of the MetadataList appears in the textbox.

Micro-messaging
The Micro-messaging server control lets users post brief messages. It resembles microblogging services like Twitter. See Also: Using the Micro-messaging Server Control on
page 1256.

Micro-messaging Properties
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The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultObjectID (Long)
The default object ID for this control to use when there is no matching dynamic
parameter value passed.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicObjectParameter (String)
Gets or sets the QueryString parameter to read a object ID dynamically. To use the
default object ID, leave blank. For example, if you are passing the ID value of a user,
you might enter ‘uid’ for this property. So, if you passed
http://~yoursite~/UPpage.aspx?uid=21 on the QueryStrings to a page containing this
control, you would see the list of Micro-messages for the user with an ID of 21.

l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).
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l

MaxResults (Integer)
Enter the maximum number of items to appear in the initial display of this server
control. To set no maximum, enter zero (0). To let site visitors view more than the
maximum but limit the amount of space, enter the maximum number of results per page
here. Then, set the EnablePaging property to True. If you do and more than the
number of MaxResults are available, navigation aids help the site visitor view
additional items.

l

MaxSearchResults (Integer)
The maximum number of messages to return when performing a micro-message search.
0 (zero) = unlimited.

l

Mode (ActivityFeedType)
Specify the type of micro-messages you want to display. Choices are:
o

User—micro-messages for logged-in user with search option

o

Colleagues—micro-messages for logged-in user and colleagues of a specified user
with search option

o

TimeLine—micro-messages from all site users whose Private Profile setting is set
to Public; includes search option

o

Message—a single message

See Also: Server Control Reference on page 1636
l

ProfileParamName (String)
The parameter name to pass in the QueryString to the TemplateUserProfile page, if you
want it to be anything other than id. For example, you may prefer messageid, because it
is more descriptive.

l

SpamControlType
Assigns a spam filter to the micro-messages. The control supplies 3 predefined spam
filters, and the ability to define your own. Spam control is turned off by default. Filter
choices are:
o

SameUserMessageDay—prevents a user from posting the same message to the
board more than once per day

o

SameUserTimeDelay—prevents a user from posting another message for
specified period of time. The amount of time is specified, in seconds, in the
SpamTimeSpan property.

o

SameMessageTimeDelay—prevents a user from posting an identical message
for a specified period of time. The amount of time is specified, in seconds, in the
SpamTimeSpan property.

o

Custom—control uses custom spam filter code. See Server Control Reference on
page 1636.

See Also: Server Control Reference on page 1636
l

SpamTimeSpan (Integer)
Sets the amount of time, in seconds, for which the SameUserTimeDelay or
SameMessageTimeDelay spam filter delays a user from posting. These values can be
selected in the SpamControlType property.See Also: Server Control Reference on
page 1636
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l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TemplateMessage (String)
The URL path to a page that contains another Micro-messaging server control. When this
property contains such a path, and the destination page has a Micro-messaging control
whose Mode property is set to Message, a user can click a micro-message’s time span on
the first page to open a second page that contains just that message.See Also: Server
Control Reference on page 1636

l

TemplateUserProfile (String)
The URL path to the page that contains the UserProfile server control. The path can be
relative or absolute. If you enter a path, a user can click any user’s name or avatar from
the Micro-message server control and be forwarded to that profile page.

Note that user templates can be defined in the Workarea > Settings > Community
Management > Templates screen. However, if you assign a template in this field, this
setting takes precedence over the setting on the Workarea Template screen.
l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

MyAccount
The MyAccount server control lets logged-in customers (site visitors) view and edit their
Personal Information, Billing Address and Shipping Address. See Also: Using the MyAccount
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Server Control on page 1420.

MyAccount Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

CustomerPropertyID (String)
An ID or comma separated list of IDs for a Custom User Property (or properties) to
expose in the UI. These properties are used to define information about a user beyond
the standard Ektron user properties; such as Username, First Name, Password and
email Address. See Also: Editing Personal Information on page 1422.
IDs for these properties can be found in the Workarea > Settings > Configuration >
Custom Properties screen. See Also: Creating Custom User Properties on page 1108.

l

CustomXml (Code-behind Only) (String)
Lets you inject custom XML into the generated XML before being processed by the XSLT.
Enter a string of XML that you want to make available to the XSLT as follows:
<root><customXml>custom-xml-inserted-here</customXml></root>

See Also: Displaying Custom XML in Ektron’s Server Controls on page 1632.
l

DefaultCountryID (Integer)
The ID of the default country that appears in the Billing Address and Shipping Address.
Set this ID to the country from which the majority of your customers will be making
purchases. If the customer is from a different country, the customer can it change when
editing the Billing or Shipping Address.
NOTE: If a customer enters information in the Billing Address area, the Billing Country seeds the
Shipping Country when adding a new Shipping Address.
To find a country’s numeric ID, sign into the Workarea. Then go to Settings >
Commerce > Configuration > Countries. The Numeric ID is in the left column of
that screen.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page. By default, the control uses MyAccount.xsl. This file is located in
siteroot\Workarea\Xslt\Commerce
IMPORTANT: If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
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l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LoadingImage (String)
The image to display while the control is fetching data. The default is
siteroot\Workarea\images\application\ajax-loader_circle_lg.gif.

l

RedirectUrl (String)
Enter the path of a template that contains the Login server control. When a customer
arrives at this control and is not logged in, the control checks this property for a path to
template containing a Login server control. If one exists, the customer is sent to that
template. When the customer logs in, the template containing the MyAccount server
control appears. If no path exists, the control checks the web.config file’s
<addkey=”ek_RedirectToLoginURL”value=””/> value for a path.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

OrderList
The OrderList server control lets customers view a list of processed orders. Customers
typically reach this server control by clicking a link on your site, such as the View Order
History link.
For information about how to use the OrderList server control, see Using the OrderList Server
Control on page 1423.

OrderList Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

CustomXml (Code-behind Only) (String)
Lets you inject custom XML into the generated XML before being processed by the XSLT.
Enter a string of XML that you want to make available to the XSLT as follows:
<root><customXml>custom-xml-inserted-here</customXml></root>

See Also: Displaying Custom XML in Ektron’s Server Controls on page 1632.
l

DefaultUserId (Long)
The default ID of the user for which to display a list of orders.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page. By default, the control uses OrderList.xsl. This file is located in
siteroot\Workarea\Xslt\Commerce
IMPORTANT: If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DynamicProductParameter (String)
The QueryString parameter name which is used to pass the product ID to the product
details page. For example, if your QueryString parameter for products is ID, enter that
in this property. Then, when customers click a product in their order list, this parameter
is passed with the product’s ID to the product details page.

l

DynamicOrderParameter (String)
Sets the QueryString parameter name which is used to pass an order ID dynamically. By
default, this parameter is OID.

l

GuestOrderView (Boolean)
Set to true to allow guest account visitors to view their orders. If you do, a visitor can
go to the View Orders screen, enter an order number and an email address, then view all
submitted orders. See Also: Server Control Reference on page 1636

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.
o

True—Hide the control output.

o

False—Display the control output.
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l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MaxResults (Integer)
Specify the number of orders to show per page when a customer views their order
history. If the number of orders exceeds the quantity defined in this property, the list is
paged and the customer uses the paging navigation to move through the list.

l

PageSize (Integer)
The maximum number of orders to show per page.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TemplateProduct (String)
The URL path of the template that allows a customer to view the details of a product in
an order. When a path is entered, the product’s title becomes a link that lets customers
navigate to the template containing details of the product; for example, the template
containing a Product server control.

PhotoGallery
The PhotoGallery server control helps users and community groups track and manage
images. See Also: Using the PhotoGallery Server Control on page 1267.

PhotoGallery Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.
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l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultObjectID (Long)
The default object ID for this control to use when there is no matching dynamic
parameter value passed.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicContentBoxHeight (Integer)
The height of the dynamic content box in pixels.

l

DynamicContentBoxWidth (Integer)
The Width of the dynamic content box in pixels.

l

DynamicContentTemplate (String)
The template to use when displaying dynamic content. Leave blank to use the dynamic
box.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a object ID dynamically. To use the
default object ID, leave blank.

l

EnablePaging (Boolean)
This property, in conjunction with the MaxNumber property, lets site visitors view an
unlimited number of items while controlling the amount of screen space. The
MaxNumber property limits the number of items displayed. If you set this property to
True, and the number of items exceeds MaxNumber, navigation aids appear below the
last item, allowing the visitor to go to the next screen.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeIcon (Boolean)
Choose whether to display icons next to the navigation list’s links.

Ektron 8.7

1809

Working with Ektron Server Controls

l

o

True—Show icons

o

False—Hide icons

ItemSortOrder
Specify the sort order of results. Choices are:
o

taxonomy_item_display_order—the order of taxonomy items as set in the
Workarea. For additional information, see Reordering Content Assigned to a
Taxonomy Category on page 806.

o

content_title—alphabetical order by title

o

date_created—chronological order by date created

o

last_edit_date—chronological order by date edited

To specify the direction of the items, use the SortDirection property.
l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LinkTarget (String)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905

l

MaxResults (Integer)
Enter the maximum number of items to appear in the initial display of this server
control. To set no maximum, enter zero (0). To let site visitors view more than the
maximum but limit the amount of space, enter the maximum number of results per page
here. Then, set the EnablePaging property to True. If you do and more than the
number of MaxResults are available, navigation aids help the site visitor view
additional items.

l

ObjectType (String)
The type of object to which this control is assigned. Choices are:
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l

o

User

o

Group

ShowCount (Boolean)
Indicates if an integer representing the number of taxonomy items in the category
appears next to each category when displayed on the website. The default is False.

l

o

True—Show taxonomy items number

o

False—Do not show taxonomy items number

SortDirection (String)
Select the direction of the itemSortOrder property. Choose Ascending or Descending.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

TaxonomyCols (Integer)
Enter the number of columns in which this taxonomy/category appear on the page.

l

TaxonomyItemCols (Integer)
Enter the number of columns in which the taxonomy items appear on the page.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Poll
The Poll server control displays a poll or survey created from an Ektron form on a Web page.
When added to a template and visited, the poll might look like this. You can change a poll's
appearance by modifying its properties.
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You should display a poll or survey with a Poll server control, because it provides great
flexibility with the poll's appearance. Typically, developers want a poll or survey in a small
section of a Web page, not the main content. By using the EnableAjax property, you can
display the results in the same area as the poll or survey without refreshing the entire page.
However, if you want the form/poll/survey’s response to be either Redirect to a file or
page or Redirect form data to an action page, you must use a Form Block server control
to display the form on a Web page. See Also: FormBlock Server Control on page 1738

Poll Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

{Poll ID} (Long)
The ID of the poll that appears where you inserted this server control. If you don’t know
the ID number of the pol, use the CMS Explorer to browse to it.See Also: Browsing Your
Ektron Site Using CMS Explorer on page 1610

l

AddValidation (Boolean)
The AddValidation property is obsolete and ignored. It has no effect. It is always true.

l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
To make this form block dynamic, select ekfrm. When you do, this server control uses
the form block passed as a URL parameter.

l

EnableAjax (Boolean)
Can display the poll or results using an iFrame in the area of the page that contains the
poll. As a result, the surrounding contents are not disturbed. The default is true.

l

o

True—Polls and results are shown in an iFrame without modifying or refreshing the
surrounding contents.

o

False—Poll and the results replace the Web page’s content.

Fields (FormFieldCollection)
Displays a list of fields that are defined in the form. These fields are read only. This is an
excellent way of displaying the field names used on the form. With this list of names,
you can create events using the fields without having to enter the Workarea to see the
names.
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l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeTags (Boolean)
Determines if tags are generated automatically or manually.
l

l

Let Ektron generate form tags automatically if you are developing a pure .aspx
page script. To enable this option, set IncludeTags property to True.
Modify HTML form tags in the .aspx file if you are developing an .aspx page and
associated code-behind Web form. To enable this option, set IncludeTags property
to False. Here is the default .NET generated form tag:
<form id="Form1" method="post" runat="server">

Modify the form tag as indicated in red:
<form id="Form1" method="post" runat="server"
OnSubmit=”return EkFmValidate(this);”>
l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

PostHistory
The PostHistory server control displays a list of forum posts for a given user. The posts are
displayed in order, by date, and contain the following:
l

Topic—the topic that contains the post

l

Posted—the date the post was created

l

Content—the post's content
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PostHistory Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (Boolean)
Indicates if you are logged in to the CMS Explorer and can use it to browse to Content,
collections, and so on.

l

BoardID (Long)
The ID of the discussion board from which to get a user's posts. If you don’t know the ID,
click Ellipses (

l

), then sign in, browse to and select the discussion board.

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MaxNumber (Integer)
The maximum number of posts listed. The default is 10.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
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True—Suppress wrap tags.

o

False (default)—Allow wrap tags.
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l

URLPath (String)
The URL path to the page that hosts the Forum server control.

l

UserID (Long)
The ID of the user for whom to get the post history.

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Product
The Product server control lets customers view the details of a product and add it to their
cart. To display a product on a Web page, drag and drop a Product server control on a
template and enter a product ID in the DefaultProductID property. You could also
dynamically pass a product’s ID to the control by setting DynamicProductParameter property
to the QueryString parameter used for product IDs.
See Also: Using the Product Server Control on page 1426

Product Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

CustomXml (Code-behind Only) (String)
Lets you inject custom XML into the generated XML before being processed by the XSLT.
Enter a string of XML that you want to make available to the XSLT as follows:
<root><customXml>custom-xml-inserted-here</customXml></root>

See Also: Displaying Custom XML in Ektron’s Server Controls on page 1632.
l

DefaultProductID (Integer)
Enter a default product’s ID. This is the default product that’s displayed when the
template containing this control is viewed by a customer and a product ID is not
dynamically passed. To make this server control dynamic, enter zero (0) for this
property and set the DynamicProductParameter to the QueryString parameter used to
pass the product ID.
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l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page. By default, the control uses product.xsl. This file is located in
siteroot\Workarea\Xslt\Commerce.See Also: Using the eCommerce Server Controls
on page 1404.
IMPORTANT: If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
The QueryString parameter name, which is used to read the product ID. For example, if
your QueryString parameter for products is ID, enter that. Then, when customers view a
product’s details, the product’s ID is passed to this control.

l

EkItems (String)
This property gets EntryData for a product and can be called only during the
PreProcessXml or PostProcessXml event. If used outside of these events, it returns
empty values for the entry data.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

ImageGallery (ImageGalleryType)
Determine if the image gallery appears along with a product’s information. Images that
appear in the gallery are set in the product’s Media tab when creating or editing a
product. The Gallery Display property for each image on the Media tab must be set to
Yes. Choices:
o

List—display gallery images

o

None—hide gallery images

In the Image Gallery, images are displayed at their smallest size. If a customer clicks an
image, a full size version appears.
l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

OverrideXslt (Integer)
Specifies an XSLT identified in the Edit Product Type Configuration screen.

l

ShowAddToCart (Boolean)
Set to true if you want to the Add to Cart button to appear. The default is True. Setting
this property to false lets you show details of a product, but not offer it for sale. For
example, a product is no longer for sale, but you want to allow people who purchased it
to view details. Also, by using code-behind to dynamically set the property, you could
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create code that checks your inventory system and hides the button if a product is out of
stock. You could also accomplish this for a product by removing the check from the
Buyable property when creating or editing a product in the Workarea.
l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

TemplateCart (String)
Enter the URL path of the template that contains the Cart server control. The path can be
relative or absolute.See Also: Using the eCommerce Server Controls on page 1404 and
Using the Add to Cart Button with Aliasing on page 1428

The OverrideXslt and DisplayXslt Properties
The DisplayXslt property is optional. If used, it specifies an external XSLT file. If the
DisplayXslt property is not defined, the OverrideXslt property specifies an XSLT identified
in the Edit Product Type screen. The following list provides more information about these
properties.
l

The default XSLT is specified in the Edit Smart Form Configuration screen. To use this
display XSLT, enter 0 for OverrideXslt.
NOTE: In this example, the XSLT Packaged option is the default XSLT, since it is selected. XSLT
Packaged is the XSLT from the Edit Smart Form Configuration screen (that is, the XSLT created in
the Data Designer).
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l

l

l

l

XSLT 1 from the Edit Smart Form Configuration screen; to use this display XSLT, enter 1
for OverrideXslt.
XSLT 2 from the Edit Smart Form Configuration screen; to use this display XSLT, enter 2
for OverrideXslt.
XSLT 3 from the Edit Smart Form Configuration screen; to use this display XSLT, enter 3
for OverrideXslt.
An absolute or relative path to an XSLT file. For DisplayXslt, enter an external XSLT file
not specified in the Edit Product Type Configuration screen. For example: sample.xslt.
No value is required for OverrideXslt. If an XSLT value exists, OverrideXSLT is ignored.

ProductList
The ProductList server control displays a list of products on a Web page.
NOTE: Private catalog entries appear in the display of the Product List server control only if the user is
logged in and has at least Read-Only permissions for its catalog folder. See Also: Making Content Private
on page 294
See Also: Using the ProductList Server Control on page 1430.

ProductList Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
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l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

CustomXml (Code-behind Only) (String)
Lets you inject custom XML into the generated XML before being processed by the XSLT.
Enter a string of XML that you want to make available to the XSLT as follows:
<root><customXml>custom-xml-inserted-here</customXml></root>

See Also: Displaying Custom XML in Ektron’s Server Controls on page 1632.
l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page. By default, the control uses ProductList.xsl. This file is located in
siteroot\Workarea\Xslt\Commerce
IMPORTANT: If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Sets the QueryString parameter to read a source’s ID dynamically. For example, if your
QueryString parameter for a source ID is SID, enter that.

l

EkItems (String)
This property gets EntryData for a product and can be called only during the
PreProcessXml or PostProcessXml event. If used outside of these events, it returns
empty values for the entry data.

l

GetAnalyticsData (Boolean)
Set to true if you want the average rating for this product to appear with the product
display, as shown below.
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Below the rating, a number indicates how many customers have rated the product. For
more information on letting customers rate your products, see User-Ranking of Content
on page 587.
IMPORTANT: This property only provides reliable data when the Business Analytics Feature is on.
Business Analytics on page 602
l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IdList (String)
Enter a comma-separated list of IDs if the SourceType property is set to IdList,
TaxonomyList or CatalogList.

l

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

LoadingImage (String)
The image to display while the Product List is loading.
The default is siteroot\Workarea\images\application\ajaxloader_circle_lg.gif.

l

OrderBy
(SortMode property must be set to None)
For further definition of the values shown here, see the entryPropertyenumeration in
the API documentation.
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o

AverageRating

o

CatalogId

o

CollItemsDisplayOrder (only available if SourceType property = Collection)

o

ContentStatus

o

CurrencyId

o

EndDate

o

EntryType

o

GoLIve

o

Html

o

Id

o

IsArchived

o

IsBuyable

o

IsPublished

o

LanguageId

o

LastEditDate

o

LastEditorFirstName

o

LastEditorLastName

o

ListPrice
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l

o

Media

o

NumberRated

o

ProductTypeId

o

SalesPrice

o

Sku

o

Status

o

Summary

o

TaxClassId

o

TaxItemsDisplayOrder (only available if SourceType property = Taxonomy)

o

Title

o

ViewCount

PageSize (Integer)
Specify the number of items to show per page when a customer views the product list. If
the number of items exceeds the quantity defined in this property, the list is paged and
the customer can use the paging navigation system to move through the list.

l

PageSpan (Integer)
The number of pages to show before and after the current page. Enter zero to show all
pages. For example, if you set this property to 2 and you are on page four of the product
list, you see:

l

SortMode (SortModes)
Select the default way the product list is sorted when a customer first views the page.
When the page is loaded, a customer can change the sort via a drop-down list. Choices
are:
o

Title—sorts in alphabetical order.

o

SKU—sorts by the product number. This number is typically a unique number
supplied by the producer of the product.

o

Price Descending—sorts by price from highest to lowest.

o

Price Ascending—sorts by price from lowest to highest.

o

Highest Rated—sorts by rating from highest to lowest.

o

Lowest Rated—sorts by rating from lowest to highest.

o

Most Rated—sorts by products that have most ratings from highest to lowest.

o

None—Use this setting to use OrderBy property.
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See Also: Sorting the Product List on page 1432
l

SourceId (Integer)
The ID of the catalog, collection or taxonomy that is being used as a product list. This
property is used when the SourceType property is set to Catalog, Collection or
Taxonomy.

l

SourceType (SourceObjectType)
The type of source being used to create the list. Choices are:

l

o

Catalog—use the SourceId property to specify the ID of a single catalog when this
source type is selected.

o

CatalogList—use the IdList property to specify a list of catalog IDs when this
source type is selected.

o

Taxonomy—use the SourceId property to specify the ID of the single taxonomy
when this source type is selected.

o

TaxonomyList—Use IdList property to specify a list of taxonomy IDs when this
type is selected.

o

IdList—Use the IdList property to specify a list of product IDs when this source
type is selected.

o

Collection—use the SourceId property to specify the ID of a collection when this
source type is selected.

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TaxonomyDepth (Integer)
Enter the number of taxonomy levels to retrieve below each taxonomy/category. Only
the top level appears in the control. The rest of the levels are available through XML in
Code-behind. For example, if the taxonomy is DVDs > Movies > Comedies, and you
set Taxonomy Depth to 2, only DVDs and Movies are available in Code-behind.
To retrieve all categories for a taxonomy recursively, enter -1. A depth greater than 1 or
using -1 is only useful if you create a custom output using the Taxonomy’s XML. The
default value is 1.
For a live site, Ektron strongly recommends leaving this value at 1. Increasing this value
can slow down your live Web server. However, for testing on a staging server, you can
increase the depth.

l

TemplateProduct (String)
Specify the URL that contains the Product server control. This allows a customer to see
the details of the product when the product link is clicked.

Product Search Server Controls
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ProductSearchInputView

Use the Product Search server controls to let site visitors search your website.
l
l

l

ProductSearchInputView—accepts user input of search terms
ProductSearchController—takes input from ProductSearchInputView control and
returns search results
ProductSearchResultsView—shows search results; you can modify the results'
display, paging, and so on.

See Also: Using Search Server Controls on page 971 and Server Control Reference on
page 1636

ProductSearchInputView

Use the ProductSearchInputView server control to search eCommerce Products. It provides a
Basic and an Advanced search. The query string from the ProductSearchInputView control is
passed to the ProductSearchController, which sends results to the ProductSearchResultsView.
You can place the ProductSearchInputView server control anywhere on a page, and it can be
separated from the results display.
More than one ProductSearchInputView server control can reside on a page.
The following image shows the default template for this control.

Click the Advanced link to show these product search filters.
l

With all words

l

Without words

l

Exact Phrase

l

With any word

Required Properties for ProductSearchInputView
ControllerID—the ID of the ProductSearchController that provides the data.
<CMS:ProductSearchInputView ID="ProductSearchView1"
ControllerID="ProductSearchController1" runat="server">
</CMS:ProductSearchInputView>
<CMS:ProductSearchController ID="ProductSearchController1"
runat="server" />

Customizing the ProductSearchInputView Control
This process is the same as Customizing the SiteSearchInputView Control on page 1839.
Refer to ProductSearch Model Properties on page 1825 to learn which properties may be
Ektron 8.7
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referenced.

ProductSearchController

The ProductSearchController server control takes input from a ProductSearchInputView
control, and returns results to a ProductSearchResultsView control. It provides an interface to
the search API, thereby giving SearchView controls access to search data.
You can modify Ektron's ProductSearchController or write your own.
The ProductSearchController executes a search using a query string from the
ProductSearchInputView control's Text property, as specified in the code-behind's Onclick
event.
Unlike the other search controls, ProductSearchController has no UI functionality. So, there is
no corresponding .ascx file.
Use only one ProductSearchController per page.
Properties
l

ID (Required)—provides the association for the SiteSearchInputView and
SiteSearchResultsView server controls. here is an example of the ID property with the
SiteSearchController.
<ektron:SiteSearchController ID="SiteSearchController1"
runat="server" />

l

AdvancedQueryText (Optional)—see Displaying Search Results Using a ListView
Control on page 1842

ProductSearchResultsView

Use the SearchResultsView server control to show search results sent from a
ProductSearchController.
The ProductSearchResultsView is tied to the ProductSearchController by setting the property
ControllerID.
The following image shows the ProductSearchView's search field and button and search
results using the ProductSearchResultsView server control's default template.
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Required Properties for ProductSearchResultsView
ControllerID—the ID of the UserSearchController that provides the data.
<CMS:ProductSearchResultsView ID="ProductSearchView1"
ControllerID="ProductSearchController1" runat="server">
</CMS:ProductSearchResultsView>
<CMS:ProductSearchController ID="ProductSearchController1"
runat="server" />

Modifying the Default Product Search Results View
To learn about displaying search results, see Displaying Search Results on page 1858. To see
an example of displaying user search results, see
[siteroot]
\workarea\FrameworkUI\Templates\Search\ProductSearchResultsView.ascx.

ProductSearch Model Properties
This information is provided for each product returned with search results.
l

l

l

AdvancedQueryText—Use with ProductSearchController, see Displaying Search
Results Using a ListView Control on page 1842.
ExactPhrase—Use with ProductSearchInputView, this sets an EXACT ORDER
relationship among search terms.
PageInfo—Use with ProductSearchResultsView, this displays information about search
result numbers, such as Displaying results 11 through 20 of 35.
o CurrentPageIndex—current page
o

EndCount—number of results found

o

NumberOfPages—number of results divided by results per page

o

PageCount—number of the page being viewed currently

o

ResultCount—number of the results returned for the search terms
IMPORTANT: The result count is only an estimate. The count becomes more accurate you
get closer to the final page.
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l

l

l

l

l

l

l

o

ResultsPerPage— number of results displayed per page

o

StartCount—one

QueryText—Use with ProductSearchInputView or ProductSearchResultsView, this is the
string used for searching.
Results—Use with ProductSearchResultsView, these are the fields returned of
ProductSearchResultsData. Display these inside a ListView or Repeater.
o Catalog Number
o

ImageUrl

o

ListPrice

o

ProductID

o

SalePrice

o

SKU

o

Summary

o

Title

o

URL

SearchType—Use with ProductSearchInputView or ProductSearchResultsView.
o Advanced
o

Basic

o

None

o

XmlSearch

State—Use with ProductSearchResultsView.
o initialized— search has not been run yet
o

no results—no search results were returned

o

search results—search results were returned

WithAllWords—Use with ProductSearchInputView, this sets an AND relationship among
search terms.
WithAnyWord—Use with ProductSearchInputView, this sets an OR relationship among
search terms.
WithoutWords—Use with ProductSearchInputView, this sets a NOT relationship among
search terms.

Recommendation
PREREQUISITE
Cross sell or upsell products are already assigned to a catalog entry.
The Recommendation server control lets you cross-sell or up-sell products to a customer
based on another product’s ID. After you create a product in the Workarea, you can define a
list of other products that you want to associate with the new product.While viewing a product
in the Workarea, choose View > Cross Sell or Up sell. Then, by adding the
Recommendation server control to a Web form that contains a Product server control, the
customer sees the recommendations when viewing the product details.

Recommendation Properties
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The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

CustomXml (Code-behind Only) (String)
Lets you inject custom XML into the generated XML before being processed by the XSLT.
Enter a string of XML that you want to make available to the XSLT as follows:
<root><customXml>custom-xml-inserted-here</customXml></root>

See Also: Displaying Custom XML in Ektron’s Server Controls on page 1632.
l

DefaultProductID (Integer)
Enter a default product ID that contains either cross sell or up sell products. To make the
server control dynamic, enter zero (0) in this property and set the
DynamicProductParameter to QueryString parameter used to pass the product’s ID.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page. By default, the control uses Recommendation.xsl. This file is located in
siteroot\Workarea\Xslt\Commerce
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicCartParameter (String)
The QueryString parameter name which is used to pass the product ID to the Cart server
control. For example, if your QueryString parameter for products is Product, enter that
in this property. Then, when customers click Add to Cart, this parameter is passed with
the product’s ID Web form containing the Cart server control. See Also: Using the
eCommerce Server Controls on page 1404

l

DynamicProductParameter (String)
The QueryString parameter name which is used to pass the product ID to the product
details page. For example, if your QueryString parameter for products is ID, enter that
in this property. Then, when customers click a product’s title, this parameter is passed
with the product’s ID to the product details page.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.
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l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
If the template on which this server control resides includes a language selection
control, and you want to let the customer select the language, enter zero (0). Otherwise,
click the field, then the ellipsis button (
) and a popup box appears. Select a language
from the list. This property shows results in design-time (in Visual Studio) and at runtime (in a browser).

l

PageSize (Integer)
Specify the number of items to show per page when a customer views
recommendations. If the number of items exceeds the quantity defined in this property,
the list is paged and the customer can use the paging navigation system to move through
the list.

l

RecommendationType (EkEnumeration.RecommendationType)
The type of recommendation to show. Choices are:
o

CrossSell—related products that a customer might be interested in. For example,
if you are selling Denim Jackets, you might want to cross sell them pants or shirts.

o

UpSell—products that improve on the product being purchased. For example, if you
are selling 7 megapixel digital cameras, you show a 10 megapixel digital camera.

See Also: Recommending Related Products to a Customer on page 1371
l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet. For example:
Workarea\csslib\mytest.css.

l

SuppressWrapperTags (Boolean)

l

Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TemplateCart (String)
The URL to navigate to when a customer clicks Add to Cart. The path can be relative or
absolute. When a path is entered, the Add to Cart button appears next to the product
and allows a customer to add the product directly to their cart. See Also: Enabling the
Add to Cart Button on page 1433 and Using the eCommerce Server Controls on
page 1404.

l

TemplateProduct (String)
Specify the URL that contains the Product server control. This allows a customer to see
the details of the product when the product link is clicked. The path can be relative or
absolute.

RssAggregator
An RSS aggregator consumes an RSS feed and displays its information in a readable format.
The RssAggregator server control lets you do the same by processing and displaying an RSS

1828

Ektron Reference

RSS Aggregator Properties

feed from any website. This lets you create an information Web page for news, stories,
images, lists of music, and so on.
You can create a multi-level information Web page by placing several RssAggregator server
controls on a page. For example, create a world news Web page by adding RSS feeds from
the NY Times, BBC, and AFP (Agence France-Presse). To add an RSS Aggregator to your
website:
1. Drag and drop the RssAggregator server control a Web form.
2. Set the URL property to point at the RSS feed. For example,
http://msdn.example.com/rss.xml
When a site visitor views the Web form, the RSS feed displays properly. If the visitor
refreshes the page, information updated by the RSS feed provider appears.
To change an RSS feed's appearance, create a custom XSLT.

RSS Aggregator Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

DisplayXslt (String)
Determines how the information on the page appears.
l

None—databind only

l

ecmNavigation—lists the title of every RSS feed item
ecmNavigation Display Example on page 1682

l

ecmTeaser—lists a title and a description of every RSS feed item
ecmTeaser Display Example on page 1682

l

Path to Custom Xslt—If desired, enter a relative or absolute path to an Xslt that
determines the display of the page.

WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.
o

True—Hide the control output.

o

False—Display the control output.
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l

Language (Integer)
Set a language for viewing the RssAggregator. This property shows results in designtime (in Visual Studio) and at run-time (in a browser).

l

LinkTarget (ItemLinkTarget)
Determines the type of window that appears when you click a link in the server control.

l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

MaxResults (Integer)
The Maximum number of items from an RSS feed that are returned. 0 (zero) =
unlimited.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

URL (String)
The RSS feed path for the server control. For example:
http://msdn.example.com/rss.xml

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Retrieving the XML Structure of an RssAggregator
Retrieving the XML structure of XML content allows for greater control over developing XSLs.
To retrieve the XML structure:
1. Open a new Web form.
2. Drag and drop a RssAggregator server control onto it.
3. Set the URL property.
4. Drag and drop a textbox on the Web form.
5. Set the TextMode property to MultiLine.
NOTE: You should set the text box width to at least 400px.
6. Add the following line on the code-behind page.
Textbox1.Text—RssAggregator1.XmlDoc.InnerXml

7. Build the project.
8. View the Web form in a browser. The XML structure of the RssAggregator Menu appears
in the textbox.

1830

Ektron Reference
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SEO (Search Engine Optimization)
The SEO server control analyzes your website for W3C compliance, what information Google
has about the page, Alexa rankings, image alt text, keyword density, and metadata. SEO lets
you know how (and if) you’ve set these values.
The Search Engine Optimization (SEO) control appears as an image on any template or
master page on which you drop it.

You also can access the SEO report by clicking the Web Site Content menu then choosing
View Page Activity.

When you are logged in and click the image, you see a detailed report of how search engines
evaluate the page. For example, the report runs the page through a W3C validation site, or
displays how search engines evaluate the page's text.
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Inserting SEO in a Website
1. Within Visual Studio, open your website.
2. Open a master page or template on which to place the SEO control.
3. Open Solution Explorer, and your website within it.
4. Open the Workarea then the SEO folder.
5. Drag the SEO control (seo_w3c.ascx) onto an area of the page.

6. Save the page.

Viewing a Web Page's SEO Report
Only logged-in Ektron or Membership users can see the SEO control.The following list
summarizes the information on the SEO Report.
l

l

l
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SEO—Compares viewed page against a basic SEO checklist, such as if keywords are
included, language and charset values, and so on.
Google—Information that search engines have about your page, including pages that
link to it, indexed pages on the site and what the page looks like on a mobile device.
W3C—Validates Web page for markup and CSS compliance, and also checks for broken
links and the ability of the page to be displayed on mobile devices. By having correct
markup that conforms to HTML or XHTML standards, search engines will detect words
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SiteMap

and phrases correctly, a key element in SEO. Correct markup also ensures that search
engine spiders can easily understand the content and navigation on the page. Proper
code will make it easier for spiders to parse as expected and digest the content for
organic search engines.
l

l

l

Alexa—Alexa is a leader in providing insight on the overall ranking of your website on
the Internet. Alexa overview, traffic, related and linked-to sites.
Images—To ensure SEO and compliance, all images on your pages should contain alt
tags. This enables searching of the images (since engines cannot read the contents of an
image). In addition, alt tags must be used for 508 compliance. This tab identifies all
images and their alt tags.
Text—A keyword density analysis report displays text graphically in much the same way
that organic search engines see your page. Web pages that are content rich typically
yield higher search engine rankings than pages that are mainly images or multimedia
based. This report displays words, two-word phrases and 3-word phrases in a cloud
format, revealing words and phrases that show up most often on the page. This
information helps you to optimize your content and reach your target audience.

l

Meta—The page's metadata

l

Misc—Additional search information

SiteMap
The Sitemap server control utilizes the folder breadcrumb information in the Workarea to
display a sitemap of your site. By choosing the starting point of the sitemap, the max levels
to display and applying a style class, you can customize the sitemap. The sitemap appears as
indented list when viewed on a Web page.

The contents of the sitemap are defined on the Breadcrumb tab, located in the Workarea
folder properties. See Also: Using Breadcrumbs on page 819
This section also contains the following topics.
Sitemap properties
Using Sitemap
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Retrieving the XML Structure of a Site Map
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Sitemap properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

ClassName (String)
The style sheet class name used to format the HTML. Leave blank to use the default. To
use a new class, add it to the following file:
webroot\siteroot\Workarea\csslib\sitemap.css

Then, add the class name to the property.
l

DisplayXslt (String) (Code-behind only)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

FlatTopLevel (Boolean)
When set to True, include site nodes from the parent folder but not their items. Set to
False to include all nodes and items.

l

FolderID (Long)
The folder ID for the starting point of the site map. To choose the root folder, enter 0
(zero).

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).
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l

MaxLevel (Integer)
Set the maximum amount of levels to show. 0 (zero) = unlimited.

l

StartingLevel (Integer)
Set to the starting level of the site map. If set to 0 (zero), starts from the root.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

Using Sitemap
NOTE: Make sure you have added the sitemap information to your folders’ Breadcrumb tab in the
Workarea.
To use the Sitemap server control:
1. Open a Web form for which you want to create a sitemap.
2. Drag and drop the Sitemap server control onto an appropriate location of the Web form.
3. Add the starting folder’s ID to the FolderID property.
4. Set other properties. See Also: Sitemap properties on the previous page.
5. Save the Web form.
6. Open a browser.
7. View a Web page with the Sitemap server control in it. The sitemap now appears on your
site.

Retrieving the XML Structure of a Site Map
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Retrieving the XML structure of XML content allows for greater control over developing XSLs.
The following is an example of how to retrieve the XML structure:
1. Open a new Web form.
2. Drag and drop a SiteMap server control onto it.
3. Set the FolderID property.
4. Drag and drop a textbox on the Web form.
5. Set the TextMode property to MultiLine.
NOTE: It is also recommended that you set the width of the text box to at least 400px.
6. On the code-behind page, add the following line.
7. Textbox1.Text = SiteMap1.XmlDoc.InnerXml
8. Build the project.
9. View the Web form in a browser. The XML structure of the Site Map appears in the
textbox.

Site Search Server Controls

Use the Site Search server controls to let site visitors search your website.
l
l

l

SiteSearchInputView—accepts user input of search terms
SiteSearchController—takes input from SiteSearchInputView control and returns
search results
SiteSearchResultsView—shows search results; you can modify the results' display,
paging, and so on.

See Also: Using Search Server Controls on page 971

Inserting Site Search Server Controls
To provide search capabilities to your website content, insert all 3 controls onto an .aspx
template. Because the search functions are managed by separate controls, you can place a
search field and button in a one section of a page, and the results in another.
Also, unless you want to use the default paging properties (which show only 10 results), insert
an EktronUI Pager control on the page to manage the paging of the search results.
PREREQUISITE
Search server controls were added to the Visual Studio Toolbox. See Adding Search
Server Controls to Visual Studio on page 975.
If you drag and drop controls from the Visual Studio Toolbox, the necessary register
statements are copied from the web.config file and added to the page.
<add tagPrefix="ektron" namespace="Ektron.Cms.Framework.UI.Controls"
assembly="Ektron.Cms.Framework.UI.Controls, Version=8.5.0.356,
Culture=neutral, PublicKeyToken=559a2c4fa21e63be" />
<add tagPrefix="ektronUI"
namespace="Ektron.Cms.Framework.UI.Controls.EktronUI"
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assembly="Ektron.Cms.Framework.UI.Controls.EktronUI,
Version=8.5.0.356, Culture=neutral, PublicKeyToken=559a2c4fa21e63be" />

If you copy and paste the sample code, add the following register statement for templated
controls:
<%@ Register assembly="Ektron.Cms.Framework.UI.Controls"
namespace="Ektron.Cms.Framework.UI.Controls"
tagprefix="ektron" %>

For Ektron UI controls, use this register statement:
<%@ Register assembly="Ektron.Cms.Framework.UI.Controls.EktronUI"
namespace="Ektron.Cms.Framework.UI.Controls.EktronUI"
tagprefix="ektronUI" %>

The tag prefix can be anything as long as it matches the control's prefix.
Here is a basic template showing the 3 controls.
<%@ Page Language="C#" AutoEventWireup="true"
CodeFile="TemplatedControl.aspx.cs"
Inherits="TemplatedControl" ValidateRequest="false" %>
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
<html xmlns="http://www.w3.org/1999/xhtml">
<head runat="server">
<title></title>
</head>
<body>
<form id="form1" runat="server">
<div>
<ektron:SiteSearchInputView ID="SiteSearchInputView1"
ControllerID="SiteSearchController1" runat="server">
</ektron:SiteSearchInputView>
<ektron:SiteSearchController ID="SiteSearchController1"
runat="server" />
<ektron:SiteSearchResultsView ControllerID="SiteSearchController1"
ID="SiteSearchResultsView1" runat="server">
</ektron:SiteSearchResultsView>
<ektronUI:Pager ID="pager1" runat="server"
PageableControlID="SiteSearchController1"
ResultsPerPage="10"></ektronUI:Pager>
</div>
</form>
</body>
</html>

SiteSearchInputView

The SiteSearchInputView server control provides a text box and submit button, which visitors
use to search content. The control contains no business logic. It merely accepts a search term
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and passes it to the SiteSearchController, which retrieves and sends results to the
SiteSearchResultsView control.
The SiteSearchInputView control's main purpose is a placeholder for markup, which you use
to modify its appearance. The control's default markup is very simple: it inserts a text box, a
Search button, and an Advanced Search link.

This section also contains the following topics.
Placing a SiteSearchInputView Server Control on a Page
Connecting a SiteSearchController to a SiteSearchInputView Control
Customizing the SiteSearchInputView Control
Separating the Search Field from the Results Display
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Placing a SiteSearchInputView Server Control on a Page
PREREQUISITE
You added search server controls to the Visual Studio Toolbox. See Server Control
Reference on page 1636.
To place a SiteSearchInputView control on a page:
1. Open the page in Visual Studio.
2. Drag and drop the SiteSearchInputView control.
You can place the SiteSearchInputView control anywhere on a page -- it does not need to be
next to the results.
Also, you can place several SiteSearchInputView controls on a page.

Connecting a SiteSearchController to a
SiteSearchInputView Control
To enable search functionality, connect a SiteSearchController to a SiteSearchInputView
control. Use the control's controllerID property to do this.
As a value for the ControllerID property, enter the ID of the SiteSearchController that you
place within the <form> tags. For example:
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<ektron:SiteSearchInputView ID="SiteSearchInputView1"
ControllerID="SiteSearchController1" runat="server">
</ektron:SiteSearchInputView>

Customizing the SiteSearchInputView Control
See Also: Server Control Reference on page 1636
1. Add a set of <ItemTemplate> tags between the SiteSearchInputView control's opening
and closing tags. Then, insert an asp text box or an EktronUI:TextField to accept the
user's input. Here is an example.
<ektron:SiteSearchInputView ID="SiteSearchInputView1"
ControllerID="SiteSearchController1" runat="server">
<ItemTemplate>
<ektronUI:TextField ID="queryText" Text='<%# Eval("QueryText") %>'
runat="server"></ektronUI:TextField>
</ItemTemplate>
</ektron:SiteSearchInputView>

NOTE: As an alternative, you can copy the line that inserts a text box from
siteroot
\Workarea\FrameworkUI\Templates\Search\SiteSearchInputview.ascx.
Note that the Eval statement (<%# Eval("QueryText") %>) databinds the search term
to the textbox. As a result, the term remains in the box after the user clicks the search
button.
2. Insert an asp search or EktronUI:Button, like this.
<ektron:SiteSearchInputView ID="SiteSearchInputView1"
ControllerID="SiteSearchController1" runat="server"> <ItemTemplate>
<ektronUI:TextField ID="queryText" Text='<%# Eval("QueryText") %>'
runat="server"></ektronUI:TextField> <ektronUI:Button ID="Button1"
DisplayMode="button" Text="Button 1" runat="server" OnClick="Button1_Click">
</ektronUI:Button> </ItemTemplate>
</ektron:SiteSearchInputView>

NOTE: As an alternative, you can copy the line that inserts a search button from
siteroot
\Workarea\FrameworkUI\Templates\Search\SiteSearchInputview.ascx.
3. Assign to the button an onclick event that executes a search. To accomplish this, open
the page’s code-behind file and add the following code.
protected void searchButton_Click(object sender, EventArgs e)
{ SiteSearchController1.Search (queryText.Text); }

Now you can customize the control's markup as needed.
See Also: MSDN Button class, MSDN Textbox class

Separating the Search Field from the Results Display
You can place the search field and button on different parts of the page. To do that, insert 2
SiteSearchInputView controls. In one control, place the search field, like this.
<ektron:SiteSearchInputView ID="SiteSearchInputView1"
ControllerID="Scontroller" Visible="true" runat="server">
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<ItemTemplate>
<ektronUI:TextField ID="queryText" Text='<%# Eval("QueryText") %>'
runat="server"></ektronUI:TextField>
</ItemTemplate>
</ektron:SiteSearchInputView>

In the second control, in another section of the page, place the button, like this.
<ektron:SiteSearchInputView ID="SiteSearchInputView2"
ControllerID="Scontroller" Visible="true" runat="server">
<ItemTemplate>
<ektronUI:Button ID="Button1" DisplayMode="button" Text="Button 1"
runat="server" OnClick="Button1_Click">
</ektronUI:Button>
</ItemTemplate>
</ektron:SiteSearchInputView>

Then, assign an onclick event to the button that executes a search. To accomplish this, open
the page’s code-behind file and add the following code.
protected void searchButton_Click(object sender, EventArgs e)
{
SiteSearchController1.Search (queryText.Text);

SiteSearchController

The SiteSearchController server control takes input from a SiteSearchInputView control, and
returns results to a SiteSearchResultsView control. It provides an interface to the search API,
thereby giving SearchView controls access to search data.
You can modify Ektron's SiteSearchController or write your own.
The SiteSearchController executes a search using a query string from the
SiteSearchInputView control's Text property, as specified in the code-behind's Onclick
event.
Unlike the other search controls, SiteSearchController has no UI functionality. So, there is no
corresponding .ascx file.
Use only one SiteSearchController per page.
Properties
l

ID (Required)—provides the association for the SiteSearchInputView and
SiteSearchResultsView server controls. here is an example of the ID property with the
SiteSearchController.
<ektron:SiteSearchController ID="SiteSearchController1"
runat="server" />

l

AdvancedQueryText (Optional)—see Displaying Search Results Using a ListView
Control on page 1842

SearchResultsView
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The SiteSearchResultsView Control receives search results from the SiteSearchController and
displays them on a page. By default, the control's display looks like this.

NOTE: To manage the paging display at the bottom of the page, use an EktronUI:Pagercontrol.

Connecting a SiteSearchController to the
SiteSearchResultsView Control
To enable search functionality, connect a SiteSearchController to a SiteSearchResultsView
control. Use the control's controllerID property to do this. See Also: Server Control
Reference on page 1636
For the controllerID property value, enter the ID of the SiteSearchController that takes input
from SiteSearchInputView control and returns search results to this control. For example:
<ektron:SiteSearchResultsView ID="SiteSearchResultsView1"
ControllerID="SiteSearchController1" runat="server">
</ektron:SiteSearchResultsView>

Customizing the SiteSearchResultsView Control
To customize the SiteSearchResultsView Control, first add a set of <ItemTemplate> tags
between the SiteSearchResultsView control's opening and closing tags (as explained in
Modifying Templated Server Controls on page 972). Then, modify the search results in the
following ways.
NOTE: As an alternative, you can copy the line that inserts a text box from
siteroot\Workarea\FrameworkUI\Templates\Search\SiteSearchResultsView.ascx.

Displaying the Search Phrase with Results
Use <%# Eval("QueryText") %> to databind the search term to the SiteSearchResultsView
control. This code sample below displays an example of this Search Phrase: followed by the
search term.
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<ektron:SiteSearchResultsView ID="SiteSearchInputView1"
ControllerID="SiteSearchController1" runat="server">
<ItemTemplate>
<p>Search Phrase:<%# Eval("QueryText") %> </p>
</ItemTemplate>
</ektron:SiteSearchResultsView>

Displaying Search Results Using a ListView Control
Use a ListView control to display search results from a SiteSearchController.
1. Within a ListView control, use an <%# Eval("Results") %> statement to databind
search results to the ListView control.
<asp:ListView ID="aspResults" runat="server"
DataSource='<%# Eval("Results") %>'
ItemPlaceholderID="aspPlaceholder">

2. To define the main (root) layout of a ListView control, insert a LayoutTemplate. Within
that template, insert a placeholder to store the server controls on the page.
<asp:ListView ID="aspResults" runat="server"
DataSource='<%# Eval("Results") %>'
ItemPlaceholderID="aspPlaceholder">
<layouttemplate>
<ul class="results">
<asp:PlaceHolder ID="aspPlaceholder" runat="server">
</asp:PlaceHolder>
</ul>
</layouttemplate>

3. Use an ItemTemplate to specify the markup used to generate each record bound to the
ListView. Here is an example that displays search results' title, summary, URL and date.
<itemtemplate>
<li>
<h3><a href="<%# Eval("Url") %>"><%# Eval("Title") %></a></h3>
<p><%# Eval("Summary") %></p>
<p><%# Eval("Url") %> <%# Eval("Date") %></p>
</li>
</itemtemplate>

Here is the entire sample.
<itemtemplate>
<asp:ListView ID="aspResults" runat="server"
DataSource='<%# Eval("Results") %>'
ItemPlaceholderID="aspPlaceholder">
<layouttemplate>
<ul class="results">
<asp:PlaceHolder ID="aspPlaceholder" runat="server">
</asp:PlaceHolder></ul>
</layouttemplate>
<itemtemplate>
<li>
<h3><a href="<%# Eval("Url") %>"><%# Eval("Title") %></a></h3>
<p><%# Eval("Summary") %></p>
<p><%# Eval("Url") %> <%# Eval("Date") %></p>
</li>
</itemtemplate>
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</asp:ListView>
</itemTemplate>

Displaying Search Results Using a GridView Control
You can use an asp:Gridview control to make search results look like the following.

To modify the UI for SearchResultsView:
1. Within the <ektron:SearchResultsView> tags, insert
<ItemTemplate></ItemTemplate>.
2. Between the <ItemTemplate> tags, insert the following code, shown in bold.
<ektron:SearchResultsView ControllerID="SiteSearchController1"
runat="server">
<ItemTemplate>
<h2>Search results for: <%# Eval("QueryText") %></h2>
<asp:Gridview ID="Gridview1" DataSource='<%# Eval("Results") %>'
runat="server">
</asp:Gridview>
</ItemTemplate>
</ektron:SearchResultsView>

3. Modify the appearance of the results using Gridview properties and styles. See Also:
GridView Class

SiteSearch Model Properties
You can use the properties with Eval statements to display aspects of content search results.
For example, <%# Eval("Summary") %> displays the summary for content being returned by
the search. See Also: Displaying Search Results on page 1858, Server Control Reference on
page 1636
l

l

AdvancedQueryText—Use with SiteSearchController. See Displaying Search Results
Using a ListView Control on the previous page.
ElapsedTime—Use with SiteSearchResultsView, this is the time required to execute a
search.
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l

l

l

ExactPhrase—Use with SiteSearchInputView, sets an EXACT ORDER relationship
among search terms.
Fields—Label, Name, Xpath: Retrieve information from XML Smart Forms. See
XMLSearch Server Controls on page 1861.
PageInfo—Use with SiteSearchResultsView
o Display information about search result numbers, such as Displaying results 11
through 20 of 35.
o

CurrentPageIndex—current page

o

EndCount—number of results found

o

NumberOfPages—number of results divided by results per page

o

PageCount—The number of the page being viewed currently

o

ResultCount—The number of the results returned for the search terms
IMPORTANT: The result count is only an estimate. The count
becomes more accurate you get closer to the final page.

l

l

l

l

l

l
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o

ResultsPerPage— number of results displayed per page

o

StartCount—one

QueryText—Use with SiteSearchInputView or SiteSearchResultsView, this is the string
that the site visitor entered to begin search.
Results—Use with SiteSearchResultsView, these are fields returned of type
SearchResultsData. Display these inside a ListView or Repeater.
o Date—last edit date
o

Summary—content summary, up to a maximum of 400 characters

o

Title

o

Url

o

Type: Content, forms, managed assets, and so on.
For a full list, enter SiteSearchResultType into the Object Browser.

SearchType—Use with SiteSearchResultsView
o Advanced
o

Basic

o

None—no search yet

o

XmlSearch

State—Use with SiteSearchResultsView
o initialized— search has not been run yet
o

no results—no search results were returned

o

search results—search results were returned

Suggested Results—Use with SiteSearchResultsView, these fields returned of type
SearchResultsData for Suggested Results. Display inside a ListView or Repeater. See
Also: Displaying Suggested Results on page 958
o Summary—content summary, a maximum of 400 characters
o

Title

o

Url

Suggested Spellings—Use with SiteSearchResultsView, displays a list of words that
are similar to the entered search phrase. For a sample of using this, open
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siteroot\workarea\FrameworkUI\Templates
\Search\SiteSearchResultsView.ascx and find Eval("SuggestedSpellings").
l

l

l

l

WithAllWords—Use with SiteSearchInputView, sets an AND relationship among search
terms.
WithAnyWord—Use with SiteSearchInputView, sets an OR relationship among search
terms.
WithoutWords—Use with SiteSearchInputView, sets a NOT relationship among search
terms.
XmlConfigId—Long Integer: If content is an XML Smart Form, the ID of its
configuration. See Also: Copying a Smart Form Configuration on page 427

SocialBar
The SocialBar server control lets users of a community website bookmark colleagues,
community groups, and content. See Also: Using the SocialBar Server Control on page 1273.

SocialBar Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultObjectID (Long)
The default object ID for this control to use when there is no matching dynamic
parameter value passed. If you set this property set to 0 (zero) and leave the
DynamicObjectParameter blank, the social bar can be used to add Web pages to your
favorites.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.
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l

DynamicObjectParameter (String)
Gets or sets the QueryString parameter to read a object ID dynamically. To use the
default object ID, leave blank.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

IncludeIcons (Boolean)
Select whether icons are displayed next to each item.

l

o

True—Display icons next to each item.

o

False—Do not display icons next to each item.

InviteURL (String)
The URL to the Invite server control’s Web page. Two variables used within the URL.
o

{0}—object ID

o

{1}—object type

The link must have both variables. The Web form can be relative or absolute. Below is an
example.
invitepage.aspx?id={0}&type={1}
l

Items(String)
A comma-separated list of items that you want to appear on the Social Bar.
o

Add to—
n If this control is associated with a user, the Addto item appears as:
o Add a Colleague—if you are viewing another user’s profile page and can
add them as a colleague.

n

n

o

CancelColleague Request—if you are viewing another user’s profile
page who you asked to be a colleague but the user has not yet accepted.

o

Remove From Colleagues—if you are viewing a current colleague’s
profile page.

If the control is associated with a community group, the Addto item appears
as:
o Join Group—if you visit a community group that you have not joined.
o

Leave Group—if you already belong to a community group.

o

CancelRequest to Join—if you have tried join a restricted group and
have not yet been accepted.

If the control is associated with content, the Addto item appears as:
o Add to Favorites—if you view content that is not in your Favorites.
o

o

Remove Favorites—if you view content that is in your Favorites.

Invite—A link to the Web page that contains the Invite server control. This control
lets you invite people to register on the site and become a colleague.
IMPORTANT: For the Invite item to be active, you must enter a link to the page hosting the
Invite control into the InviteURL property.
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l

o

GroupInvite—Opens a dialog that invites colleagues or people who are not
registered on the site to join the group.

o

Email—Email this Web page. Clicking this item launches your email with the
subject and body loaded with the information about the content, user or community
group.

o

Digg—Appears as Digg It. Launches Digg.com, a social bookmarking service.

o

Delicious—Appears as Bookmark It. Launches del.icio.us, a social
bookmarking service.

o

Facebook—Appears as Facebook. Launches Facebook, a social network service.

o

Google—Appears as Google It. Launches Google’s social bookmarking service.

o

Furl—Appears as Furl It. Launches Furl, a social bookmarking service.

o

Technorati—Appears as Technorati. Launches Technorati, a social bookmarking
service.

o

Twitter—Launches Twitter, a social network service, which lets you communicate
with other Twitter users. If the Twitter link is clicked, and you log into a Twitter
account, a link to the current page is inserted into the Status box. See Also: Server
Control Reference on page 1636

o

Yahoo—Appears as Yahoo! It. Launches Yahoo’s social bookmarking service.

o

Print—Print the Web page.

o

PrivateMessageUser—Creates a link that lets you send a Private Message to a
user. See Also: Server Control Reference on page 1636

o

PrivateMessageAdmin—Creates a link that lets you send a Private Message to a
community group’s administrator. See Also: Server Control Reference on
page 1636

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905Controlling Output with Ektron Markup Language on page 1905

l

MessagingUrl (String)
The Web page that hosts the Messaging server control. This property is used when either
PrivateMessageUser or PrivateMessageAdmin appears in the Items property.
If a value appears in the ek_RedirectFromLoginKeyName key in the web.config file,
the user is returned to the original URL after sending the message. By default, this value
is RedirectUrl. If you remove this value and do not add another, the person sending a
message sees a note stating “Your message has been sent.”

l

ObjectType
The type of object to which this control is assigned. Choices are:
o

Content

o

User
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l

o

Group

o

Data Type—Ektron.Cms.Common.EkEnumeration.CMSSocialBarTypes

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
WARNING! If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet
property is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

TagCloud
The TagCloud server control shows a weighted list of tags assigned to users, community
groups, content, or library items. Tag sizes are proportional to the number of times they are
assigned. For example, there are 2 tags, Software and Programming. If the Software tag is
used 5 times and the Programming tag is used 2 times, the Software tag is approximately
twice as large.

Use the TagType property to determine which types of tags appear in the cloud. For example,
set TagType to User to display user tags.
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You can set a maximum number of tags to display via the MaxTagsDisplayed property. This
property makes sense if the Orderby property is set to Taggedcount. In this case, the cloud
only displays items with the highest number of tags.
Use the OrderBy property to sort tags within a cloud. Your choices are alphabetical or by
Taggedcount (the number of times an item is tagged). Then, use the OrderByDirection
property to determine if items are sorted in ascending or descending order.
Within a tag cloud, you can link tags to their source items. If you do, site visitors can click a
tag to launch a search of all users, community groups, content, or library items to which the
tag is assigned. For example, if someone views a user-based tag cloud and clicks
Motorcycles, the community search page appears, showing all users tagged with
Motorcycles.

To make a tag cloud’s items searchable, add a path to the Web form containing the Search
server control in the TagTemplate property.

TagCloud Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
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WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.
l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
By default, the TagTemplate property passes a TagId parameter, whose value is the tag
that a site visitor clicked in the tag cloud. Use this property to manually override that
parameter and set the TagID value by hand.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.
o

True—Hide the control output.

o

False—Display the control output.

l

Language (Integer)(missing snippet link)

l

MarkupLanguage (String)
Identify the template markup file that controls the display of the server control. For
example, mymarkup.ekml. If the EkML file is located in the same folder as the Web form
containing the server control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See also: Controlling Output with Ektron Markup Language on
page 1905Controlling Output with Ektron Markup Language on page 1905

l

MaxTagsDisplayed (Integer)
The maximum number of tags to display. 0 (zero) = unlimited. If you set a maximum,
and more than that number of tags are applied, then only the most frequently-used tags
appear. For example, if you enter ten, the ten tags applied the most number of times
appear.

l

OrderBy (String)
The criteria by which tags are ordered in the tag cloud. Choices are:

l

o

TaggedCount—sort by how many times a tag is assigned

o

Text—sort alphabetically by tag name

OrderByDirection (String)
Select the direction of the OrderBy property. Choose Ascending or Descending.

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.
NOTE: If you enter a valid EkML file at the MarkupLanguage property, the Stylesheet property
is ignored.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.
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True—Suppress wrap tags.

o
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l

TagTemplate (String)
If you want a tag cloud’s items to link to a page that shows all items with that tag, add a
path to a Web form page that hosts the appropriate search control. The path can be
relative or absolute.
o

If the TagType is User or Community Group, enter a page hosting a Community
Search server control.

o

If the TagType is Content or Library, enter a page hosting a Web Search server
control.

For example, in the Ektron Intranet starter site’s tagcloud.aspx page, the first 2
TagCloud controls link to users and community groups. So, this property is set to
CommunitySearch.aspx, a Web form that hosts the CommunitySearch server control.
When a site visitor clicks a tag cloud item, the Community Search page displays,
populated with search results for the clicked tag. The visitor can click any result to see
more about it.

The following 5 parameters are added to the link’s QueryString, and pass tag
information to the destination Web form. Its search server control uses the parameters
to populate the search.
o

searchtag or searchgrptag—searchtag represents the tag’s text for users;
searchgrptag represent the tag’s text for community groups

o

TagId—the clicked tag’s ID

o

TagLanguage—the clicked tag’s language; only search results in this language
appear

o

TagCount—the number of times the tag has been assigned

o

TagType—the tag’s type: user, community group, content or library item. This
value is obtained from the TagType property (described below).

In addition to these parameters, you can add your own by defining them in the path. If
you do, the above 5 parameters are appended to yours.
l

TagTemplateTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.
o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.
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l

TagType (String)
Select the type of tags that appear in the tag cloud. Choices are:

l

o

User

o

CommunityGroup

o

Content

o

Library

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

UserProfile
A user’s profile page is the person's home on the website. The UserProfile control displays
following information about a user.
l

Avatar

l

Personal tags

l

Screen name

l

Custom properties

l

If community aliasing for users is enabled, the user's alias (following Profile Links)

Logged-in users can edit their profile by clicking Edit Profile in the top right corner. This
dialog box is the same dialog that a membership user uses to create an account on the site.
See Membership Users and Groups on page 1161 for a description of this dialog. To
automatically create a friendly URL for a user profile, you can use Community Aliasing for
Users. See Also: Creating User-Friendly URLs with Aliasing on page 835
You can see a sample profile on the eIntranet My Profile page's top left corner.
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UserProfile Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

Authenticated (String)
Indicates if you are logged into the CMS Explorer and can use it to browse to content,
collections, and so on. See Also: Browsing Your Ektron Site Using CMS Explorer on
page 1610.

l

AvatarHeight (Integer)
The display height in pixels of the avatar in the profile area.

l

AvatarWidth (Integer)
The display width in pixels of the avatar in the profile area.

l

CacheInterval (Double)
The number of seconds that a server control’s data is cached. The default is 0 (zero). For
example, if you want to cache the data for 5 minutes, set to 300. See Also: Caching with
Server Controls on page 1629.

l

DefaultUserID (Long)
The default user ID for this control to use when there is no matching dynamic parameter
value passed.

Ektron 8.7

1853

Working with Ektron Server Controls

l

DisplayXslt (String)
If desired, enter a relative or absolute path to an Xslt that determines the display of the
page.
WARNING! If you specify an external file, do not store this file in the Workarea folder. If you store
this file in the Workarea folder, the file will be lost when you upgrade.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
Gets or sets the QueryString parameter to read a user ID dynamically. To use the default
object ID, leave blank.

l

EnableEmailDisplay (Boolean)
Set to True to display a user’s email address in the profile. If a user’s Private Profile
setting is set to Private, the profile information is not visible, regardless of this
property’s setting. If Private Profile is set to Colleagues, only a user’s colleagues can see
email information.

l

o

True—display a user’s email address in the profile.

o

False—do not display a user’s email address in the profile.

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

Stylesheet (String)
Specify the path to a style sheet for use with this server control. The location can be
relative or absolute. Leave blank to use the default style sheet.

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

TagTemplate (String)
The Web page template that contains the CommunitySearch server control. This allows
users to search for others users with the same tags. If a template is entered, Personal
Tags in the Profile appear as links. Clicking a tag forwards the user to a User Search
page that displays search results for the matching tag.

l

TagTemplateTarget (ItemLinkTargets)
Determines the type of window that appears when you click a link in the server control.
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l

o

_Self (default)—opens in same window.

o

_Top—opens in parent window.

o

_Blank—opens in new window.

o

_Parent—opens in the parent frame.

TaxonomyId (Long)
The numeric ID of the taxonomy that is available to users. A user editing a profile can
select which categories to associate with their profiles. See Also: Using Taxonomies on
page 777

l

WrapTag (String)
Lets a developer specify a server control’s tag.
o

Span (default)—designate an inline portion of an HTML document as a span
element.

o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

User Search Server Controls

Use UserSearch server controls to let site visitors search for users and membership users of
your website.
l
l

l

UserSearchInputView—accepts user input of search terms
UserSearchController—takes input from UserSearchInputView control and returns
search results
UserSearchResultsView—shows search results; you can modify the results' display

See Also: Using Search Server Controls on page 971

Inserting Search Server Controls
See Inserting Site Search Server Controls on page 1836

UserSearchInputView

The UserSearchInputView server control lets site visitors search for Ektron users and
members. See Also: Membership Users and Groups on page 1161 and Managing Users and
User Groups on page 1099
Site visitors can find users using any of these properties:
l

first name

l

last name
Ektron 8.7
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l

username

l

email address

l

display name

l

tag

Site visitors can use the wildcard character (*) to find all users that fit a certain pattern. For
example, to find all users with any property that begins with adm, enter adm*.
The following image shows the default template's search options.

A site visitor's query string is collected by the UserSearchInputView server control and
passed to the XMLSearchController on page 1862 which, in turn, sends results to the
UserSearchResultsView on the facing page.
You can place the UserSearchInputView server control anywhere on a page—it does not need
to be next to its results control. Also, you can place more than one UserSearchInputView
control on a page.

Required Properties for UserSearchInputView Control
ControllerID—the ID of the SearchController that provides the data.
<ektron:Serena ID="UserSearchInputView1"
ControllerID="SearchController1" runat="server">
</ektron:UserSearchInputView>

Customizing the UserSearchInputView Control
This process is the same as Customizing the SiteSearchInputView Control on page 1839.
Refer to UserSearch Model Properties on page 1858 to learn which properties may be
referenced.

UserSearchController
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The UserSearchController server control takes input from a UserSearchInputView control,
and returns results to a UserSearchResultsView control. It provides an interface to the search
API, thereby giving SearchView controls access to search data.
You can modify Ektron's UserSearchController or write your own.
The UserSearchController executes a search using a query string from the
UserSearchInputView control's Text property, as specified in the code-behind's Onclick
event.
Unlike the other search controls, UserSearchController has no UI functionality. So, there is no
corresponding .ascx file.
Use only one UserSearchController per page.
Properties
l

ID (Required)—provides the association for the SiteSearchInputView and
SiteSearchResultsView server controls. here is an example of the ID property with the
SiteSearchController.
<ektron:SiteSearchController ID="SiteSearchController1"
runat="server" />

l

AdvancedQueryText (Optional)—see Displaying Search Results Using a ListView
Control on page 1842

UserSearchResultsView

The UserSearchResultsView server control displays the results of a user and member search.
The control gets its results from a XMLSearchController on page 1862.
The following image shows the UserSearchInputView control's filters, as well as search
results that use the UserSearchResultsView control's default template.
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Connecting a SearchController to the
UserSearchResultsView Control
To enable the display of user search results, use the UserSearchResultsView control's
controllerID property to connect it to a SearchController. See Also: XMLSearchController on
page 1862
For the controllerID property value, enter the ID of the UserSearchController that takes input
from UserSearchInputView control and returns results to this control. For example:
<CMS:UserSearchResultsView ID="UserSearchView1"
ControllerID="UserSearchController1" runat="server">
</CMS:UserSearchResultsView>
<CMS:UserSearchController ID="UserSearchController1" runat="server" />

Displaying Search Results
To learn about displaying search results, see Displaying Search Results above. To see an
example of displaying user search results, see
siteroot\workarea\FrameworkUI\Templates\Search\UserSearchResultsView.ascx.

UserSearch Model Properties
l

l
l
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Advanced QueryText—Use with XMLSearchController on page 1862, see Displaying
Search Results Using a ListView Control on page 1842.
AvailableFilters—Label, Name, Value.
DirectorySearchLetter—Use with UserSearchResultsView, this is the letter the site
visitor clicks to initiate the search after clicking Browse Directory.
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l

l

DirectorySearchType—Use with UserSearchResultsView, this is First name, last
name, or display name.
PageInfo—Use with UserSearchResultsView, display information about search result
numbers, such as Displaying results 11 through 20 of 35.
o CurrentPageIndex—current page
o

EndCount—number of results found

o

NumberOfPages—number of results divided by results per page

o

PageCount—number of the page being viewed currently

o

ResultCount—number of the results returned for the search terms
IMPORTANT: The result count is only an estimate. The count becomes more accurate you
get closer to the final page.

l

l

l

l

o

ResultsPerPage— number of results displayed per page

o

StartCount—one

QueryText—Use with UserSearchInputView or UserSearchResultsView, this is the
string that the site visitor entered to begin search.
Results—Use with UserSearchResultsView, these are the fields returned of
UserSearchResults. Display these inside a ListView or Repeater, for example.
o Avatar
o

DisplayName

o

email

o

FirstName

o

LastName

o

ProfileURL

o

Tags

SearchType—Use with UserSearchInputView, this is Basic or Advanced search (site
visitor clicks Browse Directory to access advanced search).
State—Use with UserSearchResultsView, this is...
o initialized— search has not been run yet
o

no results—no search results were returned

o

search results—search results were returned

WebCalendar
The WebCalendar server control displays Ektron calendars. See Also: Working with Calendars
on page 514
NOTE: On a PageBuilder page, use the Calendar widget to insert a calendar.
The following code example shows the WebCalendar server control.
<cms:WebCalendar ID="webcalendar" runat="server"
DynamicParameter="calendar_id" DisplayType="Day">
<DataSource>
<cms:CalendarDataSource defaultId="724"sourceType="SystemCalendar"/>
</DataSource>
</cms:WebCalendar>
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WebCalendar Properties
The following are Ektron-specific server control properties. You can find information about
native .NET properties such as font, height, width and border style in Visual Studio® help.
l

AllowEventEditing (Boolean)
Determines whether users can add or edit calendar events. Default is True.

l

DefaultDisplayType (String)
Specify the default calendar display. The default is Month, which means that the month
view appears on the Web page. The site visitor can change the view.

l

DisplayTemplatePath (String)
Specify the path to the code that controls how events are displayed. Default is blank. See
Also: Customizing the Web Calendar Tooltip on page 525

l

DisplayType (String)
Determines which time periods appear on the calendar. Choices are All, Day, Month,
Week. Default is All.

l

DoInitFill (Boolean)
By default, Fill occurs during the Page_Init event. Set to false if you want to postpone
the fill-action until later. In this case, Fill is automatically called during the Page Render
event. You might do this if you need to set or change a property on the control in codebehind and have it render with your changes shown.

l

DynamicParameter (String)
To make this calendar dynamic, select calendar_id. When you do, this server control
uses the calendar passed as a URL parameter. To exclude this function, choose NoneUse Default. Only Calendars with sourcetype=SystemCalendar may be used in the
querystring for this value. For example, where DyanamicParameter=”calendar_id”,
the URL may read http://mysite.com/calendar.aspx?calendar_id=”55”. In this
case, calendar 55 must be of the SystemCalendar type.

l

Hide (Boolean)
Hides or displays the output of the control in design time and run time.

l

o

True—Hide the control output.

o

False—Display the control output.

Language (Integer)
Set a language for viewing content; shows results in design-time (in Visual Studio) and
at run-time (in a browser).

l

SuppressWrapperTags (Boolean)
Suppresses the output of the span/div tags around the control.

l

o

True—Suppress wrap tags.

o

False (default)—Allow wrap tags.

WrapTag (String)
Lets a developer specify a server control’s tag.
o
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o

Div—apply attributes to a block of code.

o

Custom—Lets you use a custom tag.

The following list shows properties set inside the <DataSource> <CalendarDataSource> tag.
l

backColor (String)
The background color of the calendar event. If you set this value to AutoSelect, the
next available color in the list is chosen automatically.

l

defaultId (String)
The Id of the SystemCalendar, GroupCalendar or UserCalendar to display on the Web
page. For more information about using this property, see Combining Web Calendars
(Mashups) on page 530.

l

queryParam (String)
The parameter that may be in the query string to mash-up additional calendars. This can
be any Calendar SourceType. For example, if the value is set to uid, then the
querystring can be:
.../calendar.aspx?calendar_id=”55”&uid=”440”
For more information about using this property, see Combining Web Calendars
(Mashups) on page 530.

l

sourceType (String)
Choices are SystemCalendar, GroupCalendar, UserCalendar. See Also: Combining
Web Calendars (Mashups) on page 530
NOTE: The CategoryID property set inside the <DataSource> <CategoryID> tag is used to
identify taxonomy categories to filter calendar events. See Also: Server Control Reference on
page 1636

Web Search
The Web Search server control is deprecated from the Visual Studio tools in Ektron versions
8.5 and higher. Ektron changed this server control to maintain backwards compatibility. So,
pages created in previous releases that use the Web Search server control will work without
modification.
For new pages, developers are encouraged to replace the Web Search server control Search
templated server controls. See Also: Using Search Server Controls on page 971

XMLSearch Server Controls
XMLSearch server controls display a Smart Form's fields on a search page. A site visitor can
use the fields to search for Smart Form content. See Also: Using Search Server Controls on
page 971
IMPORTANT: Only fields marked Indexed appear on the form (see image below).
Also, you cannot search a Smart Form field if its entire xpath exceeds 64 characters. See Also:
Specifying Which XML Elements are Indexed on page 442
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Inserting Search Server Controls
See Inserting Site Search Server Controls on page 1836

XMLSearchController

The XMLSearchController server control takes input from a XMLSearchInputView control, and
returns results to a XMLSearchResultsView control. It provides an interface to the search API,
thereby giving SearchView controls access to search data.
You can modify Ektron's XMLSearchController or write your own.
The XMLSearchController executes a search using a query string from the
XMLSearchInputView control's Text property, as specified in the code-behind's Onclick
event.
Unlike the other search controls, XMLSearchController has no UI functionality. So, there is no
corresponding .ascx file.
Use only one XMLSearchController per page.
Properties
l

ID (Required)—provides the association for the SiteSearchInputView and
SiteSearchResultsView server controls. Here is an example of the ID property with the
SiteSearchController.
<ektron:SiteSearchController ID="SiteSearchController1"
runat="server" />

l

AdvancedQueryText (Optional)—see Displaying Search Results Using a ListView
Control on page 1842

XMLSearchInputView
The XMLSearchInputView server control displays a Smart Form's fields and lets users search
on them.
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IMPORTANT: Only fields marked Indexed appear on the form (see image below).
Also, you cannot search a Smart Form field if its entire xpath exceeds 64 characters. See Also:
Specifying Which XML Elements are Indexed on page 442

Because XML fields have a type (for example, string, date, choice, integer, boolean), the
template is dynamic and connected to a Smart Form’s data structure.

The Search Model for XML Smart Forms
The Search Model gets bound to (that is, determines) the view. When viewing the Search
Model in the object browser, you see a property named Fields, which is a list of each XML
Smart Form field.
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To view the Search Model for XML Smart Forms, insert XMLField into the Object Browser.
The class consists of a...
l

Label—friendly name

l

Name—internal smart form name

l

Xpath—path to field in Smart Form

XML Smart Form search controls use these fields to retrieve and display Smart Form content.
As explained in Using Data Field Types on page 442, there are many types of Smart Form
fields. Each type has a subclass, which has a corresponding user control, an .ascx template
file. User controls are located in C:\Program Files
(x86)\Ektron\CMS400vversion\workarea\FrameworkUI\Templates\Search\Fields. As
explained in Modifying the Default Markup on page 973, to change a control's default markup,
modify its template.
Smart Form field controls receive an XML field and cast it into the specified field type. For
example, the Object Browser shows that the ChoiceField template (ChoiceField.ascx)
contains a
l

List of possible choices

l

Selected value—the current selection

l

Selection Mode—select one or many

The ChoiceField template receives an XML field and casts it into a choice field.

Creating your own XML Search Template
PREREQUISITE
You have an understanding of the structure of XML field types, as explained in The
Search Model for XML Smart Forms on the previous page.
1. Bind fields to a list view.
<ektron:XmlSearchInputView ID=”xmlSearchView” runat=”server”
ControllerID=”SearchController” XMLConfigId=”10”>
<ItemTemplate>
<asp:ListView ID=”fields” DataSource=’<%# Eval(“Fields”) %>’
runat=”server”>

NOTE: The DataSource is the field's array returned from the SearchModel.
2. Insert a set of <ItemTemplate> tags.
<ektron:XmlSearchInputView ID=”xmlSearchView” runat=”server”
ControllerID=”SearchController” XMLConfigId=”10”>
<ItemTemplate>
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<asp:ListView ID=”fields” DataSource=’<%# Eval(“Fields”) %>’
runat=”server”> </ItemTemplate>

3. Get an XML field and display its corresponding template. Because it does not specify
which type of XML Smart Form field is being retrieved, use an XMLSearchField control to
determine that.
The XMLSearchField control has a Field property, which maps the control to the correct
template in the \workarea\FrameworkUI\Templates\Search\Fields folder. For
example, a boolean Smart Form field is mapped to booleanfield.ascx.
<ektron:XmlSearchInputView ID=”xmlSearchView” runat=”server”
ControllerID=”SearchController” XMLConfigId=”10”>
<ItemTemplate>
<asp:ListView ID=”fields” DataSource=’<%# Eval(“Fields”) %>’
runat=”server”>
</ItemTemplate>
<ItemTemplate>
<ektron:XmlSearchField ID="uxField" runat="server" Field='<%#
Container.DataItem %>'>
</ektron:XmlSearchField>
</ItemTemplate>

The XMLSearchField control lets you manage the display of XML Smart Form fields
displayed in the ListView. So, you can modify the search input form with effects like the
<ItemSeparatorTemplate>, which lets you place text, images, and so on, between each
field.

Customizing the Rendering of a Field
You can customize the behavior of an XML Smart Form field on the input form.
This is a complex procedure because, when a user clicks Search, your template must
retrieve the modified fields, pass that data to the containing template which, in turn, passes
the modified fields to the Search API. Use 2-way data binding to perform this procedure.
PREREQUISITE
You followed the steps in Creating your own XML Search Template on the previous
page.
1. Inside your XML Smart Form template, press Enter after Field='<%#
Container.DataItem %>'>.
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2. Insert a less than symbol (<). A drop-down list of Smart Form field types appears.

3. To replace the value of any field type, insert the corresponding Template field. For
example, to replace a text element, click TextTemplate to insert a set of
<TextTemplate> tags. Whatever you enter between the tags replaces the text template
on the Smart Form input form.
For example, to replace a text template field with a text box, use the following syntax.
<TextTemplate>
<asp:TextBox ID="aspValue" Text='<%# Bind("Value") %>'
runat="server" </asp:TextBox></TextTemplate>

Notice that this example uses Bind, which is a two-way statement. If the user changes the
value in the text box, then posts back, the Bind command pushes the data into the template.
The child template then takes the modified data from the template and pushes it back to the
data object.
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Extensions are developer-defined software modules that modify the behavior of Ektron. In
versions previous to 8.0, developers used the Plug-in Extension Wizard to extend the system.
In versions 8.0 and higher, Extensions are preferred over the Plug-in system.
The benefits of Extensions include:
l

l
l

l
l

You have full access to the Web application context, the HTTP context, the session
information, data stored in cache, and APIs.
API access means more functionality is available, such as the Notification system.
Easy to debug because you can attach and set breakpoints in the same way you debug
Web applications.
Enhanced performance because no Web Services are required.
No Windows Services are required, because Extensions run in the context of your Web
application.

This section also contains the following topics.
Event Handlers
Using Visual Studio to Create a New Extension
Register the New Extension in the ObjectFactory
More Information about ObjectFactory objectStrategies
Test the New Extension
More Examples of Extensions
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Event Handlers
An event is an activity that occurs within Ektron and is exposed through the Extension
Framework. An event handler is a method that executes when an event occurs.
Extensibility strategies and events
NOTE: onBefore lets you manipulate the current data before it is updated. In contrast, onAfter
events do not let you change a value in the contentData object for the content being affected. onAfter
events only update data somewhere else (such as within Ektron or a third party database).
Class and Events
Ektron.Cms.Extensibility.CommunityGroupStrategy
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Class and Events
l

l

l

l

l

OnAdd(Ektron.Cms.CommunityGroupData, Ektron.Cms.Extensibility.CmsEventArgs)—called
after a new Community Group is added.
OnAfterUserAdd(long, long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a user is
added to a Community Group.
OnAfterUserDelete(long, long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a user is
removed from a Community Group
OnDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a Community Group is
deleted.
OnUpdate(Ektron.Cms.CommunityGroupData, Ektron.Cms.Extensibility.CmsEventArgs)—called
after a Community Group is updated.

Ektron.Cms.Extensibility.ContentStrategy
l

l

l

l

l

l

l

l

OnAfterAddContent(Ektron.Cms.ContentData, Ektron.Cms.Extensibility.CmsEventArgs)—
called after new content is added.
OnAfterDeleteContent(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after content is
deleted.
OnAfterPublishContent(Ektron.Cms.ContentData, Ektron.Cms.Extensibility.CmsEventArgs)—
called after content is published.
OnAfterUpdateContent(Ektron.Cms.ContentData, Ektron.Cms.Extensibility.CmsEventArgs)—
called after content is saved.
OnBeforeAddContent(Ektron.Cms.ContentData, Ektron.Cms.Extensibility.CmsEventArgs)—
called before content is added.
OnBeforeDeleteContent(long, Ektron.Cms.Extensibility.CmsEventArgs)—called before content
is deleted.
OnBeforePublishContent(Ektron.Cms.ContentData,
Ektron.Cms.Extensibility.CmsEventArgs)—called before content is published.
OnBeforeUpdateContent(Ektron.Cms.ContentData, Ektron.Cms.Extensibility.CmsEventArgs)—
called before content is saved.

Ektron.Cms.Extensibility.FolderStrategy
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Class and Events
l

l

l

l

l

l

OnAfterAddFolder(Ektron.Cms.FolderData, Ektron.Cms.Extensibility.CmsEventArgs)—called
after a new folder is added.
OnAfterDeleteFolder(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a folder is
deleted.
OnAfterUpdateFolder(Ektron.Cms.FolderData, Ektron.Cms.Extensibility.CmsEventArgs)—
called after folder is updated.
OnBeforeAddFolder(Ektron.Cms.FolderData, Ektron.Cms.Extensibility.CmsEventArgs)—called
before a folder is added.
OnBeforeDeleteFolder(long, Ektron.Cms.Extensibility.CmsEventArgs)—called before a folder is
deleted.
OnBeforeUpdateFolder(Ektron.Cms.FolderData, Ektron.Cms.Extensibility.CmsEventArgs)—
called before changes to a folder are saved.

Ektron.Cms.Extensibility.MessageBoardStrategy
l

l

l

l

l

OnAdd(Ektron.Cms.MessageBoardData, Ektron.Cms.Extensibility.CmsEventArgs)—called after
new Message Board item/post is added.
OnAfterReplyAdd(Ektron.Cms.MessageBoardData, Ektron.Cms.Extensibility.CmsEventArgs)—
called after someone replies to Message Board post.
OnDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a Message Board post is
deleted.
OnMessageApprove(Ektron.Cms.MessageBoardData,
Ektron.Cms.Extensibility.CmsEventArgs)—called before Message Board post is approved.
OnUpdate(Ektron.Cms.MessageBoardData, Ektron.Cms.Extensibility.CmsEventArgs)—called
after Message Board post is updated.

Ektron.Cms.Extensibility.MicroMessageStrategy
l

l

l

l

OnAfterAdd(Ektron.Cms.MicroMessageData, Ektron.Cms.Extensibility.CmsEventArgs)—called
after new Micro Message post is added.
OnAfterDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a Micro Message
post is deleted.
OnBeforeAdd(Ektron.Cms.MicroMessageData, Ektron.Cms.Extensibility.CmsEventArgs)—
called before a Micro Message post is added.
OnBeforeDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called before a Micro Message
post is deleted.

Ektron.Cms.Extensibility.TagStrategy
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Class and Events
l

l
l

OnAdd(Ektron.Cms.TagData, Ektron.Cms.Extensibility.CmsEventArgs)—called after Tag is
added.
OnDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a Tag is deleted.
OnUpdate(Ektron.Cms.TagData, Ektron.Cms.Extensibility.CmsEventArgs)—called after a Tag is
updated.

Ektron.Cms.Extensibility.TaxonomyStrategy
l

l

l

l

l

l

l

l

OnAfterAdd(Ektron.Cms.TaxonomyData, Ektron.Cms.Extensibility.CmsEventArgs)—called after
a new Taxonomy is added.
OnAfterAssignItem(Ektron.Cms.TaxonomyRequest,
Ektron.Cms.Extensibility.CmsEventArgs)—called after a Taxonomy Item is added/assigned to
Taxonomy.
OnAfterDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after Taxonomy is deleted.
OnAfterUpdate(Ektron.Cms.TaxonomyData, Ektron.Cms.Extensibility.CmsEventArgs)—called
after a Taxonomy is updated.
OnBeforeAdd(Ektron.Cms.TaxonomyData, Ektron.Cms.Extensibility.CmsEventArgs)—called
before a new Taxonomy is added.
OnBeforeAssignItem(Ektron.Cms.TaxonomyRequest,
Ektron.Cms.Extensibility.CmsEventArgs)—called before Taxonomy item is added/assigned to
Taxonomy.
OnBeforeDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called before a Taxonomy is
deleted.
OnBeforeUpdate(Ektron.Cms.TaxonomyData, Ektron.Cms.Extensibility.CmsEventArgs)—called
before a Taxonomy is updated.

Ektron.Cms.Extensibility.UserStrategy
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Class and Events
l

l

l

l

l

l

l

l

l

l

OnAfterAddColleague(long, long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a
colleague/friend is added.
OnAfterAddUser(Ektron.Cms.UserData, Ektron.Cms.Extensibility.CmsEventArgs)—called after
a new user is added.
OnAfterColleagueRequest(Ektron.Cms.Community.ActionRequestData,
Ektron.Cms.Extensibility.CmsEventArgs)—called after a colleague/friend request is sent.
OnAfterDeleteUser(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a user is
deleted.
OnAfterLogin(Ektron.Cms.UserData, Ektron.Cms.Extensibility.CmsEventArgs)—called after a
user logs in.
OnAfterUpdateUser(Ektron.Cms.UserData, Ektron.Cms.Extensibility.CmsEventArgs)—called
after a user is updated.
OnBeforeAddUser(Ektron.Cms.UserData, Ektron.Cms.Extensibility.CmsEventArgs)—called
before a new user is added to CMS.
OnBeforeDeleteUser(long, Ektron.Cms.Extensibility.CmsEventArgs)—called before a user is
deleted from CMS.
OnBeforeLogin(Ektron.Cms.UserData, Ektron.Cms.Extensibility.CmsEventArgs)—called before
a user logs in.
OnBeforeUpdateUser(Ektron.Cms.UserData, Ektron.Cms.Extensibility.CmsEventArgs)—called
before a user is updated.

Ektron.Cms.Extensibility.WebEventStrategy
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Class and Events
l

l

l

l

l

l

l

l

l

l

l

OnAfterAdd(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called after a new Web calendar event is added
OnAfterAddVariance(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called after a Web calendar event variance is added.
OnAfterCancelOccurrence(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called after a single occurrence of Web calendar event
(recursive event) is cancelled.
OnAfterDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called after a Web calendar event
is deleted.
OnAfterPublish(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called after a Web calendar event is published.
OnAfterUpdate(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called after a Web calendar event is updated.
OnBeforeAdd(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called before a new Web calendar event is added.
OnBeforeAddVariance(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called before a Web calendar event variance is added.
OnBeforeCancelOccurrence(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called before a single occurrence of a Web calendar
event (recursive event) is canceled.
OnBeforeDelete(long, Ektron.Cms.Extensibility.CmsEventArgs)—called before a Web calendar
event is deleted.
OnBeforePublish(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called before a Web calendar event is published.
OnBeforeUpdate(Ektron.Cms.Common.Calendar.WebEventData,
Ektron.Cms.Extensibility.CmsEventArgs)—called before a Web calendar event is updated.

Using Visual Studio to Create a New Extension
1. In Visual Studio, open your website.
2. Add a new C# class to the App_Code directory.
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3. The Class1.cs code page appears in the editor.

4. Add references to the following assemblies if they are not already added.
Ektron.CMS.Common
Ektron.CMS.Contracts
Ektron.CMS.ObjectFactory

If the assemblies are not installed in Visual Studio, you can find them in the
siteroot/bin directory.
5. Add the following using statements to the top of the class.
using
using
using
using

Ektron.Cms;
Ektron.Cms.Common;
Ektron.Cms.Extensibility;
Ektron.Cms.Extensibility.Content;

6. Update the class to extend Ektron.Cms.Extensibility.ContentStrategy.
namespace Cms.Extensions.Samples { public class ContentExtensionsSample :
ContentStrategy { } }

NOTE: The namespace in the code above is Cms.Extensions.Samples. This information is needed
for Step 8.
7. Override the method for the event you wish to catch. In this example, override
OnBeforeAddContent(). The code to modify the Title looks like this.
public override void
OnBeforeAddContent(ContentData contentData, CmsEventArgs eventArgs)
{ contentData.Title += " modified"; }

8. This is what the final code looks like.
using System;
using System.Collections.Generic;
using System.Text;
using Ektron.Cms;
using Ektron.Cms.Common;
using Ektron.Cms.Extensibility;
using Ektron.Cms.Extensibility.Content;
namespace Cms.Extensions.Samples
{
public class ContentExtensionsSample : ContentStrategy
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{ public override void
OnBeforeAddContent(ContentData contentData, CmsEventArgs eventArgs)
{ contentData.Title += " modified"; }
}
}

Register the New Extension in the ObjectFactory
After creating the extension in the steps above, register it in the
<webroot>/ObjectFactory.config file.
This file already contains GoogleGeoCoder objectStrategies, so you need to add a new Name
in the Content area. In this example, the code looks like this.
<objectFactory>
<objectStrategies>
<add name="Content">
<strategies>
<add name="MyFirstExample"
type="Cms.Extensions.Samples.ContentExtensionsSample"/>
<add name="GoogleGeoCoder"
type="Cms.Extensions.GoogleGeoCoder.ContentStrategy"/>
</strategies>
</add>
<add name="User">
<strategies>
<add name="GoogleGeoCoder"
type="Cms.Extensions.GoogleGeoCoder.UserStrategy"/>
</strategies>
</add>
</objectStrategies>
</objectFactory>

More Information about ObjectFactory
objectStrategies
l

l

Register extensions in the <objectStrategies> element of the
siteroot/ObjectFactory.config file.
For the element directly below <objectStrategies>, <addname>, enter a name to
identify extension type. A list of valid names is in the following table.
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List of Valid Names
l

Inventory

l

Basket

l

Coupon

l

Blog

l

Order

l

Content

l

Customer

l

Folder

CatalogEnt
ry

l

User

l

Forum

l

l

l

l

BasketCalc
ulator
CouponCalc
ulator
ShippingCal
culator
TaxCalculat
or

l

l

l
l

l

Country

l

Region

Community
Group
Tag
MessageB
oard

l

l

l

MicroMe
ssage

WebEve
nt
Taxonom
y

l

l

Within a <strategies> element, add one or more content extensions. For each
extension, insert a name and type. For example:
<strategies>
<add name="MyFirstExample"
type="Cms.Extensions.Samples.ContentExtensionsSample"/>
</strategies>
o

name is free-text.

o

Type is a fully-qualified name of the extension you are registering. It consists of
namespace + “.” + name of the class.

Test the New Extension
The new extension (created in the examples above) adds "modified" to the end of a new
content item's title. To test this, create new content in the Workarea; "modified" will be
appended to the end of the title.

More Examples of Extensions
More examples of Extensions are found in the Ektron SDK folder. The default location for this
folder is Program Files\Ektron\CMS400SDK\CMS Extensions. Also, sample eCommerce
extensions are found in Program Files\Ektron\CMS400SDK\Commerce\Events.
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Ektron provides a Windows Service to handle background processing functions. This section
explains the service, including
l

functions it performs

l

how it propagates updates to the connection string and site path

l

where it resides in IIS and the file system

l

its activity log

This section also contains the following topics.
Functions Performed by the Ektron Windows Service
Changing the Update Time
Disabling PDF Generation
Viewing the Ektron Windows Service

1878
1878
1878
1879

Functions Performed by the Ektron Windows
Service
The Ektron Windows Service performs the following processes.
l

Balancing the Load on Your Servers on page 89

l

Working with Assets in the Document Management System on page 310

l

Bad Link Report on page 584

l

l

Publication of content scheduled to go live at a future time, and removal of content
scheduled to expire. See Scheduling Content on page 296.
When a new metadata definition is created, the Windows service applies it to all content
in the Ektron database. However, the metadata definition is only activated for the
content when it is enabled for the content’s folder. See Also: Working with Metadata on
page 369

In addition, the Ektron Windows Service propagates updates made to the database connection
string or the site path in the web.config file. The service copies the new value to the
data.config and sitedb.config files (respectively). These are located in C:\Program
Files\Ektron\EktronWindowsservice40. Any Ektron components that reference these
values can retrieve the current information from these files.
WARNING! Do not edit the data.config and sitedb.config files. They are dynamically generated by
Ektron. If these files have incorrect values, edit the web.config file, which is used to generate them.

Changing the Update Time
The update of the data.config and sitedb.config files occurs once a day at a time prescribed in
the C:\Program
Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices.exe.config file’s
updateTime value. If desired, you can change this time.

Disabling PDF Generation
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By default, PDF generation is enabled. To disable it within the Ektron Windows Services
configuration file:
1. On the server to which you installed Ektron, open C:\Program
Files\Ektron\EktronWindowsService40.
2. Open Ektron.ASM.EktronServices40.exe.config.
3. Find this line:
<add name="PdfFileRead"
type="Ektron.ASM.EktronServices.PdfFileManagerRead.PdfFileManagerReadServ
ice, Ektron.ASM.EktronServices40" IntervalSeconds="101" Enabled="true" />
4. Set enabled to false.

Viewing the Ektron Windows Service
This section also contains the following topics.
Viewing in IIS
The Activity Log
Viewing in the File System

1879
1880
1880

Viewing in IIS
The Windows Service starts automatically when Ektron is installed, and again whenever the
server is restarted.
1. To see the status of the service, go to Computer Management > Services and
Applications > Services.
2. Look for Ektron Windows Services. You can see its status in the Status column.
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The Activity Log
The service has an Activity Log, which tracks all related events. To see it, go to Computer
Management > System Tools > Event Viewer > Ektron Log.

To view detail for any event, double click it.
A common source of errors is that the service cannot find Ektron sites, because they have not
been created yet, as shown in the sample below.

Viewing in the File System
On your file system, the Ektron Windows Service is located in C:\Program
Files\Ektron\EktronWindowsservice40. Within that folder, the
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Ektron.ASM.EktronServices.exe.config file runs the Ektron Windows service.
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This section also contains the following topics.
How the Diagnostics Utility Works
Installing the Diagnostics Utility
Accessing the Diagnostics Utility
Information Provided by the Diagnostics Utility
Exporting and Viewing Saved Diagnostic Information

1884
1884
1885
1886
1895

Ektron's Diagnostics Utility provides comprehensive information about you network's servers
that are related to the website to which you are logged on. (An Ektron network consists of
your Ektron server, connected database servers, and other servers with which your website
has an Synchronizing Servers Using eSync on page 1473 or Load Balance relationship.)
The utility gives you and Ektron's support staff a real-time snapshot of all servers in the
network, and includes the following for each node.
l

status of all services

l

version information for Windows, SQL, IIS, Visual Studio, and so on

l

event log

l

database connection status, test query, server, and so on

l

for each server: drive capacity and available space; available memory, and so on

l

eSync information, such as remote certificates for this server

NOTE: Most Diagnostics fields are read-only. The utility lets you perform only a few actions.
The following video provides additional information about the Diagnostics Utility: The Making
of Ektron eSync Diagnostics
This section explains what you need to know about the Diagnostics Utility: how to install it,
the information it provides, and how to "capture" its current state. You can save the captured
files for comparison with previous and future versions, and send them to Ektron's support
staff for diagnosis.

How the Diagnostics Utility Works
1. The Diagnostics Utility uses a Workarea Web service that is installed to the Ektron
server. This service runs independently of the Ektron Windows Service and your Ektron
website.
2. That Web service routes requests to the Ektron Diagnostics Service.
3. The Ektron Diagnostics Service collects diagnostic information from the database,
website files, and other locations like the event log. It also scans for other known Web
servers (eSync servers, load balance servers, and multi-site servers).
4. If any other servers are found, the Diagnostics Windows Service opens a connection to
the destination server's Diagnostics service. The Diagnostics Service uses the same port
as the Ektron Windows service.
5. The Ektron Diagnostics Service returns the collected data to the Silverlight viewer, which
dynamically builds the network that appears on the screen.

Installing the Diagnostics Utility
1884
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An opportunity to install the Diagnostics Utility appears during the installation or upgrade of
Ektron(see Diagnostic Utility checkbox).

If Diagnostic Utility is not checked during installation, you can install it by going to
Windows Start button > All Programs > Ektron > CMS400vxx > Utilities > Ektron
Diagnostic Utility.
Install the utility to every website and server in your Ektron network. This includes Ektron
Web servers, as well as servers used in Load Balance and eSync configurations.
You do not need to install the utility on client workstations.
The Diagnostics Utility installs the following files on each server.
l

web.config file additions

l

the Ektron Diagnostics Windows service

NOTE: If the Diagnostics Utility is not installed on a server, a node for that server appears, but
information about it is not available in the lower section of the screen, and additional relationships are not
visible.
For example, you have an eSync relationship between development and staging servers, and between
staging and production servers. If the Diagnostics Utility is installed on the development server but not on
staging, and you view the network from the development Workarea, you see nodes for development and
staging, but not production. You can view details for development, but not staging.

Accessing the Diagnostics Utility
PREREQUISITES
l

You are a member of the Ektron Administrator's group
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l

l

The Diagnostics Utility was installed on every server with which your website has
an eSync or Load Balance relationship
The Diagnostics Utility requires Silverlight 4. If a client does not have it, you are
prompted to install it before you can view the screen.

Access the Diagnostics Utility from the Workarea, by going to Settings > Configuration >
Diagnostics.

Information Provided by the Diagnostics Utility
The Diagnostics screen consists Ektron network nodes connected by lines that indicate
relationships. Use the slider on the right side to adjust the zoom level.

You may drag the nodes around for easier viewing.
This section also contains the following topics.
Connecting Lines on the Diagnostics Screen
Network Node Icons
Bandwidth Test
Analysis
Details in the Lower Section of the Diagnostics Utility
Basic Diagnostics
Server Details
Sync Certificates
Sync Scope
Site Details
Service Status
Assets

1886
1887
1887
1888
1889
1889
1891
1892
1893
1894
1894
1895

Connecting Lines on the Diagnostics Screen
A connecting line's color indicates the type of relationship that exists between nodes.
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l

Blue—eSync
The arrowhead direction indicates the direction of the profiles. For example:

l

o

no arrowheads—no profiles

o

2 arrowheads—one upload and one download profile exists between servers

Red—Database server
Appears even if the database resides on the same server with Ektron.

l

Green—Load balance

l

Teal—Multi-site

Network Node Icons
This section describes icons that may appear within a network node.

l

l

l

l

l

l

Analysis— Reports server's installed memory, available memory, and available
disk space. Click the icon for more information. See Also: Analysis on the next page
Bandwidth test—Reports speed of server's connections. Click the icon for more
information. Bandwidth Test below
Refresh—For selected node, load or reload Details in the Lower Section of the
Diagnostics Utility on page 1889. Click the icon for more information.
Warning—When hovered over, displays a warning about the node. For example, if
your database resides on an Ektron server, you are advised to move the database to its
own server.
Web server—Hosts Ektron.

Database—Hosts MS SQL Server.

Bandwidth Test
Ektron 8.7
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You can run a bandwidth test between any 2 network nodes. The test checks the speed of
the selected server's connections. To accomplish this, the test sends a 32 MB file in both
directions then reports the transfer time.
Before

After

As an example of when you would conduct a bandwidth test, assume it takes a long time to
sync a production server with a staging server. Use a bandwidth test to diagnose the problem.

Analysis
The Analysis function reports a selected server's installed memory, available memory,
and available disk space.
Each item is assigned a status of critical, warning, and OK. By default, the items are sorted in
that order. To change the sort order, click the Severity column header.
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Details in the Lower Section of the Diagnostics Utility
The lower section of the Diagnostics Utility screen provides a wealth of information about
your Ektron network.

The tabs across the top indicate main areas of interest.

Basic Diagnostics
IMPORTANT: The Diagnostics screen runs as a Windows Service. So, that service must have
administrator access to perform the tests and retrieve the necessary information.
The basic diagnostics screen has several subtabs:
l

Basic Connectivity—Displays server name, site URL, connection string, paths to site,
workarea, assets, private assets, uploaded files and images, asset library
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l

Version—Installed version of Ektron, Windows service, IIS, Visual Studio

l

License—License key, status, expiration date, enabled features, maximum users

l

Settings—Active Directory, SMTP port, and DMS settings

l

l

l

Database—Connection status, Test query, SQL version, Database server, Database
name, Integrated Security (true/false).

Connections—Status of the following services:
o server controls Web service
o

content Web service

o

content service

o

indexing service

o

Windows services 2.0, 3.0, and 4.0

Security—Information for the 10 default accounts installed with an Ektron sample site.
o if user exists
o

if default password was changed

See Also: Securing Ektron on page 51
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l

Permissions—User permission settings for these DMS folders:
n asset library\servername\site name
n

\siteroot\assetmanagement\dmdata

n

\siteroot\assets

See Also: Checking Document Management Permissions on page 326

l

Events—The Windows Event Log
o each event includes: event, event type, time of occurrence, description, source
o

l

sorted by log name

Authentication—Active Directory and LDAP settings
See Also: Using Active Directory with Ektron on page 1127, Using LDAP with Ektron on
page 1151

Server Details
The Server Details tab provides information about the selected server.
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The tab displays the following information.
l

Server index

l

Share index

l

Server time (UTC)

l

OS architecture (32 or 64 bit)

l

Number of Processors

l

CLR Version

l

OS version

l

Memory: total, available, current process usage

l

System storage: for each drive, the capacity and available space in megabytes

l

Site databases: name, Maximum size, location, size and type

l

Your website's asset server: callback URL, ID, date modified, and so on.

Sync Certificates
Use this tab to view the site's encoded eSync certificate, copied from the web.config file.

The tab also displays all remote certificates for this server. Checks in the lower section
indicate the presence of certificate files on all servers. See Also: Managing eSync Security
Certificates on page 1521
NOTE: The tab does not indicate if the certificates on the servers in the sync relationship match.
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Sync Scope
The Sync Scope tab retrieves details from the serverinfo.xml file. The tab also shows
information about saved eSync profiles. See Also: Setting up eSync Profiles on page 1512

Here is an example of what appears when you click View Child Profiles.

The bottom section of the Sync Scope tab shows information for the eSync Logs. See Also:
Viewing eSync Activity on page 1546
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Site Details
The Site Details tab shows Files over 100 MB in the site below and the Knowledge and
Metadata Files Screen below.

Files over 100 MB in the site
This tab highlights website files that exceed 100 MB. Files of this size may cause problems
when synching or Load Balancing. This tab makes it easy to locate such files.

Knowledge and Metadata Files Screen
Use this section to view eSync Knowledge and Metadata files, which can be used to
troubleshoot problems with eSync relationships.
Legend for the Knowledge and Metadata Files Screen
l

Gray circle—no files to view

l

Green circle—you can view files under that server and its folders

Service Status
The Service Status tab provides information about EWS (Ektron Windows Service). It also lets
you stop and start the service. See Also: Ektron Windows Service on page 1877

This screen tells you
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l

how much memory the service is using

l

the user account under which it runs

l

its status

l

the name, address, and status of each internal Web service that EWS is running

Assets
The Assets tab display a recursive list of assets under each folder.

Exporting and Viewing Saved Diagnostic
Information
You can easily "capture" the current Diagnostic information. The captured files can be saved
for comparison with previous and future versions, and sent to Ektron's Support staff for
diagnosis.
The export file collects all information described in Details in the Lower Section of the
Diagnostics Utility on page 1889 from each server. The file also includes a copy all
configuration files and logs for all servers in your website's network. This information is
packed into a .zip file for easy storage and transfer.
To capture Diagnostics information, click Export Map.
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Contents of the .Zip File
Inside the .zip file are
l
l

1896

other zipped files, which contain the captured config files and log files.
a NetworkMap.ekd file. This file may be loaded in the Diagnostic utiilty, in the Silverlight
viewer, or in a text editor, such as Notepad (the saved data is XML.) See Also: View an
Exported Map on the facing page
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View an Exported Map

The values of all files are those that existed when you clicked the Export Map button.

View an Exported Map
PREREQUISITE
The location of the exported map file on your computer. The file's name is
DiagExportdate-time.zip.
1. From the Workarea, go toSettings > Configuration > Diagnostics > Load Save
button.
2. Navigate to the saved DiagExportdate-time.zip file.
3. Click Open.
4. Click any node to view its information.
NOTE: You can also use the
C:\Program Files\Ektron\EktronDiagnosticsService\Tools\EktronDiagnosticsWPF.exe to view a
networkmap.ekd file.

Ektron 8.7

1897

(This page intentionally blank.)

39

Targeting Content with
GeoIP Information

Ektron Reference

1899

Targeting Content with GeoIP Information

GeoIP support lets you target your messaging to specific audiences based on current
geographical location. Ektron uses a site visitor’s IP address to detect the location.
Ektron maintains GeoIP information in a cookie while visitors use the site. When they exit,
Ektron deletes the cookie.
For example, your eCommerce website is having a special on snow blowers. That information
is relevant to people in Northern climates but of no interest to those living in the tropics. As
another example, a site visitor uses a cell phone to find the nearest store location. In this
case, Ektron Map server control displays a map of nearby stores based on the user's current
latitude and longitude.
This section also contains the following topics.
IP Address Location Information
Choosing a GeoIP Database
Using GeoIP Information in Ektron

1900
1901
1901

IP Address Location Information
Ektron obtains the following information from the IP address of your site visitors. (Values are
examples.)
l

IP Address—208.32.120.10

l

Country code and name—United States

l

Region—NH (New Hampshire)

l

US area code—603

l

US metro code—506

l

City—506

l

US zip code—Nashua

l

Latitude and longitude—42.7551/-71.4853

l

Organization—Sprint

l

Domain name—www.example.com

Retrieving IP Address Information
Ektron retrieves the IP address information from a site visitor's IP address via 3 databases.
The databases are installed to your site root's App_data folder and listed in your site's
web.config file.
l

<!-- GeoIP City Database -->
<add key="GeoIpCityDatabase" value="~/App_Data/GeoLiteCity.dat"/>
Returns the following information, based on IP address:

1900

o

Area code

o

City

o

US State

o

Country code and name

o

Latitude and Longitude
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l

o

MetroCode

o

PostalCode

o

Telephone area code

<!-- GeoIP Organization Database -->
<add key="GeoIpOrgDatabase" value="~/App_Data/GeoIPOrg.dat"/>
Returns the organization name, based on IP address.

l

<!-- GeoIP Domain Database -->
<add key="GeoIpDomainDatabase" value="~/App_Data/GeoIPDomain.dat"/>
Returns the domain name, based on IP address.

If you want to move the databases to another folder, you must update their web.config
value elements to the new location.
NOTE: The tilde character (~) in the value element represents the site root folder.
BEST PRACTICE
You should keep the GeoIP databases in the App_data folder, since this folder
prevents unauthorized copying of the database.

Choosing a GeoIP Database
Ektron includes GeoLite data created by MaxMind. You can purchase more accurate GeoIP
databases from MaxMind.

Using GeoIP Information in Ektron
The following Ektron components provide access to GeoIP information.
l

Using GeoIP Information in the Targeted Content Widget below

l

Using GeoIP Information in the Map Server Control on the next page

l

Accessing GeoIP Information via API on the next page

Using GeoIP Information in the Targeted Content
Widget
Among the Targeted Content widget's criteria is User Regional Info, which has 2 options:
Country and US Regions.

Ektron 8.7

1901

Targeting Content with GeoIP Information

If you choose US Regions, you can select from states in the United States.
User Regional Info data uses GeoIP information. See Also: Using Widgets on page 711

Using GeoIP Information in the Map Server Control
You can center a map on a specific location by using the Map server control's latitude and
longitude properties. You also can use GeoIP information to obtain a user's latitude and
longitude, based on IP address. For example, if a site visitor searches for a chain restaurant,
the map can indicate restaurants near the user.
The following code shows how to set up the Map server control to populate latitude and
longitude with GeoIP information.
Sample .aspx page, showing the placement of the Map server control.
<cms:Map ID="uxMap" runat="server" />

Code-behind page in C#
Ektron.Cms.UserLocationData userLocationData =
Ektron.Cms.UserContext.GetCurrentUserLocationInfo();
if(userLocationData != null)
{
uxMap.Latitude = userLocationData.Latitude;
uxMap.Longitude = userLocationData.Longitude;
}

See Also: Server Control Reference on page 1636

Accessing GeoIP Information via API

1902
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The following API code demonstrates the retrieval of a user's GeoIP information. Note that
Ektron.Cms.UserContext.GetCurrentUserLocationInfo() returns the
Ektron.Cms.UserLocationInfo() object, which provides access to all elements listed in
Retrieving IP Address Information on page 1900 except IP address.
To obtain IP address, use Ektron.Cms.UserContext.IP.
Ektron.Cms.UserLocationData userLocationInfo =
Ektron.Cms.UserContext.GetCurrentUserLocationInfo();
//If GeoIpCity.dat/GeoIpLiteCity.dat file is present in webconfig
int AreaCode = userLocationInfo.AreaCode;
string City = userLocationInfo.City;
string CountryCode = userLocationInfo.CountryCode;
string CountryName = userLocationInfo.CountryName;
double Distance = userLocationInfo.Distance(userLocationInfo);
int DMACode = userLocationInfo.DMACode;
double Latitude = userLocationInfo.Latitude;
double Longitude = userLocationInfo.Longitude;
int MetroCode = userLocationInfo.MetroCode;
string PostalCode = userLocationInfo.PostalCode;
string Region = userLocationInfo.Region;
string RegionName = userLocationInfo.RegionName;
// If GeoIpOrg.dat file and GeoIpCity.dat/GeoIpLiteCity.dat file
// is provided in web config
string Organization = userLocationInfo.Organization;
// If GeoIpDomain.dat and GeoIpCity.dat/GeoIpLiteCity.dat file
// is provided in web config
string Domain = userLocationInfo.Domain;
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The Ektron Markup Language (EkML) makes it easy for Web developers to manage the output
presentation of server controls. EkML uses a simple markup that resembles HTML in syntax.
The EkML is cached and .NET watches for file changes.
The MarkupLanguage property in the Ektron server controls and Ektron Dreamweaver
functions is used to select the template file that contains the Ektron Markup Language. This
language is made up of tags and variables that assign formatting information to a control or
function when displayed on a Web page.
IMPORTANT: If the markup template file is located in the same folder as the form that contains the server
control, just type the file’s name in the server control’s MarkupLanguage property. For example,
mycollectionmarkup.ekml. If the file is in another folder, enter the path relative to site root. For
example,
\CMS400Developer\workarea\customfiles\markup\mycollectionmarkup.ekml.

EkML Templates
Ektron, Inc. provides an EkML basic template for each control. These templates are located in
[webroot]/Workarea/Templates. At the top of each template is a list of variables that can be
used with that control.
WARNING! You should save the template under another name and use that template. This prevents your
file from being overwritten when upgrades occur.
NOTE: If you install the Developer site, .ekml template files reside in various project folders. These files
exemplify using the .ekml with a specific server control.

collection.ekml
This file defines which items and information are included when displaying content item
information in a collection using the Collection on page 1677 server control.

collection.ekml Variables
l

[$CollectionDescription] on page 1928—Display the collection’s description.

l

[$CollectionTitle] on page 1928—Display the collection’s title.

l

[$Comment] on page 1929—Displays the content’s comment information.

l

[$ContentId] on page 1930—Displays the content item’s ID.

l

[$DateCreated] on page 1930—Display the date the content was created.

l

[$DateModified] on page 1931—Display the date the content was last modified.

l

[$EditorFirstName] on page 1933—Display the last editor’s first name for a content item.

l

[$EditorLastName] on page 1933—Display the last editor’s last name for a content item.

l

[$FolderId] on page 1936—Display the folder ID of a content item.

l

[$Html] on page 1937—Display the HTML contained in the content item.

l

l

1906

[$HyperLink] on page 1937—Adds a hyperlink using the title of the content block as the
text.
[$Image] on page 1938—Displays the path for the image defined in a content item’s
Metadata. When wrapped in <img src=””/> tag, the image appears. For example: <img
src=”[$Image]”/>
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l

l

[$ImageIcon] on page 1938—Displays an image icon for the content item. For example,
if the content item is HTML, the () icon appears.
[$ImageThumbnail] on page 1938—Displays the path for the image’s thumbnail defined
in a content item’s Metadata. When wrapped in <img src=””/> tag, a thumbnail version
of the image appears. For example: <img src=”[$ImageThumbnail]”/>. See:

l

[$Index] on page 1938—Serialize the content items in a numbered list.

l

[$ItemCount] on page 1939—The total number of items in a list.

l

[$Language] on page 1939—Display the language ID for the content item.

l

l

l

l

l

l

l
l

l
l

l

[$LinkTarget] on page 1940—When added to an <a href=””> tag’s target=”” attribute,
this variable reads the server control’s LinkTarget property and uses its setting.
[$QuickLink] on page 1943—This property displays the Quicklink information for the
content item. When wrapped in an <a href=””> tag, you can create a Hyperlink.
[$SERVER_NAME] on page 1945—Displays the server name. For example, If this
variable is applied to
http://www.example.com/demo.aspx, the return is www.example.com.
[$ShowBubble(width,height)] on page 1947—This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and lets you set the width of the bubble.
[$ShowBubble] on page 1946—Calls the <ekbubbleinfo> tags and places the
information contained within those tags in a pop-up bubble.
[$ShowContent(‘htmltagid’)] on page 1948—Calls the <ekcontentinfo> tags an places
the information in those tags within the specified HTML tag ID. Replace the 'htmltagid'
with the ID of the tag.
[$Status] on page 1948—Displays the status of a content item.
[$Teaser] on page 1949—Display the content item’s summary information. If the item is
an HTML form, this variable is not supported with this ekml file.
[$Title] on page 1949—Displays the content item’s title.
[$UrlEncode(‘str’)] on page 1950—Encodes the string information. This variable can be
used to encode another EkML variable and place it in an email.
[$UrlParam(‘paramname’)] on page 1951—Displays the value of a query string’s
parameter. For example, if the query string is ?id=27 and the variable is [$UrlParam
(‘id’)], 27 appears.

contentlist.ekml
This file defines which items and information are included when displaying content item
information in a content list using the ContentList server control.

listsummary.ekml
This file defines which items and information are included when displaying content item
information in a list summary using the ListSummary on page 1756server control. For an
example of using this file with a ListSummary server control, see the Ektron demo example:
http://<your site>/CMS400Developer/Developer/ListSummary/TemplateMarkup.aspx.

ListSummary.ekml Variables
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l

[$Comment] on page 1929—Displays the content’s comment information.

l

[$ContentId] on page 1930—Displays the content item’s ID.

l

[$DateCreated] on page 1930—Display the date the content was created.

l

[$DateModified] on page 1931—Display the date the content was last modified.

l

[$EditorFirstName] on page 1933—Display the last editor’s first name for a content item.

l

[$EditorLastName] on page 1933—Display the last editor’s last name for a content item.

l

[$FolderDescription] on page 1935—Displays the folder’s description.

l

[$FolderId] on page 1936—Display the folder ID of a content item.

l

[$FolderName] on page 1936—Displays the folder’s name.

l

[$Html] on page 1937—Display the HTML contained in the content item.

l

l

l

[$HyperLink] on page 1937—Adds a hyperlink using the title of the content block as the
text.
[$Image] on page 1938—Displays the path for the image defined in a content item’s
Metadata. When wrapped in <img src=””/> tag, the image appears. For example: <img
src=”[$Image]”/>
[$ImageIcon] on page 1938—Displays an image icon for the content item. For example,
if the content item is HTML, the (

l

[$ImageThumbnail] on page 1938—Displays the path for the image’s thumbnail defined
in a content item’s Metadata. When wrapped in <img src=””/> tag, a thumbnail version
of the image appears. For example: <img src=”[$ImageThumbnail]”/>

l

[$Index] on page 1938—Serialize the content items in a numbered list.

l

[$ItemCount] on page 1939—The total number of items in a list.

l

[$Language] on page 1939—Display the language ID for the content item.

l

l

l

l

l

l

l
l

l
l
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) icon appears.

[$LinkTarget] on page 1940—When added to an <a href=””> tag’s target=”” attribute,
this variable reads the server control’s LinkTarget property and uses its setting.
[$QuickLink] on page 1943—This property displays the Quicklink information for the
content item. When wrapped in an <a href=””> tag, you can create a Hyperlink.
[$SERVER_NAME] on page 1945—Displays the server name. For example, If this
variable is applied to http://www.example.com/demo.aspx, the return is
www.example.com.
[$ShowBubble(width,height)] on page 1947—This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and lets you set the width of the bubble.
[$ShowBubble] on page 1946—Calls the <ekbubbleinfo> tags and places the
information contained within those tags in a pop-up bubble.
[$ShowContent(‘htmltagid’)] on page 1948—Calls the <ekcontentinfo> tags an places
the information in those tags within the specified HTML tag ID. Replace the 'htmltagid'
with the ID of the tag.
[$Status] on page 1948—Displays the status of a content item.
[$Teaser] on page 1949—Displays the content item’s summary information. If the item
is an HTML form, this variable is not supported with this ekml file.
[$Title] on page 1949Displays the content item’s title.
[$UrlEncode(‘str’)] on page 1950—Encodes the string information. This variable can be
used to encode another EkML variable and place it in an email.
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l

[$UrlParam(‘paramname’)] on page 1951—Displays the value of a QueryString’s
parameter. For example, if the QueryString is ?id=27 and the variable is [$UrlParam
(‘id’)], 27 appears.

map.ekml
The map.ekml file defines which items and information are included when using the Map
server control. Unlike most other .ekml files, the map.emkl has some variables that cannot
be changed or moved around.
The file’s variables appear in 3 <tr></tr> table rows. These rows are located below the main
table. In the first 2 table rows, you can modify a tag’s style information only. In the third, you
can change the style information and the order of the variables to create different layouts for
your page. It is recommended you hide the first 2 table rows if you are not changing their
style information. For example:

When using the map.ekml file remember these 3 rules.
1. Do not change any of the IDs.
2. You can change any tag’s style information.
3. You can move the variables in the third table row around to create different layouts. For
example, you can display these sections horizontally or vertically.

__Map
Displays the map section of the Map server control.
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__RouteInfoPane
The panel that displays driving directions from the starting address to the arrival address.

Search Txt Result Pane
Displays the results pane from the search.
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messageboard.ekml
This file defines which items and information are included when displaying message
information for a message board using the MessageBoard on page 1786 server control.

messageboard.ekml Variables
l

l

l

[$AddCommentBox] on page 1925—Displays the Add Comment text box and button for a
message board.
[$ApproveMessageLink] on page 1926—Display an Approve link to approve comments
when message board moderation is active.
[$Avatar] on page 1926—Display the profile image of the member who entered the
comments on the message board.

l

[$DateCreated] on page 1930—Display the date the content was created.

l

[$DateModified] on page 1931—Display the date the content was last modified.

l

l

l

l

l

l
l

l

[$DeleteMessageLink] on page 1931—Displays the Delete link for a comment on the
message board. Only Administrators, the person who left the message or the person
who owns the board.
[$DisplayName] on page 1932—Displays the display name of the member who left the
message.
[$EmailAddress] on page 1934—Displays the email address of the member who left the
message on the board.
[$FirstName] on page 1935—Display the first name of the person who left the comment
on the message board.
[$LastName] on page 1939—Display the last name of the person who left the comment
on the message board.
[$MessageText] on page 1941—Displays the message on a message board.
[$NumberComments] on page 1941—Displays the number of comments posted to a
message board.
[$UserName] on page 1951—Display the Username of a user who left a comment on a
message board.
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metadatalist.ekml
This file defines which items and information are included when displaying content item
information for a metadata list using the MetadataList server control.

metadatlist.ekml Variables
l

[$Comment] on page 1929—Displays the content’s comment information.

l

[$ContentId] on page 1930—Displays the content item’s ID.

l

[$DateCreated] on page 1930—Display the date the content was created.

l

[$DateModified] on page 1931—Display the date the content was last modified.

l

[$EditorFirstName] on page 1933—Display the last editor’s first name for a content item.

l

[$EditorLastName] on page 1933—Display the last editor’s last name for a content item.

l

[$FolderId] on page 1936—Display the folder ID of a content item.

l

[$Html] on page 1937—Display the HTML contained in the content item.

l

l

l

[$HyperLink] on page 1937—Adds a hyperlink using the title of the content block as the
text.
[$Image] on page 1938—Displays the path for the image defined in a content item’s
Metadata. When wrapped in <img src=””/> tag, the image appears.
[$ImageIcon] on page 1938—Displays an image icon for the content item. For example,
if the content item is HTML, the (

l

[$ImageThumbnail] on page 1938—Displays the path for the image’s thumbnail defined
in a content item’s Metadata.

l

[$Index] on page 1938—Serialize the content items in a numbered list.

l

[$ItemCount] on page 1939—The total number of items in a list.

l

[$Language] on page 1939—Display the language ID for the content item.

l

l

l

l

l

l

l
l

l
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) icon appears.

[$LinkTarget] on page 1940—When added to an <a href=””> tag’s target=”” attribute,
this variable reads the server control’s LinkTarget property and uses its setting.
[$QuickLink] on page 1943—This property displays the Quicklink information for the
content item. When wrapped in an <a href=””> tag, you can create a Hyperlink.
[$SERVER_NAME] on page 1945—Displays the server name. For example, If this
variable is applied to http://www.example.com/demo.aspx, the return is
www.example.com.
[$ShowBubble(width,height)] on page 1947—This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and lets you set the width of the bubble.
[$ShowBubble] on page 1946—Calls the <ekbubbleinfo> tags and places the
information contained within those tags in a pop-up bubble.
[$ShowContent(‘htmltagid’)] on page 1948—Calls the <ekcontentinfo> tags an places
the information in those tags within the specified HTML tag ID. Replace the 'htmltagid'
with the ID of the tag.
[$Status] on page 1948—Displays the status of a content item.
[$Teaser] on page 1949—Display the content item’s summary information. If the item is
an HTML form, this variable is not supported with this ekml file.
[$Title] on page 1949—Displays the content item’s title.
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l

l

[$UrlEncode(‘str’)] on page 1950—Encodes the string information. This variable can be
used to encode another EkML variable and place it in an email.
[$UrlParam(‘paramname’)] on page 1951—Displays the value of a QueryString’s
parameter. For example, if the QueryString is ?id=27 and the variable is [$UrlParam
(‘id’)], 27 appears.

taxonomy.ekml
This file defines which items and information are included when displaying taxonomy item
information using the Directory server control. Similar to maps.ekml, the taxonomy.ekml
works differently than other .ekml files.
The Directory server control produces multiple areas where content or functionality is
defined. To specify these areas in a template, you would call the <ekoutput> tag with the
mode attribute equaling the area you want to define. For example, in the Directory server
control, you can define information in the breadcrumb area of the server control by using
<ekoutput mode=”breadcrumb”>.
Additional descriptions and commenting in the taxonomy.ekml file will assist you with
learning about EkML with taxonomy. This file is located in <web
root>/CMS400Developer/Workarea/template/taxonomy/taxonomy.ekml.

Taxonomy <ekoutput> modes
The following <ekoutput modes=””> are used with the taxonomy.ekml template.
l

l

l

l

<ekoutput mode=”breadcrumb”>—Defines the display of the breadcrumb portion of the
taxonomy. Within these tags you can define:
o <bctitle>—title for the breadcrumbs
o

<bcrootlink>—root link text

o

<bcseparator>—separator used to between breadcrumbs in the breadcrumb trail

o

<bchyperlink>—hyperlinks in the breadcrumb trail

o

<bcactivelink>—the current active breadcrumb item

<ekoutput mode=”category”>—Defines how the category information appears. Within
these tags you can define:
<ekcolrepeat> takes the category links and spreads them over the amount of columns
that are defined in the Directory server control's TaxonomyCol property. This tag must
appear within <ekrepeat> tags.
<ekoutput mode=”categorybacklink”>—Defines information about the link that moves
the category up one level. This can be a text link or an image link. In this mode, you
need to define the following tags:
o <ekactivebacklink> </ekactivebacklink>—between these tags, define what
appears when a user is in a sub category. Add the [$categorybacklink] variable
between these tags and an clickable image appears that lets a user navigate one
level up.
o

<ekdisablebacklink> </ekdisablebacklink>—between these tags, define what
happens when a user is at the top level category. Add the [$categorybacklink]
variable between these tags with an <a> tag have users navigate to another
location. For example:
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<a href="http://www.example.com" target="_blank">
[$categorybacklink]</a>

See Also: [$CategoryBackLink] on page 1927
l

l

l

<ekoutput mode=”article_search”>—Defines how the search results from the
taxonomy are displayed.
<ekoutput mode=”article”>—Defines the display of an individual content item in your
taxonomy.
<ekoutput mode=”view”>—This section defines the overall output view of the
Taxonomy. It denotes the locations of the Search box, Breadcrumb, Category and
Articles.

taxonomy.ekml Variables
l

l

l

l
l

[$AddArticle] on page 1924—Adds a link that allows a logged in user to add HTML content
to Ektron.
[$AddAsset] on page 1925—Adds a link that allows a logged in user to add assets to
Ektron.
[$CategoryBackLink] on page 1927—When placed between <ekactivebacklink> tags,
this variable adds a clickable image that allows a user to navigate up one category level.
When placed between <ekdisablebacklink> tags and in the text area of an <a> tag, this
variable adds a clickable image that allows a user to navigate to another URL once they
reach the top level category.
[$CategoryID]—The ID of a taxonomy’s category.
[$ContentByteSize] on page 1929—Displays the content item’s size in KB. Works only
with taxonomy search. <ekoutput mode=”article_search”>

l

[$ContentId] on page 1930—Displays the content item’s ID.

l

[$DateCreated] on page 1930—Display the date the content was created.

l

[$DateModified] on page 1931—Display the date the content was last modified.

l

[$EditorFirstName] on page 1933—Display the last editor’s first name for a content item.

l

[$EditorLastName] on page 1933—Display the last editor’s last name for a content item.

l

[$FolderId] on page 1936—Display the folder ID of a content item.

l

[$Html] on page 1937—Display the HTML contained in the content item.

l

l

[$HyperLink] on page 1937—Adds a hyperlink using the title of the content block as the
text.
[$ImageIcon] on page 1938—Displays an image icon for the content item type. For
example, if the content item is HTML, the (

1914

) icon appears.

l

[$Index] on page 1938—Serialize the content items in a numbered list.

l

[$ItemCount] on page 1939—The total number of items in a list.

l

[$Language] on page 1939—Display the language ID for the content item.
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l

l

l

l

l

l

l

l

l

l

l

l

l
l

l

l
l

l

[$LinkTarget] on page 1940—When added to an <a href=””> tag’s target=”” attribute,
this variable reads the server control’s LinkTarget property and uses its setting.
[$PagingCurrentEndIndex] on page 1942—The end count number of the items
on the page. For example, if you are displaying items 11—20 on a page, this variable
represents the number 20. Works only with taxonomy search. <ekoutput
mode=”article_search”>
[$PagingCurrentStartIndex] on page 1943—The numerical record of the first item on a
page. For example, if you are displaying items 1 through 10 out of 50 total items on a
page, this variable represents the number 1. Works only with taxonomy search.
<ekoutput mode=”article_search”>
[$QuickLink] on page 1943—This property displays the Quicklink information for the
content item. When wrapped in an <a href=””> tag, you can create a Hyperlink.
[$SearchDuration] on page 1944—Displays the amount of time, in seconds, it has taken
to execute the search. Works only with taxonomy search. <ekoutput mode=”article_
search”>
[$SearchSummary] on page 1944—Creates a summary from information stored in the
indexing service for each item in the search results. Works only with taxonomy search.
<ekoutput mode=”article_search”>
[$SearchText] on page 1945—Displays the text for which a user is searching. This
information is same as what a user entered in the search text box. Works only with
taxonomy search. <ekoutput mode=”article_search”>
[$SERVER_NAME] on page 1945—Displays the server name. For example, If this
variable is applied to http://www.example.com/demo.aspx, the return is
www.example.com.
[$ShowAllcategory] on page 1946—Adds to the Taxonomy search screen a checkbox that
lets the user decide whether to display categories that have no items.
[$ShowBubble] on page 1946—Calls the <ekbubbleinfo> tags and places the
information contained within those tags in a pop-up bubble.
[$ShowBubble(width,height)] on page 1947—This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and lets you set the width of the bubble.
[$ShowContent(‘htmltagid’)] on page 1948—Calls the <ekcontentinfo> tags an places
the information in those tags within the specified HTML tag ID. Replace the 'htmltagid'
with the ID of the tag.
[$Status] on page 1948—Displays the status of a content item.
[$Teaser] on page 1949—Display the content item’s summary information. If the item is
an HTML form, this variable is not supported with this ekml file.
[$TemplateQuickLink] on page 1949—This property displays the Template Quicklink
information assigned to the taxonomy item in the Workarea. When wrapped in an <a
href=””> tag, you can create a Hyperlink.
[$Title] on page 1949—Displays the content item’s title.
[$UrlEncode(‘str’)] on page 1950—Encodes the string information. This variable can be
used to encode another EkML variable and place it in an email.
[$UrlParam(‘paramname’)] on page 1951—Displays the value of a QueryString’s
parameter. For example, if the QueryString is ?id=27 and the variable is [$UrlParam
(‘id’)]code, 27 appears.
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websearch.ekml
This file defines which items and information are included when displaying search results
using the WebSearch server control.
NOTE: The WebSearch server control is deprecated as of Release 8.5. Instead of the Web search
control, you should convert to templated search. If you are already using the WebSearch server control,
you can continue to do so with one important exception: the Solr search provider is incompatible with the
Web Search server control.
The websearch.ekml template needs 2 <ekoutput> nodes.
l

The first <ekoutput> node formats the results of non-image searches

l

The second <ekoutput> node formats results that include images

websearch.ekml Variables
l

[$ContentByteSize] on page 1929—the size of the content item.

l

[$ContentId] on page 1930—the content ID number assigned to the content.

l

[$DateModified] on page 1931—the date the content was last modified.

l

[$EditorFirstName] on page 1933—the last editor’s first name for a content item.

l

[$EditorLastName] on page 1933—the last editor’s last name for a content item.

l

l

[$Image] on page 1938—the path for the image defined in a content item’s Metadata.
When wrapped in <img src=””/> tag, the image appears.
[$ImageIcon] on page 1938—used in non-image searches to display an image icon for
the content item. For example, if the content item is HTML, the (

l

l
l

l

l

l

l

l

) icon appears.

[$ImageThumbnail] on page 1938—the path for the image’s thumbnail defined in a
content item’s Metadata.
[$ItemCount] on page 1939—the total number of results produced by the search.
[$LinkTarget] on page 1940—when added to an <a href=””> tag’s target=”” attribute,
this variable reads the server control’s LinkTarget property and uses its setting.
[$PagingCurrentEndIndex] on page 1942—The end count number of the items on the
page. For example, if you are displaying items 11—20 on a page, this variable
represents the number 20.
[$PagingCurrentStartIndex] on page 1943—the numerical record of the first item on a
page. For example, if you are displaying items 1 through 10 out of 50 total items on a
page, this variable represents the number 1.
[$QuickLink] on page 1943—the Quicklink information for the content item. When
wrapped in an <a href=””> tag, you can create a Hyperlink.
[$SearchDuration] on page 1944—the amount of time, in seconds, it has taken to
execute the search.
[$SearchSummary] on page 1944—creates an abstract for each item in the search
results.
NOTE: The Adobe IFilter, which is used to generate the abstract, is only supported in Tier 1
languages (English, French, German, and Japanese). If your website uses other languages, the
abstract may not be legible. In such a case, you should suppress the abstract from the search
results.
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l

l

l

[$SearchText] on page 1945—the text for which a user is searching. This information is
same as what a user entered in the search text box.
[$ShortDateModified] on page 1945—the date the content was modified. To display the
date and time a content item was modified, use [$DateModified] on page 1931.
[$Title] on page 1949—the content item’s title.

EkML Example
By customizing the provided EkML templates, you can create a custom layout for the content
you are displaying. For example, if you have a collection and you want to display it as a
numbered list containing a content’s hyperlink, the date it was last updated and its summary,
you would create the following .ekml file and assign that file to a Collection server control’s
MarkupLanguage property.
<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td> [$Index]. [$HyperLink] Updated:<i>[$DateModified]</i><br/>[$Teaser]
<hr/>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>
l

l

l
l

l

l

The <ekmarkup> tags open and close the markup language. Everything to do with the
EkML needs to be between these tags.
The specific information you want displayed and any HTML formatting are added
between the <ekoutput> tags.
<table width=”100%” border=”0”></table> sets up a table. This is HTML formatting.
The <ekrepeat> tags contain formatting information and variables for items in the
Collection. It repeats this information for each item in the list.
The [$Index] variable creates a numbered list for each content item in the Collection.
Note, you can add a period (.) or other separator depending on how you want the list to
look.

The [$HyperLink] variable adds a hyperlink for each content item in the collection. The
hyperlink use the content’s title as the text for the link. There is no need for anchor tags,
the variable creates them for you. If you want to use anchor tags for formatting you own
links, you can use the [$QuickLink] variable.
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l
l

l

Updated: is plain text.
The <i></i> tags are HTML that cause the [$DateModified] variable to appear in
italics.
The [$DateModified] variable displays the date and time each content item in the
Collection was last modified.

l

<br/> is HTML. It adds a line break.

l

The [$Teaser] variable displays the summary for each content item in the Collection.

l

<hr/> is HTML. It adds a horizontal rule line.

When the Collection appears, it is formatted as follows.

Because you can use HTML in the Ektron Markup Language, you can format the variables
using common HTML tags.
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EkML Tags
The EkML tags define functions that occur when using the language to display content.
l
l

l

l

l

<ekmarkup>—Use these tags to open and close the Ektron Markup Language.
<ekoutput>—Define what information is output from the server control between these
tags.
<ekrepeat>—These tags cause what ever formatting information that appears
between them to be applied to each item in the list. They always appear between the
<ekoutput> tags.
<ekbubbleinfo>—Creates a pop-up bubble. This tag is invoked when you use the
[$ShowBubble] or [$ShowBubble(width)] variables. By adding different variables
between the <ekbubbleinfo> tags, you define what information appears in the bubble.
These tags are placed outside the <ekoutput> tags but within the <ekmarkup> tags.
<ekcontentinfo>—Places the information defined between the tags in the specified
HTML tag ID. This tag is invoked when you use the [$ShowContent(‘htmltagid’)]
variable.

EkML Variables
The Ektron Markup Language uses variables that appear between the tags in a template file to
define the information that appears in a control’s display. Some variable are used in more
than one template. These are known as common EkML variables.
Another type of variable is a server control specific variable, these variables can only be used
with a specific server control. For example, [$SearchSummary] can only be used in
WebSearch.

EkML Variable List
The following list shows EkML variables and whether the variable is common or specific.

Variable

Description

Common or
Control
Specific

[$AddCommentBox] on
page 1925

Displays the Add Comment text box and button for a
message board.

MessageBoard

[$AddArticle] on page 1924

Adds a link that allows a logged in user to add HTML
content to Ektron.

Directory

[$AddAsset] on page 1925

Adds a link that allows a logged in user to add assets
to Ektron.

Directory

[$ApproveMessageLink] on
page 1926

Displays an Approve link to approve comments when
message board moderation is active.

MessageBoard

Ektron 8.7
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Variable

Description

Common or
Control
Specific

[$Avatar] on page 1926

Displays the profile image of the member who entered
comments on a message board.

MessageBoard

[$CollectionDescription] on
page 1928

Displays the collection’s description.

Collection

[$CollectionTitle] on
page 1928

Displays the collection’s title.

Collection

[$Comment] on page 1929

The content’s comment information appears.

Common
Except: Map,
WebSearch
and taxonomy

[$ContentByteSize] on
page 1929

Displays the content item’s size in KB. Works only
with taxonomy search. <ekoutput
mode=”article_search”>. More information

[$ContentId] on page 1930

Displays the content item’s ID.

Common
Except: Map

[$DateCreated] on
page 1930

Displays the date the content was created.

Common
Except: Map
and
WebSearch

[$DateModified] on
page 1931

Displays the date and time the content was last
modified.

Common
Except: Map

[$DeleteMessageLink] on
page 1931

Displays the Delete link for the comment on a
message board.

MessageBoard

[$DisplayName] on
page 1932

Displays the display name of the member who left the
message on the board.

MessageBoard

[$EditorFirstName] on
page 1933

Displays the last editor’s first name for a content item.

Common
Except: Map

[$EditorLastName] on
page 1933

Displays the last editor’s last name for a content item.
1

Common
Except: Map
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EkML Variable List

Variable

Description

Common or
Control
Specific

[$EmailAddress] on
page 1934

Displays the email address of the member.

MessageBoard

[$FirstName] on page 1935

Displays the first name of the person who left the
comment on a message board.

MessageBoard

[$FolderDescription] on
page 1935

Displays the folder’s description.

ListSummary

[$FolderId] on page 1936

Displays the folder ID of a content item.

Common
Except: Map
and
WebSearch

[$FolderName] on
page 1936

Displays the folder’s name.

ListSummary

[$Html] on page 1937

Displays the HTML contained in the content item. ”

Common
Except: Map
and
WebSearch

[$HyperLink] on page 1937

Adds a hyperlink using the title of the content block as
the text. More information:

Common
Except: Map
and
WebSearch

[$Image] on page 1938

Displays the path for the image defined in a content
item’s Metadata. When wrapped in <img src=””/>
tag, the image appears. For example:
<img src=”[$Image]”/>.

Common
Except: Map

Displays an image icon for the content item. For
[$ImageIcon] on page 1938

[$ImageThumbnail] on
page 1938

example, if the content item is HTML, the (
appears.

) icon

Displays the path for the image’s thumbnail defined in
a content item’s Metadata. When wrapperd in <img
src=””/> tag, a thumbnail version of the image
appears. For example:
<img src=”[$ImageThumbnail]”/>.

Common
Except: Map

Common
Except: Map
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Description

Common or
Control
Specific

[$Index] on page 1938

Serialize the content items in a numbered list.

Common
Except: Map
and
WebSearch

[$ItemCount] on page 1939

The total number of items in a list.

Common
Except: Map

[$Language] on page 1939

Displays the language ID for the content item.

Common
Except: Map
and
WebSearch

[$LastName] on page 1939

Displays the last name of the person who left the
comment on a message board. ]

MessageBoard

[$LinkTarget] on page 1940

When added to an <a href=””> tag’s target=””
attribute, this variable reads the server control’s
LinkTarget property and uses its setting.

Common
Except: Map

[$MessageText] on
page 1941

Displays the text of a message on a message board.

MessageBoard

[$NumberComments] on
page 1941

Displays the number of comments posted to a
message board.

MessageBoard

[$PagingCurrentEndIndex]
on page 1942

The end count number of the items on the page. For
example, if you are displaying items 11—20 on a
page, this variable represents the number 20. Works
only with taxonomy search. <ekoutput
mode=”article_search”>.

[$PagingCurrentStartIndex]
on page 1943

The numerical record of the first item on a page. For
example, if you are displaying items 1 through 10 out
of 50 total items on a page, this variable represents
the number 1. Works only with taxonomy search.
<ekoutput mode=”article_search”>.

[$QuickLink] on page 1943

This property displays the Quicklink information for
the content item. When wrapped in an <a href=””>
tag, you can create a Hyperlink.

Variable
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WebSearch

Directory and
WebSearch

Common
Except: Map

EkML Variable List

Common or
Control
Specific

Variable

Description

[$SearchDuration] on
page 1944

Displays the amount of time, in seconds, it has taken
to execute the search. Works only with taxonomy
search. <ekoutput mode=”article_search”>.
More information:

[$SearchSummary] on
page 1944

Creates a summary for each item in the search
results. Works only with taxonomy search.
<ekoutput mode=”article_search”>. More
information:

[$SearchText] on
page 1945

Displays the text for which a user is searching. This
information is same as what a user entered in the
search text box. Works only with taxonomy search.
<ekoutput mode=”article_search”>.

[$SERVER_NAME] on
page 1945

Displays the server name. For example, If this
variable is applied to
http://www.example.com/demo.aspx, the
return is www.example.com.

Common
Except: Map
and
WebSearch

[$ShortDateModified] on
page 1945

Displays the date the content was modified. To
display the date and time a content item was updated,
use [$DateModified] on page 1931

WebSearch

[$ShowAllcategory] on
page 1946

Adds to the Taxonomy search screen a checkbox that
lets the user decide whether to display categories that
have no items.

Directory

[$ShowBubble
(width,height)] on
page 1947

This is similar to [$ShowBubble]. It calls the
<ekbubbleinfo> tags and lets you set the width
and height of the bubble. For example, [$ShowBubble
(300,400)]. The first number represents the width. The
second number represents the height.

Common
Except: Map
and
WebSearch

[$ShowBubble] on
page 1946

Calls the <ekbubbleinfo> tags and places the
information contained within those tags in a pop-up
bubble.

Common
Except: Map
and
WebSearch

[$ShowContent
(‘htmltagid’)] on page 1948

Calls the <ekcontentinfo> tags an places the
information in those tags within the specified HTML
tag ID. Replace the htmltagid with the ID of the tag.

Common
Except: Map
and
WebSearch

Directory and
WebSearch

Directory and
WebSearch

Directory and
WebSearch
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Variable

[$Status] on page 1948

Description

Common or
Control
Specific

Displays the status of a content item.

Common
Except: Map
and
WebSearch

Displays the content item’s summary information.
[$Teaser] on page 1949

NOTE: If the item is an HTML form, this variable
is not supported with this ekml file.

Common
Except: Map
and
WebSearch

[$TemplateQuickLink] on
page 1949

This property displays the Template Quicklink
information assigned to the taxonomy item in the
Workarea. When wrapped in an <a href=””> tag,
you can create a Hyperlink. See Also: Applying a
Template to a Taxonomy or Category on page 784.
More information :

Directory

[$Title] on page 1949

Displays the content item’s title.

Common
Except: Map

[$UrlEncode(‘str’)] on
page 1950

Encodes the string information. Replace str with the
string you want to encode. This variable can be used
to encode another EkML variable and place it in an
email.

Common
Except: Map
and
WebSearch

[$UrlParam(‘paramname’)]
on page 1951

Displays the value of a query string’s given
parameter. For example, if the query string is ?id=27
and the variable is [$UrlParam(‘id’)], 27
appears.

Common
Except: Map
and
WebSearch

[$UserName] on page 1951

Displays the Username of user who left a comment
on a message board.

MessageBoard

[$AddArticle]
This variable adds a link that allows a user to add HTML content to Ektron. Clicking the link
opens an editor. When the content is added, it’s automatically added to the taxonomy
category associated with the Directory server control. When you allow users to add content
using this variable, you should set the AddItemFolderID property in the Directory server
control to the folder ID where the content will be stored. This variable should not be added
between the <ekrepeat></ekrepeat> tags.
<tr>
<td>
[$AddArticle]

1924

Ektron Reference

[$AddAsset]

</td>
</tr>

[$AddAsset]
This variable adds a link that allows a user to add assets to Ektron via a drag and drop box.
When the asset is added, it’s automatically added to the taxonomy category associated with
the Directory server control. When you allow users to add assets using this variable, you
should set the AddItemFolderID property in the Directory server control to the folder ID
where the asset will be stored. This variable should not be added between the
<ekrepeat></ekrepeat> tags.
<tr>
<td>
[$AddAsset]
</td>
</tr>

[$AddCommentBox]
Displays the Add Comment text box and button for a message board.

<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
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</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$ApproveMessageLink]
Displays the Approve link for the message. This link is used to approve the message for
display when the Moderate property is set to true. Only Administrators, the person who left
the message, or the person who owns the board can see this link.

<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$Avatar]
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[$CategoryBackLink]

Display the profile image of the member who entered the comments on the message board.

<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$CategoryBackLink]
When placed between <ekactivebacklink> tags, this variable adds a clickable image that
allows a user to navigate up one category level.
When placed between <ekdisablebacklink> tags and in the text area of an <a> tag, this
variable adds a clickable image that lets a user navigate to another URL once they reach the
top level category.
<ekoutput mode="categorybacklink">
<ekactivebacklink>
[$categorybacklink]
</ekactivebacklink>
<ekdisablebacklink>
<a href="http://www.example.com" target="_blank">[$categorybacklink]</a>
</ekdisablebacklink>
</ekoutput>
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[$CollectionDescription]
Display the collection’s description.

<ekmarkup>
<ekoutput>
<h3><b>[$CollectionTitle]</b></h3>
<p/>[$CollectionDescription]<br/>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$CollectionTitle]
Display the collection’s title.
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[$Comment]

<ekmarkup>
<ekoutput>
<h3><b>[$CollectionTitle]</b></h3>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$Comment]
The content’s comment information appears. Comment information can be added in the
Workarea via the content item’s Comment tab.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] <br/> [$Comment]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ContentByteSize]
Display the size of the content item in the results list.
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[$ContentId]
Displays the content item’s ID.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] Content ID = [$ContentId]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$DateCreated]
Displays the date the content was created.

<ekmarkup>
<ekoutput>
<table width="100%"
<ekrepeat>
<tr>
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border="0">

[$DateModified]

<td>
[$Index]. [$HyperLink] - <i>[$DateCreated]</i>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$DateModified]
Displays the date and time the content was last modified. To display the date only, use
[$ShortDateModified] on page 1945.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] <br/>Date Modified: <b>[$DateModified]</b>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$DeleteMessageLink]
Displays the Delete link for a comment on the message board. Only Administrators, the
person who left the message or the person who owns the board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$DisplayName]
Displays the display name of the member who left the message.

<ekoutput>
<div class="ContributionForm">
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[$EditorFirstName]

<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$DisplayName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$EditorFirstName]
Displays the last editor’s first name for a content item.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] Last Editor: [$EditorFirstName]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$EditorLastName]
Displays the last editor’s last name for a content item.
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<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] Last Editor: [$EditorLastName]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$EmailAddress]
Displays the email address of the member who left the message on the board. To create a
hyperlinked email, wrap the [$EmailAddress] variable in a <a> tag with the mailto: variable.
For example:
<a href="Mailto:[$EmailAddress]">[$EmailAddress]</a>

<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]&#160;&#160;
<a href="Mailto:[$EmailAddress]">[$EmailAddress]</a>
</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
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[$FirstName]

</div>
</ekoutput>

[$FirstName]
Displays the first name of the user who left a comment on a message board.

<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$FirstName] [$LastName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$FolderDescription]
Displays the folder’s description.
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<ekmarkup>
<ekoutput>
<h3><b>[$FolderName]</b></h3><p/>[$FolderDescription]<br/>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$FolderId]
Displays the folder ID of a content item.

[$FolderName]
Displays the folder’s name.

<ekmarkup>
<ekoutput>
<h3><b>[$FolderName]</b></h3><p/>[$FolderDescription]<br/>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>
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[$Html]

[$Html]
Displays the HTML contained in the content item. In the server control, the control’s GetHTML
property must be set to True; otherwise nothing appears. The exception to this is when the
[$Html] appears between the <ekbubbleinfo> tags. In that case, the GetHTML property can
be set to True or False.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$HyperLink]<br/>[$Html]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$HyperLink]
Adds a hyperlink using the title of the content block as the text. You do not add an <a
href=””> tag when using this variable. That functionality is built into the EkML. Use this
variable when you do not want to create a custom hyperlink. If you want to create a custom
hyperlink, use the [$QuickLink] variable. See Also: [$QuickLink] on page 1943

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink]
</td>
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</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$Image]
Displays the path for the image defined in a content item’s Metadata. When wrapped in <img
src=””/> tag, the image appears. For example, <img src=”[$Image]”/>.

[$ImageIcon]
Displays an image icon for the content item. Except for HTML content, these icons are the
same icons used in the Workarea to show the content type. HTML content uses the Internet
Explorer icon (

). For example, Forms use the Form icon (

).

When using this variable with the server control, the IncludeIcons property is automatically
set to True.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] [$ImageIcon]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ImageThumbnail]
Displays the path for the image’s thumbnail defined in a content item’s Metadata. When
wrapped in <img src=””/> tag, the image thumbnail appears. For example, <img src=”
[$ImageThumbnail]”/>.

[$Index]
Serialize the content items in a numbered list.
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<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] [$ImageIcon]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ItemCount]
Displays the total number of results in a list that are produced by the search. In the server
control, the EnablePaging property must be set to True; otherwise nothing appears.
This variable is typically used in the following context:
Results [$PagingCurrentStartIndex]—[$PagingCurrentEndIndex] of [$ItemCount] for
item [$SearchText] ([$SearchDuration]).

[$Language]
Displays the language ID for the content item.

[$LastName]
Displays the last name of the user who left a comment on a message board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$FirstName] [$LastName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$LinkTarget]
When added to an <a href=””> tag’s target=”” attribute, this variable reads the server
control’s LinkTarget property and uses its setting. For example, If you want to create a
custom hyperlink that opens in a new window, you set the server control’s LinkTarget
property to _Blank. Then, in the Ektron Markup Language file, add the [$LinkTarget]
variable to the <a href=””> tag’s Taget=”” attribute. A code example appears below.
<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
<a href=”[$QuickLink]” target=”[$LinkTarget]”>[$Title]</a>
</td>
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</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$MessageText]
Displays the text of a message on a message board.

<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$NumberComments]
Displays the number of comments posted on the message board.
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>

[$PagingCurrentEndIndex]
The numerical record of the last item on a page. For example, if you are displaying items 1
through 10 out of 50 total items on a page, this variable represents the number 10.
This variable is typically used in the following context:
Results [$PagingCurrentStartIndex]—[$PagingCurrentEndIndex] of [$ItemCount] for
item [$SearchText] ([$SearchDuration]).
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[$PagingCurrentStartIndex]

[$PagingCurrentStartIndex]
The numerical record of the first item on a page. For example, if you are displaying items 1
through 10 out of 50 total items on a page, this variable represents the number 1.
This variable is typically used in the following context:
Results [$PagingCurrentStartIndex]—[$PagingCurrentEndIndex] of [$ItemCount] for
item [$SearchText] ([$SearchDuration]).

[$QuickLink]
This property displays the Quicklink information for the content item. When wrapped in an <a
href=””> tag, you can create a Hyperlink. Use this property instead of the [$HyperLink] if
you want to customize your hyperlinks. See Also: [$HyperLink] on page 1937
The first image shows the variable displaying the Quicklink information. The second image
shows the Quicklink as a Hyperlink with a custom text.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$QuickLink]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>
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<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. <a href="[$QuickLink]">Click Here For Item #[$Index]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$SearchDuration]
Displays the amount of time, in seconds, it has taken to perform the search.
This variable is typically used in the following context:
Results [$PagingCurrentStartIndex]—[$PagingCurrentEndIndex] of [$ItemCount] for
item [$SearchText] ([$SearchDuration]).

[$SearchSummary]
Gets the first 300 characters from the body content and creates an abstract.
For content items that do not get indexed, such as images, the SearchSummary uses the
image’s title, summary, and metadata information.
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[$SearchText]
Displays the text for which a user is searching. This information is same as what a user
entered in the search text box.
This variable is typically used in the following context:
Results [$PagingCurrentStartIndex]—[$PagingCurrentEndIndex] of [$ItemCount] for
item [$SearchText] ([$SearchDuration]).

[$SERVER_NAME]
Displays the server name for the page on which this variable appears. For example, If this
variable is applied to http://www.example.com/demo.aspx, the return is www.example.com.

[$ShortDateModified]
Displays the date the content was last modified. The variable show the date only. To show the
Date and Time, use the [$DateModified] on page 1931 variable.
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<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] <br/>Date Modified: <b>[$ShortDateModified]</b>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ShowAllcategory]
If a Directory server control’s EnableSearch property is set to true, this variable adds the
checkbox circled below to the right of the search field.

By default, the Directory server control only shows categories to which at least one content
block is assigned. If you check this box, all categories appear, even those with no content
assigned.

[$ShowBubble]
Calls the <ekbubbleinfo> tags and places the information contained within those tags in a
pop-up bubble. This bubble is typically assigned to the onclick or onmouseover attribute in
an <a href=””> tag. See the following example EkML code.
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[$ShowBubble(width,height)]

<ekmarkup>
<ekbubbleinfo>
<table border="0">
<tr>
<td>[$Html]</td>
</tr>
</table>
</ekbubbleinfo>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index].<a href="#" onmouseover="[$ShowBubble]">[$Title]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ShowBubble(width,height)]
This is similar to [$ShowBubble]. It calls the <ekbubbleinfo> tags and places the
information contained within those tags in a pop-up bubble. This variable lets you set the
width and height of the bubble. For example, [$ShowBubble(300,400). In this example, the
first number represents the width. The second number represents the height.
If you enter a single number, it sets the width. The height of the bubble is then limited to the
length of the content. For example, if you had a video that was formatted at 200 pixels wide
and you wanted to launch it in a bubble, you would add the function as [$ShowBubble(200)].
The minimum width for a bubble is 287. The minimum height is 101.
<ekmarkup>
<ekbubbleinfo>
<table border="0">
<tr>
<td>[$Html]</td>
</tr>
</table>
</ekbubbleinfo>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
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[$Index].<a href="#" onmouseover="[$ShowBubble(200)]">[$Title]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$ShowContent(‘htmltagid’)]
Calls the <ekcontentinfo> tags and places the information contained within those tags in the
specified HTML tag ID. Replace the htmltagid with the ID of the tag. This tag is typically
assigned to the onclick or onmouseover attribute in an <a href=””> tag. See the example
EkML code below.
<ekmarkup>
<ekcontentinfo>
<table border="0">
<tr>
<td>[$Html]</td>
</tr>
</table>
</ekcontentinfo>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index].<a href="#" onmouseover="[$ShowContent(‘contarea’)]">[$Title]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$Status]
Displays the status of a content item. For example, Approved, Checked in, or Submitted for
Approval. For additional information, see Content Statuses on page 307.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$Hyperlink]
The content status is <i>[$Status]</i>
</td>
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[$Teaser]

</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$Teaser]
Displays the content item’s summary information. Summary information is added to content
in the Workarea via the Summary tab. A code example appears below.

<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. [$HyperLink] <br/> [$Teaser]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$TemplateQuickLink]
This variable displays the Template Quicklink information assigned to the taxonomy item in
the Workarea. When wrapped in an <a href=””> tag, you can create a Hyperlink.
<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
<a href="[$TemplateQuickLink]">[Title]</a><br/>[$Teaser]
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$Title]
Ektron 8.7

1949

Controlling Output with Ektron Markup Language

Displays the content item’s title. Use this variable if you want to display the title as normal
text. If you want to display the title as a hyperlink, use [$HyperLink]. See Also:
[$HyperLink] on page 1937. If you want to create a custom hyperlink with the title as the text
of the hyperlink, use this property in conjunction with the <a href=””> tag and the
[$QuickLink] variable. See Also: [$QuickLink] on page 1943.
<ekmarkup>
<ekoutput>
<table width="100%" border="0">
<ekrepeat>
<tr>
<td>
[$Index]. <a href="[$QuickLink]">[$Title]</a>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$UrlEncode(‘str’)]
Encodes the string information in the variable. This variable can be used to encode another
EkML variable and place it in an email. For example, You want the title of the content block to
appear as the subject of an email. A code example appears below.

<ekcontentinfo>
<table border="0">
<tr>
<td>
<strong>Title:&#160;</strong>
<span style="color:red;">[$Title]</span>
<a href="mailto:?subject=[$UrlEncode('[$Title]')]&body=
http://[$SERVER_NAME]/CMS400Developer/wiki.aspx?id=
[$ContentId]">&nbsp;
<img src="WorkArea/images/application/icon_email.png"
align="absmiddle" alt="[$Title]" border="0"/></a>
<hr />
</td>
</tr>
<tr>
<td>[$Html]</td>
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[$UrlParam(‘paramname’)]

</tr>
</table>
</ekcontentinfo>

[$UrlParam(‘paramname’)]
Displays the value of a query string’s parameter. For example, if you have a collection and
want to display its ID, add the [$UrlParam(‘coll_id’)] where you want the collection’s ID
to appear.

<ekmarkup>
<ekbubbleinfo>
<table border="0">
<tr>
<td>[$Html]</td>
</tr>
</table>
</ekbubbleinfo>
<ekoutput>
<table width="100%" border="0">
<tr>
<td>
<b>This Collection's ID is: [$UrlParam('coll_id')]</b>
<br/><hr/>
</td>
</tr>
<ekrepeat>
<tr>
<td>
[$Index].<a href="#" onclick="[$ShowBubble]">[$Title]</a>[$Teaser]<hr/>
</td>
</tr>
</ekrepeat>
</table>
</ekoutput>
</ekmarkup>

[$UserName]
Display the Username of a user who left a comment on a message board.
Ektron 8.7
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<ekoutput>
<div class="ContributionForm">
<h4>[$NumberComments] Comments</h4>
<ul>
<ekrepeat>
<li class="ekMessagePost">
<div class="avatar">[$Avatar]</div>
<div class="message">
<div class="metaData">
<span class="username">[$UserName]</span>
<span class="time">[$DateCreated]</span>
</div>
<p>[$MessageText]</p>
<ul class="commands">
<li class="ekDeleteMessage">[$DeleteMessageLink]</li>
<li class="ekApproveMessage">[$ApproveMessageLink]</li>
</ul>
</div>
</li>
</ekrepeat>
</ul>
[$AddCommentBox]
</div>
</ekoutput>
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User and Content Constants

Developers can use the following information to determine constant values when working
with Ektron users and content.

User Constants
l

999999999—Builtin

l

18611864—Internal Admin

l

1—Image

l

2—File

l

888888—AllMemberShip Group

l

2—Everyone Group

l

1—Admin Group

Content Constants
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l

-1—CMSContentType_AllTypes

l

1—CMSContentType_Content

l

2—CMSContentType_Forms

l

3—CMSContentType_Archive_Content

l

4—CMSContentType_Archive_Forms

l

7—CMSContentType_Library

l

9—CMSContentType_NonImageLibrary

l

12—CMSContentType_Archive_Media

l

13—CMSContentType_BlogComments

l

14—CMSContentType_XmlConfig

l

98—CMSContentType_NonLibraryForms

l

99—CMSContentType_NonLibraryConten

l

101—CMSContentType_OfficeDoc

l

102—CMSContentType_PDF

l

104—CMSContentType_Media

l

106—CMSContentType_Image

l

1111—CMSContentType_DiscussionTopic

l

3333—CMSContentType_CatalogEntry

l

100—ManagedAsset_Min

l

1099—ManagedAsset_Max

l

1100—Archive_ManagedAsset_Min

l

2099—Archive_ManagedAsset_Max

l

1000—MaxNumManagedAssetTypes
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Using the eWebEdit400 Editor

The eWebEdit400 editor is a Web content editor designed for dynamic websites that lets you
create and publish Web content in any language supported by the operating system and your
website. You can use the eWebEdit400 editor on Windows and Macintosh operating systems.
Although you can still use the eWebEdit400 editor, it is not the default editor since Ektron
Version 8.7. For information about the default editor, see Editing in Ektron on page 207.
To use a the eWebEdit400 editor in Ektron, edit web.config and set ek_EditControlWin
(Windows) or ek_EditControlMac (MacIntosh) to ContentDesigner.
<!-- EditControlWin may be either "Aloha" or "ContentDesigner" or "eWebEditPro" or
"UserPreferred" -->
<add key="ek_EditControlWin" value="ContentDesigner" />

Working with Tables in eWebEdit400 on page 1975 has more information about working with
tables in the eWebEdit400 editor.
eWebEdit400 Toolbar

When you cut, copy and paste from Microsoft Word, you can preserve the styles, class
attributes, and HTML tags by following these steps:
1. In the Workarea, choose Settings > Configuration >Setup. The Application Setup
screen appears.
2. Click Edit.
3. Click the Editor tab.
4. Check the boxes: Preserve MS-Word Styles and Preserve MS-Word Classes.
This section also contains the following topics.
eWebEdit400 functions
Using Temporary Markers
Finding and Replacing Text
Checking Spelling
Using Bookmarks
Using Hyperlinks
Using the Wiki Feature
Working with HTML
Working with Images
Working with Tables in eWebEdit400
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1961
1962
1964
1966
1968
1968
1975

eWebEdit400 functions
NOTE: HOW TO: Add and remove buttons to the toolbar for eWebEdit400 is an Ektron Knowledge Base
article that explains how a Webmaster adds a custom toolbar button to eWebEdit400.
l

l

1956

Select All (Ctrl/a)—Select all content
Cut (Ctrl/x)—Remove selected text and graphics. Place that data into temporary
memory, also known as the “clipboard.” (If you later cut or copy more information onto
the clipboard, the new information overwrites the original information.)
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eWebEdit400 functions

l

l

l

Copy (Ctrl/c)—Copy selected text and graphics into temporary memory. Leave
selected data where it is. (If you later cut or copy more information into memory, the
original information is lost.)
Paste (Ctrl/v)—Insert the most recently cut or copied text and graphics at the
current cursor location.
Paste from Word, Cleaning Fonts & Styles—Designed for pasting Microsoft Word
content, this button strips fonts and classes. For example, if you use the Paste button,
Word content contains these tags.
<p class="MsoNormal" style="MARGIN: 0in 0in 0pt">
<span style="BACKGROUND: lime; mso-highlight: lime">
<font size="3">
<font face="Times New Roman">

But if you paste that content using this button, only <p> tags are preserved.
l

l

l

l

l

Paste Plain Text—Paste the clipboard’s contents as plain text. That is, all HTML tags
(including images) are stripped out. This button is helpful when you want to eliminate
HTML formatting from the copied text.
Find and Replace—Launch the Search and Replace dialog box. The dialog searches
for (and lets you optionally replace) text that you specify. See Finding and Replacing
Text on page 1960.
Print (Ctrl/p)—Print the editor content.
Undo (Ctrl/z)—Reverse the most recent action, as if it never occurred. You can undo
as many actions as you wish.
Redo (Ctrl/y)—Reverse the undo action.

l

Spell Check—Begin spell checker. See Checking Spelling on page 1961.

l

Anchor Tag—Insert a bookmark anchor. See Using Bookmarks on page 1962.

l

l

Add/edit Hyperlink—Change information about a hyperlink. Using Hyperlinks on
page 1964.
Remove Hyperlink—Remove a hyperlink.

l

Library—Insert a library file. See Storing Files in the Library on page 333.

l

Add Wiki Link—Create a wiki link. See Using the Wiki Feature on page 1966.

l

l

l
l

l
l

l

Localize Section—Designate sections of content for certain languages only.
Creating One or More Localized Paragraphs on page 1073.
Translate—Translate content into another language. See Using Machine Translation
on page 1071.
Horizontal Line—Insert a horizontal line.
Insert Symbol—Insert symbols and special characters.
Validate—Check content for adherence to XHTML and accessibility standards.
Hide/Show Elements—Toggle to show/hide temporary markers in content.
Apply CSS Class—Display a list of style sheet classes. Users can select
from the list to apply a class to selected text. The list can change depending on the
selected text. Your Webmaster determines which styles are available.
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l

Paragraph Style—Display a list of paragraph styles. Users can select
from the list to apply a style to selected text. The list can change depending on the
selected text. Your Webmaster determines which styles are available. See: HOW TO:
Customize the Formatting drop down in the eWebEdit400 toolbar

l

Bold (Ctrl/b)—Make selected text bold.

l

Italic (Ctrl/i)—Make selected text italic.

l
l

Underscore (Ctrl/u)—Make selected text underlined.
Strikethrough—Apply strikethrough to selected text. For example: Here is some
text

l

Superscript—Make selected text appear smaller and above text line.

l

Subscript—Make selected text appear smaller and below text line.

l

l

Relative Font Size—Change the relative font size. Your Webmaster determines
which relative font sizes are available.
Font Style—Change the font style. Your Webmaster determines which
fonts are available.
NOTE: If more than one font appears in a selection, the browser on the reader’s PC tries to display
text using the first font. If the browser cannot find that font, it tries to use the second, and so on.
Your system administrator can enable or disable the font toolbar buttons (style, size, color, and
background color).

l

Font Size—Change the font size in points. Your Webmaster determines which
font sizes in points are available.
Font Color—Change the font color.

l

Background Color—Change the background color of the selected content.

l
l

Number—Begin the line on which the cursor rests with a number. If the line above
this line is:
o not numbered, assign this line 1
o

numbered, assign a number one more than the line above

NOTE: The Number toolbar button applies a number to each paragraph. If you want to switch to
regular (that is, non-numbered) paragraphs, click the button a second time
l

Bullet—Begin the line on which the cursor rests (or all selected lines) with a bullet.
NOTE: The Bullet toolbar button applies a bullet to each paragraph. If you want to switch to regular
(that is, non-bulleted) paragraphs, click the button a second time.
Indent—Increase or decrease the current line’s distance from the left margin.

l

l

Left, Center, and Right Justify—Align paragraph so that it is
arranged evenly on the...
o left side (uneven on the right)
o in

the center of each line
o evenly

o

evenly on right and left side

Use the last button to remove justification.
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on the right side (uneven on the left)

Using Temporary Markers

l

l

l

Insert table—Insert a table. See: Working with Tables in eWebEdit400 on
page 1975
Insert row above—Insert a new row above current one (that is, the one in which
the cursor currently resides).
Insert row below—Insert a new row below current one (that is, the one in which
the cursor currently resides).

l

Insert column left—Insert a new column to the left of the current one.

l

Insert column right—Insert a new column to the right of the current one.

l

Delete row—Delete current row.

l

Delete column—Delete current column.

l

Delete cell—Delete current cell.

l

Merge cells horizontally—Merge current cell with cell to its right.

l

Merge cells vertically—Merge current cell with cell below it.

l

Split cell—Divide a cell into two. After you split, each cell occupies one half the size
of the original cell.

l

Table properties—Adjust a table’s properties.

l

Cell properties—Adjust properties of current cell.

l

Show/hide border—Display/suppress internal table border.

Using Temporary Markers
Temporary markers let you insert your cursor in a place that is otherwise inaccessible. For
example, if 2 tables are adjacent to each other, you cannot insert text between them without
temporary markers. You can click on any marker and begin inserting new content. When you
save, temporary markers are removed.
To toggle temporary markers on and off, click Hide/Show Elements (

).
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NOTE: Your Ektron system administrator can use the siteroot/web.config file's ek_
ShowTemporaryMarkers element to enable (true) or disable (false) temporary markers for all
users.

Finding and Replacing Text
To find (and optionally replace) text, click Find and Replace (
dialog box appears.
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). The Find and Replace

Checking Spelling

In the Find field, type the text you want to find.
1. Click the Replace tab.
2. In the Replace With field, type the replacement text.
3. Set dialog box options.
l
Selection only—operates on a selected portion of content.
l

l
l

Direction—Search from the current cursor location up (backwards) or down
(forwards).
Match case—The search must match the string exactly.
Match whole words only—Find only whole words. By default, the search finds
any occurrence of the text that you type into the Find field. For example, if you
enter the, the search finds the word the, as well as those letters embedded in other
words, such as others and theater.

4. If you want to...
l
replace all occurrences of the “find” text with the “replace” text, click Replace All.
NOTE: You can undo replacements one at a time using the Undo button (
l
l

l

).

replace only the highlighted term with the “replace” text, click Replace.
find the next occurrence of the “find” text (and optionally replace it with the
“replace” text), click Find Next.
change the highlighted term using the editor, exit the Find and Replace dialog,
move to the term and edit as needed. To restart the search, press the Find button (
).

Continue to find and optionally replace or edit until you reach the end of the text.

Checking Spelling
To begin spell checking, click the spell check button ( ). eWebEdit400 puts a red line under
each word that’s not in the dictionary. Then, it stops at the first misspelled word and displays
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your options for fixing the problem. Instead of stopping at every misspelled word, you can
place the cursor on any highlighted word. When you do, its spelling options appear.

NOTE: The FireFox browser has its own spell check software. To eliminate confusion between
eWebEdit400’s and Firefox’s spell checker, you can disable Firefox’s by choosing Tools > Options
dialog > General Tab and unchecking the Check my spelling as I type check box.
If you are done before fixing every misspelled word, click Finish spell checking from the
toolbar. Your changes are saved, and you return to edit mode. If you want to exit the spell
checker and ignore all changes you have made since beginning it, click Cancel (circled
above) at any time.

Using Bookmarks
A bookmark lets you “jump” from any word or phrase to another place in the same content
block. On your Web page, text appears in a different color to indicate the bookmark.
Bookmarks are helpful if your page is long.
To create a bookmark, you must specify:
l

a source—the text a user clicks to move to the bookmark

l

a bookmark—the destination to which the cursor jumps when a user clicks the source

For example, if your Web page contains minutes from several meetings, the top of the page
could list the meeting dates. You could then assign a hyperlink (source) to each date and a
bookmark to each set of minutes. The user sees that a date is in a different color, so clicks it
to “jump” (using the bookmark) to the correct minutes.
To create a bookmark:
1. Place the cursor where you want to create the bookmark..
2. Click Insert Bookmark (
Tab selected.
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). The Link Manager dialog appears with the Bookmark

Using Bookmarks

3. Enter a name for the bookmark and click OK. The editor screen redisplays. (The
bookmark does not appear on the page.)
4. Select the source text that will link to the bookmark that you created..
5. Click Hyperlink Manager (
Hyperlink tab selected.

). The Hyperlink Manager dialog appears with the

6. Click the down arrow on the Existing Bookmark field and click the bookmark you
created.

7. Optionally set the Target Frame field on the Hyperlink Manager dialog to change the
window that displays the destination page.
l
New Window—Appears in a new browser window, on top of the current browser.
l

l

l

Same Window(default)—Appears in the same position within the browser window.
The new window replaces the current one.
Parent Window—Appears if your page contains frames, in the frame that contains
the frame with the hyperlink.
Browser Window—Appears if your page contains frames, in the full display area,
replacing the frames.

8. Click OK.
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Using Hyperlinks
A hyperlink lets you “jump” from any word or phrase to another Web page. The page can be
within your network (that is, on an intranet) or anywhere on the internet. For example, your
Web page could include a link to the Ektron website.
To create a hyperlink, you must specify:
l

a source—the text a user clicks to move to the bookmark

l

a destination—the destination to which the cursor jumps when a user clicks the source

NOTE: To create jumps within a content block, see Using Bookmarks on page 1962.
This section also contains the following topics.
Creating a Hyperlink
Creating an Email Hyperlink
Editing a Hyperlink
Removing a Hyperlink

Creating a Hyperlink
To create a hyperlink:
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Creating an Email Hyperlink

1. Select the source text. (You can also select an image as a hyperlink.)
2. Click Hyperlink Manager (

). The Link Manager dialog appears.

3. In the URL field, after http://, enter the address of the destination Web page. For
example, www.ektron.com. If your Ektron library includes a hyperlink that you want to
apply, click the ellipsis button (

) to browse the library and choose one.

4. Optionally set the Target Frame field to change the window in which the destination
text appears. If you leave the Target Frame field blank, the new window replaces the
current window.
5. Optionally enter "hover over" text in the Tooltip field.
6. The hyperlink's style is normally determined by the style sheet assigned to the content’s
page template. However, if you want to apply a special style sheet class to this link,
select it from the Style drop-down.
7. Click OK.

Creating an Email Hyperlink
An email link resembles a hyperlink. When a site visitor clicks the link, instead of opening a
Web page, the person's email application is launched. To create an email hyperlink:
1. Select the source text. (You can also select an image as an email hyperlink.)
2. Click Hyperlink Manager (

). The Link Manager dialog appears.
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3. Click the E-mail tab. The selected text appears in the Link Text field.

4. In the Address field, enter the email address of the message recipient.
5. In the Subject field, enter default text for the email’s Subject line. The user sending the
mail can edit it.
6. Click OK.

Editing a Hyperlink
To change a hyperlink’s destination Web page or target frame:
1. Right click on hyperlinked text and choose Set Link Properties. The Link Manager
dialog appears.
2. Edit the fields as needed and click OK.

Removing a Hyperlink
l

To remove a hyperlink from text, select the text and click Remove Link (

l

If you enter a URL or an email address into eWebEdit400, it automatically becomes a
hyperlink. To avoid this, select the text and click Remove Link (

).

).

Using the Wiki Feature
The Wiki feature lets registered site visitors (that is, membership users) and Ektron users
insert hyperlinks to other content. The hyperlinks can connect to existing content or to
content that doesn’t exist yet. This collaborative authoring style is used in wiki sites such as
Wikipedia, where any author can contribute new content and articles.
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Using the Wiki Feature

There are 2 ways to create a wiki link.
l
l

Surround text with double square brackets ([[ ]]). This is quick.
Use the wiki button ( ). This has the following advantages:
o Can link to existing content or create new content
o

Can choose new content’s folder
NOTE: Membership users cannot choose a folder. The new content is created in the same
folder as the content being edited.

o

Can change title of new content

o

Can select new window’s target frame

To create a wiki link using the wiki button, select the text to which you want to assign a wiki
hyperlink. It can be one or several words and click Add Wiki Link ( ).
NOTE: The Wiki button only appears if you have permission to add content to the folder that contains the
current content.
The Add/Edit Wiki Link screen appears. It has 2 tabs.
l

New Content tab—create new content to which you will add information later. The new
content item will appear when a site visitor clicks the link text.
If you want to place the new content item in the folder that contains the text you are
editing, do nothing. To place new content in a different folder, click Change and
navigate to that folder. You can also edit the Title and the Target Frame.
NOTE: Membership users cannot assign a folder. New content is saved to the folder that contains
the source content.

l

Related Content tab—link to existing content. If you click this tab, Ektron uses the
selected text to search your website. All content with that text then appears on the
screen. Each content item’s title appears followed by its summary. Click the radio button
next to the content you want to link to.

To indicate that a wiki has been applied to new content, the text color changes to blue and
bold, and small dots appear under the wiki text.
l

If you applied a link to related content, a regular hyperlink appears.

l

If you link to existing content, the link is the same as quicklink.

l

If you are creating new content, Ektron assigns a <span> tag to the selected text. For
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example:
<Span class = "makelink">selected text here</span>

When the content is published, Ektron does the following:
l

Detects the <span class = "makelink"> tag.

l

Finds text surrounded by the <span> tag.
Creates a new content block in the selected folder.
o its name is typically the selected text. However, if the user used the wiki button,
the user can modify the new content block’s title on the Add/Edit Wiki Link screen.

l

o

its initial text is New Content: content for selected text. (Fill in the topic text as you
or other collaborators have time.)

Gets the quicklink for the newly-created content block.

l

Opens the original content and replaces the <span> tag with the quicklink to newlycreated content.

l

Working with HTML
You do not need to know HTML to use eWebEdit400. However, if you know HTML, you can
view, insert or edit your Web page’s HTML code by clicking
at the bottom of the editor.
The HTML code appears.

To return to normal view, click

.

Working with Images
PREREQUISITE
Before you can insert an image into eWebEdit400, the image must be either uploaded
to the Library or imported as an asset.
l

l

Moving or Copying Content on page 290 explains how to upload an image to the
Library.
Methods for Importing Assets on page 315 explains how to import an asset.

This section also contains the following topics.
Inserting an Image into the Editor
Editing an Image
Setting a Border on an Image
Aligning an Image
Adding Space Around an Image

1968

Ektron Reference

1969
1970
1970
1971
1972

Inserting an Image into the Editor

Editing Image Properties
Deleting an Image from an XML Smart Form and eWebEdit400

1972
1974

Inserting an Image into the Editor
1. Place the cursor where you want the image to appear.
2. Click Library ( ).
3. From the left panel's folder display, select the folder that contains the image you want to
insert. If you don’t know the image’s folder, use the search button (
by title, description, or internal file name.

) to find the image

4. Select Images from the content type drop-down.

NOTE: If you are inserting an asset, its content ID number (for example, assets/1062.jpg)
appears in the Insert Library Item screen.

5. Select an image to insert.
6. Click Insert (

). The image is inserted into the content.

Alternatively, you can insert a miniature version of the image, called a thumbnail, by
clicking the thumbnail button (
). When the thumbnail appears on a Web page, a site
visitor can click it to view a full-sized image.
NOTE: You can change the thumbnail image by right clicking it, selecting Set Image Properties
and editing the Image Src field. If you do that, however, and someone clicks it, the original full-sized
image appears. If you want to change both the thumbnail and the full-sized image, delete it then
enter a new thumbnail.
To delete an image, click it and click Cut (

).
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Editing an Image
To edit an image, right click it and choose Image Modification Tool.
NOTE: The Image Modification Tool is not available in the default editor. To edit image properties in the
default editor, choose Review > Inspect Properties, then click the image. The Inspector shows the
properties you can edit.

l

—Save changes

l

—Exit without saving changes

l

l

l

l

—Crop image. Drag the box around the area you want to keep and click Done.
—Change image size. Specify the width and height. Check the box to keep the aspect
ratio.
—Rotate image
—Adjust brightness. Move slider to left to lighten image; to right to darken it.

Setting a Border on an Image
To add a border around a picture, enter the border’s thickness in pixels in the Border Width
field on the Image Properties dialog.
1 pixel border
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Aligning an Image

10 pixel border

If the picture is not a hyperlink, its border is black. If the picture is also a hyperlink, the
border is the same color as a hyperlink (for example, blue or purple if visited).

Aligning an Image
To align an image , use the Image Alignment field on the Image Properties dialog.
l

—The picture on the left margin, allowing subsequent text to wrap around it

l

—The picture on the right margin, allowing subsequent text to wrap around it

l

—The top of the picture with the first line of text

image
l

—The vertical center of the picture with the first line of text
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l

—The bottom of the picture with the first line of text

Adding Space Around an Image
On the Image Properties dialog box, you can use the Spacing fields (Horizontal and
Vertical) to add space around the picture. You enter a number of pixels to determine
spacing value.

NOTE: When you save an image, a version is placed in the siteroot/uploaded images/CMS
folder folder. The version is named filename.nextnumber.file extension.
For example, if a library image is named ektronlogo.png, and someone inserts it into content and saves it,
a new version is created and named ektronlogo.1.png. If someone later saves that image in another
content block (or even another section of the same content), that version is named
ektronlogo.2.png. Also, whenever someone edits and saves the image, a new version is created
and assigned the next highest number.
These edits have no effect on the original image stored in the library.

Editing Image Properties
After an image in inserted, you can adjust the image properties by right clicking on the
image and choosing Set Image Properties.
NOTE: To edit image properties in the default editor, choose Review > Inspect Properties, then click
the image. The Inspector shows the properties you can edit.
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Editing Image Properties

l

l

Border Width—Set the width of the image’s border in pixels. See Also: Setting a
Border on an Image on page 1970
Border Color—To set the color of the image’s border, click the X circled below. When
you do, a palette of colors appears. Click the border color from the palette.

If a color has already been assigned, it appears next to this field label. To change it,
click down arrow next to the color to display the color palette.
l

Image Alt Text—The image’s title is used as the default alt text. Change if desired.
The alt text appears in place of the image on the Web page if the image does not
display. Examples of when an image does not display include:
o

a speech browser (for example, a visually impaired person)

o

a text-only browser (for example, browsing from a mobile phone)

o

a graphical browser with images turned off
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l

l

Image Alignment—The alignment of the image relative to adjacent text and images.
If you choose left or right alignment, the text wraps around the image. For more
information, see Aligning an Image on page 1971
Image Src—The path to the image.
If you want to change the image, click the ellipsis (
there, select a replacement image.

l

l

) button to open the library. From

Horizontal Spacing, Vertical Spacing—The amount of horizontal and vertical space
around the picture. See Also: Adding Space Around an Image on page 1972
Width—The width of the picture in pixels. See Also: Working with Images on page 1968
NOTE: The Width and Height settings determine the area on a Web page in which the image
appears. To display an image correctly, its height and width settings should match its actual size
(set using the resize button). See Also: Working with Images on page 1968

l
l

Height—The height of the picture in pixels.
Constrain—The constrain feature lets you determine if an image’s height and width can
be adjusted independently. Typically, you want Constrain on, as shown.

In this state, if one dimension is adjusted, the other is automatically adjusted in
proportion to it. For example, if you change the height from 100 to 200, the width is also
doubled.
To turn Constrain off, click it. When you do, it looks like this.

When Constrain is off, the adjusted picture can be disproportionate.

NOTE: If you substantially adjust a picture’s height and/or width, the picture may be distorted when
users view your Web page.

Deleting an Image from an XML Smart Form and
eWebEdit400
If you want to remove an image from content created from an XML Smart Form and
eWebEdit400 is your editor, click image (
the image path (circled below).
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), open the Image Properties dialog, and delete

Working with Tables in eWebEdit400

NOTE: If you begin editing an image then click cancel ( ), and later try to edit that image, you may see a
small, red x instead of the image. (This problem only occurs if your browser is Internet Explorer.) To
remedy the problem, go to Tools > Internet Options > Browsing History > Settings (or Temporary
Files > Settings in Internet Explorer 6). Set Check for newer versions of stored pages to Every Visit.

Working with Tables in eWebEdit400
You can do the following tasks with tables. For information about tables in the default editor,
see Working with Tables on page 219.
This section also contains the following topics.
Creating aTable
Creating Up to 6 Rows by 6 Columns
Creating More than 6 Rows by 6 Columns:
Deleting a Table
Creating a Section 508-Compliant Table
Formatting Tables
Merging and Splitting Table Cells
Inserting and Deleting Rows and Columns
Setting Table Borders
Setting the Exterior Border of a Table
Setting the Color of a Table Border
Deleting Cells from a Table
Aligning the Contents of a Cell
Setting the Word Wrap Feature
Setting Cell Padding and Spacing
Setting the Minimum Height and Width of a Cell
Setting a Background Color for a Table or a Cell
Setting a Background Image for a Table or a Cell
Setting a Background Color for a Table Row or Column

1975
1975
1976
1977
1978
1981
1981
1981
1982
1982
1983
1983
1983
1984
1984
1985
1986
1987
1988

Creating aTable
Creating Up to 6 Rows by 6 Columns
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1. Click Table (

). A table dialog box appears.

2. Drag the cursor over rows and column to indicate the size of the table.

3. Click the mouse.

4. Enter text and images in the table cells. You can also select the table and drag its right
border to the right and/or down to enlarge it for ease of use.
NOTE: You can create a table within a table by clicking Table ( ) inside a table cell. To modify an
inner table, click inside a cell and use right click menu options, such as Set Table Properties.

Creating More than 6 Rows by 6 Columns:
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Deleting a Table

1. Click Table (

). A table dialog box appears.

2. Click Table Wizard. The Table Wizard dialog box appears.

3. To change the number of columns or rows, click the plus or minus signs (+ -) next to
Columns and Rows. The image adjusts to show the number of rows and columns.
4. Press OK.
5. Enter text and images into the table cells.
NOTE: You can create a table within a table by clicking Table ( ) inside a table cell. To modify an
inner table, click inside a cell and use right click menu options, such as Set Table Properties.

Deleting a Table
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1. Move the cursor over the table until the cursor becomes a 4-headed arrow (

).

2. Click the mouse button. The table becomes selected (small squares appear around it).

3. Press Delete.

Creating a Section 508-Compliant Table
Narrative software uses the information from the Accessibility table fields (heading rows,
columns, caption alignment and summary) to produce a Tooltip message for each table cell.
Users with impaired vision can see those Tooltips as they hover over the cells.
To create a 508-compliant table:
1. Create a new table or edit an existing one.
2. Right click in the table and choose Set Table Properties. The Table Properties dialog
appears.
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Creating a Section 508-Compliant Table

3. Click the Accessibility tab.

l

l

l

l

l

Heading Rows—If you want your table to have a horizontal header, enter the
number of rows that it should occupy. The number cannot exceed five. Beginning
with the top, all cells in the specified number of rows are designated as table
headers.
Heading Columns—If you want your table to have a header, enter the number of
columns that it should occupy. The number cannot exceed 3. Beginning with the left
column, all cells in the specified number of columns are designated as table
headers.
Caption Alignment—To choose the caption’s alignment, click the down arrow next
to this field. Click the box that represents the alignment style you want.
Caption—Enter a table caption. The caption appears above the table. The caption’s
alignment is set in the Caption Alignment field.
Summary—Enter the table summary. Non-visual browsers use the summary to
explain the table’s contents. From HTML Techniques for Web Content Accessibility
Guidelines 1.0:
“A summary of the relationships among cells is especially important for tables with
nested headings, cells that span multiple columns or rows, or other relationships
that may not be obvious from analyzing the structure of the table but that may be
apparent in a visual rendering of the table. A summary may also describe how the
table fits into the context of the current document. If no caption is provided, it is
even more critical to provide a summary.”
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l

Associate Cells with Headers—Check this box if you want to associate the
table’s data cells with the appropriate headers. See Also: H43: Using id and
headers attributes to associate data cells with header cells in data tables

4. Click on the Cell Properties tab to set the Abbreviation and Categories fields.

l

l

Abbreviation—Sets or retrieves abbreviated text for the content in the tag. Can
be used to render non-visual media, such as speech or Braille. For more
information, see abbr attribute | abbr property
Categories—Sets or retrieves a comma-delimited list of conceptual categories
associated with that tag. Can be used to render non-visual media, such as speech
or Braille. For more information, see axis attribute | axis property

5. Click OK to make the table Section 508-compliant.
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Formatting Tables

Formatting Tables
Merging and Splitting Table Cells
l

l

l

Merge cells in the table wizard.

Merge cells in a the editor by clicking in a cell, then right clicking and choosing Merge
Cells Horizontally (row span) or Merge Cells Vertically (column span).
Split a previously merged cell by clicking in a cell, then right clicking and choosing Split
Cell.

Inserting and Deleting Rows and Columns
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1. Place the cursor in the cell from which you want to add or delete rows or columns.
2. Right click the mouse. A menu appears.

NOTE: These options are also on the toolbar.

Setting Table Borders
1. Right click in the table and choose Set Table Properties.
2. Click the Table Properties tab.
3. Use the icons within the Border area to indicate which border lines should appear. Each
icon has tooltip text that explains its function.

NOTE: To view the selected borders on the dialog, a border color must be assigned.

Setting the Exterior Border of a Table
1. Right click in the table and choose Set Table Properties.
2. Click the Table Properties tab.
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Setting the Color of a Table Border

3. Enter a number of pixels in the Border field.

Setting the Color of a Table Border
1. Right click the table and choose Set Table Properties.
2. Click the Table Properties tab.
3. Click the Border Colordrop-down. A color selection box appears.
4. Click a color to apply to the table’s border.

Deleting Cells from a Table
To delete one or more cells, right click in the cell you want and choose Delete Cell. Cells to
the right of the deleted cell shift left to occupy the vacant space.
Before

After

Aligning the Contents of a Cell
1. Right click the cell you want and choose Set Cell Properties. The Cell Properties dialog
appears.
2. Click the down arrow to the right of Content Alignment. The alignment choices appear.

3. Click your alignment choice.
4. Click Update.
Ektron 8.7
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Setting the Word Wrap Feature
1. Right click in the cell you want and choose Set Cell Properties. The Cell Properties
dialog box appears.
2. To turn off Word Wrap, click the No Wrapping checkbox.

3. Click Update.
Word Wrap causes text to move down to the next line when the width of the characters on a
line equals the column width. By default, all cells have the Word Wrap feature turned on.
If Word Wrap is turned off, text stays on one line until you press Enter.

Setting Cell Padding and Spacing
1. Right click in the cell you want and choose Set Table Properties. The Table Properties
dialog appears.
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Setting the Minimum Height and Width of a Cell

2. Click the Table Properties tab.
3. In the Cell Padding and Cell Spacing fields, enter the number of pixels.

4. Click Update.

Setting the Minimum Height and Width of a Cell
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1. Right click on the cell you want and choose Set Cell Properties.
2. Click Cell Properties. The Cell Properties dialog appears.

3. Enter the cell width and height in the fields. You can enter the width in pixels or
percentage.
NOTE: When you set a cell width, there is no guarantee that the cell will occupy that width when
displayed in a browser. This is because the cell is part of a column, and changes to other cells in
the column can affect the cell whose width you set. Setting cell width only guarantees that the cell
will not be less than the width you specify.
4. Click Update.

Setting a Background Color for a Table or a Cell
1. Right click in a table cell and choose Set Table Properties.
2. Click the Table Properties tab (or the Cell Properties tab).
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Setting a Background Image for a Table or a Cell

3. Click the Background drop-down list. A selection of colors appears.

4. Click a color for the table’s background. To choose no color, click the X color box.
NOTE: From the drop-down, you can add custom colors by selecting a color patch or entering a
color’s hex value. Follow these steps to get help on how to use the color box. The custom colors box
is only available with Internet Explorer. If you are using Firefox or Google Chrome, you can enter a
custom color by its hexadecimal value.

Setting a Background Image for a Table or a Cell
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab (or the Cell Properties tab).
5. In the Background Image field, click the ellipsis button (
there, select an image for the table’s background.

) to open the Library. From
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6. Click Update.

Setting a Background Color for a Table Row or Column
1. Right click on a table cell and choose Set Table Properties.
2. Click the Cell Properties tab.
3. Within the Table Wizard dialog, hold down Ctrl while clicking all cells in the row. In the
following image, the second row from the top is selected (dark gray) and red is chosen
for the background color.
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Setting a Background Color for a Table Row or

4. Click a color for the table’s background.
5. Click OK.
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Getting Support

Technical Support
l

via Web form: Ektron Tech Support

l

via chat

l

via phone or email: Support phone

l

additional contact information: Contact Ektron

More Resources
l

l

l

l

1992

ektron.com has lots of useful information, including additional contact information and
services.
Ektron Dev Center (http://developer.ektron.com/) has resources to help you find a
solution to a problem or see what you can do with Ektron. The Dev Center also has
Webinars for many Ektron features. In the product forum, you can post tips or ask
fellow users about using Ektron products more effectively.
Ektron Professional Services (http://www.ektron.com/Services/Professional-Services/)
is a complete services infrastructure that is customized to meet your specific needs.
Ektron Implementation offers comprehensive, end-to-end architectural, development
and deployment services to ensure a successful Ektron-powered website
Ektron Training Services (http://www.ektron.com/Solutions/services/training/) ensure
your Web project’s success by providing the right level of training to your team at the
right stage of your Web project’s lifecycle.
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Index

A
accept colleague request
1253
accessibility
table fields
1978
active directory
1127
AD information imported to
Ektron
1129
advanced domains method 1127
configuring AD integration
mode
1131
domains, editing
1131
import AD user information to
Ektron
1138
importing AD user group
information
1139
integration
1129
disabling
1141
login procedure
1144
user groups
associating AD info
with CMS
1140
mapping administrator group1140
legacy method
1128
screens
setup screen
1133
status screen
1134
view user groups
1137
view users screen
1136
server configuration
70
setup methods
1127
single signon
1144
setup for IE7
1145
user authentication only mode1142
editing user information 1143
user group information, maintaining
1141
user information, maintaining 1139
ActiveTopics
server control
1637
activities tab, personal profile
1776
activity stream
display on Web site
1232
event
RSS feed link
1239
sharing on profile
1237
view in browser
1238
overview
1231
server control
1638
showing web events
520
widget
715
filtering
1235
making available
1233
on PageBuilder page
1236
personalization page
1233
adaptive image
145
caching
147
support
145
add assets button
316
advanced query text
979
advanced search
Workarea
966
advanced segments, Google
637
agents
notification
delete
1207
notification, custom
1205-1206
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Ajax
enabled server controls
1624
alias
role
admin
1121
aliasing
See URL aliasing
analytics
business
602
Google
browsers
634
provider
626
segments, viewing
637
site reports
632
tracking clicks by file type 631
tracking page
630
tracking Web site
627
traffic sources
635
overview
601
report widget
625
site overlay
655
Sitecatalyst
overview
646
reports
651
setting up
646
site content
651
site metrics
651
traffic sources
653
visitor profile
654
visitor retention
654
tracker server control
1642
web traffic
622
Webtrends
638
reports
642
API
documentation
1634
Framework
1602
Application Setup screen
license key
116
approval chain
approvers
adding
265
deleting
266
creating
264
editing approval order
265
editing for content block
266
examples
259, 268
inheritance from parent folder 259
introduction
262
viewing
for content
266
for folder
264
approval method
271
approvals report
577
approving
content
267
appsettings
68
architecture, eCommerce
1282
archiving
content, definition
298
options
298
restoring archived content
299
tasks
1036
asset management configuration,
updating
312
assetcontrol server control
1644
assets
adding
316
enabling users to upload
1644
import methods
315
load balancing, see load bal91

ancing, assets
multimedia
318
overview
315
private
295
searching
940
supported types
312
troubleshooting
329
Asynchronous Log File
582
autosuggest
960
adding term
961
removing term
963
troubleshooting
964
avatar
community group, defining
1183
membership user
1163
user, defining
1852
Azure
CDN Endpoint, creating
182
cloud instances, managing171, 191
configure eSync to cloud
instance
174, 197
configuring
179
create cloud package
194
deploying site package to
cloud
162, 183
Ektron caching, configuring
193
Ektron storage, configuring
193
hosting service, creating
180
installing certificate
179
overview
153
set BLOB redirect handler
194
set SQL Azure connection
string
194
storage account, creating
181
synchronize database and
templates
169, 189

B
bad links report
bandwidth test
Diagnostics Utility
BLOB redirect handler
blog server control
blogcalendar server control
blogcategories server control
blogentries server control
blogpost server control
blograrchive server control
blogrecentposts server control
blogroll server control
blogrss server control
blogs
adding
archive, appearance
comments
adding
approving
deleting
notification
overview
deleting
elements
maximum results, setting
overview
posts
adding
adding via Windows
LiveWriter
approving

584
1887
194
1646
1654
1655
1651
1656
1650
1658
1659
1660
494
1648
502
503
503
504
500
495
492
1649
491
507
508
507

Index

deleting
508
editing
507
editing via Windows
LiveWriter
508
made from the Web site
505
made from the Workarea 506
overview
504
subscribing
513
tags
507
properties
493
roll
497
link
adding
497
removing
499
searching
940
server controls
1645
smart forms used with
491
style sheet
494
subjects
adding
496
removing
497
subscribing
513
tagline
493
widget
715
workflow
492
bookmarklet
1249
customizing
1663
server control
1661
submitting Web page link
1250
bookmarks
inserting
editor
217
border
setting for image within eWebEdit400
1970
breadcrumb server control
1664
properties
1665
using
1668
breadcrumbs
adding
820
editing
822
inheritance and
820
overview
820
removing item
823
reordering items
821
sitemap vs. history
820
Brightcove Video widget
715
bubble text
inserting, editor
227
building block server controls
1601
builtin user
104
bundled product, displaying
product server control
1428
bundles, eCommerce
1347
business analytics
602
API
CreateContentQueryRequest
Method
617
CreateQueryRequest
Method
616
custom provider
619
GetList method
617
GetReportNameList
Method
616
introduction
612
reading event data
614
saving event data
612
UpdateReportData method 618
enabling
602
frequency of databsae writes 602

reporting
content
referrers
site statistics
templates
statistics captured
tracking site vsistors
business rules
rulesets
add rule to ruleset
adding new rule
changing sequence of
rules
creating
deleting
editing
editing rule
removing a rule
working with
selecting a rule
server control

605
606
604
606
602
603
1049
1055
1053
1052
1051
1052
1051
1056
1052
1051
1050
1671

C
cache
clearing
148
caching
configure for the cloud
193
page level
1630
while logged in
1630
with server controls
1629
calculated field, data designer
443
calendars
community
521
community user profile
522
customizing
style sheets
526
tooltip
525
events
adding
517
all day option
518
applying metadata
519
applying taxonomy
519
recurring
518
setting start time
518
folder properties
521
folder, adding
515
iCalendar export
519
introduction
514
mashups
530
server control
1859
showing events on Activity
Stream
520
using taxonomy with
534
widgets
527
group calendar
529
system calendar
527
user calendar
528
within community group profile 523
capturing order, eCommerce
1388
cart server control
flow
1407
overview
1672
properties
1672
catalog entries, eCommerce
1356
catalog folders, eCommerce
1354
categories
adding to photo gallery server
control
1268
deleting from photo gallery
1269

CDN endpoint
182
character encoding
1097
checkbox field, Data Designer
455
checked in content
report
578
checked out content
report
578
checkout server control
custom field
1419
logging in
1412
overview
1673
properties
1674
screens
1414
choices field, data designer
456
creating custom list
458
cloud
BLOB redirect handler
194
CDN endpoint
182
configuraing the portal
179
configure eSync
174, 197
configuring Ektron caching
193
configuring Ektron storage
193
create package
194
creating a storage account
181
Ektron overview
153
initial deployment
162, 183
instances, managing
171, 191
server certificate
179
set SQL Azure connection string 194
site package
162, 183
synchronize database and
templates
169, 189
codebehind file, widget, creating
723
colleagues
folder
changing name
1255
deleting
1255
group by folder
1254
invited, canceling
1254
pending
accept
1253
decline
1253
view
1253
removing
1254
selected, designating
1254
collection
ASP.Net
examples
ecmTeaser
1682
collections
adding content
361
approval system, setting up
366
assigning permission via Roles
screen
1122
compared with menu and List
Summary
355
creating
357
creating new content for
360
default template
359, 363
definition
355
deleting
359
example
ecmNavigation
1682
examples
ecmTeaser
1682
finding
357
information, editing
363
introduction
355
multi-language
365
removing content
363
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reordering content blocks
364
retrieve XML structure
1684
server control
1677
using default template or quicklinks
364
widget
715
comment
content
289
comments
task
1035
communities, user, managing
1159
community folders
1171
creating
1171
editing content
1173
permissions
1172
viewing content
1173
community groups
1181
adding
1182
browser server control
1688
calendars
523
creating personalization page 833
deleting
1184
discussion boards
1186
email address
1229
list server control
1691
members
accept/decline join
request
1185
add
1184
delete
1184
view
1182
members server control
1695
profile server control
1698
searching
1185
tags
1186
templates, assigning
1167
using discussion boards
573
web calendars
521
community management
email, setup
1223
community user profile
web calendar
522
CommunityDocuments server control
group profile
1278
overview
1275, 1685
properties
1685
comparing content
301
Diff tab
301
published tab
301
staged tab
301
complex product
displaying, product server control
1429
eCommerce
1348
configuration
mobile device
140
reorder
144
configuration screen
search
929
connection strings
68
content
adding as menu option
762
adding metadata
379
adding to collection
361
approval chain, editing
266
archiving
298
assigning permissions
261
comment
289
copying
290
deleting
291
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difference
viewing
301
displaying on your Web site
348
editing
208
editing in context
208
editing in Workarea
211
end date, setting
298
expired report
580
history
300
metadata
overview
369
moving
290
multi-language
1057
new, report
578
pending start date
report
579
previewing on mobile devices 138
private
294-295
purging historical versions
252
reports
577
approvals
577
checked in content
578
checked out content
578
refresh reminder
579
site update activity
580
restoring previous version
303
review
widget
715
review feature
deleting review
590
inserting server control
587
moderating
588
purging data
590
view all pending reviews 589
view history of reviews for
content
587
scheduling
296
searchable property, setting
942
start date, setting
297
status
pending deletion
308
submitted, report
578
summary
292
tags
380
to expire report
580
translating
296, 1069
view history, restore
303
Workarea search
966
content block
ASP.Net
examples
dynamic content
1703
definition
305
server control, static
content
1701, 1703
server control, using programmatically
1707
server control, XMLcontent 1704
widget
715
content flags
report
586
content list
retrieving XMLstructure
352
server control
1708
widget
715
ContentFlagging Server Control 1707
ContentReview Server Control 1712
control panel
discussion boards
569

copy
content
290
countries, eCommerce
1305
country tax table, eCommerce
1341
coupons
1373
crawl
filters
932, 1857
full vs. incremental
931
monitoring
934
starting manually
932
troubleshooting
937
understanding
931
CreateContentQueryRequest
Method
617
credit card types, eCommerce
1327
cross sell items, eCommerce
1371
culture, custom
1068
currencies, eCommerce
1307
default
1308
currencyselect sever control
overview
1716
properties
1716
custom ASP.Net functions
collection
1677
login
1763
placing
1763
custom tab
personal profile
1774
custom user properties
adding
1110
changing order
1117
deleting
1117
editing
1116
overview
1108
with non-English languages
813
custom validation
data designer
488
HTML form
399

D
data binding with server controls 1624
data design mode
433
data designer
calculated field
443
checkbox field
455
choices field
456
creating custom list
458
conditional section
434
custom validation
488
group box field
460
relevance tab
465
image only field
471
plain text field
485
resource selector field
476-477
tabular data field
481
decline colleague request
1253
default application language, setup
information
116
deleting
content
291
Delicious
bookmarking current page
1847
deploy to cloud
162, 183
DesignTimeDiagnostic Server
Control
1717
developer SDK
1633
developer, reference site
1602
device detection
enabling for mobile devices
137

Index

Diagnostics Utility
1884
accessing
1885
analysis screen
1888
assets tab
1895
bandwidth test
1887
basic diagnostics screen
1889
exporting
1895
how it works
1884
information provided
1886
installing
1884
prerequisites
1885
screen explained
1886
server details tab
1891
service status tab
1894
site details tab
1894
sync certificates tab
1892
sync scope tab
1893
viewing exported information 1895
did you mean feature
search
944
Digital Experience Hub (DxH)
architecture
992
connecting to external appplications
1002
connection, defined
992
connection, setting up
999
DxHConnection admin role
1123
DxHConnection user role
1123
error log
1009
inbound connection, setting up 1001
installing
996
map Ektron form to external
application
1018
mapped Ektron form
creating
1018
deleting
1022
editing
1021
mapping, defined
992
overview
991
requirements
996
Salesforce example
993
SharePoint example
995
targeted content example
994
upgrading
997
using with targeted content
1022
direct access mode
148
discussion boards
activity notifications
555
changing page size
545
community group
1186
control panel
569
creating
538
deleting
542
editing
541
file types that may be uploaded 539
forums
creating
548
deleting
550
editing
549
locking
549
moderating from control
panel
561
outputting as RSS
571
ranking users
551-552
in community groups
573
locking
540
maximum file upload size
540
overview
536
permissions
542
editing users and user
545

groups
for membership users
544
granting to users and user
groups
545
revoking for users and user
groups
545
post reporting
setting up
568
posts
adding a reply
560
approving
562
attaching images and files 563
deleting from Web SIte
563
deleting from Workarea
563
editing
562
replacing words
565
replying to post from Web
site
561
private message
573
restricting IP address
550
server controls
activetopics
1637
forum
1740
posthistory
1813
sort order
547
subject
creating
546
editing
547
subscriptions
deleting
573
reviewing
572
submitting
572
taxonomy, assigning
540
terms and conditions
545
topics
adding to forum
556
approving
558
deleting
559
editing title
558
locking
559
overview
556
sorting
569
Web site
adding video to a post
564
approving
569
deleting a topic
570
editing post from Web site 562
editing post from Workarea 562
reporting a post
568
suppressing user
information
568, 570
using on
568
display on map button
595
distributing content
after first time
1193
enabling
1188
new
1189
overview
1188
overwrite existing document 1191
prerequisites
1189
procedures
1189
document management feature
configuring
312
document types
312
file types
312, 314
importing documents
315
introduction
310
Office document, editing
323
permissions
326
troubleshooting
329

documentation
online
installing on local server
documents
importing into DMS
Droid
previewing content on
Dublin Core metadata
DxHConnection admin role
DxHConnection user role

32
315
138
380
1123
1123

E
ecmNavigation example
collection server control
eCommerce
analytics
architecture
bundles
catalog entries
attributes
content
creating/updating
deleting
dimensions
inventory adjustments
pricing
items
entering
media
overview
pricing
non-default currency
tier
tier, for non-default
currency
properties
summary
tangible item
thumbnail size
thumbnails
catalog folders
assigning product type
deleting
overview
complex product
countries
country tax table
deleting
editing
overview
coupons
creating
eligible catalog entries
minimum order amount
quantities
start/end dates
credit card types
creating
deleting
editing
introduction
where used
cross sell items
currencies
default
enabled
installed
customer information
overview

1682
1403
1282
1347
1364
1360
1357
1358
1361
1362
1368
1366
1356
1362
1363
1364
1361
1361
1361
1367
1366
1355
1355
1354
1348
1305
1342
1342
1341
1373
1373
1378
1377
1377
1377
1328
1329
1329
1327
1327
1371
1307
1308
1308
1307
1395
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images
inventory provider
customizing
inventory workflow
kits
messages
creating
editing
how created
overview
variables
order activity customizing
order fulfillment
orders
cancelling
deleting
marking fraud
overview
statuses
tracking number
packages
creating
deleting
editing
how used
introduction
payment gateway
creating
customizing
default
deleting
editing
introduction
postal tax table
creating
deleting
editing
product types
classes
deleting
editing
effect on catalog entries
overview
regional tax table
deleting
editing
overview
regions
reports
inventory
server controls
customizing
overview
shipping calculations
customizing
shipping methods
adding
changing sequence
deleting
editing
shipping provider
customizing
shipping providers
default
defining
shipping workflow
site
setting up
templates, required
site design
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1292
1463
1285
1345
1393
1393
1392
1391
1393
1445
1284
1389
1389
1391
1386
1387
1389
1331
1331
1331
1330
1330
1320
1449
1319
1324
1324
1311
1339
1340
1340
1343
1354
1353
1344
1343
1341
1340
1340
1306
1397
1405
1404
1466
1331
1333
1334
1334
1333
1456
1332
1332
1287
1293
1293
1289

stock activity customizing
1445
subscription workflow
1286
tax class
creating
1339
deleting
1339
editing
1339
screens
1338
taxes
how calculated
1335
overview
1334
shipping
1337
upsell items
1371
warehouse
1329
creating
1329
default, changing
1330
deleting
1330
editing
1330
wireframe design
1290
workflow
1283
ecommerce workflows
customizing
1435
editor
customizing
231
attributes
237
tags
237
editing source
227
images
inserting
223
inserting bookmarks
217
inserting bubble text
227
inserting links
215
inserting tables
219
inserting video
226
integrating into aspx page
238
introduction
207, 1955
plug-ins
232
styles, applying
214
translating text
230
using templates
229
validation
229
ek_ADAdvancedConfig
70
ek_ADEnabled
70
ek_ADPassword
70
ek_ADUsername
70
ek_appeXSLTPath
68
ek_appImagePath
68
ek_appName
68
ek_appPath
68
ek_assetPath
71
ek_AUTH_Protocol
70
ek_BatchSize
71
ek_buildNumber
68
ek_CacheControls
71
ek_cmsversion
69
ek_DefaultContentLanguage
71
ek_ecom_ComplianceMode
73
ek_ecom_DefaultCurrencyId
73
ek_ecom_TestMode
73
ek_EditControlMac
71
ek_EditControlWin
71
ek_EnableMessageBoardEmail
72
ek_EnableMultilingual
71
ek_helpDomainPrefix
72
ek_Image_1
70
ek_InvitationFromEmail
72
ek_LDAPMembershipUser
69
ek_LinkManagement
72
ek_LogFileName
72
ek_loginAttempts
72
ek_LoginScreenWidth
72

ek_MailFormat
70
ek_MeasurementSystem
73
ek_MenuDisplayType
70
ek_PageSize
72
ek_QueueName
72
ek_RedirectFromLoginKeyName 69
ek_RedirectorInstalled
69
ek_RedirectorManualExt
69
ek_RedirectToLoginURL
69
ek_ServerURL
71
ek_ShowWorkareaRetErrorReferrer
72
ek_sitePath
69
ek_SMTPPass
70
ek_SMTPPort
70
ek_SMTPServer
70
ek_SMTPUser
70
ek_SSL_Port
70
ek_ToolBarFormatTag
72
ek_TreeModel
69
ek_UserMenuType
71
ek_UseSSL
70
ek_WorkareaLibSearchResultMode 73
ek_XliffVersion
73
EkML
1905
example
1917
tags
1919
templates
collection.ekml
1906
contentlist.ekml
1907
map.ekml
1909
messageboard.ekml
1911
metadatalist.ekml
1912
taxonomy.ekml
1913
websearch.ekml
1916
variables
1919
Ektron CMS FileHelper Service
882
Ektron markup language
1905
Ektron ProtocolHandler File Helper
Service
882
Ektron Query Service
882
Ektron Search Server Service
882
Ektron support
1991
Ektron UI
1602
Ektron Windows service
1877
view in IIS
1879
email
disabling notification for a user 1102
display in user profile
1854
notification of content changes,
configuring
93
setting up
community management 1223
to announce content changes,
configuring
96
email address
community groups
1229
email variables; variables, email
96
encoding, character
1097
end date
content, setting
298
eSync
bidirectional
1520
CMS content and folder
prerequisites
1537
configure to a cloud
instance
174, 197
content
1538
initializing a new site
1480
introduction
1473, 1475

Index

load balanced system
logs
manually running
multi-site environment
packages
pause schedule
performance counters
profile
setting up
security certificates
installing
introduction
regenerating
replacing
testing
troubleshooting
using with three-tier architecture
event handlers
events
web calendar
adding
eWebEdit400
bookmarks
finding text
hyperlinks
editing
removing
images
inserting
replacing text
search
spelling
table
section 508
abbreviation
categories
table caption
table summary
temporary markers
text, searching
toolbar buttons
expired content
report
extensions
creating
registering in ObjectFactory

1556
1546
1532
1560
1542
1519
1552
1512
1523
1521
1528
1528
1528
1565
1600
1868

517
1962
1960
1964
1966
1966
1968
1960
1960
1961

1980
1980
1979
1979
1959
1960
1956
580
1867
1875

F
Facebook
login
109
targeted content widget criteria 740
faceted search
916
fallback locale
1069
FAST search
Microsoft
3-tier architecture
1600
FAST Search
Microsoft
faceted search
916
making Title property sortable
915
overview
899
rank profiles
920
troubleshooting
925
favorites
adding URL link
1724
folder, deleting
1725
group by folder
1724

server control
1723
file extensions
library folder property
336
file types, determining allowed
314
file upload path
library folder property
337
files
copying to library
339
library
editing title
342
inserting into content
342
overwriting
344
viewing
341
508
compliant table
1978
validating content
229
flags
applied to content
deleting
1245
edit details
1244
finding
1242
view details
1244
definition
adding
1240
assigning to folder
1241
deleting
1241
editing
1241
overview
1239
report
586
Flash widget
746
flexible menu
server control
overview
1728
properties
1733
working with XLSTfile
1729
flickr widget
715
folderbreadcrumb server control 1736
folders
assigning metadata
377
assigning smart forms
437
assigning Web Alerts
1581
colleagues
1254
community
1171
content
applying
style sheet
255
deleting
251
managing
241
properties
253
toolbar
254
information available when viewing
242
move/copy
authorized users
250
folder types
251
introduction
248
private
295
traverse
259
using to group favorites
1724
font buttons, enabling
118
fonts
adding
285
deleting
285
editing
285
managing
284
viewing
285
format
license key
11
formblock server control
overview
1738

forms
adding to content
346
HTML
386
assigning task
421
buttons, properties
403
chart types
416
creating content block
389
custom validation
399
field validation options
397
inserting fields
checkbox
390
text
395
reports, exporting
421
reports, viewing
417
viewing
404
viewing
346
Forum server control
1740
custom theme
1746
editing toolbar
1747
forums
discussion boards
550
creating
548
deleting
550
editing
549
permissions
550
ranking users
551
searching
941
Foxit PDF filter
880
framework API
1602
framework UI
1602
friends
server control
1747
server control properties
1748
Front Page server extensions,
removing
328
full screen, work page, customizing
for user
1104

G
GeoIP
databases
1901
information, accessing via API 1902
support
1899
using with Targeted Content Widget
1901-1902
geomapping
with mobile devices
149
GetReportNameList Method
616
Google
bookmarking current page
1847
Gadget widget
715
web analytics provider
626
group box field, data designer
460
groups
community
1181

H
HelloWorld widget
help
installing on local server
history
content
hosting service, Azure
HTML
saving Office document as
HTML forms
HubSpot
using with DxH and Ektron

715
32
300
180
325
386
1024
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hyperlinks
adding as menu option
definition

1964
763
333

I
ical export of calendar events
519
iFrame widget
715
image
resize
145
resolution
146
image only field
data designer
471
image upload path
library folder property
336
imagecontrol server control
1750
images
adaptive, caching
147
adaptive, support
145
editing within eWebEdit400 1970
inserting
223
inserting into eWebEdit400
editor
1968
letting community users
update
1750
login, changing
104
inbound connection
Digital Experience Hub (DxH),
setting up
1001
indexing (XML)
438
inheritance
breaking
260
restoring
260
integrated search
946
intellisense
1617
inventory provider
ecommerce
customizing
1463
inventory report
1397
invite server control
overview
1751
properties
1752
invited colleagues
canceling
1254
IP address
restricting for a forum
550
using to obtain user information
1900
iPad
previewing content on
138
iPhone
previewing content on
138

J
journal
displaying

1652

K
kits
displaying
product server control
eCommerce

1429
1345

L
language awareness, URL aliasing 838
language export feature, see
multi-language content 1072
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languageAPI server control
codebehind only properties 1754
overview
1754
properties
1754
using programatically
1755
languages (multiple)
1057
languageselect server control
overview
1755
properties
1755
LDAP authentication
Active Directory Setup screen 1156
adding organizational unit
1154
adding user information from
LDAP server to CMS
400
1154
deleting users
1156
disabling
1157
editing user information in
CMS 400
1156
enabling
1152
library
accessing
334
asset, adding as menu item
763
copying files to
339
definition
333
files
deleting
345
editing
342
inserting into content
342
overwriting
344
viewing
341
folder properties
336
forms
adding to content
346
viewing
346
items
actions that can be performed
333
quicklinks
adding to content
346
viewing
346
searching
337
license keys
format
11
modifying
116
link checker
291
links
inserting
editor
215
ListSummary
compared with collection and
menu
355
server control
introduction
1756
properties
1757
retrieve XML structure
1762
widget
715
Live Writer
508
load balancing
assets
91
introduction
89
library images and files
90
search
885
locales
creating
custom culture
1068
fallback
1069
pseudolocalization strategy 1067
localized section
creating
1073

editing
overview
removing

1076
1073
1076

lock
a user out
103
discussion boards
540
discussion forum
549
locked user account, unlocking
103
login
ASP.Net
1763
placing
1763
attempts, disabling
103
Facebook
109
images, changing
104
locking out a user
103
preventing all users from
104
preventing CMS users from
104
procedure
101
restricting number of attempts 102
LogLevel
73
logs
eSync
1546

M
machine translation feature
230
machine translation strategy
1066
mapped network folder
removing
321
maps
default center
1768
distance units
1767
elements, displaying
596
elements, suppressing
596
find what tab
594
google
obtaining license
592
initial boundaries
597
provider, determining
1768
restricting content
599
server control
1765
properties
1765
showing taxonomy categories 1768
zoom control
1771
mark for translation status
1078
marketing optimization suite
125
Marketo
DxH connection
1003
markup language, Ektron
1905
mashups
calendar, web
530
master layout
680
master zone
680
media settings
73
membership
module, accessing
1162
server control
1771
captcha
1778
properties
1777
membership user groups 1165-1166
adding
1166
adding users
1166
deleting
1166
deleting users
1166
viewing users
1165
membership users
activating
1588
deleting
1164
permissions, assigning
1166

Index

unverified, confirmation message
1587
unverified, viewing
1588
menus
accessing
755
add new content block via navigation link
764
adding new
via content folder
756
via Menus module
759
appearance
to content contributor
754
to site visitor
754
assigning users permission to edit
via the Roles
screen
1122-1123
compared with collection and
List Summary
355
creating
in any language
771
definition
753
deleting
769
editing
765
via content folder
765
via menus module
765
via navigation link
765
items
adding
content block as
762
external hyperlink as 763
library asset as
763
submenu
764
via content folder
759
via modules folder
761
via navigation link on
Web page
761
definition
754
rearranging
768
multi-language issues
770
permissions
755
structure
754
submenu, definition
754
template link field
758
translating
770
URL link field
758, 760
viewing
via content folder
766
via menus module
767
via navigation link
768
message board
comments, authorization to
submit
1177
comments, deleting
1178
comments, replying
1178
moderating
1175
users authorized
1177
notification of postings
1179
replies, authorization to submit 1177
server control
1786
properties
1787
spam filtering
1180
widget
715
messages
eCommerce
1391
messaging server control
overview
1790
populating
1791

metadata
adding to content
379
applying to web calendar event 519
assigning to a folder
377
definitions
adding
370
converting style
376
Dublin Core
380
impact of folder inheritance
378
inheritance from parent folder 378
list
widget
715
related content
creating and deploying definitions
375
requiring users to enter
378
search data
adding to content
377
searching for
943
Micro-messages
replying
1265
spam filter
1266
Micro-messaging server control
display modes
1259
overview
1801
properties
1801
searching for
1263
micromessaging bookmarklet
1249
Microsoft Dynamics
DxH connection
1003
Microsoft FAST Search
faceted search
916
making Title property sortable 915
overview
899
rank profiles
920
troubleshooting
925
Microsoft Office documents
adding via Multiple DMS Documents option
317
checking out
323
compatability pack
322
deleting
324
importing
315
managing
322
replacing
323
saving
324
saving in html format
325
Microsoft Search Server
adding CMS site to server
885
configurations
871
installation
871
optimizing
880
register CMS site
927
mobile devices
configurations
adding
140
deleting
144
editing
143
device-specific content
139
enabling device detection
137
geomapping
149
previewing content
138
reorder configurations
144
templates
developing
137
templates, previewing content 138
mobile templates
136
moderating message board
1175
most popular widget
607
move content
290

multi-language content
1057
creating new content
1062
default language
1061
determining available languages
1059
disabling a language
1061
enabling/disabling
1059
language export
introduction
1072
locales, creating
1064
machine translation strategy 1066
setting up Web site
1059
spell checking
1088
translating content
1070
by machine
1071
translation
files, importing
1076
viewing site in another language
1062
multi-language menus
770
multilingual settings
71
multimedia assets
318
Multiple DMS Documents option
317
myaccount server control
overview
1420, 1804
properties
1805

N
new content
report
578
notifications
agents
1204
delete
1207
agents, custom
1205-1206
conditions for
1195
custom activity
1203
default preferences
1202
eSync
1212
message board postings
1179
messages
1208
multi-site environment
1210
overview
1194
receiving
1200
recipients
1196
setting up
1199
SMS,configuring
1212
SSL
1211
tokens
1213
triggering
1195

O
ObjectFactory
objectstrategies
1875
online help
installing on local server
32
orderlist server control
overview
1423, 1806
properties
1806
organizational unit, LDAP, adding 1154

P
packages
eCommerce
eSync
page level caching
page property
server controls

1330
1542
1630
1621
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PageBuilder
code samples
692
dropzone user control
letting users add columns 692
letting users resize
692
set column width programmatically
691
master layout
680
asigning to pages folder
684
using to create new page 684
master zone
680
changing to layout zone
684
setting dropzone to
683
overview
659
page
create
661, 663
place widgets
665
page,searching
941
three-tier architecture
1598
wireframe
676
assign to folder
686
assigning custom taxonomy to
688
assigning default page to 687
passwords
custom, strategy
106
setting for user
1101
payment gateway
1311
provider
ecommerce
customizing
1449
PDF
generation
disabling
1878
pending deletion, content status
308
performance counters, use with e
Sync
1552
permissions
assigning to community
folders
1172
assigning to content block
261
assigning to membership
users
1166
discussion boards
542
document management feature
326
inheritance
breaking
260
restoring
260
menus
755
table
adding user or group
260
deleting user or group
261
editing user or group
261
personalization
introduction
825
personalization page
community group
833
creating
830
photo gallery
adding photos
1269
copying photos
1271
deleting photos
1271
moving photos
1271
saving photo to computer
1272
server control
1267, 1808
server control, adding categories
1268
server control, deleting cat- 1269
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egories
sharing photos
1271
plug-ins
editor
232
polls
creating
407
editing from Web site
410
replacing from Web site
411
server control
1811
postal code
applying non-U.S.
1415
PostHistory
server control
1813
preapproval groups
report
583
preserve MS Word
classes
117
styles
117
pricing tier, eCommerce
1363
private
assets
295
content
294-295
folders
295
messages
discussion boards
573
send from social bar control
1274
product list server control
overview
1430, 1818
properties
1818
product server control
bundled product, displaying 1428
complex product, displaying 1429
kit, displaying
1429
overview
1426, 1815
properties
1815
product types, eCommerce
1343
profile
personal
activities tab
1776
custom tab
1774
editing
1775
forum tab
1773
tags tab
1773
rank
overview
920
pseudolocalization strategy
1067
purge history
252

Q
quicklinks
adding to content
definition
using for a collection
viewing

346
333
364
346

R
rank profiles
overview
920
ranking users, for discussion
boards
551
receiver, SharePoint
setting up
1005
recent documents
widget
715-716
recommendation server control
overview
1432, 1826
properties
1826

recurrence
web calendar events
518
redirect handler, BLOB
194
referrers
business analytics reporting
606
refresh reminder
report
579
regional tax table, eCommerce
1340
regions, eCommerce
1306
relevance tab
data designer group box field 465
remove Ektron from server
29
replies
message board
authorization to submit
1177
reports
approvals
577
bad links
584
checked in content
578
checked out content
578
content
overview
577
content flags
586
content pending start date
579
content to expire
580
expired content
580
new content
578
preapproval groups
583
refresh reminder
579
search phrase
582
site update activity
580
submitted content
578
resource selector field
data designer
476
overview
477
responsive design
670
restoring content
303
retrieving XML structure of content
1706
roles
alias admin
1121
business rules screen
1122
community group admin
1123
community group create
1123
defining
1120
folder user admin screen
1121
member admin
1123
metadata admin screen
1124
permission to work with collections
1122
permission to work with
menus
1122-1123
screens
1121
smart forms admin
1124
synchronization user
1124
synchronize widgets
1125
task create screen
1125
task delete screen
1125
task redirect screen
1125
user admin screen
1125
XLIFF admin screen
1125
RSS
discussion board forum output 571
RssAggregator server control
1828
rulesets
1049

S
Salesforce
DxH connection

1003

Index

scheduling content
296
search
advanced
Workarea
966
assets
940
autosuggest
960
adding term
961
removing term
963
troubleshooting
964
by content ID
969
configuration screen
logging in
926
registering site
929
content folder
966
crawls
monitoring
884
criteria for returned content
939
did you mean? feature
944
expired content
939
faceted
916
files outside of Ektron
946
forums
941
Foxit PDF filter
880
HTML forms
940
images
941
integrated
overview
946, 950
language, effect of
939
library
337
library items
939
load balanced
885
metadata
943
multimedia
941
multiple terms, and/or relationship
939
overview
861
PageBuilder page
941
phrase report
970
private content
939
property
results
content type
1844
last edit date
1844
summary
1844
title
1844
URL
1844
published tab
966
queries, how processed
883
query language
951
ranking results
942
results
did you mean?
944
display
943
postback message
944
rank
942
server
register CMS site
927
sitesearch model
1843
Smart Forms
940
status screen
884
suggested results
952
synonym sets
945
tags
941
troubleshooting
988
unusual file extensions
881
using with three-tier architecture
1600
Visio file
943
Web site
advanced
941

basic
939
Windows services used by
881
Search Engine Optimization (SEO)
control
1831
appearance
1832
viewing report
1832
search model
sitesearch
1843
search phrase
report
582
search screen
specifying
kind of content to search
968
word or phrase
968
search server controls
adding to Visual Studio
975
advanced query text
managed properties
980
operators
980
overview
979
data fields for Eval statement
973
injecting custom service
975-976
markup, modifying
973
model fields, discovering
973
modifying
972
overview
971
product
overview
1822
productsearchinputview 1823
productsearchresultsview 1824
SearchController 1824, 1840, 1856,
1862
site
overview
1836
sitesearchinputview
1837
connecting to sitesearchcontroller 1838
customizing
1839
placing on page
1838
separating search field
from results
1839
sitesearchresultsview
1840
connect to sitesearchcontroller 1841
customizing
1841
user
overview
1855
usersearchinputview
1855
usersearchresultsview
1857
XML search
overview
1861
XML search template, customizing
1864
XML smart form search model 1863
XMLsearchinputview control 1862
Search Server Express
setup
864
Search Server, Microsoft
configurations
871
installation
871
optimizing
880
search, web, server control
981
searchable content
field
942
searchable properties
adding to content
379
definitions
adding
370
security certificates, eSync
1521

segments
Google analytics, viewing
637
selected colleague
designating
1254
server controls
activity stream
1638
adding to Visual Studio
1602
Ajax enabled
1624
assetcontrol
1644
blog
1651
blogcalendar
1654
blogpost
1656
blograrchive
1650
blogrecentposts
1658
blogroll
1655, 1659
blogrss
1660
bookmarklet
1661
building block
1601
business rules
1671
caching
1629
community group list
1691
community group members 1695
community group profile
1698
ContentFlagging
1707
ContentReview
1712
customizing
1622-1623
data binding
1624
DesignTimeDiagnostic
1717
display custom XML
1632
favorites
1723
flexible menu
1728
formblock
1738
imagecontrol
1750
inserting programmatically
1614
inserting via drag drop
1611
installing
1606
introduction
1605
languageAPI
1754
languageselect
1755
map
1765
membership
1771
message board
1786
page property
1621
poll
1811
recognizing in code-behind
1622
recognizing in HTML
1622
removing
1608
RssAggregator
1828
setting properties in codebehind
1616
TagCloud
1848
web calendar
1859
SharePoint
authentication modes
1013
importing files to Ektron
1009
importing files to Ektron, supported data types
1013
preparing metadata
1010
receiver
setting up
1005
shipping calculations
ecommerce
customizing
1466
shipping provider
ecommerce
customizing
1456
shipping tax, eCommerce
1337
single signon
1144
setup for IE7
1145
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site
overlay
655
statistics
604
site map, see breadcrumbs
820
site package to the cloud
162, 183
site update activity
report
580
Sitecatalyst analytics
overview
646
reports
651
site content
651
site metrics
651
traffic sources
653
visitor profile
654
visitor retention
654
SiteMap server control
1833
properties
1834
retrieving XML structure
1835
using
1835
Smart Desktop
personalizing
278
set as start location for user 1104
Smart Forms
adding
via data designer
427
via external XML file
428
conditional section
434
data design mode
433
data entry mode
433
deleting
437-438
introduction
423
searching
940
XSLT
editing
436
smart forms admin role
1124
SMPT server configuration
70
SMTP
configuring
94
social bar
server control
1273, 1845
adding favorite URL
1273
private messaging
1274
tweeting current user location
1275
social business software
129
solution file, opening
1608
source content
editing
227
spam filtering
message board
1180
spell checking
dictionary
adding word
1090
adding word list
1091
custom
1094
deleting
1093
deleting word
1091
importing
1092
updating
1090
foreign language
1088
in eWebEdit400
1961
set language
1088
standard dictionaries
1089
SSL support
70
start date
content
assigning
296
content block, setting
297
storage
configuring for the cloud
193
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storage account on the cloud
181
strategy
password
106
stream, activity, widget
715
style sheet
determining appearance of
page on Web site
255
style sheets
applying to content folder
255
web calendar, customizing
526
style sheets, used in Ektron Workarea
277
styles
applying via editor
214
subfolders, adding
247
submenus
adding as menu item
764
definition
754
submitted content
report
578
subscriptions
blog
513
blog posts
513
CMS user sign-up
1589
defining
1578
user sign-up
1586
verification email
1587
suggested results
952
adding a link
959
creating
956
deleting
960
display, determining
958
editing a link
959
rearranging links
960
removing a link
960
summary
content
adding
292
support, contact information
1991
surveys
creating
407
synchronization user role
1124
synchronize database and templates in cloud
169, 189
synchronize widgets role
1125
synonym sets
945
best practices
945
creating
945
deleting
946
editing
946

T
table
permissions
adding user or group
deleting user or group
editing user or group
tables
inserting
editor
tabular data field
data designer
TagCloud server control
tags
community group
content
creating
default, creating
deleting

260
261
261

219
481
1848
1186
380
1247
1246
1248

overview
1245
searching
941
tab
personal profile
1773
types
1246
targeted content
using with Digital Experience
Hub
994
targeted content widget
731
configuration
creating
745
deleting
746
editing
746
overview
744
referencing
744
creating conditions
734
criteria
cookie
736
date and time
day
737
day of month
738
day of week
738
hour of day
739
Facebook information
740
logged in
736
referring URL
735
regional information
739
search engine
735
URL parameter
736
user in community
737
user in group
736
user properties
737
customizing
744
editing condition criteria
742
editing condition widgets
743
multiple criteria
741
tasks
archiving
1036
assigning
to content block
1030, 1041
to HTML form
421
to user
1029, 1041
comment
adding
1035
definition
1028
deleting
1036-1037
due date
1030, 1042
editing
1035
priority, assigning
1030, 1041
purging
1037
redirecting to another
user
1029, 1041
relationship to content blocks 1028
start date
1030, 1042
state, assigning
1030, 1041
states
introduction
1033
view
options by users
1039
viewing
options
1038
taxes
eCommerce, overview
1334
taxonomy
adding a category
802
applying to web calendar event 519
assigning a folder
791
assigning items
787
changing order of categories 805
changing order of content
806

Index

community groups
817
copy
802
creating
780
custom properties
creating
810
deleting
812
editing
812
introduction
808
reordering
813
deleting
803
exporting
806
importing
806
inheriting
791
move
802
multi-language support
814
overview
777
removing content from
804
removing folder from
804
showing on map
1768
using with social networking
817
using with web calendar
534
viewing
800
taxonomy summary widget
716
technical support options
1991
Technorati
bookmarking current page
1847
template link
field on Add/Edit Menu screen 758
templates
adding new
383
community groups and members
1167
creating and updating
382
declaring
383
deleting
384
how used in CMS400
382
mobile
136
setting up in Visual Studio
1609
updating
384
using with editor
229
temporary markers
ewebedit400
1959
three-tier architecture
aliasing
1599
benefits
1593
creating content
1597
limitations
1593
overview
1591
setting up
1595
using PageBuilder
1598
using with eSync
1600
using with Fast search
1600
using with search
1600
thumbnail, inserting
224, 1969
tier pricing. eCommerce
1363
tokens
used in notifications
1213
translating content
230
translation
status, mark for
1078
workarea
1086
translation package
assigning content
1085
assigning folders
1085
creating
1084
overview
1083
traverse folders
259
trends widget
introduction
610

twitter
posting user's current URL

1275

U
uninstall Ektron
29
upcoming events widget
716
upsell items, eCommerce
1371
URL aliasing
automatic
849
configuration
849
inactivating
853
delete
853
pattern
849
setting up
851
clear cache
844
community
troubleshooting
853
configuring
837
file extensions
enabling/disabling
838
filtering
845
introduction
835
language awareness
838
manual
activate/deactivate
848
add/edit
845-846
additional variables
848
enabling
838
introduction
845
query string parameters
848
remove
848
multi-language content
844
override template
838
permissions
840
redirect
858
RegEx
854
create/edit
854
restrictions
841
site
deleting
858
editing
857
introduction
856
three-tier architecture
1599
types
836
URL link
field on Add/Edit Menu
screen
758, 760
user calendar
widget
528
widget, adding groups
529
user control file, widget, creating
722
user groups
creating
1106
deleting
1107
editing
1107
removing user from
1105
viewing
1107
user profile
calendars
521
display email address
1854
server control
1852
users
adding to permissions table
260
communities, managing
1159
creating new
1100
deleting
1105
deleting from permissions table 261
editing
1103
editing in permissions table
261

email, disabling notification
1102
password, setting
1101
profile
customizing work page
width
1104
set Smart Desktop as start
location
1104
removing from user group
1105
unlocking locked account
103

V
validation
editor
field
HTML forrms
verification message for membership users
video
inserting
editor
view content difference
ViewAllMenus
Visio file
include in search results
Visual Studio
adding server controls
learning
setting up template

229
397
1587

226
301
753
943
1602
1633
1609

W
warehouse, eCommerce
Web Alerts
assigning to folders and content
Asynchronous Log File
email, setting up
overview
password reset for site visitors
sample email
server configuration
setting up
asynchronous processor
message queue
subscriptions
CMS users
defining
multi-language
user sign-up
verification email
web analytics widget
web search server control
web sites
supporting multiple
advantages
prerequisites
web traffic analytics
URL filtering
view from PageBuilder page
view from Workarea
viewing page level traffic
viewing site level traffic
web.config
active directory server configuration
appsettings
connection strings
ektronCommerce
images

1329

1581
582
1576
1567
1588
1568
1569
1570
1572
1572
1589
1578
1580
1586
1587
621
981

76
76
620
625
623
624
622
625

70
68
68
73
70
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mediasettings
73
menu settings
70
miscellaneous settings
71, 74
multilingual settings
71
SMPT server configuration
70
SSL support
70
system.diagnostics
73
webcalendar widget
716
Webtrends
638
widgets
711
activity stream
715
adding a field
729
Blog
715
Brightcove video
748
collection
715
content block
715
content list
715
css files, working with
726
customizing
726
Flash
746
flickr
715
global properties, setting
727
GoogleGadget
715
HelloWorld
715
help,adding
731
iFrame
715
JavaScript, working with
726
list summary
715
local properties, setting
729
message board
715
metadata list
715
most popular
607
place on PageBuilder page.
665
recent documents
715-716
removing
714
RSS feed
716
spaces
829
targeted content
731
taxonomy summary
716
trends
610
upcoming events
716
web analytics
621
web calendar
527
Youtube video
716
Windows
Live Writer
508
Windows services
Ektron
1877
used by search
881
wireframe
PageBuilder
676
Word, Microsoft
classes, preserve
117
styles, preserve
117
Workarea
274
accessing
277
advanced search
966, 1838
closing
277
translating
1086
WSPath
73
WURFL
150

X
XLIFF
creating file
XML content
retrieving XML structure
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1081
1706

XML indexing
438
search
setting up
439
search criteria
types
441
user vs. developer
441
specifying elements to index
442
validation
441
XML structure
retrieving
1706

Y
Youtube video widget

716

Z
zoom level
maps, displaying

1771

